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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.
 

 
CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

 

 
NOTICE
indicates that an unintended result or situation can occur if the relevant information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

 
Ⓟ 08/2011

Copyright © Siemens AG 2011.
Technical data subject to change
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System overview of STEP 7 and WinCC 1
1.1 Scaling of STEP 7 and WinCC

Scope of performance of the products
The following graphic shows the scope of performance of the individual products of STEP 7 
and WinCC:

* Only with Professional for S7-300/400/WinAC

STEP 7
STEP 7 (TIA Portal) is the engineering software for configuring the SIMATIC S7-1200, 
S7-300/400, and WinAC controller families. STEP 7 (TIA Portal) is available in 2 editions, 
depending on the configurable controller families:

● STEP 7 Basic for configuring the S7-1200

● STEP 7 Professional for configuring S7-1200, S7-300/400, and WinAC
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WinCC
WinCC (TIA Portal) is an engineering software for configuring SIMATIC Panels, SIMATIC 
Industrial PCs, and Standard PCs with the WinCC Runtime Advanced or the SCADA System 
WinCC Runtime Professional visualization software.

WinCC (TIA Portal) is available in 4 editions, depending on the configurable operator control 
systems:

● WinCC Basic for configuring Basic Panels
WinCC Basic is included with every STEP 7 Basic and STEP 7 Professional product.

● WinCC Comfort for configuring all panels (including Comfort Panels, Mobile Panels)

● WinCC Advanced for configuring all panels and PCs with the WinCC Runtime Advanced 
visualization software
WinCC Runtime Advanced is a visualization software for PC-based single-station systems. 
WinCC Runtime Advanced can be purchased with licenses for 128, 512, 2k, 4k as well as 
8k PowerTags (tags with a process interface).

● WinCC Professional for configuring panels and PCs with WinCC Runtime Advanced or 
SCADA System WinCC Runtime Professional
WinCC Runtime Professional is a SCADA system for structuring a configuration ranging 
from single-station systems to multi-station systems including standard clients or web 
clients. WinCC Runtime Professional can be purchased with licenses for 128, 512, 2k, 4k, 
8k, 64k, 102400, 153600 as well as 262144 PowerTags (tags with a process interface).

With WinCC (TIA Portal), it is also possible to configure a SINUMERIK PC with WinCC Runtime 
Advanced or WinCC Runtime Professional and HMI devices with SINUMERIK HMI Pro sl RT 
or SINUMERIK Operate WinCC RT Basic. 

1.2 Options for STEP 7 Engineering System

Additional STEP 7 products
For applications with increased safety requirements, STEP 7 Professional can be extended 
with the STEP 7 Safety option.

The STEP 7 Safety option allows you to configure fail-safe PLC programs for F-CPUs.

1.3 Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional options allow you to extend the functionality in some cases to increase the range 
of available tasks.

System overview of STEP 7 and WinCC
1.3 Options for WinCC Engineering and Runtime systems
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Options for Comfort Panels, Mobile Panels, Multi Panels
The following possible extensions are available for Comfort Panels, Mobile Panels, and Multi 
Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option 
are incorporated into the basic functionality.

 

Options for WinCC Runtime Advanced
The following possible extensions are available for WinCC Runtime Advanced:

● WinCC SmartServer (remote operation)

● WinCC Recipes (recipe system)

● WinCC Logging (logging of process values and alarms)

● WinCC Audit (audit trail for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option 
are incorporated into the basic functionality.

 

Options for WinCC Runtime Professional
The following possible extensions are available for WinCC Runtime Professional:

● WinCC Client (standard client for structuring multi-station systems)

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)
 

  Note

In contrast to WinCC V7, functions from the WinCC /OPC-Server and WinCC /
ConnectivityPack options are incorporated into the basic functionality. Likewise, the basic 
functionality includes the Runtime API from WinCC /ODK.

 

Beyond the Runtime options, WinCC Runtime Advanced and WinCC Runtime Professional 
can be extended through customer-specific controls. To develop controls, the WinCC 
ControlDevelopment option is required.

System overview of STEP 7 and WinCC
1.3 Options for WinCC Engineering and Runtime systems
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Readme 2
2.1 General notes

2.1.1 General notes
The information in this readme file supersedes statements made in other documents.

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation.

Security settings
In order to operate the software packages in the TIA Portal, port 4410 for TCP must be entered 
as an exception in the Windows firewall during installation.

Installing new .Net versions or .Net service packs
● Close the TIA portal before installing a new .Net version or a new .Net service pack on your 

programming device/PC.

● Restart the TIA portal only after successful installation of the new .Net version or the 
new .Net service pack.

Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected, 

you may experience delays when opening the "Project" menu.

● When you insert a CPU, you may need to wait for some time if the project editor is open at 
the same time. This generally takes longer when you insert the first CPU in a newly created 
project. To be able to continue working more quickly, you should close the project editor 
before inserting a CPU.

● The message "Application is not responding" may appear in Windows 7 with functions that 
take a long time to run (loading the CPU for example). If this occurs, wait until the function 
has correctly finished.

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes 
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint 
software from Microsoft.

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In 
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.
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Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked.

If you experience this blockage, follow these steps on the desktop client.

1. Open the Windows Task-Manager and close the "rdpclip.exe" process.

2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity.

Opening the TIA portal multiple times
If you are running several applications of the TIA portal and they continually become active in 
turn, you can briefly switch to another application or use the key combination <ALT+Tab> to 
solve the problem.

Note on SD cards
The SD cards have been formatted and initialized by Siemens for use with S7-1200 modules. 
This format must not be overwritten otherwise the card will no longer be accepted by the 
S7-1200 modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job     

Note that active force jobs will be retained even after you have loaded a new project to the SD 
card. This means you should first delete the active force job before you remove an SD card 
from the CPU and before you overwrite the card in the PC with a new project. If you use an 
SD card with unknown content, you should format the SD card before the next download.

Issues when shutting down Windows XP or when activating a screen saver         
Windows XP uses the ACPI (Advanced Configuration and Power Interface) to shut down the 
computer or to go to standby mode. It can happen that while the system is processing a newly 
installed tool that the screen saver is not activated by the ACPI or that after exiting the tool 
that Windows XP cannot be shut down properly.

If the TIA Portal is running, the Standby function of the computer is deactivated. To put the 
computer into Standby, you have to first exit the TIA Portal. 

The following description shows several optional settings in the "Power Options Properties" 
you can use to set the Standby mode of the computer with the function "Hibernate":

1. In Windows XP, open the "Power Options Properties" by pointing at "Start > Settings > 
Control Panel > Power Options" and select the tab "Hibernate". Select the "Enable 
hibernation" check box.

2. Switch to the "Advanced" tab. In the "Power buttons" dialog, click the drop down list box 
under "When I close the lid of my portable computer:" and select the option "Hibernate".

3. Then click the drop-down list box under"When I press the power button on my computer:" 
and select the option "Shut down".
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4. Click "Apply" and confirm the settings with "OK".

5. Afterwards, restart the PC.

If you experience problems shutting down the computer, make sure that the TIA Portal has 
closed completely.

1. In the shortcut menu, select the Task Manager from the shortcut menu on the Taskbar.

2. If you see the process "Siemens.Automation.ObjectFrame.FileStorage.Server.exe" in the 
"Processes" tab, wait until this process has closed.

3. Then you can shut down the computer.

Subnet addressing for CP 1613 and CP 1623
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol stack 
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e. 
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is 
recommended to place both stacks of a module in the same subnet.

Editing a device IP address   
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network classes.

"TM_MAIL" instruction for TeleService     
The "TM_MAIL" instruction is not included in the scope of delivery for TIA portal V11.0. The 
information on the use and functionality of the "TM_MAIL" instruction contained in the 
information system does not apply.

Migrating projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation.

Screen display
After long periods of work, it can happen in the case of certain computer configurations with 
Windows XP that parts of the TIA Portal interface are no longer updated. Reducing the graphic 
hardware acceleration can correct this problem. You can find the setting for this by clicking on 
the desktop and selecting "Properties > Settings > Advanced > Troubleshoot > Slider Hardware 
acceleration" by means of the right mouse button. In this dialog, move the slider "Hardware 
acceleration" gradually to the left and apply this setting until the contents of the screen are 
displayed correctly again. 

Readme
2.1 General notes

WinCC Professional V11.0 SP1
System Manual, 08/2011,  27



Tablet PCs
For the TIA Portal V11, tablet PCs are only released with the operating system Windows 7, 
not with Windows XP.

SQL Server
During the installation of the SQL Server 2005 or the SQL Server 2005 Express, an error can 
occur if the product SQL Server 2008 is already installed on your system.

In order to be able to use both varieties of the SQL Server in parallel, the SQL Server 2005 
must be installed before the SQL Server 2008. To do this, follow these steps:

1. Remove the SQL Server 2008 version, without deleting the databases.

2. Install WinCC. The SQL Server 2005 is hereby installed and set up on your system.

3. Install the SQL Server 2008 again. Now you can continue to use the databases already 
created in the SQL Server 2008.

Working with automatically synchronized network drives   
Automatic synchronization after a network interruption can result in current (local) project data 
being stored as a "backup" on the network drive through user interactions. This could cause 
outdated project data to be loaded from the network drive when opening the project. For this 
reason, we do not recommend that you store TIA Portal projects on synchronized network 
drives. 

If, however, you do work on synchronized drives, you can continue working locally in the event 
of a network interruption. In this case, you must always ensure that the TIA Portal application 
is closed while data is synchronized. The synchronization itself must be implemented in such 
a way that the current (local) project data replaces the project data on the network drive. 

Entry of decimal places  
With certain Windows language settings, it may occur that the entry of values with a comma 
is not recognised (entering "1,23" leads to an error). Instead, use the international format 
("1.23").

FAQs on the TIA Portal
FAQs on the TIA Portal are available at http://support.automation.siemens.com (http://
support.automation.siemens.com/WW/view/en/28919804/133000). 

 

2.1.2 Notes on the installation

Contents 
Information that could not be included in the online help.
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Target directory of the installation
Do not use any UNICODE characters (for example, Chinese characters) in the installation path.

Installation of STEP 7 Basic V11 and STEP 7 Professional V11 under Windows XP with Turkish 
Regional and Language Options

Installation of STEP 7 Basic V11 and STEP 7 Professional V11 under Windows XP may be 
cancelled, if the regional and language options are set to Turkish. In this case change the 
regional and language options from Turkish to English or German.

1. Open the Control Panel under Windows with one of the following commands:

– "Start > Control Panel" (Start menu under Windows XP)

– "Start > Settings > Control Panel" (classic start menu)

2. Open the "Regional and Language Options".

3. Select the "Regional Options" tab.

4. Under "Standards and formats" select "German" or "English" in the drop-down list.

5. Click "Apply" and confirm with OK.

6. Restart your PC for the setting to become active. Now you can continue with the installation 
of STEP 7 Basic V11 and STEP 7 Professional V11.

7. After installation, you can revert the regional and language settings (as described in steps 
1 to 4) to Turkish.

Removing
In rare cases removal of the program can cause the computer to freeze, even when a full 
version of SQL Server 2005 is installed. In this occurs, disconnect the computer from the 
network to continue the removal process.

Installation of the SIMATIC USB driver under Windows server 2003 R2 StdE SP2
An operating system message relating to the SIMATIC USB driver is issued on the operating 
system Windows Server 2003 R2 StdE SP2. This message must be acknowledged with "Yes" 
as soon as possible after the message has been issued. The message may be in the 
background and therefore may not be immediately visible. After a certain period of time, the 
setup continues with the next component. The SIMATIC USB drivers are then not installed 
and cannot be used.

Display of the desktop icon
If you do not select the standard installation path during the installation of the TIA portal, the 
desktop icon may not be displayed correctly. This does not affect the functionality of the product.
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2.1.3 Use of communications processors

Contents
Information that could not be included in the online help.

Necessary hotfixes for the use of certain communications processors     
For the following communication processors, hotfixes are required for the use of certain 
products:

● CP 1613

● CP 1613 A2

● CP 1623

● CP 5613

● CP 5614

● CP 5613 A2

● CP 5614 A2

● CP 5623

● CP 5624

Install the following hotfixes and service packs:

● SIMATIC NET CD V8.0 SP1 for Windows 7: Hotfix 1 for SIMATIC NET CD V8.0 SP1

● SIMATIC NET CD 2008 SP3 for Windows XP, Windows Server 2003 or Windows Server 
2008

You can find the hotfixes in the Service & Support area (http://
support.automation.siemens.com/WW/view/en/12660737) of the Siemens website under the 
entry ID 12660737

Operation of communications processors 
If both STEP7 V5.5 and STEP7 V11 are installed on a computer and STEP7 V5.5 is removed, 
the setup repair function of STEP7 V11 must be executed before the following communications 
processors can be used: 

● CP 561x 

● CP 5613 A2

● CP 5614 A2 

● CP 5623

● CP 5624 

● CP 5711
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2.2 WinCC Readme

2.2.1 Functional Constraints

Functional Constraints
The following functions are already described in the information system, but are not available 
in WinCC V11.0 Professional:

1. Mobile Panel 277 IWLAN V2; Mobile Panel 277F IWLAN V2; Mobile Panel 277F IWLAN 
(RFID tag)
These devices cannot be configured with WinCC V11.

2.2.2 Notes on use

Contents
Information that could not be included in the online help.

Parallel installation in the TIA portal
You will be prevented from starting the TIA portal if you set up a non-permitted parallel 
installation of STEP 7 and WinCC.

The following parallel installations are not permitted in the TIA portal:

● STEP 7 V11 and WinCC V11 SP1

● STEP 7 V11 SP1 and WinCC V11

Both Engineering Systems must always have the same version after an installation.

A dialog opens during installation to inform you of any inconsistencies in your parallel 
installation. 

The following parallel installations are also not permitted:

● WinCC V11 and RT Advanced V11 SP1

● WinCC V11 and RT Professional V11 SP1

● WinCC V11 SP1 and RT Advanced V11

● WinCC V11 SP1 and RT Professional V11

The Engineering System and Runtime must always be of the same version after an installation.

Parallel installation of WinCC V11 and WinCC V7
Parallel installation of WinCC V11 Professional or Runtime Professional with WinCC up to 
V7.0 (including ServicePacks) is not released.
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Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the 
use of the following products/versions is permitted in accordance with paragraph 1.6 of the 
General Terms and Conditions (see also setup text):

● WinCC flexible 2008 Standard

Installation on a computer with regional setting "Turkish"
If the computer is operated with the regional setting "Turkish" at the time of the installation, 
WinCC Runtime Professional cannot be started.

Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI 
device will not automatically be connected to an existing PLC with the same name. This 
statement applies to copying within a project as well as copying across projects.     

To access the PLC tag via HMI tag in the new HMI device, you will have to complete the HMI 
configuration immediately after the copying step. Proceed as follows:

1. Open the "Devices & Networks" editor.

2. Connect the new HMI device with the desired network.

3. Open the connection table.

4. Select the HMI connection of the new HMI device.

5. Select the desired PLC under "Partner".

If you compile the new HMI device or connect additional PLC tags in between copying the HMI 
device and completing the connection, there may be some instances in which you create an 
additional HMI connection to the same PLC. This is especially true if you connect HMI tags 
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and appearance 
of screen objects, e.g. recipe view and alarm view.

Device replacement - character sets
If you have configured different character sets on screen objects for multilingual texts in the 
various project languages, you should check the screens after an HMI device replacement 
from a panel to a PC-based Runtime. The configured character sets may be changed by the 
device replacement.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... will not be supported in the new 
configuration. It will be removed" will be issued. These alarms refer to configured connections 
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of the device and are triggered, for example, if the HMI devices have a different number of 
interfaces. These connections are marked red after a device replacement. If you would like to 
continue to use these connections, you have change the configuration of the connection. 
Proceed as follows:   

1. Open the "Devices and Networks" editor.

2. Click "Network" in the toolbar of the network view.

3. Network the interface of the HMI device with the interface of the CPU.

4. Click in the tabular area of the network view on the "Connections" table.

5. Select the connection marked red.

6. Enter the new interface under "Properties > Properties > General > Interface" in the 
Inspector window.

Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object 
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time 
of the last change to the screen to change in the overview window.   

HMI device wizard
When you create a device with a color display using the HMI device wizard, the graphics of 
the navigation buttons may be displayed in black and white. This error only occurs, however, 
if the new device is created with the same name as a device with a monochrome display which 
has been deleted in the meantime.

You can avoid this error by always deleting the associated graphics in the Graphics collection 
whenever you delete a device from the project.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible.   

● With "simple copy" a WinCC flexible screen including an IO field, for example is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. With regard to tags, it functions like 
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions 
like "copy" in WinCC flexible.

If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure 
the referenced objects when using them in WinCC.
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Reports with Asian character sets on Windows CE devices
If Asian characters sets are displayed in an illegible manner in a report on a Windows CE 
device, you must change the character sets for the objects in the report. it is sufficient to change 
to a different character set and then reset the original character set.

Saving the WinCC project
If you save a project in WinCC using the "Save As…" command, this has no effect on the 
names of the Runtime projects generated for Runtime Professional. If you do not adapt the 
target path of the devices in the "Extended download to device" dialog, the Runtime projects 
on the target devices will be overwritten. Configuration changes from the original project and 
configuration changes from the newly saved project may influence each other.

Therefore, change the target path of the devices in the "Extended download to device" dialog.

Texts in the simulation
If a Runtime language which does not correspond to an installed product langauge is used in 
the simulation, system texts are shown in an installed product language. Depending on the 
operating system and the installed product languages, this will be either English or Chinese.

If you wish to see all texts in Japanese, Korean or Taiwanese in the relevant language in the 
simulation, you should first install WinCC without simulation. Then install WinCC Runtime 
Professional with the required languages.

SQL Server
During the installation of the SQL Server 2005 or the SQL Server 2005 Express, an error can 
occur if the product SQL Server 2008 is already installed on your system.

In order to be able to use both varieties of the SQL Server in parallel. the SQL Server 2005 
must be installed before the SQL Server 2008. To do this, follow these steps:

1. Remove the SQL Server 2008 version, without deleting the databases.

2. Install WinCC. The SQL Server 2005 is hereby installed and set up on your system.

3. Install the SQL Server 2008 again. Now you can continue to use the existing databases in 
the SQL Server 2008.

WinCC RT Professional and S7-1200
The use of WinCC RT Professional in conjunction with an S7-1200 CPU is not permitted.

Windows 7 and Windows 7 SP1
WinCC V11 SP1 is released for:

● Windows 7

● Windows 7 SP1
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WinCC DataMonitor
If Windows Excel reports an error, make sure that the regional settings of the operating system 
and the installed Office language match.

Invalid Runtime language
You may only select the Runtime languages for WinCC Professional that are compatible with 
the current settings on your PC. The setting is available in the Control Panel, "Regional and 
Language Options > Advanced > Languages for non-Unicode programs" dialog. 

The default font is marked as invalid if you select an incompatible Runtime language in the 
"Runtime settings > Languages & font" editor.

2.2.3 Migration

Contents
Information that could not be included in the online help.

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The display names of the alarm classes can be changed as necessary after migration.

Project languages in WinCC
WinCC V11 does not support all project languages that were available in WinCC flexible, such 
as Arabic. If you receive an empty project as the result of your migration, you may want to 
check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows:

1. Open the project with WinCC flexible.

2. Change the editing language to English, for example.

3. Save the project.

4. Restart the migration.
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Objects with object references in the project library
Two copying methods can be used in WinCC flexible. 

● With "simple copy", a WinCC flexible screen including an IO field, for example, is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. It functions like "simple copy" in 
WinCC flexible.

If you have stored objects with references to other objects in a library in WinCC flexible, you 
must reconfigure the referenced objects when using them in WinCC.

Structures with data type "Stringchar"
In WinCC V11, the data type "StringChar" is not supported in HMI user data types. 

If you have used this data type in a structure in a WinCC flexible project, an invalid element is 
created by the migration in the HMI user data type.

You have to rework this user data type in WinCC. You can only remove the invalid element if 
you assign a valid data type and release the user data type. You can then delete the element. 
However, doing this causes any interconnections present between a faceplate and the 
elements of the user data type to be lost.

Also check the offsets of the subsequent elements and change them, if required.

Tag logging archives from WinCC V7
It is not possible to use the tag logging archives from WinCC V7 after migration to WinCC V11.

See also
Object support during migration

2.2.4 Special considerations for Windows 7

Contents 
Information that could not be included in the online help.

Permission for the starting Runtime
To start WinCC Runtime Professional or WinCC Runtime Advanced, a user must be a member 
of the automatically created group, "Siemens TIA Engineer". 
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Working with standard user rights 
If you are working with standard user rights in Windows 7, "User Account Control (UAC)" cannot 
be disabled.

The "User Account Control" is enabled in Windows 7 by default.

For more information on the "User Account Control, refer to the online help for Windows 7.

Slow response from the screen keyboard and SmartServer
The following programs may start and respond very slowly under Windows 7 and Windows 
2008 servers:

● Microsoft OSK screen keyboard and HMI TouchInputPC

● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog

The delay is caused by the callback for the Internet certificate validation.

Remedy:

Locate the following files on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\ 
:

● DisableCRLCheck_LocalSystem.cmd

● DisableCRLCheck_CurrentUser.cmd

1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the 
command "Run as administrator" from the shortcut menu of the file.

2. Reboot the PC.

If the problem persists, follow these steps:

1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.

2. Reboot the PC.
 

 
 NOTICE

The callback for the certificate validation is disabled for all users or PCs. To restore the 
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd

You can find the files in the following directory of product DVD:
● Support\Windows7\CRL_Check bzw. CD_RT\Support\Windows7\CRL_Check\

 

Readme
2.2 WinCC Readme

WinCC Professional V11.0 SP1
System Manual, 08/2011,  37



2.2.5 Engineering System

2.2.5.1 Screens and Screen Objects

Contents
Information that could not be included in the online help.

Text format of output fields in alarm text
It is not possible to underline tags and text list entries.

Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm 
window and paste it in the Global Screen in Project_2.             

The enabled alarm classes are partly not enabled in the alarm window after pasting.

This behavior applies to the following display objects:

● Alarm window

● Alarm indicator

● Alarm view

Representation of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab.

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag.

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed.

If the HMI tag is interconnected with a PLC tag or a DB tag, then the locations of use of the 
interconnected PLC tag or DB tag will be displayed.     

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the 
names in the "Properties" tab.       

Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Cleared ClearScreen
Loaded GenerateScreen
Enable Activate
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Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Change Change
When a dialog is opened ONMODALBEGIN
When a dialog is closed ONMODALEND
User change PASSWORD
Screen change SCREEN
Disable Deactivate
Press Press
Outgoing Going
Incoming Coming
Limit "high limit error" violated AboveUpperLimit
Limit "low limit error" violated BelowLowerLimit
Click Click
Loop-In-Alarm LoopInAlarm
Release Release
Alarm buffer overflow OVERFLOW
Acknowledge Acknowledgement
Runtime stop Shutdown
Press key KeyDown
Release key KeyUp
Switch ON SwitchOn
Switch OFF SwitchOff
Value change Change value

Dynamization of object properties in a group
The dynamization of properties for all objects of the group which have these properties is not 
possible in a group. In WinCC V11, the properties of the objects beloning to a group can only 
be dynamized for each object itself. 

Illegible characters in Runtime Professional
With Runtime Professional, only characters belonging to the language area which is defined 
with the operating system setting "Language for non-Unicode programs" can be displayed on 
the target system. Texts with characters from other language areas can, however, also be 
configured in the project.

Illegible characters may occur in the Engineering System with the objects text field, symbolic 
I/O field, gauge and slider if the settings in the operating system relating to "Language for non-
Unicode programs" do not match the selected editing language and the objects are displayed 
in a different design than "WinCC Classic". The characters are displayed correctly in the 
Inspector window and the "Project texts" editor.

Therefore, first check in the Control Panel under "Regional and Language Options > Advanced" 
whether the setting for "Language for non-Unicode programs" is the same as the editing 
language. Otherwise, you can check or change the correct texts in the Inspector window or 
the "Project texts" editor.
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Faceplates
Faceplates cannot be rotated or mirrored.

Persistence with display objects in WinCC Runtime Professional
The objects f(t)-trend view, f(x)-trend view, alarm view, recipe view, table view and value table 
have settings for the persistence of online configurations. If you have configured "Persistence" 
for "Online configuration" and "Keep changes" for "Reaction to screen change", you can make 
changes to the configuration dialogs in runtime which will be retained after a screen change 
and after runtime is exited.

However, online configurations for the settings mentioned cause changes to the configuration 
of the objects in the Engineering System to only be applied in Runtime if you recompile the 
device with the command "Compile > Software (rebuild all)".

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime 
The default font selected in the "Runtime settings > Languages & font" editor has an effect on 
the display of texts in runtime. 

Text entries may be truncated if you selected an unfavorable font size or style.

This setting possibly has an effect on the following text entries:

● Tooltips

● long alarm text

● text in the dialogs

2.2.5.2 Tags

Contents
Information that could not be included in the online help.

Tag names
HMI tag names may not start with the character @.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated 
by the tag name. If the element of an array tag is used, then the tag name will be extended by 
the index of the array element indicated in brackets.

If a used tag is no longer included in the project, then the tag name will still be displayed at the 
location of use. The field will be displayed with a red background to indicate the missing tag. 
If a used array element or the array tag is no longer present, then only the index of the array 
element will be displayed in brackets. The tag name will not be displayed. The field is 
highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance.

Readme
2.2 WinCC Readme

WinCC Professional V11.0 SP1
40 System Manual, 08/2011,  



If you do not know which array tag was linked to this location of use, then it may be necessary 
to link the array element once again.

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically.

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer 
exist in the project, then the same behavior will take place in the "HMI tags" editor.       

Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.       

The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported. 

2.2.5.3 Alarm system and alarm displays

Contents
Information that could not be included in the online help.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.     

Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
In the engineering system, it is also possible to use multiplex tags in the output boxes of alarm 
texts. During runtime, this leads to an incorrect display of the alarm, because the use of 
multiplex tags is not supported by the basic panels.     

2.2.5.4 System functions and scripts

Contents
Information that could not be included in the online help.

Debugging using the Microsoft Script Debugger
If you want to use the Microsoft Script Debugger for debugging, the English version 
"scd10en.exe" must be used. The German version "scd10de.exe" cannot be installed.
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Runtime error on startup on TP 277 and OP 277
At the start of the runtime on a TP 277 or OP 277, the error "Global unknown error with VBScript: 
'Expected statement' in script ..". can be reported.

This error is triggered on devices with the Windows CE 3.0 operating system by user functions 
of the following type:

 
Sub VBFunction_1()
With HmiRuntime.Screens("Screen_1").ScreenItems("Button_1")
    .backcolor = vbred
    .visible = not .visible
End With
End Sub

If the error occurs, you need to re-program the user function as follows:

 
Sub VBFunction_1()
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").backcolor = vbred
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").visible = not .visible
End Sub

2.2.5.5 Recipes

Contents
Information that could not be included in the online help.

2.2.5.6 User administration

Contents
Information that could not be included in the online help.

2.2.5.7 Communication

Contents
Information that could not be included in the online help.
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Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also enable them again.   

Using "DTL" data type for area pointers
Use the "DTL" data type for configuration of area pointers "Date/time" and "Date/time PLC". 
The "DTL" data type supports time information down to the nanosecond range. Because Basic 
Panels support time information only down to the millisecond range, you will encounter the 
following restrictions in the case of use on the area pointers:       

● Area pointer "Date/time"
For transmission of time information from a Basic Panel to the PLC, the smallest unit of 
time is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" 
data type will be filled with zeros.

● Area pointer "Date/time PLC"
For transmission of time information from a PLC to a Basic Panel, the area from 
microseconds to nanoseconds will be ignored. The time information will be processed on 
the panel down to milliseconds.

Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded.

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using.

Routed communication with S7 300/400
The communication of connection partners in various subnets can be routed via the following 
links: PROFINET, PROFIBUS, MPI.

Using PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration in 
HW Config.

The following restriction applies when you use a PROFINET IO-capable CPU of the 400 series 
with one of the HMI devices listed below:

The offset for the start of the address area of the inputs must not be bigger than the offset for 
the start of the address area of the outputs.

The restriction applies to the following HMI devices:

Readme
2.2 WinCC Readme

WinCC Professional V11.0 SP1
System Manual, 08/2011,  43



● OP 177B

● OP 277

● Mobile Panel 177

For the configuration of the address parameters, open the PLC with the CPU of the 400 series 
in HW Config. Select the HMI device connected via PROFINET IO in the station window of 
HW Config. A table with the properties of the HMI device is displayed at the bottom of the 
station window in the detail view. Select the line containing the addresses of the HMI device 
in the table and open the object properties using the shortcut menu.

Select the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs 
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the communication drivers Mitsubishi MC and Mitsubishi FX do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are:

● 4-bit block

● 12-bit block

● 20-bit block

● 24-bit block

● 28-bit block

Area pointer Coordination in an OPC connection
In principle, the area pointer Coordination can be used eight times in an OPC connection. If 
you have configured an OPC connection and automatically create another OPC connection 
using "Add", the area pointer Coordination is only displayed once in the newly created 
connection. In this case, you should change the communication driver of the connection. If you 
then set OPC again as the communication driver, the area pointer Coordination can again be 
used eight times.

Communication resources: SIMATIC S7 1200         
The SIMATIC S7 1200 controller provides six communication resources for HMI 
communication.

The number of HMI connections that you can actually configure depends on the HMI devices 
that you connect with the SIMATIC S7 1200. 
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● One HMI Panel occupies one communication resource per connection.

● One RT Advanced occupies one communication resource per connection.

● One RT Professional occupies two communication resources per connection.

RT Advanced communication via Station Manager (SIMATIC NET) with a SIMATIC S7 1200
For routed communication of a SIMATIC S7 1200 with a PC with WinCC RT Advanced, the 
following restrictions apply for the PC:

● Windows 7: Only with installed SIMATIC NET 8.1

● Windows XP: Communication via Station Manager (SIMATIC NET) is not supported

These restrictions also apply if you are using WinAC MP or Station Manager. Connections with 
the help of the Station Manager of Runtime Advanced are always treated as routed 
connections.

Valid operand types for communication with Mitsubishi MC TCP/IP
Operand type "W" is not available for the "String" data type.

Communication between S7-1200 and a multi panel
Communication between an S7-1200 and a multi panel with the "WinAC MP" option installed 
via ProSave is not possible. The data types affected are:

● SIMATIC MP 177 6" Touch

● SIMATIC MP 277 8" Touch

● SIMATIC MP 277 8" Key

● SIMATIC MP 277 10" Touch
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● SIMATIC MP 277 10" Key

● SIMATIC MP 377 12" Touch

● SIMATIC MP 377 12" Key

● SIMATIC MP 377 15" Touch

● SIMATIC MP 377 19" Touch

2.2.6 Compiling and loading

Contents
Information that could not be included in the online help.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device.

Saving the WinCC project
If you save a project in WinCC using the "Save As…" command, this has no effect on the name 
of the Runtime projects generated for the devices. If you do not adapt the target path of the 
devices in the "Extended download to device" dialog, the Runtime projects on the target 
devices will be overwritten.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used.

To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the "Load" 
button the changed settings are saved.

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and 
Tools > HMI Tools > SIMATIC ProSave".
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Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.     

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software" 
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will 
not be checked. If you want to ensure that the address parameters are checked as well, you 
will have to compile the HMI device in the "Devices & Networks" editor of the toolbar.   

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other. 

If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.     

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute.

     

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel. 

If you activate the option "Show all accessible devices", it may occur that the application stops 
responding.   

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel.

If this happens, stop Runtime and manually set the transfer mode on the HMI device.       

Loading a SIMATIC HMI application to a PC station
The following circumstances can lead to an error message during the first load of a SIMATIC 
PC station:
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● A SIMATIC HMI application is configured in a PC station in the project

– WinCC Runtime Advanced

– WinCC Runtime Professional

– WinCC Standby

– or WinCC Client

● The property "S7RTM is installed" is activated.

Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT 
(WinCC...) in the project navigation. Open the "Extended download to device" dialog and select 
the appropriate interface and parameter settings. Click "Load".

You then load the PC station as normal.     

Unpacking a distributed "Pack&Go" file
To unpack a "Pack&Go" file which is distributed over several files, you need an unpack 
program. The unpack program integrated in the operating system is not adequate to unpack 
distributed files.

 

2.2.7 Runtime

2.2.7.1 Notes on operation in Runtime

Contents
Information that could not be included in the online help.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, the end user is responsible for the security of his data 
network. The proper functioning of the device cannot be guaranteed in all circumstances; 
targeted attacks, for example, can lead to overload of the device.

 

Special characters in the user view
Special characters, such as / " § $ % & ' ?, are not permitted when entering a name or the 
password in the user view.     

Language behavior - Layout of screen keyboard
The layout of the screen keyboard is not switched when the runtime language changes.     
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Tag values overwrite the maximum length     
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
number of configured tags, the character string will be shortened to the configured length.

2.2.7.2 Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help.

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.  

2.2.7.3 Notes on operation of Runtime Advanced

Contents
Information that could not be included in the online help.

.Net-Controls in Runtime
If you have incorporated a .Net Control in your project as "Specific .Net-Control", you have to 
copy the files belonging to these controls to the installation directory of WinCC Runtime, e.g. 
"C:\ProgramFiles\Siemens\Automation\WinCC RT Advanced". Otherwise, the control cannot 
be loaded in Runtime.

2.2.7.4 Notes on operation of Runtime Professional

Contents
Information that could not be included in the online help.
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User authorizations within the operating system
1. All user must be added to the "SIMATIC HMI" user group. This also applies to users who 

want to open WinCC projects remotely.

2. The storage folders of the projects must have the NTFS authorizations "SIMATIC HMI" with 
full access and "SIMATIC HMI Viewer" with read access. The authorizations must be 
inherited for all subordinate objects.

3. Members of the Windows user group "SIMATIC HMI" should not simultaneously be 
members of the Windows user group "SQLServer2005MSSQLUser$<Computername>
$WINCC". The members of this group have administrator rights to the SQL server. 
Therefore remove all Windows users from this group for whom restricted access to the 
WinCC database is sufficient.

Windows 7 / Windows Server 2008: Locking key combinations
If you want to lock key combinations under Windows 7 or Windows Server 2008, you must 
change the group policies in the administrative tools of the operating system

A detailed description of this can be found in the FAQ with the entry ID "44027453" in the 
SIMATIC Customer Online Support:

Internet: WinCC FAQ 44027453 (http://support.automation.siemens.com/WW/view/en/
44027453) 

Fault in the connection between the server and the client
If the connection between the server and client is faulty, check the settings of the PG/PC 
interface. TCP/IP(Auto) should not be used for the "Interface Parameter Assignment Used". 
Used fixed IP addresses instead.

Fault in the connection between the server and the client
If the computer is simultaneously used as a server with the Engineering System and a client 
cannot establish the connection to the server, you should check the releases set on the server.

1. Exit Runtime on the server.

2. Select the command "Find computer..." in the shortcut menu of the network environment 
on the desktop of the server.

3. Enter the name of the server as the computer to be found.

4. Open the computer found to recognise the released directories.

5. Remove all the releases that begin with "WinCC_Project_HMI". Information on this is 
available in the documentation for the operating system.

This malfunction is caused by the use of the command "Save as..." in conjunction with the 
startup of the Runtime of this new project. You can make copies of the projects for backup 
purposes using the "Save as..." command. You should, however, continue to work with the 
original project.
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Language setting for Runtime Professional
With Runtime Professional, illegible texts may occur during runtime if the settings in the 
operating system for "Language for non-Unicode programs" do not match the selected Runtime 
language. This setting must also be the same on the client and the server for client/server 
applications.

Therefore, first check in the Control Panel under "Regional and Language Options > Advanced" 
whether the setting for "Language for non-Unicode programs" is the same as the Runtime 
language. 

Starting WinCC Runtime Professional
If Engineering System and Runtime are operated on a computer, Runtime or simulation for a 
project opened in the engineering system should only be started and ended via the TIA portal. 
Other options, for example, the symbol in the taskbar information area, should not be used.

Setting the services for the SQL server
In order to ensure the full functionality of the SQL server for WinCC and WinCC Runtime, you 
have to check the SQL server settings.

1. Start "Programme > Microsoft SQL Server 2005 > Configuration Tools > SQL Server 
Configuration Manager" in the start menu.

2. Click "SQL Server 2005 Services" in the tree.

3. Check the services "SQL Server (WinCC)","SQL Server (WINCCPLUSMIG)" and "SQL 
Server Browser". "Automatic" must be entered for "Start Mode". "LocalSystem" must be 
entered for "Log On As". Change the settings, if necessary.

4. Click "SQL Server Network Configuration" in the tree.

5. Click "Protocols for WinCC".

6. Check the "TCP/IP" protocol. "Enabled" must be entered for "Status". Change the settings, 
if necessary.

WinCC RT Professional and S7-1200
The use of WinCC RT Professional in conjunction with an S7-1200 CPU is not permitted in 
productive operation.

"Report system error" in WinCC Runtime Professional
The "Report system error" functionality is limited in WinCC Runtime Professional in conjunction 
with an S7-300 or S7-400. In an alarm view, only one alarm is ever displayed for each 
diagnostics type. Alarms on other errors of the same diagnostics type are not displayed.
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2.2.8 HMI devices

2.2.8.1 General notes

Contents
Information that could not be included in the online help.

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status 
after interruption of the transfer is not defined.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the Engineering 
System and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface".

1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.

3. Select the interface in the "Interface Parameter Assignment Used" area.

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records. 

You may encounter inconsistencies if you have altered the structure of the recipe in the 
Engineering System and the device already held recipe data records.

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.       
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Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0.

USB device driver under Windows XP
If a configuration PC with Windows XP and a Comfort Panel are connected via USB, the S7-
USB driver may be reinstalled when the HMI device is restarted. The device settings may in 
this case not be restored.

 

2.2.8.2 Printing via print server

Introduction
Print servers enable access to network printers.  Print jobs are routed to a corresponding printer 
via the print server.     

 

 Note

Printing takes place via the print server for the following HMI devices:
● xP 177, Mobile Panel 177
● xP 277, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
● Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN 

(RFID Tag)
● MP 377
● PC with WinCC Runtime Advanced

 

Requirements
● The print server deploys the "RAW" mode.

 

  Note

For additional information on settings, refer to the relevant print server documentation.
 

● The device is interconnected via Ethernet with the print server or with a printer featuring an 
integrated print server.

● External print servers are interconnected with a printer via USB port.

● The IP address and port used are identical in the "Printer Properties" of the HMI device and 
on the print server.
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Procedure
1. Open the "Control Panel" on your HMI device.

2. Select "Printer". The "Printer Properties" dialog box opens.

3. Select a printer from the "Printer Language" selection list.

4. Select the "PrintServer" entry from the "Port" selection list.

5. Enter the IP address and the port used for communication with the printer in the "IP:Port" 
input field.

 

  Note

Use the ":" character as delimiter between the IP address and the port number. For 
example: "192.168.56.23:9100".

 

6. Select any additional printer settings.

2.2.9 Add-ons

2.2.9.1 DataMonitor

Contents
Information that could not be included in the online help.

Special considerations for Windows 7
Time- or event-triggered Excel Workbooks are not released under the Windows 7 operating 
system.

Opening Excel workbooks
If you open an Excel workbook from the DataMonitor client, Excel may issue the error message 
"File not found". If this happens, proceed as follows:

1. Confirm the error message with "OK".

2. Leave Excel open.

3. Open the Excel workbook again in Internet Explorer.

Readme
2.2 WinCC Readme

WinCC Professional V11.0 SP1
54 System Manual, 08/2011,  



Opening Excel workbooks with Excel 2010
Due to safety settings, the automatic connection of an Excel workbook with the server does 
not work in Excel 2010.

If you wish to enable automatic connection, deactivate the setting "Enable Protected View for 
files located in potential unsafe locations" in Excel 2010 under "Files > Options > Trust Center 
> ProtectedView".

2.2.9.2 WebNavigator

Contents
Information that could not be included in the online help.

Installation instructions
The installation instructions for the Web Navigator are part of the installation instructions of 
WinCC Runtime Professional. They can be found on the DVD of WinCC Runtime Professional.

Access via Web client
A user can only get access via a Web client if a screen released for Web access has been 
assigned to him as the start screen in the user administration.

To release a screen for Web access:

1. Select the "Properties" command in the shortcut menu of a screen.

2. Activate the "Web access" option under "Properties > Web access".

To assign a start screen to a user:

1. In the user administration, select the user to whom you would like to assign a start screen.

2. Click "Properties > General" > Web options > Settings in the Inspector window to specify 
a start screen. You can only select screens which have been released for Web access.
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Installation 3
3.1 System requirements for installation

3.1.1 Notes on the system requirements

System requirements for individual products  
The system requirements may differ depending on the products you want to install. You should 
therefore check the individual system requirements of your products.

If you want to install several products, make sure that your system meets the demands of the 
product with the highest requirements.

Displaying PDF files
To be able to read the supplied PDF files, you require a PDF reader that is compatible with 
PDF 1.7 e.g. Adobe (R) Reader version 9.

Displaying the Welcome Tour
You require the Adobe (R) Reader as of version 9 to start the Welcome Tour for the TIA portal.

 

See also
Licenses (Page 71)

Starting installation (Page 73)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)
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3.1.2 WinCC Professional system requirements

3.1.2.1 Software and hardware requirements

Introduction
Specific requirements for the operating system and software configuration must be met for the 
installation.

 

 Note

WinCC is generally authorized for use in a domain or workgroup.

However, be aware that domain group policies and restrictions of the domain may hinder the 
installation. In this happens, remove the computer from the from the domain prior to installing 
Microsoft Message Queuing, Microsoft SQL Server and WinCC. Log onto the computer in 
question locally with administrative rights. Then perform the installation. After successful 
installation, you can enter the WinCC computer back into the domain. If the domain group 
policies and restrictions of the domain do not impede the installation, the computer need not 
be removed from the domain during the installation.

Be aware that domain group policies and restrictions of the domain may also hinder operation. 
If you cannot avoid these restrictions, run the WinCC computer in a workgroup.

Consult with the domain administrator if needed.
 

Installation requirements
The following table shows the minimum software and hardware requirements that have to be 
met for installation of the "SIMATIC WinCC Professional" software package:   

Hardware/software Requirement
Processor type Pentium M, 1.6 GHz or similar
RAM 2 GB
Free hard disk space 2 GB on system drive "C:"
Operating systems * ● Windows XP Professional SP3

● Windows 7 (Professional, Enterprise, Ultimate)
● Windows 7 SP1 (Professional, Enterprise, Ultimate)
● Windows Server 2003 R2 Standard Edition SP2
● Windows Server 2008 Standard Edition SP2

Graphics card 32 MB RAM 
24-bit color depth

Screen resolution 1024x768
Network Ethernet 10 Mbps or faster
Optical drive DVD-ROM
Software Microsoft .Net Framework 3.5 SP1

Microsoft Windows Message Queuing
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* For more detailed information on operating systems, refer to the help on Microsoft Windows 
or the Microsoft homepage. 

Simultaneously opening multiple instances of WinCC on a configuration PC can also increase 
the hardware capacity required.

 

 Note
"Aero Glass Style" of Microsoft Windows 7

A powerful graphics card is required for "Aero Glass Style". It requires DirectX9 capabilities 
and 128 MB of dedicated graphics memory.

The performance of the architecture of the graphics system can significantly influence the 
performance of WinCC.

 

Recommended hardware
The following table shows the recommended hardware for the operation of SIMATIC WinCC.

Hardware Requirement
Computer SIMATIC FIELD PG M2 PREMIUM
Processor 2.2 GHZ CORE 2 DUO (T7500)
RAM 1X2GB DDR2 RAM
Hard disk 250GB S-ATA HDD
Monitor 15" SXGA+ DISPLAY (1400 X 1050)
Optical drive DL MULTISTANDARD DVD RW

Parallel installation of WinCC V11 and other SIMATIC products
The parallel installation of WinCC V11 is permitted with the following other SIMATIC 
products   

● WinCC Basic V11, WinCC Comfort V11 or WinCC Advanced V11 can be installed on a 
computer parallel to STEP 7 V5.4 or V5.5, STEP 7 Micro/WIN, STEP 7 10.5, WinCC flexible 
(as of 2008) and WinCC (as of V7.0 SP2).
When WinCC V7 is removed, the Setup for WinCC V11 should be run and a repair 
performed for the installation.

● WinCC Professional V11 can be installed on a computer parallel to STEP 7 V5.4 or V5.5, 
STEP 7 Micro/WIN, STEP 7 10.5 and WinCC flexible (as of 2008).

Installing Microsoft .Net Framework
.Net Framework 3.5 SP1 is included on the installation medium. The installation routine 
determines if .Net Framework is already installed at the beginning of the installation. If .Net 
Framework is not installed, you will be prompted with a dialog to perform the installation. When 
you confirm the prompt for installation, .Net Framework is installed. You need to reboot the 
computer after installing .Net Framework. If you do not install .Net Framework, the installation 
of WinCC Runtime Professional is aborted.

Installation
3.1 System requirements for installation

WinCC Professional V11.0 SP1
System Manual, 08/2011,  59



Installing Microsoft Windows Message Queuing
You can install the Windows Message Queuing component from the Windows Control Panel. 

Under Windows XP
Click Start > Control Panel. Double-click "Add or remove software", the "Add or remove 
software" dialog opens. In the "Add or Remove Programs" dialog, click "Add or Remove 
Windows Components". The Windows Components Wizard opens. Select the "Message 
Queuing" component in the Windows Components Wizard. Click "Next", the "Message 
Queuing" component is installed.

Under Windows 7
Click Start > Control Panel. Click "Programs" and the "Programs" dialog opens. Under the 
"Programs and Features" section, click "Turn Windows features on or off". The "Windows 
Features" dialog opens. In the "Windows Features" dialog, select the "Microsoft Message 
Queue Server" feature. Click "OK" to enable the "Microsoft Message Queue Server".

Online help for Windows 7 / Windows Server 2008
Windows 7 and Windows Server 2008 no longer support all online help formats by default. 
With WinCC, these online help formats are used in the following cases:

● Calling WinCC Direct Help

● Calling the WinCC Information System from the WinCC editors or via the Direct Help links

Opening Direct Help
To be able to continue calling WinCC Direct Help, the following components are installed during 
the installation of WinCC:

● Microsoft Help Engine

Calling the "WinCC Information System" online help
You can also call the WinCC Information System under Windows 7 and Windows Server 2008 
from the Windows Start menu or from the installation folder.

To call the WinCC Information System from the WinCC editors or via the Direct Help links, 
some changes have to be made to the operating system. You can find more information on 
this in the section "More information for advanced users" of Microsoft Support article "917607": 
http://support.microsoft.com/kb/917607 (http://support.microsoft.com/kb/917607) 

See also
Options for WinCC Engineering and Runtime systems (Page 61)

Licensing of WinCC Engineering System (Page 63)
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3.1.2.2 Add-ons

Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional add-ons allow you to extend the functionality in some cases to increase the range 
of available tasks.

Add-ons for Comfort Panels, Mobile Panels, Multi Panels
The following add-ons are available for Comfort Panels, Mobile Panels, and Multi Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Advanced
The following add-ons are available for WinCC Runtime Advanced:

● WinCC SmartServer (remote operation)

● WinCC Recipes (recipe system)

● WinCC Logging (logging of process values and alarms)

● WinCC Audit (audit trail for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Professional
WinCC Runtime Professional contains the following components, which you can activate with 
the appropriate license:

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC Logging (logging system, previously WinCC/TagLogging)

You can select and install the following add-ons in the installation dialog:
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● WinCC Client (standard client for building multiple-station systems)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)
 

  Note

In contrast to WinCC V7, functions from the WinCC / OPC Server add-ons have been 
incorporated into the basic functionality. Likewise, the basic functionality includes the 
Runtime API from WinCC /ODK.

 

In addition to the Runtime add-ons, you can also expand WinCC Runtime Professional with 
custom controls. The WinCC ControlDevelopment add-on is required to develop controls.

See also
Software and hardware requirements (Page 58)

Installing and uninstalling options (Page 62)

Installing and uninstalling options

Introduction
Some add-ons are included in standard WinCC installation and are installed automatically.

During the installation of WinCC Engineering System, the following add-ons are available for 
you to select for installation:

● Simulation for WinCC Runtime Advanced

● Simulation for WinCC Runtime Professional

During the installation of WinCC Runtime Professional, the following add-ons are available for 
you to select for installation:

● SIMATIC WinCC Web Navigator

● SIMATIC WinCC Data Monitor

● SIMATIC Logon

You must enable all the necessary add-ons for use.
 

 Note

Each add-on requires a license. You activate an add-on by installing the appropriate license 
key.

 

Installation
3.1 System requirements for installation

WinCC Professional V11.0 SP1
62 System Manual, 08/2011,  



Add-ons for non-PC-based HMI devices
The required Runtime add-ons are installed on the HMI device as follows:       

● During the transfer of the project to the HMI device
Add-ons that are no longer required are removed automatically.

● With ProSave

Procedure - activating add-ons
To activate an add-on for use, install the appropriate license key using the Automation License 
Manager.

In order to backup the license key of an add-on or use it on a different configuration PC or HMI 
device, you must uninstall this license key using the Automation License Manager.

 

 NOTICE

When no valid license key is installed on a PC with WinCC Runtime, Runtime runs in Demo 
mode.

 

See also
Options for WinCC Engineering and Runtime systems (Page 61)

3.1.2.3 Licenses and Powerpacks

Licensing of WinCC Engineering System
You require a license key for the following:

● WinCC Engineering System, for example, WinCC Professional

● Add-ons for WinCC Engineering System

You can install the license key during the installation of WinCC. You transfer the licenses for 
WinCC add-ons after installation with the Automation License Manager.

Starting without a valid license key   
If you start WinCC without a valid license, the system alerts you that you are working in non-
licensed mode. You have the one-time option of activating a trial license. Trial licenses for 
Engineering editions WinCC Basic, Comfort, Advanced und Professional expire after 21 days.

If the trial license expires, the following scenarios can occur:
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● WinCC was never licensed on the PC in question.

– Operations requiring a license can no longer be performed in WinCC.

● WinCC was already licensed on the PC in question.

– An alert for non-licensed mode is presented every 10 minutes and for every action 
requiring a license by a window requiring acknowledgment.

License requirements for simulation
When you want to start simulation in WinCC using the menu command "Online > Simulation> 
With tag simulator", you do not need licenses for WinCC Runtime or licensed-based add-ons.

If the following conditions are met, you also need the appropriate licenses for the simulation 
of WinCC Runtime and license-based add-ons:

● The engineering station is connected to a PLC.

● The connection to the PLC is configured and active.

● You start the simulation with the "Online > Simulation > Start" menu command.

See also
Software and hardware requirements (Page 58)

Licensing WinCC Runtime on PC-based HMI devices (Page 64)

Licensing of HMI devices (Page 65)

Working with license keys (Page 66)

Licensing WinCC Runtime Professional Asian (Page 69)

Powerpack (Page 70)

Installing a Powerpack (Page 71)

Licensing WinCC Runtime on PC-based HMI devices
With PC-based HMI devices, you require a license key for the following:

● WinCC Runtime with 128 tags, for example.

● WinCC add-ons

You can install the license key for WinCC Runtime during the installation of WinCC. You 
transfer the licenses for WinCC add-ons after installation with the Automation License Manager.

 

 Note

Only the Certificate of License for WinCC Runtime V11 authorizes operation of WinCC 
Runtime V11.

 

The appropriate new license is required to license WinCC Runtime.

You can upgrade the runtime licenses of WinCC flexible 2008 and WinCC V7 with an upgrade 
to WinCC Runtime V11.
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Productive operation of the software is only allowed with a valid Certificate of License that 
matches the version listed on it.

Non-licensed mode  
WinCC Runtime and the Runtime add-ons can be used freely without license. An alert for non-
licensed mode is presented every 10 minutes by a window requiring acknowledgment.

 

See also
Licensing of WinCC Engineering System (Page 63)

Licensing of HMI devices
Non-PC-based HMI devices are always equipped with the maximum quantity structure. A 
license key is not required for runtime operation.   

A license is required for each option for non-PC-based HMI devices. The license key of the 
respective license always activates one instance for use.

License key
To be able to license non-PC-based HMI devices with license keys you require the "SIMATIC 
HMI License Manager Panel Plugin" add-on.  

WinCC Setup installs this add-on by default. You can open the License Manager Panel plug-
in in the Automation License Manager with the menu command "Edit > Connect Target System 
> Connect HMI Device".

If WinCC is not installed, an installation of ProSave 7.2 or higher is required.
 

 Note

Further information about handling the licenses can be found in the Automation License 
Manager help.

 

 Note

Verify that the current release of the operating system is installed on the HMI device before 
you start licensing. If necessary, update the operating system using ProSave.
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Data backup
 

 CAUTION

Destruction of License Keys on non-PC-based HMI Devices

The authorizations and License Keys you installed are destroyed by back-up / restore 
processes on the HMI devices listed below.   
● 270 series
● 370 series

Carry out the following before beginning with restoring:
● Use the Automation License Manager and ProSave to check whether license keys are 

installed on the HMI device.
● Remove any license keys present on the HMI device.

After restoring has been carried out, re-install the license keys on the HMI device.
 

Non-licensed mode  
In particular, runtime options can also be used without a license. Non-licensed mode is 
indicated every 10 minutes by a window, which you must acknowledge.

See also
Licensing of WinCC Engineering System (Page 63)

Working with license keys

Introduction
Install a license key in the following situations:

● To use the WinCC Engineering System

● To use add-ons for the WinCC Engineering System

● To operate WinCC Runtime

● To use add-ons for WinCC Runtime on PC-based HMI devices

● To use add-ons on non-PC-based HMI Devices

To uninstall a license key in the following cases:

● When backing up data

● If you no longer require the license

You can then use this license on another PC or HMI device.    
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When you install a license, the associated license key is removed from the license key storage 
location.

 

 Note

A license key cannot be copied. The copy protection employed prevents the license keys 
from being copied.

 

Data backup
Remove the license keys on the HMI device when backing up data on the HMI device and 
when creating a backup during device replacement. 

You use the Automation License Manager to back up license keys of a HMI device to the 
storage area of the license key. 

 

 CAUTION

Destruction of license keys on non-PC-based HMI devices

Installed license keys are destroyed by backup/restore processes on the HMI devices listed 
below.  
● 270 series
● 370 series

Carry out the following before beginning restoring:
● Use the Automation License Manager and ProSave to check whether license keys are on 

the HMI device.
● Remove any license keys present on the HMI device.

After restoring has been carried out, re-install the license keys on the HMI device.
 

 CAUTION

Destruction of license keys on PCs

Start by removing all license keys in the following situations:
● Before you format the hard disk
● Before you compress the hard disk
● Before you restore the hard disk
● Starting an optimization program that moves fixed blocks
● Installing a new operating system

Read the description of Automation License Manager ("Start > Simatic Automation > 
Documentation"). Observe all warnings and notices.

 

The license key storage location on PC-based HMI devices and on non-PC-based HMI devices 
where Automation License Manager is used may contain multiple license keys. This capability 

Installation
3.1 System requirements for installation

WinCC Professional V11.0 SP1
System Manual, 08/2011,  67



means you can store multiple licenses of the same type at one location. Save all license keys 
of the HMI device to the same storage location.

 

 CAUTION

Always keep the original storage location of the license keys.
 

Invalid license after time zone change  
The installed license no longer functions in the following case.

● If you change the time zone on a WinCC PC as follows:

– From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To avoid this inconvenience, uninstall the license key under the time zone setting that was set 
when the license key was installed.

Example: 

You have installed the license key with a time zone setting based on a full hour. Then also 
uninstall the license key with a time zone setting based on a full hour.

This behavior does not apply to the trial license.

Defective license   
A license is defective in the following cases:

● If the license key is no longer accessible at the storage area.

● If the license key disappears during its transfer to the destination drive.

You can use the Automation License Manager to repair the defective license. Use the "Restore" 
function or the "Restore Wizard" of the Automation License Manager for this purpose. Contact 
Customer Support in order to restore the license. For additional information see: http://
support.automation.siemens.com (http://support.automation.siemens.com)

 

 Note

The runtime software can also be operated without errors if the license is missing or defective. 
The system alerts you at brief intervals that you are working in non-licensed mode.
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 CAUTION

If you start WinCC Engineering System without a valid license key, the system alerts you that 
you are working in non-licensed mode. You have the one-time option of activating a trial 
license. The trial license expires after 21 days.

When the trial license expires, the following scenarios can occur:
● WinCC was never licensed on the PC in question.

WinCC can no longer be started.
● WinCC was already licensed on the PC in question.

WinCC cannot be started. An alert for non-licensed mode is presented every 10 minutes 
by a window requiring acknowledgment.

 

See also
Licensing of WinCC Engineering System (Page 63)

Licensing WinCC Runtime Professional Asian

Introduction    
If you are using WinCC Runtime Professional in an Asian language, a dongle is additionally 
used for the validation of the required license. The dongle comes in the form of a certified USB 
stick together with the required license key for WinCC Runtime Professional Asian. The license 
key is stored on the certified USB flash drive. 

The following Asian languages are protected by a dongle:

● Chinese Simplified

● Chinese Traditional

● Japanese

● Korean

Using the dongle for an Asian Runtime Professional
The following is required to operate WinCC Runtime Professional in an Asian language:

● The language for programs that do not support Unicode is set to the appropriate Asian 
language in the operating system of the machine running WinCC Runtime.

● The runtime language of the WinCC project is set to the Asian language.

If the above conditions are met, the validation is performed by querying the license key and 
also by querying the dongle.

In order to successfully license a WinCC project in an Asian language, transfer the required 
license key from the certified USB stick to the HMI device using the "Automation License 
Manager". Plug the USB into the USB port of the HMI device. The USB stick acts as a dongle 
during runtime. The dongle must always remain plugged in the USB port in during runtime.

If you remove the dongle during runtime, WinCC Runtime switch to Demo mode.
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The USB sticks supplied for the Asian markets are certified for permanent use in production. 
Therefore, you cannot transfer or copy the content to another disk or USB medium. If you lose 
the certified USB stick or it becomes defective, you need a new, certified USB stick.

Simulation of a WinCC project in an Asian language
If you want to check a WinCC project in an Asian language with the simulator, the appropriate 
Asian language must also be set in the operating system on the configuration PC for programs 
that do not support Unicode. You then also need a certified USB stick as dongle for the 
simulation. If no dongle is available, the simulation runs in Demo mode.

See also
Licensing of WinCC Engineering System (Page 63)

Powerpack

Introduction  
The following upgrades can be performed with a Powerpack:

● From a smaller to a larger edition of WinCC

● On a runtime system with greater capacity

A Powerpack also includes a special license using which you can at any time activate a higher 
level of WinCC for use.

Engineering system  
You own WinCC Advanced, for example. You can use the "SIMATIC WinCC Professional 
Powerpack WinCC Advanced -> WinCC Professional 512 PowerTags V11 " Powerpack to 
activate WinCC Professional with 512 tags for use.

Runtime  
You own WinCC Runtime Professional with 128 tags, for example. You can use the "SIMATIC 
WinCC Runtime Professional Powerpack 128 PowerTags -> 512 PowerTags V11" Powerpack 
to increase the capacity from 128 to 512 tags.

You own WinCC Runtime Advanced with 128 tags, for example. You can use the "SIMATIC 
WinCC Runtime Professional Powerpack Runtime Advanced 128 PowerTags -> Runtime 
Professional 128 PowerTags V11" Powerpack to activate WinCC Runtime Professional with 
128 tags for use.

See also
Licensing of WinCC Engineering System (Page 63)
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Installing a Powerpack

Introduction
Install a Powerpack by transferring the corresponding license key. The Powerpack license key 
replaces the license key of an existing installation.    

Requirement
● The conditions described in the "System requirements" section must be fulfilled.

● WinCC is installed.

● The license key for the license for which you have purchased a Powerpack is available on 
the PC.

Installing a Powerpack
1. Transfer the purchased Powerpack license key using the Automation License Manager.

Result
The Powerpack license key replaces the former license key. You cannot reverse this process.

See also
Licensing of WinCC Engineering System (Page 63)

3.2 Licenses

Availability of licenses   
The licenses for the products of the TIA Portal are usually supplied on the installation data 
medium and installed automatically by the Automation Licence Manager  during the installation 
process of the TIA Portal. 

If you remove the TIA Portal, the corresponding licenses are also removed automatically. 
Licenses still required should be secured. 

Provision of the Automation License Manager
The Automation License Manager  is supplied on the installation data medium and is 
transferred automatically during the installation process. 

If you remove the TIA Portal, the Automation License Manager  remains installed on your 
system.
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Working with the Automation License Manager
The Automation License Manager is a product of Siemens AG, which is used for handling 
license keys (technical representatives of licenses). 

Software products that require license keys for operation, such as the TIA-Portal, register the 
required license key automatically with the Automation License Manager . If the Automation 
License Manager finds a valid license key for this software, the software can be used according 
to the license usage terms associated with this license key.

 
 

 Note

For additional information on how to manage your licenses with the Automation License 
Manager , refer to the documentation supplied with the Automation License Manager .

 

See also
Notes on the system requirements (Page 57)

Starting installation (Page 73)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)

Installation log (Page 72)

3.3 Installation log

Function of the installation log  
The progress during the following installation processes is logged in a file:

● Installing products

● Modifying or updating already installed products

● Repairing an existing installation

● Uninstalling products

If errors occur during the installation process or warnings are issued, these can be evaluated 
with the help of the log file. You can do this yourself or contact product support. 

Installation logs storage location
The log file is the most recent file with the file extension ".log" and whose name begins with 
"SIA", e.g. "SIA_STEP7_PRO_V11.log".
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The location of the log file is stored in the environment variable "%autinstlog%". You can enter 
this environment variable in the address bar of Windows Explorer to open the folder with the 
log files. Alternatively, you can navigate to the corresponding directory by entering "CD 
%autinstlog%" in the command line. 

The location depends on the operating system, e.g. "C:\Documents and Settings\All Users
\Application Data\Siemens\Automation\Logfiles\Setup" in the English version of Windows XP. 

Setup_Report (CAB file)
To make it easier to provide Product Support with all necessary files, an archive file that 
contains the installation log and all other required files is saved in CAB format. This archive 
can be found at "%autinstlog%\Reports\Setup_report.cab". Send this CAB file to Product 
Support if you need assistance with installation. With this information, Product Support can 
determine whether the installation was executed properly. CAB files that were generated 
during earlier installation processes are saved with a date ID in the "Reports" directory. 

See also
Licenses (Page 71)

Starting installation (Page 73)

Installing Support Packages (Page 75)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)

3.4 Starting installation

Introduction  
Software packages are installed automatically by the setup program. The setup program starts 
once the installation medium has been inserted in the drive. 

Requirement
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.
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Procedure
To install the software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the product languages opens.

6. Select the languages for the product user interface, and click the "Next" button.
 

  Note

"English" is always installed as the basic product language.
 

The dialog for selecting the product configuration opens.

7. Select the products you want to install:

– If you wish to install the program in a minimal configuration, click on the "Minimal" button.

– If you wish to install the program in a typical configuration, click on the "Typical" button.

– If you wish to personally select the products to be installed, click on the "User-defined" 
button. Then select the check boxes for the products you wish to install.

8. If you want to create a shortcut on the desktop, select the "Create desktop shortcut" check 
box.

9. Click the "Browse" button if you want to change the target directory for the installation. Note 
that the length of the installation path must not exceed 89 characters.

10.Click the "Next" button.
The dialog for the license terms opens.

11.To continue the installation, read and accept all license agreements and click "Next".
If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

12.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

13.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking on "Next".
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14.Click the "Install" button.
Installation is started. 

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

15.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

16.If the computer does not reboot, click "Exit".

Result
The TIA Portal along with the products and licenses you have ordered and the Automation 
License Manager have been installed on your computer. 

See also
Installation log (Page 72)

Notes on the system requirements (Page 57)

Licenses (Page 71)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)

3.5 Installing Support Packages
You can install subsequent support packages, for example, hardware support packages, in 
the TIA Portal.

 

 Note

Support packages for STEP7 V5.4 or V5.5 cannot be used.
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Procedure     
To install a Support Package, follow these steps:

1. Click "Support packages" in the "Options" menu.
The "Detailed information" dialog opens. A table lists all support packages from the directory 
that you selected as the storage location for support packages in the settings.

2. If you want to install a support package that is not in the list, you have the following options:

– If the support package is already on your computer, you can add it to the list by selecting 
"Add from the file system".

– If you add a support package from the "Service & Support" page on the Internet, first 
you download it by selecting "Download from the Internet". Then you can add it from 
the file system.

3. Select the support package that you want to install.

4. Click "Install."

5. Close and then restart the TIA Portal.

See also
Installation log (Page 72)

3.6 Displaying the installed software
You can find out which software is installed at any time. In addition, you can request additional 
information on the installed automation software to be displayed.

Procedure  
To display an overview of the software installed, follow these steps:

1. Click "Installed software" in the "Help" menu.
The "Installed software" dialog opens. You will see the installed software products in the 
dialog. Expand the entries to see which version is installed in each case.

2. If you would like to display additional information on the installed automation software, click 
the link on the "Detailed information about installed software" dialog.
The "Detailed information" dialog opens.

3. Chose the topic you want more information about in the area navigation.
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See also
Notes on the system requirements (Page 57)

Licenses (Page 71)

Starting installation (Page 73)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)

Installation log (Page 72)

3.7 Modifying or updating installed products
You have the option to modify installed products using the setup program or to update to a 
new version.

Requirement   
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To modify or update installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Modify/Upgrade" option button and click the "Next" button.
The dialog for selecting the product languages opens.
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7. Select the check boxes of the product languages that you want to install. You can remove 
previously installed product languages by clearing the corresponding check boxes.

 

  Note

Note that the product language "English" cannot be removed.
 

8. Click the "Next" button.
The dialog for selecting the product configuration opens.

9. Select the check boxes of the components that you want to install. You can remove 
previously installed components by clearing the corresponding check boxes.

10.Click the "Next" button.
 

  Note

Note that you cannot change the target directory because the existing installation is being 
modified.

 

If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

12.Click the "Modify" button.
This starts the installation of the additional components. 

 

  Note

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

13.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

14.If the computer does not reboot, click "Exit".

Result
The existing installation has been modified on your computer. 
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See also
Notes on the system requirements (Page 57)

Licenses (Page 71)

Starting installation (Page 73)

Displaying the installed software (Page 76)

Repairing installed products (Page 79)

Starting to uninstall (Page 80)

Installation log (Page 72)

3.8 Repairing installed products
You have the option to repair installed products by completely reinstalling them using the setup 
program.

Requirement  
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To repair installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Repair" option button, and click the "Next" button.
The next dialog displays an overview of the installation settings.
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7. Click the "Repair" button.
This starts the repair of the existing installation. 

 

  Note

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

Result
The installed products have been reinstalled. 

See also
Notes on the system requirements (Page 57)

Licenses (Page 71)

Starting installation (Page 73)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Starting to uninstall (Page 80)

Installation log (Page 72)

3.9 Starting to uninstall

Introduction
Software packages are removed automatically by the setup program. Once started, the setup 
program guides you step-by-step through the entire removal procedure. 

You have two options for removing:

● Removing selected components via the Control Panel 

● Removing a product using the installation medium
 

 Note

The Automation License Manager will not be removed automatically when you remove the 
software packages, because it is used for the administration of several license keys for 
products supplied by Siemens AG. 
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Removing selected components via the Control Panel  
To remove selected software packages, follow these steps:

1. Open the Control Panel with "Start > Settings > Control Panel".

2. Double click on "Add or Remove Programs" in the control panel.
The "Add or Remove Programs" dialog opens.

3. Select the software package to be removed in the dialog "Add or Remove Programs", and 
click "Remove".
The dialog for selecting the setup language opens.

4. Select the language in which you want the setup program dialogs to be displayed and click 
the "Next" button.
The dialog for selecting the products you want to remove opens.

5. Select the check boxes for the products that you want to remove and click the "Next" button.
The next dialog displays an overview of the installation settings.

6. Check the list with the products to be removed. If you want to make any changes, click the 
"Back" button.

7. Click the "Uninstall" button.
Removal begins.

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

Removing a product using the installation medium 
To remove all software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Uninstall" option button and click the "Next" button.
The next dialog displays an overview of the installation settings.

7. Click the "Uninstall" button.
Removal begins.
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8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

See also
Installation log (Page 72)

Notes on the system requirements (Page 57)

Licenses (Page 71)

Starting installation (Page 73)

Displaying the installed software (Page 76)

Modifying or updating installed products (Page 77)

Repairing installed products (Page 79)

3.10 Installing and uninstalling the migration tool

3.10.1 System requirements

System requirements for the migration tool 
The following system requirements apply to the use of the migration tool:

● All products used to create the source project must be installed. The following products are 
supported:

– SIMATIC STEP 7 V5.4 SP5 and STEP 7 V5.5

– WinCC V7 SP1 or V7 SP2

– WinCC flexible V1.3 SP2

● All optional packages needed to process the STEP 7 project are installed. For example, all 
HSPs for the devices used in the source project are required.

3.10.2 Installing the migration tool

Distribution of the migration tool   
The migration tool is available for download from the Service & Support area of the Siemens 
website.

Normally, the migration tool is installed without the TIA Portal. Because the TIA Portal has its 
own integrated migration function, a separate installation of the migration tool is not necessary.
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Procedure
To install the migration tool, proceed as follows:

1. Download the installation file from the Service & Support area on the Siemens website.

2. Run the downloaded file.
The setup program for the migration tool will open.

3. First, select the language in which the setup should be displayed and click the "Next" button.
The page for selecting the software language is displayed.

4. Since the migration tool is provided exclusively in English, you cannot choose any other 
language for the installation. Therefore, click "Next" to proceed to the next step.
The page for selecting the product is displayed.

5. The migration tool consists solely of a software component. Therefore, the migration tool 
is already selected.
To create a Desktop icon for starting the migration tool, select the check box "Create 
Desktop icon". Then click the "Next" button.
The page for confirming the licensing terms is shown.

6. Click on an entry in the list of license terms to read the selected license term. If you agree 
with all license terms, select the check box "I accept the terms of the displayed license 
agreement". Then click the "Next" button.
An overview of the installation is displayed.

7. Click the "Install" button.
The installation is performed with the displayed settings.

3.10.3 Uninstalling the migration tool
The migration tool can be removed using the Control Panel.

Procedure
To remove the migration tool, follow these steps:

1. Open the Control Panel.

2. Double click on "Add or Remove Programs" in the Control Panel.
The "Add or Remove Programs" dialog opens.

3. Select the "TIA Portal Migration Tool V11" entry in the "Add or Remove Programs" dialog, 
and click the "Remove" button.
A confirmation prompt appears.

4. Click the "Uninstall" button to confirm this prompt.
The migration tool will be removed.
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Migrating projects 4
4.1 Migrating projects

Migration of existing projects   
You can migrate projects from earlier automation solutions to the TIA Portal. Each time you 
migrate, a new project is created for the migrated data with which you can then work. Any 
projects already open are closed first.

The migration is then displayed in the table of the project history. From here, you have access 
to a log file that is created automatically for the migration.

Supported products for migration 
The chapter "System overview STEP 7 and WinCC" includes information on the products that 
are available for the TIA Portal. In principle, all products listed there are supported by the TIA 
Portal during migration.

Any additional requirements that must be met depend on the initial products that were used 
and the currently installed products. For more information on the migration options for your 
products, you can, for example, refer to the Service & Support Internet pages and the 
documentation of your software products.

See also: Scaling of STEP 7 and WinCC (Page 21) 

Procedure during migration   
The migration process is divided into the following basic steps:

1. Preparing the initial project
If the software that was used to create the initial project is not installed or is only partly 
installed on the programming device/PC together with the TIA Portal installation, you first 
need to convert the project to a special migration format with the file extension "AM11". To 
do this, install the migration tool on a PG/PC on which the required software is installed.
Then, use the migration tool to convert the initial project, and copy the file to the 
programming device/PC on which the TIA Portal is installed.
You can omit this step if the initial project and its associated software are on the same 
programming device/PC as the TIA Portal. In this case, you can directly migrate the source 
project.

2. Performing migration
You perform the actual migration within the TIA Portal.
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3. Checking the migration log
A log is created for each migration, in which the result of the migration is stored. In this log, 
you can find information on project components that have been lost or modified, or, when 
applicable, the reasons why the migration of a project could not be performed. Check this 
log after migration. Immediately after completion of the migration, the log is displayed in 
the Inspector window. You can also open the log from the project history. If a migration is 
not possible, you can decide where the log will be saved.

4. Correcting the migrated project
Because the configurations of the initial project may not always be completely compatible 
with the TIA Portal, not all configurations are transferred in identical form in the migrated 
project. You should therefore work through the points in the migration log systematically.

 Excluding the hardware configuration from the migration   
If you know at the outset that hardware used in the initial project is not supported by the TIA 
Portal, you can exclude the hardware configuration from the migration. In this case, only the 
software is migrated.

An unspecified device is then generated in the migrated project for the devices contained in 
the initial project. The hardware and network configurations and the connection are not 
migrated. You can convert the unspecified devices into suitable devices after the migration 
and create any network configurations and connections manually.

See also
Displaying the log file of the migration (Page 90)

Scaling of STEP 7 and WinCC (Page 21)

4.2 Preparing projects with the migration tool

4.2.1 Migrating projects with the migration tool

Preparation for migration   
In many cases, a project you want to migrate is not located on the same programming device/
PC on which the TIA Portal V11 is installed. Therefore, the initial project must first be converted 
to a compatible format for the migration. You then copy the migration file to the programming 
device or PC on which the current version of the TIA Portal is installed. There you can then 
read the file into the TIA Portal and create a project in the current file format of the TIA Portal.
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Procedure for migration with the migration tool
To perform a migration without the initial software, the following preparatory steps are 
necessary:

1. Install the migration tool on the programming device/PC where the source project is located. 
To do this, download the installation file from the Service & Support area on the Siemens 
website.

2. Start the migration tool and use it to convert the source project to the migration file format 
with file extension ".ap11".
For this step, make sure that all software needed to process the source project is installed 
on the programming device/PC. This also includes all necessary service packs, hardware 
support packages and all expansion software that is needed to process the initial project. 
If individual products are not installed it may not be possible to perform the migration or the 
migration may be incomplete.

3. Copy the migration file to the target system on which a current version of the TIA Portal is 
installed.
Note that the target system must have been installed with all software needed to configure 
the complete set of devices contained in the migration.

4. Perform the migration within the TIA Portal, and specify the migration file as the source.

5. Following the migration, check the log file and work through the information provided there 
for the newly created project in a systematic manner. Read the information in the Inspector 
window with special care after the first compilation of the configuration.

Excluding the hardware configuration from the migration   
If you know at the outset that hardware used in the initial project is not supported by the TIA 
Portal, you can exclude the hardware configuration from the migration. In this case, only the 
software is migrated.

An unspecified device is then generated in the migrated project for the devices contained in 
the initial project. The hardware and network configurations and the connection are not 
migrated. You can convert the unspecified devices into suitable devices after the migration 
and create any network configurations and connections manually. 

See also
Migrating projects (Page 85)

Migrating projects (Page 89)

Calling the migration tool (Page 88)

Creating a migration file (Page 88)
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4.2.2 Calling the migration tool

Starting the migration tool 
A "Migration to TIA Portal V11" shortcut is always created during the installation in Start menu 
under "Siemens Automation > Migration Tool". Click this shortcut.

Alternatively, you can call the migration tool directly in Windows Explorer. The migration tool 
is saved to the following default folder during installation: "C:\Program Files\Siemens
\Automation\Portal V11\Mig\bin". To start the migration tool, click the 
"Siemens.Automation.MigrationApplication.exe" file in this directory.

See also
Creating a migration file (Page 88)

4.2.3 Creating a migration file
The section below describes how you can use the migration tool to convert the initial project 
into a migration file that can be read by the TIA Portal. Following conversion, this file is 
transferred to the target system and migrated there.

You can specify whether the migration file should contain the entire project, including the 
complete hardware configuration and the associated software, or whether you want to migrate 
the software only.

Requirement
● The suitable, original software with a valid license is installed for all configurations used in 

the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.

Procedure  
To create the migration file, follow these steps:

1. Choose the path of the source file for the migration in the "Storage Location (Path)" field.

2. Select the check box "Exclude hardware configuration" to migrate the software only.

3. Choose the path and the file name for the migration file in the "Intermediate file".

4. Click the "Migrate" button.

Result:
A migration file is created. Finally, copy this file to the target system and migrate this file in the 
TIA Portal.
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See also
Migrating projects (Page 89)

Calling the migration tool (Page 88)

Migrating projects with the migration tool (Page 86)

4.3 Migrating projects

Requirement  
● There is already a converted file in the format AM11 available or the original software with 

a valid license is installed for all the configurations in the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.

Read the additional information on the requirements in the help for the respective products 
installed.

 

 Note
System hibernation during the migration

While a migration is running, the system should not be changed to the standby or hibernate 
mode. Otherwise the migration will be aborted.

 

Procedure  
To migrate a project, follow these steps:

1. Select the "Migrate project" command in the "Project" menu.
The "Migrate project" dialog opens.

2. Specify the path and the file name for the project to be migrated in the "Source path" field. 
Choose either a project in the AM11 migration format or in the format of the initial project.

3. Select the check box "Exclude hardware configuration" to migrate the software only.
If you have selected a migration file that was created using the migration tool, the check 
box is disabled. In this case, you must specify if you wish to exclude the hardware 
configuration of the migration before the conversion with the migration tool .

4. Choose a name for the new project in the "Project name" box.

5. Choose a path in the "Target path" box where the new project will be created.

6. Enter your name or the name of another person responsible for the project in the "Author" 
field.

7. Enter a comment in the "Comment" box, if you require one.

8. Click "Migrate".
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Result
The initial project is converted. The system outputs a message when the migration is complete. 
From here, you can directly open a log for the migration. The newly created project then opens 
in the project view. The migration log is also displayed in the Inspector window.

See also
Post-editing integrated projects (Page 139)

Migrating projects with the migration tool (Page 86)

Creating a migration file (Page 88)

4.4 Displaying the history of the migration
If a project was created by migration, the migration will be listed in the table of the project 
history. You can open the migration log in the table. The time of the migration is also shown.

Procedure   
To display the migration in an overview table, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the "Project history" group in the area navigation.
The overview table is displayed.

See also
Displaying properties of the project (Page 193)

4.5 Displaying the log file of the migration
A log file is created for each migration. The log file contains the following information:

● Migrated objects

● Modifications to objects made during migration

● Errors that occurred during migration
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Procedure  
To display the log file of the migration, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the "Project history" group in the area navigation.
The overview table is displayed.

4. Click on the link to the log file in the "Log file" column.
The log file is displayed in the Microsoft Internet Explorer.

See also
Migrating projects (Page 85)

4.6 Migrating WinCC flexible projects (Professional)

4.6.1 Migrating WinCC flexible 2008 projects

4.6.1.1 Basics (WinCC flexible)

Migration (WinCC flexible)

Introduction
You can continue to use projects in WinCC from WinCC flexible. The following version of 
WinCC flexible is supported:

● WinCC flexible 2008 SP2

The following sections describe the HMI devices that are supported and the required basic 
conditions for a successful migration.

Projects from ProTool Pro and earlier WinCC flexible versions cannot be migrated directly to 
WinCC. If you want to continue using such projects in WinCC, you have to migrate these to a 
supported version of WinCC flexible first and change the HMI device type.  

If the project to be migrated contains components of a supported option package, the option 
package must be installed for successful migration to WinCC. If the option package is not 
installed, migration is canceled. This concerns the following option packages:

● SINUMERIK

The following option packages are not supported  by the migration:
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● ProAgent

● Open Platform Program - OPP

See also
Basics on migration (WinCC flexible) (Page 92)

Migrating projects from WinCC flexible (WinCC flexible) (Page 94)

Compiling and loading a migrated project (WinCC flexible) (Page 96)

Supported HMI devices (WinCC flexible) (Page 97)

Object support in the migration (WinCC flexible) (Page 101)

Migration of connections (WinCC flexible) (Page 105)

Migration of tags (WinCC flexible) (Page 108)

Migrating runtime data (WinCC flexible) (Page 117)

Migrating integrated projects (WinCC flexible) (Page 120)

Migrating data types (WinCC flexible) (Page 123)

Basics on migration (WinCC flexible)

Introduction
In the migration the project data are converted from a WinCC flexible project into the new data 
format of WinCC. The data will not be evaluated to see if they are consistent in the project you 
want to migrate. If errors or warnings are output in a source project during compilation, these 
will not be resolved as part of the migration. This means you should be able to compile the 
project without errors prior to migration. Note the scope of a project during migration. The 
features of WinCC apply for migration. See Engineering system (Page 2380) for additional 
information.     

Unique object names
The objects are clearly identified by the folders in which they are contained in WinCC flexible. 
Screen objects in groups are clearly identified by the group name.       

In WinCC, an object name must be unique within an HMI device. The name of screen objects 
must be unique within a screen.

The uniqueness of the name is verified during migration. If a name is not unique according to 
the new rule, the object in question will be renamed. A renamed object will receive the suffix 
"#Mign", where "n" stands for a sequential number.

Points to note when renaming tags
If you have structured tags in folders in WinCC flexible, the name of the tag will be formed 
during migration from the folder name and the tag name. The names of the folders and tags 
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are separated by the character \. The name of the tag after migration is then, for example: 
Plant1\Line3\Tag17.

If the name would otherwise be longer than 128 characters after migration, the name is formed 
by the character string #mig, a consecutive number, the character # and the tag name from 
WinCC flexible, for example #mig2#Tag17.

If you dynamically compose tag names in scripts, you must check the tags whose names were 
changed during migration with "#mig".

Affected objects
The following objects are renamed if necessary:

● Screens

● Faceplates

● Screen objects

● Graphics

● Recipes

● Structures

● Structural elements

● Alarm logs

● Tags

● Data logs

● Connections

Cancelling migration
The migration is cancelled in the following cases:

● If the project to be migrated is opened in the engineering system or in Runtime.

● If not enough memory space is available on the hard disk to create a a copy for migration 
of the project.

● If the migration cannot address the project database due to problems with the installed SQL-
Server.

● If the migration cannot address the project database due to missing user authorization.

● If you select the "*.hmi" file for the migration in an integrated project. You must select the 
"*.s7" file for the migration in an integrated project.

● If the project was created with a version not supported by the migration.

Saving the project in the migration format 
You do not have to execute the migration of a WinCC flexible project completely on the PC on 
which the project is available. You can prepare the migration by saving the project in the 
migration format. The migration tool is available for saving a WinCC flexible project in the 
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migration format. The migration tool exports the engineering data from the WinCC flexible 
project and saves the data in the migration format "*.AM11".   

For the actual migration, copy the data in the migration format to a PC on which the TIA-Portal 
is installed.

For more detailed information, please refer to the migration tool documentation.

See also
Migration (WinCC flexible) (Page 91)

Engineering system (Page 2380)

Migrating projects from WinCC flexible (WinCC flexible)

Introduction
When you migrate a project, data from a WinCC flexible project is loaded into a new project 
for WinCC. A new project is therefore created automatically for project migration. You cannot 
migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal. 

Information on the migration of integrated project can be found in the Chapter Migrating 
integrated projects (WinCC flexible) (Page 120).

If you only want to save the project in migration format, you can use the migration tool. See 
Basics on migration (WinCC flexible) (Page 92) for additional information.

Requirement
● A project from WinCC flexible is available.

● The project is not open in WinCC flexible.

● The TIA portal is newly started.
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Procedure
Migrate a project in the Portal view as follows:    

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the WinCC flexible project file "*.hmi".

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– A message is displayed upon completion of the migration. The message contains a link 
that you can use to open the log.

6. Once migration is completed, save the project.
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When migration is complete, you will find a newly created device for each migrated HMI device 
in the project tree. These devices contain the migrated data, such as screens, alarms and tags.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Select the project in the project tree.

2. Select the "Properties" command in the shortcut menu.

3. Click "Project History" in the "Properties" dialog.

4. Click on the log file.
The migration log opens.

 

See also
Migration (WinCC flexible) (Page 91)

Migrating integrated projects (WinCC flexible) (Page 120)

Basics on migration (WinCC flexible) (Page 92)

Compiling and loading a migrated project (WinCC flexible)

Compiling a migrated project
Once you have successfully migrated a WinCC flexible project, you need to recompile it before 
loading it to the HMI device. The project will only compile successfully if it was capable of error-
free compiling prior to migration.

If errors occur during compilation of the migrated project, they have to be eliminated.

Once compiling is successfully completed, load the project to the HMI device.   

Settings for download to the HMI device
The settings for loading the HMI device are not included in the migration. Once you have 
migrated the project, you must configure the settings for loading.

Select the HMI device in the project tree and select "Loading in device > Software (complete 
loading)" from the shortcut menu.The dialog "Advanced Loading" is opened. Configure the 
required settings for the interface. Click the "Load" button. The project is recompiled and the 
dialog "Load preview" is opened.

Expand the "Overwrite" entry and verify the settings for the following options:

● Would you like to overwrite the existing user administration data from this device

● Would you like to overwrite the existing recipe data on HMI system
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Configure the options as you want to use them in the project in the future. Subsequently, load 
the project to the HMI device.

See also
Migration (WinCC flexible) (Page 91)

4.6.1.2 Migrating engineering data (WinCC flexible)

HMI devices (WinCC flexible)

Supported HMI devices (WinCC flexible)

Introduction
When migrating projects from WinCC flexible you must bear in mind that WinCC does not 
support all HMI devices. You have to distinguish between the following cases:

● HMI device is supported by WinCC.
The project is migrated 1:1 and gets the same HMI device after migration as before 
migration.

● The HMI device is replaced by a compatible successor model.
The project is migrated. The migration replaces the HMI device with a compatible successor 
model. See HMI device change by the migration (WinCC flexible) (Page 99) for additional 
information.

● HMI device is not supported.
If your WinCC flexible project contains an HMI device that is not supported by WinCC, the 
migration process is cancelled. To migrate the project, you must change the HMI device in 
WinCC flexible to a HMI device type supported by WinCC.

The following HMI device types are supported both by WinCC flexible and WinCC:

Basic Panels  
● KTP400 Basic mono PN

● KTP400 Basic mono PN Portrait

● KTP600 Basic DP

● KTP600 Basic DP Portrait

● KTP600 Basic PN

● KTP600 Basic PN Portrait

● KTP600 Basic mono PN

● KTP600 Basic mono PN Portrait

● KTP1000 Basic DP
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● KTP1000 Basic PN

● TP1500 Basic PN

Mobile Panels
● Mobile Panel 177 6'' DP

● Mobile Panel 177 6'' PN

● Mobile Panel 277 8''

● Mobile Panel 277 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN (RFID Tag)

● Mobile Panel 277 10''

Panels
● OP 73

● OP 77A

● OP 77B

● OP 177B 6'' mono

● OP 177B 6'' color PN/DP

● TP 177B 4'' color PN/DP

● TP 177A

● TP 177A Portrait

● TP 177B 6'' mono DP

● TP 177B 6'' color PN/DP

● OP 277 6''

● TP 277 6''

Multi Panels
● MP 177 6'' Touch

● MP 277 8'' Key

● MP 277 8'' Touch

● MP 277 10'' Key

● MP 277 10'' Touch

● MP 377 12'' Key

● MP 377 12'' Touch
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● MP 377 15'' Touch

● MP 377 19'' Touch

Sinumerik PC
● OP 010 Key

● OP 012 Key

● OP 015 Key

● OP 015A Key

● TP 015A Touch+Key

HMI applications
● WinCC flexible Runtime

WinCC only supports the functions provided by these HMI device types.

Other functions which are not migrated because of the restricted device selection are 
documented in the following sections.

Adaptations before migration
If the HMI device was changed to an HMI device with a different screen size in the project to 
be migrated, you must recompile and save the project in WinCC flexible before the migration. 
The compilation process will adjust the size of the screens and screen elements.   

See also
Migration (WinCC flexible) (Page 91)

HMI device change by the migration (WinCC flexible) (Page 99)

Configuration change after HMI device change (WinCC flexible) (Page 101)

Object support in the migration (WinCC flexible) (Page 101)

Migration of connections (WinCC flexible) (Page 105)

HMI device change by the migration (WinCC flexible)

Introduction
WinCC flexible supports some HMI devices which are discontinued in the future. These HMI 
devices are no longer supported by WinCC. When migrating a WinCC flexible project, an HMI 
device that is not supported is replaced by a compatible successor device.

Only the HMI device type is changed during the migration. HMI device-specific data are not 
changed by the migration. 
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Inconsistencies in the project may occur due to a change in the HMI device. In a project which 
was compilable before the migration, errors may occur in the project compilation after changing 
the HMI device. E.g. because the changed HMI device supports different memory media to 
the previous HMI device.

HMI device change by the migration
The following table provides information about which successors replace the HMI devices that 
are not supported.

Unsupported HMI devices Successors
Mobile Panel 170 6'' Mobile Panel 177 6'' DP
Mobile Panel 277 8'' IWLAN Mobile Panel 277 8'' IWLAN V2
Mobile Panel 277F 8'' IWLAN Mobile Panel 277F 8'' IWLAN V2
OP 170B 6'' mono OP 177B 6'' color PN/DP
TP 170A 6'' TP 177A 6''
TP 170B 6'' mono TP 177B 6'' color PN/DP
TP 170B 6'' color TP 177B 6'' color PN/DP
OP 270 6'' OP 277 6''
OP270 10'' MP 277 10'' Key
TP 270 6'' TP 277 6''
TP 270 10'' MP 277 10'' Touch
MP 270 6'' Touch TP 277 6''
MP 270 10'' Key MP 277 10'' Key
MP 270 10'' Touch MP 277 10'' Touch
MP 370 12'' Key MP 377 12'' Key
MP 370 12'' Touch MP 377 12'' Touch
MP 370 15'' Touch MP 377 15'' Touch
PC 477 12'' Key PC 477B 12'' Key PB
PC 477 12'' Touch PC 477B 12'' Touch PB
PC 477 15'' Key PC 477B 15'' Key PB
PC 477 15'' Touch PC 477B 15'' Touch PB
PC 477 19'' Touch PC 477B 19'' Touch PB
PC 577 12'' Key IPC 577C 12'' Key PB
PC 577 12'' Touch IPC 577C 12'' Touch PB
PC 577 15'' Key IPC 577C 15'' Key PB
PC 577 15'' Touch IPC 577C 15'' Touch PB
PC 577 19'' Touch IPC 577C 19'' Touch PB
PC 670 12'' Key PC 677B 12'' Key PB
PC 670 12'' Touch PC 677B 12'' Touch PB
PC 670 15'' Key PC 677B 15'' Key PB
PC 670 15'' Touch PC 677B 15'' Touch PB
PC 677 12'' Key PC 677B 12'' Key PB
PC 677 12'' Touch PC 677B 12'' Touch PB
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Unsupported HMI devices Successors
PC 677 15'' Key PC 677B 15'' Key PB
PC 677 15'' Touch PC 677B 15'' Touch PB
PC 677 17'' Touch PC 677B 17'' Touch PB
PC 677 19'' Touch PC 677B 19'' Touch PB

HMI device change by the user
If a project contains an HMI device that is not supported by WinCC and no compatible 
successor model exists, the migration is cancelled. If you want to migrate the project, you must 
change the HMI device to WinCC yourself before the migration. Use an HMI device which is 
supported both by WinCC flexible and WinCC for this.

See also
Supported HMI devices (WinCC flexible) (Page 97)

Configuration change after HMI device change (WinCC flexible)

HMI device change by the migration
If the migration makes an HMI device change, it replaces the existing HMI device with a 
compatible successor model. The successor models are further developed and therefore more 
efficient than their predecessors. The new models therefore support all the properties of their 
predecessors. Therefore only a little rework is to be expected on the project due to the HMI 
device change.  

HMI device change by the user
if you change an HMI device yourself before the migration, you must ensure that the HMI 
device used supports all properties which are used in the project. Compile the project after the 
HMI device change in WinCC flexible. The project must be perfectly compilable before the 
migration. Then migrate the project to WinCC. 

See also
Supported HMI devices (WinCC flexible) (Page 97)

Object support in the migration (WinCC flexible)

Introduction
When migrating projects from WinCC flexible, all configuration data involving an HMI device 
supported by WinCC will be migrated. Basically, all object types and functions that are available 
and can be mapped to the new project environment will be fully migrated.

Some global object types are not migrated, for example, dictionaries and global libraries.
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Supported object types
The following object types are supported for migration:

● Animations

● Audit settings

● Audit reports

● Scheduler

● User administration

● Area pointer

● Faceplates

● Screens

● Screen template

● Data types

● Function lists

● Graphics lists

● Display and operating elements
Migration supports all display and operating elements available on the supported HMI 
devices.

● Alarms

● Alarm classes

● Alarm groups

● Project library

● Project languages

● Reports

● Recipes

● Runtime languages

● Runtime scripting

● Sm@rtAccess/Sm@rtService

● Structures

● System events

● System functions

● Texts

● Text lists

● Tags

● Connections

● Effective ranges
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● Zones

● Cycles

Unsupported object types
The following object types are not supported by migration:

● Global libraries

● Dictionaries

● Project versions

● Change log

Mapping of the screen navigation
WinCC does not support the screen navigation from WinCC flexible. The data of the screen 
hierarchy from WinCC flexible are not migrated. To map the functionality of a screen navigation 
from WinCC flexible, the naivigation buttons are migrated to the button available in WinCC. 
The system functions migrated to the "ActivateScreen" system function are migrated to the 
"Click" event of the respective button. The following system functions used in WinCC flexible 
are not available for the screen navigation in WinCC:

● ActivateRootScreen

● ActivateLeftScreen

● ActivateRightScreen

● ActivateParentScreen

● ActivateFirstChildScreen

These system functions are migrated to the "ActivateScreen" system function. The "Screen 
name" parameter is taken from the data of the screen hierarchy. If one of the named system 
functions is called from a screen which is not contained in the screen hierarchy, the 
"ActivateScreen" function is created without parameters. You must configure the desired 
screen to this system function after the migration.

Migration of the screen template
WinCC offers an extended concept for working with screen templates. WinCC offers a global 
screen and several templates for each device. During migration of a template from 
WinCC flexible, the objects contained there and the properties configured in the template are 
migrated to the extended concept of the screen templates of WinCC.

The following objects are migrated to the "global screen" of WinCC:

● Alarm window

● Alarm indicator

● Help indicator

● Function keys of HMI devices with function keys

All other objects and properties are migrated to a template of WinCC.
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The connection of the objects and properties to the respective template is automatically 
adapted.

See also
Supported HMI devices (WinCC flexible) (Page 97)

Migration (WinCC flexible) (Page 91)

Changes of values of object properties by the migration (WinCC flexible) (Page 104)

Changes of values of object properties by the migration (WinCC flexible)

Introduction
The standardization of object properties from WinCC V7 and WinCC flexible requires changes 
to the object properties during the migration process. The migration calculates the changes in 
such a way that the representation of the objects after migration is the same as prior to 
migration. Changes made during migration result in different units of measurements and values 
in the configuration for some object properties. 

Migrating the font settings of an object
In WinCC V7 and WinCC flexible, the unit of measurement "point" is used to denote the size 
of the fonts used for an object. In WinCC, the unit of measurement "pixel" is used to denote 
the size of the fonts used for an object. During migration, the font size is converted accordingly 
to ensure that the representation of the font is the same size at zoom level 100%. The different 
units of measurement result in changes to the numerical values for the font sizes after 
migration.   

Example:

Font style before migration Font style after migration
Arial 10 points Arial 13 pixels
Arial 16 points Arial 21 pixels
Tahoma 10 points Tahoma 13 pixels
Tahoma 16 points Tahoma 21 pixels

Migration of object margins
In WinCC flexible, some objects permit the entry of values <0 and >127 for setup of the object 
margins for the configuration of the representation. In WinCC, the range of values for object 
margins is limited to values between 0 and 127. The migration changes values <0 to the value 
"0" and values >127 to the value "127".

See also
Object support in the migration (WinCC flexible) (Page 101)
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Connections (WinCC flexible)

Migration of connections (WinCC flexible)

Introduction
If you migrate a project in which a supported communication driver is used, this driver is used 
further in WinCC. Objects which communicate via this driver are migrated 1:1. No rework is 
necessary.

Not all communication drivers which are available in WinCC flexible are supported in WinCC. 
If an unsupported driver is used in the project to be migrated, there are two possible scenarios:

1. A compatible spare driver is available for the used driver.

2. No compatible spare driver is available for the used driver.

Compatible spare driver is available
If a driver is available in WinCC which addresses the used PLC or a comptaible PLC, the driver 
is automatically replaced during the migration.

You get an appropriate warning if the used driver is replaced.

In this case, check whether all the external tags and area pointers are valid after the migration 
by means of the migration report.

If the used driver is replaced, all the connection parameters are reset to the standard values. 
The CPU type is adapted to the appropriate PLC. The properties of the connected tags and 
area pointers are not changed.

Compatible spare driver is not available
If no driver is available in WinCC which addresses the used PLC or a compatible PLC, the 
configured connection is not migrated. All external tags which were connected to the PLC by 
this driver are converted into internal tags. External tag properties are lost in the conversion, 
e.g. the address in the PLC. All changes to the tags are recorded in the migration report.

You must reconnect the tags with the PLC after the migration and configuring of a connection.

You get an appropriate warning if the driver is not migrated.

Converting the communication driver
The following tables show the mapping of communication drivers from WinCC flexible to 
WinCC.
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Supported communication drivers

WinCC flexible WinCC
Allen Bradley DF1 Allen Bradley DF1
Mitsubishi FX Mitsubishi FX
Modicon MODBUS Modicon MODBUS RTU
Modicon MODBUS TCP/IP Modicon MODBUS TCP/IP
Omron Hostlink/Multilink Omron HostLink
OPC OPC
SIMATIC HMI HTTP Protocol SIMATIC HMI HTTP Protocol
SIMATIC S7 200 SIMATIC S7 200
SIMATIC S7 300/400 SIMATIC S7 300/400

Compatible communication drivers

WinCC flexible WinCC
Allen Bradley DH485 Allen Bradley DF1
Allen Bradley E/IP C.Logix Allen Bradley EtherNet/IP
Mitsubishi Protocol 4 Mitsubishi MC TCP/IP

Not supported communication drivers

WinCC flexible WinCC
GE Fanuc SNP not supported
ISAC not supported
LG GLOFA-GM not supported
SIMATIC 500/505 DP not supported
SIMATIC 500/505 serial not supported
SIMATIC S5 AS511 not supported
SIMATIC S5 DP not supported
SIMOTION not supported
Telemecanique Uni-Telway not supported

See also
Migration (WinCC flexible) (Page 91)

Supported HMI devices (WinCC flexible) (Page 97)

Adaptation of the configuration for non-migrated connection (WinCC flexible) (Page 107)

Migration of area pointers (WinCC flexible) (Page 108)

Migration of tags (WinCC flexible) (Page 108)
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Adaptation of the configuration for non-migrated connection (WinCC flexible)

Introduction
If a connection cannot be migrated you have the following options:

● Change the configuration in WinCC flexible before the migration

● Change the configuration after the migration

Change a connection before the migration
If the communication driver selected for the connection is not supported by the migration, you 
must select a driver which is supported by the migration. The HMI device must also support 
the selected communication driver.   

If no suitable driver is available for the used HMI device, you must use a suitable HMI device. 
Then adapt the configuration in WinCC flexible and recompile the project. Migrate the project 
after successful adaptation and compiling. The connection is then also migrated.

Changing a connection before the migration
If you migrate a WinCC flexible project in which the connection is not migrated, all external 
tags of this connection are mapped to internal tags. You receive an appropriate entry in the 
migration protocol for every tag concerned. 

You must configure a new connection after the migration. For this connection you select a 
communication driver which supports the used HMI device. If no suitable driver is available for 
the used HMI device, you must use a suitable HMI device.

If you have configured the new connection, you must reconnect all tags which were mapped 
to internal tags before the migration. Open the migration report to make reconfiguration easier. 
Reconfigure the tags according to the log entry.

If the project contained area pointers, you must also reconfigure these. You will also find 
corresponding entries for the area pointers in the migration log.

See the section Migrating projects from WinCC flexible (WinCC flexible) (Page 94) for further 
information about the migration log.

See also
Migration of connections (WinCC flexible) (Page 105)

Migrating projects from WinCC flexible (WinCC flexible) (Page 94)
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Migration of area pointers (WinCC flexible)

Introduction
The migration of area pointers depends on the used communication driver. 

● If the used communication driver is supported by the migration, area pointers from WinCC 
flexible are taken over unchanged in the migration.

● if the used communication driver is not supported by the migration, area pointers are not 
migrated.  

Migration of the area pointers
If the connection used by the area pointers is fully migrated, the area pointers are also fully 
migrated. The parameters of the area pointers are taken over unchanged.

If you replace the communication driver of the connection before the migration, check whether 
all the parameters of the area pointers are still valid after the migration.

If the connection used by the area pointer is not migrated, the area pointers are not migrated 
either. See Adaptation of the configuration for non-migrated connection (WinCC flexible) 
(Page 107) for additional information.

See also
Migration of connections (WinCC flexible) (Page 105)

Adaptation of the configuration for non-migrated connection (WinCC flexible) (Page 107)

Migration of tags (WinCC flexible)

Introduction
You need to make some special considerations when migrating tags. The following aspects 
should be distinguished:

● Migrating data types of tags

● Migrating internal tags

● Migrating external tags

● Tag names

● Tag limits

Migrating data types
WinCC features some other data types and uses different data type names than 
WinCC flexible. When migrating a relevant tag, the data type from WinCC flexible is mapped 
to the corresponding data type in WinCC. See Migrating data types (WinCC flexible) 
(Page 123) for additional information.
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Migrating internal tags
Internal tags are always migrated completely. Only the data type names and tag names may 
change due to migration.

Migrating external tags
If the connection used by the external tags is migrated, the external tags are also fully migrated. 
The migration of external tags depends on whether the used communication driver is supported 
by the migration. See Migration of connections (WinCC flexible) (Page 105) for additional 
information.

If the connection used by the external tags is not migrated, the external tags are not migrated 
either. The external tags are then mapped to internal tags. You must configure a new 
connection and reconnect the tags with the tags of the PLC after the migration.

Migrating names of tags
In WinCC flexible, tags located in different folders can have the same name. In WinCC, the 
tag name must be unique on the configured HMI device. This means that tags with the same 
name from different folders will be renamed during migration. See Basics on migration (WinCC 
flexible) (Page 92) for additional information.

See also
Migration of connections (WinCC flexible) (Page 105)

Migration (WinCC flexible) (Page 91)

Migration of alarm classes and alarm groups (WinCC flexible) (Page 110)

Migrating scripts (WinCC flexible) (Page 112)

Migration of language-dependent contents (WinCC flexible) (Page 114)

Migration of libraries (WinCC flexible) (Page 116)

Migrating data types (WinCC flexible) (Page 123)

Basics on migration (WinCC flexible) (Page 92)

Migration of logs

Storage location of logs
WinCC flexible allowed you to store logs in a database which was automatically set up upon 
WinCC flexible installation ("System-defined data source" setting). This option is not available 
in WinCC.

If you have used this setting in your WinCC flexible project, it will be changed to "User-defined 
name of data source" during migration. Before you can store logs in a database, you must 
configure an ODBC data source in the Windows control panel and configure the name of the 
user data source specified there as the "name of the data source" in the log in WinCC.
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Migration of alarm classes and alarm groups (WinCC flexible)

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Alarms
System System
Warnings Events

The names of the alarm classes can be changed as necessary after migration.

Migrating alarm groups
Migration will migrate only those alarm groups actually in use.   

Alarm groups with an ID from 1-31 will be migrated 1:1.

A corresponding alarm group is created in WinCC for each alarm class in the system. These 
alarm groups created by the system are assigned IDs beginning with the number 32 and 
consecutively incremented. The 4 pre-defined message classes in every WinCC project are 
automatically given IDs 32-35 by their alarm groups. Additionally created alarm group and an 
additional ID is assigned to each user-defined alarm class. Therefore, the IDs for alarms groups 
with IDs > 31 may be changed after migration. This step also changes the assignment of the 
alarm group names to the IDs. 

Example:

In the example, you can see the assignment of the IDs in WinCC for the migration. 

Alarm groups ID in WinCC flexible ID in WinCC  
Alarm group 1-16 1-16 1-16 Default for alarm groups from system 

alarms
Alarm group 17-31 17-31 17-31 Custom alarm groups
  32-35 Default in WinCC for alarm groups of 

predefined alarm classes.
Alarm group 32 32 36 Changed assignment of ID to alarm group 

in WinCC
Alarm group 33 33 37 Changed assignment of ID to alarm group 

in WinCC

Also note:

When migrating alarm groups that supposedly have the same group name, the migration 
adapts the name. This occurs, for example, when a group name contains a space at the end 
of the name. The migration deletes all existing spaces at the end of names. If two groups 
obtained the same group names due to this deletion, the migration adds the suffix "# Mign" to 
the group name of the following alarm groups, where "n" stands for a sequential number.
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Example:

The following alarm groups exist in WinCC flexible: 

"AlarmGroup_18"

"AlarmGroup_18 " - group name contains one space

"AlarmGroup_18 " - group name contains two spaces

"AlarmGroup_18" is the alarm group with the highest number. 

Result after migration:

"AlarmGroup_18"

"AlarmGroup_18#Mig1"

"AlarmGroup_18#Mig1.1"

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:   

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The names of the alarm classes can be changed as necessary after migration.

Display of ALARM_S messages and SIMATIC SFM messages
In WinCC flexible you can activate the display classes for ALARM_S messages in integrated 
projects. In WinCC flexible, you activate the display of SIMATIC SFM messages via a separate 
setting. The separate setting for activating the display of SIMATIC SFM messages is not 
required in WinCC. You control the display of SIMATIC SFM messages, and also the display 
of ALARM_S messages in WinCC only by activating the corresponding display class.

The changed concept may cause the display of messages to change following migration.

If all the display classes for ALARM_S messages are activated and the display of 
SIMATIC SFM messages is deactivated in the WinCC flexible project , ALARM_S messages 
and SIMATIC SFM messages are displayed following migration.

To ensure that only ALARM_S messages are displayed following migration, you have to assign 
the SIMATIC SFM messages to an unused display class after migration to STEP 7. You then 
have to deactivate this display class in WinCC.

If all the display classes for ALARM_S messages are deactivated and the display of 
SIMATIC SFM messages is activated in the WinCC flexible project , ALARM_S messages and 
SIMATIC SFM messages are not displayed following migration.
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To ensure that only SIMATIC SFM messages are displayed following migration, you have to 
assign the SIMATIC SFM messages to an unused display class after migration to STEP 7. 
You then have to activate this display class in WinCC.

The display class is dependent on the settings in STEP 7. The default setting for SIMATIC SFM 
messages in Step 7 is the display class "0". To activate the display in WinCC, the display class 
"0" must be activated.

You activate the display class in WinCC in the Runtime settings of the respective HMI device 
in the "Messages" category.

See also
Migration of tags (WinCC flexible) (Page 108)

Migrating scripts (WinCC flexible)

Introduction
The migration supports VB-scripts which were created in WinCC flexible. For a VB-script to 
be migrated successfully it must be functionable in WinCC flexible first.
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Migration of a VB script
A script is analyzed in the migration and adapted to the system behavior of WinCC if necessary. 
The following is adapted:        

● System functions which have changed their names are renamed.
This concerns the following system functions:

Function name in WinCC flexible Function name in WinCC
IncreaseValue IncreaseTag
DecreaseValue DecreaseTag
SetValue SetTag

● The access to tags as parameters of system functions is adapted to the system behavior 
of WinCC. In WinCC scripts are no longer transfromed as in WinCC flexible. The scripts 
are executed directly as a source code. Therefore the stricter rules for the VBS syntax 
apply. A tag call is always migrated with inverted commas. If several parameter types are 
allowed for a system function, these are migrated with the keyword "SmartTags".
Example 1:
The value of the "temperature" tag should be incremented by the value "1".
Valid expressions in WinCC flexible:
IncreaseValue temperature, 1
IncreaseValue "temperature", 1
IncreaseValue SmartTags("temperature"), 1
Valid expression in WinCC:
IncreaseTag "temperature", 1
 
Example 2:
You use a system function on which several parameters are allowed. The value of the 
"temperature" tag should be incremented by the value of the "heatcontrol" tag.
Valid expression for WinCC flexible:
IncreaseValue "temperature", "heatcontrol"
Valid expression for WinCC:
IncreaseTag "temperature", SmartTags("heatcontrol")

● Objects renamed by the migration are also renamed in the script when using in a script. 
See the section Basics on migration (WinCC flexible) (Page 92) for further information about 
the renaming objects. You only have to observe the following rules when renaming objects:
If you address objects whose names are dynamically generated by the script with the help 
of a script, the object names in the script can not be automatically changed by the migration. 
In such a case, you have to correct the generation of the object names in the script after 
migration. 

 

See also
Migration of tags (WinCC flexible) (Page 108)

Basics on migration (WinCC flexible) (Page 92)
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Migration of language-dependent contents (WinCC flexible)

Introduction
WinCC offers the same options for configuring projects in different languages as those 
available in WinCC flexible. All languages supported by WinCC are included in the migration 
of a project. 

Migrating language-dependent content
The following language-dependent content is migrated:       

● Project languages

● Project texts

● Fonts for display in runtime

● Language-dependent graphics

You need to consider the following when migrating language-dependent content:

● The operating system on the PC performing the migration must support the project 
languages used in the project.

● The fonts used for runtime display must be installed on the PC performing the migration.

● Dictionaries are not supported by the migration.

Editiing language of integrated projects following migration
During migration of an integrated project, the project components to be migrated from STEP 7 
and WinCC flexible also bring their respective settings for the editing language. In WinCC there 
is only one editing language for all project components. Migration activates for the mgrated 
project the editing language which was set in STEP 7 prior to migration. If this setting is not 
the same as the setting from WinCC flexible, the configured texts are no longer visible in 
WinCC. No text is displayed at the usage locations, or only the entry "Text" can be seen. To 
make the texts visible, you must change the editing language. Click the "Tasks" taskcard at 
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the right-hand edge of the TIA portal and select the correct editing language in the "Language 
& Resources" area.

Unsupported languages
The migration of language-dependent content depends on whether or not WinCC supports the 
respective language. 

If a project only contains project languages not supported by WinCC, the project will not be 
migrated.

If a project contains supported and unsupported project languages, only the supported 
languages will be migrated. The editing language and reference language are set to a 
supported language.

The following languages are not supported by WinCC:

● Arabic

● Hebrew

● Dhivehi

● Gujarati

● Kannada
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● Tamil

● Telugu

● Urdu

● Punjabi

● Persian

● Syrian

See also
Migration of tags (WinCC flexible) (Page 108)

Migration of libraries (WinCC flexible)

Introduction
You need to consider two different cases when migrating from libraries:

1. Migrating a project library

2. Migrating a global library

Migrating a project library
A project library is stored together with the project data in the project file. For this reason, a 
project library is migrated with the same restrictions as the project data.   

Migrating a global library
Global libraries are not supported by the migration. The library objects used in the project will 
be migrated, however. The library objects are copied when used in the project and then no 
longer have a connection to the library.

To migrate a global library, you must copy or move the objects contained in the library to the 
project library. The objects are then included in the migration. In WinCC, you move the migrated 
objects to a new global library that is created. You can copy or move both individual objects 
or entire library categories.   

See also
Migration of tags (WinCC flexible) (Page 108)
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4.6.1.3 Migrating runtime data (WinCC flexible)

Migrating runtime data (WinCC flexible)

Introduction
Only the configuration data are migrated by the migration when migrating a project. The runtime 
data are not affected. You need to update the runtime data following migration.

The runtime data consists of the following: 

● Runtime project
The runtime project contains the compiled project data.

● Recipe data and user administration
The recipe data and user administration are data that can be changed in runtime.

● Log data
The data of tag logs and alarm logs are acquired and logged in runtime.

Migrating recipe data and user administration
If the recipe data and user administration were changed in runtime, you need to back up this 
information from the HMI device before you load the migrated project.

Depending on the used HMI device, you have different options for saving the above data.

If the HMI device supports external memory media and the recipe data are saved there, the 
data remain on the memory medium. External memory media are for example StorageCard 
or a network drive. You use the data again after the migration. The user adminsitration is not 
saved on an external memory medium so you have to save these data, e.g. with ProSave.

If the recipe data are saved in the internal memory of the HMI device, save these data on an 
external memory medium. Use ProSave to save the recipe data. If you have already configured 
appropriate system functions in your project, use the system functions. The following system 
functions are available for the recipe data:

● "ExportDataRecords" for the backup

● "ImportDataRecords" for the restore

You update the runtime project by compiling the project in WinCC again and loading it to the 
HMI device.

After you have loaded the migrated project on the HMI device, restore the recipe data and the 
user administration to the HMI device.

See also
Migration (WinCC flexible) (Page 91)

Backing up recipe data and user administration (WinCC flexible) (Page 118)

Restoring recipe data and user administration (WinCC flexible) (Page 119)

Backing up log data (WinCC flexible) (Page 120)
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Backing up recipe data and user administration (WinCC flexible)

Introduction
To continue using the recipe data and user administration in a migrated project, you first need 
to back up this data from the HMI device. Then load the data into the migrated WinCC project. 
Use ProSave to back up the data. 

Requirement
● The WinCC flexible project is running on the HMI device in Runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to back up the recipe data and user administration:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Backup" tab.

4. Select the "Recipes from the device memory" entry in the "Data type" box.
Do not select "Complete backup" because otherwise you will not be able to select separately 
when restoring the recipe data.

5. Navigate to the desired location in the "Save as" box and click "Start Backup".
The recipe data are saved.

6. Select "User administration" in the "Data type" box and click "Start Backup".
The user administration is saved.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC flexible. The entire functional range of ProSave 
is available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

Alternatively, you can back up the recipe data and user administration via the ProSave 
integrated in WinCC flexible. Start WinCC flexible and select the menu command "Project > 
Transfer > Backup". Back up the recipe data and user administration as described in steps 4-6.

See also
Migrating runtime data (WinCC flexible) (Page 117)
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Restoring recipe data and user administration (WinCC flexible)

Introduction
To continue using saved recipe data and user administration after the migration, you first need 
to compile the migrated project and load it to the HMI device. You can then transfer the saved 
data to the HMI device. Use ProSave to restore the data. 

Requirement
● The migrated project has been transferred to the HMI device and is running in runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to load the saved recipe data and user administration to the HMI device:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Restore" tab.

4. Navigate to the location of the saved recipe data in the "Opening..." box and select the file.

5. Click "Start Restore".
The recipe data will be transferred to the HMI device..

6. Repeat steps 4-5 to restore the user administration.
The user administration will be transferred to the HMI device.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC. The entire functional range of ProSave is 
available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

You can also restore the recipe data and user administration via the ProSave integrated in 
WinCC. Start WinCC and select the menu command "Online > Device maintenance > 
Restore". Restore the recipe data and user administration as described in steps 4-6.

See also
Migrating runtime data (WinCC flexible) (Page 117)
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Backing up log data (WinCC flexible)

Introduction
If an HMI device supports external memory media and the log data are saved there, the data 
remain on the memory medium. External memory media are for example StorageCard or a 
network drive. If a log is saved on an external memory medium, the migrated project accesses 
this storage location again after the migration. In this case the log data must not be backed up.

Backing up log data
If you want to back up the log data externally before the migration, you have the following 
options:

● Backup with the "ArchiveLogFile".
If you have already configured the "ArchiveLogFile" function in the WinCC flexible project, 
use this function to back up the data.

● Copy the log files by Copy&Paste with the Windows Explorer to an external memory 
medium or network drive.

See also
Migrating runtime data (WinCC flexible) (Page 117)

4.6.1.4 Migrating integrated projects (WinCC flexible)

Migrating integrated projects (WinCC flexible)

Introduction
The controllers and HMI devices contained in a project integrated in STEP 7 are linked together 
by the configuration. The configuration data of WinCC flexible and STEP 7 are also connected. 
When an integrated project is migrated, the complete project will be migrated with components 
from WinCC flexible and STEP 7. The connections remain intact.

Migrating an integrated project
When migrating an integrated project, the same requirements apply for the WinCC flexible 
component as those for the migration of a non-integrated WinCC flexible project. The objects 
and properties contained in the WinCC flexible component must be supported by WinCC, for 
example, the HMI device or the communication driver. The "Online" property must be activated 
on the configured connection. A connection with deactivated "Online" property is not migrated.

In addition to the requirements for the WinCC flexible component, there are also requirements 
for the STEP 7 component of the integrated project. The objects and properties contained in 
the STEP 7 V5.4 SP5 or V5.5 component must be supported in STEP 7. For detailed 
information, refer to the documentation for STEP 7.   
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To fully migrate an integrated project and then edit it, the following components must be 
installed on the PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC

● STEP 7

If you only want to save the project in migration format, you can use the migration tool. See 
Basics on migration (WinCC flexible) (Page 92) for additional information.

An integrated project is always fully migrated. If you only want to migrate the WinCC flexible 
project it contains, you need to separate it from the STEP 7 project before the migration. To 
separate the project from the integrated form, open the project in STEP 7 V5.4 SP5 or V5.5. 
Open the WinCC flexible project in the SIMATIC Manager. The project is opened with 
WinCC flexible. In WinCC flexible, select the menu command "Project > Copy project from 
STEP 7". WinCC flexible saves a non-integrated copy of the project.

See also
Migration (WinCC flexible) (Page 91)

Migrating an integrated project (WinCC flexible) (Page 121)

Basics on migration (WinCC flexible) (Page 92)

Migrating an integrated project (WinCC flexible)

Introduction
When migrating an integrated project, the components from both the WinCC flexible project 
and the STEP 7 project will be migrated. This means you need to select the project file with 
the file extension "*.s7p" for migration. During migration, the data is copied from the existing 
project and migrated to a new project. You cannot migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal.

If you only want to save the project in migration format, you can use the migration tool. See 
Basics on migration (WinCC flexible) (Page 92) for additional information.

Requirement
● STEP 7 V5.4 SP5 or STEP 7 V5.5 and all add-on packages used are installed.

● STEP 7 and all add-on packages used are installed.

● The TIA portal is newly started.

● No project is open in WinCC.

● An integrated project is available.

● The integrated project is not open.
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Procedure
Proceed as follows to migrate an integrated project in the Portal view:    

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the "*.s7p" project file.

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– A message is displayed upon completion of the migration. The message contains a link 
that you can use to open the log.

6. Once migration is completed, save the project.
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Once the migration is complete, you will find a newly created device for each migrated HMI 
device and controller in the project tree. These devices include the migrated data.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Select the project in the project tree.

2. Select the "Properties" command in the shortcut menu.

3. Click "Project History" in the "Properties" dialog.

4. Click on the log file.
The migration log opens.

See also
Migrating integrated projects (WinCC flexible) (Page 120)

Basics on migration (WinCC flexible) (Page 92)

4.6.1.5 Reference (WinCC flexible)

Migrating data types (WinCC flexible)

Introduction
To harmonize the data types used by PLCs and HMI systems, some data types of the internal 
HMI tags are renamed. The naming takes place in accordance with IEC conventions. Because 
only the names change, there are no changes to the internal tags for the configuration. 

The following table describes the mapping of the internal data types from WinCC flexible to 
the data types in WinCC.

Migrating internal data types
The internal data types are mapped as follows during migration:    

Internal data types WinCC flexible Internal data types WinCC
Bool Bool
Char SInt
Byte USInt
Int Int
UInt UInt
Long DInt
ULong UDInt
Float Real
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Internal data types WinCC flexible Internal data types WinCC
Double LReal
String WString
DateTime DateTime

Migrating external data types
See the following pages for how to map the available communication drivers.

See also
Migration (WinCC flexible) (Page 91)

Migrating data types of Allen-Bradley DF1 (WinCC flexible) (Page 125)

Migrating data types of Allen-Bradley DF485 (WinCC flexible) (Page 125)

Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible) (Page 126)

Migrating data types of GE Fanuc SNP (WinCC flexible) (Page 126)

Migrating data types of LG GLOFA GM (WinCC flexible) (Page 127)

Migrating data types of Mitsubishi FX (WinCC flexible) (Page 127)

Migrating data types of Modicon Modbus (WinCC flexible) (Page 129)

Migrating data types of Modicon Modbus TCP/IP (WinCC flexible) (Page 129)

Migrating data types of Omron Hostlink/Multilink (WinCC flexible) (Page 130)

Migrating data types of OPC (WinCC flexible) (Page 130)

Migrating data types of SIMATIC 500/505 DP (WinCC flexible) (Page 131)

Migrating data types of SIMATIC 500/505 serial (WinCC flexible) (Page 131)

Migrating data types of SIMATIC S5 AS511 (WinCC flexible) (Page 132)

Migrating data types of SIMATIC S5 DP (WinCC flexible) (Page 133)

Migrating data types of SIMATIC S7 200 (WinCC flexible) (Page 134)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible) (Page 134)

Migrating data types of Telemecanique Uni-Telway (WinCC flexible) (Page 137)

Migrating data types of Mitsubishi Protocol 4 (WinCC flexible) (Page 128)

Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible) (Page 132)
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Migrating data types of Allen-Bradley DF1 (WinCC flexible)

Migrating data types Allen-Bradley DF1
The data types of the Allen-Bradley DF1 communication driver are mapped as follows in the 
migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
BCD4 UInt
BCD8 UDInt
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of Allen-Bradley DF485 (WinCC flexible)

Migrating data types Allen-Bradley DH485
The Allen-Bradley DH485 communication driver is not supported by WinCC, it is replaced by 
the Allen-Bradley DF1 driver. The data types of the Allen-Bradley DH485 communication driver 
are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt

See also
Migrating data types (WinCC flexible) (Page 123)
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Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible)

Migrating data types Allen-Bradley Ethernet IP
The data types of the Allen-Bradley Ethernet IP communication driver are mapped as follows 
in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
DInt DInt
Int Int
Real Real
SInt SInt
String String
UDInt UDInt
UInt UInt
USInt USInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of GE Fanuc SNP (WinCC flexible)

Migrating data types GE Fanuc SNP
The GE Fanuc SNP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the GE Fanuc SNP 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
BCD4 UInt
BCD8 UDInt
Bit Bool
Byte USInt
DInt DInt
Word UInt
Int Int
Real Real
UInt UInt
DWord UDInt
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See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of LG GLOFA GM (WinCC flexible)

Migrating data types LG GLOFA GM
The LG GLOFA GM communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the LG GLOFA GM 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
DInt DInt
DWord UDInt
Int Int
SInt SInt
String WString
Time UDInt
UDInt UDInt
UInt UInt
USInt USInt
Word UInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of Mitsubishi FX (WinCC flexible)

Migrating data types Mitsubishi FX
The data types of the Mitsubishi FX communication driver are mapped as follows in the 
migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
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Data type in WinCC flexible Data type in WinCC
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
Bit Bool
Double DWord
IEEE-Float Real
String String
Word Word

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of Mitsubishi Protocol 4 (WinCC flexible)

Migrating data types Mitsubishi Protocol 4
The Mitsubishi Protocol 4 communication driver is not supported by WinCC, it is replaced by 
the Mitsubishi MC TCP/IP driver. The data types of the Mitsubishi Protocol 4 communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
Bit Bool
DInt DInt
DWord DWord
Int Int
Real Real
String String
Word Word

See also
Migrating data types (WinCC flexible) (Page 123)
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Migrating data types of Modicon Modbus (WinCC flexible)

Migrating data types Modicon Modbus
The Modicon Modbus communication driver is not supported by WinCC, it is replaced by the 
Modicon Modbus RTU driver. The data types of the Modicon Modbus communication driver 
are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
Float Float
Int Int

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of Modicon Modbus TCP/IP (WinCC flexible)

Migrating data types Modicon Modbus TCP/IP
The data types of the Modicon Modbus TCP/IP communication driver are mapped as follows 
in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
Float Float
Int Int

See also
Migrating data types (WinCC flexible) (Page 123)
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Migrating data types of Omron Hostlink/Multilink (WinCC flexible)

Migrating data types Omron Hostlink/Multilink
The Omron Hostlink/Multilink communication driver is not supported by WinCC, it is replaced 
by the Omron Host Link driver. The data types of the Omron Hostlink/Multilink communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-DEC Int
+/-LDEC DInt
ASCII String
BIN Bool
BYTE Byte
DEC UInt
IEEE Real
LDEC UDInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of OPC (WinCC flexible)

Migrating data types OPC
The data types of the OPC communication driver are mapped as follows in the migration to 
WinCC:   

Data type in WinCC flexible Data type in WinCC
Bool VT_BOOL
Byte VT_UI1
Char VT_I1
Date VT_DATE
Double VT_R8
DWord VT_UI4
Float VT_R4
Long VT_I4
Short VT_I2
String VT_BSTR
Word VT_UI2
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See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC 500/505 DP (WinCC flexible)

Migrating data types SIMATIC 500/505 DP
The SIMATIC 500/505 DP communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC 500/505 serial (WinCC flexible)

Migrating data types SIMATIC 500/505 seriell
The SIMATIC 500/505 seriell communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 seriell 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

Migrating projects
4.6 Migrating WinCC flexible projects (Professional)

WinCC Professional V11.0 SP1
System Manual, 08/2011,  131



See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible)

Migrating data types SIMATIC HMI HTTP Protocol
The data types of the SIMATIC HMI HTTP Protocol communication driver are mapped as 
follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
Char SInt
DateTime DateTime
Double LReal
Float Real
Int Int
Long DInt
String WString
UInt UInt
ULong UDInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC S5 AS511 (WinCC flexible)

Migrating data types SIMATIC S5 AS511
The SIMATIC S5 AS511 communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 AS511 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
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Data type in WinCC flexible Data type in WinCC
KH UInt
KM UInt
KT UDInt
KY UInt
KZ UInt

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC S5 DP (WinCC flexible)

Migrating data types SIMATIC S5 DP
The SIMATIC S5 DP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
KH UInt
KM UInt
KT UDInt
KY UInt
KZ UInt

See also
Migrating data types (WinCC flexible) (Page 123)
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Migrating data types of SIMATIC S7 200 (WinCC flexible)

Migrating data types SIMATIC S7 200
The data types of the SIMATIC S7 200 communication driver are mapped as follows in the 
migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char (Range of values: -128...127) Char (Range of values: 0...255)
DInt DInt
DWord DWord
Int Int
Real Real
StringChar StringChar
Timer Timer
Word Word

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible)

Migrating data types SIMATIC S7 300/400
The data types of the SIMATIC S7 300/400 communication driver are mapped as follows in 
the migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char see below
Counter see below
Date Date
Date and Time Date_And_Time
DInt DInt
DWord DWord
Int Int
Real Real
String String
StringChar see below
Time Time
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Data type in WinCC flexible Data type in WinCC
Time of Day Time_Of_Day
Timer see below
Word Word

Special considerations for some data types
There are special considerations to be made when migrating external tags that contain data 
types of a SIMATIC S7-300/400 PLC.

Mapping of the S7 data type "Char"
The S7 data type "Char" is a data type for mapping characters according to the specification. 
However, since this data type is often used for reading and writing numerical values, it is 
mapped in WinCC to the S7 data type "Byte". If this should be the case during migration, an 
alarm will appear in the output window.

If the S7 data type "Char" is used for numerical values and negative numbers were configured 
at the point of use, the result is an error in mapping to the S7 data type "Byte". The S7 data 
type "Byte" cannot map any negative numbers. You have to adapt the configuration accordingly 
to correct the error. Use a signed data type, such as the data type "Int", for processing positive 
and negative numerical values.

If the S7 data type "Char" is used for mapping characters, you must change the configuration 
after migration. To represent characters, use the data type "String".

When an integrated project is migrated, the data type "Char" in WinCC is also migrated to the 
data type "Byte". With a connected PLC tag, the data type "Char" remains "Char". As a result 
of changing the data type of the HMI tag, symbolic addressing of the tags in question is not 
migrated. After migration. the tags are interconnected by absolute addresses and continue to 
work. If you want to restore symbolic addressing, you have to change the configuration 
accordingly after the migration.

Mapping an array of the S7 data type "Char"
An array of the S7 data type "Char" is mapped to an array of the data type "Byte" during 
migration.

If an array of the S7 data type "Char" is used for numerical values and negative numbers were 
configured at the point of use, the result is an error in mapping to an array of the S7 data type 
"Byte". The S7 data type "Byte" cannot map any negative numbers. You have to adapt the 
configuration accordingly to correct the error. Use a signed data type, such as the data type 
"Int", for processing positive and negative numerical values.

Mapping of the S7 data type "Counter"
An external tag with the S7 data type "Counter" with counter address is mapped to the S7 data 
type "Counter". The address will be retained.

If an external tag with the S7 data type "Counter" addresses a data block or a bit memory 
address, it is is mapped to the S7 data type "Word". The address will be retained. The migration 
sets the coding to "SimaticBCDCounter".
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The S7 data type "Counter" has a value range of 0-999. When supplied by the S7 data type 
"Word" the value range may be exceeded on the PLC side. Ensure that you are observing the 
value range.

Example:

WinCC flexible

Tag S7 data type Address Comment
Counter_Actual_Value Counter C10 BCD coded counter value
Counter_Setpoint_Value Counter DB10.DBW200 BCD coded counter value
Counter_Setpoint_Value#2 Counter MW20 BCD coded counter value

WinCC

Tag S7 data 
type

Address Coding Comment

Counter_Actual_Value Counter %C10 <Standard> BCD coded counter 
value

Counter_Setpoint_Value Word %DB10.%DB
W200

SimaticBCDCounter BCD coded counter 
value

Counter_Setpoint_Value#2 Word %MW20 SimaticBCDCounter BCD coded counter 
value

Mapping of the data type "StringChar"
In WinCC there is no corresponding data type to which the "StringChar" data type can be 
mapped. Mapping in WinCC depends on the property "Length" of the S7 data type.

A tag of the "StringChar" data type with the "Length" property > 1 is migrated to an array of 
the S7 data type "Char". The length of the array corresponds to the length of the originally 
configured data type "StringChar".

If the property "Length" = 1, the data type in WinCC is migrated to an array of the S7 data type 
"Char" with length = 1. The expression for an array with an element is "Array[0 ..0] of Char".

Mapping of the S7 data type "Timer"
An external tag with the S7 data type "Timer" with timer address is mapped to the S7 data type 
"Timer". The address will be retained.

If an external tag with the S7 data type "Timer" addresses a data block or a bit memory address, 
it is is mapped to the S7 data type "S5 Time". The address will be retained.

Example:

WinCC flexible
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Tag S7 data type Address Comment
Timer_Actual_Value Timer T10 BCD coded timer value
Timer_Setpoint_Value Timer DB10.DBW200 BCD coded timer value
Timer_Setpoint_Value#2 Timer MW20 BCD coded timer value

WinCC

Tag S7 data type Address Comment
Timer_Actual_Value Timer %T10 BCD coded timer value
Timer_Setpoint_Value S5Time %DB10.%DBW200 BCD coded timer value
Timer_Setpoint_Value#2 S5Time %MW20 BCD coded timer value

See also
Migrating data types (WinCC flexible) (Page 123)

Migrating data types of Telemecanique Uni-Telway (WinCC flexible)

Migrating data types Telemecanique Uni-Telway
The Telemecanique Uni-Telway communication driver is not supported by WinCC, the data 
types are mapped to the internal data types of WinCC. The data types of the Telemecanique 
Uni-Telway communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Int Int
+/-Long DInt
ASCII WString
Bool Bool
Float Real
Int UInt
Long UDInt

See also
Migrating data types (WinCC flexible) (Page 123)
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4.7 Post-editing integrated projects

4.7.1 Migrating an integrated project

Introduction
When an integrated project is migrated, the complete project will be migrated with components 
from Wind and STEP 7. Configured connections between control and visualization remain 
intact.

Migrating an integrated project  
When migrating an integrated project, the same requirements apply for the STEP 7 component 
as those for migration of a non-integrated STEP 7 project. The objects and properties contained 
in the Wind component must also be supported in Wind (IA Portal). For detailed information, 
refer to the documentation for Wind.   

To fully migrate an integrated project, the following components must be installed on the PH/
PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC V7 SP1 or SP2 or Wind Flexible 2008 SP2

To be able to fully post-edit an integrated project, the following components must be installed 
on the PC for post-editing:

● STEP 7 Professional V11 (IA Portal)

● Wind Basic, Wind Comfort/Advanced oder Wind Professional, depending on the 
components used

If the initial project is not located on the same PH/PC on which the IA Portal is installed, first 
use the migration tool to prepare migration. This enables you to convert the initial project to a 
format that can be read for the IA Portal.

Migration of the STEP 7 part of an integrated project
An integrated project is always fully migrated. Individual components cannot be migrated on 
their own. You can only migrate the included STEP 7 project alone, if you have previously 
deleted all HMI stations in the SIMATIC stations in the SIMATIC manager and then recompiled 
the project in NetPro.

Alternatively, you can open the project in an installation of STEP 7 V5.4 S or V5.5 without an 
installation of Wind. Then, save the project again and select the "Reorganize" function during 
saving. The Wind parts are then automatically removed during the saving of the copy.

You can then migrate the STEP 7 project without the Wind project.
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Migration of an integrated project without the hardware configuration
You can migrate an integrated project just like any other project without the hardware 
configuration. In this case, only the software of the initial project is migrated. The STEP 7 
devices, network configurations, connections and interrupts used in the initial project are not 
migrated. However, HMI devices are always retained even if you migrate without hardware 
configuration. 

HMI modules that are plugged into a PC station are converted to a separate Station during the 
migration. Thus, the migrated project contains a non-specified SIMATIC PC Station and a 
SIMATIC PC Station with the HMI devices. References to HMI devices are not imported during 
migration.

The following chapters describe, by way of example, how you post-edit an integrated project 
after the migration, in order to restore the full functionality of source project.

Storage location of an integrated Wind project
If you migrate an integrated project, the HMI portion of it must be on the same PH/PC as the 
STEP 7 portion of the project. If the HMI portion is on a different PH, then only the STEP 7 
portion will be migrated.

Unsupported objects
The following components are not supported for migration:

● STEP 7 multiproject
A STEP 7 multiproject cannot be migrated. Migration will be canceled.

● Central Archive Server - CAS
If a CAS is part of an integrated project, then the migration will be carried out but the CAS 
data will not be migrated.

See also
Post-editing integrated projects (Page 139)

4.7.2 Post-editing integrated projects
If you have migrated an integrated project without hardware configuration, unspecified CPUs 
are used instead of the CPUs of the original project. Since no connection can exist between 
an unspecified CPU and an HMI device, connections from the source project are also imported 
only unspecified. 

The following figure shows the state after a Migration without hardware configuration in an 
example project:
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1

2

① The original CPU 317-2 PN/DP was replaced with an unspecified CPU during migration.
② The link between the CPU and HMI device is also unspecified and must be renewed.

Procedure
To continue to use an integrated project after the migration, follow these steps:

1. Convert the unspecified devices into suitable devices again.

2. Restore the integrated HMI connection between the HMI device and the PLC.

3. Connect all HMI tags to the newly created integrated connection.

4. Restore the connection between HMI tags and PLC tags.

5. Delete the non-integrated HMI connection.

In the following chapters a sample project is used to describe the individual steps in more detail.

See also
Converting unspecified CPUs into specified CPUs (Page 141)

Creating an integrated HMI connection (Page 142)

Re-linking HMI tags (Page 144)

Deleting an unspecified connection (Page 145)
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4.7.3 Converting unspecified CPUs into specified CPUs
The first step after the migration without hardware configuration is the conversion of the 
unspecified CPUs into specified CPUs. Unspecified CPUs are placeholders for certain CPUs 
from the hardware catalog that are not currently known. You can define general parameters 
and home the CPUs already in the user program. However, the project is not fully functional 
until the unspecified CPU has been specified.

Specifying a CPU using module replacement    
To use module replacement to specify an unspecified CPU, follow these steps:

1. Select the unspecified CPU in the network or device view.

2. Select the "Replace device" command in the shortcut menu.
The "Replace device" dialog opens.

1

2
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3. Under "New device" in the tree structure, select the module with which you want to replace 
the unspecified CPU. (Area 1)
"Compatibility information" provides you with information on the extent to which the selected 
CPU is compatible with the configuration in source project. (Area 2)

4. Click "OK".

5. Perform the above-described steps for all unspecified CPUs.

See also
Creating an integrated HMI connection (Page 142)

4.7.4 Creating an integrated HMI connection
After you have specified the unspecified CPU, establish the connection to the HMI-device.

Procedure   
To create a connection graphically, follow these steps:

1. On the toolbar, click the "Connections" icon. This activates connection mode.

2. Select the connection type "HMI connection" in the adjacent drop-down list.
The network view highlights in color all CPUs and HMI devices that can be used for an HMI 
connection.

3. You can now have the connection path automatically determined, or explicitly select a 
connection path via specific interfaces:

– Allow connection path to be automatically determined
Select the source CPU for a connection. Drag the mouse to the target components. 
Confirm the connection endpoint with another mouse click.
Alternatively: While holding down the shift button, select the target components and with 
the right mouse button select the "Add new connection" command.

– Selecting an explicit connection path from interface to interface
Click on the subnet interface in the device for which you want to create a connection. 
Hold down the mouse button, drag the cursor to the relevant interface in the target device 
and then release the mouse button.
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Result
The following figure shows the state after the integrated connection has been created:

1

2

3

① An integrated HMI connection is created and highlighted in the network view.
② The connection is shown in the connection table of the components.
③ The connection can be edited in the connection properties.

 

See also
Re-linking HMI tags (Page 144)
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4.7.5 Re-linking HMI tags
When you have created a new HMI connection between the CPU and HMI device, you have 
to assign the existing HMI tags to the new connection. Perform the following steps for each 
line in the relevant tag table.

Procedure   
To re-link HMI tags, follow these steps:

1. In the project tree, navigate to the HMI tags and double-click the relevant tag table to show 
this in the work area.
The tag table opens.

2. Click the " ... " button in the "Connection" column.
A dialog box for selecting the connection opens.

3. Select the newly established HMI connection.

4. Click the "✓" button to apply the selected connection.

5. On the toolbar, click the "Re-connect PLC tag" button.
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See also
Deleting an unspecified connection (Page 145)

4.7.6 Deleting an unspecified connection
Finally, you can remove unspecified connections that still remain from the source project.

Procedure   
To delete unspecified connections, follow these steps:

1. In the project tree, open the HMI device and double-click the "Connections" entry.
The connection table opens.

2. Select the row with the old connection in the table.

3. Select the "Delete" command in the shortcut menu of the connection line.

4. Perform the above-described steps for all unspecified connections of the source project.
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First steps 5
5.1 Getting Started Documentation

Getting started with the TIA Portal
The Getting Started documentation is available to help you begin using the TIA portal.

The Getting Started documentation contains instructions which show you, step-by-step how 
to create a project in the TIA portal and give you the chance to get a quick overview of all the 
possibilities the TIA portal offers you.

Contents
The Getting Started documents describe the creation of a single, continuous project that is 
extended with each chapter. You start with simple basic functions, and use more complex ones 
as you continue with the creation of the project.

In addition to the step-by-step instructions, the Getting Started documents also give you 
background information that explains the functions used and illustrate how they relate to each 
other.

Target audience
The Getting Started documents are intended for beginners, but are also useful for users 
migrating from a previous version of SIMATIC STEP 7 and WinCC.

Download
The documentation is available, free of charge at the Service&Support (https://
support.automation.siemens.com) portal in PDF form. 

You can download the documents here:

● STEP 7 Basic (http://support.automation.siemens.com/WW/view/en/40263542/0/en)

● STEP 7 Professional (http://support.automation.siemens.com/WW/view/en/
28919804/133300)
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Introduction to the TIA Portal 6
6.1 User interface and operation

6.1.1  Starting, setting and exiting the TIA Portal

6.1.1.1 Starting and exiting the TIA Portal

Starting the TIA Portal 
Follow the steps below to start the TIA Portal:

1. In Windows, select "Start > Programs > Siemens Automation > TIA Portal V11".
The TIA Portal opens with the last settings used.

Exiting the TIA Portal
Follow the steps below to exit the TIA Portal:

1. In the "Project" menu, select the "Exit" command.
If the project contains any changes that have not been saved, you will be asked if you wish 
to save them.

– Select "Yes" to save the changes in the current project and close the TIA Portal.

– Select "No" to close the TIA Portal without saving the most recent changes in the project.

– Select "Cancel" to cancel the closing procedure. The TIA Portal will remain open if you 
select this option.

6.1.1.2 Overview of the program settings

Overview   
The following table shows the application settings that you can make:

WinCC Professional V11.0 SP1
System Manual, 08/2011,  149



Group Setting Description
General settings User name The user name of the user. The user name is stored in the project 

properties when a new project is created.
User interface language Language for the program interface
Mnemonic Specifies the mnemonics for programming: 

"German" uses the German mnemonics, for example, "E1.0".
"International" uses international mnemonics, for example, "I1.0".
For information on the differences in the mnemonics of the 
individual commands, refer to the description of the relevant 
programming language.

Show list of recently used 
projects

Number of entries in the list of recently used projects in the 
"Project" menu

Show all message 
windows

All message windows whose appearance was manually 
suppressed are displayed again.

Open cascade 
automatically in tooltips

After a brief time, the tooltips automatically expand to display a 
cascade containing additional help. If this option is cleared, the 
tooltips must be manually expanded.

Layout Load most recent project 
during startup

The last opened project is opened automatically after the TIA 
Portal starts.

Reset layout Resets the complete layout of the application to factory settings.
Start view Most recent view Starts the program in the last view that was used. This can be be 

either the portal view or the project view.
Portal view The TIA Portal will always be started in the portal view, 

irrespective of the last view you worked in.
Project view The TIA Portal will always be started in the project view, 

irrespective of the last view you worked in.
View for objects in overview Details When several views are available, the detail view opens by 

default, for example, in the overview window.
List When several views are available, the list view opens by default, 

for example, in the overview window.
Thumbnails When several views are available, the symbol view opens by 

default, for example, in the overview window.
Storage settings Recently used storage 

location
When a project is saved the first time, the most recently used file 
path is set by default.

Default storage location Enables the specification of file paths for:
● Projects
● Libraries

Data exchange Storage location for data 
import

Imported files are searched for at this storage path by default.

Storage location for data 
export

This is the default storage path for the data export.

Storage location for 
support packages

When support packages are downloaded, they are stored in the 
specified storage path and can be installed from there.

Storage location for log 
files

Log files are stored at the location specified here.
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See also
Starting and exiting the TIA Portal (Page 149)

Resetting the user interface layout (Page 177)

Changing the settings (Page 153)

6.1.1.3 Overview of the script and text editor settings

Overview   
The following table shows the available settings for script and text editors:

Group Setting Description
Font Font type and size Sets the font type and size for the text in text editors.
Font colors Color settings You can choose the colors for individual text elements from the 

respective drop-down lists in the text editors. Optional settings 
are available for the following text elements:
● Text
● Keywords
● Comments
● Translatable comments
● Instructions
● Scripts
● Standard functions
● System functions
● Constant strings
● Constant tags
● Tags
● Object models
● Formal parameters

Reset to default Resets all font colors in editors to their factory settings.
Tabs Tab width Sets the width of tabs.

Use tabs Enables the use of tabs.
Use spaces Specifies use of space characters instead of tabs.

Indent Indention at start of 
paragraph

Specifies whether the start of a new paragraph is to be indented. 
The following selection options are available:
● None

No indentation is used at the beginning of a paragraph in 
editors.

● Block
The first line of a paragraph in the editors is automatically 
indented.

● Smart
The program code is detected and the paragraphs are 
automatically indented to improve readability of the syntax.
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Group Setting Description
View Show line numbers Displays the line numbers on the left side of the text.

Show white spaces Shows control characters within a text.
STL (statement list) Font type and size Sets the font type and size for STL program code.
SCL (Structured Control 
Language)

Font type and size Sets the font type and size for SCL.
Indentation Creates SCL programs automatically with syntactically correct 

indentation.
Show line numbers Shows the row numbers in SCL programs.

See also
Changing the settings (Page 153)

6.1.1.4 Overview of the print settings

Overview   
The following table shows the available settings for printing:

Group Setting Description
General Always print table data as 

pairs of values
Tables are printed as a list and not in tabular form. The corresponding 
values are listed for each column.
Enable this option, for example, if you want to print a table that is too 
large for the print area.

Always print data in tables All parameters of technology objects are printed in tabular format.
Print mask graphics if 
possible

If the utilized editor supports this function, the contents of the editor 
are printed not only as a table but rather as a complete graphic as it 
appears on the screen.

Hardware 
configuration

Active graphic view The graphics of network and device view are included in the printout.
Active table A table associated with an editor is included when printing with the 

editor.
PLC Programming Zoom factor Specifies the size in which blocks are to be printed out.

With interface The interfaces of blocks are included in the printout.
With comments Comments on blocks are included in the printout.
With line numbers The line numbers of the program code are printed for text-based 

programming languages.
HMI screens Show tab order In the printout you can specify the order in which the runtime objects 

can be selected with the TAB key.

See also
Changing the settings (Page 153)
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6.1.1.5 Changing the settings

Procedure 
To change the settings, proceed as follows:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation to change the settings described in the 
previous sections. Or click on one of the other entries in area navigation to make settings 
for your installed products.

3. Change the settings.

Result
The change will be adopted immediately, there is no need to save it explicitly.

See also
Overview of the program settings (Page 149)

Overview of the script and text editor settings (Page 151)

Overview of the print settings (Page 152)

6.1.2 Layout of the user interface

6.1.2.1 Views

Views 
Two different views are available for your automation project:

● The portal view is a task-oriented view of the project tasks.

● The project view is a view of the components of the project, as well as the relevant work 
areas and editors.

You can change over between the two views using a link.

6.1.2.2 Portal view

Purpose of the portal view 
The portal view provides you with a task-oriented view of the tools. Here, you can quickly 
decide what you want to do and call up the tool for the task in hand. If necessary, the view 
changes automatically to the project view (Page 155) for the selected task.
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Layout of the portal view
The following figure shows an example of the components in the portal view:

① Portals for different tasks 
② Actions for the selected portal
③ Selection panel for the selected action
④ Change to the project view
⑤ Display of the project that is currently open

Portals
The portals provide the basic functions for the individual task areas. The portals that are 
provided in the portal view depends on the products that have been installed.

Actions for the selected portal
Here, you will find the actions available to you in the portal you have selected. You can call up 
the help function in every portal on a context-sensitive basis.

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Professional V11.0 SP1
154 System Manual, 08/2011,  



Selection panel for the selected action
The selection panel is available in all portals. The content of the panel adapts to your current 
selection. 

Change to the project view
You can use the "Project view" link to change to the project view.

Display of the project that is currently open
Here, you can obtain information about which project is currently open.

See also
Project navigation (Page 157)

Basics of the work area (Page 160)

Inspector window (Page 169)

Basics on task cards (Page 171)

Details view (Page 172)

6.1.2.3 Project view

Purpose of the project view 
The project view is a structured view of all components of the project. 
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Layout of the project view
The following figure shows an example of the components of the project view:

① Title bar
② Menu bar
③ Toolbar
④ Project tree (Page 157) 
⑤ Work area (Page 160) 
⑥ Task cards (Page 171) 
⑦ Details view  (Page 172)
⑧ Inspector window (Page 169) 
⑨ Changing to the Portal view (Page 153)
⑩ Editor bar
⑪ Status bar with progress display
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Title bar
The name of the project is displayed in the title bar.

Menu bar
The menu bar contains all the commands that you require for your work.

Toolbar
The toolbar provides you with buttons for commands you will use frequently. This gives you 
faster access to these commands.

Changing to the portal view
You can use the "Portal view" link to change to the portal view.

Editor bar
The Editor bar displays the open editors. If you have opened a lot of editors, they are shown 
grouped together. You can use the Editor bar to change quickly between the open elements.

Status bar with progress display
In the status bar, you will find the progress display for processes that are currently running in 
the background. This also includes a progress bar that shows the progress graphically. Hover 
the mouse pointer over the progress bar to display a tooltip providing additional information 
on the active background process. You can cancel the background processes by clicking the 
button next to the progress bar.

If no background processes are currently running, the status bar displays the last generated 
alarm.

6.1.2.4 Project navigation

Function of the project tree   
Using the project tree features gives you access to all components and project data. You can 
perform the following tasks in the project tree:

● Add new components

● Edit existing components

● Scan and modify the properties of existing components

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Professional V11.0 SP1
System Manual, 08/2011,  157



Layout of project tree
The following figure shows an example of the project tree components:

① Title bar
② Toolbar
③ Project
④ Devices
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⑤ Common data
⑥ Document information
⑦ Languages & resources
⑧ Online access
⑨ SIMATIC Card Reader

Title bar
The title bar of the project tree has a button for automatically and manually collapsing the 
project tree. Once it is collapsed manually, the button is "Reduced" to the left-hand margin. It 
changes from an arrow pointing left to one that is pointing right, and can now be used to reopen 
the project tree. You can use the "Reduce automatically" button collapse to project tree 
automatically when you do not need it. 

See also: Maximizing and minimizing the work area (Page 162)

Toolbar
You can do the following tasks in the toolbar of the project tree:

● Create a new user folder; for example, in order to group blocks in the "Program blocks" 
folder.

● Navigate forward to the source of a link and back to the link itself.
There are two buttons for links in the project tree. You can use these to navigate from the 
link to the source and back.

● Show an overview of the selected object in the work area.
When the overview is displayed, the lower-level objects and actions of the elements in the 
project tree are hidden. 

Project
You will find all the objects and actions related to the project in the "Project" folder, e.g.:

● Devices

● Languages & resources

● Online access

Device
There is a separate folder for each device in the project, which has an internal project name. 
Objects and actions belonging to the device are arranged inside this folder.

Common data
This folder contains data that you can use across more than one device, such as common 
message classes, scripts and text lists.
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Document information
In this folder, you can specify the layout for project documentation to be printed at a later point.

Languages & resources
You can determine the project languages and texts in this folder. 

Online access
This folder contains all the interfaces of the programming device / PC, even if they are not 
used for communication with a module.

SIMATIC Card Reader
This folder is used to manage all card readers connected to the programming device / PC.

See also
Portal view (Page 153)

Project view (Page 155)

Basics of the work area (Page 160)

Inspector window (Page 169)

Basics on task cards (Page 171)

Details view (Page 172)

6.1.2.5 Work area

Basics of the work area

Function of the work area   
The objects that you can open for editing purposes are displayed in the work area. These 
objects include, for example:

● Editors and views

● Tables

You can open several objects. However, normally it is only possible to see one of these at a 
time in the work area. All other objects are displayed as tabs in the Editor bar. If, you would 
like to view two objects at the same time when performing certain tasks, you can tile the work 
area either horizontally or vertically or undock elements of the work area. If no objects are 
open, the work area will be empty.
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Layout of the work area
The following figure shows an example of a vertically split work area:

1 3

2 4

① Title bar of left-hand editor 
② Work area of left-hand editor
③ Title bar of right-hand editor
④ Work area of right-hand editor
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See also
Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)

Maximizing and minimizing the work area
You have the option to adapt the work area to make it as large as possible. You can use the 
following function for this:

● Maximizing the work area
You can close the task cards, project tree and inspector window with a single click. This 
increases the size of the work area. You can minimize the work area again at any time in 
order to return to the previous view.

● Collapsing task cards, project tree, and Inspector window automatically
You can use the "Collapse automatically" option for the task cards, project tree, and 
Inspector window. This function causes these items to collapse automatically when you 
don't need them. 

Maximizing and minimizing the work area    
To maximize the work area, follow these steps:

1. Open an element such as an editor or a table.
The element appears in the work area.

2. Click the "Maximize" button in the title bar of the element.
The task cards, project tree and inspector window collapse, and the work area is shown 
with its maximum dimensions.

To minimize the work area again, follow these steps:
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1. Click the "Embed" button in the title bar of the displayed element.
This restores the view that existed before the work area was maximized. That is, if the task 
cards, project tree, or Inspector window were expanded before, they will be expanded 
again. 

Collapsing task cards, project tree, and Inspector window automatically   
To collapse the task cards automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the task cards.
The task cards collapse when you click anywhere outside the task cards. 

2. To use the task cards, click the collapsed task cards.

3. The task cards expand and are available for use. The "Collapse automatically" option 
remains enabled.

To collapse the project tree automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the project tree.
The project tree collapses when you click anywhere outside the project tree. 

2. To use the project tree, click the collapsed project tree.
The project tree expands and is available for use. The "Collapse automatically" option 
remains enabled.

To collapse the Inspector window automatically, follow these steps: 

1. Click "Collapse automatically" in the title bar of the Inspector window.
The Inspector window collapses when you click anywhere outside the Inspector window. 

2. To use the Inspector window, click the collapsed Inspector window.
The Inspector window expands and is available for use. The "Collapse automatically" option 
remains enabled.

To disable the automatic collapse option, follow these steps:

1. Click "Expand permanently" again in the relevant window.
The Collapse automatically" option is disabled, and the window remains expanded.

 

See also
Basics of the work area (Page 160)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)
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Splitting the work area
You can split the work area vertically or horizontally.

Procedure
To split the work area vertically or horizontally, follow these steps:

1. In the "Window" menu, select the "Split editor space vertically" or "Split editor space 
horizontally" command.
The element you have clicked and the next element in the Editor bar will be displayed either 
next to one another or one above the other.

 

 Note

If no elements are open in the work area, the "Split editor space vertically" and "Split editor 
space horizontally" functions will not be available.

 

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)

Floating the work area elements
You can float work area elements in their own separate window:

● Editors

● Tables

● Setting windows

● Task cards

● Inspector window

You can embed floating elements again in the work area at any time.
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Floating the work area elements  
To float work area elements, follow these steps:

1. Click the "Float" button in the title bar of the element.
The element will be released from the work area and displayed in its own window. You can 
now place the window wherever you wish. If you have minimized the window, you can 
restore it via the editor bar.

Embedding elements in the work area
To embed elements in the work area again, follow these steps:

1. Click the "Embed" button in the title bar of the element.
The element will appear in the work area again.

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)

Using grouped elements of the work area
If you open more than five elements of the same type, e.g., editors or tables, they are grouped 
in the editor bar. You can use these groups as follows:

● Displaying individual elements of a group

● Displaying all elements of a group in separate windows

● Embedding all displayed elements of a group in the work area

● Minimizing all displayed elements

● Closing all elements of a group

Displaying individual elements of a group  
To display individual elements of a group, follow these steps:

1. In the editor bar, click the group containing the element you want to display.
All list of all available elements of the group is displayed.

2. Click the element that you want to display.
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Displaying all elements of a group in separate windows
To display all elements of a group in separate windows, follow these steps:

1. In the editor bar, right-click the group whose elements you want to display.

2. Select "Restore group" in the shortcut menu.
All elements of the group are displayed in separate, overlapping windows. Move the 
windows in order to see the individual element, or choose an element via the group in the 
editor bar.

Embedding all displayed elements of a group in the work area
To embed all elements of a group displayed in separate windows in the work area again, follow 
these steps:

1. In the editor bar, right-click the group whose elements you want to embed.

2. Select "Embed group" in the shortcut menu.
All elements of the group are embedded in the work area again.

Minimizing all displayed elements
To minimize all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to minimize.

2. Select "Minimize group" in the shortcut menu.
All elements of the group are minimized. However, the minimized elements remain open 
and can be quickly maximized again via the group in the editor bar.

Closing all elements of a group
To close all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to close.

2. Select "Close group" in the shortcut menu.
All elements of the group are closed. The group is removed. 

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)
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Minimizing and maximizing elements of the work area
You can minimize the elements that are open in the work area, such as editors or tables, as 
needed. However, an element remains open even if it has been minimized, and can quickly 
be maximized again using the editor bar.

Minimizing elements in the work area 
To minimize elements in the work area, follow these steps:

1. Click the "Minimize" button in the title bar of the element.
The element is minimized, but can still be accessed via the editor bar.

To minimize all elements at the same time, follow these steps:

1. In the "Window" menu, select the "Minimize all" command.

Maximizing elements in the work area 
To maximize elements in the work area again, follow these steps:

1. Click the required element in the editor bar.
The element is maximized and appears in the work area.

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Switching between the elements in the work area (Page 167)

Saving a layout of editors and tables (Page 168)

Switching between the elements in the work area
You can switch between the elements in the work area at any time.
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Switching between the elements in the work area
To switch to the previous or next editor, follow these steps:

1. In the "Window" menu, select the "Next editor" or "Previous editor" command.
The next or previous editor will be displayed.

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Saving a layout of editors and tables (Page 168)

Saving a layout of editors and tables
You have the option of adapting editors and tables to meet your requirements. For example, 
you can hide columns in tables that you don't need. You can then save your customized view.

Procedure  
To save the layout of editors and tables in the work area, follow these steps:

1. Adapt the editor or table according to your requirements.

2. Click the "Remember Layout" button in the editor or table.

Result
The layout is saved. When you reopen the editor or table, this layout will be used.

See also
Basics of the work area (Page 160)

Maximizing and minimizing the work area (Page 162)

Splitting the work area (Page 164)

Floating the work area elements (Page 164)

Using grouped elements of the work area (Page 165)

Minimizing and maximizing elements of the work area (Page 167)

Switching between the elements in the work area (Page 167)
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6.1.2.6 Inspector window

Function of the Inspector window
Additional information on an object selected or on actions executed are displayed in the 
inspector window. 

Layout of the Inspector window
The following figures show the components of the Inspector window:

4

5

3

① "Properties" tab
② "Info" tab
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③ "Diagnostics" tab
④ Navigation within the tabs:

● Area navigation within the "Properties" tab
● Lower-level tabs in the "Info" and "Diagnostics" tabs

"Properties" tab
This tab displays the properties of the object selected. You can change editable properties 
here.

"Info" tab
This tab displays additional information on the object selected, as well as alarms on the actions 
executed (such as compiling). 

"Diagnostics" tab
This tab provides information on system diagnostics events, configured alarm events, and 
connection diagnostics.

Navigation within the tabs
You can use area navigation and the lower-level tabs to display the information you require 
within the tabs. 

See also
Project navigation (Page 157)

Basics of the work area (Page 160)

Portal view (Page 153)

Project view (Page 155)

Basics on task cards (Page 171)

Details view (Page 172)
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6.1.2.7 Task cards

Basics on task cards

Function of task cards
Depending on the edited or selected object, task cards that allow you perform additional actions 
are available. These actions include:

● Selecting objects from a library or from the hardware catalog

● Searching for and replacing objects in the project

● Dragging predefined objects to the work area

The task cards available can be found in a bar on the right-hand side of the screen. You can 
collapse and reopen them at any time. Which task cards are available depends on the products 
installed. More complex task cards are divided into panes that you can also collapse and 
reopen.

Layout of task cards
The following figure shows an example of the bar with the task cards:
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① Task cards closed
② "Libraries" task card open
③ "Project library" pane open 
④ "Global libraries" pane closed

See also
Changing the pane mode (Page 172)

Project navigation (Page 157)

Basics of the work area (Page 160)

Inspector window (Page 169)

Portal view (Page 153)

Project view (Page 155)

Details view (Page 172)

Changing the pane mode
You can choose between two pane modes:

● Single pane mode:
Only one pane is open at any given time. If you open another pane, the previously opened 
pane is closed automatically.

● Multi-pane mode:
You can open several panes at the same time.

Procedure   
To change the pane mode, follow these steps:

1. Click the "Change pane mode" button above the panes inside a task card.

See also
Basics on task cards (Page 171)

6.1.2.8 Details view

Purpose of the details view 
The detail view shows certain content of the selected object is in the overview window or in 
the project tree. This might include text lists or tags.

The content of folders is not shown, however. To display the content of folders, use the project 
tree or the Inspector window.
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Layout of the details view
The following figure shows an example of the details view:

① Title bar
② Content of the selected object

Title bar
The arrow for closing the details view is located in the title bar of the details view. After it has 
closed, the direction in which the arrow is pointing changes from left to right. It can now be 
used to reopen the details view.

Objects
The displayed content varies depending on the selected object. You can move the content of 
objects from the details view to the required location using drag-and-drop.

See also
Project navigation (Page 157)

Basics of the work area (Page 160)

Inspector window (Page 169)

Basics on task cards (Page 171)

Portal view (Page 153)

Project view (Page 155)

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Professional V11.0 SP1
System Manual, 08/2011,  173



6.1.2.9 Overview window

Overview window

Functions of the Overview window     
The Overview window supplements the project tree. The Overview window shows the contents 
of the folder currently selected in the project tree.

In addition, you can perform the following actions in the Overview window:

● Open objects

● Display and edit the properties of objects in the Inspector window

● Rename objects

● Call object-specific actions from the shortcut menu

● Compare objects side by side

● Perform various object operations, such as inserting objects from the library via drag-and-
drop and moving, copying, pasting, and deleting objects
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Layout of the Overview window
The following figure shows the components of the Overview window:

① Overview window
② Switch to the Details view
③ Switch to the List view
④ Switch to the Icon view
⑤ Move to higher level
⑥ Split the overview window in two. Either the right or left half of the overview window is synchronized. Clicking again 

cancels the split.
⑦ Contents of the object selected in the project tree.
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Display forms of the Overview window
The content of the Overview window can be displayed as follows:

● Details view
The objects are displayed in a list with additional information, such as the date of the last 
change.

● List view
The objects are displayed in a simple list.

● Icon view
The objects are displayed as icons.

See also
Comparing objects (Page 176)

Showing or hiding additional columns (Page 176)

Comparing objects
You can display the contents of two folders or objects side by side in the Overview window. 
The Overview window is split in half and you can display different contents on the left and right 
sides.

In addition, you can use a drag-and-drop operation to move objects between the split windows. 
Thus, for example, you can move contents from one window to the other.

Procedure 
To split the Overview window in half or cancel the split, follow these steps:

1. In the toolbar, click on the "Synchronize left side" or "Synchronize right side" icon to split 
the overview window. Either the left or the right side of the overview window synchronized 
with the contents of the selected object in the project tree.

2. To cancel the split, click again on the previously selected icon.

See also
Overview window (Page 174)

Showing or hiding additional columns
In the details view of the Overview window, you can display more columns containing additional 
information on an object and then hide them again. The columns available depend on the 
selected object.
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Procedure
To show or hide additional table columns, follow these steps:

1. Right-click the title bar of the table.

2. Select the "Show/Hide" command in the shortcut menu, and select the columns you want 
to display.

See also
Overview window (Page 174)

6.1.2.10 Resetting the user interface layout
Every change you make to the layout of the user interface is saved. The changes are thus 
available even after a restart of the TIA Portal. For example, if you change the height and width 
of a text editor or the division of a table, your changes are retained so that you don't have to 
re-customize elements every time.

In some cases, however, it may be helpful to restore the original layout settings, for example, 
to suit the preferences of another user or if a different user interface layout is desired.

Procedure
To reset the user interface settings to the factory settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation.

3. Click the "Reset to default" button under "Layout > Reset layout".

Result
The default settings for the user interface are restored.

See also
Overview of the program settings (Page 149)
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6.1.3 Keyboard shortcuts

6.1.3.1 Keyboard shortcuts for project editing

Editing a project   

Function Key combination Menu command
Open a project <Ctrl+O> Project > Open
Close a project <Ctrl+W> Project > Close
Save a project <Ctrl+S> Project > Save
Save a project under a different name <Ctrl+Shift+S> Project > Save as
Print project <Ctrl+P> Project > Print
Compile a project <Ctrl+B> Edit > Compile
Undo last action <Ctrl+Z> Edit > Undo
Redo last action <Ctrl+Y> Edit > Redo

Editing objects within a project

Function Key combination Menu command
Rename a project <F2> Edit > Rename
Highlight all objects in an area <Ctrl+A> Edit > Select all
Copy an object <Ctrl+C> Edit > Copy
Cut an object <Ctrl+X> Edit > Cut
Paste an object <Ctrl+V> Edit > Paste
Delete an object <Del> Edit > Delete
Find an object <Ctrl+F> Edit > Find and replace
Replace an object <Ctrl+H> -

Calling up the help function

Function Key combination Menu command
Calling up the help function <F1> or <Shift+F1> Help > Show help
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6.1.3.2 Keyboard shortcuts for windows

Opening and closing windows   

Function Key combination Menu command
Open/close project tree <Ctrl+1> View > Project tree
Opening/closing the detailed view <Ctrl+4> View > Details view
Opening/closing the overview <Ctrl+2> View > Overview
Opening/closing a task card <Ctrl+3> View > Task card
Open/close inspector window <Ctrl+5> View > Inspector window
Close all editors <Ctrl+Shift+F4> Window > Close all
Open the shortcut menu <Shift+F10> -

6.1.3.3 Keyboard shortcuts in the project tree

Keyboard shortcuts in the project tree     

Function Key combination
Jump to the start of the project tree <Home> or <Page Up>
Jump to the end of the project tree <End> or <Page Down>
Open folder <Arrow Right>
Close folder <Arrow Left>

6.1.3.4 Keyboard shortcuts in tables

General keyboard shortcuts in tables 

Function Key combination
Place a cell in edit mode <F2> or <Return>
Open drop-down list in a cell <Return>
Close drop-down list in a cell <Esc>

Navigate in tables

Function Key combination
Go to the next cell <Arrow keys>
Go to the next editable cell on the right <Tab>
Go to the next editable cell on the left <Shift+Tab>
Move a screen upwards <PgUp>
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Function Key combination
Move a screen downwards <PgDn>
Go to the first cell in the row <Home>
Go to the last cell in the row <End>
Go to the first cell in the table <Ctrl+Home>
Go to the last cell in the table <Ctrl+End>
Go to the top cell in the column <Ctrl+up arrow>
Go to the bottom cell in the column <Ctrl+down arrow>

Highlighting areas in tables

Function Key combination
Highlight a column <Ctrl+space bar>
Highlight a row <Shift+space bar>
Highlight all cells <Ctrl+A>
Highlight to expand a cell <Shift+arrow keys>
Extend highlighting to the first visible cell <Shift+PgUp>
Extend highlighting to the last visible cell <Shift+PgDn>
Extend highlighting to the first row <Ctrl+Shift+up arrow>
Extend highlighting to the last row <Ctrl+Shift+down arrow>
Extend highlighting to the first cell in the row <Ctrl+Shift+left arrow>
Extend highlighting to the last cell in the row <Ctrl+Shift+right arrow>

6.1.3.5 Keyboard shortcuts for text editing

Editing text 

Function Key combination
Switch to insert or overwrite mode <Insert>
Exit edit mode <Esc>
Delete <Del>
Delete characters <Backspace>

6.1.3.6 Using the on-screen keyboard

Introduction
When working with the TIA portal, you also have the Microsoft on-screen keyboard available. 
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Displaying the on-screen keyboard
To display the on-screen keyboard, follow these steps:

1. In the "View" menu, select the "Screen keyboard" command.

 

Exiting the on-screen keyboard
To exit the on-screen keyboard, follow these steps:

1. In the "File" menu of the on-screen keyboard, select the "Exit" command.

6.1.4 Special features specific to the operating system

6.1.4.1 Influence of user rights

Restrictions when user rights are limited  
The software provides several functions that require direct access to the hardware of the 
programming device / PC and therefore also to the installed operating system. To make full 
use of the range of functions, the software must cooperate closely with the operating system. 
To ensure problem-free interaction, you should therefore be logged on to the operating system 
with adequate user rights.

In particular, you may not be able to use functions requiring an online connection or those that 
change the settings of interface cards if you work with limited user rights.

Recognizing restricted functions  
You can recognize functions requiring special rights as follows:

● A shield icon is displayed beside the function.

The function can be used but is regulated by the user account control.

● A box is grayed out and cannot be accessed.
You require administrator privileges to access the box. In some operating system 
environments, you can obtain administrator privileges by entering an administrator 
password.

 

 Note

A box being grayed out does not necessarily mean a lack of rights. You should also check 
the additional information in the tooltip cascades to find out the conditions for editing the box.
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6.1.4.2 Expanding user rights

Counteracting restrictions due to user rights 
Certain functions may not be available if you are not logged on to the operating system with 
adequate rights. You can counteract these restrictions in the following ways:

● Enabling of extended rights using Windows user account control

● Logging on to the operating system with administrator privileges

● Using temporary administrator rights

Enabling extended rights using the Windows user account control 
To be able to use a function indicated by the shield icon of the Windows user account control, 
follow these steps:

1. Click on the box or button with the shield icon.
The security prompt of the Windows user account control opens.

2. Follow the instructions of the Windows user account control and, when prompted enter an 
administrator password, if possible.

The function can now be used once without restrictions.

Logging on to the operating system with administrator privileges 
To be able to use a function that is disabled due to lack of user rights, follow these steps:

1. Close the software.

2. Log off from the operating system.

3. Log on to the operating system with administrator privileges.

4. Restart the software.

Using temporary administrator rights
To obtain administrator privileges temporarily, follow these steps:

1. Click the "Change settings" button. You will find this button in dialogs that allow the 
temporary assignment of administrator privileges.
An operating system dialog box for entering an administrator password opens.

2. Enter an administrator password.

The settings can be temporarily changed. When you call the dialog again, the procedure must 
be repeated.

 

 Note

This function is not supported by all operating systems. If no "Change settings" button is 
present or the button is grayed out, you will need to log on to the operating system with 
administrator privileges instead.
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6.2 Help on the information system

6.2.1 General remarks on the information system

Quick answers to your questions  
A comprehensive Help system is available for solving your tasks. It describes basic concepts, 
instructions and functions. While working with the program, you also receive the following 
support:

● Roll-out for correct inputs in dialog boxes

● Tooltips for information on elements of the user interface, for example text boxes, buttons 
and icons. Some of the tooltips are supplemented by cascades containing more precise 
information.

● Help on the current context, on menu commands for example when you click on the keys 
<F1> or <Shift+F1>.

The following figure shows an example of a cascading tooltip (top) and a roll-out (bottom):

Help
The Help system describes concepts, instructions and functions. It also contains reference 
information and examples. The help opens in a separate window.

A navigation pane appears on the left side of the help window. You can also hide the navigation 
pane to make room on the screen. The navigation pane provides you with the following 
functions:

● Table of contents

● Search in the index

● Full text search of the entire Help

● Favorites
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Identification of the topics in the Help according to the type of information  
The help topics are identified by different symbols depending on the type of information they 
contain.

Symbol Information type Explanation
Operating instructions Describes the steps to follow in order to carry out a particular task.
Example Contains a concrete example to explain the task.
Factual information Contains background information that you need to know to carry 

out a task.
Reference Contains comprehensive reference information to refer back to.

Identification of the topics in the Help according to the target system
Depending on the products that are installed, the help system may contain sections that apply 
only to specific devices. To be able to recognize such sections at a glance, you will find a note 
in brackets in the table of contents. The search results in the full text search and in the index 
are marked in the same way if they only apply to a specific device.

Roll-out  
Certain text boxes offer information that rolls out and helps you to enter valid parameters and 
values. The roll-out informs you about permissible value ranges and data types of the text 
boxes.

The following figure shows a roll-out (yellow) and a roll-out error message (red), which indicates 
an invalid value:

Tooltip  
Interface elements offer you a tooltip for easier identification. 
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Tooltips, which have an arrow icon on the left, contain additional information in tooltip 
cascades. If you position the mouse pointer briefly over the tooltip or click the arrow icon, this 
information is displayed. The automatic display of tooltip cascades can be disabled.

If additional information is contained in the Help system, a link appears to the corresponding 
Help topic in the cascade. If you click on the link, the corresponding topic opens in Help.

The following figure shows a tooltip with opened cascade:

See also
Disabling the automatic display of tooltip cascades (Page 188)
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6.2.2 Opening the Help system

Opening the Help system  
You can open the Help system in the following ways: 

1. In the "Help" menu, select the "Show help" command or press <F1> to display the 
corresponding help for the current context.

Or

1. Click on the link in a tooltip cascade to go directly to an additional point in the Help system.

6.2.3 Searching the Help system for keywords

Searching for keywords in the help text  
To search the help topics for predefined keywords, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Index" tab.

3. Enter the search term in the input box or select the search term from the list of key words.

4. Click "Display".

6.2.4 Full-text searches

Full-text searches
To search the entire text for specific words, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Search" tab.

3. Type in your search term in the text box.

4. Refine your search if necessary using additional criteria:

– Select "Search previous results" to start an additional search operation of your last 
search results only.

– Select "Search for similar words" to find words that differ only slightly from your search 
term.

– Select "Search titles only" to obtain only results that contain your search term in the title. 
The contents of the Help topics are ignored during the search.
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5. Click on the arrow button to the right of the search field to use logic operations. The following 
logic operations are available:

– Combine two or more search terms using the "AND" operator to find only Help topics 
that contain all the search terms in the text.

– Combine two or more search terms using the "OR" operator to find only Help topics that 
contain one or more of the search terms in the text.

– Combine two or more search terms using the "NEAR" operator to find only Help topics 
that contain terms in close proximity to each other (eight words).

– Precede a word with the "NOT" operator to exclude Help topics from the search that 
contain this word.

6. Click on "List topics" to start the search.
The results are now listed with title, position and ranking. The "Position" column shows the 
section in which the Help topic found is located. Sorting according to ranking is based on 
the position of the Help topics found in the table of contents and based on the number of 
hits in the Help topics.

6.2.5 Using favorites

Using favorites
You can save individual help topics as favorites. This saves you searching for the help topic 
a second time.

Saving favorites: 
To save a page as a favorite, follow these steps:

1. Open the help topic or the chapter you want to save as a favorite.

2. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

3. Open the "Favorites" tab.

4. Click the "Add" button.
The help topic or chapter is saved as a favorite and is available the next time you open the 
help system.

Calling up favorites: 
To call up a page from the favorites, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.
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3. Select the topic you want to open from the list.

4. Click the "Display" button.

Deleting favorites
To delete an entry from the favorites, proceed as follows:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.

3. Select the topic you want to remove from the list.

4. Click the "Remove" button.

6.2.6 Printing help topics

Printing information
You can either print all the contents of the Help system or individual topics only.

Procedure
To select the topics you would like to print, follow these steps:

1. Click the "Display printing dialog" button.
The table of contents opens in a separate window.

2. Select the check boxes for the folders and help topics to be printed in the "Print help topics" 
dialog.

3. Click the "Print" button to print the selected information.
The "Print" dialog opens.

4. Select the printer on which you want print the help topics.

5. Click "Properties" if you want to make additional printer settings.

6. Confirm your entries with "OK".
The help topics are printed out on the selected printer.

6.2.7 Disabling the automatic display of tooltip cascades
You can suppress the automatic display of tooltip cascades. Manual display remains possible.
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Procedure
To disable the automatic display of tooltip cascades, follow these steps:

1. In the "Options" menu, select the "Settings" command.

2. Select the "General" group in the area navigation.

3. Disable the "Open cascade automatically in tooltips" check box in the "General settings".

If you want to display a tooltip cascade manually, click on the arrow icon within the tooltip.

See also
General remarks on the information system (Page 183)

6.2.8 Safety Guidelines

Safety guidelines
This Help manual contains you have to observe in order to ensure your personal safety, as 
well as to prevent damage to property. The notices referring to your personal safety are 
highlighted in the manual by a safety alert symbol, notices referring only to property damage 
have no safety alert symbol. These notices shown below are graded according to the degree 
of danger.

 

 DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions 
are not taken.

 

 CAUTION

without a safety alert symbol, indicates that property damage can result if proper precautions 
are not taken.

 

 NOTICE

indicates that an unintended result or situation can occur if the corresponding information is 
not taken into account.
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If more than one degree of danger is present, the warning notice representing the highest 
degree of danger will be used. A notice warning of injury to persons with a safety alert symbol 
may also include a warning relating to property damage.

Qualified Personnel
The device/system may only be set up and used in conjunction with this documentation. 
Commissioning and operation of a device/system may only be performed by qualified 
personnel. Within the context of the safety notes in this documentation qualified persons are 
defined as persons who are authorized to commission, ground and label devices, systems and 
circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

 

 WARNING

This device may only be used for the applications described in the catalog or the technical 
description and only in connection with devices or components from other manufacturers 
which have been approved or recommended by Siemens. Correct, reliable operation of the 
product requires proper transport, storage, positioning and assembly as well as careful 
operation and maintenance.

 

Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining 
trademarks in this publication may be trademarks whose use by third parties for their own 
purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware 
and software described. Since variance cannot be precluded entirely, we cannot guarantee 
full consistency. However, the information in this publication is reviewed regularly and any 
necessary corrections are included in subsequent editions.
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Editing projects 7
7.1 The basics of projects

Introduction   
Projects are used to organize the storage of data and programs resulting from the creation of 
an automation solution. The data that makes up a project includes the following:

● Configuration data on the hardware structure and parameter assignment data for modules

● Project engineering data for communication over networks

● Project engineering data for the devices

Project hierarchy
Data is stored in a project in the form of objects. Within the project, the objects are arranged 
in a tree structure (project hierarchy). 

The project hierarchy is based on the devices and stations along with the configuration data 
and programs belonging to them. 

Common data of the project and online access, for example, are also displayed in the project 
tree. 

See also
Creating a new project (Page 192)

Opening projects (Page 192)

Saving projects (Page 194)

Deleting projects (Page 195)
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7.2 Creating and managing projects

7.2.1 Creating a new project

Procedure
To create a new project, follow these steps:

1. Select the "New" command in the "Project" menu.
The "Create a new project" dialog opens.

2. Enter your project name and path or accept the proposed settings.

3. Click the "Create" button.

Result
The new project is created and displayed in the project tree.

See also
The basics of projects (Page 191)

Opening projects (Page 192)

Saving projects (Page 194)

Deleting projects (Page 195)

7.2.2 Opening projects

Procedure  
To open an existing project, follow these steps:

1. Select the "Open" command in the "Project" menu.
The "Open project" dialog opens and includes the list of most recently used projects.

2. Select a project from the list and click "Open".

3. If the project you require is not included in the list, click the "Browse" button. Navigate to 
the desired project folder, and open the project file. Projects of the TIA Portal V11 have the 
extension ".ap11", while older projects from the TIA Portal V10 have the extension "ap10".

Result
The project opens in the project view.
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Notes on compatibility
When you open a project that was created with an older version of the TIA Portal, the project 
is converted automatically to the current file format and saved as a new project. The 
designation "_V11" is added to the file name of the new project.

If you want to open a project from a newer version, this is possible if the following conditions 
are met:

● The project was created with a different version of the TIA Portal V11, for example, a version 
with an installed service pack.

● The project does not contain any data that is incompatible with the current installation.

If the project to be opened contains data that was created with optional software, but the 
corresponding software product is not installed, the following cases can occur:

● Software components are missing, but none of them are essential:
A dialog appears listing the missing software components. After the project is opened, its 
properties are displayed. You now have the opportunity to install the missing products. All 
the devices contained in the project are available even if you do not install the missing 
products. However, you can only work with the devices that are supported by the currently 
installed software.
If devices are not supported because software is missing, they are marked with the following 
symbol in the project tree:

● At least one software package is required in order to open the project:
A dialog appears listing the missing software components. The essential package(s) are 
marked. The project can only be opened if you install the missing components.

See also
The basics of projects (Page 191)

Creating a new project (Page 192)

Saving projects (Page 194)

Deleting projects (Page 195)

7.2.3 Displaying properties of the project
You can display the properties of a project. Properties include the following:

● Metadata for the project
This includes the following information: creation time, author, file path, project size, 
copyright , project languages, etc. Many of the attributes can be changed.

● Project history
The project history contains an overview with important events in the project life cycle. Here 
you can also call the log file for a migration.
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● Support packages in the project
You can display an overview of the additional software needed to work with all devices in 
the project.

● Software products in the project
You can display an overview of all installed software products needed for the project.

Procedure
To display the project properties, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the project properties in the area navigation that you want to have displayed.

7.2.4 Saving projects
You can save the project at any time either under the same or a different name. You can even 
save a project when it still contains elements with errors.

Saving a project 
To save a project, follow these steps:

1. Select the "Save" command in the "Project" menu.
All changes to the project are saved under the current project name.

Project Save as
To save a project under another name, follow these steps:

1. Select the "Save as" command in the "Project" menu.
The "Save current project as" dialog opens.

2. Select the project folder in the "Save in" box.

3. Enter the new project name in the "File name" box.

4. Confirm your entry with "Save".
The project is saved under the new name and opened.

See also
The basics of projects (Page 191)

Creating a new project (Page 192)

Opening projects (Page 192)

Deleting projects (Page 195)
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7.2.5 Closing projects

Procedure
To close a project, follow these steps:

1. Select the "Close" command in the "Project" menu.
If you have made changes to the project since the last time you saved it, a message is 
displayed. 

2. Decide whether or not you want to save the changes.

7.2.6 Deleting projects
 

 NOTICE

When you delete a project, the entire project data is removed from the storage medium.
 

Requirements
The project you want to delete is not open.

Procedure
Follow the steps below to delete an existing project:

1. Select the "Delete project" command in the "Project" menu.
The "Delete project" dialog opens and includes the list of most recently used projects.

2. Select a project from the list.
If the project you require is not included in the list, click the "Browse" button. Navigate to 
the required project folder, and open the project file with the extension ".ap11".

3. Click the "Delete" button.

4. Click "Yes" to confirm. This starts the deletion of the project. 

Result
The entire project folder is deleted from the file system. 

See also
The basics of projects (Page 191)

Creating a new project (Page 192)

Opening projects (Page 192)

Saving projects (Page 194)
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7.2.7 Working with multi-language projects

7.2.7.1 Project text basics

Texts in different languages in the project  
When you enter texts while working on a project, you would normally do this in your own 
language. If you then pass on the project to someone else who does not know this language, 
this person will require a translation of the relevant texts to a language they know. This is why 
all texts can be translated. In this way, you can ensure that anyone who is subsequently 
confronted with the texts sees the texts in his/her language of choice.

Project language
Project languages are all languages in which a project will later be used. Based on the editing 
language, all the texts can be translated to the various project languages. You specify the 
languages that will be available in the project tree under "Languages & Resources > Project 
languages".  

Editing language
Every project has an editing language. When you enter texts, these are always created in the 
editing language. You should therefore make sure that the editing language set is the language 
in which you enter the texts. This avoids problems if you translate the texts later.

The editing language does not depend on the language of the user interface. You could, for 
example, set English as the user interface language, but use Italian as the editing language. 
If you enter texts, these will be created in this case in the project language "Italian", although 
the user interface of the TIA Portal displays English.

You set the editing language in the project tree under "Languages & Resources > Project 
languages > Editing language".

User texts and system texts   
For clarification purposes, a distinction is made between user texts and system texts:

● User texts are texts that the user created.

● System texts are texts that are created automatically according to the configuration in the 
project.

You manage the project texts in the project tree under "Languages & Resources > Project 
texts".

Examples of multilingual project texts
You can, for example, manage the following project texts in more than one language:

● Block titles and block comments

● Network titles and network comments
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● Statement comments from STL programs

● Comments in tables

● Alarm texts

● Operator-relevant texts

● Text lists

● Labels of buttons

● Display names of recipes

Translating texts
There are three ways of translating texts.

● Translating texts directly
You can enter the translations for the individual project languages directly in the "Project 
texts" table. You will find this in the project tree under "Languages & Resources > Project 
texts".

● Translating texts using reference texts
You can change the editing language for shorter texts. All the text cells are filled again with 
the default values and can be filled in the current language. As orientation, you can display 
what you last entered in the box in the reference language. To do this, select the "Tasks" 
task card and open the "Languages & resources".

● Exporting texts and translating them externally
With larger volumes of text, you can export the texts to an Office Open XML file and translate 
them with a normal table calculation program. You then import the translated texts again 
into the TIA Portal.

 

 Note
Using Asian project languages

East Asian project languages are only displayed correctly in Windows XP, if the option "Install 
files for East Asian languages" is selected on the Languages tab of Regional and Language 
Options in the Control Panel of Windows XP Professional.

 

See also
Overview of the program settings (Page 149)

Changing the settings (Page 153)

Application examples for multilanguage projects (Page 202)

7.2.7.2 Select project languages
All the texts can be displayed within a project in the same language that you selected for your 
software user interface. This means that all project texts must exist in the corresponding 
language. You can select the available project languages yourself.
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Requirement
● You are in the project view.

● A project is open.

Procedure
To select the project languages, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project languages".
In the work area, you will see a list of languages that you can select.

3. Select the required languages.

Result
All texts can be displayed in the activated languages if there is already a translation for these 
languages.

7.2.7.3 Setting the editing language
All the texts in the project are created in the editing language when they are entered. If you 
change the editing language, all future text input will be stored in the new editing language.

Requirement
● You are in the project view.

● A project is open.

Procedure
To change the editing language, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The lower-level elements are displayed.

2. Double-click on "Project languages".
The possible settings for the project languages are displayed in the work area.

3. Select the editing language in "General > Editing language".

7.2.7.4 Translating texts directly
If you use more than one language in your project, you can enter translations of individual 
project texts directly in the selected project languages. To allow this, there is a list for user 
texts and one for system texts with a column for every project language.
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Requirement
● You are in the project view.

● A project is open.

● You have selected at least one further project language.

Procedure
To translate individual texts, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click "Project texts".
A list with the user texts in the project is displayed in the work area.

3. Click on "System texts" if you you want to edit the list of system texts rather than the user 
texts.

4. You can improve the clarity of the lists if you have a lot of texts.

– To group identical texts and to translate them all at once, click the "Switch on/off 
grouping" button in the toolbar.

– To hide texts that do not have a translation, click the "Filter for empty texts on/off" button 
in the toolbar.

– To further limit the displayed project texts to certain devices, select the devices for which 
you want to display project texts in the drop-down list.

5. Enter the translation of the project texts in the relevant column.
 

 Note

If there is no translation for a text in a particular language, the English text is displayed.
 

7.2.7.5 Translating texts using reference texts

Introduction  
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for the newly set language, the input boxes 
are empty or filled with default values.

If you enter text in an input box, this is saved in the current editing language. Following this, 
the texts exist in two project languages for this input field, in the previous editing language and 
in the current editing language. This makes it possible to create texts in several project 
languages.
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You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

 

 Note

The display of reference texts depends on the installed products and is not supported by 
every editor.

 

Requirement
There is at least one translation into a different project language for an input field.

Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. In the "Tasks" task card, select the "Languages & Resources" pane.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text box, translations that already exist in 
other project languages are shown in the "Tasks > Languages & Resources" task card.

See also
Application examples for multilanguage projects (Page 202)

7.2.7.6 Exporting and importing project texts
You can export project texts for translation and then reimport them. The texts are exported to 
an Office Open XML file with the extension ".xlsx". This can be edited in Microsoft Excel or a 
number of other spreadsheet programs.

The following export options are available:

● Exporting individual project texts

● Exporting all user texts or system texts at once
In this case, the export can be additionally limited by categories.

 

 Note
Row limit in Microsoft Excel

Note that Microsoft Excel 2003 supports a maximum of 65536 rows. Microsoft Excel 2007 
supports up to 1048576 rows.
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Exporting individual project texts  
To export individual project texts, follow these steps:

1. Open the "Languages & Resources" folder in the project tree.
The lower-level elements are displayed.

2. Double-click "Project texts".
The project texts editor opens.

3. Choose the "User texts" or "System texts" tab in the editor, depending on which texts you 
want to export.

4. Select the project texts you want to export.

5. Click the "Export project texts" icon in the toolbar of the editor.
The "Export" dialog box opens.

6. Choose the language you want to translate from in the "Source language" drop-down list.

7. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

8. Specify a file path and a file name for the export file in the "Select file for export" input box.

9. Click "Export".

Exporting all system or user texts  
To export all project texts, follow these steps:

1. Select the "Export project texts" command in the "Tools" menu.
The "Export" dialog box opens.

2. Choose the language you want to translate from in the "Source language" drop-down list.

3. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

4. In "Select content", select the check box "User texts" to export user texts. To export system 
texts, select "System texts". To export both user texts and system texts, select both check 
boxes.

5. In "Select content", select the required text categories for the user texts or the system texts.

6. In the "Export file" input field, specify a file name for the export file.

7. In the "Path" input field, select a path in the data system to which the export file is to be 
saved.

8. Click "Export".
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Importing project texts  
To import a file containing project texts, follow these steps:

1. Select the "Import project texts" command in the "Tools" menu.
The "Import" dialog box opens.

2. Select the path and the file name of the import file from the "Select file for import" field.

3. Select the "Import base language" check box if you have made changes to the base 
language in the export file and you want to overwrite the entries in the project with the 
changes.

4. Click "Import".

See also
Application examples for multilanguage projects (Page 202)

7.2.7.7 Application examples for multilanguage projects

Introduction
Let us assume you are working in a team with colleagues some of whom speak English, some 
French and some German. You have created a project with the TIA Portal and have already 
created a functioning configuration.

To allow your other colleagues to be able to keep track of the project, you would like all devices 
being used to have comments in English and German. First, you would like to enter the 
comments in German. Following this, to save time and costs, you want to have the texts 
translated into English in a spreadsheet program by an external translation office.

In addition to this, you also want a single comment for a particular device in French so that 
your French-speaking colleague can continue working on this device.

The section below describes an example of how you can achieve this with the tools of the TIA 
Portal.

Translating the project into English
To enter the comments in German and to have them translated into English later, follow these 
steps:

1. Set the editing language to "German" and fill all the comment boxes with the relevant texts 
in German.
On the device selected from the French-speaking colleague, enter, for example "Unser 
neues Gerät" in German first.
All the comments are now stored in German.

2. Export all user texts to an Office Open XML file with the extension ".xlsx".

3. Have the user texts contained in the file translated into English in a spreadsheet program 
such as Microsoft Excel.

4. Import the file into the TIA Portal after it has been translated.
All texts are now available in German and English.
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Translating a single comment field to French
To translate an individual comment field to French, follow these steps:

1. Open the comment box for the device on which the French-speaking colleague will be 
working.

2. Open the "Languages & Resources" pane in the "Tasks" task card.

3. Set "French" as the editing language in the "Languages & Resources" pane. As the 
reference language, set, for example, "English".
Since no translation has yet been installed in French, the comment box is empty. In the 
"Languages & Resources" pane, the English translation "Our new device" is displayed as 
a reference.

4. Orientating yourself on the English reference text enter "Notre nouvel appareil" in the 
comment box.
The comment for this device is now available in the languages German, English and French.

See also
Project text basics (Page 196)

Exporting and importing project texts (Page 200)

Translating texts using reference texts (Page 199)

7.3 Editing project data

7.3.1 Compiling and loading project data

7.3.1.1 Compiling project data

General information on compiling project data

Compiling project data  
During compilation, project data is converted so that it can be read by the device. Hardware 
configuration data and program data can be compiled separately or together. You can compile 
the project data for one or more target systems at the same time.

The following project data must be compiled prior to loading:

● Hardware project data, for example, configuration data of the devices or networks and 
connections

● Software project data, for example, program blocks or process screens
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Scope of the compilation
When you compile project data, you have the following options depending on the device 
involved:

● All

● Hardware configuration

● Software

● Software (rebuild all blocks)

See also
Compiling project data (Page 204)

Compiling project data
The following section describes the general procedure for compiling project data in the project 
tree. You will find details of how certain objects are compiled and any special points to note in 
the online help of the product.

Procedure   
To compile project data, follow these steps:

1. In the project tree, right-click on the device for which you want to compile the project data.

2. Select the option you require in "Compile" submenu of the shortcut menu.
 

  Note

Note that the options available to you depend on the selected device.
 

The project data is compiled. You can check whether or not the compilation was successful 
in the Inspector window with "Info > Compile".

Canceling compilation operation
You can cancel compilation at any time. Proceed as follows:

1. Click the "Cancel" button in the status bar next to the progress bar. If the TIA Portal is 
currently processing multiple asynchronous processes, you can use the Up or Down arrow 
to change to the progress display of the compilation operation you want to cancel.

2. Click "Yes" to confirm.

See also
General information on compiling project data (Page 203)
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7.3.1.2 Downloading project data

General information on loading

Introduction   
In order to set up your automation system, you must download the project data you generated 
offline to the connected devices. This project data is generated, for example when configuring 
hardware, networks, and connections or when programming the user program or when 
creating recipes. The first time you download, the entire project data is downloaded. During 
later loading operations, only changes are downloaded. 

You can download the project data to the following destinations:

● Devices

● Accessible devices

● Memory cards

Depending on the object you want to download, you have the following options:

● All
Both hardware configuration as well as software are downloaded to the destination.

● Hardware configuration
Only the hardware configuration is downloaded to the destination.

● Software
Only the objects that differ online and offline are downloaded to the destination.

● Software (all blocks)
All blocks are downloaded to the destination.

You can also upload project data already contained in a device back to your project. You have 
the following options:

● Uploading a complete device
All relevant data of the device is uploaded to the project.

● Uploading blocks and parameters
Only the blocks and parameters from the device are uploaded to the project. 

See also
Downloading project data to a device (Page 206)

Loading project data to an accessible device (Page 207)

Downloading project data to a memory card (Page 208)

Uploading project data from a device (Page 208)
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Downloading project data to a device
The following section describes the general procedure for downloading project data to a device. 
You will find details of how certain objects are downloaded and any special points to note in 
the online help of the product.

Requirement   
● The project data is consistent.

● Each device to which you want to download is accessible via an online access.

Procedure
To download the project data to the selected devices, follow these steps:

1. Select one or more devices systems in the project tree.

2. Right-click on a selected element.
The shortcut menu opens.

3. Select the option you require in the shortcut menu of the "Download to device" submenu.
 

  Note

Note that the options available to you depend on the selected device.
 

When necessary, the project data is compiled. 

– If you had previously established an online connection, the "Load preview" dialog opens. 
This dialog displays messages and proposes actions necessary for downloading.

– If you had not previously established an online connection, the "Extended download to 
device" dialog opens, and you must first select the interfaces via which you want to 
establish the online connection to the device.
See also: Establishing and canceling an online connection (Page 2800)

4. Check the messages in the "Load preview" dialog, and select the actions in the "Action" 
column, if necessary.

 

 
 NOTICE

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions! 
 

As soon as loading becomes possible, the "Load" button is enabled.

5. Click the "Load" button.

6. The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

7. Click the "Finish" button.
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Result
The selected project data was downloaded to the devices. 

See also
General information on loading (Page 205)

Loading project data to an accessible device (Page 207)

Downloading project data to a memory card (Page 208)

Uploading project data from a device (Page 208)

Loading project data to an accessible device
The following section describes the general procedure for downloading project data to an 
accessible device in the project tree. You will find details of how certain objects are downloaded 
and any special points to note in the online help of the product.

Requirement  
The accessible devices are displayed.

See also: Displaying accessible devices (Page 2798)

Procedure
To load project data to an accessible device, follow these steps:

1. In the project tree, drag the folder containing your device to the accessible device.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for downloading.

2. Check the messages, and select the actions in the "Action" column, if necessary.
 

 
 NOTICE

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors. 

Make sure that no dangerous situations can arise before you start the actions!
 

3. As soon as loading becomes possible, the "Load" button is enabled.

4. Click the "Load" button.
The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

5. Click the "Finish" button.
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See also
General information on loading (Page 205)

Downloading project data to a device (Page 206)

Downloading project data to a memory card (Page 208)

Uploading project data from a device (Page 208)

Downloading project data to a memory card

Requirement   
The memory card is displayed.

See also: Accessing memory cards (Page 242)

Procedure
To download project data to a memory card, follow these steps:

1. Use a drag-and-drop operation in the project tree to take the project data you want to 
download and move it to the memory card.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for downloading.

2. Check the messages, and select the actions in the "Action" column, if necessary.
As soon as loading becomes possible, the "Load" button is enabled.

3. Click the "Load" button.
The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

4. Click the "Finish" button.

See also
General information on loading (Page 205)

Downloading project data to a device (Page 206)

Loading project data to an accessible device (Page 207)

Uploading project data from a device (Page 208)

Uploading project data from a device
The following section describes the general procedure for uploading project data from a device. 
Which project data you can upload from a device depends on the products installed.

You have the following basic options for uploading project data from a device to your project:
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● Uploading a device to a programming device or PC
You can use this option to start with an empty project and upload existing project data 
directly from a device.

● Uploading from device
Only certain project data are uploaded from the device to the project. You will find the project 
data that can be downloaded in the online help of the product.

Requirement     
● A project is open.

● The hardware configuration and software to be downloaded have to be compatible with the 
TIA Portal. If the data on the device was created with a previous program version or with 
a different configuration software, please make sure they are compatible.

Uploading a device to a programming device or PC
To upload the complete device to your project, follow these steps:

1. Select the project name in the project tree.
The "Upload device to PG/PC" command in the "Online" menu is then enabled.

2. In the "Online" menu, select the "Upload device to PG/PC" command.
The "Upload device to PG/PC" dialog opens.

3. Select the type of interface you want to use for the load operation in the "Type of the PG/
PC interface" drop-down list.

4. Select the interface to be used from the "PG/PC interface" drop-down list.

5. Click the "Configure interface" button to the right of the "PG/PC interface" drop-down list to 
adapt the settings for the selected interface.
See also: Establishing and canceling an online connection (Page 2800) 

6. In the accessible devices table, select the device from which you want to upload project 
data.

7. Click on "Load".
Depending on the selected device, a dialog appears in which you have to enter additional 
information, such as the position of the module rack.
The project data of the device is uploaded to the project. You can edit it offline and then 
download it to the device again.

Or:

1. Open the accessible devices in the project tree.
See also: Displaying accessible devices (Page 2798) 

2. Use a drag-and-drop operation in the project tree to move the accessible devices to the 
project.
Depending on the selected device, a dialog appears in which you have to enter additional 
information, such as the position of the module rack. 
The project data of the device is uploaded to the project. You can edit it offline and then 
download it to the device again.
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Uploading from device
To upload only certain project data from a device to your project, follow these steps:

1. Establish an online connection to the device from which you want to download the project 
data.
See also: Establishing and canceling an online connection (Page 2800) 

2. Select an element in the project tree that allows uploading of project data.
As a result, the "Upload from device" command in the "Online" menu becomes enabled.

3. Select the "Upload from device" command in the "Online" menu.
The "Upload preview" dialog box opens.

4. Check the messages in the "Upload preview" dialog, and select the necessary actions in 
the "Action" column.
As soon as uploading becomes possible, the "Upload from device" button is enabled.

5. Click the "Upload from device" button.
The loading operation is performed. 

See also
General information on loading (Page 205)

Downloading project data to a device (Page 206)

Loading project data to an accessible device (Page 207)

Downloading project data to a memory card (Page 208)

7.3.2 Comparing project data

7.3.2.1 Basics of project data comparison

Function  
You have the option of comparing project data of the same type in order to determine possible 
discrepancies. For example, you can compare a hardware configuration with another hardware 
configuration. 

A simple online-online comparison is already performed when you establish an online 
connection. During this process, comparable objects in the project tree are marked with icons 
that represent the result of the comparison. Beyond this marking, you can use the comparison 
editor to compare project data and have detailed information displayed. You can also select 
actions for non-identical objects in the comparison editor.

In addition to the online-offline comparison, there is also an offline-offline comparison available. 
This allows you to compare project data of two devices within one project or from different 
projects. 

Which project data you can compare depends on the products installed.
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Comparison icons
The result of the comparison is indicated by means of icons. The following table shows the 
relevant icons and their meaning:

Icon Meaning
Folder contains objects whose online and offline versions differ

Comparison result is not known

Online and offline versions of the object are identical

Online and offline versions of the object are different

Object only exists offline

Object only exists online

7.3.3 Protecting project data

7.3.3.1 Protection concept for project data

Introduction   
You can protect your project data from unauthorized access. These include, for example:

● Access protection for devices

● Copy and display protection of objects

● Restrictions for printouts of know-how-protected objects

Note that every protection mechanism is not available for all objects. How to protect specific 
objects is described in the online help of the product. 

Revoking access rights for devices
If you want to execute a function that is password-protected by means of the device protection 
level, you are prompted to enter a password. When the password is entered correctly, you can 
execute the required function. You continue to have access rights on the device until you close 
the TIA Portal. 

If you want to reactivate password protection while the TIA Portal is open, you can explicitly 
revoke the access rights for a device. As a result, certain functions for the protected device 
cannot be executed until the correct password is entered again. You specify the functions for 
which a password must be entered when you assign the device protection level. 
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See also
Printing project data (Page 229)

7.3.3.2 Revoking access rights for devices

Requirement    
● A protection level has been set for the device.

● A protected function for the device has been enabled by entering the password.

Procedure
To revoke the access rights for the device, follow these steps:

1. Select the device for which you want to revoke access rights in the project tree.

2. Select the "Delete access rights" command in the "Online" menu.

Result
The access rights are revoked, and starting from now the user will be prompted to enter the 
password again to execute a password-protected function on the device. The function can only 
be executed if the correct password is entered. 

If the device has an online connection, it will be disconnected. 

See also
Protection concept for project data (Page 211)

7.3.4 Printing project contents

7.3.4.1 Documentation settings

Introduction
Once a project is created, the contents can be printed in an easy-to-read format. You may print 
the entire project or individual objects within the project. A well-structured printout is helpful 
when editing the project or performing service work. The printout can also be used for your 
customer presentations or as full system documentation.

You can prepare the project in the form of standardized circuit manuals and print it in a uniform 
layout. You can limit the scope of the printout. You have the option to print to the entire project, 
individual objects along with their properties, or a compact overview of the project. In addition, 
you can print the contents of an open editor.
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Improving the printout with frames and cover pages.
You can design the appearance of the printed pages according to your own requirements, for 
example, with your company logo or company layout. You can create your own printout 
templates with frames that will surround the project data in the printout. You create the frames 
in an external layout program or an image editing program and save the file in PDF or EMF 
format. The file can then be imported as a background image. You can insert placeholders for 
data from previously entered document information on the background. These will be filled 
automatically with the appropriate metadata during printing.

If you want to avoid designing your own template, there are ready-made frames and covers 
pages available. These include templates complying with the ISO standard for technical 
documentation.

If you already have cover pages or frames from earlier versions of the TIA Portal or you have 
templates and cover pages in EMF or PDF file format, you can import these.

Modular structure of a printout
An printout generally consists of the following components:

● Cover page (only when printing from the project tree)

● Table of contents (only when printing from the project tree)

● Name and path of an object within the project tree

● Object data

Printout of the cover page or the table of contents can be deactivated in the "Print" dialog.

See also
Creating a frame (Page 218)

Creating a cover page (Page 219)

Editing cover pages and frames (Page 220)

Entering document information (Page 216)

7.3.4.2 Printout of project contents

Availability of print function   
The following contents can be printed:

● An entire project in the project tree

● One or more project-related objects in the project tree

● Contents of an editor

● Tables

● Libraries

● Diagnostics view of the Inspector window
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It is not possible to print in the following areas:

● Portal view

● Detailed view

● All tabs of the Inspector window, except the diagnostics view

● All task cards, except the libraries

● Most of the dialogs

Scope of printout  
To be able to print, at least one printable element has to be selected.

If a selected object is printed, all subordinate objects are also printed. For example, if a device 
is selected in the project tree, all of its data is also printed.

When table contents are printed, all lines in the table in which a cell is selected are printed. In 
order to print one or more table columns, the desired columns must be selected. If no individual 
cells or columns are selected, the entire table is printed.

Limitations when printing  
In general, it is possible to print all objects that can be visualized on the user interface. 
Conversely, this means that you cannot print objects that you do not have access to. If a printout 
fails, possible reasons may include the following:

● A valid license does not exist for displaying an object.

● There is no device description for an object.

● A software component needed to display an object is not installed.

See also
Printing project data (Page 229)

7.3.4.3 Changing the print settings

Changing the print settings  
You can specify general print settings that are retained even after the TIA Portal is closed and 
re-opened. Some settings are dependent on the products installed. The following settings are 
possible in every case:

Always print table data as pairs of values
If this option is selected, tables are not printed in tabular format but rather as a pairs of key 
and value.

Example:
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Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1

Property 2: Value B2

Printing mask editors
● Always print data in tables

All parameters of technology objects are printed in tabular format.

● Print mask graphics if possible
If the utilized editor supports this function, the contents of the editor are not printed as a 
table but rather as a complete graphic as it appears on the screen.

Procedure
To change the print settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group.

3. Select the desired default settings in the "Print settings" area.
The changes are applied immediately and are retained for all projects, even after the TIA 
Portal is closed.

See also
Overview of the print settings (Page 152)

7.3.4.4 Specifying the print layout

Specifying the print layout   
If you do not want to rely on ready-made print templates, you can specify your own cover page 
or your own layout for the individual pages. Your designs are saved together with the respective 
project.

Your designs for the cover page and your templates for the page layout can be found in the 
project tree under the "Documentation information" group. You will also find metadata on the 
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project there under the entry "Document information". For subsequent print operations, you 
can customize the appearance of the printout in the "Print" dialog using the saved cover pages 
and page layout templates and the available metadata.

Designing the cover page  
The cover page can be customized. You can insert a background graphic and provide 
placeholders for text on the page. The placeholders are automatically filled with data from a 
documentation information during printing.

Cover pages are located in the project tree under the "Documentation information > Cover 
pages" group.

Designing the content page  
The regular pages of a printout can contain the following elements:

● Frame with static content, such as a company logo

● Place holders for text, such as the name of the project, the page number, and the time the 
printout was started
Several different values for the individual placeholders can be specified in the document 
information. Other values, such as the project name, are preassigned and are inserted 
automatically during printing.

● Footnote
The footnote is always output below the content area.

● Content area
You can specify an area where the printed content is to be embedded.

The design of the content pages is saved in Frames. The individual frames are located in the 
project tree under the "Documentation information > Frames" group.

7.3.4.5 Entering document information
You can enter metadata in the document information for every project. In addition, a print frame 
and a cover page are specified in the document information. You can create different 
information, if required, to enable you to quickly switch between different document information 
containing different information, frames, cover pages, page sizes, and page orientations when 
printing. For example, this is useful if you want to generate printouts in different languages and 
different document information is provided for each language.

In the documentation editor, you can specify placeholders on the cover page or in the frame 
of the regular pages. These placeholders can be automatically replaced with metadata from 
the documentation information during printing.

The various document information are therefore part of the printing function and specify the 
print layout and print content.
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Procedure 
To add metadata, follow these steps:

1. To create new document information, double-click "Add new document information" under 
"Documentation information > Document information" in the project tree.
The new document information is created and opened immediately.

2. Enter a name for the set in the "Name" field.

3. Fill in the individual fields with the metadata for the project.

7.3.4.6 Managing cover pages and frames

Using cover pages and frames

Uses for cover pages
You can give your plant documentation printouts a professional appearance by adding a cover 
page. You can design your own cover page or use ready-made cover pages. Ready-made 
cover pages can be adapted and stored again as a template.

Cover pages can be saved in global libraries where they are available for use across projects.

Cover pages are designed for use as a right printed page only.

Uses of frames 
You can embed the regular pages of your plant documentation inside a consistently uniform 
page frame. The frame can contain placeholders for project metadata, which is stored in the 
document information. It can also contain graphic elements that you design yourself.

You can create your own frames or rely on ready-made page frames. You can adapt a ready-
made page frame and then store it again as a new frame.

Like cover pages, frames can be saved in global libraries where they are available for use 
across projects.

Frames are designed for use on right printed pages only.

Cover pages and templates in the project tree 
Cover pages and frames associated with the project are stored in the project tree under the 
entry "Documentation information". There are separate folders here for frames and cover 
pages.

The following actions are available in the project tree for cover pages and frames.

● Creating your own subfolders

● Copying and pasting

● Inserting cover pages and frames from the "Documentation templates" system library

● Copying cover pages and templates to a global library
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Cover pages and templates in libraries 
The "Documentation templates" system library contains a few cover pages and templates that 
are available in every project. The cover pages and templates can be moved from there to the 
project tree using a drag-and-drop operation. You can then adapt the cover pages and 
templates in the project tree according to the requirements of your project.

Cover pages and templates can be moved from the project tree to a global library. Afterwards, 
these are available in every project.

See also
Library basics (Page 243)

"Libraries" task card (Page 245)

Global library basics (Page 256)

Using ready-made frames and cover pages (Page 219)

Creating a frame
You can create any number of frames for each project. The frames are stored in the project 
tree below the "Documentation information > Frames" group. You can assign a frame to all 
document information. When you select document information for printing, its associated frame 
is used.

Procedure 
To create a new frame, follow these steps:

1. Double-click the entry "Add new frame" below the "Documentation information > Frames" 
group in the project tree.
The "Add new frame" dialog opens.

2. Enter a name for the frame in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new frame is created. The frame is then opened automatically in the documentation editor 
where it can be edited.

See also
Editing cover pages and frames (Page 220)

Creating a cover page (Page 219)
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Creating a cover page
You can create any number of cover pages for the printout for each project. The cover pages 
are stored in the project tree below the the "Documentation information > Cover pages" group. 
You can assign a cover page to all document information. When you select specific document 
information for printing, its associated cover page is used.

Procedure 
To create a new cover page, follow these steps:

1. Double-click the entry "Add new cover page" below the "Documentation information > Cover 
pages" group in the project tree.
The "Add new cover page" dialog box opens.

2. Enter a name for the cover page in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new cover page is created. The cover page is then opened automatically in the 
documentation editor where it can be edited.

See also
Editing cover pages and frames (Page 220)

Creating a frame (Page 218)

Using ready-made frames and cover pages
The TIA Portal comes with some ready-made frames and cover pages. These can change 
according to your wishes.

Procedure
To create and edit the ready-made frames and cover pages, follow these steps:

1. Open the "Global libraries" pane in the "Libraries" task card.

2. In the "Templates" folder, open the "Cover Pages" or "Frames" folder.
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3. Drag a cover page or a frame from one of the folders into the project tree and drop it into 
one of the following folders:

– For frames: "Document information > Frames"

– For cover pages: "Document information > Cover pages".

The ready-made frame or cover page can now be used in the project.

4. Double-click on the new entry in the project tree click to edit the frame or the cover page.

See also
Using cover pages and frames (Page 217)

Editing cover pages and frames (Page 220)

7.3.4.7 Designing cover pages and frames

Editing cover pages and frames
The documentation editor is a graphical editor which allows you to design frames and cover 
pages for your plant documentation. You can place images or text elements on the frame and 
the cover pages in the document editor. The text elements are either static or they are 
automatically filled during printing with the data from the document information that you have 
selected in the print dialog.

Procedure     
To edit a cover page or a frame in the documentation editor, follow these steps:

1. In the project tree, double-click on the entry for an existing cover page or frame under the 
"Documentation information > Frames " or "Documentation information > Cover pages" 
group.
The documentation editor opens.

2. Design the cover page or frame as desired.

3. Close the documentation editor.
The changes to the cover page or frame are applied automatically.

See also
Creating a cover page (Page 219)

Creating a frame (Page 218)

General operation of the documentation editor (Page 221)
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General operation of the documentation editor

Components of the documentation editor  
The following figure provides an overview of the components of the documentation editor:
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① Toolbar
The toolbar provides the following tools (from left to right):
● Insert background image

Inserts a background image into the template or cover page.
● Arrow tool

Enables object selection.
● Navigation tool

Allows shifting of the partial page.
● Zoom-in button

Magnifies the page display incrementally.
● Zoom-out button

Reduces the page display incrementally.
● Selecting a zoom factor

Adapts the page size to the area selected with the lasso zoom tool.
● Dynamic zoom

Adapts the page width to the work area.
② Work area

You can design the cover page or frame in the work area.
③ "Toolbox" task card

The "Toolbox" task card contains various types of placeholders that you can use on 
the cover sheet or frame. The placeholders can be placed in the work place using 
a drag-and-drop operation.

④ Properties in the Inspector window
You can display and modify the properties of the currently selected object in the 
"Properties" tab of the Inspector window. For example, you can modify the properties 
of the page, format text, specify the position of objects on the page, etc.
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Operation in the documentation editor
The following basic functions are available in the documentation editor:

● Drag-and-drop functionality
The documentation editor is a graphic editor, which means you can place objects anywhere 
with the mouse. An image of the page is displayed in the work area. This image corresponds 
to the ultimate print layout.
If you want to select objects on the page in order to move them or modify their properties, 
the arrow tool must be activated in the toolbar.

● Zoom function
You can use the zoom function to change the size of the page display. You have two options 
for changing the page size:

– Via the buttons in the toolbar
Select the "Zoom in" or "Zoom out" magnifying glass button in the toolbar of the 
documentation editor. Then click on the page in order to magnify (zoom in) or reduce 
(zoom out) the page incrementally.
To zoom in on a particular area, select the "Select zoom factor" tool and use the mouse 
to drag an outline around the area you want to focus on.
To continuously zoom in or zoom out of the work area, use the "Dynamic zoom" tool. 
To magnify the page display, click anywhere on the work area, and then hold down the 
mouse button while dragging the mouse toward the top of the page. To reduce the page 
display, drag the mouse toward the bottom of the page.

– Via the zoom bar
You can also use the zoom bar (located in the bottom right corner of the work area) to 
change the display size. Choose a percentage value from the drop-down list or enter a 
percentage value. Alternatively, you control the display size using the slider.

● Navigation over the page
In addition to scrolling, you the option of changing the partial page with the navigation tool. 
To change the partial page with the navigation tool, select the Hand button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

Using and adapting the positioning aids
You have various aids at your disposal to help you position elements on the page:

● Rulers
Rulers are affixed to the page margins in the work area.

● Page grid
A grid is placed underneath the page in the work area.

You can display, hide or adapt the positioning aids in the Inspector window under "Properties 
> Rulers and grid". You can make the following settings:

● Units:
Specify the unit of measurement for the grid and the rulers.

● Grid steps:
Specify the width of the grid.

● Show grid:
Specify whether the grid is to be displayed or hidden.
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● Snap to grid:
Specify whether objects are to be aligned automatically to the grid. If the option is selected, 
the grid lines function like a "magnet".

● Show rulers:
Specify whether the rulers are to be displayed.

See also
Editing cover pages and frames (Page 220)

Inserting a background image (Page 224)

Specifying the print area (Page 224)

Inserting placeholders for metadata (Page 225)

Inserting a background image
You can specify a background image for a cover page or frame. You can design the 
background image in another program and then insert it.

The background image is inserted in its original size. To keep it from extending beyond the 
margins, make sure that the background image is already correctly sized when you save it.

Requirement
● The background image must be in EMF or PDF format.

● A cover page is open in the documentation editor.

Procedure
To insert a background image, follow these steps:

1. Click the "Add background image" button.
The "Open" dialog box opens.

2. Select the background image in the file system.

3. Click the "Open" button.
The background image is inserted in its original size at the top left page margin.

See also
Creating a cover page (Page 219)

General operation of the documentation editor (Page 221)

Specifying the print area
An area within the frame is provided for the actual printed contents. The project data is then 
always inserted inside this defined and uniformly consistent area within the frame. You can 
adjust the size of the print area.
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Requirement
A frame is open in the documentation editor.

Procedure
To define an area for the printed contents, follow these steps:

1. Click on the slightly darker area within the page display in the documentation editor to select 
the area for the print content.
This opens the properties of the area to be printed in the Inspector window.

2. Enter the position of the print area on the X and Y axes in the Inspector window.

3. Specify the width and height of the print area in cm in the Inspector window.

Alternatively, you can change the width and position of the print area in the graphic display of 
the page. To do so, use the mouse to drag the margins of the print area until the desired size 
and position are achieved.

See also
Creating a frame (Page 218)

General operation of the documentation editor (Page 221)

Inserting placeholders for metadata
You can provide placeholders on the cover page and in a frame. The placeholders are 
automatically filled with metadata from documentation information during printing, if they are 
placeholders for text. Alternatively, you can add non-modifiable data, such as free text or an 
image.

All elements are arranged in numbered Z-Orders. If objects overlap, you can determine in 
which sequence these are to be arranged.

Types of placeholders
The following types of placeholders are available to you:

● Text field
The text field stands as a placeholder for a text element from a document information. In 
the properties of the text field, you set which text from a document information should be 
automatically inserted during printing.

● Field for date and time
A date and time is inserted instead of the placeholder when printing. This can be the date 
of creation or the point in time when the last change was made to the project. In the 
properties of the Inspector window, you specify which date or time is printed.

● Page number
The correct page number is automatically applied when printing.
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● Free text
You can enter freely selectable text in the properties of the text field. The text is static and 
is not influenced by the document information selected at the time of printing.

● Image
Select the image file in the properties of the placeholder in the Inspector window. Images 
in the formats BMP, JPEG, PNG, EMF or GIF are possible.

Requirement
An cover page or frame is open in the documentation editor.

Procedure     
To insert placeholders for metadata on the cover sheet or in a frame, follow these steps:

1. Drag a field from the "Toolbox > Elements" task card to the work area of the documentation 
editor.
The placeholder is inserted. The placeholder properties are shown in the Inspector window 
and can be edited there.

2. Select the metadata to be inserted during printing from the "Text" drop-down list in the 
Inspector window under "Properties > General > Text box". Alternatively, you have the 
option of entering free text or selecting an image depending on the type of placeholder.

3. In the Inspector window under "Properties > General > Position and size", specify the 
position of the placeholder on the X and Y axis and enter the width and height of the text 
box in cm. You specify the sequence of the objects in the "Z-Order" field, if these overlap. 
The smaller the value, the further down an object is located.

4. In the Inspector window, go to "Properties > View" and select the font formatting and the 
orientation of the text as well as the alignment of the text. You cannot make this setting for 
images.

See also
General operation of the documentation editor (Page 221)

7.3.4.8 Displaying print preview

Creating a print preview

Creating a print preview  
You can create a preview of the printout. Document information can be chosen for this, in the 
same way as as for the actual printout. In this way, you preview the selected frame and, if 
applicable, the cover sheet. The settings are retained for later printing.
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Procedure
To create a print preview and to set the scope of the later printout, follow these steps:

1. Select the "Print preview" command in the "Project" menu.
The "Print preview" dialog opens.

2. Select the frame layout you want to use for the printout.

– In the "Document information" drop-down list, select the documentation information you 
want to use later for the printout. 

– Select the "Print cover page" check box to print the cover page, which is specified in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.

3. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.

4. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor 
that supports this function.

– Choose "Compact" to print out an abbreviated version of the project data.

5. Click "Preview" to generate the preview.
A print preview is created in the work area.

 

  Note
Wait time for extensive documents

It can take several minutes to generate the print preview in the case of very extensive 
projects. You can continue working normally in the meantime on systems with adequate 
resources. The progress of the print preview is shown in the status bar.

 

See also
Operation within the print preview (Page 228)
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Operation within the print preview

Functions within the print preview
The print preview shows an exact image of the subsequent printout. You can use the buttons 
in the toolbar to modify the print preview display. The following functions are available (from 
left to right):

● Navigation mode
Allows shifting of the partial page.
To change the partial page with the navigation tool, select the arrow button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

● Zoom function

– "Zoom in" and "Zoom out"
Magnifies or reduces the page display.
To zoom in or zoom out the display incrementally, select the corresponding button. Then 
click on the page in order to magnify (zoom in) or reduce (zoom out) the page 
incrementally.
To zoom in on a particular area, select the "Lasso zoom" button and use the mouse to 
drag an outline around the area you want to focus on.
To select an area to focus on, select the button "Zoom in / zoom out with rectangle". 
With the mouse, drag a border around the area to focus on it.
To zoom dynamically through the page, select the button "Zoom in / zoom out 
dynamically". With pressed mouse button, scroll down over the page to zoom in. Scroll 
up to zoom out.

– Percentage value in the drop-down list
Specifies the display size of the page in percent.
Enter a percentage value or select a percentage value from the drop-down list. 
Alternatively, choose the the "Fit to page" option from the drop-down list to adapt the 
page size to the work area. Or, choose "Fit to width" to adapt the page width to the work 
area.
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● "Forward" and "Backward":
Each change in the partial page, the page count, or the display size is saved in a history in 
the background. You can use the "Forward" or "Backward" button to return to the previous 
view or the next view.

● Page navigation

– "First page"
Jumps back to the first page.

– "Previous page"
Goes one page back.

– "Page number" input field
Shows the current page. To jump directly to a page, enter the page number of the page 
you want to view.

– "Next page"
Goes to the next page.

– "Last page"
Jumps to the last page.

See also
Creating a print preview (Page 226)

7.3.4.9 Printing project data
You have two options for printing out project data:

● Print immediately using default settings by means of the "Print" button in the toolbar.
The button is only active if a printable object is selected.

● Printout with additional setting options with the "Project > Print" menu command.
For example, you can choose a different printer or specific documentation information or 
you can specify whether a cover page and table of contents are to be printed. In addition, 
you can specify the print scope or display a print preview prior to printing.

Requirement 
● At least one printer is configured.

● The objects to be printed are not protected.
If printing is restricted by access protection, you must temporarily cancel the password 
protection in order to release the objects for printing. Otherwise, protected objects will not 
be included in the printout.
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Printing project data  
To print out data from the current project or the entire project with additional setting options, 
follow these steps:

1. Select the entire project in the project tree in order to print out the entire project. To print 
only individual elements within a project, select them in the project tree.

2. Select the "Print" command in the "Project" menu.
The "Print" dialog opens.

3. Select the printer in the "Name" box.

4. Click "Advanced" to modify the Windows printer settings.

5. Select the frame layout you want to use for the printout.

– Select the documentation information in the "Document information" drop-down list.
The frame stored in the document information is used for the printout. All placeholders 
within the chosen frame are filled with the metadata from the selected document 
information.

– Select the "Print cover page" check box to print the cover page, which is stored in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.

6. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.

7. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor.

– Choose "Compact" to print out an abbreviated version of the project data.

8. Click "Preview" to generate a print preview in advance.
A print preview is created in the work area.

9. Click "Print" to start the printout.
 

 Note
Scope of the "Print" dialog

The options available in the "Print" dialog vary depending on the elements to be printed.
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Result
The project data is prepared in the background for printing and then printed on the selected 
printer. The status bar shows the progress of the print operation. You can continue working 
normally while data is being prepared for printing.

The print results and any errors or warnings are listed in the Inspector window under "Info" at 
the conclusion of the print job.

Canceling a print job  
To cancel an active print job, follow these steps:

1. Click the red "X" in the status bar next to the progress display for the printout.
The printout is cancelled promptly.

See also
Protection concept for project data (Page 211)

Revoking access rights for devices (Page 212)

Printout of project contents (Page 213)

7.4 Undoing and redoing actions

7.4.1 Basics of undoing and redoing actions

Function     
You can undo performed actions at any time. For this purpose, every action you perform is 
saved in an action stack. When undoing actions, the stack is processed from top to bottom. In 
other words, if you undo an action that lies further down in the stack, all actions located above 
it in the stack will also be undone automatically. 

You can redo previously undone actions until you execute a new action. Once you execute a 
new action, it is no longer possible to redo previously undone actions.

Particularities for undoing
There are a few actions that empty the action stack. You cannot undo these actions or the 
actions performed before these actions. The following actions empty the action stack:

● Saving

● Project management (creating a new project, opening project, closing a project, deleting a 
project)

● Compiling

● Restoring blocks
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● Establishing an online connection

● Loading

● Writing to memory cards

Displaying the action stack
The "Undo" button in the toolbar is enabled as soon as you perform an action that can be 
undone. This button is split; you can use the arrow down portion to open a drop-down list 
containing all actions of the action stack that you can undo. If you had performed actions in 
an editor other than the currently displayed editor, the corresponding editor is also displayed 
as a subheading. This allows you to always identify the point at which the undo operation will 
be applied. The subheadings are removed from the list when the editor responsible can no 
longer undo actions. 

Actions you have undone are entered in the action stack from where they can be redone. Here, 
you can redo actions you have undone. The display of actions you can redo it is analogous to 
the display of the actions that you can undo.

Example of undoing actions
The figure below shows how actions performed in various editors and tables are undone:

In this example, you cannot undo actions 1 to 3 because the project was saved. You can undo 
actions 4 to 10 in the order indicated by the direction of the arrow. In other words, you must 
undo action 10 first. Once you have undone action 8, you cannot then undo action 5. You must 
first undo actions 7 and 6. As the final step in the sequence, you can then undo action 4. You 
also have the option of undoing several actions in a single step by undoing an action located 
further down in the action stack. All actions located above it in the stack will be undone 
automatically. 

The same principle also applies to redoing of actions. 

See also
Undoing an action (Page 233)

Redoing an action (Page 234)
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7.4.2 Undoing an action
The following options are available for undoing actions:

● Undoing the last action only
Only the last action performed is undone.

● Undoing as many actions as required
Multiple actions in the action stack are undone in a single step.

Undoing the last action only
To undo the last action performed, follow the steps below:

1. Click the "Undo" button in the toolbar.

– If the action was not performed in the currently displayed editor, a confirmation prompt 
appears.

– If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was performed is displayed and the action is undone.

Undoing as many actions as required
To undo multiple actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Undo" button in the toolbar.
This opens a drop-down list containing all actions you can undo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to undo.
The chosen action and all actions in the stack located above the chosen action are undone. 
If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were performed are displayed and the actions are undone. 

See also
Basics of undoing and redoing actions (Page 231)

Redoing an action (Page 234)
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7.4.3 Redoing an action
You have the option of redoing an action that has been undone, so that you can return to the 
status present before "Undo" was performed. However, this is only possible until you perform 
a new action. The following options are available for redoing actions:

● Redoing the last undone action only
Only the last undone action is redone.

● Redoing as many undone actions as required
Multiple undone actions in the action stack are redone in a single step.

Redoing the last undone action only 
To redo the last undone action, follow the steps below:

1. Click the "Redo" button in the toolbar.

– If the action is not being redone in the currently displayed editor, a confirmation prompt 
appears.

– If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was undone is displayed and the action is redone.

Redoing as many undone actions as required
To redo multiple undone actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Redo" button in the toolbar.
This opens a drop-down list containing all actions you can redo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to redo.
The chosen action and all actions in the stack located above the chosen action are redone. 
If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were undone are displayed and the actions are redone. 

See also
Basics of undoing and redoing actions (Page 231)

Undoing an action (Page 233)
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7.5 Finding and replacing in projects

7.5.1 Information on the search function

Find and replace   
You can search for texts in the editors. The search function finds all texts containing the search 
key in the currently opened editor. The results are selected in sequence in the opened editor.

You also have the following options:

● Narrowing down the search with additional options

● Replacing found texts

The additional options and the type of texts for which you can search depend on the installed 
products and the currently open editor.

See also
Search and replace (Page 235)

7.5.2 Search and replace

Using Find  
The "Find and replace" function enables you to search for or replace texts in an editor.

Additional options for searching
You can narrow down your search by selecting one of the following additional options:  

● Whole words only
Only whole words are found. Words that contain the search key as part of the word are 
ignored.

● Match case
Upper- and lowercase letters are taken into account in the search.

● Find in substructures
The search also includes texts contained in another object.
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● Find in hidden texts
Texts that are assigned to another text but that are currently hidden are also included in 
the search.

● Use wildcards
Enter an asterisk as the wildcard for any number of characters. Example: You want to 
search for all words starting with "Device". Type in "Device*" in the search key box.
Enter a question mark as the wildcard, however, if you only want to leave out a single 
character.

● Use regular expressions (for searching in scripts only)
A regular expression is a character string used to describe sets of values and for filtering. 
This allows you to create complex search patterns.

The additional options available depend on the installed products and the editor opened.

Start search  
Follow these steps to start the "Find and replace" function:

1. Select the "Find and replace" command in the "Edit" menu or open the "Find and replace" 
pane in the "Tasks" task card.
The "Find and replace" pane opens.

2. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

3. Select the options desired for the search.

4. Using the option buttons, select the starting point for the search and the search direction.

– Select "Whole document" if you want to search through the entire editor regardless of 
the current selection,

– Select "From current position" if you want to start the search at the current selection.

– Select "Selection" if you only want to search within the current selection.

– Select "Down" to search through the editor from top to bottom or from left to right.

– Select "Up" to search through the editor from bottom to top or from right to left.

5. Click "Find".
The first hit is marked in the editor.

6. Click "Find" again to display the next hit.
The next hit is marked in the editor. Repeat this process, as necessary, until you reach the 
last hit.

Replacing the search key  
You have the option of replacing hits individually or automatically replacing all the found texts, 
if the respective editor supports this function. Follow these steps to replace terms:

1. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

2. Select the options desired for the search.
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3. Click the "Find" button to start a search for the specified search key.
The first hit is displayed in the editor.

4. In the "Replace" drop-down list, enter the text you wish to use to replace the search key.
As an alternative, you can select the most recently text specified from the drop-down list.

5. Click the "Replace" button to replace the selected hit with the specified text.
The found text is replaced and the next hit is marked in the editor.
Repeat this process until you have replaced all the hits as wanted. To skip to the next hit 
without replacing the marked word, click the "Find" button instead of "Replace".

6. Click "Replace all" to automatically replace all hits at once.

See also
Information on the search function (Page 235)

7.6 Working with text lists

7.6.1 Text lists

Introduction  
You can manage texts to be referenced in alarms centrally. All the texts are stored in text lists. 
Each text list has a unique name with which you can call up its content. A range of values is 
assigned to each text in a text list. If a value from a range of values occurs, the corresponding 
text is called up.

All the texts can be translated to all project languages. Here, you have two options available:

● You can enter the translation of the texts in a list. You will find the list in the project tree 
under "Languages & Resources > Project texts".

● You can export all texts to a file in Office Open XML format and enter the translation in a 
spreadsheet program. The translations can then be imported again.

The texts are translated into the other project languages within the framework of the project 
texts. In the text lists editor, you only have to manage the assignment of individual texts to a 
text list.

Each device in the project has its own text lists. For this reason, these lists are arranged under 
the devices in the project tree. In addition, there are text lists that apply to all devices. These 
can be found in the project tree under "Common data > Text lists".
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User-defined and system-defined text lists
There are two types of text lists:

● User-defined text lists
You can create user-defined text lists yourself and fill them with texts; in other words, you 
can specify value ranges and the corresponding texts yourself. With user-defined text lists, 
the name of the text list begins with "USER" as default. You can change this name to any 
suitable name.

● System-defined text lists
System-defined text lists are created by the system. These always involve texts relating to 
devices. They are automatically created as soon as you insert a device in the project. With 
system alarms, the name of the text list begins with "SYSTEM". The name of the text list 
and the ranges of values it contains cannot be modified. You can only edit texts assigned 
to individual value ranges.

User-defined text lists System-defined text lists
A user-defined text list can only be assigned to one 
device.

System-defined text lists can be assigned both to 
a device as well as to the entire project.

You can create new text lists and delete existing 
text lists.

You cannot create new text lists or delete text lists.

You can add and delete value ranges in the text 
lists.

You cannot add or delete value ranges in the text 
lists.

You can specify both the value ranges as well as 
the associated texts.

You can only edit the text associated with one 
value range.

Device-specific and cross-device text lists
Device-specific text lists relate to only one device in the project and are therefore only valid 
for this device. For this reason, they are arranged under a device in the project tree. Device-
specific text lists can be used-defined or created by the system. 

If system-defined text lists are generally valid for several devices or not intended uniquely for 
one device, these are grouped together in the project tree under "Common data". These text 
lists are available for all devices. Cross-device text lists are always created by the system and 
are used solely for system diagnostics alarms. For this reason, you cannot store any user-
defined text lists under "Common data". 

See also
Exporting and importing project texts (Page 200)

7.6.2 Creating user-defined text lists

Creating text lists
You can create user-defined text lists for individual devices.
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Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Procedure
To create user-defined text lists, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below the device are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Double-click on the first free row in the table.
A new user-defined text list is created.

4. Enter a name for your new text list in the "Name" column.

5. From the drop-down list in the "Selection" column, select whether you want to specify the 
value ranges in decimal, binary or in bits. Depending on the device, there may be further 
options available at this point.

6. Enter a comment in the "Comment" column.
A new user-defined text list has been created and you can now enter the value ranges and 
texts.

7.6.3 Editing user-defined text lists

Editing user-defined text lists  
You can enter value ranges and the corresponding texts in user-defined text lists. User-defined 
text lists are always located below a device in the project tree.

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.
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Adding to user-defined text lists with value ranges and texts  
To add to user-defined text lists with value ranges and texts, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. There, you can enter 
a value range and assign texts to the individual value ranges.

4. Enter the value ranges you require in the "Range from" and " Range to" columns. The entry 
must be made in the numeric format selected for the text list.

5. Enter a text for each value range in the "Entry" column.

7.6.4 Editing system-defined text lists

Editing system-defined text lists  
In system-defined text lists, you can only modify the individual texts assigned to a value range. 

System-defined text lists are located in the project tree either below a device or under 
"Common data".

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Modifying texts in system-defined text lists  
To edit texts in system-defined text lists that are assigned to a value range, follow these steps:

1. Click on the arrow to the left of a device in the project tree or the "Common data" element.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device or used in common are displayed in the work area 
listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. Here, you can add to 
or edit the texts assigned to a value range.

4. Enter a text for each value range in the "Entry" column.
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7.7 Using memory cards

7.7.1 Basics about memory cards

Introduction 
Memory cards are plug-in cards that come in a variety of types and can be used for a variety 
of purposes. Depending on the device type or device family, memory cards can be used for 
purposes, such as: 

● Load memory of a CPU 

● Storage medium for projects, firmware backups, or any other files

● Storage medium for performing a firmware update

● Storage medium for the PROFINET device name 

For information regarding the technical variants of the respective memory cards and general 
information on their handling, refer to the respective documentation for the device. For 
information on handling memory cards in the TIA Portal, refer to the online help under keyword 
"Memory Card".

 

 CAUTION

Do not use memory cards for non-SIMATIC-related purposes, and do not use third-party 
devices or Windows tools to format them. This will irrevocably overwrite the internal structure 
of the memory card, rendering it unusable for SIMATIC devices!

 

 

See also
Adding a user-defined card reader (Page 241)

Accessing memory cards (Page 242)

Displaying properties of memory cards (Page 242)

7.7.2 Adding a user-defined card reader

Introduction
If your card reader is not detected automatically, you can add it manually.

Requirement  
The project view is open.
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Procedure
To add a card reader, follow these steps:

1. Open the project tree.

2. Select "SIMATIC Card Reader > Add user-defined Card Reader" in the "Project" menu.
The "Add user-defined Card Reader" dialog opens.

3. In the drop-down list box, select the path for the card reader.

4. Confirm your entries with "OK".

See also
Basics about memory cards (Page 241)

Accessing memory cards (Page 242)

Displaying properties of memory cards (Page 242)

7.7.3 Accessing memory cards

Requirement 
● A memory card is inserted in the card reader.

● The project view is open.

Procedure
To access memory cards, follow these steps:

1. Open the project tree.

2. Select "SIMATIC Card Reader > Show SIMATIC Card Reader" in the "Project" menu.
The "SIMATIC Card Reader" folder is displayed in the project tree.

3. Open the "SIMATIC Card Reader" folder.
You can now access the memory card. 

See also
Basics about memory cards (Page 241)

Adding a user-defined card reader (Page 241)

Displaying properties of memory cards (Page 242)

7.7.4 Displaying properties of memory cards
You can display the properties for the utilized memory cards. Note that different memory cards 
with different properties must be used, depending on the device.
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Requirement
● A memory card is inserted in the card reader.

● The project view is open.

Procedure
To display the properties of a memory card, follow these steps:

1. Right-click on the memory card for which you want to display the properties.

2. Select the "Properties" command in the shortcut menu.
The "Memory Card <name of the memory card>" dialog opens. The properties are displayed 
in this dialog.

 

See also
Basics about memory cards (Page 241)

Adding a user-defined card reader (Page 241)

Accessing memory cards (Page 242)

7.8 Using libraries

7.8.1 Library basics

Introduction   
You can store objects you want to use more than once in libraries. It is possible to reuse the 
stored objects throughout a project or across projects. This means you can, for example, create 
block templates for use in different projects and adapt them to the particular requirements of 
your automation task. 
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Library types
Depending on the task, you can use one of the following library types:

● Project library
Each project has its own library. Here, you store the objects you want to use more than 
once in the project. This project library is always opened, saved, and closed together with 
the current project.

● Global libraries
You can also create other libraries in addition to the project library. Here, you store the 
objects you want to use in more than one project. You can create, change, save, and 
transfer these global libraries independent of projects. 
In the global libraries area, you will also find libraries that ship with the software. These 
include off-the-peg functions and function blocks that you can use within your project. You 
cannot modify the supplied libraries.

Library objects
Libraries can accommodate a large number of objects. These include, for example:

● Functions (FCs)

● Function blocks (FBs)

● Data blocks (DBs)

● Devices

● PLC data types

● Watch and force tables

● Process screens

● Faceplates

For objects with know-how protection, this protection is also retained after the object is inserted 
into a library. 

Use types
You can use the library elements as either a copy template or a type. You can use copy 
templates to generate copies of the library element that are independent of one another. Copy 
templates are marked with a black triangle in the "Libraries" task card. You can derive and use 
instances from types. These instances are tied to their respective type, and changes to one 
instance also change all other instances. Types are marked with a green triangle in the 
"Libraries" task card.

 

 Note

Please note the following:
● The use as a type is not available for every object. 
● You can only create types in the project library.
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See also
Project library basics (Page 248)

Global library basics (Page 256)

"Libraries" task card (Page 245)

7.8.2 "Libraries" task card

Function of the "Libraries" task card  
The "Libraries" task card enables you to work efficiently with the project library and the global 
libraries. 

You can show or hide the task card as needed.
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Structure of the "Libraries" task card
The "Libraries" task card consists of the following components:

① "Project library" pane
② "Global libraries" pane
③ "Elements" pane
④ "Parts" pane
⑤ "Types" folder
⑥ "Master copies" folder

"Project library" pane
In this pane, you can store the objects that you want to use more than once in the project. 
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"Global libraries" pane
In this pane, you can store the objects you want to use more than once in various projects. 

The "Global libraries" pane also lists libraries that ship with the system. These libraries provide 
you with ready-made functions and function blocks, for example. You can use these supplied 
global libraries but cannot modify them. 

"Elements" pane
In this pane, you can display the elements of a library.

"Parts" pane
In this pane, you can display the contents of the library elements.

"Types" folder
In this directory, you can create types of your objects in the project library and insert them as 
instances. You cannot create types in a global library. You can copy a type in the project library 
and paste it into the "Types" folder of a global library.

"Master copies" folder
In this directory, you can create copy templates of your objects, which you can insert as copies. 

See also
Library basics (Page 243)

Using the elements and parts view (Page 247)

7.8.3 Using the elements and parts view

Introduction    
When you open the "Libraries" task card the first time, the "Project library" and "Global libraries" 
panes are opened and the "Parts" pane is closed. You need to open the "Elements" pane 
explicitly. 

The elements view shows the elements of the selected library. You can select one of the 
following views:

● Details

● List

● Overview

The parts view shows the contents of the selected library element.
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Requirement
The "Libraries" task card is displayed.

Procedure
To use the elements and parts view, follow these steps:

1. Click "Open or close the element view" in the "Project library" or "Global libraries" pane.

See also
Library basics (Page 243)

"Libraries" task card (Page 245)

7.8.4 Working with the project library

7.8.4.1 Project library basics

Function    
In the project library, you can store the elements that you want to use more than once in the 
project. The project library is generated and saved automatically with the project.

See also
Library basics (Page 243)

7.8.4.2 Creating folders in the project library
The library elements are stored according to their type in the "Types" and "Master copies" 
folders within the project library. You can add subfolders to these folders as required.

Requirement
The "Libraries" task card is displayed.

Procedure
To create a new folder, follow these steps:

1. Right-click any folder within the project library.

2.  Select "Add folder" from the shortcut menu.
A new folder is created.

3. Enter a name for the new folder. 
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See also
Project library basics (Page 248)

Editing elements of a project library (Page 253)

Removing elements from the project library (Page 254)

Filtering the view (Page 255)

7.8.4.3 Adding elements to the project library

Adding master copies to the project library

Requirement
The "Libraries" task card is displayed.

Procedure 
To add a new copy template to the project library, follow these steps:

1. Open the project library in the "Project library" pane of the "Libraries" task card.

2. Select the element you want to add as a copy template to the project library, and use a 
drag-and-drop operation to move it to the "Master copies" folder or any of its subfolders in 
the project library. Release the left mouse button when a small plus symbol appears below 
the mouse pointer.

Result
The element is inserted into the project library as a copy template. You can generate copies 
from this template and use them anywhere in the TIA Portal where it is permissible. 

See also
Library basics (Page 243)

Project library basics (Page 248)

Adding types to the project library (Page 249)

Adding types to the project library

Requirement  
● Your installed products contain objects from which types can be generated.

● The "Libraries" task card is displayed.
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Procedure
To add a new type to the project library, follow these steps:

1. Open the project library in the "Project library" pane of the "Libraries" task card.

2. Right-click the "Types" folder or any of its subfolders.

3. Select the "Add new type" command in the shortcut menu.
The dialog for generating types opens.

 

  Note

If your installed products do not contain any objects from which types can be generated, 
the "Add new type" command is not available. Use master copies in this case.

 

4. In the dialog, choose the element from which you want to generate a type.

5. Specify all other necessary data.

6. Click "OK".

Result
A new type is generated and inserted into the project library. You can generate instances from 
this type and use them anywhere in the TIA Portal where it is permissible. The instances are 
tied to the type, i.e., changes to one instance are passed on to the other instances. 

See also
Library basics (Page 243)

Project library basics (Page 248)

Adding master copies to the project library (Page 249)

7.8.4.4 Using elements of the project library

Using master copies
You use the master copies you inserted into the project library in order to generate copies of 
elements and insert them in the TIA Portal, where permitted. The copies are generated and 
used in a single operation.

Requirement
The "Libraries" task card is displayed.
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Procedure  
To generate and use a copy from a copy template, follow these steps:

1. Open the "Master copies" folder or any of its subfolders in the project library so that you 
looking at the master copy from which you want to generate a copy.

2. Use a drag-and-drop operation to move the copy template from the project library to the 
location where you want to use it. If you are not permitted to insert it at this location, the 
mouse pointer changes to a circle with a slash.
A copy based on the copy template is inserted. If there is already an element with the same 
name at this location, the "Paste" dialog opens. In this dialog, you can decide whether to 
replace the existing element or to insert the copy with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

 

Or:

1. Open the element view.

2. Use a drag-and-drop operation to move the copy template from the "Elements" pane to the 
location where you want to use it. If you are not permitted to insert it at this location, the 
mouse pointer changes to a circle with a slash.
A copy based on the copy template is inserted. If there is already an element with the same 
name at this location, the "Paste" dialog opens. In this dialog, you can decide whether to 
replace the existing element or to insert the copy with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Result
A copy is generated from the copy template and inserted at the location where you want to 
use it. You can create any number of copies from a copy template. 

See also
Library basics (Page 243)

Project library basics (Page 248)

Using types (Page 252)

Using the elements and parts view (Page 247)
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Using types
You use the types you inserted into the project library in order to generate instances of elements 
and insert them in the TIA Portal, where permissible. The instances are generated and used 
in a single operation.

Requirement 
The "Libraries" task card is displayed.

Procedure 
To generate and use an instance from a type, follow these steps:

1. Open the "Types" folder or any of its subfolders in the project library so that you looking at 
the type from which you want to generate an instance.

2. Use a drag-and-drop operation to move the type from the project library to the location 
where you want to use it. If you are not permitted to insert it at this location, the mouse 
pointer changes to a circle with a slash.
The type is inserted as an instance. If there is already an element with the same name at 
this location, the "Paste" dialog opens. In this dialog, you can decide whether to replace 
the existing element or to insert the instance with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Or:

1. Open the element view.

2. Use a drag-and-drop operation to move the type from the "Elements" pane to the location 
where you want to use it. If you are not permitted to insert it at this location, the mouse 
pointer changes to a circle with a slash.
The type is inserted as an instance. If there is already an element with the same name at 
this location, the "Paste" dialog opens. In this dialog, you can decide whether to replace 
the existing element or to insert the instance with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Result
An instance is generated from the type and inserted at the location where you want to use it. 
You can create any number of instances from a type. The instances are tied to the type, i.e., 
changes to one instance are passed on to the other instances. 
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See also
Library basics (Page 243)

Project library basics (Page 248)

Using master copies (Page 250)

7.8.4.5 Editing elements of a project library
You can use the following editing commands on library elements:

● Copy

● Cut

● Paste

● Move within the library

● Rename

Each of these commands can always be executed via the keyboard (Page 178), menu, and 
shortcut menu.

Requirement 
The "Libraries" task card is displayed.

Copying elements
To copy a library element, follow these steps:

1. Right-click on the library element you want to copy.

2. Select the "Copy" command in the shortcut menu.

Cutting elements
To cut a library element, follow these steps:

1. Right-click on the library element you want to cut.

2. Select the "Cut" command in the shortcut menu.
 

 Note

You can only paste previously cut library elements into the same library. In so doing, you can 
only paste master copies into the "Master copies" folder or any of its subfolders. Likewise, 
you can only paste types into the "Types" folder or any of its subfolders.
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Pasting elements 
To paste a library element, follow these steps:

1. Copy a library element.

2. Right-click the library where you want to paste the element.

3. Select the "Paste" command in the shortcut menu.

Moving elements
To move a library element, follow these steps:

1. Select the library element you want to move.

2. Use a drag-and-drop operation to move the library element to the folder where you want 
to insert the element.

 

 Note

Note the following:
● When you move an element from one library to another, the element is copied and not 

moved.
● You cannot move master copies into a type folder or a type into a master copies folder.

 

Renaming elements
To rename a library element, follow these steps:

1. Right-click the element you want to rename.

2. Select the "Rename" command in the shortcut menu.

3. Enter the new name.

See also
Library basics (Page 243)

Project library basics (Page 248)

Creating folders in the project library (Page 248)

Removing elements from the project library (Page 254)

Filtering the view (Page 255)

7.8.4.6 Removing elements from the project library

Requirements
The "Libraries" task card is displayed.
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Procedure
To remove an element from the project library, follow these steps:

1. In the "Project library" pane, maximize the folder containing the element you want to remove.

2. Right-click the element.

3. Select the "Delete" command in the shortcut menu.

Or:

1. Open the element view.

2. Right-click the element you want to remove in the "Elements" pane.

3. Select the "Delete" command in the shortcut menu.

 

See also
Library basics (Page 243)

Project library basics (Page 248)

Creating folders in the project library (Page 248)

Editing elements of a project library (Page 253)

Filtering the view (Page 255)

7.8.4.7 Filtering the view
To make viewing of extensive libraries more straightforward, you can use filter options to limit 
the display.

Requirement   
The "Libraries" task card is displayed.

Procedure
To filter the view, follow these steps:

1. Open either the "Project library" pane or "Global libraries" pane.

2. In the drop-down list, select the object type for which you want to display the library 
elements.

Result
Only the library elements that are available for the object type are displayed. You can set the 
filter to "All" at any time to revert to an unfiltered view.
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See also
Library basics (Page 243)

Project library basics (Page 248)

Creating folders in the project library (Page 248)

Editing elements of a project library (Page 253)

Removing elements from the project library (Page 254)

7.8.5 Working with global libraries

7.8.5.1 Global library basics

Function   
You can store elements that you want to reuse in other projects in global libraries. You must 
create global libraries explicitly. 

Depending on the products installed, global libraries supplied by Siemens are also installed. 
You can use, but not change, the elements of these libraries.

Shared work with global libraries  
You can use global libraries together with other users. This requires, however, that all users 
who want to access to the global library open the library as read-only. 

See also
Library basics (Page 243)

7.8.5.2 Creating a new global library

Requirement
The "Libraries" task card is displayed.

Procedure  
To create a new global library, follow these steps:

1. Click "Create new global library" in the toolbar of the "Global libraries" pane or select the 
menu command "Options > Global libraries > Create new library".
The "Create new global library" dialog opens.

2. Specify the name and the storage location for the new global library.

3. Confirm your entries with "Create".
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Result
The new global library is generated and inserted into the "Global libraries" pane. A folder with 
the name of the global library is created in the file system at the storage location of the global 
library. This actual library file is given the file name extension ".al11". 

See also
Library basics (Page 243)

Global library basics (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.3 Opening a global library

Requirement
The "Libraries" task card is displayed.

Procedure  
To open a global library, follow these steps: 

1. Click "Open global library" in the toolbar of the "Global libraries" pane or select the menu 
command "Options > Global libraries > Open library".
The "Open global library" dialog box is displayed.

2. Select the global library you want to open. Library files are identified by the file name 
extension ".al11".
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3. You can also open the library so that it is write-protected. To do this, enable the "Open as 
read-only" option in the "Open global library" dialog.

 

  Note

Note the following:
● You cannot enter any additional elements in the global library if you open the library 

as read-only.
● All users have to open the library as read-only if multiple users want to access the 

library. This is a requirement for shared access to the library.
 

4. Click "Open".
The selected global library is opened and inserted into the "Global libraries" pane. 

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.4 Displaying properties of global libraries
You can display the properties of global libraries. Properties include the following:

● General information about the library
This includes the following information: creation time, author, file path, file size, copyright, 
etc. Many of the attributes can be changed.

● Library history
The library history contains an overview of the migrations performed. Here you can also 
call the log file for the migrations.

● Support packages in the library
You can display an overview of the additional software needed to work with all devices in 
the project.

● Software products in the library
You can display an overview of all installed software products needed for the project.
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Requirement  
The "Libraries" task card is displayed.

Procedure
To display the properties of a global library, follow these steps:

1. Right-click the global library whose properties you want to display.

2. Select the "Properties" command in the shortcut menu.
A dialog containing the properties of the global libraries opens.

3. Select the properties in the area navigation that you want to have displayed.

 

See also
Opening a global library (Page 257)

Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.5 Saving a global library
You can save changes made to global libraries not supplied by Siemens at any time. You can 
save a global library under another name using the "Save library as" command.

Requirement  
● The "Libraries" task card is displayed.

● The global library is not write protected.
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Saving changes
To save a global library, follow these steps:

1. Right-click on the global library you want to save.

2. Select the "Save library" command in the shortcut menu.

Saving a global library under another name
To save a global library under another name, follow these steps:

1. Right-click the global library that you want to save under a different name.

2. Select the "Save library as" command in the shortcut menu.
The "Save global library as" dialog opens.

3. Select the storage location and enter the file name.

4. Confirm your entries with "Save".
The library is saved in the specified location under the new name. The original library is 
retained. 

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.6 Closing a global library
Global libraries are independent of projects. This means that they are not closed together with 
your project. You must therefore close global libraries explicitly. 

Requirement 
The "Libraries" task card is displayed.
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Procedure
To close a global library, follow these steps:

1. Right-click on the global library you want to close.

2. Select the "Close library" command in the shortcut menu.

3. If you make changes to the global library, a dialog box opens where you can choose whether 
you want to save the changes to the global library. Click "Yes" or "No", depending on 
whether or not you would like to save your changes.
The global library is closed.

See also
Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Library basics (Page 243)

Global library basics (Page 256)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.7 Deleting a global library
You can delete global libraries that were not supplied by Siemens. Note, however, that this 
action causes deletion of the entire library directory in the file system of your programming 
device or PC. 

Requirements
The "Libraries" task card is displayed.

Procedure
To delete a global library, follow these steps:

1. Right-click the global library you want to delete.

2. Select the "Delete" command in the shortcut menu.

3. Click "Yes" to confirm.
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Result
The global library is removed from the "Global libraries" pane and deleted from the file system. 

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.8 Creating folders in the global libraries
The library elements are stored according to their type in the "Types" and "Master copies" 
folders within global libraries. You can add subfolders to these folders as required.

Requirements 
● The "Libraries" task card is displayed.

● The global library is not write protected.

Procedure
To create a new folder, follow these steps:

1. Right-click any folder within the global library.

2. Select "Add folder" from the shortcut menu.
A new folder is created.

3. Enter a name for the new folder.
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See also
Global library basics (Page 256)

Library basics (Page 243)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.9 Adding elements to a global library

Adding master copies to a global library

Requirements 
● The "Libraries" task card is displayed.

● The global library is not write protected.

Procedure
To add a new copy template to a global library, follow these steps:

1. In the Global libraries" pane of the "Libraries" task card, open the global library to which 
you want to add the copy template.

2. Select the element you want to add as a master copy to the global library, and use a drag-
and-drop operation to move it to the "Master copies" folder or any of its subfolders in the 
global library. Release the left mouse button when a small plus symbol appears below the 
mouse pointer.

Result
The element is inserted into the global library as a copy template. You can generate copies 
from this template and use them anywhere in the TIA Portal where it is permissible. 
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See also
Library basics (Page 243)

Global library basics (Page 256)

Adding types to a global library (Page 264)

Adding types to a global library
You can paste an existing type into a global library type from the project library. This allows 
you to use this type across multiple projects.

Requirement
● The "Libraries" task card is displayed.

● A type is available in the project library.

Procedure  
To add a type to a global library, follow these steps:

1. Open the project library in the "Project library" pane of the "Libraries" task card.

2. Right-click the type which you want to paste into the global library.

3. In the shortcut menu, select "Copy".

4. Right-click the type which you want to paste into the global library.

5. In the shortcut menu, select "Paste".

Result
The type is inserted in the global library. You can generate instances from this type and use 
them anywhere in the TIA Portal where it is permissible. The instances are tied to the type, 
i.e., changes to one instance are passed on to the other instances. 

See also
Library basics (Page 243)

Global library basics (Page 256)

Adding master copies to a global library (Page 263)

7.8.5.10 Using elements of a global library

Using master copies
You use the master copies you inserted into the global library in order to generate copies of 
elements and insert them in the TIA Portal, where permitted. The copies are generated and 
used in a single operation.

Editing projects
7.8 Using libraries

WinCC Professional V11.0 SP1
264 System Manual, 08/2011,  



Requirements
The "Libraries" task card is displayed.

Procedure 
To generate and use a copy from a copy template, follow these steps:

1. Open the "Master copies" folder or any of its subfolders in the global library so that you 
looking at the master copy from which you want to generate a copy.

2. Use a drag-and-drop operation to move the copy template from the global library to the 
location where you want to use it. If you are not permitted to insert it at this location, the 
mouse pointer changes to a circle with a slash.
A copy based on the copy template is inserted. If there is already an element with the same 
name at this location, the "Paste" dialog opens. In this dialog, you can decide whether to 
replace the existing element or to insert the copy with a different name.

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Or:

1. Open the element view.

2. Use a drag-and-drop operation to move the copy template from the "Elements" pane or the 
"Parts" pane to the location where you want to use it. If you are not permitted to insert it at 
this location, the mouse pointer changes to a circle with a slash.
A copy based on the copy template is inserted. If there is already an element with the same 
name at this location, the "Paste" dialog opens. In this dialog, you can decide whether to 
replace the existing element or to insert the copy with a different name.

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Result
A copy is generated from the copy template and inserted at the location where you want to 
use it. You can create any number of copies from a copy template. 

See also
Library basics (Page 243)

Global library basics (Page 256)

Using types (Page 266)

Using the elements and parts view (Page 247)
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Using types
You use the types you inserted into a global library in order to generate instances of elements 
and insert them in the TIA Portal, where permissible. The instances are generated and used 
in a single operation.

Requirements 
The "Libraries" task card is displayed.

Procedure
To generate and use an instance from a type, follow these steps:

1. Open the "Types" folder or any of its subfolders in the global library so that you looking at 
the type from which you want to generate an instance.

2. Use a drag-and-drop operation to move the type from the global library to the location where 
you want to use it. If you are not permitted to insert it at this location, the mouse pointer 
changes to a circle with a slash.
The type is inserted as an instance. If there is already an element with the same name at 
this location, the "Paste" dialog opens. In this dialog, you can decide whether to replace 
the existing element or to insert the instance with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Or:

1. Open the element view.

2. Use a drag-and-drop operation to move the type from the "Elements" pane to the location 
where you want to use it. If you are not permitted to insert it at this location, the mouse 
pointer changes to a circle with a slash.
The type is inserted as an instance. If there is already an element with the same name at 
this location, the "Paste" dialog opens. In this dialog, you can decide whether to replace 
the existing element or to insert the instance with a different name. 

 

  Note

The "Paste" dialog is not displayed for all elements. The elements for which the dialog is 
available depends on the installed products.

 

Result
An instance is generated from the type and inserted at the location where you want to use it. 
You can create any number of instances from a type. The instances are tied to the type, i.e., 
changes to one instance are passed on to the other instances. 
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See also
Library basics (Page 243)

Global library basics (Page 256)

Using master copies (Page 264)

Using the elements and parts view (Page 247)

7.8.5.11 Editing elements of a global library
You can use the following editing commands on library elements:

● Copy

● Cut

● Paste

● Move within the library

● Rename

Each of these commands can always be executed via the keyboard (Page 178), menu, and 
shortcut menu.

Requirements 
● The "Libraries" task card is displayed.

● The global library is not write protected.

Copying elements
To copy a library element, follow these steps:

1. Right-click on the library element you want to copy.

2. Select the "Copy" command in the shortcut menu.

Cutting elements
To cut a library element, follow these steps:

1. Right-click on the library element you want to cut.

2. Select the "Cut" command in the shortcut menu.
 

 Note

You can only paste previously cut library elements into the same library. In so doing, you can 
only paste master copies into the "Master copies" folder or any of its subfolders. Likewise, 
you can only paste types into the "Types" folder or any of its subfolders.
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Pasting elements 
To paste a library element, follow these steps:

1. Copy a library element.

2. Right-click the library where you want to paste the element.

3. Select the "Paste" command in the shortcut menu.

Moving elements
To move a library element within a library, follow these steps:

1. Select the library element you want to move.

2. Drag the library element to the library where you want to insert the element.
 

 Note

When you move an element from one library to another, the element is copied and not moved.
 

Renaming elements
To rename a library element, follow these steps:

1. Right-click the element you want to rename.

2. Select the "Rename" command in the shortcut menu.

3. Enter the new name.

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

Editing projects
7.8 Using libraries

WinCC Professional V11.0 SP1
268 System Manual, 08/2011,  



7.8.5.12 Removing elements from a global library

Requirements
● The "Libraries" task card is displayed.

● The global library is not write protected.

 

Procedure
To remove an element from a global library, follow these steps:

1. In the "Global libraries" pane, maximize the folder containing the element you want to 
remove.

2. Right-click the element.

3. Select the "Delete" command in the shortcut menu.

Or:

1. Open the element view.

2. Right-click the element you want to remove in the "Elements" pane.

3. Select the "Delete" command in the shortcut menu.

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Using a supplied global library (Page 269)

Filtering the view (Page 270)

7.8.5.13 Using a supplied global library
Depending on the products you install, various global libraries ship with the system.
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Requirement 
The "Libraries" task card is displayed.

Procedure
To use an element from a supplied global library in your project, follow these steps:

1. Open the relevant library so that you can see the elements of the library.

2. Drag the element from the "Global libraries" pane and drop it on the location where you 
want to use it. If you are not permitted to insert it at this location, the mouse pointer changes 
to a circle with a slash.

Or:

1. Open the element view.

2. Use a drag-and-drop operation to move the element from the "Parts" pane to the location 
where you want to use it. If you are not permitted to insert it at this location, the mouse 
pointer changes to a circle with a slash.

 

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Filtering the view (Page 270)

7.8.5.14 Filtering the view
To make viewing of extensive libraries more straightforward, you can use filter options to limit 
the display.

Requirement   
The "Libraries" task card is displayed.
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Procedure
To filter the view, follow these steps:

1. Open either the "Project library" pane or "Global libraries" pane.

2. In the drop-down list, select the object type for which you want to display the library 
elements.

Result
Only the library elements that are available for the object type are displayed. You can set the 
filter to "All" at any time to revert to an unfiltered view.

See also
Library basics (Page 243)

Global library basics (Page 256)

Creating a new global library (Page 256)

Opening a global library (Page 257)

Displaying properties of global libraries (Page 258)

Saving a global library (Page 259)

Closing a global library (Page 260)

Deleting a global library (Page 261)

Creating folders in the global libraries (Page 262)

Editing elements of a global library (Page 267)

Removing elements from a global library (Page 269)

Using a supplied global library (Page 269)

7.9 Using cross-references

7.9.1 Using cross-references

Introduction to cross-references
The cross-reference list provides an overview of the use of objects within the project. You can 
see which objects are interdependent and where the individual objects are located. Cross-
references are therefore part of the project documentation.

You can also jump directly to the point of use of an object.

Which objects you can display and localize in the cross-reference list depends on the installed 
products.
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7.10 Simulating devices

7.10.1 Simulation of devices

Introduction
You can use the TIA Portal to run and test the hardware and software of the project in a 
simulated environment. The simulation is performed directly on the programming device or 
PC. No additional hardware is required.

The simulation software provides a graphical user interface for monitoring and changing the 
configuration. It differs according to the currently selected device.

Integration in the TIA Portal
The simulation software is fully integrated in the TIA Portal but is only supported by certain 
devices. Therefore, the button for calling the simulation software is only active if the selected 
device supports simulation.

The simulation software for some devices requires its own virtual interface to communicate 
with the simulated devices. The virtual interface can be found in the project tree under the 
"Online access" entry next to the physical interfaces of the programming device/PC.

Once you have opened the software, additional help on the simulation software is available 
via a separate link.

See also
Starting the simulation (Page 272)

7.10.2 Starting the simulation
Some devices can be simulated with additional software. You therefore do not have to have 
the actual devices to perform comprehensive testing of your project. 

Procedure 
To start the simulation software, follow these steps:

1. Select the device you want to simulate, for example, in the project tree.

2. Select the "Simulation > Start" command in the "Online" menu.
This calls the simulation software.

See also
Simulation of devices (Page 272)
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Editing devices and networks 8
8.1 Configuring devices and networks

8.1.1 Hardware and network editor

8.1.1.1 Overview of hardware and network editor

Function of the hardware and network editor   
The hardware and network editor opens when you double-click on the "Devices and Networks" 
entry in the project tree. The hardware and network editor is the integrated development 
environment for configuring, networking and assigning parameters to devices and modules. It 
provides maximum support for the realization of the automation project.

Structure of the hardware and network editor   
The hardware and network editor consists of the following components:
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① Device view (Page 277), network view (Page 275), topology view (Page 280)
② Inspector window (Page 284) 
③ Hardware catalog (Page 285) 

The hardware and network editor provides you with three views of your project. You can switch 
between these three views at any time depending on whether you want to produce and edit 
individual devices and modules, entire networks and device configurations or the topological 
structure of your project.

The inspector window contains information on the object currently marked. Here you can 
change the settings for the object marked.

Drag the devices and modules you need for your automation system from the hardware catalog 
to the network, device ot topology view. 
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8.1.1.2 Network view

Introduction
The network view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Networking devices with one another

Structure     
The following diagram shows the components of the network view:

① Changeover switch: device view / network view / topology view
② Toolbar of network view
③ Graphic area of network view
④ Overview navigation
⑤ Table area of network view

You can use your mouse to change the spacing between the graphic and table areas of the 
network view. To do this, click on the upper edge of the table view and expand or contract this 
by moving the mouse with the mouse button held down. You can use the two small arrow keys 
to minimize, maximize or select the latest table structure of the table view with just one click.
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Toolbar   
The toolbar provides the following functions:

Symbol Meaning
Mode to network devices.

Mode to create connections.
You can define the connection type using the drop-down list.
Mode to create relations.

Show interface addresses.

Adjust the zoom setting.
You can select the zoom setting or enter it directly in the drop-down list. You can also 
zoom in or zoom out the view in steps using the zoom symbol or draw a frame around 
an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view 
is stored.

Graphic area
The graphic area of the network view displays any network-related devices, networks, 
connections and relations. In this area, you add devices from the hardware catalog, connect 
them with each other via their interfaces and configure the communication settings.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the network view includes various tables for the devices, connections and 
communication settings present:

● Network overview

● Connections

● I/O communication

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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See also
Adding a device to the hardware configuration (Page 300)

Determination of online status and display using symbols (Page 589)

Networking devices in the network view (Page 313)

Tabular network overview (Page 316)

8.1.1.3 Device view

Introduction
The device view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Configuring and assign module parameters

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  277



Structure     
The following diagram shows the components of the device view:

① Changeover switch: device view / network view / topology view
② Toolbar of device view
③ Graphic area of the device view
④ Overview navigation
⑤ Table area of device view

You can use your mouse to change the spacing between the graphic and table areas of the 
device view. To do this, click on the upper edge of the table view and expand or contract this 
by moving the mouse with the mouse button held down. You can use the two small arrow keys 
to minimize, maximize or select the latest table structure of the table view with just one click.

Toolbar   
The toolbar provides the following functions:

Symbol Meaning
Switches to the network view.
Note: The device view can switch between the existing devices using the drop-down 
list.
Show the area of unplugged modules.
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Symbol Meaning
Show module labels.
Adjust the zoom setting.
Select the zoom setting or enter it directly in the drop-down list. You can use the Zoom 
symbol to zoom in or out incrementally or to drag a frame around an area to be 
enlarged.
With signal modules, you can recognize the address labels from a zoom level of 200% 
or higher.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the device view displays hardware components and if necessary the 
associated modules that are assigned to each other via one or more racks. In the case of 
devices with racks, you have the option of installing additional hardware objects from the 
hardware catalog into the slots on the racks.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the device view gives you an overview of the modules used and the most 
important technical and organizational data.

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

See also
Working with racks (Page 294)

Network view (Page 275)

Area for unplugged modules (Page 297)

Inserting a module into a rack (Page 303)

Objects in the device view (Page 296)

Determination of online status and display using symbols (Page 589)
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8.1.1.4 Topology view

Introduction
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

● Configuring the Ethernet topology

● Identify and minimize differences between the desired and actual topology

Structure     
The following figure provides an overview of the topology view.

① Changeover switch: device view / network view / topology view
② Topology view toolbar
③ Graphic area of the topology view
④ Overview navigation
⑤ Table area of the topology view

You can use your mouse to change the spacing between the graphic and table areas of the 
topology view. To do this, click on the upper edge of the table view and expand or contract 
this by moving the mouse with the mouse button held down. You can use the two small arrow 
keys to minimize, maximize or select the latest table structure of the table view with just one 
click.
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Toolbar  
The toolbar provides the following functions:

Symbol Meaning
Adjusting the zoom setting.
You can select the zoom setting via the drop-down list or enter it directly. You can also 
zoom in or zoom out the view in steps using the zoom symbol or draw a frame around 
an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines will be displayed at the positions where the 
pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the topology view displays Ethernet modules with their appropriate ports 
and port connections. Here you can add additional hardware objects with Ethernet interfaces. 
See: Adding a device to the hardware configuration (Page 300) 

Overview navigation    
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
This displays the Ethernet or PROFINET modules with their appropriate ports and port 
connections in a table. This table corresponds to the network overview table in the network 
view. 

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

See also
Determination of online status and display using symbols (Page 589)

8.1.1.5 Printing hardware and network configurations

Printout of hardware and network configurations  
You can print out the following elements of the hardware and network view as part of the project 
documentation:

● Graphic network view

● Network overview table
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● Graphic device view

● The device overview table

● The parameters of the object currently selected in the editor

Printout of editor content
If you start a printout within an opened editor and no module is selected, the content of the 
editor is always printed. This includes a graphic representation of the editor as well as the table 
for the editor. You can adapt the scope of the printout. You can specify whether only the graphic 
view, the table or both together are to be printed. Read section "Changing the print options 
(Page 283)" for more on this.

If the graphic is larger than the page layout you have selected, the printout is continued on the 
next page. No content is lost this way. Alternatively, you can change the zoom level of the 
graphic representation to fit the printout on one page. The printout is always made in the 
currently selected zoom setting.

To check that all content fits on one page, you can either use the print preview or activate the 
page break preview. When page break preview is activated, dashed lines are displayed within 
the graphic editor at the location where the page break is later made.

Printing very large tables
If a table is larger than the print area and therefore cannot be fully printed, the content of the 
table is not printed as a table, but instead as pairs between value and key.

Example:

Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1

Property 2: Value B2

You can also preset this as a template so that tables are always printed as pairs between the 
key and the value. Read section "Auto-Hotspot" for more on this.

Printing module parameters
Parameters of selected modules are printed out along with the current value settings in text 
form. All parameters from corresponding modules are also printed. For example, if you have 
selected a CPU, the parameters of an inserted signal board, if present, are printed as well.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
282 System Manual, 08/2011,  



You can determine the scope of the module parameters to be printed. In the "Print" dialog, 
select whether all properties and parameters of a module are to be printed or whether to use 
the compact printout. If you select the compact form, only the entries in the "General" area of 
the module properties are printed. Comments on modules, as well as the author and module 
description, are excluded. In compact mode, the following module parameters are therefore 
printed, for example:

● Module specifications
Name, module slot, short description, order number, firmware version

● Name of the PROFINET interface

● Subnet specifications
Name of the subnet, ID of the S7 subnet

See also
Changing the print options (Page 283)

Activating the page break preview for printout (Page 283)

8.1.1.6 Activating the page break preview for printout
You can activate the page break preview for the printout in the graphic editor. If this option is 
activated, dashed lines are shown within the graphic editor at the locations where page breaks 
are later made during printout.

Procedure
Proceed as follows to activate the page break preview:

1. Select the graphic area of the corresponding view.

2. Click on the "Show page break" symbol in the toolbar of the graphic editor.
Dashed lines are displayed within the graphic editor at the location a page break is later 
made.

3. To modify the frame layout, select the "Print" command in the "Project" menu.

4. To disable page break preview, click again on the "Show page break" symbol in the toolbar 
of the graphic editor. 

8.1.1.7 Changing the print options

Changing the scope of the printout
When printing from an editor, you can specify whether both graphics and tables are to be 
printed or just one of the two. Both are printed by default.
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Procedure
To change the scope of the printout, proceed as follows:

1. In the "Options" menu, select the "Settings" command.

2. In the area navigation, open the "Print settings" parameter group under "General".

3. Scroll to the "Hardware configuration" group.

4. Select or clear the "Active graphic view" check box, depending on whether you want to print 
the graphics of the network and device view as well.

5. Select or clear the "Active table" check box, depending on whether you want to print the 
table for the editor as well.

See also
Printing hardware and network configurations (Page 281)

8.1.1.8 Inspector window 
The properties and parameters shown for the object selected can be edited in the inspector 
window.

Structure 
The inspector window consists of the following components:

① Switch between various information and work areas
② Navigation between various pieces of information and parameters
③ Display showing the selected information and parameters
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Function
The information and parameters in the inspector window are split into different types of 
information:

● Properties

● Info

● Diagnostics

To display the corresponding information and parameters, click in the area you want. The 
"Properties" area is the most important one for configuring an automation system. This area 
is displayed by default.

The left pane of the inspector window is used for area navigation. Information and parameters 
are arranged there in groups. If you click on the arrow symbol to the left of the group name, 
you can expand the group if sub-groups are available. If you select a group or sub-group, the 
corresponding information and parameters are displayed in the right pane of the inspector 
window and can be edited there too.

See also
Editing properties and parameters (Page 309)

Overview of hardware and network editor (Page 273)

8.1.1.9 Hardware catalog 
The "Hardware catalog" task card gives you easy access to a wide range of hardware 
components.
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Structure     
The "Hardware catalog" task card consists of the following panes:

① "Catalog" pane, search and filter function
② "Catalog" pane, component selection
③ "Information" pane

Search and filter function
The search and filter functions of the "Catalog" pane make it easy to search for particular 
hardware components. You can limit the display of the hardware components to certain criteria 
using the filter function. For example, you can limit the display to objects that you can also 
place within the current context or which contain certain functions.

Objects that can be used in the current context include, for example, interconnectable objects 
in the network view or only modules compatible with the device in the device view.
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Component selection
The component selection in the "Catalog" pane contains the installed hardware components 
in a tree structure. You can move the devices or modules you want from the catalog to the 
graphic work area of the device or network view.

Installed hardware components without a license are grayed out. You cannot use non-licensed 
hardware components.

Hardware components belonging to various components groups thematically are partially 
implemented as linked objects. When you click on such linked hardware components, a catalog 
tree opens in which you can find the appropriate hardware components.

Information
The "Information" pane contains detailed information on the object selected from the catalog:

● Schematic representation

● Name

● Version number

● Order number

● Brief description

See also
Browsing the hardware catalog  (Page 292)

Overview of hardware and network editor (Page 273)

Information on hardware components (Page 287)

8.1.1.10 Information on hardware components
In the hardware catalog, you can display information on selected hardware components in the 
"Information" pane. You can also display further information on the selected hardware 
components using the shortcut menu.

Access to further information
If you select a hardware object in the hardware catalog and open the shortcut menu, you not 
only have the "Copy" function available but also three options for accessing information on 
Service & Support:

● Information regarding product support

● FAQs

● Manuals
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The required information is displayed in the work area of the hardware and network editor.
 

 Note

You can only access Service & Support when you are connected to the Internet and the 
function is enabled. By default, the function is disabled. To enable the function, refer to the 
instructions in the section "Enabling product support (Page 288)".  

 

Information regarding product support  
Here, you have access to general information on hardware and software components. The 
order number of the selected hardware object is entered automatically in the search mask. 
You can, however, also search for other hardware and software components.

FAQs  
Here, you have access to "Frequently Asked Questions" (FAQs). You can view various entries 
on hardware and software questions. Using a detailed search mask, you can filter the required 
topics.

Manuals  
Here, you have access to the manuals of the various hardware components. This is particularly 
useful if the configuration, addressing or parameter assignment you are planning requires more 
detailed knowledge of the hardware you are using.

See also
Hardware catalog  (Page 285)

Enabling product support (Page 288)

8.1.1.11 Enabling product support

Enabling Service & Support function
For each device in the hardware catalog, you have the option of displaying additional 
information that is stored in the Service & Support area of the Siemens website. By default, 
the function is disabled. Instructions for enabling the function are given below.

Requirement
The software must have access to the Internet.
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Procedure
To enable the Service & Support function, proceed as follows:

1. In the "Options" menu, select the "Settings" command.

2. Open the "Hardware configuration" group in the area navigation.

3. Select the "Via Internet" check box.

Result
You can now access product support, FAQs and manuals from the hardware catalog via the 
shortcut menu for the module.

See also
Information on hardware components (Page 287)

8.1.1.12 Keyboard action in the hardware and network editor
You can execute some of the functions of the network and device view directly with a 
combination of keyboard and mouse in the hardware and network editor. The keyboard 
operation in tables corresponds to standard behavior. Here you find the keyboard operation 
for the graphic work area of the network and device view. 

General keyboard operation    

Function Key combination Comments
Zoom in on view in frame <Ctrl+Space> + mouse button pressed No object selection
Move view <Space> + mouse button pressed -
Cancel current operation <Esc> -
Separate connection <Esc> or double-click When making a connection
Zoom in graphic view <Ctrl> + turn mouse wheel -

Selected objects

Function Key combination Comments
Select object Mouse click -
Move object <Ctrl+X>, then <Ctrl+V> Copy selected object to move and then 

paste in new position
Copy object <Ctrl+C> Copy selected object to clipboard
Paste object <Ctrl+V> Paste object from clipboard to selection
Delete selected object <Del> -
Select several objects 1 <Shift> + click Select objects individually
Select several objects 2 <Ctrl> + click Selected objects can also be deselected
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Function Key combination Comments
Move selection Mouse button pressed Move to permitted slot
Copy selection <Ctrl> + mouse button pressed Move to permitted slot

8.1.2 Configuring devices

8.1.2.1 Basics

Introduction to configuring hardware
To set up an automation system, you will need to configure, assign parameters and interlink 
the individual hardware components. The work needed for this is undertaken in the device and 
network view.

Configuring   
"Configuring" is understood to mean arranging, setting and networking devices and modules 
within the device or network view. Racks are represented symbolically. Just like "real" racks, 
they allow you to plug in a defined number of modules. 

An address is automatically assigned to each module. The addresses can be subsequently 
modified. 

When the automation system is started, the CPU compares the setpoint configuration 
produced by the software with the system's actual configuration. Possible errors can be 
detected and reported straight away.

Assigning parameters  
"Assigning parameters" is understood to mean setting the properties of the components used. 
Hardware components and settings for the exchange of data are assigned:

● Properties of modules with selectable parameters

● Settings for data exchange between components

The parameters are loaded into the CPU and transferred to the corresponding modules when 
the CPU starts up. Modules can be replaced with ease since the parameters set are 
automatically loaded into the new module during startup.

Adjusting the hardware to the project requirements
You need to configure hardware if you want to set up, expand or change an automation project. 
To do this, add hardware components to your structure, link these with existing components, 
and adapt the hardware properties to the tasks.

The properties of the automation systems and modules are preset such that in many cases 
they do not have to be parameterized again. Parameter assignment is however needed in the 
following cases:
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● You want to change the default parameter settings of a module.

● You want to use special functions.

● You want to configure communication connections.

See also
Changing properties of the modules (Page 495)

Using existing configurations

Open existing projects
When opening existing projects, an automatic check is made to determine if the appropriate 
software is installed for all modules used within the project. If you try to open a project with 
modules that are not supported by the current scope of the installation of the TIA portal, a 
message appears on opening the project informing you of the missing software components. 
If the software components are not absolutely required to open the project, the project can still 
be opened.

Reaction to missing software components
Projects that contain modules not supported by the current scope of the installation react as 
follows:

● Display the modules on the GUI

– The non-supported modules are displayed in the project navigation with all of their 
nested objects. However, the modules themselves cannot be processed in editors or in 
inspector windows. When possible, a replacement module is used that best matches 
the original module. Replacement modules are indicated by an exclamation mark.

– Display of properties in tables is limited. This applies in particular to the display of 
network parameters, such as the IP address.

● Functional limitations

– Non-supported modules cannot be printed out or compiled.

– An online connection cannot be established to the module. It is therefore also impossible 
to download.

– To change the device type, the device must first be deleted and then re-inserted. The 
"Change device type" function is not supported.

– Copying and inserting nested objects, such as modules, is possible although the device 
itself cannot be copied and inserted.

– The network configuration cannot be changed with replacement modules within the 
network view.

– Cross-references can be displayed. However, the cross-references only reflect the state 
last saved within the project because on online comparison to the original module cannot 
be made.
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General slot rules

Introduction  
Specific slot rules apply to each automation system and module.

If you select a module from the hardware catalog in the device view, all possible slots for the 
module selected are marked in the rack. You can only drag modules to marked slots.

If you insert, move or swap a module, the slot rules are also applied.

Consistency  
Some slot rules depend on how the environment is configured. This means that you can 
sometimes plug modules into the rack although this would result in inconsistencies at the 
current time. If you change the configuration, for example by selecting different modules or 
module parameter settings, you can make the configuration consistent again.

In cases where inserting a module results in an inconsistency that can be corrected, this will 
be permitted. A consistency check is run when transferring the configuration. Inconsistencies 
are displayed as alarms in the inspector window under "Info". You can revise your configuration 
on the basis of the results of the consistency check and make it consistent again.

Rules for arranging modules  
As a rule of thumb, the following applies to modules in racks:

● You can only plug modules into a rack.

● You can only plug interface modules into a module.

● You can only use modules of the same product or system family in one rack.

There are also other special rules for some modules:

● Can only be inserted in certain slots

● Inertion depends on other modules, CPUs or settings

● Limitation of the number of times used in a rack

Browsing the hardware catalog 

Introduction  
Use the "Hardware catalog" task card to select the hardware components you want for a 
hardware configuration. Use the hardware catalog to select the interconnectable hardware 
components in the network and topology view and to select the modules you want in the device 
view.
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Context filter   
You can use the "Filter" option of the hardware catalog to restrict the number of displayed 
hardware components and the number of hardware components that can be found by 
searching.

If you select the filter, only those components are displayed that can be selected currently in 
the hardware catalog. If the do not select the filter, the entire hardware catalog is displayed.

If you switch between the various views, the view of the filter objects is adapted to the current 
context.

Search options  
You can use the search function to search for specific entries in the hardware catalog. Note 
the following rules when entering search terms:

● No distinction is made between upper and lower case text.

● Dashes and blanks are ignored during the search.

● The search function considers parts of a search term.

● Several search terms must be separated by a space

You start the search from an object highlighted in the hardware catalog and either search 
upwards or downwards.

Symbol Meaning
Downwards search
Upwards search
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Browsing the hardware catalog 
If you want to browse the hardware catalog, proceed as follows:

1. Click in the entry field of the search function

2. Enter a search term. The search includes the following elements:

– Name of device or module

– Order number (MLFB)

– Description in "Information" pane

3. Click on either the "Downwards search" or "Upwards search" buttons.
 

  Note

To ensure the right search direction, note which point you have marked in the hardware 
catalog. To browse the entire catalog, click on the topmost object of the hardware catalog 
and start the search once you have entered the search term by clicking "Downwards 
search".

The first match with the search term found is displayed as the result. For more search 
results, again click on the "Downwards search" or "Upwards search" button.

Observe the context filter of the hardware catalog. If this is selected, the search in the 
hardware catalog is restricted to the displayed inserted hardware components.

 

See also
Hardware catalog  (Page 285)

Information on hardware components (Page 287)

Working with racks

Introduction   
To assign modules to a device, you need a rack, for example a mounting rail. Secure the 
modules on the rack and connect these via the backplane bus with the CPU, a power supply 
or other modules.

Creating a rack
If you insert a device in the network view, a station and a rack suitable for the device selected 
are created automatically. The rack and slots available are displayed in the device view. The 
number of slots available again depends on the type of device used.

Rack structure   
A rack always contains the device that has been inserted in the network view. The device is 
permanently assigned a slot which will depend on the type of device in question. There are 
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additional slots on the right of the device and, if necessary, on left of the device; slot numbers 
are located above slots in which devices are plugged.

A corresponding short description is displayed above the plugged devices and modules. You 
show or hide this short description via the toolbar under "View" with the command "Display 
module titles" or the corresponding symbol in the toolbar of the device view (Page 277).

Symbol Meaning
Show module titles

When modules are selected in the hardware catalog, all the slots permitted for this module are 
marked. This allows you to see immediately the slot into which the selected module can be 
inserted.

In the following screenshot, a signal module has been selected in the hardware catalog for a 
partially filled S7-1200 rack:

Since slots 101-103 are reserved for communications modules, only the other free slots are 
shown as available slots.

You can expand and collapse the front group of slots using an arrow symbol above the 
expandable slot. When the group of slots is collapsed, the first and last of the group's slot 
numbers are displayed.

The following figure shows the expanded slot group:

Groups of slots into which modules have already been plugged cannot be collapsed.
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Multiple selection of modules and slots    
There are various ways of selecting several modules or slots:

● By pressing <Shift> or <Ctrl>, you can select several modules or slots at the same time.

● Click outside the rack and then hold the mouse button and drag a frame to include the 
modules or slots you want to select.

Objects in the device view
A graphic display of the rack and the devices plugged into it is shown in the upper section of 
the device view.

You can see the device overview in the bottom part of the device view. The device overview 
is a table showing you the most important information about the modules inserted in the rack.

Structure and content of device view
The offline configuration of the devices in the rack are displayed in the graphic device view. 
This is a symbolic representation of the configuration on the real rack.

The rack configuration is displayed as a table in the device view. Each line in the table contains 
the information for assigning a slot.

The following screenshot shows the device view with the configuration of a SIMATIC S7-1200 
CPU. 
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In the upper part, you can see the graphic view showing how the rack is occupied by various 
modules in slots 1 to 3 as well as 101. In the lower part you can see a tabular representation 
of the rack in the device overview.

Each line in the device overview represents one slot. The key information for each slot is 
displayed in the various columns:

Column Meaning
Module Name of module, can be edited in any way
Slot Slot number
I address Input address area, can be edited in any way
Q address Output address area, can be edited in any way
Type Catalog name of module
Order no. Module order number
Firmware Firmware version of module
Comments Optional comments

See also
Device view (Page 277)

Area for unplugged modules
In some cases, the modules for a hardware configuration are not assigned a slot for short 
periods. Such unplugged modules are moved to the area of unplugged modules, a special 
area in the device view.

Adding modules to the storage area       
The modules, which for example are to be assigned to a device using a copy action but for 
which the corresponding rack does not have a free compatible slot, are moved automatically 
into the area of unplugged modules.

Under the following conditions, modules are automatically added to the area of unplugged 
modules:

● In the network view, a module is moved to a device but the rack does not have a compatible 
free slot.

● In the device view, a module is moved from the rack, the hardware catalog or the project 
tree straight into the storage area.

CPs and FMs which occupy a network resource can be moved into the area for unplugged 
modules but will lose the network resources they have been assigned.

You can add modules to the area of unplugged modules by means of drag-and-drop, for 
example. To do this, the area must be opened.

Using the area of unplugged modules
Use the corresponding button to open the area of unplugged modules.
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You can find the area of unplugged modules in the device view.

You open the area of unplugged modules with the respective symbol in the toolbar of the device 
view (Page 277).

Symbol Meaning
Open area of unplugged modules

 

 Note

To free up slots, move modules from your configuration into the storage area and plug the 
modules you want from the storage area into the freed up slots.

You can use this approach to temporarily move modules that have already been 
parameterized out of the configuration without deleting them.

 

Treatment of modules in the storage area
The following rules apply to modules in the storage area:

● The modules appear in the project tree under the corresponding device in the "Local 
modules" folder.

● The modules retain all settings and parameters previously provided.

● The modules are not taken into account when downloading to a target system so a 
consistency check is not undertaken for modules in the area of unplugged modules.

● Using the context menu, the modules can be copied, pasted or deleted, for example.

8.1.2.2 Configuring individual devices

Selecting a CPU

Introduction
Select a CPU from the hardware catalog and place it, together with a rack, in the network view. 
On this device drag the desired modules from the hardware catalog; they are arranged 
automatically on the rack.
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Selecting the components in the hardware catalog   
Each hardware component is displayed as a folder in the hardware catalog. When you open 
this folder you will see the different versions of the selected hardware component with its 
respective order numbers.

There will be an example of how to set up a CPU with a rack in network view.

Requirement
● The hardware catalog is open.

● You must be in the network view.

Procedure
To select a CPU from the hardware catalog, proceed as follows:

1. In the hardware catalog navigate to the folder with the desired CPUs.

2. Open the folder with the desired CPU type; you will see all order numbers for the selected 
CPU type.

3. Click on a CPU order number to get information about the selected CPU under "Information" 
pane.

4. Set up the CPU and a rack. You have the following options:

– Use drag-and-drop to drag the CPU from the hardware catalog into network view.

– Use Copy & Paste to copy the CPU to the network view.

– Double-click the CPU entry in the hardware catalog.
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See also
Browsing the hardware catalog  (Page 292)

Adding a device to the hardware configuration (Page 300)

Inserting a module into a rack (Page 303)

Working with racks (Page 294)

Creating an unspecified CPU (Page 301)

Information on hardware components (Page 287)

Adding a device to the hardware configuration

Introduction   
There are various ways of adding a connectable device from the hardware configuration in the 
network view and the topology view:

● Command "Add new device" in the project tree

● Double-click device in hardware catalog

● Drag-and-drop from the hardware catalog in network view or in topology view:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● "Add > Device" command from menu bar in network view or topology view

● Shortcut menu of a device in the hardware catalog for copying and pasting

A suitable rack is created along with the new device. The selected device is inserted at the 
first permitted slot of the rack.

Regardless of the method selected, the added device is visible in the project tree and the 
network view of the hardware and network editor.

Adding device using the project tree  
To use the project tree to add a device to the hardware configuration, proceed as follows:

1. Click on the command "Add new device" in the project tree.
The "Add new device" dialog box opens.

2. Display the required device in the tree structure:

– Go to required device in the tree structure.

– Enter a device name in the entry field.

3. Select the required device from the tree.
More information about the device presently selected is displayed on the right-side of the 
dialog box.

4. If necessary, set the firmware version using the drop-down list in the dialog box.
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5. Select the "Open device view" check box if you want to change to the device view 
immediately after adding the device.
There you can immediately continue with device configuration and equipping the rack.

6. Click on "OK" to add the device selected.
The dialog box closes.

Adding device from the hardware catalog    
To add a device to the hardware configuration using the hardware catalog, proceed as follows:

1. Open the network view or the topology view.

2. Open the hardware catalog.

3. Go to the required device in the hardware catalog.

4. Click on the chosen device to select it.

5. If necessary, set the firmware version using the drop-down list in the hardware catalog.

6. Drag the device to the network view or the topology view.

You have now placed the device in the network view or in the topology view. The displayed 
rectangle (in other words "Station") symbolizes the plugged device together with its rack and 
any lower-level modules. Double-click on the device or station to open the device view and 
view the new rack and inserted device. In the next steps, you can configure the device in the 
device view and equip the rack with modules.

See also
Network view (Page 275)

Creating an unspecified CPU (Page 301)

Information on hardware components (Page 287)

Topology view (Page 280)

Creating an unspecified CPU

Introduction
If you have not yet selected a CPU but have already started programming or want to use an 
existing program, you have the option of using an unspecified CPU. You can also adjust some 
settings with unspecified CPUs. The setting options are restricted to parameters that all CPUs 
of the same CPU family have in common.
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Creating an unspecified CPU in the portal view  
To create an unspecified CPU in the portal view, follow these steps:

1. Now, click one of the following options:

– "Devices & networks > Add new device"

– "PLC programming" > "Device" button

2. For a device family, select an unspecified CPU from the tree structure of the "Add new 
device" dialog.

3. Click on "Add".

An unspecified CPU is created and the device view for this CPU appears.

Further options for creating unspecified CPUs
In the project view, you can create unspecified CPUs like specified CPUs:

● Using the "Add new device" button in the project tree

● In the "Hardware catalog" task card

You can also use these methods to create multiple unspecified CPUs.

Specifying unspecified CPUs
You have two options for specifying unspecified CPUs:

● Use drag-and-drop to assign an existing CPU from the hardware catalog to an unspecified 
CPU by means of module replacement (Page 308).

● Select an unspecified CPU and then click "Online > Hardware detection" in the menu bar 
and assign a CPU identified online. For this purpose, you assign an IP address using the 
"Add address for PG/PC" button.

See also
Selecting a CPU (Page 298)

Adding a device to the hardware configuration (Page 300)
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Inserting a module into a rack

Introduction   
Once you have added devices from the hardware catalog to your configuration in network view, 
you can add modules to the devices. There are various ways of adding a module to a rack in 
the device view:

● If there is an available valid slot, double-click a module in the hardware catalog.

● Use drag-and-drop to move the module from the hardware catalog to an available valid slot 
in the graphic or table area:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● Select "Copy" in the shortcut menu for a module in the hardware catalog and then select 
"Paste" in the shortcut menu on an available valid slot in the graphic or table area.

To access the device view from the network view, double-click a device or station in the network 
view or select the Device view tab. The device view contains an illustration of the device 
selected within a rack. The graphic illustration of the rack in the software corresponds to the 
real structure, i.e. you can see the same number of slots as exist in the real structure.

 

 Note

You can also move a module to a rack in the network view. The filter function for the hardware 
catalog must be deactivated in this instance. The module is automatically plugged into a free 
and permitted slot. If there are no slots available, the module will be moved to the area of 
unplugged modules (Page 297).

 

Equipping a rack   
Arrange the modules on a rack according to the applicable slot rules.

After a module has been inserted in a rack with an already inserted CPU, the address areas 
are checked automatically so that addresses are not assigned twice. After it has been inserted, 
each module then has one valid address range. To do so, DP slaves and IO devices must be 
networked with a CPU via the corresponding DP master or IO system.

Requirements
● You are in the device view.

● The hardware catalog is open.
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Adding module from the hardware catalog 
How to insert a module from the hardware catalog into a rack is illustrated based on the 
example of a signal module. To do this, follow these steps:

1. Go to the required module board in the hardware catalog.
 

  Note

If you activate the filter function of the hardware catalog, only those modules which match 
the selected device type will be displayed.

 

2. Select the chosen module.

3. If necessary, set the firmware version using the drop-down list in the hardware catalog.

4. Drag the signal module to a free slot in the rack.

You have now inserted the digital signal module in a slot in the rack. Repeat these steps with 
the other modules.

The name of the module is displayed above the inserted modules. You can activate or 
deactivate module labeling in the menu bar with "View > Show module labels".

Inserting module  
You can also drag modules and drop them between modules that have already been inserted. 
To do this, drag a module above and between the two existing modules while holding down 
the mouse button.

A mouse pointer appears. When you release the mouse button, all modules plugged to the 
right of the pointer are moved one slot to the right. Any redundant modules are moved to the 
area of unplugged modules. The new module is plugged at the point of the freed up slot. 
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See also
Device view (Page 277)

Area for unplugged modules (Page 297)

Information on hardware components (Page 287)

General slot rules (Page 292)

Deleting a hardware component
There are various ways of deleting hardware components. Deleted hardware components are 
removed from the system and assigned addresses made available again.

Rules
● CPUs or modules from the rack and from the area of unplugged modules can be deleted.

● When a rack is deleted in the device view the plugged hardware components are moved 
to the area of unplugged modules.

Procedure     
Proceed as follows to delete a hardware component:

1. Select the hardware components you want to delete.

– Network view: Select devices or network relevant hardware components in the graphic 
view or in the network view.

– Device view: In the graphic view or device overview, select racks or modules in racks 
or in the area of unplugged components.

– Topology view: Select devices or hardware components with Ethernet interfaces in the 
graphic view or in the topology view.

– Project tree: Select devices or individual hardware components from the tree structure.

2. Select "Delete" from the shortcut menu or press <Del>.
If the "Delete" menu item is unavailable, your selection contains at least one component 
that cannot be deleted.

The selected hardware components are deleted.
 

 Note

Deleting hardware components may result in inconsistencies in the project, for example 
infringement of slot rules. Inconsistencies are reported during the consistency check. Correct 
the inconsistencies by taking appropriate action, for example, make sure that slot rules are 
kept to.

 

See also
Keyboard action in the hardware and network editor (Page 289)
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Copying a hardware component
You can copy hardware components in the device or network view. Copied hardware 
components are stored on a clipboard and can be pasted at another point from this clipboard. 
Copied stations are pasted as new stations in the network view. Copied devices and modules 
can be pasted into existing racks in the network and device view.

Rules
● Single objects as well as several objects can be copied at the same time.

● Modules inserted in the rack and in the area of unplugged modules can be copied.

● You can only copy devices and modules to free and valid slots in keeping with the slot rules.

● Racks with a CPU inserted cannot be copied individually, but only as complete units along 
with all inserted hardware components.

Procedure     
Proceed as follows to copy a hardware component:

1. Select the hardware components you want to copy.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the station or the relevant hardware component from the network 
view.

– Project tree: Select the station or module.

2. Select "Copy" from the shortcut menu or press <Ctrl+C>.
If the "Copy" menu item is unavailable, your selection contains at least one component that 
cannot be copied.

3. Select the location at which the content of the clipboard is to be pasted.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules or move 
the mouse pointer to a free location in the network view to paste a copied station or a 
hardware component relevant to the network view.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.

The selected object is pasted at the chosen point.
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Once you have selected a station where you want to insert a module in the network view, the 
module is inserted in the first free and valid slot. If no free, valid slots are available, the object 
is inserted in the area of unplugged modules.

 

 Note

You can also copy a module from one device to another:

To do so, copy a module in the hardware and network editor, select a different device in the 
network view or the drop down list of the device view and insert the module.

You can insert the copied object directly in a slot or place it in the area of unplugged modules 
in the device view. If you add the copied object in the network view of a device or a station, 
it will be inserted in the first available slot.

If there is no slot available for the object, it is automatically placed in the area of unplugged 
modules (Page 297).

 

 Note

You can use <Ctrl> and drag-and-drop to directly copy a selected hardware component.
 

See also
Keyboard action in the hardware and network editor (Page 289)

Moving a hardware component
You can move hardware components in the device or network view.

Rules
● You can move devices and modules from the rack and the area for unplugged modules 

taking the slot rules into consideration.

● CPs can be moved in the network view. The CP is plugged in a free and valid slot in the 
target device. If there are no free slots available, the CP to be inserted is moved to the area 
for unplugged modules.

● In the network view, CPU and slave head modules can be moved between the devices; 
depending on CPU type also within the rack.

 

 Note

Moved CPs are disconnected from their network but keep their network parameters and 
address. If you reconnect the CP to the network and its address has been assigned, use a 
dialog to assign a new unique address to the CP.
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Procedure 
Proceed as follows to move a hardware component:

1. Select the hardware component you want to move.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the hardware component of relevance to the network view.

2. Select "Cut" from the shortcut menu or press <Ctrl+X>.
If the "Cut" menu item is unavailable, your selection contains at least one component that 
cannot be cut.

3. Select the location to which the cut object is to be moved.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.

The selected hardware component is moved to the target. If the hardware component being 
moved is a networked object, it is disconnected from the network.

 

 Note

You can use drag-and-drop to directly move a selected hardware component.
 

See also
Keyboard action in the hardware and network editor (Page 289)

Replacing a hardware component
You can replace hardware components with others. This, for example, allows you to replace 
unspecified CPUs (Page 301) with available CPUs from the hardware catalog.

Rules
You can only replace hardware components if they support module replacement and if the two 
components are compatible.

Procedure 
To replace one module with another, proceed as follows:

1. Select the module you want to replace.

2. Open the shortcut menu:

– If the "Replace device" entry is enabled, the module can be replaced.

– If the "Replace device" entry is disabled, a module cannot be replaced.
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3. Click on "Replace device" in the shortcut menu. ### The "Replace device" dialog box 
appears.

4. Under "New device" in the tree structure, select the module with which you want to replace 
your current module.

5. Click "OK".

The existing module is replaced by the new one.

As an alternative, you can take a module by dragging it from the hardware catalog to the module 
you are replacing. If the module can be replaced by the selected module, this is indicated by 
the mouse pointer symbol.

Editing properties and parameters
Once you have inserted hardware components in your rack, you can edit their default 
properties, for example parameters or addresses in the network or device view.

Requirements
You are in the device view.

 

 Note

You can also edit properties and parameters in the network view. In the graphic network view, 
you have access to the network-related hardware components and the station. You can 
access modules and hardware components not displayed in the graphic network view using 
the table network view.

 

Procedure     
To change the properties and parameters of the hardware components, proceed as follows:

1. In the graphic view, select the CPU, module, rack or interface you want to edit.

2. Edit the settings for the selected object:

– Use the table view to edit addresses and names, for example.

– In the Inspector window additional setting possibilities are available in "Properties".

Note that modules can only be fully parameterized if they are assigned to a CPU. Therefore, 
PROFIBUS or PROFINET interfaces modules must first be networked with the CPU or a 
centrally inserted communication module so that they form a master system or IO system. 
Only then is it possible, for example, to edit the addresses of the distributed components that 
are inserted. 
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Example of changing settings

① Selection of a module
② Editing option for addresses in the device overview
③ Selection options in the inspector window
④ Editing option for addresses in the inspector window

 

See also
Inspector window  (Page 284)
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Update module version

Explanation of terms
The terms "Module version" and "Firmware version" are explained in more detail in the 
following section.

● Module version: The specific version of the configuration software from which the module 
description stems.
Exp.: V11.0.0.0

● Firmware version: The version of the firmware of the offline configured module
Exp.: V2.0

Requirements
● You have created a device configuration.

● You have installed an update or an optional package at a later date. As a result of this 
installation, the module version of at least one module type was updated in the hardware 
catalog, whereby the new version is incompatible with the previous version.

● You have used such modules in your device configuration and want to use the modified or 
added properties.

Procedure
Perform the following step for each affected module type.

1. Select the affected module in the device view.

2. In the Inspector window, go to "Properties > General > Catalog Information". Click the 
"Update module version" button there.

3. In the query that then appears, specify whether you want to update the module version only 
for the selected module or for all modules of this type in the current project.

Result
The selected modules are replaced by the same modules with updated module version in the 
the current project.

In which cases is it unnecessary to update the module version?
An updating of the module version is not necessary in the following cases:

● You do not want to used the modified or added properties of the modules.

● You open an existing project with a version of the configuration software that is more recent 
than the version with which you created the project and the system automatically performs 
a project conversion, for example from V10.5 to V11.0. In this case, all older module 
versions are automatically adapted.
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8.1.3 Configure networks

8.1.3.1 Networking devices

Communication and networks

Communication between devices  
The basis of all types of communication is always a previously configured network. The network 
configuration provides the necessary requirements for communication:

● All the devices in a network are provided with a unique address

● Communication of the devices with consistent transmission properties

Network configuration  
The following steps are necessary when configuring networks:

● Connect devices to subnet

● Specify the properties/parameters for each subnet

● Specify the device properties for every networked module

● Download configuration data to the devices to supply interfaces with the settings resulting 
from the network configuration

● Document the network configuration

For Open User Communication, creating and configuring a subnet is supported by the 
assignment of connection parameters.

Relation between network configuration and project  
Within a project, subnets and their properties are managed. Properties result mainly from 
adjustable network parameters and the quantity and communication properties of the 
connected devices.

The devices to be networked must be in the same project.

Subnet name and subnet ID
Within the project, subnets are clearly identified by a subnet name and ID. The subnet ID is 
saved in all components along with interconnectable interfaces. Components can then be 
clearly assigned to a subnet even after uploading into a project.
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Networking options
In the project, you can create and network devices with components capable of 
communication. The following basic options are available for networking the devices:

● You link the interfaces of the components capable of communication with one another. A 
new subnet is created suitable for the type of interface.

● You connect the interface of the devices capable of communication with a new or existing 
subnet.

● You create an Open User Communication connection. When you assign parameters to the 
connection for Open User Communication, a subnet is created automatically between the 
communication partners.

● You use the graphic connection configuration to configure connections; missing networks 
are hereby recognized and are created either automatically or via dialog.

Due to the different tasks of the devices or the span of the plant, you may need to use several 
subnets. These subnets are managed in a project.

Networking devices in the network view

Options
In the graphic network view, you have an overview of the subnets of the entire system in the 
project. You can use the tabular network overview for additional support.

Depending on the starting situation, there are various ways of undertaking configuration to 
network the interface for a component capable of communication. The procedures are 
described in the following section:

● Creating an individual subnet

● Creating several subnets at one time

● Connecting two target devices via a new subnet

● Connecting devices to existing subnet

● Selecting an existing subnet from a list

● Automatic networking during the configuration of the connection;
See also: Auto-Hotspot

Possible starting situations are:

● A suitable subnet is not yet available.

● The subnet with which you want to connect the component already exists.

Procedure - creating a single subnet  
To create a subnet and to connect it to an interface, proceed as follows:

1. Select the interface of a CPU / a CP.

2. Select the "Create subnet" command in the shortcut menu of the interface.
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The selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following schematic shows an interface with outgoing line connecting to a subnet:

Procedure - creating several subnets at one time  
To create several subnets at one time, proceed as follows:

1. Select several interfaces by clicking on them while pressing the <Ctrl> button.

2. Select the "Create subnet" command in the shortcut menu of the interface.

Each selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following figure shows multiple subnets created by selecting multiple interfaces:

Procedure – Connecting two target devices via a new subnet
To connect an interface with another device via a subnet that does not yet exist, proceed as 
follows:

1. Position the mouse pointer over the interface for a component capable of communication 
requiring networking.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.
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4. Now move the pointer onto the interface of the target device. You can either keep the mouse 
button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

A new subnet is created. The interfaces are now connected via the new subnet. Consistent 
address parameters are set automatically for the interface.

The following schematic shows two networked devices:

Procedure - Connecting devices to existing subnet  
To connect an interface to an existing subnet, proceed as follows:

1. Position the mouse pointer on the interface of a communications-compliant component you 
want to network or on the existing subnet.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear once the pointer is 
moved to a valid target.

4. Now move the mouse pointer to the existing subnet or to the interface to be networked. 
You can either keep the mouse button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

Result:

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.
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Procedure - selecting an existing subnet from a list
To link an interface with a subnet that has already been created, proceed as follows:

1. Select the interface of a CPU.

2. Select the "Assign to new subnet" command in the shortcut menu of the interface.
A list box containing the available subnets appears.

3. Select a subnet from the list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Tabular network overview

Meaning
The tabular network overview adds the following functions to the graphic network view:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect components capable of communication with 
created subnets.

Basic functions for tables
The network overview supports the following basic functions for editing a table:

● Displaying and hiding table columns
 Note: The columns of relevance to configuration cannot be hidden. 

● Optimizing column width

● Sorting table

● Displaying the meaning of a column, a row or cell using tooltips.

Networking devices in the device view

Networking in the device view 
In the device view, you can check and set all the parameters of the components belonging to 
a device and the interfaces in detail. Here you can also assign the interfaces to the subnets 
created in the project.

Requirements
● The subnet with which you want to connect an interface has already been created.

● If the subnet has not yet been created, change to the network view and make the settings 
required for networking. 
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Procedure - connecting to an existing subnet 
To connect an interface to an existing subnet, proceed in the device view as follows:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. Select the subnet to be connected from the "Interface connected with" drop-down list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Procedure - creating a new subnet 
To create a subnet and to connect it to the interface, proceed as follows in the device view:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. In "Interface connected with", click the "Add new subnet" button.

The interface is connected to a new subnet of the appropriate subnet type. Consistent address 
parameters are set automatically for the interface.

Checking or changing network parameters and interface parameters

Introduction 
Communication between networked devices requires the following parameters to be 
configured:

● Network parameters
Network parameters identify the network within the system configuration, for example, using 
a name.

● Interface parameters
Interface parameters define specific properties of a component capable of communication. 
Addresses and transmission characteristics are set automatically and are consistent with 
the network parameters.

 

  Note

Network parameters and interface parameters are usually set during networking such that 
communication can take place for numerous applications without the parameters having 
to be changed.
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Procedure - checking or changing network parameters 
Proceed as follows to check or change network parameters:

1. Enter the network view.

2. Select the subnet from the network view.
You can see the network parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the network parameters in the relevant group of parameters.

Procedure - checking or changing interface parameters 
You can check and modify interface parameters in the network and device view.

Proceed as follows to check or change interface parameters:

1. Enter the network view or device view.

2. Select the interface.
You can see the interface parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the interface parameters in the relevant group of parameters.

 

Changing networkings

Introduction
You can cancel an interface's network connection or assign it to another subnet of the same 
subnet type.

Consequences
Depending on the version, a distinction should be made between:

● Canceling a network connection for an interface
The configured parameters for the interface remain unchanged.

● Assigning a network connection to another subnet
If the addresses in the assigned subnet are not unique, in other words, they already exist, 
they will be changed automatically to make them unique.
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Procedure - disconnecting from a network  
Proceed as follows to cancel the network connection for an interface:

1. Select the networked interface.

2. Select the "Disconnect from subnet" command in the shortcut menu of the interface.

The network connection is deleted, the interface addresses are, however, not changed.

Configured connections are retained; however these connections are marked red in the 
connection table because they are not networked. Specified connections remain specified.

See also
Networking devices in the network view (Page 313)

Copying, cutting or deleting subnets

Introduction
You can copy subnets as individual objects or copy them along with networked devices or 
other networks.

For example, you can create complex configurations to be used more than once in different 
variants within the project with no additional effort.

Effects on the copied subnet 
Properties that have to be assigned explicitly within a project are re-assigned appropriately 
when the copied objects are copied. 

For subnets, this means: The subnet ID and name are re-assigned to the copied subnet.

The configured properties are adopted in the copied subnet.

Procedure - copying a subnet
Proceed as follows to copy one or more subnets:

1. Select one or more subnets.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

The copied subnets are shown as "orphaned" subnets in the top part of the network view.
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Procedure - copying a subnet with connected devices 
To copy one or more subnets with networked devices, proceed as follows:

1. Select one or more subnets with the connected devices, for example by drawing a lasso 
around them.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

Complete copies of the subnets and connected devices are created.

Configured connections are adopted and remain within the copied devices. Connections to 
devices that have not been copied are interrupted and become unspecified.

MPI network configuration

Allocating MPI addresses 
Note the following for devices with an MPI interface: All devices of a subnet must have different 
device addresses. 

CPUs with MPI address ship with the default MPI address 2. Since you can only use this 
address once in the MPI subnet, you will have to change the default address in all other CPUs.

The following applies to devices with the order no. 6ES7 3xx-xxxxx-0AB0:

When planning the MPI addresses for several CPUs, you have to fill "MPI address gaps" for 
FMs and CPs with separate MPI addresses to prevent addresses being assigned twice. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

Rules for assigning the MPI address 
● Allocate the MPI addresses in ascending order.

● Reserve MPI address 0 for a programming device.

● You can link up to 126 (addressable) devices with one another in an MPI subnet; up to 8 
devices at a transfer speed of 19.2 KB/s.

● All MPI addresses in an MPI subnet must be different.
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You will find other rules relating to the structure of a network in the manuals for setting up 
automation systems.

PROFIBUS network configuration

PROFIBUS addresses

Rules for the network configuration  
All the devices in a subnet must have a different PROFIBUS address. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

You can connect devices to the PROFIBUS subnet that communicate via configured 
connections or that belong to a PROFIBUS DP master system.

You can find more information on configuring a DP master system in the following sections.

Requirements
The 121xC CPU is PROFIBUS compatible as of firmware version 2.0.

Rules for assigning PROFIBUS addresses
● Allocate the PROFIBUS addresses in ascending order.

● Reserve the PROFIBUS address "0" for a programming device.

● Allocate a unique PROFIBUS address between 0 and 126 for each device on the 
PROFIBUS network and/or for each DP master and each DP slave in the PROFIBUS 
network.

● There are modules with which the smallest address that can be set has to be greater than 
1.

● All PROFIBUS addresses of a PROFIBUS subnet must be different.

You will find additional rules relating to the structure of a network in the manuals for setting up 
automation systems, for example SIMATIC S7-1200.

 

 Note
PROFIBUS address "0"

Reserve PROFIBUS address "0" for a programming device that you will briefly connect up 
to the PROFIBUS network at a later date for servicing.

 

See also
What you need to know about PROFIBUS bus parameters (Page 322)
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What you need to know about PROFIBUS bus parameters

Matching parameters to one another  
The PROFIBUS subnet will only function without problem if the parameters for the bus profile 
are matched to one another. You should therefore only change the default values if you are 
familiar with how to configure the bus profile for PROFIBUS.

 

 Note

It may be possible for the bus parameters to be adjusted depending on the bus profile. If the 
bus parameters cannot be adjusted, they are grayed out. The offline values of the bus 
parameters are always shown even if you are online and linked to the target system.

 

The parameters shown apply to the entire PROFIBUS subnet and are briefly explained below.

Activating cyclic distribution of the bus parameters
If the "Enable cyclic distribution of the bus parameters" check box is selected under "Bus 
parameters" while PROFIBUS subnet is selected in the Inspector window, the bus parameters 
are transferred cyclically during operation by the modules that support this function. This allows 
a programming device, for example, to be easily connected to the PROFIBUS in runtime. 

You should deactivate this function:

● For a heterogeneous PROFIBUS subnet (or more accurately: when external devices are 
connected whose protocol uses the DSAP 63 for Multicast)

● When in constant bus cycle time mode (minimize bus cycle)

Bus parameters for the bus profile of PROFIBUS subnets  

Bus parameter Adjustable? Limit values
Tslot_Init Yes Max. Tsdr + 15 <= Tslot_init <= 16.383 t_bit
Max. Tsdr Yes 35 + 2*Tset + Tqui <= Max. Tsdr <= 1.023 t_bit
Min. Tsdr Yes 11 t_bit <= Min. Tsdr <= MIN(255 t_bit, ...

... Max. Tsdr - 1, 34 + 2*Tset + Tqui)
Tset Yes 1 t_bit <= Tset <= 494 t_bit
Tqui Yes 0 t_bit <= Tqui <= MIN(31 t_bit, Min. Tsdr - 1)
GAP factor Yes 1 <= GAP factor <= 100
Retry limit Yes 1 <= Retry limit <= 15
Tslot No ---
Tid2 No Tid2 = Max. Tsdr
Trdy No Trdy = Min. Tsdr
Tid1 No Tid1 = 35 + 2*Tset + Tqui
Ttr Yes 256 t_bit <= Ttr <= 16.777.960 t_bit
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Bus parameter Adjustable? Limit values
Ttr typical No This time is provided for information only and is not transferred to the 

nodes.
Response monitoring  10 ms <= response monitoring (watchdog) <= 650 s

If you want to create a customized bus profile, we recommend the following settings:

● Minimum target rotation time (Ttr) = 5000 x HSA (highest PROFIBUS address)

● Minimum response monitoring (watchdog) = 6250 x HSA

Recalculating
You can use the "Recalculate" button to recalculate the parameters. 

See also
PROFIBUS addresses (Page 321)

Description of the bus parameters (Page 323)

Description of the bus parameters

Detailed description of PROFIBUS bus parameters

Bus parameter Meaning
Tslot_Init The wait-for-reception (slot time) defines the maximum time the sender will wait 

to receive a response from the addressed partner. If the influence of the line 
components on message frame run times is entered in the "Cable Configuration" 
parameter group, these components must also be taken into account. The 
component is added to the specified Tslot_Init and the total used as Tslot.

Max. Tsdr The maximum protocol processing time defines the latest time by which the 
responding node should have replied.

Min. Tsdr The minimum protocol processing time defines the earliest time by which the 
responding node may reply.

Tset The trigger time is the time which may lapse between the reception of a data 
message frame and the response to it in the node.

Tqui The modulator quiet time is the time which a sending node needs after the end 
of the message frame to switch from sending to receiving.

GAP factor The GAP update factor defines the number of token rotations after which a newly 
added, active node can be added to the logical token ring.

Retry limit This parameter defines the maximum number of attempts (message frame 
repeats) made to reach a node.

Tslot The wait-for-reception time (slot time) defines the maximum time the sender will 
wait to receive a response from the addressed partner.
If the influence of the bus design components on message frame run times is 
entered in the "Cable Configuration" parameter group, these components must 
also be taken into account. The component is added to the specified Tslot_Init 
and the total used as Tslot.
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Bus parameter Meaning
Tid2 Idle time 2 defines the earliest time by which a sending node may send the next 

message frame after sending a message frame that has not been acknowledged.
Trdy The ready time specifies the earliest time by which a sending node may receive 

a response message frame.
Tid1 Idle time 1 defines the earliest time by which a sending node may send the next 

message frame after receiving a response.
Ttr The target rotation time is the maximum time made available for a token rotation. 

During this time, all active nodes (DP masters etc.) have the right to send (token) 
once. The difference between the target rotation time and the actual token holding 
time of a node determines how much time is left over for the other active nodes 
(programming device, other DP masters etc.) to send message frames.

Ttr typical The typical data cycle time is the average response time on the bus if all 
configured slaves are exchanging data with the DP master. None of the slaves 
report diagnostics and there is no extra message frame traffic with programming 
devices or other active nodes etc. on the bus.

Response monitoring The response monitoring time is only needed for PROFIBUS-DP bus systems. It 
defines the latest time by which a DP slave has to be addressed by its DP master 
with a new data message frame. If this does not happen, the DP slave assumes 
that the DP master has failed and resets its outputs to a secure mode.

See also
What you need to know about PROFIBUS bus parameters (Page 322)

Bus profiles with PROFIBUS

Introduction  
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.   

Devices with different profiles on the same PROFIBUS subnet  
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. For example, if both DP and FMS services are being used on a subnet, 
the "slower" sets of bus parameters must always be set for all devices, i.e. even the "Universal 
(DP/FMS)" profile for DP devices.  

Profiles and transmission rates  

Profiles Supported transmission speeds in Kbits/s
DP 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000 
Standard 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
Universal (DP-FMS) 9.6 19.2 93.75 187.5 500 1500
Customized 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
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Meaning of profiles  

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal (DP/FMS) Select the "Universal (DP/FMS)" bus profile when individual devices on the 
PROFIBUS subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5 (SIMATIC S7)
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

Customized The PROFIBUS subnet will only function without problem if the parameters for 
the bus profile are matched to one another. Select the "Customized" profile 
when none of the usual profiles "match" a PROFIBUS device and you need to 
adapt the bus parameters to your special structure. Information on this can be 
found in the documentation for the PROFIBUS device. 
You should only change the default values if you are familiar with how to 
configure the bus profile for PROFIBUS. 
Not all combinations that can be theoretically set can be used even with this 
bus profile. The PROFIBUS standard specifies several parameter limits that 
depend on other parameters. For example, a responder must not respond (Min 
Tsdr) before the initiator can receive the message frame (Trdy). These standard 
specifications are also checked in the "Customized" profile. 
Tip: The bus parameters last valid on the PROFIBUS subnet are always 
automatically set as customized. For example, if the "DP" bus profile was valid 
for the subnet, then the bus parameters for "DP" are set in the "Customized" 
bus profile. The parameters can be modified on this basis. 
The monitoring times are not automatically recalculated so that you do not put 
at risk the consistency of set values, for example with configurations in other 
configuration tools without realizing that you have done so.
You can also have the Ttr monitoring times and target rotation time calculated 
on the basis of parameters you have set: Click here on the "Recalculate" button.

 

 Note

Both mono-master mode and multi-master mode are possible with all PROFIBUS profiles. 
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What you need to know about PROFIBUS line configuration

Cable configuration and bus parameters
Information regarding the cable configuration can be taken into consideration when calculating 
the bus parameters. For this purpose, you must select the "Consider cable configuration" check 
box in the properties for the PROFIBUS subnet.

The remaining information then depends on the type of cable used; the following settings are 
available:

● Copper cable

● Fiber-optic cable/optical ring

PROFIBUS line configuration, optical ring
The calculation depends on the OLM types used. The selection is made by activating the check 
box (multiple activation is possible, at least one OLM type must be selected):

● OLM/P12

● OLM/G12

● OLM/G12-EEC

● OLM/G12-1300

The following bus parameter adjustments are made:

● Configuration of a node not present
 

  Note
The following restrictions apply to optical rings, even for passive nodes (DP slaves for 
example):

A maximum of HSA-1 nodes may be connected to the PROFIBUS network. With an HSA 
of 126, addresses 126 and 125 must not be used. A maximum of 125 nodes are possible 
on the bus (No. 0 to 124).

If an HSA is less than or equal to 125, the addresses HSA and greater may not be used. 
The address HSA-1 may not be used.

 

● Increase the retry value to 3

● Setting of minimum slot time needed for ring mode
 

  Note

Short slot time values are needed for OLM/P12, average ones for OLM/G12 and OLM/
G12-EEC and long ones for OLM/G12-1300. This results in high performance for small 
network lengths and average to low performance for average to large network lengths.
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PROFIBUS communication load

Communication load - allowing for additional network stations
The bus parameters depend on the volume of communication between the active network 
nodes. There are differences between cyclic communication (DP) and connection-based, 
acyclic communication (S7 communication, Send/Receive (FDL), FMS). Unlike DP, the volume 
and size of communication tasks (communication load) depends on the user program. For this 
reason, the communication load cannot always be calculated automatically. 

To calculate the bus times you can define a network configuration in the "Additional network 
stations" parameter group that differs from the network configuration.

Taking the profile into account
The network configuration can be defined for the "Standard", "Universal (DP/FMS)", and "User-
defined" profiles. Parameters cannot be entered in the "Additional network stations" parameter 
group for the "DP" profile.

Quantification of the communication load
The following settings are available in order to make allowance for the communication load.

● Information regarding the number of unconfigured network stations;

● Information on the communication load resulting from the user programs for FDL or S7 
communication. Here you can selected from the following settings:

– Low
Typically used for DP, no great data communication apart from DP.

– Medium
Typically used for mixed operations featuring DP and other communication services 
(such as for S7 communication), when DP has strict time requirements and for average 
acyclic volumes of communication.

– High
For mixed operations featuring DP and other communication services (such as for S7 
communication), when DP has loose time requirements and for high acyclic volumes of 
communication.

 

Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.
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IP address  
The IP parameters are visible if the module capable of communication supports the TCP/IP 
protocol. This is usually the case for all Ethernet modules.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of: 

● Address of the (sub) net

● Address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The device address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0

 

 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.
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Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (for example IP address 129.80.xxx.xxx) and change 
the default subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The task of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, you have to enter the 
address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.

Network configuration of AS interface
AS-Interface consists of an AS-i master and AS-i slaves connected to each other over an AS-
i subnet.

Rules for AS interface network configuration
All the nodes in an AS-i subnet must have a different AS-i node address.

You should only load the settings over the network when all the modules in a subnet have 
different addresses and when the actual structure matches that of the network configuration 
you have created.

One AS-i master and up to 31 AS-i slaves can be operated on one AS-i subnet.

For more information on configuring an AS-Interface with an AS-i master and AS-i slaves, refer 
to the section on AS-Interface and the documentation of the AS-i master modules.
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8.1.3.2 Communication via connections

Working with connections

S7 connection

Introduction to configuring connections

Definition   
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (for example, S7 connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an S7 connection as 
a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A row in this connection table represents a 
configured connection from the viewpoint of the local communication partner with its properties, 
for example, between two S7-1200 CPUs.

What you need to know about using connection resources

Introduction  
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.
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S7 connections
In the case of S7 connections via the PN interface, one connection resource per S7 connection 
is assigned for the endpoint for the S7-1200 CPU. One connection resource is also required 
for the connection partner.

You can find an overview of available and assigned connection resources for selected S7-1200 
CPU in the Inspector window at "Properties > Connection Resources"
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window
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Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– When connection mode is enabled, the connection path is highlighted in the network 
view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view 
(when connection mode is enabled)

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
In the network view, you have add devices between which the connections should be 
configured.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically in the connection table of the S7-1200 CPU. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
In the case of graphic connection configuration, the connection path is automatically specified 
provided interfaces and resources are available. Select the devices to be connected in the 
current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

This step activates the connection mode: You can now select the connection type you want. 
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Configuring a connection when there is no or no clear network assignment
Any networking not in place will if possible be created automatically when a connection is 
created. A query will be made upon completion of connection configuration if unique network 
assignment is not possible. You will be able to choose from the existing subnets.

Example below: A query is made upon creation of a connection between stations PLC_1 and 
PLC_2, which are not yet networked.
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Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.

Procedure
Proceed as follows to interactively create a connection:

1. Select the "Add new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog appears. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To accept the configured connection and to configure additional connections to other 
endpoints, click "Add".
To close the dialog, click "OK".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the S7-CPU for which you want to display the connection partners in the network 
view and then select the "Highlight connection partners" command in the shortcut menu.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.
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 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.

 

 

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

If you want to store the layout, width and visibility of the table columns, click on the "Remember 
layout" function in the top right-hand of the network view.
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Symbol Meaning
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view is 
stored.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit some of the parameters displayed in the connection table. The name of 
the connection can, for example, only be changed in the connection table.

Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections via the network view or the connection table.

In the network view you can delete a highlighted connection. In the connection table you can 
delete one or more connections.

Procedure
To delete a connection, proceed as follows:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

The selected connection will be completely deleted.

Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.
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You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.

Copying devices
If you copy devices for which connections have been configured, the connections are copied 
as well. To complete the connection path, you must still finalize the networking. 

An S7-1200 CPU with a V.10 firmware is merely a server for connections and has no 
connection configuration itself. Consequently, no connections are copied along with it when 
an S7-1200 CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
To assign a closed connection path to an existing open connection path, expand the device 
configuration in such a way that the interfaces required for the connection type are available 
for both partners. At "Properties > General > Interface" in the Inspector window, you can use 
the "Find connection path" button to create a connection to an existing partner.
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S7 connection - general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can assign the connection path and specify all aspects of the connection partner.

Local ID
The local ID of the module from which the connection is viewed is displayed here (local partner). 
You can change the local ID. You may need to do this if you have already programmed 
communication function blocks, and you want to use the local ID specified in those function 
blocks for the connection.

Special connection properties
Display of connection properties (can be modified depending on the components used):

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Active connection establishment
In the case of one-way connection, for example with a S7-1200 CPU (firmware version 
V1.0), a connection partner can only be provided for the active connection establishment. 
In the case of a two-way connection you can set which connection partner will assume the 
active role.

● Sending operating mode messages
Indicates whether or not the local partner sends operating mode messages to the 
connection partner.

Address details
Displaying address details of the S7 connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed.

S7 connection - address details

Meaning
The address details show the end points of the connection and can localize these via the 
specification of rack and slot.

When a connection is established, the connection-specific resources of a module are assigned 
specifically to this connection. This assignment requires that the connection resource can be 
addressed. The TSAP (Transport Service Access Point) is, as it were, the address of the 
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resource that is formed with the help of the connection resource or, in the case of  S7-1200 
CPUs (firmware V2.0 or higher) with the SIMATIC-ACC (SIMATIC Application Controlled 
Communication). 

Configuration of TSAP for S7-1200  
● For S7-1200 CPU (firmare V2.0 or higher):

"SIMATIC-ACC"<nnn><mm>
nnn = Local ID
mm = any value

● For S7-1200 CPU (firmare V1.0):
<xx>.<yz>
xx = Number of the connection resource
y = Rack number
z = Slot number

TSAP structure, dependent on partner
The configuration of the TSAP for S7-1200 CPUs is dependent on the respective firmware and 
on the remote connection partner. When a S7-1200 CPU is connected with a S7-300/400 CPU, 
a S7-1200 CPU also uses a TSAP configuration that includes the connection resource.

See the following examples for TSAPs of various connection configurations

● Connection between two S7-1200 CPUs (both with firmware V2.0):

– S7-1200 CPU "A" with firmware V2.0 and local ID 100:
TSAP: SIMATIC-ACC10001

– S7-1200 CPU "B" with firmware V2.0 and local ID 5AE:
TSAP: SIMATIC-ACC5AE01

● Connection between two S7-1200 CPUs (firmware V2.0 and V1.0):

– S7-1200 CPU with firmware V2.0 and local ID 1FF:
TSAP: SIMATIC-ACC1FF01

– S7-1200 CPU with firmware V1.0 (rack 0, slot 1, connection resource 03):
TSAP: 03.01

● Connection between S7-1200 CPUs (firmware V2.0) and S7-300/400 CPU:

– S7-1200 CPU with firmware V2.0 (rack 0, slot 1, connection resource 12):
TSAP: 12.01

– S7-300/400 CPU (rack 0, slot 2, connection resource 11):
TSAP: 11.02
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HMI connection

Introduction to configuring connections

Definition    
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (e.g., HMI connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an HMI connection 
as a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A line in this connection table represents a 
configured connection, e.g., between an HMI device and PLC, along with its properties.

What you need to know about using connection resources

Introduction
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.

HMI connections
For HMI connections via the integrated PN interface, one connection resource for the endpoint 
per HMI connection is occupied for the HMI device. 

One connection resource is also required for the connection partner (PLC). 
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window
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Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– You will graphically see the connection path in the network view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
You have created the devices with CPUs and HMI devices between which you want to 
configure connections in the network view.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically into the connection table of the HMI device. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
When using the graphic connection configuration, if necessary the system asks you to define 
the connection path. Select the devices to be connected in the current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

The connection mode for the connection type you have selected is then activated.
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.
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Procedure
Proceed as follows to interactively create a connection:

1. Select the "Create new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog is opened. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To close the dialog, click "OK". 
To accept the configured connection and to configure additional connections to other 
endpoints, click "Apply".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the "Highlight connection partners" command in the shortcut menu for the HMI device 
whose connection partners you want to display in the network view.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.

 

 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.
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See also
Creating a new connection graphically (Page 345)

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit the parameters displayed in the connection table in some cases. To 
change the name of a connection, you do not have to navigate to the Inspector window. 
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Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections via the network view or the connection table.

In the network view you can delete a highlighted connection. In the connection table you can 
delete one or more connections.

Procedure
To delete a connection, proceed as follows:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

The selected connection will be completely deleted.

Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.

You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.

Copying devices
If you copy devices for which connections have been configured (HMI devices), the 
connections are copied as well. To complete the connection path, you must still finalize the 
networking. 
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An S7-1200 CPU with a V.10 firmware is only a server for connections and has no connection 
configuration itself. Consequently, no connections are copied along with it when an S7-1200 
CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Errors when backing up data due to insufficient memory

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
If the connection cannot be repaired by opening the connection properties, changing them or 
undoing them in the configuration, then it may be necessary to delete the connection and re-
create it. 

HMI connection general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can also assign the connection path and specify all aspects of the connection 
partner. 
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Special connection properties
Display of the connection properties (cannot be changed): 

● Active connection establishment
The connection establishment always starts from the HMI device. This option is selected 
by default if the address of the partner is specified.

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Sending operating mode messages
Not relevant for HMI devices. 

Address details
Displaying address details of the HMI connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed. 

Miscellaneous
Display of the access points for the online connection between HMI device and connection 
partner. 

Using Open User Communication

Basics of Open User Communication

Introduction  
Open User Communication is the name of a program-controlled communications technique 
for communication via the integrated PN/IE interface of the CPU. Various connection types 
are available for this communications technique.

The main feature of Open User Communication is its high degree of flexibility in terms of the 
data structures transferred. This allows open data exchange with any communicating devices 
providing they support the connection types available here. Since this communication is 
controlled solely by instructions in the user program, event-driven connection establishment 
and termination is possible. Connections can also be modified by the user program during 
runtime.

For S7-1200 CPUs with an integrated PN/IE interface, the TCP, UDP and ISO-on-TCP 
connection types are available for Open User Communication. The communications partners 
can be two SIMATIC PLCs or a SIMATIC PLC and a suitable third-party device.
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Instructions for Open User Communication  
To create the connections, you have various instructions available after opening the program 
editor in the "Instructions > Extended instructions > Communication" task card:

● Compact instructions for sending or receiving data via integrated functions for establishing 
and terminating the connection:

– TSEND_C (connection establishment/termination, sending)

– TRCV_C (connection establishment/termination, receiving)

● Individual instructions for sending and receiving data or for establishing or terminating 
connections:

– TCON (connection establishment)

– TDISCON (connection termination)

– TSEND (TCP or ISO-on-TCP: Sending)

– TRCV (TCP or ISO-on-TCP: Receiving)

– TUSEND (UDP: Sending)

– TURCV (UDP: Receiving)

Connection establishment  
For Open User Communication, instructions for establishing and terminating the connection 
must exist for both communications partners. One communications partner sends its data 
using TSEND, TUSEND or TSEND_C while the other communications partner receives the 
data using TRCV, TURCV or TRCV_C. 

One of the communications partners starts the connection establishment as the active partner. 
The other communications partner reacts by starting its connection establishment as the 
passive partner. If both communication partners have initiated their connection establishment, 
the communication connection is fully established.

Connection parameter assignment   
You can assign parameters to establish the connection using a connection description DB with 
the TCON_Param structure as follows:

● Manually create, assign parameters and write directly to the instruction.

● Supported by connection parameter assignment.

Connection parameter assignment supports the establishment of the connection and should, 
therefore, be given preference over the other methods.

You specify the following in the connection parameter assignment:

● Connection partner

● Connection type

● Connection ID

● Connection description DB

● Address details according to selected connection type
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In addition, you specify here which communication partner activates the connection 
establishment and which partner establishes a connection passively in response to a request 
from its communications partner.

See also
Principle of operation of connection-oriented protocols (Page 362)

Overview of connection parameter assignment

Introduction
You will find the connection configuration in the Inspector window of the program editor if you 
want to program Open User Communication with the communication instructions TSEND_C, 
TRCV_C or TCON.

Connection parameter assignment supports the flexible functionality of communications 
programming: The parameters entered for the connection configuration are stored in an 
automatically created global DB derived from the structure of the TCON_Param type. You can 
modify the connection parameters in this connection description DB.
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Structure of the connection parameter assignment   
The connection parameter assignment is made up of the following components:
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① Communication instruction for TCON, TSEND_C or TRCV_C
② "Configuration" tab in the "Properties" tab
③ Area navigation of the "Configuration" tab
④ General properties of the connection parameters
⑤ Address details of the connection parameters (for selected connection DBs)

"Configuration" tab
Enter the desired connection parameters in the "Configuration" tab. The area navigation of the 
"Configuration" tab includes the "Connection parameters" group. This group contains the 
connection parameter assignment. Here, you can enter the parameters for the connections 
and the address details with system support. Here, you also connect the CONNECT (TCON, 
TSEND_C, TRCV_C) or ID (TCON, TSEND, TRCV, TUSEND, TURCV) block parameters of 
the selected communication instructions.

When all the required parameters are assigned, a check mark is set in front of the "Connection 
parameters" group in the area navigation.

 

 NOTICE

The connection configuration does not check whether the connection IDs and port numbers 
(TCP, UDP) or TSAPs (ISO-on-TCP) are unique. When you configure Open User 
Communication, you should, therefore, make sure that the parameter settings are unique 
within a device.

 

See also
Parameters of communication connections (Page 364)

Description of the connection parameters

Overview     
The following table shows the general connection parameters:

Parameter Description
End point The names of the local end point and the partner end point are shown.

The local end point is the CPU for which TCON, TSEND_C or TRCV_C is programmed. The 
local end point is, therefore, always known.
The partner end point is selected from the drop-down list. The drop-down list shows all 
available possible connection partners including unspecified connection partners for devices 
whose data is unknown in the project.
As long as no connection partner is set, all other parameters in the mask are disabled.

Interface The interface of the local end point is displayed. The partner interface is displayed only after 
a specified partner end point.
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Parameter Description
Subnet The subnet of the local end point is displayed, provided this exists. The partner subnet is 

displayed only after the partner end point has been selected.
If at least one of the two connection partners is not connected with a subnet, the two 
connection partners are connected with each other.
A connection between partners in different subnets is only possible with IP routing. The 
routing settings can be edited in the relevant interface properties.

Address The IP address of the local end point is displayed. The IP address of the partner is displayed 
only after the partner end point has been selected.
If you have selected an unspecified connection partner, the input box is empty and has a red 
background. In this case, you will need to specify a valid IP address.

Connection type Select the connection type you want to use from the "Connection type" drop-down list:
● TCP
● ISO-on-TCP
● UDP
The parameters for the required connection data change depending on the selected 
connection type.

Connection ID Enter the connection ID in the input box. You can change the connection ID in the input boxes 
or enter it directly in TCON.
Ensure that the connection ID assigned is unique within the device.

Connection data The names of the connection description DBs for the connection description structured 
according to TCON_Param are displayed in the drop-down lists.
When you create the connection, one data block each is generated for the specified 
connection partner and automatically filled with the values from the connection parameter 
assignment. For the local connection partner, the name of the selected data block is entered 
automatically in the block parameter CONNECT of the selected TSEND_C, TRCV_C or 
TCON instruction.
For the second connection partner, the connection description DB generated by the first 
connection partner can also be used directly at the CONNECT input of the TSEND_C, 
TRCV_C or TCON instructions. With this procedure, you can use the existing connection 
description DB after selecting the first connection partner or create a new connection 
description DB.
From the drop-down list, you can also reference another valid data block. If a DB is referenced 
using the CONNECT input parameter of the TSEND_C, TRCV_C or TCON extended 
instruction and this does not correspond to the structure of a TCON_Param, the drop-down 
list is shown with no content on a red background.

Active connection 
establishment

Use the "Active connection establishment" check box to specify the active partner of the Open 
User Communication (only with TCP and ISO-on-TCP).

Port
(only with TCP and UDP)

Address component for a TCP or UDP connection. The default after creating a new TCP 
connection is 2000.
You can change the port numbers. 
The port numbers must be unique on the device!

TSAP
(ISO-on-TCP only)

Address component for an ISO-on-TCP connection. The default after creating a new ISO-on-
TCP connection is E0.01.49.53.4F.6F.6E.54.43.50.2D.31. 
You can enter the TSAP-ID with an extension or as an ASCII TSAP. 
The TSAPs must be unique on the device!
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See also
Parameters of communication connections (Page 364)

Assignment of port numbers (Page 366)

TSAP structure (Page 368)

Examples of TSAP assignment (Page 370)

Ability to read back connection description parameters (Page 367)

Creating and assigning parameters to connections (Page 359)

Starting connection parameter assignment
The connection parameter assignment for Open User Communication is enabled as soon as 
a TCON, TSEND_C or TRCV_C instruction for communication is selected in a program block.

Requirements
● Your project must contain at least one S7-CPU.

● The program editor is open.

● A network is available.

Procedure   
To insert the extended instructions for Open User Communication, proceed as follows:

1. Open the task card, pane and folder "Instructions > Communication > Open User 
Communication".

2. Drag one of the following instructions to a network:

– TSEND_C

– TRCV_C

– TCON

The "Call options" dialog opens.

3. Edit the properties of the instance DB in the "Call properties" dialog. You have the following 
options:

– Change the default name.

– Select the "Manual" check box to assign your own number.

4. Click "OK" to complete your entry.

Result
A corresponding instance DB is created for the inserted instruction TSEND_C, TRCV_C or 
TCON.
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With TSEND_C, TRCV_C or TCON selected, you will see the "Configuration" tab under 
"Properties" in the Inspector window. The "Connection parameters" group in area navigation 
contains the connection parameter assignment that you can now make.

See also
Creating and assigning parameters to connections (Page 359)

Creating and assigning parameters to connections
In the connection configuration for Open User Communication, you can create and configure 
connections of the TCP, UDP or ISO-on-TCP type.

Requirement
A CPU exists with a TCON, TSEND_C or TRCV_C communication instruction.

Procedure     
To create a connection for Open User Communication, proceed as follows:

1. Select a TCON, TSEND_C or TRCV_C block of Open User Communication in the program 
editor.

2. Open the "Properties > Configuration" tab in the inspector window.

3. Select the "Connection parameters" group. Until you select a connection partner, only the 
empty drop-down list for the partner end point is enabled. All other input options are 
disabled.
The connection parameters already known are displayed:

– Name of the local end point

– Interface of the local end point

– IP address of the local end point

4. In the drop-down list box of the partner end point, select a connection partner. You can 
select an unspecified device or a CPU in the project as the communications partner. Certain 
connection parameters are then entered automatically.
The following parameters are set:

– Interface of the partner end point

– Interface of the partner end point

– IP address of the partner end point

If the connection partners are networked, the name of the subnet is displayed.
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5. In the "Connection data" drop-down list, select the existing connection description DBs or 
create new connection description DBs. You can subsequently select different connection 
description DBs in the relevant "Connection data" drop-down lists or change the name of 
the connection description DBs to create new data blocks:

– You can also see the selected data block at the interconnection of the CONNECT input 
parameter of the selected TCON, TSEND_C or TRCV_C instruction.

– If you have already specified a connection description DB for the connection partner 
using the CONNECT parameter of the TCON, TSEND_C or TRCV_C instruction, you 
can either use this DB or create a new DB.

– If you edit the name of the displayed data block in the drop-down list, a new data block 
with the changed name but with the same structure and content is generated and used 
for the connection.

– Changed names of a data block must be unique in the context of the communications 
partner.

– A connection description DB must have the TCON_Param structure.

– A data block cannot be selected for an unspecified partner.

Additional values are determined and entered after the selection or creation of connection 
description DBs. The following is valid for specified connection partners:

– ISO-on-TCP connection type

– Connection ID with default of 1

– Active connection establishment by local partner

– TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31

The following is valid for unspecified connection partners:

– TCP connection type

– Partner port 2000

6. Enter a connection ID for the connection partner. No connection ID can be assigned to an 
unspecified partner.

 

  Note

You must enter a unique value for the connection ID at a known connection partner. The 
uniqueness of the connection ID will not be checked by the connection parameter settings 
and there will be no default value entered for the connection ID when you create a new 
connection.

 

7. Select the connection type you want from the relevant drop-down list. Default values are 
set for the address details depending on the connection type. You can choose between the 
following:

– TCP (partner port 2000)

– ISO-on-TCP (TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31)

– UDP (local port 2000)
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8. You can edit the input boxes in the address details. Depending on the selected protocol, 
you can edit the ports (for TCP) or the TSAPs (for ISO-on-TCP).

9. Use the "Active connection establishment" check box to set the connection establishment 
behavior for TCP and ISO-on-TCP. You can decide which communications partner 
establishes the connection actively.

Changed values are checked immediately for input errors by the connection parameter 
assignment and entered in the data block for the connection description.

 

 Note

Open User Communication between two communications partners can only work when the 
program section for the partner end point has been downloaded to the hardware. To achieve 
fully functional communication, make sure that you load not only the connection description 
of the local CPU on the device but also that of the partner CPU as well.

 

See also
Description of the connection parameters (Page 356)

Starting connection parameter assignment (Page 358)

TSAP structure (Page 368)

Assignment of port numbers (Page 366)

Parameters of communication connections (Page 364)

Deleting connections

Introduction
The data of a created connection for Open User Communication is stored in a connection 
description DB. You can delete the connection by deleting the data block containing the 
connection description.

Requirement
You have created an Open User Communication connection.

Procedure 
To delete a connection, proceed as follows:

1. Select a communications partner for Open User Communication in the project tree.

2. Open the "Program blocks" folder below the selected communications partner.

3. Select the "Delete" command from the shortcut menu of the data block with the connection 
parameter assignment.
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 Note

If you are not certain which block to delete, open the extended instruction TCON, TSEND_C 
or TRCV_C. You will find the name of the data block as the CONNECT input parameter or 
in the connection parameter assignment as the "Connection data" parameter.

If you only delete the instance DBs of the extended instructions TCON, TSEND_C or 
TRCV_C, the assigned connections are not deleted as well.

 

 Note

If the connection DB is used by other blocks of the extended instructions, then the 
corresponding calls, their instance DBs and the combination blocks TSEND_C and TRCV_C 
are also deleted from the block folder, provided they are not used elsewhere.

This action prevents the program from being inconsistent.
 

Result
You have deleted the connection.

 

 Note

Insert an extended instruction TCON, TSEND_C or TRCV_C again to reference an existing 
connection description with the TCON_Param structure via the "Connection data" parameter. 

 

How protocols work

Principle of operation of connection-oriented protocols

Introduction  
Connection-oriented protocols establish a logical connection to the communication partner 
before data transmission is started. After the data transmission is complete, they then terminate 
the connection, if necessary. In particular, connection-oriented protocols are used for data 
transmission when reliable, guaranteed delivery is of importance. Several logical connections 
can exist over one physical line. 

Open User Communication supports the following connection types: 

● TCP

● ISO-on-TCP

● UDP

For communication partners that do not support an ISO-on-TCP connection, a TCP connection 
should be used. For these types of communication partners, such as third-party devices or 
PCs, enter "unspecified" for the partner end point during connection parameter assignment.
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Characteristics of TCP  
During data transmission via a TCP connection, no information about the length or about the 
start and end of a message is transmitted. This does not pose a problem during sending 
because the sender knows the amount of data to be transmitted. However, the receiver has 
no means of recognizing where one message in the data stream ends and the next one begins. 
It is therefore recommended that the number bytes to be received (parameter LEN, instruction 
TRCV/TRCV_C) be assigned the same value as the number of bytes to be sent (parameter 
LEN, instruction TSEND/TSEND_C).

If the length of the sent data and the length of the expected data do not match, the following 
will occur:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the received data to the specified receive area (parameter DATA) 
only after the assigned length is reached. When the assigned length is reached, data of 
the subsequent job are already being received. As a result, the receive area contains data 
from two different send jobs. If you do not know the exact length of the first message, you 
are unable to recognize the end of the first message and the start of the second message.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the number of bytes you specified in the LEN parameter to the 
receive data area (parameter DATA). Then, it sets the NDR status parameter to TRUE (job 
completed successfully) and assigns RCVD_LEN (amount of data actually received) the 
value of LEN. With each subsequent call, you receive a further block of the sent data.

Characteristics of ISO-on-TCP  
During data transmission via an ISO-on-TCP connection, information regarding the length and 
the end of a message is also supplied.

If the length of the sent data and the length of the expected data do not match, the following 
will occur:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies all the sent data to the receive data area (parameter DATA). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C does not copy any data to the receive data area (parameter DATA), but 
instead supplies the following error information: ERROR=1, STATUS=W#16#8088 
(destination buffer too small).

Characteristics of UDP  
Information on the length and the end of a message is also supplied during data transmission 
via a UDP connection.

If the length of the sent data and the length of the expected data do not match, the following 
will occur:
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● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TURCV/TRCV_C copies all the sent data to the receive data area (DATA parameter). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TRCV/TRCV_C copies as much data to the receive data area (parameter DATA) as the 
LEN parameter requests. No further error message is generated. In this case, the user has 
to call a T_URCV again in order to receive the remaining bytes.

See also
Basics of Open User Communication (Page 351)

Parameters of communication connections

Data block for connection description     
A connection description DB with a structure according to TCON_Param is used to configure 
the communication connections for TCP, UDP and ISO-on-TCP. The fixed data structure of 
the TCON_Param contains all the parameters that are needed to establish the connection. 
The connection description DB is automatically created for a new connection by the connection 
parameter assignment for Open User Communication when the TSEND_C, TRCV_C or TCON 
instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the utilized data block.

Structure of the connection description according to TCON_Param       

Byte Parameter Data type Initial value Description
0 … 1 block_length UINT 64 Length: 64 bytes (fixed) 
2 … 3 id CONN_OUC 1 Reference to this connection (range of values: 1 to 4095).

You specify the value of this parameter for the TSEND_C, 
TRCV_C or TCON instruction under ID. 

4 connection_type USINT 17 Connection type: 
● 17: TCP
● 18: ISO-on-TCP
● 19: UDP

5 active_est BOOL TRUE Identifier for the type of connection establishment: FALSE 
always applies to UDP, since data can be sent and received 
via local ID.
The following is valid for TCP and ISO-on-TCP:
● FALSE: Passive connection establishment
● TRUE: Active connection establishment

6 local_device_id USINT 1 ID for the local PN/IE interface.
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Byte Parameter Data type Initial value Description
7 local_tsap_id_len USINT 0 Length of parameter local_tsap_id used, in bytes; possible 

values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the active side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 2, if connection type = 19 (UDP)

8 rem_subnet_id_len USINT 0 This parameter is not used.
9 rem_staddr_len USINT 4 Length of address of partner end point, in bytes: 

● 0: unspecified, i.e., parameter rem_staddr is irrelevant.
● 4: valid IP address in the parameter Parameter 

rem_staddr 
(TCP and ISO-on-TCP only)

10 rem_tsap_id_len USINT 2 Length of parameter rem_tsap_id used, in bytes; possible 
values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the passive side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 0, if connection type = 19 (UDP)

11 next_staddr_len USINT 0 This parameter is not used.
12 … 
27

local_tsap_id ARRAY 
[1..16] of 
BYTE 

- Local address component of connection: 
● TCP and UDP: local port no. (possible values: 1 to 49151; 

recommended values: 2000...5000);
local_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
local_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
local_tsap_id[3-16] = irrelevant 

● ISO-on-TCP: local TSAP-ID:
local_tsap_id[1] = B#16#E0;
local_tsap_id[2] = rack and slot of local end points (bits 0 
to 4: Slot number, bits 5 to 7: rack number);

local_tsap_id[3-16] = TSAP extension, optional 
Note: Make sure that every value of local_tsap_id is unique 
within the CPU. 

28 … 
33

rem_subnet_id  ARRAY 
[1..6] of 
USINT

- This parameter is not used. 

34 … 
39

rem_staddr ARRAY 
[1..6] of 
USINT 

- TCP and ISO-on-TCP only: IP address of the partner end 
point, for example for 192.168.002.003: 
● rem_staddr[1] = 192 
● rem_staddr[2] = 168 
● rem_staddr[3] = 002 
● rem_staddr[4] = 003 
● rem_staddr[5-6]= irrelevant 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  365



Byte Parameter Data type Initial value Description
40 … 
55

rem_tsap_id ARRAY 
[1..16] of 
BYTE 

- Partner address component of connection
● TCP: partner port no. (possible values: 1 to 49151; 

recommended values: 2000...5000);
rem_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
rem_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
rem_tsap_id[3-16] = irrelevant

● ISO-on-TCP: partner TSAP-ID: 
rem_tsap_id[1] = B#16#E0; 
rem_tsap_id[2] = rack and slot of partner end point (bits 0 
to 4: Slot number, bits 5 to 7: rack number);
rem_tsap_id[3-16] = TSAP extension, optional

● UDP: This parameter is not used.
56 … 
61

next_staddr ARRAY 
[1..6] of 
BYTE 

- This parameter is not used.

62 … 
63

spare WORD W#16#0000 Reserved. 

See also
Principle of operation of connection-oriented protocols (Page 362)

Description of the connection parameters (Page 356)

Ability to read back connection description parameters (Page 367)

Overview of connection parameter assignment (Page 353)

TSAP structure (Page 368)

Assignment of port numbers (Page 366)

Assignment of port numbers

Introduction
When an Open User Communication is created, the value 2000 is automatically assigned as 
the port number.

Permissible values for port numbers are 1 to 49151. You can assign any port number within 
this range. However, because some ports may already be used depending on the system, port 
numbers within the range from 2000 to 5000 are recommended.
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Overview of port numbers 
The following table summarizes the system reactions to various port numbers.

Port no. Description System reaction
2000 … 5000 Recommended range No warning, no error message on entry

Port number is permitted and accepted
1 … 1999, 5001 … 49151 Can be used, but is outside the 

recommended range
Warning message on entry
Port number is permitted and accepted

20, 21, 25, 80, 102, 135, 161, 34962 … 
34964

Can be used conditionally*

53, 80, 102, 135, 161, 162, 443, 520, 
9001, 34962 … 34964

Can be used conditionally**

* These ports are used by TSEND_C and TRCV_C with the TCP and UDP connection types.

** These ports are blocked depending on the function scope of the utilized S7-1200 CPU. The 
documentation of the respective CPUs provides the assignment of these ports.

See also
Description of the connection parameters (Page 356)

Creating and assigning parameters to connections (Page 359)

Ability to read back connection description parameters

Changing parameter values in the connection description 
The connection description for exactly one connection of the Open User Communication is 
entered from the connection parameter assignment in the connection description DB.

You can change the parameter values of the connection description DB outside of the 
connection parameter assignment in the user program. The structure of the connection 
description cannot be changed. 

Connection description DBs containing values you changed subsequently can be read back 
from the connection parameter assignment. Under "Properties > Configuration > Connection 
parameters", the Inspector window displays only the connection parameters stored in the 
connection description DB.

The connection parameter assignment does not support nested entries of connection 
descriptions in DB types that can only be found via offset referencing (for example, Global-DB).

Ability to read back individual connection parameters 
For the "Address" parameter of the communication partner in a TCP or ISO-on-TCP 
connection, its IP address is displayed from the "rem_staddr" parameter of the connection 
description.

The following values can also be reloaded from the connection description:
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● Connection type

● Local connection ID:

● Active/passive connection establishment (only with UDP)

● Local TSAP (ISO-on-TCP only)

● Partner TSAP (ISO-on-TCP only)

● Local port (only with TCP and UDP)

● Partner port (TCP only)

The values of the connection ID parameters of the communication partner, the connection 
data, as well as the connection establishment, are not included in the connection description 
in the local connection description DB. Consequently, these parameters cannot be displayed 
when the connection parameter assignment is reopened. The connection establishment of the 
partner results from the local connection establishment and is therefore also displayed.

A new communication partner can be selected at any time in the "Partners" drop-down list box.

When a CPU recognized in the project is selected as a specified communication partner, the 
entry options for the connection ID and the connection data are shown again.

See also
Parameters of communication connections (Page 364)

Description of the connection parameters (Page 356)

TSAP structure

Introduction 
For an ISO-on-TCP connection, Transport Service Access Points (TSAPs) must be assigned 
for both communication partners. TSAP IDs are assigned automatically after an ISO-on-TCP 
connection is created. To ensure the uniqueness of TSAP IDs within a device, you can change 
the preassigned TSAPs in the connection parameter assignment.

Structure of TSAPs 
You must comply with certain rules when assigning TSAPs. A TSAP must contain a certain 
number of bytes, which are able to be displayed and entered as hexadecimal values (TSAP-
ID) or as ASCII characters (ASCII-TSAP):

Entries or changes of the TSAP-ID or the ASCII-TSAP in the corresponding entry fields always 
take effect in the other display format as well.
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If a TSAP contains no valid ASCII characters, the TSAP is displayed only as TSAP-ID and not 
as ASCII-TSAP. This is the case after a connection is created. The first two hex characters as 
TSAP-ID identify the communication type and the rack/slot. Because these characters are not 
valid ASCII characters for a CPU, the ASCII-TSAP is not displayed in this case.

In addition to the rules for length and structure of TSAPs, you must also ensure the uniqueness 
of the TSAP-ID. The assigned TSAPs are not automatically unique.

Length and content of TSAPs
A TSAP is structured as follows:

● TSAP-ID with TSAP extension
Length = 2 to 16 bytes
x_tsap_id[0] = 0xE0 (Open User Communication)
x_tsap_id[1] (bits 0 to 4) = slot number of CPU
x_tsap_id[1] (bits 5 to 7) = rack number of CPU
x_tsap_id[2...15] = any characters (TSAP extension, optional)
(x = loc (local) or x = rem (partner))

● TSAP-ID as ASCII-TSAP
Length = 3 to 16 bytes
x_tsap_id[0 to 2] = 3 ASCII characters (0x20 to 0x7E)
x_tsap_id[3...15] = any characters (optional)
(x = loc (local) or x = rem (partner))

The following table shows the schematic structure of a TSAP-ID:

TSAP-ID tsap_id_len tsap_id[0] tsap_id[1] tsap_id[2..15] tsap_id[3..15]
...with extension 2...16 bytes 0xE0 0x01 (0x00)* Extension

(optional)
Extension
(optional)

...as ASCII-TSAP 3...16 bytes 0x20...0x7E 0x20...0x7E 0x20...0x7 Any
(optional)

*A recognized CPU is normally inserted on rack 0 in slot 1. For this reason, hex value 01 is 
valid for the second place of the TSAP-ID with extension. If the connection partner is an 
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unspecified CPU, for example, a third-party device, the hex value 00 is also permissible for 
the slot address.

 

 Note

For unspecified communication partners, the local TSAP-ID and the partner TSAP-ID can 
have a length of 0 to 16 bytes, in which all hex values from 00 to FF are permitted.

 

ASCII code table for entry of ASCII TSAPs 
For entry of an ASCII-TSAP in the connection parameter assignment, only hexadecimal values 
from 20 to 7E are permitted:

Code ..0 ..1 ..2 ..3 ..4 ..5 ..6 ..7 ..8 ..9 ..A ..B ..C ..D ..E ..F
2..  ! " # $ % & ’ ( ) * + , - . /
3.. 0 1 2 3 4 5 6 7 8 9 : ; < = > ?
4.. @ A B C D E F G H I J K L M N O
5.. P Q R S T U V W X Y Z [ \ ] ^ _
6.. ` a b c d e f g h i j k l m n o
7.. p q r s t u v w x y z { | } ~  

See also
Examples of TSAP assignment (Page 370)

Description of the connection parameters (Page 356)

Creating and assigning parameters to connections (Page 359)

Examples of TSAP assignment
The following examples illustrate various aspects of editing TSAPs:

● Example 1: Creating a new connection for PLC-PLC communication

● Example 2: Entry of a local ASCII-TSAP

● Example 3: Entry of a TSAP extension in the TSAP-ID

● Example 4: Incorrect editing of the TSAP-ID

● Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field

Example 1: Creating a new connection for PLC-PLC communication
Once you have created a new connection with two PLCs for the Open User Communication, 
the TSAP extension "ISOonTCP-1" is assigned automatically.

This TSAP extension produces the TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31, which is 
entered automatically in the connection description DB and in the entry fields of the local and 
the partner TSAP. The entry fields of the ASCII-TSAPs remain empty:
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 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

You can change the values in the entry fields of the TSAP-ID and the ASCII-TSAP at any time. 

The entry field of the TSAP-ID shows the complete TSAP stored in the data block of the 
connection description. The TSAP-ID with TSAP extension, which is limited to 16 characters, 
is not displayed in the "TSAP (ASCII)" entry field because the character E0 does not represent 
a valid character for the ASCII-TSAP.

If the displayed TSAP-ID is a valid ASCII-TSAP, it is displayed in the "TSAP (ASCII)" entry 
field.

Changes in the entry fields for TSAP-ID and ASCII-TSAP affect the other field.

Example 2: Entry of a local ASCII-TSAP
If you have created a new connection and assigned an ASCII value for the local TSAP in the 
"TSAP (ASCII)" entry field, for example, "ISOonTCP-1", the resulting TSAP-ID is created 
automatically.

When you exit the "TSAP (ASCII)" entry field, the number of ASCII characters is checked 
automatically for compliance with the limit (3 to 16 characters) and the resulting TSAP-ID is 
entered into the corresponding entry field:

 Local TSAP Partner TSAP
TSAP (ASCII) ISOonTCP-1  
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Example 3: Entry of a TSAP extension in the TSAP-ID
If, following creation of a connection and entry of an ASCII-TSAP (see examples 1 and 2) in 
the entry field of the local TSAP-ID, you add the prefix "E0.01" to the TSAP value, the ASCII-
TSAP will no longer be displayed when the entry field is exited.

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Once you have exited the entry field of the TSAP-ID, a check is performed automatically to 
determine whether the first character of the TSAP-ID is a valid ASCII character. Since the 
character "E0" now present in the TSAP-ID is not a valid character for the ASCII-TSAP, the 
"TSAP (ASCII)" entry field no longer displays an ASCII-TSAP.

If a valid ASCII character is used, the check for compliance with the length specification of 2 
to 16 characters follows.
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Example 4: Incorrect editing of the TSAP-ID
If you remove the hex value "E0" from a TSAP-ID beginning with "E0.01", the TSAP-ID now 
begins with "01" and therefore no longer complies with the rules and is invalid:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

After the entry field is exited, a message is output because the TSAP-ID is neither a valid ASCII-
TSAP (this would have to have a hex value in the range from 20 to 7E as the first value) or a 
valid TSAP-ID (this would have to have the identifier "E0" as the first value).

Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field
If you remove the value "01" in addition to the value "E0" from the incorrect TSAP-ID in example 
4, the TSAP-ID begins with the hex value 49. This value is within the permissible range for 
ASCII-TSAPs:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

When you exit the entry field, the TSAP-ID is recognized as a valid ASCII-TSAP and the 
resulting ASCII-TSAP "ISOonTCP-1" is written to the "TSAP (ASCII)" entry field.

See also
TSAP structure (Page 368)

Description of the connection parameters (Page 356)
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8.1.3.3 Displaying and configuring topology

Overview of the topology view

Functions of the topology view  
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

– Displaying all the PROFINET devices and passive Ethernet components of the project 
along with their ports

– Displaying interconnections between the ports

– Displaying corresponding logical networks

– Display diagnostic information of all ports

● Configuring the Ethernet topology

– Creating, modifying and deleting interconnections of the ports

– Renaming stations, devices, interfaces or ports

– Adding PROFINET devices and passive Ethernet components to the project from the 
hardware catalog

● Identifying and minimizing differences between the desired and actual topology

– Running an offline/online comparison of Ethernet modules, ports and port 
interconnections

– Adopting existing online topology information in the offline project

Differences between network view and topology view  
● The network view shows all the logical subnets of the project.

The topology view shows all Ethernet components of the project. These include passive 
components such as switches, media converters and cables.

 

  Note

Stations with non-Ethernet components are also displayed if the station has a least one 
Ethernet component.

 

● The position of a device in the network view and its position in the topology view are not 
dependent on each other; in other words, the same device generally appears at different 
locations in the two views.

● If you open the hardware catalog in the topology view, you only see devices with an Ethernet 
interface.
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Structure of the topology view
The topology view (Page 280) essentially consists of a graphic area (called the graphic view 
below) and a table area (called the table view below).

Which functions are there in the graphic view and which functions are there in the table view?
● Displaying the Ethernet topology

Function Graphic view Table view
Displaying all the PROFINET devices and passive Ethernet 
components of the project along with their ports

yes yes

Display interconnections between the ports (including type of 
medium)

yes yes

Displaying corresponding logical networks no yes
Displaying properties of the cables between the ports no yes
Display diagnostic information of all ports yes yes

● Configuring the Ethernet topology

Function Graphic view Table view
Creating, modifying and deleting interconnections of the ports ● Create: yes

● Modify: no
● Delete: yes

● Create: yes
● Modify: yes
● Delete: yes

Renaming stations, devices, interfaces or ports no yes
Adding PROFINET devices and passive Ethernet components to 
the project from the hardware catalog

yes no

● Identifying and minimizing differences between the desired and actual topology

Function Graphic view Table view
Running an offline/online comparison of Ethernet modules, ports 
and port interconnections

no yes

Adopting existing online topology information in the offline project no yes

Starting the topology view

Requirement
The device or network view is open in the hardware and network editor.

Procedure
To start the topology view of your project, follow these steps:  

1. Click on the "Topology view" tab.

Or:
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1. Open the network view of the hardware editor.

2. Select a PROFINET device or a PROFINET module.

3. Select the "Go to topology view" command in the shortcut menu.

Result
The graphic view of the topology view is started. If you opened the topology view using the 
shortcut menu, the selected component remains selected after the change of view.

Displaying topology

Displaying the graphic view of the configured topology

What is shown?  
The graphic view of the configured topology shows the following:

● Configured PROFINET devices and passive Ethernet components along with their ports

● Configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports

Type of display
The way in which the graphic view of the topology view and the network view are displayed is 
very similar:

● Compared with the device view, components are shown in a simplified form.

● The interconnections between ports are shown as horizontal and vertical lines. These are 
dashed when an interconnection between a tool changer port and its possible partner ports 
is involved.
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Displaying the table view of the configured topology

What is shown?   
The table view of the configured topology shows exactly the same content as the graphic view 
except for the logical PROFINET subnets.

● All the configured PROFINET devices and passive Ethernet components along with their 
ports

● All the configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports
For each port with the "Alternative partner port" property, there are as many completed 
rows as there are potential partner ports plus one empty row.

Type of display
As the name implies, the table view of the topology view consists of a table, the topology 
overview table. It is structured like the network overview table. It consists of the following 
columns:

● Device / port
This is the most important column of the table. The entries in this column have a hierarchical 
structure with the PROFINET ports being the last element in the hierarchy. You can expand 
and collapse the hierarchical entries. For a CPU, for example, an entry consists of the 
following elements:

– Station name

– Device name

– Name of the PROFINET interface

– Names of the ports

Note: All the other columns only have entries in the rows containing the port names.

● Type (as default, this column is not displayed)
Shows what type of station, device or interface the table row relates to or whether it belongs 
to a port.

● Order no. (as default, this column is not displayed)
Order no. of device

● Subnet (as default, this column is not displayed)
Configured subnet to which the interface belongs

● Master / IO system (as default, this column is not displayed)
Shows whether or not the interface belongs to a PROFIBUS DP master system or a 
PROFINET IO system.

● Device address (as default, this column is not displayed)
Configured address of the interface in the subnet

● Partner station
Name of the station that contains the partner port
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● Partner device
Name of the device that contains the partner port

● Partner interface
Interface to which the partner port belongs

● Partner port

● Cable data
Contains the cable length and the signal delay of the cable connecting the ports

Basic functions for tables
The topology overview table supports the following basic functions for editing a table:

● Displaying and hiding table columns
Note: The columns that define the configuration cannot be hidden.

● Optimizing column width

● Displaying the meaning of a column, a row or cell using tooltips.

 

Displaying the diagnostics status of ports and cables in the graphic view

Requirements
The graphic view of the topology view is open.

Procedure  
To determine the diagnostics status of the port, follow these steps: 

1. Go online with the required component or components.

Result
The following icons are displayed:

● The corresponding diagnostics icon is displayed for each device.

● If there is an error in at least one lower-level component, the diagnostics icon "Error in lower-
level component" is also displayed in the left-hand lower corner of the diagnostics icon.

● The corresponding diagnostics icon is displayed for each port.

● Every cable between two ports that are online has the color that matches its diagnostics 
status.

You will find the possible diagnostics icons for ports and the color coding of Ethernet cables 
in the description of hardware diagnostics. See: Determination of online status and display 
using symbols (Page 589)
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Showing the diagnostics status of hardware components in the table view

Requirement
The table view of the topology view is open.

Procedure 
To obtain the diagnostics status of hardware components of the topology overview table, follow 
these steps: 

1. Go online with the required components.

Result
The following icons are displayed at the left-hand edge of the topology overview table in each 
row that belongs to the component involved:

● The diagnostics icon belonging to the hardware component is displayed.

● If the hardware component has lower-level components and if there is an error in at least 
one of the lower-level components, the diagnostics icon "Error in lower-level component" 
is also displayed in the left-hand lower corner of the diagnostics icon of the hardware 
component.

For the possible diagnostics icons for hardware components, refer to the description of 
hardware diagnostics. See: Determination of online status and display using symbols 
(Page 589)

 

 Note

The display of the diagnostics status of hardware components in the topology overview table 
and the network overview table is identical.

 

Running an offline/online comparison and displaying the results

Requirements
The topology view is open. There may be an online connection to one or more devices, but 
this is not actually necessary.
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Procedure   
To find the differences between the configured and the actual topology, follow these steps: 

1. Click the "Compare offline/online" button in the toolbar of the topology overview.

Result
The "Partner station", "Partner interface" and "Cable data" columns in the topology overview 
table are removed.

Two additional groups of columns are added to the right-hand side of the table and these are 
initially empty:

● On the far right, columns for the topology to be identified online are added.

● Between the columns for the offline and the online topology, the "Status", "Action" and 
"Description" columns are added to show the result of the offline/online comparison.

 

  Note

As default, the "Description" column is not displayed.
 

The following buttons are enabled in the toolbar of the table:

Button Name Meaning
Update The detection of the existing online topology is started again.

Synchronize ● Adopt the port interconnections identified online in the 
project (Page 386)

● Adopt the devices identified online in the project 
(Page 387)

After the actual topology has been identified, the added columns are filled. This is discussed 
in more detail in the following section.

 

 Note

A difference between offline and online view is displayed for that port connected with the PG/
PC which is only available online. This is because the PG/PC cannot be configured offline.

 

Columns for the topology identified online
The following columns are displayed:

● "Device / port"

● "Type" (as default, this column is not displayed)

● "Order no." (as default, this column is not displayed)

● "IP address" (as default, this column is not displayed)

● "Partner device"
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● "Partner port"

● "Cable data"

Columns for the result of the offline/online comparison
The following columns are displayed:

● "Status"
The result of the offline/online comparison is shown here in the form of diagnostics icons. 
The following icons are possible:

Diagnostics icon Meaning
Differing topology information in at least one lower-level component 

Identical topology information

Topology information only available offline or device is disabled.

Topology information only exists online

Differing topology information

● "Action"
The possible actions are shown here in the form of icons. The following icons are possible:

Icon Meaning
No action possible

Adopt the interconnection found online

● "Description"
This column describes the selected action in words.

Configuring topology

Interconnecting ports

Overview

Interconnecting ports in the topology view
In the topology view, you have the following options for interconnecting ports:

● in the graphic view (Page 381)

● in the graphic view of a tool changer (Page 382)

● in the table view (Page 382)
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● in the table view of a tool changer (Page 383)

● by adopting port interconnections identified online (Page 386)

What effects does the interconnection of ports have on the network view?
 

 Note

In the properties of a subnet in the network view, you can specify that when a port 
interconnection is created between two devices that are not networked, this subnet is used.

 

When you create an interconnection between two ports, the following effects are possible in 
the network view:

● If the corresponding interfaces are not networked: If you have specified a default subnet, 
this is used. Otherwise a new subnet is created to connect the two interfaces.

● If one (and only one) of the two interfaces involved is networked: The non-networked 
interface is connected to the same subnet as the already networked interface.

● In all other cases: The corresponding interfaces are not connected to a logical subnet.

Interconnecting ports in the graphic view

Requirements
You are in the graphic view of the topology view.

Procedure – Creating a new interconnection between two ports 
To interconnect a port of a device with a port of another device, follow these steps:

1. Place the mouse cursor on the port you want to interconnect.

2. Click with the left mouse button and hold it down.

3. Move the mouse pointer.
The pointer now shows the networking symbol to indicate "Interconnect" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.

4. Now drag the mouse cursor to the target port. You can do this while holding down or after 
releasing the mouse button.

5. Now release the left mouse button or press it again (depending on your previous action).

Result: A new port interconnection is created.
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Interconnecting ports in the table view

Which actions are possible with port interconnections in the table view?
The following actions are possible with port interconnections in the table view:

● Create new port interconnection

● Modify existing port interconnection

● Delete existing port interconnection

Requirement
The row with the port whose interconnection you want to create, modify or delete is visible in 
the topology overview.

Procedure
To create the interconnection of a port for the first time, to modify it or delete it, follow these 
steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click on the drop-down list there.

3. Select the required partner port (when creating a new interconnection or changing the port 
interconnection) or the "Not interconnected" entry (when deleting a port interconnection).

Result
The required action is performed. The new partner port (after creating or modifying a port 
interconnection) is displayed in the "Partner port" column otherwise the "Select port" entry 
(after deleting a port interconnection).

Interconnecting a port with more than one partner port in the graphic view

Requirement
● You have assigned parameters to a port of a PROFINET device with the "Alternative 

partners" property and have specified the possible partner ports.

● The graphic view of the topology view is open.
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Procedure
1. Interconnect this port (called source port below) with one of the partner ports you have 

specified (called target port below).

2. Interconnect the source port with an additional target port.
You can do this in several ways:

– Drag the mouse pointer from an already interconnected partner port to a target port.

– Drag the mouse pointer from an interconnection that has already been created to a 
target port.

– Drag the mouse pointer from a target port to an already interconnected partner port.

– Drag the mouse pointer from a target port to an already created interconnection.

3. If necessary, repeat the step above one or more times.

Result
An interconnection is created between the source port and the alternative partner ports. This 
is indicated by a dashed line.

Interconnecting a port with more than one partner port in the table view

Which actions are possible with port interconnections to multiple partner ports in the table view?
When working with a tool changer, the following actions can be performed with port 
interconnections to multiple partner ports in the table view:

● Create new port interconnection

● Modify existing port interconnection

● Delete existing port interconnection

Requirement
● You have assigned parameters to a port of a PROFINET device with the "Alternative 

partners" property and have specified the possible partner ports.

● The row with the port whose interconnection you want to create, modify or delete is visible 
in the topology overview.

Procedure 
To create the interconnection of a port to one or more partner ports for the first time, to modify 
it or delete it, follow these steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click on the drop-down list there.

3. Select the required partner port (when creating a new interconnection or changing the port 
interconnection) or the "Not interconnected" entry (when deleting a port interconnection).

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  383



Result
The required action is performed:

● If you are creating an interconnection, a new row is inserted in the topology overview table. 
The new partner port is displayed there in the "Partner port" column.

● If you make a change, the new partner port is displayed in the "Partner port" column.

● If you are deleting, the row with the previous port interconnection is deleted.
 

  Note

With a tool changer, there are normally several rows for a port with port interconnections 
to several partner ports. The last row is always an empty row. The first row can be edited, 
all other rows are read-only.

 

Renaming stations, devices, interfaces or ports

Rename a station, a device, an interface or a port

Requirement
The table view of the configured topology is open.

Procedure        
To rename a station, a device, an interface or a port, proceed as follows:

1. Click twice in the relevant field of the topology overview table (the second click starts the 
editing mode).

2. Enter the new name and then press the ENTER key (this closes editing mode).

Result
The object is renamed.

 

Offline/online comparison

Automatic assignment of devices by offline/online comparison

Overview  
During the offline/online comparison, the configured topology is compared with the actual 
existing topology. Devices identified online are automatically assigned to configured devices 
as far as this is possible.
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Start of availability detection
You start the availability detection the first time by clicking the "Compare offline/online" button 
in the toolbar of the topology overview.

You restart availability detection by clicking the "Update" button.
 

 Note

The availability detection can take several seconds. During this time, no user input is possible.
 

Automatic assignment
A device identified online is automatically assigned to a configured device if the following 
properties of the two devices match up:

● Device name

● Order number

● Number of ports

The following section describes the situations that can occur and what action you can take:

● Identical port interconnections
This is the ideal situation. No action is necessary here.

"Action" column Meaning
No action

● There are interconnections for the identified and configured device, there are however 
differences.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 386)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action
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● The interconnection only exists online.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 386)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action

● The interconnection only exists in the configuration.
The following actions are possible:

"Action" column Meaning
Adopt the online interconnection (Page 386), in other words, the 
interconnection in the configuration will be deleted
No action

No automatic assignment
In the following situations, no automatic assignment is possible:

● No device can be identified online to match a configured device. In this case the 
corresponding columns in the "Online topology" area of the topology overview table are 
empty.
In this case, you should add the already configured device to your system or delete the 
configured device from the configuration.

● A device identified online cannot be assigned to any configured device. In this case the 
corresponding columns in the "Offline topology" area of the topology overview table are 
empty.
In this case, you can adopt the device identified online in the project (Page 387).

Adopt the port interconnections identified online in the project

Requirements
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online was automatically assigned to a configured device, but that 
there are differences relating to the interconnection.
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Procedure  
To adopt one more port interconnections identified online in the project manually, follow these 
steps: 

1. Select the value "Adopt" in the "Action" column for a port of a configured device to which 
a device identified online was assigned.

2. Repeat the step if necessary for other ports of the same configured device.

3. Repeat the steps up to now if necessary for other configured devices to which devices 
identified online were assigned and for which there are differences relating to the 
interconnection.

4. Click the "Synchronize" button.

Result
The port interconnections identified online and the cable information for the corresponding 
devices are adopted in the project. Successful adoption is indicated by the diagnostics icon 
"Identical topology information" for each port.

 

 Note

If other port interconnections are recognized for a device identified online and these differ 
from those that exist in the project, adopting these in the project means that the port 
interconnections that were previously in the project are replaced by those identified online. 
If no port interconnections are detected for a device identified online, adopting in the project 
means that all the port interconnections of this device are deleted in the project.

 

Adopt the devices identified online in the project

Requirements
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online could not be assigned to any configured device.

Procedure  
To adopt one more devices identified online in the project manually, follow these steps: 

1. For a configured device without an online partner, move the mouse pointer to the "Device/
port" column of the online topology.

2. Select the device you want to assign to the configured device from the drop-down list of 
this box.

3. Repeat the previous steps if necessary for other configured devices without an online 
partner.
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Result
The selected device that was identified online is moved up from the end of the table. Following 
this, it is in the row of the configured device to which you have just assigned it.

8.1.4 Creating configurations

8.1.4.1 Configurations for automation systems

Addressing modules

Addressing modules

Introduction         
In the device view you see the addresses or address ranges of the modules in the I-address 
and Q-address columns. There are other addresses as well, which are explained below. 

I/O address   
I/O addresses are required to read inputs and/or set outputs in the user program. 

Input and output addresses are assigned automatically when inserting modules in the rack. 
The address of the first channel is the start address of a module. The addresses of the other 
channels are derived from this start address. The address end is derived from the module-
specific address length.

Device address (e.g., Ethernet address)
Device addresses are addresses of programmable modules (Industrial Ethernet addresses). 
They are required to address the different stations of a subnet, e.g. to load a user program 
into a CPU.

Hardware ID for identification of modules or functional units of modules
In addition to the I addresses and Q addresses, a hardware identifier is also assigned 
automatically and is used to identify the module. Functional units of a module, for example an 
integrated counter, also receive a hardware identifier. 

The hardware identifier consists of a whole number and is output by the system along with 
diagnostics alarms to allow the faulty module or functional unit to be localized. 

You also use the hardware identifier for a number of instructions to identify the relevant module 
on which the instruction will be used. 

The hardware ID cannot be changed.

Example: Identifying a high-speed counter
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The hardware ID is assigned automatically when components are inserted in the device or 
network view and in the constants table of the PLC tags. A name is also assigned automatically 
for the hardware ID. These entries in the constants table of the PLC tags cannot be changed 
either. 

See also
Specifying input and output addresses (Page 389)

Assigning addresses to a location in the program (Page 390)

Introduction to loading a configuration (Page 473)

Specifying input and output addresses
Default input and output addresses are set automatically. You can, however, change the 
address assignment later. 

All addresses of modules are located in the process image area. The process image is 
automatically updated cyclically. 

Requirement
You are in the device view. 

Procedure 
To change the preset address range proceed as follows:

1. In the device view, click on the module for which you want to set the start address.

2. Go to "I/O addresses" in "Properties" in the inspector window.

3. Under "Start address" enter the required start address.

4. Press <Return> or click on any object to accept a modified value.

If you have entered an invalid address, a message indicating the next available address is 
displayed.

 

 Note

You can also change the addresses directly in the device overview. 
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See also
Editing properties and parameters (Page 309)

Assigning addresses to a location in the program
You can assign addresses or symbols from the I/O channels of the modules directly to the 
locations in the program.

Requirement
The device view of the hardware and network editor as well as the instruction window of the 
program editor must be opened and arranged one below the other.

Procedure 
Proceed as follows to assign addresses of modules and locations in the program:

1. In the device view, navigate to the module with the desired I/O channel.

2. Use the zoom function to specify a magnification of at least 200%: At a magnification level 
of 200% and higher, the labels of the individual address channels are displayed and can 
be edited.
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3. In the program, navigate to the block with the matching location.

4. Drag the desired address or tag to the appropriate location of the block or the I/O channel 
of the module.

The module address or tag will be assigned to the location in the program, or the address or 
tag in the program will be assigned to a module I/O channel. 
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Signal board

Inserting a signal board in a CPU

Introduction 
Signal boards allows you to increase the number of the S7-1200 CPU's own inputs and outputs. 
Just like all other hardware components, you will find signal boards in the hardware catalog. 
However, you do not insert signal boards in the rack like other modules but directly in a slot of 
the CPU itself.

Note the following points when using a signal board:

● Each CPU can have only one signal board inserted in it.

● A signal board can only be inserted when the slot in the CPU is free.

There are various ways of inserting a signal board in a CPU:

● Double click on a signal board in the hardware catalog when there is a free slot in the CPU

● Drag from the hardware catalog to a free slot in the CPU

● Shortcut menu of a signal board in the hardware catalog for copying and pasting

Requirement
● The hardware catalog is open.

● The S7-1200 CPU has a free slot for the signal board.

Inserting a signal board in a CPU 
To insert a signal board in a CPU, proceed as follows:

1. Go to the required signal board in the hardware catalog.

2. Select the signal board you want to use.

3. Drag the signal board to the free slot in the CPU.

You have now inserted a signal board in the slot of the CPU.

If you are in the network view, you can also drag a signal board to a device. If the CPU has a 
an empty slot for a signal board, the signal board is inserted automatically into this slot.
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Configurations for Web server

What you need to know about web servers

Introduction
The web server allows you to monitor the CPU via the Internet or the intranet of your company. 
This permits evaluation and diagnostics over long distances.

Messages and status information are visualized on HTML pages.

Web browser  
You need a web browser that supports HTML 1.1 to access the HTML pages of the CPU.

The following web browsers, for example, are suitable for communication with the CPU:

● Internet Explorer (version 6.0 and higher)

● Mozilla Firefox (V1.5 and higher)

● Opera (version 9.0 and higher)

● Netscape Navigator (version 8.1 and higher)

Reading information via the web server
The information listed in the following can be read from the CPU. Availability of the respective 
web pages depends on the CPU and its firmware version:

Page/information Description
Intro Entry page for the standard web pages
Start Page
Start page with general CPU information

The start page provides an overview of general 
information on the CPU, the name of the CPU, the 
type of CPU and basic information on the current 
operating state.

Identification
Identification information

Displays the static identification information such 
as serial number, order number and version 
numbers.

Diagnostic Buffer
Diagnostic information

Displays the content of the diagnostics buffer with 
the most recent entries.

Module Information
Module information

Displays whether the centrally inserted 
components of a station are OK, whether there are 
maintenance requirements or components cannot 
be reached, for example.

Communication
Communication

Displays the communication connections during 
open communication (OUC); displays resources 
and address parameters.

Varable Status
Tags

Displays the status of operands of the user 
program to monitor and change the values.
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Page/information Description
Data Logs Data logs in CSV format to transfer to the hard disk 

of the programming device. The data logs are 
created with data log instructions in the user 
program and filled with data. 

User Pages
User pages (if custom web pages have been 
configured and loaded)

The user web pages provide a list of web pages 
with customized web applications.

 

Web access to the CPU via PG/PC
Proceed as follows to access the web server:

1. Connect the client (PG/PC) to the CPU via the PROFINET interface.

2. Open the web browser.
Enter the IP address of the CPU in the "Address" field of the web browser in the format 
http://ww.xx.yy.zz (example: http://192.168.3.141).
The start page of the CPU opens. From the start page you can navigate to further 
information. 

Standard web pages

Requirements for web access
The requirements for access to standard CPU web pages are explained in the following, as 
well as the effects of missing or existing configuration information.

Requirements  
The web server must be started.

The web server only starts when it has been activated in the properties of the CPU in the "Web 
server" section.

Note the following:

The web pages are normally transmitted via an non-secure connection and are not secured 
against hacker attacks. If you want to transfer the web pages in encrypted form to the browser, 
use the URL https://, followed by the IP address of the CPU.

Logon   
No logon is required to access the standard web pages read-only. To execute certain actions, 
such as changing the operating state of the CPU or for write access, the user must be logged 
on as "admin". The logon input boxes are on the top left of each standard web page.
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If you log on as "admin", you must enter the user name and password there.

Name: admin.

Password: configured CPU password (for password-protected CPU).

JavaScript and cookies
The standard web pages use JavaScript and cookies. You must enable both in your web 
browser.

If JavaScript is not enabled, the following limitations apply:

● Data from standard web pages are not automatically updated.

● You cannot log on as "admin".

● Fields cannot be sorted (module information)

If cookies are not enabled you cannot log on as "admin".

See also
Access for HTTPS (Page 395)

Settings for operation

Settings for operation
To be able to use the web server of an S7-1200-CPU, you must select the CPU in the network 
view or the device view and make the following settings in the inspector window under 
"Properties > General > Web server":

● Enable the web server

● Restricting access to the CPU to HTTPS transmission protocol (encrypted transmission)
Access via port 80 is then blocked. Communication is only possible via port 443.

● Enabling automatic update of web pages 
The update interval is set by default and cannot be changed. The CPU updates web pages 
with changing content ( (for example, status information or diagnostics information) at 
regular intervals. 

Access for HTTPS

Access via HTTPS   
HTTPS is used for encrypting and authentication of communication between the browser and 
web server.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  395



To transfer data between the browser and the CPU using the HTTPS protocol, enter the URL 
as https://ww.xx.yy.zz  in the address line of your browser, whereby ww.xx.yy.zz  stands for 
the IP address of the CPU. 

You require a valid, installed certificate for error-free HTTPS access to the CPU. 

If no certificate is installed a warning is displayed with a recommendation not to use this page. 
To view the page you must explicitly "Add exception".

You can receive a valid certificate (Certification Authority) "SIMATIC CONTROLLER" as a 
download from the "Intro" web page under "Download certificate". The help function for your 
respective web browser provides information on how to install a certificate.

Accessing data logs
The "Data logs" web page allows files to be viewed or downloaded that have been created 
using DataLog instructions and that have been filled with data. You can clear or delete these 
entries after downloading by logging on as "admin".

Opening a data log  
To open a data log, click on the link of the desired data log. You can then open the file (.csv), 
for example, in Microsoft Excel or in another program you choose or you can save the file.

Special feature: Data logs are saved in U.S. American CSV format. You can only open the file 
directly using the U.S. version of Microsoft Excel. If you are using another national version of 
Microsoft Excel, you must import the file, selecting "comma" in the import assistant as the 
delimiter. 

Downloading a data log
To download a data log, click on the download icon of the desired data log. You can then open 
the file (.csv), for example, in Microsoft Excel or in another program you choose or you can 
save the file.

Downloading and clearing or deleting a data log
To download and delete the current entries of the data log, you must be logged on as "admin". 
To do this, click on the "Download and delete" icon of the required data log. You can then open 
the file (.csv), for example, in Microsoft Excel or in another program you choose or you can 
save the file. The web server delete the content of the file. The file itself is not deleted, only its 
content. New data can then be written in this file.

Determining the amount of content
As a default, the 25 most-used entries are displayed, irrespective of how many entries are 
contained in the data log. The number of displayed entries can be set. 
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Creating and loading custom web pages

What you need to know about custom web pages

Concept    
The concept of custom web pages allows you to access freely-designed web pages of the 
CPU from a web browser. The web server of the CPU provides this function.

You are not dependent on special tools for the design and functionality of the custom web 
pages. You can adapt the pages in the layout with CSS, provide dynamic content with 
JavaScript or use any framework to produce web pages.

The totality of files processed by the web server is also referred to as the "web application".

Web application and user program
Using HTML code in user-defined web pages, you can also transmit data via a web browser 
to the user program of the CPU for further processing and can display data from the operand 
area of the CPU in the web browser.

You can use script instructions (such as Javascript) to optimize your web pages, for example 
to dynamically change contents or validate user entries.

To synchronize between the user program and the web server, but also to initialize, you must 
call the WWW (SFC 99) instruction in the user program.

● If no interaction is required between the web application and the user program, for example, 
if a web page only provides static information, only initialization in the user program is 
required.

● If a simple data exchange is necessary between PLC tags and tags in web applications, to 
display the contents of PLC tags or write a value in a PLC tag for example, the syntax for 
reading and writing tags has to be observed. In this case only an initialization is required 
in the user program, for example in the startup OB. 

● If a further interaction is required between the web application and the user program, you 
must handle status and control information from the Web Control DB in addition to the 
synchronization between Web server and user program. This is the case, for example, 
when user entries are transmitted via the web browser to the web server for evaluation by 
the CPU. Unlike simple data exchange, the user program directly influences the time at 
which the requested web page is relayed back to the web browser. In this case, you must 
be acquainted with the concept of manual fragments and the structure of the Web Control 
DB.

Initialization  
Custom web pages are "packaged" in data blocks for processing by the CPU. You must 
generate appropriate data blocks from the source data (HTML files, images, JavaScript files, 
etc.) during configuration to be able to download the web application into the CPU. The Web 
Control DB has a special role (default: DB 333). It contains status and control information as 
well as links to additional data blocks with coded web pages. Data blocks that contain coded 
web pages are termed "Fragment DBs".
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When the data block is downloaded into the CPU, the CPU does not "know" that custom web 
pages are coded inside it. The "WWW" (SFC 99) instruction, for example, in the Startup OB 
informs the CPU which DB is the Web Control DB. The custom web pages can be accessed 
via a web browser after this initialization.

Synchronization  
If the user program is to exchange data with the user-defined web pages, the WWW (SFC 99) 
instruction must be used in the cyclic program section.

Examples of interaction between user program and web page:

● Check received data

● Assemble and send back data to the web browser making the request

In this case, the status information must be able to be evaluated and control information must 
be transmitted to the web server, for example, to release a requested web page.

Procedural overview

Basic considerations
This section provides a step-by-step explanation of the basic procedure used to create and 
download custom web pages and to use them in the operating phase.

The following graphic provides a simplified representation of the process used in creating and 
displaying custom web pages:
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① Programming a web application (using suitable tools when required and AWP commands for 
dynamic pages when applicable).

② The web application is comprised of single source files, for example, *.html, *.gif, *.js, etc.
③ Using STEP 7:

● Generate the data blocks (Web Control DB and fragment DBs) from source files. The DBs 
contain meta information and the complete web application, including the images and the 
dynamic and static parts of the web application. The DBs are stored under "System blocks" 
in the project tree.

● Call the "WWW" instruction in the user program. This instruction initializes the web server 
of the CPU for a web application.

● If required, complete final programming for interaction between the web server and user 
program

④ Downloading the blocks to the CPU.
⑤ Call the web page in the browser. The web pages of the CPU are called by entering the IP 

address of the CPU.

Additional information
You can find additional information and examples relating to the S7-1200 web server on the 
Internet (http://support.automation.siemens.com/WW/view/en/36932465). 

Creating web pages
Web design tools from various companies can be used to create custom web pages. As a rule, 
the web pages should be programmed and designed compliant to the conventions of the W3C 
(World Wide Web Consortium). No check is made for compliance to W3C criteria in the web 
server of the CPU.
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Rules
● The tool must be able to directly edit the HTML code so that the AWP command can be 

inserted into the HTML page.
Only the AWP commands are parsed in the CPU and, for example, replaced by values from 
the user program/process image of the CPU.

● Files containing AWP commands must be coded in UTF-8. In the metadata of the HTML 
page, therefore, set the attribute charset to UTF-8 and save the file UTF-8 coded.

● Files containing AWP commands must not contain the following sequence: ]]>

● Files containing AWP commands must not contain the following sequence outside of the 
"Tag-read ranges" (:=<Tag name>:): :=
Tip: Replace the first character of a prohibited sequence with its character coding; for the 
colon, for example, &#58;.

A small example for a custom web page should make clear the basic design.

Requirements
● The CPU must have a web server and the web server of the CPU must be activated.

● To be able to access PLC tags with write access as a user, you must be logged on as 
"admin".

● For the example below, PLC tags must be defined for those PLC tags that are to be shown 
on the web page. This is shown here for the first tab used, "Tank_below_max".

Creating custom web pages
The following code for an example web page reads values from the process image and 
provides them in a table.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/
TR/html4/strict.dtd">
<html>
  <head>
   <meta http-equiv="Content-Type" content="text/html; 
charset=utf-8">
   <title>Mix</title>
  </head>
   <body>
    <h1>Mix</h1>
    <h2> Actual State </h2>
    <table border="1">
     <tr>
      <th>Variable</th>
      <th>State</th>
     </tr>
     <tr>
      <td>Tank below max</td>
      <td>:="Tank_below_max":</td>
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     </tr>
     <tr>
      <td>Tank above min</td>
      <td>:="Tank_above_min":</td>
     </tr>
    </table>
   </body>
</html>

AWP commands
The interface between a freely-programmable web application for a CPU that has a web server 
and the CPU data is declared by the AWP command (Automation Web Programming). 

To develop web applications you are only subject to the restrictions of the web browser. In one 
of the programming languages of STEP 7, control with the user program which CPU data is 
displayed at what time in the web browser of the viewer. Use AWP commands, which you 
comment within the HTML files, to declare data to be used for intentional interaction between 
the web application and the user program.

AWP commands are inserted as HTML comments with a special syntax into HTML files; they 
declare the following features:

● Read PLC tags

● Write PLC tag

● Read special tags

● Write special tags

● Define enum types

● Assign tags to enum types

● Defining fragments

● Import fragments

Syntax of AWP commands   
An AWP command begins with "<!--AWP_" and ends with "-->". In JavaScript files, the 
commands should also be enclosed by JavaScript comments ("/*...*/").

Notation rules for PLC tag names within an AWP command  
The AWP commands "AWP_In_Variable" and "AWP_Out_Variable" contain a name attribute 
and optionally a use attribute. A PLC tag name is assigned to these attributes, by means of 
which the PLC tags in the browser are written or read. The following rules apply to handling 
PLC tag names in HTML code:

● PLC tags must be enclosed in quotation marks (" ... ").

● PLC tags used in AWP commands must also be enclosed by single quotation marks  ('" ... 
"') or with quotation marks masked by a backslash ("\" ... \"").
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● If the PLC tag name contains the character \ (backslash), this character must be designated 
with the escape sequence \\ as standard character of the PLC tag name.

● If the PLC tag name in the AWP command is also enclosed by single quotation marks and 
the single quotation mark (') occurs within the name, it must also be designed as normal 
character by the escape sequence \'.

● If an absolute address (input, output, bit memory) is used in AWP command, it is enclosed 
by single quotation marks.

PLC tag PLC tag in HTML code
"Velocity" <!-- AWP_In_Variable Name='"Velocity"' -->

<!-- AWP_In_Variable Name="\"Velocity\"" -->
"abc\de" <!-- AWP_In_Variable Name='"abc\\de"' -->
"abc'de" <!-- AWP_In_Variable Name='"abc\'de"' -->
"abc'de" <!-- AWP_In_Variable Name="abcde" Use'"abc\'de"' -->
"DB name".tag <!-- AWP_In_Variable Name='"DB name".tag' -->
"DB name"."ta.g" <!-- AWP_In_Variable Name='"DB name"."ta.g"' -->
- <!-- AWP_Out_Variable Name=’flag1’ Use='M0.0' -->

See also
Reading tags (Page 402)

Writing tags (Page 404)

Special tags (Page 405)

Reading tags
Custom web pages can read PLC tags.

The PLC tag must be specified by a PLC tag name.

These OUT variables (direction of output as viewed from the controller) are inserted at any 
location within the HTML text with the syntax described in the following.

Syntax    
:=<varname>:
These references are replaced when the web server is in operation by the current values of 
the PLC tag in each case.

<varname> can be a simple, global CPU tag but also a complete tag path to a structure 
element.
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Notation rules for PLC tag names 
● PLC tags in HTML code are enclosed by quotation marks ("), if they are defined in the tag 

table. In the case of data block tags, the name of the data block is enclosed by quotation 
marks. If special characters are used in the structure elements of the data block, for example 
the dot (.) or blank, this part must also be enclosed by quotation marks.

● Quotation marks are not used for absolute addresses of inputs, outputs or bit memories.

PLC tag PLC tag in HTML code
"DB_name".var_name :="DB_name".var_name:
"DB_name".struct_name.var_name :="DB_name".struct_name.var_name:
"DB_name"."var.name" :="DB_name"."var.name":
"memory" :="memory":
- :=I0.0:

:=Q0.0:
:=MW100:
:=%MW100:

"My_Data_Block".flag1 <!-- AWP _Out_Variable Name=’flag1’ 
Use='"My_Data_Block".flag1' -->
...
:=flag1:

● If the PLC tag name contains the character : (colon) or \ (backslash), this character must 
be designated with the escape sequence \: or \\ as standard character of the PLC tag name.

 PLC tag PLC tag in HTML code
"abc:de" :="abc\:de":
"abc\de" :="abc\\de":

● Special characters "<, &, >"
Display problems can occur if these characters are contained in the tag name (for example, 
"a<b"). 
Avoid expressions such as :="a<b": in the HTML page. 
To prevent display problems from occurring, use e.g. an AWP command with a use 
expression according to the pattern depicted below. The use attribute defines the PLC tag 
with the problematic character, the name attribute defines the name without problematic 
character, as it is used in the HTML page. 

 PLC tag PLC tag in HTML code
"a<b" <!—AWP _Out_Variable Name=’simplename’ 

Use='"a<b"' -->
...
:=simplename:

See also
AWP commands (Page 401)
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Writing tags
Custom web pages can write data into the CPU. 

This requires an AWP command that identifies the PLC tag to be written.

The PLC tag must also be specified by a PLC tag name.

The IN tags (direction of input as viewed from the controller) are placed on the browser page. 
This can be done, for example, in a form.

The tags are either set in the HTTP header (by cookie or POST method) or in the URL (GET 
method) by the browser and are then written by the web server into the respective PLC tag.

Syntax    
To allow the IN tags to be written to the CPU, the tags must first be defined by an explicit AWP 
instruction:
<!-- AWP_In_Variable Name='<PLC_Varname1>' Name='<PLC_Varname2>' 
Name='<PLC_Varname3>' -->
Several tags can be defined in an instruction - such as that shown above.

The specific PLC tag name is hereby written in double quotation marks; for example 
<PLC_Varname1> = "myVar".

In cases where the name of the tag that you use for the web application is not identical to the 
name of the PLC tag, the "Use" parameter can be used to assign to a PLC tag.
<!-- AWP_In_Variable Name=’<Webapp_Varname>’ Use=’<PLC_Varname>’

Example
The "AWP_In_Variable" AWP command is indispensable when handling forms.
<form method='post' action='/awp/appl/x.html'>
 <p>
  <input name='"var1"' type='text'>
  <input value='set' name='Button1' type='submit'>
 </p>
</form>
In the form defined above, the HTTP request method "post" is used to transfer the tag "var1" 
to the web server. The user places the "var1" tag in the form field. The tag 'Button1' has the 
value 'set', but is not required for the CPU. To allow the "var1" tag to be written to the CPU, 
the following instruction must be included in the same fragment:
<!-- AWP_In_Variable Name='"var1"' -->
Since PLC tags are enclosed in double quotation marks ("), the name in the AWP command 
must be enclosed in single quotation marks (') or in masked quotation marks (\"). To avoid the 
numerous escape sequences, we recommend the use of single quotation marks.
<!-- AWP_In_Variable Name=’"Info".par1’ -->
<!-- AWP_In_Variable Name="\"Info".par1\"" -->
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Conditions for write access during operation 
The following requirements have to be met in order for a user to be able to write to PLC tags 
from a user-defined web page.

● The CPU is is password protected.

● The user is logged in as "admin".

This rules applies to all writing access to web pages on a CPU. 

See also
Requirements for web access (Page 394)

AWP commands (Page 401)

Special tags
Special tags are mainly HTTP tags set in the definition of the World Wide Web Consortium 
(W3C) . Special tags are also used for cookies and server tags.

The AWP command to read and write special tags differ only in that they have additional 
parameters than the AWP command used to read and write normal tags.

Reading a special tag   
The Web server can read PLC tags and transfer these to special tags in the HTTP Response 
Header. You can, for example, read a URL for a diversion to another web page and transfer 
to the special tag HEADER:Location using the special tag HEADER:Location. 

The following special tags can be read:

Name Description
COOKIE_VALUE:name Value of cookie with name: "name"
COOKIE_EXPIRES:name Execution time of cookie with name: "name" in 

seconds (must be set beforehand).
HEADER:Status HTTP status code (if no other value has been set, 

status code 302 is returned).
HEADER:Location Path for forwarding to another page. Status code 

302 must be set.
HEADER:Retry-After Anticipated time in which the service is not 

available. Status code 503 must be set.
HEADER: … All other header tags can also be forwarded in this 

way.

Use the AWP command "AWP_Out_Variable" to specify which PLC tags are to be transferred 
in the HTTP header to the web browser.

Basic structure:

 
<!-- AWP_Out_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
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Parameter description
● Name: Type and name of special tag

● Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, parameter "Use" can be used to assign to a PLC tag.

Example:

 
<!-- AWP_Out_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->

Writing a special tag
In principle, all HTTP tags written in the HTTP header by the web browser can be evaluated 
by the user program of the CPU. Examples of tag types:

Name Description
HEADER:Accept-Language Accepted or preferred language
HEADER:Authorization Proof of authorization for a requested resource
HEADER:Host Host and port of the requested resource
HEADER:User-Agent Information on the browser
HEADER: … All other header tags can also be forwarded in this 

way
  
SERVER:current_user_id Indicates whether a user is logged on 

(current_user_id=0: no user logged on)
SERVER:current_user_name User name of the user logged on
SERVER:GET Request method is GET
SERVER:POST Request method is POST
  
COOKIE_VALUE:name Value of cookie with name: "name"

The AWP command "AWP_In_Variable" is used to define which special tags are to be 
evaluated in the user program of the CPU. 

Basic structure:

 
<!-- AWP_In_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
 

Parameter description:

Name: Type and name of special tag

Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, the parameter Use can be used to assign to a PLC tag.
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Examples:

 
<!-- AWP_In_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use . The 
cookie is written to the PLC tag "info".language . 

 
<!-- AWP_In_Variable Name='COOKIE_VALUE:siemens' Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use. The 
cookie is written to the PLC tag "info".language .

 
<!-- AWP_In_Variable Name='"COOKIE_VALUE:siemens"' -->
 

The HTTP-header variable is written in the same-name PLC variable.

See also
AWP commands (Page 401)

Enumeration types

Enumeration types (enums)
Numerical values from the PLC program can be converted into text and vice versa using 
enums. The numerical values can also be assigned for several languages.

Creating enums 
Enter an AWP command using the following syntax at the start of the HTML file:
<!-- AWP_Enum_Def Name="<Name of the enum type>" 
Values='0:"<Text_1>", 1:"<Text_2>", ... , x:"<Text_x>"' -->
For example, for German values to be saved as an HTML file in the "de" folder of the HTML 
directory:

 
<!-- AWP_Enum_Def Name="Enum1" Values='0:"an", 1:"aus", 2:"Störung"' -->
 

For example, for English values, to be saved as an HTML file in the "en" folder of the HTML 
directory:
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<!-- AWP_Enum_Def Name="Enum1" Values='0:"on", 1:"off", 2:"error"' -->
 

Assigning enums 
Tags are assigned from the user program to the individual enum texts using a special AWP 
command:

 
<!-- AWP_Enum_Ref Name="<VarName>" Enum="<EnumTypeName>" -->
 

<VarName>  is thereby the symbolic name from the user program and <EnumTypeName> is 
the previously set name of the enum type.

 

 Note

In each fragment in which enum texts are referenced by a PLC tag, this PLC tag must be 
assigned by the appropriate AWP command of the enum type name.

 

Example
Enum type "state" is defined with values "0" and "1". "0" means "off", "1" means "on":

 
<!-- AWP_Enum_Def Name="state" Values='0:"off", 1:"on"' -->
 

The following code is contained in the HTML code of the web page to be output:

 
<!-- AWP_Enum_Ref Name="operating state" Enum="state" -->
:=operating state:
 

Depending on the value of the "operating state" tag, the ´result displayed  is no longer "0" or 
"1", but "off" or "on".

Definition of fragments

Fragments  
Fragments are "logical sections" of a web page to be processed by the CPU individually.

Fragments are usually complete pages but can also be individual elements such as files (for 
example, images) or complete documents.
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Defining fragments

 
<!-- AWP_Start_Fragment Name="<Name>" [Type="<Type>"] [ID="<Id>"] -->
 

The start of a fragment is specified by this command. A fragment runs to the start of the next 
fragment or to the end of the file.

● <Name> Indicates the name of the fragment.
The name must start with a letter [a-zA-Z] or an underscore ( _ ). Letters, underscores or 
numbers [0-9] can follow after this first character.

● <Type> Indicates the type of the fragment.

– "manual" The user program is informed of the request for a fragment; the web page to 
be returned can be changed by the user program.

– "automatic" The page is automatically processed (default).

● <id> A numeric ID can be stipulated for the fragment. If no ID is assigned, the fragment is 
automatically assigned an ID. For manual pages (<Type>=manual) , the fragment can be 
addressed in the user program of the CPU by this ID.

 

  Note

Keep the ID low because the highest ID influences the size of the Web Control DB.
 

The input document is completely divided into fragments by the "AWP_Start_Fragment" 
command. "AWP_End_Fragment" is therefore unnecessary.

Without a start fragment command, a file is mapped as a fragment; the fragment name is 
derived from the file name. If a file is divided into several fragments (by 
"AWP_Start_Fragment"), the file must begin with the "AWP_Start_Fragment" command.

Importing fragments
You can declare a fragment in an HTML page and import this fragment into other web pages.

Example
A company logo is to be displayed on all web pages of a web application.

There is only one instance of the HTML code for the fragment that displays the company logo. 
You can import the fragment as often and into as many HTML files as required.

Syntax

 
<!-- AWP_Import_Fragment Name = "<name>"-->
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● <name> is the name of the fragment to be imported.

Example
HTML code within a web page that declares a fragment:

 
<!-- AWP_Start_Fragment Name = "My_Company_Logo"-->
<p><img src = "compay_logo.jpg"></p>

Example
HTML code within another web page that imports the declared fragment:

 
<!-- AWP_Import_Fragment Name = "My_Company_Logo"-->
 

Creating and loading a data block

Requirement
● All source files required for the web application have been created.

Procedure
To create data blocks from the source files for custom web pages in STEP 7, proceed as 
follows:

1. Select the CPU, for example, in the device configuration.

2. Select the properties for custom web pages in the inspector window under "Properties > 
General > Web server".

3. As "HTML source", select the folder that contains the source files for the web application.

4. Enter the HTMP page to be opened on starting the web application as the start HTML page.

5. Enter a name for the application if required.

6. You can supplement a range of file name extensions as "Files with dynamic content" if 
necessary. Only enter those file name extensions that also contain AWP commands.

7. The number for the Web Control DB and for the fragment DB start number can be kept as 
long as they are not already being used by your user program.
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8. Click on the "Generate" button to create DBs from the source files.
The generated data blocks are saved in the project navigation in the "System block" folder 
(in the "Web server" subfolder).

9. In the CPU, select the network view to be loaded and then select the "Download to device" 
command in the "Online" menu to download the blocks. Compilation of the blocks is 
implicitly initiated before downloading.
If errors are reported during this process, you must correct these errors before you can 
download the configuration.

Structure of the PLC program
Your user program must call the " WWW" instruction to even allow the web application, for 
example, the custom web pages, to be available to the CPU on the standard web pages and 
to allow them to be called up there.

The Web Control DB you have created from the source files is the input parameter (CTRL_DB) 
for the "WWW" instruction. The Web Control DB references the content of the custom web 
pages coded in the fragment DB and then receives status and control information.

Calling the "WWW" instruction in the startup program
If you do not want the user program to influence requested web pages, it is sufficient to only 
call the "WWW" instruction once in a startup OB. This instruction initializes communication 
between the web server and the CPU.

Calling the "WWW" instruction in the cyclic program
The "WWW" instruction can also be called in an OB processed in cycles (for example, OB 1). 
This has the advantage of being able to respond to web server requests from within the user 
program. Manual fragments must be used for this.

In this case, you must evaluate information from the Web Control DB in order to identify the 
requested web page or the requested fragment. On the other hand, you must set a bit in the 
user program in order to explicitly release the web page to be returned by the web server after 
processing the web page request.

The structure of the Web Control DB is described in the following section.

Web Control DB
The Web Control DB (DB 333 by default) is created by STEP 7 and contains information on 
the structure of user pages, the status of communication and any errors that occur.

Additional fragment DBs are also created as well as the Web Control DB. These fragment DBs 
(there may also only be one fragment DB) are referenced in the Web Control DB. The fragment 
DBs contain the web pages and media data coded in fragments, for example, images. The 
content of the fragment DB cannot be changed by the user program. It is created automatically 
and is only for data management.

The status and control tags of the Web Control DB are accessed via symbols.

The following lists the tags of the Web Control DB required for status evaluation and to control 
interaction.
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The Web Control DB provides two types of information:

● Global status information: Not bound to a concrete web page request.

● Request status and control information: Information about queued requests.

Global status information

"WEB-Control_DB".commandstate.init Activates and initializes the web application.
"WEB-Control_DB".commandstate.deactivate Deactivates the web application.
"WEB-Control_DB".commandstate.inititializing The web application is initialized (read Web 

Control DB, etc.).
"WEB-Control_DB".commandstate.error Web application could not be initialized. The 

reason is coded  in "WEB-
Control_DB".commandstate.last_error .

"WEB-
Control_DB".commandstate.deactivating

The web application is closed.

"WEB-Control_DB".commandstate.initialized The web application has been initialized and is 
ready.

"WEB-Control_DB".commandstate.last_error Refer to the next table for a value table of 
possible errors.

Last_error Description
1 Fragment DB is inconsistent (does not match the Web Control DB).
2 A web application already exists with this name.
3 Memory problem initializing in the web server.
4 Inconsistent data in the Web Control DB.
5 A fragment DB is not available (not loaded).
6 No AWP ID for a fragment DB.
7 The enum fragment is not available (contains the texts and information on the enum 

types).
8 An action requested via the command flag in the Web Control DB is prohibited in the 

current state.
9 Web application is not initialized (if there is no reinitializing after disabling).
10 Web server is disabled.
... Last_error is reset once the web application has been successfully initialized.

Request status information
Request status information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].idle Nothing need be done.
"WEB-Control_DB".requesttab[x].waiting The user program must react to a request from 

a manual fragment and explicitly initiate further 
processing in the web browser.
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"WEB-Control_DB".requesttab[x].sending The web server is occupied with processing the 
request/fragment.

"WEB-Control_DB".requesttab[x].aborting The TCP connection is closed by the web 
server.

Request control information
Request control information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].continue Releases the fragment being processed for 
transmission. Processing of the next fragment 
is initiated.

"WEB-Control_DB".requesttab[x].repeat Releases the fragment being processed for 
transmission. The fragment is then processed 
again.

"WEB-Control_DB".requesttab[x].abort Closes the TCP connection.
"WEB-Control_DB".requesttab[x].finish Releases the fragment being processed for 

transmission. Stops further processing of 
requests (terminates the request).

Example:
The tag for the DB is: "WEB-Control_DB". Whether errors have occurred during initialization 
of the web application can be determined by requesting bit "WEB-
Control_DB".commandstate.error in the user program.

If an error has occurred you can analyze it using the "WEB-
Control_DB".commandstate.last_error value.

Interaction with the user program
Using manual fragments ensures that the user program reacts synchronously to the user 
program, thereby allowing the responding web page to be processed by the user program.

Fragment type   
To react to the received data in the user program the "manual" fragment type must be used 
for the fragment writing the data (for "manual pages"):
<!-- AWP_Start_Fragment Name="testfrag" ID="1" Type="manual" -->
The values are always transferred to the web server of the CPU for automatic and manual 
pages in the same way:

Example:
<form method="POST" action="">
<p>
<input type="submit" value="Set new value">
<input type="text" name='"Velocity"' size="20">
</p>
</form>
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User program for manual fragments
When using manual pages, the "WWW" instruction must be called in cycles in the user program 
of the CPU.

To react to values entered in the browser, the request - which is made by the manual page to 
the web server - must first be evaluated in the user program. To do this, the Web Control DB 
(for example, DB 333) must be examined in cycles for queued requests. The array that 
manages four requests is contained in the "requesttab" section of the Web Control DB. Each 
element of the array thereby contains information on the respective request within a structure.

A simple programming example shows how queued requests are checked based on the tags 
of the Web Control DB.
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In cases where a request has been made, this program section writes the fragment ID in the 
#frag_index  tag and the request no. (value range 1-4) in the #req_index tag.

Using the information from this, the information transferred in the request can now be 
processed separately for each fragment ID in the program (for example, plausibility check).

Once processing of the request has been completed by the program, the request must be 
answered and the appropriate entry is once more reset under"requesttab" of the Web Control 
DB (for example, DB 333).

A simple programming example for replying to requests:
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Principle sequence of a browser request with interaction from the user program
The following figure shows the simplified, principle sequence of the web browser request on 
the effects of Web Control DB content and the actions required from the user program until 
the processed web page is returned (response).

Displaying custom web pages in the browser

Display web pages in browser
Web pages are called from the standard web pages of the web browser. 
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In addition to the other links in the navigation bar, the standard web pages also have a link to 
"user pages". 

Click on the "user pages" link to open the web browser you have configured as the default 
HTML page. 

Creating custom web pages in several languages
You can make each of your custom web pages available in various languages.

Requirements
The language-dependent HTML; pages must be stored in a folder structure containing folders 
with the respective language abbreviations:

Specified language abbreviations 
Language abbreviations "de", "en", "fr", "es", "it" and "zh" are fixed. Additional language folders 
or other designated language folders are not supported.

Additional folders within the same folder hierarchy for other files can be created as required; 
for example, an "img" folder for images and a "script" folder for JavaScript files.

Language switching for custom web pages

Requirements
The HTML pages are contained in the predefined language folders, for example, HTML pages 
with German text are in the "de" folder, HTML pages with English text are in the "en" folder.

Language switching concept
Language switching is based on a predefined cookie named "siemens_automation_language". 
If the cookie is set to value "de", at the next web page request or web page update, the web 
server switches to the web page from the  "de" folder.

Similarly, the web server switches to the web page from the "en" folder when the cookie is set 
to "en".
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Example of language switching
The example is structured as follows:

● The language-dependent HTML files with the same name, for example,  "langswitch.html" 
are located in both language folders "de" and "en". The text to be displayed within the two 
files are German or English, corresponding to the name of the folder.

● There is an additional "script" folder in the folder structure containing the JavaScript file 
"lang.js". Functions required for language switching are stored in this file .

Structure of the "langswitch.html" file ("de" folder)
Meta data "content language", charset and path to JavaScript file are set in the file header.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="de">
<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Switch language to German page</title>
<script type="text/javascript" src="script/lang.js" ></script>
<head>
Language selection is implemented in the body of the file by the "select" HTML element. The 
select element initiates a list box and contains the "de" option, labeled as "German" and "en", 
labeled as "English"; "de" is the default. 

The "DoLocalLanguageChange(this)" function is called using the "onchange" event handler. 
The "this" parameter transmits the select object with the selected option to this function. 
"onchange" calls the function each time the option is changed.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" selected >Deutsch</option>
                <option value="en" >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of the "langswitch.html" file ("en" folder)
The header of the HTML file with English text is structured similarly to the HTML file with 
German text. 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="en">

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
418 System Manual, 08/2011,  



<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Language switching english page</title>
<script type="text/javascript" src="script/lang.js" ></script>
Language selection is also implemented in the body of the file by the "select" HTML element. 
In contrast to the German HTML file, the English option is already selected as a default and 
the test or the labels are in English.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" >German</option>
                <option value="en" selected >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of "lang.js" file (in the "script" folder)
The "DoLocalLanguageChange" function is defined in the JavaScript file; this in turn calls the 
"SetLangCookie" function with the value of the language selection. SetLangCookie combines 
the cookie name and the cookie value and then sets the cookie using the appropriate 
document.cookie property. The web page must then be reloaded (top.window.location.reload) 
to allow the web server to react to the setting of the cookie by displaying the required language.

 
function DoLocalLanguageChange(oSelect) {
        SetLangCookie(oSelect.value);
        top.window.location.reload();
    }
 
 function SetLangCookie(value) {
        var strval = "siemens_automation_language=";
            // this is the cookie by which the web server
            // detects the desired language
            // this name is required by the web server
        strval = strval + value;
        strval = strval + "; path=/ ;";
            // set path to the application, since otherwise
            // path would be set to the requesting page 
            // would not get the cookie. 
            // The path for user defined applications follows this 
sample: 
            // path=/awp/<application name>/<pagename>
            // example: path=/awp/myapp/myappstartpage.htm 
            //(where myapp is the name of the web application 
            // entered in the web server properties of the cpu)
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            /*
            use expiration if this cookie should live longer
            than the current browser session
            var now      = new Date();
            var endttime = new Date(now.getTime() + expiration);
            strval = strval + "; expires=" + endttime.toGMTString() 
+ ";";
            */
        document.cookie = strval;
    }

Additional configurations

Configuring additional functions
The S7-1200 automation system has numerous additional functions that are useful as 
integrated CPU functions or available via plug-in modules (for example, communication 
modules). You can find the description via the following links.

See also
Overview of point-to-point communication (Page 508)

General information on high-speed counters (Page 503)

8.1.4.2 Configurations for PROFIBUS DP

The basics of configuring a DP master system

Distributed I/O  
DP master systems that consist of a DP master and DP slaves which are connected via a bus 
and communicate with one another via the PROFIBUS DP protocol are referred to as 
distributed I/O.

Firmware version of the S7‑1200 CPU
Use of the PROFIBUS functions with the S7‑1200, requires CPUs with firmware version 2.0 
or higher.

Configuring distributed I/O
Since DP masters and DP slaves are different devices, these instructions only provide a basic 
configuration procedure. However, the process for configuring distributed I/O is practically 
identical to that of non-distributed configuration.
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Creating the DP master system in the network view  
After you have used dragged a DP master and a DP slave (for example, a CM 1243‑5 and a 
CM 1243‑5) from the hardware catalog to the network view, connect them both to a PROFIBUS 
subnet.

Additional information
Observe additional information on the scope of functions in the manuals of the respective 
device.

DP slaves within the hardware catalog

DP slaves within the hardware catalog   
You will find the DP slaves in the "Distributed I/O" folder of the hardware catalog. Compact 
and modular DP slaves are located there:

● Compact DP slaves
Modules with integrated digital/analog inputs and outputs, for example, ET 200L

● Modular DP slaves
(Interface modules with S7 modules assigned, for example, ET 200M

The available DP master and the desired functionality will determine which DP slaves can be 
used.

I slaves within the hardware catalog  
The CM 1242-5 is, for example, an DP slave that can be configured as intelligent DP slave. 
You can find it in the hardware catalog at:

● CM 1242‑5
"PLC > SIMATIC S7 1200 > Communication module > PROFIBUS"

DP/DP coupler in the hardware catalog 

Introduction
A DP/DP coupler connects two PROFIBUS DP networks as a gateway so that the DP master 
from one network can transfer data to the DP master of the other network.

The maximum amount of data that can be transferred is 244 bytes input data and 244 bytes 
output data.

DP/DP coupler in the hardware catalog    
Details of a DP/DP coupler as gateway between two DM master systems are contained in the 
hardware catalog in the folder "Other field devices > PROFIBUS-DP > Gateways".
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Configuring the DP/DP coupler
DP/DP couplers are configured in both PROFIBUS networks, each in their own master 
systems.

The input and output areas of both networks must thereby be matched to one another. The 
output data from one end of the DP/DP coupler are accepted as input data at the other 
respective end and vice versa.

Configurations involving PROFIBUS DP

Configurations involving basic DP slaves

Communication between DP master and DP slave    
In the case of a configuration involving simple DP slaves, data is exchanged between the DP 
master and simple DP slaves, i.e. with I/O modules via the DP master. The DP master polls 
each of the configured DP slaves in its polling list within the DP master system in succession, 
sending the output data to the slaves and receiving the input data back from the slaves.

Mono-master system 
The configuration with only one DP master is also described as mono-master system. A single 
DP master with its associated DP slaves is connected to a physical PROFIBUS DP subnet.

Configurations involving intelligent DP slaves

Definition   
DP slaves that feature their own preprocessing program are referred to as intelligent DP slaves 
(I slaves).
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CM 1242-5 is an intelligent DP slave.

I slave <> DP master data exchange   
A higher-level automation system processes the automation task, which is broken down into 
sub-tasks. The necessary control tasks are processed separately and efficiently in a CPU as 
preprocessing programs.

In the case of configurations involving intelligent DP slaves, the DP master only accesses the 
address area of the I slave CPU, and not the I/O modules of the intelligent DP slave. The 
address area must not be assigned to any actual I/O modules on the I slave. The assignment 
must be made during I slave configuration.

Configuring distributed I/O systems

Hint: Quick configuration of master systems
If the DP master system has several DP slaves, use drag-and-drop operation to assign to the 
master in one step all DP slaves that were placed.

Requirements   
DP master and DP slaves are placed in the network view.
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Assigning DP slaves to a DP master system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many DP slaves as possible in 
the network view.

2. Arrange the DP slaves in a maximum of two rows.

3. Select all DP interfaces with the mouse cursor (not all devices!). This only works if you 
begin to drag the mouse cursor outside of the first DP slave and release the mouse button 
at the last DP slave (selection with the lasso).

4. Select the shortcut menu "Assign to new master" and select the corresponding DP interface 
for the DP master in the subsequent dialog.

5. The DP slaves are automatically networked with the DP master and combine with it to form 
a DP master system.

 

  Note

When a DP master system is highlighted, you can double-click on a DP slave in the 
hardware catalog and thereby quickly add additional DP slaves. This will result in the DP 
slave being added to the highlighted DP master system automatically.
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Creating a DP master system

Introduction 
To create a DP master system, you need to have one DP master and at least one DP slave. 
As soon as you connect a DP master to a DP slave, a master-slave link is established.

DP master 
You can use any of the following devices as a DP master:

● CM 1243‑5

Requirements
● You must be in the network view.

● The hardware catalog is open.

Procedure  
To create a DP master system, follow these steps:

1. Select a DP master from the hardware catalog.

2. Pull the DP master onto the free area within the network view.

3. Right-click on the DP master's DP interface.

4. Select "Create master system" from the shortcut menu.
A DP master system with one DP master will be created as a single node.

If you connect a DP slave's DP interface to that of the DP master, the DP slave will be added 
to the master system.

Assuming that you have already placed both a DP master and a DP slave within the network 
view, you can drag-and-drop to connect the two and thereby create a DP master system. To 
do so, follow these steps:
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1. Click on the DP interface of either the DP master or DP slave.

2. Hold down the mouse button and draw a connecting line between this DP interface and 
that of the desired communications partner.

This will create a subnet with one DP master system between the DP master and DP slave.

DP master display on the DP slave  
When you connect a DP slave to a DP master, the name of the DP master is displayed on the 
DP slave as a hyperlink. Click the hyperlink to select the associated DP master.

Highlighting applied to the DP master system 
When you create a new DP master system, highlighting will be applied to it. This enables you 
to identify quickly which devices belong to the DP master system. You can also highlight a DP 
master system yourself by moving the mouse pointer over a subnet. This will result in the 
names of the available DP master systems being displayed. Click the required DP master 
system to highlight it.

There are various ways of removing the highlighting from a DP master system:
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● Highlight a different master system.

● Click on the drawing pin with the name of the master system in the top right-hand corner 
of the network view.

Editing DP master systems and interfaces

Introduction   
Once you have created a DP master system, you also have the option of disconnecting the 
DP master system and its components. This can result in subnets with DP slaves but no DP 
master. 

Generally, there is no need to edit the interfaces of a DP master.

You can change the name and number on the DP master system.

Disconnection from DP master systems
If you have configured either a CPU with an integrated PROFIBUS DP interface or a 
PROFIBUS CP (that can be configured as an intelligent DP slave) as a DP master with master 
system, then you will be able to disconnect the DP master from the DP master system. After 
this, the device will no longer be connected to the DP master system.

Disconnecting the subnet for a DP master effectively eliminates the master system in the sense 
that it is no longer assigned to a DP master. However, the individual DP slaves remain 
interconnected via the subnet and any direct data exchange that has been configured remains 
unaffected.

If you delete the DP slaves or detach them from the master system, the master system is 
retained on the DP master. 

Requirements
● You must be in the network view.

● There has to be a DP master system with one DP master and at least one DP slave.

Disconnecting the DP master from the DP master system  
To disconnect the DP master system, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Disconnect from master system" from the shortcut menu.

The selected DP master will be disconnected from the DP master system. A subnet with the 
DP slaves will be retained.
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Adding a DP master to the DP master system  
To reassign a DP master to a subnet, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Create master system" from the shortcut menu.

3. Draw connecting lines between the new DP master system and the DP interfaces of the 
DP slaves.

The DP master combines with the DP slaves to recreate a DP master system.

Editing the properties of a DP master system  
To edit the properties of a DP master system, proceed as follows:

1. Move the mouse pointer over a subnet with a DP master system.

2. A message will appear displaying the available DP master systems. Click the one you want 
to edit. The DP master system will now be color-highlighted.

3. Click on the highlighted DP master system.

4. In the inspector window, edit the DP master system attributes under "Properties > General".
 

  Note

If you click a subnet when no DP master system is highlighted, you will be able to edit the 
properties of the entire subnet under "Properties" in the inspector window. 

 

Adding DP slaves to the master system and configuring them
In the network view, you can add various DP slaves from the hardware catalog directly by 
using the drag-and-drop function or by double-clicking.

DP slaves  
For configuration purposes, DP slaves are broken down into the following categories:

● Compact DP slaves
(Modules with integrated digital/analog inputs and outputs, for example, ET 200L)

● Modular DP slaves
(interface modules with S5 or S7 modules assigned, for example ET 200M)

● Intelligent DP slaves (I slaves)
(CM 1242‑5 or ET 200S with IM 151-7 CPU)
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Rules
● Your DP master system should only contain one DP master, but it may contain one or or 

more DP slaves.

● You may only configure as many DP slaves in a DP master system as are permitted for the 
specific DP master.

 

  Note

When configuring the DP master system, remember to observe the DP master technical 
data (max. number of nodes, max. number of slots, max. quantity of user data). User data 
restrictions may possibly prevent you from being able to use the maximum number of 
nodes that is theoretically possible.

 

Requirements
● You must be in the network view.

● A DP master system must have been created.

Adding a DP slave to the DP master system  
To add a DP slave from the hardware catalog to the DP master system, follow these steps:

1. Select a DP slave from the hardware catalog.

2. Drag-and-drop the DP slave from the hardware catalog into the network view.

3. Draw a connecting line between the DP master's DP interface or a highlighted DP master 
system and the DP interface of the new DP slave.

A DP master system will be created and the DP slave will be connected to the DP master 
automatically.

 

 Note

When a DP master system is highlighted, you can double-click the required DP slave in the 
hardware catalog. This will result in the DP slave being added to the highlighted DP master 
system automatically.

 

Disconnecting a DP slave from the DP master system  
To disconnect a DP slave from the DP master system, follow these steps:

1. In the network view, right-click on the DP slave's DP interface.

2. From the shortcut menu, select the method for disconnecting from the DP master system:

– "Disconnect from subnet": The PROFIBUS connection is broken and the device is no 
longer connected to the DP master system or a subnet.

– "Disconnect from master system": The DP slave remains connected to the subnet, but 
is no longer assigned to the DP master system as a DP slave.

The selected DP slave will be disconnected from the DP master system.
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Assigning a DP slave to a new DP master system 
To assign an existing DP slave to a new DP master system, follow these steps:

1. Right-click on the DP slave's DP interface.

2. From the shortcut menu, select "Assign to new master".
It does not matter whether the DP slave concerned is already assigned to another DP 
master system.

3. From the selection list, select the DP master whose DP master system is to have the DP 
slave connected to it.
The selected DP slave is now assigned to a new DP master system.

The "Assign to new subnet" function works in a similar way in that it allows you to connect a 
DP slave to a new subnet. However, in this case, the DP slave will not be connected to an 
existing DP master system.

Configuring a DP slave  
To configure a DP slave, follow these steps:

1. Switch to the DP slave's device view.

2. Select the module you want.

3. Configure the DP slave in the Inspector window.

Configuring intelligent DP slaves

Adding an I slave to a DP master system

Introduction
One of the characteristics of an intelligent DP slave (I slave) is that the DP master is not 
provided with I/O data directly by a real I/O, but by a preprocessing CPU. Together with the 
CP, this preprocessing CPU forms the I slave.
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Difference: DP slave v. intelligent DP slave
In the case of a DP slave, the DP master accesses the distributed I/O directly.

In the case of an intelligent DP slave, the DP master actually accesses a transfer area in the 
I/O address space of the preprocessing CPU instead of accessing the connected I/O of the 
intelligent DP slave. The user program running on the preprocessing CPU is responsible for 
ensuring data exchange between the address area and I/O.

 

 Note

The I/O areas configured for data exchange between the DP master and DP slaves must not 
be used by I/O modules.

 

Applications
Configurations involving intelligent DP slaves:

● I slave <> DP master data exchange

● Direct DP slave > I slave data exchange

Procedure
To add an I slave to a DP master system, follow these steps:

1. Drag two devices with PROFIBUS DP interface for configuration as DP master and I slave 
from the hardware catalog to the network view.

2. Draw a connecting line between the DP interfaces of both devices. This way you connect 
the I slave with a DP master in a DP master system.
Result: You have now set up a DP master system with one DP master and one I slave.

Configuring access to I slave data

Data access 
The following generally applies to I slaves: The address for the data transfer area and the 
address for the module on the I slave are different. This means that the start address occupied 
by a module can no longer be used for the transfer memory. If the higher-level DP master is 
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to access the data of an I slave module, you will need to program this form of data exchange 
between the module and transfer area in the I slave user program.

Configuring the transfer area for data with DP slaves of the S7-1200
With CM 1242‑5, the transfer area for the cyclic PROFIBUS data exchange is configured as 
transfer area in the parameter group "PROFIBUS interface > Mode > I Slave Communication".

Direct data access from CPU to CPU
Direct data access from CPU to CPU via PROFIBUS is supported by the S7-1200 PROFIBUS 
CMs only via the PUT/GET services.

Configuring DP slaves as distributed I/O devices

Configuring an ET 200S

Slot rules for configuring an ET 200S   
The following rules apply when configuring an ET 200S:

● Do not leave any gaps when inserting the ET 200S modules.

● Slot 1: only for PM-E or PM-D Power Modules.

● To the left of an Electronics Module (EM): an EM or a Power Module (PM-E or PM-D) only.

● To the left of Motor Starter (MS): an MS, a PM-D, PM-D Fx (1..x..4) Power Module or a PM-
X Power Module only.
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● To the left of a PM-X: a motor starter or a PM-D only

● Up to 63 modules and one IM Interface Module are permitted
 

  Note

Remember to ensure that the correct PM-E and EM voltage ranges are assigned.
 

Configuring reference junctions  
A reference junction is the connection of a thermocouple to a supply line (generally in the 
terminal box). The voltage that occurs due to the effects of temperature falsifies the 
temperature value measured by the module. 

On the ET 200S, one channel of the AI RTD module can be programmed as a reference 
junction. Other AI TC modules can correct their measured values using the temperature at the 
reference junction as measured by this module.

  
① Configuring the AI TC:

→ Selection of the reference junction used
② Configuring of the AI RTD: 

→ Activation of the reference junction
→ Specifying the slot and channel of the AI RTD

 

Special characteristics to be noted when assigning parameters for reference junctions  
The process of assigning parameters for reference junctions will be explained based on the 
example of a resistance thermometer with a Pt 100 climatic range that is used for measuring 
the reference junction temperature.

To assign parameters for the reference junction, follow these steps: 

1. In the ET 200S device view, insert an analog electronics module, for example a 2AI RTD HF.

2. Select the module on the rack.

3. Under "Properties > Inputs" in the inspector window, set a channel for the reference 
junctions function to the "RTD-4L Pt 100 climatic range" measuring range.
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4. Select the ET 200S.

5. Under "Properties > Module parameters > Reference junctions" in the inspector window, 
select the "Reference junction" check box and specify the slot and channel number of the 
relevant RTD module.

6. Insert the analog electronics module for measuring the temperature using a thermocouple 
(TC module) and parameterize it with the reference junction number of the RTD module.

Additional information
For additional information on the various types and uses of ET 200S modules, please refer to 
the operating instructions and the manual titled "ET 200S Distributed I/O System".

For additional information on analog value processing, please see the documentation for the 
ET 200S distributed I/O system.

Packing addresses

Introduction 
DP slaves and I/O devices from the ET 200S family are configured in the same way as other 
modular DP slaves and I/O devices. As well as supporting all the standard modular DP slave 
and I/O device functions, the ET 200S also offers the "Pack addresses" function:

When digital electronics modules requiring an address space of 2 or 4 bits are inserted into 
the device view, they will initially be spread over a total area of 1 byte. However, the address 
area actually occupied can be compressed after configuration using the "Pack addresses" 
function. 

 Initial state After "Pack addresses"
Module I address I address
2DI (2-bit) Byte 10 10.0...10.1
4DI (4-bit) Byte 11 10.2...10.5

Requirements
● You are in the device view.

● An ET 200S, for example an IM 151-1, must be present.

● A pair of digital electronics modules, for example 2DI AC120V ST, must be inserted into 
the slots.
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Packing addresses   
To pack addressed, follow these steps:

1. Select the electronics modules whose addresses are to be packed. The following options 
are available for selecting multiple electronics modules:

– Press and hold down <Shift> or <Ctrl> while clicking the relevant electronics modules.

– Click off the rack and select the required electronics modules by drawing round them 
with the mouse.

2. Click "Pack addresses" in the shortcut menu for the selected electronics modules.

The address areas for inputs, outputs and motor starters are packed separately. The packed 
addresses will be displayed in the I address and Q address columns of the device overview.

How packed addresses are generated and structured  
If you make use of the "Pack addresses" function, the addresses of the selected electronics 
modules will be packed in accordance with the following rules:

● The start of the address area is determined by the lowest address of the selected electronics 
modules: X.0

● If the bit address is not "0", then the next (free) byte address as of which the selected area 
can be compacted will be selected automatically: (X+n).0

● If no coherent area exists, the addresses will be automatically packed into any available 
address gaps.

Electronics modules with packed addresses and the same byte address form a packing group.

Unpacking addresses  
To unpack addressed, follow these steps:

1. Select one or more electronics modules with packed addresses.

2. Click "Unpack addresses" in the shortcut menu for the selected electronics modules.

The packing groups of the selected electronics modules will be disbanded and the packed 
addresses for the relevant electronics modules unpacked.

The packing group will also be disbanded and the packed addresses unpacked in the following 
cases: if you delete electronics modules from a packing group, move electronics modules out 
of a packing group or insert electronics modules on a free slot within a packing group.

The start addresses of the unpacked electronics modules will be assigned to the next available 
byte addresses in each case.
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Special characteristics of electronics modules with packed addresses
The following special characteristics apply to electronics modules with packed addresses:

● As far as the CPU is concerned, there is no way of assigning a slot for the electronics 
module. Consequently, the instruction GADR_LGC (SFC 5) outputs error information 
W#16#8099 "Slot not configured" for the actual slot of the electronic module.

● The instruction LGC_GADR (SFC 49) and SZL-ID W#16#xy91 "module status information" 
cannot be evaluated for an electronics module.

● The electronics module receives an additional diagnostics address via the DPV1 function, 
because otherwise the packed addresses would prevent interrupts from being assigned as 
far as the CPU is concerned.

● The "Insert/remove interrupt" is not possible. This is because the "Pack addresses" and 
"Insert/remove interrupt" functions are mutually exclusive. 

Configuring an ET 200S with option handling
You can use the option handling function to prepare the ET 200S for future expansions 
(options). This section describes option handling with reserve modules. 

You do this by assembling, wiring, configuring, and programming the maximum configuration 
envisaged for the ET 200S and by using cost-effective reserve modules (138-4AA00 or 
138-4AA10) during assembly until it becomes time to replace them with the necessary 
electronics modules.

 

 Note

The ET 200S can be completely factory-wired with the master cabling, as no connection 
exists between a reserve module and the terminals of the terminal module (and, in turn, to 
the process).

 

Requirements
● ET 200S interface module

– IM 151-1 STANDARD (6ES7 151-1AA03-0AB0 or higher)

– IM 151-1 FO STANDARD (6ES7 151-1AB02-0AB0 or higher)

● Power module with option handling

– PM-E DC24..48V

– PM-E DC24..48V/AC24..230V
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Procedure
To activate option handling, follow these steps:

1. Select the IM 151-1 in the device view and enable it in "Option handling" check box under 
"Properties > General >  Option handling" in the inspector window.

2. Select the numbered check boxes for the slots that are initially to accommodate the reserve 
modules prior to the future electronics modules.

3. Select the power module in the device view and enable it in the "Option handling" check 
box under "Properties > Addresses" in the inspector window. Reserve the necessary 
address space for the control and check-back interface in the process image output (PIQ) 
and process image input (PII).

The assembled reserve modules can be replaced with the configured modules at a later date 
without having to modify the configuration.

 

 Note

The addresses for these interfaces are reserved as soon as you activate option handling on 
the power module. The "Option handling" function must also be activated on the DP slave 
(IM 151-1 STANDARD Interface Module). If it is not activated, the addresses reserved for the 
control and check-back interface will be released again.

Note that activating and deactivating the option handling function repeatedly can change the 
address of the control and check-back interface.

Option handling may be activated for one PM-E DC24..48V or one PM-E DC24..48V/
AC24..230V Power Module only.

 

Additional information
For additional information on the assignment and significance of bytes within the process 
image, option handling with PROFIBUS and the use of reserve modules, please refer to the 
documentation for the ET 200S distributed I/O system.

How option handling works during startup
If "Startup when expected/actual config. differ" is not available, the ET 200S will still start up 
if a standby module is inserted instead of the configured electronics module and option 
handling has been activated for the slot concerned. 
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How option handling works during operation
During operation, the option handling mode varies in accordance with the following:

● Option handling enabled for a slot: 
Either the standby module (option) or the configured electronics module can be plugged 
into this slot. If any other kind of module is present on this slot, diagnostics will be signaled 
(no module/incorrect module).

● Option handling disabled for a slot: 
Only the configured electronics module can be plugged into this slot. If any other kind of 
module is present, diagnostics will be signaled (no module/incorrect module).

Standby module substitute values
● Substitute value for digital inputs: 0

● Substitute value for analog inputs: 0x7FFF

Control and evaluation in the user program
The ET 200S is equipped with a control and feedback interface for the "Option handling" 
function. 

The control interface is located in the process image output (PIQ). Each bit in this address 
area controls one of the slots from 2 to 63: 

● Bit value = 0: Option handling parameterized. Standby modules are permitted.

● Bit value = 1: Option handling canceled. Standby modules are not permitted on this slot.

The check-back interface is located in the process image input (PII). Each bit in this address 
area provides information about the modules that are actually plugged into slots 1 to 63: 

● Bit value = 0: This slot has the standby module, an incorrect module or no module plugged 
into it.

● Bit value = 1: This slot has the configured module plugged into it.

Configuring the ET 200S in DPV1 mode
PROFIBUS DPV1 enables you to access extended PROFIBUS functions.

Requirement
● You must be in network view.

● A DP master with DPV1 functionality must be available.

● A master-slave connection must be established with PROFIBUS.
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Procedure   
To switch the DP slave over to DPV1, follow these steps:

1. Select the DP slave.

2. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

or

1. Select the DP master.

2. In the I/O communications table, select the row with the connection between the DP master 
and the desired DP slave.

3. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

Special characteristics
The parameters are subject to interdependencies, which are outlined below: 

Parameter DPV0 mode DPV1 mode
Operation when target 
configuration does not match 
actual configuration

Fully available Fully available

Diagnostics interrupt (OB 82) Not available, not set Fully available
Hardware interrupt (OB 40 to 47) Not available, not set Fully available
Insert/remove interrupt (OB 83) Not available, not set Only available when addresses 

are not packed.
"Startup when target 
configuration does not match 
actual configuration" is activated 
automatically along with an 
insert/remove interrupt.

Interrupts in the case of modules with packed addresses  
If the module is capable of triggering interrupts and the bit address is not equal to 0 because 
of packed addresses, you will need to assign a diagnostics address in the ET 200S address 
dialog. 

The diagnostics address is required for the purpose of assigning a DPV1 interrupt to the module 
as an interrupt trigger. The CPU will only be able to assign an interrupt correctly and store 
information on the interrupt in the interrupt OB start information/in the diagnostics buffer if the 
module concerned has this "unpacked" address. In this context, the CPU cannot make use of 
"packed" addresses. 
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From the point of view of interrupt processing (interrupt OB), this means the module will have 
the assigned diagnostics address, but from the point of view of processing the input and output 
data in the user program, the module will have the packed addresses.

 

 Note

When the module addresses are packed, the insert/remove interrupt for the ET 200S is 
unavailable. 

 

Using GSD files

GSD revisions

What you need to know about GSD revisions   
The properties of DP slaves are made available to configuration tools by means of GSD files.

Functional enhancements in the area of the distributed I/O will have an effect on the GSD 
specification, for example, they will require the definition of new keywords.

This results in the versioning of the specification. In the case of GSD files, the version of the 
specification on which a GSD file is based is called a "GSD revision".

From GSD revision 1, the GSD revision must be included as a keyword "GSD_revision" in 
GSD files. GSD files without this keyword will therefore be interpreted by configuration tools 
as GSD revision "0".

GSD files can be interpreted up to GSD revision 5. This means that DP slaves that support 
the following functions, for example, will be supported: 

● Diagnostic alarms for interrupt blocks

● Isochronous mode and constant bus cycle time 

● SYNC/FREEZE

● Clock synchronization for DP slaves

Installing the GSD file

Introduction
A GSD file (device data file) contains all the DP slave properties. If you want to configure a DP 
slave that does not appear in the hardware catalog, you must install the GSD file provided by 
the manufacturer. DP slaves installed via GSD files are displayed in the hardware catalog and 
can then be selected and configured.
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Requirement
● The hardware and network editor is closed.

● You have access to the required GSD files in a directory on the hard disk.

Procedure  
To install a GSD file, proceed as follows:

1. In the "Options" menu, select the "Install device master data files" command.

2. In the "Install device master data files" dialog box, choose the folder in which you want to 
save the GSD files.

3. Choose one or more files from the list of displayed GSD files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new DP slave installed by means of the GSD file in a new folder in the hardware 
catalog.

 

 Note

Installation of GSD file cannot be undone.
 

Configuring GSD-based DP slave
DP slaves that you have inserted through installation of a GSD file can be selected as usual 
via the hardware catalog and inserted in the network view. If you want to insert the modules 
of the GSD-based DP slaves, you must take into account some particular details.

Requirements
● You have installed a DP slave using a GSD file.

● You have inserted the head module in the network view in the usual manner.

● The device overview opens in the device view.

● The hardware catalog is open.

Procedure         
To add the modules of a GSD-based DP slave, proceed as follows:

1. In the hardware catalog, navigate to the modules of the GSD-based DP slave.
GSD-based DP slaves, also referred to as DP standard slaves, can be found in the "Other 
field devices" folder of the hardware catalog.

2. Select the desired module.
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3. Use drag-and-drop to move the module to a free space in the device overview.

4. Select the module in the device overview to edit parameters.

You have now inserted the module in a free slot of the GSD-based DP slave and can edit its 
parameters.

 

 Note

You can see only the GSD-based DP slave in the graphic area of the device view. The added 
modules of GSD-based DP slaves are only found in the device overview.

 

Preset configuration
For modules with an adjustable preset configuration, you can change this configuration in the 
inspector window under "Properties > Preset configuration". 

8.1.4.3 Configurations for PROFINET IO

What you need to know about PROFINET IO

What is PROFINET IO?

PROFINET IO  
PROFINET is an Ethernet-based automation standard of PROFIBUS Nutzerorganisation e.V. 
(PNO) which defines a manufacturer-neutral communication, automation and engineering 
model.

Objective
The objective of PROFINET is:

● Integrated communication via field bus and Ethernet

● Open, distributed automation

● Use of open standards

Architecture
The PROFIBUS User Organisation e.V. (PNO) has designated the following aspects for 
PROFINET architecture:

● Communication between controllers as components within distributed systems.

● Communication between field devices, such as I/O devices and drives.
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Implementation by Siemens
The demand for "Communication between controllers as components within distributed 
systems" is implemented by "Component Based Automation" (CBA). Component Based 
Automation is used to create a distributed automation solution based on prefabricated 
components and partial solutions. 

The demand for "Communication between field devices" is implemented by Siemens with 
"PROFINET IO". Just as with PROFIBUS DP, the complete configuration and programming 
of the components involved is possible using the Totally Integrated Automation Portal. 

The following sections deal with the configuration of communication between field devices 
using PROFINET IO.

Overview of RT classes

RT classes in PROFINET IO   
PROFINET IO is a scalable, real-time communication system based on Ethernet technology. 
The scalable approach is reflected in several real-time classes:

● RT: Transmission of data in prioritized, non-isochronous Ethernet frames. The required 
bandwidth is within the free bandwidth area for TCP/IP communication.

● IRT: Isochronous transmission of data with high stability for time-critical applications (for 
example, motion control). The required bandwidth is from the area of bandwidth reserved 
for cyclic data.

Depending on the device, not all real-time classes are supported. 

Connecting existing bus systems

Connection of PROFINET and PROFIBUS  
PROFINET IO and PROFIBUS DP can be connected with each other as follows: 

● via Industrial Ethernet: 
To connect the two network types, Industrial Ethernet (control level) and PROFIBUS (cell 
level/field level), use e.g. the IE/PB link.

● via Industrial Wireless LAN: 
PROFIBUS devices, for example, can be connected to PROFINET IO via a wireless LAN/
PB link. This allows existing PROFIBUS configurations to be integrated into PROFINET.

AS interface devices can be connected by an IE/AS-i link PN IO to the interface of a PROFINET 
device. This allows the existing AS-i network to be integrated into PROFINET.

The following figure shows the connection of a PROFIBUS subnet via PROFINET device with 
proxy functions. 
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① PROFINET devices
② PROFINET device with proxy functions (for example, IE/PB link)
③ PROFIBUS devices

PROFINET device with proxy functions used as proxy for a PROFIBUS device
The PROFINET device with proxy functions is the proxy for a PROFIBUS device on the 
Ethernet. Proxy functionality allows a PROFIBUS device that can communicate with all devices 
on the PROFINET and not just with its master.

Using PROFINET, existing PROFIBUS systems can easily be integrated into PROFINET 
communication using the proxy functions.

If, for instance, you connect a PROFIBUS device via an IE/PB link to PROFINET, the IE/PB 
link acts as a proxy for the PROFIBUS components to establish communication via PROFINET.

Configuration using IE/PB link PN IO

Configuration using IE/PB link PN IO
Use the IE/PB link IO to connect PROFIBUS DP configurations to PROFINET IO. 

From the CPU perspective, the PROFIBUS DP slaves are connected to the same network as 
the IE/PB link PN IO. These slaves have the same device names and IP addresses as the IE/
PB link PN IO, but different device numbers. Furthermore, each also has a specific PROFIBUS 
address. 

In the properties of the IE/PB link, the PROFIBUS addresses of the connected DP slaves are 
displayed in addition to the PROFINET device numbers, as this device has two addressing 
schemes. 
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Handling device numbers and PROFIBUS addresses on the master system
During placement, the same number is assigned for the PROFINET device number and the 
PROFIBUS address. 

In the inspector window under "General Properties > PROFINET device number", you can find 
an overview of the device numbers used and the PROFIBUS addresses of an IE/PB link. The 
device number can also be changed here. You can also set that the device number and the 
PROFIBUS address should or should not always be identical. If the "PROFINET device 
number=PROFIBUS address" is activated, you do not have to track the device number when 
the PROFIBUS address changes. 

The PROFIBUS addresses can be changed in the properties of the PROFIBUS device.

Restrictions
The following restrictions apply to DP slaves configured as described above on the PROFIBUS 
subnet of an IE/PB link:

● No pluggable IE/PB link

● No pluggable DP/PA link

● No pluggable Y link

● Not CiR-compliant

● No pluggable redundant slaves

● No isochronous transmission / constant bus cycle time can be configured

● SYNC/FREEZE instructions ("DPSYC_FR") of a CPU on the the Ethernet subnet for DP 
slaves behind the IE/PB-Link are not supported.

Configuration using IWLAN/PN link

Maximum number of devices in a IWLAN segment
If an Ethernet subnet is set up as wireless network (IWLAN = Industrial Wireless LAN), cyclic 
data exchange between IO controllers and IO devices is possible via a wireless route. 

On one side of the wireless route there are fixed installed access points (for example, 
SCALANCE W 788) and on the other side mobile stations (with, for example IWLAN/PB links 
with PROFIBUS devices). 

If the action radius of the mobile stations is large, it may be necessary to install several access 
points (SCALANCE W 788). Since each access point forms a segment with its wireless range, 
the IWLAN is made up of a series of segments. 

The mobile devices "on the one side" of the wireless link with their IWLAN/PB links can move 
along the segments.
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Special feature
If several IWLAN/PB links are located within a segment, they have to share the bandwidth that 
is available for wireless transmission. This leads to a lengthening of the update time for these 
devices.

Example
In the following example there are two IO devices (IWLAN/PB link) with a segment. 

If no more than a maximum of two IWLAN/PB links are present in a IWLAN segment at the 
same time, enter a "2".

① Segment 1
② Segment 2
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Configure PROFINET IO 

Addressing PROFINET devices

Assigning addresses and names to PROFINET devices
In this chapter you will learn which address and naming conventions are valid for the 
PROFINET devices.

IP addresses    
All PROFINET devices work with the TCP/IP protocol and therefore require an IP address for 
Ethernet operation. 

You can set the IP addresses in the module properties. If the network is part of an existing 
company Ethernet network, ask your network administrator for this data.

The IP addresses of the IO devices are assigned automatically, usually at CPU startup. 

Device names 
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to administer than complex 
IP addresses. 

Both the IO controller as well as IO devices have a device name. The device name is 
automatically derived from the name configured for the device (CPU, CP or IM):

● The PROFINET device name is made up of the name of the device (for example, the CPU), 
the name of the interface (only with multiple PROFINET interfaces) and optionally the name 
of the IO system:
<CPU name>.<Name of the interface>.<IO system name>
You cannot change this name directly. You change the PROFINET device name indirectly, 
by changing the name of the affected CPU, CP or IM in the general properties of the module. 
This PROFINET device name is also displayed, for example, in the list of accessible 
devices. 

● A "converted name" is generated from the PROFINET device name. This is the device 
name that is actually loaded into the device.
The PROFINET device name is only converted if it does not comply to the rules of IEC 
61158-6-10. You cannot change this name directly either. 

Rules for the converted name
The rules for the converted name are listed in the following section. If the converted name is 
not different from the name of the module, the name of the module must comply with this rule. 

● The name consists of one or more labels , which are separated by a dot [.].

● Total length of the name: 1 to 240 characters

● Length of a label: 1 to 63 characters

● A label consists of the characters [a-z0-9-]
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● Labels should not start or end with the "-" character

● The first label should not start with "port-xyz" or "port-xyz-abcde" (a,b,c,d, e,x,y,z=0-9)

● The name should not have the following form: n.n.n.n (n=0-999)

Example of device names
device-1.machine-1.plant-1.vendor
If you assign this name, to a CPU for example, STEP 7 will not convert it. 

Device number  
In addition to the device name, a device number is also automatically assigned when an IO 
device is plugged in. You can change this number. 

Devices in the PROFINET subnet
In a PROFINET subnet the maximum allowable number of devices is monitored during 
configuration. 

See also
Assigning the device name and IP address (Page 448)

Retentivity of IP address parameters and device names (Page 455)

Assigning the device name and IP address

Assigning an IP address and subnet mask for an IO controller the first time    
There are various options for this: During the configuration of PROFINET interface, you have 
to set the following:

● IP address is set in the project.

● IP address is set using a different method.
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Assign an IP address Comments
Option: Set IP address in the project:
With download hardware configuration

With the downloading of the hardware 
configuration to the IO controller (e.g. CPU), the 
IP address and the device name are also 
downloaded. 

Option: Set IP address in the project: 
Assign online via PROFINET interface

Connect your programming device/PC to the 
same network as the relevant PROFINET device. 
The interface of the PD/PC must be set to TCP/IP 
(Auto) mode. Have a list of accessible devices 
displayed. Select the target device via its MAC 
address and then assign its configured IP address 
before you download the hardware configuration 
including the configured IP address (IP address is 
then saved retentively).

Option: Set IP address in the project: 
Assign online via MPI/PROFIBUS interface

If your PROFINET device has an MPI or 
PROFIBUS DP interface, connect your 
programming device/PC directly to the PROFINET 
device via the MPI or PROFIBUS DP interface. 
The configured IP address is applied during 
download of hardware configuration.

Option "Use different method to obtain IP address" 
● Assign online
● Assign via user program
● Higher-level IO controller (only with I devices)

If you have selected this option in the properties 
of the PROFINET interface, the IP address can be 
assigned by the online and diagnostics editor, by 
the primary setup tool or by the user program 
("IP_CONF" instruction)..
In case of an S7-1200-CPU, make sure that 
access to the CPU is not protected by a password. 
If the CPU is write-protected, no IP address and 
no device name can be assigned by any other 
method.

Commissioning a PROFINET interface 
Further details of how to commission a PROFINET interface can also be found in the operating 
instructions for the PROFINET devices from the SIMATIC family. 

Assigning device names for IO devices when the "Device replacement without removable media/PG" 
option is enabled  

For IO devices where the "Device replacement without removable media/PG" option is 
activated, it is not necessary to assign the device name in the case of a device replacement. 
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Assigning a device name and address for an IO device (exception in the case device exchange without 
media change/PG) 

The following graphic illustrates the process for assigning the device name and address.

① Each device receives a name; STEP 7 automatically assigns an IP address. 
② STEP 7 generates a PROFINET device name from the name. This is then assigned to an IP 

device online (MAC address) and is written into the device. 
③ The configuration is downloaded to the IO controller.
④ The IO controller assigns the appropriate IP address to the IO device with the assigned 

PROFINET device name during startup.

A device name is assigned to each IO device. You can change the name and IP address 
manually.

You have two options for downloading configured data to the PROFINET IO device:
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● Offline with a Micro Memory Card:
Place the configured data (device name: for example, turbo-3) for the IO device in the MMC 
in the PG/PC. Use the command "SIMATIC Card Reader > Save Device Name to Memory 
Card" in the "Project" menu for this.
Then insert the MMC into the IO device. The IO device automatically adopts the configured 
device name.

● Online with programming device/PC:
Connect the programming device/PC directly to the Ethernet subnetwork via the 
PROFINET interface. 
Select the subnet in the network view and then select the "Assign device name" shortcut 
command. 
In the "Assign PROFINET device name" dialog box, select the suitable PG/PC interface to 
connect to the Ethernet subnet.
All configured PROFINET device names are in the top drop-down list. Select a PROFINET 
device name from it and select the IO device to receive this device name from the table at 
the bottom. You can filter the display of devices in the table according to various criteria. 
You can easily identify the device using the "Flash LED" button. 
The IO controller recognizes the IO device by its device name and automatically assigns 
the configured IP address to it.

IP address assignment for special IO devices
Special IO devices, for example, SCALANCE X, S7 300 CPs, support the option of assigning 
the IP addresses not from the IO controller during startup. In this case, the IP address is 
assigned in a different way. For additional information, refer to the manual of the respective 
PROFINET device of the SIMATIC device family.

Requirement for additional procedures when assigning IP address and device name
If the IO device, as described above, should not obtain the IP address or device name from 
the IO controller, proceed as follows:

1. Select device or network view.

2. Open the properties for the respective PROFINET device.

3. Select the "Use different method to obtain IP address" option or "Different method for 
obtaining device name" option.

Rules 
If the "Different method for obtaining IP address / device name" option is used in a PROFINET 
device, note the following: 

● The subnet part of the IP address of the IO device must match the subnet part of the IP 
address of the IO controller.

● The corresponding PROFINET device cannot be used as a router.
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See also
Calling the name assignment function from the project tree or via the "Online" menu 
(Page 614)

Example of the assignment of the device name
In this example you assign device names to a PROFINET IO controller and a PROFINET IO 
device. To make assignment easier, the device names should also contain the names of the 
PROFINET IO system. 

Requirements
● You must be in the network view.

● A CPU 1214C (V2.0 or higher) must be available in the network view.

● An IM 151-3PN is available.

● The PROFINET interfaces of both modules are networked.

Procedure     
To assign the names, follow these steps: 

1. Select the CPU.
Make sure that you have selected only the CPU and not the complete device! 

2. Assign the name "myController" in the Inspector window, under "General".

3. Select the IM.
Make sure that you have selected only the IM and not the complete device ET200S!

4. Assign the name "Device_1" in the Inspector window, under "General".

5. Right-click on the PROFINET IO system and select the "Properties" command.
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6. Assign the name "Plant_section1" to the IO system and select the check box "Use name 
as extension for PROFINET device names".

7. You can find the automatically generated PROFINET device names at the selected device 
in the Inspector window, at "PROFINET interface".

The PROFINET device name corresponds to the name of the module (with the name of 
the IO system as extension) with the difference that only lower case text is used. 
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Background: No distinction is made between upper and lower case ("case insensitive") for 
the storing of the name.
The converted name is displayed below. This is the name that is automatically generated 
from the PROFINET device name and satisfies the DNS conventions. If you work with STEP 
7, you do not require this name. This name is displayed here as a check and corresponds 
to the name that is stored in the device. If you work with other tools that are able to record 
the data exchange and read the actual device names, then you find the converted names. 

Other special features
For PROFINET devices with multiple PROFINET interfaces, the name of the interface is 
attached to the name of the module, separated by a dot. 

Example: 

● Name of the module: myController

● Name of the interface: Interface_1

● PROFINET device name: mycontroller.interface_1

Assign device name via memory card

Introduction
You can configure the device names of PROFINET IO devices offline. To do this, store a 
configured device name on a memory card and then insert the card into the appropriate IO 
device. 

If an IO device has to be completely replaced due to a device defect, the IO controller 
automatically reconfigures the new device. Using the memory card, a device can be replaced 
without a programming device. 

Requirements
● The programming device has a card reader for memory cards.

● The IO device must support the assignment of the device name via memory card.

● The station and its PROFINET IO system is configured.

Procedure
To store a device name on a memory card, follow these steps:

1. Insert the memory card into the card reader.

2. Select the IO device whose device name is to be assigned by the memory card.

3. Select the "Card reader > Save Device Name to Memory Card" command in the "Project" 
menu.
If the memory card is not empty, a message will be issued informing you of this and you 
will have the option to delete the card.
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Retentivity of IP address parameters and device names
The retentivity of IP address parameters (IP address, subnet mask, router setting) and device 
name depends on how the address is assigned. The non-retentive, temporary assignment 
means:

● IP address parameters and device name remain valid for the following time period:

– Until the next POWER OFF

– Until the next bootstrap

– Until termination of the online connection (for example, after downloading the program)
After POWER OFF / POWER ON or a permanent deletion, the CPU can only be 
accessed via the MAC address.

● Loading a temporary IP address also deletes the retentive, saved IP address parameter.

IP address parameters and device name not assign retentively
If the IP address parameters are not retentive, communication can no longer take place after 
the above described events (for example, after POWER OFF/POWER ON) that are based on 
the IP protocol. 

IP address parameters and device name are not retentive in the following case:

● The properties of the PROFINET interface have a setting specifying that the IP address is 
to be obtained by another method.

● The device is a "normal" IO controller and it is specified in the user program ("IP_Conf" 
instruction) that the IP address parameters/device name is not to be retentive.

Non-retentive IP address parameters with an I device:

● If the device is an I device, the IP address is assigned by a higher-level IO controller and 
no prioritized startup is set, no IP address parameters can be assigned retentively via the 
online and diagnostics view. In this case the IP parameters are not retentive.

Recommendation
If possible, use the "Set IP address in project" and specify an appropriate IP address. In this 
case, the IP address is assigned retentively. 
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Resetting the IP address parameters and device names 
Retentive IP address parameters and device names can be reset as follows:

● By "Reset to factory settings" (reset to delivery state with the option of also resetting the IP 
address parameters and the device name)

● Through a Firmware update
 

 
 NOTICE

Consequences of repeated assignment of IP address parameters on top of existing IP 
parameters
● Through the temporary assignment of IP address parameters / device names, a reset 

of retentively saved IP address parameters/device names occurs.
● With a fixed assignment of IP address parameters/device names, previously retentively 

saved parameters are replaced with the newly assigned parameters.
 

 
 NOTICE

Reuse of devices 

Execute the "Reset to factory settings" before you install a device with retentive IP address 
parameters / device names in different subnetworks / systems or before you place it in 
storage.

 

Creating a PROFINET IO system
A PROFINET IO system is comprised of a PROFINET IO controller and its assigned 
PROFINET IO devices. 

To create a PROFINET IO system you require an IO controller (for example, CPU 1214C) and 
one or more IO devices (for example, a head module from the distributed I/O family ET 200S). 

As soon as you connect an IO controller to an IO device, a controller-device link is established.

Procedure  
To create a PROFINET IO system, proceed as follows:

1. Use drag-and-drop to pull an IO controller from the hardware catalog (for example, CPU 
1214C) into the free area of the network view.
The IO controller is created in the project.

2. Use drag-and-drop to move an IO device from the hardware catalog (for example, ET 200S) 
into the free area of the network view.

3. Click on the PROFINET interface of the IO controller or the IO device.

4. Hold down the mouse button and draw a connecting line between this selected interface 
and that of the partner device.
A subnet with an IO system between the IO controller and the IO device is created. 

5. If required, adapt the properties of the Ethernet subnet or the IO controller (for example, IP 
address) under "Properties" in the inspector window.
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Handling PROFINET IO systems
Using shortcut menu commands, you can delete PROFINET IO systems, create new ones or 
even connect the interface to another subnet from within the network view. 

An existing PROFINET configuration can thereby be corrected in the network view. 

Create new PROFINET IO system for IO controller
To create a new PROFINET IO for an IO controller, proceed as follows: 

1. Make sure that no IO system is already assigned to the IO controller. If an IO system is 
already assigned to the IO controller, the "Assign IO system" shortcut menu command is 
disabled.

2. Select the PROFINET interface and then select the "Assign IO system" shortcut menu 
command.

A new PROFINET IO system is created at the IO controller and you can assign IO devices to 
this IO system. 

Disconnecting PROFINET IO devices from PROFINET IO system   
To disconnect an already networked PROFINET IO device from its PROFINET IO system, 
follow these steps:

1. Click on the PROFINET interface of an IO device.

2. Select the "Disconnect from IO system" shortcut menu command.
The IO device that was assigned to this IO system is then no longer assigned to it. 

You can create a new IO systems and can assign each of the non-assigned IO devices to an 
IO controller. 
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Assign PROFINET IO devices to other IO controllers
Existing PROFINET IO systems can be easily reconfigured in the network view: 

1. Select the interface of an IO device and then select the shortcut menu. You have the 
following options here:

– Assign a new subnet to the IO device or disconnect it from the existing subnet

– Assign a new IO controller to the IO device

– Assign a new IO system to the IO device or disconnect it from the existing subnet

2. To assign another IO controller to the IO device, select the "Assign to new IO controller" 
shortcut menu command.
If there is no connection, a subnet is automatically created and the IO device is assigned 
to the IO system of the new IO controller. 

Tip: Quick configuration of IO systems
If the IO system has a lot of IO devices, assign all IO devices placed by drag-and-drop operation 
to an IO controller on one step.

Requirements   
IO controller and IO devices are placed in the network view.

Assign IO devices to an IO system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many IO devices as possible in 
the network view.

2. Arrange the IO devices in not more than of two rows.

3. Select all IO interfaces (not all devices) with the mouse cursor. This only works if you begin 
to drag the mouse cursor outside of the first IO device and release the mouse button at the 
last IO device (selection with the lasso).
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4. Select the shortcut menu "Assign new IO controller" and select the corresponding IO 
interface of the IO controller in the subsequent dialog.

5. The IO devices are automatically networked with the IO controller and combine with it to 
form an IO system.

 

  Note

When an IO system is highlighted, you can double-click on an IO device in the hardware 
catalog and thereby quickly add additional IO devices. Result: The IO device is 
automatically added to the highlighted IO system.

 

 

Interconnecting ports
If an IO device is assigned to an IO controller, this does not yet specify that the ports are 
connected to each other. 

Although a port interconnection is not required to use the PROFINET functions, it does however 
offer the following advantages:

● A setpoint topology is assigned with the port interconnection. Based on an online-offline 
comparison, it is possible to conduct a setpoint-actual comparison with all devices that 
support this function.

● Only with IRT communication: If a port interconnection is configured, STEP 7 can determine 
the required bandwidth more precisely. As a rule, this leads to a higher performance.

Make sure that no invalid ring structures occur through the interconnection of ports. 

Port interconnection is only advisable for devices that support the topology configuration. 
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Interconnecting ports in the Inspector window  
To interconnect ports, follow these steps: 

1. Select the PROFINET device or the PROFINET interface.

2. Navigate to the port property "Port interconnection".
When the PROFINET interface is selected, you can find this setting in the Inspector window 
as follows: Properties > General > Advanced Options > Port [...] > Port Interconnection. 

3. In the "Local port" section, you can find the settings at the local port. In the case of fiber-
optic cable you can, for example, set the cable names here.
In the "Partner port" section, click on the black triangle in the "Partner port" box to display 
and select the available partner ports. 

4. If the port interconnection is a port interconnection with copper as medium and the devices 
support IRT communication, you can also set cable length and signal transit time.

If the PROFINET interface was not networked, it is automatically networked by this action. In 
the properties of the subnet you can set whether this subnet should or should not be used for 
the networking. 

Setting the send clock

Shortest possible update interval for send clock
The send clock indicates the time between two consecutive communication cycles. It is the 
shortest possible transmission interval in data exchange. The update times are calculated as 
multiples of the send clock cycle.

Requirements to change the send clock at the PROFINET device
No IRT (Isocronous Realtime) should be configured. In detail, this means: 

● No device must be configured at the IO system as a sync-slave or sync-master.

● All devices at the IO system must be unsynchronized.

Procedure
To set the send clock, proceed as follows:

1. Select the PROFINET IO controller in the device or network view.

2. Change the value for "Shortest possible update interval for send clock" in the properties of 
the PROFINET interface under "PROFINET Interface > Advanced options > Realtime 
settings > IO communication".

The send clock is valid for all PROFINET devices at the IO system. If the synchronization role 
is set to a value other than "Unsynchronized", you can only set the send clock in the sync 
domain, in other words, centrally at the PROFINET IO system. 
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Setting the update time

Update time  
An IO device / IO controller in the PROFINET IO system is supplied with new data from the 
IO controller / IO device within this time period. The update time can be separately configured 
for each IO device and determines the time interval in which data is transmitted from the IO 
controller to the IO device (outputs) as well as data from the IO device to the IO controller 
(inputs).

STEP 7 calculates the update time automatically in the default setting for each IO device of 
the PROFINET IO system, taking into account the volume of data to be exchanged as well as 
the set send clock. 

Setting the update time
If you do not want to have the update time calculated automatically, you can change the setting.

To change the update time, proceed as follows:

1. Select the PROFINET interface of the IO device in the network or device view.

2. Change the update time in the interface properties under "Advanced options > Realtime 
settings > IO cycle".

– To have a suitable update time calculated automatically, select "Automatic".

– To set the update yourself, select "Can be set" and enter the required update time in 
ms.

3. To ensure consistency between the send clock and the update time, activate the "Adapt 
update time when send clock changes" option.
This option ensures that the update time is not set to less than the send clock. 

Non-automatic setting of the send clock may result in errors if the available bandwidth is 
insufficient or if other limits are exceeded (for example, too many devices are configured). 

Setting the watchdog time

Watchdog time 
You can configure the watchdog time for PROFINET IO devices. 

If the IO device is not supplied with input or output data (IO data) by the IO controller within 
the watchdog time, it switches to the safe state. 

Do not enter the watchdog time directly, but as "Accepted number of update cycles when IO 
data is missing". This makes setting easier because the update time can be shorter or longer, 
depending on the power of the IO device or the setting. 

The resulting watchdog time is automatically calculated from the "Accepted number of update 
cycles when IO data is missing". 
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Configuring the watchdog time
To specify the watchdog time, follow these steps:

1. Select the PROFINET interface of the IO device in the network or device view.

2. In the properties of the interface, navigate to "Advanced options > Realtime settings > IO 
cycle".

3. Select the required number of cycles from the drop-down list "Trigger watchdog after # 
cycles with missing IO data". 

The watchdog time is subsequently calculated automatically based on the preset factor. It must 
not be more than 1.92 seconds.

 

 Note

The default setting should only be changed in exceptional cases, for example, during the 
commissioning phase.

 

Calculated bandwidth for cyclic IO data

Calculated bandwidth for cyclic IO data
Adherence to the maximum available bandwidth for cyclic IO data is monitored by the system. 
The maximum bandwidth depends on the send clock cycle. If the send clock cycle is greater 
than or equal to 1 ms, the maximum bandwidth is 0.5 ms. If the send clock cycle is shorter, 
the maximum available bandwidth is also reduced.

The bandwidth actually required for cyclic IO data is determined by the system based on the 
number of configured IO devices and IO modules. Furthermore, the required bandwidth 
depends on the update time that is used.

In general, the calculated bandwidth increases in the following cases:

● There is a greater number of IO devices

● There is a greater number of IO modules

● The update times are shorter.

Maximum bandwidth for cyclic IO data depending on the send clock
The following table shows how the maximum available bandwidth for cyclic IO data reacts 
based on the send clock:

Send clock cycle Maximum bandwidth for cyclic IO data
250 µs – 468.75 µs << 125 µs
500 µs – 968.75 µs = send clock / 2
1 – 4 ms = 500 µs
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Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission medium/duplex       
Depending on the selected device, you can make the following settings for "Transmission 
medium/duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option     
This option is used to activate or deactivate the port diagnostics. Examples of port diagnostics: 
The link status is monitored, in other words, the diagnostics are generated during link-down 
and the system reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "     
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.
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You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 

 

Wiring rules for disabled autonegotiation

Requirement
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission speed

● Autonegotiation incl. autocrossing disabled

This saves you the time required to negotiate the transmission rate during startup.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation        
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
464 System Manual, 08/2011,  



Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

Enabling device replacement without exchangeable medium

Replacing an IO device without exchangeable medium    
Replacement of IO devices is frequently required in automation systems. The IO devices are 
generally assigned a device name by either inserting an exchangeable medium or via the 
programming device. The CPU identifies the IO device by using these device names.

Replacing an IO device can be done without inserting an exchangeable medium (e.g. memory 
card) or without the programming device, under certain circumstances. For this purpose the 
Ethernet mechanism analyzes the relationship between the individual IO devices and the IO 
controller. From these relationships which are stored in the IO controller, the IO controller 
recognizes which IO device was replaced and assigns a device name to the new device.

Requirements
● A port interconnection is already configured.

● The affected IO devices in the automation system must support device replacement without 
exchangeable medium.
If the individual IO devices in the automation system do not support device replacement 
without exchangeable medium, a corresponding message is output for the IO device.

 

  Note

Use only new IO devices as replacements or restore configured IO devices to their delivery 
state.

 

Procedure
In order to enable the replacement of an IO device without exchangeable medium, proceed 
as follows:

1. In the device, select the device or network view of the PROFINET interface in the 
corresponding IO controller.

2. In the interface properties under "Advanced settings > Interface options", select the "Allow 
device replacement without exchangeable medium"
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See also
Components with the the device replacement without exchangeable medium function (http://
support.automation.siemens.com/WW/view/en/36752540)

Using GSDML files

GSD files for IO devices

Basic information on GSD files of IO devices      
The properties of PROFINET IO devices are not stored in a keyword-based text file (as for 
PROFIBUS DP slaves), but in an XML file whose structure and rules are determined by a 
GSDML scheme.

The language used to describe the GSD files is GSDML (Generic Station Description Markup 
Language). It is determined by the GSDML scheme. The following sections therefore refer to 
GSDML files.

A GSDML scheme contains validation rules that allow it, for example, to check the syntax of 
a GSDML file. GSDML schemes (as scheme files) are acquired by IO device manufacturers 
from PROFIBUS International.

Functional enhancements in the area of PROFINET IO will have an effect on the GSDML 
specification and the corresponding scheme. A new version of the specification and of the 
scheme is created by the functional enhancement.

Names of GSDML files for IO devices
The name of a GSDML file for IO devices can, for example, be as follows:

"GSDML-V1.0-Siemens-ET200S-20030616.xml"

Name component Explanation
GSDML String at the start of each GSDML file for IO 

devices
V1.0 Version of the GSDML scheme
Siemens Manufacturer
ET200S Name of the device
20030616 Version code (date)
.xml File extension

Versioning of GSDML files for IO devices
The version information of GSDML files is in two parts: 

First, the version of the GSDML scheme is indicated. This determines the scope of language 
used by a GSDML file. 
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This is followed by the version, listed as an issue date. The version of GSDML files is 
incremented, for example, after troubleshooting or if a functional enhancement was added. 

Functional enhancements may result in a new version of the GSDML scheme. A new version 
of a GSDML scheme might only be supported with restrictions.

Installing the GSDML file

Introduction
A GSDML file (device data file) contains all the IO device properties. If you want to configure 
an IO device that is not available in the hardware catalog, you must install the GSDML file 
provided by the manufacturer. IO devices installed via GSDML files are displayed in the 
hardware catalog and can then be selected and configured.

Requirements
● The hardware and network editor is closed.

● You have access to the required GSDML files in a directory on the hard disk.

Procedure     
To install a GSDML file, follow these steps:

1. In the "Options" menu, select the "Install device master data files" command.

2. In the "Install device master data files" dialog box, choose the folder in which you want to 
save the GSDML files.

3. Choose one or more files from the list of displayed GSD- and GSDML files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new IO devices installed by means of the GSDML files in a new folder in the 
hardware catalog.

 

 Note

You cannot undo the installation of an GSDML file.
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Changing the version of a GSDML file

Changing the revision of a GSD file   
You can change the revision of a GSD file for an IO device:

● Only for the current IO device

● All suitable IO devices within the IO system

● All suitable IO devices within the complete project

First, all existing GSD files for the current IO device are shown. The only difference between 
the GSD files shown is their revision status. The currently used GSD file is highlighted.

Requirements
● The I/O data is the same for all IO devices whose revision is to be changed.

● The order number has not changed.

● The number of submodules is identical.

● The configuration data has not changed.

● There must be no module or submodule in a slot that is invalid after the new GSD file has 
been created.

Procedure
To change the revision of one or more IO devices, proceed as follows:

1. Select the IO device whose GSD file revision is to be changed.

2. Click on the "Change revision" button under "General> Catalog information" in the 
properties of the IO device.
The "Change revision" dialog box opens.

3. Select the GSD revision you want to use in the "Available revisions" table.

4. Under "Use selected revision for", select the devices whose version are to be changed:

– Only for the current IO device

– For all suitable IO devices in the IO system

– For all suitable IO devices in the project

5. Click the "Apply" button.
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8.1.4.4 Bus coupling with PN/PN coupler

Application and function

Application  
The PN/PN coupler is used to link two Ethernet subnets with one another and to exchange 
data. That way use data about input or output address areas or datasets can be used. The 
maximum size of the transferable input and output data is 1024 bytes. The division into input 
and output data is preferable, so that e.g. 800 byte input data and 200 byte output data can 
be configured.

As a device, the PN/PN coupler has two PROFINET interfaces, each of which is linked to one 
subnet.

In the configuration, two IO Devices are produced from this one PN/PN coupler which means 
that there is one IO Device for each station with its own subnet. The other part of PN/PN coupler 
in each case is known as the bus node. Once configuring is complete, the two parts are joined.

 

Figure 8-1 Coupling two PROFINET IO subnets with one PN/PN coupler

Additional information
For additional information on "PN/PN couplers", refer to Service & Support on the Internet 
(http://support.automation.siemens.com/WW/view/en/44319532).

Linking Ethernet subnets

Linking Ethernet subnets with a PN/PN coupler
You can link Ethernet subnets with the standard device PN/PN coupler.  

To link Ethernet subnets, follow these steps:

1. Create your Ethernet subnets.

2. Select the standard field devices in the hardware catalog. Find the PN/PN coupler as head 
module in the "PROFINET IO" folder.
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3. In the network view, drag the two components X1 and X2 to the required version of the PN/
PN coupler per drag-and-drop operation. The components form a device, but are shown 
separately to make handling easier.

4. Connect the Ethernet interface of the PN/PN coupler X1 to the first Ethernet subnet.

5. Connect the Ethernet interface of the PN/PN coupler X2 to the second Ethernet subnet.
The Ethernet subnets are now linked through the two components of the PN/PN coupler.

8.1.4.5 Configurations using external tools

Integrating S7-external tools

Introduction
Tools external to STEP 7 ("Device Tools") with a special call interface (Tool Calling Interface) 
can be used to configure distributed devices. Such devices are also referred to as "TCI 
capable". 

The performance range of these tools exceeds the possibilities provided within GSD 
configuration, for example, they can provide expanded graphical input options.    

Distributed devices can be as follows:

● PROFIBUS DP slaves

● Modules within a DP slave

● PROFINET IO devices

● Modules within an IO device

Requirements
The call interface of the tool complies with the TCI specification. Parameters and commands 
are forwarded to the distributed device via this call interface. 
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Such tools have to be installed using a setup provided by the manufacturer. The "S7-PCT" 
(Port Configuration Tool) device tool for IO-Link modules is an exception; this is supplied with 
STEP 7. Special feature: After the installation, the tool is not shown in the list of installed 
software or in the list of software products in the project. 

The GSD or GSDML file of the distributed device, which has to be configured with the device 
tool, has to be installed. 

Starting the device tool
You can find the command to start the device tools as follows:

● Menu command "Edit > Start device tool" in the device view.

● "Start device Tool" in the shortcut menu of a TCI-enabled device.

See also
Example of a device tool (Page 472)

Example of a device tool

Introduction  
The "S7-PCT" (Port Configuration Tool) device tool is installed with STEP 7.

The tool is used to assign parameters to the IO link ports of modules such as 4SI IO-Link (ET 
200S) or 4IOL+8DI+4DO (ET 200eco PN). 

Requirements
You have configured the corresponding DP slave or the corresponding IO device.

Starting S7-PCT 
For a ET 200S with 4SI IO-Link, for example, follow these steps:

1. Select the module in the device view.

2. Select "Edit > Start device tool" from the shortcut menu.
The tool starts and you can configure the ports. 
Alternatively, you can also start from the device view (see next section). 

For a ET 200eco PN with 4IOL+8DI+4DO, follow these steps:

1. Select the module in the device view.

2. Arrange the areas in the work area in such a way that the device overview is visible (is 
located between device view and Inspector window).

3. Select the row with the IO link in the device overview.

4. Select "Edit > Start device tool" from the shortcut menu.
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See also
Integrating S7-external tools (Page 471)

8.1.4.6 Loading a configuration

Introduction to loading a configuration
To start a device, identical configurations must be stored on the PG/PC as well as on the 
connected devices. Download a configuration to compare the PG/Pc and the connected 
devices. Configuration data can generally be downloaded in two directions:

● Download configuration from PG/PC in a device

● Download configuration from a device to the PG/PC

See also
Downloading a configuration to a device (Page 473)

Downloading a configuration to the PG/PC (Page 474)

Special features during startup (Page 480)

Downloading a configuration to a device

Downloading the hardware configuration
After you have inserted a new device in the project and configured it or if you have modified 
an existing hardware configuration, the next step is to load the current configuration on the 
device. This makes sure that the same configuration is set on the programming device/PC as 
well as on the physical module.

The first time you load, the entire hardware project data is loaded. When you load again later, 
only changes to the configuration are loaded.

You have the following options when loading the hardware configuration:

● Loading in the device or network view

● Loading in the project tree

● Loading on an accessible device
 

 WARNING

Load only in STOP mode

After loading, you may experience unexpected behaviors on the machine or in the process 
if the parameter settings are incorrect. The CPU must be set to STOP mode for the download 
operation to rule out possible damage to equipment or personal injury.
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Downloading a configuration to the PG/PC

Introduction
If you have connected a new device to a PG/PC but have not yet inserted the device into the 
project, you can transfer the complete configuration from the newly connected device to the 
PG/PC. The device is thereby created in the project.

A device is always downloaded via the list of accessible devices in the project tree. You can 
download several devices into the project by selecting them accordingly. A configuration can 
be downloaded several times. A new device is created on each download, even if the device 
has already been downloaded.

Requirements
● The original hardware configuration must be created in TIA-Portal V11.

● The opened project is in offline mode.

Scope of download
The following list presents an exact overview of the parts of the configuration that are 
transferred:

● Device parameters
All set parameters of the module are transferred.

● PROFIBUS master systems and all PROFIBUS-relevant settings
A DP master system and all connected slaves are inserted into the project. The respective 
settings remain unchanged. If a suitable PROFIBUS subnet has already been created, the 
downloaded modules are connected to the PROFIBUS interface at the existing subnet.

● PROFINET IO systems and all PROFINET-relevant settings
The devices with IO controllers, all IO systems as well as all IO devices are transferred into 
the project. Settings and topologies are also transferred.
If there already is a suitable Ethernet network in the project, the downloaded devices are 
integrated into the existing network.
Relations between IO controllers and IO devices are only established within the project if 
both the IO controller as well as the I device are downloaded to the PG. It is unimportant 
whether you download the IO controller or the I devices first.

● I devices and I slaves
Master-slave relations between the I slave and assigned DP master are only established 
in the project if both the master as well as the I slave are downloaded to the PG. It is 
unimportant whether you download the master system or the I devices and I slaves first. 
As soon as both devices are downloaded, the connections are also established.

● Direct data exchange
The configuration of a direct data exchange between two devices can also be downloaded 
into the project. You must download both partners one after the other to do this.
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● S7 connections
S7 connections are automatically accepted as configured at one end when downloading a 
device configuration, even if the S7 connection was configured at both ends in the original 
project. Once both connection partners are downloaded, the connection is once again 
linked together during the next compiling procedure.

● Bus parameter
Downloaded bus parameters initially differ from the settings in the original project after 
downloading a single device. The bus parameters only match those of the original project 
after all devices involved are downloaded and there are no additional devices on the same 
bus.

● An I/O module associated with the CPU 
After downloading a CPU, all other modules within the address area of the CPU are also 
downloaded.

8.1.5 Additional information on configurations

8.1.5.1 Functional description of S7-1200 CPUs

Operating modes

Principles of the operating modes of S7-CPUs

Introduction  
Operating modes describe the behavior of the CPU. The following operating modes are 
possible:

● STARTUP

● RUN

● STOP

In these operating modes, the CPU can communicate via the PN/IE interface, for example.
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Other operating modes
If the CPU is not ready for operation, it is in one of following two operating modes:

● Deenergized, i.e. the supply voltage is switched off.

● Defective, which means an internal error has occurred.
If the "Defective" status is caused by a firmware error, this state is indicated by the status 
LEDs of the CPU (refer to the description of the CPU). To find out the cause, follow these 
steps:

– Turn the power supply switch off and on again.

– Read out the diagnostics buffer when the CPU starts up and send the data for analysis 
to Customer Support.

If the CPU does not start up, replace it.

See also
STOP mode (Page 481)

RUN mode (Page 481)

Operating mode transitions

Overview  
The following figure shows the operating modes and the operating mode transitions of S7-1200 
CPUs:

The following table shows the conditions under which the operating modes will change:

No. Operating mode transition Conditions
① STOP After you turn on the power supply, the CPU is in "STOP" mode. It then determines 

the required type of startup and changes to the next operating mode.
② STOP → STARTUP If the hardware configuration and the program blocks are consistent, the CPU 

changes to "STARTUP" mode in the following situations:
● The CPU is set to "RUN" from the programming device.
● After automatic triggering of a STARTUP operating mode by "POWER-ON".

③ STARTUP → STOP The CPU returns to the "STOP" mode in the following situations:
● An error is detected during startup.
● The CPU is set to "STOP" from the programming device.
● A STOP command is executed in the STARTUP OB.
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No. Operating mode transition Conditions
④ STARTUP → RUN If the STARTUP is successful, the CPU switches to "RUN".
⑤ RUN → STOP The CPU returns to the "STOP" mode in the following situations:

● An error is detected that prevents continued processing.
● The CPU is set to "STOP" from the programming device.
● A STOP command is executed in the user program.

 

"STARTUP" operating mode

Principles of the STARTUP mode

Function   
After turning on the CPU, it executes a startup program before starting to execute the cyclic 
user program. 

By suitably programming startup OBs, you can specify certain initialization variables for your 
cyclic program in the startup program. There is no rule in terms of the number of startup OBs. 
That is, you can set up one or several startup OBs in your program, or none at all.

Parameter settings for startup characteristics
You can specify whether the CPU remains in STOP mode or whether a warm restart is run. 
Over and above this, you can set the response during startup (RUN or previous mode) in the 
"Startup" group of the CPU properties.

Special characteristics
Note the following points regarding the "STARTUP" mode:

● The startup OBs are executed. All startup OBs you have programmed are executed, 
regardless of the selected startup mode.

● No time-based program execution can be performed.

● Interrupt controlled program execution limited to:

– OB 82 (diagnostics interrupt)

● The outputs on the modules are disabled.

● The process image is not updated; direct I/O access to inputs is possible.
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See also
Editing properties and parameters (Page 309)

Principles of the operating modes of S7-CPUs (Page 475)

Organization blocks for startup (Page 520)

Warm restart (Page 478)

Warm restart

Function
During a warm restart, all non-retentive bit memory is deleted and non-retentive DB contents 
are reset to the initial values from load memory. Retentive bit memory and retentive DB 
contents are retained. 

Program execution begins at the call of the first startup OB.

Triggering a warm restart   
You can trigger a "Warm restart" using a corresponding menu command on your programming 
device in the following situations:

● The CPU must be in "STOP" mode.

● After a memory reset

● After downloading a consistent program and a consistent hardware configuration in the 
"STOP" mode of the CPU.

"POWER ON" triggers a "warm restart" if you have set the following parameters for the startup 
response:

● Startup type "warm restart - RUN" (regardless of the CPU operating mode prior to POWER 
OFF).

● "Warm restart - mode prior to POWER OFF" (depending on the CPU operating mode prior 
to POWER OFF. The CPU must have been in RUN mode prior to this.)

See also
Retentive memory areas (Page 486)
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Startup activities

Overview  
The following table shows which activities the CPU performs at STARTUP:

Activities in execution sequence At warm restart
Clear non-retentive bit memories Yes
Clear all bit memories No
Clear the process image output Yes
Processing startup OBs Yes
Update the process image input Yes
Enable outputs after changing to "RUN" mode Yes

Sequence
The following figure shows the activities of the CPU in "STOP", "STARTUP", and "RUN" modes.

You can use the following measures to specify the state of the I/O outputs in the first cycle of 
the user program:

● Use assignable output modules to be able to output substitute values or to retain the last 
value.

● Set default values for outputs in startup OBs.

During the startup, all interrupt events are entered in a queue so that they can be processed 
later during RUN mode. In RUN mode, hardware interrupts can be processed at any time.
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Special features during startup

Response when expected and actual configurations do not match 
The expected configuration is represented by the engineering configuration loaded on the 
CPU. The actual configuration is the actual configuration of the automation system. 

If the expected configuration and actual configuration differ, the CPU nevertheless initially 
changes to RUN.

Canceling a STARTUP
If errors occur during startup, the startup is canceled and the CPU remains in "STOP" mode. 

Under the following conditions, a startup will not be performed or will be canceled:

● If an invalid SD card is inserted.

● If no hardware configuration has been downloaded.
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See also
Overview of the CPU properties (Page 496)

RUN mode

Function   
In "RUN" mode the cyclic, time-driven, and interrupt-driven program sections execute:

● The process image output is read out.

● The process image input table is read.

● The user program is executed.

Active data exchange between S7-1200 CPUs by means of Open User Communication is only 
possible in "RUN" mode.

Running the user program
Once the CPU has read the inputs, the cyclic program runs from the first to the last instruction. 

If you have configured a minimum cycle time, the CPU will not end the cycle until this minimum 
cycle time is up even if the user program is completed sooner. 

A maximum cycle time is set which you can adjust according to your requirements. This 
ensures that the cyclic program is completed within a specified time. The system will respond 
with a time error if the cyclic program is not completed within this time. 

Other events such as hardware and diagnostic interrupts can interrupt the cyclic program flow 
and prolong the cycle time. 

See also
Principles of the operating modes of S7-CPUs (Page 475)

Events and OBs (Page 489)

STOP mode

Function   
In "STOP" mode, the user program is not executed. All outputs are disabled or react according 
to the parameter settings: They provide a substitute value as set in the parameters or retain 
the last value output and bring the controlled process to a safe status. 

The CPU checks the following points:

● Hardware, for example whether are all modules are available

● Whether the default settings for the CPU are applicable or parameter sets are present

● Whether the general conditions for the programmed startup behavior are correct
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See also
Principles of the operating modes of S7-CPUs (Page 475)

Basics of a memory reset

Function 
A memory reset on the CPU is possible only in STOP mode.

When memory is reset, the CPU is changed to an "initial status". This means:

● The content of the work memory and the retentive and non-retentive data are deleted.

● The load memory (code and data blocks) is then copied to work memory. As a result, the 
DBs no longer have current values but their initial values.

● An existing online connection between your programming device/PC and the CPU is 
terminated.

● The diagnostics buffer, the time, the IP address, the hardware configuration and active 
force jobs are retained.

 

Memory areas

Things you should know about memory cards

How the memory card functions    
The SIMATIC Memory Card for a S7-1200 is an SD memory card preformatted by Siemens 
for the CPU user program. 

You may only delete files and folders. If you format the memory card with Windows, for example 
with a commercially available card reader, you make the memory card unusable as a storage 
medium for a S7-CPU.

Setting the card type  
You can use the memory card as a transfer card, a program card or a firmware update card.
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To set the card type, insert the memory card in the programming device's card reader and 
select the "SIMATIC card reader" folder from the project navigation. In the properties of the 
selected memory card, designate the card type:

● Program
If it is used as a program card, you can load the user program on the memory card. In this 
case, the internal load memory of the device is replaced by the memory card and the internal 
load memory is erased. The user program is then fully executable from the memory card. 
If the memory card with the user program is removed, there is no longer a program available.

● Transfer
If it is used as a transfer card, you can transfer the user program from the memory card to 
the internal load memory of the CPU. You can then remove the memory card again. 

● Firmware card
Firmware for the S7-1200 modules can be stored on a memory card. Therefore it is possible 
to perform a firmware update with the help of a specifically prepared memory card. Likewise, 
a backup copy of firmware for a module can be stored on a memory card.

Transferring objects from the project to a memory card
When the memory card is inserted in the programming device or in an external card reader, 
you can transfer the following objects from the project tree to the memory card: 

● Individual blocks (multiple selection possible)
In this case a consistent transfer is available, as the dependencies of the blocks to each 
other is taken into account with block selection. 

● PLC
In this case, all objects relevant to processing are transferred, such as blocks and the 
hardware configuration on the memory card, just as with downloading.

To perform a transfer, you can move the objects by dragging and dropping, or use the 
command "Write to memory card" in the "Project" menu. 

Transferring objects from the memory card to the project
You can transfer Individual blocks (multiple selection is possible) by dragging them to the 
project. A hardware configuration cannot be transferred from the memory card to the project.

Updating firmware with a memory card
You can get the latest firmware data on the internet from the Service & Support pages: 

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/view/en/
34143537)

Store the firmware data on the hard drive.

To store the data on the micro memory card, select the command "SIMATIC Card Reader > 
Create Firmware-Update Memory Card" in the "Project" menu. 

Then follow the instructions in the Service & Support portal for performing a firmware update 
with your CPU.
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Updating the firmware changes the CPU firmware status. If you have used the CPU in the 
project, you will have to update the CPU already configured to the CPU with the new firmware 
status by changing devices offline, and adapt and then load the program or configuration. 

See also
Replacing a hardware component (Page 308)

Load memory

Function    
Each CPU has an internal load memory. The size of this internal load memory depends on the 
CPU used. 

This internal load memory can be replaced by using external memory cards. If there is no 
memory card inserted, the CPU uses the internal load memory; if a memory card is inserted, 
the CPU uses the memory card as load memory. 

The size of the usable external load memory cannot, however, be greater than the internal 
load memory even if the inserted SD card has more free space. 

Work memory

Function    
Work memory is a non-retentive memory area for storing elements of the user program that 
are relevant for program execution. The user program is executed exclusively in work memory 
and system memory.

System memory

System memory areas

Function                         
System memory contains the memory elements that each CPU makes available to the user 
program, such as the process image and bit memory. 

By using appropriate operations in your user program, you address the data directly in the 
relevant operand area. 

The following table shows the operand areas of the system memory:
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Operand area Description Access via units of the following size: S7 notation
Process image output The CPU writes the values 

from the process image 
output table to the output 
modules at the start of the 
cycle.

Output (bit) Q
Output byte QB
Output word QW
Output double word QD

Process image input The CPU reads the inputs 
from the input modules and 
saves the values to the 
process image input table at 
the start of the cycle.

Input (bit) I
Input byte IB
Input word IW
Input double word ID

Bit memory This area provides storage 
for intermediate results 
calculated in the program.

Bit memory (bit) M
Memory byte MB
Memory word MW
Memory double word MD

Data block Data blocks store 
information for the program. 
They can either be defined 
so that all code blocks can 
access them (global DBs) or 
assigned to a specific FB or 
SFB (instance DB).
Requirement: The block 
attribute "Optimized block 
access" is not enabled.

Data bit DBX
Data byte DBB
Data word DBW
Data double word DBD

Local data This area contains the 
temporary data of a block 
while the block is being 
processed. 
Requirement: The block 
attribute "Optimized block 
access" is not enabled.
Recommendation: Access 
local data (temp) 
symbolically.

Local data bit L
Local data byte LB
Local data word LW
Local data double word LD

I/O input area The I/O input and output 
areas permit direct access to 
central and distributed input 
and output modules.

I/O input bit <tag>:P
I/O input byte
I/O input word
I/O input double word

I/O output area I/O output bit
I/O output byte
I/O output word
I/O output double word

See also
Diagnostics buffer (Page 488)

Basic principles of process images (Page 486)

Access to the I/O addresses (Page 489)
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Retentive memory areas

Retentive memory areas   
Data loss after power failure can be avoided by marking certain data as retentive. This data is 
stored in a retentive memory area. A retentive memory area is an area that retains its content 
following a warm restart, in other words, after cycling the power when the CPU changes from 
STOP to RUN. 

The following data can be assigned retentivity:

● Bit memory: The precise width of the memory can be defined for bit memory in the PLC tag 
table or in the assignment list.

● Tags of a function block (FB): You can define individual tags as retentive in the interface 
of an FB if you have enabled optimized block access. Retentivity settings can be defined 
only in the assigned instance data block if optimized block access has not been activated 
for the FB.

● Tags of a global data block: You can define retentivity either for individual or for all tags of 
a global data block depending on the settings for access.

– Block with optimized access: retentivity can be set for each individual tag.

– Block with standard access: The retentivity setting applies to all tags of the DB; either 
all tags are retentive or no tag is retentive.

See also
Warm restart (Page 478)

process image input/output

Basic principles of process images

Function
When the user program addresses the input (I) and output (O) operand areas, it does not query 
or change the signal states on the digital signal modules. Instead, it accesses a memory area 
in the system memory of the CPU. This memory area is referred to as the process image.

Advantages of the process image
Compared with direct access to input and output modules, the main advantage of accessing 
the process image is that the CPU has a consistent image of the process signals for the 
duration of one program cycle. If a signal state on an input module changes during program 
execution, the signal state in the process image is retained until the process image is updated 
again in the next cycle. The process of repeatedly scanning an input signal within a user 
program ensures that consistent input information is always available.

Access to the process image also requires far less time than direct access to the signal modules 
since the process image is located in the internal memory of the CPU.
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Updating the process images

Sequence 
The operating system updates the process images at cyclic intervals unless defined otherwise 
in your configuration. The process image input/output is updated in the following order:

1. The internal tasks of the operating system are performed.

2. The process image output (PIQ) table is written to the outputs of the module.

3. The status of inputs is read to the process image input (PII) table.

4. The user program is executed with all the blocks that are called in it.

The operating system automatically controls the writing of the process image output to the 
outputs of the modules and the reading of the process image input.

Special characteristics
You have the option of accessing inputs or outputs directly using direct I/O access. 

● If an instruction accesses an output directly and the output address is located in the process 
image output, the process image of the relevant output is updated.

● If an instruction accesses an output directly and the output address is not located in the 
process image output, the process image of the relevant output is not updated.

Example of normal I/O access by way of the process image

Update QW10 in the I/O output area with the value from MW0.

I/O access error during process image updating
If an error occurs while updating the process image (I/O access error), the CPU reacts with 
the default system reaction "STOP". 

See also
Start address of a module (Page 488)

Access to the I/O addresses (Page 489)

Startup activities (Page 479)
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Diagnostics buffer

Function   
The diagnostics buffer is part of the system memory of the CPU. It contains the errors detected 
by the CPU or modules with diagnostics capability. It includes the following events:

● Every mode change of the CPU (for example, POWER UP, change to STOP mode, change 
to RUN mode)

● Every diagnostics interrupt

The diagnostics buffer of the S7-1200-CPU has a capacity of 50 entries of which the last (most 
recent) 10 entries are retained following power cycling. 

Those entries can only be cleared by restoring the CPU to factory defaults.

You can read the content of the diagnostics buffer with the help of the Online and Diagnostics 
view.

See also
Basic information on the diagnostics buffer  (Page 615)

I/O data area

Start address of a module

Definition 
The start address is the lowest byte address of a module. It acts as the initial address of the 
module user data area. 

Configuring module start addresses 
The addresses used in the user program and the module start addresses are coordinated 
when the modules are configured. 

In the module properties ("I/O addresses" group), you can change the start addresses that 
were assigned automatically after the modules were inserted. 

You can also make a setting that decides whether or not the addresses are located in the 
process image. 
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Access to the I/O addresses

I/O addresses               
If you insert a module in the device view, its user data is located in the process image of the 
S7-1200-CPU (default). The CPU handles the data exchange between the module and the 
process image area automatically during the update of the process images. 

Append the suffix ":P" to the I/O address if you want the program to access the module directly 
instead of using the process image. 

This could be necessary, for example, during execution of a time time-sensitive program which 
also has to control the outputs within the same cycle. 

Basics of program execution

Events and OBs

Events and OBs
The operating system of S7-1200-CPUs is based on events. There are two types of events:

● Events which can start an OB

● Events which cannot start an OB

An event which can start an OB triggers the following reaction:

● It calls the OB you possibly assigned to this event. The event is entered in a queue according 
to its priority if it is currently not possible to call this OB.

● The default system reaction is triggered if you did not assign an OB to this event.

An event which cannot start an OB triggers the default system reaction for the associated event 
class.

The user program cycle is therefore based on events, the assignment of OBs to those events, 
and on the code which is either contained in the OB, or called in the OB.

The following table provides an overview of the events which can start an OB, including the 
associated event classes and OBs. The table is sorted based on OB priority. Priority class 1 
is the lowest.
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Event class OB no. Number of 
OBs

Start event OB priority

Cyclic program 1, >= 200 >= 1 Starting or end of the last cyclic OB 1
Startup 100, >= 

200
>=0 STOP to RUN transition 1

Time-delay interrupt >= 200 Max. 4 Delay time expired 3
Cyclic interrupt >= 200 Constant bus cycle time expired 4
Hardware interrupt >= 200 Max. 50 

(more can 
be used with 
DETACH 
and 
ATTACH)

● Rising edge (max. 16)
● Falling edge (max. 16)

5

● HSC: Count value = reference value (max. 6)
● HSC: Count direction changed (max. 6)
● HSC: External reset (max. 6)

6

Diagnostic error interrupt 82 0 or 1 Module has detected an error 20
Time error 80 0 or 1 ● Maximum cycle time exceeded

● Called OB is still being executed
● Queue overflow
● Interrupt loss due to high interrupt load

26

 

The following table describes events which do not trigger an OB start, including the 
corresponding reaction of the operating system. The table is sorted based on event priority.

Event class Event Event priority System reaction
Insert/remove central modules Insert/remove a module 21 STOP
I/O access error during 
process image update

I/O access error during process image update 22 Ignore

Programming error Programming error in a block for which you 
use system reactions provided by the 
operating system (note: the error handling 
routine in the block program is executed if 
you activated local error handling).

23 STOP

I/O access error I/O access error in a block for which you use 
system reactions provided by the operating 
system (note: the error handling routine in the 
block program is executed if you activated 
local error handling).

24 STOP

Maximum cycle time exceeded 
twice

Maximum cycle time exceeded twice 27 STOP

 

Assignment between OBs and events
With the exception of the cyclic program and startup program and event can only be assigned 
to one OB. However, in certain event classes such as hardware interrupts one and the same 
OB can be assigned to several events.

The assignment between OBs and events is defined in the hardware configuration. Defined 
assignments can be changed at runtime by means of ATTACH and DETACH instructions.
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OB priority and runtime behavior
S7-1200 CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.

OBs are always executed on a priority basis: The OBs with the highest priority are executed 
first. Events of the same priority are processed in order of occurrence. This means:

● Any OB with priority >= 2 will interrupt cyclic program execution.

● An OB of priority 2 to 25 cannot be interrupted by any event of priority group 2 to 25. This 
rule also applies to events of a priority higher than that of the currently active OB. Such 
events are processed later.

● A time error (priority 26) will interrupt any other OB.

OB start information
Certain OBs have start information, while others do not. This is explained in greater detail in 
the description of the relevant OB.

See also
Event-based program execution (Page 491)

Event-based program execution

OB priority and runtime behavior
S7-1200-CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.

Interrupt OBs can only be interrupted by time error interrupts. This rule also applies to events 
of a priority higher than that of the currently active OB. That is, only one interrupt OB can be 
active, with exception of the time error interrupt OB.

Any further event of generated while an interrupt OB is being executed is added to a queue in 
accordance with its priority. Start events within a queue are processed later based on the 
chronological order of their occurrence.

Program execution on the CPU
Cyclic OBs are interrupted by interrupt OBs.

Interrupt OBs can only be interrupted by time error interrupt OBs.

The following figure shows the basic sequence:
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Figure 8-2 Program sequence

Description of program execution

① and ② An event (e.g. a hardware interrupt) calls its associated OB. 
A called OB is executed without interruption, including all of its nested blocks. 
Execution of the cyclic OB is resumed on completion of interrupt processing, 
provided the queue does not contain any events which trigger an OB start.

③ An interrupt OB can only be interrupted by a time error interrupt OB (OB 80).
④ An new alarm-triggering event occurs during interrupt processing. This new event 

is added to a queue. The queued events successively call their corresponding 
OBs only after execution of the current interrupt OBs was completed and according 
to the following rules: 
● Events are processed in the order of their priority (starting at the highest priority)
● Events of the same priority are processed in chronological order

⑤ The cyclic OBs are processed one after the other. 
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Notes on queues
● Every priority class (OBs of the same priority to be called) is assigned a separate queue. 

The size of those queues is set by default.

● Any new event leading to the overflow of a queue is discarded and therefore lost. A "time 
error interrupt event" is generated simultaneously. Information identifying the OB that 
caused the error is included in the start information of the time error interrupt OB (OB 80). 
A corresponding reaction such as an alarm trigger can be programmed in the time error 
interrupt OB.

 

Example of a hardware interrupt event
The function principle of event-oriented program execution in the S7-1200-CPU is described 
based on the example of a hardware interrupt-triggering module. 

Process events and their priority
Process events are triggered by the I/O (e.g. at a digital input) and initiate a call of the assigned 
OB in the S7-1200 CPU. OBs assigned to a hardware interrupt event are so-called hardware 
interrupt OBs. 

Examples of process events and their priority:

● Process events "rising edge" or "falling edge" at an interrupt-triggering module: The 
hardware interrupt OB started by such an event is always assigned priority 5.

● Process events from a high-speed counter

– Count value corresponds to the reference value

– Change count direction

– External reset of the high-speed counter
The hardware interrupt OB started by this event is always assigned priority 6. 

The following figure shows the sequence of hardware interrupt execution.
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Hardware interrupt execution

① A hardware interrupt-triggering event such as a rising edge at the input calls the OB to 
which it is assigned.

② If a new event occurs that triggers a hardware interrupt while the OB is executing, this 
event is entered in a queue. 

③ The new event that triggers a hardware interrupt starts the hardware interrupt OB 
assigned to the event. 

Assigning the interrupt-triggering event
The interrupt-triggering event is assigned to an OB in the input properties of the device view.

● An interrupt-triggering event can only be assigned to a single OB.

● OBs, however, can be assigned to several interrupt-triggering events. 
That is, you could assign both the rising and the falling edge event to the same interrupt 
OB in order to trigger the same reaction to any transition of the input signal.
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● The started OB can interrupt a cycle OB at every instruction. Consistent data access is 
secured up to dword size.

● You can parameterize module-specific interrupt-triggering events such as a rising and the 
falling edge at the input.

● Assign the interrupt-triggering event and the OB to be started in the configuration of the 
interrupt-triggering module. However, within the started hardware interrupt OB you can 
override this assignment using the DETACH instruction, or assign the same event to a 
different OB using the ATTACH instruction. This functionality allows a flexible reaction to 
external process signals.

Setting the operating behavior

Changing properties of the modules

Default settings
When they leave the factory, all hardware components with parameters have default settings 
suitable for standard applications. These default values allow the hardware components to be 
used immediately without making any additional settings. 

You can, however, modify the behavior and the properties of the hardware components to suit 
the requirements and circumstances of your application. Hardware components with settable 
parameters include, for example, communications modules and several analog and digital 
modules.

Setting and loading parameters
When you have selected a hardware component in the device or network view, you can set 
the properties in the Inspector window. When you save a device configuration with its 
parameters, data is generated that needs to be loaded on the CPU. This data is transferred 
to the relevant modules during startup.

Properties of the CPUs  
The properties of the CPUs have special significance for system behavior. For example for a 
CPU you can set:

● Interfaces

● Inputs and outputs

● High-speed counters

● Pulse generators

● Startup behavior

● Time-of-day

● Protection level

● Bit memory for system and clock
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● Cycle time

● Communications load

The entry possibilities specify what is adjustable and in which value ranges. Fields that cannot 
be edited are disabled or are not shown in the properties window.

Requirement
You have already arranged the hardware components for which you want to change properties 
on a rack.

Procedure
To change the properties and parameters of the hardware components, follow these steps:

1. In the device or network view, select the hardware component or interface that you want 
to edit.

2. Edit the settings for the selected object:

– For example in the device view you can edit addresses and names.

– In the Inspector window additional setting possibilities are available.

You do not need to confirm your entries, the changed values will be applied immediately.

See also
Editing properties and parameters (Page 309)

Introduction to loading a configuration (Page 473)

CPU properties

Overview of the CPU properties

Overview            
The following table provides you with an overview of the CPU properties:

Group Properties Description
General Project information General information to describe the inserted CPU. Apart from the 

slot number, you can change all the settings
Catalog information Read-only information from the hardware catalog for this CPU.
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Group Properties Description
PROFINET interface General Name and comment for this PROFINET interface. The name is 

limited to 110 characters.
Ethernet addresses Select whether the PROFINET interface is networked. If subnets 

have already been created in project, they can be selected in the 
drop-down list. If not, you can create a new subnet with the "Add 
new subnet" button.
Information on the IP address, subnet mask, and IP router usage 
in the subnet is available in the IP protocol. If an IP router is used, 
the information about the IP address of the IP router is necessary.

Extended Name of and comment on the port of the Ethernet interface
Time-of-day synchronization Settings for time-of-day synchronization in the NTP time format.

The NTP (network time protocol) is a general mechanism for 
synchronizing system clocks in local and global area networks. 
In NTP mode, the interface of the CPU sends time queries (in 
client mode) at regular intervals to NTP servers on the subnet 
(LAN) and the addresses must be set in the parameters here. 
Based on the replies from the server, the most reliable and most 
accurate time is calculated and synchronized. The advantage of 
this mode is that it allows the time to be synchronized across 
subnets. The accuracy depends on the quality of the NTP server 
being used.

DI#/DO# General Name of and comment on the integrated digital inputs of the CPU. 
Digital inputs
 

Input delays can be set for digital inputs. The input delays can be 
set in groups (in each case for 4 inputs). 
The detection of a rising and a falling edge can be enabled for 
each digital input. A name and a hardware interrupt can be 
assigned to this event. 
Depending on the CPU, pulse catches can be activated at various 
inputs. When the pulse catch is activated, even pulse edges that 
are shorter than the cycle time of the program are detected. 

Digital outputs The reaction to a mode change from RUN to STOP can be set 
for all digital outputs: 
The state can either be frozen (corresponds to retain last value) 
or you set a substitute value ("0" or "1")

I/O/Diagnostic addresses The address space of the input and output addresses is specified 
as is the process image. The hardware ID of the device is 
displayed.
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Group Properties Description
AI# General Name of and comment on the integrated analog inputs of the 

CPU.
Analog inputs During noise reduction, the specified integration time suppresses 

interference frequencies at the specified frequency (in Hz). 
The channel address, measurement type, voltage range, 
smoothing, and overflow diagnostics must be specified in the 
"Channel #" group. The measurement type and voltage range 
are set permanently to voltage, 0 to 10 V.
Smoothing analog values provides a stable analog signal for 
further processing. Smoothing analog values can be useful with 
slow measured value changes, for example in temperature 
measurement. The measured values are smoothed with digital 
filtering. Smoothing is achieved by the module forming mean 
values from a specified number of converted (digitalized) analog 
values. The selected level (slight, medium, strong) decides the 
number of analog signals used to create the mean value.
If overflow diagnostics is enabled, a diagnostics event is 
generated if an overflow occurs.

I/O/Diagnostic addresses The address space of the input addresses is specified as is the 
process image. The hardware ID of the device is displayed.

High-speed counter 
(HSC)

High-speed counter (HSC)# High-speed counters are typically used to drive counting 
mechanisms.
For description and parameter assignment, see: Configuring 
high-speed counters (Page 506)

Pulse generators 
(PTO/PWM)

PTO#/PWM# A pulse generator is activated and can be initialized with project 
information.
For the parameter assignment of an activated pulse generator, 
specify the usage as PWM (Pulse Width Modulation) or as PTO 
(Pulse Train Output).
Specify the output source, time base, pulse width format, cycle 
time, and initial pulse width for PWM. A pulse output is specified 
as the hardware output. The PWM output is controlled by the 
CTRL_PWM instruction, see CTRL_PWM.
Specify the output source for PTO. A pulse output and a direction 
output are specified as the hardware outputs. A PTO is operated 
together with a high-speed counter in the "motion axis" count 
mode and controlled by the Motion Control technology object, 
see Auto-Hotspot. 
The hardware ID is displayed in the I/O-diagnostic addresses 
and, if the PWM function is selected, the address space of the 
output addresses and the process image can be selected.

Startup Startup type Setting the start up behavior after cycling power. 
See: Principles of the STARTUP mode (Page 477)

Time-of-day Local time and daylight-saving 
time

Setting of the time zone in which the CPU is operated and setting 
of the daylight-saving/standard time changeover.

Protection Protection and password for read/
write access

Setting options for the level of protection (Page 519)
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Group Properties Description
System and clock 
memory bits

System memory bits and clock 
memory bits

You use system memory bits for the following scans: 
● Is the current cycle the first since cycling power?
● Have there been any diagnostics state changes compared 

with the previous cycle?
● Scan for "1" (high)
● Scan for "0" (low)
Clock memory bits change their values at specified periodic 
intervals.
See: Using clock memory (Page 517)

Cycle time Maximum cycle time and 
minimum cycle time. 

See: Cycle time and maximum cycle time (Page 500)

Communications load Maximum allocation of the cycle 
for communication (as a 
percentage)

See: Cycle loading by communications (Page 501)

I/O addresses 
overview

- Tabular representation of all addresses used by the CPU for 
integrated inputs/outputs as well as for the inserted modules. 
Addresses that are not used by any module are represented as 
gaps. 
The view can be filtered according to: 
● Input addresses
● Output addresses
● Address gaps

See also
Specifying input and output addresses (Page 389)

Configuring high-speed counters (Page 506)

Setting options for the level of protection (Page 519)

Cycle time and maximum cycle time (Page 500)

Cycle loading by communications (Page 501)

Assigning parameters to hardware interrupt OBs (Page 528)

Principles of the STARTUP mode (Page 477)

Access to the I/O addresses (Page 489)

Using clock memory (Page 517)

Addressing modules (Page 388)

Special features during startup (Page 480)
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Cycle time and maximum cycle time

Function    
The cycle time is the time that the operating system requires to execute the cyclic program 
and all the program sections that interrupt this cycle. The program execution can be interrupted 
by: 

● Time errors and 2xMaxCycleTime errors

● System activities, e.g., process image updating

The cycle time (Tcyc) is therefore not the same for every cycle. 

The following schematic shows an example of different cycle times (TZ1 ≠ TZ2) for S7-1200 
CPUs:

In the current cycle, the cyclic OB used here (e.g. OB 1) will be interrupted by a time error (e.g. 
OB 80) Following the cyclic OB, the next cycle OB 201 is processed. 

Maximum cycle time  
The operating system monitors the execution time of the cyclic program for a configurable 
upper limit known as the maximum cycle time. You can restart this time monitoring at any point 
in your program by calling the RE_TRIGR instruction.

If the cyclic program exceeds the maximum cycle time, the operating system will attempt to 
start the time error OB (OB 80). If the OB is not available, the CPU ignores the overshoot of 
the maximum cycle time.

In addition to monitoring the runtime for overshooting of the maximum cycle time, adherence 
to a minimum cycle time is guaranteed. To do this, the operating system delays the start of 
the new cycle until the minimum cycle time has been reached. During this waiting time, new 
events and operating system services are processed.
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If the maximum cycle time is exceeded a second time, for example while the time error OB is 
being processed (2xMaxCycleTime error), the CPU changes to STOP mode.

Cycle loading by communications

Function    
The cycle time of the CPU can be extended due to communications processes. These 
communications processes include for example: 

● Transferring data to another CPU

● Loading of blocks initiated by a programming device

You can control the duration of these communications processes to some extent using the 
CPU parameter "Cycle load due to communication". 

In addition to communications processes, test functions also extend the cycle time. The "Cycle 
load due to communication" parameter can be used to influence the duration. 

How the parameter works
You use the "Cycle load due to communication" parameter to enter the percentage of the 
overall CPU processing capacity that can be available for communications processes. This 
CPU processing capacity is now available at all times for communication. This processing 
capacity can be used for program execution when not required for communication.

Effect on the actual cycle time
The "Cycle load due to communication" parameter can be used to extend the cycle time of the 
cyclic organization block (e.g., OB 1) by a factor calculated according to the following formula:

The formula does not take into account the effect of asynchronous events such as hardware 
interrupts or cyclic interrupts on the cycle time. 

If the cycle time is extended due to communication processes, more asynchronous events 
may occur within the cycle time of the cyclic organization block. This extends the cycle still 
further. The extension depends on how many events occur and how long it takes to process 
them.

Example 1 – no additional asynchronous events:
If the "Cycle load due to communication" parameter is set to 50%, this can cause the cycle 
time of the cyclic organization block to increase by up to a factor of 2.
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Example 2 – additional asynchronous events:
For a pure cycle time of 500 ms, a communication load of 50% can result in an actual cycle 
time of up to 1000 ms, provided that the CPU always has enough communications jobs to 
process. If, parallel to this, a cyclic interrupt with 20 ms processing time is executed every 100 
ms, this cyclic interrupt would extend the cycle by a total of 5*20 ms = 100 ms without 
communication load. That is, the actual cycle time would be 600 ms. Because a cyclic interrupt 
also interrupts communications, it affects the cycle time by adding 10 * 20 ms at 50 % 
communication load. That is, in this case, the actual cycle time amounts to 1200 ms instead 
of 1000 ms.

 

 Note

Observe the following:
● Check the effects of changing the value of the "Cycle load due to communication" 

parameter while the system is running.
● You must always consider the communication load when setting the minimum cycle time 

as time errors will otherwise occur.
 

 

Recommendations
● Increase this value only if the CPU is used primarily for communication purposes and the 

user program is not time critical.

● In all other situations you should only reduce this value.

Time-of-day functions

Basic principles of time of day functions
All S7-1200 CPUs are equipped with an internal clock. The backup supports the display of the 
correct time for up to 10 hours if the power supply is interrupted.

Time-of-day format    
The clock always shows the time of day with a resolution of 1 millisecond and the date including 
the day of the week. The time adjustment for daylight-saving time is also taken into account.
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Setting and reading the time of day

Setting and reading the time with instructions   
You can set, start and read the time of day and date on the CPU clock with the following 
instructions in the user program:

● Set the time of day: "WR_SYS_T"

● Read the time of day "WR_SYS_T"

● Read local time "RD_LOC_T"

● Write local time "WRLT_DTL"

Manual setting
You can also read and set the time of day manually in the online and diagnostics view under 
"Functions > Set time of day".

Parameterizing the clock

Clock parameters
The clock parameters allow you to make the following settings:

● Enable time-of-day synchronization using an NTP server
Select this check box if you want the internal clock to be synchronized using the NTP 
synchronization mode.

● Network time server
The IP addresses of up to four NTP servers need to be configured.

● Update interval
The update interval defines the interval between time queries.

High-speed counters

General information on high-speed counters

Introduction 
High-speed counters are typically used to drive counting mechanisms in which a shaft turning 
at a constant speed is equipped with an incremental step encoder. The incremental step 
encoder ensures a certain number of count values per rotation and a reset pulse once per 
rotation. The clock memory bit(s) and the reset pulse of the incremental step encoder supply 
the inputs for the high-speed counter.

The various S7-1200 CPUs have differing numbers of high-speed counters available:
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S7-1200 CPU Number of HSCs HSC designation
CPU 1211C 3 (with digital signal board 4)* HSC1…3 (and HSC5)*
CPU 1212C 4 (with digital signal board 5)* HSC1…4 (and HSC5)*
CPU 1214C 6 HSC1…6

* with DI2/DO2 signal board

How it works 
The first of several default values is loaded on the high-speed counter. The required outputs 
are enabled for the time during which the current value of the counter is lower than the default 
value. The counter is set up so that an interrupt occurs if the current value of the counter is 
equal to the default value or when the counter is reset.

If the current value is equal to the default value and an interrupt event results, a new default 
value is loaded and the next signal state is set for the outputs. If an interrupt event occurs 
because the counter is reset, the first default value and the first signal states of the outputs 
are set and the cycle repeated.

Since the interrupts occur much less frequently than the high-speed counter counts, a precise 
control of the fast operations can be implemented with only a slight influence on the overall 
cycle of the automation system. Since you can assign specific interrupt programs to interrupts, 
each new default can be loaded in a separate interrupt program allowing simple control of the 
state.

 

 Note

You can also process all interrupt events in a single interrupt program.
 

Count algorithms of the various counters
All counters work in the same way, however some high-speed counters do not support all 
count algorithms. There are four basic count algorithms:

● Single-phase counter with internal direction control

● Single-phase counter with external direction control

● 2-phase counter with 2 clock inputs

● A/B counter

Each high-speed counter can be used with or without a reset input. If the reset input is activated, 
this resets the current value. The current value remains reset until the reset input is deactivated.

See also
Configuring high-speed counters (Page 506)

Interdependency of the counter mode and counter inputs (Page 505)
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Interdependency of the counter mode and counter inputs

General information on counter mode and counter inputs   
You can assign not only the counter modes and counter inputs to the high-speed counters but 
also functions such as clock pulse generator, direction control, and reset. The following rules 
apply:

● An input cannot be used for two different functions.

● If an input is not required by the current counter mode of the defined high-speed counter, 
it can be used other purposes.

If, for example, you set HSC1 to counter mode 1, in which inputs I0.0 and I0.3 are required, 
you can use I0.1 for edge interrupts or for HSC2.

If, for example, you set HSC1 and HSC5, inputs I0.0 (HSC1) and I1.0 (HSC5) are always used 
with the counting and frequency counter modes. As a result, these two inputs are not available 
for any other functions when counters are operated.

You have additional inputs available if you use a digital signal board.

Overview of the interdependency of counter mode and counter inputs

Counter mode Description Inputs
 HSC1 I0.0 (CPU)

I4.0 (signal board)
I0.1 (CPU)
I4.1 (signal board)

I0.3 (CPU)
I4.3 (signal board)

HSC2 I0.2 (CPU)
I4.2 (signal board)

I0.3 (CPU)
I4.3 (signal board)

I0.1 (CPU)
I4.1 (signal board)

HSC3* I0.4 (CPU) I0.5 (CPU) I0.7 (CPU)
HSC4 (CPU 1212/14C only) I0.6 (CPU) I0.7 (CPU) I0.5 (CPU)
HSC5 (CPU 1214C only)** I1.0 (CPU)

I4.0 (signal board)
I1.1 (CPU)
I4.1 (signal board)

I1.2 (CPU)
I4.3 (signal board)

HSC6 (CPU 1214C only)** I1.3 (CPU) I1.4 (CPU) I1.5 (CPU)
Counting / 
frequency

Single-phase counter with 
internal direction control

Clock pulse 
generator

  

Counting Clock pulse 
generator

 Resetting

Counting / 
frequency

Single-phase counter with 
external direction control

Clock pulse 
generator

Direction  

Counting Clock pulse 
generator

Direction Resetting

Counting / 
frequency

2-phase counter with 2 clock 
inputs

Clock pulse 
generator forwards

Clock pulse 
generator backwards

 

Counting Clock pulse 
generator forwards

Clock pulse 
generator backwards

Resetting
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Counter mode Description Inputs
Counting / 
frequency

A/B counter Clock pulse 
generator A

Clock pulse 
generator B

 

Counting Clock pulse 
generator A

Clock pulse 
generator B

Resetting

Motion axis Pulse generators PWM/PTO HSC1 and HSC2 support the motion axis count mode for the PTO1 
and PTO2 pulse generators:
● For PTO1, HSC1 evaluates the Q0.0 outputs for the number of 

pulses.
● For PTO2, HSC2 evaluates the Q0.2 outputs for the number of 

pulses.
Q0.1 is used as the output for the motion direction.

* HSC3 can only be used for CPU 1211 without a reset input

** HSC5 can be also be used for CPU 1211/12 if a DI2/DO2 signal board is used

See also
General information on high-speed counters (Page 503)

Configuring high-speed counters (Page 506)

Configuring high-speed counters

Requirement
An S7-1200 CPU has been inserted in the hardware configuration.

Procedure  
To configure a high-speed counter, follow these steps:

1. Select an S7-1200 CPU in the device or network view.

2. Click on the required high-speed counter under "Properties > High-speed counter" in the 
Inspector window:

– CPU 1211C: HSC1 to HSC3 (also HSC5 with a DI2/DO2 signal board)

– CPU 1212C: HSC1 to HSC4 (also HSC5 with a DI2/DO2 signal board)

– CPU 1214C: HSC1 to HSC6
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3. Enable the high-speed counter in the "General" parameter group using the relevant check 
box.

 

  Note

If you use a CPU 1211C or CPU 1212C with a DI2/DO2 signal board, you can also enable 
the high-speed counter HSC5.

 

  Note

If you activate the pulse generators and operate them as PTO1 or PTO2, they use the 
associated high-speed counter HSC1 or HSC2 with "Motion axis" counting mode to 
evaluate the hardware outputs. If you configure high-speed counter HSC1 or HSC2 for 
other counting tasks, these cannot be used by pulse generator PTO1 or PTO2, 
respectively.

 

If required, you can enter a name and a comment for the high-speed counter here.

4. Define the functionality of the high-speed counter in the "Function" parameter group:

– Count mode: Select what you want to be counted from the drop-down list.

– Operating phase: Select the count algorithm from the drop-down list.

– Input source: Select the on-board CPU inputs or the inputs of an optional digital signal 
board as the input source for the count pulses from the drop-down list.

– Count direction is specified by: If you have selected a single-phase operating phase, 
open the drop-down list and select whether the count direction is set internally by an 
SFB parameter of the user program or externally via a digital input.

– Initial count direction: If the user program is set as the internal direction control for the 
count direction, you can select the count direction at the start of counting from the drop-
down list.

– Frequency meter period: If frequency is set as the count mode, you can select the 
duration of the frequency meter periods in the drop-down list.

5. Specify the initial values and reset condition of the high-speed counter in the "Reset to initial 
values" parameter group:

– Initial counter value: Enter a start value for the high-speed counter.

– Initial reference value: Enter a maximum value for the high-speed counter.

Here, you can also specify whether the high-speed counter will use a reset input and the 
set the corresponding signal level for the reset input from the drop-down list.
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6. Configure the reaction of the high-speed counter to certain events in the "Event 
configuration" parameter group. The following events can trigger an interrupt:

– The counter value matches the reference value.

– An external reset event was generated.

– A change of direction was triggered.

Enable an interrupt reaction using the check box, enter a name and select a hardware 
interrupt for the interrupt from the drop-down list.

7. Assign the start address for the high-speed counter in the "I/O/Diagnostic addresses" 
parameter group.

 

  Note

In the "Hardware inputs" parameter group, you can only see which hardware inputs and 
values are being used for the clock, direction determination, reset pulse, and maximum 
count speed.

 

Result
You have now adapted the parameters of the high-speed counter to the requirements of your 
project.

See also
General information on high-speed counters (Page 503)

Interdependency of the counter mode and counter inputs (Page 505)

Point-to-point communication

Overview of point-to-point communication
PtP communication is communication via a serial interface that uses standardized UART data 
transmission (Universal Asynchronous Receiver/Transmitter). The S7-1200 uses 
communications modules with an RS-232 or RS-485 interface to establish PtP communication.

Functions of point-to-point communication  
Point-to-point communication (PtP) allows numerous applications:

● Direct transmission of information to an external device, for example a printer or a barcode 
reader

● Reception of information from external devices such as barcode readers, RFID readers, 
cameras and third-party optical systems as well as many other devices.

● Exchange of information with third-party devices, for example GPS devices, radio modems 
and many others
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The Freeport protocol  
The S7-1200 supports the Freeport protocol for character-based serial communication. Using 
Freeport communication, the data transmission protocol can be configured entirely by the user 
program.

Siemens provides libraries with Freeport communication functions that you can use in your 
user program:

● USS Drive protocol

● Modbus RTU Master protocol

● Modbus RTU Slave protocol

See also
Configuring a communications port (Page 509)

Using RS-232 and RS-485 communications modules

Communications modules with RS-232 and RS-485 interfaces  
In an S7-1200 CPU, you can use two different communications modules:

● RS-232 communications module

● RS-485 communications module

The communications modules can be connected to the S7-1200 CPU via the I/O channel on 
the left. You can plug in up to three different modules.

Properties of the communications modules  
The communications modules have the following features:

● Support of the Freeport protocol

● Configuration by the user program with the aid of expanded instructions and library functions

Configuring a communications port

Configuring a communications port   
After you have inserted a communications module with an RS-232 or RS-485 interface, you 
then set the interface parameters. You set the parameters for the interface either in the 
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properties of the interface or you control the interface parameters from the user program using 
the PORT_CFG instruction. The following description relates to the graphic configuration.

 

 Note

If you use the user program to change the port setting, the settings of the graphic configuration 
are overwritten.

You should also keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

Requirement
● A communications module is already plugged in.

● You are in the device view.

Procedure
To configure the communications port, proceed as follows:

1. Select the interface in the graphic representation in the device view.
The properties of the interface are displayed in the Inspector window.

2. Select the "Port configuration" group in the area navigation of the Inspector window.
The settings of the port are displayed.

3. From the "Transmission speed" drop-down list, select the speed for the data transmission. 
With user-programmed communication, remember the influence of the transmission speed 
on the changeover time.

4. From the "Parity" drop-down list, select the type of detection of bad information words.

5. Using the "Data bits" drop-down list, decide whether a character consists of eight or seven 
bits.

6. From the "Stop bit" drop-down list, select how many bits will identify the end of a transmitted 
word.

7. From the "Flow control" drop-down list, select the method for ensuring a trouble-free data 
stream between sender and receiver. This parameter can only be set for the RS-232 
interface.

– Enter a HEX value in the "XON character" box that will cause the transmission of the 
message to be continued when it is detected. This parameter can only be set for 
software-controlled data flow control.

– Enter a HEX value in the "XOFF character" box that will cause the transmission of the 
message to be suspended for the set wait time. This parameter can only be set for 
software-controlled data flow control.

8. In the "Wait time" box, enter a wait time in ms that must be kept to after the end of the 
message before the next transmission can start.
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 Note

You can configure the interface in the network view as well. To do so, you must first select 
the communication module in the tabular network view and then select the interface in the 
Inspector window. Then you can continue as described above.

 

See also
Setting data flow control (Page 511)

Setting data flow control

Data flow control
Data flow control is a method that ensures a balanced send and receive behavior. In the ideal 
situation, the intelligent control does not allow data to be lost. It ensures that a device does 
not send more information than the receiving partner can process.

There are two methods of data flow control:

● Hardware-controlled data flow control

● Software-controlled data flow control

With both methods, the DSR signals of the communications partners must be active at the 
beginning of transmission. If the DSR signals are inactive, the transmission is not started.

The RS-232 communications module can handle both methods. The RS-485 communications 
module does not support data flow control.

Hardware-controlled data flow control
Hardware-controlled data flow control uses the request to send (RTS) and clear to send (CTS) 
signals. With the RS-232 communications module, the RTS signal is transmitted via the output 
by pin 7. The CTS signal is received via pin 8.

If hardware-controlled data flow control is enabled, the RTS signal is then always set to 
activated when data is sent. At the same time, the CTS signal is monitored to check whether 
the receiving device can accept data. If the CTS signal is active, the module can transfer data 
until the CTS signal becomes inactive. If the CTS signal is inactive, the data transfer must be 
suspended for the set wait time. If the CTS signal is still inactive after the set wait time, the 
data transfer is aborted and an error is signaled back to the user program.

Data flow control using hardware handshaking
If data flow control is controlled by hardware handshaking, the sending device sets the RTS 
signal to active as default. A device such as a modem can then transfer data at any time. It 
does not wait for the CTS signal of the receiver. The sending device itself monitors it own 
transmission by sending only a limited number of frames (characters), for example to prevent 
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overflow of the receive buffer. If there is nevertheless an overflow, the transferring device must 
hold back the message and signal an error back to the user program.

Software-controlled data flow control
Software-controlled data flow control uses certain characters within the messages and these 
control the transfer. These characters are ASCII characters selected for XON and XOFF.

XOFF indicates when a transmission must be suspended. XON indicates when a transmission 
can be continued.

If the sending device receives the XOFF character, it must suspend sending for the selected 
wait time. If the XON character is sent after the selected wait time, the transfer is continued. 
If no XON character is received after the wait time, an error is signaled back to the user program.

Software data flow control requires full duplex communication because the receiving partner 
needs to send the XON character during the ongoing transfer.

See also
Configuring a communications port (Page 509)

Configuration of message transfer

User-programmed communication  
You can control the data traffic between a communications module and a device connected 
externally via the serial interface using your own mechanisms. If you want to do this, you will 
need to define a communications protocol yourself. In freely programmable communication, 
ASCII and binary protocols are supported for message transfer.

Within the communications protocol, you will need to specify the criteria by which the start and 
end of a transferred message can be recognized in the data stream.

User-programmed communication can only be activated in RUN mode. If there is a change to 
STOP mode, the user-programmed communication is stopped.
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Specifying the communications protocol  
You can specify the communications protocol as follows:

● With the user program

– The behavior when sending data is controlled by the SEND_CFG instruction.

– The behavior when receiving data is controlled by the RCV_CFG instruction.

● Using parameter settings set graphically in the Inspector window
 

  Note

If you change the communications protocol from the user program, the settings of the 
graphic configuration are overwritten.

You should keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

 

See also
User-programmed communication with RS-232 devices (Page 513)

Making the settings for sending (Page 515)

Specifying the start of the message (Page 515)

Specifying the end of the message (Page 516)

User-programmed communication with RS-232 devices

RS-232/PIP multi-master cable and user-programmed communication with RS-232 devices 
Using the RS-232/PIP multi-master cable and user-programmed communication, you can 
connect a wide variety of RS-232-compliant devices to the communications modules of the 
S7-1200. The cable must, however, be set to the "PIP/user-programmed communication" 
mode.

Settings on the cable
The switches on the cable must be set as follows:

● Switch 5 must be set to 0

● Switch 6 sets either the local mode (DCE) or the remote mode (DTE):

– Switch set to 0 for the local mode

– Switch set to 1 for the remote mode
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Changing over between send and receive mode
The RS-232/PIP multi-master cable is in send mode when data is sent from the RS-232 
interface to the RS-485 interface. The cable is in receive mode when it is idle or when data is 
sent from the RS-485 interface to the RS-232 interface. The cable changes from receive to 
send mode immediately when it detects characters on the RS-232 send line.

Supported transmission speeds
The RS-232/PIP multi-master cable supports transmission rates between 1200 baud and 115.2 
kbaud. The RS-232/PIP multi-master cable can be set to the required transmission rate using 
the DIP switch on the PC/PIP cable.

The following table shows the switch settings for the various transmission speeds:

Transmission speed Switchover time Settings (1 = up)
115200 bps 0.15 ms 110
57600 bps 0.3 ms 111
38400 bps 0.5 ms 000
19200 bps 1.0 ms 001
9600 bps 2.0 ms 010
4800 bps 4.0 ms 011
2400 bps 7.0 ms 100
1200 bps 14.0 ms 101

 

The cable returns to receive mode when the RS-232 send line is idle for a certain time that is 
defined as the changeover time of the cable. The set transmission speed influences the 
changeover time as shown in the table.

Influence of the changeover time 
When working with an RS-232/PIP multi-master cable in a system in which user-programmed 
communication is used, the program must take into account the changeover time for the 
following reasons:

● The communications module reacts to messages sent by the RS-232 device.
Once the communications module has received a request from the RS-232 device, it must 
delay the reaction message for a period that is equal to or longer than the changeover time 
of the cable.

● The RS-232 device reacts to messages sent by the communications module.
Once the communications module has received a reaction message from the RS-232 
device, it must delay the next request message for a period that is equal to or longer than 
the changeover time of the cable.

In both situations, the RS-232-PIP multi-master cable has enough time to change from send 
to receive mode so that the data can be sent from the RS-485 interface to the RS-232 interface.
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See also
Configuration of message transfer (Page 512)

Making the settings for sending (Page 515)

Specifying the start of the message (Page 515)

Specifying the end of the message (Page 516)

Making the settings for sending

Sending messages  
You can program pauses between individual messages.

The following table shows which pauses can be set:

Parameter Definition
RTS ON delay You can set the time that must elapse after the send request RTS 

(request to send) before the actual data transfer starts.
RTS OFF delay You can set the time that must elapse after the complete transfer 

before RTS signal is deactivated.
Send pause at the start of the 
message

You can specify that a pause is sent at the start of every message 
transfer when the RTS ON delay has elapsed.
The pause is specified in bit times.

Send Idle Line after a pause You can make a setting so that following a selected pause at the start 
of the message, the "Idle Line" signal is output to signal that the line 
is not in use. To enable the parameter, "Send pause at message start" 
must be set.
The duration of the "Idle Line" signal is specified in bit times.

See also
Specifying the start of the message (Page 515)

Specifying the end of the message (Page 516)

User-programmed communication with RS-232 devices (Page 513)

Specifying the start of the message

Recognizing the start of the message  
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

If a criterion is met that indicates the start of a message, the receiver starts searching the data 
stream for criteria that mean the end of the message.

There are two different methods for identifying the start of a message:
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● Starting with any character:
Any character can defined the start of a message. This is the default method.

● Starting with a specific condition:
The start of a message is identified based on selected conditions.

Conditions for detecting the start of a message
The following table shows the various options for defining the start of a message:

Parameter Definition
Recognize start of message 
by line break

The receiver recognizes a line break when the received data stream is 
interrupted for longer than one character. If this is the case, the start of 
the message is identified by the line break.

Recognize start of message 
by idle line

The start of a message is recognized when the send transmission line 
is in the idle state for a certain time (specified in bit times) followed by an 
event such as reception of a character.

Recognize start of message 
with individual characters

The start of a message is recognized when a certain character occurs. 
You can enter the character as a HEX value.

Recognize start of message 
by a character string

The start of a message is detected when one of the specified character 
sequences arrives in the data stream. You can specify up to four 
character sequences each with up to five characters.

The individual conditions can be logically linked in any way.

See also
Making the settings for sending (Page 515)

User-programmed communication with RS-232 devices (Page 513)

Specifying the end of the message

Recognizing the end of the message  
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

In total, there are six different methods of recognizing the end of a message and these can all 
be logically linked in any way. The following table shows the various possible setting options:

Parameter Definition
Recognize end of message by 
message timeout

The end of a message is recognized automatically when a selected 
maximum duration for a message is exceeded. Values from 0 to 65535 
ms can be set.

Recognize end of message by 
reply timeout

The end of a message is recognized when there is no reply within a 
set time after transferring data. Values from 0 to 65535 ms can be set.
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Parameter Definition
Recognize end of message by 
timeout between characters

The end of a message is detected when the time between two 
characters specified in bit times is exceeded. Values from 0 to 2500 
bit times can be set.
The S7-1200 CPU only accepts a maximum time of eight seconds 
even if the value that is set results in a duration of more than eight 
seconds.

Recognize end of message by 
maximum length

The end of a message is recognized when the maximum length of a 
message is exceeded. Values from 1 to 1023 characters can be set.

Read message length from 
message

The message itself contains information about the length of the 
message. The end of a message is reached when the value taken from 
the message is reached. Which characters are used for the evaluation 
of the message length is specified with the following parameters:
● Offset of the length field in the message

The value decides the position of the character in the message that 
will be used to indicate the message length. 
Values from 1 to 1022 characters can be set.

● Size of the length field
This value specifies how many characters starting at the first 
evaluation position will be used to indicate the message length. 
Values of 0, 1, 2 and 4 characters can be set.

● The data following the length field 
(does not belong to the message length)
The value specifies the number of bytes after the length field that 
must be ignored in the evaluation of the message length. 
Values from 0 to 255 characters can be set.

Recognize message length by 
a character string

The end of a message is detected when the specified character 
sequence arrives in the data stream. You can define up to five 
characters in the character string.

 

See also
Making the settings for sending (Page 515)

User-programmed communication with RS-232 devices (Page 513)

Using clock memory

Clock memory
A clock memory is a bit memory that changes its binary status periodically in the pulse-no-
pulse ratio of 1:1. 

You decide which memory byte of the CPU will become the clock memory byte when assigning 
the clock memory parameters. 
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Benefits
You can use clock memory, for example, to activate flashing indicator lamps or to initiate 
periodically recurring operations such as recording of actual values.

Available frequencies
Each bit of the clock bit memory byte is assigned a frequency. The following table shows the 
assignment:

Bit of the clock 
memory byte

7 6 5 4 3 2 1 0

Period (s) 2.0 1.6 1.0 0.8 0.5 0.4 0.2 0.1
Frequency (Hz) 0.5 0.625 1 1.25 2 2.5 5 10

 
 

 Note

Clock memory runs asynchronously to the CPU cycle, i.e. the status of the clock memory can 
change several times during a long cycle.

The selected memory byte cannot be used for intermediate storage of data. 
 

Enabling system memory

System memory   
A system memory is a bit memory with defined values. 

You decide which memory byte of the CPU will become the system memory byte when 
assigning the system memory parameters. 

Benefits
You can use system memory in the user program, for example to run program segments in 
only the first program cycle after start-up. Two system memory bits are constant 1 or constant 
0. 
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Bits of the system memory bytes
The following table shows the meaning of the system memory:

Bit of the system 
memory bytes

7 6 5 4 3 2 1 0

Meaning Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

=0 =1 =1 with 
change to 
the 
diagnosis 
status

=1 in first 
program 
cycle after 
startup, 
otherwise 0

 
 

 Note

The selected memory byte cannot be used for intermediate storage of data. 
 

Setting options for the level of protection

Protection level    
In the following, you will learn how to use the various protection levels of the S7-1200 CPU. 

Effects of the protection level setting
You can choose between the following protection levels:

● No protection: This corresponds to the default behavior. You cannot enter a password. 
Read and write access is always permitted.

● Write protection: Only read-only access is possible. You cannot change any data on the 
CPU and cannot load any blocks or a configuration. PLC tags that you have marked as 
relevant for HMI are excluded from the write protection. Assignment of a password is 
required to select this protection level.

● Write/read protection No write or read access is possible in the "Accessible devices" area 
or in the project for devices that are switched online. Only the CPU type and the identification 
data can be displayed in the project tree under "Accessible devices". Display of online 
information or blocks under "Accessible devices", or in the project for devices 
interconnected online, is possible.
The following objects are excluded from write/read protection:

– PLC tags that are marked as HMI-relevant

– Monitorable properties of HMI objects

Assignment of a password is required to select this protection level.

Behavior of a password-protected CPU during operation
The CPU protection takes effect after the settings are downloaded to the CPU
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Before an online function is executed, the necessary permission is checked and, if necessary, 
the user is prompted to enter a password. 

Example: The module was assigned a protection level and you want to execute the "Modify 
tags" function. This requires write access; therefore, the assigned password must be entered 
to execute the function. 

The functions protected by a password can only be executed by one programming device/PC 
at any one time. Another programming device/PC cannot log on with a password. 

Access authorization to the protected data is in effect for the duration of the online connection, 
or until the access authorization is manually rescinded with "Online > Delete access rights". 
Access authorization will also expire when the project is closed. 

 

 Note

You can not restrict functions for process control, monitoring, and communications. 

Some functions are still protected due to their use as online data. RUN/STOP in the "Online 
Tools" task card or "Set time of day" in the diagnostics and online editor is therefore write-
protected.

 

 

Organization blocks

Organization blocks for startup

Description 
You can determine the boundary conditions for the startup behavior of your CPU, for example 
the initialization values for "RUN". To do this, write a startup program. The startup program 
consists of one or more startup OBs (OB numbers 100 or >= 123). 

The startup program is executed once during the transition from "STOP" mode to "RUN" mode. 
Current values from the process image of the inputs are not available for startup program, nor 
can these values be set.

After the complete execution of the startup OBs, the process image of the inputs is read in and 
the cyclic program is started.

There is no time limit for executing the startup program. Therefore the scan cycle monitoring 
time is not active. Time-driven or interrupt-driven organization blocks cannot be used. 

Start information
A startup OB has the following start information:

Tag Data type Description
LostRetentive BOOL = 1, if retentive data storage areas have been lost
LostRTC BOOL = 1, if realtime clock has been lost
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See also
Events and OBs (Page 489)

Organization blocks for cyclic program execution

Introduction 
For the program execution to start, at least one program cycle OB must be present in the 
project. The operating system calls this program cycle OB once in each cycle and thereby 
starts the execution of the user program. You can use multiple OBs (OB numbers >= 123). 

The program cycle OBs have the priority class 1. This corresponds to the lowest priority of all 
OBs. The cyclic program can be interrupted by events of any other event class. 

Programming cyclic program execution
You program cyclic program execution by writing your user program in the cycle OBs and the 
blocks that they call.

The first cyclic program execution begins as soon as the startup program has ended without 
errors. The cycle restarts after the end of each cyclic program execution.

Sequence of cyclic program execution
One cycle of the program execution encompasses the following steps:

1. The operating system starts the scan cycle monitoring time.

2. The operating system writes the values from the process image output to the output 
modules.

3. The operating system reads out the state of the inputs of the input modules and updates 
the process image input.

4. The operating system processes the user program and executes the operations contained 
in the program.

5. At the end of a cycle, the operating system executes any tasks that are pending, for 
example, loading and deleting blocks, or calling other cycle OBs.

6. Finally, the CPU returns to the start of the cycle and restarts the scan cycle monitoring time.

See also: process image input/output (Page 486)

Options for interrupting
Cyclic program execution can be interrupted by the following events:

● An interrupt

● A STOP command, triggered by

– Operation of the programming device

– "STP" instruction
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● Supply voltage failure

● Occurrence of a device fault or program error

 

Start information
Cycle OBs have no start information.

See also
Events and OBs (Page 489)

Organization blocks for interrupt-driven program execution

Organization blocks for time-delay interrupts

Description 
A time-delay interrupt OB is started after a configurable time delay of the operating system. 
The delay time starts after the SRT_DINT instruction is called.

You can use up to four time-delay interrupt OBs or cyclic OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two cyclic interrupt OBs, you can insert a 
maximum of two further time-delay interrupt OBs in your program.

You can use the CAN_DINT instruction to prevent the execution of a time-delay interrupt that 
has not yet started.

Function of time-delay interrupt OBs
The operating system starts the corresponding OB after the delay time, which you have 
transferred with an OB number and an identifier to the SRT_DINT instruction.

To use a time-delay interrupt OB, you must execute the following tasks:

● You must call the instruction SRT_DINT.

● You must download the time-delay interrupt OB to the CPU as part of your program.

The delay time is measured with a precision of 1 ms. A delay time can immediately start again 
after it expires.

Time delay interrupt OBs are executed only when the CPU is in the "RUN" mode. A warm 
restart clears all start events of time-delay interrupt OBs. 

The operating system calls the time-delay interrupt OB if one of the following events occurs:

● If the operating system attempts to start an OB that is not loaded and you specified its 
number when calling the SRT_DINT instruction.

● If the next start event for a time-delay interrupt occurs before the time delay OB has 
completely executed.
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You can disable and re-enable time-delay interrupts using the DIS_AIRT and EN_AIRT 
instructions.

 

 Note

If you disable an interrupt with DIS_AIRT after executing SRT_DINT, this interrupt executes 
only after it has been enabled with EN_AIRT. The delay time is extended accordingly.

 

 

Start information
Time delay interrupt OBs have no start information.

See also
Events and OBs (Page 489)

Organization blocks for cyclic interrupts

Description 
Cyclic interrupt OBs serve to start program in periodic time intervals independently of the cyclic 
program execution. The start times of a cyclic interrupt OB are specified using the time base 
and the phase offset. 

The time base defines the intervals at which the cyclic interrupt OB is started and is a whole 
multiple of the basic clock cycle of 1 ms. The phase offset is the time by which the start time 
is offset compared with the basic clock cycle. If several cyclic interrupt OBs are being used, 
you can use this offset to prevent a simultaneous start time if the time bases of the cyclic 
interrupt OBs have common multiples.

You can specify a time period between 1 ms and 60000 ms. 

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 
 

 Note

The execution time of each cyclic interrupt OB must be noticeably smaller than its time base. 
If a cyclic interrupt OB has not been completely executed but execution is again pending 
because the cycle clock has expired, the time error interrupt OB is started. The cyclic interrupt 
that caused the error is executed later or discarded. 
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Example of the use of phase offset
You have inserted two cyclic interrupt OBs in your program:

● Cyclic interrupt OB1

● Cyclic interrupt OB2

For cyclic interrupt OB1, you have set a time base of 20 ms and for cyclic interrupt OB2 a time 
base of 100 ms. After the expiry of the time base of 100 ms, the cyclic interrupt OB1 reaches 
the start time for the fifth time, cyclic interrupt OB2 for the first time. To nevertheless execute 
the cyclic interrupt OBs offset, enter a phase offset for one of the two cyclic interrupt OBs.

Start information
Cyclic interrupt OBs have no start information.

See also
Assigning parameters to cyclic interrupt OBs (Page 529)

Events and OBs (Page 489)

Organization blocks for hardware interrupts

Description 
You can use hardware interrupt OBs to react to specific events. You can assign an event that 
triggers an alarm to precisely one hardware interrupt OB. A hardware interrupt OB in contrast 
can be assigned to several events.

Hardware interrupts can be triggered by high-speed counters and input channels. For each 
high-speed counter and input channel that should trigger a hardware interrupt, the following 
properties need to be configured:

● The process event that should trigger the hardware interrupt (for example, the change of 
a count direction of a high-speed counter)

● The number of the hardware interrupt OB which is assigned to this process event

You can use up to 50 hardware interrupt OBs (OB numbers >= 123) that are independent of 
each other in your program.

Function of a hardware interrupt OB
After triggering a hardware interrupt, the operating system identifies the channel of the input 
or the high-speed counter and determines the assigned hardware interrupt OB.

If no other interrupt OB is active, the determined hardware interrupt OB is called. If a different 
interrupt OB is already being executed, the hardware interrupt is placed in the queue of its 
priority class. The hardware interrupt is acknowledged after the completion of the assigned 
hardware interrupt OB.

If another event that triggers a hardware interrupt occurs on the same module during the time 
between identification and acknowledgement of a hardware interrupt, the following applies:
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● If the event occurs on the channel that previously triggered the hardware interrupt, then no 
additional hardware interrupt is triggered. Another hardware interrupt can only be triggered 
if the current hardware interrupt is acknowledged.

● If the event occurs on a different channel, a hardware interrupt is triggered.

Hardware interrupt OBs are called only in the CPU's "RUN" mode.

Start information
Hardware interrupt OBs have no start information.

See also
Assigning parameters to hardware interrupt OBs (Page 528)

Events and OBs (Page 489)

Organization block for time error

Description   
The operating system calls the time error interrupt OB (OB 80) if one of the following events 
occurs:

● The cyclic program exceeds the maximum cycle time.

● The OB called is currently still being executed (possible for time-delay interrupt OBs and 
cyclic interrupt OBs).

● An overflow has occurred in an interrupt OB queue.

● An interrupt was lost due to the excessive interrupt load.

If you have programmed no time error interrupt OB, the S7-1200 CPU reacts as follows:

● CPUs with firmware version V1.0: The CPU remains in RUN mode.

● CPUs with firmware version V2.0:

–  The CPUs goes to STOP mode when the maximum cycle time is exceeded.

– With all other start events of the time error interrupt OB, the CPU remains in RUN mode.

With CPUs with firmware version V1.0, the two-time overshooting of the maximum cycle time 
does not lead to the calling of an OB, but to the STOP of the CPU. You can avoid the second 
violation by restarting the cycle monitoring of the CPU with the RE_TRIGR instruction.

You can use only one time error interrupt OB in your program.
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Start information
The time error interrupt OB has the following start information:

Tag Data type Description
fault_id BYTE ● 0x01: Maximum cycle time exceeded

● 0x02: Called OB is still being executed
● 0x07: Queue overflow
● 0x09: Interrupt loss due to high interrupt load

csg_OBnr OB_ANY Number of the OB being executed at the time of the error
csg_prio UINT Priority of the OB being executed at the time of the error

 

See also
Events and OBs (Page 489)

Organization block for diagnostic error interrupts

Description 
You can enable the diagnostic error interrupt for diagnostics-capable modules so that the 
module detects changes in the I/O status. As a result, the module triggers a diagnostic error 
interrupt in the following cases:

● A fault is present (incoming event)

● A fault is no longer present (outgoing event)

If no other interrupt OB is active, then the diagnostic error interrupt OB (OB 82) is called. If 
another interrupt OB is already being executed, the diagnostic error interrupt is placed in the 
queue of its priority group. 

You can use only one diagnostic error interrupt OB in your program.

Start information
The diagnostic error interrupt OB has the following start information:

Tag Data type Description
IO_state WORD Contains the I/O status of the diagnostics-

capable module. 
laddr HW_ANY HW-ID
Channel UINT Channel number
multi_error BOOL = 1, if there is more than one error
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IO_state tag
The following table shows the possible I/O states that the IO_state tag can contain:

IO_state Description
Bit 0 Configuration correct:

= 1, if the configuration is correct
= 0, if the configuration is no longer correct

Bit 4 Error:
= 1, if an error is present, e.g., a wire break
= 0, if the error is no longer present

Bit 5 Configuration not correct:
= 1, if the configuration is not correct
= 0, if the configuration is correct again 

Bit 6 I/O cannot be accessed:
= 1, if an I/O access error has occurred
In this case, laddr contains the hardware identifier of the I/O with the access error. 
= 0, if the I/O can be accessed again

See also
Events and OBs (Page 489)

Block parameters of organization blocks

Basics of block parameters

Introduction  
Several organization blocks (OBs) have properties with which you can control their behavior 
or their assignment to specific events. You can influence these properties by assigning 
parameters.

Overview
You can assign parameters to the properties for the following organization blocks:

● Hardware interrupt OBs

● Cyclic interrupt OBs

 

See also
Assigning parameters to hardware interrupt OBs (Page 528)

Assigning parameters to cyclic interrupt OBs (Page 529)
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Assigning parameters to hardware interrupt OBs

Introduction  
You must select the corresponding event and assign the following parameters for every input 
channel and high-speed counter that should trigger a hardware interrupt:

● Event name

● Number of the hardware interrupt OB that is assigned to this process event

The parameters of the hardware interrupt are assigned in the properties of the corresponding 
device. You can assign parameters for up to 50 hardware interrupt OBs.

You can create the hardware interrupt OB to be assigned parameters either before or during 
activation of an event. 

Procedure
To assign parameters for the hardware interrupt OB, follow these steps:

1. Double-click the "Devices & Networks" command in the project tree.
The hardware and network editor opens in the network view.

2. Change to the device view.

3. If the Inspector window closed in the device view, select the "Inspector window" check box 
in the "View" menu.
The Inspector window opens.

4. Click the "Properties" tab.

5. In the device view, select the module for which you want to a assign a hardware interrupt.

6. Select the corresponding event.

7. Enter an event name.

8. Select an existing hardware interrupt OB from the "Hardware interrupt" drop-down list.
 

  Note

If you have not previously created any hardware interrupt OB, you can click "Add new 
block" in the drop-down list. 

See also: Auto-Hotspot
 

9. If you want to assign further hardware interrupts, repeat steps 5 to 8.

See also
Basics of block parameters (Page 527)

Organization blocks for hardware interrupts (Page 524)

Events and OBs (Page 489)
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Assigning parameters to cyclic interrupt OBs

Introduction  
You can use cyclic interrupt OBs to start programs at regular time intervals. To do so you must 
enter a scan time and a phase shift for each cyclic interrupt OB used.

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 200) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 

 Note

If you assign multiple cyclic OBs, make sure that you assign a different cycle time or phase 
offset to each cyclic interrupt OB to avoid them executing at the same time or having to queue. 
When you create a cyclic interrupt OB, the cycle time 100 and the phase offset 0 are entered 
as the start values.

 

Procedure
To enter a scan time and a phase shift for a cyclic interrupt OB, proceed as follows:

1. Open the "Program blocks" folder in the project tree.

2. Right-click on an existing cyclic interrupt OB.

3. Select the "Properties" command in the shortcut menu.
The "<Name of the cyclic interrupt OB>" dialog box opens.

4. Click the "Cyclic interrupt" group in the area navigation.
The text boxes for the scan time and the phase shift are displayed.

5. Enter the scan time and the phase shift.

6. Confirm your entries with "OK".

 

 

See also
Basics of block parameters (Page 527)

Organization blocks for cyclic interrupts (Page 523)

Symbolic and numerical names of instructions

Description
The instructions from the task card are comprised of functions (FC), function blocks (FB), 
system functions (SFC) and system function blocks (SFB) that are identified internally by 
numbers.
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The following tables show the assignment of numerical and symbolic names.

Function blocks (FBs)

Numerical name Symbolic name
FB 105 TC_CONFIG
FB 110 Port_Config
FB 111 Send_Config
FB 112 Receive_Config
FB 113 Send_P2P
FB 114 Receive_P2P
FB 115 Receive_Reset
FB 116 Signal_Get
FB 117 Get_Features
FB 118 Set_Features
FB 163 TC_SEND
FB 164 TC_RECV
FB 165 TC_CON
FB 166 TC_DISCON
FB 804 SET_TIMEZONE
FB 1030 TSEND_C
FB 1031 TRCV_S
FB 1071 USS_DRIVE
FB 1080 MB_COMM_LOAD
FB 1081 MB_MASTER
FB 1082 MB_SLAVE
FB 1084 MB_CLIENT
FB 1085 MB_SERVER
FB 1100 MB_Halt
FB 1101 MC_Home
FB 1102 MC_MoveAbsolute
FB 1103 MC_MoveJog
FB 1104 MC_MoveRelative
FB 1105 MC_MoveVelocity
FB 1107 MC_Power
FB 1108 MC_Reset
FB 1110 MC_MoveInterrupt
FB 1111 MC_ChangeDynamik
FB 1112 MC_CommandTable
FB 1113 MC_MoveLinearAbs_2D
FB 1114 MC_MoveLinearRel_2D
FB 1115 MC_MoveCircular_2D
FB 1130 PID_Compact
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Numerical name Symbolic name
FB 1134 PID_3Step
FB 1140 HSC
FB 2040 RecipeCreate
FB 2041 RecipeOpen
FB 2042 RecipeRead
FB 2043 RecipeWrite
FB 2044 RecipeAppend
FB 2045 RecipeClose

Functions (FCs)

Numerical name Symbolic name
FC 2 (1) CONCAT
FC 4 (1) DELETE
FC 11 (1) FIND
FC 17 (1) INSERT
FC 20 (1) LEFT
FC 21 (1) LEN
FC 22 (1) LIMIT
FC 25 (1) MAX
FC 26 (1) MID
FC 27 (1) MIN
FC 31 (1) REPLACE
FC 32 (1) RIGHT
FC 36 (1) ENCO
FC 36 (1) SEL
FC 37 DECO
FC 800 LED
FC 801 IM_DATA
FC 802 DeviceStates
FC 803 ModuleStates
FC 1070 USS_PORT
FC 1072 USS_RPM
FC 1073 USS_WPM
(1) MC7+ instruction

System data types (SDTs)

Numerical name Symbolic name
SDT 99 WWW_CDB
SDT 513 CONDITIONS
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Numerical name Symbolic name
SDT 581 Send_Conditions
SDT 582 Receive_Conditions

System function blocks (SFBs)

Numerical name Symbolic name
SFB 0 (1) CTU
SFB 1 (1) CTD
SFB 2 (1) CTUD
SFB 3 (1) TP
SFB 4 (1) TON
SFB 5 (1) TOF
SFB 27 START_OB
SFB 52 RDREC
SFB 53 WRREC
SFB 54 RALRM
SFB 105 T_CONFIG
SFB 106 TDIAG
SFB 107 TRESET
SFB 110 PORT_CFG
SFB 111 SEND_CFG
SFB 112 RCV_CFG
SFB 113 SEND_PTP
SFB 114 RCV_PTP
SFB 115 SGN_GET
SFB 116 SGN_SET
SFB 117 RCV_RST
SFB 120 CTRL_HSC
SFB 122 CTRL_PWM
SFB 140 DataLogCreate
SFB 141 DataLogOpen
SFB 142 DateLogWrite
SFB 143 DataLogClear
SFB 144 DataLogClose
SFB 145 DataLogDelete
SFB 146 DataLogNewFile
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System functions (SFCs)

Numerical name Symbolic name
SFC 7 DP_PRAL
SFC 11 DPSYC_FR
SFC 13 DPNRM_DG
SFC 14 DPRD_DAT
SFC 16 RD_OBINF
SFC 23 DEL_DB
SFC 28 SET_TINT
SFC 29 CAN_TINT
SFC 30 ACT_TINT
SFC 31 QRY_TINT
SFC 32 SRT_DINT
SFC 33 CAN_DINT
SFC 34 QRY_DINT
SFC 41 DIS_AIRT
SFC 42 EN_AIRT
SFC 43 RE_TRIGR
SFC 45 DE_ACT
SFC 46 STP
SFC 82 CREA_DBL
SFC 83 READ_DBL
SFC 84 WRIT_DBL
SFC 86 CREATE_DB
SFC 89 RST_EVOV
SFC 99 WWW
SFC 101 RTM
SFC 117 GET_DIAG
SFC 124 ATTR_DB
SFC 140 IO2MOD
SFC 143 RD_ADDR
SFC 154 RD_LOC_T
SFC 154 DPWR_DAT
SFC 161 WR_LOC_T
SFC 180 ID2LOG
SFC 181 LOG2ID
SFC 182 ID2GEO
SFC 190 SET_CINT
SFC 191 QRY_CINT
SFC 192 ATTACH
SFC 193 DETACH
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Numerical name Symbolic name
MC7+ Anweisung GET_ERROR
MC7+ Anweisung GET_ERR_ID

8.1.5.2 Distributed I/O

Distributed I/O systems

SIMATIC ET 200 - The right solution for all applications
SIMATIC ET 200 provides the most varied range of distributed I/O systems.

● Solutions for use in the control cabinet 

● Solutions without control cabinet directly at the machine

Additionally, there are also components that can be used in explosive areas. SIMATIC ET 200 
systems for construction without a control cabinet are contained in robust, glass-fibre 
reinforced plastic casing and are therefore shock-resistant, resistant to dirt and watertight.

Their modular design allows the ET 200 systems to be easily scaled and expanded in small 
steps. Fully-integrated auxiliary modules lower costs and also provide a wide range of possible 
applications. There are several combination possibilities available:

● Digital and analog I/OS

● Intelligent modules with CPU functions,

● Safety technology,

● Pneumatics,

● Frequency converters

● Various technology modules.

Communication via PROFIBUS and PROFINET, uniform engineering, clear diagnostic 
possibilities as well as optimal connection to SIMATIC controller and HMI devices vouch for 
the unique consistency provided by Totally Integrated Automation.

The following table provides an overview of I/O devices for use in the control cabinet:      

I/O device Properties
ET 200S ● Highly modular design with multiple conductor 

connections
● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)

ET 200S COMPACT ● Highly modular design with multiple conductor 
connections

● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)
● Integrated DE/DA
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I/O device Properties
ET 200L ● Cost-effective digital block I/OS

● Digital electronic blocks up to 32 channels
ET 200M ● Modular design with standard modules from 

SIMATIC-S7-300
● Failsafe I/O modules
● Use in explosive areas up to Zone 2, sensors 

and actuators up to Zone 1
● High level of plant availability, for example by 

plugging and unplugging when in operation
ET 200iSP ● Modular design, also possible with redundancy

● Robust and intrinsically safe design
● Use in explosive areas up to Zone 1/21; 

sensors and actuators even up to Zone 0/20
● High level of plant availability, for example by 

plugging and unplugging when in operation

 

The following table provides an overview of I/O devices for use without a control cabinet:     

I/O device Properties
ET 200pro ● Modular design with compact housing

● Easy assembly
● Multifunctional due to a wide range of modules
● High level of availability due to plugging and 

unplugging in operation and permanent wiring
● Comprehensive diagnostics

ET 200eco PN ● Cost-efficient, space-saving block I/OS
● Digital modules up to 16 channels (also 

configurable)
● Analog modules, IO-link master and load 

voltage distributor
● PROFINET connection with 2-port switch in 

each module
● Can be flexibly distributed via PROFINET in 

line or star shape directly within the plant
ET 200eco ● Cost-effective digital block I/OS

● Flexible connection possibilities
● Failsafe modules
● High level of plant availability

ET 200R ● Specially for use on robots
● Assembled directly on the chassis
● Resistant to weld spatter due to robust metal 

housing
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See also
Documentation on ET 200L (http://support.automation.siemens.com/WW/view/de/1142908/0/
en)

Documentation on ET 200S (http://support.automation.siemens.com/WW/view/en/1144348)

Documentation on ET 200M (http://support.automation.siemens.com/WW/view/de/1142798/0/
en)

Documentation on ET 200pro (http://support.automation.siemens.com/WW/view/de/
21210852/0/en)

Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Documentation on ET 200R (http://support.automation.siemens.com/WW/view/de/
11966255/0/en)

Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/de/
29999018/0/en)

Documentation on ET 200eco  (http://support.automation.siemens.com/WW/view/de/
12403834/0/en)

ET 200iSP

ET 200iSP Distributed I/O Station

Definition  
The ET 200iSP distributed I/O station is a highly modular and intrinsically safe DP slave with 
degree of protection IP 30.

Area of application
The ET 200iSP distributed I/O station can be operated in potentially explosive atmospheres 
characterized by gas and dust:

Approval ET 200iSP Station* Inputs and outputs
ATEX
IECEx

Zone 1, Zone 21 up to Zone 0, Zone 20 **
Zone 2, Zone 22 up to Zone 0, Zone 20 **

* In combination with an appropriate enclosure
** for electronic module 2 DO Relay UC60V/2A: up to Zone 1, Zone 21

The ET 200iSP distributed I/O station can, of course, also be used in the safety area.

You can insert almost any combination of ET 200iSP I/O modules directly next to the interface 
module that transfers the data to the DP master. This means you can adapt the configuration 
to suit your on-site requirements.
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Every ET 200iSP consists of a power supply module, an interface module and a maximum of 
32 electronic modules (for example digital electronics modules). Remember not to exceed the 
maximum current consumption.

Terminal modules and electronic modules  
In principle, the ET 200iSP distributed I/O station consists of various passive terminal modules 
onto which you plug the power supply and the electronic modules.

The ET 200iSP is connected to PROFIBUS RS 485-IS by means of a connector on terminal 
module TM-IM/EM. Every ET 200iSP is a DP slave on the PROFIBUS RS 485‑IS. 

DP master  
All ET 200iSP modules support communication with DP masters that are compliant with 
IEC 61784-1:2002 Ed1 CP 3/1 and operate with "DP" transmission protocol (DP stands for 
distributed peripherals or distributed I/O).  

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Assigning the channel and IEEE tag

Properties  
Analog electronic modules 4 AI I 2WIRE/HART, 4 AI I 4WIRE/ HART and 4 AO I HART support 
up to four IEEE tags. 

The process input image (PII) provides up to 20 bytes per module for the IEEE tags. Thus, 
four blocks of 5 bytes each are available for the four IEEE tags within the PII.

Requirements
The HART field device must support the assigned number of IEEE tags.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  537

http://support.automation.siemens.com/WW/view/de/28930789/0/en
http://support.automation.siemens.com/WW/view/de/28930789/0/en


Assigning IEEE tags 
You assign the IEEE tags of the field devices to any one of the four blocks in the PII.

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)
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Assigning parameters to reference junctions for thermocouples

Compensation of the reference junction temperature 
There are various ways of obtaining the reference junction temperature in order to get an 
absolute temperature value from the temperature difference between the reference junction 
and the measuring point.

Table 8-1 Compensation of the reference junction temperature

Option Explanation Reference junction parameters
No compensation You record not only the temperature of 

the measurement point. The 
temperature of the reference junction 
(transition from Cu line to thermocouple 
line) also affects the thermo-
electromotive force. The measured 
value then includes an error.

None

Use of a Pt100 
Climatic Range 
resistance 
thermometer to 
record the reference 
junction temperature 
(best method)

You can record the reference junction 
temperature using a resistance 
thermometer (Pt100 Climatic Range). If 
parameterized accordingly, this 
temperature value is distributed to the 4 
AI TC modules in the ET 200iSP where 
it is offset against the temperature value 
obtained at the measuring location.
Number of reference junctions: 2

The parameter assignment of the IM 
152 and the 4 AI TC must be 
coordinated:
● 4 AI RTD assigned parameters 

for Pt100 climatic range in 
correct slot;

● 4 AI TC: Reference junction : 
"yes"; select reference junction 
number "1" or "2"

● IM 152-1:Assignment of the 
reference junction to a slot with 4 
AI RTD; channel selection;

Internal 
compensation 4 AI 
TC

The TC sensor module (temperature 
sensor) is mounted onto the terminals of 
terminal module EM 4 AI TC. The 
temperature sensor reports the 
temperature of the terminals to the 4 AI 
TC. This value is then calculated 
together with the measured value from 
the channel of the electronic module.

● 4 AI TC: Reference junction 
number "internal"

Compensation by means of a resistance thermometer at the 4 AI RTD 
If thermocouples that are connected to the inputs of the 4 AI RTD have the same reference 
junction, compensate by means of a 4 AI RTD.

For both channels of the 4 AI TC module, you can select "1", "2" or "internal" as the reference 
junction number. If you select "1" or "2", the same reference junction (RTD channel) is always 
used for all four channels.
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Setting parameters for the reference junction 
You set the reference junctions for the 4 AI TC electronic modules by means of the following 
parameters:

Table 8-2 Reference junction parameters

Parameter Module Range of values Explanation
Slot reference junction 1 to slot 2 IM 152 none, 4 to 35 With this parameter, you can assign up to 2 

slots (none, 4 to 35), on which the channels 
for reference temperature measurement 
(calculating the compensation value) are 
located.

Input reference junction 1 to 4 
input reference junction  

IM 152 RTD on channel 0
RTD on channel 1
RTD on channel 2
RTD on channel 3

This parameter allows you to set the channel 
(0/1/2/3) for measuring the reference 
temperature (calculation of the 
compensation value) for the assigned slot. 

Reference junction E0 to 
reference junction E3

4 AI TC None
yes

This parameter allows you to enable the use 
of the reference junction.

Reference junction number 4 AI TC 1
2
Internal

This parameter allows you to assign the 
reference junction (1, 2) that contains the 
reference temperature (compensation 
value).

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Fundamentals of Time Stamping

Properties 
Time stamping is possible with the IM 152 in customer applications using FB 62 (FB 
TIMESTMP). 

Principle of operation 
A modified input signal is assigned a time stamp and stored in a buffer (data record). If time 
stamped signals exists or a data record is full, a hardware interrupt is generated to the DP 
master. The buffer is evaluated with "Read data record". Special messages are generated for 
events that influence the time stamping (communication with the DP master interrupted, frame 
failure of time master, ...).
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Parameter Assignment
With the parameter assignment you define which IM 152 user data will be monitored. For the 
time stamping these are digital inputs that are monitoring for signal changes.

Parameter Setting Description
Time stamping ● disabled

● enabled
Activate the time staming for the 
channels of the electronics module 8 
DI NAMUR.

Edge evaluation 
incoming event

● rising edge
● falling edge

Determine the type of signal change 
that will be time-stamped.

Counting

Count properties

Counting functions
The 8 DI NAMUR electronics module has configurable counting functions:

● 2 x 16-bit up counters (standard counting function) or

● 2 x 16-bit down counters (standard counting function) or

● 1 x 32-bit down counter (cascading counter function)

● Setting a setpoint with the PIQ

● GATE function

● You can configure the control signals of the counters:

– Configuration channel 0..1: "Counter", channel 2..7: "DI": Two counters are configured. 
The control signals of the counters are stored in the PIQ (process image output).

– Configuration channel 0..1: "Counter", channel 2..7: "Control": Two counters are 
configured. The control signals of the counters are stored in the PIQ (process image 
output). They are also controlled by the digital inputs of the 8 DI NAMUR. 

See also
Principle of operation (Page 541)

Configuring counters (Page 544)

Assigning parameters to counters (Page 547)

Principle of operation

16-bit up counters (standard counting function)
The counting range is 0 to 65,535. 
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With each count pulse at the digital input, the count is incremented by 1. Once the count limit 
is reached, the counter is reset to 0 and it counts up again from this value.

If there is counter overflow, the corresponding output is set in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.

In 16-bit up counting operations, the system does not set any outputs in the PIQ. These are 
always reset.

The positive edge of the Reset counter control signal sets the counter to 0 and resets the set 
counter output.

The GATE control signal pauses the counting on a positive edge. Count pulses are processed 
at the digital input again, but only at the negative edge. The Reset counter control signal is 
also effective when GATE is active.

16-bit down counters (periodic counting function)
The maximum counting range is always 65,535 to 0.

When the counter is started, the actual value is set to the selected setpoint. Each counted 
pulse reduced the actual value by 1. Once the actual value reaches 0, the corresponding output 
in the PII is turned on and the actual value is set to the selected setpoint. The counter then 
counts down from this value.

The positive edge of the Reset counter control signal resets the selected setpoint and the 
corresponding output in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.
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The GATE control signal pauses the counting on a positive edge. At the same time, the 
assigned output in the PII is reset. Count pulses are processed at the digital input again, but 
only at the negative edge. The Reset output and Reset counter control signals are also effective 
when GATE is active.

The setpoint of the counter is set and changed using the PIQ. The setpoint is adopted on a 
positive edge of the Reset counter control signal or when the counter has reached zero.

 

32-bit down counter (cascading counter function)   
The maximum counting range is always 4294967295 to 0.

The principle of operation is identical to that of the 16-bit down counter. Channel 1 has no 
function.

See also
Count properties (Page 541)
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Configuring counters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Counter", channel 2..7: "DI" or "Control"). 
In the module properties (inspector window), you can find this setting under "Parameters 
> Inputs > Configuration".

Configuration channel 0..1: "Counter", channel 2..7: "DI"
● Assignment of the digital inputs on the electronic module 8 DI NAMUR

Table 8-3 Assignment of digital inputs for channel 0..1: "Counter", channel 2..7: "DI": 

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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● Assignment of the process image input (PII)

● Assignment of the process image output (PIQ)
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Configuration channel 0..1: "Counter", channel 2..7: "CONTROL"
With this configuration, you can also control the counters over the digital inputs.

● Assignment of the digital inputs on electronic module 8 DI NAMUR
For further information on input assignments, refer to the technical data for electronic 
module 8 DI NAMUR.

Table 8-4 Assignment of the digital inputs for 2 Count/ 6 Control

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 control signal GATE 1
Channel 3 13, 14 control signal GATE 2
Channel 4 3, 4 control signal Reset counter 1
Channel 5 7, 8 control signal Reset counter 2
Channel 6 11, 12 control signal Reset counter output 1
Channel 7 15, 16 control signal Reset counter output 2

● Assignment of the process image input (PII)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

● Assignment of the process image output (PIQ)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

See also
Count properties (Page 541)
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Assigning parameters to counters

Parameters for the counting function
Only those parameters that are relevant for the counters are explained below. These belong 
to the parameters of electronic module 8 DI NAMUR and depend on the selected configuration:

Table 8-5 Parameters for the counters

Parameter Setting Description
Sensor type counter 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load resistance

Select the sensor for the respective 
counter of channels 0 or 1.

Mode for counter 1 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 1.

Mode for counter 2 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 2. This 
parameter is not relevant if you have 
set the "Mode for counter 1" 
parameter to "Cascaded counter 
function".

See also
Count properties (Page 541)

Frequency measurement

Frequency measurement properties

Properties
The electronic module 8 DI NAMUR allows the frequencies to be measured on channel 0 and 
1:

● 2 frequency meters from 1 Hz to 5 kHz

● Configurable metering window (GATE)

● The signals of the frequency meter are read in by means of the digital inputs of the electronic 
module. 

See also
Principle of operation (Page 548)

Configuring frequency meters (Page 548)

Assigning parameters for the frequency meters (Page 550)
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Principle of operation

Frequency measurement
The signal frequencies are identified from the input signals of channel 0 or 1 of the electronic 
module. To calculate the frequency the signals are measured within a configurable gate.

The frequency is displayed as 16-bit value in fixed-point format and transferred to the PII.

The frequency meter calculates the frequency according to the follow formula:

Exceeding the input frequency
If the input frequency exceeds 5kHz, 7FFFH is reported as actual value. If the input frequency 
is above approx. 8 kHz it is no longer possible to display correct actual values.

See also
Frequency measurement properties (Page 547)

Configuring frequency meters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Trace", channel 2..7: "DI"). In the module 
properties (inspector window), you can find this setting under "Parameters > Inputs > 
Configuration".

Configuration 0..1: "Trace", channel 2..7: "DI"
Assignment of the digital inputs on electronic module 8 DI NAMUR

Digital input Terminal Assignment
Channel 0 1, 2 Frequency counter 1
Channel 1 5, 6 Frequency counter 2
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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Assignment of process image input (PII) for configuration of channel 0..1: "Trace", channel 
2..7: "DI"

Assignment of the process image output (PIQ): The PIQ is not assigned.

See also
Frequency measurement properties (Page 547)
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Assigning parameters for the frequency meters

Parameters for frequency meter
Only those parameters that are relevant for the frequency meters are explained below. These 
are part of the parameters of electronic module 8 DI NAMUR.

Table 8-6 Parameters for the frequency meters 

Parameter Setting Description
Sensor type frequency 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load 

resistance

Select the sensor for the relevant frequency 
meter for channel 0 or 1.

Measuring window 
(GATE)

● 50 ms
● 200 ms
● 1 s

Select the required measuring window for 
channel 0 or 1. 
To achieve the highest possible accuracy 
when metering frequencies, remember the 
following rules:
● High frequencies (> 4 kHz): Set a low 

measuring window (50 ms)
● Variable/medium frequencies: set 

medium measuring window (200 ms)
● Low frequencies (< 1 kHz): Set a high 

measuring window (1 s)

See also
Frequency measurement properties (Page 547)

ET 200eco PN

ET 200eco PN Distributed I/O Device

Definition   
The ET 200eco PN distributed I/O device is a compact PROFINET IO device in degree of 
protection IP 65/66 or IP 67 and UL Enclosure Type 4x, Indoor use only.
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Field of application 
The fields of application of the ET 200eco PN are derived from its special properties. 

● A robust design and degree of protection IP 65/66 or IP 67 make the ET 200eco PN 
distributed I/O device suitable in particular for use in rugged industrial environments.

● The compact design of the ET 200eco PN is particularly favorable for applications in 
confined areas.

● The easy handling of ET 200eco PN facilitates efficient commissioning and maintenance.

Properties
The ET 200eco PN has the following properties:

● Integrated switch with 2 ports

● Supported Ethernet services:

– ping

– arp

– Network diagnostics (SNMP)

– LLDP

● Interrupts

– Diagnostics interrupts

– Maintenance interrupts

● Port diagnostics

● Isochronous real-time communication

● Prioritized startup

● Device replacement without programming device

● Media redundancy

● Connection to intelligent sensors/actuators via IO link master interface module.

IO Controller 
The ET 200eco PN can communicate with all IO Controllers that conform to IEC 61158. 

ET 200eco PN can be configured on a CPU with advanced diagnostics.

 

See also
Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/en/
29999018)
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Parameter description analog input

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.

Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit  
If you enable this parameter, a diagnostics event is generated if a short-circuit of the sensor 
supply to ground is detected and the channel is enabled. The sensor supply is monitored for 
connectors X1, X3, X5 and X7. It is not possible to differentiate which connector has 
experienced the sensor short circuit.

Interference frequency suppression
With this parameter, you set the integration time of the device, based on the selected 
interference frequency. Select the frequency of the supply voltage used. Interference 
frequency suppression Off means 500 Hz, which corresponds to an integration time of 2 ms 
for a measurement channel.

Temperature unit
Specify the unit of the temperature measurement here.

Measurement type (channel-wise)
With this parameter, you set the measurement type, for example, voltage. For any unused 
channels, you must select the disabled setting. For a disabled channel, the conversion time 
and integration time of the channel = 0 s and the cycle time is optimized.

Measuring range
With this parameter, you set the measuring range of the selected measurement type.

Temperature coefficient (for RTD, thermoresistor)  
The correction factor for the temperature coefficients (α-value) indicates by what extent the 
resistance of specific material changes relatively if the temperature increases by 1 ℃.

The α-values conform to EN 60751, GOST 6651, JIS C 1604 and ASTM E-1137.

The temperature coefficient depends on the chemical composition of the material. 
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Smoothing  
Smoothing of the analog values produces a stable analog signal for further processing. The 
smoothing of analog values is useful when handling wanted signals (measured values) with a 
slow rate of change, for example, temperature measurements.

The measured values are smoothed by digital filtering. To achieve smoothing, the device 
generates a mean value from a specified number of converted (digitized) analog values.

You assign a maximum of four levels for the smoothing (none, weak, medium, strong). The 
level determines the number of module cycles, from which the mean value is generated.

The stronger the smoothing, the more stable the smoothed analog value and the longer it takes 
until the smoothed analog value is applied following a signal change (see the example below).

The figure below shows the number of cycles a module requires to apply the smoothed analog 
value at almost 100% after a step response, based on the smoothing function settings. The 
figure applies to all signal changes at the analog input. The smoothing value defines the 
number of cycles a module requires to reach 63% of the end value of the changed signal.

① Smoothing, weak
② Smoothing, medium
③ Smoothing, strong

Diagnostics, wire break 
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. 

Observe the rules outlined below to handle a wire break in the 1 to 5 V and 4 to 20 mA 
measuring ranges:
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Parameter Event Measured 
value

Explanation

Enable wire break1 Wire break 7FFFH Diagnostics, wire break
Wire break disabled1

 
Underflow enabled

Wire break 8000H Measured value after leaving the 
underrange
 
Diagnostic message Lower limit value 
undershot

Wire break disabled1

Underflow disabled
Wire break 8000H Measured value after leaving the 

underrange
1 Measuring range limits for wire break detection and measuring range undershoot detection:
● 1 to 5 V: At 0.296 V
● 4 to 20 mA: At 1.185 mA

Diagnostics, underflow 
If you enable this parameter, the Underflow diagnostics event is generated when the measured 
value reaches the underflow range.

Diagnostics, overflow 
If you enable this parameter, the Overflow diagnostics event is generated when the measured 
value reaches the overflow range.

Reference junction for thermoresistor (TC) 
A difference in temperature between the measuring point and the free ends of the 
thermocouple (terminal point) generates a voltage between the free ends, namely the 
thermoelectric voltage. The value of this thermoelectric voltage is determined by the 
temperature difference between the measuring point and the free ends and by the type of 
material combination of the thermocouple. Since a thermocouple always measures a 
temperature difference, the free ends at the reference junction must be maintained at a known 
temperature in order to determine the temperature of the measuring point.

If you specify Internal compensation, the temperature of the measuring point in the housing of 
the I/O device is measured. With the External compensation setting, you can connect a 
compensation box in series in order to increase the accuracy of the temperature measurement. 

Parameter description analog output

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.
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Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit
When this parameter is enabled, the system generates a diagnostics event if it detects a short-
circuit of the sensor supply to ground. This diagnostics function is activated when the group 
diagnostics function is enabled.

Response to CPU/Master STOP
Select how the module's outputs will respond to a CPU STOP:

● Shut down
The I/O device goes to the safe state. The process image output is deleted (=0).

● Keep last value
The I/O device retains the last value to be output before STOP.

● Substitute value
The I/O device outputs the value for the channel set beforehand.

 

 
 NOTICE

Make sure that the plant is always in a safe state if "Keep last value" is selected.
 

Type of output
With this parameter, you set the output type, for example, voltage. For any unused channels, 
select the disabled setting. For a disabled channel, the conversion time and integration time 
of the channel = 0 s, and the cycle time is optimized.

Output range
With this parameter, you set the output range of the selected output type.

Diagnostics, wire break (in current mode)
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. This diagnostics event cannot be detected in the zero range.

Diagnostics, short circuit (in voltage mode)
If you enable this parameter, a diagnostics event is generated in the event of a short circuit in 
the output line. This diagnostics event cannot be detected in the zero range.

Diagnostics, overload
If you enable this parameter, the diagnostics event is generated in the event of an overload.
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Substitute values
With this parameter, you enter a substitute value that the module is to output in CPU-STOP 
mode. The substitute value must be in the nominal range, overrange, or underrange.

Signal modules for process automation

Fundamentals

Introduction
Signal modules for the process automation are S7-300 models, such as SM 321; DI 
16xNAMUR or SM 322; DO 16x24VDC/0.5A. 

They are being operated in a DP slave (IM 153-2).

Unlike standard modules, they offer the following additional technical functions, such as pulse 
extension and chatter monitoring. 

See also
Changeover contact (Page 556)

Technological parameters (Page 557)

Changeover contact

"Changeover contact" sensor type
If the digital inputs of a channel group are configured as "changeover contacts", the module 
runs diagnostics for the changeover contact sensor type for this channel group. 

Changeover contact 
A changeover contact is an auxiliary switch with only one moving switch element with one 
close setting each for closed and open switching device. 

Remember the following rule:

● Always connect a normally open contact to the "even" channel

● Always connect a normally closed contact to the "odd" channel.

The tolerated switchover time between the two channels is fixed at 300 ms.

If the result of the check is negative, then

● the module identifies the value status of the normally open channel as "invalid"

● the module generates a diagnostic entry for the normally open channel

● triggers a diagnostic interrupt (if diagnostic interrupts have been enabled)

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
556 System Manual, 08/2011,  



The digital input signal and the value status are updated only for the normally open channel. 
For the normally closed channel, the digital input signal is set permanently to "zero" and the 
value status to "invalid" since this channel is used only to check the sensor.

Diagnostics depends on the "Selection" parameter (of the sensor). You should also note the 
special features of diagnostics with the changeover contact sensor type in the "Signal Modules 
for Process Automation" manual.

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)

Technological parameters

Pulse extension and flutter monitoring
Pulse extension is a function for changing a digital input signal. A pulse at a digital input is 
extended to at least the length set in the parameters. If the input pulse is already longer than 
the specified length, it is not changed. 

If you want the pulse to be extended, click in the box to select the time. If you do not want the 
pulses to be extended, select the "---" entry.

Flutter monitoring is a process control function for digital input signals. It detects and reports 
signal changes that are unexpected in process control, for example when an input signal 
fluctuates too often between "0" and "1". 

Flutter monitoring is possible only when group diagnostics has also been enabled for this input. 

Monitoring window and number of signal changes
Flutter monitoring works with aid of the two parameters Monitoring window and Number of 
signal changes.

The first time the signal changes, the time set as the monitoring window is started. If the signal 
changes more often during this time than allowed by the number of signal changes parameter, 
this is signaled as a flutter error. If no flutter error is detected during the monitoring window 
time, the monitoring window can be restarted at the next signal change.

 

 Note

If you set pulse extension for an input channel, this also affects the flutter monitoring enabled 
for this channel. The "extended pulse" signal is the input signal for the flutter monitoring. You 
should therefore make sure that the values set for pulse extension and flutter monitoring are 
compatible with each other. 

 

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)
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Frequency converters

Use of the frequency converter

Frequency converters
The frequency converter ICU24 and ICU24F ( as fail-safe version) are modular design 
frequency converters that are completely embedded in the distributed I/O system ET 200S. 
For parameterization of both modules, please see the following.

Message frame
The message frame number and the operating mode of the module are only displayed and 
cannot be modified.

Application ID
You indicate the saved parameters in the frequency converter as a whole with the application 
ID. Enter an application ID from the value range 0 to 65535. During startup (or pull/plug), this 
ID is compared with the application ID stored on the converter.

Converters that work with identical applications are usually also identically parameterized and 
should be identified with the same application ID. Converters with the same application ID may 
be exchanged between each other. Copying of the complete parameterization of a converter 
to another converter, for example, via an MMC, is only accepted, if both have the same 
application ID.

Converters that work with different applications and are parameterized differently must be 
identified by different application IDs. This prevents a converter with unsuitable 
parameterization from starting on an incorrect slot, i.e. on the wrong application. This also 
prevents the parameterization that is saved in the converter from being accidently overwritten 
with any parameteriation that is stored on an MMC.

Enable diagnostic interrupt
You can enable the diagnostic interrupt for the frequency converter. If diagnostic interrupt is 
enabled, an OB 82 must be available in a CPU to process the diagnostic events.

See also
Documentation for the frequency converter (http://support.automation.siemens.com/WW/view/
en/26291825/0/en)
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IQ sense module

Properties of 4 IQ-SENSE

Properties   
The 8 IQ-SENSE module has the following properties:

● Connection of sensors with IQ-SENSE®, photoelectric proximity switches: for example, 
reflex sensors, diffuse sensors, and laser sensors.

● It can be used centrally in an S7-300 or distributed in an ET 200M.

● You can connect up to 8 sensors to every module. Each sensor requires a two-wire cable.

● Function reserve that can be assigned parameters.

● Time functions, switching hysteresis, synchronous mode that can be assigned parameters

● Sensitivity and distance values can be specified (IntelliTeach using the "IQ-SENSE Opto" 
FB)

● Teach-in

● Sensors can be removed and inserted during operation (automatic reassignment of 
parameters)

See also
Sensor type (Page 559)

Switching hysteresis (Page 560)

Time function,time value (Page 561)

Sensor type
This parameter is used to set the sensor type per channel:

● Reflex sensor or

● Diffuse sensor or

● De-activated
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Diffuse sensor

Table 8-7 Diffuse sensor

Diffuse sensor Object  
Transmitter
Receiver

Circuit state 0: no object detected, i.e. the 
object is not in the beam. The receiver 
does not see any light.

Transmitter
Receiver

Circuit state 1: object detected, i.e. the 
object is in the beam. The receiver does 
not see any light.

Reflex sensor

Table 8-8 Reflex sensor

Reflex sensor Object  
Transmitter
Receiver

Circuit state 0: no object detected, i.e. the 
object is not in the beam. The receiver sees 
light.

Transmitter
Receiver

Circuit state 1: object detected, i.e. the 
object is in the beam. The receiver does 
not see any light.

Switching hysteresis
Faults with the diffuse sensor or in the production process can result in signal wobbles. The 
measured value then changes the switching threshold by 100 % (object detected - object not 
detected). You can prevent this switching threshold wobble using the switching hysteresis 
parameter. This will ensure a stable output signal on the sensor.

You can assigned parameters to 5 %/10 %/20 %/50 % for switching hysteresis.

Prerequisites
You can only set the switching hysteresis parameter for diffuse sensors with background 
fadeout.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
560 System Manual, 08/2011,  



Operating principle

Figure 8-3 Switching hysteresis parameter

Time function,time value
These parameters can be used to set the electronic module for its specific application.
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Operating principle

Figure 8-4 Time functions, time values parameters
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8.1.5.3 Parameters of analog modules

Measurement types with thermocouples

Differences in the measurement types with thermocouples
● Thermocouples with reference junction

TC-IL (internal reference junction, with linearization): Linearization of the characteristic and 
temperature compensation with the temperature of the internal reference junction (module 
clamping point) as the reference temperature.
TC-EL (external reference junction, with linearization): Linearization of the characteristic 
and temperature compensation with the temperature of the external reference junction as 
the reference temperature.

● Thermocouples with reference temperature
TC-L00C (0 ºC reference junction, with linearization): Linearization of the characteristic and 
temperature compensation with 0 °C / 32 °F
TC-L50C (50 ºC reference junction, with linearization): Linearization of the characteristic 
and temperature compensation with 50 °C / 122 °F

Interference frequency suppression and integration time

Interference frequency suppression and integration time
The following table illustrates the interaction:

Interference 
frequency suppression 
(Hz)

Integration 
time 
(ms)

60 16,6
50 20

With some modules, you can set other frequencies for the interference frequency suppression: 

Interference 
frequency suppression 
(Hz)

Integration 
time 
(ms)

10 100
400 2,5
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8.1.6 System diagnostics with 'Report System Errors'

8.1.6.1 Introduction to system diagnostics with 'Report System Errors'

Introduction  
When a system error occurs, hardware components and devices of other manufacturers 
(slaves whose properties are set by the GSD files) can trigger organization block calls.  

Example: If a wire breaks, a module with diagnostics capability can call OB 82. 

The hardware components provide information on the system error that has occurred. The 
start event information, in other words, the local data of the assigned OB (including data record 
0), provides general information on the location (for example, logical address of the module) 
and type (for example channel error or module fault) of the error. 

The problem can also be specified in greater detail using additional diagnostics information 
(reading data record 1 with the "RDSYSST" instruction or reading the diagnostics frame from 
standard DP slaves with the "DPNRM_DG" instruction): For example, channel 0 or 1, broken 
wire or measuring range exceeded. 

System diagnostics with "Report System Errors" (RSE) provides you with a convenient way 
of evaluating this diagnostics information for S7-300/400 PLCs, ET200S, ET200Pro and 
software PLCs and to display it in the form of messages. The required blocks and alarm texts 
are created in the properties of the particular PLC. You only need to download the generated 
blocks to the CPU and, if required, transfer the texts to connected HMI devices. 

To display diagnostics events graphically, for example on an HMI device or via a Web server, 
you can generate one or more status DBs. These status DBs are updated by the system 
diagnostics blocks and then contain information on the current state of the system. 

 

8.1.6.2 Basics of system diagnostics
Using system diagnostics with "Report System Errors", you can generate blocks that analyze 
errors in the system and generate alarms with a textual error description and the error location.

These alarms are defined per component with alarm capabilities (for example channel errors 
or rack errors) and are limited to 255 alarms component with alarm capability. You will receive 
a message if this limit is exceeded.

General settings that you make or change in system diagnostics are stored along with the 
project. The influence on the system diagnostics only takes effect after generating the blocks, 
compiling the hardware configuration and downloading the configuration to the components 
involved.

Recommended procedure
Make the settings for reporting system errors and the structure of the alarms. Specify which 
diagnostics blocks will be created. Configure the OBs, Status DBs, as well as the PLC in STOP. 
Generate the blocks and download the configuration to apply the changes.
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You will find detailed information in the sections below.
 

 Note

If you use system diagnostics, the system response of the plant may change if an error occurs. 
For example, the CPU may not change to "STOP" mode as it would without system 
diagnostics. 

Make sure that all protective mechanisms of the plant are working properly.
 

8.1.6.3 Components supported
The following components are supported:

● S7-300 CPUs

● S7-400 CPUs

● S7-400 power supply modules

● PN/PN Coupler

● DP/DP Coupler

● IE/PB-Link

● AS-i CP

● ET 200S

● ET 200M

● ET 200eco

● ET 200R

● ET 200Pro

● ET 200L

● Diagnostics repeater

● GSD-based slaves

● GSDML-based slaves

● ET 200iSP

● IO-Link

● Software CPUs

8.1.6.4 Diagnostics blocks for reporting system errors
Once you have made the settings for reporting system errors, the required blocks (FB with 
assigned instance DB and one or more global DBs, an FC and, depending on the setting, also 
OBs that do not yet exist) and status DBs are created the next time you compile the hardware 
configuration. 

The following blocks are created:
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● Diagnostics FB (default: FB 49),

● Instance DB for the diagnostics FB (default: FB 49),

● Global DB (default: FB 50),

● Diagnostics FC (default: FC 49),

● Error OBs (if you have selected this option in the "OB configuration" group box),

● Cyclic OBs (if you have selected this option in the "OB configuration" group box),

● Optional status DBs

The created blocks (except OBs) are stored in the project tree under "Program blocks > System 
blocks > Report System Errors". 

See also
Properties of the blocks (Page 566)

8.1.6.5 Properties of the blocks

Diagnostics blocks   
The created diagnostics blocks (FB with assigned instance DB and one or more global DBs 
and an FC) evaluate the local data of the error OB and read any additional diagnostics 
information from the hardware component that triggered the error. 

They have the following properties:

● Created in RSE language (report system errors) (also applies to the blocks listed above)

● Know-how protected (also applies to the blocks listed above)

● Delay incoming interrupts during runtime

Status DBs
The Status DBs are used as the interface for diagnostic blocks and make it possible to 

 

See also
Settings for system diagnostics blocks (Page 578)
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8.1.6.6 Supported error OBs
The following error OBs are created if they are also supported by the configured CPU:   

OB Diagnostics FB call Description
OB 70 (IO redundancy error) possible This OB exists only with H-CPUs.
OB 72 (CPU redundancy error) possible This OB exists only with H-CPUs.
OB 73 (communications 
redundancy error)

possible This OB exists only with a few H-
CPUs.

OB 81 (power supply error) possible  
OB 82 (diagnostics interrupt OB) possible  
OB 83 (pull/plug interrupt) possible  
OB 85 (program execution error) not possible If 'RSE' creates this OB when it 

is generating the diagnostics 
blocks, additional networks are 
inserted to implement the 
following program sequence:
● If errors occur when updating 

the process image (for 
example removing the 
module), the CPU is 
prevented from changing to 
STOP so that the diagnostic 
FB can be run in OB 83. If 
there is a setting for "CPU 
STOP" after an alarm from 
"RSE", this takes effect in OB 
83.

● With all other error events of 
OB 85, the CPU changes to 
STOP.

OB 86 (failure of an expansion 
rack, a DP master system or a 
distributed I/O device)

possible  

If the OBs already exist...
Existing error OBs on not overwritten. If appropriate, the call for the diagnostics FB is appended 
in the existing OB. 

If the configuration includes distributed I/O devices...
To evaluate errors in the distributed I/O, the created FB automatically calls the "DPNRM_DG" 
instruction (read diagnostics data of the DP slaves). For this function to operate correctly, the 
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created FB must be called either only in OB 1 or in a cyclic interrupt OB with a short call interval 
and in the startup OBs. 

 

 NOTICE

Please note the following:
● Due to the OB 85 created by "RSE", the CPU does not change to STOP if the "error 

updating the process image" error event occurs.
● OB 85 is also called by the CPU in the following error situations.

– "Error event for an OB that is not loaded"
– "Error calling or accessing a block that is not loaded"

In these error situations, the OB 85 generated by "RSE" still changes the CPU to STOP 
in the same way as prior to the use of "RSE".

● The setting "PLC in STOP" does not have any effect in OB 85, because this OB of the 
"RSE" FB is not called. This setting is taken into account indirectly by the FB call in OB 
83.

 
 

 

See also
Settings for OB configuration (Page 579)

8.1.6.7 Overview of the status DBs
Within system diagnostics, you have the option of creating status DBs. These status DBs are 
updated by the system diagnostics blocks and then contain information on the current state of 
the system. The following status DBs are available:

● The diagnostics status DB (default: DB 127) displays the state of racks, and central 
modules, PROFIBUS slaves and IO devices.

● The PROFINET IO DB (default: DB 126) displays the state of IO devices in I/O systems 
and the state of DP slaves in DP master systems downstream from an IE/PB-Link.

● The PROFIBUS DP DB (default: DB 125) displays the status of PROFIBUS slaves in DP 
master systems.

 

8.1.6.8 Diagnostics status DB

Interface for the diagnostics status DB
The created data block (default: DB 127) allows you to query the system state of a configured 
component and, if required, all its lower-level components. 
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This data block is required to support system diagnostics using the Web server or diagnostics 
viewer. As default, it is enabled. 

 

 NOTICE

Please note that system diagnostics must be activated both on the Web server or diagnostics 
viewer and in the Inspector window of the PLC to be able to display diagnostics data of the 
status DBs.

 

After restarting a CPU with Web server, the module state is displayed following a delay. To 
shorten the waiting time, you can call the RSE diagnostics block in a cyclic interrupt OB.

Structure of the diagnostics status DB
 

Address Name Data type Description
+0 Directory   
0 D_Version WORD Version supported by system diagnostics
2 D_pGlobalState WORD Byte offset to the start of the "GlobalState" section
4 D_pQuery WORD Byte offset to the start of the "Query" section
6 D_pComponent WORD Byte offset to the start of the "Component" section
8 D_pError WORD Byte offset to the start of the "Error" section
10 D_pState WORD Byte offset to the start of the "State" section
12 D_pAlarm WORD Byte offset to the start of the "Alarm" section
14 D_pSubComponent WORD Byte offset to the start of the "Subcomponent" 

section
+16 GlobalState   
0 G_EventCount WORD ID of the last event (counter)
2.0 G_StartReporting BOOL Startup evaluation active
+20 Query   
0 Q_ClientID_User DWORD ID of the client; here, please use a value between 

1 and 255. Make sure that different clients use 
different IDs.

4 Q_ClientID_Intern DWORD ID of the client (internal)
8.0 Q_WithSubComponent BOOL With/without status of the lower-level components 

(slower)
8.1 Q_SubComponentAlarm BOOL AS-i master returns AS-i slave interrupts
8.2 Q_Reserved2 BOOL Reserved
8.3 Q_Reserved3 BOOL Reserved
8.4 Q_Reserved4 BOOL Reserved
8.5 Q_Reserved5 BOOL Reserved
8.6 Q_Reserved6 BOOL Reserved
8.7 Q_Reserved7 BOOL Reserved
9.0 Q_Start BOOL Start query
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Address Name Data type Description
10 Q_Error BYTE Internal error in query
11 Q_Reserved8 BYTE Reserved
+32 Component   
0 C_AddressMode BYTE Addressing mode of the module
1 C_Reserved1 BYTE Reserved
2 C_ComponentID WORD Hardware ID of the component (internal)
+36 Error   
0 E_ErrorNo WORD Index of the requested/actual error
2.0 E_LastError BOOL Is set when E_ErrorNo does not equal 0. Value 

TRUE if E_ErrorNo is the index of the last error 
otherwise FALSE

2.1 E_Reserved ARRAY [1 to 
15]
BOOL

Reserved

+40 State   
0 S_Hierarchy BYTE Reserved
1 S_Periphery BYTE Reserved
2.0 S_SupFault BOOL The component cannot be reached
2.1 S_NotAvailable BOOL The component does not exist
2.2 S_Faulty BOOL The component is faulty, the "Alarm" section is not 

empty
2.3 S_MoreErrors BOOL There are more errors than system diagnostics can 

store
2.4 S_Maintenance1 BOOL A maintenance request is pending
2.5 S_Maintenance2 BOOL A maintenance demand is pending
2.6 S_Deactivated BOOL The component was deactivated *)
2.7 S_Reserved2 BOOL Reserved
3.0 S_SubFault BOOL A subcomponent is faulty
3.1 S_SubMaintenance1 BOOL A maintenance request is pending for a 

subcomponent
3.2 S_SubMaintenance2 BOOL A maintenance demand is pending for a 

subcomponent
3.3 S_SubDeactivated BOOL A subcomponent is deactivated
3.4 S_Reserved4 BOOL Reserved
3.5 S_Reserved5 BOOL Reserved
3.6 S_Reserved6 BOOL Reserved
3.7 S_Reserved7 BOOL Reserved
4 S_TIAMS DWORD Maintenance state of the component
8 S_TIAMSChannelExist DWORD Maintenance state: Configured channels
12 S_TIAMSChannelOK DWORD Maintenance state: Faulty channels
16 S_ChannelCount WORD Number of channels; valid only when 

Q_WithSubComponent is set
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Address Name Data type Description
18.0 S_ChannelVector ARRAY [0 to 

255]
BOOL

Number of channels affected; valid only when 
Q_WithSubComponent is set

+90 Alarm   
0 A_ComponentID WORD Hardware ID of the component (internal)
2 A_TextID1 WORD ID of the first error text
4 A_TextLexikonID1 WORD ID of the first error text lexicon
6 A_HelpTextLexikonID1 WORD ID of the first help text lexicon
8 A_MapTextID WORD ID of the first error text (HMI)
10 A_MapHelpTextID WORD ID of the first help text (HMI)
12 A_TextID2 WORD ID of the second error text
14 A_TextLexikonID2 WORD ID of the second error text lexicon
16 A_HelpTextLexikonID2 WORD ID of the second help text lexicon
18 A_MapTextID2 WORD ID of the second error text (HMI)
20 A_MapHelpTextID2 WORD ID of the second help text (HMI)
22 A_AlarmID DWORD Alarm number
26 A_ValueCount WORD Number of further bytes occupied (12)
28 A_AssociatedValue ARRAY [1 to n]

WORD
Associated values of the alarm
n = A_ValueCount / 2 (= 6)

+130 SubComponent   
0 U_SubComponentCount WORD Number of subcomponents
2 U_SubComponentFault ARRAY [1 to 

n] 
BYTE

List of subcomponents
"n" depends on the configuration **)

    

*) If the component was deactivated, the index of the requested/actual error is not changed 
and "E_LastError" is set to "true". The tag area of the alarm is also not filled in. 

**) The list of subcomponents is valid only when Q_WithSubComponent is set. The ARRAY 
has a status byte for each configured component. For a master, the ARRAY contains the status 
of the configured stations sorted in ascending order according to the station ID. For a station, 
the ARRAY contains the status of the configured slots sorted in ascending order according to 
slot number. This field can contain a maximum of 4096 entries (for an IO system): only the 
actual maximum size is displayed. 
The status byte for each lower-level component is defined as follows: 
Bit 0 = SubFault: the component cannot be reached
Bit 1 = Fault: the component is not available or faulty
Bit 2 = Maintenance1: the component has reported a need for maintenance
Bit 3 = Maintenance2: the component has reported a need for maintenance
Bit 4 = Deactivated: the component was deactivated
Bit 5 = SubFault: a subcomponent is faulty
Bit 6 = SubMaintenance1: the component has reported a need for maintenance
Bit 7 = SubMaintenance2: a subcomponent has reported a need for maintenance
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8.1.6.9 PROFINET IO DB

Interface for the PROFINET IO DB
The generated data block represents the current status of all configured IO devices and can 
describe the status of a device in greater detail in response to a query from an HMI device. 
The data block is generated dynamically and depends on the hardware configuration. The DB 
uses the diagnostics FB generated by system diagnostics to access the diagnostics data. The 
current status of the devices is entered in the DB directly by this FB.

Only one HMI device (for example OP, MP, PC) can access the DB. If several HMI devices 
are connected, simultaneous access is interlocked using the HMI_ID tag.

 

 Note

The diagnostics downstream from an IE/PB-Link is restricted.
 

Structure of the PROFINET IO DB

Address Name Data type Description
0 HMI_ID WORD No. of the OP that uses the DB (0 = unused)
2 System_No WORD No. of the IO system to be investigated
4 Device_No WORD No. of the IO device to be investigated
6.0 Enable BOOL Calls up the errors of the specified device
6.1 Next_Error BOOL Calls up the next error of the specified device
6.2 Busy BOOL Busy = 1; evaluation active
6.3 More_Errors BOOL There are more error messages
7 Device_Status BYTE Status of the affected device
8 Offset_System_Header WORD Address of Detail_IO_Sys[n] in the system being evaluated
10 Offset_System_Array WORD Address of IO_Sys[n] in the system being evaluated
12 Vendor_ID WORD Vendor ID is filled out if it is supported by the CPU
14 Device_ID WORD Device ID is filled out if it is supported by the CPU
16 Error_Level BYTE Error level 1=IO device, 2=module, 3=submodule, 4=channel
17  BYTE Reserved
18 Module_No WORD No. of the module affected
20 Submodule_No WORD No. of the submodule affected
22 Channel_No WORD No. of the channel affected
24 Error_Cat DWORD Category of the error (lexicon ID)
28 Help_Cat DWORD Category of the error in the help lexicon
32 Error_No DWORD Number of the error (index in help lexicon)
36 Map_ErrorNo WORD The number of the error text
38 Map_HelpNo WORD The number of the help text
40 Number_IO_Sys WORD Number of configured IO systems
42 Systems_Status WORD Overview of all IO systems
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Dynamic tag area

 Name Type Comment
Once Detail_IO_Sys Struct[n] Array of structures per IO system
Per IO system System_No Word System number
 Max_Num_Dev Word Maximum ID of the configured devices
 Offset Word Offset to the start of the field in bytes relative to Detail_IO_Sys
 Devices_Affected Word Number of devices affected
 Offset_Status Word Offset to the start of the IO_Sys_Status field in bytes 

regardless of Detail_IO_Sys
Per device IO_Sys_<n> ARRAY OF 

WORD[n]
Status of the groups, 1 bit for 16 devices. The table is large 
enough to include all configured devices (Max_Num_Dev).

Status of a device in the overview IO_Sys_<n>
 

Status OK faulty failed not configured
Coding 
(bit b+1, bit b)

00 01 10 11

 

Byte N    N+1    
Bit 6-7 4-5 2-3 0-1 6-7 4-5 2-3 0-1
IO_Sys_<n>[0]: Device number 4 3 2 1 8 7 6 5
IO_Sys_<n>[1]: Device number 12 11 10 9 16 15 14 13
...         

Status of a device group in the overview IO_Sys_Status_<n>
 

Status All devices of the group are OK or not 
configured

At least one device of the group is faulty or failed

Coding 0 1

 

Byte N   N+1   
Bit 7 ... 0 7 ... 0
IO_Sys_Status_<n>[0]: Device number 113-128 17-112 1 - 16 241 - 256 145 - 240 129 - 144
Group 8 2 - 7 1 16 10 - 15 9
...       
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8.1.6.10 PROFIBUS DP DB

Interface for the PROFIBUS DP DB
The generated data block represents the current status of all configured stations of the current 
DP master system and can describe the status of all DP slaves in greater detail in response 
to a query. The data block is generated dynamically and depends on the hardware 
configuration. The DB uses the diagnostics FB generated by system diagnostics to access the 
diagnostics data. The current status of the DP slaves is entered in the PROFIBUS DB directly 
by this FB.

During the processing of the PROFIBUS DB, all interrupts are delayed.
 

 Note

Diagnostics is not possible with the master system of an IE/PB-Link. Diagnostics is performed 
using the PROFINET IO DB.

 

"Manual" mode
In this mode, all errors of the selected station are displayed one after the other.

"Automatic" mode
In this mode, the errors of all configured stations are displayed one after the other.

Structure of the PROFIBUS DP DB

Address Name Data type Description
0 DP_MASTERSYSTEM INT Number of the DP master system
2.0 EXTERNAL_DP_INTERFACE BOOL External DP interface (CP/IM)
2.1 MANUAL_MODE BOOL Mode
2.2 SINGLE_STEP_SLAVE BOOL Move on to the next station affected
2.3 SINGLE_STEP_ERROR BOOL Move on to the next error
2.4 RESET BOOL DP master system (number and interface) are 

adopted: everything re-initialized
2.5 SINGLE_DIAG BOOL DP slave single diagnostics
3 SINGLE_DIAG_ADR BYTE DP slave address in single diagnostics
4.0 ALL_DP_SLAVES_OK BOOL Group indicator showing whether or not all DP 

slaves are operating error-free
5 SUM_SLAVES_DIAG BYTE Number of stations affected (faulty or failed)
6 SLAVE_ADR BYTE Station number of the current station
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Address Name Data type Description
7 SLAVE_STATE BYTE Status of the station:

0:o.k. 
1:failed
2:faulty
3:not configured/diagnostics not possible

8 SLAVE_IDENT_NO WORD PROFIBUS identification number
10 ERROR_NO BYTE Current error number
11 ERROR_TYPE BYTE 1:Slot diagnostics (general information) 

2:Module status 
3:Channel diagnostics to DP standard
4:S7 diagnostics (DS0/DS1) 
5:Device diagnostics (vendor-specific) 
6:Cable diagnostics (diagnostics repeater)
7: Decoded device diagnostics

12 MODULE_NO BYTE Slot number.
13 CHANNEL_NO BYTE Channel number.
14 CHANNEL_TYPE BYTE Channel type
15 CHANNEL_ERROR_CODE BYTE Error code
16 CHANNEL_ERROR_INFO_1 DWORD Channel error code 1
20 CHANNEL_ERROR_INFO_2 DWORD Channel error code 2
24 DIAG_COUNTER BYTE Sum of all the diagnostics information of the 

displayed station
25.0 DIAG_OVERFLOW BOOL Diagnostics overflow
25.1 BUSY BOOL Evaluation active
932 - 1176 DIAG_DAT_NORM BYTE [1 to 

244]
Slave diagnostics data

1176 - 1191 CONFIG_SLAVES DWORD [1 to 
4]

Configured slaves

1192 - 1207 EXIST_SLAVES DWORD [1 to 
4]

Existing (addressable) slaves

1208 - 1223 FAILED_SLAVES DWORD [1 to 
4]

Failed slaves

1224 - 1239 FAULTY_SLAVES DWORD [1 to 
4]

Faulty slaves

1240 - 1255 AFFECT_SLAVES DWORD [1 to 
4]

Slaves affected (faulty or failed)

1256 - 1271 AFFECT_SLAVES_MEM DWORD [1 to 
4]

Stored affected slaves (internal)

1272 - 1397 DIAG_CNT BYTE [1 to 
126]

Number of diagnostics per slave

1404 ERROR_CAT DWORD Text lexicon ID of the error text
1408 HELP_CAT DWORD Text lexicon ID of the help text
1412 ERROR_NO DWORD Text ID in the text lexicon
1416 MAP_ERRORNO WORD Error ID
1418 MAP_HELPNO WORD Help text ID
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Address Name Data type Description
1420 MASTERSTATUS_FAILED BOOL [1 to 32] True if at least one station of the PROFIBUS 

master system (1 to 32) has failed
1424 MASTERSTATUS_FAULTY BOOL [1 to 32] True if at least one station of the PROFIBUS 

master system (1 to 32) is faulty

8.1.6.11 Displaying settings of system diagnostics

Requirement
You are in the "Properties" area of the Inspector window of the required PLC.

Procedure
To display and edit the settings for system diagnostics, follow these steps:

1. Click "System diagnostics" in the area navigation of the Inspector window. In the right-hand 
part of the Inspector window, you can display and edit the various settings.

8.1.6.12 Basic settings

General settings
Here, you can decide which options will be enabled when the diagnostic block executes.  

Enabling system diagnostics for this PLC (RSE)
This option is enabled by default. 

 
 

 NOTICE

If you disable this option, no diagnostics data is read out in the Web server and diagnostics 
viewer either even if the option is enabled there.

If you disable this option on a PLC on which it was previously enabled, all the diagnostic data 
is deleted the next time you compile the hardware configuration.  

 

Send alarms  
This option is enabled by default. The diagnostics block then sends alarms as a reaction to 
system errors. 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V11.0 SP1
576 System Manual, 08/2011,  



Download system diagnostics block when downloading hardware configuration
Enable this option if you want the diagnostics blocks to be generated or updated each time 
the hardware is compiled. So make sure that the generated alarms are up to date even after 
modifying the hardware configuration.

 

Settings for configuring alarms
You can adapt the structure and texts of the alarms created by system diagnostics and the 
alarm attributes freely for each reporting component.  

Alarming component
Select the component (for example module or rack) for which you want to configure the alarm 
text. 

Available alarm information
Select the entries you want to include in the alarm and click of one of the arrow buttons to 
include the dynamic information in the event text or info text. Regardless of your selection, the 
start of each alarm indicates whether it is entering or exiting state or is an alarm requiring 
acknowledgment and when the error/fault occurred. 

See also
Adapting event text/info text (Page 577)

Adapting event text/info text
You can adapt texts to match your requirements by positioning the cursor on the required 
position in the box and modifying the text. Event texts and info texts can have one or more 
lines. Tags output by the software (for example <rack number>) are displayed in pointed 
brackets. If you modify these, they are no longer tags. 

See also
Settings for configuring alarms (Page 577)

Attributes
The default alarm attributes "Priority", "Group ID" and "Display class" and the options "Logging" 
and "With acknowledgement" can be set separately for each individual reporting component.

You will find more detailed information on the alarm attributes in the description of "Configuring 
alarms".
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Settings for system diagnostics blocks
As default, the following values are set for the system diagnostics blocks: 

Block Name Number
Diagnostics FB RSE_FB 49
Diagnostics DB RSE_DB 49
first global DB RSE_GLOBAL_DB 50
Diagnostics FC RSE_FC 49

 

You can, however, assign different numbers and/or names for these blocks as long as they 
are not already being used.

 

Settings for diagnostics support
With the help of diagnostics support, diagnostics data is made available in special status DBs 
by the diagnostics FB. This can then be displayed graphically, for example on an HMI device. 

Status DBs
Enable the required status DB to read out the current system status of configured components 
via this data block.

The following status DBs are set as defaults:

Block Name Number
Diagnostics status DB RSE_DIAGNOSTIC_STATUS_

DB
127

PROFINET IO DB RSE_PROFINET_IO_DB 126
PROFIBUS DP DB RSE_PROFIBUS_DP_DB 125

 

You can, however, assign different names and/or number for these blocks as long as they are 
not already being used. 

If the "Enable Web server on this module" functionality is enabled in the properties of the CPU, 
the diagnostics status DB must be enabled. As default, DB 127 is generated if the CPU 
supports the Web server and if this is enabled in the properties of the CPU. 

 

 Note

The status DBs "PROFINET IO DB" and "PROFIBUS DP DB" only have limited diagnostics 
functionality. It is therefore preferable to use the "diagnostics status DB".
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Extended diagnostics settings
This query is only possible if the PLC includes the "D_ACT_DP" instruction. 

Enable the option "Query for status "activated/deactivated" after PLC startup" if you want the 
status of slaves to be queried. 

Enable the "Send alarm if status changes from/to activated or deactivated" if you want an alarm 
to be output when there is a status change. To use this option, execute the "D_ACT_DP" 
instruction in mode 3/4 and select the diagnostics DB call in OB 86 in the "OB configuration" 
group.

8.1.6.13 Advanced settings

Settings for OB configuration
Here, you can make the settings you require for OBs. 

● Error OBs

● Cyclic and startup OBs

The OBs that are supported by system diagnostics and the CPU are displayed in the "OB" 
column.

The "Exists" column indicates whether the OB already exists. This column cannot be edited.

In the "Create OB" column, you can choose whether or not the OB should be generated if it 
does not already exist. 

In the "Call system diagnostics block" column, you can set the system diagnostics FB call if 
the OB already exists or will be generated. You can also remove an existing call again. If OBs 
exist that were not written in LAD/FBD or STL, it is not possible to insert or delete the call.

 

 Note
● Error OBs: Before the function will execute correctly, system diagnostics must be called 

in all supported error OBs. There is an automatic check to determine whether or not these 
requirements are met.

● Cyclic and startup OBs: Before the function will execute correctly, system diagnostics 
must either be called in OB 1 or in a cyclic interrupt OB (30 - 38) and in all startup OBs. 
There is an automatic check to determine whether or not these requirements are met.

 

 

See also
Supported error OBs (Page 567)

Settings for "PLC in STOP"
Here, you can decide whether or not the PLC changes to STOP mode if a system error within 
an error class occurs.  
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The following table shows the available error classes and their meaning: 

Error class Meaning
Rack error Errors triggered by OB 86.
Component error ● Errors in data record 0 triggered by OB 82 

(global module errors)
● Remove/insert module error triggered by OB 

82 (DPV0) or OB 83 (central module, DPV1 
and PROFINET)

Channel error Channel errors triggered by OB 82 (data record 1, 
standard DP slave channel error, PROFINET 
channel error)

Subcomponent error Error on a subcomponent with a subslot >= 1.

 
 

 Note

In "Startup" mode, the PLC does not change to STOP regardless of the settings you made. 
 

See also
Assignment of error classes to system errors (Page 580)

Assignment of error classes to system errors
The following table shows which system error is assigned to which error class:

Hardware Error Error class
Central   
Rack Failure Rack error
Power supply module/CPU Power supply error  - *
H-CPU Loss of redundancy  - *
 Return of redundancy  - *
Module Removal/insertion of module or 

wrong module type
Component error

 Data record 0 Component error
 Channel error Channel error
DP master Failure Rack error
IO controller Failure Rack error
AS-i master Failure Rack error
PROFIBUS DP   
DP station Failure Rack error
 Vendor-specific diagnostics  - *
Head Vendor-specific diagnostics  - *
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Hardware Error Error class
Module Removal/insertion of module or 

wrong module type
Component error

 Data record 0 Component error
 Channel error Channel error
Diag. rep head Specific errors of the diagnostic 

repeater
 - *

Head ET 200 B, C, U, Eco Disrupted Component error
H-station Failure Rack error
Head H-station Loss of redundancy  - *
PROFINET IO   
IO device Failure Rack error
IO device head module Vendor-specific errors  - *
 Channel error Channel error
 Maintenance  - *
 Data record 0 Component error
 Channel error for the entire head 

module (subslot = 0)
Component error

IO device head submodule 
(PDEV)

Channel error Channel error

 Maintenance  - *
 Data record 0 Component error
 Channel error for the entire head 

submodule (subslot = 0)
Subcomponent error

Module Removal/insertion of module or 
wrong module type

Component error

 Data record 0 Component error
 Channel error (channel 0...7FFF) Channel error
 Channel error for the entire 

module (subslot = 0)
Component error

 Maintenance (channel 0...7FFF)  - *
 Maintenance (entire module)  - *
Submodule Removal/insertion of module or 

wrong module type
Subcomponent error

 Data record 0 Component error
 Channel error (channel 0...7FFF) Channel error
 Channel error for the entire 

submodule (subslot >= 1)
Subcomponent error

 Maintenance (channel 0...7FFF)  - *
 Maintenance (entire submodule)  - *
IE/PB-Link Failure Rack error
PROFIBUS station downstream 
from a link

Failure Rack error

AS-i slave   
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Hardware Error Error class
AS-i slave
PROFIBUS/central channel error

Failure  - *

AS-i slave
PROFINET module

Failure  - *

* The CPU does not change to STOP mode.
 

 Note

In "startup" mode, the CPU does not change to STOP. 
 

See also
Settings for "PLC in STOP" (Page 579)

8.1.7 Displaying alarms

8.1.7.1 Overview of the alarm display
The "Alarm display" function can be used to output asynchronous alarms of diagnostics events 
and user-defined diagnostics alarms as well a alarms from ALARM instructions.

From the alarm display, you can also start the alarm editor with the "Edit alarm" shortcut menu 
command and then create user diagnostic alarms.

Icons   
The following table shows the icons and their functions:

Icon Function

Archive view

Shows the alarms located in the archive. 

Active alarms

Shows the currently active (pending) alarms. 
Alarms that must be acknowledged are shown in 
bold characters. 

Ignore

Ignores the arrival of alarms, These alarms are 
neither shown in the window nor stored in the 
archive. 

Acknowledge

Confirms the selected alarm as read. Alarms 
requiring acknowledgment are shown in bold 
characters. 

Clear archive

Deletes all alarms in the archive. 
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Icon Function

Export archive

Exports the current alarm archive to a file in xml 
format. 

Decimal/Hexadecimal

Displays the alarm numbers in decimal/
hexadecimal notation.

8.1.7.2 Archive view
In the archive view, alarms are displayed and archived according to the time they appear. You 
can set the size of the archive (between 200 and 3000 alarms) with the menu command 
"Options > Settings > Online & Diagnostics". If the selected archive size is exceeded, the oldest 
alarm it contains is deleted.

Alarms that must be acknowledged are displayed in bold characters and can be acknowledged 
with the context menu command "Acknowledge alarm(s)".

The archive is constantly updated and does not need to be saved explicitly.

 

8.1.7.3 Layout of the alarms in the archive view
In the archive view, all events occurring on the selected CPUs are logged. A new entry is 
created for each individual event and shown as a further row in the table.

Table structure
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed. 

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgement or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in bold print 
and can be acknowledged either context-sensitive with the button in the toolbar or with the 
shortcut menu command "Acknowledge alarm(s)".

8.1.7.4 Receiving alarms
To allow alarms to be displayed, you must first set the receipt of alarms for each CPU. 
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Procedure
Toe receive alarms, follow these steps: 

1. Double-click on the "Online & Diagnostics" folder of the relevant CPU in project navigation.

2. Click the "Settings" group in area navigation.

3. Select the option "Receive alarms".

Or: 

1. Select the "Online & Diagnostics" folder of the relevant CPU in project navigation.

2. Open the "Online" menu and select "Receive alarms".

Or: 

1. Select the relevant CPU in the device or network view.

2. Select the "Receive alarms" command in the context menu.

Or: 

1. Select the CPU in project navigation.

2. Select the "Receive alarms" command in the context menu.

8.1.7.5 Export archive
To archive alarms, you can export the archive. Follow these steps:

1. Go to the archive view.

2. Click the "Export archive" button.

3. In the dialog that opens, select the path to export the archive.

Result
The archive is saved as an xml file at the location you selected.

8.1.7.6 Clear archive
The archive is organized as a ring buffer, in other words, when it is full, the oldest alarms are 
deleted from the archive. With the "Clear archive" button, you can delete the entire archive.

Procedure
To clear the archive, follow these steps:

1. Click the "Clear archive" button in the toolbar of the alarm display.

8.1.7.7 "Active alarms" view
The "Active alarms" view is an image of the alarm acknowledgement memory of the selected 
CPU(s). 
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8.1.7.8 Layout of the alarms in the "Active alarms" view
The "Active alarms" view represents an image of the alarm acknowledgement memory of the 
selected CPUs. One entry is shown in the table per active alarm. Events of an alarm 
("incoming", "outgoing" and "acknowledged") are displayed in one row. 

Table structure 
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed.

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgement or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in bold print 
and can be acknowledged either context-sensitive with the button in the toolbar or with the 
shortcut menu command "Acknowledge alarm(s)". 

8.1.7.9 Status of the alarms
Depending on whether you are in the "Active alarms" view or the archive view, the displayed 
alarms may have a different status.

Status of the alarms in the "Active alarms" view
● I: Alarm came

● IA: Alarm came and was acknowledged

● IO: Alarm has gone

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red. 

Status of the alarms in the archive view
● No information: only with alarms generated by the PG/PC and displayed in the "Archive" 

tab, for example logon status, connection abort, mode changes

● I: Alarm came

● A: Alarm came and was acknowledged

● O Alarm has gone

● D: The alarm was deleted.

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red.

8.1.7.10 Acknowledging alarms
Alarms that must be acknowledged are shown in bold characters.
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Procedure 
To acknowledge an alarm, follow these steps:

1. Select the required alarm or alarms from the table.

2. Click the "Acknowledge" button.
 

  Note

You can select more than one alarm to acknowledge at the same time. To do this, hold 
down the <Ctrl> key and then select the alarms you want to acknowledge.

 

Result
The selected alarm was acknowledged and is then shown in normal characters. 

 

 Note

In the "Active alarms" view, acknowledged alarms that have already gone are no longer 
displayed. 

 

 

8.1.7.11 Ignoring alarms

Ignoring alarms 
To ignore alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a gray background.

Result
From this point onwards, all alarms will be ignored. A message is created in the archive view 
indicating that the display of alarms and events is disabled.

Canceling the ignoring of alarms
To cancel the ignoring of alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a white background.

Result
All alarms, in other words, even the alarms currently pending on the CPU while the "Ignore 
alarms" function was active, are displayed again from this point onwards. A message is created 
in the archive view indicating that the display of alarms and events is enabled again.
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8.1.7.12 Keyboard commands in the alarm display

Alarm display

Function Shortcut keys
Select all alarms Ctrl+A
Acknowledge all selected alarms Ctrl+Q
  
  
  
  
  
  
  

8.2 Device and network diagnostics

8.2.1 Hardware diagnostics

8.2.1.1 Overview of hardware diagnostics

Principal methods of hardware diagnostics

Principal methods of hardware diagnostics  
Hardware diagnostics can be performed as follows:

● Using the Online and Diagnostics view

● Using the "Online Tools" task card

● Using the "Diagnostics > Device Info" area of the Inspector window

● Using diagnostics icons, for example, in the device view and the project tree
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Structure of the Online and Diagnostics view  
The Online and Diagnostics view consists of two windows alongside each other:

● The left window shows a tree structure with folders and - when you open the folder - groups.

● The right window contains detailed information on the selected folder or selected group.

The "Online access" group and the "Diagnostics" and "Functions" folders are located here:

● "Online access" group: Displays whether or not there is currently an online connection with 
the associated target. In addition, you can establish or disconnect the online connection.

● "Diagnostics": Contains several diagnostics groups for the selected module.

● "Functions": Contains several groups, in which you can make settings for the selected 
module or issue commands to the module.

Function and structure of the "Online Tools" task card  
For modules with their own operating mode (such as CPUs), the "Online tools" task card allows 
you to read current diagnostics information and commands to the module.

If you selected a module without its own operating mode or if you selected several modules 
before activation of the "Online Tools" task card, the task card relates to the relevant CPU.

The "Online Tools" task card consists of the following panes:

● CPU control panel

● Cycle time

● Memory
 

  Note

A pane is filled with content only if the module controls the associated functions and an 
online connection exists.

If there is no online connection to the respective module, the display "No online 
connection" appears in blue. If an existing online connection was disconnected, then "This 
target is not available" will be displayed.
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Structure or the "Diagnostics" tab of the Inspector window  
The "Diagnostics" tab of the Inspector window itself consists of several tabs: Of these tabs, 
the following is relevant for the hardware diagnostics.

● Device information
This tab relates to all CPUs of the project to which the online connection is established. 
Alarms are reported here if one or more CPUs are defective or are not in RUN mode.

Determination of which of the devices that are connected online are defective

Overview of the defective devices 
In the "Diagnostics > Device Info" area of the Inspector window you will obtain an overview of 
the defective devices that are or were connected online. 

The "Diagnostics> Device Info" area of the Inspector window consists of the following elements:

● Header line with the number of defective devices

● Table with detailed information on each defective device

If you originate the establishment of an online connection to a device which is not reachable 
or reports one or more faults or is not in RUN mode, it will rank as defective.

Structure of the table with detailed information on the defective devices
The table consists of the following columns:

● Online status: Contains the online status as a diagnostic symbol and in words

● Operating mode: Contains the operating mode as a symbol and in words

● Device / module: Name of the affected device or the affected module

● Message: explains the entry of the previous column

● Details: The link opens the online and diagnostics view for the device, and places it in the 
foreground. If an online connection does not exist any longer, the link will open the 
connection establishment dialog.

● Help: The link supplies further information on the defect that has occurred.

See also
Determination of online status and display using symbols (Page 589)

Determination of online status and display using symbols

Determining diagnostics status online and displaying using icons   
When the online connection to a device is established, the diagnostics status of the device 
and, if applicable, its subordinate components will be determined. The operating mode of the 
device is also determined, where applicable.
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The following is a description of the symbols that are displayed in a specific view.

● Device view

– The associated diagnostics icon is displayed for every hardware component (except the 
signal board on the CPU).

– For hardware components with subordinate components, an "Error in subordinate 
component" diagnostics icon will also be displayed in the hardware component 
diagnostics icon if an error is present in at least one subordinate component.

– For hardware components with their own operating mode, the operating mode icon will 
also be displayed to the left of or above the diagnostics icon.

● Device overview

– The associated diagnostics icon is displayed for every hardware component.

– For hardware components with subordinate components, an "Error in subordinate 
component" diagnostics icon will also be displayed in the bottom right corner of the 
hardware component diagnostics icon if an error is present in at least one subordinate 
component.

● Network view

– The associated diagnostics icon is displayed for every device.

– If an error is present in at least one subordinate component, then the "Error in 
subordinate component" diagnostics icon will also be displayed in the bottom right corner 
of the diagnostics icon.

● Network overview

– The associated diagnostics icon is displayed for every hardware component.

– For hardware components with subordinate components, an "Error in subordinate 
component" diagnostics icon will also be displayed in the bottom right corner of the 
hardware component diagnostics icon if an error is present in at least one subordinate 
component.

● Topology view

– The associated diagnostics icon is displayed for every device.

– If an error is present in at least one subordinate component, then the "Error in 
subordinate component" diagnostics icon will also be displayed in the bottom right corner 
of the diagnostics icon.

– The associated diagnostics icon is displayed for every port.

– Each cable between two online ports is assigned the color associated with its diagnostics 
status.

● Topological overview

– The associated diagnostics icon is displayed for every hardware component.

– For hardware components with subordinate components, an "Error in subordinate 
component" diagnostics icon will also be displayed in the bottom right corner of the 
hardware component diagnostics icon if an error is present in at least one subordinate 
component.
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● Project tree

– The associated diagnostics icon is displayed behind every hardware component.

– For hardware components with subordinate components (e.g., distributed I/O, Slave_1), 
an "Error in subordinate component" diagnostics icon will also be displayed in the bottom 
right corner of the diagnostics icon if an error is present in at least one subordinate 
component.

– For hardware components with their own operating mode, the operating mode icon is 
also displayed in the top right corner of the diagnostics icon.

– If forcing is active on a CPU, then a red F will be displayed at the left margin of the 
diagnostics icon.

Diagnostics icons for modules and devices   
The following table shows the available icons and their respective meaning.

Icon Meaning
The connection with a CPU is currently being established.

The CPU is not reachable at the set address.

The configured CPU and the CPU actually present are of incompatible types.

On establishment of the online connection to a protected CPU, the password dialog 
was terminated without specification of the correct password.
No fault

Maintenance required

Maintenance demanded

Error

The module or device is deactivated.

The module or the device cannot be reached from the CPU (valid for modules and 
devices below a CPU).
Diagnostics data are not available because the current online configuration data 
differ from the offline configuration data.
The configured module or device and the module or device actually present are 
incompatible (valid for modules or devices under a CPU).
The configured module does not support display of the diagnostics status (valid for 
modules under a CPU).
The connection is established, but the state of the module has not yet been 
determined.
The configured module does not support display of the diagnostics status.

Error in subordinate component: An error is present in at least one subordinate 
hardware component.
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 Note

Some modules, for example the FM 450-1, are only indicated as having a problem in the 
case of an error if you have enabled the diagnostics interrupt when setting the module 
properties.

 

Icons for the comparison status   
The diagnostics icons can be combined at the bottom right with additional smaller icons that 
indicate the result of the online/offline comparison. The following table shows the available 
comparison icons and their meaning.

Icon Meaning
Folder contains objects whose online and offline versions differ (only in the project 
tree)
Online and offline versions of the object are different

Object only exists online

Object only exists offline

Online and offline versions of the object are the same
 

 Note

If both a comparison icon and the "Error in subordinate component" diagnostics icon are to 
be displayed at the bottom right in the device view, the following rule applies: The diagnostics 
icon for the subordinate hardware component has a higher priority than the comparison icon. 
This means that a comparison icon is only displayed if the subordinate hardware components 
have no faults.

 

Combined diagnostics and comparison icons
The following table shows examples of icons that are displayed in the diagnostics icon.     

Icon Meaning
Folder contains objects whose online and offline versions differ (only in the project 
tree)
Object only exists online
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Operating mode icons for CPUs and CPs   
The following table shows the available icons and their respective operating states.

Icon Operating mode
RUN

STOP

STARTUP

HOLD

DEFECTIVE

Unknown operating mode

The configured module does not support display of the operating mode.

 

 Note

If forcing is active on a CPU, a red F will be displayed on a pink background at the bottom 
right of the operating mode icon.

 

Color marking of ports and Ethernet cables     
The following table shows the available colors and their respective meaning.

Color Meaning
No fault or maintenance required

Maintenance demanded

Communication error

Start online and diagnostics view

Overview of possible ways of starting the Online and Diagnostics view
You can start the Online and Diagnostics view of a module to be diagnosed at the following 
locations:

● Overview

● Project tree

● Device view

● Device overview
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● Network view

● Network overview

● Topology view

In the following, examples are used to show how to proceed. 

Requirement
The project with the module to be diagnosed is open.  

 

 Note

This requirement does not apply if you call the online and diagnostics view from the project 
tree after you have identified the accessible devices.

 

Procedure
To start the online and diagnostics view of a module, follow these steps:  

1. In the project tree, open the respective device folder.

2. Double click on "Online & Diagnostics".

Or:

1. In the project tree, select the respective device folder.

2. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Online access" folder.

2. Open the folder for the interface with which you want to establish the online connection.

3. Double click on "Show/Update accessible devices".

4. Select the module to be diagnosed.

5. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Local modules" folder.

2. Select the respective device or the module that is to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the main menu.

Or:

1. Open the device view in the device configuration.

2. Select the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:
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1. Open the device view in the device configuration.

2. Establish an online connection to the module to be diagnosed.

3. Double-click on the diagnostics icon above the module.

Or:

1. Open the network view in the device configuration.

2. Select the station with the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

Result
The online and diagnostics view of the module to be diagnosed will be started. If an online 
connection to the associated CPU had previously been created, the header bar of the Online 
and Diagnostics view will now have an orange background.

 

 Note

If no online connection exists when the online and diagnostics view is started, no online 
information is displayed and the display fields remain empty.

 

Activation of the "Online Tools" task card

Activation of the "Online Tools" task card    
You can activate this task card as follows:

1. Start the online and diagnostics view.

2. Click on the "Online Tools" task card.

Or:

1. Start the device view.

2. Click on the "Online Tools" task card.

Or:

1. Start the network view.

2. Click on the "Online Tools" task card.
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8.2.1.2 Showing non-editable and current values of configurable module properties

Showing general properties and system-relevant information for a module

Where do I find the information I need?
The general properties and system-relevant information for a module can be found in the 
"General" group in the "Diagnostics" folder in the online and diagnostics view of the module 
to be diagnosed.   

Structure of the "General" group
The "General" group consists of the following areas:

● Module

● Module information

● Vendor information

"Module" area
This area shows the following data of the module:

● Short designation, for example, CPU 1214C DC/DC/DC

● Order no.

● Hardware

● Firmware

● Racks

● Slot

"Module information" area
This area shows the following data of the module that you configured during hardware 
configuration:

● Module name

● Installation date (not displayed for all modules)

● Additional information (not displayed for all modules)

"Manufacturer information" area
This area shows the following data of the module:

● Manufacturer

● Serial number
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● Profile: Profile ID as hexadecimal number
 

  Note

You will find the corresponding profile name in the profile ID table for PROFIBUS 
International (see "www.profibus.com").

 

● Profile details: Profile-specific type as hexadecimal number
 

  Note

You will find the corresponding profile-specific type name in the profile-specific type table 
for PROFIBUS International (see "www.profibus.com").

 

Display configured cycle times

Where do I find the information I need?  
The required information can be found in the following places:

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card

Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)

Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Assigned cycle times
The following assigned cycle times are displayed in the cycle time diagram and in the "Cycle 
time configured" area.

● Minimum cycle time

● Maximum cycle time

In the cycle time diagram, the minimum cycle time and the maximum cycle time correspond 
to the two markings on the time axis.

In the "Cycle time configured" area, the assigned cycle times are displayed as absolute values.
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Show interfaces and interface properties of a module

Where do I find the information I need?
The interfaces and interface properties of a module can be found in the "Diagnostics" folder 
in the Online and Diagnostics view of the module to be diagnosed in the following group:   

● PROFINET interface

"PROFINET interface" group  
This group is divided into the following areas:

● "Ethernet address" with the "Network connection" and "IP Parameters" subareas

● "Ports"

"Network connection" subarea of the "Ethernet address" area
This subarea shows the following data of the module:

● MAC Address:
MAC address of the interface.
The MAC address consists of two parts. The first part ("Basic MAC address") identifies the 
manufacturer (Siemens, 3COM, ...). The second part of the MAC address differentiates 
between the various Ethernet devices. Each Ethernet module is assigned a unique MAC 
address.

"IP Parameters" subarea of the "Ethernet address" area  
This subarea shows the following data for the module:

● IP address:
Internet protocol address of the device on the bus (TCP/IP)

● Subnet mask:
The subnet mask shows which part of the IP address determines the membership of a 
particular sub-network.

● Default router:
If the subnet is connected via a router to other subnets, the IP address of the default router 
must be known. This is the only way a datagram can be forwarded with a non-matching 
subnet address.

● IP settings:
Identifier for the path by which the device has obtained its IP settings (IP address, subnet 
mask, default router).

Identifier Meaning
0 IP address is not initialized
1 By configuration (i.e., by the configuration loaded to the device from the device or 

network view)
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Identifier Meaning
2 Via the "Assign IP address" group of the Online and Diagnostics view
3 Via the DHCP server (i.e., the IP parameters are obtained by a special service from a 

DHCP server (Dynamic Host Configuration Protocol) and assigned for a limited time)

 

● IP setting time:
Time stamp of the last change to the IP address directly through the Ethernet connection 
of the module

"Ports" area
This area shows the following data for the module:

● Ethernet ports
Physical properties of the PROFINET interface

Properties of the 
PROFINET interface

Meaning

Port no. Port number The short description of interface (X + interface no.) and port 
(P + port no.) is specified in parentheses. An "R" in the short description of 
a port means that it is a ring port.

Status Displays the status of the port LINK LED.
● Status "OK" means another device (such as a switch) is connected to 

the port and the physical connection is available.
● Status "disconnected" means no other device is connected to the port.
● Status "deactivated" means that access to the port is blocked.

Customize Individual network settings of the device (automatic or manual)
Mode Network settings for the speed and the transmission process

If you select a line in the port table, additional help information will be provided for the 
corresponding port.

 

8.2.1.3 Showing the current values of dynamic modules properties

Display measured cycle times

Where do I find the information I need?
The measured cycle times can be found at each of the following places:  

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card
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Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)

Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Graphical display of the measured cycle times
The following measured cycle times are displayed in the cycle time diagram:

● Shortest cycle time: Duration of the shortest cycle since the last transition from STOP to 
RUN
This corresponds to the dashed gray arrow on the left in the diagram.

● Current / last cycle time: Duration of the last cycle
This corresponds to the green arrow in the diagram. If the current / last cycle time exceeds 
the maximum cycle time, the arrow will turn red.

 

  Note

If the duration of the last cycle comes close to the maximum cycle time, it may be possible 
that it will be exceeded. Depending on the CPU type, parameter assignment and your 
user program, the CPU can switch to STOP mode. If for instance you are monitoring the 
tags in your program, this will increase the cycle time.

If the cycle lasts longer than double the maximum cycle time, and you do not restart the 
maximum cycle time in the user program (by calling the extended RE_TRIGR) instruction, 
the CPU will switch to STOP mode.

 

● Longest cycle time: Duration of the longest cycle since the last transition from STOP to 
RUN.
This corresponds to the dashed blue arrow on the right in the diagram.

A blue band extends between the two dashed lines; this band corresponds to the entire range 
of the measured cycle times. If a measured cycle time is greater than the maximum cycle time, 
the portion of the band that lies outside the assigned limits will be colored red.

Display of the measured cycle times as absolute values
The following measured times are displayed in the "Cycle times measured" area and in the 
"Cycle time" pane.

● Shortest cycle time since the last transition from STOP to RUN.

● Current/last cycle time:

● Longest cycle time since the last transition from STOP to RUN.
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Showing the current status of the LEDs of a CPU

Where do I find the information I need?
The current status of the LEDs of a CPU can be found in the display area of the "CPU control 
panel" pane of the "Online tools" task card.   

Display area of the "CPU control panel" pane of the "Online Tools" task card   
This area contains the following displays:

● Station name and CPU type (short designation)

● RUN / STOP (corresponds to the "RUN / STOP" LED of the CPU)

● ERROR (corresponds to the "ERROR" LED on the CPU)

● MAINT (corresponds to the "MAINT" LED on the CPU)

 

Showing fill levels of all types of memory on a CPU

Where do I find the information I need?     
The fill levels of all types of memory on a CPU can be found on the following two pages:

● In the display area of the "Memory" group in the "Diagnostics" folder in the online and 
diagnostics view of the module to be diagnosed.

● In the "Memory" pane display area of the "Online Tools" task card

Display area of the "Memory" group in the "Diagnostics" folder of the online and diagnostics view
This area contains the current memory utilization of the respective module and details of the 
individual memory areas.

The memory utilization is shown both as a bar diagram and as a numerical value (percentage).

The following memory utilizations are shown:

● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory
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Display area of the "Memory" pane of the "Online Tools" task card
This area contains the current memory utilization of the module. The available memory is 
shown both as a bar diagram and as a numerical value (percentage). The numerical value is 
rounded to an integer value.

 

 Note

If a memory area is utilized to less than 1%, the available portion of this memory area is 
shown as "99%".

 

The following memory utilizations are shown:

● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory

See also
Load memory (Page 484)

Work memory (Page 484)

Retentive memory areas (Page 486)

8.2.1.4 Checking a module for defects

Determining the diagnostic status of a module

Where is the diagnostics status of a module displayed?   
The diagnostic status of a module is displayed in the "Diagnostic status" group in the 
"Diagnostics" folder in the online and diagnostics view of the module to be diagnosed.

The "Diagnostics status" group consists of the following areas:

● Status

● Standard diagnostics (for S7-300 and S7-400 only for non-CPU modules)
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"Status" area
The following status information is displayed in this area:

● Status of the module as viewed by the CPU, for example:

– Module available and OK.

– Module defective.
If the module experiences a fault and you have enabled the diagnostic error interrupt 
during configuration, the "Module defective" status is displayed.  

– Module configured, but not available.

● Detected differences between the configured and the inserted module. Provided it can be 
ascertained, the order number will be displayed for the set and actual type.

The scope of the displayed information depends on the selected module.

"Standard diagnostics" area
The following diagnostics information for non-CPU modules is displayed in this area:

● Internal and external faults that relate to the overall module

● Associated diagnostics events

Examples of such diagnostics information are:

● Entire backup failed

● Module defective
 

  Note
Diagnostic interrupts

A diagnostic interrupt can be reported to the CPU only if the module has diagnostic 
interrupt capability and the diagnostic interrupt has been enabled.

The display of the diagnostic interrupt is a snapshot. Sporadic module defects can be 
identified in the diagnostics buffer of the respective CPU.

 

 

Reading out the diagnostics buffer of a CPU

Where do you read out the diagnostics buffer of a CPU?   
You read out the diagnostics buffer of a CPU in the "Diagnostics buffer" group in the 
"Diagnostics" folder in the Online and Diagnostics view.
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Structure of the "Diagnostics buffer" group
The "Diagnostics buffer" group consists of the following areas:

● "Events"

● "Settings"

Diagnostics buffer
The diagnostics buffer is used as a log file for the diagnostics events that occurred on the CPU 
and the modules assigned to it. These are entered in the order of their occurrence, with the 
latest event shown at the top.

"Events" area
The "Events" area consists of the following elements:

● Check box "CPU time stamp takes into account local PG/PC time"

● Event table

● "Freeze display" or "Cancel freeze" button

● Details of the event: Event no., event ID, description, time stamp, incoming/outgoing 
information

● "Help on event", "Open block", "Save as ..." buttons

Check box "CPU time stamp takes into account local PG/PC time"
If you have not activated the check box, the diagnostics buffer entries are shown with the 
module time.

If you have activated the check box, the diagnostics buffer entries are shown with the time 
given by the following formula:

Displayed time = module time + time zone offset on your programming device / PC

This requires the module time to be identical to UTC.

You should use this setting if you wish to see the times of the diagnostics buffer entries for the 
module expressed in the local time of your programming device / PC.

Selecting or clearing the check box immediately changes the times displayed for the 
diagnostics buffer entries.

 

 Note

If you use the "WR_SYS_T" instruction in your program or if you set the real-time clock of the 
CPU using an HMI device instead of using UTC, we recommend that you clear the "CPU time 
stamp takes into account local PG/PC time" check box. In this case, the module time is the 
sole time of concern.
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Event table
The following information is displayed in the table for each diagnostics event:

● Sequential number of the entry
The first entry contains the latest event.

● Date and time of the diagnostics event
If no date and time are shown, the module has no integral clock.

● Short name of the event and, if applicable, the reaction of the CPU
 

  Note

If an individual parameter of a text cannot be determined, the character string "###" is 
shown in its place.

If no display text is yet available for new modules or new events, the numbers of the events 
and the individual parameters are stated as hexadecimal values.

 

● Icon for information related to incoming/outgoing status
The following table shows the available icons and their respective meaning.

Icon Meaning
Incoming event

Outgoing event

Incoming event to which there is no independent outgoing event

User-defined diagnostics event

● For S7-1200 CPUs only: Icon for the severity of the event
The following table shows the available icons and their respective meaning.

Icon Meaning
No maintenance and/or no fault

Maintenance required

Maintenance demanded

Error

You can change the order of the columns, adjust the column widths, and remove and add 
individual columns in the event table. Sorting is possible, but only by the sequential numbers.

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the CPU.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:
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● The current display of the diagnostics buffer entries is frozen.

● The labeling of the button changes to "Cancel freeze".

If an error has occurred in your system, diagnostics events can occur very quickly in 
succession. This produces a high update rate on the display. Freezing the display allows you 
to calmly examine the situation in more detail.

If the display is frozen and you click the "Cancel freeze" button, the following happens:

● The display of the diagnostics buffer entries is updated again.

● The labeling of the button changes to "Freeze display".
 

 Note

If you freeze the diagnostics buffer display, the CPU continues to enter events in the 
diagnostics buffer.

 

Details of the event
If you select a line in the list of events, you will obtain detailed information on the respective 
event:

● Sequential number of the event in the diagnostics buffer.

● Event ID

● Description of the event with event-dependent additional information. Examples of this 
additional information:

– Command that caused the event

– Operating mode switch caused by the diagnostics event

● Time stamp

● For S7-1200 CPUs only: Associated I&M data (module, rack/slot, plant designation, location 
designation)

● Priority of the event

● Information on whether the event is an incoming or outgoing event

"Help on event" button
If you click on this button, the selected event is explained in more detail and any remedies 
given.

 

 Note

If the selected event is not a CPU event, the "Help on event" button is unavailable.
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"Open block" button
The following table shows if the "Open block" button is active and which function it conceals.

When is the "Open block" button active? What happens when you click this button?
If the diagnostics event references the relative address of a 
block.
This is the address of the command that caused the event.

The "Open block" function opens the referenced block in the 
offline view at the programming instruction that caused the 
error. This allows you to check and, if necessary, change the 
source code of the block at the specified place and then 
download it again to the CPU.

If the diagnostics event was triggered by a module. The "Open block" function opens the Device view of the 
module involved.

"Save as ..." button
If you click this button, the content of the diagnostics buffer is saved in a text file. "Diagnostics", 
depending on the language, with the extension ".txt" is suggested as the file name. You can 
however change this name.

"Settings" area
The "Settings" area consists of the following elements:

● "Display events" list

● "Apply settings as default" button

● "Output event information in hexadecimal format" check box

"Display events:" list
There is an check box in this list for every event class (default setting: all check boxes are 
selected). If you clear a check box, the events of that event class will no longer be displayed 
in the "Events" area. Reselecting the check box will display the associated events once again.

"Apply settings as default" button
If you click this button, the settings will also apply to future occasions when the "Events" tab 
is opened.

"Output event information in hexadecimal format" check box
If you select the check box, the event IDs in the Events list of the "Events" area will be displayed 
in hexadecimal format. If you clear the check box, the event information is given in text form.

 

See also
Basic information on the diagnostics buffer  (Page 615)
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8.2.1.5 Changing the properties of a module or the programming device / PC

Changing the mode of a CPU

Requirement  
There is an online connection to the CPU whose mode you want to change.

Procedure
To change the mode of the CPU, follow these steps:

1. Enable the "Online tools" task card of the CPU.

2. Click the "RUN" button in the "CPU control panel" pane if you want to change the CPU to 
RUN mode or the "STOP" button if you want to change the CPU to STOP mode.

 

  Note

The only button active is the one that can be selected in the current operating mode of 
the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Open the "Online" menu.

2. Choose the "Start CPU" menu command if you want to set the CPU to RUN mode and 
"Stop CPU" if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Click the "Start CPU" button in the toolbar if you want to set the CPU to RUN mode and the 
"Stop CPU" button if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

2. Acknowledge the confirmation prompt with "OK".

 

Result
The CPU will be switched to the required operating mode.
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Performing a memory reset

Requirement 
● There is an online connection to the CPU on which the memory reset is to be performed.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the memory reset, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure
To perform a memory reset on a CPU, follow these steps:

1. Enable the "Online Tools" task card of the CPU.

2. Click the "MRES" button in the "CPU control panel" pane.

3. Acknowledge the confirmation prompt with "OK".

Result
The CPU is switched to STOP mode, if necessary, and the memory reset is performed on the 
CPU.

See also
Basics of a memory reset (Page 482)

Determining and setting the time of day on a CPU

Where do I find the functions I need? 
You determine and change the time of day on a CPU in the "Set time of day" group in the 
"Functions" folder of the Online and Diagnostics view. This requires an online connection. 

Structure of the "Set time of day" group
The "Set time of day" group consists of the following areas:

● Area for reading out and setting the time of day

● Time system (This area does not exist for S7-1200 and will not be examined here.)
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Structure of the area for reading out and setting the time of day
This area consists of the following parts:

● Programming device / PC time
Here the time zone setting, the current date and the current time setting of your 
programming device / PC are displayed.

● Module time
Here the date and time values currently read from the module (for example the CPU), are 
converted to local time and date and displayed.
If the "Take from PG/PC" check box is selected, when you click the "Apply" button, the date 
and the PG/PC time converted to UTC are transferred to the module.
If the "Take from PG/PC" check box is not selected, you can assign the date and time for 
the integrated clock of the module. After clicking the "Apply" button, the date and the time 
recalculated to UTC time are transferred to the module.

Assigning an IP address to a PROFINET IO device

Overview  
All PROFINET IO devices work with the TCP/IP protocol and therefore require an IP address 
for operation on Industrial Ethernet. Once an IO device has been assigned an IP address, it 
can be accessed via this address. This step lets you download configuration data or perform 
diagnostics, for example.

You have two basic options for choosing an IP address:

● You assign the IP address yourself.

● You obtain the IP address from a DHCP server. (This is not possible for some IO devices.) 
In this case, the client ID, the MAC address, or the device name of the IO device is 
communicated to the DHCP server, depending on the option selected.

Both options are described below.

Requirement
● The Ethernet LAN connection must already be established.

● The Ethernet interface of your programming device or PC must be accessible.

● The IO device that is to be assigned an IP address must be in the same IP band as the 
programming device or PC.

Procedure for specifying the IP address yourself
To assign the IP address you have specified yourself to the IO device, proceed as follows:

1. Open the Online and Diagnostics view of the IO device.

2. Select the "Assign IP address" group from the "Functions" folder.

3. Select the "Use IP parameters" option.
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4. Click the "Accessible devices" button to identify the devices that can be accessed via MAC 
addresses. After the search is complete, select the IO device with the MAC address known 
to you. The "IP address" entry field now contains the value configured for this IO device.

5. Check this value and correct it, if necessary.

6. Enter the subnet mask.

7. If a router is to be used, select the "Use router" check box and enter its IP address.

8. Click "Assign IP address".

Procedure for obtaining the IP address from from a DHCP server.
To assign an IP address specified by a DHCP server to the IO device, proceed as follows:

1. Open the Online and Diagnostics view of the IO device.

2. Select the "Assign IP address" group from the "Functions" folder.

3. Select the "Obtain IP address from a DHCP server" option.

4. If the DHCP server is to identify the target device using its client ID, choose the "Client ID" 
option. Enter the client ID in the entry field of the same name.

 

  Note

The client ID is a string with a maximum of 63 characters. Only the following characters 
are permitted: a-z, A-Z, 0-9 and - (dash)

 

5. Alternatively: If the DHCP server is to identify the target device using its MAC address, 
choose the "MAC address" option. The "Accessible devices" button now becomes active, 
and you select the target device as described in section "Procedure for specifying the IP 
address yourself".

6. Alternatively: If the DHCP server is to identify the target device using its device name, 
choose the "Device name" option.

 

  Note

If you specify that the DHCP server is to identify the target device using its device name, 
you must have assigned a device name to the target device beforehand.

 

7. Click "Assign IP address".

Result
The IP address will be assigned to the IO device.
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Resetting a CPU to the factory settings

Requirement
● There is no memory card inserted in the CPU.

● There is an online connection to the CPU that you want to reset to the factory settings.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the reset operation, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure
To reset a CPU to the factory settings, follow these steps:

1. Open the Online and Diagnostics view of the CPU.

2. Select the "Reset to factory settings" group from the "Functions" folder.
 

  Note

The MAC address is not displayed for S7-1200 CPUs.
 

3. Select the "Retain IP address" check box if you want to retain the IP address or the "Delete 
IP address" if you want to delete the IP address.

 

  Note

The two check boxes mentioned are only available if the module to be reset is able to 
choose whether to retain or delete the IP address.

 

4. Click the "Reset" button.

5. Acknowledge the confirmation prompt with "OK".

Result
The module is switched to STOP mode, if necessary, and the factory settings are then reset. 
This means:

● The work memory and the internal load memory and all operand areas are deleted.

● All parameters are reset to their defaults.

● The diagnostics buffer is cleared.

● The time of day is reset.

● The IP address is retained or deleted depending on the setting you make.
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Assigning a PROFINET device name

Basic information on assigning a name to a PROFINET IO device

Device name   
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to handle than complex IP 
addresses.

Assigning a device name to a PROFINET IO device is comparable to setting the PROFIBUS 
address for a DP slave.

An IO device has no device name in its delivery state. For an IO controller to address an IO 
device, it must first be assigned a device name using the programming device or PC. It is now 
ready to transfer the configuration information including the IP address during startup or 
exchange user data in cyclic operation. 

Rules for the device name
The device name is subject to the following limitations:

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● A name component within the device name, which is a character string between two dots, 
must not exceed 63 characters.

● No special characters such as umlauts, brackets, underscore, slash, blank space, etc. The 
only special character permitted is the dash.

● The device name must not begin or end with the "-" character.

● The device name must not begin with a number.

● The device name form n.n.n.n (n = 0, ... 999) is not permitted.

● The device name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

Where do I find the function I am seeking?
To assign a name to a PROFINET IO device, go to the "Assign name" group in the "Functions" 
folder of the Online and Diagnostics view for the device. The user interface for this group differs 
depending on how you open the Online and Diagnostics view:

● Call from project navigation (using "Update accessible devices") or via the "Online" menu

● Call from within the project context
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See also
Calling the name assignment function from the project tree or via the "Online" menu 
(Page 614)

Calling the name assignment function from within the project context (Page 614)

Calling the name assignment function from the project tree or via the "Online" menu

Requirement   
● You have opened the Online and Diagnostics view of the PROFINET IO device from the 

project tree or with the "Online" menu.

Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The "Type" 

field displays the module type of the PROFINET IO device.

2. Enter the required device name in the "PROFINET device name" input box.

3. Optional: Click the "Flash LED" button on the left of the graphic to run an LED flash test for 
the PROFINET IO device. In this way you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

4. Click "Assign name".

Result
The entered name is assigned to the PROFINET IO device.

 

Calling the name assignment function from within the project context

Requirement  
● An online connection to the PROFINET IO device is not required.

● You have opened the Online and Diagnostics view of the PROFINET IO device from within 
the project context.

● The PROFINET IO device can be accessed using at least one PG/PC.

Editing devices and networks
8.2 Device and network diagnostics

WinCC Professional V11.0 SP1
614 System Manual, 08/2011,  



Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The 

"PROFINET device name" drop-down list displays the current name in the offline project, 
and the "Type" box shows the module type of the PROFINET IO device.

2. Choose a different name from the drop-down list, if necessary.
 

  Note

In steps 3 to 5, you determine the IO devices that are present in the PROFINET subnet.
 

3. In the "PG/PC interface for assignment" drop-down list, select the PG/PC interface you 
want to use to establish the online connection.

4. Optional: Use the three check boxes to make a selection from all IO devices available online.

5. Click the icon for determining the IO devices present in the PROFINET subnet. The table 
is then updated.

6. Select the desired IO device in the table.

7. Optional: Click the "Flash LED" button to run an LED flash test for the PROFINET IO device. 
In this way you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

8. Click "Assign name".

Result
The selected name is assigned to the PROFINET IO device.

8.2.1.6 Diagnostics in STOP mode

Basic information on the diagnostics buffer 

Function 
The operating system of the CPU enters the errors detected by the CPU and the diagnostics-
capable modules into the diagnostics buffer in the order in which they occurred. This includes 
the following events:

● Every mode change of the CPU (POWER UP, change to STOP mode, change to RUN 
mode)

● Every hardware and diagnostic error interrupt

The top entry contains the most recent event. The entries in the diagnostics buffer are stored 
permanently. They are retained even if the power supply fails and can only be deleted by 
resetting the CPU to factory settings.

A diagnostics buffer entry contains the following elements:
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● Time stamp

● Error ID

● Additional information specific to the error ID

Advantages of the diagnostics buffer
The diagnostics buffer offers the following advantages:

● After the CPU has changed to STOP mode, you can evaluate the last events prior to the 
STOP so that you can locate and identify the cause of the STOP.

● You can detect and eliminate the causes of errors more quickly and thus increase the 
availability of the system.

● You can evaluate and optimize the dynamic system response.

Organization of the diagnostics buffer
The diagnostics buffer is a ring buffer. The maximum number of entries for the S7-1200 CPUs 
is 50. When the diagnostics buffer is full and a further entry needs to be made, all existing 
entries are shifted by one position (which means that the oldest entry is deleted) and the new 
entry is made at the top position that is now free (FIFO principle: first in, first out).

Evaluation of the diagnostics buffer
The contents of the diagnostics buffer can be accessed as follows: 

● Using the Online and Diagnostics view

The evaluation of events occurring prior to the error event (e.g., transition to STOP mode) 
allows you to obtain a picture of the possible causes or to zero in more closely or specify in 
more detail the possible causes (depending on the error type).

Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.

 

 Note

To make the best use of the time stamp information on the diagnostics buffer entries in time-
critical systems, it is advisable to check and correct the date and time of day on the CPU 
occasionally.

Alternatively, it is possible to perform a time-of-day synchronization using an NTP time server.
 

See also
Resetting a CPU to the factory settings (Page 612)

Determining the cause of a STOP of a CPU (Page 617)

Determining and setting the time of day on a CPU (Page 609)

Parameterizing the clock (Page 503)
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Determining the cause of a STOP of a CPU

Requirement
The CPU you want to analyze is in STOP mode.

Procedure
To find out the reason why a CPU changed to STOP, follow these steps:

1. Open the online and diagnostics view of the CPU.

2. Select the "Diagnostics buffer" group from the "Diagnostics" folder.

3. Evaluate the events occurring prior to the transition to STOP mode. Use this to obtain a 
picture of the possible causes or to zero in on or specify in more detail the possible causes 
(depending on the error type).
Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.

Result
You were able to zero in on or determine in more detail the cause of the CPU STOP.

 

 Note

If the analysis does not enable you to overcome the problem, contact Customer Support. In 
this case, use the "Save as" button to back up the content of the diagnostics data to a text 
file and submit it to Customer Support.

 

See also
Reading out the diagnostics buffer of a CPU (Page 603)
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8.2.1.7 Online accesses in the Online and Diagnostics view

Displaying status of the online connection

Requirement  
● The associated device can be accessed using at least one PG/PC interface.

Procedure
1. Open the Online and Diagnostics view for the device whose online connection status you 

want to display.

2. Select the "Online access" group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.

 

Result
The status of the online connection is displayed in the "Status" area both graphically and in 
text form.

Specifying a PG/PC interface, going online

Requirement  
● The associated device can be accessed using at least one PG/PC interface.

● There is currently no online connection to the relevant device.

Procedure
1. Open the Online and Diagnostics view of the device to which you want to establish an online 

connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.
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3. If an online connection was established previously for the device, the associated data for 
this online connection will be preset in the drop-down lists. In this case, you can skip directly 
to the last step of this operating instruction.

4. Choose the interface type in the "Type of PG/PC interface" drop-down list.
The "PG/PC interface for online access" drop-down list then shows only the interfaces of 
the programming device or PC that match the selected interface type.

5. In the "PG/PC interface for online access" drop-down list, select the programming device 
or PC interface via which you want to establish the online connection.

6. Optional: Click the "Properties" button to change the properties of the associated CP.

7. In the "Connection to subnet" drop-down list, select the subnet via which the device is 
connected to the PG/PC interface. If the device is connected directly to the PG/PC interface, 
select the "Local" setting.

8. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.

9. In the "Device address" entry field, enter the IP address of the device to which you want to 
establish an online connection.

10.Alternatively: Click the "Show accessible devices" button and choose the device from the 
list of accessible devices to which you want to establish an online connection.

11.Click the "Go online" button.

Result
The online connection to the desired device will be established.

Going offline

Requirement  
● There is currently an online connection to the relevant device.

Procedure
1. Open the Online and Diagnostics view of the device for which you want to disconnect the 

online connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.

 

3. Click the "Go offline" button.
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Result
The online connection to the desired device will be disconnected.

Performing the flash test for a device with an online connection

Requirement  
● There is currently an online connection to the relevant device.

Procedure
1. Open the Online and Diagnostics view of the device for which you want to perform a flash 

test.

2. Choose the "Online access" group and the "Status" area within this group.
 

  Note

The "Online access" group exists only for CPUs. However, if you have opened the Online 
and Diagnostics view using the "Show/update accessible devices" function, it will not be 
displayed.

 

3. Click the "LED Flash test" button.

Result
● On an S7-1200 CPU, the RUN/STOP, ERROR and MAINT LEDs flash.

● On an S7-300 or S7-400 CPU, the FRCE LED flashes.
 

  Note

The flash test cannot be performed when the FORCE function is active.
 

8.2.1.8 Checking PROFIBUS DP subnets for faults

Basic information on the diagnostic repeater

What is the diagnostic repeater?  
The diagnostic repeater is a repeater that can monitor a segment of an RS 485 PROFIBUS 
subnet (copper cable) during operation and signal line errors to the DP master via a diagnostics 
message frame.

The diagnostic repeater detects, localizes and visualizes line errors during operation at an 
early stage. As a result, problems in the system are identified early and production downtimes 
will be minimized.
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Function of the diagnostic repeater
The diagnostic repeater can perform line diagnostics on the DP2 and DP3 segments because 
it has a measuring circuit for these segments.

The line diagnostics run in two steps:

●  Step 1: Topology determination
You start the topology determination by calling the "DP_TOPOL" instruction in your program.
The diagnostic repeater then determines the PROFIBUS addresses and the distance of 
the devices and creates a topology table.

●  Step 2: Error localization
The diagnostic repeater checks the lines during operation. It determines the distance to the 
point of the error and the reason for the error; it then issues a diagnostics alarm with relative 
information on the error location.

Display of detailed information on the determined error location
You receive detailed information on the determined error location in the Online and Diagnostics 
view of the diagnostic repeater.

● By means of icons

● By means of a display with graphics and text

See also
Displaying the status of the segment diagnostics using icons (Page 621)

Displaying the status of the segment diagnostics using graphics and text (Page 622)

Displaying the status of the segment diagnostics using icons

Where do I find the information I need?  
The icons for the status of the segment diagnostics are available:

● In the expanded "Segment diagnostics" folder in the navigation pane of the Online and 
Diagnostics view of the relevant diagnostic repeater.

The diagnostics icon associated with the segment will be displayed behind the segment 
designation. It must be noted here that line errors will be displayed for the DP2 and DP3 
segments only. The DP1 and programming device segments do not display errors in the form 
of a diagnostics icon; rather, they signal only a few bus errors.
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Diagnostics icons
The following table shows the available icons and their meaning.

Icon Meaning
Segment is error-free

Segment contains errors

Segment is deactivated

Displaying the status of the segment diagnostics using graphics and text

Where is the status of the segment diagnostics displayed with graphics and text?
The status of the segment diagnostics will be displayed using graphics and text in the "DP1", 
"DP2", "DP3", and "PG" groups of the "Segment diagnostics" folder in the Online and 
Diagnostics view of the relevant diagnostic repeater.

Structure of the "DP1", "DP2" "DP3", and "PG" groups
The "DP1", "DP2", "DP3", and "PG" groups consist of the following elements:

● "Error location" field

● "Error" field

● "Resolution" field

● "Help on event" button

● "Freeze display" or "Cancel freeze" button

"Error location" field
This field displays the error location graphically, provided the diagnostic repeater can 
determine the location.

The following picture shows an example for a line error occurring in the DP2 segment.
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In this example, the diagnostic repeater has the PROFIBUS address 2, and a line error has 
occurred between the devices with PROFIBUS addresses 16 and 17. This line error is located 
25 m from device 16, 4 m from device 17, and 72 m from the diagnostic repeater.

"Error" field
The error is explained in plain text in this field.

"Resolution" field
Here, you will find actions for resolving the error.

"Help on event" button
Click this button to obtain a more detailed explanation of the error and additional details on 
resolving the error, if applicable.

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the diagnostic repeater.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:

● The current display of the segment diagnostics is frozen.

● The labeling of the button changes to "Cancel freeze".

If the display is frozen and you click the "Cancel freeze" button, the following happens:

● The display of the segment diagnostics is updated again.

● The labeling of the button changes to "Freeze display".

8.2.2 Connection diagnostics

8.2.2.1 Overview of connection diagnostics

Basics  
Connection diagnostics, as described below, refers to the diagnostics of communication 
connections.

The connection diagnostics is started each time an online connection is established to a 
module (CPU or CP) that participates in one or more communication services. The connection 
status is updated automatically in the background.

In the case of one-way connections, an online connection must exist to the communication 
partner that has established the communication connection.
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On connections configured at both ends, a distinction between the following two situations 
must be made:

● If there is an online connection to only one connection endpoint, only the part of the 
connection belonging to this connection endpoint can be diagnosed.

● If there is an online connection to both connection endpoints, both parts of the connection 
(and therefore the entire connection) can be diagnosed.

Basic connections diagnostics options
Connection diagnostics can be performed as follows:

● Using icons on the connection status display
This display is generated in the connection table.

● Through detailed connection diagnostics
This step is available in the "Diagnostics > Connection information" area of the Inspector 
window.

Requirement for the connection diagnostics described below
You can display the details of either all the communication connections created in the project 
(default) or selected communication connections in the connection table.

The connection diagnostics described in the following assume that you display the details of 
selected communication connections. To do this, clear the "Show all connections" option in 
the shortcut menu.

8.2.2.2 Displaying the connection status using icons

Content of connection table without an online connection
For a CPU or CP, the connection table lists the communication connections (including 
properties) configured offline, if an online connection is not established. For S7-1200, the 
following connections are listed:

● Configured S7 connections (for S7-1200 these are configured only with the PUT and GET 
instructions)

● HMI connections

Content of connection table with an online connection  
After the online connection has been established, the properties of the communication 
connections listed offline will be expanded to include diagnostics icons for the connection 
status ("Online status" column).

In addition, entries for all communication connections that exist online only (e.g., connections 
configured using open user communication instructions, PG and OP connections) will now be 
added to the connection table.

For connections that exist online or offline only, the diagnostics icon at the bottom right is 
combined with a smaller additional comparison status icon.
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Diagnostics icons for communication connections  
The following table shows the diagnostics icons for communication connections.

Icon Meaning
Connection setup

Connection not setup / is being setup

Connection not available

Diagnostics icons for the comparison status  
The diagnostics icons for communication connections can be combined at the bottom left with 
additional smaller icons that indicate the result of the online/offline comparison. The following 
table shows the available comparison icons and their meaning.

Icon Meaning
Connection exists online only

Connection exists offline only

8.2.2.3 Detailed connection diagnostics

Detailed connection diagnostics - overview

Where do I perform detailed connection diagnostics?  
To perform detailed connection diagnostics, go to the "Diagnostics > Connection" information 
of the Inspector window.

How do I open the "Diagnostics > Connection information" area of the Inspector window?
The following options are available for opening the "Connection information" tab of the 
Inspector window.

● Select the line of the relevant connection in the connection table. Click the "Diagnostics" 
and "Connection information" tabs one after the other in the Inspector window.

● Double-click the diagnostics icon of the relevant connection in the connection table.

● This step takes you to the programming editor for a S7 communication instruction or open 
user communication instruction. Double-click the diagnostics icon of the instruction (3 
squares back-to-back at an angle in green, yellow, red).
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Structure or the "Diagnostics > Connection information" area of the Inspector window  
Requirements: the content of the "Connection information" tab has been filled, and an online 
connection to at least one end point of the relevant connection has been established.

If a module has been selected (network view), the tab will contain the following group:

● Connection resources (for S7-1200 only)

If a connection has been selected (connection table), it will contain the following groups:

● Connection details

● Address details of the connection (for S7-1200 only)

 

Determining connection resources

Where do I determine connection resources? 
The connection resources are obtained in the "Connection resources" group. This group is 
located in the "Diagnostics > Connection information" area of the Inspector window. It is 
displayed only if you have selected a module in the Network view.

Number of connection resources
● Maximum number: Specifies the maximum number of available connection resources of 

the module.

● Not assigned: Indicates how many connection resources are not yet assigned. If connection 
resources are already reserved for certain types of communication, then the unreserved 
connection resources cannot always be used for the various connection types.

Reserved and currently assigned connection resources
For the communication types indicated below, the connection resources that are reserved and 
currently assigned by the module will be displayed.

Communication type Meaning
PG communication Resources for connections between the module and programming devices (for 

example, for the establishment of a connection from the project tree, for online 
diagnostics, etc.)

HMI communication Resources for connections between the module and HMI devices
Open user communication Resources for connection of open user communication instructions
S7 communication Resources for configured S7 connections, through which data can be exchanged by 

calling instructions in the user program.
Other communication Specifies other assigned connection resources for which connection resources are not 

reserved.
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Determining connection details

Where do I determine the connection details?  
The connection details are obtained in the "Connection details" group. This group is located 
in the "Diagnostics > Connection information" area of the Inspector window.

When is the "Connection details" group filled in?
The following requirements must be met to fill in the "Connection details" group on the 
"Connection information" tab:

● An online connection to the end point of the relevant connection must exist.

● You have selected a line in the connection table.

Structure of the "Connection details" group
The "Connection details" group consists of the following elements:

● Local ID (hex)

● Connection type (for S7-1200 only)

● Protocol

● Connection status: icon and description

● Details

● Last status change (for S7-300 and S7-400 only)

Determining the address details of a connection

Where do I determine the address details of a connection?  
The address details of a connection are obtained in the "Address details for connection" group. 
This group is located in the "Diagnostics > Connection information" area of the Inspector 
window.

For which CPUs is the "Address details for connection" group available?
The "Address details for connection" group of the "Connection information" tab is available for 
S7-1200 CPUs only.

When is the "Address details for connection" group filled in?
The following requirements must be met to fill in the "Address details for connection" group on 
the "Connection information" tab:

● An online connection to the end points of the relevant connection must exist.

● You have selected a line in the connection table.
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Structure of the "Address details of connection" group
The following information is specified for the two communication partners:

● Endpoint

● Interface (not for remote partner)

● Subnetwork (not for remote partner)

● Address

● TSAP

● Protocol

● Active connection setup: Yes/no
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Visualizing processes (Professional) 9
9.1 Creating screens

9.1.1 Principles

9.1.1.1 Screen basics

Introduction
In WinCC you create screens that an operator can use to control and monitor machines and 
plants. When you create your screens, the object templates included support you in visualizing 
processes, creating images of your plant, and defining process values.

Application example
The figure shows a screen that was created in WinCC. With the help of this screen, the operator 
can operate and monitor the mixing station of a fruit juice manufacturing system. Fruit juice 
base is supplied from various tanks to a mixing unit. The screen indicates the fill level of the 
tanks. 

Screen design
Insert an object you need to represent a process into your screen. Configure the object to 
correspond to the requirements of your process.

A screen may consist of static and dynamic elements. 
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● Static elements such as text or graphic objects do not change their status in runtime. The 
tank labels (W, K, Z, A) shown in this example of a mixing unit are static elements.

● Dynamic elements change their status based on the process. Visual current process values 
as follows:

– From the memory of the PLC

– From the memory of the HMI device in the form of alphanumeric displays, trends and 
bars.

Input fields on the HMI device are also considered dynamic objects. The fill level values of 
the tanks in our example of a mixing plant are dynamic objects.

Process values and operator inputs are exchanged between the controller and the HMI device 
via tags.

Screen properties
The screen layout is determined by the features of the HMI device you are configuring. It 
corresponds with the layout of the user interface of this device. If the set HMI device has 
function keys, the screen shows these function keys. Other properties such as the screen 
resolution, fonts and colors are also determined by the characteristics of the selected HMI.

Function keys
A function key is a key on the HMI device to which you can assign one or several functions in 
WinCC. The functions are triggered as soon as the operator presses the key on the HMI device. 

A function key can be assigned global or local functions: 

Global function keys always trigger the same action, regardless of the currently displayed 
screen.

Local function keys trigger different actions depending on the currently displayed screen on 
the HMI device. This assignment applies only to the screen in which you have defined the 
function key.
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Navigation
You configure a screen navigation to enable the operator to call a screen on the HMI device 
in Runtime. 

● The "Screen" editor is used to configure buttons for calling other screens.

● You use the "Global Screen" editor to configure globally assigned function keys.

See also
Overview of objects (Page 660)

Basics on text lists (Page 708)

Basic principles of graphics lists (Page 718)

Basics on dynamizing screens (Page 729)

Basics on libraries (Page 773)

Basics on faceplates (Page 785)

Print job/Script diagnostics (Page 837)

Basics on screen navigation (Page 953)

9.1.1.2 Screen basics

Introduction
In WinCC you create screens that an operator can use to control and monitor machines and 
plants. When you create your screens, the object templates included support you in visualizing 
processes, creating images of your plant, and defining process values.

Application example
The figure shows a screen that was created in WinCC. With the help of this screen, the operator 
can operate and monitor the mixing station of a fruit juice manufacturing system. Fruit juice 
base is supplied from various tanks to a mixing unit. The fill levels of the tanks are indicated. 
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Screen design
Insert an object you need to represent a process into your screen. Configure the object to 
correspond to the requirements of your process.

A screen may consist of static and dynamic elements: 

● Static elements such as text or graphic objects in the screen above do not change their 
status in Runtime. The tank labels (W, K, Z, A) shown in this example of a mixing unit are 
static elements.

● Dynamic elements change their status based on the process. Visual current process values 
as follows:

– From the memory of the PLC

– From the memory of the HMI device in the form of alphanumeric displays, trends and 
bars.

Input fields on the HMI device are also considered dynamic objects. The fill level values of 
the tanks in our example of a mixing plant are dynamic objects.

Process values and operator inputs are exchanged between the controller and the HMI device 
via tags.

Navigation
You configure a screen navigation to enable the operator to call a screen on the HMI device 
in Runtime.

● You use the "Menus & Toolbars" editor to configure the navigation between the screens.

● The "Screen" editor is used to configure buttons for calling other screens.

9.1.1.3 HMI device dependency for screens

Introduction
The functions of an HMI device determine the display of the device in WinCC and the scope 
of functions of the editors.

The following screen properties are determined by the functions of the selected HMI device:

● Device layout

● Screen resolution

● Number of colors

● Fonts

● Objects available

Device layout
The device layout of a screen forms the image of the HMI device in your configuration. The 
device layout of the screen shows all the function keys available on the HMI device, for 
example.   
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Screen resolution
The screen resolution is determined by the different display dimensions of the various operator 
panels. You can only change the screen resolution if you configure the 
"WinCC Runtime Advanced" or "WinCC Runtime Professional" HMI device. 

Number of colors
You can assign colors to the screen objects. The number of possible colors is determined by 
the color depth and specific colors supported on the selected HMI device. 

Fonts
You can customize the appearance of the texts in all the screen objects that contain static or 
dynamic text. How to highlight individual texts in a screen. Select the font, font style and size, 
and set additional effects such as underscoring, for example.  

The settings for the text markups such as font style and effects always refer to the entire text 
of a screen object. That is, you can display the complete title in bold format, but not its individual 
characters or words, for example. 

Objects available
Some of the screen objects can not be configured globally for all HMI devices. These screen 
objects are not displayed in the "Tools" task card. For a KTP 1000 touch panel unit you can 
not configure a slider, for example. 
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9.1.1.4 Elements and Basic Settings

Task cards

Introduction
The following task cards are available in the "Screens" editor:  

● Tools: Display and operating objects

● Animations: Templates for dynamic configuration

● Layout: Aid for customizing the display

● Libraries: Administration of the project library and of the global libraries
 

  Note
WinCC Basic

The "Animations" task card is not available in WinCC Basic.
 

Tools
The "Tools" task card contains objects in different panes:

● Basic objects

● Elements

● Controls

● User controls (optional)

● Graphics

You paste objects from the palettes into your screens by drag&drop or a double click. The 
objects available for selection are determined by the features of the HMI device you are 
configuring. The following icons are used to change the display mode:

Icon Meaning
Displays the objects as a list.

Displays the objects as a graphic.

Animations
The "Animations" task card contains the possible dynamizations of a screen object in the 
palettes. You paste the animations to a screen object by drag&drop or a double click from the 
"Movements", "Display" and "Tag Binding" palettes.
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Layout
The "Layout" task card contains the following panes for displaying objects and elements:

● Zoom: Serves to select detail view

● Layers: Serves to manage screen object layers The layers are displayed in a tree view and 
contain information about the active layer and the visibility of all layers.

● Grid: You specify whether you want to align the objects to a grid or to other objects and set 
the grid size for a grid. 

● Objects out of range: Objects that lie outside the visible area are displayed with name, 
position and type.

Libraries
The "Libraries" task card show the following libraries in separate panes:

● Project library: The project library is stored together with the project.

● Global library: The global library is stored in a separate file in the specified path on your 
configuration PC.

Zooming the view

Introduction
To view a small screen section in closer detail, use the zoom tool to magnify the screen in the 
working area. The maximum zoom amounts to 800%.   

You can zoom with the toolbar in the work area or with the "Layout > Zoom" task card.

There are different ways to zoom the screen, e.g. with the zoom factor or by adapting the work 
area to the height of the screen.
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Requirement
The screen is opened.

Procedure
Proceed as follows to zoom a view with the selection frame:

1. Click the  toolbar button.

2. Use the mouse to draw a selection frame in the screen.

After you have released the mouse button, the section enclosed by the selection frame is 
zoomed to fit the complete work area. 

Alternatively open the "Layout" task card and change the screen view.

Result
The selected screen section is magnified. 

Move view

Introduction
You have the following options to display only a section of the entire screen in the work area:

● With the  icon of the "Screens" editor.

● With the miniature view of the entire screen in the "Zoom" palette of the "Layout" task card.

Requirement
● A screen is open.

● The view shows only a screen section.

Procedure
To move the view:

1. Click the  icon at the bottom right corner of the work area and press the left mouse button.
A miniature view of the full screen is shown. An orange frame shows the currently selected 
area.

2. Hold down the mouse button and drag the frame to the desired area.
 

  Note

The screen is scrolled when you drag a screen object from the visible to a currently hidden 
section. 
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9.1.1.5 Working with screens

Steps

Steps
To create screens, you need to take the following initial steps:   

● Plan the structure of the process visualization: Number of screens and their layout
Example: Subprocesses are visualized in separate screens, and merged in a master screen.

● Define your screen navigation control strategies.

● Adapt the templates and the global screen.
You define objects centrally and assign function keys for example. 

● Create the screens. Use the following options of efficient screen creation:

– Working with libraries

– Working with layers

– Working with faceplates

Steps

Steps
To create screens, you need to take the following initial steps:   

● Plan the structure of the process visualization: Number of screens and their layout Example: 
Subprocesses are visualized in separate screens, and merged in a master screen.

● Define your screen navigation control strategies.
Create the menus and toolbars to navigate between the screens.

● Create the screens. Use the following options to achieve efficient screen configuration:

– Working with libraries

– Working with faceplates

– Working with layers

– Working with designs

See also
Basics on working with designs (Page 648)
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Creating a new screen

Introduction
Create screens to display processes in your system.   

Requirement
● The project has been created.

● The Inspector window is open.

Procedure
1. Double-click "Screens > Add New Screen" in the project navigation.

The screen is generated in the project and appears in your view. The screen properties are 
shown in the Inspector window.

2. Enter a meaningful name for the screen.

3. Configure the screen properties in the Inspector window:

– Specify whether and on which template the screen is based.

– Set the "Background Color" and the "Screen Number."

– Specify a documenting text under "Tooltip".

– Specify the layers to be displayed under "Layers" in the engineering system.

– Select dynamic screen update under "Animations."

– Select "Events" to define which functions you want to execute in Runtime when you call 
and exit the screen or at other events.

 

  Note

Not all HMI devices support the "Visibility" animation.
 

Result
You created the screen in your project. You can now paste objects and control elements from 
the "Tools" task card and assign function keys in further work steps.

Creating a new screen

Introduction
Create screens to display processes in your system.   
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Requirement
● The project has been created.

● The Inspector window is open.

Procedure
To create a new screen:

1. Double-click "Screens > Add New Screen" in the project navigation.
The screen is generated in the project and appears in your view. The screen properties are 
shown in the Inspector window.

2. Enter a meaningful name for the screen, such as "Overview_Diagram."
Do not use the special characters ?, ", /, \, *, <, >

3. Configure the screen in the Inspector window:

– Set the background color and the grid color under "General."

– Specify a tooltip providing additional information.

– Specify the size of the screen under "Layout."

– Define the pattern and the color of a fill pattern under "Appearance."

– Specify the layers to be displayed under "Layers" in the Engineering System.

– Specify the tab sequence for activating the screen objects and selecting the objects to 
be activated under "Miscellaneous."

– Under "Hide/Show" specify whether a size to be defined is used to determine the display 
for layers and/or objects.

– Dynamize the display and operating elements under "Animations."

– Select "Events" to define which functions you want to execute in runtime when you call 
and exit the screen or at other events.

Result
You created the screen in your project. You can now paste objects and control elements from 
the "Tools" task card in further work steps.

Managing Screens

Introduction
You can move screens within a project to other groups, or copy, rename, and delete them.          

Moving screens in a group
1. Select the "Screens" folder in the project tree.

2. Select the "Add group" command from the shortcut menu.
A folder called "Group_x" is inserted.
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3. Select the screen in the project tree.

4. Drag-and-drop the screen to the required group.
The screen is moved into this group.

Copy screen
1. Select the screen in the project tree.

2. Select the "Copy" command in the shortcut menu to copy the screen to the clipboard.

3. In the project tree, select the screen insert position.

4. Select "Paste" from the shortcut menu to insert the screen.
A copy of the screen is inserted. A consecutive number is appended to the name of the 
original in the copy. 

Alternatively, press <Ctrl> while you drag the screen to the required position.
 

 Note

If you copy a screen with interconnected template for several devices and projects, the 
template will also be copied. Any existing matching template is not used. This holds 
particularly true when you copy the screens with drag-and-drop.

 

Rename screen
1. Select the screen in the project tree.

2. Select "Rename" from the shortcut menu.

3. Type in a new name.

4. Press <Enter>.

As an option, use the <F2> function key to rename the screen.

Delete screen
1. Select the screen in the project tree.

2. Select "Delete" from the shortcut menu.
The screen and all its objects are deleted from the current project. 

Defining the start screen of the project

Introduction
The start screen is the initial screen opened at the start of project in Runtime. You can define 
a different start screen for each one of the HMI devices. Beginning at this start screen, the 
operator calls the other screens.   

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
640 System Manual, 08/2011,  



Requirement
The project contains the screen you want to use as the start screen.

Procedure
1. Double-click "Runtime settings > General" in the project tree.

2. Select the desired screen as "Start screen."

Alternatively select a screen in the project tree and select "Use as start screen" in the shortcut 
menu.

Result
The start screen opens on the HMI at the start of Runtime. 

9.1.1.6 Working with templates

Basics on working with templates

Introduction
Configure the objects in a template which are to be displayed in all screens based on this 
template.

Note the following rules:

● A screen must not be based on a template.

● A screen is only based on one template.
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● You can create several templates for one device.

● A template cannot be based on another template.

Objects for a template
You determine functions and objects in the template which are to apply for all screens based 
on this template:

● Assignment of function keys: You also assign the function keys in the template for HMI 
devices with function keys. This assignment overwrites a possible global assignment.

● Permanent window: Some devices support a permanent window for all screens in the top 
area of the screen. In contrast to the template, the permanent window occupies an area of 
the screen for itself alone.

● Operator controls: You can paste all screen objects which you also use for a screen into a 
template.

Application examples
● You want to assign the ActivateScreen" function to a function key in the template. The 

operator uses this key to switch to another screen in runtime. This configuration applies to 
all screens that are based on this template.

● A graphic with your company logo can be added to the template. The logo appears on all 
screens that are based on this template.

 

  Note

If an object from the template has the same position as an object in the screen, the 
template object is covered.

 

See also
Configuring a permanent window in the template  (Page 645)

Using a template in the screen (Page 647)

Creating a new template (Page 644)

Managing a template (Page 646)

Global screen (Page 642)

Global screen

Introduction
You define global elements for all screens of an HMI device independently of the used 
template.  
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Function keys  
For HMI devices with function keys you assign the function keys globally in the "Global Screen" 
editor. This global assignment applies for all screens of the HMI device.

Proceed as follows to assign function keys locally in screens or templates:

1. Click the function key in your screens or templates.

2. Deactivate "Properties > Properties > General > Use Global Assignment" in the inspection 
window.   

Indicator and control objects for alarms 
The "Alarm window" and "Alarm indicator" objects that are available as global objects are 
configured within the "Global screen" editor.

The "Alarm window" and "Alarm indicator" are always shown in the foreground.

For Comfort Panels you also have the possibility of configuring a "System diagnostic view" in 
the global screen.

 

 Note

If you have configured a permanent window in a template, do not position the alarm window 
and alarm indicator in the area of the permanent window. Otherwise, the alarm window and 
the alarm indicator will not be displayed in Runtime. 

The permanent window is not visible in the "Global screen" editor. 
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Order of configuration of screens  
The following order applies for the configuration:

● The global screen comes before screens and templates

● Screens come before templates

The system layer is not configurable. This contains

● input dialog boxes

● alarms from the operating system

● the direct keys for touch panels

See also
Basics on working with templates (Page 641)

Creating a new template

Introduction
In a template, you can centrally modify objects and function keys. Changes to an object or of 
a function key assignment in the template are applied to the object in all the screens which 
are based on this template.   

 

 Note
HMI device dependency

Function keys are not available on all HMI devices.
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Requirement
● The project has been created.

● The Inspector window is open.

Procedure
1. Select "Screen management > Templates" in the project tree and then double-click "Add 

new template".
The template is created in the project, and appears in your view. 
The properties of the template are displayed in the Inspector window.

2. Define the name of the template under "Properties > Properties > General" in the Inspector 
window.

3. Specify the layers in the engineering system that are displayed under "Properties 
>Properties >Layers" in the Inspector window.

4. Add the necessary objects from the "Tools" task card.

5. Configure the function keys.

Result
The template is created in your project. 

See also
Basics on working with templates (Page 641)

Configuring a permanent window in the template 

Introduction
In the permanent window you configure objects which are visible in all screens. In contrast to 
the template, the permanent window occupies an area of the screen for itself alone.
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Configuring permanent windows
Proceed as follows to configure a permanent window:  

1. Open a template for a HMI device with a permanent window.

2. Use the mouse (cursor shape: ) to drag the top edge of the editable screen area down.

3. Configure the desired objects in the area of the permanent window.

The default height of the permanent window is "0". The maximum height is the maximum height 
of the screen minus 10 pixels.

Result
The content of the permanent window appears on every screen, and in the template. The area 
above this line is now used as a permanent window in all the screens of the HMI device. Already 
configured objects in the screens are moved down by the height of the permanent window.

See also
Basics on working with templates (Page 641)

Managing a template

Introduction
You can move, copy, rename, and delete templates within a project in the Project window.          

Moving a template into a group
1. Select the templates in the project navigation "Screen management > Templates".

2. Select "Add group" in the shortcut menu.
A folder called "Group_x" is inserted.
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3. Select the template in the project navigation.

4. Drag-and-drop the template to the required group.
The template is moved to this group.

Copying templates
1. Select the template in the project navigation.

2. Select "Copy" in the shortcut menu.

3. Select the position in the project navigation where you want to paste the template.

4. Select "Paste" from the shortcut menu to insert the template.
A unique name is assigned automatically to the copy. 

Alternatively, you can hold down the <Ctrl> key, and drag the template into position.

Deleting a template
1. In the project navigation, select the template to be deleted.

2. Select "Delete" in the shortcut menu.
The template, and all its objects are deleted from the current project. 

Assigning a template to a screen
1. In the project navigation, select the screen to which you want to assign the template.

2. In the Inspector window, select "Properties > Properties > General".

3. Select the desired template under "Template."
The selected template and all the objects contained in it are assigned to the screen. 

See also
Basics on working with templates (Page 641)

Using a template in the screen

Introduction
You use a template in the screen. All the objects configured in the template are also available 
in the screen.

Requirement
A template has been created.

A screen has been created.
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Procedure
Proceed as follows to use a template in a screen:   

1. Double click a screen in the project tree. The screen opens in the work area.

2. Open "Properties > Properties > General" in the inspector window.

3. Select a template that is to be applied to the screen under "Template".

Show template in screen
When you edit a screen, you can show an existing template in the screen. 

Proceed as follows to show a template in the screen:

1. Activate "Extras > Settings > Visualization > Show template in screens" in the menu.

Result
The screen is based on the selected template. All objects which you have configured in the 
template are available in the screen. The template is displayed in the screen. 

See also
Basics on working with templates (Page 641)

9.1.1.7 Working with designs

Basics on working with designs

What are designs?   
Designs are templates for displaying screens and the objects configured there. A design 
contains, for example, color specifications for foreground, background, border line, text, fill 
pattern, etc. of the following objects: 

● Screens

● Menus and toolbars

● Basic objects and pipes

● Text fields

● Buttons, sliders, check boxes, option buttons and bars

● Controls

Application
You create the surfaces of the HMI devices in a uniform layout with the help of designs. Instead 
of defining the appearance of all the screens and objects individually, use the design selected 
in the runtime settings of the HMI device. 
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If you want to change the layout of the screens and objects, select a different design or modify 
the current design to your requirements. The new or modified design is automatically taken 
over from all the screens and objects of the HMI device.

 

 Note
Individual layout for screens and objects

You can configure an individual layout that differs from the selected design for each screen 
and each object in the properties of the configured screens and objects.

 

 Note
Same layout for user interfaces of several HMI devices

To design the user interfaces of several HMI devices in a uniform layout, assign the same 
design to each HMI device. When you assign the standard design you can define another 
design as the standard design and therefore change the basic layout of all HMI devices.

 

Predefined designs
WinCC features a number of predefined designs such as "WinCC Classic" for user interfaces 
in the classic WinCC layout and "WinCC Glass" for user interfaces in the style of Windows 
Vista. 

 

 Note

Predefined designs cannot be deleted or changed.
 

Managing designs  
You manage designs in the "Designs" editor. Here you can find out about existing designs, 
select a design as the standard design and create new designs if required. You can change 
and delete your own designs.

Designs are project-specific. You can therefore find the editor in the project tree under 
"Common data".

See also
Use default design (Page 656)

Managing designs (Page 650)

Applying a design (Page 653)
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Managing designs

Designs editor

Introduction  
You manage layout templates for screens, objects and controls in the "Designs" editor. Here 
you can find out about existing designs, select a design as the standard design and create 
new designs if required. In contrast to the predefined designs, you can change and delete 
designs that were created manually.

Structure of the "Designs" editor
The "Designs" area in the left pane lists all the designs. The "Preview" area in the right pane 
shows how images and objects are displayed with the design selected from the left pane. 

The names of the predefined designs are shown against a gray background in the list of 
designs. These designs cannot be deleted or changed. The default design is selected in the 
"Default" column.
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Click the desired design in the "Designs" list for a preview of another design. The "Preview" in 
the right pane is refreshed: 

● The first line offers a preview of the menu layout.

● The icons on the left offer a preview of the layout of the toolbar.

● The objects of the "Tools" task card are grouped by basic objects, elements and controls 
in the same way as in the toolbox.

You can find detailed information on which layout properties are specified by the design in the 
Inspector window.

 

 Note

To display the layout properties of a particular object, click the desired object in the preview. 
The Inspector window displays the related properties.

 

See also
Basics on working with designs (Page 648)

Use default design (Page 656)

Applying a design (Page 653)

Creating a design (Page 651)

Changing a design (Page 652)

Deleting a design (Page 652)

Creating a design

Requirement
You have opened the "Designs" editor.

Procedure  
Proceed as follows:

1. Click "Add" in the list of designs.
A new design is created. The WinCC default properties are set for screens, menus, toolbars 
and objects. Note that these are not the properties of the configured default design.

2. Overwrite the suggested name with a meaningful name.

3. Enter a description of the design, e.g. the intended use in the "Comment" column.

4. Configure the design as required.
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Alternatively: Copying a design  
You can also create a new design on the basis of a similar design. Use the functions of the 
shortcut menu to copy a design and add it to the end of the list as a new design.

See also
Designs editor (Page 650)

Changing a design (Page 652)

Deleting a design (Page 652)

Basics on working with designs (Page 648)

Changing a design

Requirement
You have opened the "Designs" editor.

Procedure  
Proceed as follows:

1. Select the design you wish to change from the list of designs.
Note that you can only change designs which were created manually. You cannot change 
the predefined designs of WinCC.

2. Make the required changes in the Inspector window.

3. Check the result in the preview.

The changes are effective immediately. 

See also
Designs editor (Page 650)

Creating a design (Page 651)

Deleting a design (Page 652)

Basics on working with designs (Page 648)

Deleting a design

Requirement
You have opened the "Designs" editor.
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Procedure   
Proceed as follows:

● Select "Delete" from the shortcut menu of the desired design.
Note that you can only delete designs which were created manually. You cannot delete the 
predefined designs of WinCC.

Result
The design is deleted. WinCC assigns the predefined design "WinCC Classic" as the new 
basic design to HMI devices to which the deleted design was assigned as the basic design in 
the Runtime settings.

See also
Designs editor (Page 650)

Creating a design (Page 651)

Changing a design (Page 652)

Basics on working with designs (Page 648)

Applying a design

Applying a design

Core message   
In WinCC, every HMI device is assigned a design as a basic design. The following basic design 
specifications are applied to all screens of the HMI device:

● Settings relating to the display of the shadow of an object (if "Shadow" is activated for the 
object)

● Settings relating to the display of elements when the mouse pointer is moved over them 
(hover effect)

● Settings relating to the layout of menus and toolbars

For the individual screens, elements and controls, you also specify in each case whether the 
specifications of the basic design or the individual settings are applied in the Inspector window.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  653



See also
Basics on working with designs (Page 648)

Designs editor (Page 650)

Use default design (Page 656)

Specifying the basic design user interface of an HMI device (Page 654)

Applying design specifications for the layout of screens (Page 654)

Applying design specifications for the layout of basic elements and elements (Page 655)

Applying design defaults for the layout of controls (Page 656)

Specifying the basic design user interface of an HMI device

Procedure
To change the basic design of the user interface of an HMI device, follow the steps below:

1. Open the "Runtime settings" of the HMI device.

2. Under "General > Settings", specify whether the default design or a different design is used 
as the basic design.

See also
Applying a design (Page 653)

Applying design specifications for the layout of screens (Page 654)

Applying design specifications for the layout of basic elements and elements (Page 655)

Applying design defaults for the layout of controls (Page 656)

Basics on working with designs (Page 648)

Applying design specifications for the layout of screens

Procedure  
To apply the design specifications for the layout of screens to a screen, proceed as follows:

1. Open the desired screen in the "Screens" editor.

2. Display the screen properties in the Inspector window and select "Properties > Properties 
> Design > Settings > Use color scheme".

Result
The settings of the design are applied to the screen. 

The corresponding fields are disabled in the Inspector window. All the settings that are not 
predefined by the design are activated and can be changed.
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See also
Applying a design (Page 653)

Specifying the basic design user interface of an HMI device (Page 654)

Applying design specifications for the layout of basic elements and elements (Page 655)

Applying design defaults for the layout of controls (Page 656)

Basics on working with designs (Page 648)

Applying design specifications for the layout of basic elements and elements

Procedure 
To apply the design specifications for the layout of basic elements and elements, proceed as 
follows:

1. Open the screen in the "Screens" editor.

2. Click the required object in the work area.

3. In the Inspector window, display the settings of the group "Properties > Properties > 
Designs".

4. To represent the object with a shadow, select "Settings > Shadow".
WinCC applies the specifications of the design. 
If the "Shadow" option is deactivated in the design, the object is displayed without a shadow 
in the screen - even if a "shadow" is activated in the object properties.

5. To apply the color defaults from the design, select "Settings > Use color scheme".

Result
The settings of the design are applied to the screen. 

In the Inspector window, the fields for setting the background color, frame etc. are deactivated. 
All the settings that are not predefined by the design are activated and can be changed.

See also
Applying a design (Page 653)

Specifying the basic design user interface of an HMI device (Page 654)

Applying design specifications for the layout of screens (Page 654)

Applying design defaults for the layout of controls (Page 656)

Basics on working with designs (Page 648)
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Applying design defaults for the layout of controls

Procedure 
To apply the design defaults for the layout of controls, proceed as follows:

1. Open the screen in the "Screens" editor.

2. Click the required object in the work area.

3. Select "Properties > Properties > Appearance > Style > Accept project settings".

The control is displayed in the style specified in the design. 

See also
Applying a design (Page 653)

Specifying the basic design user interface of an HMI device (Page 654)

Applying design specifications for the layout of screens (Page 654)

Applying design specifications for the layout of basic elements and elements (Page 655)

Basics on working with designs (Page 648)

Use default design

Introduction  
A design is specified as a default design. If you want to design the user interfaces of several 
HMI devices in a uniform layout, specify the desired design as the default design, and assign 
it to the HMI devices as the basic design in the Runtime settings "Default design". 

If you want to change the layout of the screens and objects, adapt the default design to your 
requirements or configure a different design as the default design. The latter is the actual 
advantage of working with the default design: You can practically change the layout for the 
screens and objects of all the HMI devices at the click of a mouse. 

Configuring a default design
Proceed as follows:

1. Open the "Designs" editor.

2. Select the desired design in the list of designs in the "Default" column in the work area.
Or:
Display a preview of the desired desire in the work area and select "Properties > Properties 
> General > Design > Default" in the Inspector window.

3. If required, adapt the design to your requirements.
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Use default design
The default design settings are effective for the objects which satisfy the following conditions:

● "Runtime settings > General > Settings > Use default design" is activated for the HMI device.

● For screens, basic elements and elements: "Properties > Properties> Design > Settings > 
Use color scheme" is selected in the Inspector window.

### Bitte UI vereinheitlichen – oder Text muss geändert werden: 
For screen "Properties > Properties > Design > Settings > Use color scheme"
For objects "Properties > Properties > Designs > Settings > Color scheme" ###
● For controls: "Properties > Properties > Appearance > Style > Accept project settings" is 

selected in the Inspector window.

See also
Basics on working with designs (Page 648)

Designs editor (Page 650)

Applying a design (Page 653)

9.1.2 Working with Objects

9.1.2.1 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.    

The "Tools" task card contains all objects that can be used for the HMI device.

Display the tool window with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example "Trend view" and "Recipe view."

● "User-specific controls"
In this palette you can add ActiveX control to the Toolbox window. Only the ActiveX controls 
that are registered in the Windows operating system on the configuration computer are 
available. From this palette you incorporate ActiveX controls into your project.
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● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches". 
You may also store customized objects and faceplates in user libraries. Faceplates are 
objects that you create from existing screen objects, and for which they define the 
configurable properties. 

Basic objects

Icon Object Instructions
"Line" -

"Polyline" The polyline is an open object. Even if the start and end points have 
the same coordinates, the area they enclose cannot be filled in. If 
you want to fill a polygon, select the "Polygon" object.

"Polygon" -

"Ellipsis" -

"Circle" -

"Rectangle" -

"Circular arc" The circular arc is an open object. Even if the start and end points 
have the same coordinates, the area they enclose cannot be filled 
in. If you want to fill a circle, select the "Circle" or "Circle segment" 
object.

"Ellipse arc" An ellipse arc is an open object. Even if the start and end points 
have the same coordinates, the area they enclose cannot be filled 
in. If you want to fill an ellipse, select the "Ellipse" or "Ellipse 
segment" object.

"Circle segment" -

"Ellipse segment" -

"Connector" Connects objects with lines.

"Text field" One or more lines of text. The font and layout are adjustable.
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Icon Object Instructions
"Graphic view" Displays graphics from external graphic programs, and inserts OLE 

objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

"Pipe" Represents a continuous pipe with several bends in a pipe system.

"Double T-piece" Represents a pipe junction in a pipe system.

 "T piece" Represents a T-shaped pipe connection.

"Pipe bends" Represents a bent section of pipe.

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in Runtime, activate "Hidden input."

"Button" Executes a list of functions, or a script as configured.

"Round button" Operates processes, such as confirm messages.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text 
from a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A 
graphic from a graphics list is displayed in relation to the tag value.

"Bar" The bar represents a value from the PLC in the form of a scaled 
bar graph.

"Symbol library" Used to add screen objects based on controls of the same name. 

"Slider" Used to display a current value or to enter a numeric value.

"Scroll bar" Enters a numerical value at the PLC. The value can be adjusted 
smoothly.

"Check box" Selects options.

"Option button" Selects an option.

"Gauge" Displays numeric values.
The appearance of the gauge is adjustable.

"Clock" Displays the system time in analog or digital format.
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Controls

Icon Object Description
"Screen window" Displays other screens of the object.

"f(t) trend view" Represents multiple curves with values from the PLC, 
or from a log.

"f(x) trend view" Represents the values of a tag as a function of another 
tag.

"Table view" Represents current or archived process data in a table.

"Value table" Represents evaluated data and statistics in a table.

"User view" Allows an administrator to administer users on the HMI 
device.
It also allows an operator without administrator rights to 
change his password.

"HTML browser" Displays HTML pages.

"Print job/Script diagnostics" Displays data of the Global Script application and of the 
log system for editing.

"Recipe view" Used to display and modify recipes.

Media Player Enables video and audio files to be played.

"Memory space view" Shows the existing memory size.

"Channel diagnostics" Allows users to control the active connections.

"Alarm view" Shows currently pending alarms or alarm events from 
the alarm buffer or alarm log.

 

 Note

Some of the toolbox objects are either available with restricted functionality, or not at all. This 
depends on the HMI device you are configuring. Unavailable properties of an object are 
displayed as deactivated, and cannot be selected.

 

See also
Example: Inserting and configuring a rectangle (Page 705)

9.1.2.2 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 
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The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.

● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 
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Basic objects

Icon Object Instructions
"Line" -

"Polyline" The polyline is an open object. Even if the start and end points have 
the same coordinates, the area they enclose cannot be filled in. If you 
want to fill a polygon, select the "Polygon" object.

"Polygon" - 

"Ellipsis" -

"Circle" -

"Rectangle" -

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in Runtime, activate "Hidden input."

"Button" Executes a list of functions, or a script as configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text from 
a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A graphic 
from a graphics list is displayed in relation to the tag value.

"Date/time field" Outputs the system date and time, or the time and date from a tag. 
This allows the operator to enter new values. The display format is 
adjustable.

"Bar" The bar represents a value from the PLC in the form of a scaled bar 
graph.

"Switch" Toggles between two defined states. You can label a switch with 
text, or a graphic.

"Symbol library" Used to add screen objects based on controls of the same name. 

"Slider" Displays a current value from the PLC, or sends a numeric value to 
the PLC.

"Gauge" Displays numeric values.
The appearance of the gauge is adjustable.

"Clock" Displays the system time in analog or digital format.
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Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"Status/Force" This function gives the operator direct read / write 
access from the HMI device to individual address 
areas in the connected SIMATIC S7.

"Sm@rtClient view" Allows an operator to monitor and maintain a 
connected device remotely.

"Recipe view" Displays data records, and allows them to be edited.

"f(x) trend view" Represents the values of a tag as a function of another 
tag.

"Charge condition" Shows the charge condition of the battery for Mobile 
Wireless 

"Effective range name" Shows the name of the effective range.

"Effective range 
name (RFID)"

Displays the name of the effective range (RFID).

"Effective range 
signal"

Indicates how accurately the Mobile Panel Wireless is 
positioned within an effective range. 

"WLAN reception" Indicates how good the WLAN radio connection is.

"Zone name" Displays the name of the zone.

"Zone signal" Indicates how accurately the Mobile Panel Wireless is 
positioned within a zone.

See also
Screen basics (Page 629)

Rotating an object in runtime (Page 680)

Flashing (Page 682)

Inserting multiple objects of the same type (stamping tool) (Page 683)

Overview of objects (Page 664)
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9.1.2.3 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.

● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 
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Basic objects

Icon Object Instructions
"Line" -

"Ellipsis" -

"Circle" -

"Rectangle" -

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in Runtime, activate "Hidden input."

"Button" Executes a list of functions, or a script as configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text from 
a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A graphic 
from a graphics list is displayed in relation to the tag value.

"Date/time field" Outputs the system date and time, or the time and date from a tag. 
This allows the operator to enter new values. The display format is 
adjustable.

"Bar" The bar represents a value from the PLC in the form of a scaled bar 
graph.

"Switch" Toggles between two defined states. You can label a switch with 
text, or a graphic.

Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
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Icon Object Description
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"Recipe view" Displays data records, and allows them to be edited.

See also
Overview of objects (Page 660)

9.1.2.4 Options for Editing Objects

Introduction
Objects are graphics elements which you use to design the screens of your project. 

You have the following options for editing objects:

● Copying, pasting or deleting objects using the shortcut menu If you copy an object in a 
screen and the screen already includes an object of the same name, the name of the object 
is changed.

● Maintaining the standard size of the objects you are inserting or customizing their size on 
insertion.  

● Changing the properties of an object, e.g. the size  

● Positioning an object  

● Moving an object in front of or behind other objects   

● Rotating objects  

● Mirroring objects  

● Changing default properties of the objects 

● Defining the tab sequence for objects 

● Stamping: Inserting several objects of the same type 

● Selecting several objects simultaneously  
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● Repositioning and resizing multiple objects 

● You can assign external graphics to objects, e.g. in the Graphic View.
You can view only the images you have previously stored in the graphic browser of your 
WinCC project.  
You can save graphics in the graphic browser:

– Via drag & drop from the "Graphics" object group to the working area

– As graphic files in the following formats: *.bmp, *.dib, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg 
or *.jpg

– As an OLE object
You either create a new OLE object or save an existing graphic file as an OLE object. 
To save an OLE object, an OLE-compatible graphics program must be installed on the 
configuration computer.     

See also
Inserting an object (Page 668)

Deleting an Object (Page 669)

Positioning an object (Page 670)

Resizing an object (Page 671)

Selecting multiple objects (Page 672)

Aligning objects (Page 674)

Moving an object forward or backward (Page 675)

Show objects outside the screen area (Page 676)

Rotating objects (Page 677)

Flipping objects (Page 679)

Inserting multiple objects of the same type (stamping tool) (Page 683)

Repositioning and resizing multiple objects (Page 685)

Hiding or showing objects (Page 685)

Managing My Controls (Page 686)

External graphics (Page 688)

Managing external graphics (Page 689)

Storing an external image in the graphics library. (Page 690)

Example: Inserting and configuring a rectangle (Page 705)
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9.1.2.5 Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
 

Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 

Alternatively, double-click the object in the "Toolbox" task card.

Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.
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Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
 

 

 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.

 

 

See also
Moving an object forward or backward (Page 675)

9.1.2.6 Deleting an Object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.
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Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 

9.1.2.7 Positioning an object

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   

 

 Note

If the position is outside the work area the object is not displayed in Runtime.
 

Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.
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Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.

3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 

9.1.2.8 Resizing an object

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.
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Procedure   
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
 

  Note

In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

 

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".

Result
The object now appears with its new size. 

9.1.2.9 Selecting multiple objects

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 

You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.

Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:
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● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.

Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.

Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:

1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.
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Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size

● Moving all the objects in one group

● Aligning the objects to the reference object

9.1.2.10 Aligning objects

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush   
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.

Distributing objects evenly   
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal."
The selected objects are distributed at equal distances.

The following screen shows how you align the vertical spacing of the selected objects:
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Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 

Harmonizing the object size   
1. Select the objects.

2. Now, click one of the following buttons:  or  or 
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:

Icon Description
Aligns the selected objects to the width of the reference object.
Aligns the selected objects to the height of the reference object.
Aligns the selected objects to the width and height of the reference object.

9.1.2.11 Moving an object forward or backward

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
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Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.

3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.

Result
The object is moved up or down. 

See also
Inserting an object (Page 668)

9.1.2.12 Show objects outside the screen area

Introduction 
If you assign objects to positions that are outside the configurable area, these objects will be 
hidden. The functions of the "Objects outside the visible area" palette in the "Layout" task card 
are used to move these objects back into the screen.

Requirement
● You have opened a screen which contains objects that are outside the configurable area.

● The "Layout" task card is open.
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Procedure
1. Open the "Layout > Objects outside the area" task card.

This displays a list of objects that are outside the configurable area.

2. Select the the object which you want to move back into the screen from the list.

3. Select "Move to screen" in the object shortcut menu.

Alternatively open the "Layout > Layer" task card. Objects outside the area are indicated by 
the  icon. If you click this icon, the object is moved back into the screen.

Result
The objects are moved to the configurable area.

9.1.2.13 Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.

 

You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:
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Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 
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9.1.2.14 Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

9.1.2.15 Designing an object

Introduction
You design the border and background of an object.      

Requirement
A line has been created in a screen.
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Procedure
1. Select the line on your screen.

2. In the Inspector window, select "Properties > Properties > Appearance":

3. Select "Dash" as the style.

4. To display the dashed line in two colors, select the line width "1".

5. Select the setting "Arrow" in the "Line ends" area.

Result
The line is displayed in two colors as a dashed line. The end of the line is an arrow. 

9.1.2.16 Designing an object

Introduction
You design the border and background of an object.      

Requirement
A circle has been created in a screen.

Procedure
1. Select the circle in the screen.

2. In the Inspector window, select "Properties > Properties > Appearance":

3. Select "Solid" as the background fill pattern.

4. Activate "Fill level".

5. Enter "50" for the fill level.

6. Select "Solid" as the style.

Result
The object is displayed as a semicircle without a border.

9.1.2.17 Rotating an object in runtime

Introduction    
You define the rotation of an object around a reference point. You define the reference point 
with "X", "Y" in the Inspector window in the group "Properties > Properties > Layout". 

The rotation of the object is visible in Runtime only.
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X, Y
The attributes "X" and "Y" define the horizontal and vertical distance of the reference point 
from the object origin.

The values are specified as a percentage. The object width or object height correspond to a 
value of 100%. The reference point value can be outside the selection rectangle. This means 
that both negative values and positive values higher than 100% are possible.

Angle
The angle defines the rotation of an object around the reference point. The angle is specified 
in degrees. The configured start point corresponds to a value of 0°. The position of an object 
deviates from its configured start position by the value of the angle. 
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See also
Polygon (Page 897)

Polyline  (Page 899)

Overview of objects (Page 660)

9.1.2.18 Flashing

Introduction   
You want an object to flash in Runtime.

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to flash.

2. In the Inspector window, select the type "Default" under ""Properties > Properties > 
Flashing".

Result
The object flashes in runtime.

See also
Overview of objects (Page 660)

9.1.2.19 Flashing

Introduction   
You display objects flashing in runtime. You select the flash rate and colors for the object. 

Requirement
You have opened the work area containing at least one object.
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Procedure
1. Select the object that you want to flash.

2. In the Inspector window, select the type "Advanced" under ""Properties > Properties > 
Flashing".

3. Activate "Line" to make the line flash in runtime.

4. Activate "Text" to make the text flash in runtime.

5. Activate "Background" to make the background flash in runtime.

6. Select the flash rate.

7. Select a color for the "OFF" state.

8. Select a color for the "ON" state.
 

  Note

Flashing is only visible in runtime when there is a difference between the two colors. 
 

Result
In runtime, the object flashes in the selected colors and flash rate. 

9.1.2.20 Inserting multiple objects of the same type (stamping tool)

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.

Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.
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4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.

 

Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.

3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

See also
Overview of objects (Page 660)
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9.1.2.21 Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

9.1.2.22 Hiding or showing objects

Introduction
You can hide and show objects from or up to a defined size. This means, for example, that 
objects are only shown if a sufficient size allows the required detail to be displayed.

Requirement
A screen is open.

Procedure
Proceed as follows to hide specific objects in a screen:

1. Click in an area of the screen that does not contain an object.

2. Activate the "Activate for objects" check box under "Hide/Show" in the Inspector window.

3. Specify the minimum and maximum percentage within which the objects in question should 
be displayed. The specified limit values are also still shown.

Result
Those objects are shown whose size lies within the specified range when the object layer is 
visible. The object continues to be displayed as long as either the height or the width lies within 
the specified range. 
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9.1.2.23 Managing My Controls

Introduction
Add standardized or user-defined controls in the "Tools > My Controls" task card. All the 
ActiveX controls registered in the operating system and the .Net controls on your system are 
available for use in WinCC.

● ActiveX controls
ActiveX controls are control elements from any providers, which can be used by other 
programs over a defined OLE-based interface.

● .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

● Specific .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

When you intend to run external controls in your WinCC project, you need to verify that these 
run on the HMI device you are configuring. If you are using controls from third parties, you 
must first of all add these to the "My controls" palette before you copy the project to different 
PCs.

 

 NOTICE

The use of any control elements that are not included in the delivery scope (for example of 
third parties) may cause errors such as performance loss, or system hangs. The user of such 
control software is alone responsible for any problems caused by its use. We therefore advise 
you to closely examine such elements prior to their use.

 

Requirement
● The required  ActiveX control is installed in the PC's operating system.

● The required or specific .Net control is available on the PC in an assembly.

● A screen is open.

● The "Tools" task card is open.
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Adding a new control to the "My controls" group     
1. Open "Tools > My controls" in the "Tools" task card.

2. Select "Select objects" from the shortcut menu.
A dialog opens. This contains all the controls available on the system. Controls that already 
exist in the "Tools" task card are identified by a check mark.

3. Select the desired tab, e.g. ActiveX controls.

4. Activate the required control.

5. Confirm your selection with "OK".

Inserting a specific .Net control in the "My controls" group  
1. Select the "Specific .Net controls" tab. The list is empty the first time you select the tab.

2. Click the "…" button.

3. Select the folder in which the assembly is contained.

4. Select a file.

5. Click "Open." All the available controls are displayed in the "Specific .Net controls" tab.

6. Activate the required .Net control.

7. Confirm your selection with "OK".
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Result
The control now appears in the "Tools > My controls" task card and can be configured in a 
screen.

Removing a control from the "My controls" group    
1. Select "Delete" from the shortcut menu for the control concerned.

The control is removed from the "My controls" group. 

9.1.2.24 External graphics

Introduction
You can use graphics created with an external graphic program in WinCC. To use these 
graphics you store them in the graphic browser of the WinCC project. 

You can save graphics in the graphic browser:

● When you drag-and-drop graphics objects from the "Graphics" pane into the work area, 
these are stored automatically in the graphic browser. The graphic names are numbered 
in the order of their creation, for example, "Graphic_1." Use the <F2> function key to rename 
the graphic.

● As a graphic file with the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.png, *.jpeg or *.jpg

● As an OLE object that is embedded in WinCC and is linked to an external graphic editor. 
In the case of an OLE link, you open the external graphic editor from WinCC. The linked 
object is edited using the graphic editor. An OLE link only works if the external graphic 
editor is installed on your PC, and supports OLE.

Use of graphics from the graphic browser
Graphics from the graphic browser are used in your screens:   

● In a Graphic view 

● In a graphics list

● As labeling for a button/function key

Transparent graphics
In WinCC you also use graphics with a transparent background. When a graphic with a 
transparent background is inserted into a graphic object of WinCC, the transparency is 
replaced by the background color specified for the graphic object. The selected background 
color is linked firmly with the graphic. If you use the graphic in another graphic object of WinCC, 
this object is displayed with the same background color as the graphic object that was 
configured first. If you want to use the graphic with different background colors, include this 
graphic in the graphic browser again under a different name. The additional background color 
is configured when the graphic is used at the corresponding graphic object of WinCC.   
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Managing graphics
An extensive collection of graphics, icons and symbols is installed with WinCC, for example:

In the Toolbox window of the "Graphic" pane the graphic objects are structured by topic in the 
"WinCC graphics folder." The link to the WinCC graphics folder cannot be removed, edited or 
renamed.   

The "Graphics" pane is also used to manage the external graphics. The following possibilities 
are available:

● Creating links to graphics folders
The external graphic objects in this folder, and in the subfolders, are displayed in the toolbox 
and are thus integrated in the project. 

● Editing folder links

● You open the program required for editing of the external graphic in WinCC.

 

9.1.2.25 Managing external graphics

Introduction    
External graphics that you want to use in WinCC are managed in the "Screens" editor by using 
the "Tools" task card in the "Graphics" pane.

Requirement
● The "Screens" editor is open.

● The "Tools" task card is open.

● The graphics are available.

● The graphics have the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg or *.jpg         

Creating a folder link   
1. Click "My graphics folder."

2. Select "Link" in the shortcut menu.
The "Create link to folder" dialog is opened. The dialog suggests a name for the folder link. 

3. Edit the name as required. Select the path containing the graphic objects.

4. Click "OK" to confirm your input.
The new folder link is added to the "Graphics" object group. The external graphics that are 
located in the target folder and in sub-folders are displayed in the toolbox.
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Editing folder links   
1. Select the folder link to edit.

2. Select the "Edit link..." command from the shortcut menu. 
The "Create link to folder" dialog is opened.

3. Edit the name and path of the folder link as required.

4. Click "OK" to confirm your input.

Renaming the folder link  
1. Select the folder link to rename.

2. Select "Rename" from the shortcut menu.

3. Assign a name to the new folder link.

Removing a folder link   
1. Select the folder link you want to delete.

2. Select "Remove" in the shortcut menu.

Edit external graphics
1. Select the graphic you want to edit.

2. Select the "Edit graphic" command from the shortcut menu.
This opens the screen editor associated with the graphic object file.

Editing graphics folders from WinCC
1. Select the graphic you want to edit.

2. Select the "Open parent folder" command from the shortcut menu.
The Windows Explorer opens. 

9.1.2.26 Storing an external image in the graphics library.

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● A screen has been created.

● A Graphic View is inserted in the screen.

● The Inspector window of the Graphic view  is open.
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To store an external graphic in the image browser: 

● A graphic is available.

To store an OLE object in the browser: 

● An OLE-compatible graphics program is installed on your configuration computer.

Save graphics file
1. Open the Windows Explorer.

2. Select the graphic that you want to store.

3. Drag-and-drop the graphic into the graphic browser.

Creating and saving a new graphic as an OLE object
1. Select the Graphic view  on your screen.

2. In the Inspector window, select "Properties > Properties > General":

3. Open the graphic selection list.

4. Click .

5. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

6. From the "Insert object" dialog box, select "New" and an object type. The settings in 
"Settings > "OLE settings" determine which object types are shown.

7. Click "OK." The associated graphic program is opened.
When you are finished creating graphics, end the graphic programming software with "File 
> Close" or "File > Close & return to WinCC." 
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.

Inserting created graphics in WinCC
 

 Note

A new graphic object created as OLE object may not be directly accepted in WinCC when 
you save it to an external graphics program. 

 

1. Reopen the dialog for inserting a graphic.

2. From the "Insert object" dialog box, select "Create from file."

3. Click the "Browse" button.

4. Navigate to the created graphic and select it.
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Saving an existing graphic object as an OLE object
1. In the Inspector window, select "Properties > Properties > General":

2. Open the graphic selection list.

3. Click .

4. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

5. From the "Insert object" dialog box, select "Create from file."

6. Click the "Browse" button.

7. Use the dialog to help you navigate to the folder in which the graphic file is saved.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
 

Result
The image file is now stored in your image browser. It is shown in a screen with a Graphic 
view , or is added as a list element in an image list.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. When you have finished editing graphics, end the graphic programming 
software with "File > Close" or "File > Close & return to WinCC." The changes are applied to 
WinCC. 

 

9.1.2.27 Working with object groups

Basics on groups

Introduction
Groups are several objects that are grouped together with the "Group" function. You edit a 
group in the same way as any other object. 
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Overview
WinCC offers the following methods for editing multiple objects: 

● Multiple selection

● Creating object groups

Editing mode
To edit an individual object in a group, select the object in the "Layout > Layers" task card. 

Alternatively select "Group > Edit group" in the object group's shortcut menu.

Hierarchical groups
You add further objects or groups to extend a group. The group is enlarged by the new objects 
and is structured hierarchically in main and sub-groups. Such hierarchical groups must be 
broken up in stages. You also break up the group in the same order in which you grouped the 
objects or groups. It takes exactly the same number of steps to break up these hierarchical 
groups as it did to create them.

Rectangle surrounding the object
Only one surrounding rectangle is now displayed for the whole group. The surrounding 
rectangles of all objects are displayed for a multiple selection on the other hand.

Layers
All objects of a group are located in the same layer. 

Creating object groups

Introduction
The "Group" command combines multiple objects to form a group.       

You can change the size and position of the group. The following rules apply: 

● The system automatically adapts the position coordinates of the grouped objects when you 
reposition the group. The relative position of the grouped objects to the group is not affected.

● The system automatically adapts the height and width of the grouped objects in proportion 
to a change of the group size.

● To change the size of the group proportionately, hold down the <Shift> key and drag the 
rectangle around the object until has the required size.

 

  Note

To create a hierarchical group, organize the individual groups like objects. 
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Requirement
● You have opened a screen which contains at least two objects.

Creating object groups
1. Select all the objects you want to organize in a group.

2. Select the command "Group > Group" from the shortcut menu.

The objects of the group are displayed with a rectangle around the objects.

Grouping objects within a group
1. Select the group you want to edit.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.

3. Select the objects of a group that you want to combine into a subgroup.

4. Select the command "Group > Group" from the shortcut menu.

A subgroup with the objects is created.

Adding objects into an existing group
1. Select the group to which you want to add objects.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

The object is added to this group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

Result
The selected objects are combined in a group. The multiple selection rectangle becomes the 
rectangle surroundings the objects in the group. The handles are shown only for the group. 
The group in in the active layer.
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See also
Ungrouping (Page 695)

Adding Objects to the Group (Page 696)

Removing Objects from the Group (Page 697)

Editing an Object in a Group (Page 698)

Example: Inserting and configuring a rectangle (Page 705)

Ungrouping

Introduction
Select the "Ungroup" command to split a group into the original object fractions.     

Requirement
● You have opened a screen that contains a group.

Ungroup
1. Select the group.

2. Select the "Group > Ungroup" command from the shortcut menu.

Ungrouping a group within a group
1. Select the higher-level group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.

3. Select the lower-level group.

4. Select the "Group > Ungroup" command from the shortcut menu.

Result
The lower-level group is ungrouped. The objects are assigned to the next higher group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.
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See also
Creating object groups (Page 693)

Adding Objects to the Group (Page 696)

Removing Objects from the Group (Page 697)

Editing an Object in a Group (Page 698)

Example: Inserting and configuring a rectangle (Page 705)

Adding Objects to the Group

Introduction
The "Add objects to group" command is used to add objects to a group, without ungrouping it 
first.   

Requirements
A screen with one group and at least one other object is opened.

Procedure
1. Select the group.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

Result
The group consists of the original objects, and the newly-added objects. The added objects 
are arranged at the front of the group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag&drop you can also easily edit 
hierarchical groups in the "Layers" palette.

 

See also
Example: Inserting and configuring a rectangle (Page 705)
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Removing Objects from the Group

Introduction
You use the "Remove objects from group" command to remove individual objects from a group, 
without ungrouping it first.    

You do not have to remove the object from the group to edit an object in a group. You can edit 
the objects of a group individually.

Requirement
● You have opened a screen that contains a group.

Removing objects from a group
To remove an object from a group:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.

3. Select all objects in the group that you want to remove from the group.

4. Select the "Group > Remove from group" command from the shortcut menu.

The objects are removed from the group.
 

 Note

If there are only two objects in the group, the menu command "Remove from group" is not 
available.

 

Deleting objects from a group
To remove an object from the group, and from the screen:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.

3. Select the objects in the group that you want to delete.

4. Select "Delete" from the shortcut menu.
 

  Note

If there are only two objects in the group, the menu command "Delete" is not available.
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Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

See also
Example: Inserting and configuring a rectangle (Page 705)

Editing an Object in a Group

Introduction
You can edit the objects of a group individually.    

Requirement
You have opened a screen that contains a group.

Editing grouped objects
1. Select the group.

The properties of the group are displayed in the Inspector window.

2. Change the position and size of the grouped objects in "Properties > Properties >Layout."

3. Change the name of the group in "Properties > Properties > Miscellaneous."
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Modifying the properties of an object within a group
1. Select the group.

2. Select the object whose properties you want to change in the Inspector window.

The properties of the object are displayed.

3. Change the object properties.

Result
Although you have edited the object, it is still an element of the group. These changes do not 
affect the other objects of the group. 

See also
Example: Inserting and configuring a rectangle (Page 705)

9.1.2.28 Configuring the Keyboard Access

Overview of keyboard access

Introduction
For keyboard units without a mouse, the operator activates control objects using the <Tab> 
key. You can set up keyboard input to make the process easier to run, and to make sure that 
the operator enters all the necessary values. If you are using the keyboard, use the <Tab> key 
to activate the objects in a certain order, and to enter the necessary values.

For HMI devices without key, you can simulate the <Tab> key by configuring the 
"SimulateSystemKey" system function to a function key.
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Operator authorizations and operator control enables
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable. 

Editing the tab sequence
The tab sequence is determined automatically when the control objects are created. The 
numbers of the tab sequence are assigned in the sequence in which the libraries are created.

It makes sense to change the tab sequence in the following cases:

● The operator changes directly to a specific control object.

● The screen requires a specific sequence

Change to the tab sequence mode to change the tab sequence. In this mode, the tab sequence 
number is displayed at the top left of the control objects. The tab sequence numbers of hidden 
objects are also shown. The distribution of these numbers is edited using the mouse.

 

 Note

Other functions are not available in the tab sequence mode.
 

Overview of keyboard access

Introduction
To influence the process, the operator edits operable objects such as I/O fields or buttons in 
Runtime. You set up keyboard input to make the process easier to run, and to make sure that 
the operator enters all necessary values. When the operator makes entries, he uses the <Tab> 
key to activate the objects in a specified order and to enter the necessary values. 

Keyboard access
There are two methods of mouseless operator input:

● Alpha cursor: The operator uses the <Tab> key in Runtime to activate objects of the "I/O 
field", and "text list" type only.

● Tab cursor: Depending on the settings, the operator uses the <Tab> key in Runtime to 
activate all objects that permit an input.

You define the cursor mode when Runtime starts. You set the cursor mode in the Inspector 
window of the screen.

Combining the Alpha cursor and Tab cursor modes
When you have defined a hotkey, the operator can toggle the cursor mode between the two 
modes during runtime if necessary. In this case you specify the tab sequence for both cursor 
types.
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Operation in Runtime
You use the tab sequence to define in which order the operator can activate objects. The 
default setting is operation using the <Tab> key. If required, define operation using a hotkey 
or the mouse. 

See also
Example: Inserting and configuring a rectangle (Page 705)

Defining cursor mode

Introduction
You define the cursor mode when Runtime starts. The operator can change the cursor mode 
in Runtime as required. You set the cursor mode in the object properties of the screen.   

Requirement
You have opened a screen which contains multiple objects.

Procedure
1. Click on a empty surface on the screen.

2. In the Inspector window, click "Properties > Properties > Miscellaneous".

3. Select the desired cursor mode under "Tab sequence".

Result
The required cursor mode is active when Runtime starts.

See also
Example: Inserting and configuring a rectangle (Page 705)

Defining the Operator Authorization and Operator Control Enable for an Object

Introduction
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable.

Requirement
You have opened a screen which contains at least one object.
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Procedure
1. Select the object.

2. Select "Properties > Properties > Security" in the Inspector window.

3. Select the operator authorization under "Authorization."

4. Activate the authorization to operate.

Result
The operator can use the <Tab> key in Runtime to select the object.

See also
Example: Inserting and configuring a rectangle (Page 705)

Defining object types for Tab cursor mode

Introduction
In the Inspector window, you can define the object types that the operator activates using the 
<Tab> key in "Tab cursor" mode.

Requirement
● You have opened a screen which contains at least one object.

● The objects have been enabled for use in Runtime, and have operator authorization.

● "Tab cursor" mode is specified.
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Procedure
1. Click on a empty surface on the screen.

2. Select the object types to be used in Runtime using the <Tab> key in the inspector window 
under "Properties > Properties > Miscellaneous > Tab sequence object types".

Result
The user can activate all the defined objects in Runtime using the <Tab> key in "Tab cursor" 
mode.

See also
Example: Inserting and configuring a rectangle (Page 705)

Setting the tab sequence order

Introduction
All operable objects can be reached in runtime with the <Tab> key. You use the "Tab sequence" 
command to define the order in which the operator can activate objects in runtime. 

 

 Note

You cannot reach objects with the "Output" or "Two states" mode in runtime with the <Tab> 
key.

 

You can operate the screen in runtime:

● Using the <Tab> key

● Using the mouse

● Using a configured hotkey

Requirement
● The active screen contains operable objects.

● No object is selected.

● The objects have been enabled for use in runtime, and have operator authorization.
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Procedure
1. Select "Edit tab sequence" in the "Edit" menu.

Tab sequence mode is activated. The tab sequence number is displayed for all objects that 
can be used. The tab sequence number is also displayed for hidden objects.

2. Use edit the tab sequence mode, click the accessible objects in the order in which you want 
them to be activated using <Tab> in runtime.
The following figure shows how the tab sequence is defined in the screen. In runtime, the 
<Tab> key first activates the alarm view (number 1), then the I/O field (number 2), and then 
the button (number 3):

3. To exclude a screen object from the tab sequence, press the key combination <Shift+Ctrl> 
and click on the desired object.
The tab sequence number is no longer displayed in the screen object. The screen object 
is now excluded from the tab sequence. The remaining tab sequence numbers are 
automatically decreased by 1.

4. To reenter an excluded screen object in the tab sequence, repeat step 3.
The screen object entered as the first object in the tab sequence.

Result
The operator selects the objects in the specified order in Runtime with the <Tab> key.

See also
Example: Inserting and configuring a rectangle (Page 705)

Setting the tab sequence order

Introduction
Every object can be accessed in Runtime in the mode "Tab cursor". You use the "Tab 
sequence" command to define the order in which the operator can activate objects in Runtime. 
You can operate the process screen in runtime:

● Using the <Tab> key

● Using the mouse

● Using a configured hotkey
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Requirement
● You have opened a screen which contains at least one object.

● The objects have been enabled for use in Runtime, and have operator authorization.

● "Tab cursor" or "Alpha cursor" mode is activated.

Procedure
1. Select "Edit > Tab sequence > Edit tab cursor" or "Edit alpha cursor".

Tab sequence mode is activated. The tab sequence number is displayed for all objects that 
can be used. The tab sequence number is also displayed for hidden objects.

2. Use edit the tab sequence mode, click the accessible objects in the order in which you want 
them to be activated using <Tab> in Runtime.
The following figure shows how the tab sequence is defined in the screen. In Runtime, the 
<Tab> key first activates the I/O field (number 1), and then the button (number 2).

Result
The operator selects the objects in the specified order in Runtime with the <Tab> key. 

See also
Example: Inserting and configuring a rectangle (Page 705)

9.1.2.29 Examples

Example: Inserting and configuring a rectangle

Task
In this example, you insert a rectangle in a screen. You can configure the following properties:  

● Name = "MyRectangle"

● Position = (20, 20)

● Size = (100,100)

● Color = red

● Black frame 2 pixels wide
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Principle
The rectangle is a closed object which can be filled with a color or pattern. The height and 
width of a rectangle can be adjusted to allow its horizontal and vertical alignment.

 

Overview
Carry out the following steps in order to create a rectangle:

● Inserting a rectangle

● Configuring a rectangle

See also
Overview of objects (Page 660)

Basics on groups (Page 692)

Example: Inserting a rectangle (Page 706)

Example: Configuring a rectangle (Page 707)

Example: Inserting a rectangle

Task
In this example, you insert and rename a rectangle. Do not use the special characters ?, ", /, 
\, *, <, > for the name.   

Requirement
● A screen is open.

● The Inspector window is open.

● The "Tools" task card is open.

Procedure
1. Click the "Basic objects" palette in the "Tools" task card.

2. Drag the "Rectangle" object into the screen.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
706 System Manual, 08/2011,  



3. In the Inspector window, select "Properties > Properties > Miscellaneous".

4. Type in the new name "MyRectangle".

Result
The rectangle is now inserted and named "MyRectangle". The rectangle has the default 
properties of the "rectangle" object. 

See also
Example: Inserting and configuring a rectangle (Page 705)

Example: Configuring a rectangle

Task
In this example you configure a rectangle:   

● Color = red

● Black frame 2 pixels wide

● Position = (20, 20)

● Size = (100,100)

Changing the color of the rectangle
To change the color of the rectangle:

1. Select the rectangle.

2. Define the background color in "Properties > Properties > Appearance > Background > 
Color" in the Inspector window.

3. Select "Solid" as the fill pattern.

4. Define the color for the border in "Properties > Properties > Appearance > Border > Color" 
in the Inspector window.

5. Enter the value "2" for "width".

6. Select "Solid" as the "Style".

Interim result
The rectangle is red and has a black frame with a width of two pixels.
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Repositioning and resizing the rectangle
To change the position and size of the rectangle:

1. Select the rectangle.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Set "20" for the both the X and Y coordinates under "Position & Size".

4. Set "100" for the height and for the width.

Result
The rectangle is positioned at the coordinates (20, 20), and has a width and height of 100 pixels. 

See also
Example: Inserting and configuring a rectangle (Page 705)

9.1.3 Working with Text Lists and Graphic Lists

9.1.3.1 Working with Text Lists

Basics on text lists

Introduction
Texts are assigned to the values of a tag in a text list. Assign the text list to a symbolic I/O field 
for example in the configuration. This supplies the text to be displayed to the object. The text 
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lists are created in the ""Text List" editor. You configure the interface between the text list and 
a tag at the object that uses the text list. 

The selection of objects that can have a text list assigned depends on the Runtime.  

Application
The text list is used, for example, to display a drop-down list in a symbolic I/O field. 

If the symbolic I/O field is a display field, the associated texts will differ according to the value 
of the configured tags. If the symbolic I/O field is an input field, the configured tag assumes 
the associated value when the operator selects the corresponding text in Runtime. 

 

 Note
Display of tag values without text

The display of tag values to which no text has been assigned depends on the Runtime:
● The display and operating object remains empty.
● Three asterisks *** are displayed.

 

Multilingual texts
You can configure multiple languages for the texts in a text list. The texts will then be displayed 
in the set language in Runtime. To this purpose you set the languages in the Project window 
under "Language support > Project languages." 

Configuration steps
The following steps are necessary to display texts in a symbolic I/O field for example:

1. Creating the text list

2. Assignment of the texts to values or value ranges of a text list

3. Assignment of a text list in the display object, e.g. the symbolic I/O field

See also
Output of texts from a text list in an alarm (Page 1277)

Configuring a text list in the faceplate type  (Page 801)

Screen basics (Page 629)
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Creating a text list

Introduction
The text list allows you to assign specific texts to values and to output these in Runtime, for 
example in a symbolic I/O field. The type of symbolic I/O field can be specified, for example 
as a pure input field. 

The following types of list are available:  

● Value/Range

● Bit

● Bit Number

Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Text lists" tab.

3. Click "Add" in the "Text lists" table.
The Inspector window of the text list is open.

4. Assign a name to the text list that indicates its function.

5. Select the text list type under "Selection":

– Value/Range: Text from the text list is displayed when the tag has a value that lies within 
the specified range.

– Bit (0,1): A text from the text list is displayed when the tag has the value 0. A different 
text from the text list is displayed when the tag has the value 1.

– Bit number (0-31): Text from the text list is displayed when the tag has the value of the 
assigned bit number.

6. Enter a comment for the text list.
 

  Note

You must not use semicolons in the texts in a text list. The semicolon is a control character 
and is automatically deleted from a text. 
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Result
A text list is created.

See also
Configuring a text list in the faceplate type  (Page 801)

Assigning texts and values to an area text list

Introduction
For each area text list you specify which texts are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● An area text list has been created and selected.
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Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime if the tag is within the specified 
value range.

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.

4. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "21" for  "Min" for example.

– Enter the value "40" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime when the tag is within the specified 
value range.

5. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area text list is created. Texts have been assigned to the possible value ranges.     
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Assigning texts and values to an area text list

Introduction
For each area text list you specify which texts are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● An area text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select one of the following settings in the Inspector window under "Properties > Properties 
> General > Value".

– "Range": Minimum to maximum tag value, for example 1 ≦ Value ≦ 21

– "To": Maximum tag value, e.g. value ≦ 13

– "Individual value": Exactly one tag value, for example Value = 21

– "From": Minimum tag value, e.g. value ≧ 2

3. Enter the text that is displayed in Runtime when the tag has the specified value or lies within 
the specified range of values under "Text."

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
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4. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

5. Create further corresponding list entries for additional value ranges of the same text list.

Result
An area text list is created. Texts that appear in Runtime are assigned to the possible 
values.     

Assigning texts and values to a bit text list

Introduction
For each text list, you specify which text is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit text list has been created and selected.
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Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "0" for "Value."

– Enter the text which is displayed in Runtime under "Text" if the bit tag is set to "0".
 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.

4. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "1" under "Value."

– Enter the text which is to be displayed in Runtime under "Text" if the bit tag is set to "1".

Result
A bit text list is created. Texts that appear in Runtime are assigned to the possible values "0" 
and "1".     

Assigning texts and values to a bit number text list

Introduction
For each bit number text list you specify which texts are displayed at which bit number.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  715



Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit number text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "10", for example, for "Value".

– Under "Text", enter the text that is displayed in Runtime when the tag 
has the value "10".

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same text list.

Result
A bit number text list is created. Texts that appear in Runtime are assigned to the specified bit 
numbers.     
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Configuring objects with a text list

Introduction
The output value and value application for text lists are specified in the display and operating 
object that displays the texts of the text list in Runtime. The properties of these objects are 
configured as required.   

Requirement
● A text list is created.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a symbolic I/O field is open. The object is edited.

Procedure
1. Select the text list which you want to have displayed in Runtime in "Properties > Properties 

> General > Text list" in the Inspection window.

2. Select the setting "Output" as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a symbolic I/O field depending on the Runtime.
 

3. Select the tag the value of which determines the display in the symbolic I/O field as "Tag".

Result
The defined texts of the text list are displayed in the symbolic I/O field in Runtime when the 
tag has the specified value. 

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  717



9.1.3.2 Working with Graphic Lists

Basic principles of graphics lists

Introduction
The possible values of a tag are assigned to specific graphics in a graphics list. During 
configuration, you can create a graphics list for a button or a graphic I/O field. This supplies 
the graphics to be displayed to the object. 

The graphics lists are created with the "Text and graphics list" editor. You configure the 
interface between the graphics list and a tag at the object that uses the graphics list. The 
availability of the graphics list is determined by the HMI device used.  

Application
You can configure the graphics list for the following situations: 

● Drop-down list with a graphic I/O field

● State-specific graphic for a button

The graphics in a graphics list can be configured as multilingual. The graphics will then be 
displayed in the set language in runtime. 

Graphic sources
Graphics can be added to the graphics list from the following sources: 

● By selecting from a graphic browser

● By selecting an existing file 
You can use the following file types: 
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tiff, *.png, *.jpeg and *.jpg.

● By creating a new file

Function
If the graphic I/O field is a display field, the associated graphics will differ according to the value 
of the configured tags. If the graphic I/O field is an input field, the configured tag assumes the 
associated value when the operator selects a graphic in runtime. 

Configuration steps
The following tasks are required to display graphics, for example, in a graphic I/O field:

1. Creating the graphics list

2. Assignment of the graphics to values or value ranges of a graphics list

3. Assigning a graphics list in the display object, for example the graphic I/O field
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See also
Configuring a graphics list in the faceplate type (Page 802)

Screen basics (Page 629)

Creating a graphics list (Page 720)

Creating a graphics list

Introduction
The graphics list allows you to assign specific graphics to variable values and to output these 
in a graphic IO field in Runtime. You can specify the type of graphic I/O field, for example as 
a pure output field.  

Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Graphics lists" tab.

3. Click "Add" in the "Graphics lists" table. The Inspector window of the graphics list will open 
up.

4. Assign a name to the graphics list that indicates its function.
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5. Select the graphics list type "Bit number (0 - 31)" for example under "Select".

6. Enter a comment for the graphics list.

Result
A graphics list of the type "Range (0 - 31)" is created.  

Creating a graphics list

Introduction
The graphics list allows you to assign specific graphics to variable values and to output these 
in a graphic IO field in Runtime. You can specify the type of graphic IO field, for example as a 
pure output field.  

Procedure
1. Double-click "Text and graphics lists" in the project navigation.

2. Open the "Graphics lists" tab.

3. Click "Add" in the "Graphics lists" table.
The Inspector window of the graphics list will open up.

4. Assign a name to the graphics list that indicates its function.

5. Select the "Value/Range" graphics list type under "Selection."

6. Enter a comment for the graphics list.

Result
An area graphics list is created.  
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See also
Configuring a graphics list in the faceplate type (Page 802)

Basic principles of graphics lists (Page 718)

Assigning a graphic and values to an area graphics list

Introduction
For each area graphics list you specify which graphics are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● An area graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Range" in "Properties > Properties > General > Value" in the Inspector 
window:

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– Select a graphic that is displayed in Runtime when the tag is within the specified value 
range.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A further list entry is created.
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4. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "21" for example.

– Select a graphic which is displayed in Runtime if the bit "21" is set in the tag.

5. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area graphics list is created. Graphics that appear in Runtime are assigned to the possible 
values.   

Assigning graphics and values to an area graphics list

Introduction
For each bit number graphics list you specify which graphics are displayed at which bit number.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● A bit number graphics list has been created and selected.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  723



Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "0" for example.

– Select a graphic which is displayed in Runtime if the bit "0" is set.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Activate "Properties > Properties > General > Use transparent color" in the inspector 
window and select a color.

5. Activate "Properties > Properties > Flash > Use flash" in the inspector window.

6. Select "Flash frequency > Slow" for example.

7. Create further list entries for additional bit numbers of the same graphics list.
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Result
A bit number graphics list is created. Graphics that appear in Runtime are assigned to the 
specified bit numbers. The graphic flashes when the tag has a defined value.   

Assigning graphics and values to a bit graphics list 

Introduction
For each graphics list you specify which graphic is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is opened.

● A bit graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in the inspector window "Properties > Properties > 
General > Value":

– Enter "0" as the value.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.
 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A new list entry is created.

4. Select "Properties > Properties > General > Value > Single value": in the Inspector window.

– Enter "1" as the value.

– Select a graphic which is displayed in Runtime if the bit "1" is set in the tag.

Result
A bit graphics list is created. Graphics that appear in Runtime are assigned to the values "0" 
and "1".   

Assigning graphics and values to a bit number graphics list

Introduction
For each bit number graphics list you specify which graphics are displayed at which bit number.
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Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● A bit number graphics list has been created and selected.

Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "0" for example.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.
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3. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same graphics list.

Result
A bit number graphics list is created. Graphics that appear in Runtime are assigned to the 
specified bit numbers.   

Configuring objects with a graphics list

Introduction
The output value and value application for graphics list are specified in the display and 
operating object that displays the graphics of the graphics list in Runtime. The properties of 
these objects are configured as required.  

Requirement
● A graphics list is created. The values have been defined. Graphics have been assigned to 

the values.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a graphics I/O field is open. The object is edited.

Procedure
1. Select the graphics list the graphics of which you want to have displayed in Runtime in 

"Properties > Properties > General > Graphics list" in the inspector window.

2. Select the setting "Input/Output" 

 as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a graphic I/O field depending on the Runtime.
 

3. As "Tag", select the tag whose values are defined by the display in the graphic I/O field.

Result
The defined graphics of the graphics list are displayed in the graphic I/O field in Runtime when 
the tag has the specified value.
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9.1.4 Dynamic Screen Control

9.1.4.1 Basics on dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● Tags

● System functions

One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 

The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

See also
Dynamization in the inspector window (Page 730)

Dynamization in the inspector window (Page 732)

Configuring a new animation (Page 735)

Show overview of the dynamizations (Page 764)

Basics on dynamization in the property list (Page 756)

Screen basics (Page 629)

Basic on events (Page 762)

9.1.4.2 Basics of dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● System functions

● Tags

● Local scripts
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One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 

The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

Customized menus and toolbars
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. These 
menus and toolbars are displayed in all screens of your project or in the screen windows. The 
menu entries and icons are connected by means of tags or VB scripts.

Use the customized menus and toolbars, for example, to change from a screen in your project 
to any other screen. 

See also
Dynamization in the inspector window (Page 730)

Dynamization in the inspector window (Page 732)

9.1.4.3 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

Animations
WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation in the object's inspector window. Then 
adapt the animation to the requirements of your project. 

The selection of the supported animations depends on the HMI device and the selected object. 
You choose between the following types of animation: 

● Layout: Appearance, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Variable binding

You can configure the "Variable binding" type of animation several times for one object.

You configure animations in the "Properties > Animations" inspector window.
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Events
Operable objects also react to events, such as a mouse click. 

You configure a function list with system functions on an event. The system functions are 
processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.

You will find further information in "Working with function lists (Page 1748)".
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See also
Basics on dynamizing screens (Page 729)

9.1.4.4 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

The inspector window offers you the possibilities for dynamization of screen objects in three 
tabs.

Property list
With the  button you go to the properties list in the "Properties > Properties" inspector 
window.

In the property list, you set any dynamization for the individual object properties using tags or 
local C and VB scripts. You can, for example, dynamically change the background color of an 
object.

In the "Dynamic Value" column you can dynamize the object property of a tag, a C-script or a 
VB-script.

Whether an object property can be dynamized is indicated in the Property list by means of the 
background color:

● Light gray: Can be dynamized

● Dark gray: Cannot be dynamized

Any animations you have already configured will also appear in the object property list, where 
you can edit the animations. 

The following table shows you how to sort the property list:

Sort by alphabet

Sort by category

With the  button you return to the property pages in the inspector window.   
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Animations
You have two different options for animating objects.

You configure animations  

● in the inspector window under "Properties > Animations",

● in the "Animations" task card.

WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation with the tools of the toolbox or in the 
object's inspector window. Then customize the animation in the Inspector window to suit the 
requirements of your project. 

The selection of the supported animations depends on the device and the selected object. You 
choose between the following types of animation: 

● Tag binding

● Layout: Appearance, control enable, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Property animation
 

  Note
HMI device dependency

The "Control enable" animation is not available for every HMI device.
 

You can configure the "Tag binding" and "Property animation" types of animation several times 
for one object.

You configure animations in the "Properties > Animations" inspector window.
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Events  
Operator control enabled objects also react to events, such as a mouse click. 

You configure a function list with system functions or local scripts on an event. The system 
functions or the local script are processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.

You will find further information in "Working with function lists (Page 1748)".
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See also
Local scripts (Page 1747)

Basics on dynamizing screens (Page 729)

9.1.4.5 Dynamization with animations

Configuring a new animation

Introduction
Use predefined animations to dynamize screen objects. 

Requirement
● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure in the inspector window
1. In the Inspector window, select "Properties > Animations".

2. Select the animation you want to use.

3. Click the button. 

Procedure in the "Animations" task card.
1. Open the object group containing the required animation in the "Animations" task card.

2. Drag the animation onto the object that you want to make dynamic.

Alternatively you select the object in the screen and double click the desired animation in the 
"Animation" task card.

Result
The animation appears in the Inspector window of the object. You configure the animation in 
the following steps. 

In the animations overview the green arrow indicates which animation is already configured. 
The configured animation opens in the inspector window when you click the green arrow.    
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See also
Dynamize control enable of a control object (Page 741)

Dynamizing the visibility of an object (Page 743)

Basics on dynamizing screens (Page 729)

Configuring direct movement (Page 740)

Configuring animation with tag binding (Page 744)

Animations of object groups (Page 753)

Animations of object groups  (Page 754)

Dynamization with property animations (Page 745)

Dynamize appearance of an object

Introduction
The appearance of a screen object is controlled by changing the value of a tag in runtime. 
When the tag adopts a certain value, the screen object changes its color or flashing 
characteristics according to the configuration.         
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Type
Areas or single values of the tag are observed in Runtime depending on the selection. The 
appearance of the object changes according to the configuration.

Requirement
● A screen is open.

● A dynamic object is contained and selected in the screen.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. In the Inspector window, select "Properties > Animations".

The animations available for the selected object are displayed. 

2. Select the animation "Appearance" and click the  button.
The parameters of the animation are displayed.

3. Select a tag in "Tag > Name".

4. Select "Type > Range" for example.

5. Click "Add" in the table.

6. Enter the tag interval "0 - 20" in the "Range" column for example.

7. For "Foreground color" and "Background color", select the color the object is to acquire in 
Runtime when the tag reaches the interval.
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8. Select a flashing mode for the object from the "Flashing" list.

9. Repeat steps 5 to 8 to create another tag interval, e.g. "21 - 60".

Result
In Runtime, the flashing response, and color of the object change dynamically according to 
the process value returned in the tag. 

Configuring horizontal movement

Introduction
You can configure dynamic objects in such a way that they move on a certain track. The 
movement is controlled via tags. The object moves every time the tag is updated.     

You can only program one type of movement for each object. 

Requirement
● You have created a tag.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.
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Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.
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Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

 

 Note

You configure vertical and diagonal movement in the same way as horizontal movement     
 

Configuring direct movement

Introduction
The object is moved respectively in x direction and y direction with "Direct movement". Two 
tags define the number of pixels by which the object moves from its original static start 
position.       

Requirement
● Two tags are set up.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.

Configuring "Direct movement"
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".

3. Select "Direct movement" and click the  button.
The parameters of the animation are displayed.
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4. Select a tag for the X position with which the movement in x direction is controlled.

5. Select a tag for the Y position with which the movement in y direction is controlled.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. 

See also
Configuring a new animation (Page 735)

Dynamize control enable of a control object

Introduction
You can dynamically change the usability of  an operating element. The object either can, or 
cannot be used in Runtime, depending on the value of a tag.    

You can use this dynamic control to restrict operator access to  an operating element to specific 
situations, such as for maintenance.
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Requirement
● You have created a tag.

● A screen with an operating element is open.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. Select the operating element in the screen that you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Control enable" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.

5. Activate "Range".

– For "From:" enter  e.g. the value "0"

– For "To:" enter  e.g. the value "100"

6. Activate "Control enable > Activated".

Result
The screen object is operator control enabled in Runtime depending on the tag value:

● The object becomes operator control enabled when the tag value is between 0 and 100.

● The object is not operator control enabled if the tag value is outside the range.
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See also
Configuring a new animation (Page 735)

Dynamizing the visibility of an object

Introduction
Dynamization of the "Visibility" property allows you to output an alarm to your screen, which 
is triggered when the tag value exceeds a critical range, for example. The alarm is cleared 
when the tag value returns to the non-critical range.

The "Simple recipe view" and "Simple alarm view" objects are always visible.

Requirement
● You have created a tag.

● You have opened a screen containing an object that you want to show or hide in Runtime.

● The Inspector window is open.

Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Visibility" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.

5. Activate "Single bit".

6. Select bit number "6" for example.

7. Activate "Visible".
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Result
The screen object is shown or hidden in Runtime depending on the tag value.

● If the tag value matches the configured bit number exactly, the screen object is shown.

● If the tag value matches the configured bit number exactly, the screen object is hidden.

See also
Configuring a new animation (Page 735)

Configuring animation with tag binding

Introduction
When you object property an object property with a tag, the object property is changed in 
Runtime depending on the tag value.   

The following example shows the tag binding in the "Properties > Animations" inspector 
window. If you have comnfigured tag binding it is also visible in the property list or in the property 
pages in the inspector window.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.

Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Tag connection" and click the  button.
The parameters of the animation are displayed.
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4. Select  the object property that you want to dynamize in "Properties > Animation > Tag 
binding > Property > Name", e.g. "Background color".

5. Select a tag.

Result
You have dynamized the "Background color" property with a tag. The background color of the 
screen object changes in Runtime depending on which value the tag adopts. 

See also
Configuring a new animation (Page 735)

Dynamization with property animation

Dynamization with property animations

Introduction
With the property animation you dynamize the properties of screens and screen objects 
depending on certain value ranges or tags. You select value ranges and determine how the 
linked object property changes when the tag adopts a certain value in Runtime. You have the 
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option of dynamizing several object properties simultaneously, e.g. the position and the color 
of a screen object. You can also configure several property animations on one object.

 

 Note
Dynamizing multiple object properties at the same time

You can dynamize multiple object properties with animation. The order of processing in 
runtime is not necessarily the same as the order of property configuration in the Inspector 
window under "Properties > Animation".

 

Type     
The following types are available to define the value range:

● Range 
One or more value ranges of a tag are viewed. You configure different value ranges. You 
define the appropriate values of the object property for every value range. If the value in 
Runtime is within a configured value range, the linked object property is dynamized.
Only define value ranges as integers. A non-integer tag value or expression is rounded up 
or down accordingly.

● Multiple bits  
One or more bit numbers of a tag are viewed. You configure different bit numbers. The 
linked object property is only dynamized if the tag value in Runtime exactly matches one 
of the configured bit numbers. If the variable value does not match, the static value of the 
object property is displayed.

● Single bit  
You select the bit of tab which is to be monitored. If the bit is to be set, you configure the 
value "0". If the bit is not to be set, you configure the value "1".
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● Bool (true, false)  
The Boolean tag or an expression which contains a logical comparison is viewed. If the tag 
or return value of the expression returns one of the two values - true or false - the value is 
assigned to the dynamized property.

● Direct 
Unlike the other types, the tag value or expression in the "Direct" type is written directly into 
the object property.

Expression       
You can formulate the expression by using tags, VB-scripts and arithmetic operators. The 
value of the expression is determined in Runtime and compared with the configured value 
ranges. The "Expression" option is only available for the "Range", "Boolean" and "Direct" types.

Evaluation "Quality Code"       
Use "Quality Code" to check the status and quality of a tag. The quality of the entire value 
transmission and value processing of the respective tag is combined in the displayed "Quality 
Code". The monitoring of the "Quality Code" enables you to draw conclusions about the quality 
of the tags in the process. 

The evaluation of the "Quality Code" has priority over the defined value ranges. 

If you use several tags, the "Quality Code" of the tags is evaluated in the order in which they 
appear from left to right in the expression. The configured values are only viewed if the "Quality 
Code" of the tag is correct.

The figure below shows a selection of the offered "Quality Codes". The "Quality Codes" are 
sorted in descending order of priority in this list.
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See also
Configuring property animation of the Range type (Page 748)

Configuring property animation of the Direct type (Page 750)

Configuring property animation of the Bool type (Page 751)

Configuring a new animation (Page 735)

Configuring property animation of the Range type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. The following example shows the dynamization of a circle. The 
circle changes color and position depending on a tag.

Requirement
● You have created a "Tag1" tag.

● You have created a screen.

● You have inserted and selected a circle in the screen.

● The Inspector window is open.

Select animation type, tag and type
1. In the Inspector window, select "Properties > Animation".

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Light" under "Settings > Name".

4. Select "Range" as type".
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5. Activate "Process > Tag".

6. Select "Tag1" under "Process > Tag".

Select object properties and ranges
1. Click  "Add property". A drop-down list opens.

2. Select the property "Y position". A column "Y position" is added to the table.

3. Click  "Add property". A drop-down list opens.

4. Select the property "Color background". A column "Color background" is added to the table.

5. Click "Add" in the table.

6. Define the first range from "0 - 49".

7. Click "Add" in the table.

8. Define the second range from "50 - 99".

9. Click "Add" in the table.

10.Define the second range from "100 - 149".

Assign the background color and position to a range
Define the following settings for the ranges:

● Range 0 - 49: Y position "200"; color "green"

● Range 50 - 99: Y position"220"; color "yellow"

● Range 100 - 149: Y position  "240"; color "red"
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Result
Depending on in which range the tag is located in Runtime, the circle changes position and 
background color.

 

 Note

If you use the operands "=", ">", "<", "!=" in the expression and have set the type "Range", 
note the following:

The value for "true" = -1

The value for "false" = 0
 

See also
Dynamization with property animations (Page 745)

Configuring property animation of the Direct type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. The following example shows the dynamization of an I/O field. 
The I/O field changes its output value depending on a tag.

Requirement
● You have created a "Tag1" tag.

● You have created a screen.

● You have inserted and selected an I/O field with the "Output" mode in the screen. 

● The inspector window is open.

Select animation type, tag and type
1. Click "Properties > Animation" in the inspector window.

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Fill level" under "Settings > Name".

4. Select "Direct" as type".

5. Activate "Process > Tag".

6. Select "Tag1" under "Process > Tag".
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Result
The tag value in Runtime is written directly into the I/O field. 

See also
Dynamization with property animations (Page 745)

Configuring property animation of the Bool type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. In the following example, a button is shown and hidden depending 
on the value of an expression.

Requirement
● A "TCelsius" tag of the "Uint" type is created.

● You have created a screen.

● You have inserted and selected a button in the screen.

● The inspector window is open.

Select animation type, expression and type
1. Click "Properties > Animation" in the inspector window.

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Visibility" under "Settings > Name".

4. Select "Boolean" as type".

5. Activate "Process > Expression".

6. Enter the following expression in the field: "(('TCelsius’ × 9) / 5) + 32 < 100".
 

  Note

Make sure to write the tag name in single inverted commas in the direct input.
 

Alternatively, enter the expression with the buttons above the field. For example, click the  
button and select a tag from the drop-down list.
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Select object property
1. Click  "Add property". A drop-down list opens.

2. Select the "Visibility" property. A "Visibility" column is added to the table.

3. Activate the "Visibility" property for the "True" value in the table.

Result
The value of the expression is determined in runtime. The button is displayed if the value 
matches the configured "True" value. 

See also
Dynamization with property animations (Page 745)
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Animations of object groups

Applying animations to object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Only the animation of the object 
group i.e. "direct movement" is executed in Runtime. This also applies for object groups within 
object groups. Only the animation of the group on the top layer is listed.

 

See also
Configuring a new animation (Page 735)
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Animations of object groups 

Changing animations of object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.   

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Both animation types are 
executed in runtime. This also applies for object groups within object groups.

See also
Configuring a new animation (Page 735)

Animations in multiple selection

Changing animations for multiple objects  
For a multiple selection, the animations that are configured for the reference object appear in 
the Inspector window. You can change the animations as usual. The changes will apply to all 
the objects in the multiple selection that support the configured animation. This means that 
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even objects for which you have not yet configured an animation will have the reference object's 
animation. 

Application example
Select a button, and a circle at the same time. The button is the reference object. The 
"Appearance" animation is already configured for the button, so it appears in the Inspector 
window of the multiple selection. When you activate "Properties > Animations >Appearance > 
Flashing" in the inspector window, the settings of the "Appearance" animation apply for the 
button and for the circle.

Configuring new animations for multiple objects
If you configure a new animation for the objects of a multiple selection, this animation will apply 
to all selected objects that support the configured animation. If the new animation replaces an 
existing animation, a security prompt appears.

Application example
You select a circle, and a rectangle. The "Diagonal movement" animation is already configured 
for the circle. You configure the "Horizontal movement" animation for the multiple selection. 
This animation applies to the rectangle since no animation of the Movement type is yet 
configured for it. For the circle, you are asked to confirm that you want to replace the existing 
"Diagonal movement" animation with the new "Horizontal movement" animation. 
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9.1.4.6 Dynamization in the property list

Basics on dynamization in the property list

Basic principle of dynamization
In the case of an object property that can be dynamized you first specify the type of 
dynamization. The following figure shows the types of dynamization available:

Depending on the type of dynamization you either select a tag using the object list or you create 
a local script. 

Dynamization with tags
If you dynamize an object property with a tag, you can configure a function list additionally on 
the following events:

● Changed

● Tag status changed

● Quality code changed

The tags are updated in the update cycle set for the screen.

The figure below shows the "Radius" object property dynamized with a tag. When the value 
of the tag changes, a function list is executed additionally:
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You can also convert the function list into a local script.

Further information can be found in Creating local scripts (Page 1782)

Quality Code
Use "Quality Code" to check the status and quality of a tag. The quality of the entire value 
transmission and value processing of the respective tag is combined in the displayed "Quality 
Code". The monitoring of the "Quality Code" enables you to draw conclusions about the quality 
of the tags in the process. 

Dynamization with local scripts
With a local script you dynamize an object property in Runtime by means of the return value 
of the local script. The script is created directly at the instance where it is used. The following 

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  757



figure shows the implementation of a status indicator by dynamizing the background color 
using a VB script:

See also
Dynamizing an object property with a tag (Page 759)

Dynamizing an object property with local scripts (Page 762)

Basics on dynamizing screens (Page 729)

Basics on dynamization in the property list (Page 758)

Local scripts (Page 1782)

Programming a dynamization method for a tag change (Page 760)

Show overview of the dynamizations (Page 764)

Basics on dynamization in the property list

Basic principle of dynamization
Select a tag from the object list for a dynamizable object property in the property list. The object 
is dynamized if the tag value changes in Runtime.

Dynamization with tags
You dynamize an object property with a tag and configure a function list. The tags are updated 
in the update cycle set for the screen.

The figure below shows the "Radius" object property dynamized with a tag. When the value 
of the tag changes, a function list is executed additionally:
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You can also convert the function list into a local script.

Further information can be found in Creating local scripts (Page 1782)

See also
Basics on dynamization in the property list (Page 756)

Dynamizing an object property with a tag

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. When you indirectly dynamize the object property, you connect 
the property to a tag that sets the property value in Runtime.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.

Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. Click the  button in the Inspector window.
The property list is displayed with the properties of the selected object. 
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3. Select the property to be dynamized.

4. In the "Dynamization" column, select the entry "HMI_Tag".
A dialog opens.

5. Select a tag.

6. Activate "Use indirect addressing" to dynamize the object property.

Result
The object property changes in Runtime according to how the property list is configured. 

Representation of a multiple selection in the property list
If you selected multiple objects at the same time, the "Object type" column is added to the 
property list. The objects that support the property displayed in the row are displayed in this 
column. Changes to, or dynamization applied to a property affect all the objects displayed in 
the "Object type" column.

See also
Basics on dynamization in the property list (Page 756)

Programming a dynamization method for a tag change

Introduction
If you have entered a tag in the "Dynamization" column, you can configure a function list 
additionally on different events.
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Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The property list is open in the inspector window.

● An object property is connected with the tag.

Procedure
1. Extend the property list by clicking next to the property which you have dynamized with a 

tag.

2. Three other lines with the following events are displayed below the property.

– Changed

– Tag status changed

– Quality code changed

3. Configure a function list for the required event.
Alternatively you can convert the function list into a local script.

Result
The object property changes in Runtime according to how the property list is configured. 

See also
Basics on dynamization in the property list (Page 756)
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Dynamizing an object property with local scripts

Introduction
With a local script you dynamize an object property in Runtime by the return value of the script. 

Requirement
● The object with the property to be dynamized is selected.

● The Inspector window is open.

Procedure    
1. Click  in the Inspector window.

2. Select the object property to be dynamized.

3. Select the "VB script" or "C script" entry in the "Dynamization" column.
A dialog opens.

4. Write the program code.

5. Click " " in the toolbar to change the trigger.

Result
The object property changes in Runtime according to how the property list is configured.

Deleting the dynamization    
1. Select the dynamized object property in the property list.

2. Select the "None" entry in the "Dynamization" column.

See also
Basics on dynamization in the property list (Page 756)

Creating local scripts (Page 1782)

9.1.4.7 Dynamize with system functions

Basic on events

Introduction
Screen objects react to events. You configure a function list with system functions on the events 
of an object. 
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Events 
Which events and system functions are available depends on the object used.

If the operator activates a screen object for example, the configured system function is 
executed.

Further information can be found in Working with Function Lists (Page 1748)

See also
Configure system function on the "Click" event (Page 763)

Example: Configuring a button for language switching (Page 764)

Basics on dynamizing screens (Page 729)

Configure system function on the "Click" event

Introduction
You configure a function list on an object event. The linked system function is executed when 
the event occurs in runtime.

Requirements
A screen is open.

A button has been created in the screen.

The inspector window is open.

Procedure
1. Select the button.

2. Click "Properties> Events" in the Inspector window.

3. Select the "Click" event.

4. Click "Add function" in the table.

5. Select the "ShowAlarmWindow" system function.

Result
The alarm window opens in the screen if the operator clicks the button in runtime. 

See also
Basics of the function list (Page 1748)

Basic on events (Page 762)
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Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.

Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 

See also
Basic on events (Page 762)

9.1.4.8 Show overview of the dynamizations

Introduction
You can set the update cycle separately for every single dynamization. The number of different 
update cycles is limited to five per project.
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Show overview of existing dynamizations
1. Select a screen in the project tree.

2. Select "Overview dynamizations" in the shortcut menu.

Result
All objects and their dynamizations are shown in the work area in the screen. Under "Cycle" 
you select another update cycle if necessary.

See also
Basics on dynamizing screens (Page 729)

Basics on dynamization in the property list (Page 756)

9.1.5 Working with Layers

9.1.5.1 Basics on working with layers

Layers
Use layers in order to achieve differentiated editing of the objects in a screen. A screen consists 
of 32 layers that you can give any names. If you assign objects to the layers, you thereby define 
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the screen depth. Objects of layer 0 are located at the screen background, while objects of 
layer 31 are located in the foreground. 

The objects of a single layer are also arranged hierarchically. When you create a screen, the 
object inserted first is located at the rear within the layer. Each further object is placed one 
position towards the front. You can shift objects forwards and backwards within a layer.

Principle of the layer technique
Always one layer of the 32 layers is active. New objects you add to the screen are always 
assigned to the active layer. The number of the active level is displayed in the inspector window 
of the screen and in the "Layout > Layers" task card. 

When you open a screen, all 32 layers of the screen are displayed. You can hide all the layers 
except for the active layer in the inspector window of the screen and in the "Layout > Layers" 
task card. You then explicitly edit objects of the active layer.

In the tree view of the "Layers" palette in the "Layout" task card, you administer layers and 
objects with drag-and-drop and the context menu.

Application examples
Use layers, for example, in the following cases:

● To hide the labeling of objects when editing,

● To hide objects, e.g. alarm windows, while configuring other objects

9.1.5.2 Moving objects between layers

Introduction
By default, a new object is inserted on the active layer. You can, however, assign an object to 
another layer at a later time.     
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Requirement
● A screen with an object is open.

● The Inspector window is open.

Procedure
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. Enter the layer to which you want to move the object in "Properties > Properties > 
Miscellaneous > Layer" in the Inspector window.

Alternatively, select the object from the "Layout" task card and drag it to the required layer.

Changing the order of objects
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. To move the object to the front or back, select the "Order" > "Move backward" or "Move 
forward" command from the shortcut menu.
Alternatively, use the  or  button in the toolbar.

Result
The object is assigned to the selected layer, and positioned at the top of the layer. 

9.1.5.3 Setting the active layer

Introduction
The screen objects are always assigned to one of the 32 layers. There is always an active 
layer in the screen. New objects you add to the screen are always assigned to the active layer. 

The number of the active layer is indicated in the "Layer" toolbar. The active layer is indicated 
by the  icon in the "Layout > Layers" task card.

Layer 0 is the active layer when you start programming. You can activate a different layer 
during configuration, if necessary.

Requirement
● You have opened a screen which contains at least one object.

● The Inspector window of the active screen is open.

Procedure
1. Click "Properties > Properties > Layers" in the Inspector window of the current screen.

2. Enter the layer number in "Settings > Active layer".
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Alternative procedure
1. Select "Layout > Layers" in the "Layout" task card.

2. Select the "Set to active" command from the shortcut menu of a layer.

Result
The layer with the specified number is now active.

9.1.5.4 Show and hide layers

Introduction
You can show or hide the layers of a screen as required. You specify the layers that are shown 
in the Engineering System. When you open a screen, all the layers are always shown. 

Requirement
● The screen is opened.

● The "Layout" task card is open.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
768 System Manual, 08/2011,  



Procedure
1. Select the layer that you want to hide or show in the "Layout > Layers" task card.

2. Click one of the icons next to the corresponding layer:

–  A shown layer is hidden

–  A hidden layer is shown
 

  Note

The active layer cannot be hidden.
 

Alternative procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers":

3. In the list, disable the levels you wish to hide.
If you activate "All ES layers" for a layer, the objects in this layer will be shown in the 
Engineering System.

Result
The layers are shown according to your settings. 
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9.1.5.5 Show and hide layers

Introduction
You can show or hide the layers of a screen as required. You define whether the layers are 
displayed in the engineering system, and/or in Runtime. When you open a screen, all the layers 
are always shown.

Requirement
● The screen is opened.

Procedure
1. In the Inspector window, select "Properties > Properties > Layers":

2. Deactivate the layers that are not to be displayed in the Engineering System.

3. Deactivate the layers that are not to be displayed in runtime.

Alternatively you can also activate and deactivate the layers in the "Layer" task card.

Result
The activated layers are displayed in ES and in Runtime. 

9.1.5.6 Hide layers and objects in Runtime

Introduction
Layers and the objects stored in them can be shown and hidden in Runtime system-
dependently depending on the zoom factor. This means, for example, that a layer is only shown 
if a sufficient zoom factor allows the required detail to also be displayed.
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You can hide or show objects depending on the defined pixel size.

Requirement
A screen is open.

Hiding layers
1. Click in an area of the screen that does not contain an object.

2. Activate "Properties > Properties > Hide/Show > Activate for layers" in the Inspector window.

3. In the table enter the minimum and the maximum value for the zoom factor within which 
the respective layer is displayed.

Hiding objects
1. Click in an area of the screen that does not contain an object.

2. Activate "Properties > Properties > Hide/Show > Activate for layers" in the Inspector window.

3. Enter the minimum size in which the objects are displayed under "Min. pixels."

4. Enter the maximum size in which the objects are displayed under "Max. pixels."
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Result
Levels which are outside the zoom factor are not displayed in runtime. Objects which are 
outside the specified size are also not displayed. 

9.1.5.7 Renaming layers

Introduction
When you create a screen, the 32 layers are numbered consecutively by default. To improve 
clarity, you can rename the layers to suit your requirements.

Requirement
● The screen is opened.

Procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers".

3. Enter the new layer name.
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Result
The layer is displayed with the new name. 

9.1.6 Working with libraries

9.1.6.1 Basics on libraries

Introduction
Store all objects you need frequently in the libraries. An object that is stored in the library only 
has to be configured once. It can then be used repeatedly as often as required. Library objects 
extend the number of available screen objects and increase the effectiveness during 
configuration through the multiple usage of ready-to-use objects.

Libraries are managed in the "Libraries" task card. The following libraries are available:     

● Project library

● Global libraries

 

 Note

There is a symbol library in the "Tools" task card in the "Graphics" palette.
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Project library
There is one library for each project. Objects of the project library are stored alongside with 
the project data and are available only for the project in which the library was created. If the 
project is moved to another PC, any project library created in it is also moved. 

To use the library object of the project library in other objects, move or copy the object into a 
global library.

Global libraries
In addition to the objects from the project library, you can also incorporate objects from global 
libraries in your projects. A global library is saved independently of the project data in its own 
file with the extension *.aI11.

A project can access several global libraries. A global library may be used concurrently in 
several projects. 

When a library object is changed by a project, this library will be changed in all projects in 
which these libraries are open. 

Library objects  
A library can contain all WinCC objects. Examples: 

● Complete HMI device

● Screens

● Display and control objects including tags and functions

● Graphics

● Tags

● Alarms

● Text and graphics lists

● Faceplates

● Structures

 

See also
Copy templates and types (Page 774)

Screen basics (Page 629)

9.1.6.2 Copy templates and types

Introduction
Both the "Project library" and the "Global library" contain the two folders "Copy templates" and 
"Types". You can create or use the library objects either as a copy template or a type. 
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Copy templates   
Use copy templates to create independent copies of the library object. 

Types   
Create instances of objects of the "Types" folder and use these in your project. The instances 
are bound to their respective type. Changes to an instance also change all other instances. 
Types are marked by a green triangle in the "Libraries" task card.

Administration of the library objects  
You can only copy and move library objects within the same library.  You can only copy copy 
templates to the "Copy templates" folder or any sub-folder of "Copy templates". You can also 
only insert types in the "Types" folder or any sub-folder of "Types". 

See also
Basics on libraries (Page 773)

9.1.6.3 Libraries in WinCC

Introduction
The WinCC software package includes extensive libraries. Sorted by topic into folders, they 
contain preassembled graphic objects which you can use in screens for operation and 
monitoring of your plant.
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Global library "Buttons and Switches"
The libraries "Buttons and Switches" offer a wide selection of buttons and switches.     

The folders divide switches and buttons into categories. The "DiagnosticsButtons" folder 
contains the object "System diagnostics indicator", for example. You use the "System 
diagnostics indicator" object for system diagnostics in your plant. 

 

 Note

You can only use the objects in the "DiagnosticsButtons" folder on Comfort Panels. 

You cannot use objects which have "Switch" in the object name or in the associated folder 
name in Runtime Professional.
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Global library "Monitoring and Control objects"
The "Monitoring and Control objects" library offers more complex display and operating objects 
in several designs and corresponding control lights, buttons and switches. 

 

In addition, graphics views for the designs are stored in the "Design_Backgrounds" folder; they 
can be used as object backgrounds for the custom extension of the scope of the library.

 

 Note

You cannot use objects which have "Switch" in the object name in Runtime Professional. The 
same applies for the object "D5_Display_3" with the date/time field it contains.

 

9.1.6.4 Displaying library objects

Introduction
The libraries are displayed as file folders in the corresponding palette. The elements contained 
in the library are displayed in the file folder and in the "Elements" palette.
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Requirement
● At least one library object has been created in a library.

● The "Libraries" task card is opened.

Procedure
1. Select the library in the corresponding palette whose library objects you want to display.

2. Click .
The contained library objects are displayed in the "Elements" palette. 

3. Click one of the following icons:

Icon Description
Element view in detailed mode

Element view in list mode

Element view in overview mode with icons

When several objects are assigned to the library with a multiple selection, only one of the 
objects is shown in the "Elements" palette. The individual components of this element are 
displayed in the "Parts" palette.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
778 System Manual, 08/2011,  



Show parts of the library objects
1. Select the library in the corresponding palette from which you want to view the components 

of an element.

2. Click .

3. The contained library objects are displayed in the "Elements" palette.

4. Select the element.
The "Parts" palette shows the objects of which the element consists.

Result
The library objects are displayed in accordance with the configuration. The components of the 
faceplates are displayed.
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9.1.6.5 Managing library objects

Introduction
You can always copy or move library objects within the categories of a library. Delete the library 
objects you do not require. 

 

 Note
Copy templates and types

You can only copy and move library objects within the same library.  You can only copy copy 
templates to the "Copy templates" folder or any sub-folder of "Copy templates". You can also 
only insert types in the "Types" folder or any sub-folder of "Types".

 

Requirement
● You have opened a library which contains several categories and at least one object.

● The library object is shown.

Moving a library object
1. Select the library object.

2. Drag the object to the desired folder with drag&drop.

Copying a library object
1. Select the library object.

2. Select "Copy" from the shortcut menu.

3. Select the folder in which you want to insert the library object.

4. Select "Paste" from the shortcut menu.

Deleting a library object
1. Select the library object.

2. Select "Delete" from the shortcut menu.

Renaming a library object
Proceed as follows to rename a library object

1. Click the object that you wish to rename with the right mouse button.

2. Select the "Rename" command from the shortcut menu.

3. Enter the new name.
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9.1.6.6 Storing an object in a library

Introduction
You can store all of WinCC objects, such as screens, tags, graphic objects or alarms in your 
libraries. You can use drag-and-drop to move the corresponding object from the work area, 
project window or detail view to the library. In a library you have divided into categories, you 
can directly add objects to a specific category.   

Requirement
● The "Screens" editor is open.

● A screen object has been created in the work area of the screen.

● The created libraries are displayed.

Procedure
1. Select the object in the work area of the "Screens" editor.

2. Drag-and-drop the object from the work area to the desired library.
The mouse pointer is transformed into a crosshair with an appended object icon.

Result
The object is saved to the library for further use in multiple instances of your configuration.
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9.1.6.7 Inserting a library object

Introduction
 The system always assigns the inserted library object a name which consists of the name of 
the object type and of a consecutive number. If the inserted object already exists, you can use 
a dialog window to specify whether or not the existing object should be replaced or inserted 
under a new name. Enter a new name if you do not want to replace the existing object.   

You cannot insert library objects that are not supported by the HMI device.
 

 Note

If you insert a screen with interconnected template from the library, the template will also be 
inserted. Any existing matching template is not used.

 

Requirement
● The "Libraries" task card is opened.

● The editor in which you want to insert the library object is open.

Procedure
1. Select the library object that you want to insert in the library.

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is inserted.

3. Select the library object in the screen and adapt it.

Result
If the object was contained in the "Copy templates" folder, you have inserted an independent 
copy of the library object in the editor.

If the object was contained in the "Types" folder, you have inserted an instance of the library 
object in the editor.

See also
Copying and pasting (Page 2146)
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9.1.6.8 Creating a global library

Introduction
In the libraries you store the configured objects that you want to use several times in your 
configuration. To use objects in several projects, create a global library.  

Requirement
● You have opened the project.

● The "Libraries" task card is opened.

Procedure
1. Click the  icon in the "Libraries > Global libraries" task card.

The "Create new global library" dialog opens. 

2. Enter a name.

3. Select the path where the new library is to be stored.

4. Click "Create".

Result
The new library is shown in the "Global libraries" palette. The global library contains the "Types" 
and "Copy templates" folders. You can save objects to the library.

9.1.6.9 Saving a global library

Introduction
A global library is stored in a separate file on your hard disk drive. The file contains the objects 
of the global library including the referenced objects. E.g. the reference of a tag which was 
configured on an I/O field is also saved in the library.    
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WinCC prompts you to save the global libraries when you close WinCC or your project without 
saving. You also can store the global library during configuration, without storing the entire 
project. 

Requirement
● You have opened a project which contains at least one library.

● The "Libraries" task card is opened.

● A library has been changed.

Procedure
1. Select the global library that you want to save.

2. Click the  icon in the "Libraries" task card in the "Global libraries" palette.

You can alternatively select the "Save Library" command in the shortcut menu. 

If you want to store the global library in a different folder, select "Save as" in the shortcut menu. 
Select the path in which you want to store the new library and enter a file name. 

Result
The global libraries are saved under their current file name or a file name you have specified. 

9.1.6.10 Opening a global library

Introduction
In WinCC, the global libraries are stored in separate files. You can use a global library in every 
project.    

Requirement
● You have saved a global library.

● A project is open.

● The "Libraries" task card is opened.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
784 System Manual, 08/2011,  



Procedure
1. Click the  icon in the "Global libraries" palette.

The "Open global library" dialog box is displayed. 

2. Select the path in which the library is stored.

3. Click "Open."
 

  Note

If you want to access a global library from several projects, the global library will have to 
be read-only when you open it. As soon as a global library is read-only, access from other 
projects is blocked.

 

Result
WinCC displays the opened global library in the "Global libraries" palette. 

9.1.7 Working with faceplates

9.1.7.1 Basics on faceplates

Introduction
Faceplates are a configured group of display and control objects which you manage and 
change centrally in a library. You can use a faceplate in several projects as required. The 
faceplates are stored in the project library. 

Application
You use faceplates to create individually configured display and control objects. You can use 
faceplates several times in the project or in different projects. All instances of a faceplate in 
the project are changed centrally. This reduces the configuration effort.
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Types and instances     
Faceplates are based on a type-instance model to support the central changeability. You 
create centeral properties for an object in types. The instances represent local application 
points of the types.

● Faceplate type 
You create a display and control object according to your requirements and store it in the 
project library. The instances are bound to the respective faceplate type. If you change a 
property of a faceplate type, the property is saved centrally and also changed in all 
instances. In the faceplate type, you define the properties that can be changed on the 
faceplate. You edit a faceplate type in the "Faceplates" editor.

● Faceplate 
The faceplate is an instance of the faceplate type. You use a faceplate in screens as a 
display and control object. You configure the variable properties of the faceplate type on 
the instance. You assign the tags of your project to the faceplate for example. If you 
configure properties on the faceplate, you overwite the properties of the faceplate type. The 
changes on the faceplate are saved at the application point and have no effects on the 
faceplate type.

The figure below shows the relations between the faceplate type and the faceplate. The 
background color of the I/O field is configured in the faceplate type in such a way that every 
instance can change the property. Blue is used as a background color for the faceplate type. 
Use yellow as a background color for the faceplate. 

When you change the background color in the faceplate type, this has no effect on the faceplate 
because the "Background color" property is assigned instance-specifically.

Device dependence of faceplates
Not all HMI devices support every display and screen object. The screen objects which are 
not available in the respective HMI device are not displayed when using the faceplate.

The following devices support faceplates:

Runtimes
● WinCC Runtime Advanced

● WinCC Runtime Professional
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Comfort Panels
● KTP 400

● KP 400

● TP 700

● KP 700

● TP 900

● KP 900

● TP 1200

● KP 1200

● TP 1500

● TP 1700

Panels
● TP 277

● OP 277

Mobile Panels
● Mobile Panels

● Mobile Panel 277

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277F IWLAN (RFID Tag)

Multi Panels
● MP 277

● MP 377

See also
Faceplate editor (Page 788)

Creating a faceplate type (Page 791)

Screen basics (Page 629)

Basics of dynamizing faceplates (Page 808)

Example: Configuring a faceplate (Page 809)
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9.1.7.2 Faceplate editor

Open
When you create or edit a faceplate type, the "Faceplate" editor opens. 

Layout
The "Faceplates" editor consists of several editors, e.g. "Screens" and "Tags which are 
arranged in the work area and the configuration area.

The following figure shows the "Faceplate" editor:
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Work area
In the work area, place the objects contained in the faceplate type, as is familiar from the 
"Screens" editor. You can remove objects, or use the "Toolbox" task card to add new objects.
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Configuration section
● Properties 

The static and dynamic properties are identified as follows: 

– The  symbol identifies a dynamic property. Dynamic implementation of this property, 
using tags or text and graphic lists.

– The  symbol identifies a static property. You change only the values of a static 
property.

You define the faceplate type properties in the "Properties" tab.
You use the following two lists for this:

– The "Contained objects" list
This list includes the properties of the objects contained in the faceplate type. These 
properties can only be configured in the faceplate type in the "Faceplate" editor.

– The "Interface" list contains the properties and tags of the faceplate type. The "Interface" 
list consists of the pre-defined category "Dynamic properties" and user-defined 
categories.

● Events 
You define the faceplate type events in the "Events" tab. You use the following two lists for 
this:

– The "Contained objects" list contains the events of the objects embedded in the 
faceplate type.

– The "Interface" list contains the events of the faceplate.
You create links between the two lists using a drag and drop operation.

● Tags 
You can also create faceplate tags on the "Tags" tab. The tags are only available within 
the faceplate type. You can interconnect the faceplate type tags directly with an object 
contained in the faceplate type. 

● Scripts 
In the "Scripts" tab, you can configure scripts for the faceplate type. In the script, you can 
call up system functions or program new functions, for example to convert values. The 
scripts are only available within the faceplate type. They work with VB Script code.

 

  Note

The "Scripts" tab is not available for Runtime Professional.
 

● Text lists 
You can also create and edit texts lists for the faceplate type in the "Text lists" tab. These 
text lists are only available within the faceplate type. You can interconnect the text lists of 
the faceplate type directly with an object contained in the faceplate type, such as a symbolic 
I/O field.
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● Graphics lists 
If necessary, you can also create graphics lists for the faceplate type in the "Graphics lists" 
tab. These graphic lists are only available within the faceplate type. You can interconnect 
the graphic lists of the faceplate type directly with an object contained in the faceplate type, 
e.g. a graphic I/O field. 

● User texts 
The "User text" tab shows the contained user text of the opened faceplate type, for example 
entries from text lists. You can enter the compilations for the individual project languages 
directly in the "User text" tab. 

See also
Basics on faceplates (Page 785)

Example: Configuring a faceplate (Page 809)

9.1.7.3 Create and manage faceplate types

Creating a faceplate type

Introduction    
Faceplate types are display and control objects which are made up of several objects, e.g. 
controller modules. 

Requirement
You have opened a screen which contains multiple objects.

Procedure
1. Select all the objects that you need for the faceplate type.

2. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
The "Faceplates" editor is open.

3. Click on a empty surface in the work area.

4. Enter the name of the faceplate type in the Inspector window under "Properties > Properties 
> Miscellaneous".
"HMI device class" shows which runtime the faceplate type is suitable for. 

5. Define the size of the faceplate type in the "Properties > Properties > Layout > Size" 
inspector window.

Alternative procedure
1. Open the "Libraries" task card.

2. Select the "Create type" command in the shortcut menu of the project library. A dialog opens.
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3. Select the runtime for which the faceplate type is to be available. An empty faceplate type 
is created.

4. Open the "Tools" task card.

5. Move the objects from the toolbox to the work area of the faceplate type by drag&drop. The 
objects are displayed in the configuration area of the faceplate type.

6. Enter a name for the new faceplate type in the "Properties > Properties > Miscellaneous" 
Inspector window.

Result
The new faceplate type is displayed under the selected name in the project library. 

The faceplate type is assigned the status "In progress" and the version 1.0.0. 
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See also
Basics on faceplates (Page 785)

Configuring a faceplate type  (Page 793)

Configuring an event in the faceplate type (Page 798)

Configuring a tag in the faceplate type (Page 796)

Configuring scripts in the faceplate type (Page 797)

Creating an instance of the faceplate type (Page 806)

Editing the faceplate type (Page 805)

Copy templates and types (Page 774)

Configuring a graphics list in the faceplate type (Page 802)

Configuring a text list in the faceplate type  (Page 801)

Translating texts directly in the faceplate type (Page 803)

Editing the category and property of a faceplate type (Page 795)

Removing faceplate object from faceplate (Page 807)

Example: Configuring a faceplate (Page 809)

Configuring an event in the faceplate type  (Page 800)

Configuring a faceplate type 

Introduction
In the configuration area of the "Faceplates" editor you define which properties and process 
values of the objects contained in the faceplate can be configured in the "Properties" tab. 

Requirement
● The faceplate is generated and is displayed in the "Faceplate" editor.

● The "Properties" tab is open in the configuration area.

Procedure
1. To create a new property, click the "Add property"  button in the interface list.

A new property is displayed in the "Interface" list.

2. To create a new category, click the "Add category"  button in the interface list.
A new category including a new property is displayed in the "Interface" list.
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3. Click the name of the property and assign a name, for example, "Color".

4. Select the data type.

Interim result
You have created a new property.

1. Click an object in the "Contained objects" list.

2. Select a property, e.g. "Appearance > Background color".

3. Move the property from the "Contained objects" list to the desired property in the "Interface" 
list by drag&drop.
The connection is displayed as a colored line.
The system assigns the same data type to the property in the "Interface" list as that of the 
property in the "Contained objects" list.
To change the data type, select the data type from the data types of the connected property. 

4. Repeat step 3 to connect other properties of the contained properties with the interface.
 

  Note

The property from the "Contained objects" list must be in concordance with the data type 
of the already connected property of the "Interface" list.
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Deleting a connection   
1. Click the connection that you wish to delete.

2. In the shortcut menu select the "Delete" command or use the <DEL> key.
The connection is deleted.

Result
You have created a new property or a new category with a property. You have connected the 
property of the interface with a property of the contained objects. If you use an instance of the 
faceplate type in a screen, you configure the properties of the faceplate which you have created 
in the "Interface" list. 

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Editing the category and property of a faceplate type

Deleting a property in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the property which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The property is deleted from the "Interface" list. Existing connections to the contained objects 
are deleted. All linked faceplates lose their instance-specific property.

Deleting a category in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the category which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The category including the properties is deleted from the "Interface" list. Existing connections 
to the contained objects are deleted. All linked faceplates lose their instance-specific properties.

Moving a property to another category
1. Select a property in the "Interface" list.

2. Move the property to a new category by "drag&drop".

You have moved the property to a new category.
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Changing the data type of a property
1. Select a property in the "Interface" list.

2. Click the second column of the drop-down list.

3. Select a data type.

You have changed the data type of the property in the "Interface" list.

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Configuring a tag in the faceplate type

Introduction
You connect a tag in the faceplate type directly with the properties of the objects contained in 
the faceplate type. With tags in the faceplate type you define the dynamization in the faceplate 
type centrally for example. Without tags in the faceplate type the assignment of tags to I/O 
fields in the instance cannot be changed for example. 

The tags of a faceplate type have limited functionality.

The "Tags" tab of the configuration area has the same structure as the "Tags" editor.

Requirements
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Tags" tab is open in the configuration area.

Procedure
1. Click "Add" in the "HMI tags" table. A new tag is created in the faceplate type.

2. Open "Properties > Events" in the inspector window if necessary. You configure the "Value 
change" event on the tag for example.

3. In the work area, select the object to which you want to assign this tag, e.g. an I/O field.

4. Select the tag in the inspector window of the I/O field "Properties > Properties > General > 
Process > Tag".

 

  Note

Only tags of the faceplate type are displayed in the object list in the "Faceplates" editor.
 

5. In the Inspector window, select "Properties".

6. Create a new property in the "Interface" list.

7. Select the process value to which the tag is assigned in the "Contained objects" list.
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8. Move the process value from the "Contained objects" list to the new property in the 
"Interface" list by drag&drop.
A connection is displayed as an arrow.

9. To change the data type of the process value as required, click the process value in the 
"Interface" list. Open the selection list and select the desired data type.

Result
The tag of the faceplate type appears in the "Interface" list under the "Tag" entry.

In a faceplate you connect the property with a tag of the project in the "Properties > Interface" 
inspector window. 

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Configuring scripts in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you create scripts which you only use within 
a faceplate type. You can only refer to tags of the faceplate type or properties of the contained 
objects within the script. The script is used as a copy in the instance of the faceplate type. 
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Requirement
● The faceplate is generated and is displayed in the "Faceplate" editor.

● Faceplate tags or dynamic properties have been created.

Procedure
1. Click the "Scripts" tab in the configuration area of the faceplate.

2. Double click "Faceplate scripts > Add VB script".

3. Write the program code.

4. Press the shortcut keys <CTRL+J> to Include tags of the faceplate type in the script. The 
object list opens.

5. Click "HMI tags".
All tags of the faceplate type are displayed in the object list.

6. Select a tag and confirm the selection.

7. Press the shortcut keys <CTRL+J> to use properties of the faceplate type in the script. The 
object list opens.

8. Click "Properties."
All dynamic properties of the "Interface" list for the faceplate type are displayed in the object 
list.

Result
You have created a script in the faceplate type. The instance of the faceplate type uses a copy 
of the script. The script is executed in runtime depending on the configuration. 

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Configuring an event in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you define which events of the objects 
contained in the faceplate can be configured in the "Events" tab. You configure a function list 
on the events of the faceplate in the "Screens" editor.

Requirement
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Events" tab of the configuration area is open.
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Procedure
1. Click an object in the "Contained objects" list.

2. Select an event, e.g. "Activate".

3. Move the event from the "Contained objects" list to a new category in the "Interface" list.
The new event is displayed in the "Interface" list.
The connection appears as a colored line.

4. Double-click the event and, if required, change the name of the event.

Result
You have created an event in the faceplate type. if you use an instance of the faceplate type, 
you will only be offered the configured events in the inspector window. You configure a function 
list on the event in the faceplate. 

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)
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Configuring an event in the faceplate type 

Introduction
In the configuration area of the "Faceplates" editor you define which events of the objects 
contained in the faceplate can be configured in the "Events" tab. You configure a function list 
on the events of the faceplate in the "Screens" editor.

Requirement
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Events" tab of the configuration area is open.

Procedure
1. Click an object in the "Contained objects" list.

2. Select an event, e.g. "Activate".

3. Move the event from the "Contained objects" list to a new category in the "Interface" list.
The new event is displayed in the "Interface" list.
The connection appears as a colored line.

4. Double-click the event and, if required, change the name of the event.
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Result
You have created an event in the faceplate type. If you use an instance of the faceplate type, 
you will only be offered all default settings for events in the inspector window. In the faceplate 
you configure a function list or a VB-script or C-script on the event. 

See also
Example: Configuring a faceplate (Page 809)

Creating a faceplate type (Page 791)

Configuring a text list in the faceplate type 

Introduction
In a faceplate type, you connect a text list with an object included in the faceplate type. Text 
is assigned to the values of a tag in a text list. The text list is used, for example, to display a 
selection list in a symbolic I/O field contained in the faceplate type. The interface between the 
text list and a tag of the faceplate type is configured at the object that uses the text list.

Requirements
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Text list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Text lists" table. A new text list is created in the faceplate type.

2. Assign a name to the text list that indicates its function.

3. Select the text list type, e.g. "Value/Range" under "Select".
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4. Click "Add" in the "Text list entries" table.

5. Define the values or range of values for the text list.

6. Enter a text for every value range which is displayed in Runtime when the tag is within the 
specified value range.

7. Select an object, for example a button in the work area of the faceplate type.

8. In the Inspector window of the object, enable "Properties > Properties > General > Label > 
Text list".

9. Select the "Text list" from the selection list.

10.Select a tag of the faceplate type in "Process > Tag".

Result
You have created a text list in the faceplate type. This text list is linked to an object contained 
in the faceplate type. You have configured a faceplate type tag at the object. 

See also
Creating a text list (Page 710)

Basics on text lists (Page 708)

Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Configuring a graphics list in the faceplate type

Introduction
In a graphics list, specific graphics are assigned to possible values of a tag. In a faceplate type, 
you connect a graphics list with an object included in the faceplate type. Graphics are assigned 
to the values of a tag in a graphics list. For example, the graphics list is used to display a 
selection list in a graphic I/O field contained in the faceplate type. The interface between the 
graphics list and a tag of the faceplate type is configured at the object that uses the graphics 
list.

Requirements
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Graphics list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Graphics lists" table. A new graphics list is created in the faceplate type.

2. Assign a functional name to the graphics list.
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3. Select a graphics list type, e.g. "Range (... - ...)", under "Selection".

4. Click "Add" in the "Graphics list entries" table. A new entry is created in the list.

5. Define the values or range of values for the graphics list.

6. Select a graphic for every value or value range which is displayed in runtime when the tag 
is within the specified value range.

7. Select an object, e.g. a graphic I/O field, in the work area of the faceplate type.

8. Activate "Properties > Properties > General > Contents > Graphics list" in the object's 
Inspector window.

9. Select the "Graphics list" from the selection list.

10.Select a tag of the faceplate type in "Process > Tag".

Result
You have created a graphics list in the faceplate type. This graphics list is linked to an object 
contained in the faceplate type. You have configured a faceplate type tag at the object.

See also
Creating a graphics list (Page 720)

Basic principles of graphics lists (Page 718)

Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Translating texts directly in the faceplate type

Translating texts   
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● A project is open.

● You have opened the "Faceplates" editor.

● You have created a faceplate type.

● The faceplate type contains at least one object with text, e.g. a text field.
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Procedure
Proceed as follows to translate individual texts:

1. Open the "Tasks" task card.

2. Click the  button under "Languages & Resources > Editing language". The "Project 
languages" editor opens.

3. Activate at least two project languages.

4. Open the "Texts" tab in the "Faceplates" editor.
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

5. Click on the  button in the toolbar to group identical texts together.

6. To hide texts that do not have a translation, click on the  button in the toolbar.

7. Click on an empty column and enter the translation.

Result
You have translated individual texts in the "Texts" tab of the faceplate type. The texts will then 
be displayed in the runtime language.

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)
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Editing the faceplate type

Introduction
All faceplate types in the project library have a status. You create a faceplate type in "WIP" 
status. You can edit the faceplate types as required in this status. When the editing is complete, 
set the status to "Enabled". Faceplate type set to the "Enabled" status cannot be changed.   

Requirement
● A faceplate type has been created.

● The faceplate must be used in at least one screen.

● The "Libraries" taskcard is opened.

Enable faceplate type  
1. Select the faceplate type from the project library.

2. Select "Enable faceplate type" in the shortcut menu.

The faceplate type is enabled. The faceplate type can no longer be edited. The faceplate type 
contains a version label. After all faceplates are enabled, they are updated and refer to the 
new version of the faceplate type. The old version is deleted.

Edit faceplate type  
1. Select the faceplate type from the project library.

2. Select "Edit faceplate type" in the shortcut menu. The "Faceplates" editor is open.

3. Edit the faceplate type as required.

The properties of the faceplate type have been edited. The faceplate type has the "WIP" status. 

If the faceplate type was already enabled, a new version of the faceplate type is created. 

Restore faceplate type
The faceplate type was already enabled and has a version. 

Edit the faceplate type. The faceplate type receives the "WIP" status.

1. Select the faceplate type from the project library.

2. Select "Restore faceplate type" in the shortcut menu.

All changes to the faceplate type since the last enabling operation are rejected. The faceplate 
type is enabled again and receives the label of the previously enabled version. 

See also
Creating a faceplate type (Page 791)
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Resizing a faceplate

Introduction
In the faceplate type, specify the response of the faceplate when it is resized.    

Requirements
● A faceplate type has been created.

● You have opened the "Faceplates" editor.

● The Inspector window is open.

Specifying the response to resizing
1. Activate "Properties > Properties > Layout > Fit to size > Auto-size."

2. Select one of the following options for "Response to resizing":

– Fixed size
Specifies that the size of the faceplate cannot be changed.

– None
No restriction on resizing of the faceplate.

– Keep aspect ratio
The size of the faceplate can be changed. The aspect ratio is kept during resizing.

3. Click the faceplate in the "Libraries" task card.

4. Select "Enable faceplate type" in the shortcut menu.

Result
You have specified how the faceplate responds when its size in a screen is changed. You can 
change the response for a particular faceplate. 

Select a faceplate in the screen. Select the required setting in "Properties > Properties > Layout 
> Characteristics" in the Inspector window. 

Creating an instance of the faceplate type

Introduction
The faceplate type is stored in the project library. If you use the faceplate type in a screen, you 
create an instance of the faceplate type.       

 

 Note

Faceplate types are also stored in global libraries. When you add a faceplate type from the 
global library to the screen, the system automatically saves a copy of it to the project library.
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Requirement
● A screen is open.

● The project library is open and it contains at least one faceplate type.

● The Inspector window is open.

Procedure
1. Move the desired faceplate type from a library to the screen by drag&drop.

A faceplate is created in the screen. The inspector window of the faceplate is displayed.
 

  Note

Note that a faceplate is always configured for a particular class of HMI devices. For 
example, you cannot use a faceplate type that is configured for "RT Professional" in a 
screen on an "RT Advanced" HMI device.

 

2. Configure the properties of the faceplate in the Inspector window as required.
To dynamize the faceplate, open the interface in the Inspector window.

 

See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

Removing faceplate object from faceplate

Introduction
Cancel application, to remove specified instances from the update of the faceplate type. 

Requirement
● A faceplate type has been created.

● The faceplate must be used in a minimum of one screen.

Disconnect the faceplate object from faceplate type.    
1. Select a faceplate on the screen.

2. In the shortcut menu, select "Disconnect faceplate object from faceplate type".

Result
The faceplate is independent of the associated faceplate type. Changes to the faceplate type 
are not updated in the faceplate. 
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See also
Creating a faceplate type (Page 791)

Example: Configuring a faceplate (Page 809)

9.1.7.4 Dynamizing faceplates

Basics of dynamizing faceplates

Application
You can dynamically control events and properties of faceplates in two ways:   

● Dynamically controlling faceplates
You configure the events or dynamic properties individually for the application point on the 
faceplate. To do this, define in the "Faceplates" editor that these properties and events are 
configurable in the faceplate. To dynamize the faceplates in the "Screens" editor, use the 
scripts and tags that are created in the project. 

● Dynamizing the faceplate type 
You dynamize the objects which are contained in the faceplate type in the "Faceplates" 
editor. You configure the individual objects as in the "Screens" editor. Tags and scripts are 
available in the "Faceplates" editor to dynamize properties and events. You do not have 
access to the tags and scripts of the project within the faceplate. 
Every faceplate created with the faceplate type has the same preconfigured dynamization. 
You can edit this dynamic control only in the "Faceplates" editor. 

Animation
WinCC provides preconfigured dynamic control in the "Animations" task card. You use 
animations to dynamize faceplates and faceplate types. 

See also
Dynamizing faceplates (Page 808)

Basics on faceplates (Page 785)

Example: Configuring a faceplate (Page 809)

Dynamizing faceplates

Introduction   
You dynamize a faceplate in exactly the same way as you dynamize an object from the "Tools" 
task card. 

You connect the dynamic properties of the faceplate in the "Screens" editior with a tag or a 
script which supplies values to the property in runtime.
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You Include tags and scripts which you have created in the project for the faceplate.

Requirement
● A faceplate is inserted in the screen.

Procedure
1. Select the faceplate.

2. In the Inspector window, open "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

See also
Basics of dynamizing faceplates (Page 808)

Example: Configuring a faceplate (Page 809)

9.1.7.5 Example: Creating and dynamically controlling faceplates

Example: Configuring a faceplate

Introduction
In this example you create a faceplate in which you can convert the value of a length measuring 
system from kilometers into meters. The length in meters is displayed in an output field.  
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Procedures overview
The example is divided into the following steps:

1. Creating a faceplate type

2. Configuring a faceplate type

3. Creating a script in the faceplate type

4. Connecting a script with the contained objects of the faceplate type

5. Creating a faceplate and connecting with a tag

See also
Example: Creating a faceplate type (Page 810)

Example: Configuring a faceplate type (Page 811)

Example: Creating a script in the faceplate type (Page 812)

Example: Creating an instance of the faceplate type (Page 814)

Example: Configuring included objects (Page 816)

Basics on faceplates (Page 785)

Example: Creating a faceplate type

Task
You create a faceplate type.  

Requirement
● A screen is open.

● The toolbox window is displayed.

Settings
For the example you require objects with the following settings:

Object Object name Properties
Text field Label_Meter Text: Meter
I/O field Output_Meter Mode: Output
Button KM_to_Meter Text OFF: Convert

Procedure
1. In the toolbox, click the individual objects and drag&drop the objects into the screen.

2. Set the properties as shown above.
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3. Select all objects.

4. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
The "Faceplates" editor is open.

5. In the Inspector window, click "Properties > Properties > Miscellaneous".

6. Enter "KMtoMeter" as the name.

Result
The faceplate types appears in the project library under the name "KMtoMeter". The faceplate 
type is assigned the "WIP" status.

See also
Example: Configuring a faceplate (Page 809)

Example: Configuring a faceplate type

Job
You create the dynamic property and tag of the faceplate type.  

Creating a new property
1. Click "Properties" in the configuration area of the faceplate.

2. In the "Interface" list, click the  icon "Add property".
A new property is added to the "Interface" list.

3. Double click the name of the property and enter "KMToMeter".

4. Click the selection list and select the data type "Int".

Interim result
The "KMToMeter" property is displayed in the "Interface" list. The symbol identifies the dynamic 
property. The property will be linked to a tag in the next step.
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Creating a tag in the faceplate type   
1. Click "Tags" in the configuration area.

2. Click "Add" in the "HMI tags" table. A new tag is added to the table. The inspector window 
of the tag is opened.

3. In the Inspector window, select "Properties > Properties > General":

4. Enter "BB_Tag" as the name. Select the "Int" data type.

Result
The "KMToMeter" property and the "BB_Tag" of the faceplate type are created in the 
configuration area of the "Faceplates" editor.

See also
Example: Configuring a faceplate (Page 809)

Example: Creating a script in the faceplate type

Task
You create a script that converts the value of a length measuring system from kilometers to 
meters.  

Procedure
1. Click "Scripts > Faceplate scripts" in the configuration area.

2. Double click "Add VB script".

3. Press the shortcut keys <CTRL+J>.
The object list opens. 
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4. Click "HMI tags".
The faceplate tag "BB_Tag" is displayed in the object list.

5. Select the faceplate type tag "BB_Tag". Confirm the selection.

6. Insert an "=" sign.

7. Press the shortcut keys <CTRL+J>. The object list is opened.

8. Click "Properties."
The dynamic property "KMtoMeter" is displayed in the object list.

9. Select the "KMToMeter" dynamic property. Confirm the selection.
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10.Enter "*1000" at the end of the code. This corresponds to the conversion factor from 
kilometers to meters.

11.Enter the name "Script_1" under "Properties > Properties > General >Setting > Name" in 
the Inspector window.

Result
The script has been created in the faceplate type. If you use the "KMtoMeter" faceplate type 
in a screen, you assign a tag to the "KMtoMeter" property. The value of this tag is multiplied 
by factor 1000 and assigned to the tag of the faceplate type "BB_Tag" as a new value. In this 
way you supply values to the tags of the faceplate type. 

See also
Example: Configuring a faceplate (Page 809)

Example: Creating an instance of the faceplate type

Task
You insert the faceplate type "KMtoMeter" in a screen and assign a tag to the dynamic property 
"KMtoMeter".

Requirement
● The "Screens" editor is open.

● A new screen has been created.

Settings
For the example you require a tag with the following settings:

Name PLC connection Type
Kilometer No ULong
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Procedure
1. Create the HMI tag "Kilometer" with the settings named above.

2. Open the  "project library" in the "Libraries" task card.

3. Move the "KMtoMeter" faceplate type into the screen by drag&drop.

4. Click "Properties > Properties > Interface" in the Inspector window.
The table shows all the properties which you can dynamize in the faceplate.

5. Click the "Dynamization" column in the "KMtoMeter" line.

6. Select "HMI tag".

7. Click the "..." button.

8. Select the tag "Kilometer" from the object list.

9. Confirm the selection.

Result
The dynamic property "KMtoMeter" is linked with the "Kilometer" tag. During runtime the 
dynamic property is supplied with values of the "Kilometer" tag. The values are multiplied by 
factor 1000 in the script of the faceplate type and assigned to the tag in the faceplate as a new 
value.

See also
Example: Configuring a faceplate (Page 809)
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Example: Configuring included objects

Task
You connect the included objects in the faceplate "KMtoMeter" to a faceplate tag and a 
faceplate script. 

You connect the I/O field with the "BB_Var" tag of the faceplate type. You connect the "Click" 
event for a button to the script "Script_1".  

Requirement
The faceplate is displayed in the "Faceplates" editor.

Interconnecting I/O field with a tag
1. Select the "Output_Meter" I/O field in the faceplate.

2. Connect the I/O field with the faceplate tag "BB_Tag" in the "General > Process > Tag" 
inspector window.

Connecting an event to a faceplate script
1. Select the "KM_to_Meter" button in the faceplate.

2. Select "Script_1" in the inspector window under "Events > Click".

Result
The I/O field is connected with the tag of the faceplate type. The button is connected with the 
script of the faceplate type. 

If you click the button of the faceplate during runtime, the script is executed. The value of the 
tag of the faceplate is output in the I/O field. 

See also
Example: Configuring a faceplate (Page 809)
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9.1.8 Display and Control Objects

9.1.8.1 Device-Specific Nature of the Objects

Objects for Basic Panels

Availability of display and operating elements for Basic Panels      
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Basic Panels. 

Overview

 KTP300 Basic KTP400 Basic KTP600 Basic KTP1000 Basic KTP1500 Basic
Bar Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes
Help indicator Yes No No No No
Circle Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes
Line Yes Yes Yes Yes Yes
Alarm view
Alarm window

Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
Text field Yes Yes Yes Yes Yes
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See also
Objects for Comfort Panels (Page 819)

Objects for Multi Panels (Page 821)

Objects for Mobile Panels (Page 822)

Objects for WinCC Runtime Advanced (Page 824)

Objects for WinCC Runtime Professional (Page 826)

Objects for Panels (Page 818)

Objects for Panels

Availability of display and operating elements for Panels      
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Panels. 

Overview

 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Bar Yes Yes Yes Yes Yes
User view Simple Simple Simple Yes Yes
Date/time field No No No Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse No No Yes Yes Yes
f(x) trend view No No No No No
Function key only on keyboard units
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes 1) Yes 1) Yes 1) Yes Yes
Hand wheel No No No No No
Help indicator Yes No No No No
HTML browser No No No No No
Circle No No Yes Yes Yes
Trend view No No Yes Yes Yes
Charging condition No No No No No
Illuminated pushbutton No No No No No
Line No No Yes Yes Yes
Media Player No No No No No
Alarm view, 
Alarm window

Simple Simple Simple Yes Yes

Alarm indicator Simple Simple Simple Yes Yes
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 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Polygon No No No Yes Yes
Polyline No No No Yes Yes
Rectangle No No Yes Yes Yes
Recipe view No Simple Simple Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes 2) Yes 2) Yes 2) Yes Yes
Slider No No No Yes Yes
KeySwitch No No No No No
Sm@rtClient view No No No Yes Yes
Status/Force No No No Yes Yes
Symbol library No No No Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
System diagnostics 
display

No No No No No

System diagnostics 
window

No No No No No

Text field Yes Yes Yes Yes Yes
Clock No No No No No
Effective range signal No No No No No
Effective range name No No No No No
Effective range name 
(RFID)

No No No No No

WLAN reception No No No No Yes
Gauge No No Yes Yes Yes
Zone name No No No No No
Zone signal No No No No No

1) Only two different graphics can be used.
2) Only the "Switch with text" and "Switch with graphic" types can be used.

See also
Objects for Basic Panels (Page 817)

Objects for Comfort Panels

Availability of display and operating elements for Comfort Panels      
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects on 
Comfort Panels. 
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Overview

 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 Comfort
TP1200
Comfort

Bar Yes Yes Yes Yes
User view Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes
I/O field Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes
f(x) trend view Yes Yes Yes Yes
Function key only on keyboard units
Graphic view Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes
Handwheel No No No No
Help indicator No No No No
HTML browser No No No No
Circle Yes Yes Yes Yes
Trend view Yes Yes Yes Yes
Charging condition No No No No
Illuminated pushbutton No No No No
Line Yes Yes Yes Yes
Media Player Yes Yes Yes Yes
Alarm view, 
Alarm window

Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes
Polygon Yes Yes Yes Yes
Polyline Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes
Button Yes Yes Yes Yes
Switch Yes Yes Yes Yes
Slider Yes Yes Yes Yes
KeySwitch no) No No No
Sm@rtClient view Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes
System diagnostics display Yes Yes Yes Yes
System diagnostics window Yes Yes Yes Yes
Text field Yes Yes Yes Yes
Clock Yes Yes Yes Yes
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 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 Comfort
TP1200
Comfort

Effective range signal No No No No
Effective range name No No No No
Effective range name (RFID) No No No No
WLAN reception No No No Yes
Gauge Yes Yes Yes Yes
Zone name No No No No
Zone signal No No No No

 

 

See also
Objects for Basic Panels (Page 817)

Objects for Multi Panels

Availability of display and operating elements for Multi Panels     
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Multi Panels. 

Overview

 MP 177 MP 277 MP 377
Bar Yes Yes Yes
User view Yes Yes Yes
Date/time field Yes Yes Yes
I/O field Yes Yes Yes
Ellipse Yes Yes Yes
f(x) trend view No No No
Function key only on keyboard units
Graphic view Yes Yes Yes
Graphic I/O field Yes Yes Yes
Handwheel No No No
Help indicator No No No
HTML browser No No No
Circle Yes Yes Yes
Trend view Yes Yes Yes
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 MP 177 MP 277 MP 377
Charging condition No No No
Illuminated pushbutton No No No
Line Yes Yes Yes
Media Player No No No
Alarm view, 
Alarm window

Yes Yes Yes

Alarm indicator Yes Yes Yes
Polygon Yes Yes Yes
Polyline Yes Yes Yes
Rectangle Yes Yes Yes
Recipe view Yes Yes Yes
Button Yes Yes Yes
Switch Yes Yes Yes
Slider Yes Yes Yes
KeySwitch no) No No
Sm@rtClient view Yes Yes Yes
Status/Force Yes Yes Yes
Symbol library Yes Yes Yes
Symbolic I/O field Yes Yes Yes
System diagnostics display No No No
System diagnostics window No No No
Text field Yes Yes Yes
Clock Yes Yes Yes
Effective range signal No No No
Effective range name No No No
Effective range name (RFID) No No No
WLAN reception No No No
Gauge Yes Yes Yes
Zone name No No No
Zone signal No No No

See also
Objects for Basic Panels (Page 817)

Objects for Mobile Panels

Availability of display and operating elements for Mobile Panels      
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Mobile Panels. 
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Overview

 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Bar Yes Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes Yes
f(x) trend view No      
Function key Yes Yes Yes Yes Yes Yes
Graphic view Yes Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes Yes
Handwheel Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Help indicator No No No No No No
HTML browser No No No No No No
Circle Yes Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes Yes
Charging condition No No No Yes Yes Yes
Illuminated pushbutton Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Line Yes Yes Yes Yes Yes Yes
Media Player No No No No No No
Alarm view, 
Alarm window

Yes Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes Yes
Polygon Yes Yes Yes Yes Yes Yes
Polyline Yes Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes Yes
Slider Yes Yes Yes Yes Yes Yes
KeySwitch Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Sm@rtClient view No Yes Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes Yes
System diagnostics 
display

No No No No No No

System diagnostics 
window

No No No No No No

Text field Yes Yes Yes Yes Yes Yes
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 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Clock No No Yes Yes Yes Yes
Effective range signal No No No No Yes Yes
Effective range name No No No No Yes No
Effective range name 
(RFID)

No No No No No Yes

WLAN reception No No No Yes Yes Yes
Gauge Yes Yes Yes Yes Yes Yes
Zone name No No No Yes Yes No
Zone signal No No No Yes Yes No
1) optional operator control

 

 

See also
Objects for Basic Panels (Page 817)

Objects for WinCC Runtime Advanced

Availability of display and operating elements for WinCC Runtime Advanced       
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
WinCC Runtime Advanced. 

Overview

 WinCC Runtime Advanced
Bar Yes
User view Yes
Date/time field Yes
I/O field Yes
Ellipse Yes
f(x) trend view Yes
Function key No
Graphic view Yes
Graphic I/O field Yes
Handwheel No
Help indicator No
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 WinCC Runtime Advanced
HTML browser Yes
Circle Yes
Trend view Yes
Charging condition No
Illuminated pushbutton No
Line Yes
Media Player No
Alarm view, 
Alarm window

Yes

Alarm indicator Yes
Polygon Yes
Polyline Yes
Rectangle Yes
Recipe view Yes
Button Yes
Switch Yes
Slider Yes
KeySwitch No
Sm@rtClient view No
Status/Force Yes
Symbol library Yes
Symbolic I/O field Yes
System diagnostics display No
System diagnostics window No
Text field Yes
Clock Yes
Effective range signal No
Effective range name No
Effective range name 
(RFID)

No

WLAN reception No
Gauge Yes
Zone name No
Zone signal No

 

 

See also
Objects for Basic Panels (Page 817)
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Objects for WinCC Runtime Professional

Availability of display and operating elements    
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following tables show the availability of indicator and control objects for 
WinCC Runtime Professional.

Overview

Table 9-1 WinCC Runtime Professional

 WinCC Runtime Professional
Application window Yes
Bar Yes
User view Yes
Screen window Yes
Scroll bar Yes
Date/time field No
Double T-piece Yes
I/O field Yes
Editable text field Yes
Ellipse Yes
Ellipse arc Yes
Ellipse segment Yes
Function key No
f(x) trend view Yes
f(t) trend view Yes
Graphic view Yes
Graphic I/O field Yes
HTML browser No
Channel diagnostics Yes
Combo box Yes
Check box  
Circle Yes
Circular arc Yes
Circle segment Yes
Trend view Yes
Charging condition No
Illuminated pushbutton No
Line Yes
List box Yes
Media Player Yes
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 WinCC Runtime Professional
Alarm view, 
Alarm window

Yes

Alarm indicator No
Polygon Yes
Polyline Yes
Rectangle Yes
Recipe view Yes
Round button Yes
Pipe Yes
Pipe bends Yes
Switch No
Button Yes
Slider Yes
Sm@rtClient view No
Disk space view Yes
Status/Force No
Symbol library No
Symbolic I/O field Yes
System diagnostics display No
System diagnostics window No
Text field Yes
T piece Yes
Clock Yes
Connector Yes
Value table Yes
Effective range name No
Effective range name (RFID) No
Effective range signal No
WLAN reception No
Gauge Yes
Zone name No
Zone signal No

See also
Objects for Basic Panels (Page 817)
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9.1.8.2 Objects

Bar

Application  
The tags are displayed graphically using the "Bar" object. The bar graph can be labeled with 
a scale of values.

Layout  
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Color transition: Specifies the change in color display when limit values are exceeded.

● Displaying the limit lines / limit markers: Shows the configured limit as a line or marker.

● Define bar segments: Defines the gradations on the bar scale.

● Define scale gradation: Defines the subdivisions, scale markings and intervals of a bar 
scale.

Color transition   
You define how the color change is represented in "Properties > Properties > Appearance" in 
the Inspector window.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segment by segment representation, you visualize, for example, which 
limits are exceeded by the displayed value.

"Entire bar" If a particular limit was reached, the entire bar changes color.

Displaying limit lines and limit markers   
You display the configured limit in the bar as a line or marking in Runtime using the "Lines" 
and "Markings" property:

1. In the Inspector window, select "Properties > Properties > Appearance":

2. Activate "Lines" and "Markings".

Define bar segments  
Use the "Subdivisions" property to define the number of segments into which the bar is divided 
by the main gradations on the scale. 

Use the "Interval" property to divide the distance between the main gradations. The value 
appears as the difference in value between two adjacent main gradations:
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1. In the Inspector window, select "Properties > Properties > Scales":

2. Activate "Show scale."

3. Select the corresponding value for "Settings > Subdivisions".

4. Select the corresponding value for "Settings > Marks label".

5. Select the corresponding value for "Large interval > Interval".

See also
Device-Specific Nature of the Objects (Page 817)

Bar

Application  
The tags are displayed graphically using the "Bar" object. The bar graph can be labeled with 
a scale of values.

Layout  
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Color transition: Specifies the change in color display when limit values are exceeded.

● Displaying the limit markers: Displays the configured limit value as an arrow.

● Define bar segments: Defines the gradations on the bar scale.

● Define scale gradation: Defines the position of the zero point on a bar scale.

Color transition   
You define how the color change is represented in "Properties > Properties > Appearance" in 
the Inspector window.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segment by segment representation, you visualize, for example, which 
limits are exceeded by the displayed value.

"Entire bar" If a particular limit was reached, the entire bar changes color.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  829



Displaying the limit markers   
You display the configured limit in the bar as an arrow in Runtime using the "Selections" 
property:

1. In the Inspector window, select "Properties > Properties > Appearance":

2. Activate "Selections".

Define bar segments   
Use the "Scales" property to define the subdivisions into which the bar is divided by the main 
gradations on the scale. 

Use the "Interval" property to divide the distance between the main gradations. The value 
appears as the difference in value between two adjacent main gradations:

1. In the Inspector window, select "Properties > Properties > Scales":

2. Activate "Show scale."

3. Enter the corresponding value for "Large interval > Interval".
 

  Note

Intervals can only be changed if the "Auto-scale" option is disabled.
 

Define scale gradation   
Use the "Zero point" property to define the zero point on the bar graph scale. Enter the value 
as a percentage. The percentage relates to the distance between the end values on the scale. 
For a value of 0 %, for example, the zero point is represented at the height of the lowest value 
on the scale. The zero point can also be outside the shown area.

The "Zero point" property is only evaluated if the "Bar scaling" property is set to "Auto-scale":

1. In the Inspector window, open "Properties > Properties > Scales"

2. Activate "Auto-size".

3. Enter the required value for "Start values .> Zero point".

See also
Device-Specific Nature of the Objects (Page 817)

User view

Application 
The "User view" object is used to set up and administer users and authorizations. The user 
view is used, for example, to create new users in runtime and assign them to a user group.
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 Note

Configure only one user view at a time in one screen on the HMI devices TP 177A 6", TP 
177A 6" (Portrait), OP 73 and OP 77A. Otherwise, a corresponding error message appears 
during generation. 

 

Complex user view   
The complex or simple user view is available for administration of users and authorizations 
depending on the HMI devices.

Simple user view   

Proceed as follows to configure the appropriate user view:

1. Click "Properties > Properties > Layout > Mode" in the inspector window.

2. Select "Simple" or "Complex".

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Number of lines: Specifies the maximum number of visible entries.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in Runtime.
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Number of lines  
The number of lines in the user view displayed in Runtime is specified in the Inspector window. 
The setting for the number of lines is only effective if "Fit object to contents" is active.

1. Click "Properties > Properties > View" in the Inspector window.

2. Enter an integer value under "Number of lines".

3. In the Inspector window, select "Properties > Properties > Layout".

4. Activate "Fit object to contents."

Columns moveable  
The operator can change the sequence of columns in Runtime with the "Columns movable" 
property.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Columns moveable".

This option is only available at the complex user view.

See also
Device-Specific Nature of the Objects (Page 817)

Complex user view (Page 1714)

Simple user view (Page 1713)

Creating users (Page 1698)

Managing users in the complex user view (Page 1719)

Screen window

Application
You use the "Screen window" object to represent other screens from the project in the current 
screen. You can make the object dynamic to constantly update the content of a screen window, 
for example. Customized menus and toolbars are used to add specific buttons to the screen 
window.

You can also use independent screen windows independently of the screen in question. With 
appropriate hardware equipment and support by the operating system you can also control 
multiple monitors and map processes in a more comprehensive and differentiated manner.
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Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Zoom factor: Defines the size of the embedded screen.

● Screen section: Defines the section of the embedded screen that is displayed in the screen 
window. If the embedded screen is larger than the screen window, you configure scroll bars 
for the screen window.

● Independent screen windows: Specified that the screen windows are displayed 
independently from the screen in which they were configured.

 

 Note
Nesting of screen windows

In the Engineering System, the display of nested screen windows is limited to 3. Therefore 
check whether a screen containing a further screen window is displayed in a screen window.

 

Matching the size of the embedded screen and screen window
You can match the size of the embedded screen to the size of the screen window in the 
following ways:

● You want the embedded screen to appear smaller.
Enter the required zoom factor under "Properties > Properties > General" in the Inspector 
window.

● You want to scroll to a section of the embedded screen.
In the Inspector window, activate "Properties > Properties > Layout > Scroll bar". 
The user can scroll to details of the embedded screen in Runtime.
You can move the position of the scroll bar horizontally or vertically under "Properties > 
Properties > Layout > Scroll bar position" in the Inspector window. 

● You can adapt the embedded screen to the size of the screen window, or vice versa.
Select either "Size window to screen", or "Size screen to window" in "Properties > Properties 
>" in the Inspector window.
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Define screen section
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the values for the horizontal and vertical displacement of the zero point of the screen 
display under "Offset."
The desired section is displayed in the screen window.

3. If you want to scroll from the defined section to other areas of the screen, activate 
"Properties > Properties > Appearance > Scrollbar".

Defining independent screen windows
1. Insert a screen window in the start screen.

2. Select a screen that is displayed in the screen window under "Properties > Properties > 
General > Name".

3. Select "Properties > Properties > General > Independent screen windows".

4. Select "Position and mode":

– As configured: The screen window is displayed in the configured size and at the 
configured position.

– Centered: The screen window is displayed in the configured size in a central position.

– Maximized: The screen window is adjusted to the monitor size.

5. If you are using multiple monitors select the desired monitor for the screen window under 
"Monitor number".

 

  Note

The monitor numbers refer to the number of monitors set in Microsoft Windows: "Control 
Panel > Display > Settings > Display"

 

6. Repeat steps 1 to 5 for all further independent screen windows.

Define tag prefix
Define a tag prefix to access structure instances in Runtime. The tag prefix is freely definable 
but must match the name of the structure instance.

1. Click "Properties > Properties > General > Contents" in the inspector window.

2. Enter one of the created structure instances with a period after the name under "Tag prefix", 
e.g. "Motor1.".

The "Temperature" tag is requested on an object in the screen window. If a tag prefix "Motor1." 
is assigned to the screen window, the "Motor1.Temperature" tag is requested.

 

 Note

If the variable prefix for a screen window is set, the tag prefix is prefixed to all tags contained 
in the screen to be displayed. This also applies when the request is made in a function. if a 
tag or a tag prefix is to be read, you must prefix "@NOTP::" to the tag name.
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See also
Device-Specific Nature of the Objects (Page 817)

Scroll bar

Application
The "Scroll bar" object is used to control processes. The scroll bar allows you to make stepless 
changes to values, for example. To incorporate a scroll bar into the process, dynamize the 
corresponding attribute.

Layout
In the Inspector window, you customize the settings for the object position, style and color. 
You can, in particular, adapt the following properties as required:

● Maximum value and minimum value: Specifies the top and bottom values of the scale.

● Alignment: Defines the horizontal, or vertical alignment.

Maximum value and minimum value
You define the top and bottom values of the scale in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a number under "Maximum static" and "Minimum static". If you select a tag as the 
end value of the scale, the number will be no longer available.

Define alignment
Define whether the scroll bar is aligned vertically or horizontally in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required alignment under "Style."

See also
Device-Specific Nature of the Objects (Page 817)
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Date/time field 

Application  
The "Date/time field" object shows the system time and the system date. The appearance of 
the "Date/time field" depends on the language set on the HMI device.

Layout  
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Display system time: Specifies that the system time is displayed.

● Include tag: Specifies that the time of the connected tag is displayed.

● Long date/time format: This setting defines the format displayed for the data and time.

Display system time   
The time displayed in the "Date/time field" on the HMI device is specified in the inspector 
window.

1. Click the "General" group in the inspector window.

2. Activate the "System time" option in the "Format" area.

Using tags   
The time of the interconnected tag is displayed in the date/time field.

1. Click the "General" group in the inspector window.

2. In the "Format" area, select a tag with the "DateTime" data type, e.g. an internal tag. 
Information about data types which are available for connection to other PLCs can be found 
in the documentation about the respective communication drivers.

Long date/time format   
The layout of the date and time is specified in the "Format" area under "General" in the inspector 
window.

Option Description
"Enabled" Date and time are displayed in full, e.g. "Sunday, December 31, 2000 10:59:59 

AM"
"Disabled" Date and time are displayed in short form, e.g. "12/31/2000 10:59:59 AM"
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See also
Device-Specific Nature of the Objects (Page 817)

Double T-piece

Application
You use the "Double T-piece" to reproduce a pipe junction. To reproduce a pipe system, 
connect the "Double T-piece" to other objects, e.g. pipe bend or T piece. 

Layout
Customize the object position, color and width in the Inspector view. 

See also
Device-Specific Nature of the Objects (Page 817)

Pipe (Page 908)

Pipe bends (Page 908)

T piece (Page 937)

Print job/Script diagnostics

Application   
You use the "Print job/Script diagnostics" object to show contents from the "Print jobs" and 
"Scripts" editors. Information items are transferred to the "Print job/Script diagnostics" object 

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  837



in Runtime and operation is possible. Depending on which windows content and which 
template you use, you can display a preview of the print job, for example.

Layout   
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Window content: Defines the application that is displayed in the "Print job/Script 
diagnostics" object.

● Template: Defines the template in which the window content is displayed in the "Print job/
Script diagnostics" object.

Templates for using functions     
The following templates are available for functions:

● GSC diagnostics
The "Print job/Script diagnostics" object is supplied by the function applications. It displays 
the results from the diagnostic system.

Templates for using print jobs
The following templates are available for the "Print jobs" window content:     

● All print jobs
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list.

● Shortcut menu for all jobs
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list. A shortcut menu offers the following actions:

– Print preview

– Print report
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● Jobs detailed view
The "Print job/Script diagnostics" object is supplied by the print jobs. There is a menu for 
selecting the available print jobs. Detailed information is displayed for the selected print job.

● Shortcut menu for selected jobs.
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list. 
To display print jobs in the list, select "Properties > Properties > General > Display Control 
print job/script diagnostics" in the Print Job editor. A shortcut menu offers the following 
actions:

– Print preview

– Print report

Configure window content
You define the window content of the object in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General".

2. Select the window content, e.g. "Print jobs".

Configure template
You define the template for the window content of the object in the Inspector window:

1. In the Inspector window, select "Properties > Properties > General".

2. Select a template
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Window layout in Runtime
In Runtime, the "Print Job/Script Diagnostics" object appears as a standalone window within 
a process screen. Use the attributes under "Window display" to customize the window layout 
features.

See also
Device-Specific Nature of the Objects (Page 817)

I/O field

Application  
The "I/O field" object is used to enter and display process values.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Display format: Specifies the display format in the I/O field for input and output of values.

● Hidden input: Specifies whether the input value is displayed normally or encrypted during 
input.

 

  Note
Reports

In reports, I/O fields only output data. "Output" mode is preset. Properties for configuring 
input are not available, e.g. "hidden input".
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Mode   
The response of the I/O field is specified in the Inspector window in "Properties > Properties 
> General > Type".

Mode Description
"Input" Values can only be input into the I/O field in runtime.
"Input/output" Values can be input and output in the I/O field in runtime.
"Output" The I/O field is used for the output of values only.

Layout  
The "display format" for the input and output of values is specified in "Properties > Properties 
> General > Format" in the Inspector window.

Layout  
"Binary" Input and output of values in binary form
"Date" Input and output of date information. The format depends on the language setting 

on the HMI device.
"Date/time" Input and output of date and time information. The format depends on the 

language setting on the HMI device.
"Decimal" Input and output of values in decimal form
"Hexadecimal" Input and output of values in hexadecimal form
"Time" Input and output of times. The format depends on the language setting on the HMI 

device.
"Character string" Input and output of character strings.

 

 Note
Data formats

Not all data formats are available for selection for Runtime Professional.
 

Hidden input   
In Runtime the input can be displayed normally or encrypted, for example for hidden input of 
a password. A "*" is displayed for every character during hidden input. The data format of the 
value entered cannot be recognized. 

1. In the Inspector window, select "Properties > Properties > Response":

2. Activate "Hidden input".

Avoid overlaps in output fields
If several I/O fields are configured as output fields with a transparent background in a screen, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in Runtime. In order to avoid such overlaps, set the 
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margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

See also
Device-Specific Nature of the Objects (Page 817)

Editable text field

Application
The "Editable text field" object enables you to display several lines of text in a rectangle on the 
screen. If the text is larger than the rectangle, WinCC automatically adds a scroll bar to the 
right margin. 

If you allow operation, the operator can edit the text in runtime. You can use the multiple-line 
text for the input or output of text by connecting tags. 

Layout
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Text: Defines the text for the "Editable text field".

Text 
The text for the "Editable text field" is defined in the inspector window. 

1. Click "Properties > Properties > General" in the inspector window.

2. Enter a text of any length.
For texts over several lines you can set a line break by pressing <Enter>, with the key 
combination <Shift + Enter> or the key combination <Ctrl + Enter>.

See also
Device-Specific Nature of the Objects (Page 817)
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Ellipse

Application 
The "Ellipse" is an enclosed object that can be filled with a color or pattern. 

Layout 
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Horizontal radius: Specifies the horizontal radius of the elliptical object.

● Vertical radius: Specifies the vertical radius of the elliptical object.

Horizontal radius   
The horizontal radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 under "Horizontal."

Vertical radius   
The vertical radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 at "Vertical."

See also
Device-Specific Nature of the Objects (Page 817)

Elliptical arc  (Page 844)

Ellipse segment (Page 845)
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Elliptical arc 

Application
The "Elliptical arc" is an open object. Use the "Ellipse segment" object if you want to fill the 
object with color. By default, an elliptical arc is a quarter ellipse. It can be customized as 
required.   

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:   

● Horizontal and vertical radii: Specifies the horizontal and vertical radius of the elliptical 
object.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.

Defining radii     
Define the horizontal and vertical radius of the "Elliptical arc" object in the Inspector window. 
Enter the values using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Horizontal radius" and "Vertical radius".

Define start and end angle     
Determine the length of the elliptical arc using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Angle start" and "Angle end".

Alternative procedure
You can also change the start and end points of the elliptical arc using the mouse.

1. Place the cursor on a start or end point of the elliptical arc. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross.

2. Hold down the mouse button, and drag the start or end point to the desired position.
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See also
Device-Specific Nature of the Objects (Page 817)

Ellipse (Page 843)

Ellipse segment

Application
The "Ellipse segment" is a closed object that you can fill with a color or pattern. By default, an 
ellipse segment is a quarter ellipse. It can be customized as required.     

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Horizontal and vertical radii: Specifies the horizontal and vertical radius of the elliptical 
object.

● Start and end angle: Specify where the start and end point lie on a virtual circle of 360°.

Defining radii     
Define the horizontal and vertical radius of the "Ellipse segment" object in the Inspector 
window. Enter the values using Pixels as the unit:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Horizontal radius" and "Vertical radius" in the "Arc" area.

Define start and end angle     
Determine the size of the ellipse segment using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Arc" area.
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Alternative procedure
You can also change the start and end points of the ellipse segment using the mouse.

1. Place the cursor on a start or end point of the ellipse segment. The start and end points 
are indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 817)

Ellipse (Page 843)

f(t) trend view

Application  
You use the "f(t) trend view" object to display tag values from the current process, or from the 
log in the form of trends as a function of the time. 

Layout  
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Adding and configuring trends

● Configuring a diagram

● Window settings

● Persistence

● Toolbar
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Configuring trends
1. Select the data supply for the trend under "Properties > Properties > Trends > Data source".

– "Log tags": The trend window is supplied with values from a data log.

– "User-defined": The supply for the trend window is user-defined.

– "Tags": The trend window is supplied with values of a tag.

2. Under "Data range", define whether the trend displays the values statically or if the values 
are refreshed.

– "Automatic": The displayed value range is automatically adapted to the current values:

– "Initial value / End value": You define the minimum value and maximum value for the 
value range.

3. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit.

4. Select "Properties > Properties > Time axis".

5. Configure the "Time range" of the trend display.

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

Configuring a diagram
Configure the display of several trends under "Diagram":

● Common or separate diagrams

● Common or separate axes

● Writing direction of all trends

Window settings
Under "Layout > Window", define whether the user can change the size of the window in 
runtime and can close the window. 

Persistence
Under "Properties > Properties > Security > Persistence" define how long a user's changes to 
the trend view in runtime are retained.

● "Allow persistence"
Users can change settings. Changes are retained until the next screen change.

● "Persistence until logoff"
User group changes are retained until logoff.

● "Persistence until next loading"
User group changes are retained until the project is updated on the HMI device.
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Toolbar    
You define the control elements of the f(t) trend view in Runtime under "Properties > Properties 
> Toolbar" in the Inspector window. The following control elements are available for the f(t) 
trend view:

Button Name Function ID
Online help Opens the online help. 1

Open configuration Opens the configuration dialog. 2

First data record Scroll in the log:
Shows the trend curve starting with the first logged value.

3

Previous data record Scroll in the log:
Shows the trend curve of the previous time interval.

4

Next data record Scroll in the log:
Shows the trend curve of the next time interval.

5

Last data record Scroll in the log:
Shows the trend curve up to the last logged value.

6

Show/ hide ruler Determines the coordination of a point of the trend. 7

Zoom area Increases the size of any section of the trend window. 8

Original view Switches from the magnified trend view back to the normal view 14

Tag selection Opens the dialog for selecting the log and tags. 15

Trend selection Opens the dialog for setting the visibility of trends. 16

Time range selection Opens the dialog for setting the time range displayed in the 
trend window.

17

Previous trend Displays the previous trend in the foreground 18

Next trend Displays the next trend in the foreground 19

Start/end update Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again. 

20

Print log Starts printing the trends shown in the trend window. You define 
the print job under "General > Print > Print job". 

21

Selection of the statistics area Enables you to define a time range for which static values are 
determined. Vertical lines which you use to set the time range 
are displayed in the trend window. 

22
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Button Name Function ID
Statistics window Opens a statistics window to display the minimum, maximum, 

means, and standard deviation for the selected time range and 
the selected trend. 

23

Exporting process data in 
runtime as a CSV file 

Opens the dialog for saving the trend data in CSV format. 26

The order of the buttons is fixed. Under "Hotkey" you can set up individual key assignments, 
and shortcuts for every button on the toolbar.

See also
Device-Specific Nature of the Objects (Page 817)

f(x) trend view (Page 851)

Table view (Page 933)

Value table (Page 940)

f(x) trend view

Application  
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. You can also compare the trend to a setpoint trend. 

Layout  
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Adding and configuring trends

● Configuring a diagram

● Window settings
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● Persistence

● Toolbar

Configuring trends
You create and configure trends in the Inspector window "Properties > Properties > Properties 
> Trend".

1. Select the data supply for the trend in the "Data source" column. 

– "Log tag": The trend window is supplied with values from a data log.

– "Tags": The trend view is supplied with current values from the PLC. The values are 
constantly updated.

2. Configure the area of the trend display under "Data area".

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

3. Configure the value range of the trend display under "X axis" and "Y axis".

4. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit, 
uncertain status.

Configuring a diagram
Configure the display of several trends under "Properties > Properties > Appearance":

● Common diagram or separate diagrams

● Common or separate axes

● Writing direction of all trends

Toolbar    
The control elements of the f(x) trend display are defined in the "Properties > Properties > 
Toolbar" inspector window. The following control elements are available for the f(x) trend view:

Button Name Function
Online help Opens the online help.

Configuration dialog box Opens the configuration dialog. 

Show/ hide ruler Determines the coordination of a point of the trend. 

Zoom area Increases the size of any section of the trend window.
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Button Name Function
Original view Switches from the magnified trend view back to the normal view

Trend selection Opens the dialog for setting the visibility of trends. 

Previous trend Displays the previous trend in the foreground

Next trend Displays the next trend in the foreground

Start/end update Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again. 

The order of the buttons is fixed. The operator can set up individual key assignments, and 
shortcuts for every button on the toolbar.

See also
Device-Specific Nature of the Objects (Page 817)

f(x) trend view

Application  
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. You can also compare the trend to a setpoint trend. 
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Layout  
In the Inspector window, you customize the position, geometry, style, colors and font types of 
the object. You can adapt the following properties in particular:

● Add and configure trends

● Configure a diagram

● Window settings

● Persistence

● Toolbar

Configuring trends
1. Select the data supply for the trend under "Properties > Properties > Trends > Data source".

– "Log tags": The trend window is supplied with values from a data log.

– "User-defined": The supply for the trend window is user-defined.

– "Recipe" The trend window is supplied with values from a recipe.

– "Tags": The trend window is supplied with values of a tag.

2. Configure the area of the trend display under "Data area".

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

– "Start ID" and "Number of data records": With data supply via recipes, you define the 
range by the ID of the first data record and the number of subsequent data records.

3. Configure the value range of the trend display under "X axis" and "Y axis".

– "Automatic": The displayed value range is automatically adapted to the current values.

– "Initial value / End value": You define the minimum value and maximum value for the 
value range.

4. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit, 
uncertain status.

Configuring a diagram
Configure the display of several trends under "Layout":

● Common diagram or separate diagrams

● Common or separate axes

● Writing direction of all trends
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Window settings
Under "Layout > Window", define whether the user can change the size of the window in 
runtime and can close the window. 

Persistence
Under "Security > Persistence" define how long a user's changes to the trend view in runtime 
are retained.

● "Allow persistence"
Users can change settings. Changes are retained until the next screen change.

● "Persistence until logoff"
User group changes are retained until logoff.

● "Persistence until next loading"
User group changes are retained until the project is updated on the HMI device.

Toolbar    
You define the control elements of the f(x) trend view in Runtime under "Properties > Toolbar" 
in the Inspector window. The following control elements are available for the f(x) trend view:

Button Name Function
Online help Opens the online help.

Configuration dialog box Opens the configuration dialog. 

Show/hide ruler Determines the coordinates of a point of the trend. 

Zoom area Increases the size of any section of the trend window.

Original view Switches from the magnified trend view back to the normal view

Trend selection Opens the dialog for setting the visibility of trends. 

Previous trend Displays the previous trend in the foreground.

Next trend Displays the next trend in the foreground.

Start/end update Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again. 

The order of the buttons is fixed. The operator can set up individual key assignments, and 
shortcuts for every button on the toolbar.
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See also
Device-Specific Nature of the Objects (Page 817)

f(t) trend view (Page 846)

Table view (Page 933)

Value table (Page 940)

Graphic view

Application  
The "Graphic view" object is used to display graphics.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

● Transparent color: Specify whether or not the transparent color is used for the graphic.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic that you wish to insert.
The graphic preview is shown in the right pane.

3. Click "Apply" to insert the graphic in the Graphic view .
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Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Select the required size adjustment for the graphic.

Transparent color   
This property defines whether the transparent color is used for the graphic to be displayed. 

1. Click "Properties > Properties > Appearance" in the inspector window:

2. Activate "Background > Transparent".

3. Select a transparent color.
 

  Note

When using bitmaps in WinCC screens the "Transparent color" setting demands a high 
character performance in the layout on the panel. Visualization performance is enhanced 
by disabling the "Transparent" setting in the properties of the relevant display object. This 
restriction applies in particular when bitmaps are used as background image.  

 

  Note
Basic Panels

The "Transparent" property is not available for Basic Panels.
 

See also
Device-Specific Nature of the Objects (Page 817)

Storing an external image in the graphics library. (Page 690)

Options for Editing Objects (Page 666)

Overview of objects (Page 657)

Graphic I/O field

Application  
The "Graphic I/O field" object can be used to configure a list for display and selection of graphic 
files.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Scroll bar type: Specifies the graphic layout of the scroll bar.
 

 Note
Basic Panels

The scroll bar is not available for Basic Panels.
 

 Note
Reports

Graphic I/O fields output exclusively graphics in reports. "Output" mode is preset. Properties 
for configuring the selection of graphics are not available, e.g. "scroll bar".

 

Mode  
The response of the "Graphic I/O field" object is specified under "Properties > Properties > 
General > Type > Mode" in the Inspector window.

Mode Description
"Input" The "Graphic I/O field" object is only used to select graphics.
"Input/output" The "Graphic I/O field" object is used to select and display graphics.
"Output" The "Graphic I/O field" object is used to display graphics only.
"Two states" The "Graphic I/O field" object is only used to display graphics and can have a 

maximum of two states.
You use no graphics list but insert one graphic each for the "ON" and "OFF" 
state.

Stretch graphic  
Whether a graphic displayed in a graphic I/O field is stretched to the size of the view in runtime 
is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required size adjustment for the graphic.
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Scroll bar type
The response for the graphic representation of the scroll bar is specified under "Properties > 
Properties > Appearance > Scroll Bar > Type" in the Inspector window.

Type Description
"Permanent" The scroll bar is always visible.
"No scrollbar" The scroll bar is not visible.
"Visible after clicking" The scroll bar is made visible by a mouse click.

See also
Print job/Script diagnostics (Page 837)

Device-Specific Nature of the Objects (Page 817)

Symbolic I/O field (Page 925)

Graphic I/O field

Application  
With the "Graphic I/O field" object you configure a graphics list which is used to display and 
select graphic files.

Layout  
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in runtime.

● Fit to size: Specifies the ratio of the display window and the embedded graphic.

Mode  
The response of the "Graphic I/O field" object is specified in the Inspector window in "Properties 
> Properties > General > Mode".

Mode Description
"Output" The "Graphic I/O field" object is used to display graphics only.
"Two states" The "Graphic I/O field" object is only used to display graphics and can have a 

maximum of two states.
You use no graphics list but insert one graphic each for the "ON" and "OFF" 
state.
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Fit to size  
The ratio for the graphic representation in the display window is specified under "Properties > 
Properties > Layout > Fit to size" in the Inspector window.

Sizing type Description
"Fit object size to content" The display window is adapted automatically to the size of the 

graphic.
"Fit content to object size" Adjust the graphic to the display window size.

See also
Device-Specific Nature of the Objects (Page 817)

Symbolic I/O field (Page 926)

Handwheel

Application   
The object "Handwheel" is a control element for some SIMATIC Mobile Panels. You can enter 
incremental values in Runtime using the "HandWheel" object. 

Layout   
You can set the following property in the Inspector window:

● Tag: Specifies the tags to which the "HandWheel" object is linked.

Tag     

Global assignment
The "Tag" property is specified in the template for the global assignment of the "HandWheel" 
object. There is only one template for each HMI device. 

1. In the Inspector window, select "Properties > Properties > General":

2. Select a tag from the selection list under "Settings > Tag".
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Local assignment
The "HandWheel" object is assigned to another tag. To do so you configure a function that 
assigns the tag to the handwheel in Runtime.

Example for configuration to a button:

1. Open the screen in which the "HandWheel" object is assigned to another tag.

2. Drag the "Button" object from the toolbox to the screen. Select the button on your screen.

3. Click "Properties > Events > Click" in the Inspector window.

4. The "Function list" dialog box opens. Click the first line of the function list. The list of system 
functions and scripts available in the project appears.

5. Select the system function "SetTagToHandWheel" from the "Other functions" group. Select 
a tag from the combo box at "Value".

 

  Note

The Mobile Panel may ignore the change of the value in the PLC made at another location 
while the handwheel is being operated. The value is the PLC is overwritten again. 

 

See also
Device-Specific Nature of the Objects (Page 817)

Illuminated pushbutton (Page 874)

Help indicator

Application  
The object "help indicator" is available for the HMI devices OP 73 and KP300 Basic. If a a 
tooltip exists for the selected object, the help indicator is displayed during runtime. If a tooltip 
was configured for the opened screen, the help indicator always remains visible.

You configure the object "help indicator" exclusively in the global screen.
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Layout
You can adapt the following properties in the Inspector window:

● Position: Determines the position of the object "Help indicator."

Position
You can use this property to set the position of the object "Help indicator." 

1. Select the object "Help indicator" in the template.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Enter a value for X and Y. You can also use the cursor keys to position the selected object.

If you have configured a screen object at this position, the visible help indicator covers the 
screen object. The help indicator is covered only by incoming system alarms and dialogs. 

See also
Device-Specific Nature of the Objects (Page 817)

HTML browser

Application   
The "HTML browser" object is designed for the visualization of simple HTML pages. This 
function allows you to draw up machine-specific descriptions which are stored centrally and 
which can then be displayed from different HMI devices.
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 Note

Changing the functionality of the HTML browser to that of a file explorer, for example by one 
of the following methods, is not authorized in the context of WinCC:
● Entering a folder or drive, for example "\" or "C:" or
● Connecting to an FTP server, for example "ftp://"

One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     

When configuring, ensure that the operator can only enter valid Internet addresses, for 
example via symbolic I/O fields. Configure a password-protected input for service purposes.

 

Layout   
Customize the object position and size in the Inspector window. You customize the following 
property in particular:

● Address: Specifies which Internet address is opened in the HTML browser.

Address   
The Internet address is specified in the Inspector window under "URL" in the "Window" area 
under "General". 

Basic procedure
1. Create an internal tag of the "String" data type, for example InternetAddress, in the "Tag" 

editor.

2. Insert the "HTML browser" object in the screen in the "Screens" editor.

3. In the Inspector window, select "Properties > Properties > General".

4. At "Tag for the URL" select the "InternetAddress" tag from the selection list.
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5. Insert an I/O field in the screen in the "Screens" editor.

6. Select the "InternetAddress" tag at "URL tag" from the selection list under "Properties > 
Properties > General" in the Inspector window.

When the operator enters or activates an address, the HTML browser opens the relevant page.

Control elements       
Control elements are configured buttons in the process screen or softkeys on the HMI device. 

The "HTML browser" object does not have its own operator control components. Assign the 
system functions used to control the "HTML browser" object to your configured control 
elements, such as buttons.

1. For example, drag the "Button" object to the screen from the toolbox.

2. Input a text of any length or select a graphic, for example Update.

3. In the Inspector window, select "Properties > Events > Click". 
The "Function list" dialog box is opened.

4. The system functions for controlling the "HTML browser" object can be found in the list of 
system functions in the "Keyboard online operation for screen objects". 
Select a function from the list, for example HTMLBrowserRefresh.

5. Select the object name of the HTML browser in which the command will be executed from 
the "Screen object" list.

Remarks
The functional scope of the HTML browser is limited in comparison to the Internet Explorer:

● The HTML browser will only show pure HTML pages. VBScript, Java, JavaScript and 
Flashund ActiveX controls are not supported. Set up the HTML pages for display in the 
HTML browser by using a text editor or using a simple HTML editor.

● Links to embedded files, for example *.pdf or *.xls, are not supported.

● Queries and dialogs that are conducted during the access of, for example protected pages 
are not supported. When accessing protected pages enter your user name and password 
in the URL: <http://User_Name:Password@Server_Name> (for example, "http://
Admin:Admin123@192.168.0.199").
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See also
Device-Specific Nature of the Objects (Page 817)

HTML browser

Application   
The "HTML browser" object is designed for the visualization of simple HTML pages. This 
function allows you to draw up machine-specific descriptions which are stored centrally and 
which can then be displayed from different HMI devices.

 

 Note

Changing the functionality of the HTML browser to that of a file explorer, for example by one 
of the following methods, is not authorized in the context of WinCC:
● Entering a folder or drive, for example "\" or "C:" or
● Connecting to an FTP server, for example "ftp://"

One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     

When configuring, ensure that the operator can only enter valid Internet addresses, for 
example via symbolic I/O fields. Configure a password-protected input for service purposes.

 

Layout   
Customize the object position and size in the Inspector window. You customize the following 
property in particular:

● Address: Specifies which Internet address is opened in the HTML browser.

Address   
The Internet address is specified in the Inspector window under "URL" in the "Window" area 
under "General". 
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Basic procedure
1. Create an internal tag of the "String" data type, for example InternetAddress, in the "Tag" 

editor.

2. Insert the "HTML browser" object in the screen in the "Screens" editor.

3. In the Inspector window, select "Properties > Properties > General".

4. At "Tag for the URL" select the "InternetAddress" tag from the selection list.

5. Insert an I/O field in the screen in the "Screens" editor.

6. Select the "InternetAddress" tag at "URL tag" from the selection list under "Properties > 
Properties > General" in the Inspector window.

When the operator enters or activates an address, the HTML browser opens the relevant page.

Remarks
The functional scope of the HTML browser is limited in comparison to the Internet Explorer:

● The HTML browser will only show pure HTML pages. VBScript, Java, JavaScript, Flash 
and ActiveX controls are not supported. Set up the HTML pages for display in the HTML 
browser by using a text editor or using a simple HTML editor.

● Links to embedded files, for example *.pdf or *.xls, are not supported.

● Queries and dialogs that are conducted during the access of, for example protected pages 
are not supported. When accessing protected pages enter your user name and password 
in the URL: <http://User_Name:Password@Server_Name> (for example, "http://
Admin:Admin123@192.168.0.199").

See also
Device-Specific Nature of the Objects (Page 817)
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Channel diagnostics

Application
You use the "Channel Diagnostics" object to monitor the active connections in Runtime. The 
"Channel Diagnostics" object allows you to output the following status, and diagnostic 
information for the channel units:

● Output status/statistical information about the connections in Runtime

● Text output to a logbook file for fault analysis, and troubleshooting

● Text output to a trace file to help the Hotline in pinpointing the cause of connection problems

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. 

Overview of the status messages
The following statuses are displayed in the "Channel Diagnostics" object:

● Channel / connection ready without restriction

● Channel / connection ready with some restrictions

● No information available about connection status

● Channel / connection failed

Check channel and connection
Use the "Channel Diagnostics" object to output the log, and trace files. To do this, activate 
your project. The following is displayed on the left of the Channels/Connections tab in the 
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"Channel Diagnostics" object: Status information about all installed channels, and their 
connections.

1. Check the icons in front of the channel called "System Info", and its connection. If the status 
of a channel, and connection are OK, a green tick is displayed in front the associated entry. 
The meaning of the individual icons is explained in the "Overview of the Status Messages" 
table.

2. If there is no green check mark in front of the channel name and connection, select the 
connection in the left-hand window.

3. In the right-hand window, check the values of the "Address Error", Size Error", and "Type 
Error" counters. These values indicate the errors detected.

4. Check the channel-specific log file. Open the log file from the "Siemens\Automation
\SCADA_2007\WinCC\Diagnose" folder in a text editor.

5. Check the latest entries with the "ERROR" flag. For more information on this topic, refer to 
"Description of the Log File Entries".

6. Activate the trace function.
Contact Customer Support if you are unable to locate the error, even after checking the log 
file. 

See also
Device-Specific Nature of the Objects (Page 817)

Combo box

Application
You use the "Combo box" object to present and select entries in a drop-down menu. You 
activate an entry by default so that the operator only changes the preset value if necessary. 
To incorporate combo boxes into the process, dynamize the corresponding properties.

Layout
In the Inspector window, you customize the position, style, colors and font type settings of the 
object. You can adapt the following properties in particular:

● Number of entries: Defines the number of combo boxes.

● Selection of entries: Defines which entry is displayed as activated by default.
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Defining the number of entries
1. In the Inspector window, select "Properties > Properties > General".

2. Define the required number of list boxes using the "Fields" property in the "Number" area.

At the same time, the value of the "Number" attribute specifies the upper limit for the "Index" 
property under "Label." Changing the value can have the following effects:

Changing the number
New fields are added under the field with the highest value for the "Index" property if you 
increase the number of entries. You can change the default label for the new field using the 
"Text" property under "Label."

All fields for which the value of the "Index" property is higher than the new number will be 
deleted if you reduce the number of entries.

See also
Device-Specific Nature of the Objects (Page 817)

List box (Page 879)

Check box 

Application
You use the "Check box" object to present and select multiple options. You activate check 
boxes by default so that the operator only changes the preset value if necessary. The operator 
can select several options in Runtime. To incorporate a check box into the process, dynamize 
the corresponding properties.

Layout
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Number of check boxes: Defines the number of options.

● Check box selection: Defines which options are displayed as activated by default.
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Define number of check boxes
1. In the Inspector window, select "Properties > Properties > General":

2. Define the desired number of check boxes under "Label > Check boxes".

At the same time, the value of the attribute specifies the upper limit for the "Index" property 
under "Label." Changing the value can have the following effects:

● Increases the number
New fields are added under the field with the highest value of the "Index" property. You can 
change the default label for the new field using the "Text" property under "Label."

● Reduces the number
All fields for which the value of the "Index" property is greater than the new number are 
deleted.

Define the default setting of the check boxes
In the table under "Properties > Properties > General > Presetting enabled " you define which 
options are to be shown activated in a check box list. You can activate multiple options.

Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit 
must have the value "1". The 32-bit word contains the information for all options of the check 
box list. The value of the "Presetting enabled" property is specified in hexadecimal format. 

See also
Device-Specific Nature of the Objects (Page 817)

Option buttons (Page 896)

Circle

Application
The "Circle" object is a closed object which can be filled with a color or pattern.
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Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Radius: Specifies the size of the circle.

Radius
The radius of the "Circle" object is specified in the Inspector window. The value is entered in 
pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 in the "Radius" area.

See also
Device-Specific Nature of the Objects (Page 817)

Circular arc (Page 869)

Circle segment (Page 870)

Circular arc

Application
The "Circular arc" is an open object. Use the "Circle segment" object if you want to fill the object 
with color. By default, a circular arc is a quarter circle. It can be customized as required.

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Radius: Define the size of the circular arc.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.
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Defining the radius  
Define the horizontal, and the vertical radius of the "Circular arc" object in the Inspector window. 
Enter the values using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Radius" in the "Arc" area.

Define start and end angle   
Determine the length of the circular arc using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Radii" area.

Alternative procedure
You can also change the start and end points of the circular arc using the mouse.

1. Place the cursor on a start or end point of the circular arc. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 817)

Circle (Page 868)

Circle segment (Page 870)

Circle segment

Application
The "Circle segment" is a closed object that you can fill with a color or pattern. By default, a 
circle segment is a quarter circle. It can be customized as required.
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Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Radius: Define the size of the circle segment.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.

Radius  
You define the radius of the "Circle segment" object in the Inspector window. Enter the value 
using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Radius" in the "Arc" area.

Define start and end angle   
Determine the size of the circle segment using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Radii" area.

Alternative procedure
You can also change the start and end points of the circle segment using the mouse.

1. Place the cursor on a start or end point of the circle segment. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 817)

Circle (Page 868)

Circular arc (Page 869)
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Trend view

Application   
The trend view is meant for the graphical representation of tag values from the current process 
or from a log in form of trends.

Layout   
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Display value table, ruler and grid: Specifies whether a value table, a ruler or a grid is 
displayed in addition to the coordinate system to improve legibility.

● Toolbars: Defines the display of the control elements.

Display value table, ruler and grid
For improved legibility a value table, a ruler and a grid can be displayed in Runtime.

1. Activate "Properties > Properties > Appearance > Show ruler".

2. Activate "Properties > Properties > Table > Show table".

3. Activate "Properties > Properties > Table > Show grid".

Toolbars     
The layout of the control elements is defined in the "Properties > Properties > Toolbar" 
inspector window. 

 

 Note
Basic Panels

As archiving is not possible for Basic Panels, the control elements are not available.
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Toolbar button Brief description Description
"Go to start" Scrolls back to the beginning of the trend recording. 

The start values with which the trend recording started 
are displayed. 

"Zoom in" Zooms into the displayed time section.

"Zoom out" Zooms out of the displayed time section.
"Ruler backward" Moves the ruler back.
"Ruler forward" Moves the ruler forward.
"Backward" Scrolls back one display width.
"Forward" Scrolls forward one display width.
"Ruler" Shows or hides the ruler. The ruler displays the X-

value associated with a Y-value.
"Start/stop" Stops trend recording or continues trend recording.

Configuration behavior

Displaying column headers
The layout of the table in the trend view depends on the view settings in the Control Panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Consistency test
If warnings or errors are displayed in the output window during a consistency check in 
connection with trend views, clicking "Go to Error/Tag" on the shortcut menu will not always 
take you to the exact error position. In some cases only the trend view is shown as cause of 
error.

Adding, configuring, and removing trends
The trends of the trend view are managed in the Inspector window under "Properties > 
Properties > Trend." You can copy trends between different trend views. 

See also
Device-Specific Nature of the Objects (Page 817)

Configuring trend displays for values from the PLC (Page 1176)

Trends (Page 1171)

Creating trends for the trend window. (Page 1193)
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Charging status

Application
The object "Charging condition" is a control element for some SIMATIC Mobile Panels. The 
"Charging condition" object indicates the charging status of the battery. Charge the battery in 
good time. Alternatively, you can replace the battery with a spare battery.     

Layout

Symbol Description Charging condition
Battery is charged >20 %

Battery must be charged <20 % and
>6 %

Battery is weak < 6 %

Operation
The object is for display only and cannot be controlled by the operator.   

See also
Device-Specific Nature of the Objects (Page 817)

Effective range name (Page 942)

Effective range name (RFID) (Page 944)

Effective range signal (Page 946)

WLAN reception (Page 947)

Zone name  (Page 951)

Zone signal (Page 952)

Illuminated pushbutton

Application  
The object "Illuminated pushbutton" is a control element for some SIMATIC Mobile Panels. 
The LEDs can be activated by the PLC. The illuminated LED signals the operator in Runtime 
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that the illuminated pushbutton has to be pressed. The illuminated pushbutton is configured 
in the global screen.

Layout  
You can adapt the following properties in the Inspector window:

● Tag: Specifies the tag in which the status of the illuminated pushbutton is written.

● LED assignment: Specifies the assignment of the LED to the bit in the LED tag.

Tag   
The "Tag" property is used to specify the global assignment of the "Illuminated pushbutton" 
object in the global screen. 

 

 Note
Information for configuring

The current status of the illuminated pushbutton is written to the tag when Runtime is started 
and whenever the button is pressed. This may cause inconsistencies between the status of 
the illuminated pushbutton and the illuminated pushbutton tags.
1. If the tag has a connection to the PLC, the current value is transferred from the PLC to 

the tag after establishment of communication. The tag that contains the current status of 
the key is overwritten by this process. The illuminated pushbutton tag may therefore no 
longer reflect the current value of the illuminated pushbutton, for example if the Mobile 
Panel is switched off while the illuminated pushbutton is pressed.

2. If the illuminated pushbutton is pushed before communication to the PLC could be 
established (for example after a device start-up), it may not be possible to send the value 
of the illuminated pushbutton tag to the PLC. In this case the value of the tag in the PLC 
is different from the current status of the key.

Carry out the following configuration steps so that the illuminated pushbutton always reflects 
the actual state.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Open the "HMI tags" editor and create three tags.

– Internal tag: Pushbutton_State

– External tag: BufferTag

– External tag: Pushbutton_PLC

3. Open the Inspector window of the "Pushbutton_State" tag.

4. In the Inspector window, select "Properties > Events > Value change". Click the first line of 
the function list. The list opens, showing the system functions available in the project.

5. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

The value of the "Pushbutton_PLC" tag is written to the PLC with the "Pushbutton_PLC" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Pushbutton_PLC" tag from the PLC. The "BufferTag" is 
required to transfer the current position of the pushbutton to the PLC.
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6. Open the Inspector window of the "BufferTag" tag.

7. In the Inspector window, select "Properties > Events > Value change".

8. Click the first line of the function list. The list opens, showing the system functions available 
in the project.

9. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

After establishing communication the current value is written to the "BufferTag" from the 
PLC. The "SetTag" system function is executed by the value change in the auxiliary tag. 
The system function re-allocates the value of the "Pushbutton_State" tag to the 
"Pushbutton_PLC" tag.

10.Open the global screen in the "Screen navigation" editor.

11.Select the illuminated key on the global screen.

12.Select the tag "Pushbutton_State" in "Properties > Properties > General > Settings >Tag" 
in the Inspector window.
If you press the illuminated pushbutton, the value is written to the "Pushbutton_PLC" tag.

LED assignment
To actuate the LED an LED tag or an array tag must be set up in the PLC and specified as an 
LED tag during configuration. The LED tag is specified at "LED tag" in the "Settings" area in 
the "General" group. With "LED bit" the allocated bit is given. When the bit is set the following 
states of the LED can be realized in runtime.

Bit n+1 Bit n LED function
0 0 Off
0 1 Fast flash
1 0 Slow flash
1 1 On permanently
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See also
Device-Specific Nature of the Objects (Page 817)

Handwheel (Page 858)

Line

Application  
The "Line" object is an open object. The line length and gradient slope are defined by the height 
and width of the rectangle enclosing the object. 

Layout  
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line style

● Line start and end

Line style 
The representation of the line is specified under "Properties > Properties > Appearance" in the 
Inspector window. The line is shown without interruption if you select "Solid", for example.

 

 Note

The line styles available depend on the selected HMI device.
 

Line start and end     
The start and end points of the line are specified under "Properties > Properties > Appearance 
> Line ends" in the Inspector window. 

Use arrow point, for example, as start and end point. The available start and end points depend 
on the device.

See also
Device-Specific Nature of the Objects (Page 817)
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List box

Application  
You use the "List box" object to present and select multiple list entries. You activate list entries 
by default so that the operator only changes the preset entry if necessary. If the list box is 
larger than the selection rectangle, WinCC automatically adds a scroll bar to the right margin.

To incorporate list fields into the process, dynamize the corresponding properties.

Layout  
In the Inspector window, you customize the position, style, colors and font type settings of the 
object. You can adapt the following properties in particular:

● Number of entries: Defines the number of list entries.

● Selection of entries: Defines which entry is displayed as activated by default.

Defining the number of entries
1. In the Inspector window, select "Properties > Properties > General".

2. Define the desired number of list entries under "Entries".

At the same time, the value of the "Entries" attribute specifies the upper limit for the "Index" 
property under "Label." Changing the value can have the following effects:

Changing the number
New fields are added under the field with the highest value for the "Index" property if you 
increase the number of entries. You can change the default label for the new field using the 
"Text" property under "Label."

All fields for which the value of the "Index" property is higher than the new number will be 
deleted if you reduce the number of entries.

Specifying the default setting of the list boxes
Specify which list entry is displayed as active with "Properties > Properties > General > 
Presetting enabled".

Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit 
must have the value "1". The 32-bit word contains the information for all texts of the list of list 
boxes. The value of the "Selected fields" property is given in hexadecimal notation. 
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See also
Device-Specific Nature of the Objects (Page 817)

Combo box (Page 866)

Media Player

Application   
The Media Player is used in Runtime to play back video or audio files.

The Media Player is only available for the following devices:

● MP 377

● Comfort Panels

Layout   
You can set the following properties in the Inspector window:

● Display status bar: Determines whether to display the status bar.

● Display control elements: specifies the control elements during runtime.

● Show seek: establishes, whether a slider is available for the operation.

Control elements   
The control elements that can be used to control the Media Player in Runtime are specified in 
the Inspector window under "Properties > Properties > Appearance > Elements". 
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Supported file formats
The following audio formats are supported by Media Player:

● Moving Picture Experts Group standard 1, Layer 1,2, 3 (.mpa, .mp2, .mp3)

● Windows Media Audio (.wma)

● Waveform Audio (.wav)

The following video formats are supported by Media Player:

● Moving Picture Experts Group standard 1 (.mpg, .mpeg, .mpv, .mpe)

● Advanced Streaming Format (.asf)

● Windows Media Video Format (.wmv)

● Audio-Video Interleaved (.avi)
 

 Note

Media Player does not support the creation and management of favorites. If you create 
favorites before closing the Media Player, they will not reappear when you open it again. 

 

See also
Device-Specific Nature of the Objects (Page 817)

Alarm view

Application       
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The following 
screen contains an alarm view with no content:

Complex alarm view       
The complex or simple alarm view is available for editing alarms depending on the HMI devices. 
The figure below shows a complex alarm view:
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Simple alarm view       
The following screen contains a simple alarm view:

Proceed as follows to configure the appropriate alarm view:

1. Click "Properties > Properties > Layout > Mode" in the inspector window.

2. Select "Simple" or "Complex".
 

  Note

In the Engineering System you can dynamically control the visibility of an object, for 
example, in the "Animations" tab of the Inspector window. In Runtime, the "Simple alarm 
view" does not support animations. If you have configured an animation and, for example, 
wish to perform a consistency check of the project, then an error alarm is issued in the 
Output window.

 

Alarm line       
The alarm line allows display of the most current pending alarm in Runtime. The following 
figure shows an alarm line:

How to configure the alarm line: 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "Mode > Alarm line".
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Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. 

 

 Note

The fonts available for selection depend on the "Language and fonts" you have configured 
in the device settings.

 

You can adapt the following properties in particular:

● Control elements: Defines the operator controls of the alarm view.

● Alarm classes: This setting defines which alarm classes are displayed in the alarm view.

● Columns: Specifies the displayed columns in Runtime.

● Sequence of columns: Specifies whether the sequence of columns can be changed in 
Runtime.

● Identification of alarm classes: To be able to distinguish various alarm classes, they are 
identified in the first column of the alarm view.

● Filter: Defines that only alarms that contain a specific character string will be displayed in 
the alarm text.

● Enable sorting: Specifies whether the messages can be sorted in runtime by date and time.

● Defining display area This setting specifies from which date on alarms are displayed in the 
alarm view.

 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in Runtime, and then by when the alarm occurred.

 

Control elements     
The control elements that can be used to control the alarm view in Runtime are specified in 
the Inspector window under "Properties > Properties > Display > Settings". The following table 
shows the control elements in the alarm view, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" Switches to the screen containing information about the error that 
has occurred.
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Select alarm classes
1. Click "Properties > Properties > General" in the Inspector window.

2. Under "Alarm classes" activate the alarm classes to be displayed in the alarm view in 
Runtime .

Access protection in Runtime
Configure access protection in the "Properties > Security" group in the properties of the alarm 
view. If a logged-on user has the required authorization, he can acknowledge and edit alarms 
using the operator controls in the alarm view. If the logged-in user does not have the required 
authorization, or if no user is logged in, using the "Acknowledge" or "Edit" buttons or double-
clicking an alarm line opens the login dialog.

Define columns     
Define the columns to be displayed in the alarm view in Runtime in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate the columns that are to be displayed in Runtime under "Columns".

Sequence of columns
If this property is enabled, the column sequence in the alarm view can be changed in Runtime.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Column order".

Enable sorting     
If this property is enabled, the alarms displayed in the alarm view in Runtime can be sorted by 
date and time.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Sorting by date/time possible".

Filtering alarms
This property is used to define that only alarms that contain a configured string will be displayed 
in the alarm text in runtime for the extended alarm view.

1. In the Inspector window, select "Properties > Properties > Filter.

2. Enter the required term for filtering in the field "Filter string".
Alternatively, you configure a filter tag using the field "Filter tag". The contents of the filter 
tag serve as the filter criterion in runtime.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
884 System Manual, 08/2011,  



Identify alarm classes             
An icon is displayed in the first column of the alarm view. This symbol allows the alarm to be 
allocated to an alarm class.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Columns > Alarm class".

3. Open the "Alarms" editor, and click the "Alarm Classes" tab.

4. Specify an icon for use to identify the alarms of this alarm class for an alarm class in the 
"Display name" column.

 

  Note

The "alarm view" object cannot be grouped. 
 

Defining display area
You select a tag which defines the time from which alarms should be displayed. The following 
data types are permitted:

● External tags: Date, Date_and_Time, Time_of_Day

● Internal Tags: DateTime

To define the display area, proceed as follows:

1. Click "Properties > Properties > Display" in the Inspector window.

2. Define the tag in which the time is specified under "Control tag for the display area".
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Configuration behavior

Displaying column headers
The layout of the alarm view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance tab" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Displaying the buttons for operation
The simple alarm view in the HMI devices OP 73, OP 77A and TP 177A has a button which 
displays the alarm text in its own window. This button is not shown during configuration.

The display of the buttons for using the simple alarm view depends on the configured size. 
You should check on the HMI device whether all necessary buttons are available.

See also
Device-Specific Nature of the Objects (Page 817)

Alarm window (Page 892)

Alarm indicator  (Page 894)
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Alarm view

Application  
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 

Layout  
In the Inspector window, you customize the position, shape, style, color and font type of the 
object. You can adapt the following properties in particular:

● Control elements: Defines the operator controls of the alarm view.

● Status bar: Defines the elements in the status bar.

● Time base: Defines the time basis used to output the alarms.

● AutoScroll: Defines whether it is always the latest alarm that is selected in the alarm view.

● Text format: Defines the font and font size.

● Sorting: Defines whether and how the alarms can be sorted in Runtime.

● Table: Defines the properties of the table in the alarm view.

● Loop-In-Alarm: Defines whether double-clicking an alarm triggers the configured screen 
change.

 

  Note

The "alarm view" object cannot be grouped. 

You only configure a script at the "Incoming" event
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Configuring output of alarms   
● Selection of displays and filters: Defines which alarms are displayed in this alarm view.

● Alarm statistics: Activates the display of a statistical overview for the display duration and 
frequency of the alarms.

● Print: This setting defines which print job is used for the alarm view.

Control elements   
You define the control elements of the alarm view in Runtime, and their operator authorizations, 
under "Properties > Properties > Toolbar" in the inspector window. The following control 
elements are available for the alarm view:

Button Function
Display "Current alarms" Shows the currently active alarms.

Display "Historical alarm 
list" (short-term)

Shows the logged and currently active alarms. 

Display "Historical alarm 
list" (long-term)

Shows the logged alarms. 

Display "Locked alarms" Shows all locked alarms in the system.

Display "Alarm statistics" Displays a statistical overview for the display duration and 
frequency of the alarms.

"Alarm annunciator 
acknowledgment"

Acknowledges a visual, or audible signaling device.

"Single acknowledgment" Acknowledges an individual alarm.

"Group acknowledgment" Acknowledges all active visible alarms in the alarm view that 
require acknowledgment, unless they are subject to single 
acknowledgment.

"Autoscroll" Defines whether it is always the latest alarm that is selected in 
the alarm view. The visible area of the alarm view moves, if 
necessary. 
You can only select individual alarms if "Autoscroll" is not active.

"Filter" Opens a dialog for filtering alarms in the alarm view. Even 
alarms that are not displayed in the filtered view will be logged.

"Display Options" dialog Opens a dialog for defining which alarms are displayed in the 
alarm view. 
If the "All alarms" option is selected, the alarm view displays 
both hidden, and visible alarms.
If the "Visible alarms" option is activated, the alarm view 
contains only visible alarms.
If the "Hidden alarms" option is activated, the alarm view 
contains only hidden alarms.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
888 System Manual, 08/2011,  



Button Function
"Lock dialog" Opens a dialog for locking alarms. Any alarms that meet these 

criteria are neither displayed, nor logged.

"Print alarm report" Prints the alarm report that is configured for the alarm view.

"Print current view" Starts printing the alarms displayed in the alarm view. 

"Emergency 
acknowledgment"

Applies emergency acknowledgment to an alarm that requires 
acknowledgment. The acknowledgment bit for an alarm is sent 
directly to the AS, even if the alarm is not active.

"First alarm" Selects the first of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

"Last alarm" Selects the last of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

"Next alarm" Selects the next alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if necessary. 
This button can only be used if the "Autoscroll" function is 
disabled.

"Previous alarm" Selects the previous alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if necessary. 
This button can only be used if the "Autoscroll" function is 
disabled.

"Infotext dialog" Opens a dialog to display a tooltip.

"Comment dialog" Opens a text editor where you can enter comments.
This button is not available in the alarm view unless the 
"Historical alarm list (long-term)" display is displayed. 

"Loop-In-Alarm" If a screen change is configured, the display switches to a 
screen containing information about the alarm. 

"Unlock alarm" Unlocks an alarm in the display "Locked alarms."

"Lock alarm" Locks an alarm in the current alarm list, and in the alarm log 
lists. The alarm is added to the display "Locked alarms."

"Sort dialog" Opens a dialog for setting user-defined sort criteria for the 
displayed alarms. 

"Time base dialog" Opens a dialog for selecting the time base for the time data 
displayed in alarms.

"List of hidden alarms" Opens the display "Hidden alarms." 

"Hide alarms" Suppresses the display of an alarm in the displays "Current 
alarms", "Historical alarm list (short-term)" or "Historical alarm 
list (long-term)." The alarm is added to the display "Hidden 
alarms."

'Show alarm" Shows in the display "Hidden alarms" again an alarm in the 
displays "Current alarms", "Historical alarm list (short-term)" or 
"Historical alarm list (long-term)." The alarm is removed from 
to the display "Hidden alarms."
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Status bar  
You define which of the elements of the status bar are displayed using "Properties > Properties 
> Status bar" from the Inspector window. The following display elements are available for the 
alarm view:

Button Function
Date System date
Time of day System time

Lock is set.
A filter is activated.

List: Number of current alarms
Window: Number of alarms in the window
Ackn: Number of active alarms requiring acknowledgment

Access protection in Runtime  
Configure access protection under "Properties > Properties > Security" in the Inspector 
window. If a logged-on user has the required authorization, he can acknowledge, and edit 
alarms using the control elements in the alarm view.

The logon dialog box is displayed in the following cases:

● The logged-on user attempts to process the alarm but does not have the required 
authorization.

● A user attempts to process an alarm while no user is logged on.

Set timebase   
1. In the Inspector window, select "Properties > Properties > General":

2. Select the required timebase under "Properties > Properties > Miscellaneous > Time base."

3. Under "Time-based standard sort", define whether the alarms are sorted in ascending or 
descending order in Runtime.

Enable Autoscroll   
1. In the Inspector window, activate "Properties > Properties > Layout > Window > Autoscroll".

Define text format   
To format the alarm text:

1. In the Inspector window, select "Properties > Properties > Text format".

2. Click the "..." button in the "Font" area.
A dialog opens.

3. Select the font and size in the dialog.
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Set up sort order   
1. In the Inspector window, select "Properties > Properties > Columns".

2. Select sort criteria and sorting order.

Set to a table in the alarm view   
1. Click "Properties > Properties > Table font" in the Inspector window.

2. Define settings for the rows and cells in the "Table body" area.

– "Optimum line height" activated: The font is aligned to the height of the line.

– "Truncate cell contents": If the text is longer than the cell, the text is displayed truncated.

3. In the "Line numbering" area, define whether each row has a header.

4. Select the column header layout from the "Column headers" area.

Set Loop-In-Alarm
1. In the Inspector window, click "Properties > Properties > Miscellaneous".

2. Activate the "Loop-In-Alarm with double-click" option.

Configuration behavior  

Displaying column headers
The layout of the alarm view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is available in the Control 
Panel, "Display" > "Appearance" tab. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 
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Alarm window

Application  
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The layout 
and operation of the Alarm window are similar to that of the Alarm view. The Alarm window 
has the following characteristics that are the same as in the Alarm view:

● Simple alarm window

● Advanced alarm window

● Alarm line
 

  Note
Basic Panels

Only the simple alarm window is available for Basic Panels.
 

The Alarm window is configured in the "Global screen" editor. 

The Alarm window is independent of the process screen. Depending on the configuration, the 
Alarm window opens automatically as soon as a new, unacknowledged alarm has been 
received. If applicable, the Alarm window is configured so that it only closes after all alarms 
have been acknowledged. The following figure shows an advanced Alarm window:

 

 Note

In the engineering system you dynamize, for example, the visibility of an object in "Properties 
> Animations" in the Inspector window. In runtime, the "Simple alarm window" object does 
not support animations. If you have configured an animation and, for example, wish to perform 
a consistency check of the project, then an error alarm is issued in the Output window.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You configure the Alarm window in the same way as the Alarm view. In addition you 
adapt the following properties:

● Fixed alarm windows: Specifies that the Alarm window retains the focus after a screen 
change.

● Window: You define the operator input and response of the Alarm window in runtime.
 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in runtime, and then by when the alarm occurred.

 

Control elements  
The control elements that can be used to control the alarm view in runtime are specified in the 
Inspector window under "Properties >Display > Settings". The following table shows the control 
elements in the Alarm window, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" Switches to the screen containing information about the error that 
has occurred.

Access protection in runtime
Configure access protection under "Properties > Properties > Security" in the Inspector window 
of the alarm view. If a logged-on user has the required authorization, he can acknowledge and 
edit alarms using the operator controls in the alarm view. If the logged-in user does not have 
the required authorization, or if no user is logged in, clicking the "Acknowledge" or "Edit" buttons 
or double-clicking an alarm line opens the login dialog box.

 

 Note
Basic Panels

Access protection is not available for Basic Panels.
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Activating the focus of the Alarm window
Select the following option so that the Alarm window does not lose the focus after a screen 
change:

1. In the Inspector window, select "Properties > Properties > Mode":

2. Enable "Label".

Window
Define the response of the Alarm window under "Properties > Properties > Mode > Window" 
in the Inspector window. The following table shows the possible properties:

Option Function
Automatic display The Alarm window is automatically displayed when a system alarm 

occurs, for example.
Closable The window closes again after a set time has elapsed. You define the 

display duration in the alarm settings. 
Modal The Alarm window is linked to a confirmation, such as: Alarm must be 

acknowledged. If the modal alarm window has the focus, the buttons in 
the screen behind it cannot be used. The functions configured for a 
function key are carried out. 

Sizeable You can change the size of the Alarm window in runtime.

See also
Device-Specific Nature of the Objects (Page 817)

Alarm view (Page 881)

Alarm indicator  (Page 894)

Alarm indicator 

Application  
The alarm indicator is a graphic symbol that shows current errors or errors that need to be 
acknowledged, depending on the configuration. The alarm indicator is configured in the "Global 
screen" editor. The following figure shows an alarm indicator:
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Alarm indicator OP 73
A "simple" alarm indicator is available for the HMI OP 73. The following diagram shows the 
alarm indicator for the OP 73 HMI devices:

The "simple" alarm indicator shows alarms to be acknowledged or alarms which have already 
been acknowledged and have not yet gone. Only the position can be defined for the "simple" 
alarm indicator. The alarm indicator is displayed on the device at the selected position. If you 
have configured a screen object at this position, the visible alarm indicator covers the screen 
object. The alarm indicator is covered by system dialogs, such as the login dialog, Help dialog, 
and alarm windows. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Alarm classes: Establishes the alarm classes where the alarm indicator is displayed.

● Operator control in Runtime: Defines the operator actions in Runtime that cause the Alarm 
window to open.

Alarm classes  
You define which alarm classes are shown with an alarm indicator in "General > Alarm classes" 
in the Inspector window. Alarm classes, such as "Warnings" or "Errors".

Define operator control in Runtime  
1. Select the alarm indicator in the screen.

2. Click "Events > Click" or "Click when flashing" in the Inspector window.

3. The "function list" opens. Click the first line of the function list. The list of system functions, 
and scripts available in the project opens.

4. Select the "ShowAlarmWindow". system function under "Alarms."

5. Under "object name" select the name of the Alarm window from the selection list. Under 
"Layout", define whether the Alarm window should be visible, hidden, or should toggle 
between the two states.

See also
Device-Specific Nature of the Objects (Page 817)

Alarm view (Page 881)

Alarm window (Page 892)
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Option buttons

Application
You use the "Option button" object to display, and select various options. Only one of these 
options can be selected respectively by the operator. Enable one of the options by default so 
that the operator only changes the default value if necessary. To incorporate an option button 
into the process, dynamize the corresponding attribute.

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Number of fields

● Selection of the fields: Specifies which fields are displayed as activated.

Specifying the number of fields
You specify the number of fields in the Inspector window:

1. Click "Properties > Properties > General" in the inspector window.

2. Define the desired number of fields in the area "Label > Number of fields".

The value of the "Number of fields" property also indicates the upper limit value for the "Index" 
property. Changing the value can have the following effects:

● Increasing the number of fields
New fields are added under the field with the highest value of the "Index" property. The 
standard label of the new field is changed with "Font > Text".

● Decreasing the number of fields
All fields for which the value of the "Index" property is greater than the new number are 
removed.

Specifying the default setting of the option buttons
The "Default" property is used to specify which of the fields of the option buttons are to be 
displayed as active. If the default setting for the field is that it is to be activated, activate the 
"Default" field under "General" in the table row. Only one field may be activated at any time. 
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See also
Device-Specific Nature of the Objects (Page 817)

Check box  (Page 867)

Polygon

Application   
The "Polygon" is a closed object which you can fill with a background color. 

Layout     
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. In particular, you can customize the following property:

Geometry: Modifies, deletes or adds corners.

Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position " and 
"Y position ".

3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.
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Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.

3. Right-click the position at which you want to insert the corner point. Select "Add point" from 
the shortcut menu.

Configuring Rotation in Runtime
You configure the "Polygon" object so that it rotates about a reference point in Runtime. The 
rotation in Runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

Further information can be found in "Device-Specific Nature of the Objects (Page 817)".

See also
Polyline  (Page 899)
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Polyline 

Application   
The "Polyline" is an open object. Use the "Polygon" object if you want to fill the object with 
color.

Layout   
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line start and end: Specifies the type of line start and line end.

● Geometry: Modifies, deletes or adds corners.

Line start and end         
You define the start point and the end point of the line under "Properties > Properties 
>"Appearance" in the Inspector window. Use arrow point, for example, as start and end point. 
The available start and end points depend on the device.

Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position" and 
"Y position".

3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.
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Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.

Configuring rotation in Runtime
You configure the "Polyline" object so that it rotates about a reference point in Runtime. The 
rotation in Runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. Click "Layout" in the Inspector window.

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

Further information can be found in "Device-Specific Nature of the Objects (Page 817)".

See also
Polygon (Page 897)

Rectangle

Application 
The "Rectangle" is a closed object which you can fill with a color. 

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
900 System Manual, 08/2011,  



Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Corner radius: Specifies the horizontal and vertical distance between the corner of the 
rectangle and the start point of a rounded corner.

Corner radius   
The corners of the "Rectangle" object can be rounded to suit your requirements. When the 
properties "X" and "Y" are set to the 100 % value, the rectangle is displayed as an ellipse. As 
soon as one of the properties has the value 0%, a normal rectangle without a rounded corner 
is shown.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Enter a value for "X" in the "Corner radius" area.
The input value is the percentage proportion of half the width of the rectangle.

3. Enter a value for "Y" in the "Corner radius" area.
The input value is the percentage proportion of half the height of the rectangle.

See also
Device-Specific Nature of the Objects (Page 817)

Recipe view

Application   
The "Recipe view" object is used to display and modify recipes.
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Advanced recipe view       
Both the advanced and the "Simple recipe view" can be used to administer and process recipes 
on HMI devices with a display larger than 6".

Configuring the advanced recipe view:

1. Click the "General" group in the Inspector window.

2. Activate the option "Advanced view" in the "Display type" area.

Simple recipe view       
The "Simple recipe view" is used for display and processing of recipes on HMI devices with a 
display size less than 6". 

 

 Note

Do not use the simple recipe view in a group.
 

Configuring the simple recipe view:

1. Click "Properties > Properties > General" in the inspector window.

2. Activate the option "Simple view" in the "Display type" area.
 

  Note
Behavior for Runtime Professional, Runtime Advanced and Panels

In the Engineering System you can dynamically control the visibility of an object, for 
example, in the "Animations" tab of the Inspector window. In Runtime, the "Simple recipe 
view" does not support animations. If you have configured an animation and, for example, 
want to check the consistency of the project, an error alarm is displayed in the Output 
window. 

 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Control elements: Defines the control elements of the recipe view.

● Display number: establishes if the number of the recipe and the number of the recipe data 
record is displayed.
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Control elements     
The control elements with which the recipe view is operated in Runtime are configured under 
"Properties > Buttons" in the inspector window. In the simple recipe view the operating 
elements are based on the functions of the menu.

Control element  Description
"Tooltip" Calls up the configured tooltip for the selected 

recipe.
"New record" Creates a new recipe data record in the recipe.
"Delete record" Deletes the selected record.
"Saving" Saves the modified record with its current name.
"Save as" Saves the modified record with a new name.
"Write to PLC" Sends the current value to the PLC.
"Read from PLC" Reads the current value from the PLC.
"Synchronizing recipe tags" Compares the values of the selected record with 

the values on the PLC.

Display number     
Specifies whether the number of the recipe and the number of the recipe data record are 
displayed during runtime. The number of the recipe uniquely identifies the recipe in the project.

1. Click "Properties > Properties > View" in the inspector window:

2. Activate "Display > Display numbers".

Configuration behavior

Displaying column headers
The layout of the recipe view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime.

 

See also
Device-Specific Nature of the Objects (Page 817)

Simple recipe view (Page 1488)

Advanced recipe view (Page 1492)

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  903



Recipe view

Application   
The "Recipe view" object is used to display and modify recipes.

Layout     
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Log/View: define recipe or view

● Toolbar: Defines the control elements of the recipe view.

● Columns: Specifies the columns that are displayed in the recipe data record.

Log/View
Define which recipe or view is displayed in the recipe view under "General > Archive/View" in 
the Inspector window.

Toolbar     
The control elements with which the recipe view is operated in Runtime is configured under 
"Properties > Buttons" in the Inspector window. In the simple recipe view the operating 
elements are based on the functions of the menu.

Control element  Description
"Info text" Calls the info text for the recipe display.
"Configuration dialog" Opens the configuration dialog box in which you 

change the properties of the recipe display.
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Control element  Description
"Select data connection" Opens a dialog box for selecting a recipe or recipe 

view. The recipe data are then shown in the table 
of the recipe display.

"First data record" The first data record is displayed in the table by 
the button. 

"Successive data record" The previous data record is displayed in the table 
by the button.

"Next data record" The next data record is displayed in the table by 
the button.

"Last data record" The last data record is displayed in the table by 
the button.

"Delete record" The content of the marked lines are deleted.
"Cut lines" The content of the marked lines are cut out.
"Copy lines" The content of the marked lines are copied.
"Insert lines" The content of the copied or cut-out lines is 

inserted starting from the marked line.
"Read tags" The contents of the connected WinCC tags are 

read and written into the recipe elements by the 
button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use 
the button. The recipe elements must be 
connected with tags.

"Write tags" The contents of the recipe elements are written 
into the connected WinCC tags. The "Tags" 
communication type must be activated in the 
displayed recipe to be able to use the button. The 
recipe elements must be connected with tags.

"Import Archive" A CSV file is imported from the "ua" directory of 
the project folder into the table of the recipe 
display by the button.

"Export archive" The original contents of the table are exported 
with table headers by the button when loading. 
The recipe is stored as a CSV file in the "ua" 
directory of the project folder. 

"Sort dialog" Opens a dialog box for setting a customized 
sorting of the displayed columns.

"Print" Starts the printout of the displayed values. The 
print job used for printing is defined in the 
configuration dialog on the "General" tab. 

"Time base dialog" Opens a dialog box for setting the time base for 
the used times.
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Control element  Description
"Export data" You export the recipe or recipe view with the 

button as configured into a CSV file but with the 
current Runtime data. If the option "Display 
dialog" is active, a dialog opens in which you can 
view the settings for exporting and can start the 
export. With the appropriate operator 
authorizations you may also select the file and the 
directory for export.
If no dialog is displayed, export of data to the 
default file is started immediately.

"User-defined" Displays the first button created by the user. The 
function of the button is customized.

Columns
In the Inspector window under "Columns > Column properties", define which columns are 
displayed in the recipe view.

Configuration behavior
Displaying column headers

The layout of the recipe view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime.

See also
Device-Specific Nature of the Objects (Page 817)

Displaying recipes (Page 1558)

Properties of the recipe view (Page 1559)

Editing recipe data (Page 1583)
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Round button

Application
The "Round button" object is used to control processes. A round button is used, for example, 
to confirm alarms. To incorporate a round button into the process, dynamize the corresponding 
attribute. 

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. A round button can have the following three states:

● On

● Off

● Disabled

In particular, you can customize the following property:

Layout and behavior of the round button: You define whether a round button should appear 
pressed by default, and whether the round button should engage when pressed.

Show round button pressed
You specify the layout of the round button under "General" in the Inspector window.

1. Click the "General" group in the Inspector window.

2. Activate the "Pressed" check box in the "Miscellaneous" area.

Configure toggle button as a two-way switch
You specify the layout of the round button under "General" in the Inspector window.

1. Activate "General" in the Inspector window.

2. Activate the "Engage" check box in the "Type" area.

See also
Device-Specific Nature of the Objects (Page 817)
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Pipe

Application
You reproduce a continuous pipe with several bends with the object "Pipe". To reproduce a 
pipe system, connect the "Pipe" object to other objects, e.g. pipe bend or T piece.  

 

Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:

● Geometry: You add additional points and extend the object.

A pipe may have any number of corners. The corner points are numbered in the order of their 
creation. You can move them individually. 

See also
Device-Specific Nature of the Objects (Page 817)

Double T-piece (Page 837)

Pipe bends (Page 908)

T piece (Page 937)

Pipe bends

Application
A pipe bend is displayed using the "Pipe bend" object. To reproduce a pipe system, connect 
the "Pipe bend" object to other objects, e.g. pipe bend or double T piece. 
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Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:   

● Angle: You specify the start and end angle of the pipe bend. 

● Radius: You specify the horizontal and vertical radius of the pipe bend. 

The attributes are interdependent. 

● When you change "Start angle" and "End angle", the width and height are also automatically 
changed.
"Horizontal radius " and "Vertical radius" are retained.

● When you change "Horizontal radius" and "Vertical radius", the width and height are also 
automatically changed.
"Start angle" and "End angle" are retained.

● When you change the width and the height, the "Horizontal radius" and "Vertical radius" 
are also automatically changed.
"Start angle" and "End angle" are retained.

 

See also
Device-Specific Nature of the Objects (Page 817)

Double T-piece (Page 837)

Pipe (Page 908)

T piece (Page 937)

Switch 

Application 
The "Switch" object is used to configure a switch that is used to switch between two predefined 
states in Runtime. The current state of the "Switch" object can be visualized with either a label 
or a graphic.

The following figure shows a "Switch" type switch.
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Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. In particular, you can customize the following property:

● Type: Defines the graphic representation of the object.

Type 
The button display is defined in "Properties > Properties > General >Settings" in the Inspector 
window.

Type Description
"Switch" The two states of the "Switch" are displayed in the form of a switch. The 

position of the switch indicates the current state. The state is changed in 
runtime by sliding the switch. 
You specify the direction of movement of the switch in "Switch orientation" 
with this type.

"Switch with text" The switch is shown as a button. The current state is visualized with a label. 
In runtime click on the button to actuate the switch.

"Switch with graphic" The switch is shown as a button. The current state is visualized with a graphic. 
In runtime click on the button to actuate the switch.

 

 Note
Basic Panels

The "Switch" type is not available for Basic Panels. 
 

See also
Device-Specific Nature of the Objects (Page 817)

Elements (Page 1983)

Overview of objects (Page 660)

Button

Application  
The "Button" object allows you to configure an object that the operator can use in runtime to 
execute any configurable function. 
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Defines the graphic representation of the object.

● Text / Graphic: Defines whether the Graphic view  is static or dynamic.

● Define hotkey: Defines a key, or shortcut that the operator can use to actuate the button.
 

  Note

You can only define a hotkey for HMI devices with keys.
 

Mode   
The button display is defined in "Properties > Properties > General >Mode" in the Inspector 
window.

Mode Description
"Invisible" The button is not visible in runtime.
"Text" The current state of the button is visualized with a label.
"Graphic" The current state of the button is visualized with a graphic.

Depending on the device, further options are available:

Text / Graphic     
The "Mode" property settings are used to define whether the display is static or dynamic. The 
display is defined in "Properties > Properties > General >Label > Text" or "Graphic" in the 
Inspector window.

Type Option Description
"Text" "Text" "Text OFF" is used to specify a text that appears in the button when the 

state is "OFF". 
If you enable "Text ON", you can enter a text for the "ON" state.

"Text list" The text in the button depends on the state. The entry from the text list 
corresponding to the state is displayed.

"Graphic" "Graphic" "Graphic OFF" is used to specify a graphic that is displayed in the button 
when the state is "OFF". 
If you enable "Graphic ON", you can enter a graphic for the "ON" state.

"Graphics 
list"

The graphic in the button depends on the state. The entry from the graphics 
list corresponding to the state is displayed.
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Define hotkey   
In the Inspector window, a key or key combination is defined that the operator can use to 
control the button in runtime.

1. In the Inspector window, select "Properties > Properties > General":

2. Select a key or key combination from the selection list in the "Hotkey" area.

 

See also
Device-Specific Nature of the Objects (Page 817)

Slider

Application  
Process values are monitored and adapted within a defined range with the "Slider" object. The 
monitored range is visualized in the form of a slider. By adjusting the slider, you intervene in 
the process and correct the displayed process value.

 

 Note

Do not configure a system function at the "Change" event for a regulated project if it is used 
to execute a GMP-relevant action. 

Instead configure the system functions at the "Value change" event of the tags in order to 
reduce the number of user actions.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can, in particular, adapt the following properties as required:

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Display current value: Specifies whether the current position of the controller appears below 
the slider.

● Display bar: The sliders above and below the bar can be hidden.

Maximum Value and Minimum Value   
The top and bottom end values of the scale are specified in the Inspector window.

1. In the Inspector window, activate "Properties > Properties > General".

2. Enter a number at "Maximum value" and "Minimum value". If you select a tag as the end 
value of the scale, the number will be no longer available.

Display current value  
Specify that the value of the current position is displayed below the slider in the Inspector 
window.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Activate "Show current value."

Display bar  
The display of sliders below the bar can be hidden.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Activate "Display bar".

See also
Device-Specific Nature of the Objects (Page 817)

KeySwitch

Use     
The object "KeySwitch" is an optional control element for the SIMATIC Mobile Panel. The key 
switch is used to lock functions that can be triggered from the Mobile Panel.

You configure the object "key switch" object in the "global screen" or in a template.
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Layout     
You can set the following properties in the Properties view:

● Tag: Specifies the tag in which the position of the key switch is written.

Tag     
The "Tag" property is used to specify the "Key switch" object assignment in the global screen 
or template. 

 

 Note
Notes on configuring

When starting runtime and every time the key is pressed the current position of the key switch 
is written to the tag. In doing so it can cause inconsistencies between the position of the key 
switch and the key switch tags.
1. If the tag has a process connection, the current value is transferred from the PLC to the 

tag after establishment of communication. The tag that contains the current position of 
the key is overwritten by this process. It can be that the key switch tag no longer reflects 
the current value of the key switch, e.g. if the Mobile Panel is switched off while the key 
is being turned.

2. If the key switch is pressed before communication with the PLC has been established 
(e.g. after a device start-up), it may not be possible to send the value of the key switch 
tag to the PLC. In this case the value of the tag in the PLC is different from the current 
position of the key.

A specific configuration is required to make sure that the key switch tag reflects the actual 
position of the key switch at all times. See the instructions below for the basic procedure.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Create three tags in the "Tag" editor.

– Internal tag: Position_Keyswitch

– External tag: Auxiliary tag

– External tag: Keyswitch_PLC

3. Open the Inspector window of the "Position_KeySwitch" tag.

4. In the Inspector window, select "Properties > Events > Value change".

5. Click the first line of the function list. The list opens, showing the system functions available 
in the project.

6. Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

The value of the "Keyswitch_PLC" tag is written to the PLC with the "Position_Keyswitch" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Keyswitch_PLC" tag from the PLC. 
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7. Open the Inspector window of the "Auxiliary tag" tags.

8. In the Inspector window, select "Properties > Events > Value change".

9. Click the first line of the function list. The list of system functions available in the project 
appears.

10.Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

After establishing communication the current value is written to the "Auxiliary Tag" from 
the PLC. The "SetTag" system function is executed by the value change in the auxiliary 
tags. The system function re-allocates the value of the "Position_Keyswitch" tag to the 
"Keyswitch_PLC".

11.Open the global screen or a template in the "Screen navigation" editor.

12.Select the key switch in the screen.

13.Select the "Position_KeySwitch" tag in the Inspector window under "Properties > Properties 
> General > Settings > Tag".
If you press the illuminated pushbutton, the value is written to the "Position_KeySwitch" tag.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
916 System Manual, 08/2011,  



Sm@rtClient view

Application   
The "Sm@rtClient View" object is used to configure a network connection to the remote 
monitoring and remote maintenance of a connected unit.

Layout     
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Connect on start: Establishes whether when opening the Sm@rtClient view the connection 
to the HMI device is automatically created which should be remote-controlled.

● View only: Determines whether the Sm@rtClient view for remote monitoring or remote 
servicing is to be used.

● Shared use_ Specifies that an HMI device is shared by several Sm@rtClient Views.

● Local cursor: Establishes whether the cursor data is transferred separately in order to 
increase the performance.

● Use cursor key scroll: For keyboard devices places the control of the horizontal and vertical 
scroll with the cursor keys.

● Show controls: Establishes whether additional fields exist for entering the address and 
password.

● Allow menu: Establishes whether the shortcut menu should be enabled to control the 
Sm@rtClient view.

● Connection type: Establishes the expected transfer speed for the remote monitoring.

● Scaling: Establishes whether the Sm@rtClient view should be zoomed in or out.

Connect on start
Establishes whether when opening the Sm@rtClient view the connection to the HMI device is 
automatically created which is remote-controlled. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Connect on start".
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View only   
If this property is set, the Sm@rtClient view is used only for remote control. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Only display".

Shared use   
Define whether the HMI device can be used by several Sm@rtClient views under "Properties 
> Properties > General > View > Shared".

Shared use  
Enabled The HMI devices that the remote control has enabled can access the 

distant HMI device and control the process. Only one HMI device can be 
active at a time in this case. A different HMI device can only assume control 
when there has been no activity on the active HMI device for a specified 
period of time.

Disabled The remote control can use only one HMI device at a time. The activities 
can be followed on the other HMI devices. 
Depending on the settings on the Sm@rtServer the following options are 
available if another HMI device logs on:
● The HMI device is rejected.
● The active HMI device is disconnected and the new HMI device is 

connected.

Local cursor   
If this property is set, then the cursor data is transferred separately. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Local cursor".

Use cursor key scroll
When this property is set for keyboard devices, the horizontal and vertical scroll is controlled 
by the cursor keys.

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Scroll with cursor keys".

Display extended objects
If this property is set then there are additional fields for inputting the address and password. 
For the fields to be shown the "Connect on start" option is not activated.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "View > Show enhanced objects".
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Allow menu
If this property is set, then a shortcut menu to control the Sm@rtClient view is opened in 
Runtime. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Allow Menu".

Connection type
The "Connection type" property establishes the expected transfer speed for the remote 
monitoring. You define the connection type in the Inspector window at "Connection type" under 
"Properties > Properties > General".

Connection type  
LAN Connection via network
Slow Connection with a low transfer speed
Medium Connection with a medium transfer speed
Modem Connection via an analog modem
Very slow Connection with a very low transfer speed 

Scaling
If this property is set, then via "Client scale factor" and "Server scale" you can reduce or enlarge 
the Sm@rtClient view on the HMI device. 

1. In the Inspector window, select "Properties > Properties > Scaling".

2. Activate "Scaling > Scaling".

3. Enter the values for the scaling under "Client scale factor" and "Server scale factor".

Operation behavior
If the program cannot resolve the dynamic address of a Sm@rtClient view after a screen 
change, the system connects to the configured server using the static address of the server. 
If a tag is now set using the dynamic address, you can make a second connection to this server. 
As a remedy preset the tags of the dynamic address for example by means of a script. 

Use cursor key scroll
To operate in Runtime you must press the <Ctrl> and a cursor key.

Allow menu
When operating using the mouse, the left mouse key must remain depressed for a few seconds 
for the shortcut menu to open. 
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See also
Device-Specific Nature of the Objects (Page 817)

Memory space view

Application
The "Memory space view" object is used to display the memory space view. You can create 
one memory space display for each drive.

Layout
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Drive: Defines the drive whose memory assignment is displayed in the memory space 
display.

● Monitoring limits: Defines the values for the monitoring limits.

Define drive
1. Activate "General" in the Inspector window.

2. Enter the relevant letter in the "Drive letter" area.

Change monitoring limits
Enter the monitoring limits for Alarm, Warning, and Tolerance in the Inspector view. The values 
are specified as a percentage. The percentage of the occupied memory space is monitored 
in relation to the total capacity of the specified drive:

1. Activate "General" in the Inspector window.

2. Enter the value for each monitoring limit as a percentage in the "Limits" area.

See also
Device-Specific Nature of the Objects (Page 817)
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Status/Force

Use 
The "Status/Force" object is used to configure an editor that will allow you to process single 
address areas of a SIMATIC S7 in runtime.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● PLC type: Specifies the PLC type in the object for which the address area is output in 
runtime.

● Control elements: Specifies the controls of the object.

● Visible columns: Specifies the displayed columns in runtime.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in Runtime.

Control elements     
The control elements that can be used to control the "Status/Force" object in Runtime are 
specified in the Inspector window of the "Display" group in the "Settings" area.

 Function
This button refreshes the display in the status value column.

Use this button to accept the new value in the control value column. The control value 
is then written to the PLC.
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Visible columns     
The columns that are displayed in Runtime are specified in the Inspector window in the 
"General" group in the "Visible columns" area.

Column Description
"Connection" The PLC of which the address areas are displayed.
"Type"
"DB- number"
"Offset"
"Bit"

The address area of the operand.

"Data type"
"Format"

The data type of the operand.

"Status value" The value that was read from the specified address of the operand.
"Control value" The value written to the specified address of the operand.

Sequence of columns     
The operator can use the "Column ordering" property to change the sequence of columns in 
Runtime.

1. Click "Columns" in the "Properties" group in the Inspector window.

2. Enable the "Sequence of columns" option in the "Properties of columns" area.

Display of the column headers and buttons
The layout of the "Status/Force" object is dependent on the view settings in the control panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style. This behavior only occurs during 
configuration. The column headers are displayed correctly in Runtime.   

If you change the layout, for example from "Windows Classic" to "Windows XP Style", the 
button in the "Status/Force" object may no longer be displayed. Change the size of the object 
to make the buttons in the engineering system visible again.     

See also
Device-Specific Nature of the Objects (Page 817)
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Symbol library

Application  
The "Symbol library" object contains a large collection of ready-to-use icons. These icons are 
used to represent systems and plant areas in screens.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Select icon: Specifies which library object will be used.

● Fill style: Specifies the graphic design of the object.

● Flip: Specifies the flip type of the library object.

● Rotate: Specifies the angle around which the library object is rotated.

● Fixed aspect ratio Defines whether the aspect ratio is maintained if the size is changed.

Select symbol
You determine which symbol you use in the "Properties > Properties > General" inspector 
window.
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Fill style   
The appearance of the library object is specified under "Properties > Appearance > Layout" in 
the Inspector window.

"Hollow" The library object is displayed in outline.
"Solid" Black lines remain as outlines. Elements of the icon with a different color are displayed as a main color.
"Original" The screen object will not be changed.
"Shaded" Black lines remain as outlines. Elements of the symbol in other colors are displayed as brightness 

levels of a main color.

At the TP 177B mono and OP 177B mono HMI devices the library object is displayed as an 
outline. "Hollow" is set as the default value for the fill style. 

If you change the setting from "hollow" to "original" or "shaded" then the color of the display 
on the configuration computer will deviate from that on the HMI device. This deviation is caused 
by the different color resolutions. You may also use a graphic object from the "Graphics" object 
group. The graphic objects are structured by topic and by depth of color in the "WinCC graphics 
folder."     

Flip and rotate     
The object alignment of the library object is specified in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the desired flip type at "Flip" in the "Orientation" dialog.
The content of the screen flips around the horizontal or vertical central axis of the icon. The 
icon can be flipped horizontally, vertically or simultaneously horizontally and vertically.

3. Select the desired angle for rotation at "Rotation" in the "Orientation" dialog.
The screen content rotates around the central point of the icon. The symbol is rotated 
clockwise in increments of 90, 180, or 270 degrees.
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Fixed aspect ratio   
The smaller page of the library object defines the maximum size of the symbol. If you change 
the size of the library object unproportionally, the symbol is still scaled proportionally. Proceed 
as follows to configure a fixed aspect ratio:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Form > Fixed aspect ratio".

 

See also
Device-Specific Nature of the Objects (Page 817)

Symbolic I/O field

Application  
The "Symbolic I/O field" object can be used to configure a selection list for input and output of 
texts in Runtime.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Text list: Specifies the text list that is linked to the object.

● Button for selection list: Specifies that the object has a button to open the selection list.
 

  Note
Reports

In reports, symbolic I/O fields only output data. "Output" mode is preset. Properties for 
configuring the selection of graphics are not available, e.g. "button for selection list".

 

Mode  
The response of the symbolic I/O field is specified in the Inspector window in "Properties > 
Properties > General > Type".

Mode Description
"Output" The symbolic I/O field is used to output values.
"Input" The symbolic I/O field is used to input values.
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Mode Description
"Input/output" The symbolic I/O field is used for the input and output of values.
"Two states" The symbolic I/O field is used only to output values and has a maximum of two 

states. The field switches between two predefined texts. This is used, for 
example, to visualize the two states of a valve: closed or open.

 

 Note

The behavior possible for the symbolic I/O field depends on the Runtime.
 

Text list   
In the Inspector window, you specify which text list is linked to the symbolic I/O field.

1. In the Inspector window, select "Properties > Properties > General":

2. Under "Contents" open the selection list for "Text list".

3. Select a text list.

Button for selection list 
The "Button for selection list" property is used to display a button for opening the selection list.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate the "Button for selection list" option under "Response".
 

  Note
Basic Panels

The "Button for selection list" option is not available for Basic Panels.
 

 

See also
Device-Specific Nature of the Objects (Page 817)

Graphic I/O field (Page 855)

Symbolic I/O field

Application  
The "Symbolic I/O field" object can be used to configure a selection list for input and output of 
texts in Runtime.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can customize the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Text list: Specifies the text list that is linked to the object.

Mode   
The response of the symbolic I/O field is specified in the Inspector window in "Properties > 
Properties > General > Type".

Mode Description
"Output" The symbolic I/O field is used to output values.
"Input" The symbolic I/O field is used to input values.
"Input/output" The symbolic I/O field is used for the input and output of values.
"Two states" The symbolic I/O field is used only to output values and has a maximum of two 

states. The field switches between two predefined texts. This is used, for 
example, to visualize the two states of a valve: closed or open.

Text list   
In the Inspector window you specify which text list is linked to the symbolic I/O field.

1. In the Inspector window, select "Properties > Properties > General":

2. Open the selection list for "Text list".

3. Select a text list.

 

See also
Device-Specific Nature of the Objects (Page 817)

Graphic I/O field (Page 857)

System diagnostics display

Introduction
The system diagnostic view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.

The system diagnostics view is only available for Comfort Panels. 
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Application
The system diagnostic view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostic view. 

● Device view

● Details view

● Matrix view (only for master systems, PROFIBUS)

Device view 
The device view of the system diagnostics view shows all the available devices of a layer in 
table form. By double clicking a device you open either the lower level devices or the detail 
view. Symbols in the first column provide information about the current status of the device.

Details view 
The details view shows detailed information about the selected device and the associated 
faults. Check whether the data is correct in the details view. Error texts cannot be sorted in the 
details view.

Matrix view 
The matrix view is only available for master systems. In the matrix view you can see the status 
of the subdevices of the master system. 

● With Profibus, the numbers assigned by Profibus are used as identification (DP station 
number).

● The IO devices are numbered consecutively beginning with 1 for PROFINET.
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Layout
In the Inspector window, you customize the position, shape, style, color and font type of the 
object. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and details view.

● Table headers: Specifies the table headers of the view.

Configuring the system diagnostic view
1. Drag-and-drop the system diagnostic view from the toolbox.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Activate the columns that you require in the device view for runtime, e.g.:

– Status

– Name

– Operating mode

– Slot

– Address

4. Activate the columns which you need in the detail view for runtime, e.g.:

– Status

– Name

– Operating mode

– Plant designation

– Address

5. Click "Properties > Properties > Table headers" in the inspector window.

6. Enter "IP" for "Address", for example.
The column header "IP" is displayed in the device view in runtime. 

7. Rename other elements if necessary.

8. Select an authorization for operation in "Properties > Properties > Security".

Symbols in the system diagnostic view 

Icon Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required
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Icon Function
Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization

Stop

Simulation

 

See also
Device-Specific Nature of the Objects (Page 817)

System diagnostics window (Page 930)

System diagnostics window

Introduction
The system diagnostics window offers you an overview of all the available devices in your 
plant. You navigate directly to the cause of the error and to the relevant device. You have 
access to all diagnostics-capable devices which you have configured in the "Devices & 
networks" editor.

The system diagnostics window is only available in the global screen for Comfort Panels.

Application
The system diagnostics window enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.
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Three different views are available in the system diagnostics window. 

● Device view

● Details view

● Matrix view (only for master systems, PROFIBUS)

Device view
The device view of the system diagnostics window shows all the available devices of a layer 
in table form. By double clicking a device you open either the lower level devices or the detail 
view. Symbols in the first column provide information about the current status of the device.

Details view
The details view shows detailed information about the selected device and the associated 
faults. Check whether the data is correct in the details view. Error texts cannot be sorted in the 
details view.

Matrix view
The matrix view is only available for master systems. In the matrix view you can see the status 
of the subdevices of the master system. 

● With Profibus, the numbers assigned by Profibus are used as identification (DP station 
number).

● The IO devices are numbered consecutively beginning with 1 for PROFINET.

Layout
In the Inspector window, you customize the position, shape, style, color and font type of the 
object. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and details view.

● Table headers: Specifies the table headers of the view.

● Window: Specifies whether the system diagnostics window can be closed, for example.

Configuring the system diagnostics window
1. Drag and drop the system diagnostic view from the toolbox into the global screen.

2. In the Inspector window, select "Properties > Properties > Columns".
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3. Activate the columns that you require in the device view for runtime, e.g.:

– Status

– Name

– Operating mode

– Slot

– Address

4. Activate the columns which you need in the detail view for runtime, e.g.:

– Status

– Name

– Operating mode

– Plant designation

– Address

5. Click "Properties > Properties > Table headers" in the inspector window.

6. Enter "IP" for "Address", for example.
The column header "IP" is displayed in the device view in runtime. 

7. Rename other elements if necessary.

8. To be able to close the system diagnostics window in runtime, active "Properties > 
Properties > Window > Closable" in the Inspector window.

9. Select an authorization for operation in "Properties > Properties > Security".

Icons in the system diagnostics window

Button Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization
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Button Function
Stop

Simulation

 

See also
Device-Specific Nature of the Objects (Page 817)

System diagnostics display (Page 927)

Table view

Application  
You use the "Table view" object to display the tag values in a table. You can display current, 
or logged values in the table. 

Layout  
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Configuring data source and columns

● Configuring a table

● Window settings

● Persistence

● Toolbar
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Configuring data source and columns  
1. Open "Properties > Properties > Value column".

2. Select the log tag or compressed log tag that supplies the column with values under "Data 
source".

3. Under "Time column", select the column of the table view in which the data source is to 
displayed.

4. Select the time range of the table under "Properties > Properties > Time column > Time 
range":

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

5. Use the "Update" option to define whether the table displays the values statically or if the 
values are refreshed.

6. Under "Style" specify the format for displaying the time and the alignment within the column.

Configuring a table
Under "Properties > Properties > Table", you specify whether the columns of the table have a 
title and whether the grid lines of the table are displayed.

Window settings
Under "Properties > Properties > Layout > Window" you define whether the user can change 
the size of the window and close the window in Runtime.

Persistence
Under "Properties > Properties > Security > Persistence" define how long a user's changes to 
the trend view in runtime are retained.

● "Allow persistence"
Users can change settings. Changes are retained until the next screen change.

● "Persistence until logoff"
User group changes are retained until logoff.

● "Persistence until next loading"
User group changes are retained until the project is updated on the HMI device.
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Toolbar    
You define the control elements of the table view in Runtime in the "Properties > Properties > 
Toolbar" inspector window. The following control elements are available for the table view:

Button Name Function
Online help Opens the online help.

Open configuration Opens the configuration dialog. 

First data record Browse the log:
Shows the tag values starting with the first logged value.

Previous data record Browse the log:
Shows the tag values in the previous time interval.

Next data record Browse the log:
Shows the tag values in the subsequent time interval.

Last data record Browse the log:
Shows the tag values up to the last logged value.

Edit data Allows the editing of data in any table field that is opened 
when the user double-clicks it.

Tag selection Opens the dialog for selecting the log and tags.

Select column Opens the dialog for setting the visibility of columns.

Time range selection Opens the dialog for setting the time range displayed in 
the table view.

Previous column Displays the previous column in the foreground

Next column Displays the next column in the foreground

Start/end update Stops and starts the column update. The values are 
buffered and updated as soon as you start column 
update again. 

Print log Starts printing the columns displayed in the table view. 
You define the print job under "General > Print > Print 
job". 

Selection of the statistics 
area

Enables you to define a time range for which static 
values are determined.

Statistics window Opens a statistics window to display the minimum, 
maximum, means, and standard deviation for the 
selected time range and the selected column. 
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See also
Device-Specific Nature of the Objects (Page 817)

f(t) trend view (Page 846)

f(x) trend view (Page 851)

Value table (Page 940)

Text field

Application 
The "Text field" is a closed object which you can fill with a color. 

Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.

Text 
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field 
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Auto-size".

Otherwise you can set the size manually. Deactivate "Auto-size". Press the mouse button and 
drag the text field to the required size.
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See also
Device-Specific Nature of the Objects (Page 817)

T piece

Application
You use the "T piece" object to reproduce a T-shaped pipe junction. To reproduce a pipe 
system, connect the "T piece" object to other objects, e.g. pipe or pipe bend.  

Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:

Rotation: Specifies the angle of rotation in degrees of the T piece.

Rotation
You specify by how many degrees the "T piece" is rotated under "Properties > Properties > 
Layout > Rotation" in the Inspector window. The value entered is automatically rounded to a 
multiple of 90.   

● 0: the "leg" of the T piece is pointing downward

● 90: the "leg" of the T piece is pointing to the left

● 180: the "leg" of the T piece is pointing upward

● 270: the "leg" of the T piece is pointing to the right

See also
Device-Specific Nature of the Objects (Page 817)

Pipe (Page 908)

Pipe bends (Page 908)

Double T-piece (Page 837)
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Clock

Application 
The "Clock" object displays the date and time.

Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Analog display: Specifies whether the clock is shown as an analog clock or digital clock.

● Display clock dial: Specifies whether hour marks of the analog clock will be displayed.

● Width and length of hands: Specifies the width and length of the hands.

Analog display 
In the Inspector window you can specify whether the clock is displayed as an analog or digital 
clock. The digital clock shows both the time and the date. The display format depends on the 
language set on the HMI device.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

Display dial  
In the Inspector window you can specify whether hour marks will be displayed.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

3. Activate "Show dial".

Width and length of hands  
The width of the second hand, minute hand and hour hand is set for the analog display. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter values for "width" and "length".
The values for the length are interpreted as a percentage of the size of the clock. The value 
for the length of the second hand influences the radius of the dial at the same time.
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See also
Device-Specific Nature of the Objects (Page 817)

Connector

Application
You use the "Connector" object to interconnect several objects using a line.  You can also 
attach multiple connectors to one another.  

There are two types of connector:

● Automatic: The connector consists of horizontal and vertical parts.

● Single: The connecting points are connected by a straight line.

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line style

● Line start and end
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Connecting objects
To connect objects, join the ends of the connectors to the connecting points on the objects.

1. Click the "Connector" object in the "Tools" task card.

2. Click on an object in the screen. The connector is connected to the first object.

3. Click on another object in the screen. 
Both objects are connected to each other.

See also
Device-Specific Nature of the Objects (Page 817)

Value table

Application
You use the "Value table" object to show evaluated data and statistics in a table. 

● f(t) trend view

● f(x) trend view

● Table view

Layout
In the inspector window, you customize the position, geometry, style, colors and font types of 
the object. You can adapt the following properties in particular:   

● Data source for displaying the values

● Mode

● Toolbar
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Data source for displaying the values
You define which values are displayed in the value table in the "Properties > Properties > 
General > Data source" inspector window.

Select between the following objects:

● f(t) trend view

● f(x) trend view

● Table view

Mode
You define the mode in the "Properties > Properties > General > Mode" inspector window. You 
have a choice of three different types depending on the data source.

● The ruler window shows the coordinate values of the trends on the ruler or values of a 
selected line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. The statistics area window is not 
provided for the object f(x) trend view.

● The statistics window shows the statistical evaluation of the trends between two rulers or 
the selected values in the table. The statistics window is not provided for the object "f(x) 
trend view".

Toolbar  
You define the control elements of the value table in Runtime in the "Properties > Properties 
> Toolbar - Toolbar - Buttons" inspector window. The following control elements are available 
for the recipe data:

Button Brief description Description
Help Calls help for the WinCC value table
Configuration dialog 
box

Opens the configuration dialog box in which you change the 
properties of the value table.

Ruler window You query the coordinate points of a trend with the button. 
The trend data are displayed in the ruler window.

Define statistics area Enables you to define a time range for which statistics values 
are determined.

Calculating statistics
 

The button shows the statistical values in the statistics 
window. The displayed values refer to a selected trend with 
the configured calculation time period. The button can only 
be pressed if a statistics window is connected with an f(t) 
trend view.

Printing
 

Start the print-out of the values shown in the table. You define 
the print job to be used in the "Properties > Properties > 
General > Print job" inspector window. 
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Exporting data
 

This button is used for exporting all or the selected runtime 
data into a "CSV" file. If the "Properties > Properties > Data 
export > Show dialog" inspector window is activated, a dialog 
box opens in runtime. The dialog box offers you settings for 
the export and starting the export. With the appropriate 
authorizations you can also select the file and the directory 
for the export.
If no dialog box is displayed, the data export to the preset file 
starts immediately.

Customized 1
 

Shows the first key function created by the user. The function 
of the button is user-defined.

See also
Device-Specific Nature of the Objects (Page 817)

f(t) trend view (Page 846)

f(x) trend view (Page 851)

Table view (Page 933)

Effective range name

Application  
The "Effective range name" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range name" object shows the names of the effective range in which the HMI device 
is located and also the logon status. 

Layout  

Symbol Meaning Description Logon status
Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

It is not possible to log on to the 
effective range

Acknowledgement 
button functions

Within the "MixingAxisControl" 
effective range

Logged on to effective range
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Symbol Meaning Description Logon status
Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

Logon to the effective range is 
rejected because a different 
HMI device is already logged on.
Note:
When using the "Override" 
mode: Although no other HMI 
device is still logged on to the 
effective range, logon is 
rejected because the override 
switch is still set.

Acknowledgement 
button has no effect

Outside of each effective range Note: You can only log on within 
the effective range

In the Inspector window "Properties > Properties > Security", assign an authorization to log on 
to a machine in runtime.

Logon requirements   
● The HMI device is located within the effective range.

● No HMI device is logged on to this effective range.

Logon procedure
1. Click on the "Effective range name" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range match, the HMI device is logged on to the effective range. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range.

Requirement for logging off
The HMI device is logged on to this effective range.
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Logoff procedure   
Before you leave the effective range or runtime, you must log off from the effective range first. 
If you leave the effective range without logging off, a warning appears.

1. Click on the "Effective range name" object. The "Effective range logoff" dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range. Other HMI devices can now log 
on to this effective range.

 

 Note

Do not deactivate the "Override" mode again unless you logon a different HMI device.
 

 

See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

Effective range signal (Page 946)

WLAN reception (Page 947)

Zone name  (Page 951)

Zone signal (Page 952)

Configuring the effective range name (Page 2026)

Effective range name (RFID)

Application  
The "Effective range name (RFID)" object is a control element for some SIMATIC Mobile 
Panels. The "Effective range name (RFID)" object shows the name of the effective range 
(RFID) in which the HMI device is located and also the logon status. 

 

 NOTICE

RFID tags in the plant area

RFID tags may only be attached in demarcated areas which are secured by additional 
protective measures, e.g. protective fencing. 
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Layout  

Symbol Description Description Logon status
Acknowledgement 
button has no effect

Within the effective 
range (RFID)  
"MixingAxisControl"

It is not possible to log on to the 
effective range (RFID)

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logon to effective range (RFID) 
running

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logged on to the effective 
range (RFID)

In the "Properties > Properties > Security" category of the Inspector window, you can assign 
an authorization for the user group that logs on to the effective range (RFID) during runtime. 

Logon requirements   
● The HMI device is located within the effective range (RFID).

● The machine is demarcated by additional protective measures.

● No HMI device is logged on to this effective range (RFID).

Logon procedure
1. Click on the "Effective range name (RFID)" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range (RFID)  match, the HMI device is logged on to the machine. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range (RFID) or the machine.

Logoff requirements
The HMI device is logged on to this effective range (RFID).
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Logoff procedure   
Before you exit the effective range (RFID) or runtime, you must first log off from the effective 
range (RFID). If you exit the effective range (RFID) without logging off, a local rampdown is 
executed.

1. Click on the "Effective range name (RFID)" object. The "Effective range (RFID) - logoff" 
dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range (RFID) or machine. Other HMI 
devices can now log on to this effective range (RFID).

See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

WLAN reception (Page 947)

Configuring the effective range name (RFID) (Page 2030)

Effective range signal

Application
The "Effective range signal" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range signal" object indicates how accurately the Mobile Panel Wireless is positioned 
within an effective range.   

Layout

Symbol Description 
Within an effective range

When leaving an effective range
When entering an effective range

Outside of each effective range

Override function is activated:
Within a special security range of the effective range

The "Effective range name" object indicates which effective range this concerns.
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Override function
An effective range, e.g. "robots" is formed outwardly through transponders. However, within a 
special protection zone, e.g. "robot cells", the effective range is not formed by transponders, 
but by alternative restrictions e.g. by railings and a door.

The operator initially logs on to the effective range. An operator who enters the restricted and 
secure zone "robot cells" must press an additional switch to activate the override function:   

● The effective range is allocated and can no longer be established by the transponder.

● Therefore, the quality does not play a role and is no longer displayed.

● The HMI device remains logged into the effective range.

● Other HMI devices can no longer logon to this effective range.

Calculating the signal quality
The quality within an effective range depends, as follows, on the measured distance:

● In the center of the effective range the quality is 100%.  

● On the transponder and on the border of the effective range, the quality is 0%.

Operation
The object is for display only and cannot be controlled by the operator.

See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

Effective range name (Page 942)

WLAN reception (Page 947)

Zone name  (Page 951)

Zone signal (Page 952)

Configuring additional Mobile Wireless objects (Page 2027)

WLAN reception

Application
The "WLAN reception" object is a control element for some SIMATIC Mobile Panels. The 
"WLAN reception" object displays the signal strength of the WLAN wireless connection. In 
addition, the signal strength is measured and displayed by means of 5 bars.    
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Layout

Symbol Meaning Signal strength
No wireless connection No signal

Very poor wireless connection =<20 % 

Poor wireless connection >20 %
=<40 %

Wireless connection OK >40 %
=<60 %

Good wireless connection >60 %
=<80 %

Very good wireless connection >80 %

Operation
The object is for display only and cannot be controlled by the operator.

See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

Effective range name (Page 942)

Effective range name (RFID) (Page 944)

Effective range signal (Page 946)

Zone name  (Page 951)

Zone signal (Page 952)

Configuring additional Mobile Wireless objects (Page 2027)
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Gauge

Application    
The "Gauge" object shows numeric values in the form of an analog gauge. For example, a 
glance during Runtime is enough to note that the boiler pressure is in the normal range.

 

 Note

The gauge is for display only and cannot be controlled by the operator.

Configure system functions that are performed at value changes in the tag properties at the 
"Value change" event and not at the "Change" event of the gauge. If your project is to comply 
with Good Manufacturing Practices, and the system function performs a GMP-relevant action. 
e.g. increasing a GMP-relevant tag, every value change of the tag used at the gauge is 
interpreted as a user action.

 

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Display peak value pointer: Specifies whether the actual measurement range is indicated 
with a slave pointer.

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Start value of the danger range and start value of the warning range: Specifies the scale 
value from which the danger range and the warning range start.

● Display normal range: Specifies whether the normal range is shown in color on the scale.

● Color of individual ranges: Different operating modes, such as normal range, warning range 
and danger range, are shown in different colors so that the operator can distinguish them 
easily.
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Display peak value   
The "Display peak value" property can be used to activate a marker function for the maximum 
and minimum pointer movement in Runtime. The actual measurement range is shown with a 
slave pointer.

1. In the Inspector window, activate "Properties > Properties > Appearance > Show peak 
values".

Maximum Value and Minimum Value   
Define the range of the scale in the inspector window.

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a number under "Scale > Maximum value" and at "Minimum value".
If you select a tag as the end value of the scale, the number will be no longer available.

Start value of the danger range and start value of the warning range   
Define the scale value at which the danger range and the warning range start in the inspector 
window.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Input the start value at "start value of danger range" and "start value of warning range".

3. Activate "start value of danger range" and "start value of warning range" to display the 
ranges on the scale.

Normal range visible   
In the inspector window, define whether to show the normal range in color.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Activate "Normal".

Color of individual ranges   
You can display the normal range, the danger range and the warning range in different colors. 
Define the color in the inspector window.

1. In the Inspector window, select "Properties > Properties > Areas".

2. Select a color from the color palette for the three areas.
 

  Note

The following restrictions apply for HMI devices with Windows CE:
● The three ranges (normal / warning / danger) are not visualized in different colors in 

Runtime.
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See also
Device-Specific Nature of the Objects (Page 817)

Zone name 

Application
The "Zone name" object is a control element for some SIMATIC Mobile Panels. The "Zone 
name" object shows the names of the zone in which the HMI device is located.   

Layout

Symbol Meaning Description
The "On entry" and "On exit" events of the zone 
and the zone ID can be used in the configuration.

Within the "MixingPlant" zone

– Outside of each zone

Procedure for "On entry" event
1. In the "Zones" or "Zones and effective ranges" editor, configure the function 

"ActivateScreen" on the "On entry" event.

Procedure with zone ID
1. Select an internal tag as the "Zone ID / Connection point ID" in the "Runtime settings > 

General" editor.

2. Animate the visibility of an object, e.g. "I/O field" via the internal tag.

Operation
The object is for display only and cannot be operated.
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See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

Effective range name (Page 942)

Effective range signal (Page 946)

WLAN reception (Page 947)

Zone signal (Page 952)

Zone signal

Application
The "Zone signal" object is a control element for some SIMATIC Mobile Panels. The "Zone 
signal" object indicates how well the Mobile Panel is still in a zone. Compared to the "WLAN 
reception" object, it is not the signal strength that is measured, it is calculated from the 
distance.   

Layout

Symbol Meaning Quality
Within one zone >=15 %

When leaving a zone
When entering a zone

<15 % and
>0 %

Outside of each zone =0 %

The "Zone name" object indicates which zone this concerns.

Calculating the signal quality
The quality of the signal within a zone depends, as follows, on the measured distance:  

● In the centre of the zone the quality is 100%.

● To the rear towards the transponder and to the front away from the transponder, the quality 
starts to diminish linearly.

● On the transponder and on the border of the zone, the quality is 0%.

Operation
The object is for display only and cannot be operated. 
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See also
Device-Specific Nature of the Objects (Page 817)

Charging status (Page 874)

Effective range name (Page 942)

Effective range signal (Page 946)

WLAN reception (Page 947)

Zone name  (Page 951)

9.1.9 Configuring screen navigation

9.1.9.1 Basics on screen navigation

Types of navigation for the screen change
For a production process consisting of multiple subprocesses, you will configure multiple 
screens. You have the following options to enable the operator to switch from one screen to 
the next in Runtime:

● Assign buttons to screen changes

● Configuring screen changes at local function keys

Procedure
Before you create a screen change, define the plant structure and derive from it the screen 
changes that you want to configure. 

Create the start screen under "Runtime Settings > General > Start screen". 

See also
Screen basics (Page 629)

Basics for screen navigation (Page 954)

Assigning button with screen change (Page 954)

Assigning screen change to function key (Page 956)

Overview of working with menus and toolbars (Page 957)

Creating a menu (Page 961)
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9.1.9.2 Basics for screen navigation

Types of navigation for the screen change
For a production process consisting of multiple subprocesses, you will configure multiple 
screens. You have the following options to enable the operator to switch from one screen to 
the next in Runtime:

● Assign buttons to screen changes

● Configuring a screen change at a menu and toolbars
 

  Note

For some HMI devices, you can alternatively create buttons for the screen change in the 
permanent window. In this case, the button is incorporated into every screen.

 

Procedure
Before you create a screen change, define the screen hierarchy based on the plant structure 
and derive from it the screen changes that you want to configure. 

Create the start screen under "Runtime Settings > General > Start screen".  

 

See also
Basics on screen navigation (Page 953)

Example: Configuring toolbars and buttons (Page 970)

9.1.9.3 Assigning button with screen change

Introduction
Configure a button in the screen to switch between the screens on the HMI device during 
operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the Inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created the project.

● You have created the "Screen_2" screen.

● "Screen_1" is created.
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Procedure
1. Double-click "Screen_1" in the project navigation. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to the open screen by drag&drop.
A button with the name "Screen_1" is inserted.

3. In the Inspector window, select "Properties > Events > Click".
The "ActivateScreen" system function is displayed in the "Function list". 

4. At the "Object number" attribute, define, if required, the tab sequence number of the object 
on which the focus is to be set after a screen change. You can also specify a tag that 
contains the object number.

Alternative procedure
1. Move a button from the "Tools" task card to "Screen2" by drag&drop.

2. In the Inspector window, select "Properties > Events > Click".

3. Select the "ActivateScreen" system function.

4. Select "Screen_2" for the "Screen number".

Result
The operator goes to "Screen_1 with the button in Runtime. If you have specified an object 
number, the object with this object number has the focus following a screen change. 

See also
Basics on screen navigation (Page 953)
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9.1.9.4 Assigning screen change to function key

Introduction
Configure a screen change function key in the screen to switch between the screens on the 
HMI device during operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created a project.

● You have created the "Screen_2" screen.

● You have created the "Screen_1" screen.

Procedure
1. Double click "Screen_1" in the project tree. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to a function key, e.g. "F2".
The configured function key displays a yellow triangle. 

3. Click "Properties > Events > Press key" in the inspector window.
The "ActivateScreen" system function is displayed. 

Result
The operator goes to the specified "Screen_2" with function key "F2" in Runtime. 

See also
Basics on screen navigation (Page 953)
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9.1.9.5 Menus and toolbars for Runtime Professional

Basics

Overview of working with menus and toolbars

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all screens of a project and in the screen 
windows. You connect the menu commands and icons with the local scripts. 

Application
You use customized menus and toolbars, for example to implement a screen navigation. The 
customized menus and toolbars are displayed in each screen of a project or in a screen 
window. You can thus move from any screen to all the screens for which you have configured 
screen changes at menu entries or icons.     

See also
Basics on screen navigation (Page 953)

Example: Configuring toolbars and buttons (Page 970)

Menu basics

Introduction
A menu is placed at the top margin of each screen beginning on the left. In a configuration file 
you specify which menu and toolbars are created with this file in screens or screen windows. 
You can configure one menu line for each configuration file.

Menu structure
The configuration options for a menu element depend on the position where the menu is 
located in the menu structure. 

You create the following components for a menu:
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● Main menu command

– Is displayed in the screen.

– Opens a submenu.

● Menu item

– Is displayed in the screen when the main menu opens.

– Executes a defined procedure when clicked.

– You can enter a parameter (for example a screen name) that is to be passed to the 
procedure under "Properties > Events."

– Opens a submenu, if it exists.

● Submenu command

– Is displayed in the screen when the higher-level menu item is open.

● Separator lines between the menu entries

The following figure shows a typical menu structure with different menu elements:

Editing options
You have the following options for configuring a menu:

● Adding a new main menu

● Adding a new menu command / submenu command

● Adding a separator line

● Moving a selected menu command to the left

● Moving a selected menu command to the right

● Changing settings in the Inspector window

See also
Example: Configuring toolbars and buttons (Page 970)
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Configuration

Introduction
The menus and toolbars that you have configured are combined in the configuration files. Each 
configuration file contains a maximum of one menu, but can contain several toolbars. You can 
create any number of configuration files. A configuration file is selected for the following 
reasons: 

● To add a menu and a toolbar to a screen window

● To add a menu and a toolbar to all the screens of your project

● To exchange the menus and toolbars in Runtime dynamically

Configuring a configuration file
You have the following options for configuration a configuration file:

● Assign authorizations
The elements are automatically disabled if a logged in user does not have the required 
authorization. 

● Hiding or disabling menu entries and icons
You can also exchange the configuration file, for e.g. in case of user change during runtime, 
if you save the modified functional scope in a new configuration file. 

See also
Example: Configuring toolbars and buttons (Page 970)

"Menus and Toolbars" editor 

Introduction
Use the "Menus and Toolbars" editor to create, configure and edit customized menus and 
toolbars. The customized menus and toolbars are combined in the configuration files and are 
then displayed in all the screens of a project as well as in the screen windows. You connect 
the menu commands and icons with the local scripts. 

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
System Manual, 08/2011,  959



Layout   
The "Menus and Toolbars" editor has three tabs:

● Toolbars

● Menus

● Configurations

You open the editor in the project navigation by double-clicking "Screen management > Menus 
and Toolbars".

 

Work area
The work area is divided into two sections in the "Toolbars" and "Menus" tabs:

● In the table you define the complete toolbar and/or complete menu.

● The lower section offers you a preview of your toolbars or menus. You create and configure 
the individual icons and/or menu commands and specify the structure, labelling texts and 
symbolizing graphics.
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The "Configurations" tab has an undivided work area that contains the table editor for selecting 
the corresponding toolbars and the corresponding menus. 

Inspector window
You configure the menus and toolbars in the Inspector window under "Properties > Properties." 

See also
Example: Configuring toolbars and buttons (Page 970)

Working with menus and toolbars

Creating a menu

Introduction
In the "Menus and Toolbars" editor you create a menu with main menu commands and the 
corresponding menu commands with up to six hierarchy levels. The menu is shown as it is 
displayed later in the screens or a screen window.

Requirement
● The "Menus and Toolbars" editor is open.

● The "Menus" tab is open.

Creating a menu
1. Double-click "Add" in the "Menus" table.

The first main menu command is created in the preview of the menu commands.

2. Change the name of the menu and enter a comment, if appropriate.

Creating main menu commands   
1. Click in the preview of the menu on the already created main menu command.

Four yellow stars are displayed around the selection rectangle.

2. Click the yellow star to the right of the standard text.
A further main menu command is created.

3. Enter a name under "Properties > Properties > General >Name" in the Inspector window.

4. Enter a label for the main menu command "Properties > Properties > General >Text" in the 
Inspector window.
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1. To display the main menu command as visible in Runtime, activate "Properties > Properties 
> Miscellaneous > Visibility".

2. To define an operator authorization, select an authorization under "Properties > Properties 
> Security".

Creating menu commands   
1. Click in the preview on a main menu command.

Yellow stars are displayed around the selection rectangle.

2. Click the yellow star below the selection rectangle.
A menu command is created under the main menu command.

3. Configure the menu command in the Inspector window like a main menu command.
 

  Note

The authorization, visibility and activation for Runtime can be configured both in the menu 
as well as in each individual menu command. In the case of differing configurations the 
following applies: Menu overwrites menu command.

 

Creating submenu commands   
1. Click in the preview on a menu command.

Yellow stars are displayed around the selection rectangle.

2. Click the yellow star to the right of the menu command.
A submenu command is created.

3. Configure the submenu command in the Inspector window like a main menu command.

Result
The menu is created and can be selected as the menu for a specific configuration file in the 
"Configurations" tab.

See also
Editing menus and toolbars (Page 966)

Basics on screen navigation (Page 953)
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Creating a toolbar

Introduction
Use the "Menus and Toolbars" editor to create a toolbar with buttons. The toolbar is shown in 
the preview as it is displayed later in the screens or a screen window.

You can configure any number of toolbars for each configuration. For each toolbar you specify 
the placement position of the toolbar in the screen. Further, you can also define whether the 
user should have the option of freely placing the toolbar. 

 

 Note

Toolbars are device-specific due to the connected scripts. The functionalities are lost when 
they are used for a different device.

 

Requirement
● The "Menus and Toolbars" editor is open.

● The tab "Toolbars" is displayed.

Creating a toolbar
1. Double-click "Add" in the "Toolbars" table.  

A toolbar is created and has a pre-assigned name given to it.
A button is created in the preview of the toolbar.

2. Enter a name to the toolbar in the "Name" column.

3. Select one of the following options as "Button type":

– Text and graphics combined

– Graphics only

– Text only

4. Specify the size of the buttons in the "Screen size" column.
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Adjusting buttons
1. Select the toolbar for which you want to create buttons.

2. Click the already existing button in the preview of the toolbar.  
The button contains a default text and/or a default graphic depending on the type.

The properties are displayed in the Inspector window.

3. Enter a name under "Properties > Properties > General" in the Inspector window.

4. Depending on the button type, select a text and/or a graphic for the button design.

5. To display the button as visible in Runtime, activate "Properties > Properties > 
Miscellaneous > Visibility".

6. To display a tooltip in Runtime, enter a text under "Properties > Properties > Miscellaneous 
> Tooltip".

7. To define an operator authorization, select an authorization under "Properties > Properties 
> Security".

8. To insert further buttons, click in the preview of the toolbar on the  symbol.
 

  Note

The authorization, visibility and activation for Runtime can be configured both in the toolbar 
as well as in each individual button. The following rule is valid for different configurations: 
Toolbar overwrites button.

 

Result
A toolbar with the define toolbars has been created and can be selected as the menu for a 
specific configuration file in the "Configurations" tab.
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See also
Example: Configuring toolbars and buttons (Page 970)

Creating a configuration file

Introduction
Use a configuration file to display menus and/or toolbars in all screens of your project or in a 
screen window. A configuration file consists of one/no menu and/or any number of toolbars. 

Requirement
● The "Menus and Toolbars" editor is open.

● The "Configurations" tab is displayed.

● Menus and toolbars are required.

Creating a configuration file    
1. Double-click "Add" in the "Configurations" table. A configuration file is created.

2. Change the name of the configuration file and enter a comment, if appropriate.

3. Select a name under "Properties > Properties > Menu >Name" in the Inspector window.

4. Specify whether the menu is to be activated and visible in Runtime and which authorization 
is required for operation.
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5. Select the toolbars you want to add to the configuration file under "Properties > Properties 
> Toolbars" in the Inspector window.

6. Specify for each selected toolbar whether or not the toolbar is to be activated and visible 
in Runtime and which authorization is required for operation.

7. You define the alignment for each toolbar in "Properties > Properties > Toolbars" in the 
Inspector window.

Result
The configuration file can be selected in the project for all screens or in a screen window.

See also
Example: Configuring toolbars and buttons (Page 970)

Editing menus and toolbars

Introduction
You edit and change already created menus and toolbars in the work are of the "Menus and 
Toolbars" editor". 

Inserting a separation line
1. Open the "Menus" tab or Toolbars" tab.

2. Select the menu command or button in front of which you want to insert a separation line.

3. Click . 
A separation line is shown before the selected menu item. 

You can alternatively insert separation lines by means of the shortcut menu and the command 
"Add separator."
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Moving a menu command / button
1. Open the "Menus" tab or Toolbars" tab.

2. Select the menu command or the button you wish to move.

3. Click one of the symbols  or .
The menu command or button is moved one place to the left or to the right.

Alternatively, you can move a selected element by dragging and dropping it onto the desired 
position. A marking displays the selected target position.

Showing and hiding menus
1. Open the "Menus" tab.

2. To display all the menu commands, click . 

3. To display only the main menu commands, click the  symbol. 
Only the main menu is displayed.

See also
Creating a menu (Page 961)

Example: Configuring toolbars and buttons (Page 970)

Configuring menus and toolbars for all the screens

Introduction
In the Runtime settings you can define a configuration file with a user-defined menu and 
toolbars as standard. The customized menu and toolbars are displayed in each screen at the 
configured position. 

You can use VB Script to load other configuration files in Runtime. For e.g. when another user 
logs in, you can load a configuration file with modified scope of customized menus and toolbars. 

Configuring menus and toolbars for all the screens

1. Open the "Runtime settings" editor.

2. Select the configuration file whose menu and toolbars are to be displayed in all the screens 
of your project under "General > Menus and toolbars."

Result
When you activate a project, all customized menus and toolbars will be displayed in all the 
screens of the project. 
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See also
Example: Configuring toolbars and buttons (Page 970)

How to configure menus and toolbars in a screen window

Introduction
Independent of the start configuration, you can load, in a screen window, an additional 
configuration file with customized menus and toolbars.   

The customized menus and toolbars of the screen window and the start configuration can thus 
be displayed in the screen window. 

Requirement
● You have created a configuration file.

● A screen is open.

How to configure menus and toolbars in a screen window
1. Drag-and-drop the "Screen window" object into the screen.

2. In the Inspector window, select the configuration file in "Properties > Properties > General".

Result
The customized menus and toolbars are displayed in the screen window during runtime. 

See also
Example: Configuring toolbars and buttons (Page 970)

Adapting menus and toolbars in Runtime

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all screens of a project and in the screen 
windows. You connect the menu entries and icons with procedures from the local scripts. 

Example
You can dynamize the "MT configuration" property in a screen window. It is also possible to 
change the configuration of the basic screen and the screen window by means of VB script.

The following example shows a procedure in which the configuration file is transferred as a 
parameter.
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Sub ChangeMenuToolbarConfigFile (ByVal strMTConfigFile)
HMIRuntime.MenuToolBarConfig = strMTConfigFile
End Sub

 

 Note

One menu and several toolbars can be configured in every configuration. 

You can make individual elements of menus or buttons inactive or invisible. This allows 
display of an adapted functional scope in various screens by editing the configuration and 
saving it under a different name.

 

See also
Example: Configuring toolbars and buttons (Page 970)

Connecting a menu command or icon to a procedure

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all the screens of a project and/or also in a 
screen window. The individual menu commands and buttons are connected with a function 
list. Only "Click" is available as an event.     

Requirement
● A "Screen_1" screen has been created.

● A "Screen_2" screen has been created.

● The "Menus and Toolbars" editor is open.

● A button or menu command is created.

Configuring an event with a system function to a button or menu command.
1. Select the button or menu command.

2. In the Inspector window, select "Properties > Events > Click".
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3. Select the "ActivateScreen" system function from the function list.

4. Select "Screen_2" as the "Screen name".

Configuring an event to a button or menu command via scripts.
1. Select the button or menu command.

2. In the Inspector window, select "Properties > Events > Click".

3. Click the icon  "VB script" in the toolbar of the Inspector window.

4. Write the required script.
The "Item" is the object that triggers the event, in this case the button or the menu command. 
It is specified using the "Name" property in the script.

Result
When the operator clicks the button or the menu command, the configured function is executed 
in Runtime. 

See also
Example: Configuring toolbars and buttons (Page 970)

Example: Configuring a screen change with toolbars

Example: Configuring toolbars and buttons

Introduction
Your process is split into six process image partitions. One screen is the start screen that does 
not have a higher-level screen.

Visualizing processes (Professional)
9.1 Creating screens

WinCC Professional V11.0 SP1
970 System Manual, 08/2011,  



Requirement
● The screens of the project have been created.

● The "Menus and Toolbars" editor is open.

● The "Toolbars" tab is opened.

Creating a toolbar for a start screen
1. Click "Add" in the "Toolbars" table. An toolbar is created.

2. Enter the name "Screen_Change_Start_Screen" in the column.

3. Select the setting "Combined" as the "Button type".

4. Select the screen size "S48x48".

5. Repeat the procedure: Create a toolbar with a corresponding name for each screen.

Creating buttons for a start screen
1. Select the first button and select "Properties > Properties > General" in the Inspector 

window.

2. Enter the text "Screen up" under "Text".

3. Select the graphic "Up_Arrow" under "Graphic".

4. To display the button as visible in Runtime, activate "Properties > Properties > 
Miscellaneous > Visibility".
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5. Enter the text "Changes to parent screen" under "Properties > Properties > Miscellaneous 
> Tooltip".

6. Click  in the preview of the toolbar.

A button is created.

7. Repeat the procedure for all the buttons with the following properties:

– Button_2: Text: "Screen down"; Graphic: "Down_Arrow".

– Button_3: Text: "Screen left"; Graphic: "Left_Arrow".

– Button_4: Text: "Screen right"; Graphic: "Right_Arrow".

– Button_5: Text: "Start screen"; Graphic: "Home".

Result
A specific toolbar is now available for each screen. 

Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Assigning system functions to buttons

● Inserting toolbars into a configuration file

● Configuring in the screen window

See also
Basics for screen navigation (Page 954)

Example: Configuring functions at buttons

Introduction
In order for each button to execute the desired function during a screen change, configure the 
system functions using the function lists.   

Requirement
● The toolbars for all the screens have been created.

● Buttons for the corresponding screens have been created for each toolbar.
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● The "Menus and Toolbars" editor is open.

● The "Toolbars" tab is opened.

Configuring system functions at a button of the toolbar.
1. Open the toolbar for the start screen.

2. Select the first button.

3. In the Inspector window, select "Properties > Events > Click".

4. Select the "ActivateScreen" system function from the function list.

5. Enter the name of the screen to which the change is to take place under "Screen name."

6. Enter "2" under "Object number" as the screen object in the screen to which the change is 
to take place. The focus is set to the screen object with the tab sequence number "2."

 

  Note

The object number is defined during the configuration of the tab sequence in the screen. 
The sequence can be displayed in the screen by selecting the menu command "Edit > 
Tab sequence > Edit tab sequence".

 

7. Repeat the procedure for all the buttons of this toolbar:
Always select the screen to be activated with the corresponding button as "Screen name".

8. Repeat the procedure for all the toolbars of the other screens:

Result
The buttons of all the toolbars are configured with the desired system functions for changing 
the screen.

Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Creating configuration files with toolbars

● Configuring configuration files in the screen window

Example: Creating a configuration file

Introduction
In a configuration you specify which menu and toolbars are created with this file in screens or 
screen windows.
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Requirement
● The toolbars for all the screens have been created.

● Buttons are created for every toolbar.

● The "Menus and Toolbars" editor is open.

● The "Configurations" tab is opened.

Defining a configuration
1. Click "Add" in the "Configurations" table. 

A new configuration is created.

2. Enter the name "Configuration_Start_Screen" in the "Name" column.

3. Select the toolbar "Toolbar_start_screen" in the "Toolbars" table.

4. Select the setting "Down" under "Alignment".
The toolbar is displayed in the screen window at the lower margin of the display section.

5. To protect the toolbar with an operator authorization in Runtime, select an authorization.

6. Repeat the procedure for each screen you wish to create:

Result
The configuration files for displaying the toolbars of all screen windows have been created.

Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Configuring configuration files in the screen window

Example: Configuring a configuration file in the screen window

Introduction
To change from any screen to additional screens, create as many screen windows as you 
require to represent your complete process in an overview screen. Both the corresponding 
screen and the associated configuration are configured in each screen window.

Requirement
● Screens have been created.

● A configuration file is created for each screen.
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Configuring a configuration file in a screen window
1. Double-click "Screens > Add Screen" in the project window. A new screen is created.

2. Assign the name "Overview_Screen_Project" to this screen.

3. Drag-and-drop the "Screen window" object into the screen.

4. Enter a name for the title bar under "Properties > Properties > General >Title" in the 
Inspector window.

5. Select a screen that is displayed in the screen window in the Inspector window under 
"Properties > Properties > General > Name".

6. Define the configuration under "Properties > Properties > General > Configurations" in the 
Inspector window.

7. Repeat the procedure for all the screens and configurations.

Result
An overview screen with screen windows is created. A screen and a configuration are defined 
for each screen window. 

9.2 Working with tags

9.2.1 Basics

9.2.1.1 Basics of tags

Introduction
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

The external tags form the link between WinCC and the automation systems. The values of 
external tags correspond to the process values from the memory of an automation system. 
The value of an external tag is determined by reading the process value from the memory of 
the automation system. It is also possible to rewrite a process value in the memory of the 
automation system.
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Internal tags do not have a process link and only convey values within the WinCC.

Tags in WinCC
For external tags, the properties of the tag are used to define the connection that the WinCC 
uses to communicate with the automation system and form of data exchange.  

Tags that are not supplied with values by the process - the internal tags - are not connected 
to the automation system. In the tag's "Connection" property, this is identified by the "Internal 
tag" entry.

You can create tags in different tag tables for greater clarity. You then directly access the 
individual tag tables in the "HMI tags" node in the project tree. The tags from all tag tables can 
be displayed with the help of the table "Show all tags".

With structures you bundle a number of different tags that form one logical unit. Structures are 
project-associated data and are available for all HMI devices of the project. You use the "Types" 
editor in the project library to create and edit a structure.

See also
Internal Tags (Page 982)

External tags (Page 979)

Cycle basics (Page 1034)

Basics on user data types (Page 1023)

Basics on arrays (Page 1019)

Overview of HMI tag tables (Page 977)

Addressing external tags (Page 980)

Creating external tags (Page 984)

Cycle basics (Page 1036)

Basic principles for data logging (Page 1107)

External tags (Page 978)

Internal Tags (Page 983)

Outputting tag values in screens (Basic) (Page 1169)
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9.2.1.2 Overview of HMI tag tables

Introduction
HMI tag tables contain the definitions of the HMI tags that apply across all devices. A tag table 
is created automatically for each HMI device created in the project.    

In the project tree there is an "HMI tags" folder for each HMI device. The following tables can 
be contained in this folder:

● Default tag table

● User-defined tag tables

● Table of all tags

In the project tree you can create additional tag tables in the HMI tags folder and use these to 
sort and group tags and constants. You can move tags to a different tag table using a drag-
and-drop operation or with the help of the "Tag table" field. Activate the "Tags table" field using 
the shortcut menu of the column headings.

Default tag table
There is one default tag table for each HMI device of the project. It cannot be deleted or moved. 
The default tag table contains HMI tags and, depending on the HMI device, also system tags. 
You can declare all HMI tags in the standard tags table or, as necessary, additional user-
defined tables of tags.

User-defined tag tables
You can create multiple user-defined tag tables for each HMI device in order to group tags 
according to your requirements. You can rename, gather into groups, or delete user-defined 
tag tables. To group tag tables, create additional subfolders in the HMI tags folder. 

All tags
The "All tags" table shows an overview of all HMI tags and system tags of the HMI device in 
question. This table cannot be deleted, renamed or moved. This table also contains the "Tags 
table" column, which indicates the tag table of where a tag is included. Using the "Tags table" 
field, the assignment of a tag to a tags table can be changed. 

With devices for Runtime Professional, the table "All tags" contain an additional tab "System 
tags". The system tags are created by the system and used for internal management of the 
project. The names of the system tags begin with the "@" character. System tags cannot be 
deleted or renamed. You can evaluate the value of a system tag, but cannot modify it.
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Additional tables
The following tables are also available in an HMI tag table:

● Discrete alarms

● Analog alarms

● Logging tags

With the help of these tables you configure alarms and logging tags for the currently selected 
HMI tag. 

Discrete alarms table
In the "Discrete alarms" table, you configure discrete alarms to the HMI tag selected in the 
HMI tag table. When you configure a discrete alarm, multiple selection in the HMI tag table is 
not possible. You configure the discrete alarms for each HMI tag separately.

Analog alarms table
In the "Analog alarms" table, you configure analog alarms to the HMI tag selected in the HMI 
tag table. When you configure an analog alarm, multiple selection in the HMI tag table is not 
possible. You configure the analog alarms for each HMI tag separately.

Logging tags table
In the "Logging tags" table, you configure logging tags to the HMI tag selected in the HMI tag 
table. When you configure a logging tag, multiple selection in the HMI tag table is not possible. 
You configure the logging tags for each HMI tag separately. The "Logging tags" table is only 
available if the HMI device used supports logging. 
If WinCC Runtime Professional is used, you can also assign several log tags to a tag. With 
the other HMI devices, you can only assign one log tag to a tag.

See also
Basics of tags (Page 975)

9.2.1.3 External tags

Introduction
External tags allow communication (exchange of data) between the components of an 
automation system, such as between the HMI device and the PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.  
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Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

In STEP 7, if you write a PLC control program, the PLC tags created in the control program 
will be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access 
the PLC tags directly via the PLC tag table and connect them to the external tag.

Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. Information about data types which are available for connection to other PLCs can 
be found in the documentation about the respective communication drivers.

See "Auto-Hotspot" for additional information.
 

 Note

As well as external tags, area pointers are also available for communication between the HMI 
device and PLC. You can set up and enable the area indicators in the "Connections" editor.

 

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.   

See also
Basics of tags (Page 975)

9.2.1.4 External tags

Introduction
External tags allow communication (exchange of data) between the components of an 
automation system, such as between the HMI device and the PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.  

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.
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If you write a PLC control program in STEP 7, the PLC tags created in the control program will 
be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access the 
PLC tags directly via the PLC tag table and connect them to the external tag.

Data types
In WinCC all data types will be available at an external tag that are available at the connected 
PLC. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. You can change the data type at the HMI tag, if necessary.

See "Auto-Hotspot" for additional information.

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.   

You can read out the process values directly from the PLC memory, if necessary. Use the 
GetTag functions for this purpose. For more detailed information, refer to the documentation 
for C functions under "GetTag (Page 1868)".

See also
Basics of tags (Page 975)

Adapting the data type of a tag (Page 988)

GetTag (Page 1868)

9.2.1.5 Addressing external tags

Introduction
The options for addressing external tags depend on the type of connection between WinCC 
and the PLC in question. A distinction must be made between the following connection 
types:         

● Integrated connection
Connections of devices which are within a project and were created with "Devices & 
Networks" editor are referred to as integrated connections.

● Non-integrated connection
Connections of devices which were created with the "Connections" editor are referred to 
as non-integrated connections. It is not necessary that all of the devices be within a single 
project.

The connection type can also be recognized by its symbol.
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Integrated connection
Non-integrated connection

You can find additional details on this in the section "Auto-Hotspot".

Addressing with integrated connections
An integrated connection offers the advantage that you can address a tag both symbolically 
and absolutely.

For symbolic addressing, you select the PLC tag via its name and connect it to the HMI tag. 
The valid data type for the HMI tag is automatically selected by the system. You have to 
distinguish between the following cases when you address elements in data blocks:

● Symbolic addressing of data blocks with optimized access
For symbolic addressing of a data block with optimized access, the address of an element 
in the data block is assigned dynamically and automatically applied to the HMI tag in case 
of a change. You do not need to compile the connected data block or the WinCC project 
for this step.
For data blocks with optimized access, only symbolic addressing is available.

● Symbolic addressing of data blocks with standard access
For symbolic addressing of a data block with standard access, the address of an element 
in the data block is assigned permanently. The valid data type for the HMI tag is 
automatically selected by the system. Any change in the address of an element in the data 
block is applied directly to the HMI tag. You do not need to compile the connected data 
block or the WinCC project for this step.
For data blocks with standard access, you can use symbolic addressing as well as absolute 
addressing.

For symbolic addressing of elements in a data block, you only need to recompile and reload 
the WinCC project in case of the following changes:

● If the name or the data type of the connected data block has changed.

● If the name or the data type of a higher-level structure node of the connected element in 
the data block has changed.

● If the name of the connected data block has changed.

Symbolic addressing is currently only available on PLCs of the SIMATIC S7 1200 type. 
Addressing with optimized access is only available in an integrated connection.

You can also use absolute addressing with an integrated connection. You have to use absolute 
addressing for PLC tags from a SIMATIC S7 300/400 PLC. If you have connected an HMI tag 
with a PLC tag and the address of the PLC tag changes, you only have to recompile the control 
program to update the new address in WinCC. Then you recompile the WinCC project and 
load it onto the HMI device.

In WinCC, symbolic addressing is the default method. To change the default setting, select 
the menu command "Options > Settings". Select "Visualization > Tags" in the "Settings" dialog. 
If required, disable the "Symbolic access" option.     

The availability of an integrated connection depends on the PLC used. The following table 
shows the availability:
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PLC Integrated connection Comments
S7 300/400 Yes The linking of tags is not checked in Runtime. If 

the tag address changes in the PLC and the HMI 
device is not compiled again and loaded, the 
change is not registered in runtime.

S7 1200 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. The reaction described for S7 300/400 
applies whilst addressing with standard access.

Create an integrated connection in the "Devices & Networks" editor. If the PLC is contained in 
the project and integrated connections are supported, you can then also have the connection 
created automatically. To do this, when configuring the HMI tag, simply select an existing PLC 
tag to which you want to connect the HMI tag. The integrated connection is then automatically 
created by the system.

Addressing with non-integrated connections
In the case of a project with a non-integrated connection, you always configure a tag connection 
with absolute addressing. Select the valid data type yourself. If the address of a PLC tag 
changes in a project with a non-integrated connection during the course of the project, you 
also have to make the change in WinCC. The tag connection cannot be checked for validity 
in Runtime, an error message is not issued.

A non-integrated connection is available for all supported PLCs.

Symbolic addressing is not available in a non-integrated connection.

With a non-integrated connection, the control program does not need to be part of the WinCC 
project. You can perform the configuration of the PLC and the WinCC project independently 
of each other. For configuration in WinCC, only the addresses used in the PLC and their 
function have to be known.

See also
Basics of tags (Page 975)

9.2.1.6 Internal Tags

Introduction
Internal tags do not have any connection to the PLC.  

Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.  
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You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
Array One-dimensional array
Bool Binary tag
DateTime Date/time format
DInt Signed 32-bit value
Int Signed 16-bit value
LReal Floating-point number 64-bit IEEE 754
Real Floating-point number 32-bit IEEE 754
SInt Signed 8-bit value
UDInt Unsigned 32-bit value
UInt Unsigned 16-bit value
USInt Unsigned 8-bit value
WString Text tag, 16-bit character set

See also
Basics of tags (Page 975)

9.2.1.7 Internal Tags

Introduction
Internal tags do not have any connection to the PLC.  

Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.  

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
Bool Binary tag
DInt Signed 32-bit value
Int Signed 16-bit value
LReal Floating-point number 64-bit IEEE 754
Raw Raw data
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HMI data type Data format
Real Floating-point number 32-bit IEEE 754
SInt Signed 8-bit value
String Text tag, 8-bit character set
TextRef Text reference
UDInt Unsigned 32-bit value
UInt Unsigned 16-bit value
USInt Unsigned 8-bit value
WString Text tag, 16-bit character set

See also
Basics of tags (Page 975)

9.2.2 Working with Tags

9.2.2.1 Creating tags

Creating external tags

Introduction
You can access an address in the PLC via a PLC tag using an external tag. The following 
options are available for addressing:

● Symbolic addressing

● Absolute Addressing

For additional information on symbolic addressing see the section "Addressing external tags 
(Page 980)". If possible, use symbolic addressing when configuring a tag. You create tags 
either in the standard tag table or in a tag table you defined yourself.     

Requirement
● You have opened the project.

● A connection to the PLC is configured.

● The Inspector window is open.
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Procedure
To create an external tag, proceed as follows:

1. Open the "HMI tags" folder in the project tree and double-click the standard tag table. The 
tag table is opened.
Alternatively, create a new tag table and then open it.

2. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

3. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. The tag name must be unique 
throughout the device.

4. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.

5. Select the connection to the required PLC in the "Connection" box. If the connection you 
require is not displayed, you must first create the connection to the PLC. You create the 
connection to a SIMATIC S7 PLC in the "Devices & Networks" editor. You create the 
connection to external PLCs in the "Connections" editor.
If the project contains the PLC and supports integrated connections, you can have the 
connection created automatically. To do this, when configuring the HMI tag, simply select 
an existing PLC tag to which you want to connect the HMI tag. The integrated connection 
is then automatically created by the system.

6. If you are working with an integrated connection, click the  button in the "PLC tag" field 
and select an already created PLC tag in the object list. Click the  button to confirm the 
selection.

7. If you are working with a non-integrated connection, enter the address from the PLC in the 
"Address" field. The "PLC tag" field remains empty.

8. Configure the other properties of the tag in the inspector window.

You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.   
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You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
by clicking the  button in the object list. You then configure the new tag in the 
Inspector window.

Result
An external tag has been created and linked to a PLC tag or an address in the PLC.

See also
Creating internal tags (Page 986)

Creating multiple tags (Page 987)

Addressing external tags (Page 980)

Adapting the data type of a tag (Page 988)

Editing a Tag (Page 990)

Tag Limits (Page 996)

Basics of tags (Page 975)

Creating internal tags

Introduction
You must at least set the name and data type for internal tags. Select the "Internal tag" item, 
rather than a connection to a PLC.        

For documentation purposes, it is a good idea to enter a comment for every tag.

Requirement
You have opened the project.

Procedure
1. Open the "HMI tags" folder in the project tree and double-click the entry "Standard tag 

table". The tag table is opened.
Alternatively, create a new tag table and then open it.

2. If the Inspector window is not open, select the "Inspector window" option in the "View" menu.

3. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. This tag name must be unique 
throughout the project.

4. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.

5. Select "Internal tag" as the connection in the "Connection" field.
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6. Select the required data type in the "Data type" field.

7. In the "Length" field, you must specify the maximum number of characters to be stored in 
the tag according to the selected data type. The length is automatically defined by the data 
type for numerical tags.

8. As an option, you can enter a comment regarding the use of the tag. To do so, click 
"Properties > Properties > Comment" in the Inspector window and enter a text.

You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.

You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
by clicking the  button in the object list. You can then configure the new tag in 
the Properties window that opens.

Result
An internal tag is created. You can now use this in your project.

In additional steps you can configure the tag, for example, by setting the start value and limits.

See also
Creating external tags (Page 984)

Creating multiple tags

Introduction
In a tag table, you create additional identical tags by automatically filling the rows of the table 
below a tag.

The tag names are incremented automatically when filling in automatically.

You can also use the auto fill function to fill table cells below a tag with a single tag property 
and thus modify the corresponding tags.

If you apply the automatic filling in to already filled cells of a tab table, you will be asked whether 
you want to overwrite the cells or insert new tags.

If you do not want to overwrite already configured tags, activate insert mode. Activate insert 
mode by keeping the <Ctrl> key pressed during insertion. Already existing entries in the tag 
table are moved down if insert mode is activated.

Requirement
● You have opened the project.

● A tag table is open.

● The tag which is to serve as a template for other tags is configured.
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Procedure
1. If you want to create new tags, mark in the "Name" column the tag that should be used as 

a template for the new tags.
If you want to copy a property of a tag to the tags below it, select the cell which contains 
this property.
The selected cell will be highlighted in color and a small blue square will appear in its bottom 
right corner. If you move the mouse over this square, the cursor will change to a black cross.

2. Hold down the mouse button and drag this square over the cells below that you wish to fill 
automatically.
The marking will be extended to cover this area.

3. Now release the mouse button. All of the marked cells will be filled automatically.
New tags will be created in all empty cells in the marked area.

Result
Depending on which cells were selected, the function may automatically fill individual 
properties or create new tags.

See also
Creating external tags (Page 984)

Adapting the data type of a tag

Introduction         
When you create a tag, you assign one of the possible data types to the tag. This data type 
depends on the type of data for which you would like to use the tag.

The data types available depend on the connected communication partner, such as a PLC.
 

 Note

If you modify the data type of an existing, external tag, the previously defined tag address is 
identified as invalid. This reason for this is that the PLC address changes when the data type 
is modified.

 

Format adjustment
WinCC sets the data type of an external tag according to the data type of the connected PLC 
tag. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. As required, you can specify that WinCC uses a different 
data type and converts the format of the data type of the PLC tag and the data type of the HMI 
tag.     
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In WinCC, you have access to the following data types:

HMI data type Description Value range
SInt Signed 8-bit value -128 ... +127
USInt Unsigned 8-bit value 0 ... 255
Int Signed 16-bit value -32768 ... +32767
UInt Unsigned 16-bit value 0 ... 65535
DInt Signed 32-bit value -2147483648 ... +2147483647
UDInt Unsigned 32-bit value 0 ... 4294967295
Real Floating-point number 32-bit IEEE 754 +-3.402823e+38
LReal Floating-point number 64-bit IEEE 754 +-1.79769313486231e+308
Bool Binary tag 0 ... 1
String Text tag, 8-bit character set  
WString Text tag, 16-bit character set  
TextRef Text reference  
Raw Raw data type  

 

For format adaptation, select the desired PLC data type at the respective external tag. The 
suitable standard data type is then selected automatically in the "HMI data type" field for use 
in WinCC. Change the format adaptation as required. Additional information is available in the 
following section:

● Mapping and coding of data types (Page 1039)

Data types without format adaptation
The data types are shown 1:1 without format adaptation.

SIMATIC S7 300/400 data types without format adaptation

PLC data type Description
Bool No format adaptation
String No format adaptation

OPC-DA data types without format adaptation

OPC-DA data type Description
VT_BSTR No format adaptation
VT_BOOL No format adaptation

OPC-DA XML data types without format adaptation

OPC-DA data type Description
String No format adaptation
boolean No format adaptation
Base64Binary No format adaptation
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See also
Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

Data types for SIMATIC S7 300/400 (Page 1048)

Creating external tags (Page 984)

Data types for SIMATIC S7 1200 (Page 1058)

Data types for Allen Bradley Ethernet IP (Page 1082)

Data types for Modicon Modbus TCP/IP (Page 1089)

Data types for Mitsubishi MC (Page 1096)

Mapping and coding of data types (Page 1039)

9.2.2.2 Editing Tags

Editing a Tag

Introduction
You can always rename, copy or delete tags.

When a tag is renamed, the new name must be unique for the whole device.

If you use the "Copy" command to copy a tag to the clipboard, the objects and references 
linked to the tag are copied as well.

If you use the "Insert" command to add a tag to another device, the tag will be added without 
the connected references. Only the object name of the reference will be inserted. If a reference 
of the same name and valid properties exists in the target system, the existing reference will 
then be connected to the copied tag.

If you copy a tag, some of the objects linked to the tag are copied as well. The following objects 
are copied:

● Logging tags

● Cycles

● Alarms

If you add the copied tag to another device, the tag is added together with the linked objects.

Requirement
● The tag which you wish to rename, copy or delete must exist.

● The tag table containing the tag is open.
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Renaming tags
1. In the "Name" field, select the tag in the tag table.  

2. Select "Rename" from the shortcut menu.

3. Type in a new name.
The tag appears under its new name.

Copying tags
1. Mark one or more tags in the tags table.  

2. Select "Copy" from the shortcut menu.

3. Click on the point at which you want to insert the tag. For example, click another tag table 
in the same device or the tag table in a second device.

4. Select "Paste" from the shortcut menu. The tag is inserted as described above.

Deleting a tag
1. Select one or more tags in the tag table.  

2. Select the "Cross-reference" command from the "Tools" menu. In the "Cross-reference" 
editor, check to see where the tags are used. In this manner, you can see what impact the 
deletion of the tag will have on your project.

3. Select "Delete" in the pop-up menu of the tag.
All marked tags will be deleted.

Export and import of tags
WinCC gives you the option to export and import tags. With Export and Import, you have the 
option to export tags from one project and import them into another project. There is also the 
option to create larger numbers of tags outside of WinCC, edit them and subsequently import 
into any WinCC project. For further details, refer to Importing and exporting tags (Page 2084).

See also
Changing the tag configuration (Page 992)

Configuring multiple tags simultaneously (Page 992)

Using multiple tags simultaneously in a screen (Page 993)

Reconnecting a tag (Page 995)

Creating external tags (Page 984)

Importing and exporting tags (Page 2084)
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Changing the tag configuration

Introduction
You can modify tags at any time to adapt them to changed requirements in the project.   

Changing the tag configuration
if you want to change the configuration of a tag, open the tag table in which the tag is contained. 
Open the "Show all tags" tag table alternatively.

In the tag tables, you can perform such tasks as comparing and adjusting the properties of 
multiple tags or sorting the tags by their properties.

Change the properties either directly in the table or in the inspector window.

If you change a tag property and this change causes a conflict with another property, it will be 
highlighted in color to draw your attention to this fact. This could happen, for example, if you 
connect the tag to another PLC which does not support this data type.

See also
Editing a Tag (Page 990)

Configuring multiple tags simultaneously

Introduction
In WinCC, you can assign the same properties to multiple tags in a single operation. This 
facilitates efficient programming.   

Requirement
● You created the tags you want to configure.

● The tag table is open.

● The Inspector window is open.

Procedure
1. In the tag table, select all the tags that you want to configure at the same time.

If the selected property is identical for all the tags, the setting for this property will appear 
in the Inspector window. The associated field will remain blank otherwise.

2. You can define the shared properties in the Inspector window or directly in the tag table.

if you change a property commonly on several tags, only this one property is changed. The 
other properties of the tag remain unchanged.
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Result
All marked tags will be reconfigured.

To edit tag properties which differ from one tag to the other, simply clear the multiple selection.

See also
Editing a Tag (Page 990)

Using multiple tags simultaneously in a screen

Introduction
In WinCC, you can create multiple I/O fields that are linked with tags in one screen in a single 
operation. This facilitates efficient programming.

Requirement
● Several tags are set up.

● A screen is open.
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Procedure
1. In the project tree, select the required tag table under "HMI tags".

2. Select the detail view at the bottom of the project tree. The detail view shows the tags that 
exist in the selected tag group.

3. Mark the tags in the detail window.

4. Drag the tags to the screen. For each tag, this creates an I/O field that is connected to the 
tag.

 

 Note

When you move a PLC tag from the detail window to the work area by drag&drop, a network 
and a connection are created additionally in the "Devices & Networks" editor.

 

 

See also
Editing a Tag (Page 990)
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Reconnecting a tag

Introduction
WinCC enables you to automatically connect tags to addresses in the PLC. This procedure is 
suitable if, for example, changes were made to the connection between the HMI device and 
the PLC and the tag connections were lost. The function can also be used if you have 
configured the control program and HMI project separately.

The shortcut menu "Reconnect PLC tag" is available for this.

The menu command is available under the following conditions:

● An integrated connection to the PLC is present.

● The absolute address from the PLC is entered in the HMI tag.

● The HMI tag is configured with the correct data type.

The menu command is not available at a tag with symbolic addressing.

If you select multiple tags, the menu command is available if at least one of the selected tags 
meets the above-mentioned requirements. Only the tags that meet the requirements are 
connected.

Requirement
● You have created an HMI tag.

● The tag table is open.

● A PLC tag with the absolute address from the PLC is present.

Procedure
Proceed as follows to reconnect tags:

1. Select the row with the tag in the tag table.

2. Open the shortcut menu and select the menu command "Reconnect PLC tag".
The system looks for a PLC tag whose absolute address and data type match the settings 
for the HMI tag. If a matching PLC tag is found, the tag connection is established 
immediately.

Result
The PLC tag is connected to the HMI tag.

See also
Editing a Tag (Page 990)
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9.2.2.3 Configuring Tags

Tag Configuration Basics

Tag Limits

Introduction
You can restrict the value range with limits for numerical tags.

Principle
You can specify a value range defined by a high limit and a low limit for numerical tags.   

If the operator enters a value for the tag that is outside the configured value range, the input 
is rejected. The value is not accepted. You configure a function list when configuring for 
Runtime Advanced and Panels. When the tag value leaves the value range, the function list 
is processed. 

 

 Note

If you want to output an analog alarm when a limit is violated, configure the respective tag in 
the "Analog alarms" tab. You can also configure the analog alarm in the "HMI alarms" editor. 
The values for output of an analog alarm depend on the configured tag limits.

 

Application example
Use the limits to warn the operator when the value of a tag enters a critical range, for example.

See also
Defining Limits for a Tag (Page 996)

Start value of a tag (Page 998)

Defining the start value of a tag (Page 998)

Connecting a tag to another PLC (Page 999)

Linear scaling of a tag (Page 1000)

Applying linear scaling to a tag (Page 1001)

Defining Limits for a Tag

Introduction
For numerical tags, you can specify a value range by defining a low and high limit.    
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For Runtime Advanced and Panels you can configure the system to process a function list 
whenever a tag value drops below or exceeds its configured value range.

Requirement
● The tag for which you want to set the limits is created.

● The Inspector window with the properties for this tag is open.

Procedure
To define limits for a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > Limits." If you want to define one 
of the limits as a constant value, select "Constant" using the  button. Enter a number in 
the relevant field.
If you want to define one of the limits as a tag value, select "HMI tag" using the  button. 
Use the object list to define the tag for the limit.

2. To set additional limits for the tag, repeat step 1 with the appropriate settings.

Alternative procedure
You can also configure the high and low limit directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.

Configuring a function list for Runtime Advanced and Panels
When you configure Runtime Advanced and Panels, you can have a function list called up if 
a high or low limit is violated.

1. If you want to start a function list when the value drops below the value range, click 
"Properties > Events > Minimum violated" in the Inspector window. Create a function list in 
this dialog.

2. If you want to start a function list when the value exceeds the value range, click "Properties 
> Events > Maximum violated" in the Inspector window. Create a function list in this dialog.

Result
You have set a value range defined by a high and low limit for the selected tag. If the value 
range is exceeded or undershot, a function list may be carried out.

See also
Tag Limits (Page 996)
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Start value of a tag

Value of a tag at start of Runtime
You can configure a start value for numeric tags and tags for date/time values. The tag will be 
preset to this value when Runtime starts. In this way, you can ensure that the tag has a defined 
status when Runtime starts.   

For external tags, the start value will be displayed on the HMI device until it is overwritten by 
the PLC or by input.

If no start value was configured, the tag contains the value "0" when starting Runtime.

In WinCC Runtime Professional you can enter a tag value in place of the start value on a tag 
with the "String" data type. The tag value is saved in the "Project texts" editor and is multilingual. 
After the text has been translated, it is displayed in Runtime as a language-dependent start 
value.

Application example
You can assign a default value to an I/O field. Enter the desired default value as start value 
for the tag that is linked to the I/O field. 

See also
Tag Limits (Page 996)

Defining the start value of a tag (Page 998)

Defining the start value of a tag

Introduction
In WinCC you can configure a start value for a numeric tag and a tag for date/time values 
which this adopts at Runtime start. 

Requirement
● You have created the tag for which you want to define a start value.

● The Inspector window with the tag properties is open.

Procedure
To configure a start value, proceed as follows:

1. In the Inspector window select "Properties > Properties > Values."

2. Enter the desired "Start value."
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Alternative procedure
You can also configure the start value directly in the tag table. To view hidden columns, activate 
the column titles using the shortcut menu.

Result
The start value you selected for the tag is transferred to the project.

See also
Tag Limits (Page 996)

Start value of a tag (Page 998)

Connecting a tag to another PLC

Introduction
In WinCC, you can change the PLC connection of a tag at any time. This is needed when you 
change the configuration of your plant, for example.

Depending on the PLC selected, you may need to modify the configuration of the tag. The tag 
properties which must be changed will be highlighted in color.   

Requirement
● The external tag, whose connection you wish to change, must already exist.

● The connection to the PLC must already exist.

● The Properties window for this tag is open.

Procedure
To change the PLC connection of a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > General."

2. Select the new connection in the "Connection" field.
The tag properties that you must change will be highlighted in color in the tag table and in 
the Inspector window.

3. Change all highlighted properties of the tag to suit the requirements of the new PLC.

Result
The external tag is connected to the new PLC.

See also
Tag Limits (Page 996)
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Linear scaling of a tag

Introduction
Numeric data types can be processed with linear scaling. The process values in the PLC for 
an external tag can be mapped onto a specific value range in the project.

Principle
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

As soon as data from the HMI device is written to an external tag, it will be automatically 
mapped to the value range of the PLC. As soon as data from the HMI device is read from the 
external tag, a corresponding transformation will be performed in the other direction.

 

 Note

You can also use the system functions "LinearScaling" and "InvertLinearScaling" to 
automatically convert process values.

 

Application example
The user enters length dimensions in centimeters but the PLC is expecting inches. The entered 
values are automatically converted before they are forwarded to the controller. Using linear 
scaling, the value range [0 to 100] on the PLC can be mapped onto the value range [0 to 254] 
on the HMI device.
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See also
Applying linear scaling to a tag (Page 1001)

Tag Limits (Page 996)

Applying linear scaling to a tag

Introduction
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

Requirement
● The external tag to which linear scaling is to be applied must exist.

● The Inspector window with the properties for this tag is open.

Procedure
To apply linear scaling to a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > Linear scaling."

2. Click on "Enable" to switch on linear scaling.
Using this option, you can temporarily switch off linear scaling for testing purposes, for 
example. Settings which were made earlier for linear scaling remain unchanged.

3. In the "PLC" area, enter the start and end values of the value range to be applied to the 
process values on the PLC.

4. In the "HMI device" area, enter the end and start values of the value range to be applied to 
the process values on the HMI device.

Result
In Runtime the data will be automatically mapped from one value range to the other.

 

 Note

You can also use the "LinearScaling" and "InvertLinearScaling" system functions to 
automatically convert process values.

 

See also
Linear scaling of a tag (Page 1000)

Tag Limits (Page 996)
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Special configuration options

Address multiplexing

Introduction
Using address multiplexing, you can use a single tag to access a multitude of memory locations 
within the PLC's address range. You read and write to the addresses without defining a tag 
for each individual address.

Multiplexing with absolute addressing
When using multiplexing with absolute addressing, you configure tags as placeholders for the 
address in the PLC to be addressed.    

If you want to access, for example, an address of the format "%DBx.DBWy", the expression 
for multiplexing is as follows:

"%DB[HMITag1].DBW[HMITag2]"

In Runtime, you supply the tag "HMITag1" with the required value for the data block you want 
to address. 

In Runtime, you supply the tag "HMITag2" with the required address from the data block.

Tags are supplied with values, for example, with the help of values from the PLC or via a script.

Multiplexing with absolute addresses is supported for the following PLCs and communication 
drivers. 

● SIMATIC S7 300/400

● SIMATIC S7 1200

Multiplexing with absolute addresses is not available for data blocks with optimized access.

Multiplexing with symbolic addressing
When multiplexing with symbolic addressing, you access an array element of an array tag in 
a data block of the connected PLC by means of a multiplex tag and an index tag. The multiplex 
tag contains the symbolic address of the data block which you want to access. The symbolic 
address also contains the index tag via which you access the index of the array tag.   

If you want to access, for example, the array tag "Arraytag_1" in the data block "Datablock_1", 
the expression for symbolic addressing is as follows:

"Datablock_1.Arraytag_1["HMITag_1"]

You control the access to the index of the array elements with the HMI-Variable "HMITag_1". 
In Runtime, you supply the tag with the index of the array element that you want to access.

Multiplexing with symbolic addressing is only available if the following components support 
symbolic addressing:
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● the HMI device

● PLC

● Communication driver

Symbolic addressing is currently only supported by the SIMATIC S7 1200 communication 
driver.

See also
Configuring address multiplexing with absolute addressing (Page 1003)

Configuring address multiplexing with symbolic addressing (Page 1006)

Updating the Tag Value in Runtime (Page 1011)

Indirect addressing of tags (Page 1009)

Addressing tags indirectly (Page 1009)

Using tags to trigger functions (Page 1010)

Defining the acquisition cycle for a tag (Page 1012)

Configuring address multiplexing with absolute addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the absolute address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created and connected to the PLC.

● The Properties window for this tag is open.
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Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the "Int" data type for this example.

3. Select the access type "Absolute addressing".

4. Click the selection button in the "Address" field. The address dialog opens.

5. Click the selection button in the "DB number" field and select the entry "HMI tag".
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6. In the "DB number" field, click the  button and select a tag for the DB number in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

7. Repeat steps 3 and 4 for the "Address" field and configure a further tag for calling the 
address area in the data block.

The selection options in the Address dialog depend on the selected data type of the multiplex 
tag. The Address dialog offers only address settings that can be configured with the selected 
data type. 

Result
In runtime, the multiplex tag is used to access the memory location corresponding to the 
address currently found in the tag. You control access to the data block with the tag in the DB 
number field. You control access to the address in the selected data block with the tag in the 
"Address" field. 

 

 Note

The value in the memory location will only be read at the next update cycle for the addressed 
tag. 

If, for example, you use a multiplex tag in a script, do not attempt to access contents of the 
memory location directly after changing it. 

 

See also
Address multiplexing (Page 1002)

Configuring address multiplexing with symbolic addressing (Page 1006)
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Configuring address multiplexing with symbolic addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the symbolic address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created.

● The Properties window for this tag is open.

● A data block with an array tag is created in the connected PLC.

● The data block was compiled.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1006 System Manual, 08/2011,  



Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the connection to the PLC via the "Connection" field.

3. Select the access type "Symbolic addressing".
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4. Navigate to the data block of the PLC via the "PLC tag" field and select an array element 
of the array tag.

5. Click the selection button in the "Address" field. The address dialog opens. 

6. Click the selection button in the "Index tag" field and select the entry "HMI tag".

7. In the "Index tag" field, click the  button and select a tag for the array index in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

Result
In Runtime, the array element whose index value is contained in the index tag is accessed.
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See also
Address multiplexing (Page 1002)

Configuring address multiplexing with absolute addressing (Page 1003)

Indirect addressing of tags

Principle
In multiplexes, a type of indirect addressing, the tag used is first determined at runtime. A list 
of tags is defined for the multiplex tag. The relevant tag is selected from the list of tags in 
runtime. The selection of the tag depends on the value of the index tag.

In Runtime, the system first reads the value of the index tag. Then the tag which is specified 
in the corresponding place in the tag list is accessed. 

Application example
Using indirect addressing, you could configure the following scenario: 

The operator selects one of several machines from a selection list. Depending on the operator's 
selection, data from the selected machine will be displayed in an output field.

To configure such a scenario, configure the index tag for a symbolic I/O field. Configure the 
multiplex tag at an I/O field. Configure the tag list of the multiplex tag to reflect the structure of 
the selection list.

If the operator selects another machine, the value of the index tag will change. The selection 
field then displays the content of the tag that is pointed to in the tag list in the multiplex tag by 
the new index value.

See also
Addressing tags indirectly (Page 1009)

Address multiplexing (Page 1002)

Addressing tags indirectly

Introduction
With indirect addressing, the tag used is first determined at runtime. Instead of a single tag, a 
list of tags is defined. The list entries consist of an index value and the name of the tag to be 
used. Using an index tag, you can control which entry in the tag list will be accessed.      

Requirement
● The tag which you wish to address indirectly must already exist.

● The index tag must exist.
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● The tags which will be contained in the tag list must already exist.

● The Inspector window with the tag properties is open.

Procedure
To address tags indirectly, proceed as follows:

1. In the Inspector window select "Properties > Properties > Multiplexing".

2. Select the "Multiplexing" option to activate indirect addressing.
Using this option, you can temporarily switch off indirect addressing for testing purposes, 
for example. Settings which were made earlier for indirect addressing remain unchanged. 

3. Select an "Index tag" or define a new tag using the object list.

4. Click the first entry in the "Tags" column in the tag list.

5. Select a tag as a list entry or define a new tag using the object list.
The entry in the "Index" column will be generated automatically.

6. Repeat step 5 for all tags that you wish to add to the tag list.

7. If necessary, you can use drag-and-drop to change the order of the entries in the list.

Result
In runtime, the system will dynamically access the tag in the tag list which has the same index 
value as the value currently in the index tag.

See also
Indirect addressing of tags (Page 1009)

Address multiplexing (Page 1002)

Using tags to trigger functions

Introduction
You can use the values of variables as the triggering event for an action in runtime. To start 
an action in Runtime, configure a function list for a tag. Include one or more system functions 
or VB scripts in the function list. The function list is processed when the configured event 
occurs.     

The following events are available for a tag: 
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● Change in value of the tag
Function list processing is triggered by each change in the value of the variable.
When the tag is defined as an array tag, the function list is processed whenever an array 
element changes.

● Violation of the tag's high limit
The function list is processed when the high limit is violated.

● Violation of the tag's low limit
The function list is processed when the low limit is violated.

Requirement
● The tag whose value you wish to use as an event already exists.

● The Inspector window with the properties for this tag is open.

Procedure
To configure a tag with a function list, proceed as follows:

1. Under "Properties > Events >" in the Inspector window, select the event for which you want 
to create a function list.
The function list associated with the selected event is shown.

2. Click "<Add function>". The second table column contains a selection button.

3. Click the selection button and select a system function.

4. Define the parameter values.

Alternatively, select a script to run in the function list, rather than a system function. The "VB 
scripts" entry is only displayed if there is a script available in the project.

Result
If the configured event occurs in Runtime, the function list or the script is processed.

See also
Address multiplexing (Page 1002)

Updating the Tag Value in Runtime

Introduction
Tags contain process values which change while Runtime is running. Value changes are 
handled differently at internal and external tags.      
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Principle
When Runtime starts, the value of a tag is equal to its start value. Tag values change in 
Runtime.

In Runtime, you have the following options for changing the value of a tag:

● A value change in an external tag in the PLC.

● By input, for example, in an I/O field.

● By running a system function, such as "SetValue."

● A value assignment in a script.

Updating the Value of External Tags
The value of an external tag is updated as follows:      

● Cyclic in operation
If you select the "Cyclic in operation" acquisition mode, the tag is updated in Runtime while 
it is displayed in a screen or is logged. The acquisition cycle determines the update cycle 
for tag value updates on the HMI device. You can either choose a default acquisition cycle 
or define a user-specific cycle.

● Cyclic continuous
If you select the "Cyclic continuous" acquisition mode, the tag will be updated continuously 
in Runtime, even if it is not in the currently-open screen. This setting is activated for tags 
that are configured to trigger a function list when their value changes, for example.   
Only use the "Cyclic continuous" setting for tags that must truly be updated. Frequent read 
operations increase communication load.

● On demand
If you select the "On demand" acquisition mode, the tag is not updated cyclically. It will only 
be updated on demand using the "UpdateTag" system function, for example, or by a script. 

See also
Address multiplexing (Page 1002)

Defining the acquisition cycle for a tag

Introduction
The value of an external tag can be changed in Runtime by the PLC to which the tag is linked. 
To ensure that the HMI device is informed of any changes in tag values by the PLC, the values 
must be updated on the HMI. The value is updated at regular intervals while the tag is displayed 
in the process screen or is logged. The interval for regular updates is set with the acquisition 
cycle. The update can also be made continuous.     
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Requirement
● You have created the tag for which you want to define an acquisition cycle.

● The Inspector window with the tag properties is open.

Procedure
To configure an acquisition cycle for a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > General."

2. If you want to update the tag at regular intervals as long as it is being displayed on the 
screen or logged, select "Cyclic in operation" as the acquisition mode.
Or:
If you want to update the tag at regular intervals even though it is not being displayed on 
the screen or logged, select "Cyclic continuous" as the acquisition mode.
The "Cyclic continuous" setting is selected for a tag, for example, that has a function list 
configured for a change of its value and that is not directly visible in a screen.

3. Select the required cycle time in the "Acquisition cycle" field or define a new acquisition 
cycle using the object list.

Alternatively, you can configure the acquisition cycle directly in the work area of the tag table. 
To view hidden columns, activate the column titles using the shortcut menu.

 

 Note

Only use the "Cyclic continuous" acquisition mode for tags that really have to be continuously 
updated. Frequent read operations generate a heavy communication load.

 

Result
The configured tag is updated in Runtime with the selected acquisition cycle.

See also
Address multiplexing (Page 1002)

Special configuration options

Defining a substitute value

Introduction    
You can define a specific value as a substitute value for a tag.

In the "Use substitute value" area you define when WinCC should use this substitute value. 
The current process value is then not accepted from the automation system.
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You can define a substitute value for the following cases:

● As start value
WinCC sets the substitute value when the project is activated and there is no current 
process value.

● After communication error
WinCC sets the substitute value when the connection to the automation system is disturbed 
and there is no valid process value.

● Maximum exceeded
If you have set an upper limit for the tag, WinCC sets the substitute value as soon as the 
process value exceeds this upper limit.

● Minimum undershot
If you have set a lower limit for the tag, WinCC sets the substitute value as soon as the 
process value falls below this lower limit.

Requirement
● The tag table is open.

● The Inspector window with the tag properties is open.

Procedure
To configure a substitute value, follow these steps:

1. Select the desired tag in the tag table, and select "Properties > Properties > Values" in the 
Inspector window.

2. In the "Use substitute value" segment, select when you want WinCC to use this substitute 
value in the tag.

3. Enter the required substitute value in the "Substitute value" field.
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Result
The configured tag is populated with the substitute value in Runtime once the selected 
condition is fulfilled.

 

 Note

If you have set a high or low limit in an I/O field, you cannot enter any value outside these 
limits.

WinCC ignores incorrect entries and therefore does not set a substitute value. The substitute 
value is only set by WinCC when an incorrect process value is read.

 

See also
Defining the acquisition cycle for a tag (Page 1015)

Tag Limits (Page 996)

Indirect addressing of tags (Page 1016)

Addressing tags indirectly (Page 1017)

Defining the acquisition cycle for a tag

Introduction   
If you are using tags, you define the acquisition cycle for Runtime Professional at the object 
on which the tag is to be used.

If you are logging a tag, define the acquisition cycle at the connected logging tag. The 
connected tag is updated with this acquisition cycle.

If you use a tag on a graphic object, the tag is updated with the acquisition cycle of the graphic 
object. The graphic objects in a screen are usually updated with the update cycle of the screen. 
You configure the update cycles of the screen and the objects in it in the "Dynamization 
overview" editor. All the objects used in a screen that require a trigger are shown in the 
"Dynamization overview" editor. Select the required acquisition cycle for each object. For a 
high-performance configuration, you should only configure an acquisition cycle for individual 
objects that deviates from the screen cycle if there truly is a need for it.

Requirement
● You have configured a screen.

● The screen contains an object on which a tag is configured.
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Procedure
To define the acquisition cycle, follow these steps:

1. Select the screen from the project tree and select "Dynamization overview" from the 
shortcut menu.
The "Dynamization overview" editor opens.

2. Configure the update cycle for the screen in the upper area of the "Dynamization overview" 
dialog. Select the required update cycle for the screen in the "Cycle" field or define a new 
cycle using the object list. The set cycle time has an effect on all objects whose cycle is set 
to the value "Screen cycle".

3. If you want to configure a different cycle time for an individual object, select the required 
object from the editor table and select the acquisition cycle from the "Cycle" field or define 
a separate cycle using the object list.

If you want to change the acquisition cycle for an individual object only, select this object in 
the screen and select "Dynamization overview" from the shortcut menu.

Result
The configured object is updated in Runtime with the selected cycle.

See also
Defining a substitute value (Page 1013)

Indirect addressing of tags

Introduction
With indirect addressing, the tag used is first determined at runtime. Use a string tag for indirect 
addressing in WinCC Runtime Professional. You also need a series of tags whose values are 
to be displayed in Runtime. In Runtime you enter the name of the tag in the string tag whose 
value you want to display and process.

Application example
The operator enters the name of one or several machines in the input field. Depending on the 
operator input, a process value of the machine is displayed in an output field.

To configure such a scenario, configure the string tag with activation of indirect addressing for 
an I/O field. Use this I/O field to output the values. Configure the same tag to another I/O field 
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without activation of indirect addressing. Use this I/O field to enter the machine names. Also 
configure a series of tags whose values you want to output.

When the operator enters the name of a different machine, the value of the string tag for indirect 
addressing changes. The output field shows the content of the tag whose name is included in 
the string tag.

You can use other mechanisms in WinCC to supply the string tag for indirect addressing, for 
example, a script.

See also
Addressing tags indirectly (Page 1017)

Defining a substitute value (Page 1013)

Addressing tags indirectly

Introduction
With indirect addressing, the tag used is first determined at runtime. Instead of individual tags, 
you define a series of tags. In Runtime the tag name is used to access individual tags.    

Requirement
● The "Temperature_Motor" tag that you want to use for indirect addressing does exist.

● A series of tags is created, for example, the "Motor1", "Motor2" and "Motor3" tags.

● The Inspector window with the tag properties is open.

● You have created a screen and the "Screens" editor is open.
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Procedure
To address tags indirectly, proceed as follows:

1. Add an I/O field to the screen and select the following settings for this example in the 
information window under "Properties > Properties > General":

– Mode: Output

– Display format: Decimal

2. Open the object list in the "Tag" field using the selection button, select the 
"Temperature_Motor" tag and activate the "Use indirect addressing" option.

3. The "Temperature_Motor" tag is configured for indirect addressing. The additional text 
("indirect") is displayed in front of the tag name in the "Tag" field.

4. Add another I/O field to the screen and select the following settings for this example in the 
information window under "Properties > Properties > General":

– Mode: Entry

– Display format: Character string
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5. Open the object list in the "Tag" field using the selection button, select the 
"Temperature_Motor" tag. Do not activate the option "Use indirect addressing".

6. Save the project.

Result
If you enter the name of one of the tags "Motor1", "Motor2" or "Motor3" in the input field in 
Runtime, the value of the respective tag is displayed in the output field.

See also
Indirect addressing of tags (Page 1016)

Defining a substitute value (Page 1013)

9.2.3 Working with Arrays

9.2.3.1 Basics on arrays

Definition
Array data of a uniform data type is successively arranged and is addressed within the address 
space to allow access to these data by means of an index. The individual array elements are 
addressed by means of an integer index. Each array element is assigned the same properties 
which are configured at the array tag.       

Advantages
You can configure numerous array elements with the same properties all at once with a single 
array tag. You can then use each array element as any other tag in your configuration. 
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Restrictions
The following restrictions apply to the use of arrays:

● Arrays are only available in projects for Runtime Advanced and Panels; array tags are not 
available for Runtime Professional.

● An array may contain only one dimension.

● The lower index of an array must begin with "0".

Application examples
Array tags can be used in the following situations:

● To group process values in profile trends: You map process values to trends which are 
acquired at different points in time, for example.

● To access specific values which are grouped in trends: For example, display all recorded 
values of the profile trend by gradually increasing the index tag.

● To configure discrete alarms with successive bit number.

● To save the complete machine data records in a recipe.

License rule for runtime
An array tag is counted in WinCC Runtime as one PowerTag, regardless of the number of 
array elements.

Special features
 

 WARNING

Increased system load and performance losses

Read or write access to a single array element always includes read or write access to all 
array elements of the array tag. Transfer of the data of large arrays from and to the PLC 
usually takes longer compared to the transfer of a basic data type. This may cause 
communication overload and disruption as a result.

 

Example:
● An array tag which consists of 100 array elements of data type "Real" was configured.

● If an array element with a length of four bytes changes, 100 x 4 bytes are written to the 
PLC.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1020 System Manual, 08/2011,  



Use in scripts.
To maintain performance, always use internal arrays to change arrays in scripts.

1. Copy the PLC array to the internal array at the start of the script.

2. Load on data transfer to the PLC is avoided while the script processes the internal array.
 

 
 CAUTION

Data inconsistency at array tags

If the value of a single element must be changed in an array tag, the whole array is read, 
changed and rewritten as a complete array. Changes carried out in the meantime to other 
array elements in the PLC are overwritten during rewriting.

You should always prevent the HMI device and the PLC from concurrently writing values 
to the same array tag. Use synchronous transfer of recipe data records to synchronize an 
array tag with the PLC.

 

See also
Creating array tags (Page 1021)

Examples of arrays (Page 1022)

Basics of tags (Page 975)

9.2.3.2 Creating array tags

Introduction
Create an array tag to configure a large number of tags of the same data type. The array 
elements are saved to a consecutive address space.

You can create an array tag as an internal tag or as an external tag.

If you want to create an array tag as an external tag, first configure an array tag in a data block 
of the connected PLC. You then connect the array tag to an HMI tag.    

Requirement
● The HMI tag table is open.

Procedure
To create an array tag, follow these steps:

1. Double click <Add> in the "Name" column of the HMI tag table.
A new HMI tag is created.

2. Click  in the Data type column and select the "Array" data type.
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3. Click  in the data type column. The dialog box for configuring the array is opened.

4. Select the desired data type for the array tag in the "Date type" field.

5. Define the number of array elements in the "Array limits" field. The lower limit must begin 
with "0".

6. Click . The settings for the array are saved.

7. Save the project.

Result
An array tag is created. The properties of the array elements are inherited from the parent 
array tag.

See also
Basics on arrays (Page 1019)

9.2.3.3 Examples of arrays

Introduction
Array tags combine a number of tags, e.g. 100 array elements. You use array tags as complete 
arrays in the following places:

● In the "Alarms" editor

● In the "Recipes" editor

● For address multiplexing

● In the trend view
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You use individual array elements everywhere in the configuration like HMI tags.

Examples
You can configure an array tag with the corresponding number of array elements to handle 
multiple tags of the same data type.

● The individual array elements can be accessed indirectly by means of a multiplex index 
tag, for example.

● Use these index tags to operate and monitor the array elements.

See also
Basics on arrays (Page 1019)

9.2.4 Working with user data types

9.2.4.1 Basics on user data types

Introduction
With user data types you bundle a number of different tags that form one logical unit. You 
create a user data type as a type and use instances of this type in the project. User data types 
are project-associated data and are available for all HMI devices of the project. 

User data types differ in their association to a family of devices. User data types are available 
for the following families of devices:

● WinCC Runtime Advanced and Panels

● WinCC Runtime Professional

User data types also differ in their applicability with a specific communication driver. User data 
types are available for the following communication drivers:

● SIMATIC S7 300/400

● SIMATIC S7 1200

Create user data types and user data type elements in the project library.           
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Principle
For example, the different conditions of a motor can be described using six unique Boolean 
tags.

If the overall condition should be described with a single tag, this tag can be created based on 
a user data type. For each of the individual Boolean tags you create a user data type element 
in the user data type. 

This user data type can then be assigned complete to a faceplate for the motor. The created 
and enabled user data type is displayed at the tag in the "Data type" selection field.

The configured properties of a user data type are used in the instances of the user data type. 
If required, you change individual properties directly at the point of use, e.g. at a tag. Changing 
a property at the tag does not affect the user data type created.

License regulation in Runtime
If you use external tags of the "User data type" data type in a faceplate instance, each user 
data type element is counted as a tag in Runtime.

Example
You have created two screens in the "Screens" editor: Screen_1 and screen_2

3 faceplate instances are inserted in Screen_1. 4 faceplate instances are inserted in Screen_2. 
Each faceplate instance is connected to an external tag of the "User data type" data type. The 
user data type includes 10 user data type elements.
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Screen 1: 3 faceplate instances * 10 user data type elements corresponds to 30 external tags 
= 30 PowerTags.

Screen 2: 4 faceplate instances * 10 user data type elements corresponds to 40 external tags 
= 40 PowerTags.

In Runtime, 70 PowerTags are counted together for both screens. This also applies to the user 
data type elements that are not required.

See also
Creating the user data type (Page 1025)

Creating tags with a user data type data type (Page 1030)

Managing user data types (Page 1032)

Basics of tags (Page 975)

Creating user data type elements (Page 1027)

9.2.4.2 Creating the user data type

Introduction
You create a user data type in the project library.     

Requirement
● A project is open.

● The view of the "Libraries" task card is activated.

Procedure
Proceed as follows to create a user data type:

1. Click the "Libraries" task card.

2. Double-click the "Project library" item. The folder structure of the project library is open.
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3. Select the "Types" folder and select the shortcut menu command "Add new type".

4. The type addition dialog opens.

5. Click the "HmiUdt" button in the "Add new type" dialog and enter a meaningful name in the 
"Name of user data type" field. The name uniquely identifies the user data type within the 
project.
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6. Select the required device family for the user data type.

7. Click "OK" to apply your settings. The user data type is created and opened in the editor.

8. Select the required communication in the "Communication driver" field.

If a user data type already exists in the project, you can create a new user data type based on 
the existing user data type. To do this, activate the option "Based on existing user data type". 
Enter the name of the existing user data type. A new user data type with identical properties 
is created. If necessary, change the individual properties of the new user data type or the 
elements they contain directly in the editor.

Result
A user data type with the configured properties is created.

Create the required user data type elements in the next step.

Assign the created user data type to a tag or the dynamic property of a faceplate as data type. 
The user data types that can be selected are displayed in the "Data type" selection field.

See also
Basics on user data types (Page 1023)

9.2.4.3 Creating user data type elements

Introduction
You create user data type elements in the table of the "HMI user data types" editor.

Requirement
A user data type is created and opened in the editor.
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Procedure
1. Specify the type of communication for the user data type in the "Communication driver" 

field.
If you select the <Internal communication> entry, you can only assign the user data type 
to the internal tags as the data type.

If a connection to a PLC is selected as the type of communication, the user data type can 
only be assigned to tags with a connection to this PLC as the data type.

The communication type set applies to all user data type elements of a user data type. In 
a user data type for the"WinCC Runtime Professional" family of devices, you can define for 
each user data type element whether the configured driver is used for control or internal 
communication.

2. Double-click "Add" in the "Name" column of the table of user data type elements. A new 
user data type element is added to the user data type.

3. Under the "Name" column, replace the default entry with an unambiguous name.

4. Select the required data type in the "Data Type" field.

5. Create as many user data type elements as you need.

6. You configure the user data type elements in the "Properties" group in the Inspector window.

Alternatively, you can configure the properties of the user data type elements directly in the 
editor table. To view hidden columns, activate the column titles using the shortcut menu.
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Enabling user data type
After a user data type has been created, initially it cannot be used in the project. First, a user 
data type must be enabled before it can be used in the project. To enable a user data type, 
follow these steps:

1. Select the user data type in the project library.

2. Select "Enable user data type" from the shortcut menu.

The user data type is enabled in the project.

If you change an existing user data type, you have to enable the existing user data type once 
again for the change to become effective. To be able to use in runtime, the device must again 
be compiled.

If you have changed a user data type, you can undo the changes with the help of the shortcut 
menu command "Restore user data type". Restore only works as long as the user data type 
is not enabled again. 

See also
Basics on user data types (Page 1023)
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9.2.4.4 Creating tags with a user data type data type

Introduction
When a tag is created, the user data type is assigned as a data type. In the "Tag" editor you 
can create internal tags or tags with a link to a PLC. A tag has access to all user data types 
that use the same communication driver as the tag itself. 
In connection with a PLC, a user data type can only be used if the absolute addressing is 
selected.

Requirement
● A user data type with a user data type element is created.

● The user data type is enabled.

● The tag table is open.

● The Inspector window with the tag properties is open.

Procedure
To create a tag of the "User data type" data type, follow these steps:

1. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

2. In the Inspector window select "Properties > Properties > General."

3. Enter a unique tag name in the "Name" field.

4. Select the connection to the required PLC in the "Connection" box.
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5. Select the name of the user data type created in the "Data type" field. The selected 
connection determines which user data types will be displayed.
For internal tags, only user data types of the <Internal user data type> type are available.

For tags with a connection to a PLC, only those user data types that have a link to a PLC 
can be accessed.

6. Enter the address of the PLC that you want to access with the external tags in the "Address" 
field of the "Settings" area. The specified address must always point to the start data bit, 
for example, <DB1.DBX0.0>.

Result
You have now created a tag of the "User data type" data type. In additional steps you can 
configure the tag, for example, by setting the start value and limits.

With tags of the "User data type" data type, you can connect the dynamic properties of a 
faceplate instance, which then supplies these properties with values in Runtime.

If you wish to change the properties of a user data type tag, you must change the properties 
of the user data type element.

Properties such as "Start value", "Use substitute value" or " Linear scaling" can be changed 
in the employed instances of the user data type.
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See also
Basics on user data types (Page 1023)

9.2.4.5 Managing user data types

Renaming a user data type
To rename a user data type, follow these steps:  

1. In the project library, under "Types", select the user data type you want to rename.

2. Select "Rename" from the shortcut menu.

3. Type in a new name.

4. Press <Enter>.

You can also use the <F2> function key to rename the structure.

Copying and pasting the user data type
To copy a user data type, follow these steps:   

1. In the project library, under "Types", select the user data type you want to copy.

2. Select "Copy" from the shortcut menu.

3. Select the "Types" folder and select "Paste" from the shortcut menu.

You can also use the "Copy" and "Paste" commands from the "Edit" menu or from the toolbar.

A copy of the original user data type is created in the project library, in the "Types" folder.

Deleting user data type
To delete a user data type, follow these steps:  

1. In the project library, under "Types", select the user data type you want to delete.

2. Select "Delete" from the shortcut menu. If the user data type is being used in a faceplate, 
a request will be made to confirm deletion of the user data type.

You can also use the "Delete" command from the "Edit" menu or from the toolbar.

If you delete a user data type, you also delete all user data type elements contained therein. 
The entry remains in the allocated tag. In the "Tags" editor, a colored background appears to 
draw your attention to the fact that an invalid data type has occurred by the deletion. Change 
the data type in the "Tags" editor.

If you delete a user data type, all instances and copy templates of this user data type are 
deleted as well. You are informed by a warning message that the deletion action will delete 
existing instances or copy templates. Deletion starts after confirmation of the warning message 
with "OK".
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Renaming a user data type element
To rename a user data type element, follow these steps:  

1. Select the required user data type under "Types" in the project library.
Select the "Edit user data type" command from the shortcut menu".
The user data type opens in the editor.

2. Select the user data type element that you want to rename.

3. Select "Rename" from the shortcut menu.

4. Type in a new name.

5. Press <Enter>.

You can also use the <F2> function key to rename the user data type element.

Editing the user data type element
To edit a user data type element, follow these steps:  

1. In the project library, under "Types", select the required user data type.

2. Select the "Edit user data type" command from the shortcut menu.
The user data type opens in the editor.

3. Select the user data type element that you want to edit.

4. You can change the properties of the user data type element directly in the editor table or 
in the Inspector window.

If you wish to change the properties of a user data type tag, you must always change the 
properties of the user data type element.

If you change the communication driver of a user data type, the values you have already 
configured are, as far as possible, maintained at the user data type tag connected, for example, 
the start value.

Copying and pasting the user data type element
To copy a user data type element, follow these steps:   

1. In the project library, under "Types", select the required user data type.

2. Select the "Edit user data type" command from the shortcut menu.
The user data type opens in the editor.

3. Select the user data type element that you want to copy.

4. Select "Copy" from the shortcut menu.

5. Open the shortcut menu on a blank line in the editor and select the "Paste" command.

You can also use the "Copy" and "Paste" commands from the "Edit" menu or from the toolbar.

A copy of the original user data type element is pasted in the work area. A consecutive number 
is appended to the name of the user data type element.
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Deleting a structure element
To delete a user data type element, follow these steps:   

1. In the project library, under "Types", select the required user data type.

2. Select the "Edit user data type" command from the shortcut menu.
The user data type opens in the editor.

3. Select the user data type element that you want to delete.

4. Select "Delete" from the shortcut menu.

The user data type element is deleted.

You can also use the "Delete" command from the "Edit" menu or from the toolbar. 

See also
Basics on user data types (Page 1023)

9.2.5 Working with cycles

9.2.5.1 Cycle basics

Introduction
Cycles are used to control actions that regularly occur in runtime. Common applications are 
the acquisition cycle, the logging cycle and the update cycle. You can also define your own 
cycles in addition to those already provided in WinCC.      

Principle
In Runtime, actions that are performed regularly are controlled by cycles. Typical applications 
for cycles:

● Acquisition of external tags
The acquisition cycle determines when the HMI device will read the process value of an 
external tag from the PLC. Set the acquisition cycle to suit the rate of change of the process 
values. The temperature of an oven, for example, changes much more slowly than the 
speed of an electrical drive.
Do not set the acquisition cycle too low, since this will unnecessarily increase the 
communication load of the process.

● Logging process values
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle.

The smallest possible value for the cycle depends on the HMI device that will be used in your 
project. For most HMIs, this value is 100 ms. The values of all other cycles are always an 
integer multiple of the smallest value.
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If the cycles provided in WinCC do not meet the needs of your project, you can define your 
own cycles using the "Cycles" editor. User-defined cycles must always be an integer multiple 
of the smallest value.

 

 Note
Device dependency

You cannot configure self-defined cycle times for Basic Panels.
 

Application example
You can use cycles for the following tasks:

● To regularly log a process.

● To draw attention to maintenance intervals.

See also
Defining cycles (Page 1035)

Basics of tags (Page 975)

9.2.5.2 Defining cycles

Introduction
Use cycles to control actions that are run at regular intervals in Runtime. You can also define 
your own cycles in addition to those already provided in WinCC.   

Requirement
You have opened the project.

Procedure
1. Double-click the "Cycles" entry in the project navigation.

The "Cycles" editor opens.

2. In the "Name" column of the "Cycles" editor, double-click "Add".
A new cycle time is created.

3. Enter a unique name in the "Name" field.

4. Select the desired cycle unit.
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5. Select the desired value for the cycle time.
The available selection of values varies depending on the cycle unit selected. The smallest 
possible value for the cycle depends on the HMI device that will be used in your project. 
For most HMIs, this value is 100 ms. The available values are always an integer multiple 
of this value.

6. As an option, you can enter a comment regarding the use of the cycle.

Result
The cycle you configured is created and beside the default cycles in WinCC for use during 
configuration.

See also
Cycle basics (Page 1034)

9.2.6 Working with cycles

9.2.6.1 Cycle basics

Introduction
Cycles are used to control actions that regularly occur in runtime. Common applications are 
the acquisition cycle, the logging cycle and the screen cycle. You can also define your own 
cycles in addition to those already provided in WinCC.     

Principle
In Runtime, actions that are performed regularly are controlled by cycles. Typical applications 
for cycles:

● Refreshing screens
The screen cycle determines how often a screen will be refreshed. The screen cycle gives 
you the option to trigger all dynamizations in a screen at the same time. Use the predefined 
cycles in WinCC or self-defined cycles as cycle times. The standard setting for the screen 
cycle is 2 seconds.

● Updating objects
In the standard setting all dynamizations in a screen use the screen cycle. You can use 
other cycles to update individual objects, if necessary. See Basics on dynamization in the 
property list (Page 756) for additional information.
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● Triggering scheduled tasks
In scheduled tasks you have the option to configure a task with a cyclical trigger. Use the 
cycle time to determine when the scheduled task is executed. See Triggers (Page 2036) 
for additional information.

● Logging process values
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle. See Cycles and 
Events (Page 1134) for additional information.

The smallest value for a cycle in Runtime Professional is 250 ms. The next possible value is 
300 ms; configure all additional value at increments of 100 ms. 

 

 Note
Defining your own cycles

If the cycles predefined in WinCC do not meet the requirements of your project, you can 
define your own cycles using the "Cycles" editor.

You can create and use an unlimited number of cycles. Keep in mind that you can only monitor 
up to 15 different update cycles in Runtime.

 

Starting point
You can define a starting point for every cycle in WinCC. This starting point will also apply to 
the cycles provided with the system. The following starting points are possible:

● Trigger cycle at start of Runtime

● Trigger cycle at system shutdown

● Trigger cycle at user-defined starting point

You can use cycle starting points for the following tasks:

● To synchronize different tasks within the system

● To relieve the load on the communication channels by postponing tasks with a high 
communication load.

Application example
You can use cycles for the following tasks:

● To regularly log a process.

● To draw attention to maintenance intervals.
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See also
Defining cycles (Page 1038)

Define starting point (Page 1039)

Basics of tags (Page 975)

Cycles and Events (Page 1134)

Basics on dynamization in the property list (Page 756)

Triggers (Page 2036)

9.2.6.2 Defining cycles

Introduction
Use cycles to control actions that are run at regular intervals in Runtime. You can also define 
your own cycles in addition to those already provided in WinCC.   

Requirement
You have opened the project.

Procedure
1. Double-click the "Cycles" entry in the project navigation.

The "Cycles" editor opens.

2. In the "Name" column of the "Cycles" editor, double-click "Add".
A new cycle time is created.

3. Enter a unique name in the "Name" field.

4. Select the desired cycle unit.

5. Select the desired value for the cycle time.
The available selection of values varies depending on the cycle unit selected. The smallest 
possible value for the cycle depends on the HMI device that will be used in your project. 
For most HMIs, this value is 100 ms. The available values are always an integer multiple 
of this value.

6. As an option, you can enter a comment regarding the use of the cycle.

Result
The cycle you configured is created and beside the default cycles in WinCC for use during 
configuration.

See also
Cycle basics (Page 1036)
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9.2.6.3 Define starting point

Introduction
For cycles, define the starting points to start different cycles at different times. Staggering the 
start of the update processes will also stagger the communication load on the connection to 
the PLC. 

Requirement
● The "Cycles" editor is open.

● The Inspector window with the cycle properties is open.

Procedure
To define the starting point for a cycle, follow these steps:

1. Select the cycle from the table in the "Cycles" editor.

2. Click "Properties > Properties > Starting point" in the Inspector window.
The properties for the starting point of the cycle are displayed.

3. Select the settings for the starting point.

4. Save the project.

Result
The selected cycle is started in Runtime at the configured starting point.

See also
Cycle basics (Page 1036)

9.2.7 Reference

9.2.7.1 Mapping and coding of data types

Introduction
WinCC sets the data type of an external tag according to the data type of the connected PLC 
tag. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. As required, you can specify that WinCC uses a different 
data type and converts the format of the data type of the PLC tag and the data type of the HMI 
tag. The following sections include the data types that are typically used for mapping. You will 
also find optional mapping versions that you can set yourself.
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Coding of data types
In addition to mapping of data types, you can also change the coding of many mapping 
versions. Coding is used to map and process the binary information of PLC tag according to 
the requirements. The values of the PLC tags can be mapped with the following coding:

BCD

The BCD code is a binary decimal code that maps each individual digit of a number in binary 
form. The value of the digits is according to the number sequence 8-4-2-1. The result is the 
following value table:

Decimal digit BCD code
0 0000
1 0001
2 0010
3 0011
4 0100
5 0101
6 0110
7 0111
8 1000
9 1001

Aiken

The Aiken code is a complementary BCD code. The value of the digits is according to the 
number sequence 2-4-2-1. The result is the following value table:

Decimal digit Aiken code
0 0000
1 0001
2 0010
3 0011
4 0100
5 1011
6 1100
7 1101
8 1110
9 1111

Excess

Excess-3 code is used for Excess coding. The Excess-3 code is a complementary BCD code. 
The value of the digits is according to the number sequence 8-4-(-2)-(-1). The result is the 
following value table:
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Decimal digit Excess code
0 0011
1 0100
2 0101
3 0110
4 0111
5 1000
6 1001
7 1010
8 1011
9 1100

ExtBCD

The "ExtBCD" coding used the BCD code described above for coding. But with "ExtBCD" the 
Most Significant Bit is interpreted as sign. 

MSB

The "MSB" coding uses the binary code standard for coding. But with "MSB" the Most 
Significant Bit is interpreted as sign.

See also
Coding and value range of data types (Page 1041)

SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 1200 Date data type (Page 1058)

OPC-DA VT_I1 data type (Page 1070)

OPC-XML-DA Byte data type (Page 1076)

Allen Bradley Ethernet IP DInt data type (Page 1082)

Modicon Modbus TCP/IP +/- Double data type (Page 1089)

Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Adapting the data type of a tag (Page 988)

9.2.7.2 Coding and value range of data types

Coding and value range
Depending on the selected coding, the value ranges listed in the tables are available for the 
different data types.      

PLC data type Byte

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1041



Conversion Value range
Byte to UnsignedByte 0...255
Byte to UnsignedWord 0...255
Byte to UnsignedDword 0...255
Byte to SignedByte 0...127
Byte to SignedWord 0...255
Byte to SignedDword 0...255
Byte to BCDByte 0...99
Byte to BCDWord 0...255
Byte to BCDDword 0...255
Byte to AikenByte 0...99
Byte to AikenWord 0...255
Byte to AikenDword 0...255
Byte to ExcessByte 0...99
Byte to ExcessWord 0...255
Byte to ExcessDword 0...255

PLC data type Char

Conversion Value range
Char to UnsignedByte 0...127
Char to UnsignedWord 0...127
Char to UnsignedDword 0...127
Char to SignedByte -128...+127
Char to SignedWord -128...+127
Char to SignedDword -128...+127
Char to MSBByte -128...+127
Char to MSBWord -128...+127
Char to MSBDword -128...+127
Char to BCDByte 0...99
Char to BCDWord 0...127
Char to BCDDword 0...127
Char to SignedBCDByte -9...+9
Char to SignedBCDWord -128...+127
Char to SignedBCDDword -128...+127
Char to ExtSignedBCDByte -79...+79
Char to ExtSignedBCDWord -128...+127
Char to ExtSignedBCDDword -128...+127
Char to AikenByte 0...99
Char to AikenWord 0...127
Char to AikenDword 0...127
Char to SignedAikenByte -9...+9
Char to SignedAikenWord -128...+127
Char to SignedAikenDword -128...+127
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Conversion Value range
Char to ExcessByte 0...99
Char to ExcessWord 0...127
Char to ExcessDword 0...127
Char to SignedExcessByte -9...+9
Char to SignedExcessWord -128...+127
Char to SignedExcessDword -128...+127
Char to UnsignedByte 0...127
Char to UnsignedWord 0...127
Char to UnsignedDword 0...127

PLC data type Double

Conversion Value range
Double to Double +-1.79769313486231e+308
Double to UnsignedByte 0...255
Double to UnsignedWord 0...65535
Double to UnsignedDword 0...4294967295
Double to SignedByte -128...+127
Double to SignedWord -32768...+32767
Double to SignedDword -2147483647...+2147483647
Double to Float +-3.402823e+38
Double to MSBByte -127...+127
Double to MSBWord -32767...+32767
Double to MSBDword -2147483647...+2147483647
Double to BCDByte 0...99
Double to BCDWord 0...9999
Double to BCDDword 0...99999999
Double to SignedBCDByte -9...+9
Double to SignedBCDWord -999...+999
Double to SignedBCDDword -9999999...+9999999
Double to ExtSignedBCDByte -79...+79
Double to ExtSignedBCDWord -7999...+7999
Double to ExtSignedBCDDword -79999999...+79999999
Double to AikenByte 0...99
Double to AikenWord 0...9999
Double to AikenDword 0...99999999
Double to SignedAikenByte -9...+9
Double to SignedAikenWord -999...+999
Double to SignedAikenDword -9999999...+9999999
Double to ExcessByte 0...99
Double to ExcessWord 0...9999
Double to ExcessDword 0...99999999
Double to SignedExcessByte -9...+9
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Conversion Value range
Double to SignedExcessWord -999...+999
Double to SignedExcessDword -9999999...+9999999
Double to S5Timer 10...9990000
Double to S5Float +-1.701411e+38

PLC data type DWord

Conversion Value range
DWord to UnsignedDword 0...4294967295
DWord to UnsignedByte 0...255
DWord to UnsignedWord 0...65535
DWord to SignedByte 0...127
DWord to SignedWord 0...32767
DWord to SignedDword 0...2147483647
DWord to BCDByte 0...99
DWord to BCDWord 0...9999
DWord to BCDDword 0...99999999
DWord to AikenByte 0...99
DWord to AikenWord 0...9999
DWord to AikenDword 0...99999999
DWord to ExcessByte 0...99
DWord to ExcessWord 0...9999
DWord to ExcessDword 0...99999999
DWord to SimaticTimer 10...9990000
DWord to SimaticBCDTimer 10...9990000
DWord to UnsignedDword 0...4294967295
DWord to UnsignedByte 0...255
DWord to UnsignedWord 0...65535

PLC data type Float

Conversion Value range
Float to Float +-3.402823e+38 (no conversion)
Float to UnsignedByte 0...255
Float to UnsignedWord 0...65535
Float to UnsignedDword 0 to 4.294967e+09
Float to SignedByte -128...+127
Float to SignedWord -32768...+32767
Float to SignedDword -2.147483e+09 to +2.147483e+09
Float to Double +-3.402823e+38
Float to MSBByte -127...+127
Float to MSBWord -32767...+32767
Float to MSBDword -2.147483e+09 to +2.147483e+09
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Conversion Value range
Float to BCDByte 0...99
Float to BCDWord 0...9999
Float to BCDDword 0 to 9.999999e+07
Float to SignedBCDByte -9...+9
Float to SignedBCDWord -999...+999
Float to SignedBCDDword -9999999...+9999999
Float to ExtSignedBCDByte -79...+79
Float to ExtSignedBCDWord -7999...+7999
Float to ExtSignedBCDDword -7.999999e+07 to +7.999999e+07
Float to AikenByte 0...99
Float to AikenWord 0...9999
Float to AikenDword 0 to 9.999999e+07
Float to SignedAikenByte -9...+9
Float to SignedAikenWord -999...+999
Float to SignedAikenDword -9999999...+9999999
Float to ExcessByte 0...99
Float to ExcessWord 0...9999
Float to ExcessDword 0 to 9.999999e+07
Float to SignedExcessByte -9...+9
Float to SignedExcessWord -999...+999
Float to SignedExcessDword -9999999...+9999999
Float to S5Timer 10...9990000
Float to S5Float +-1.701411e+38

PLC data type Long

Conversion Value range
Long to SignedDword -2147483647...+2147483647
Long to UnsignedByte 0...255
Long to UnsignedWord 0...65535
Long to UnsignedDword 0...2147483647
Long to SignedByte -128...+127
Long to SignedWord -32768...+32767
Long to MSBByte -127...+127
Long to MSBWord -32767...+32767
Long to MSBDword -2147483647...+2147483647
Long to BCDByte 0...99
Long to BCDWord 0...9999
Long to BCDDword 0...99999999
Long to SignedBCDByte -9...+9
Long to SignedBCDWord -999...+999
Long to SignedBCDDword -9999999...+9999999
Long to ExtSignedBCDByte -79..+79
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Conversion Value range
Long to ExtSignedBCDWord -7999...+7999
Long to ExtSignedBCDDword -79999999...+79999999
Long to AikenByte 0...99
Long to AikenWord 0...9999
Long to AikenDword 0...99999999
Long to SignedAikenByte -9...+9
Long to SignedAikenWord -999...+999
Long to SignedAikenDword -9999999...+9999999
Long to ExcessByte 0...99
Long to ExcessWord 0...9999
Long to ExcessDword 0...99999999
Long to SignedExcessByte -9...+9
Long to SignedExcessWord -999...+999
Long to SignedExcessDword -9999999...+9999999
Long to SimaticTimer 10...9990000
Long to SimaticBCDTimer 10...9990000

PLC data type Short

Conversion Value range
Short to UnsignedByte 0...255
Short to UnsignedWord 0...32767
Short to UnsignedDword 0...32767
Short to SignedByte -128...+127
Short to SignedWord -32768...+32767
Short to SignedDword -32768...+32767
Short to MSBByte -127...+127
Short to MSBWord -32767...+32767
Short to MSBDword -32768...+32767
Short to BCDByte 0...99
Short to BCDWord 0...9999
Short to BCDDword 0...32767
Short to SignedBCDByte -9...+9
Short to SignedBCDWord -999...+999
Short to SignedBCDDword -32768...+32767
Short to ExtSignedBCDByte -79...+79
Short to ExtSignedBCDWord -7999...+7999
Short to ExtSignedBCDDword -32768...+32767
Short to AikenByte 0...99
Short to AikenWord 0...9999
Short to AikenDword 0...32767
Short to SignedAikenByte -9...+9
Short to SignedAikenWord -999...+999
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Conversion Value range
Short to SignedAikenDword -32768...+32767
Short to ExcessByte 0...99
Short to ExcessWord 0...9999
Short to ExcessDword 0...32767
Short to SignedExcessByte -9...+9
Short to SignedExcessWord -999...+999
Short to SignedExcessDword -32768...+32767
Short to UnsignedByte 0...255
Short to UnsignedWord 0...32767
Short to UnsignedDword 0...32767

PLC data type Word

Conversion Value range
Word to UnsignedWord 0...65535
Word to UnsignedByte 0...255
Word to UnsignedDword 0...65535
Word to SignedByte 0...127
Word to SignedWord 0...32767
Word to SignedDword 0...65535
Word to BCDByte 0...99
Word to BCDWord 0...9999
Word to BCDDword 0...65535
Word to AikenByte 0...99
Word to AikenWord 0...9999
Word to AikenDword 0...65535
Word to ExcessByte 0...99
Word to ExcessWord 0...9999
Word to ExcessDword 0...65535
Word to SimaticCounter 0...999
Word to SimaticBCDCounter 0...999
Word to UnsignedWord 0...65535
Word to UnsignedByte 0...255
Word to UnsignedDword 0...65535

See also
Mapping and coding of data types (Page 1039)
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9.2.7.3 Data types for SIMATIC S7 300/400

SIMATIC S7 300/400 Byte data type

Definition         
Data type "Byte" is unsigned and has length of one byte.

Format adjustment
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Byte".

You can adapt the following formats for data type "Byte":

PLC data type HMI data type Coding
Byte SInt BCD
Byte USInt None
Byte USInt Aiken
Byte USInt BCD
Byte USInt Excess
Byte Int BCD
Byte UInt None
Byte UInt Aiken
Byte UInt BCD
Byte UInt Excess
Byte DInt BCD
Byte UDInt None
Byte UDInt Aiken
Byte UDInt BCD
Byte UDInt Excess
Byte Real BCD
Byte LReal BCD
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See also
SIMATIC S7 300/400 Char data type (Page 1049)

SIMATIC S7 300/400 Counter data type (Page 1050)

SIMATIC S7 300/400 Date data type (Page 1050)

SIMATIC S7 300/400 DInt data type (Page 1051)

SIMATIC S7 300/400 DWord data type (Page 1052)

SIMATIC S7 300/400 Int data type (Page 1052)

SIMATIC S7 300/400 Real data type (Page 1053)

SIMATIC S7 300/400 S5Time data type (Page 1054)

SIMATIC S7 300/400 Time data type (Page 1055)

SIMATIC S7 300/400 Time_of_day data type (Page 1056)

SIMATIC S7 300/400 Timer data type (Page 1056)

SIMATIC S7 300/400 Word data type (Page 1057)

Mapping and coding of data types (Page 1039)

SIMATIC S7 300/400 Char data type

Definition         
Data type "Char" is unsigned and has length of one byte.

Format adjustment
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Char".

You can adapt the following formats for data type "Char":

PLC data type HMI data type Coding
Char SInt BCD
Char USInt None
Char Int None
Char UInt None
Char DInt None
Char UDInt None
Char Real None
Char LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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SIMATIC S7 300/400 Counter data type

Definition     
Data type "Counter" is unsigned and has length of two bytes. Tags of data type "Counter" can 
only be used to address counters (C). Entries are stored in BCD format. You can enter a count 
value between 0 and 999. 

To address bit memory (M) or data blocks (DB), use tags of PLC data type "Word" with 
"SIMATICBCDCounter" coding. 

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Counter".

You can adapt the following formats for data type "Counter":

PLC data type HMI data type Coding
Counter UInt Default

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 Date data type

Definition     
Data type "Date" is unsigned and has a length of two bytes. The date (IEC date) is represented 
in days, whereby the first day is January 1, 1990.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Date". 

You can adapt the following formats for data type "Date":

PLC data type HMI data type Coding
Date UInt Default

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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SIMATIC S7 300/400 DInt data type

Definition     
Data type "DInt" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DInt".

You can adapt the following formats for data type "DInt":

PLC data type HMI data type Coding
DInt SInt None
DInt SInt Aiken
DInt SInt BCD
DInt SInt ExtBCD
DInt SInt Excess
DInt SInt MSB
DInt USInt None
DInt Int None
DInt Int Aiken
DInt Int BCD
DInt Int ExtBCD
DInt Int Excess
DInt Int MSB
DInt UInt None
DInt DInt None
DInt DInt Aiken
DInt DInt BCD
DInt DInt ExtBCD
DInt DInt Excess
DInt DInt MSB
DInt UDInt None
DInt Real None
DInt LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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SIMATIC S7 300/400 DWord data type

Definition     
Data type "DWord" is unsigned and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DWord".

You can adapt the following formats for data type "DWord":

PLC data type HMI data type Coding
DWord SInt None
DWord USInt None
DWord USInt Aiken
DWord USInt BCD
DWord USInt Excess
DWord Int None
DWord UInt None
DWord UInt Aiken
DWord UInt BCD
DWord UInt Excess
DWord DInt None
DWord UDInt None
DWord UDInt Aiken
DWord UDInt BCD
DWord UDInt Excess
DWord Real None
DWord LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 Int data type

Definition     
Data type "Int" is signed and has a length of two bytes.
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Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Int".

You can adapt the following formats for data type "Int":

PLC data type HMI data type Coding
Int SInt None
Int SInt Aiken
Int SInt BCD
Int SInt ExtBCD
Int SInt Excess
Int SInt MSB
Int USInt None
Int Int None
Int Int Aiken
Int Int BCD
Int Int ExtBCD
Int Int Excess
Int Int MSB
Int UInt None
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt ExtBCD
Int DInt Excess
Int DInt MSB
Int UDInt None
Int Real None
Int LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 Real data type

Definition     
Data type "Real" is signed and has a length of four bytes. The floating point format conforms 
to the IEEE 754 standard.
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Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Real".

You can adapt the following formats for data type "Real":

PLC data type HMI data type Coding
Real LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 S5Time data type

Definition         
Data type "S5Time" is unsigned and has a length of two bytes. Duration entries of data type 
"S5TIME" are saved in BCD format. The following figure shows the content of the time 
operands for a time value of 127 and a time base of 1 s.

Enter the time value in the range from 0 to 999 and select a timebase if working with "S5TIME". 
The time base indicates the interval at which a timer decrements the time value by one unit 
until it reaches "0". 

Time base Binary code for the time base
10 ms 00
100 ms 01
1 s 10
10 s 11

Duration
Duration = Time base * Time value

Value range Hexadecimal Duration
Maximum value 0x3999 2h46m30s
Minimum value 0x0000 0 ms
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Format adjustment
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"S5Time". The value range is 0 to 9990000.

The duration is given in milliseconds on the HMI.

Example:
Time base = 10s

Time value = 999

999 * 10s = 9990000 ms = Duration

You can adapt the following formats for data type "S5Time":

PLC data type HMI data type Coding
S5Time DInt Default
S5Time UDInt Default
S5Time Real Default
S5Time LReal Default

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 Time data type

Definition     
Data type "Time" is signed and has a length of four bytes. The time (IEC time) is shown in 
milliseconds.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Time".

You can adapt the following formats for data type "Time":

PLC data type HMI data type Coding
Time DInt None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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SIMATIC S7 300/400 Time_of_day data type

Definition     
Data type "Time_of_day" is unsigned and has a length of four bytes. Data type "Time_of_day" 
contains the time of day in milliseconds. Milliseconds are calculated as of 00:00 AM.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Time_of_day".

You can adapt the following formats for data type "Time_of_day":

PLC data type HMI data type Coding
Time_of_day UDInt Default

See also
SIMATIC S7 300/400 Byte data type (Page 1048)

SIMATIC S7 300/400 Timer data type

Definition     
Data type "Timer" is unsigned and has a length of two bytes. 

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Timer". 

The format of data type "Timer" corresponds to data type "S5Time"

You can adapt the following formats for data type "Timer":

PLC data type HMI data type Coding
Timer DInt Default
Timer UDInt Default
Timer Real Default
Timer LReal Default

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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SIMATIC S7 300/400 Word data type

Definition     
Data type "Word" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""Word".

You can adapt the following formats for data type "Word":

PLC data type HMI data type Coding
Word SInt None
Word USInt None
Word USInt Aiken
Word USInt BCD
Word USInt Excess
Word Int None
Word UInt None
Word UInt Aiken
Word UInt BCD
Word UInt Excess
Word UInt SimaticBCDCounter
Word DInt None
Word UDInt None
Word UDInt Aiken
Word UDInt BCD
Word UDInt Excess
Word Real None
Word LReal None

See also
SIMATIC S7 300/400 Byte data type (Page 1048)
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9.2.7.4 Data types for SIMATIC S7 1200

SIMATIC S7 1200 Date data type

Definition     
Data type "Date" is unsigned and has a length of two bytes. The date (IEC date) is represented 
in days, whereby the first day is January 1, 1990.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Date". 

You can adapt the following formats for data type "Date":

PLC data type HMI data type Coding
Date UInt Default

 
 

 Note

The data type "Date" is only available in S7 1200 PLCs with firmware as of version 2.
 

See also
SIMATIC S7 1200 DInt data type (Page 1059)

SIMATIC S7 1200 DWord data type (Page 1060)

SIMATIC S7 1200 Int data type (Page 1061)

SIMATIC S7 1200 LReal data type (Page 1062)

SIMATIC S7 1200 Real data type (Page 1063)

SIMATIC S7 1200 SInt data type (Page 1063)

SIMATIC S7 1200 Time data type (Page 1064)

SIMATIC S7 1200 Time_of_day data type (Page 1065)

SIMATIC S7 1200 UDInt data type (Page 1065)

SIMATIC S7 1200 UInt data type (Page 1066)

SIMATIC S7 1200 USInt data type (Page 1067)

SIMATIC S7 1200 Word data type (Page 1069)

Mapping and coding of data types (Page 1039)
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SIMATIC S7 1200 DInt data type

Definition     
Data type "DInt" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DInt".

You can adapt the following formats for data type "DInt":

PLC data type HMI data type Coding
DInt SInt None
DInt SInt Aiken
DInt SInt BCD
DInt SInt ExtBCD
DInt SInt Excess
DInt SInt MSB
DInt USInt None
DInt Int None
DInt Int Aiken
DInt Int BCD
DInt Int ExtBCD
DInt Int Excess
DInt Int MSB
DInt UInt None
DInt DInt None
DInt DInt Aiken
DInt DInt BCD
DInt DInt ExtBCD
DInt DInt Excess
DInt DInt MSB
DInt UDInt None
DInt Real None
DInt Real Aiken
DInt Real BCD
DInt Real ExtBCD
DInt Real Excess
DInt LReal None
DInt LReal Aiken
DInt LReal BCD
DInt LReal ExtBCD
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PLC data type HMI data type Coding
DInt LReal Excess
DInt LReal MSB

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 DWord data type

Definition     
Data type "DWord" is unsigned and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DWord".

You can adapt the following formats for data type "DWord":

PLC data type HMI data type Coding
DWord SInt None
DWord Sint Aiken
DWord Sint BCD
DWord Sint Excess
DWord USInt None
DWord USInt Aiken
DWord USInt BCD
DWord USInt Excess
DWord Int None
DWord Int Aiken
DWord Int BCD
DWord Int Excess
DWord UInt None
DWord UInt Aiken
DWord UInt BCD
DWord UInt Excess
DWord DInt None
DWord Dint Aiken
DWord Dint BCD
DWord Dint Excess
DWord UDInt None
DWord UDInt Aiken
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PLC data type HMI data type Coding
DWord UDInt BCD
DWord UDInt Excess
DWord Real None
DWord Real Aiken
DWord Real BCD
DWord Real Excess
DWord LReal None
DWord Lreal Aiken
DWord LReal BCD
DWord LReal Excess

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 Int data type

Definition     
Data type "Int" is signed and has a length of two bytes.

Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Int".

You can adapt the following formats for data type "Int":

PLC data type HMI data type Coding
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt Excess
Int DInt ExtBCD
Int DInt MSB
Int Int None
Int Int Aiken
Int Int BCD
Int Int Excess
Int Int ExtBCD
Int Int MSB
Int LReal None
Int LReal Aiken
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PLC data type HMI data type Coding
Int LReal BCD
Int LReal Excess
Int LReal ExtBCD
Int LReal MSB
Int Real None
Int Real Aiken
Int Real BCD
Int Real Excess
Int Real ExtBCD
Int SInt None
Int SInt Aiken
Int SInt BCD
Int SInt Excess
Int SInt ExtBCD
Int SInt MSB
Int UDInt None
Int UInt None
Int USInt None

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 LReal data type

Definition     
Data type "LReal" is signed and has a length of 8 bytes. The floating point format conforms to 
the IEEE 754 standard.

Format adaptation
"LReal" is set by default in the "HMI data type" field if you generate an external tag of data type 
"LReal".

You can adapt the following formats for data type "LReal":

PLC data type HMI data type Coding
LReal Real IEEE 754

See also
SIMATIC S7 1200 Date data type (Page 1058)
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SIMATIC S7 1200 Real data type

Definition     
Data type "Real" is signed and has a length of four bytes. The floating point format conforms 
to the IEEE 754 standard.

Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Real".

You can adapt the following formats for data type "Real":

PLC data type HMI data type Coding
Real LReal IEEE754

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 SInt data type

Definition     
Data type "SInt" is unsigned and has a length of one byte.

Format adaptation
"SInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"SInt".

You can adapt the following formats for data type "SInt":

PLC data type HMI data type Coding
SInt DInt None
SInt DInt Aiken
SInt DInt BCD
SInt DInt Excess
SInt DInt ExtBCD
SInt Int None
SInt Int Aiken
SInt Int BCD
SInt Int Excess
SInt Int ExtBCD
SInt LReal None
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PLC data type HMI data type Coding
SInt LReal Aiken
SInt LReal BCD
SInt LReal Excess
SInt LReal ExtBCD
SInt Real None
SInt Real Aiken
SInt Real BCD
SInt Real Excess
SInt Real ExtBCD
SInt SInt None
SInt SInt Aiken
SInt SInt BCD
SInt SInt Excess
SInt SInt ExtBCD
SInt UDInt None
SInt UInt None
SInt USInt None

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 Time data type

Definition    
Data type "Time" is signed and has a length of four bytes. The time (IEC time) is shown in 
milliseconds.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Time".

You can adapt the following formats for data type "Time":

PLC data type HMI data type Coding
Time DInt None

See also
SIMATIC S7 1200 Date data type (Page 1058)
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SIMATIC S7 1200 Time_of_day data type

Definition     
Data type "Time_Of_Day" is unsigned and has a length of four bytes. Data type "Time_Of_Day" 
contains the time of day in milliseconds. Milliseconds are calculated as of 00:00 AM.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Time_Of_Day".

You can adapt the following formats for data type "Time_Of_Day":

PLC data type HMI data type Coding
Time_Of_Day UDInt Default

 
 

 Note

The data type "Time_Of_Day" is only available in S7 1200 PLCs with firmware as of version 
2.

 

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 UDInt data type

Definition     
Data type "UDInt" is unsigned and has a length of four bytes. 

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"UDInt".

You can adapt the following formats for data type "UDInt":

PLC data type HMI data type Coding
UDInt DInt None
UDInt DInt Aiken
UDInt DInt BCD
UDInt DInt Excess
UDInt Int None
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PLC data type HMI data type Coding
UDInt Int Aiken
UDInt Int BCD
UDInt Int Excess
UDInt LReal None
UDInt LReal Aiken
UDInt LReal BCD
UDInt LReal Excess
UDInt Real None
UDInt Real BCD
UDInt Real Excess
UDInt SInt None
UDInt SInt Aiken
UDInt SInt BCD
UDInt SInt Excess
UDInt UDInt None
UDInt UDInt Aiken
UDInt UDInt BCD
UDInt UDInt Excess
UDInt UInt None
UDInt UInt Aiken
UDInt UInt BCD
UDInt UInt Excess
UDInt USInt None
UDInt USInt Aiken
UDInt USInt BCD
UDInt USInt Excess

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 UInt data type

Definition     
Data type "UInt" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""UInt".

You can adapt the following formats for data type "UInt":
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PLC data type HMI data type Coding
UInt DInt None
UInt DInt Aiken
UInt DInt BCD
UInt DInt Excess
UInt Int None
UInt Int Aiken
UInt Int BCD
UInt Int Excess
UInt LReal None
UInt LReal Aiken
UInt LReal BCD
UInt LReal Excess
UInt Real None
UInt Real Aiken
UInt Real BCD
UInt Real Excess
UInt SInt None
UInt SInt Aiken
UInt SInt BCD
UInt SInt Excess
UInt UDInt None
UInt UDInt Aiken
UInt UDInt BCD
UInt UDInt Excess
UInt UInt None
UInt UInt Aiken
UInt UInt BCD
UInt UInt Excess
UInt USInt None
UInt USInt Aiken
UInt USInt BCD
UInt USInt Excess

See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 USInt data type

Definition     
Data type "USInt" is unsigned and has length of one byte.
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Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""USInt".

You can adapt the following formats for data type "USInt":

PLC data type HMI data type Coding
USInt DInt None
USInt DInt Aiken
USInt DInt BCD
USInt DInt Excess
USInt DInt MSB
USInt Int None
USInt Int Aiken
USInt Int BCD
USInt Int Excess
USInt Int MSB
USInt LReal None
USInt LReal Aiken
USInt LReal BCD
USInt LReal Excess
USInt LReal IEEE754Float
USInt Real None
USInt Real None
USInt Real Aiken
USInt Real BCD
USInt Real Excess
USInt SInt None
USInt SInt Aiken
USInt SInt BCD
USInt SInt Excess
USInt SInt MSB
USInt UDInt None
USInt UDInt Aiken
USInt UDInt BCD
USInt UDInt Excess
USInt UInt None
USInt UInt Aiken
USInt UInt BCD
USInt UInt Excess
USInt USInt None
USInt USInt Aiken
USInt USInt BCD
USInt USInt Excess
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See also
SIMATIC S7 1200 Date data type (Page 1058)

SIMATIC S7 1200 Word data type

Definition     
Data type "Word" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""Word".

You can adapt the following formats for data type "Word":

PLC data type HMI data type Coding
Word DInt None
Word DInt Aiken
Word DInt BCD
Word DInt Excess
Word Int None
Word Int Aiken
Word Int BCD
Word Int Excess
Word LReal None
Word LReal Aiken
Word LReal BCD
Word LReal Excess
Word Real None
Word Real Aiken
Word Real BCD
Word Real Excess
Word SInt None
Word SInt Aiken
Word SInt BCD
Word SInt Excess
Word UDInt None
Word UDInt Aiken
Word UDInt BCD
Word UDInt Excess
Word UInt None
Word UInt Aiken
Word UInt BCD
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PLC data type HMI data type Coding
Word UInt Excess
Word USInt None
Word USInt Aiken
Word USInt BCD
Word USInt Excess

See also
SIMATIC S7 1200 Date data type (Page 1058)

9.2.7.5 Data types for OPC-DA

OPC-DA VT_I1 data type

Definition    
Data type "VT_I1" is signed and has length of one byte.

Format adaptation
"SInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_I1". 

You can adapt the following formats for data type "VT_I":

OPC data type HMI data type Coding
VT_I1 SInt None
VT_I1 SInt Aiken
VT_I1 SInt BCD
VT_I1 SInt ExtBCD
VT_I1 SInt Excess
VT_I1 SInt MSB
VT_I1 USInt None
VT_I1 Int None
VT_I1 Int Aiken
VT_I1 Int BCD
VT_I1 Int ExtBCD
VT_I1 Int Excess
VT_I1 Int MSB
VT_I1 UInt None
VT_I1 DInt None
VT_I1 DInt Aiken
VT_I1 DInt BCD
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OPC data type HMI data type Coding
VT_I1 DInt ExtBCD
VT_I1 DInt Excess
VT_I1 DInt MSB
VT_I1 UDInt None
VT_I1 Real None
VT_I1 LReal None

See also
OPC DA data type VT_EMPTY (Page 1076)

Mapping and coding of data types (Page 1039)

OPC-DA VT_UI1 data type

Definition    
Data type "VT_UI1" is unsigned and has a length of two bytes.

Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_UI1".

You can adapt the following formats for data type "VT_UI1":

OPC data type HMI data type Coding
VT_UI1 SInt None
VT_UI1 USInt None
VT_UI1 USInt Aiken
VT_UI1 USInt BCD
VT_UI1 Byte Excess
VT_UI1 Int None
VT_UI1 UInt None
VT_UI1 UInt Aiken
VT_UI1 UInt BCD
VT_UI1 UInt Excess
VT_UI1 DInt None
VT_UI1 UDInt None
VT_UI1 UDInt Aiken
VT_UI1 UDInt BCD
VT_UI1 UDInt Excess
VT_UI1 Real None
VT_UI1 LReal None
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OPC-DA VT_I2 data type

Definition    
Data type "VT_I2" is signed and has a length of two bytes.

Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_I2".

You can adapt the following formats for data type "VT_I2":

OPC data type HMI data type Coding
VT_I2 SInt None
VT_I2 SInt Aiken
VT_I2 SInt BCD
VT_I2 SInt ExtBCD
VT_I2 SInt Excess
VT_I2 SInt MSB
VT_I2 USInt None
VT_I2 Int None
VT_I2 Int Aiken
VT_I2 Int BCD
VT_I2 Int ExtBCD
VT_I2 Int Excess
VT_I2 Int MSB
VT_I2 UInt None
VT_I2 DInt None
VT_I2 DInt Aiken
VT_I2 DInt BCD
VT_I2 DInt ExtBCD
VT_I2 DInt Excess
VT_I2 DInt MSB
VT_I2 UDInt None
VT_I2 Real None
VT_I2 LReal None

OPC-DA VT_UI2 data type

Definition    
Data type "VT_UI2" is unsigned and has a length of two bytes.
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Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_UI2".

You can adapt the following formats for data type "VT_UI2":

OPC data type HMI data type Coding
VT_UI2 SInt None
VT_UI2 USInt None
VT_UI2 USInt Aiken
VT_UI2 USInt BCD
VT_UI2 USInt Excess
VT_UI2 Int None
VT_UI2 UInt None
VT_UI2 UInt Aiken
VT_UI2 UInt BCD
VT_UI2 UInt Excess
VT_UI2 DInt None
VT_UI2 UDInt None
VT_UI2 UDInt Aiken
VT_UI2 UDInt BCD
VT_UI2 UDInt Excess
VT_UI2 Real None
VT_UI2 LReal None

OPC-DA VT_I4 data type

Definition    
Data type "VT_I4" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VTI_4".

You can adapt the following formats for data type "VT_I4":

OPC data type HMI data type Coding
VT_I4 SInt None
VT_I4 SInt Aiken
VT_I4 SInt BCD
VT_I4 SInt ExtBCD
VT_I4 SInt Excess
VT_I4 SInt MSB
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OPC data type HMI data type Coding
VT_I4 USInt None
VT_I4 Int None
VT_I4 Int Aiken
VT_I4 Int BCD
VT_I4 Int ExtBCD
VT_I4 Int Excess
VT_I4 Int MSB
VT_I4 UInt None
VT_I4 DInt None
VT_I4 DInt Aiken
VT_I4 DInt BCD
VT_I4 DInt ExtBCD
VT_I4 DInt Excess
VT_I4 DInt MSB
VT_I4 UDInt None
VT_I4 Real None
VT_I4 LReal None

OPC-DA VT_UI4 data type

Definition    
Data type "VT_UI4" is unsigned and has a length of two bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_UI4".

You can adapt the following formats for data type "VT_UI4":

OPC data type HMI data type Coding
VT_UI4 SInt None
VT_UI4 USInt None
VT_UI4 USInt Aiken
VT_UI4 USInt BCD
VT_UI4 Byte Excess
VT_UI4 Int None
VT_UI4 UInt None
VT_UI4 UInt Aiken
VT_UI4 UInt BCD
VT_UI4 UInt Excess
VT_UI4 DInt None
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OPC data type HMI data type Coding
VT_UI4 UDInt None
VT_UI4 UDInt Aiken
VT_UI4 UDInt BCD
VT_UI4 UDInt Excess
VT_UI4 Real None
VT_UI4 LReal None

OPC-DA VT_R4 data type

Definition    
Data type "VT_R4" is signed and has a length of four bytes. The floating point format conforms 
to the IEEE 754 standard.

Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_R4".

You can adapt the following formats for data type "VT_R4":

OPC data type HMI data type Coding
VT_R4 Real None
VT_R4 LReal None

OPC-DA VT_R8 data type

Definition    
Data type "VT_R8" is signed and has a length of eight bytes. The floating point format conforms 
to the IEEE 754 standard.

Format adaptation
"LReal" is set by default in the "HMI data type" field if you generate an external tag of data type 
"VT_R8".

You can adapt the following formats for data type "VT_R8":

OPC data type HMI data type Coding
VT_R8 Real None
VT_R8 LReal None
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OPC-DA data types for a byte array

Forming a byte arrays
You use a raw data tag in WinCC to form an array from an OPC connection. The following 
configuration options are available if you are using OPC-DA:

OPC-DA data type HMI data type
VT_I1 | VT_ARRAY Raw
VT_UI1 | VT_ARRAY Raw
VT_I2 | VT_ARRAY Raw
VT_UI2 | VT_ARRAY Raw
VT_I4 | VT_ARRAY Raw
VT_UI4 | VT_ARRAY Raw
VT_I8 | VT_ARRAY Raw
VT_UI8 | VT_ARRAY Raw

OPC DA data type VT_EMPTY

Definition    
The data type "VT_EMPTY" is empty, there is no equivalent among the HMI data types for this 
data type.

Format adaptation
The OPC DA data type "VT_EMPTY" is usually converted to the HMI data type "Long". The 
OPC DA data type WVT_EMPTY" can also be converted to a simpler HMI data type, for 
example, Bool, SByte, UByte, Short, UShort, Long, ULong, Float, Double, Raw, WString.

See also
OPC-DA VT_I1 data type (Page 1070)

9.2.7.6 Data types for OPC-XML-DA

OPC-XML-DA Byte data type

Definition
Data type "Byte" is signed (plus or minus) and has a length of one byte.      
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Format adaptation
"SInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Byte".

You can adapt the following formats for data type "Byte":

PLC data type HMI data type Coding
Byte SInt None
Byte SInt Aiken
Byte SInt BCD
Byte SInt ExtBCD
Byte SInt Excess
Byte SInt MSB
Byte USInt None
Byte Int None
Byte Int Aiken
Byte Int BCD
Byte Int ExtBCD
Byte Int Excess
Byte Int MSB
Byte UInt None
Byte DInt None
Byte DInt Aiken
Byte DInt BCD
Byte DInt ExtBCD
Byte DInt Excess
Byte DInt MSB
Byte UDInt None
Byte Real None
Byte LReal None

See also
Mapping and coding of data types (Page 1039)

OPC-XML-DA unsignedByte data type

Definition       
Data type "unsignedByte" is unsigned and has a length of one byte.
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Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"unsignedByte".

You can adapt the following formats for data type "unsignedByte":

PLC data type HMI data type Coding
unsignedByte SInt None
unsignedByte USInt None
unsignedByte USInt Aiken
unsignedByte USInt BCD
unsignedByte USInt Excess
unsignedByte Int None
unsignedByte UInt None
unsignedByte UInt Aiken
unsignedByte UInt BCD
unsignedByte UInt Excess
unsignedByte DInt None
unsignedByte UDInt None
unsignedByte UDInt Aiken
unsignedByte UDInt BCD
unsignedByte UDInt Excess
unsignedByte Real None
unsignedByte LReal None

OPC-XML-DA Short data type

Definition       
Data type "Short" is signed and has a length of two bytes.

Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Short".

You can adapt the following formats for data type "Short":

PLC data type HMI data type Coding
Short SInt None
Short SInt Aiken
Short SInt BCD
Short SInt ExtBCD
Short SInt Excess
Short SInt MSB
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PLC data type HMI data type Coding
Short USInt None
Short Int None
Short Int Aiken
Short Int BCD
Short Int ExtBCD
Short Int Excess
Short Int MSB
Short UInt None
Short DInt None
Short DInt Aiken
Short DInt BCD
Short DInt ExtBCD
Short DInt Excess
Short DInt MSB
Short UDInt None
Short Real None
Short LReal None

OPC-XML-DA unsignedShort data type

Definition       
Data type "unsignedShort" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"unsignedShort".

You can adapt the following formats for data type "unsignedShort":

PLC data type HMI data type Coding
unsignedShort SInt None
unsignedShort USInt None
unsignedShort USInt Aiken
unsignedShort USInt BCD
unsignedShort USInt Excess
unsignedShort Int None
unsignedShort UInt None
unsignedShort UInt Aiken
unsignedShort UInt BCD
unsignedShort UInt Excess
unsignedShort DInt None
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PLC data type HMI data type Coding
unsignedShort UDInt None
unsignedShort UDInt Aiken
unsignedShort UDInt BCD
unsignedShort UDInt Excess
unsignedShort Real None
unsignedShort LReal None

OPC-XML-DA Int data type

Definition       
Data type "Int" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Int".

You can adapt the following formats for data type "Int":

PLC data type HMI data type Coding
Int SInt None
Int SInt Aiken
Int SInt BCD
Int SInt ExtBCD
Int SInt Excess
Int SInt MSB
Int USInt None
Int Int None
Int Int Aiken
Int Int BCD
Int Int ExtBCD
Int Int Excess
Int Int MSB
Int UInt None
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt ExtBCD
Int DInt Excess
Int DInt MSB
Int UDInt None
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PLC data type HMI data type Coding
Int Real None
Int LReal None

OPC-XML-DA unsignedInt data type

Definition       
Data type "unsignedInt" is unsigned and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"unsignedInt".

You can adapt the following formats for data type "unsignedInt":

PLC data type HMI data type Coding
unsignedInt SInt None
unsignedInt USInt None
unsignedInt USInt Aiken
unsignedInt USInt BCD
unsignedInt USInt Excess
unsignedInt Int None
unsignedInt UInt None
unsignedInt UInt Aiken
unsignedInt UInt BCD
unsignedInt UInt Excess
unsignedInt DInt None
unsignedInt UDInt None
unsignedInt UDInt Aiken
unsignedInt UDInt BCD
unsignedInt UDInt Excess
unsignedInt Real None
unsignedInt LReal None

OPC-XML-DA Float data type

Definition       
Data type "Float" is signed and has a length of four bytes.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1081



Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Float".

You can adapt the following formats for data type "Float":

PLC data type HMI data type Coding
Float Real None
Float LReal None

OPC-XML-DA Double data type

Definition       
Data type "Double" is signed (plus or minus) and has a length of eight bytes.

Format adaptation
"LReal" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Double".

You can adapt the following formats for data type "Double":

PLC data type HMI data type Coding
Double Real None
Double LReal None

9.2.7.7 Data types for Allen Bradley Ethernet IP

Allen Bradley Ethernet IP DInt data type

Definition     
Data type "DInt" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DInt".

You can adapt the following formats for data type "DInt":

PLC data type HMI data type Coding
Dint DInt None
Dint DInt Aiken
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PLC data type HMI data type Coding
Dint DInt BCD
Dint DInt Excess
Dint DInt ExtBCD
Dint Int None
Dint Int Aiken
Dint Int BCD
Dint Int Excess
Dint Int ExtBCD
Dint LReal None
Dint LReal Aiken
Dint LReal BCD
Dint LReal BCD
Dint LReal Excess
Dint Real None
Dint Real Aiken
Dint Real BCD
Dint Real Excess
Dint Real ExtBCD
Dint SInt None
Dint SInt Aiken
Dint SInt BCD
Dint SInt Excess
Dint SInt ExtBCD
Dint UDInt None
Dint UInt None
DInt USInt None

See also
Mapping and coding of data types (Page 1039)

Allen Bradley Ethernet IP Int data type

Definition     
Data type "Int" is signed and has a length of two bytes.

Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Int".

You can adapt the following formats for data type "Int":
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PLC data type HMI data type Coding
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt Excess
Int DInt ExtBCD
Int Int None
Int Int Aiken
Int Int BCD
Int Int Excess
Int Int ExtBCD
Int LReal None
Int LReal Aiken
Int LReal BCD
Int LReal BCD
Int LReal Excess
Int Real None
Int Real Aiken
Int Real BCD
Int Real Excess
Int Real ExtBCD
Int SInt None
Int SInt Aiken
Int SInt BCD
Int SInt Excess
Int SInt ExtBCD
Int UDInt None
Int UInt None

Allen Bradley Ethernet IP Real data type

Definition     
Data type "Real" is signed and has a length of four bytes. The floating point format conforms 
to the IEEE 754 standard.

Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Real".

You can adapt the following formats for data type "Real":

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1084 System Manual, 08/2011,  



PLC data type HMI data type Coding
Real Real IEEE754

Allen Bradley Ethernet IP SInt data type

Definition     
Data type "SInt" is signed and has length of one byte.

Format adaptation
"SInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"SInt".

You can adapt the following formats for data type "SInt":

PLC data type HMI data type Coding
SInt DInt None
SInt DInt Aiken
SInt DInt BCD
SInt DInt Excess
SInt DInt ExtBCD
SInt Int None
SInt Int Aiken
SInt Int BCD
SInt Int Excess
SInt Int ExtBCD
SInt LReal None
SInt LReal Aiken
SInt LReal BCD
SInt LReal Excess
SInt Real None
SInt Real Aiken
SInt Real BCD
SInt Real Excess
SInt Real ExtBCD
SInt SInt None
SInt SInt Aiken
SInt SInt BCD
SInt SInt Excess
SInt SInt ExtBCD
SInt UDInt None
SInt UInt None
SInt USInt None
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Allen Bradley Ethernet IP UDInt data type

Definition     
Data type "UDInt" is unsigned and has a length of four bytes. 

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"UDInt".

You can adapt the following formats for data type "UDInt":

PLC data type HMI data type Coding
UDInt DInt None
UDInt DInt Aiken
UDInt DInt BCD
UDInt DInt Excess
UDInt DInt MSB
UDInt Int None
UDInt Int Aiken
UDInt Int BCD
UDInt Int Excess
UDInt Int MSB
UDInt LReal None
UDInt LReal Aiken
UDInt LReal BCD
UDInt LReal Excess
UDInt LReal MSB
UDInt Real None
UDInt Real Aiken
UDInt Real BCD
UDInt Real Excess
UDInt Real MSB
UDInt SInt None
UDInt SInt Aiken
UDInt SInt BCD
UDInt SInt Excess
UDInt SInt MSB
UDInt UDInt None
UDInt UDInt Aiken
UDInt UDInt BCD
UDInt UDInt Excess
UDInt UInt None
UDInt UInt Aiken
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PLC data type HMI data type Coding
UDInt UInt BCD
UDInt UInt Excess
UDInt USInt None
UDInt USInt Aiken
UDInt USInt BCD
UDInt USInt Excess

Allen Bradley Ethernet IP UInt data type

Definition    
Data type "UInt" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""UInt".

You can adapt the following formats for data type "UInt":

PLC data type HMI data type Coding
UInt DInt None
UInt DInt None
UInt DInt Aiken
UInt DInt BCD
UInt DInt Excess
UInt DInt MSB
UInt Int None
UInt Int Aiken
UInt Int BCD
UInt Int Excess
UInt Int MSB
UInt LReal None
UInt LReal Aiken
UInt LReal BCD
UInt LReal Excess
UInt LReal MSB
UInt Real None
UInt Real Aiken
UInt Real BCD
UInt Real Excess
UInt Real MSB
UInt SInt None
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PLC data type HMI data type Coding
UInt SInt Aiken
UInt SInt BCD
UInt SInt Excess
UInt SInt MSB
UInt UDInt None
UInt UDInt Aiken
UInt UDInt BCD
UInt UDInt Excess
UInt UInt None
UInt UInt Aiken
UInt UInt BCD
UInt UInt Excess
UInt USInt None
UInt USInt Aiken
UInt USInt BCD

Allen Bradley Ethernet IP USInt data type

Definition     
Data type "USInt" is unsigned and has length of one byte.

Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""USInt".

You can adapt the following formats for data type "USInt":

PLC data type HMI data type Coding
USInt DInt None
USInt DInt Aiken
USInt DInt BCD
USInt DInt Excess
USInt DInt MSB
USInt Int None
USInt Int Aiken
USInt Int BCD
USInt Int Excess
USInt Int MSB
USInt LReal None
USInt LReal Aiken
USInt LReal BCD
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PLC data type HMI data type Coding
USInt LReal Excess
USInt LReal MSB
USInt Real None
USInt Real Aiken
USInt Real BCD
USInt Real Excess
USInt Real MSB
USInt SInt None
USInt SInt Aiken
USInt SInt BCD
USInt SInt Excess
USInt SInt MSB
USInt UDInt None
USInt UDInt Aiken
USInt UDInt BCD
USInt UDInt Excess
USInt UInt None
USInt UInt Aiken
USInt UInt BCD
USInt UInt Excess
USInt USInt None
USInt USInt Aiken
USInt USInt BCD
USInt USInt Excess

9.2.7.8 Data types for Modicon Modbus TCP/IP

Modicon Modbus TCP/IP +/- Double data type

Definition     
Data type "+/- Double" is signed and has a length of four bytes

Format adaptation
"+/- Double" is set by default in the "HMI data type" field if you generate an external tag of data 
type "DInt".

You can adapt the following formats for data type "+/- Double":
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PLC data type HMI data type Coding
+/- Double DInt None
+/- Double DInt Aiken
+/- Double DInt BCD
+/- Double DInt Excess
+/- Double DInt ExtBCD
+/- Double Int None
+/- Double Int Aiken
+/- Double Int BCD
+/- Double Int Excess
+/- Double Int ExtBCD
+/- Double LReal None
+/- Double LReal Aiken
+/- Double LReal BCD
+/- Double LReal BCD
+/- Double LReal Excess
+/- Double Real None
+/- Double Real Aiken
+/- Double Real BCD
+/- Double Real Excess
+/- Double Real ExtBCD
+/- Double SInt None
+/- Double SInt Aiken
+/- Double SInt BCD
+/- Double SInt Excess
+/- Double SInt ExtBCD
+/- Double UDInt None
+/- Double UInt None
+/- Double USInt None

See also
Modicon Modbus TCP/IP +/- Int data type (Page 1091)

Modicon Modbus TCP/IP 16 Bit Group data type (Page 1092)

Modicon Modbus TCP/IP Double data type (Page 1093)

Modicon Modbus TCP/IP Float data type (Page 1094)

Modicon Modbus TCP/IP Int data type (Page 1095)

Mapping and coding of data types (Page 1039)
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Modicon Modbus TCP/IP +/- Int data type

Definition     
Data type "+/- Int" is signed and has a length of four bytes.

Format adaptation
"+/- Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"+/- Int".

You can adapt the following formats for data type "+/- Int":

PLC data type HMI data type Coding
+/- Int DInt None
+/- Int DInt Aiken
+/- Int DInt BCD
+/- Int DInt Excess
+/- Int DInt ExtBCD
+/- Int Int None
+/- Int Int Aiken
+/- Int Int BCD
+/- Int Int Excess
+/- Int Int ExtBCD
+/- Int LReal None
+/- Int LReal Aiken
+/- Int LReal BCD
+/- Int LReal BCD
+/- Int LReal Excess
+/- Int Real None
+/- Int Real Aiken
+/- Int Real BCD
+/- Int Real Excess
+/- Int Real ExtBCD
+/- Int SInt None
+/- Int SInt Aiken
+/- Int SInt BCD
+/- Int SInt Excess
+/- Int SInt ExtBCD
+/- Int UDInt None
+/- Int UInt None
+/- Int USInt None
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See also
Modicon Modbus TCP/IP +/- Double data type (Page 1089)

Modicon Modbus TCP/IP 16 Bit Group data type

Definition     
Data type "16 Bit Group" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"16 Bit Group".

You can adapt the following formats for data type "16 Bit Group":

PLC data type HMI data type Coding
16 Bit Group DInt None
16 Bit Group DInt Aiken
16 Bit Group DInt BCD
16 Bit Group DInt Excess
16 Bit Group DInt MSB
16 Bit Group Int None
16 Bit Group Int Aiken
16 Bit Group Int BCD
16 Bit Group Int Excess
16 Bit Group Int MSB
16 Bit Group LReal None
16 Bit Group LReal Aiken
16 Bit Group LReal BCD
16 Bit Group LReal Excess
16 Bit Group LReal MSB
16 Bit Group Real None
16 Bit Group Real Aiken
16 Bit Group Real BCD
16 Bit Group Real Excess
16 Bit Group Real MSB
16 Bit Group SInt None
16 Bit Group SInt Aiken
16 Bit Group SInt BCD
16 Bit Group SInt Excess
16 Bit Group SInt MSB
16 Bit Group UDInt None
16 Bit Group UDInt Aiken
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PLC data type HMI data type Coding
16 Bit Group UDInt BCD
16 Bit Group UDInt Excess
16 Bit Group UInt None
16 Bit Group UInt Aiken
16 Bit Group UInt BCD
16 Bit Group UInt Excess
16 Bit Group USInt None
16 Bit Group USInt Aiken
16 Bit Group USInt BCD
16 Bit Group USInt Excess

See also
Modicon Modbus TCP/IP +/- Double data type (Page 1089)

Modicon Modbus TCP/IP Double data type

Definition    
Data type "Double" is unsigned and has a length of four bytes. 

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Double".

You can adapt the following formats for data type "Double":

PLC data type HMI data type Coding
Double DInt None
Double DInt Aiken
Double DInt BCD
Double DInt Excess
Double DInt MSB
Double Int None
Double Int Aiken
Double Int BCD
Double Int Excess
Double Int MSB
Double LReal None
Double LReal Aiken
Double LReal BCD
Double LReal Excess
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PLC data type HMI data type Coding
Double LReal MSB
Double Real None
Double Real Aiken
Double Real BCD
Double Real Excess
Double Real MSB
Double SInt None
Double SInt Aiken
Double SInt BCD
Double SInt Excess
Double SInt MSB
Double UDInt None
Double UDInt Aiken
Double UDInt BCD
Double UDInt Excess
Double UInt None
Double UInt Aiken
Double UInt BCD
Double UInt Excess
Double USInt None
Double USInt Aiken
Double USInt BCD
Double USInt Excess

See also
Modicon Modbus TCP/IP +/- Double data type (Page 1089)

Modicon Modbus TCP/IP Float data type

Definition    
Data type "Float" is unsigned and has a length of four bytes.

Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
""Float".

You can adapt the following formats for data type "Float":
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PLC data type HMI data type Coding
Float Real IEEE754Float
Float LReal IEEE754Float

See also
Modicon Modbus TCP/IP +/- Double data type (Page 1089)

Modicon Modbus TCP/IP Int data type

Definition     
Data type "Int" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""Int".

You can adapt the following formats for data type "Int":

PLC data type HMI data type Coding
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt Excess
Int DInt MSB
Int Int None
Int Int Aiken
Int Int BCD
Int Int Excess
Int Int MSB
Int LReal None
Int LReal Aiken
Int LReal BCD
Int LReal Excess
Int LReal MSB
Int Real None
Int Real Aiken
Int Real BCD
Int Real Excess
Int Real MSB
Int SInt None
Int SInt Aiken

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1095



PLC data type HMI data type Coding
Int SInt BCD
Int SInt Excess
Int SInt MSB
Int UDInt None
Int UDInt Aiken
Int UDInt BCD
Int UDInt Excess
Int UInt None
Int UInt Aiken
Int UInt BCD
Int UInt Excess
Int USInt None
Int USInt Aiken
Int USInt BCD
Int USInt Excess

See also
Modicon Modbus TCP/IP +/- Double data type (Page 1089)

9.2.7.9 Data types for Mitsubishi MC

Mitsubishi MC TCP/IP 4-Bit Block data type

Definition     
Data type "4-Bit Block" is unsigned and has length of one byte.

Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"4-Bit Block".

You can adapt the following formats for data type "4-Bit Block":

PLC data type HMI data type Coding
4-Bit Block UDInt None
4-Bit Block UDInt Aiken
4-Bit Block UDInt BCD
4-Bit Block UDInt Excess
4-Bit Block UInt None
4-Bit Block UInt Aiken
4-Bit Block UInt Excess
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PLC data type HMI data type Coding
4-Bit Block USInt None
4-Bit Block USInt Aiken
4-Bit Block USInt BCD
4-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 8-Bit Block data type (Page 1097)

Mitsubishi MC TCP/IP 12-Bit Block data type (Page 1098)

Mitsubishi MC TCP/IP 16-Bit Block data type (Page 1099)

Mitsubishi MC TCP/IP 20-Bit Block data type (Page 1099)

Mitsubishi MC TCP/IP 24-Bit Block data type (Page 1100)

Mitsubishi MC TCP/IP 28-Bit Block data type (Page 1101)

Mitsubishi MC TCP/IP 32-Bit Block data type (Page 1101)

Mitsubishi MC TCP/IP DInt data type (Page 1102)

Mitsubishi MC TCP/IP DWord data type (Page 1103)

Mitsubishi MC TCP/IP Int data type (Page 1104)

Mitsubishi MC TCP/IP Real data type (Page 1106)

Mitsubishi MC TCP/IP Word data type (Page 1106)

Mapping and coding of data types (Page 1039)

Mitsubishi MC TCP/IP 8-Bit Block data type

Definition     
Data type "8-Bit Block" is unsigned and has length of one byte.

Format adaptation
"USInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"8-Bit Block".

You can adapt the following formats for data type "8-Bit Block":

PLC data type HMI data type Coding
8-Bit Block UDInt None
8-Bit Block UDInt Aiken
8-Bit Block UDInt BCD
8-Bit Block UDInt Excess
8-Bit Block UInt None
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PLC data type HMI data type Coding
8-Bit Block UInt None
8-Bit Block UInt Aiken
8-Bit Block UInt Excess
8-Bit Block USInt None
8-Bit Block USInt Aiken
8-Bit Block USInt BCD
8-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP 12-Bit Block data type

Definition     
Data type "12-Bit Block" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"12-Bit Block".

You can adapt the following formats for data type "12-Bit Block":

PLC data type HMI data type Coding
12-Bit Block UDInt None
12-Bit Block UDInt Aiken
12-Bit Block UDInt BCD
12-Bit Block UDInt Excess
12-Bit Block UInt None
12-Bit Block UInt Aiken
12-Bit Block UInt BCD
12-Bit Block UInt Excess
12-Bit Block USInt None
12-Bit Block USInt Aiken
12-Bit Block USInt BCD
12-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)
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Mitsubishi MC TCP/IP 16-Bit Block data type

Definition     
Data type "16-Bit Block" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"16-Bit Block".

You can adapt the following formats for data type "16-Bit Block":

PLC data type HMI data type Coding
16-Bit Block UDInt None
16-Bit Block UDInt Aiken
16-Bit Block UDInt BCD
16-Bit Block UDInt Excess
16-Bit Block UInt None
16-Bit Block UInt Aiken
16-Bit Block UInt BCD
16-Bit Block UInt Excess
16-Bit Block USInt None
16-Bit Block USInt Aiken
16-Bit Block USInt BCD
16-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP 20-Bit Block data type

Definition     
Data type "20-Bit Block" is unsigned and has length of three bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"20-Bit Block".

You can adapt the following formats for data type "20-Bit Block":
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PLC data type HMI data type Coding
20-Bit Block UDInt None
20-Bit Block UDInt Aiken
20-Bit Block UDInt BCD
20-Bit Block UDInt Excess
20-Bit Block UInt None
20-Bit Block UInt Aiken
20-Bit Block UInt BCD
20-Bit Block UInt Excess
20-Bit Block USInt None
20-Bit Block USInt Aiken
20-Bit Block USInt BCD
20-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP 24-Bit Block data type

Definition    
Data type "24-Bit Block" is unsigned and has length of three bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"24-Bit Block".

You can adapt the following formats for data type "24-Bit Block":

PLC data type HMI data type Coding
24-Bit Block UDInt None
24-Bit Block UDInt Aiken
24-Bit Block UDInt BCD
24-Bit Block UDInt Excess
24-Bit Block UInt None
24-Bit Block UInt Aiken
24-Bit Block UInt BCD
24-Bit Block UInt Excess
24-Bit Block USInt None
24-Bit Block USInt Aiken
24-Bit Block USInt BCD
24-Bit Block USInt Excess
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See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP 28-Bit Block data type

Definition    
Data type "28-Bit Block" is unsigned and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"28-Bit Block".

You can adapt the following formats for data type "28-Bit Block":

PLC data type HMI data type Coding
28-Bit Block UDInt None
28-Bit Block UDInt Aiken
28-Bit Block UDInt BCD
28-Bit Block UDInt Excess
28-Bit Block UInt None
28-Bit Block UInt Aiken
28-Bit Block UInt BCD
28-Bit Block UInt Excess
28-Bit Block USInt None
28-Bit Block USInt Aiken
28-Bit Block USInt BCD
28-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP 32-Bit Block data type

Definition     
Data type "32-Bit Block" is unsigned and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"32-Bit Block".
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You can adapt the following formats for data type "32-Bit Block":

PLC data type HMI data type Coding
32-Bit Block UDInt None
32-Bit Block UDInt Aiken
32-Bit Block UDInt BCD
32-Bit Block UDInt Excess
32-Bit Block UInt None
32-Bit Block UInt Aiken
32-Bit Block UInt BCD
32-Bit Block UInt Excess
32-Bit Block USInt None
32-Bit Block USInt Aiken
32-Bit Block USInt BCD
32-Bit Block USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP DInt data type

Definition     
Data type "DInt" is signed and has a length of four bytes.

Format adaptation
"DInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DInt".

You can adapt the following formats for data type "DInt":

PLC data type HMI data type Coding
DInt DInt None
DInt DInt Aiken
DInt DInt BCD
DInt DInt Excess
DInt Int None
DInt Int Aiken
DInt Int BCD
DInt Int Excess
DInt Int ExtBCD
DInt LReal None
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PLC data type HMI data type Coding
DInt LReal Aiken
DInt LReal BCD
DInt LReal Excess
DInt LReal ExtBCD
DInt Real None
DInt Real Aiken
DInt Real BCD
DInt Real Excess
DInt Real ExtBCD
DInt SInt None
DInt SInt Aiken
DInt SInt BCD
DInt SInt Excess
DInt UDInt None
DInt UInt None
DInt USInt None

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP DWord data type

Definition     
Data type "DWord" is signed and has a length of four bytes.

Format adaptation
"UDInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
"DWord".

You can adapt the following formats for data type "DWord":

PLC data type HMI data type Coding
DWord DInt None
DWord DInt Aiken
DWord DInt BCD
DWord DInt Excess
DWord DInt ExtBCD
DWord DInt MSB
DWord Int None
DWord Int Aiken

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1103



PLC data type HMI data type Coding
DWord Int BCD
DWord Int Excess
DWord Int MSB
DWord LReal None
DWord LReal Aiken
DWord LReal BCD
DWord LReal Excess
DWord LReal MSB
DWord Real None
DWord Real Aiken
DWord Real BCD
DWord Real Excess
DWord Real MSB
DWord SInt None
DWord SInt Aiken
DWord SInt BCD
DWord SInt Excess
DWord SInt ExtBCD
DWord SInt MSB
DWord UDInt None
DWord UDInt Aiken
DWord UDInt BCD
DWord UDInt Excess
DWord UInt None
DWord UInt Aiken
DWord UInt BCD
DWord UInt Excess
DWord USInt None
DWord USInt Aiken
DWord USInt BCD
DWord USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP Int data type

Definition     
Data type "Int" is signed and has a length of two bytes.
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Format adaptation
"Int" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Int".

You can adapt the following formats for data type "Int":

PLC data type HMI data type Coding
Int DInt None
Int DInt Aiken
Int DInt BCD
Int DInt Excess
Int Int None
Int Int Aiken
Int Int BCD
Int Int Excess
Int Int ExtBCD
Int LReal None
Int LReal Aiken
Int LReal BCD
Int LReal Excess
Int LReal ExtBCD
Int Real None
Int Real Aiken
Int Real BCD
Int Real Excess
Int Real ExtBCD
Int SInt None
Int SInt Aiken
Int SInt BCD
Int SInt Excess
Int UDInt None
Int UInt None
Int USInt None
Int USInt None

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)
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Mitsubishi MC TCP/IP Real data type

Definition     
Data type "Real" is signed and has a length of four bytes. The floating point format conforms 
to the IEEE 754 standard.

Format adaptation
"Real" is set by default in the "HMI data type" field if you generate an external tag of data type 
"Real".

You can adapt the following formats for data type "Real":

PLC data type HMI data type Coding
Real LReal IEEE754

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

Mitsubishi MC TCP/IP Word data type

Definition     
Data type "Word" is unsigned and has a length of two bytes.

Format adaptation
"UInt" is set by default in the "HMI data type" field if you generate an external tag of data type 
""Word".

You can adapt the following formats for data type "Word":

PLC data type HMI data type Coding
Word DInt None
Word DInt Aiken
Word DInt BCD
Word DInt Excess
Word DInt ExtBCD
Word DInt MSB
Word Int None
Word Int Aiken
Word Int BCD
Word Int Excess
Word Int MSB
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PLC data type HMI data type Coding
Word LReal None
Word LReal Aiken
Word LReal BCD
Word LReal Excess
Word LReal MSB
Word Real None
Word Real Aiken
Word Real BCD
Word Real Excess
Word Real MSB
Word SInt None
Word SInt Aiken
Word SInt BCD
Word SInt Excess
Word SInt ExtBCD
Word SInt MSB
Word UDInt None
Word UDInt Aiken
Word UDInt BCD
Word UDInt Excess
Word UInt None
Word UInt Aiken
Word UInt BCD
Word UInt Excess
Word USInt None
Word USInt Aiken
Word USInt BCD
Word USInt Excess

See also
Mitsubishi MC TCP/IP 4-Bit Block data type (Page 1096)

9.2.8 Archive tags

9.2.8.1 Basic principles for data logging

Introduction
Data logging is used to collect, process and log process data from an industrial system. 
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When you analyze the logged process data, you can extract important business and technical 
information regarding the operational state of the system. 

Application of the data logging
You can use data logging to analyze error statuses and to document the process. By analyzing 
data logs, you can extract the information necessary to allow you to optimize maintenance 
cycles, increase product quality and ensure that quality standards are met. 

See also
Basics of tags (Page 975)

Logging Tags (Page 1111)

Data logging (Page 1127)

9.2.8.2 Data logging

Basics

Data logging

Introduction
Data is information that is collected during the process and saved in the memory of one of the 
connected automation systems. They represent the status of a plant in the form of 
temperatures, fill levels or switching states, for example. You define tags for acquiring and 
editing the process values in WinCC.   

External tags are used in WinCC to collect process values and to access a memory address 
in the connected automation system. Internal tags are not connected to any process and are 
only available to the associated HMI device.

Principle
The values of external and internal tags can be saved in data logs. Create a log tag for every 
tag and specify the log in which it is saved.

Data logging is controlled via cycles and events. Logging cycles are used to ensure continuous 
acquisition and storage of the tag values. You can also trigger tag logging in response to 
events, such as the change in value of a tag. Define these settings independently for each log 
tag.   

In runtime, the tag values which are to be logged are captured, processed and stored in an 
ODBC database or a file.
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Logging methods
In WinCC, you have access to the following logging methods:       

● Circular log

● Segmented circular log

● Circular log which sends a system alarm message when it is full

● Circular log which executes system functions when it is full.

Storage media and storage location
The logged data is stored in an ODBC database or in a file. An ODBC database is only available 
on a PC.  

Depending on the hardware configuration of the HMI device, the data logs and alarm logs can 
be saved locally (on the hard disk of the PC or on the memory card on a panel) or, if available, 
on a network drive.

You can further process the saved data in other programs for analysis purposes, for example.

Outputting logged data
In runtime, you can output the logged tag values as trends in the process screens.  

See also
Logging Tags (Page 1111)

Storage locations of logs (Page 1110)
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Storage locations of logs

Storage location of a log
Depending on the HMI device used, you have several options of setting up the storage location 
for a data log you may be using in WinCC flexible.

File - CSV (ASCII)
Data is saved to a CSV file in standard ASCII format.

Use the "File - CSV (ASCII)" storage location if you are going to read or evaluate logged data 
without using WinCC Runtime.

 

 Note

Double quotation marks or several characters are not permitted as list separators for the 
storage location "File - CSV (ASCII)." You can find the settings for list separators under "Start 
> Settings > Control Panel > Regional and Language Options".

 

File - TXT (Unicode)
Data is stored in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, you will need software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data will be saved with quick access to a proprietary database. 

Use the "File - RDB" storage location if you require maximum read performance in Runtime. 

Data logs of this format can only be read or displayed using WinCC Runtime.

Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside WinCC Runtime.

Logs with checksum
The following files are generated under special circumstances:    

*.keep

1. If a log is started without checksum and will be continued with a checksum.

2. If you update WinCC with a service pack or a new version and the Audit Trail or the log is 
continued with the checksum.
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The content of the keep file will remain the same when compared with the original csv file or 
txt file. 

*.bak

If WinCC Runtime has determined a serious, irregular problem in the file.

Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 

See also
Data logging (Page 1108)

Working with data logs

Logging Tags

Introduction
In Runtime, you store tag values in logs. You can then analyze the logged data at a later date. 
You define the following conditions for logging a tag:       

● The log tag, through which the values of the connected tag are logged.

● The data log in which the tag is stored.

● The cycle or the event with which the tag is stored.

● The value range within which the tag is stored.
 

  Note

You use data logging mainly to log the values of external tags. You can also log the values 
of internal tags.
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Principle
Several steps come together during data logging:

● Creating and configuring the data log
When you create a data log, you define the following settings:

– General settings, such as name, size and storage location

– Runtime start characteristics

– Behavior when the log is full

● Configuring the logging of tags
For every log tag, specify a data log in which the values of the connected tags and other 
information are logged, such as the time of logging.
When and how often the values of a log tag are logged are also defined. You have the 
following options: 

– "On demand":
The tag values are logged by calling the "LogTag" system function.

– "On change":
The tag values are logged as soon as the HMI device detects a change in the value of 
the tag.

– "Cyclic":
The tag values are logged at regular intervals. You can supplement the default cycles 
in WinCC with your own cycles based on the default cycles. The smallest value that can 
be set is 1 s. All other values are integer multiples of this value.
You can also restrict the logging of values within or outside a tolerance band. In this 
way, the logging of values within a relevant range of values is restricted.

 
Note the following points if you want to log a tag on demand:

– Do not log this type of tag in a segmented circular log in which tags are logged in a 
continuous cycle or in response to changes.

Background:

– If logging takes place on demand only rarely, the log segment will be filled by cyclically-
logged values, for example, and the next log segment will be created. If you then attempt 
to access the tag that was logged on demand, it will not be possible to display the tag 
since it is the current log segment that is accessed in Runtime. To remedy this, you 
should create a separate data log for tags that are logged only rarely.

● Further processing logged tag values
You can analyze the logged tag values directly in your project, such as in a trend view, or 
in another user program, such as Excel.
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See also
Basic principles for data logging (Page 1107)

Data logging (Page 1108)

Configuring a checksum for a log (Page 1121)

Evaluating the checksum of log data (Page 1122)

Log response to language switching in runtime (Page 1124)

Creating a data log

Introduction
Data logs are used to store values from external and internal tags in runtime. When you create 
a log, you must give it a name and define its size and storage location. In addition you can 
enter comments for each log.   

Requirement
● A project is open.

● The Inspector window is open.

Procedure
To create a data log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and alarm logs opens.

2. Open the "Data logs" tab and double-click "Add" in the "Name" column of the "Data logs" 
editor.
A new data log is created.

3. In the Inspector window select "Properties > Properties > General."

4. Enter a unique name for the log in the "Name" field.

5. Define the number of data records to be logged in each log in the "Number of data records 
per log" field.
The size of a log is calculated as follows: The number of items * the length of each tag 
value to be logged.
In the Inspector window, the maximum size that the log can reach if the currently selected 
number of data records is observed is displayed beneath the "Number of data records" 
input field.

6. In the "Storage location" field, select whether the logged data should be stored in a file or 
in a database. The log can only be stored in a database on a PC.
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7. If you selected "File" as the storage location, select the storage location for the file in the 
"Path" field.
On PC HMI devices, you save the log on the hard disk or on a network drive, if there is one. 
The syntax for path specification is as follows:

– For hard disk: <C:\My_File_Folder\My_Archives\Machine_1>

– For network drive: <\\My_Fileservername\My_File_Folder\My_Archives\Machine_1>

Select one the following storage location for Panel HMI devices:

– Memory card
Select the path <\Storage Card MMC>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card MMC\My_Archives\TagLogs>

– USB memory 
Select the path <\Storage Card USB>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card USB\My_Archives\TagLogs>

– Network drive
The syntax to specify the path is as follows: <\\My_Fileservername\My_File_Folder
\My_Archives\Machine_1>

The selection available depends on the HMI device in use.

8. If you selected "Database" as the storage location, specify whether the data source name 
from the system should be used or whether you want to enter one yourself. In the latter 
case, enter a name for the data source.

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

 

 Note

The characters which can be used in the name of the data source depend on the storage 
location.

If the "File" storage location is used, the following characters must not be used: \ / * ? : " < > 
|

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $
However, the characters _ @ # $ may not be used as the first character of the name.   

The names of logs must be unique in a project. Log names must also be unique if different 
storage locations are selected for different logs. You must also assign different names for 
alarm logs and data logs.  

 

Result
The data log is created.

You can now configure tags so that their values are stored in this log.

To continue the log configuration, perform the following steps:
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● Define the restart characteristics of the log when Runtime is started.

● Define how the log should behave when it is full.

● Configure a function list for the "Overflow" event.

Managing logging behavior when Runtime starts

Introduction
When you configure a data log, you define the restart characteristics of the log when Runtime 
is started. You define whether the logging should start when Runtime starts in the log 
properties. You can also define whether an existing log will be continued or overwritten.  

You define the restart characteristics separately for each log.

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
To configure the restart characteristics of a data log, proceed as follows:

1. Select the log for which you want to define the restart characteristics in the "Data Log" editor.

2. In the Inspector window select "Properties > Properties > Restart behavior."

3. If you want logging to start when Runtime starts, enable the "Enable logging at runtime 
start" option in the "Logging" area.
You can also start logging in Runtime using the "StartLogging" system function, for example.

4. Select the restart behavior of the log in the "Log handling at restart" area.

– The logged values are deleted and logging is started again with the option "Reset log".

– The option "Append data to existing log" is used to append the values to be logged to 
the existing log.

Alternatively you can configure the restart characteristics of a log directly in the "Data log" 
editor table. To view hidden columns, activate the column titles using the shortcut menu.

Result
Logging will start in runtime according to your settings. 
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Controlling the Logging in relation to the Fill Level

Introduction
The size of a log is determined by the number of entries. You use the logging method to 
determine how the log responds when it is full.   

Logging methods
The following logging methods are available:

●  Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approx. 20% of the oldest entries are deleted. It is 
therefore not possible to display all the configured entries. During configuration, select an 
appropriate size for the circulation log. Alternatively, configure a segmented circular log.  

●  Segmented circular log
In a segmented circular log, multiple log segments of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

●  Log that sends a system alarm when it is full
When a defined level is reached, such as 90 %, a system alarm is triggered. When the log 
is 100% full, new tag values are not logged. 

●  Log with level-dependent triggering of an event.
When the log is completely full, the "Overflow" event is triggered. Configure a function list 
for the event that will be carried out when the "Overflow" event occurs. When the configured 
size of the log is reached, new tag values are not logged.
The following system functions are available for further processing of full logs: For further 
details, refer to System functions for logs (Page 1120).

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
1. Select the log for which you want to define the logging method in the "Data Log" editor.

2. Select "Properties > Properties > Logging method" in the Inspector window and select the 
required logging method.

3. If you have selected the "Segmented circular log" type, enter the number of log segments.
If you selected a log with the "Display system alarm on" setting, specify the level as a 
percentage at which a system alarm is to be triggered.
If you selected the "Trigger event" setting, configure the function list in the "Events" group.

Alternatively you can configure the logging method directly in the "Data log" editor table. To 
view hidden columns, activate the column titles using the shortcut menu.
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The "Overflow" event is not available in the editor table. You must therefore configure the 
function list in the Inspector window.

Result
The selected log responds according to the settings in Runtime.

See also
System functions for logs (Page 1120)

Logging process values

Introduction
You can save the process values of a tag in a data log in Runtime. You define the following 
conditions for logging a tag:

● The log tag, through which the values of the connected tag are logged.

● In which log the values are stored

● The conditions under which the values are stored

● If only process values for a certain range of values are stored          

To log the tag values, assign a logging tag to an HMI tag. The logging tag is stored in the data 
log and logs the values of the connected HMI tag. You can configure logging tags directly in 
the "HMI tags" editor. The " HMI tags" editor contains the "Logging tags" editing table.

If the view of the "Logging tags" table is minimized, click the arrow button below the tag table.
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Figure 9-1 The "Logging tags" table is displayed.

Requirement
● The data log has been created.

● The tag for which you wish to configure the logging must already exist.

● The "Tags" editor is open.

● The "Logging tags" table is displayed.

● The Inspector window with the tag properties is open.

Procedure
To log process values in a tag, proceed as follows:

1. Select a tag in the tag table.

2. Double-click "Add" in the "Name" field in the "Logging tags" table.
A new logging tag is created; it is given the same name as the associated HMI tag.

3. Select the data log in which the values of the tags are to be logged under "Properties > 
Properties > General" in the Inspector window.

4. Select "Properties > Properties > Logging type" in the Inspector window and select the log 
type for logging.

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.

5. If you want to log tag values cyclically, select a cycle time in the "Logging cycle" area. 
Alternatively, you can define your own cycle using the object list. The smallest value that 
can be set is 1 s. All other values are integer multiples of this value.
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6. If you only want to log tag values outside or inside a defined value range, select "Properties 
> Properties > Deadband for logging" in the Inspector window. Define the values for the 
high and low limits.
If you want to configure a dynamic limit, select "HMI tag" using the selection button. In the 
second field, select the tag that contains the limit.
If you want to configure a fixed limit, select "Constant." Enter the limit value in the second 
field.
If you want to leave a limit undefined, select "None".

7. Under "Scope", specify whether tag values are to be logged only if they are within the 
defined limits or only if they are outside the defined limits.

Alternatively, you can configure the logging of a tag directly in the "Logging tags" editor table. 
To view hidden columns, activate the column titles using the shortcut menu.

You can also fully configure a logging tag in the "Historical Data" editor.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

 

 Note

To have the tag values actually logged in runtime, you must ensure that the data log is started. 
Logging can be started automatically at start up or by means of a system function. To 
automatically start the log, use the setting in the log Properties window.

 

Triggering a system function when log is full

Introduction
You can select a logging method that executes a function list as soon as the log is full.  

Application example
You can use system functions, for example, to swap the data from a full log file out to another 
log before the full log is overwritten. You can then continue to process the transferred data in 
another program. Assign the "CopyLog" system function to the "Overflow" event accordingly.  

Requirement
● A log with the "Trigger event" logging method is created.

● The "Data log" editor is open.

● The Inspector window with the data log properties is open.
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Procedure
To configure a system function for the "Overflow" event, proceed as follows:

1. Select the required log in the table in the "Data Log" editor.

2. In the Inspector window select "Properties > Events > Overflow."
The function list will open.

3. Double-click "Add function" and select the desired system function.

4. Configure the required parameters of the selected system function.

Result
During runtime, the function list will be executed as soon as the log is full.

System functions for logs

System functions
The following system functions are available for logging:

Function name How it works
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function if you want to move the Audit Trail, 
for example, from a local storage medium to the server.
With Audit Trails, always use the "Move log (hmiMove)" mode, otherwise 
you will be violating the FDA guideline by duplicating the data stored.

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.

StopLogging Stops the logging process in the specified log. To resume logging in 
Runtime, select the "StartLogging" system function.

ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

log segment that has been configured for the given log.
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is restored.

CopyLog Copies the contents of the specified log to another log.

See also
System functions (Page 1743)
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Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.

Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".

3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.
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Result
The log data of the log is assigned a checksum in runtime.

See also
Logging Tags (Page 1111)

Enabling GMP compliant configuration (Page 2416)

GMP-compliant configuration (Page 2413)

Evaluating the checksum of log data (Page 1122)

Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format

You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".
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3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.

4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.

 

 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Logging Tags (Page 1111)

Configuring a checksum for a log (Page 1121)

Enabling GMP compliant configuration (Page 2416)

Evaluating Audit Trails in AuditViewer (Page 2434)
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Log response to language switching in runtime

Introduction
In the Runtime settings of your HMI device, select the language to be used for writing to logs 
in runtime.       

Requirement
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
To determine the startup language, follow these steps:   

1. Select "Runtime settings > Language and fonts" in the project navigation.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order". Use 0 to determine the startup language, for example:

– German 0.

– English 1
With "0", German is specified as the "Startup language".

4. Select "Runtime settings > General" in the project navigation.

5. Select the "Logs > Logging language > Startup language".

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.

The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

See also
Logging Tags (Page 1111)
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Logging tags in the "Historical Data" editor

Configuring logging tags

Introduction
You can also create and edit logging tags in the "Historical Data" editor in WinCC. You also 
directly edit the properties of logging tags in the "Historical Data" editor.

 

 Note

If you delete, move or copy in the "Historical Data" editor, the changes also take effect in the 
tag table.

 

Requirement
● The "Data logs" tab is open in the "Historical Data" editor.

● A data log has been created.

Procedure
Proceed as follows to configure a logging tag in the "Historical Data" editor:  

1. Select an existing data log in the "Data logs" table of the editor.
Alternatively, double-click on "Add..." in the "Name" column to create a new data log.

2. Double-click "Add ..." in the "Name" column of the editor "Logging tags" table.

3. Enter a unique name for the logging tag in the "Name" field.
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4. In the "Process tag" field, click on the selection button and select the process tag for logging 
in the object list.

5. Select the desired trigger mode in the "Log type" field:

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.

6. If you want to log tag values cyclically, select the desired cycle time in the "Logging cycle" 
area. Alternatively, you can define your own cycle using the object list. The smallest value 
that can be set is 1 s. All other values are integer multiples of this value.

7. Configure additional parameters for logging in the table of the editor or in the Inspector 
window.

Result
The configured logging tag is created in the "Historical Data" editor and is also displayed in 
the tag table.
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9.2.8.3 Data logging

Data logging

Introduction
The logging system is used for data logging in Runtime. The logging system processes the 
process values cached in the Runtime database and writes them to the logging database.  

The following WinCC subsystems are involved in the data logging: 

● Automation system (AS): Saves the process values that are sent to WinCC via 
communication drivers.

● Data manager (DM): Processes the process values and returns them to the logging system 
via process tags.

● Log system: Processes the acquired process values (by calculating the average, for 
example). The method of processing depends on the configuration of the log.

● Runtime database (DB): Saves the process values that are to be logged.

Term definitions
The question of whether and when process values are acquired and logged is dependent on 
a variety of parameters. The parameters to be configured depend on the applied logging 
method:

● Acquisition cycle: Determines when the value of a process tag is read out in the automation 
system. You can, for example, configure an acquisition cycle for cyclic data logging.

● Logging cycle: Determines when the processed process value is saved in the log database. 
You can, for example, configure a logging cycle for cyclic data logging.

● Start/stop tag: Starts data logging when the assigned binary tag has the value "1". Logging 
stops as soon as the start condition is no longer in effect. You can configure a start/stop 
tag for cyclic-selective data logging. 

● Logging on demand: Process values are logged only upon demand. The request is 
controlled by a binary tag. Use the "Upon demand" trigger mode for the configuration.

● Data logging on change: Process values are logged only when they have changed. Use 
the "On change" trigger mode for the configuration.

See also
Basic principles for data logging (Page 1107)
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Basics

Basic principles for data logging

Introduction
Data logging is used to collect, process and log process data from an industrial system. When 
you analyze the logged process data, you can extract important business and technical 
information regarding the operational state of the system. 

How it works
The process values to be logged are compiled, processed and saved in the log database in 
Runtime. Current or previously logged process values can be output in Runtime as a table or 
trend. In addition, it is possible to print out logged process values as a report. 

Configuration
You configure the logging of process values in the "Historical Data" editor. You create data 
logs and compressed logs. You define the acquisition cycles, logging cycles, and select the 
process values to be logged.

You configure trend views and table views for displaying process data in Runtime in the 
"Screens" editor. These views allow you to output the process data in the form of trends and 
tables.

You configure the output of logged process data in report format in the "Reports" editor. You 
output the process data in the report as a table or a trend.

Application
You can use data logging for the following tasks:

● Early detection of danger and fault conditions

● Increase of productivity

● Increase of product quality

● Optimization of maintenance cycles

● Documentation of process value trends

See also
Telegram Tags (Page 1129)

Structure of a Telegram with Raw Data Tags (Page 1130)
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Logging tags

Introduction
The values of external and internal tags are stored in logging tags in a data log.

Logging tags
There must be one archive tag created in the data log for every tag whose values are to be 
logged. There are suitable types of logging tags for the various tag data types. We distinguish 
between the following types of logging tag:

● An analog archive tag stores numerical process values, such as the fill level of a tank.

● A binary archive tag stores binary process values, such as whether a motor was switched 
on or off.

Archived process values can be compressed. This compression is achieved through the 
application of mathematical functions, for example, averaging. Compressed process values 
of this type are stored in compressed logging tags in a compressed log.

Telegram Tags

Introduction
Telegramtags are needed for the acquisition of quickly changing process values, or if you want 
to combine several measuring points from one plant.

 

 Note

Telegram tags are of the "raw data type" in WinCC and are therefore also referred to a "raw 
data tags". 

 

Principle
In the automation system the process values are written to a binary file, and are sent as a 
telegram to WinCC where they are stored in a raw data tag.

Archiving of Telegrams
If you want the acquired process values belonging to a raw data tag to be archived, you need 
to configure a process-controlled tag in the data log. To enable the archive system to process 
the telegram in the process-controlled tag, select a format DLL. The format DLL is supplied 
with the automation system that you are using and dismantles the telegram, for example, to 
ascertain the process values. The process values are then written to the archive database.

A format DLL for the SIMATIC S7 is included as standard in the scope of delivery of WinCC.

If you want to log a raw data tag, you have to activate the "Archive data link" option in the 
properties of the raw data tag. In the Inspector window, activate the option under "Properties 
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> Properties > Raw data". When the option "Archive data link" is activated, you can select and 
connect the raw data tag at the logging tag under "Properties > General" in the "Process tag" 
field.

See also
Basic principles for data logging (Page 1128)

Structure of a Telegram with Raw Data Tags (Page 1130)

Structure of a Telegram with Raw Data Tags

Introduction
A telegram for the transfer of raw data tags consists of two parts: a header and a body.

Telegram header
The header contains general data, i.e. length of the telegram.  The high byte of data word 0 is 
not used by the system and might thus be assigned by the user as required.
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Telegram body
In the block status word, the format of the measurement values and the format of the 
measurement areas, among other things, are defined. Bit 10 is reserved and will be used in 
future versions for switching daylight saving and standard times (daylight saving time = 1).

Time and date are structured in accordance with the definition of the sequential time indication. 

To transfer a measurement area, 8 data words are necessary. In these words, the upper and 
lower limits of the tag and the archive are specified.

The following section contains a number of sample telegram types.

Type 1
Measured value of a process tag + date and time
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Type 2
n measured values of a process tag + date and time of each measured value

Type 3
n measured values of a process tag with date and time, and sampling cycle

Type 4
n measured values of various process tags with time and date
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Type 5
n measured values of various process tags without time and date

See also
Basic principles for data logging (Page 1128)

Telegram Tags (Page 1129)

Types of Logging

Trigger mode

Introduction
You can use different logging methods to log process values. This will allow you to monitor an 
individual process value at certain times, for example. You make the monitoring dependent 
on certain events. You can log quickly-changing process values without increasing the system 
load as a result. You can also compress existing logged process values to reduce the volume 
of data.
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Logging methods
The logging method is determined by the selected trigger mode. The following logging methods 
are available in Runtime:

● Cyclic data logging: Continuous data logging to monitor a process value, for example.

● Cyclic-selective data logging: Event-controlled, continuous data logging to monitor a 
process value within a specific time period, for example.

● Data logging on demand: Process values are logged only on demand from a trigger tag.

● Data logging on change: Process values are logged only when they have changed.

● Compressed log: Compression of individual logging tags or of entire data logs, such as the 
hourly averaging of process values that were logged every minute.

Cycles and Events

Introduction 
Data logging is controlled via cycles and events. The acquisition and logging cycles allow you 
to continuously acquire and store process values. You can also trigger or end data logging by 
demand or by events. Cycles and events may be combined. For example, a process value 
can be acquired regularly, but the logging will only be triggered by a binary event.          

Acquisition cycle
The acquisition cycle determines the interval at which the process value of a process tag is 
read. The shortest possible value is 500 ms. All other values are integer multiples of this value. 
The start time of an acquisition cycle is determined by the start time of WinCC Runtime.

 

 Note

A short acquisition cycle may lead to a high system load. Make sure that the acquisition cycle 
you select is only as short as you actually need.

 

Logging cycle
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle. The start time of the logging 
cycle depends on either the start time of WinCC Runtime or the selected starting point.

When you set the start time, the values will be logged after a delay, which will share out the 
logging load. Examples:
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● Process values are logged in three cycles: every minute, every two minutes, and every 
three minutes. This causes a high logging load every six minutes. You should therefore 
assign a different start time to each of the three cycles.

Logging cycle Selected start time
1 min At the 15th second
2 min At the 30th second
3 min At the 45th second

● Many process values must be logged every ten seconds. To distribute the logging load, 
configure two 10-second cycles with different starting points. Logging is performed at both 
of the selected starting points.
You can configure the starting point for a cycle in the cycle properties in the "Cycles" editor.

The logging load will be distributed by the different starting points.
 

 Note

If the same cycle is used for acquisition and logging, it does not necessarily mean that 
acquisition and logging are started simultaneously.

There might be a system delay of up to the length of one acquisition cycle between the time 
of acquisition and the time of logging.

 

Processing method
All process values read from the process tags during the time period between acquisition and 
logging will be processed by the logging function. There are different processing methods 
available for binary and analog values.

In a data log, use one of the following processing methods for analog values:  

● Current: Saves the last acquired process value.

● Total: Saves the sum of all acquired process values.

● Maximum: Saves the highest of all acquired process values.

● Minimum: Saves the lowest of all acquired process values.

● Average value: Saves the mean of all acquired process values.

● Calculation: The value to be logged is calculated from the most recently acquired process 
value. The calculation is made using a function created in the "Scripts" editor.

In a data log, use one of the following processing methods for binary values:

● 0 to 1: The logging takes place whenever the value changes from 0 to 1.

● 1 to 0: The logging takes place whenever the value changes from 1 to 0.

● On each change: The logging takes place whenever the value changes from 0 to 1 or from 
1 to 0.

● Always: The logging depends on the selected cycle and does not depend on the change 
in value.
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Events
Start events and end data logging. Conditions that trigger an event can be linked to a tag. 
Events are differentiated as follows in WinCC:

● Binary action: Responds to changes in a Boolean tag.
Example: Switching on a motor starts the data logging.

● Deadband criterion: Defines an absolute or percentage value by which the newly acquired 
tag value has to deviate from the old tag value so that the newly acquired tag value will be 
logged. The value change can be absolute or relative.
Example: Logging is triggered in response to temperature fluctuations greater than 2 %.

● Time-controlled event: Responds at a fixed time or when a defined period of time from the 
start of data logging has elapsed.
Example: A log is output after every shift change.

Cyclic data logging

Introduction   
Cyclic data logging begins when Runtime starts. The process values are acquired at fixed 
cycles and stored in the log database. You can also specify limits. The process value is then 
only logged if it is within the defined limits. A comparison of the process value with the limit 
values takes place after acquisition of the process value.

Cyclic data logging ends when Runtime closes.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The acquisition cycle (1) determines when the process value is read from 
the memory of the connected PLC.

The Runtime component of the logging system processes the process value:

● Whether the process value is logged at all will depend on the way you have configured the 
system. For example, the process value may have to change by a certain amount or 
percentage (2).

● The logging function (3) defines how the acquired process values will be processed (by 
averaging, for example).
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The logging cycle (4) determines when the processed process value is written to the log 
database. 

Cyclic-selective data logging

Introduction   
The start of cyclic-selective data logging is controlled by a "Bool" type tag. Logging is started 
as soon as the tag takes the value "1" in Runtime. The process values are subsequently 
acquired at fixed cycles and stored in the log database. You can also specify limits. The process 
value is then only logged if it is within the defined limits. A comparison of the process value 
with the limit values takes place after acquisition of the process value.

Cyclic data logging is ended by the following events:

● When the tag for starting the logging has the value "0".

● When you exit Runtime.

When data logging stops, the most recently acquired process value is also logged.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. Data logging starts as soon as the tag for the start of logging has the value 
"1" in Runtime (2). The acquisition cycle (1) determines when the process value is read from 
the memory of the connected PLC.

The Runtime component of the logging system processes the process value:

● Whether the process value is logged at all will depend on the way you have configured the 
system. For example, the process value may have to change by a certain amount or 
percentage (3).

● The logging function (4) defines how the acquired process values will be processed (by 
averaging, for example).

When logging stops (6), the logging cycle (5) determines when the processed process value 
is written to the log database.
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Data logging on demand

Introduction   
Data logging on demand saves the current process value to the logging database only on 
demand in Runtime. The demand is controlled by a trigger tag. The trigger tag is of the data 
type "Bool". Logging takes place every time the status of the trigger tags changes. You can 
also specify limits. The process value is then only logged if it is within the defined limits. A 
comparison of the process value with the limit values takes place after acquisition of the 
process value.

Data logging on demand ends when Runtime closes.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The process value is read from the PLC (1) when a request from the trigger 
tag (2) is received. The Runtime component of the logging system processes the process 
value. The current process value is then written to the logging database (3).

The process value is read anew from the connected PLC (1) with each new request from the 
trigger tag (2), it is processed and logged (3).

Data logging on change

Introduction   
Data logging on change saves the current process value to the log database in Runtime when 
the process value changes. You can also specify limits. The process value is then only logged 
if it is within the defined limits. A comparison of the process value with the limit values takes 
place after acquisition of the process value.

Data logging on change ends when Runtime closes.
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How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The process value is read cyclically from the memory of the connected PLC 
(1) and monitored for change. The process value is logged when a change (2) occurs of the 
external tag.

The Runtime component of the logging system processes the process value.

The current process value is then written to the logging database (3).

Compressed log

Introduction   
To reduce the volume of data in the logging database, the logging tags for a specified period 
can be compressed. To do this, create a compressed log that will store each logged tag in a 
compressed log tag. The logging tags are retained, but they can also be copied, moved or 
deleted. The compressed log is stored in the log database in the same way as the data log.

How it works
This compression is achieved through the application of mathematical functions. To achieve 
this, one of the following functions is applied to the logged process values from a specified 
period:

● Maximum value: The highest process value is saved in the compressed log tag.

● Minimum value: The lowest process value is saved in the compressed log tag.

● Total: The total of all the process values is saved in the compressed log tag.

● Average value: The average process value is saved in the compressed log tag.

● Average weighted value: The average weighted process value is saved in the compressed 
log tag. The time period in which a tag value has not changed is included in the calculation. 
For tags which are acquired "on change", this function returns more meaningful results than 
the "Average value" function.

What happens to the old, logged process values after compression depends on which method 
of compression is used:
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● Calculate: The process values of the logging tags of the specified period are read out and 
compressed. The process values of the logging tags are retained.

● Calculate and copy: The process values of the logging tags of the specified period are read 
out, compressed and copied to the compressed log.

● Calculate and delete: The process values of the logging tags of the specified period are 
read out, compressed and then deleted.

● Calculate, copy and delete: The process values of the logging tags of the specified period 
are read out, compressed, copied to the compressed log and then deleted.

Example
The following example illustrates the way that the compressed log works:

A process value is archived once every minute and returns 60 values in one hour. The 
compression takes place over the course of one hour by averaging, for example. Accordingly, 
every hour, the average of the 60 values is calculated and is stored in the compressed log tag. 
What happens to the 60 values depends on the compression method described above.

See also
Creating a Compressed Log (Page 1147)

Creating a Compressed Log Tag (Page 1152)

Storing Process Values

Introduction       
Process values can be stored either in the log database on the hard disk or in the main memory 
of the Runtime logging system.

Storing in Archive Database
The process values to be logged are stored in two separate cyclic archives in the log database.

● Fast data log (A)

● Slow data log (B)

Each circular log consists of a configurable number of segments. You define a size in MB and 
a period (such as one day) for the segments.
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The process values are written continuously to the first segment (1). When the configured size 
of the segment is reached or the period is exceeded, the system switches to the next segment 
(2). When all the segments are full, the process data in the first segment is overwritten (3). In 
order that process data is not destroyed by the overwritten process, it can be swapped 
(exported).

The "Fast data log" stores the process values whose acquisition cycle is less than or equal to 
one minute. These process values are initially saved and compressed in a binary file. When 
the binary file has reached a specific size, it is stored in the cyclic archive. 

The "Slow data log" stores the process values whose acquisition cycle is longer than one 
minute. The "Slow data log" also stores the compressed logs. The data is written immediately 
to the circular log and is not compressed.

 

 Note

When starting Runtime, the system tests whether the configured size of a data buffer has 
been calculated to a sufficient size. If the configured size is too small, the system automatically 
adapts to the minimum size. 

 

Saving in Main Memory
In contrast to storage in the log database, process values archived in the main memory are 
only available while Runtime is active. Storing in the main memory has the advantage, 
however, that the values can be written and read very quickly. The process values stored in 
the main memory cannot be swapped out.

 

 Note

Compressed logs cannot be saved in the main memory. 
 

Optimized configuration
Use the available log types and the different storage methods to match logging to the dynamics 
of the changing process values.

Select the logging type depending on the frequency of the value changes of a tag and the 
necessity for logging.
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Combing the logging type with the selection of the matching circular log. Use shorter logging 
types, for example, only for tags whose values change quickly.

Swapping Out Process Values

Introduction      
You can swap out process values from the log database as a backup. All process values 
contained in a log segment are swapped out. A log segment is always swapped out when it is 
full and a new segment is started. A log segment is also swapped out when the time set for a 
segment change is reached and a new segment is started. 

Principle
You configure the swapping out of process values in the log settings. In the settings, you 
configure the size of the log and the log segmentsn as well as the time for the segment change. 
You should also state whether a backup is made in the settings.
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In the lines of the backup configuration you define where the backup is created and whether 
the backup file is signed. 

 

 Note

You can change a displayed process value in Runtime using the table view.

If the process value has already been swapped out of the data log, the modified value will 
not be transferred to the swapped-out log. The change only occurs in the local log segment.

If the log segment has not yet been swapped, the changed value is accepted permanently.
 

 

See also
Logging Settings (Page 1154)

Significance of Archive Value Flags
The data logging sets flags for every value that is written to the log. The flags indicate the state 
of the tags.

The flags are represented by a 2-word value. This value is decimal-coded and is shown in the 
third column of the database log. The flags must be converted to hexadecimal format for 
analysis purposes.

Structure of the 2-word value:

The High word contains the WinCC status flags or the quality code. The Low word contains 
the status flags for the data logging and an identifier for the content of the High word.

Code for High Word Content:

 Meaning
0x0 High word contains WinCC status flags
0x1 High word contains quality code
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Tag logging status flags:

Name of flag Value Meaning
PDE_RT_DAYLIGHT 0x001 Summer time
PDE_RT_SUBSTITUTION 0x002 Substitute value
PDE_RT_TIME_BEVOR_JUMP 0x004 Value prior to time jump
PDE_RT_TIME_BEHIND_JUMP 0x008 Value after time jump
PDE_RT_TIME_OVERLAPPED 0x010 Values during time overlap
PDE_RT_LOAD_SYSTEM 0x020 Value that is initially archived when the log is 

created
PDE_RT_RELOAD_SYSTEM 0x040 Initial value after archiving of RT
PDE_RT_CMPCOPY 0x080 Compressed value
PDE_RT_TIME_CHANGED 0x100 Time change took place
PDE_RT_HAND 0x200 Manual tag supply

Examples

Value in database 16842753
Hexadecimal 
representation

0101 0001

Coding for high word 0: High word contains WinCC status flag
Data logging status flag 001: Summer time
WinCC status flag 0101: Link to partner not established; tag initialization value 

Value in database 266242
Hexadecimal representation 0004 1002
Coding for high word 1: High word contains quality code
Data logging status flag 002: Substitute value
Quality codes 0004: Configuration error, value not accepted
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Working with data logs

Creating a data log

Logging tags

Principle
For the configuration of logs, the system distinguishes between the following log types:

● The data log stores process values in logging tags. When you configure the data log, select 
the process tags that are to be logged and the storage location.

● The compressed log compresses logging tags from data logs. The compressed log can 
further compress other compressed logs. When you configure the compressed log, select 
a calculation method and the compression time period.

Data buffer
For a data log, define whether the data buffer should be created on the hard disk or in the main 
memory.

In contrast to storage in the log database, process values logged in the main memory are only 
available while Runtime is active. Storing in the main memory has the advantage, however, 
that the values can be written and read very quickly. The process values stored in the main 
memory cannot be swapped out.

 

 Note

Compressed logs can only be saved on the hard disk.
 

See also
Logging Settings (Page 1154)

Configuring logging tags (Page 1165)

Creating a data log

Introduction 
The configuration of a data log consists of the following steps:    

● Create a data log.

● Configure the data log, for example, by selecting the storage location.

● Select the tags for logging.
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Requirement
● A project is open.

● The Inspector window is open.

Procedure
To create a data log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and compressed logs opens.

2. Open the "Data logs" tab and double-click "Add" in the "Name" column of the "Data logs" 
editor.
A new data log is created.

3. In the Inspector window select "Properties > Properties > General".

4. Enter a unique name for the log in the "Name" field.

5. In the "Storage location" field, decide whether the process values should be saved in the 
main memory or in a database.

6. If you select "Memory" as the storage location, set the number of data records to be logged 
per logging tag in the "Number of data records" field.

7. In the "Status" area, use the "Locked" option to determine whether the logging process is 
locked at the start of Runtime.
If you want to start logging in Runtime, you will need to deactivate the option again.

8. If the status of the logging lock changes, you can be informed of this via a C function or 
configure subsequent steps. To do this, select an available C function under "Properties > 
Properties > Events" in the Inspector window. The C function is called in Runtime from the 
log server when the "Locked" status changes. You must first write the C function in the 
"Scripts" editor. See "Function for status check of the log lock (Page 1166)" for additional 
information. Only one C function can be run by the "Changed lock" event.

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

Result
The data log is created.
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The next steps are to configure the higher-level logging parameters.
See "Specifying log settings (Page 1154)" for additional information.

 

 Note

The log name can be up to 32 characters long.

Do not use the following characters: '\\','\'', '.', ',', ';', ':', '!', '?', '"', '´', '`', '^', '~', '-', '+', '=', '/', '*', 
'#', '%', '&', '§', '°', '(', ')', '[', ']','{', '}', '<', '>', '|', ' ', 'ä', 'ö', 'ü', 'Ä', 'Ö', 'Ü', 'ß'

Capitalization is ignored.

The characters _ @ # $ cannot be used as the first character of a name.

The following terms may not be used when assigning a name: "times", "userarchives", 
"project", "archives", "defaultarchives", "defaultvariables", "templates", "tabletemplateitems", 
"curvetemplateitems".   

The names of logs must be unique in a project. Log names must also be unique if different 
storage locations are selected for different logs. You must also assign different names for 
alarm logs and data logs.  

 

 

See also
Specifying log settings (Page 1154)

Function for status check of the log lock (Page 1166)

Creating a Compressed Log

Introduction 
The configuration of a compressed log consists of the following steps:    

● Create the new compressed log.

● Configure the compressed log, for example, by selecting the calculation method and the 
time period for the compression.

● Select the logging tags that you want to add to the compressed log.

Requirement
● A project is open.

● The Inspector window is open.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1147



Procedure
To create a compressed log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and compressed logs opens.

2. Open the "Compressed logs" tab and double-click "Add" in the "Name" column of the 
"Compressed logs" editor.
A new compressed log will be created.

3. In the Inspector window select "Properties > Properties > General".

4. Enter a unique name for the log in the "Name" field.

5. Select the processing method and compression period in the "Compression" area.
All times created in the "Cycles" editor that are >= 1 minute are available as the compression 
time period. If the compression cycle you want is unavailable, configure a new cycle time. 
Then select the new cycle as the compression time period.

6. Use the "Locked" option to determine whether the logging process is locked at the start of 
Runtime.
If you want to start logging in Runtime, you will need to deactivate the option again.

7. If the status of the logging lock changes, you can be informed of this via a C function or 
configure subsequent steps. To do this, select an available C function under "Properties > 
Properties > Events" in the Inspector window. The C function is called in Runtime from the 
log server when the "Locked" status changes. You must first write the C function in the 
"Scripts" editor. See "Function for status check of the log lock (Page 1166)" for additional 
information.

8. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Compressed log" editor. To view 
hidden columns, activate the column titles using the shortcut menu.

Result
The compressed log is created.

 

 Note

The log name can be up to 32 characters long.

Do not use the following characters: '\\','\'', '.', ',', ';', ':', '!', '?', '"', '´', '`', '^', '~', '-', '+', '=', '/', '*', 
'#', '%', '&', '§', '°', '(', ')', '[', ']','{', '}', '<', '>', '|', ' ', 'ä', 'ö', 'ü', 'Ä', 'Ö', 'Ü', 'ß'

Capitalization is ignored.

The characters _ @ # $ cannot be used as the first character of a name.

The following terms may not be used when assigning a name: "times", "userarchives", 
"project", "archives", "defaultarchives", "defaultvariables", "templates", "tabletemplateitems", 
"curvetemplateitems".

The names of logs must be unique in a project. You must also assign different names for 
compressed logs and data logs.  
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See also
Function for status check of the log lock (Page 1166)

Compressed log (Page 1139)

Creating a Logging Tag

Using Logging Tags

Principle
Logging tags are used to save the process values to be logged. Use process tags to specify 
which process data should be logged. The data type is automatically defined by the process 
tag selected. Use the trigger mode to configure whether a tag is to be logged in relation to the 
time or specific events.

In a compressed log, each compressed logging tag is stored in a separate compressed logging 
tag.

Basic procedure
For binary and analog logging tags, specify the trigger mode (cyclic, etc.) as well as the 
acquisition and logging cycles. Select the parameters to start or end logging according to the 
trigger mode. Specify the display limits and parameters for processing the process value 
according to the type of logging tag.

When configuring a compressed logging tag, select the processing method for forming the 
logging tags to be compressed, such as the mean value.

 

 Note

If you delete a logging tag, save the project and then create a new tag with the same name 
as the deleted tag; you can no longer access the previously saved values of the deleted tag 
for display or logging. Reason: The newly created logging tag is assigned a new ID. The ID 
of the deleted logging tag is no longer accessible.

 

Creating binary logging tag

Introduction   
To configure a binary logging tag, first create a logging tag and then connect it to a binary 
process tag. The data type of the logging tag will then be set automatically.

Then define the properties for the logging tag.
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Requirement
● A data log has been created.

● The binary tag for which you want to configure the logging must already exist.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.

Procedure
To create a binary logging tag, proceed as follows:

1. Select the data log in which you want to create the logging tag from the table in the "Data 
log" editor.

2. In the "Name" column of the "Logging tags" table, double-click "Add".
An logging tag is created.

3. Select "Properties > Properties > General" in the Inspector window and enter a unique 
name for the logging tag in the "Name" field.

4. In the "Process tags" field, select the binary tags to be linked to the logging tag.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. You will have to deactivate the option once again if you want to start the 
logging in Runtime.

5. To reuse the logged values for other purposes, you can also write the value of the logging 
tag to an internal tag. The update process is determined by the cycle settings for the logging 
tag. Select the required tag from the "Copy logged value to tag" field.

6. Select "Properties > Properties > Logging type" in the Inspector window and select the 
required log type.
See "Trigger mode (Page 1133)" for additional information.

7. Select "Properties > Properties > Processing method" in the Inspector window and select 
the required processing method.
You can find more detailed information on this in the section "Cycles and Events 
(Page 1134)".

8. If necessary, enter a descriptive text under "Comment" to document your project.

You can configure the properties of a logging tag directly in the "Data log" editor. To view 
hidden columns, activate the column titles using the shortcut menu.

You can also configure logging tags in the tag table in the "Logging tags" tab.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

See also
Trigger mode (Page 1133)

Cycles and Events (Page 1134)
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Creating an analog logging tag

Introduction
To configure an analog logging tag, first create a logging tag and then connect it to an analog 
process tag. The data type of the logging tag will then be set automatically.

Then define the properties for the logging tag.   

Requirement
● The data log has been created.

● The analog tag for which you wish to configure the logging must already exist.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.

Procedure
To create an analog logging tag, proceed as follows:

1. Select the data log in which you want to create the logging tag from the table in the "Data 
log" editor.

2. In the "Name" column of the "Logging tags" table, double-click "Add".
An logging tag is created.

3. Select "Properties > Properties > General" in the Inspector window and enter a unique 
name for the logging tag in the "Name" field.

4. In the "Process tags" field, select the analog tags to be linked to the logging tag.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. You will have to deactivate the option once again if you want to start the 
logging in Runtime.

5. To reuse the logged values for other purposes, you can also write the value of the logging 
tag to an internal tag. The update process is determined by the cycle settings for the logging 
tag. Select the required tag from the "Copy logged value to tag" field.

6. Select "Properties > Properties > Logging type" in the Inspector window and select the 
required log type.
See "Trigger mode (Page 1133)" for additional information.

7. Select "Properties > Properties > Deadband for logging" in the Inspector window and enter 
the required limits. Open the selection box and select the "Constant" entry to enable the 
input. Then enter the required limit value. Process values outside the limits will not be 
logged.
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8. Select "Properties > Properties > Processing method" in the Inspector window and select 
the required processing method.
For additional information see "Cycles and Events (Page 1134)".
You can specify a C function for converting tag values if you use the "Calculation" 
processing method. You must first write the C function in the "Scripts" editor. For additional 
information see "Converting values from logging tags (Page 1167)".

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

See also
Trigger mode (Page 1133)

Cycles and Events (Page 1134)

Converting values from logging tags (Page 1167)

Creating a Compressed Log Tag

Introduction
You can save the process values of a logging tag or a compressed tag from another 
compressed log in compressed form in a compressed logging tag. Select the mathematical 
function with which you want to compress the process values it contains.

The following compression functions are available:

● Sum

● Mean value

● Maximum

● Minimum

You create a compressed logging tag in the "Compressed log" editor.

Requirement
● You have created a compressed variable.

● You have created the logging tag you want to configure.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.
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Procedure
To create a compressed logging tag, proceed as follows:

1. Click the "Compressed logs" tab in the "Historical Data" editor.
The "Compressed logs" editor opens.

2. Select the compressed log in which you want to create the compressed logging tag from 
the table in the "Compressed log" editor.

3. Click on the vertical "Logging tag" tab on the right side of the window. The "Logging tags" 
task card opens. The task card shows all objects you can add to the selected compressed 
log.

4. In the task card, select the objects you want to add to the compressed log. You can select 
the following objects:

– Single or multiple logging tags

– A complete data log

– One or several compressed logging tags

– A complete compressed log

5. Open the shortcut menu of the selected object and select the menu command "Add." A 
compressed logging tag is created for each object selected and linked to the respective 
object. If you select a complete data log or a complete compressed log, a compressed 
logging tag is created for each tag contained in this log.
Alternatively, you can drag-and-drop the selected object into the compressed log selected 
in step 2.

6. Select one or several compressed logging tags in the table of compressed logging tags. 
Specify more properties for the selected tag in the Inspector window.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. If you want to start logging in Runtime, you will need to disable the option 
again.
Select the processing method for the compression in the "Compression" field.

7. If necessary, enter a descriptive text under "Comment" to document your project.
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You can configure the properties of a compressed logging tag directly in the "Compressed log" 
editor. To view hidden columns, select these from the shortcut menu for the column titles.

Result
The compressed logging tags are connected to the selected logging tags. The values from the 
logging tag are compressed using the set parameters in Runtime.

If you have selected the compressed logging tags from another compressed log, they will be 
compressed even further.

See also
Compressed log (Page 1139)

Specifying log settings

Logging Settings

Introduction
You configure the logical organization of data logs and compressed logs in the "Historical Data" 
editor. You can configure the basic properties of logs in Runtime Professional, such as the 
segment size, in the "Runtime settings > Logging" dialog.

You make the settings for data logs separately in the dialog for the "Fast data log" and "Slow 
data log" types.

The following conditions apply if you are using the default settings:

The Fast data log is used to store all values with a logging cycle <= 1 minute.

The Slow data log is used to store all values with a logging cycle > 1 minute.

You can change the cycle limit for allocation to the log type in the "Cycle" field in the "Runtime 
settings > Logging" dialog.

Overview of procedure
You configure the higher-level log configuration in the "Runtime settings > Logging" dialog. 
The following instructions contain a description of the configuration procedure:

Step Description
1 Defining the Log Size and Segmentation (Page 1155) 
2 Configuring the log backup (Page 1159) 
3 Assigning Logging Tags to the Log Types (Page 1161) 
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See also
Defining the Log Size and Segmentation (Page 1155)

Configuring the log backup (Page 1159)

Connecting the log backup (Page 1163)

Disconnecting a log backup (Page 1164)

Assigning Logging Tags to the Log Types (Page 1161)

Logging tags (Page 1145)

Swapping Out Process Values (Page 1142)

Defining the Log Size and Segmentation

Introduction
In the "Runtime settings > Logging" dialog, you define the sizes of the "Fast data log" and 
"Slow data log" types in the database. You can also subdivide the two types of log into 
segments. The size of the individual segments thus also defines the number of individual 
segments.       

The individual segments are filled one after the other in Runtime. Once a segment is totally 
full, it switches to the next segment. You can also configure the segment change at specific 
times. If you define a time for the segment change, the next log segment is filled when the time 
is reached.

 

 Note

Ensure that the log size does not exceed the free memory space available. The system does 
not validate the selected settings. A high number of linked log segments can lead to longer 
waiting periods in the system when starting and ending Runtime.

 

Requirement
A project is open.
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Procedure
To edit the higher-level log settings, proceed as follows:

1. In the project tree, open the folder containing Runtime Professional and double-click the 
"Runtime Settings" entry.
The Runtime settings dialog opens.

2. Click the "Logging" entry in the dialog.
The "Logging" dialog opens.
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3. Enter the required values in the "Time period of all segments" and "Maximum size of all 
segments" fields.

– When you enter the time period across all the segments and the maximum size, you 
also define the size of the logging database. If either of these criteria is violated, a new 
segment is started. When all the segments are filled, the oldest segment is overwritten.

4. Enter the required values in the "Time period contained in a single segment" and "Maximum 
size of a segment" fields.

– When you enter the time period for the single segments and the maximum size, you 
also define the size and number of single segments. If either of these criteria is violated, 
a new individual segment is started. When the criterion for "Time period of all segments" 
is exceeded, the oldest individual segment is also deleted.

5. Enter the start date and start time for the first segment change in the "Time of first segment 
change" field.

6. Continue the configuration from step 2 of the procedural overview and configure the log 
backup. See the "Configuring the log backup" section for additional details.

 

  Note

If you change the log size or the time period in Runtime, the change will not take effect 
until the next segment change.

 

Example
The input was configured:

Property Value
Time period of all segments 1 week
Maximum size of all segments 700 MB
Time period contained in one single segment 1 day
Maximum size of a segment 100 MB
Time of first segment change Friday, 23 November 2010 18:30

With the configuration shown in the table, the started segment will be changed for the first time 
at 18.30 on 23 November 2010. The next time-controlled segment change will take place 
cyclically, after periods of 1 day since the configured time. The segment will also change if the 
configured size of 100 MB is exceeded in the course of one day. The oldest single segment 
will be deleted if the maximum log size of 700 MB is exceeded.

Changing the log type
If the user does not change the relevant settings, the logging tags will be logged with a cycle 
time of <= 1 min in the "Fast data log". Logging tags with a cycle time > 1 min will be logged 
in the"Slow data log". The cycle time of a logging tag must not be changed in Runtime beyond 
the above limits. It is not possible to change of a logging tag from "Fast" to "Slow" log type and 
vice-versa in Runtime.
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After a cycle change or reconfiguration, if tags are to be stored in a different log type, these 
tags will be read from the currently valid log. Previous log values of this tag are not accessible 
in Runtime.

If you reconfigure the logging tags so that their values are stored in a log other than the previous 
log type, more memory will be required in the log concerned. You should therefore adjust the 
log size after making major changes.

 

 NOTICE

Runtime data in the logs will be deleted if you reset the log configuration for data logging. 
Only previously swapped-out databases remain intact.

 

Resetting the log database
Use the "Extended loading" dialog to reset the log database settings. Select the HMI device 
in the project tree for this purpose and use the menu command "Online > Extended download 
to device". Select the interface for your HMI device. Click on "Download". The "Load preview" 
dialog opens. Make the settings for the reset in the "Load preview" dialog.

The reset will be executed when you start the download process.
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Configuring the log backup

Introduction  
Make regular backups of your log data to ensure complete documentation of your process.

 

 Note

The backup normally starts 15 minutes after the first time-related segment change. If the start 
of backup and start of segment should be synchronous with the start of Runtime, define the 
start time for the segment change prior to the start of Runtime.

You can change a displayed process value in Runtime using the table view. If the location of 
the log segment where the process value is stored has already been changed, then the 
modified value is not accepted in the shifted log. The change only occurs in the local log 
segment.

If the log segment has not yet been swapped, the changed value is accepted permanently.
 

Requirement
● Step 1 of the procedural overview is complete - Defining the Log Size and Segmentation 

(Page 1155)

● The "Runtime settings > Logging" dialog is open.

Procedure
Proceed as follows to create a log backup:

1. Activate the "Backup" option in the column containing the type of log for which you want to 
configure the backup, such as the "Fast data log" column.

2. In the same column, in the "Path" field, enter the storage location for the backup or browse 
to find the required storage location in the dialog. A network drive is also possible as the 
storage location.

3. If you want to create a redundant backup, select the "Backup to both paths" option.

4. In the "Alternative path" field, enter an alternative storage location for the backup or browse 
to find the required storage location in the dialog. A network drive is also possible as the 
storage location. The alternative storage location is used in the following situations:

– If the storage space on a backup medium is full.

– If the original storage location is unavailable due to a network failure, for example.

After the corresponding system alarms have been configured, the alarms are output, if the 
specified storage location is not available.
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5. If the log backup file should be signed, select the "Enable signing" option. On reconnecting 
to WinCC, the signature will allow the system to detect whether any changes were made 
to a log backup file after it was swapped out.

6. Continue the configuration from step 3 of the procedural overview and assign the logging 
tags to the log types. See the "Assigning Logging Tags to the Log Types (Page 1161)" 
section for additional details.

Structure of the Log Backup File
A log backup consists of two files with the extensions "*.LDF" and "*.MDF". To transfer a log 
backup to another computer, for example, copy the corresponding LDF and MDF files. The 
file name is in the following form: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type is 
defined by the log type:

● TLG_F: Data log with a logging cycle of less than one minute.

● TLG_S: Data log with a logging cycle of more than one minute.

The time period is specified in the following format: yyyymmddhhmm, e.g. 201012021118 for 
December 2, 2010, 11:18. Underscores "_" in the project name are displayed as "#".

Example:

FLEX-LOG2_WINCC#10#11#29#14#37#40_TLG_F_201011291414_201012030502.ldf

FLEX-LOG2_WINCC#10#11#29#14#37#40_TLG_F_201011291414_201012030502.mdf

Signing of the log backup files
If signing and backup are enabled, each log backup file is signed when it is swapped out. When 
the file is connected to WinCC once more, the signature is used to determine whether the file 
was changed after being swapped out.

If you use log signing, the maximum size of a single segment must not exceed 200 MB.

To verify the data, the "Signing enabled" option must be checked. Connecting "Slow" logs will 
take longer due to the signing.

The following values apply to the logging of signed data:

Logging signed data in Runtime Value/seconds
Fast data log 1.000
Slow data log 500 1)

1) With "Slow" type data logs, expect longer screen selection times for a given amount of data 
as those for "Fast" type data logs.

 

 Note

If you disable signing off to establish a fast connection to the backup files, for example, you 
should avoid segment changes while it is disabled. After the connection has been established, 
signing off should be reactivated in order to enable signing off for logged data.
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Activating and deactivating signing
You activate and deactivate signing in the Runtime settings of the HMI device. 

Activate or deactivate signing. If Runtime is running on the engineering station, recompile the 
project. The change becomes effective after compilation. If Runtime is running on a different 
PC than WinCC ES, you accept the change with online delta transfer. See Overview of online 
delta transfers (Page 2217) for additional information.

See also
Defining the Log Size and Segmentation (Page 1155)

Assigning Logging Tags to the Log Types (Page 1161)

Overview of online delta transfers (Page 2217)

Connecting the log backup (Page 1163)

Disconnecting a log backup (Page 1164)

Assigning Logging Tags to the Log Types

Introduction    
Data logging uses two different types of log to store data:

● Fast data log

● Slow data log

The logging tags are automatically allocated to the correct type of log. You can change this 
allocation in the log settings.

In Runtime, a changed assignment will only be accepted when the project has been 
deactivated and Runtime is restarted.

Requirement
● Step 2 of the procedural overview is complete - Configuring the log backup (Page 1159)

● The "Runtime settings > Logging" dialog is open.
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Procedure
To allocate the logging tags to the log types, follow these steps:

1. If you want to log acquired values to the fast data log on demand, activate the "Measured 
values with acquisition mode "On demand"" option in the "Fast data log" column.

2. Activate the "Cyclically measured values with cycles less or equal" option if you want to log 
logging tags to the fast data log with the "cyclic" trigger mode.

3. Select a cycle time as the upper limit of the logging cycle in the "Cycle" field. If necessary, 
select a factor for multiplying the selected cycle time in the "Factor" field.

4. Enable the "Compressed values with shorter or equal cycle" option if you want to log all 
compressed values with a logging cycle that is less than or equal to the limit allocated to 
the Fast data log.

5. Select a cycle time as the upper limit of the logging cycle in the "Cycle" field. If necessary, 
select a factor for multiplying the selected cycle time in the "Factor" field.

6. Save the project.

Result
All logging tags to which these settings apply are logged in the Fast data log. All logging tags 
to which these settings do not apply are logged in the Slow data log.
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Connecting the log backup

Introduction     
In order to access data of a log backup in Runtime, connect the log backup to the project again. 
You can establish a connection using a VB function or establish it directly. You can connect 
all backup segments that were created with each project. A requirement is that you did not 
change the log or the logging tags.

Requirement
● The corresponding LDF and MDF files for the log backup are located in a local folder on 

the configuration computer, such as the hard disk, MOD or CD.

Procedure
Proceed as follows to connect a log backup using a VB function:

1. Configure a button in a process screen and label the button "Connect log backup", for 
example.

2. Write a VB function using the "Restore" method based on this example:
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:
\Backup","","2010-11-14",-1) & vbNewLine
See "Auto-Hotspot" for additional details.

3. Configure a list of functions for the "Click" event for the configured button.

4. Select the VB function thus created from the list of functions.

5. Save the project.

Result
The VB function is executed in Runtime when the button is clicked. The log backup is connected 
using the parameters defined in the function.

The logged process values from the log backup are sorted in time-stamp order in the configured 
display.

Connecting "Tag Logging Slow" logs takes longer if signing is enabled.

Automatic linking to a log
1. Insert the log backup files into the "CommonArchiving" folder.

The "CommonArchiving" folder is located in the project folder of your WinCC project.

2. In Runtime, the data log is automatically connected to the project.

If signing is enabled, signed log backup files that are changed will not be connected 
automatically. A WinCC system message is generated and an entry is added to the Windows 
event log in the "Application" section.
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See also
Configuring the log backup (Page 1159)

Disconnecting a log backup (Page 1164)

Disconnecting a log backup

Introduction
If you have connected a log backup in Runtime, you can also disconnect the connection once 
more. You can disconnect using a VB function or manually remove the backup log files from 
the "CommonArchiving" folder.    

Requirement
● The corresponding LDF file and MDF file of the log backup are located in the 

"CommonArchiving" folder in the project folder of the WinCC project.

Procedure
Proceed as follows to disconnect a log backup using a VB function:

1. Configure a button in a process screen and label the button "Disconnect log backup", for 
example.

2. Write a VB function using the "Remove" VBS method based on this example:
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("","2010-11-14",-1) & 
vbNewLine
See "Auto-Hotspot" for additional details.

3. Configure a list of functions for the "Click" event for the configured button.

4. Select the VB function thus created from the list of functions.

5. Save the project.

Result
The VB function is executed in Runtime when the button is clicked. The log backup is 
disconnected from the log database. You will no longer have access to the data from the 
backup file in Runtime.

Alternatively, you can manually remove the backup files from the "CommonArchiving" folder. 
The "CommonArchiving" folder is found in the project folder of your WinCC project.

See also
Configuring the log backup (Page 1159)

Connecting the log backup (Page 1163)
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Logging tags in the "Tags" editor

Configuring logging tags

Introduction
You can also create and edit logging tags in the "HMI tags" editor in WinCC. You also directly 
edit the properties of logging tags in the "Tags" editor.

 

 Note

If you delete, move or copy in the "HMI tags" editor, the changes also take effect in the "Logs" 
editor.

 

Requirement
● The "Logging tags" tab is open in the "HMI tags" editor.

● You have created a tag.

Procedure
Proceed as follows to configure a logging tag in the "HMI tags" editor:  

1. Select an existing tag in the tag table.
Alternatively, double-click "Add" in the "Name" column to create a new tag.

2. Click on "Logging tags" in the lower editor. The editor for logging tags is brought to the 
foreground.
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3. Double-click "Add ..." in the "Name" column of the editor "Logging tag" table. A new logging 
tag is created. The logging tag is linked to the tag selected in the first step. The data type 
of the logging tag is taken automatically from the linked tag.

4. Select the desired logging tag from the "Data log" field. You can also create a new log using 
the object list.

5. Configure additional parameters for logging in the table of the editor or in the Inspector 
window.

Result
The configured logging tag is created in the "Tags" editor and is displayed in various editors.

See also
Logging tags (Page 1145)

Functions for data logging

Function for status check of the log lock

Introduction
You can monitor the "Locked" state of a data log using a C function. You need to create the 
C function in the "Scripts" editor with the correct syntax.

Description
This function is called in Runtime from the log server when triggered by a "Locked" status 
change. You can assign this function to the event "Lock state change" in the "Events" group 
in the "Data logs" or "Compressed logs" editor. The C function is then only displayed under 
the "Lock changed" event when the syntax below is correctly written in the function.
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Syntax
void function name (BOOL fFlag);

Parameters
fFlag

TRUE - log is locked

FALSE - log is released

Example application
You can use this function to receive information about the lock status of a log, for example.

Converting values from logging tags

Description
You can use this C function to convert tag values before logging them. This C function is 
assigned in the "Logging tags" editor in the properties of the logging tag under "Properties > 
Processing method". The C function is then only offered for selection in the "Analog processing 
method" field when the syntax below is correctly written in the function.

Syntax
double function name (double dLastValue,

 double dCurrentValue,

 DWORD dwCount,

 BOOL fArchivingCycle);

Parameters
dLastValue: most recently acquired value (from the most recent acquisition cycle)

dCurrentValue: currently acquired value

dwCount: current acquisition cycle since the most recent log cycle (for example, log cycle is 
4 x 1 seconds of acquisition cycle; the count is then 1 to 4, until the count starts again).

fArchivingCycle: TRUE = cycle is log cycle (default); FALSE = cycle is acquisition cycle

Example application
You can use this function to implement your own mean value calculation. The calculated mean 
value is used instead of the current tag value.

The following function determines the geometric mean value of the acquired process values:
double CalculateGeometricMean (double dLastValue,double 
dCurrentValue,DWORD dwCount,BOOL fArchivingCycle)
{
 
static double dCurrentProduct = 1.0;
 
    double dReturnValue = 0.0;
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if (!fArchivingCycle)
 
{
 
// 1. continuously calculate the product of all values with every 
scan cycle
 
dCurrentProduct *= dCurrentValue;
 
printf ("current value=%f current product=%f archiving cycle flag=%d
\r\n",dCurrentValue,dCurrentProduct ,fArchivingCycle);
 
dReturnValue = dCurrentProduct ; // optinonally - the return value 
is actually not of interest in a scan cycle
 
}
 
else
 
{
 
// 2. if this is the archiving cycle, use the product of all scan 
values to calculate
 
// the geometric mean value 
 
dReturnValue = pow (dCurrentProduct ,(double) 1 / dwCount);
 
      printf ("archiving cycle: geometric mean value=%f\r
\n",dReturnValue);
 
         printf ("\r\n");
 
         dCurrentProduct = 1.0; // reset current product
 
// the finally calculated value will be returned - this value will 
be archived
 
// since this is the archiving cycle
 
}
 
return dReturnValue;
 
}
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9.2.9 Displaying Tags

9.2.9.1 Displaying tags with Basic Panels

Outputting tag values in screens (Basic)

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. A trend is a graphic representation of the values that a tag takes during runtime. Use 
the "Trend display" graphic object to represent it. Process values for the trend display are 
loaded by the PLC from the ongoing process.     

The values to be displayed are determined individually within a fixed, configurable cycle. 
Cyclically-triggered trends are suitable for representing continuous curves, such as the 
changes in the operating temperature of a motor.

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.

You can control the updating of the trend display by defining the cycle time.

See also
Configuring trend display for values from the PLC (Basic) (Page 1169)

Basics of tags (Page 975)

Configuring trend display for values from the PLC (Basic)

Introduction
You use a trend view to graphically represent values that a tag assumes during the 
process.     

Requirement
● A screen is open.

● The Inspector window with the trend view properties is open.
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Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Control" group to the screen.

2. Select the "Trend" category from the "Properties" group in the Inspector window and double-
click "<Add>" in the "Name" column.

3. Assign a name to the trend in the "Name" column.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.

6. In the "Settings" column, use the selection button to open the "Data source" dialog and 
select the tags to supply the trend with values.
Specify the cycle for reading the tags from the PLC.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You set the column width and the position of the columns in the table header 
of the values table in active mode. In order to activate the trend view the zoom factor has 
to be set to 100 %.
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Result
In runtime, the values of the selected tags are displayed in the configured trend view. 

See also
Outputting tag values in screens (Basic) (Page 1169)

9.2.9.2 Displaying tags with Runtime Advanced and Panels

Trends

Introduction
A trend is a graphic representation of the values that a tag takes during runtime. In order to 
display trends, configure a trend view in a screen of your project.

To configure the trend view, specify a trend type for the values to be displayed.

● Log: For displaying the logged values of a tag

● Cyclical real time: For time-triggered display of values

● Bit-triggered real time: For event-triggered display of values

● Bit-triggered buffer: For event-triggered display with buffered data acquisition

Displaying logged values
In Runtime, the trend view displays the values of a tag from a data log. The trend shows the 
logged values in a particular window in time. The operator can move the time window in 
Runtime to view the desired information from the log.
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Pulse-triggered trends
The values to be displayed are determined individually with a definable time pattern. Cyclically-
triggered trends are suitable for representing continuous curves, such as the changes in the 
operating temperature of a motor.

Bit-triggered trends
The values to be displayed are event-driven by setting a defined bit in "Trend transfer" tags. 
The bit is reset after reading has been completed. Bit-triggered trends are useful for displaying 
fast-changing values, such as the injection pressure for producing plastic parts.

Bit-triggered trends with buffered data acquisition
When you set buffered data acquisition, the values to be displayed are buffered in the PLC 
and read in bit-triggered as a block. These trends are suitable for displaying rapid changes 
when the course of the trend as a whole is interesting and not so much the individual values.

You configure a switch buffer in the PLC so it can continue to write the new values while the 
trend buffer is being read. The switch buffer ensures that the PLC does not overwrite values 
while the operator devices reads the values for the trend.

The switch between the trend buffer and the switch buffer functions as follows:

Whenever the bit assigned to the trend is set in the "Trend transfer 1" tag, all the values are 
read simultaneously from the trend buffer and are displayed as a trend on the HMI device. The 
bit in "Trend Transfer 1" is reset after reading has been completed.

While the operator device is reading the tag values from the trend buffer, the PLC writes the 
new tag values into the switch buffer. When the bit which is assigned to the trend is set in the 
"Trend transfer 2" tag , all the trend values are read from the switch buffer and displayed at 
the operator device. While the operating device is reading the switch buffer, the PLC writes 
again to the trend buffer. 
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The structure of a *.CSV file with tags

Introduction
In the *.csv (comma-separated value) file format, the "Name" and "Value" table columns of the 
entry are separated by semicolons. Each table row ends with a line break.  

Example of a *.CSV file
The example shows a file with logged tag values:  

"VarName";"TimeString";"VarValue";"Validity";"Time_ms"

"Var_107";"01.04.98 11:02:52";66,00;1;35886460322,81

"Var_108";"01.04.98 11:02:55 AM";60.00;1;35886460358.73

"Var_109";"01.04.98 11:02:57 AM";59.00;1;35886460381.22
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Structure of a log file in *.csv format
The following values are entered in the individual columns of a log file:

Parameters Description
VarName Name of the tag from WinCC
Time string Time stamp as a STRING, e.g. readable data format
VarValue Value of the tag
Validity Validity: 

1 = value is valid
0 = an error occurred (e.g. interrupted connection)

Time_ms Specify a time stamp as a decimal value (see below for conversion).
Only needed to display the tag values in a trend.

Conversion of the time stamp decimal value
If the value needs to be processed using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: : 36343476928:1 000 000 = 36343,476928

2. The whole number portion (36344) is the date calculated from 31.12.1899.
Example: 36343 results in 02.07.1999
You can now convert the time stamp value to days in Excel by assigning a corresponding 
format from the "Date" group to the cells, which contain the time stamp.
Result: 37986 results in 31.12.2003

3. The value after the comma (0,476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46.579
This conversion is supported by Microsoft Excel, for example.

Direct access to the ODBC log database

Introduction
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
you want to use in WinCC from the Windows Start menu under "Settings > Control panel > 
ODBC Data Sources".

To store log data, specify the DSN, rather than a directory name during configuration. With the 
DSN, you are referencing the database and the storage location.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1174 System Manual, 08/2011,  



Application
The entire functional scope of the database is available for additional processing and 
evaluation of log data.

Principle
The data source establishes the connection to the database. You create the data source on 
the same computer that contains the Runtime software. Then enter the DSN configured here 
when you create a log in WinCC.

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

With the "StartProgram" system function, you can also configure a program call (to MS Access, 
for example) on the HMI device. This does not interrupt Runtime.

Outputting tag values in screens

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. The process values are loaded by the PLC from the current process or from a log 
database.   

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.

The following options are available:

● Current values from the PLC
Writing of the trend is continued with individual values from the PLC. The following trigger 
types are available for display in real time:

– Bit-triggered real time: The time of the update can be controlled by setting a bit. Bit-
triggered trends are normally used to visualize rapidly changing values. One example 
might be the injection pressure in the production of plastic parts.

– Cyclical real time: You control the update time with a cycle. Cyclically-triggered trends 
are suitable for representing continuous curves, such as the changes in the operating 
temperature of a motor.

– Bit-triggered buffer: The trend contains values that were stored in a buffer in the period 
between two reads from the PLC. Use this format pattern if the course of the trend as 
a whole is more interesting than the individual values.

● Logged tag values
In Runtime, the trend view displays the values of a tag from a data log. The following trigger 
type is available to display logged tag values:

– Data log: The trend shows the logged values in a particular window in time. The operator 
can move the time window in Runtime to view the desired information from the log.
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Configuring trend displays for values from the PLC

Introduction
You use a trend view to graphically represent values that a tag assumes during the process.   

Requirement
● A screen is open.

Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.

6. In the "Trend type" column, select the required trend type. The following entries are 
available:

– "Bit-triggered real time"

– "Cyclical real time"

– "Bit-triggered buffer"

– "Data log"
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7. In the "Settings source" column, use the selection button to open the "Data source" dialog 
and select the tags to supply the trend with values.
If you selected the "Cyclical real time" trend type, specify a cycle for reading the tags from 
the PLC.
Only for bit-triggered trends:

– Under "Bit", specify which bit of the "Trend request" tag and of the "Trend transfer" tags 
are to be assigned to the trend. Select a different value for each trend.

– Enter a tag under "Trend request" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies which trend 
is currently being displayed at the operator device.

Only for the trend type "Bit-triggered real time":

– Enter a tag under "Trend transfer" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies for which 
trend values are to be read from the PLC.

Only for the trend type "Bit-triggered buffer":

– Enter a buffer tag for the switch buffer. The tags have to be of the same type and of the 
same length as the trend tag.

– Enter a tag each under "Trend transfer 1" and "Trend transfer 2" which contains at least 
as many bits as trends are to be displayed in the trend view. The status of these tag bits 
specifies the trend for which values will be read from the PLC. "Trend transfer 1" controls 
reading from the trend buffer; "Trend transfer 2" controls reading from the switch buffer.

8. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

 Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is activated. 
You can set the column width and the position of the columns in active mode in the values 
table. In order to activate the trend view the zoom factor has to be set to 100 %.

 

Result
In runtime, the values of the selected tags are displayed in the configured trend view. 
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Configuring a trend view for a data log

Introduction
You can use a trend view to display logged tag values in Runtime. The trend view shows the 
logged tag values in a particular window in time. The operator can move the time window in 
Runtime to view the desired information from the log.   

Application example
At the end of a shift, for example, an operator wants information about the process carried out 
during the shift.

Requirement
● A data log has been created.

● A screen is open.

● The Inspector window with the trend view properties is open.

Procedure
To configure a trend view to display values from a data log, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. In the "Trend type" column, select the trend type "Data log".
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6. In the "Settings" column, use the selection button to open the "Data source" dialog; select 
the data log and the tags to supply the trend with values.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You can set the column width and the position of the columns in active mode 
in the values table. In order to activate the trend view the zoom factor has to be set to 100 
%.

 

Result
In runtime, the logged values of the selected tags are displayed in the configured trend view.

9.2.9.3 Displaying tags with Runtime Professional

Basics

Outputting the tag values

Overview
In Runtime you can output tag values as table or as trend. You can use either process values 
or logged values as source for the tag values.

Use a table, for example, for comparing tag values. In the table you can, for example, compare 
fill levels of supply tanks. 

Use a trend, for example, for graphically displaying tag values. Using a trend you can, for 
example, display the development of an engine temperature. 

Controls for displaying tag values
To display tag values in a table, use the table view. 

To display tag values as a trend, use the trend view. The trend view is available in two versions: 

● With the "f(t) trend view" you display a tag value against the time, e.g. a temperature trend.

● With the "f(x) trend view" you display a tag value against a second tag value, e.g. the engine 
speed against the heat produced.

In addition, the value table is a control with which you can create statistics from the displayed 
values. Furthermore, you can use the value table as reading assistance for the trend view. 
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Configuration
In the table and trend view, you configure the following properties:

● Data connection

● Display mode

● Evaluation of data

● Configuration in Runtime

● Persistence of changed properties in Runtime

See also
Table view (Page 1180)

Properties of the trend view (Page 1181)

f(t) trend view (Page 1182)

f(x) trend view (Page 1182)

Table view

Overview    
The table view in Runtime shows currently pending process values or logged values in a table. 
You can arrange the display of the table as you wish. 

In Runtime, you create statistics from selected data. You also export the data for further use.

The following image shows a table view in which the fill levels of three supply tanks are shown:
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See also
Outputting the tag values (Page 1179)

Properties of the trend view

Number of trends
Both in the "f(x) trend view" and the "f(t) trend view" you can display an unlimited number of 
trends. For reasons of clarity, you should not, however, configure more than 8 trends at a time. 

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and configured size of the trend view. Therefore it is possible that fewer values are 
displayed in the trend view than actually exist in the period to be represented.

If, for example, in an area of 100 pixels 200 measured values are archived, each pixel 
represents 2 measured values. The value shown on the screen is that of the most recent data 
(most recent time stamp).

The figure below shows a trend characteristic where each pixel represents a value pair with 2 
measured values:

1
2

3

① Real measured values
② Determined trend
③ Pixels

 

See also
f(t) trend view (Page 1182)

f(x) trend view (Page 1182)

Outputting the tag values (Page 1179)
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f(t) trend view

Overview  
With the f(t) trend view you can display currently pending process values or archived values 
in Runtime as a trend against the time. You can create the trend display according to your 
wishes.

The following figure shows an f(t) trend view displaying two trends simultaneously: 

See also
Properties of the trend view (Page 1181)

Outputting the tag values (Page 1179)

f(x) trend view

Overview   
With the f(x) trend view you can display currently pending process values or archived values 
in Runtime as a trend against another tag. You can create the trend display according to your 
wishes.

The following figure shows an f(x) trend view displaying two trends simultaneously:
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Rules for the data source  
The following rules must be observed when displaying trends in the f(x) trend view:

● A trend can represent a maximum of 10000 value pairs

● The following sources are allowed to supply a trend with data:

– Online tags

– Logging tags

– Recipe elements

– User-defined: Data supply of value pairs using a script

● The value pairs are displayed in the f(x) trend view. For the value pairs to be displayed at 
the same time, update the online tags or logging tags of a trend at the same time in Runtime. 
Use the same update cycle for each tag, for example.

● The logging tags of a trend must have the same update cycle and must be recorded in a 
continuous cycle

See also
Properties of the trend view (Page 1181)

Outputting the tag values (Page 1179)
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Representation Trend Lines

Introduction  
In a trend view, you display a trend curve with one of the following display types:

● Dots

● Interpolated

● Stepped

Select "Properties > Properties > Trend > Style" to configure the properties of the trend display 
in the Inspector window.

Dots
Values are shown as dots. The display of the points can be configured as you wish.

The following image shows the trend curve with the display form "Dots":

Interpolated
The trend curve is interpolated on a linear basis from the values. The display of the lines and 
points can be configured as you wish.

The following image shows the trend curve with the display form "Interpolated":

Stepped
The trend curve is interpolated as a stepped curve from the values. The display of the lines 
and points can be configured as you wish.

The following image shows the trend curve with the display form "Stepped":
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Trend curve    
With the "Trend curve" option, you can specify where the current values for all trend windows 
are to be entered. Normally, the current values are written in the trend window from the right. 

You configure the "trend curve" in the Inspector window under "Properties > Properties > 
General > Display".  

See also
Creating trends for the trend window. (Page 1193)

Time range basics

Time range 
The time range is the range from which the values at the HMI device are shown. The time 
range is determined by the start time and the end time. The time range is always in the past. 
If the end time is later than the current system time, the current system time is used as a 
temporary end time. 

A distinction is made between the following time ranges:

● Static time range

● Dynamic time range

Static time range  
The static time range is determined by fixed start and end times. The values are displayed 
within this time range. 

Dynamic time range  
The dynamic time range is determined by a period of time beginning with a fixed start time. 
The end time thus corresponds to the conclusion of the time period.

You set the time period as follows:

● Duration, e.g. 30 minutes

● The number of measurement points multiplied by the update cycle also produces a duration.
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Configuring time range
Configure the time range for all controls. Configure the time range in the time column or in the 
time axis for the table view and the f(t) trend view. Configure the time range directly at the trend 
for the f(x) table view.

See also
Configuring the time axes of the the trend view (Page 1190)

Displaying logged values (Page 1232)

Representation Using Common Axes

Introduction
If you display several trends simultaneously in the trend view, assign each trend its own value 
and time axis. Alternatively, you can assign a shared time and/or value axis to several trends. 

You configure the axes of a trend view in the Inspector window under "Properties > Properties 
> Time axis / Value axis". 

The axes are assigned to the configured trends in the Inspector window under "Properties > 
Properties > Trends". 

Representation Using Different Axes   
If the values to be displayed in a trend view differ greatly, a common value axis makes no 
sense. If you assign each trend its own value axis, they should also display different scales. 
Individual axes can be hidden if required.

The following figure shows two trends with different value axes using an f(t) trend display as 
example: 
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Representation Using Common Axes   
If the comparability of the trend lines is important, common axes in a trend view is sensible. 
Connected trend views can have a common time axis.

If you configure trends with a shared time axis, use tags with the same update cycle for the 
data supply. 

In the case of different updating cycles, the length of the time axis is not identical for all tags. 
Since the trends are updated at different times due to the different updating cycles, a minimal 
different in the end time for the time axis occurs on each change. As a result, the trends 
displayed skip slightly to and fro on each change. 
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Making buttons in the toolbar dynamic

Introduction   
If you do not wish to operate the control via the toolbar, configure any operator control such 
as a script on an event. Each button of a control has an unambiguous ID, which you assign to 
the property "ToolbarButtonClick". This allows the buttons in the control to be triggered. 

If you wish to determine which button in a control has been pressed, configure a VB script or 
C script on the event "Clicking toolbar button". The ID of the button is passed on to the script 
as the parameter "toolbarbuttonID". Using this "ID" you can determine which button the 
operator has clicked. 

Example: Open the configuration dialog for the control
In order to open the "Control1" configuration dialog of the control, dynamics are possible as 
follows:

● VBScript:

– Call in a script of an operator control event, e.g. a button:
ScreenItems("Control1").ToolbarButtonClick = 2

– As an alternative to the property "ToolbarButtonClick", there are also methods in VBS 
for operating the toolbar:
Dim obj
Set obj = ScreenItems("Control1")
obj.ShowPropertyDialog

● C script:

– SetPropertyByConstant (lpszPictureName, "Control1", 
"ToolbarButtonClick", 2);

See also
Using the trend and table view in Runtime (Page 1217)

Output of tag values in the form of a trend

Configure trend view

Introduction
To display tag values graphically in Runtime, add a trend view to a screen. In the "Tools" task 
card, two trend views are contained under "Controls":

● f(x) trend view

● f(t) trend view

The axis designations are different for the two trend views:
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● The f(x) trend view has an "X axis" and a "Y axis"

● The f(t) trend view has a "time axis" and a "value axis"

Requirement
● The screen is opened

● The Inspector window is open

Procedure  
To configure a trend view, follow these steps:

1. Add the required trend view to the screen from the "Tools" task card.

2. Configure the appearance of the trend view in the Inspector window:

– Configure the basic properties of the trend view, e.g. "Time base" or "Trend 
characteristic", under "Properties > Properties > General".

– Configure the appearance of the trend view under "Properties > Properties > 
Appearance".

– Configure the properties of the trend view in Runtime under "Properties > Properties > 
Window".

3. Configure additional diagrams, if required.

4. Configure the axes of the trend view in the Inspector window.

– Configure the properties of the axes.

– Assign each axis to a diagram of the trend view.

5. Enter the trends in the Inspector window that are shown in the trend view:

– Define the "data source" for each trend.

– Assign each trend the "diagram" in which it will be displayed.

– Assign the axes to each trend.

– Configure the view of each trend.

6. Configure the toolbar and status bar of the trend view.

7. If required, configure the data export from the trend view.

8. If required, configure the security settings of the trend view.

Result
The trend view is configured. Define an additional value display if you want to evaluate the 
data of the trend view in Runtime. You can also configure the value display as a "Ruler". 
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See also
Configuring the time axes of the the trend view (Page 1190)

Configuring the value axis of the the trend view (Page 1191)

Creating diagrams in the trend view (Page 1192)

Creating trends for the trend window. (Page 1193)

Defining the data source (Page 1194)

Configuring toolbar and status bar (Page 1195)

Configuring the export of Runtime data (Page 1197)

Determining the effect of the online configuration (Page 1197)

Online configuration of the f(t) trend view (Page 1220)

Configuring the time axes of the the trend view

Introduction
The time range for trend display is configured with time axes. In a trend view you can create 
several time axes, which you can assign to one or more diagrams.

If you assign several time axes to a trend view, the sequence of the time axes in the Inspector 
window corresponds to the sequence in the trend view. If several time axes are aligned to the 
same side of a trend display, the first time axis in the list takes the lower left position. The last 
time axis takes the upper right position.

The time axis is available only with the f(t) trend display. 

Requirement
● The trend view is selected in the screen

● The Inspector window is open

Procedure    
To configure the time axis of a trend view, follow these steps:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Time axis" to 
add a new time axis.

2. Enter the "Name" and "Display name" of the time axis.

3. Configure the "axis style".

4. Select the "diagram" to which the time axis will be assigned.

5. Configure the "time range" and "format" of the time display of the time axis.

6. To always update the trends assigned to the time axis in the trend view, activate "Online".
If you want to compare a current trend display with an earlier trend display, for example, 
supply the comparison trend from a logging tag.
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Result
The time axis is configured. Assign the time axis to one or several trends. 

See also
Time range basics (Page 1185)

Configuring the value axis of the the trend view

Introduction 
In a trend view you can create several value axes, which you can assign to one or more 
diagrams. 

The following properties are set by default with a value axis:

● The value range is based on the current values of the assigned trend

● The value axis scale is linear to the value range

Alternatively, you can configure a logarithmic scale:

● In logarithmic scaling, only positive values are displayed.

● In negative logarithmic scaling, only negative values are displayed.

If you configure a value axis for the f(t) trend view, you can also set up axis sections. A value 
range and a display name are assigned to an axis section. 

In the f(x) trend view, the value axis corresponds to both the "X axis" and the "Y axis". 

Requirement
● The trend view is selected in the screen

● The Inspector window is open

Procedure         
To configure the value axis of a trend view, follow these steps:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Value axis" to 
add a new value axis.

2. Enter the "Name" and "Display name" of the value axis.

3. Configure the "axis style".

4. Select the "diagram" to which the value axis will be assigned.

5. If required, configure the "value range" of the value axis.

6. If required, configure the "format" of the value axis labels.
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7. If required, configure the "scaling" of the value axis.

8. If you configure an f(t) trend view, you can define "axis sections" if necessary:

– Activate "User-defined axis sections".

– To add an axis section, double-click on "Add".

– Enter the "value range" of the axis section.

– Configure the "display range" of the axis section.

– Enter the "display name" of the axis section.

Result
The value axis is configured. Assign the value axis to one or several trends. 

Creating diagrams in the trend view

Introduction   
A trend view is assigned a display range as standard, in which you can configure one or more 
trends. 

Alternatively, you can subdivide the display range into several "diagrams". Each "diagram" 
functions like a standalone trend view. In this way, for example, temperature changes can be 
displayed clearly without overlapping trends. You can set the height of a diagram using "Range 
proportion". The "range proportion" establishes how much room is made available to a diagram 
in the trend view. 

Calculation of range proportion  
The amount of each range proportion can be calculated from the total number of range 
components. If, for example, you have configured a total of three diagrams, a range proportion 
of "1" each will result in three diagrams of equal size. To increase the size of range components 
in relation to each other, increase the range proportion of one or more diagrams. Changes to 
the range proportions immediately affect the trend view. 

Requirement
● Trend view is selected

● The Inspector window is open

Procedure
Proceed as follows to subdivide a trend view into several diagrams:

1. Double-click on "Add" under "Properties > Properties > Diagrams" in the Inspector window.
The diagram is added.

2. Enter a meaningful "Name" for the diagram.
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3. Select the "range proportion" for the diagram in the trend view.

4. Configure the diagram "grid".

5. Configure the diagram "ruler".

Result
The diagram has been created. You can assign one or more trends to each diagram. 

Creating trends for the trend window.

Introduction
A trend allows you to represent values in the trend view. You assign a time axis and value axis 
to each trend. The value axis assigned to the trend determines the trend view in which the 
trend will be displayed. 

By default, the data area is based on the current values of the assigned trend. 

You can also configure the visualization of limits and values with "uncertain status" for a trend. 
If a trend exceeds or falls below a configured limit, the trend is colored. 

If you assign several trends to a trend view, the sequence of the trends in the Inspector window 
corresponds to the sequence in the trend view. 

Requirement
● The trend view is selected in the screen

● Time axes and value axes are configured

● Tags for the data source are configured

● The Inspector window is open

Procedure   
To add a trend, follow these steps:

1. Double-click on "Add" under "Properties > Properties > Trends" in the Inspector window.

2. Enter a "label" for the trend.

3. If required, configure the "style" of the trend.
The changes are shown in a preview. 

4. Configure the data source.

5. If required, configure the "data area" of the trend.

6. Select the "diagram" in which the trend will be displayed.

7. Assign a "value axis" and "time axis" to the trend.

8. If required, configure the "limits" of the trend.
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Result
The trend is configured. 

See also
Representation Trend Lines (Page 1184)

Defining the data source (Page 1194)

Defining the data source

Introduction    
Using the data source, you define the sources from which the values are displayed on the HMI 
device in Runtime. The following sources are available:

● Current process values from tags

● Archived values from logging tags

● User-defined (only f(x) trend view)

● Recipe elements (only f(x) trend view)

Requirement
● An online tag or logging tag is configured

● Value column or trend has been created

● The Inspector window is open

Displaying current process values
Proceed as follows to display current process values:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

– Select the "update cycle".

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1194 System Manual, 08/2011,  



Displaying values from an archive
Proceed as follows to display values from an archive:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Logging tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

Displaying values from recipes
Output values from recipes in a f(x) trend view. 

Proceed as follows to display values from a recipe:

1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "Recipe" as "Source".

– Under "X values" and "Y values" select one recipe element each.

Result
The data supply is configured. 

See also
Basics of tags (Page 975)

Basic principles for data logging (Page 1107)

Configure trend view (Page 1188)

Creating trends for the trend window. (Page 1193)

Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 
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Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.

5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 

See also
Using the trend and table view in Runtime (Page 1217)

Configure trend view (Page 1188)

Elements of the status bar (Page 1233)
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Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 

The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open

Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configure trend view (Page 1188)

Determining the effect of the online configuration

Introduction        
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
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configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. The behavior on screen change can be configured. 

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. The behavior on screen change can be configured.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 

 

Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 

See also
Configure trend view (Page 1188)

Online configuration of the f(t) trend view (Page 1220)
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Output of tag values in tabular format

Configuring the Table View

Introduction
To display tag values in tables in Runtime, add a table view to a screen. A time stamp is 
displayed for each value. The values are displayed in value columns, and the time stamps in 
time columns. Assign the time column to one or several value columns. 

Procedure  
Proceed as follows to configure a table view:

1. Add the required table view to the screen from the "Tools" task card.

2. Configure the appearance of the table view in the Inspector window:

– Configure the basic properties of the table view, e.g. "Time base", under "Properties > 
Properties > General".

– Configure the appearance of the table view under "Properties > Properties > 
Appearance".

– Configure the properties of the table view in Runtime under "Properties > Properties > 
"Window".

3. Configure the columns of the table view in the Inspector window.

– Configure the properties of the columns.

– Configure one or more time columns with the time ranges for the table.

– Configure one or more value columns.

– Define the data connection for each value column.

– Assign time columns to the value columns.

4. Configure the appearance of each trend:

– Configure the "Headers", the "Structure" and the "Grid".

– If needed, configure the settings for "selecting" table entries.

– If needed, configure the settings for sorting table entries.

5. Configure the toolbar and status bar of the table view.

6. If required, configure the data export from the table view.

7. If required, configure the security settings of the table view.

Result
The table view is configured. Define an additional value table if you want to evaluate the data 
of the table view in Runtime. You can also configure the value table as "Ruler". 
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See also
Configuring the time columns of the table view (Page 1200)

Configuring the value columns of the table view (Page 1201)

Configuring the appearance of the table elements (Page 1202)

Configuration of the marking of selected cells and rows (Page 1203)

Configuring table column sorting (Page 1204)

Making buttons in the toolbar dynamic (Page 1188)

Defining the data source (Page 1204)

Configuring toolbar and status bar (Page 1206)

Configuring the export of Runtime data (Page 1207)

Determining the effect of the online configuration (Page 1208)

Online configuration of the table view (Page 1226)

Configuring the time columns of the table view

Introduction 
The time range for the tabular display is configured via time columns. A table can have separate 
time columns for several value columns or a common time column.

If you assign several time columns to a table view, the sequence of the time columns in the 
Inspector window corresponds to the sequence in the table view. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Procedure       
To configure the time column of a table view, follow these steps:

1. Click "Add" in the Inspector window under "Properties > Properties > Time columns" to add 
time columns.

2. Enter the "Name" and "Label" of the time column.

3. Configure the "Style" of the time column.

4. Configure the "time range" and "format" of the time display of the time column.

5. Configure the appearance of the "Header" and "Cells".

6. If the values of the time column should be updated automatically, activate "Update".
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Result
The time column is configured. Assign the time column to one or several value columns. 

See also
Configuring the value columns of the table view (Page 1201)

Configuring the value columns of the table view

Introduction
You configure the values of the table view via value columns. You can display several value 
columns in a table, e.g. to compare the fill levels of several containers. Every value column is 
connected with a time column. The value columns can have a common time column.

If you assign several value columns to a table view, the sequence of the value columns in the 
Inspector window corresponds to the sequence in the table view. If you assign several value 
columns to the same time column, the value columns in the list are automatically grouped 
according to assigned time column.

Requirement
● The table view is selected in the screen.

● The Inspector window is open

● The time column is created

Procedure 
Proceed as follows to configure a value column:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Value 
columns" to add a new value column.

2. Enter the "Name" and "Label" of the value column.

3. Configure the data source.

4. Assign a time column to the value column. 

5. If required, configure the appearance of the "Header" and "Cells".

6. If required, configure the "Sorting" of the value column. 

Result
The value column is configured.
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See also
Defining the data source (Page 1194)

Configuring the time columns of the table view (Page 1200)

Defining the data source (Page 1204)

Configuring the appearance of the table elements

Introduction
You can adjust the appearance of the table elements to your needs. 

Requirement
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure   
Proceed as follows to configure the colors of the table elements:

1. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Header":

– Visibility of the column headers and row headers

– Alignment of the column headers and row headers

– Color design of column headers

2. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Structure":

– Color design of table content, such as different colors for rows for better differentiation

– Visibility of empty columns and rows

3. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Grid":

– Design of grid lines

– Character spacing in the table cells

Result
The appearance of the table elements is configured. You can also define further properties:

● Behavior and color design when selecting a table entry

● Table entry sorting
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See also
Configuration of the marking of selected cells and rows (Page 1203)

Configuring table column sorting (Page 1204)

Configuration of the marking of selected cells and rows

Introduction 
If, for example, an operator wants to export values from a row, he must select the row. During 
configuration, define the following:

● Selection area
For the selection area, configure the following properties:

– Number of table elements that the operator can select

– Design of selection area

● Color design of selection area
Select the colors individually or use a default system-defined color. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Procedure
To configure the selection area, follow these steps:

1. In the Inspector window, select the "type" of selection area under "Properties > Properties 
> Table > Table - Selection > Selection area".

2. If needed, select the "frame" to be displayed around the selection area. 

3. Choose the colors for the "cells", "rows", and "frame" as needed. 

Result
The selection area of the table view is configured. To export the data from a selected area, 
configure the "data export". To evaluate the data from a selected area, configure a "value 
display". 

See also
Defining the data source (Page 1204)
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Configuring table column sorting

Introduction
If the operator is to be able to sort individual table columns in Runtime, configure the sorting 
within the table. 

Depending on the configuration, the operator can sort a table column as follows:

● Clicking or double-clicking on the column header

● Clicking on a sorting button
The sorting button is used to sort the selected column in the configured order. For the sorting 
button to appear, you must configure a vertical scroll bar. 

Requirement  
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure
To configure the sorting within a table, follow these steps:

1. In the Inspector window, select "Properties > Properties > Table > Table - Sorting > Sort 
by column header", "Sort with double-click", or "Sort with click".

2. Select the "Sorting order" option.

3. If needed, activate "Display sorting icon" and "Display sorting index".

4. If needed, activate "Display sorting button".

5. If you use the sorting button, select "Properties > Properties > Window > Scroll > Vertical 
scrollbar > Always" in the Inspector window.

Result
The sorting of the table columns is configured. 

Defining the data source

Introduction    
Using the data source, you define the sources from which the values are displayed on the HMI 
device in Runtime. The following sources are available:

● Current process values from tags

● Archived values from logging tags

● User-defined (only f(x) trend view)

● Recipe elements (only f(x) trend view)
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Requirement
● An online tag or logging tag is configured

● Value column or trend has been created

● The Inspector window is open

Displaying current process values
Proceed as follows to display current process values:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

– Select the "update cycle".

Displaying values from an archive
Proceed as follows to display values from an archive:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Logging tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

Displaying values from recipes
Output values from recipes in a f(x) trend view. 

Proceed as follows to display values from a recipe:
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1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "Recipe" as "Source".

– Under "X values" and "Y values" select one recipe element each.

Result
The data supply is configured. 

See also
Basics of tags (Page 975)

Basic principles for data logging (Page 1107)

Configuring the Table View (Page 1199)

Configuring the value columns of the table view (Page 1201)

Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.
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5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 

See also
Using the trend and table view in Runtime (Page 1217)

Configuring the Table View (Page 1199)

Elements of the status bar (Page 1233)

Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 

The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open
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Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configuring the Table View (Page 1199)

Determining the effect of the online configuration

Introduction        
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. The behavior on screen change can be configured. 

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. The behavior on screen change can be configured.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 
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Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 

See also
Configuring the Table View (Page 1199)

Online configuration of the table view (Page 1226)

Configuring the value table

Value table basics

Function
The value table displays values or statistics from a control. You establish the content of the 
value table when you configure it.

Overview of the value table  
You connect the value table with one of the following controls:

● Table view

● f(x) trend view

● f(t) trend view

A "display mode" is set in the value table. The display mode determines which data are shown 
in the value table. 
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Display modes     
Three different display modes are available in the value table.

● Ruler window
The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

● Statistics area window
The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. You can only connect the statistics 
area window with the f(t) trend display or the table view.

● Statistics window
The statistics window displays the statistical evaluation of the trends. Among other things, 
the statistics include:

– Minimum

– Maximum

– Average

– Standard deviation

– Integral

All windows can also display additional information on the connected trends or columns, such 
as time stamps. 

See also
Configuring the value table (Page 1210)

Creating statistics for Runtime data (Page 1230)

Determining the coordinates of a point (Page 1224)

Configuring the value table

Introduction
The contents of the value table are shown in columns. The available columns depend on the 
connected control. A block is assigned to each column. You define the alignment and 
appearance of the column headers using the blocks. By default, the format of the connected 
control is used for the display format, such as the time display.

Requirements
● The table view or trend view is selected in the screen

● The Inspector window is open
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Procedure
Proceed as follows to configure a value table:

1. Add the required table view to the screen from the "Tools" task card.

2. Click "Properties > Properties > General > Data source" in the Inspector window to connect 
the value table to the selected control.

3. Select the "mode" of the value table under "Properties > Properties > General".

4. Configure the properties of the value table columns under "Properties > Properties > 
Blocks".

5. Configure the "Properties > Properties > Columns":

– Change the "Visibility", if required

– Change the "Label", if required

– If required, change the sequence of columns using "Up" and "Down"

6. Configure the view of the value table in the Inspector window:

– Configure the view of the value table under "Properties > Properties > Appearance".

– Configure the properties of the value table in Runtime under "Properties > Properties > 
"Window".

Result
The value table is configured. 

See also
Value table basics (Page 1209)

Configuring toolbar and status bar (Page 1211)

Configuring the appearance of the table elements (Page 1213)

Configuring table column sorting (Page 1214)

Configuring the export of Runtime data (Page 1214)

Determining the effect of the online configuration (Page 1215)

Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 
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Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.

5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 

See also
Configuring the value table (Page 1210)

Elements of the status bar (Page 1233)
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Configuring the appearance of the table elements

Introduction
You can adjust the appearance of the table elements to your needs. 

Requirement
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure   
Proceed as follows to configure the colors of the table elements:

1. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Header":

– Visibility of the column headers and row headers

– Alignment of the column headers and row headers

– Color design of column headers

2. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Structure":

– Color design of table content, such as different colors for rows for better differentiation

– Visibility of empty columns and rows

3. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Grid":

– Design of grid lines

– Character spacing in the table cells

Result
The appearance of the table elements is configured. You can also define further properties:

● Behavior and color design when selecting a table entry

● Table entry sorting

See also
Configuring the value table (Page 1210)

Configuring table column sorting (Page 1214)
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Configuring table column sorting

Introduction
If the operator is to be able to sort individual table columns in Runtime, configure the sorting 
within the table. 

Depending on the configuration, the operator can sort a table column as follows:

● Clicking or double-clicking on the column header

● Clicking on a sorting button
The sorting button is used to sort the selected column in the configured order. For the sorting 
button to appear, you must configure a vertical scroll bar. 

Requirement  
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure
To configure the sorting within a table, follow these steps:

1. In the Inspector window, select "Properties > Properties > Table > Table - Sorting > Sort 
by column header", "Sort with double-click", or "Sort with click".

2. Select the "Sorting order" option.

3. If needed, activate "Display sorting icon" and "Display sorting index".

4. If needed, activate "Display sorting button".

5. If you use the sorting button, select "Properties > Properties > Window > Scroll > Vertical 
scrollbar > Always" in the Inspector window.

Result
The sorting of the table columns is configured. 

See also
Configuring the value table (Page 1210)

Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 
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The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open

Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configuring the value table (Page 1210)

Determining the effect of the online configuration

Introduction        
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
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configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. The behavior on screen change can be configured. 

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. The behavior on screen change can be configured.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 

 

Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 

See also
Configuring the value table (Page 1210)
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Using controls in Runtime

Using the trend and table view in Runtime

Introduction      
You operate the trend and table view using the toolbar buttons. 

To operate a button via a script, transfer the "ID" of the button to the script. Use the symbols 
from the symbol library to label the button. The symbols are available in the "Tools > Graphics" 
task card under "WinCC graphic folder > Runtime control icons > Trend View".

Shared buttons
The following table shows the buttons that are available in trend view and table view:

Icon Name Function ID
"Help" Calls up the control help. 1

"Configuration dialog" Opens the configuration dialog, in which you can change the 
properties of the control.

2

"First Data Record" Displays the course of a tag within a specified period starting with 
the first archived value. 
Requirement: Values come from a process value log.

3

"Previous Data Record" Displays the course of a tag within the previous time interval, 
based on the currently displayed time interval. 
Requirement: Values come from a process value log.

4

"Next Data Record" Displays the course of a tag within the next time interval, based 
on the currently displayed time interval.
Requirement: Values come from a process value log.

5

"Last Data Record" Displays the course of a tag within a specified period ending with 
the last archived value.
Requirement: Values come from a process value log. 

6

"Select Time Range" Opens a dialog in which you configure the time range 11

"Stop" Stops the updated display. 
The data is buffered.

14

"Start" Continues the updated display.
The buffered values are entered. 

14

"Print" Prints the selected values. 
The print job is defined in the configuration dialog on the 
"General" tab.

15
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Icon Name Function ID
"Export data" Exports all or selected data to a *.CSV file. 

Depending on the configuration and the privileges, the following 
options can be available:
● Display export settings and start export
● Select filename and directory

20

"Define statistics area" Defines the timeframe used to calculate the statistics. 16

"Calculate Statistics" Displays the statistical values from a fixed "statistics area" of the 
trend or table view in the statistics window of the value table. 
Only available with a configured value table

17

"Connect backup" Opens a dialog in which you connect selected archives from 
WinCC Runtime

18

"Disconnect backup" Opens a dialog in which you disconnect selected archives from 
WinCC Runtime

19

"User-defined 1"
 

Shows the first button created by the user. 
The function of the button is user-defined

1001

Trend view button
The following table shows the buttons that are available in the trend view:

Icon Name Function ID
"Ruler" Displays a ruler that shows the coordinates of the intersection 

point with a trend in the value table. 
Requirement: The value table is configured with "Ruler window" 
display mode. 

7

"Zoom area" Zooms the trend view area.  You define the area by dragging with 
the mouse. 
Use the "Original view" button to return to the original view. 

8

"Zoom +/-" Zooms in or out on the trends in the trend display. 
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

9

"Zoom time axis +/-" Zooms in or out on the time axis in the trend view.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

10

"Zoom value axis +/-" Zooms in or out on the value axis in the trend view.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

11

"Move trend area" Moves the trend along the value axis and the time axis 12
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Icon Name Function ID
"Move axis range" Moves the trend along the value axis 13

"Original view" Returns to the original view from the zoomed display 14

"Select data connection" Opens a dialog in which you select the data source:
● Process value archive
● Tag
● Recipe (only f(x) trend view)

15

"Select trends" Opens a dialog in which you can hide and show trends.  You can 
also select which trend is to be placed in the foreground. 

16

"Previous trend" Displays the previous trend in the foreground. 18

"Next trend" Displays the next trend in the foreground. 19

"Relative axis" Switches from displaying the absolute values to the percentage 
display of value axis. The high and low limits for the trend 
correspond with a range of 0 to 100%.

27

Table view buttons  
The following table shows the buttons that are available in the table view:

Icon Name Function ID
"Edit" Activates editing of table entries. To edit a value, double-click on 

the desired table cell. 
Requirement: Updated display is stopped.

7

"Copy lines" Copies the content of the selected lines to the clipboard. 
Requirement: Updated display is stopped. 

8

"Select columns" Opens a dialog in which you can show or hide columns and 
change the column sequence. 

10

"Previous column" Moves a value column ahead of the previous value column. 
The function refers to the value columns that are assigned to a 
time axis.

12

"Next column" Moves a value column behind the next value column. 
The function refers to the value columns that are assigned to a 
time axis.

13

"Select data connection" Opens a dialog in which you select the data source:
● Process value archive
● Tag
● Recipe (only f(x) trend view)

15
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Using trend view in Runtime

Online configuration of the f(t) trend view

Introduction  
In Runtime you configure online and thus change the appearance of the trend view. The table 
view configuration specifies whether online configurations are retained or discarded on a 
screen change or after Runtime is ended.

Overview
The following buttons make online configuration possible in the trend view:

● "Configuration dialog" button

● "Select data connection" button

● "Select trends" button

● "Select Time Range" button

Opening the configuration dialog
To open the configuration dialog, proceed as follows:

1. Click  in the toolbar. 

The configuration dialog is opened. You can change the table appearance, for example, in the 
configuration dialog. 

Changing the data connection
The following table shows the configuration options for data connection:

Field Description
Trend Choose one of the configured trends.
Data Source Define whether the selected trend is supplied with a logging tag or online tag.
Tag name Select the tag name for the data connection.

Proceed as follows to change the data connection: 

1. Click  in the toolbar.  
The "Archive/tag selection" dialog is opened. 

2. Choose the "Value column" for which you want to change the data connection.

3. Select the "Data supply" and the "Tag name". 
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Changing a time range
The following table shows the configuration options for the time range:

Field Description
Time axis Select the configured time axis for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

To configure the time range, follow these steps:

1. Click  in the toolbar of the trend view.
The "Time - Selection" dialog opens.

2.  Choose the "Time axis" for which you want to adapt the time range.
If the trends in a trend view are to be displayed with a common time axis, the specified time 
range applies to all trends.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

See also
Trend to Front (Page 1223)

Using the zoom functions in trend windows (Page 1221)

Starting and Stopping Update (Page 1230)

Creating statistics for Runtime data (Page 1230)

Displaying logged values (Page 1232)

Elements of the status bar (Page 1233)

Configure trend view (Page 1188)

Using the zoom functions in trend windows

Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view 
for trends, axes and various zoom areas of the trend window.
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Overview
The following zoom functions are available in the trend window:

● "Zoom area"

● "Original view"

● "Zoom +/-"

● "Zoom time axis +/-"

● "Zoom value axis +/-"

● "Move trend area"

Requirement
● The trend view is open

● Buttons with zoom functions are configured

● Runtime is activated

Zooming in on a trend view area
Proceed as follows to zoom in on an area of the trend view:

1. Click on .  
The updated display is stopped.

2. Drag with the mouse to draw a box around the area to be zoomed. 
If there are at least two measured values within this area, the area of the trend is zoomed. 

3. To return to the original view of the trend, click . 

4. Click on  to start the update again. 

The default values are used for the axis. 

Zooming in or out on trends
If you zoom in or out on a trend, the 50% value of the trend is always in the middle of the value 
axes.

Proceed as follows to zoom in or out on a trend:

1. Click on . 
The updated display is stopped.

2. To zoom in on a trend, click on the trend with the left mouse button. 

3. To zoom out on a trend, hold down the <Shift> key and click on the trend with the left mouse 
button.

4. To return to the original view of the trend, click . 

5. Click on  to start the update again. 

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1222 System Manual, 08/2011,  



The default values are used for the axis. 
 

 Note

If you change the value area of a value axis on the "Value Axis" tab in the configuration dialog 
while zooming, the visible zoom area is set to the new value area.

 

Zooming in on the time axis or value axis
While zooming with time or value axes, the 50% value of the trend is always in the middle of 
the axes.

Proceed as follows to zoom the time axis or value axis:

1. Click  to zoom the time axis.  
The updated display is stopped.

2. Click  to zoom the value axis.  
The updated display is stopped.

3. To zoom in on an axis, click on the trend view with the left mouse button. 

4. To zoom out on an axis, hold down the <Shift> key and click on the trend view with the left 
mouse button.

5. To return to the original view of the trend, click . 

6. Click on  to start the update again. 

The default values are used for the axis. 

Moving a trend area
Proceed as follows to move the trend area:

1. Click on . 
The updated display is stopped.

2. While holding the left mouse button pressed, move the cursor in the desired direction in 
the trend view.
The displayed area in the trend window is adapted on the time axis and on the value axis.

3. Click on  again to return to the original view of the trend window.

See also
Online configuration of the f(t) trend view (Page 1220)

Trend to Front

Introduction 
If more than one trend are to be displayed in a trend window, you can use key functions to 
define which trends will be displayed in the foreground.
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Requirement
● The following buttons are configured:

– "Select trends"

– "Previous trend" 

– "Next trend"

● The project is activated

Procedure
Proceed as follows to display a trend in the foreground:

1. Click on .  
The dialog for displaying or hiding trends is opened. In this dialog you can also define which 
trend is in the foreground. 

 

  Note

The first trend of a trend window cannot be hidden.
 

2. In order to display the next trend in the foreground, click on . 

3. In order to display the previous trend in the foreground, click on .  

See also
Online configuration of the f(t) trend view (Page 1220)

Determining the coordinates of a point

Introduction
The "Ruler" button is used to determine the coordinates of a point on the trend by means of a 
ruler. You can zoom in on an area of the trend to make coordinate finding easier. If you display 
the ruler in the trend view, you can move the ruler at any time. 

If you click on the trend with the mouse, several trend parameters are shown in the tooltip for 
the trend view.

Requirement
● A trend view is configured

● The value table is configured and connected with the trend view

● The "Ruler window" display mode is activated in the value table

● Runtime is activated
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Procedure
Proceed as follows to determine the coordinates of a point:

1. Click on  in the trend view.
The ruler is shown. 

2. Move the ruler to the desired position with the mouse.

3. If you want to zoom in on an area, click on . 

– Move the ruler to the desired position with the mouse.

– Click  to return to the original view.

Result
In the ruler window of the value table, besides the X value/time stamp and the Y value, the 
data that you have configured in the value table is shown in the columns. 

In the value table, the indices "i" and "u" can be displayed in addition to the values:

● "i.": The displayed value is an interpolated value.

● "u.": The displayed value has an uncertain status:

– The initial value after Runtime activation is unknown

– A substitute value is used
 

  Note

You can also identity the "uncertain" status of a value in the displayed trend curve. You 
must activate the "Value with uncertain status" option on the "Trends" tab under "Limit 
values". 

 

The following image shows the coordinates of a point in the ruler window of the value table:
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Alternative procedure
Alternatively, you can also connect the value table to the table display. In the "ruler window" 
display mode, the values of the selected line are displayed in the value table. 

See also
Value table basics (Page 1209)

Operating table view in Runtime

Online configuration of the table view

Introduction    
In Runtime you configure online and thus change the appearance of the table view. The table 
view configuration specifies whether online configurations are retained or discarded on a 
screen change or after Runtime is ended.

Visualizing processes (Professional)
9.2 Working with tags

WinCC Professional V11.0 SP1
1226 System Manual, 08/2011,  



Overview
The following buttons make online configuration possible in table view:

● "Configuration dialog" button

● "Select data connection" button

● "Select columns" button

● "Select Time Range" button

Opening the configuration dialog
To open the configuration dialog, proceed as follows:

Click  in the toolbar. 

The configuration dialog is opened. You can change the table appearance, for example, in the 
configuration dialog. 

Changing the data connection
The following table shows the configuration options for data connection: 

Field Description
Value column Choose the configured value column for which you want to change the data 

connection.
Data Source Define whether the selected value column is supplied with a logging tag or online 

tag.
Tag name Select the tag name for the data connection.

Proceed as follows to change the data connection:

1. Click  in the toolbar.
The "Archive/tag selection" dialog is opened. 

2. Choose the "Value column" for which you want to change the data connection.

3. Select the "Data supply" and the "Tag name".

Showing or hiding columns
To show or hide columns, follow these steps:

1. Click  in the toolbar.
The dialog for showing or hiding columns is opened. 

2. If required, change the sequence of the value columns that are assigned to a time column.

The value columns can only be moved in reference to the anchored time column.
 

 Note

The first column of a table view cannot be hidden.
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Changing a time range
The following table shows the configuration options for the time range:

Field Description
Time column Select the configured time column for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

To configure the time range, follow these steps:

1. Click  in the toolbar of the table view.
The "Time - Selection" dialog opens.

2. Choose the "Time column" for which you want to adapt the time range.
If the columns of a table view are to be displayed with a common time axis, the specified 
time range applies to all columns.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

See also
Editing the table field in Runtime (Page 1228)

Moving columns in the table (Page 1229)

Starting and Stopping Update (Page 1230)

Creating statistics for Runtime data (Page 1230)

Displaying logged values (Page 1232)

Elements of the status bar (Page 1233)

Configuring the Table View (Page 1199)

Editing the table field in Runtime

Introduction 
You change the values displayed in the table view manually using the "Edit" button.
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Requirement
● The table view is configured

● The "Edit" button is configured

● Runtime is activated

Procedure
Proceed as follows to edit a table field in Runtime:

1. Click  in the table view.
The updated display is stopped, the process data continues being archived.

2. Click on .

3. Double click on the desired table field of a value column.

4. Enter the new value.
The changed value is archived.

5. In order to continue with the display of Runtime data in the table view, click on .

See also
Online configuration of the table view (Page 1226)

Moving columns in the table

Introduction 
The time column is always shown in the first column in the table. The value columns that are 
assigned to this time column are displayed next. If there are more than one time columns 
configured, the second time column follows with the assigned value columns.

You can change the sequence of the value columns that are assigned with a time column in 
Runtime. The value columns can only be moved in reference to the anchored time column. 
The sequence of the time columns with the assigned value columns are defined on the "Time 
axes" tab.

Requirement
The following buttons are configured:

● "Select columns"

● "Previous column"

● "Next column".
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Procedure
To change the sequence of the columns, follow these steps:

1. Click on .
The dialog for changing the sequence of the columns is opened. 

2. To hide a column, deactivate the option before the column name.

3. To move a value column, select the value value column:
The function refers to the value columns that are assigned to a time column. 

– Click  to move the value column behind the next value column.

– Click  to move the value column in front of the previous value column.

See also
Online configuration of the table view (Page 1226)

Starting and Stopping Update

Introduction     
You can continue the update of the data contained in the control with the "Start/Stop" button. 

Some buttons stop the update automatically, e.g. "Define statistics area"

The appearance of the button indicates whether the update is stopped or not:

● : Update has been stopped. To continue the update, click on the button.

● : The update has been started. To stop the update, click on the button

See also
Online configuration of the f(t) trend view (Page 1220)

Online configuration of the table view (Page 1226)

Creating statistics for Runtime data

Introduction
You can generate an analysis of the process data for the Runtime data in the trend view or 
table view. You can display the evaluated data in the value table.

Requirement
● A trend view or table view is configured

● A value table is configured and connected with the trend view or table view

● Runtime is activated
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Displaying data in a statistics area window 
Requirement: The "Statistics area window" display mode is activated in the value table. 

To display data in the statistics area window of the value table, proceed as follows:

1. In the trend view or table view, click on .
The updated display is stopped, the process data continues being archived.

2. If you wish to evaluate data outside the displayed time range:

– Click 
The "Time - Selection" dialog opens. 

– Enter the required time range.
The data for the defined time range is displayed.

3. If you are using a trend view:

– Click 
In the trend view, two vertical lines are displayed on the right and left edges.

– To define the statistics area, move the two lines to the desired position.

4. If you are using a table view:

– Use the mouse to select the lines for the desired time range in the table.
For different columns with different time frames you can select different time ranges for 
the calculation of statistics.

– Click  in the toolbar

The evaluated data is displayed in the columns that you have configured in the statistics area 
window. The following figure shows the display in the statistics area window, using the trend 
view as an example:
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In order to continue with the display of Runtime data, click .
 

 Note

For additional statistical analysis of process data and archiving of results you can write the 
scripts yourself. 

 

See also
Value table basics (Page 1209)

Online configuration of the f(t) trend view (Page 1220)

Online configuration of the table view (Page 1226)

Displaying logged values

Introduction
Scroll through the displayed data of an archive using the buttons in the toolbar of a trend view 
or table view. If key combinations are configured, you can also use these for scrolling. 
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The buttons for browsing in archive are available only if data is supplied through archive tags.

The archived values of a tag are displayed within a time range in the trend or table view. 

Requirement
● Time range is configured

Buttons for Archived Values
To scroll in archived values, proceed as follows:

1. To display the first data record of the time range, click on .

2. To display the previous data record of the time range, click on .

3. To display the next data record of the time range, click on .

4. To display the last data record of the time range, click on .

See also
Time range basics (Page 1185)

Online configuration of the f(t) trend view (Page 1220)

Online configuration of the table view (Page 1226)

Elements of the status bar

Elements of the status bar
The status bar of the trend view or table view can contain the following elements:

Icon Name Description
Connection status1 No faulty data connections

Faulty data connections exist

All data connections are faulty

"Line 1"2 Selected line Shows the number of the selected line.
"Column 2"2 Selected column Shows the number of the selected column.
"23.02.2010" Date Shows the system date.
"23:59:59" Time Shows the system time.

Time base Shows the time base used in the display of times.
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Icon Name Description
1: If you double-click on the "Connection status" icon, the "Status of the data connections" window 
opens. The following properties of each data connection are listed in the window:
● Name
● Status
● Tag name
2: Only in the table view

See also
Online configuration of the f(t) trend view (Page 1220)

Online configuration of the table view (Page 1226)

Configuring toolbar and status bar (Page 1211)

9.3 Working with alarms

9.3.1 Principles

9.3.1.1 Alarm Logging in WinCC

Introduction
The alarm system allows you to display and record operating states and faults on the HMI 
device that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm system in WinCC  
The alarm system processes a variety of alarm types. The alarm procedures can be broken 
down into system-defined alarms and user-defined alarms: 

● User-defined alarms are used to monitor the plant process.

● System-defined alarms monitor the HMI device.

The detected alarm events are displayed on the HMI device. Targeted access to the alarms 
combined with supplementary information about individual alarms ensures that faults are 
localized and cleared quickly. This reduces stoppages or even prevents them altogether.
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The following figure shows the alarm system structure:

9.3.1.2 Alarm Logging in WinCC

Introduction
Alarm logging allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time of 
day

Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red
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Alarm Logging in WinCC
Alarm logging processes various alarm procedures used by the PLC and the HMI device. The 
alarm procedures can be broken down into system-defined alarms and user-defined alarms: 

● User-defined alarms serve to monitor the plant.

● System-defined alarms are used to monitor the HMI device or the PLC.

The detected alarm events are displayed on the HMI device. You can use the alarm logging 
system to log alarms from the ongoing process. Targeted access to the alarms combined with 
supplementary information about individual alarms ensures that faults are localized and 
cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm logging structure:

9.3.1.3 Alarm Logging in WinCC 

Introduction
Alarm logging allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.

An alarm may have the following content:
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N
o.

Time of 
day

Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm Logging in WinCC 
Alarm logging processes various alarm procedures used by the PLC and the HMI device. The 
alarm procedures can be broken down into system-defined alarms and user-defined alarms: 

● User-defined alarms serve to monitor the plant.

● System-defined alarms are used to monitor the HMI device or the PLC.

The detected alarm events are displayed on the HMI device. You can use the alarm logging 
system to log alarms from the ongoing process. Targeted access to the alarms combined with 
supplementary information about individual alarms ensures that faults are localized and 
cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm logging structure:
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9.3.1.4 Alarm Procedures

Overview of the alarm types 

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 

Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

System-defined alarms
● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

See also
Analog alarms (Page 1241)

Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 
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Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

● Controller alarms 

– You configure controller alarms in STEP 7.

– You continue to process the controller alarms in WinCC.
 

  Note
Device dependency

The controller alarm is not supported on all HMI devices.
 

System-defined alarms
● System-defined controller alarms       

– System-defined controller alarms consist of diagnostic alarms (SIMATIC S7) and system 
errors (SFM)

– System-defined controller alarms are used to monitor the PLC.
 

  Note
Device dependency

System-defined controller alarms are not supported on all HMI devices.
 

● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

See also
Analog alarms (Page 1241)

Controller alarms (Page 1242)

System-defined controller alarms (Page 1244)
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Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 

Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

● User alarms

– User alarms serve to monitor operator input.  

– User alarms are triggered by means of alarm number and can be also used in scripts 
in Runtime. 

● Controller alarms 

– You configure controller alarms in STEP 7.

– You continue to process the controller alarms in WinCC.
 

  Note
Device dependency

Controller alarms and user alarms are not supported on all HMI devices.
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System-defined alarms
● System-defined controller alarms       

– System-defined controller alarms are used to monitor the PLC.

– Diagnostics alarms (SIMATIC S7) and system alarms (SFM) also belong to the category 
of system-defined controller alarms.

 

  Note
Device dependency

System-defined controller alarms are not supported on all HMI devices.
 

● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

Custom alarm classes

Analog alarms

Description
Analog alarms signal limit violations during the process.

Example
The speed of the mixer in a fruit juice mixing plant must not be too high or too low. You can 
configure analog alarms to monitor the speed of the mixer. If the high or low limit for the speed 
of the mixer is violated, an alarm is output on the HMI device containing the following alarm 
text, for example: "Mixer speed is too low".

See also
Configuring Analog Alarms (Page 1270)

Discrete alarms

Description
Discrete alarms indicate a status in the current process.  
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Example  
A fruit juice mixing plant consists of several tanks containing the ingredients. To ensure the 
correct mixing ratio of water, fruit concentrate, sugar, and flavoring, the valves in the intakes 
open and close at the right moment. This operation should be monitored. 

You configure a suitable discrete alarm for all the valve states. If a valve on one of the four 
tanks opens or closes, an alarm is displayed, such as "Water valve closed". 

The operator can thus monitor whether the plant is producing correctly. 

See also
Configuring discrete alarms (Page 1273)

Controller alarms

Example of an alarm
CPU operating mode switch to Stop

Description
The custom controller alarms are created by the control system engineer in STEP 7. The status 
values, such as time stamp and process values, are mapped in the controller alarm. If controller 
alarms are configured in STEP 7, accept them into the integrated WinCC operation as soon 
as a connection is established to the PLC.  

In STEP 7, the controller alarm is assigned to an alarm class. You can import this alarm class 
with the controller alarm as a common alarm class.

Types of controller alarms 
SIMATIC S7 supports different types of controller alarms. WinCC supports different types of 
controller alarms according to which Runtime is used.

Controller alarms for multiple HMI devices
If a PLC is connected to multiple HMI devices, the project engineer assigns display classes to 
the controller alarms in STEP7. The display classes determine the allocation to the HMI device. 
You can activate the display classes for your HMI device that are to be displayed on it. In this 
case, only the controller alarms from this display class will be displayed on the HMI device. 
Up to 17 display classes are possible.

See also
Editing controller alarms (Page 1280)
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User alarms

Description  
User alarms indicate operator actions in Runtime. You can also configure user alarms in 
Runtime scripts for user-defined applications. 

Example
An alarm of alarm class "Errors" is displayed on the HMI device of a plant. The operator 
eliminates this error in the plant and acknowledges the alarm in the alarm view of the HMI 
device. To monitor by whom and when the error was cleared, assign a user alarm to the 
appropriate button of the alarm view. The alarm contains the following information, for example: 

● Type and content of the acknowledged alarm

● Time of acknowledgment

● Operator

● Date

System-defined alarms

System events

Examples for alarms
● "An online connection to the PLC is established."

Description   
A system alarm indicates the status of the system, plus communication errors between the 
HMI device and system.

Under "Runtime settings > Alarms" you specify how long a system alarm is shown on the HMI 
device.

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. If you contact online support because of a system alarm on the HMI device, you will 
need the alarm number and tags used in the system alarm.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1243



System events

Examples of alarms
● "Overflow of the buffer for printing lines in text mode"

● "No printer is installed or a default printer has not been set up."

Description   
A system event indicates the system status, including errors in the communication between 
the HMI device and system. 

The system events depend on the HMI device. 

You can load system events in the "HMI alarms" editor from a an *.xml file. 

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. When contacting Online Support because of a system event on the HMI device, you 
need the event number and tags used in the system event.

See also
Editing system events (Page 1279)

System-defined controller alarms

Example of an alarm
Valve open due to overpressure

Description     
System-defined controller alarms are installed with STEP 7 and are only available if WinCC is 
operated in the STEP 7 environment. 

WinCC processes system-defined controller alarms of the type "SIMATIC S7 diagnostic alarm".

S7 diagnostic alarms show states and events in the SIMATIC S7 controllers. You only have 
read access to S7 diagnostic alarms. They are assigned to the "Diagnostics" alarm class by 
the system. S7 diagnostic alarms are not acknowledged or reported. They are for signaling 
purposes only.

See also
Enabling system-defined controller alarms (Page 1281)
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9.3.1.5 Alarm states 

Introduction
An alarm assumes various alarm states in Runtime. The user analyzes and reports on the 
process execution with reference to the alarm states. 

 

 Note

Device dependency

Reporting and logging are not available for all HMI devices.
 

Description
Every alarm has an alarm status. The alarm states are made up of the following events: 

● Incoming (I)          
The condition for triggering an alarm is satisfied. The alarm is displayed, such as "Boiler 
pressure too high."

● Outgoing (O)    
The condition for triggering an alarm is no longer satisfied. The alarm is no longer displayed 
as the boiler was vented.

● Acknowledge (A)    
The operator acknowledges the alarm.

Alarms without acknowledgment
The following table shows the alarm states for alarms that do not have to be acknowledged:

Display text Status Description
I Incoming The condition for an alarm is satisfied.

IO Outgoing The condition for an alarm is no longer satisfied.

Alarms with acknowledgment
The following table shows the alarm states for alarms that have to be acknowledged:

Display text Status Description
I Incoming The condition for an alarm is satisfied 

IO Outgoing
not acknowledged

The condition for an alarm is no longer satisfied. The 
operator has not acknowledged the alarm.

IOA Outgoing
and subsequently 
acknowledged

The condition for an alarm is no longer satisfied. The 
operator has acknowledged the alarm after this time.
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Display text Status Description
IA Incoming, 

acknowledged
The condition for an alarm is satisfied. The operator 
has acknowledged the alarm.

IAO Outgoing
but acknowledged first

The condition for an alarm is no longer satisfied. The 
operator acknowledged the alarm while the condition 
was still satisfied.

Each occurrence of these states can be displayed and logged on the HMI device and a protocol 
printed.

 

 Note

You can configure the display text for the alarm status.
 

9.3.1.6 Alarm classes

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 

A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The alarm "Speed of fan 1 in upper tolerance range" has alarm class "Warnings". The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The alarm "Speed of fan 2 has exceeded upper warning range" is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.
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Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

See also
Creating alarm classes  (Page 1262)

Creating alarm classes (Page 1263)

Predefined alarm classes (Page 1248)

Using common alarm classes (Page 1264)

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 

A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The "Speed of fan 1 in upper tolerance range" alarm has "Warnings" alarm class. The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The "Speed of fan 2 has exceeded upper warning range" alarm is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.
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Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

● Common alarm classes  
Common alarm classes are displayed under "Shared data > Alarm classes" in the project 
tree and can be used for the alarms of an HMI device. Common alarm classes originate in 
the alarm configuration of STEP 7. If needed, you can create additional common alarm 
classes in WinCC. 

See also
Creating alarm classes  (Page 1262)

Creating alarm classes (Page 1263)

Predefined alarm classes (Page 1248)

Using common alarm classes (Page 1264)

Predefined alarm classes

Predefined alarm classes   
The following alarm classes already created in WinCC for every HMI device:

Alarm classes for user-defined alarms
● "Warnings"

The "Warnings" alarm class is designed to show irregular statuses and routines in the 
process. Users do not acknowledge alarms from this alarm class.

● "Errors"
The "Errors" alarm class is intended to show critical or dangerous states or limit violations 
in the process. The user must acknowledge alarms from this alarm class. 
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Alarm classes for system-defined alarms
● "System"

The "System" alarm class contains alarms that display states of the HMI device and the 
PLCs.

● "Diagnosis Events"
The "Diagnosis Events" alarm class contains alarms that display states and events in 
SIMATIC S7 controllers. Users do not acknowledge alarms from this alarm class.

 

  Note
Device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

See also
Basics on alarm classes (Page 1247)

Creating alarm classes (Page 1263)

Creating alarm classes  (Page 1262)

Using common alarm classes (Page 1264)

9.3.1.7 Acknowledgement

Acknowledging alarms 

Introduction  
To make sure that an alarm was registered by the plant operator, configure this alarm so that 
it is displayed until acknowledged by the operator. Alarms that display critical or hazardous 
states in the process have to be acknowledged. 

Description
The acknowledgment of an alarm is an event that is logged and reported. Acknowledging an 
alarm changes the alarm status from "Incoming" to "Acknowledged". When the operator 
acknowledges an alarm, the operator confirms that he or she has processed the status that 
triggered the alarm. 

 

 Note
HMI device dependency

Reporting and logging are not available for all HMI devices.
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Triggering acknowledgment of an alarm
In Runtime, you trigger alarm acknowledgments in various ways:

● Acknowledgement by the authorized user at the HMI device

● Automatic acknowledgment by the system without operator action, e.g. by means of

– Tags

– PLC

– System functions in function lists or scripts
 

  Note
HMI device dependency

Scripts are not available for all HMI devices.
 

Acknowledging alarms that belong together
To make the alarm system clearer and easier to use in Runtime, you can configure an alarm 
group. You can acknowledge all alarms belonging to this alarm group in a single pass. 

Acknowledgment by the PLC
Discrete alarms will be automatically acknowledged by the PLC, if necessary. The 
acknowledgment is triggered by a bit in the "Acknowledgment tag PLC". You define the bit and 
tag at the configuration stage. 

Acknowledgment of an alarm on the HMI device
In Runtime, the user acknowledges an alarm in one of the following ways, depending on the 
configuration:

● Using the acknowledgment button <ACK> on the HMI device

● Using the button in the alarm view

● Using configured function keys or buttons in screens
 

  Note
Acknowledgment button <ACK> on the HMI device

To ensure that critical alarms are processed only by authorized users, protect the "ACK" 
button on the HMI devices, including the operating controls and display objects of the 
alarms. Use the appropriate operator authorization for this.

 

  Note
HMI device dependency

The acknowledgement key <ACK> is not available on all HMI devices.
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Acknowledgment model 

Overview 
You define the acknowledgment model for an alarm class. Alarms that are assigned to this 
alarm class will be acknowledged on the basis of this acknowledgment model. The following 
acknowledgment model is used in WinCC:  

● Alarm without acknowledgment 
This alarm comes and goes without having to be acknowledged. There is no visible 
response from the system. 

● Alarm with simple acknowledgment 
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.

Acknowledgment model

Overview
You define the acknowledgment model for an alarm class. Alarms that are assigned to this 
alarm class will be acknowledged on the basis of this acknowledgment model. The following 
acknowledgment model is used in WinCC: 

● Alarm without acknowledgment  
This alarm comes and goes without having to be acknowledged. There is no visible 
response from the system. 

● Alarm with simple acknowledgment
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.

● Alarm with dual-mode acknowledgment
The alarm requires one acknowledgment as soon as the event that triggers the alarm has 
occurred, and a second acknowledgment when the event that triggers the alarm is no longer 
present. The alarm remains pending until it is acknowledged.

● Alarm without "outgoing" status with acknowledgment
This alarm is displayed in the alarm view until it is acknowledged. It then disappears from 
the alarm view. The alarm is only logged.

● Alarm without "outgoing" status without acknowledgment
This alarm is displayed, and goes out when the event that triggered the alarm is no longer 
present. The alarm is not added to the alarm view. The alarm is only logged.

● First value alarm with flashing and single acknowledgment
The first value alarm is a form of alarm processing in which the first alarm in a list of alarms 
to undergo a status change since the last acknowledgment is highlighted. Only the first 
alarm in this alarm class is displayed flashing in the alarm window.
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● New value alarm with flashing and single acknowledgment
The new value alarm is a form of alarm processing in which any alarms from a list of alarms 
that have undergone a state change since the last acknowledgment are highlighted.

● New value alarm with flashing and dual-mode acknowledgment
The alarm flashes if the value being monitored has changed. You acknowledge this alarm 
incoming and outgoing. 

Overview of the Acknowledgment models for Multiple Alarms
● Group Acknowledgment/Single Acknowledgment of Alarms in the Alarm View

The alarm view has a "Group acknowledgment" button . This button triggers the 
acknowledgment of all visible alarms that require acknowledgment and are pending in the 
alarm view. If the "Single acknowledgment" option is enabled for alarms, you cannot use 
the group acknowledgment function and must acknowledge each alarm separately using 
the  button. 

● Acknowledging Alarms in Alarm Groups
If an alarm group is assigned an acknowledgment tag, use this tag in Runtime for a group 
acknowledgment of all alarms of this alarm group. You can configure suitable buttons or 
function keys for using this tag.

Alarm annunciator acknowledgment model
You can configure the acknowledgment of the alarm annunciator in the following ways:

● You acknowledge the alarm annunciator alongside with the alarm that triggered it.

● To acknowledge the alarm annunciator, use a separate button in the alarm view.

● The alarm annunciator is acknowledged using a tag.

Emergency Acknowledgment
In exceptional circumstances, you can acknowledge an alarm with reference to its alarm 
number. The acknowledgment bit is sent to the AS even if the alarm is currently not pending. 

For this reason, the function should only be used in extreme emergency situations.

9.3.1.8 Alarm groups

Introduction
Many alarms from different areas and processes occur in a plant. You can compile associated 
alarms into alarm groups. 

Alarm groups  
You can use the alarm groups to monitor the parts of the plant and to acknowledge the 
associated alarms together as required. 
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Alarm groups can contain alarms from different alarm classes. You only assign alarms that 
require acknowledgment to alarm groups. 

Using alarm groups
It is a good idea to compile alarm groups for alarms such as the following:

● Alarms that are caused by the same fault.

● Alarms of the same type

● Alarms from a machine unit, such as "Fault in drive XY"

● Alarms from an associated part of the process, such as "Fault in cooling water supply"

Display in Runtime
In Runtime, the "Alarm group" column displays the number of the alarm group to which the 
alarm belongs. 

See also
Configuring alarm groups  (Page 1267)

9.3.1.9 Alarm groups

Alarm Group Basics

Introduction  
Many alarms from different areas and processes occur in a plant. You use alarm groups to 
clearly represent the states of the plant areas on the HMI device, and to make the alarm system 
for your project easy to operate. 

Description
An alarm group is a compilation of single alarms. An alarm group has several tags that address 
a specific property of the it alarms contains. You define the bits of each tag for a group. To 
display an alarm group on the HMI device, configure its visualization individually via the alarm 
group's status tag.

Application
You can use alarm groups for the following purposes, for example:

● To compile alarms that were caused by the same fault,
such as "power failure"

● To compile alarms of the same type,
such as "fuse blown"
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● To sort and monitor alarms from a machine unit
such as "fault in drive XY"

● Alarms from an associated part of the process
such as "fault in cooling water supply"

● To process a group of all alarms from a plant area, such as:

– Acknowledging alarms

– Locking alarms

– Suppressing alarm displays

● To visualize the status of plant areas

● To connect plant processes with the acknowledgment of alarms

Alarm Groups in WinCC
In WinCC, you work with two types of alarm group: 

● Custom alarm groups   
You create custom alarm groups as required. These contain alarms that must be 
acknowledged, as well as sublevel alarm groups. You can create a hierarchy of custom 
alarm groups that contains up to five subgroups. 

● Alarm Groups from Alarm Classes
An alarm group is already created for each predefined alarm class. When you create a new 
alarm class, an alarm group is created with the same name. All the alarms from this alarm 
class will also be contained in the alarm group from the alarm class. Any changes to the 
alarm class configuration will be transferred to the "Alarm Groups" tab. The configuration 
for the corresponding alarm group will be updated. You only edit the properties of the alarm 
group for alarm groups from alarm classes. 

 

  Note

An alarm is always contained in an alarm group from alarm classes. An alarm that requires 
acknowledgment can also belong to a custom alarm group. 

 

See also
Configuring alarm groups  (Page 1268)

Hierarchical alarm groups

Introduction
WinCC allows you to compile alarms and custom alarm groups hierarchically. In this way, you 
construct a hierarchy of alarms that allows you to clearly and quickly detect and process the 
states of complex plants. 

You can only create this hierarchy from alarms and alarm groups with custom alarm groups.
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Structure of Hierarchical Alarm Groups
You compile custom alarm groups and single alarms hierarchically as required. You can also 
subsequently add child alarm groups. 

The following figure shows a hierarchical alarm group in WinCC:

 

 Note

If you subsequently add an alarm group, the numbering will no longer be consecutive.
 

 
 

 CAUTION

When you create a hierarchy of alarm groups, make sure that you do not use them recursively.
 

 NOTICE

If you delete an alarm group that contains other alarm groups, all lower-level alarm groups 
will be deleted as well.

 

Components of parent alarm groups
A parent alarm group contains the following elements as required:

● Single alarms

● Child alarm groups

Display suppression tag
You only assign the display suppression tag to alarm groups that contain no alarm subgroups 
and to customized alarm groups.
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See also
Configuring alarm groups  (Page 1268)

Tags of an alarm group

Tags of an alarm group  
You can assign the following tags to an alarm group:

Status tag 
● The status tag stores the alarm states of an alarm group.

● The status tag stores the acknowledgment request. The acknowledgment request is 
pending in an alarm group when at least one of the alarms in the group is queued and this 
alarm requires acknowledgement. 

● The status tag is used to visualize the alarm states and the acknowledgment request of an 
alarm group.

● The status tag can be checked by other WinCC components.

Lock tag 
● The lock tag stores the locked status of an alarm group.

● The lock tag is used to analyze the locked status of an alarm group.

Acknowledgment tag  
● The acknowledgment tag stores the "acknowledged" status of an alarm group.

● The acknowledgment tag is used to acknowledge an alarm group.

● The acknowledgment tag can be polled by other WinCC components.
 

  Note

The acknowledgment bit of an acknowledgment tag is not automatically reset. You can 
configure a button or function key to do this. Use this button to reset the acknowledgment 
bit of the acknowledgment tag.

The acknowledgment tag of an alarm group does not display the acknowledgment via the 
alarm view.

 

Display suppression tag 
The display suppression tag automatically suppresses the display of all the alarms for an alarm 
group in response to a specific plant status.

The display suppression tag returns the current value of the plant status as a value between 
1 and 32. All alarms of the alarm group for which the corresponding bit of the number between 
1 and 32 is set in the display suppression mask are suppressed.
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See also
Configuring alarm groups  (Page 1268)

Configuring Alarm Display Suppression (Page 1329)

Bit assignment for lock tags (Page 1465)

Bit assignment for display suppression tags  (Page 1466)

Bit assignment of status tag (Page 1461)

Bit assignment for acknowledgment tags (Page 1464)

9.3.1.10 Alarm number 

Assigning alarm numbers
The system assigns unique alarm numbers within an alarm type. 

 

 Note

When adapting alarm numbers, observe the uniqueness of the alarm number within an alarm 
type.

 

9.3.1.11 Alarm number 

Assigning alarm numbers 
The system assigns unique alarm numbers for the project. 

 

 Note

When adapting alarm numbers, observe the inter-project uniqueness of the alarm number.
 

The system event number overrides a custom alarm number. If using the system event number 
for a custom alarm, change the user-defined alarm number accordingly. 
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9.3.2 Working with Alarms 

9.3.2.1 Alarm components and properties

Overview   
You configure the components of alarms in WinCC. The following table shows the basic 
components of alarms:

Alarm
 class

Alarm 
number

Time 
of day

Date Alarm 
status 

Alarm text Alarm
 
group

Tooltip Trigger tag Limit 
value

Warni
ng

1 11:09
:14

06.08.2
007

IO Maximum speed 
reached

2 This alarm is ... speed_1 27

Syste
m

110001 11:25
:58

06.08.2
007

I Switch to "Online" 
mode

0 This alarm is ... PLC-
Variable_1

–

Alarm class  
Alarm classes, such as "Warnings" or "Errors". The alarm class defines the following for an 
alarm: 

● Acknowledgment model

● Appearance in Runtime (e.g. color)

● Logging
 

 Note
Device dependency

Logging is not available for all HMI devices.
 

Alarm number  
An alarm is identified by a unique alarm number. The alarm number is assigned by the system. 
You can change the alarm number to a sequential alarm number, if necessary, to identify 
alarms associated in your project.

Time and date  
Every alarm has a time stamp that shows the time and date at which the alarm was triggered.

Alarm status  
An alarm has the events "Incoming," "Outgoing," "Acknowledge." For each event, a new alarm 
is output with the current status of the alarm. 
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Alarm text  
The alarm text describes the cause of the alarm. 

The alarm text can contain output fields for current values. The values you can insert depend 
on the Runtime in use. The value is retained at the time at which the alarm status changes.

Alarm group  
The alarm group bundles individual alarms. 

Tooltip  
You can configure a separate tooltip for each alarm; the user can display this tooltip in Runtime.

Trigger tag  
Each alarm is assigned a tag as trigger. The alarm is output when this trigger tag meets the 
defined condition, e.g. when its state changes or it exceeds a limit.

Limit value  
Analog alarms indicate limit violations. Depending on the configuration, WinCC outputs the 
analog alarm as soon as the trigger tag exceeds or undershoots the limit value.

See also
Basics on alarm classes (Page 1247)

Alarm states  (Page 1245)

Alarm groups (Page 1253)

Overview of the alarm types (Page 1238)

Overview of the alarm types (Page 1240)
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9.3.2.2 Configuring Alarms

Overview of alarm configuration tasks

Steps to configure alarms         
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.

1. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

2. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.

Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

1. Creating alarm groups
You assign the alarms of your project to alarm groups according to their association, such 
as by the cause of the problem (power failure) or source of the error (Motor 1).

2. Configuring Loop-In-Alarm
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.
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Overview of alarm configuration tasks

Steps to configure alarms         
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.

1. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

2. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.

Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

● Activating and editing system events
You can import system events when you initially open the "System events" tab in the "HMI 
alarms" editor. On completion of the import, you can edit the system events.

● Activating and editing controller alarms
For integrated operation of a project in STEP 7, specify the controller alarms to be displayed 
on your HMI device in the alarm settings.

● Creating alarm groups
Assign the alarms of your project to alarm groups based on their relation, e.g. by error cause 
(e.g. "power failure"), or by error source (e.g. "Motor 1").

● Configuring Loop-In-Alarm
Configure a Loop-In-Alarm in order to change to a screen that contains information about 
an incoming alarm. 
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Configuring Alarm Classes

Creating alarm classes 

Introduction
Create alarm classes in the "Alarm classes" tab of the "HMI alarms" editor. Some default alarm 
classes are already created for every project. You can create additional custom alarm classes. 
You can create up to 32 alarm classes. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure
To create an alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The predefined and existing custom alarm classes are displayed. The following table lists 
the predefined alarm classes:

1. Double-click "<Add>" in the table.
A new alarm class is created. Each new alarm is automatically assigned a static ID.
The properties of the new alarm class are shown in the Inspector window. 

2. Configure the alarm class under "Properties > Properties >General" in the Inspector window.

– Enter a "Name" and the "Display name".

– Depending on the HMI device, you can also activate logging, or automatic sending of e-
mails.

3. Define the acknowledgment model for the alarm class under "Properties > Properties > 
Acknowledgment" in the Inspector window.

4. Change the default text under "Properties > Properties > Status" in the Inspector window.
This text indicates the status of an alarm in Runtime. 

5. Change the default colors under "Properties > Properties > Colors" in the Inspector window. 
Depending on the HMI device, also change the flashing characteristics.

These settings define how alarms from this alarm class are displayed in Runtime.
 

 Note

To display the alarm classes in color in Runtime, the "Use alarm class colors" option must 
be activated. In the project navigation, enable "Runtime settings > Alarms > General > Use 
alarm class colors" accordingly. This option is selected in a new project in WinCC. 
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See also
Basics on alarm classes (Page 1247)

Predefined alarm classes (Page 1248)

Creating alarm classes

Introduction
Create alarm classes in the "Alarm classes" tab of the "HMI alarms" editor. Some default alarm 
classes are already created for every project. You can create additional custom alarm classes. 
You can configure up to 256 alarm classes per project.

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure
To create an alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The predefined custom alarm classes are displayed. A table of the pre-defined alarm 
classes is shown below:

1. Double-click "<Add>" in the table.
A new alarm class is created. Each new alarm class is automatically assigned a static ID.
The properties of the new alarm class are shown in the Inspector window. 

2. Configure the alarm class under "Properties > Properties >General" in the Inspector window:

– Enter a "Name" and the "Display name".

– Activate the"Log" check box if you want to log the alarms from this alarm class.

3. Select "Properties > Properties > Acknowledgment" in the Inspector window to define the 
acknowledgment model for the alarm class and alarm annunciator.
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4. You can edit the default text under "Properties > Properties > Status" in the Inspector 
window.
This text indicates the status of an alarm in Runtime. 

5. You can also change the default background and foreground colors under "Properties > 
Properties > Colors" in the Inspector window.
These settings define how alarms from this alarm class are displayed in Runtime.

Additional settings for alarm classes
Comments in Runtime     

The user enters a comment for an incoming alarm in Runtime, as required. Using the buttons 
of the alarm view, users can show the comments in the "Historical alarm list" display. You can 
configure this function in the alarm class. Enter the user in the "User name" system block.

Assign comments to defined user

To assign the comments to the user logged on, proceed as follows:

1. Select the alarm class.

2. Enable "Properties > Properties > Acknowledgment > Settings > Assign comments to 
defined user" in the Inspector window.
Any user can enter the first comment if a comment has yet to be entered. 
When the first comment has been entered, all other users have read-only access to it.

Use comment of the incoming alarm

Whenever the status of an alarm changes, for example, from "incoming" to "acknowledged" 
status, the alarm is output once again with another status. The user only assigns comments 
to one incoming alarm. To include comments for alarm output with the new status, proceed as 
follows:

1. Select the alarm class.

2. Enable "Properties > Properties > Acknowledgment > Settings > Use comment of the 
incoming alarm" in the Inspector window.

See also
Configuring alarm acknowledgment (Page 1346)

Configuring acknowledgment of the alarm annunciator (Page 1349)

Basics on alarm classes (Page 1247)

Predefined alarm classes (Page 1248)

Using common alarm classes

Introduction
Project-wide alarm classes are displayed under "Shared data > Alarm classes" in the project 
navigation. Create additional common alarm classes in WinCC. 
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Controller alarms are assigned to common alarm classes. If you work with controller alarms, 
common alarm classes are automatically loaded in WinCC.

Requirements 
● You have created a project.

Creating project-wide alarm class    
To create a project-wide alarm class, proceed as follows:

1. Double-click "Shared data > Alarm classes" in the project navigation.
The "Project-wide message classes" editor opens in the work area.

2. To create a project-wide message class, double-click in the first empty line of the table 
editor.

3. Specify the name and display name of the alarm class.

4. Select "With acknowledgment" if the alarm class requires acknowledgment.

Assign alarms to a common alarm class   
Proceed as follows to assign an analog or discrete alarm to a common alarm class:

1. In the "HMI alarms" editor, select the alarm that you want to assign to the common alarm 
class.

2. Click "General" in the Inspector window.

3. Click "Shared data > Alarm classes" in the project navigation.

4. Select the common alarm class in the detail view.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1265



5. Drag-and-drop the alarm class to the "Alarm class" selection box or "Alarm class" column 
in the work area of the Inspector window of the alarm.

The system creates a new alarm class that is linked to the common alarm class. The new 
name of the common alarm class is displayed in the "Alarm class" area of the Inspector 
window of the alarm. The display name of the common alarm class is activated for the alarm 
class in your project.

6. Click the "Alarm Class" tab.

7. Check to see whether the display name of the common alarm class is displayed in WinCC.

8. You can change the object name of the alarm class.
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Alternative procedure
To assign an alarm to a common alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The alarm classes are displayed. 

2. Click "Shared data > Alarm classes" in the project navigation. The following table shows 
the common alarm classes:

3. Select the common alarm class in the detail view.

4. Drag-and-drop the alarm class to the "Alarm classes" tab of the "HMI alarms" editor
The system creates a new alarm class that is linked to the common alarm class. The new 
name of the new alarm class in your project is displayed in the "Alarm class" tab.

5. Open the tab with the alarm procedure for the required alarm.

6. Under "General" in the Inspector window, select the alarm and the alarm class linked to the 
common alarm class.

 

 Note
Deleting a common alarm class

If you delete a common alarm class, the linked alarm class is maintained. If necessary, link 
the alarm class with another common alarm class or use it as WinCC alarm class.

 

See also
Basics on alarm classes (Page 1247)

Configuring Alarm Groups

Configuring alarm groups 

Introduction
Create alarm groups on the "Alarm Groups" tab in the "HMI alarms" editor. An alarm group is 
a compilation of single alarms. You assign alarms in an alarm group by association, such as 
cause of the problem or source of the error. If you acknowledge an alarm from this alarm group 
in Runtime, all other alarms in the alarm group are acknowledged automatically.
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Requirement
● You have created a project.

● The "HMI alarms" editor is open.

● The Inspector window is open.

Creating a new alarm group     
1. Click the "Alarm Groups" tab.

The existing alarm groups are displayed. 

2. In the work area of the table, double-click "<Add>" in the first free row.
A new alarm group is created. 

3. You can overwrite the proposed "Name".

Result
An alarm group is created. For the group acknowledgment of alarms in Runtime, assign the 
associated alarms that require acknowledgment to an alarm group.

See also
Alarm groups (Page 1252)

Configuring alarm groups 

Introduction
Create custom alarm groups on the "Alarm Groups" tab of the "HMI alarms" editor. The alarm 
groups from alarm classes are already created on a separate tab. You acknowledge alarms 
from an alarm group together in Runtime. Configure a corresponding group acknowledgment 
button for the alarm group, including an additional button for resetting the acknowledgment bit 
of the acknowledgment tag.

Requirements
● You have created a project.

● The "HMI alarms" editor is open.

● The Inspector window is open.
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Creating a new alarm group  
To create an alarm group, proceed as follows:

1. Click the "Alarm Groups" tab.
The existing alarm groups are displayed.

2. Double-click "<Add>" in the table.
A new alarm group is created.
The properties of the new alarm group are shown in the Inspector window. 

3. In the Inspector window, click "Properties > Properties > General" and enter a name for the 
alarm group.

4. In the Properties window, click "Properties > Properties > Tags" to specify the following 
tags and bits:

– Status tag for visualizing the alarm states of the alarm group

– Acknowledgment tag for acknowledging an alarm group

– Lock tag for visualizing the locked status of an alarm group

– Display suppression tag for filtering alarms in Runtime by plant status

Creating a child alarm group  
To create a child alarm group, proceed as follows:

1. Click the "Alarm Groups" tab.

2. In the work area or in the detail view, select the alarm groups you want to insert as a child 
group.

3. Drag and drop the alarm groups onto another alarm group.
The selected alarm groups become a child group in the hierarchy of this alarm group.

If you want to create a parent group for a hierarchy of alarm groups, drag and drop the entire 
hierarchy to this alarm group.
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Alternative procedure
1. Click the "Alarm Groups" tab.

2. Select the alarm groups for which you want to create a subgroup.

3. In the cell on the left of the selected row, open the shortcut menu and select "Insert child 
element".
A new child alarm group is created.

See also
Alarm Group Basics (Page 1253)

Hierarchical alarm groups (Page 1254)

Tags of an alarm group (Page 1256)

Configuring Alarm Display Suppression (Page 1329)

Tag Bit Assignments (Page 1461)

Configure alarms

Configuring Analog Alarms

Introduction
Analog alarms indicate limit violations. For example, if the speed of a motor drops below a 
certain value, an analog alarm is triggered. 

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.
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Procedure       
To configure an analog alarm, proceed as follows:

1. Click the "Analog alarms" tab.

2. To create a new analog alarm, double-click in the table on "<Add>".
A new analog alarm is created. 

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Format the text character-for-character using the shortcut menu. 
Using the shortcut menu, you can insert output fields for HMI tags, or text from text lists.

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. Configure the tag that triggers the alarm under "Properties > Properties > Trigger > 
Settings".
Do not use trigger tags for anything else.
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Configure limit values for an analog alarm
1. In the Inspector window, click the button  under "Properties > Properties > Trigger > 

Limit > Value".

– To use a constant as limit value, select "Constant".
Enter the required limit value.

– To use a tag as limit value, select "HMI tag".
The  button is shown. Use this button to select the tag you want to use.

 

  Note

If the required tag does not exist in the selection list yet, create it in the object list and 
change its properties later.

 

2. Select the mode:

– "High limit violation": The alarm is triggered when the limit is exceeded.

– "Low limit violation": The alarm is triggered when the limit is undershot.

Optional settings for analog alarms

Setting the delay time    
To set the delay time, proceed as follows:

● Enter a time period in the Inspector window under "Properties > Properties> Trigger > 
Settings > Delay".
The alarm is only triggered when the trigger condition is still present after the delay time 
has elapsed.

Setting the deadband
 

 Note

If a process value fluctuates around the limit, the alarm associated with this fault may be 
triggered multiple times. To prevent this from happening, configure a deadband or delay 
time.     

 

To enter the deadband, follow these steps:

1. Under "Properties > Properties> Trigger > Deadband > Mode", select the change in alarm 
status for which the deadband is to be taken into account.

2. Enter a constant value under "Value".

3. To define the deadband value as a percentage of the limit, set the "in %" check box.
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Automatic reporting    
To print the alarms continuously:

● Select the "Activate" option under "Properties > Properties > Miscellaneous > Report."
 

  Note

Device dependency

Reporting is not available for all HMI devices.
 

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Select "Properties > Properties > Tooltip" in the Inspector window and enter your text.

Configuring event-driven tasks  
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the analog alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Analog alarms (Page 1241)

Output of a tag value in the alarm text (Page 1276)

Configuring trigger for alarm acknowledgment (Page 1344)

Configuring reporting of alarms (Page 1340)

Formatting alarm text (Page 1275)

Output of texts from a text list in an alarm (Page 1277)

Configuring discrete alarms

Introduction
Discrete alarms triggered by the PLC indicate status changes in a plant. They indicate the 
opened or closed state of a valve, for example.

The following sections describes the configuration procedures in the "HMI alarms" editor. You 
can also configure discrete alarms in the "HMI tags" editor.
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Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.

Procedure     
To configure a discrete alarm, proceed as follows:

1. Open the "Discrete alarms" tab.

2. To create a new discrete alarm, double-click in the work area on "<Add>".
A new discrete alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Use the functions of the shortcut menu to format the text on a character-by-character 
basis, or to insert output fields for HMI tags, or texts from the text lists. 

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. In the Inspector window, select the tag and the bit that triggers the alarm under "Properties 
> Properties > Trigger". Note the following information:

– Use the data types "Int" or "UInt" to select an HMI tag.

– Use the data types "Int" or "Word" to select a PLC tag.

– Use trigger tag bits only for alarms.

– Do not use trigger tags for anything else.

– If you want to acknowledge the alarm via the PLC, use this tag also as PLC 
acknowledgment tag.

 

 NOTICE

Note the method used to count bits in the utilized PLC when specifying the bit. For more 
information, refer to the "Communication" section in the PLC Online Help.

 

 Note

If the object does not yet exist in the selection list, create it directly in the object list and change 
its properties later.

 

Status-dependent alarm texts
To display a different text independent of the alarm status, link a text list to the alarm text. You 
control the text list with a tag.
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Additional settings for discrete alarms

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Enter your text under "Properties > Properties > Tooltip".

Configuring event-driven tasks    
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Discrete alarms (Page 1241)

Configuring trigger for alarm acknowledgment (Page 1344)

Configuring reporting of alarms (Page 1340)

Output of texts from a text list in an alarm (Page 1277)

Formatting alarm text (Page 1275)

Formatting alarm text

Requirements
● The "HMI alarms" editor is open.

● An alarm has been created.

Procedure   
To format an alarm text, proceed as follows:

1. Select the alarm to edit.

2. In the Inspector window, select the characters to format under "Properties > Properties > 
General > Alarm text".

3. Select the formatting from the shortcut menu, e.g. "Underscored" or "Uppercase".

Result
The selected characters are displayed in Runtime with the selected formatting. 
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Removing format settings   
To remove all text formats, proceed as follows:

1. In the Inspector window, select the characters whose formatting you want to remove in the 
alarm text.

2. Select "Delete formatting characters" from the shortcut menu.

Result
The selected characters are displayed in unformatted notation in Runtime.

See also
Overview of alarm configuration tasks (Page 1260)

Configuring Analog Alarms (Page 1270)

Configuring discrete alarms (Page 1273)

Output of a tag value in the alarm text (Page 1276)

Output of texts from a text list in an alarm (Page 1277)

Output of a tag value in the alarm text

Introduction   
In WinCC, you can insert output fields into the alarm text which display the content of tags.

Requirements
● The "HMI alarms" editor is open.

● The alarm is selected.

Output of a tag value in the alarm text
To insert an output field for a tag value in the alarm text, proceed as follows:

1. Place the cursor onto the required position in the event text.

2. Select "Insert tag output field" in the shortcut menu.

3. Open the object list under "Tag" and select a tag.
You can also create the tag in the object list.

4. Under "Format", specify the length of the output field and the format for tag value output in 
the alarm text.
Configure an output field of sufficient size. Otherwise, the tag content is not output to the 
full extent in the alarm. 

5. Click  to save your entries.
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WinCC inserts a placeholder for the output field into the alarm text: "<tag: n, [tag name]>" 
whereby n = text string length.

Editing output field properties
To edit the properties of an output field, proceed as follows:

● Double-click on the output field in the alarm text and edit the settings.

Deleting an output field from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

 

 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log.

Device dependency

Logging is not available for all HMI devices.
 

See also
Configuring Analog Alarms (Page 1270)

Formatting alarm text (Page 1275)

Output of texts from a text list in an alarm (Page 1277)

Output of texts from a text list in an alarm

Introduction   
Text lists are used to create dynamic alarm texts. For example, you can configure the output 
of both states of a discrete alarm in an alarm text. 

Insert a corresponding output field in the alarm text and specify the tag that returns the search 
key for the text list. 
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Requirements
● A text list is created.

● The "HMI alarms" editor is open

● The alarm is selected

Output of a text list value in an alarm text
To insert an output field for a value from a text list in the alarm text, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. Select "Insert text list output field" command from the shortcut menu.

3. Select the text list under "Text list".

4. Open the object list under "Tag" and select the tag that returns the search key for the text 
list.
You can also create the tag in the object list.

5. Define the length of the output field under "Format".
Configure an output field of sufficient size so that the complete text from the text list is 
displayed in the alarm.

6. Click on the  icon to save your entries.
WinCC inserts a placeholder for the output field into the alarm text: 
""<textlist: n, [textlist name]>" whereby n = text string length.

Editing output field properties
To edit the properties of an output field, proceed as follows: 

● Double-click on the output field in the alarm text and edit the settings.

Deleting text list from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

See also
Formatting alarm text (Page 1275)

Configuring Analog Alarms (Page 1270)

Configuring discrete alarms (Page 1273)

Output of a tag value in the alarm text (Page 1276)
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Editing system events

Editing system events   
When you open the "System events" tab in the "HMI alarms" editor, WinCC prompts you to 
import or update the system events. Import the system events and specify the display period. 
You cannot delete or create new system events. You can only edit the alarm text with system 
events. 

Requirements
● You have imported the system events.

Specifying the display period
To determine the display period, proceed as follows:

1. Double-click "Runtime settings" in the project navigation.

2. Enter a value under "Alarms > System events > Display period".
This value specifies a time in seconds during which the system events are displayed on 
the HMI device. If you want to display system events permanently, enter "0".

Changing the alarm text
To change the alarm text of a system event, follow these steps:

1. Open the "HMI alarms" editor and then click the "System events" tab.

2. Select the system event that you want to edit.

1. Change the alarm text under "Properties > Properties > Properties > General" in the 
Inspector window.

 

 NOTICE

If you change an alarm text for a system event that contains a placeholder, leave the number 
of placeholders unchanged. A placeholder may be a "%1".

 

Configuring event-driven tasks
The "Incoming" event is available for certain system events, depending on the HMI device. To 
configure event-driven tasks, proceed as follows:

1. Select the system event.

2. Select "Properties > Properties > Incoming" in the inspector window and configure a function 
list.
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See also
Overview of alarm configuration tasks (Page 1261)

System events (Page 1244)

Editing controller alarms

Introduction
Controller alarms are configured in STEP 7. Controller alarms are available in WinCC running 
in a STEP 7 environment. 

In WinCC you only edit the properties of controller alarms that are specific to an HMI device. 
Different properties of a controller alarm can be edited, depending on the HMI device and PLC.

You can filter the displayed controller alarms for your project using the display classes that 
were configured on the PLC for controller alarms.

Requirements
● The connection was established to the PLC.

● Alarms were configured in STEP 7.

Editing controller alarms
Proceed as follows to edit controller alarms:

1. Double-click "HMI alarms" in the project navigation.
The "HMI alarms" editor is opened.

2. Open the "Controller alarms" tab.

3. Select the alarm that you want to change in the work area.

4. Make your changes. Depending on the HMI device, it may not be possible to display or 
enable some of the controller alarm properties.

Editing SIMATIC S7 alarms
You can edit these controller alarms in the STEP 7 alarm configuration system. To do this, 
proceed as follows:

1. Select the alarm that you want to change in the work area.

2. Select "Open in alarm editor of the PLC" from the shortcut menu.
The STEP 7 alarm configuration system is opened.

3. Make your changes.
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Filtering the controller alarm using display classes
To filter controller alarms by display classes, proceed as follows:

1. Click "Runtime settings > Alarms" in the project navigation under your HMI device.
One or several connections to a PLC are shown in "Contoller alarms".

2. Select the display classes whose controller alarms you want to display for the connection.

Result
Only those controller alarms whose display class you have enabled for your HMI device will 
be displayed on the "Controller alarms" tab of the "HMI alarms" editor.

See also
Controller alarms (Page 1242)

Enabling system-defined controller alarms

Enabling system-defined controller alarms   
To activate system-defined controller alarms for your HMI device, proceed as follows:

1. Select "Runtime settings > Alarms" in the project navigation.
The alarm settings open.

2. Under "System events" activate the system-defined controller alarms.

3. To display the system events with alarm text, activate "With text".

4. To display these alarms in Runtime, configure an alarm view that displays alarms from the 
"Diagnosis Events" alarm class.

 

  Note

For HMI devices with small display units, specify to display only the alarm number for 
system-defined controller alarms.

 

 

See also
System-defined controller alarms (Page 1244)
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Configure alarms

Configuring alarm blocks

Alarm Text Block Basics

Introduction
An alarm display is made up of alarm text blocks. Each alarm text block corresponds to one 
column in the table in the alarm view.

There are three groups of alarm text blocks:

● System blocks 
System blocks contain system data, such as date, time, alarm number and status.

● User text blocks 
User text blocks contain the alarm text with the description of the cause of a fault and 
additional text with information, for example, the location of a fault.

● Parameter blocks 
Parameter blocks are used to link the alarms to process values, such as current fill levels, 
temperatures or speeds. You can configure up to 10 parameter blocks per alarm.

Configuring Alarm Text Blocks
You enable and edit the alarm text blocks on the "Alarm text blocks" tab. To display alarm text 
blocks in an alarm view, select the alarm text blocks to be displayed and logged from the 
enabled alarm text blocks in the "Screens" editor.

Properties of Alarm Text Blocks

Text length
The maximum text length of a user text block is 255 characters.

The text length of a parameter block can be configured as follows:

● Controller alarms: up to 32 characters
Set the length of the parameter block to 32 characters to ensure that all characters will be 
displayed.

● Other alarm procedures: up to 255 characters
 

  Note
"Status" system block

The status texts of the alarms are displayed in the "Status" system block. This system 
block must be configured so that it is long enough to display the status texts in full.
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Flashing
An alarm to be acknowledged or single alarm text blocks can be displayed as flashing in 
Runtime. They have to meet the following requirements:

● The "Flashing" property must be enabled in the alarm class of the alarm. You configure this 
property on the "Alarm classes" tab.

● The "Flashing" option is enabled in the "Alarm text block" area under "General" in the 
Inspector window for alarm text blocks that should flash.

Alignment
On the "Alarm text blocks" tab, you define whether the alarm text block should be right-justified, 
left-justified or centered in an alarm view column. 

Format
For certain alarm text blocks, you can choose between different display formats. 

See also
Setting up flashing alarm text blocks (Page 1284)

Configuring Alarm Text Blocks

Introduction
An alarm is made up of configured alarm text blocks. You enable the alarm text blocks for an 
HMI device on the "Alarm text blocks" tab. Then you select, from the enabled alarm text blocks 
for each alarm view, which enabled alarm text blocks are to be displayed and logged.

Requirements
● The "HMI alarms" editor is open.

● The "Alarm text blocks" tab is selected.

Activating alarm text blocks     
1. Select the "System blocks", "User text blocks" or "Parameter blocks" tab for the alarm text 

blocks.

2. Select the alarm text block to be displayed on your HMI device.

3. In the Inspector window, select "Properties > Properties > General > Alarm text block > 
Enable".

4. Under "Properties > Properties > General > Alarm text block" in the Inspector window, 
define the text length and alignment of the alarm text block in the alarm view column.

5. In the Inspector window under "Properties > Properties > Settings > Format", select the 
format of the alarm text block. This option is not available for every alarm text block.
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Under "Shared data > Text lists" in the project navigation, define the display names for the 
user text blocks. 

Result
The alarm text blocks are enabled and displayed in the Inspector window of the alarm view in 
the "Screens" editor. 

Disabling alarm text blocks
1. Select the tabs for the alarm text blocks that you want to disable.

2. Disable the alarm text blocks that you no longer want to use for alarm view and alarm 
logging.

3. Repeat the process for every alarm text block that you no longer want to display.

See also
Description of the System Blocks (Page 1414)

Setting up flashing alarm text blocks (Page 1284)

Setting up flashing alarm text blocks

Introduction
Whether or not an alarm text block flashes in Runtime depends on the alarm class of the alarm. 
The alarm class determines if the alarms it contains flash when acknowledgment is pending. 

Requirements
● The alarms blocks are enabled for the HMI device.

● The alarms blocks are enabled for the respective alarm.

● The alarm is assigned to an alarm class with an acknowledgment model, which specifies 
whether or not the contained alarms are to flash.

● The alarm text blocks are activated in the alarm view.

● The "Alarm text blocks" tab is selected.
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Procedure
To configure flashing for alarm text blocks in Runtime, proceed as follows:

1. Select the alarm text block to flash in Runtime from the subordinate tabs on the "Alarm text 
blocks" tab.

2. In the Inspector window, select "Properties > Properties > General > Alarm text block > 
Flash".

3. Repeat this step for all the alarm text blocks that you want to flash in Runtime.

Result
These alarm text blocks flash in Runtime when the alarm is queued for acknowledgment. 

See also
Alarm Text Block Basics (Page 1282)

Configuring Alarm Text Blocks (Page 1283)

Configuring analog alarms

Configuring analog alarms

Introduction
In the "HMI alarms" editor, you can configure analog alarms and define their properties. You 
can also configure analog alarms in the "HMI tags" editor. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure         
To configure an analog alarm, proceed as follows:

1. Click the "Analog Alarms" tab.

2. To create a new analog alarm, double-click in the table on "<Add>".
A new analog alarm is created. 

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.
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4. To display the CPU number or PLC that sends the alarm, enter this under "Connection to 
the PLC". This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks > System blocks" tab.

5. In the Inspector window, select the tag that triggers the alarm under "Properties > Properties 
> Trigger". Do not use trigger tags for anything else.

6. To configure the alarm text, select "Properties > Properties > Alarm texts".

– To enter the alarm text, select "Alarm text".

– To create additional alarm texts, select "Additional texts".

– Use the functions of the shortcut menu to format text on a character-by-character basis 
and to insert output fields for system or alarm parameters.

 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.

 

Defining limits
1. Select the analog alarm to which you want to assign the limits.

2. On the  bottom of the work area, click <Add> under "Limits for analog alarm".
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3. To use a constant as limit:

– In the Inspector window, click the button  under "Properties > Properties > Trigger 
> Value" and select "Constant".

– Enter the required limit value.

4. To use a tag as limit:

– In the Inspector window, click the button  under "Properties > Properties > Trigger 
> Value" and select "HMI tag".

– Click the button. The object list opens.

– Select the tag.

5. Select the trigger mode in the "Mode" field.

– "Equal to limit": The alarm is triggered when the limit is reached.

– "Not equal to limit": The alarm is triggered when the limit is no longer reached.

– "High limit violation": The alarm is triggered if the limit is exceeded.

– "Low limit violation": The alarm is triggered if the limit is undershot.

6. You can create additional limits for the alarm, if necessary.
 

  Note

If the object included in the selection does not yet exist, create it in the object list and 
change its properties later.

 

  Note

If a process value fluctuates around the limit, the alarm associated with this fault may be 
triggered multiple times. In this case, configure a deadband or delay time.

 

Optional settings for analog alarms
Setting the delay time     

To display an alarm after a delay, proceed as follows:
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1. Select the analog alarm.

2. In the Inspector window, select "Properties > Properties > Trigger".

3. Enter a time period under "Delay". The trigger condition must be fulfilled within this time for 
the alarm to be triggered.

Setting the deadband     

Proceed as follows to enter a tolerance range for the arrival or departure of an alarm:

1. Select the limit to which the deadband is to be assigned.

2. In the Inspector window, select "Properties > Properties > Trigger".

3. Under "Deadband > Mode", select the change to the alarm status to include in the evaluation 
of the deadband.

4. Enter a constant under "Deadband > Value".

5. To define the deadband value as a percentage of the limit, activate the "%" check box.

Saving the status of the alarm

To save the alarm states to a tag, proceed as follows: 

1. Select the analog alarm.

2. Under "Properties > Properties > Status" in the Inspector window, select the tag and the 
bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Setting the priority     

To set the priority, proceed as follows:

1. Select the analog alarm.

2. Select a value between 0 and 16 under "Properties > Properties > General > Priority" in 
the Inspector window, .
If you filter the alarm view by priority, the alarm with priority 0 will appear at the top.

Creating an info text     

1. Select the analog alarm.

2. Select "Properties > Properties > Tooltip" in the Inspector window and enter a text.

Configuring event-driven tasks     

To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the analog alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.
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See also
Configuring acknowledgment of the alarm annunciator (Page 1349)

Configuring reporting of alarms (Page 1342)

Configuring alarm acknowledgment (Page 1346)

Parameter output in the analog alarm (Page 1289)

Configuring loop-in alarms (Page 1302)

Alarms in the "HMI tags" Editor (Page 1303)

Configuring Alarm Display Suppression (Page 1329)

Overview of alarm configuration tasks (Page 1261)

Parameter output in the analog alarm

Introduction
To display system or alarm parameters, insert an appropriate output field in the analog alarm. 

● "Limit", "Deadband" or "Current Value" can be selected as alarm parameters.

● The following system blocks can be selected as system parameters: 

– User Name

– Computer name

– Comments

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The analog alarm is selected.

Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To output an alarm parameter, select "Insert parameter output field in analog alarm" from 
the shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Specify the length, number of decimal places, tolerance, and alignment of the output field 
for alarm parameters.
To display leading zeros in the output field, enable "Leading zeros".

4. Click  to save your entries.
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WinCC inserts a placeholder for the output field into the alarm text:

● For alarm parameters: "<tag: n, [###]>" whereby n = text length in characters.

● For system parameters; "<name of the system parameter>"
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.

 

Deleting parameter from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

 

 Note

The sequence of output fields in the alarm text depends on the language. The sequence of 
the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

Configuring discrete alarms

Configuring discrete alarms

Introduction
Discrete alarms triggered by the PLC indicate status changes in a plant. They indicate the 
opened or closed state of a valve, for example.

The following sections describes the configuration procedures in the "HMI alarms" editor. You 
can also configure discrete alarms in the "HMI tags" editor.

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.
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Procedure
To configure a discrete alarm, proceed as follows:

1. Click the "Discrete alarms" tab.

2. To create a new discrete alarm, double-click on "<Add>" in the table.
A new discrete alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.

– To display the CPU number or PLC that sends the alarm, enter these in the "Connection" 
area. This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks" tab.

4. Select "Properties > Properties > Trigger" in the Inspector window to select the tag and the 
bit that triggers the alarm. Note the following information:

– Use data types "Bool" "USInt", "UInt", or "UDInt".

– Use trigger tag bits only for alarms.

– Do not use trigger tags for anything else.
 

 Note

If the object does not yet exist in the selection list, create it directly in the object list and change 
its properties later.

 

 Note

The trigger bit is not incremented automatically if you generate a discrete alarm by copying 
an alarm text to a new table row. Avoid any redundant use of the trigger bit. 

 

 NOTICE

Note the method used to count bits in the utilized PLC when specifying the bit. For more 
information, refer to the "Communication" section in the PLC Online Help.

 

1. Select "Mode" to specify whether to trigger the alarm at a rising or falling edge.

2. To configure the alarm text, select "Properties > Properties > Alarm texts".

– To enter the alarm text, select "Alarm text".

– To create additional alarm texts, select "Additional texts".

– Use the functions of the shortcut menu to format text on a character-by-character basis 
and to insert parameter output fields.

 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.
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Result
The discrete alarm is created.

Additional settings for discrete alarms
Creating an info text     

To configure a tooltip for the alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Properties > Info text" in the Inspector window and enter the required 
tip.

Enabling discrete alarm parameters

To output process values to an output field in the alarm text, assign corresponding tags to the 
parameter blocks. Proceed as follows:     

1. Select the alarm.

2. In the Inspector window, click "Properties > Properties > Alarm parameters".

3. Enter a value for the alarm parameter, or select a tag.

4. You can enter several alarm parameters.
Insert the activated process values as selection box into an alarm text, or show them as 
parameter block in the alarm view. 

 

  Note

To show the process values as parameter blocks, the parameter blocks must be enabled 
in the alarm view.

You only edit parameters that you have enabled under "Parameter blocks" on the "Alarm 
text blocks" tab.

 

Saving the alarm status     

To save the alarm states to a tag, proceed as follows: 

1. Select the discrete alarm.

2. Under "Properties > Properties > Status" in the Inspector window, select the tag and the 
bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Configuring event-driven tasks     

To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.
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See also
Alarms in the "HMI tags" Editor (Page 1303)

Configuring Alarm Display Suppression (Page 1329)

Configuring alarm acknowledgment (Page 1346)

Configuring acknowledgment of the alarm annunciator (Page 1349)

Configuring loop-in alarms (Page 1302)

Configuring reporting of alarms (Page 1342)

Overview of alarm configuration tasks (Page 1261)

Parameter output in discrete alarms

Introduction
To display system or alarm parameters, insert an appropriate output field in the analog alarm. 

● You can select the parameters configured in "Properties > Properties > Alarm parameters" 
for use as alarm parameters.

● The following system blocks can be selected as system parameters: 

– User Name

– Computer name

– Comment

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The discrete alarm is selected.

Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To enable the output an alarm parameter, select "Insert parameter output field" from the 
shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Select the parameter.
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4. Moreover, you can specify the following data for alarm parameters:

– The tag that provides the parameter values.
Enter the tag you configured for the parameter in "Properties > Properties > Alarm 
parameters". If you select a different tag, WinCC updates the parameter configuration 
in "Properties > Properties > Alarm parameters" accordingly.

– The length, number of decimal places, precision, and alignment of the output field

– To display leading zeros in the output field, enable "Leading zeros".

5. Click  to save your entries.
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.

 

 

 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

See also
Configuring discrete alarms (Page 1290)

Configuring discrete alarms (Page 1303)

Configuring user alarms

Configuring user alarms

Introduction
User alarms serve to to indicate operator actions in Runtime. User alarms are triggered by 
means of alarm number. For other custom applications, configure user alarms that are 
triggered in Runtime by means of scripts. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.
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Procedure
To configure user alarms, proceed as follows:

1. Click the "User alarms" tab.

2. To create a new user alarm, double-click "<Add>" in the table.
A new user alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.

– To display the CPU number or PLC that sends the alarm, enter these in the "Connection" 
area. This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks" tab.

4. Click "Alarm texts" in the Inspector window and configure the alarm text.

– Enter the alarm text.

– To create additional alarm texts, select "Additional texts".

– You can insert output fields or or additional text into the alarm text.
 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.

 

Result
The user alarm is created.

Additional settings for user alarms
Creating a tooltip     

To configure a tooltip for the alarm, follow these steps:

1. Select the user alarm.

2. Select "Properties > Properties > Tooltip" in the Inspector window and enter your text.

Enabling user alarm parameters

To output process values to an output field in the alarm text, assign corresponding tags to the 
parameter blocks. Proceed as follows:     
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1. Select the alarm.

2. In the Inspector window, click "Properties > Properties > Alarm parameters".

3. You can enter several alarm parameters.
Insert the activated process values as selection box into an alarm text, or show them as 
parameter block in the alarm view. 

 

  Note

To show the process values as parameter blocks, the parameter blocks must be enabled 
in the alarm view.

You only edit parameters that you have enabled under "Parameter blocks" on the "Alarm 
text blocks" tab.

 

Saving the alarm status     

To save the alarm states to a tag, proceed as follows: 

1. Select the user alarm.

2. Select "Properties > Properties > Status" in the Inspector window and select the tag and 
the bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Configuring event-driven tasks     

To configure event-driven tasks, proceed as follows:

1. Select the user alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Configuring acknowledgment (Page 1346)

Configuring alarm blocks (Page 1282)

Configuring Alarm Display Suppression (Page 1329)

Configuring alarm acknowledgment (Page 1346)

Configuring acknowledgment of the alarm annunciator (Page 1349)

Parameter output in user alarms

Introduction
To display system or alarm parameters, insert an appropriate output field in the user alarm. 
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● You can select the parameters configured in "Properties > Properties > Alarm parameters" 
for use as alarm parameters.

● The following system blocks can be selected as system parameters:

– User Name

– Computer name

– Comment

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The user alarm is selected.

Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To enable the output an alarm parameter, select "Insert parameter output field" from the 
shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Select the parameter.

4. Moreover, you can specify the following data for alarm parameters:

– The tag that provides the parameter values.
Enter the tag you configured for the parameter in "Properties > Properties > Alarm 
parameters". If you select a different tag, WinCC updates the parameter configuration 
in "Properties > Properties > Alarm parameters" accordingly.

– The length, number of decimal places, precision, and alignment of the output field

– To display leading zeros in the output field, enable "Leading zeros".

5. Click  to save your entries.
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.
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 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

Configuring alarm text

Introduction
The alarm text for an alarm is made up of the alarm text, additional texts and output fields. The 
alarm text and additional texts are user text blocks. You can use up to 10 user text blocks for 
an alarm.  

Each alarm text contains up to 255 characters and any number of output fields.

Requirements
● The "HMI alarms" editor is open.

● You have enabled user text blocks on the "Alarm text blocks" tab.

● An alarm has been created.

Procedure 
Proceed as follows to assign additional user text blocks to the alarm text for an alarm:

1. Select the alarm that you want to edit on the relevant tab.

2. To enter the alarm text, select "Properties > Properties > Alarm text" in the Inspector 
window. 

3. You can also add output fields to the alarm text.

4. To enter additional alarm texts, select "Properties > Properties > Alarm text > Additional 
text" in the Inspector window.
Enter more additional texts according to which user text blocks you enabled under "User 
text blocks" on the "Alarm text blocks" tab. 

 

  Note

Use the scroll buttons  to view text that is not fully visible in the text box. The additional 
text lines are displayed.
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Result
You have configured the alarm text with additional texts for this alarm. To display it in Runtime, 
enable these user text blocks in an alarm view. 

See also
Configuring analog alarms (Page 1285)

Configuring discrete alarms (Page 1290)

Editing system events

Introduction  
System events can only be changed to a limited extent. You cannot delete or create new 
system events. 

Requirements
● You have imported the system events.

● The "HMI alarms" editor is open.

Procedure
To configure system events, proceed as follows:

1. Click the "System events" tab.

2. Select the system event that you want to edit.

3. Change the editable properties in the Inspector window.

4. Select the system event that you want to edit.

5. Change the editable properties in the Inspector window.

Configuring event-driven tasks
To configure event-driven tasks, proceed as follows:

● To configure a function list for the relevant event, select "Properties > Events".

Editing controller alarms

Introduction
Controller alarms are configured in STEP 7. Controller alarms are available in WinCC running 
in a STEP 7 environment. 
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In WinCC you only edit the properties of controller alarms that are specific to an HMI device. 
Different properties of a controller alarm can be edited, depending on the HMI device and PLC.

You can filter the displayed controller alarms for your project using the display classes that 
were configured on the PLC for controller alarms.

Requirements
● The connection was established to the PLC.

● Alarms were configured in STEP 7.

Editing controller alarms
Proceed as follows to edit controller alarms:

1. Double-click "HMI alarms" in the project navigation.
The "HMI alarms" editor is opened.

2. Open the "Controller alarms" tab.

3. Select the alarm that you want to change in the work area.

4. Make your changes. Depending on the HMI device, it may not be possible to display or 
enable some of the controller alarm properties.

Editing SIMATIC S7 alarms
You can edit these controller alarms in the STEP 7 alarm configuration system. To do this, 
proceed as follows:

1. Select the alarm that you want to change in the work area.

2. Select "Open in alarm editor of the PLC" from the shortcut menu.
The STEP 7 alarm configuration system is opened.

3. Make your changes.

Filtering the controller alarm using display classes
To filter controller alarms by display classes, proceed as follows:

1. Click "Runtime settings > Alarms" in the project navigation under your HMI device.
One or several connections to a PLC are shown in "Contoller alarms".

2. Select the display classes whose controller alarms you want to display for the connection.

Result
Only those controller alarms whose display class you have enabled for your HMI device will 
be displayed on the "Controller alarms" tab of the "HMI alarms" editor.

See also
Controller alarms (Page 1242)
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Configuring Operator Input Alarms for an Alarm View

Introduction
Operator input alarms for the alarm view are preconfigured system alarms. Manage system 
alarms using the "HMI alarms" editor.In the "Screens" editor, configure the trigger conditions 
for operator input alarms for the alarm view.

Requirement
● You have imported the system alarms from the HMI device.

● The "Screens" editor is open.

● An "Alarm view" object has been created. 

● Alarm text blocks are activated in the "HMI alarms" editor.

Procedure
To configure operator input alarms for an alarm view, proceed as follows:

1. Select the alarm view.

2. In the Inspector window, click "Properties > Properties > Operator input alarms".

3. Activate the operator action at the alarm view for which an operator input alarm is to be 
output.
The alarm number of the preconfigured operator input alarm for this operator action is 
displayed in the "Alarm number" output field. 

4. To output another alarm for this operator action, enter the alarm number of this alarm.

5. To specify the columns to display in the operator input alarm, click the  button in "Alarm 
text blocks".
A dialog opens. 

6. To enable the alarm text blocks to be output with the operator input alarm, select "Alarm 
text blocks".

7. Select "Alarm group of operator input alarm" to specify the alarm text blocks to be output 
with the system alarm.Under "Output as", define whether the content of the alarm text block 
should be output as text or as a value.

 

  Note

You will find the system alarm and its alarm number on the "System alarms" tab in the 
"HMI alarms" editor.

 

Result
The configured operator input alarm is displayed when the user performs an action on the 
alarm view in Runtime. 
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Configuring loop-in alarms

Introduction
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.   

Requirements
● The screen called by the Loop-In-Alarm has been created.

● The "HMI alarms" editor is open.

Procedure
To configure a Loop-In-Alarm for an alarm, proceed as follows:

1. Click the tab that contains the alarm for which you want to configure the Loop-In-Alarm.

2. Select the alarm.

3. In the Inspector window, select "Properties > Events > Loop-In-Alarm".

4. Select the "ActivateScreen" system function.

5. Select the screen called by the Loop-In-Alarm  as parameter.

 

  Note

To configure the Loop-In-Alarm for an alarm view with an "alarm line" format, use the 
following system functions:
● "EditAlarm" for HMI devices with keys
● "AlarmViewEditAlarm" for HMI devices without keys

The system functions trigger the "Loop-In-Alarm" event. The alarm line has no buttons.
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Result
If you click on the "Loop-In-Alarm" button of the alarm view in Runtime, a screen is opened 
with information on the selected alarm.

See also
Using the Alarm Window, Alarm View (Page 1384)

Basic alarm view, using the alarm window (Page 1387)

Alarm view (Page 1393)

Configuring analog alarms (Page 1285)

Configuring discrete alarms (Page 1290)

Alarms in the "HMI tags" Editor

Configuring discrete alarms

Introduction
In WinCC, you can create and edit discrete and analog alarms, including the trigger tags, in 
the "HMI tags" editor. 

 

 Note

If you delete, move or copy objects in the "HMI tags" editor, the changes also take effect in 
the "HMI alarms" editor.

 

Requirements
The "HMI tags" editor is open.

Procedure    
To configure a discrete alarm, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

– Use the data types "Int" or "UInt" to select an HMI tag.

– Use the data types "Int" or "Word" to select a PLC tag.

3. Select the tag at the top of the work area.

4. Click on "<Add>" in the table on the "Discrete alarms" tab at the bottom of the work area.
A new discrete alarm is created for the tag. If you have selected the incorrect data type, 
the tag will be marked in the discrete alarm.
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5. Configure the discrete alarm in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".
You can also insert output fields into the alarm text.

– Select an alarm class.

– Select the trigger bit of the tag that triggers the discrete alarm under "Properties > 
Trigger".

6. You can create additional discrete alarms to monitor the tags.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.

 

Result
The configured discrete alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 

See also
Configuring discrete alarms (Page 1273)

Working with Tags (Page 984)

Parameter output in the analog alarm (Page 1289)

Configuring analog alarms

Introduction
In WinCC, create the discrete and analog alarms, including the trigger tags, in the "HMI tags" 
editor. You can also edit the alarms as in the "HMI alarms" editor. You can create up to two 
range values for a tag. You monitor these limits with analog alarms.

Requirements
The "HMI tags" editor is open.
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Procedure   
To configure an analog alarm in the "HMI tags" editor, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

3. In the Inspector window, configure the range values of the tags under "Properties > 
Properties > Range":

– Select whether to use a "Constant" or an "HMI tag" as limit value for your range values. 
The object list opens when you select "HMI tag". Select the tag you want to use.

1. Click the "Analog Alarms" tab at the bottom of the work area.
Create an analog alarm for both range values.

2. Select an analog alarm and configure it in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".

– You can also insert output fields into the alarm text.

– You can change the default alarm class.

3. Configure the analog alarms as in the "HMI alarms" editor.

4. Complete the configuration of all analog alarms.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.

 

Result
The configured analog alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 
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See also
Working with Tags (Page 984)

Parameter output in the analog alarm (Page 1289)

Configuring analog alarms (Page 1285)

9.3.2.3 Configuring the Outputting of Alarms

Overview of configuring alarm output

Steps to complete when configuring alarm output   
You configure the alarm output in WinCC in the following steps:

1. Create alarm view
Use the display and control objects in the "Screens" editor to display alarms in Runtime. 
You can also configure an alarm view for logged alarms.

2. Configure acknowledgment
In the "Screens" editor, you can set the operator action that will trigger the acknowledgment. 

3. Configure reporting
You can create reports in the "Reports" editor to print alarms in Runtime. In the "Scheduler", 
"Screens", "HMI alarms" or "HMI tags" editors, you define when and how the printing of a 
report is triggered. 

 

  Note

Device dependency

Reporting and logging are not available for all HMI devices.
 

Additional configuration tasks
Additional tasks may be necessary for configuring alarm views, depending on the requirements 
of your project:

1. Setting up authorizations
To make sure only authorized operators process the alarms, assign authorizations for the 
alarm view and the function keys of the HMI device.

2. Configuring the filtering of the alarm view
You configure the filtering of the alarms in Runtime in the "Screens" editor. You can also 
configure alarm views that only display selected alarms.

3. Configure operator input alarms
Configure the operator input alarms on the operator controls of the HMI device in the 
"Screens" editor. A preconfigured operator input alarm is output for an operator action. An 
operator input is, e.g. the acknowledgment of an alarm.
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See also
Configuring the alarm view (Page 1307)

Configuring the alarm view (Page 1320)

Reporting Alarms (Page 1340)

Configuring the alarm view

Displaying Alarms

Options for displaying alarms on the HMI device
WinCC offers the following options for displaying alarms on the HMI device: 

● Alarm view
The alarm view is configured in a screen. More than one alarm can be displayed 
simultaneously, depending on the configured size. You can configure multiple alarm views 
with different contents.

● Alarm window
The Alarm window is configured in the "Global screen" editor. The alarm window can display 
multiple alarms at the same time, depending on the configured size. An event can trigger 
closing and reopening of the alarm window. To hide it during configuration, create an alarm 
window on its own level.
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Additional signals
● Alarm indicator

The alarm indicator is a configurable, graphical icon. When an alarm comes in, the alarm 
indicator is displayed on the HMI device. You configure the alarm indicator in the "Global 
screen" editor.
The alarm indicator has two states:

– Flashing: At least one alarm that requires acknowledgment is pending.

– Static: The alarms are acknowledged but at least one of them has not gone out yet.
The alarm indicator also displays the number of pending alarms according to the HMI 
device.

● E-mail notification
To inform someone other than the operator, such as an engineer, when an alarm with a 
specific alarm class arrives, assign the alarm class to an e-mail address.

 

  Note
Device dependency

E-mail notification is not available for all HMI devices.
 

● System functions
You can configure a list of functions for the event associated with an alarm. These functions 
must be executed in Runtime when the event occurs. 
Use system functions for alarms in WinCC to control the alarm view or the alarm window 
other than via the toolbar.

Displaying the predefined alarm classes in Runtime  
The following table shows the symbols used to display the predefined alarm classes in the 
alarm view:

Alarm class Displayed icon
"Diagnosis Events" S7
"Errors" !
"System" $
"Warnings" <No symbol>

See also
System functions for alarms (Page 1410)
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Configuring an alarm view

Configuring an alarm view for active alarms

Introduction
Current alarms are displayed in Runtime in an alarm view or alarm window.

Requirement
● A screen is open in the "Screen" editor.

● The "Tools" task card is open.
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Configuring alarms for the alarm view   
To specify the alarms that will be shown in the alarm view, proceed as follows:

1. Insert an "Alarm view" object from the "Tools" task card into the screen.

2. Select the alarm view.

– In the Inspector window, select "Properties > Properties > General > View > Current 
alarm states".
Set whether to display alarms with and/or without mandatory acknowledgment.

– To display all alarms in the alarm buffer, enable "Alarm buffer".
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3. In the table, activate the alarm classes to be displayed in the alarm view.

4. Under ""Properties > Properties > View > Control tag for display area", define the tag that 
returns the date as of which the alarms will be displayed.

 

  Note
Device dependency

The "Control tag for display area" property is not available for all HMI devices.
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Configuring the layout of the alarm view   
To specify how the alarms are shown in the alarm view, proceed as follows.

1. Under "Properties > Properties > Layout > Settings > Lines per alarm" in the Inspection 
window, specify the number of lines to display for each alarm.

2. In "Properties > Properties > View", select the control elements that are available on the 
HMI device.

3. Configure the columns under "Properties > Properties > Columns":

– Under "Visible columns" select the columns to be output in the alarm view.

– Under "Properties Column", define the properties of the columns.

– Under "Sort", select the sorting order of the alarms.

 

  Note

Select the "Edit" command in the shortcut menu for the alarm view to activate the alarm 
view. You can set the column width and position in active mode. To enable the alarm 
view, set the zoom factor to 100 %.

The alarm view is deactivated as soon as you deselect the object in the screen.
 

Result
Alarms of various alarm classes are output in the alarm view during runtime. 

See also
Creating alarm classes  (Page 1262)

Configuring an alarm window (Page 1314)

Displaying Logged Alarms (Page 1319)
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Configuring an alarm view for the S7 diagnostic alarms

Introduction   
To display S7 diagnostic alarms, configure an alarm view or alarm window for the predefined 
"Diagnosis Events alarm class. Activate the diagnostic alarms accordingly in the Runtime 
settings of your HMI device.

 

 Note
HMI device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● A connection to the PLC is set up.

Configuring the display of S7 diagnostic alarms   
To configure the display of S7 diagnostic alarms, follow these steps:

1. Select "Runtime settings > Alarms > System events > S7 diagnostics alarms" in the project 
navigation.

2. To display the S7 diagnostics alarms with text, activate "With text".

3. Open the screen with the alarm view and select the alarm view.

4. In the Inspector window, select "Properties > Properties > General > Display > Alarm class 
"Diagnosis Events".

5. Continue to configure the alarm view as for the display of current alarms.
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Result
In Runtime the alarm view displays the S7 diagnostic alarms of the controller. 

Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime, the logged alarms are output in the alarm view. 

Configuring an alarm window

Introduction
The alarm window displays current alarms. The alarm window is configured in the "Global 
Screen" editor and opens regardless of the current screen. The HMI device can still be used, 
even if alarms are pending and displayed. An alarm window is displayed and configured like 
an alarm view. 

To hide an alarm window during configuration, create it on its own level. 

Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is displayed.

● The Inspector window is open.
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Procedure  
Proceed as follows to configure an alarm window:

1. Insert an "Alarm window" object from the "Tools" task card into the global screen.

2. Configure the alarm window like an alarm view.

3. Under "Properties > Properties > Mode >  Window" in the Inspector window, select how 
the alarm window reacts and is operated in Runtime.

– Activate "Modal" if the alarm window is to retain the focus in Runtime after a screen 
change.
This option is important, as switching back and forth between the screen and different 
windows with <Ctrl+TAB> is not supported.

Result
During runtime, the alarms of the selected alarm class are displayed in the alarm window. 

See also
Configuring an alarm view for active alarms (Page 1309)

Creating alarm classes  (Page 1262)

Configuring an alarm indicator 

Introduction
The alarm indicator uses a warning triangle to indicate that alarms are pending or require 
acknowledgement. If an alarm of the configured alarm class occurs, the alarm indicator is 
displayed.  

The alarm indicator has two states:

● Flashing: At least one alarm that requires acknowledgment is pending.

● Static: At least one of the acknowledged alarms has not gone out yet.

During configuration, specify whether Runtime has to open an alarm window when you operate 
the alarm indicator.

Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is open.

● The Inspector window is open.
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Procedure
Proceed as follows to configure the alarm indicator:

1. Insert the "Alarm indicator" object from the "Tools" task card into the work area.

2. Select the alarm indicator.

3. Under "Properties  > Properties  > General" in the Inspector window, select the alarm 
classes to be displayed by the alarm indicator.
Specify whether to display pending and/or acknowledged alarms in the alarm indicator.

4. Under "Properties > Event", assign system function "ShowAlarmWindow" to an event of 
the alarm indicator.

 

  Note

If you have configured a permanent window in the screen or template, do not position the 
alarm window and alarm indicator in the vicinity of the permanent window. Otherwise the 
alarm window and the alarm indicator are not displayed in Runtime. However, the 
permanent window is not visible in the "Global screen" editor.

 

Result
The alarm indicator is displayed if alarms from the selected alarm class are pending or need 
to be acknowledged in Runtime. The alarm window opens when the user operates the alarm 
indicator. 
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Configuring alarm filtering

Introduction
You can filter the display of alarms in the enhanced alarm view. The criterion is always a 
character string. There are two ways to filter the alarm view:

● A fixed criterion is configured in WinCC.
In Runtime, all alarms that contain the complete character string in the alarm text are 
displayed.

● You filter the alarm view in Runtime.
In Runtime, a filter tag sets the relevant character string in the alarm view by means of an 
I/O field, e.g. as described below. 
The filter affects the display in the alarm view. All alarms in the alarm buffer are retained. 

Requirements
● An enhanced alarm view has been configured.

● The screen with the alarm view is open.

● The Inspector window is open.

Configuring filters for a fixed character string
1. Select the alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".

3. Enter a filter string in "Filter string".
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Result
Only those alarms are displayed in Runtime that contain the complete character string from 
the filter in the alarm text.

Configuring filters for a variable character string    
1. Select the enhanced alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".

3. Select a tag from "Filter tag". The tag must be of the "String" type.

4. In the screen, configure an I/O field for entering the filter string in Runtime.

– In the Inspector window, select "Properties > Properties > General > Format > Display 
format > String".

– To link the I/O field to the alarm view, select "Process" to set the filter tag you selected 
for the alarm view.

Result
If you enter a string in the I/O field in Runtime, the alarm view only displays alarms that contain 
the complete string in their alarm text. 
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If a permanently configured character string and a filter tag were configured, the alarms will 
be filtered in Runtime according to the content of the filter tag. If the filter tag is blank, the 
permanently configured character string is used as the filter. 

 

 Note

Filtering is not possible for the following alarm views:
● Simple alarm view
● Alarm line
● Alarm window
● Alarm view for logged alarms

 

See also
I/O field (Page 840)

Working with Tags (Page 984)

Displaying Logged Alarms

Introduction
You display logged alarms in Runtime in an alarm view. The alarm view shows the content of 
an alarm log.   

Application
For example, you want to view information about the process at the end of a shift.

Requirements
● An alarm log has been created.

● A screen is open.

● The Inspector window is open.

Procedure
Proceed as follows to configure an alarm view to output an alarm log:

1. Configure an alarm view in a screen.

2. Under "Properties > Properties > General  > Display > Alarm log"" in the Inspector window, 
select the required alarm log.
You can always create a new alarm log.
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Result
During runtime, the alarms logged in the selected alarm log appear in the Alarm view.

 

 NOTICE

In runtime, the alarm texts logged are not displayed but rather the alarm texts in the current 
project. The logged alarm texts are only intended for external evaluation of the log file.

If the alarm log displayed was configured differently, the alarm texts displayed may not 
correspond with those logged. 

 

See also
Configuring an alarm view for active alarms (Page 1309)

Configuring the alarm view

Displaying alarms

Options for displaying alarms on the HMI device
WinCC offers the following options for displaying alarms on the HMI device: 

● Alarm view for pending and outgoing alarms
The alarm view is configured for a screen. More than one alarm can be displayed 
simultaneously, depending on the configured size. You can also configure multiple alarm 
views with different contents and in different screens. Use the "Historical alarm list (short-
term)" and "Historical alarm list (long-term)" views to display outgoing alarms.

● Alarm view for statistical values
The "Alarm statistics" view of the alarm view displays statistical information, such as the 
frequency and display duration of alarms.

● Status tag of an alarm group
You can visualize the changing alarm states of an alarm group using the status tag of that 
alarm group. You can customize the display in the "Screens" editor.

Additional signals
● Alarm annunciator

In addition to the alarm view, WinCC displays an alarm in the form of a visual or audible 
alarm in the plant. The alarm annunciator may be a hooter, or a warning lamp.

● System functions and scripts
You can configure a list of functions for the event associated with an alarm. These functions 
must be executed in Runtime when the event occurs. 
To be able to control the alarm view other than via the toolbar, use system functions for 
alarms in WinCC.
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See also
Bit assignment of status tag (Page 1461)

Tags of an alarm group (Page 1256)

System functions for alarms (Page 1410)

Configuring an alarm view

Introduction
Current, and logged alarms are displayed in the alarm view. Alarms from all alarm classes are 
displayed in an alarm view, if necessary. Configure the criteria for alarm filtering. 

Requirement
● A screen is open.

● The "Tools" task card is open.
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Procedure  
To configure an alarm view, proceed as follows:

1. Insert an "Alarm view" object from the "Tools" task card into the screen.

2. Select the alarm view and click "Properties > Properties > General" in the Inspector window.

– Under "Display > Type", select the type of alarms you want to display as default in the 
alarm view.

– Under "Display > Display" select which alarms are displayed. This shows or hides the 
alarms to be suppressed in the display.

– Double-click of the operator on an alarm in Runtime starts a specific action. Specify this 
action under "Display > Double-click". If you want to trigger the Loop-In-Alarm  not only 
using the "Loop-In-Alarm" button, select "Loop-In-Alarm".

– Select the required time base under "Time base".
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3. To specify the appearance of the alarm view, select "Properties > Properties > Appearance" 
in the Inspector window.

4. To specify the appearance of the headers, content, and table grid in the alarm view, select 
"Properties > Properties > Table" .

– To specify the visualization of selected alarms in Runtime, select "Properties > 
Properties > Table > Table - Select".

– To specify the sorting method for alarms in Runtime, select "Properties > Properties > 
Table > Table - Sorting".

5. To specify the sort order of alarms in Runtime, select "Properties > Properties > Alarm list" .

Enabling alarm text blocks for the alarm view  
1. Select "Properties > Properties > Alarm text blocks > Inherit project settings for alarm text 

blocks" in the Inspector window to specify whether to apply the settings from the "Alarm 
text blocks" tab in the "HMI alarms" editor to this alarm view.

2. Select "Properties > Properties > Alarm text blocks" to enable the alarm text blocks to be 
visualized in the alarm view. You can specify the following properties for each alarm text 
block:

– Name

– Layout of the header

– Layout of content

– Alignment

– Length

– Format

– Flashing

Configuring the toolbar and status bar in the alarm view  
1. To specify the the toolbar layout, select "Properties > Properties > Toolbar > Toolbar - 

General".

2. Select "Properties > Properties > Toolbar > Toolbar - Operator input elements", to enable 
the operator input elements to be included in the alarm view toolbar.

3. To specify the the status bar layout, select "Properties > Properties > Status bar > Status 
bar - General".

4. Select "Properties > Properties > Toolbar > Toolbar - Operator input elements", to enable 
the operator input elements to be included in the status bar of the alarm view.

Result
Alarms of various alarm classes are output in the alarm view during runtime. To change the 
view in Runtime, click the configured buttons on the alarm view toolbar. 
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See also
Configuring filters in the alarm view (Page 1324)

Configuring Alarm Statistics (Page 1326)

Configuring filters in the alarm view

Introduction
WinCC supports the configuration of different filters for the alarm view:

● Standard filters
The operator cannot access standard filters in Runtime. You can copy configured standard 
filter for use in other alarm views.

● Custom filters
The operator can change the custom filter in Runtime. You are using custom filter only in 
a single alarm view.

Requirement
● The screen with the configured alarm view is open in the "Screens" editor.

● The Inspector window is open.

Procedure     
1. Select the alarm view and click "Properties > Properties > Filter > Alarm filter" in the 

Inspector window.

2. To configure a custom filter, click on the "Custom" tab.
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3. Define one or more filters. For each filter, specify one or more filter criteria under 
"Expression" with condition and value.

4. To configure a standard filter, select the "Standard" tab.
You can configure several standard filters and activate these for the respective alarm view. 

5. Enter the name for the standard filter and a comment.

6. To configure the filter, select the criteria, conditions, and the value for the standard filter in 
the "Filter" dialog.

Filter by process values
You cannot enter text as the criterion for a process value. To filter by the text of a parameter 
block, or by the process tag represented, proceed as follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" alarm text block using the  
button.

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog on 
a client have the same names on all servers. 

Filter by time
When filtering by time, the start and stop values are not adjusted automatically when the time 
base of the alarm view is changed. 
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Example
At a PC location with time zone "UTC + 1h", the alarm view has the "Local time zone" time 
base. You should filter by the time 10:00 to 11:00. Convert the time base to "UTC". To display 
the same alarms as before, change the start or stop value of the filter to 9:00 and 10:00. 

See also
SQL Statements for Filtering the Alarm View (Page 1417)

Configuring Alarm Statistics

Introduction  
The alarm statistics contain statistical calculations for the logged alarms in the alarm view. The 
alarm statistics also contain a selection of the configured alarm text blocks. If the contents are 
dynamic, the alarm text blocks display the data for the last incoming alarm. You can compile 
the alarm statistics columns individually. 

The alarm statistics contain the following statistical calculations:

● Alarm rate
The system counts how often an alarm with the status "Incoming" is included in the log. If 
the alarm number does not occur, this alarm number is not included in the statistics.

● Total display time of an alarm in seconds.
The following periods between alarm states are available as calculation variables:

– "Incoming/Incoming"(sum +/+),

– "Incoming/Outgoing"(sum +/-)

– "Incoming/Initial acknowledgment"(sum +/*1)

– "Incoming/second acknowledgment"(sum +/*2)

Each type of calculation can be represented in a column in the alarm statistics.

● Average display time of an alarm in seconds
The following periods between alarm states are available as calculation variables:

– "Incoming/Incoming"(mean value +/+),

– "Incoming/Outgoing"(mean value +/-)

– "Incoming/Initial acknowledgment"((mean value +/*1)

– "Incoming/second acknowledgment"((mean value +/*2)

There is one column in the alarm statistics for each type of calculation.

The calculation of the time of acknowledgment includes the "Acknowledged" alarm status. This 
status includes both an emergency acknowledgment and an acknowledgment by the PLC.
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Requirement
● The "Screens" editor is open.

● You have created a screen with an alarm view.

Configuring the alarm statistics functions   
Proceed as follows to configure the functions of the alarm statistics:

1. Select the alarm view and click "Properties > Properties > Alarm statistics - General" in the 
Inspector window.

2. To limit the calculation period, activate the "Use time range" option under "Time range". 
Specify the frequency.

3. To define the maximum number of alarms to be processed in the alarm statistics, enter a 
value at "Data records > Maximum number of data records".
This setting requires the following conditions to be met:

– The number of alarms in the calculation period exceeeds the configured "Maximum 
number of data records which can be read".

– The calculation period is not configured.

4. To output a warning when this number is exceeded, activate the "Warning when limit is 
reached" option.
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Setting up the alarm statistics
Proceed as follows to set the columns of the alarm statistics:

1. Select the alarm view and click "Properties > Properties > Alarm statistics - Elements" in 
the Inspector window.

2. In the table, enable the alarm statistics columns that are to be displayed in Runtime.

3. To specify the arrangement of columns in the alarm view in Runtime, select a row in the 
Inspector window. Move the row to the selected location using the  and  buttons.
The columns of the alarm statistics are displayed in Runtime in the same order as the rows 
are arranged in the Inspector window.

4. Specify the sort direction for each row in "Sort by".

5. Specify the sort order in "Sort order" by assigning values from 1 to 4.
 

  Note

The sort function is only active if the alarm statistics view contains no more than four 
columns.
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Result
In Runtime, the operator clicks the  button in the alarm view to view the "Alarm statistics".

 

 Note

Alarms that have the "acknowledged" and "outgoing" states are only used for the calculation 
if a suitable alarm with "incoming" state was found in the amount of the result .

If you acknowledge an alarm with single acknowledgment or dual acknowledgment only once, 
the "Incoming/First Acknowledgement" and "Outgoing/Second Acknowledgement" alarm 
states are used for the statistical calculation.

If there is an alarm pending at the PLC and Runtime is disabled and enabled several times, 
the alarm is entered several times in the log with "incoming" status. The alarm will also be 
included multiple times in the evaluation. 

 

Configuring Alarm Display Suppression

Overview of Alarm Display Suppression

Introduction                 
Suppress the display of alarms to avoid an excessive burden of information for the plant 
operator. If only selected alarms are shown, the operator will concentrate his attention on 
essential alarms.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1329



Methods for suppressing alarm displays 
There are two options for suppressing the display of incoming alarms: 

● Automatic display suppression
The alarms are displayed in line with the specific plant status. You can enter these plant 
states as display suppression masks in each alarm. The design engineer specifies the 
values for the plant states. 
To transfer the current plant status to the alarm system, create an alarm group with a display 
suppression tag. This display suppression tag returns the value of the plant states. 
Assign this alarm group the alarms that the system does not display in Runtime at specific 
plant states. 
Example:
In the "Shutdown" plant status you want to suppress the display of alarms that normally 
occur in this status. The "Online connection to the PLC was dropped" alarm will only not 
be displayed during "Shutdown".

 

  Note

If you have specified a display suppression mask for an alarm that is not assigned to an 
alarm group, this alarm will not be suppressed in Runtime.

Alarms with display suppression masks that are not allocated to any alarm group will not 
be suppressed in Runtime. To suppress the display of specific alarms in Runtime, you 
always have to assign these to an alarm group.

 

  Note

You only use display suppression tags only for custom alarm groups.
 

● Manual display suppression
To suppress the display of an alarm in Runtime, the operator can click the  button in 
the alarm view. 
He can view the alarm once again by clicking the  button. 
The system displays the alarms again after a configurable time. 
To enable the reporting of manual display suppression, configure a corresponding user 
alarm that is triggered when the display is suppressed manually. Configure this user alarm 
in the alarm view as an operator input alarm for the "Suppress" operator action.

Properties of alarms whose display is suppressed
The following applies to alarms whose display is suppressed:

● In the following alarm view display modes, you can use the following buttons to show the 
alarms again:

– Display "Current alarms"

– Display "Historical alarm list" (short-term)

– Display "Historical alarm list" (long-term)

● The alarms are recorded and displayed under the "Hidden alarms" display.

● The alarms are also logged.

● If an alarm annunciator is set up for these alarms, it will not be triggered.
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Manual display suppression

The following properties apply only to alarms whose display is suppressed manually.

● The alarms are shown again after a set time.

● An alarm that requires acknowledgment is acknowledged by the manual suppression of its 
display.

● To enable the reporting of manual display suppression, configure a corresponding user 
alarm that is triggered when the display is suppressed manually.

Automatic display suppression

The following properties apply only to alarms whose display is suppressed automatically.

● The display suppression does not trigger an operator input alarm.

● The PLC acknowledges alarms that require acknowledgment.
In the time while alarms requiring acknowledgment are suppressed, the PLC acknowledges 
the outgoing alarms. If an alarm does not have the "Outgoing" status, the PLC 
acknowledges it immediately.

 

 
 WARNING

With automatic display suppression, alarms requiring acknowledgment no longer have to 
be acknowledged. You should therefore only use automatic display suppression for 
alarms that do not require operator actions during the configured plant states.

 

Interaction 
The two methods of suppressing alarm displays interact as follows:

● When an alarm is automatically suppressed, use the  and  buttons to show and 
hide the alarm as required.

● You have manually suppressed the display of an alarm using the  button.
When the plant status changes and the conditions for automatic suppression of this alarm 
display are not fulfilled, the alarm is displayed once more. 
The time defined as the display suppression duration must not have elapsed.

● You have suppressed the alarm by pressing the  button. The status that was defined 
for automatic display suppression using the display suppression tags occurs. After the 
specified display suppression timeout was triggered, the alarm nevertheless remains 
suppressed.

See also
Tags of an alarm group (Page 1256)
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Setting the Display Suppression Timeout

Introduction
You can set the time after which manually-suppressed alarms should be automatically 
displayed once more in the alarm settings.

Requirements
● The project navigator is open.

Procedure   
To set the alarm display suppression timeout, follow these steps:

1. Double-click "Runtime settings > Alarms" in the project navigation.
The alarm settings open.

2. Select "General > Display suppression timeout" to configure the period during which a 
manually suppressed alarm remains hidden.
30 minutes are preset.
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See also
Configuring Automatic Display Suppression (Page 1333)

Configuring Automatic Display Suppression

Introduction
With automatic display suppression, the alarm is displayed in relation to the status of the PLC. 
You define the plant status that causes an alarm to be hidden. Configure automatic display 
suppression using the "HMI alarms" editor.You will need to create an alarm group with a 
displace suppression tag. In the alarm, you assign the plant statuses using the display 
suppression mask. The display suppression tag must assume the value of the display 
suppression mask for an alarm so that it is not displayed in Runtime.

Requirements
● The "HMI alarms" editor is open.

● The "Alarm groups" tab is selected.

● Alarms are set up.

● The display suppression tag must exist.

Creasing an alarm group for display suppression
1. Double-click "Add" in the table.

A new alarm group is created.

2. Enter a name for the new alarm group.

3. Select the display suppression tag under "Tags" in the Inspector window.
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Creating a display suppression mask for the alarm
1. Select the alarm.

2. To select the alarm group for which you created the alarm suppression tag, select 
"Properties > Properties > General" in the Inspector window.

3. To enter the display suppression mask, select "Properties > Properties > Display 
suppression" in the Inspector window.
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Result
The alarm is hidden when the value set in the display suppression mask is activated at the 
display suppression tag.This means that the alarm is hidden when the plant is in the specified 
status.

 

 Note

Alarms with display suppression masks that are not allocated to any alarm group will not be 
suppressed in Runtime. You should therefore always assign alarms to an alarm group if you 
want to suppress them.

If an alarm is hidden, it can be shown once more in Runtime by clicking the  button. 
 

See also
Setting the Display Suppression Timeout (Page 1332)
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Configuring Alarm Alerts

Introduction
In addition to the alarm view, WinCC also supports alarm indication in the plant by means of 
visual or audible signals.The alarm annunciator can be a horn, or a warning lamp.

Requirements
● The "HMI alarms" editor is open.

● Alarms are set up.

● The Inspector window is open.

Procedure  
To configure an alarm annunciator, proceed as follows:

● Select the alarm you want to indicate using an alarm annunciator.

● In the Inspector window, select "Properties > Alarm annunciator".

See also
Configuring acknowledgment of the alarm annunciator (Page 1349)

Displaying logged alarms

Introduction
An alarm view displays logged alarms in Runtime according to the configuration. The alarm 
view displays alarms from the log in the "Historical alarm list" (short-term) or "Historical alarm 
list" (long-term) display. The "Historical alarm list" (short-term) also displays the current alarms.

Requirement
● The logged alarms are located on the local log server.

● The screen with the configured alarm view is open.

● The Inspector window is open.
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Procedure             
Proceed as follows to configure an "Historical alarm list" (short-term) or "Historical alarm list" 
(long-term) display:

1. Select the alarm view.

2. Select "Properties > Properties > General > Active list > "Historical alarm list" (short-term) 
or "Historical alarm list" (long-term) in the Inspector window.

3. Configure the alarm view similar to an alarm view for active alarms.

Result
In Runtime, you can view logged alarms using the "Historical alarm list" (short-term)  or 
"Historical alarm list" (long-term)  buttons. To visualize only alarms of the "Errors" alarm 
class or alarms at certain plant areas, you can filter or sort the logged alarms.

 

 Note

In the "Historical alarm list" (short-term) display, the new incoming alarms are updated 
immediately. In the "Historical alarm list" (long-term), on the other hand, they are not. You 
cannot enter or view comments in the "Historical alarm list" (short-term). Comments can only 
be entered in the "Historical alarm list" (long-term). 

 

Configuring alarm export

Introduction
To export alarms to a "*.csv" file in Runtime, the operator clicks on the  button in the alarm 
view.You can configure this function in the alarm view in the "Screens" editor. 

Requirements
● The screen with the configured alarm view is open.

● The Inspector window is open.
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Procedure
To configure the export of alarms, proceed as follows:

1. Select the alarm view and configure data export by selecting "Properties > Properties > 
Data export" in the Inspector window.

– You can specify a custom file name and folder.

– At "Scope", specify the data to be exported from the alarm view.

– at "CSV format", specify the separator to use in the ".csv" file.

2. Select "Operator input in Runtime" to configure the function of the  button in Runtime:

– Select "Display dialog" to open the "Default settings data export" dialog. 

– To export the data directly to the specified export file, disable "Display dialog".

3. Additionally, select "Operator input in Runtime" to specify whether or not the operator is 
allowed to rename the file and/or change the folder in Runtime.

Configuring alarm evaluation in Runtime

Introduction
To enable evaluation of the alarms in Runtime, assign a custom C function to the "Status 
changed" event of an alarm. Edit the function to suit your requirements for evaluation in 
Runtime.

Requirement
● The "HMI alarms" editor is open.

● A custom function for reading the data has been created.
This function must contain a pointer to a string whose data is mapped by scanf to the 
"MSG_RTDATA_STRUCT" structure.

Procedure   
To configure the evaluation of an alarm in Runtime, proceed as follows:

1. Select the alarm.

2. In the Inspector window, select "Properties > Events > Status changed".
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3. Select the custom function for reading the data.

The alarm data is read in Runtime. Alarm data includes,for example, the alarm number, 
time stamp, and alarm state. 

4. In the "Scripts" editor, configure evaluation of the alarm data within the function.

Result
When the alarm state changes, the alarm data is read in Runtime and evaluated according to 
your configuration.

Example
Use the following, user-defined function "state" to read the status of alarms, for example:
Void state (MSG_RTDATA_STRUCT Parameter)
DWORD state;
state = Parameter.dwMsgState;
printf("Status: %d\r\n", state);

See also
Working with Function Lists (Page 1748)

Working with customized functions (Page 1753)
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Reporting Alarms

Configuring reporting of alarms

Overview
WinCC can report on all alarms that occur in the system. The following options are available:

● Output an alarm sequence report
In Runtime, the standard printer of the HMI device will continuously print each alarm and 
any changes in its status.

● Output of an alarm report
You configure an alarm report in the "Reports" editor and specify when it is output in 
Runtime: 

– For event-driven output, configure an object that is assigned the "PrintReport" system 
function. The object can be a button or tag.

– For time-driven output, create a "Print job" in the scheduler. Assign an alarm report to 
the job.

 

  Note

In the alarm report, specify whether to output current or logged alarms. 
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Requirements
● A printer was configured on the HMI device.

Activating continuous alarm reporting   
To activate continuous reporting of alarms, follow these steps:

1. Double-click "Runtime settings" in the project navigation.

2. Select "Alarms > General > Report".

Result
The latest alarms are output at the printer of the HMI device. 
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Excluding an alarm from reporting
To exclude specific alarms from reporting, proceed as follows:

1. Open the "HMI alarms" editor.

2. Select the alarm to exclude from reporting on the tab of the selected alarm type.

3. In the Inspector window, disable "Properties > Properties > Miscellaneous > Report".

Result
WinCC does not output these alarms currently on the connected printer. 

See also
Working with reports (Page 1609)

Principles for preparation of reports (Page 1609)

Create a report  (Page 1616)

Report output in Runtime Advanced (Page 1631)

Alarm report (Page 1671)

Configuring reporting of alarms

Overview    
WinCC logs all system alarms as required.The following options are available:

● Output the current display in an alarm view
You can print out a system report. You can also create a custom report, if necessary.In the 
print job, specify the print scope, page area, printer, or target file.

● Output an alarm sequence report
In Runtime, every alarm is continuously output at a printer. 

Requirements
● The "Screens" editor is open.

● Alarms are configured.

● You configured an alarm view with "Print current view"  button.
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Procedure
To configure the outputting of the current display in an alarm view using your own report, 
proceed as follows:

1. Select the required alarm view.

2. To select the print job, select "Properties > Properties > General > Print > Print job" in the 
Inspector window.
The default print job is the system print job. You can also select a customized print job, or 
a modified system print job.

Result
If the user clicks the  button in Runtime, the selected report with the alarms currently 
displayed in the alarm view is output to the printer. 

 

 Note
Printer settings

Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. 

For more detailed information, refer to the operating instructions for your HMI device. 
 

See also
Working with reports (Page 1609)

9.3.2.4 Configuring acknowledgment

Configuring alarm acknowledgment by means of alarm class

Introduction
To configure an alarm with alarm acknowledgment, assign it to an alarm class with the "Alarm 
with single acknowledgment" acknowledgment model. 

Requirement   
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.
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Selecting the acknowledgment model for an alarm class
The acknowledgment model for a predefined alarm class has already been set. You can only 
set the acknowledgment model for user-defined alarm classes. Proceed as follows:

1. In the "HMI alarms" editor, click the "Alarm class" tab and select the alarm class.

2. Select the required acknowledgment model under "Properties > Properties > 
Acknowledgment" in the Inspector window.

Assign alarms to an alarm class requiring acknowledgment
Proceed as follows to assign an alarm to an alarm class requiring acknowledgment.

1. In the "HMI alarms" editor, click the tab for the alarm type and select the alarm.

2. Under "Properties > Properties > General" in the Inspector window, select the alarm class 
of the alarm.

Result
The alarm will not disappear in Runtime until it is acknowledged by the operator.

Configuring trigger for alarm acknowledgment

Introduction
You always specify the acknowledgment requirement for an alarm using the alarm class. Then 
the operator acknowledges the alarm using the "ACK" function key of the HMI device or the 
"Acknowledgment" button of the alarm view. 

The following options are also available to trigger acknowledgment:

● Configuring a button to acknowledge an alarm

● Acknowledgment of a Discrete Alarm by the PLC

Requirement   
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.

● An alarm view and a button are created in the "Screens" editor.
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Configuring a button to acknowledge an alarm
To configure a button for acknowledging an alarm, proceed as follows:

1. Select the button in the "Screens" editor.

2. Under "Properties > Events" in the Inspector window, assign the 
"AlarmViewAcknowledgeAlarm" system function to the "Click" event.

3. Select the alarm view as parameter.

Acknowledgment of a Discrete Alarm by the PLC
1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select the tag and the bit that acknowledges the PLC alarm under 
"Properties > Properties > Acknowledgment > PLC".

See also
Working with screens (Page 637)

Working with Function Lists (Page 1748)
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Sending alarm acknowledgments to the PLC

Requirement     
● The "HMI alarms" editor is open.

● The required alarm has been created and assigned to an alarm class requiring 
acknowledgment.

 

  Note

You cannot send the acknowledgment of analog alarms to the PLC. 
 

Sending alarm acknowledgments to the PLC
To configure that acknowledgment of an alarm is sent to the PLC, follow these steps:

1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select "Properties > Properties > Acknowledgment".

3. Under "HMI", select the tag and the bit set by the alarm acknowledgment function.
 

  Note

Operator 舩 and PLC only have read access to the acknowledgment tag memory area.
 

Result
If the operator acknowledges the alarm in Runtime, the operating step is forwarded to the PLC.

9.3.2.5 Configuring acknowledgment

Configuring alarm acknowledgment

Introduction
The alarm classes define how the alarms from an alarm class are to be acknowledged. When 
you assign an alarm to an alarm class, you define the acknowledgement model for that alarm.

Requirements
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.
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Procedure
To configure the acknowledgement of an alarm, follow these steps:

1. In the "HMI alarms" editor, click the "Alarm class" tab and select the alarm class.

2. To select the acknowledgment model, select "Properties > Properties > Acknowledgment 
> Settings" in the Inspector window.

– If you enable "Assign comment to defined user", this Runtime user writes a comment 
on the alarm acknowledgment that is written to the log file alongside with the alarm.

– If you enable "Use comment of the incoming alarm", the same comment is attached to 
each status change of this alarm as the one assigned for the "incoming" alarm event.

3. In the "HMI alarms" editor, select the alarm.

4. Select "Properties > Properties > General" in the Inspector window to select the alarm class 
of the alarm.

5. Select "Properties > Properties > Acknowledgement > Settings" in the Inspector window to 
specify the acknowledgment tag to which the alarm acknowledgment is saved, including 
the bit set for this purpose.

6. To exclude the alarm from the group acknowledgment of the alarm view, enable "Single 
acknowledgment".

Acknowledging an alarm via a system function
1. In the "HMI alarms" editor, select the alarm.

2. In the Inspector window, click "Properties > Events > Incoming".
The function list opens.

3. In the "Function list" dialog, assign the "SetBit" system function to the "Incoming" event.

4. Enter the acknowledgment tag of the "BOOL" data type as the "Tag (In/Out)" parameter.
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Configuring display and control objects for alarm acknowledgment
1. Select the button or function key.

2. Assign the "AcknowledgeAlarm" system function to the "Click" event.

See also
Working with screens (Page 637)

Working with Function Lists (Page 1748)

Configuring alarm group acknowledgment

Introduction
You acknowledge an alarm group using the acknowledgment tag. To set and reset the 
acknowledgment bit, configure a display and operating element. 

Requirements
● The "HMI alarms" editor is open.

● You have created the alarm groups.

● The required alarm has been created.

Procedure
To configure the acknowledgement of an alarm group, follow these steps:

1. In the "HMI alarms" editor, select the alarm.

2. Under "Properties > Properties > General" in the Inspector window, select the alarm group 
to which the alarm belongs.

3. Click the "Alarm groups" tab in the "HMI alarms" editor.

4. Select the alarm group.

5. Under "Properties > Properties > Tags > Settings" in the Inspector window, select the 
acknowledgment tag and acknowledgment bit.

6. Open the "Screens" editor and configure a button that sets the acknowledgment bit in 
Runtime for the acknowledgment tag. 

Result
The user monitors the alarms for a given function together in Runtime. If a user identifies the 
cause of a fault, then he or she can acknowledge all alarms for this function using the 
configured operator action. 
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Configuring acknowledgment of the alarm annunciator

Introduction
In addition to the alarm view, WinCC also supports alarm indication in the plant by means of 
visual or audible signals.The alarm annunciator can be a horn, or a warning lamp.You can 
acknowledge the alarm annunciator in the following ways:

● Using the  button in the alarm view
This "Acknowledge alarm annunciator" button must be configured in the alarm view. The 
button is always active, even if another option for acknowledging the alarm annunciator 
has been enabled.

● Using a single acknowledgment
You acknowledge the alarm annunciator with the alarm that triggered the alarm 
annunciator.The operator acknowledges an individual alarm by clicking the  "Single 
Acknowledgment" button in the alarm view.

● Using a tag
To acknowledge the alarm annunciator, e.g. with a button, use this option.

Requirements
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created, and assigned to the alarm class.

Procedure
To configure the acknowledgment of an alarm annunciator, proceed as follows:

1. Click the "Alarm classes" tab in the "HMI alarms" editor.

2. Select the required alarm class.

3. In the Inspector window, select "Properties > Properties > Acknowledgment > Alarm 
annunciator" to specify how to acknowledge the alarm annunciator.

Result
The operator acknowledges the alarm annunciator in Runtime as specified for the alarm class 
of this alarm.

Configuring the Group Acknowledgement of Alarms

Introduction
You can use the  button in the alarm view to acknowledge all pending, and visible alarms 
that must be acknowledged in the alarm view. You can exclude individual alarms from group 
acknowledgment.After group acknowledgment was triggered, the excluded alarms are still 
pending.
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Requirement
● A screen is open.

● An alarm view has been created.

Procedure
To set up a group acknowledgement, follow these steps:

1. Open the "Screens" editor, and select the relevant alarm view.

2. In the Inspector window, select "Properties Properties > Toolbar - Buttons > Group 
acknowledgment."
The  button appears in the alarm view. All alarms of an alarm view that are not excluded 
from group acknowledgment are acknowledged when the operator actuates this button.

Configuring a single acknowledgement
1. Open the "HMI alarms" editor and select the tab that contains the relevant alarm type.

2. Select the alarm that you want to exclude from the group acknowledgement.

3. Enable "Properties > Properties > Acknowledgment > Single acknowledgment" in the 
Inspector window.
When you acknowledge all the alarms in an alarm view using the  button, any alarms 
for which the "Single acknowledgement" option is enabled will be excluded. The operator 
acknowledges alarms with "single acknowledgment" option individually.

Configuring the Resetting of the Acknowledgment Bit for Acknowledgment Tags

Introduction    
The operator, or the PLC, resets the acknowledgment bit for acknowledgment tags.The 
acknowledgment bit is reset directly in the PLC or in WinCC Runtime via a script, for example. 
The acknowledgment bit is not automatically reset. 

Resetting of the acknowledgment bit by the PLC 
You can use an external tag as an acknowledgment tag to allow the PLC to reset the 
acknowledgment bit. 

If the alarm is acknowledged in Runtime in WinCC, the defined acknowledgment bit is set in 
the PLC. In the PLC, the acknowledgment bit is processed as required before it is reset once 
more.

In the PLC, an alarm is triggered by a reusable function block or by functions. In this block the 
alarm can also be acknowledged or the acknowledgment bit reset.

Evaluation and resetting of the acknowledgment bit by the PLC has the following advantage:

It is easy to cause the acknowledgement with external signals, such as pushbutton units in the 
field. 

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
1350 System Manual, 08/2011,  



You can acknowledge externally and via the alarm view. Both methods use the same bit in the 
automation system for acknowledgement.

 

 Note

To ensure that the alarm view in WinCC reliably acquires the external acknowledgement in 
time, configure the resetting by the automation system with a time delay.

 

Resetting of the acknowledgment bit by the WinCC
If you want to acknowledge an alarm via the acknowledgment tag only, reset the 
acknowledgment bit immediately as soon as it is set. 

If you acknowledge an alarm via the alarm view, configure the resetting of the acknowledgment 
tags separately.

You can reset the acknowledgment bit in the following ways in WinCC:

● Button
You can reset the acknowledgment bit using a button. 

● System function
Use the "ResetBitInTag" system function. If the acknowledgment bit is set, it will be 
immediately reset. 

 

  Note

If the acknowledgment tag is of the "BOOL" data type, use the "ResetBit" system function.
 

  Note

If lots of alarms are processed using scripts, this places a heavy load on the work memory. 
The acknowledgment bit should therefore ideally be reset by the PLC. 

 

9.3.2.6 Configuring alarm buffer overflow

Introduction
The size of the alarm buffer depends on the type of HMI device. In WinCC, specify the 
percentage of the alarm buffer to be deleted on alarm buffer overflow.  
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Requirements
● You have created a project.

Procedure
To configure the response to an alarm buffer overflow, follow these steps:

1. Double-click "Runtime settings" in the project navigation under your HMI device.

2. Under "Alarms > General > Buffer clearance in percent upon buffer overflow", enter a value 
between 1 and 100.
This value specifies the percentage of the alarm buffer that is deleted on alarm buffer 
overflow.    

Result
If data in the alarm buffer exceeds the resources of alarm buffer memory, the configured 
percentage of data will be deleted from the oldest alarms in the alarm buffer.

 

 Note

You cannot check the alarm buffer overflow separately by alarm method. You can use the 
"ClearAlarmBuffer" system function to delete specific alarms of specific alarm classes from 
the alarm buffer. 

 

See also
Working with Logs (Page 1468)

9.3.3 Alarm Logging

9.3.3.1 Configuring alarm logging

Basics on alarm logging

Introduction
An alarm log is used to record project alarms.  

 

 Note

Alarm logging is not available for every HMI device.
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Configuration steps
To log an alarm, follow these configuration steps:

1. Creating an alarm log  
You define the following properties for the alarm log:

– Logging method
Behavior of the log when reaching a specific fill level

– Storage location and file format

– Log size

– Runtime start characteristics

– Checksum

2. Assigning an alarm log to an alarm class
You can log the alarms from multiple alarm classes in an alarm log.

3. Assigning an alarm to a loggable alarm class

4. Configure display of logged alarms in an alarm view

Content of the alarm log
All states are logged for configured alarms. The following three entries, for example, are stored 
in the log for an alarm that requires acknowledgment:

● 04.08.2007 10:00:25:520, analog alarm, ID5, K, error, fill level exceeded by 10 %

● 04.08.2007 10:01:20:442, analog alarm, ID5, Q, error, fill level exceeded by 10 %

● 04.08.2007 10:01:30:112, analog alarm, ID5, G, error, fill level exceeded by 10 %

In the example, the alarm states are identified by the following letters:

K = Incoming

Q = Acknowledged

G = Outgoing

All data belonging to an alarm is stored in the alarm log, including configuration data such as 
the alarm class, time stamp, and alarm text.

The potential number of logged alarms depends on the data medium used.
 

 Note

Alarm text and error location are only logged if you have configured such a setting in the log 
properties.

 

 Note

The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).
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Logging methods
The logging method determines how the alarm log responds when the configured size is 
reached. WinCC supports the following logging methods:   

● Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approximately 20% of the oldest entries are deleted. 
It is therefore not possible to display all the configured entries. During configuration, select 
an appropriate size for the circulation log. Alternatively, configure a segmented circular log.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

● Log with level-dependent system alarm
When a defined level is reached, such as 90 %, a system alarm is triggered. When the 
configured size of the log has been reached, new alarm events are not logged.

● Log with level-dependent execution of system functions
When the log is completely full, the "Overflow" event is triggered. You configure a function 
list for the event. 
When the configured size of the log has been reached, new alarm events are not logged.

Checksums in regulated projects  
With WinCC you configure regulated projects as required by FDA guidelines, if necessary. Use 
the "Audit" option to create regulated projects. 

In regulated projects you supply a checksum for the logged data of an alarm log. The operator 
will use this checksum during operation of the plant to see if the data of an alarm log have 
been changed.

For the checksum to be clear, it starts with the first line of an alarm log and integrates the 
previous lines when continuously generating the checksum. This means a checksum can only 
be generated for the following logs:

● Log that sends a system alarm when it is full

● Log with execution of system functions when log is full.

Generation of a checksum is also available for alarm logs that are saved as files of the "*.csv" 
or "*.txt" (Unicode) format.

If you want to continue an existing log without checksum as one with checksum, a backup 
copy of the existing log is created in the "*.keep" file format. A new log with checksums is 
created.

To maintain the validity of checksums, the following limitations apply when using the system 
function "CopyLog":

● You cannot copy a log without checksums into a log with checksums.

● You cannot copy a log with checksums into a log without checksums.
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Storage location and storage medium   
You can save the log data to a file on a data carrier, e.g. MMC, SD, or CF cards. If you are 
using a PC as your HMI device, you may store your information in a database. You can further 
process the saved data in other programs for analysis purposes, for example.  

Displaying logged data
On the HMI device, the logged data is displayed in an alarm view that is configured for this 
purpose.   

See also
Working with Logs (Page 1468)

Storage locations for log files

Introduction
The alarm log is stored in an ODBC database or in a file. Select "Database" or "File" as the 
storage location. 

 

 Note

An "ODBC database" storage location is only available on a PC.
 

Log file
Depending on the configuration of the HMI device, select one of the following storage locations 
for the log file:

● Local hard disk of the PC

● Storage card of the Panel

● Network drive
 

  Note
Logging on network drives

Do not log alarms, tags and Audit Trail directly on a network drive. Power supply can be 
interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

Save the logs on your local hard drive or a local storage card. Use the system function 
"ArchiveLogFile" to save the logs long-term on a network drive. This step ensures reliable 
operation.
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File - CSV (ASCII)
Data is saved to a "*.csv" file in standard ASCII format.

Use the "File - CSV (ASCII)" storage location if you are going to read logged data without using 
WinCC Runtime.

 

 Note

Double quotation marks or several characters are not permitted as list separator for the 
storage site "File - CSV (ASCII)." You can find the settings for list separators under "Start > 
Settings > Control Panel > Regional and Language Options."

 

File - TXT (Unicode)
The log data are saved in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, use software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data will be saved with quick access to a proprietary database. 

Use the "File - RDB" storage location if you require maximum read performance in Runtime. 

Data logs of this format can only be read and displayed using WinCC Runtime.

Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside WinCC Runtime.

Files of logs with checksums
● *.keep

This file is created in the following cases:

– A log is started without checksum and will be continued with a checksum.

– You update WinCC with a Service Pack or a new version. Writing of the Audit Trail or 
the log with checksum is continued.

The content of the "*.keep" file remains the same when compared with the original "*.csv" 
or *.txt" file. 

● *.bak
This file is created when WinCC Runtime has determined a serious, irregular problem in 
the file.
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Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 

If you have selected an ODBC database as storage location, select one of the following options 
for naming:

● "User-defined name of data source"
You define the name of the data source.

● "System-defined name of data source",
The system defines the name.
You will need a special instance of Microsoft SQL Server on the target system in order to 
do this. Download the free SQL Server 2005 Express from the Internet for this purpose. 

 

  Note
Device dependency

This setting is not available on the Panel PC 477.
 

 

Create an alarm log

Introduction
In Runtime, you save alarms to the alarm logs. Specify the alarm log in the alarm class. An 
alarm log contains the alarms of several alarm classes. Create the alarm log in the "Logs" 
editor. When creating an alarm log, define the following parameters:

● Name

● Size

● Storage location

● Runtime start characteristics

● Log type

● Advanced content

● Checksum

You can also enter comments for each log. 

Requirement
● The "Alarm log" tab is open in the "Log" editor.

● The Inspector window is open.
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Procedure     
To create an alarm log, proceed as follows:

1. Double-click "<Add>" in the table.
A new alarm log is created.

2. Under "Properties > Properties > General" in the Inspector window, enter a unique name 
for the alarm log.

 

 Note

The log names must be unambiguous in a project. The name of a log must always be unique, 
regardless of whether different storage locations are selected for the log. 

 

 Note

The characters which can be used in the name of the data source depend on the storage 
location.

The characters \ / * ? : " < > | are not permitted for the following storage locations:
● File - RDB
● File - CSV (ASCII)
● File - TXT (Unicode)

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $

The characters _ @ # $ cannot be used as the first character of a name.
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1. Under "Number of data records per log", define the number of alarms to be saved to a log 
file.
The approximate space required on the storage medium is displayed. Memory space 
requirements will increase accordingly if you log alarm texts with tag values. 

2. Under "Storage location", select a file, or an ODBC database.

– If you select a file, enter the corresponding path. Depending on the HMI device, save 
the log files to the hard disk of the PC, to the memory card of a panel, or to a network 
drive.
Different file formats are supported, depending on the HMI device.

– If you select a "Database" storage location, specify the following:
Specify whether the name of the data source is accepted by the system.
Specify whether to select the name of the data source yourself.
Enter a name for the database.
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1. To determine if audit trail data were changed at a later time, activate "Properties > 
Properties > General > Checksum".

 

  Note
Device dependency

The "Checksum" option is only available for display and HMI devices which support logs.
 

Configuring the behavior of the log when it reaches a specific fill level
1. Define how the log should behave when it is full under "Properties > Properties > Logging 

method".

– Specify the number of logs for the "Segmented circular log" log type.

– For the "Display system event on" log type, specify the fill level triggering the system 
event.

– If you selected the "Trigger event" log version, configure a function list under "Properties 
> Events > Overflow". The function list will be processed when the log is full.

2. Under "Properties > Properties > Archiving method > Settings", specify whether to log the 
alarm text and fault location.
Logged alarms that contain alarm text and the fault location exceed the estimated size of 
the configured alarms. Check to see whether the specified specified storage location still 
has sufficient space.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
1360 System Manual, 08/2011,  



Configuring the behavior of the log when Runtime starts
1. Select "Properties > Properties > Start behavior> Type".

– Define whether to start the log automatically at the start of Runtime.

– To overwrite logged data with new data, activate "Reset log".

– To add the logged data to an existing log, activate "Continue log".
 

  Note

Use system functions to control the restart of a log in Runtime.
 

Configuring a comment
To record a text to document your configuration of a log, follow these steps: 

1. Enter your text under "Properties > Properties > Comment".

Result
The alarm log is created. You can assign one or several alarm classes to this alarm log. 

See also
Logging alarms (Page 1361)

Working with Logs (Page 1468)

Logging alarms

Overview
To log alarms, follow these steps:

● Create an alarm log.

● Assign the created alarm log to an alarm class.

● Assign the alarm class with the created alarm log to an alarm.
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● In the Runtime settings specify the language in which you want to write the logs.

● You evaluate logged alarms.
You can analyze the logged alarms directly in your WinCC project, such as in an alarm 
view, or in another user program, such as Microsoft Excel.

 

  Note
Tag fields in the alarm text

The sequence of tag fields in the alarm text is language dependent. The sequence of the 
Runtime language is used for logging alarms to a "*.csv" log file.

Changing the tag of an output field in one language causes the modified output field to 
appear at the end of the alarm text in all other languages. This means the sequence of 
the output fields in the log file can change.

 

Requirements
● You have created an alarm log.

● The "HMI alarms" editor is open.

Assigning an alarm log to an alarm class
To assign the alarm log to an alarm class, proceed as follows:

1. Open the "Alarm classes" tab in the "HMI alarms" editor.

2. Select the required alarm class.

3. Under "Properties > Properties > General  > Log" in the Inspector window, select the alarm 
log.

Assign alarm to an alarm class
To assign an alarm to the alarm class, proceed as follows:

1. In the "HMI alarms" editor, open the "Analog alarms" tab, or the "Discrete alarms" tab.

2. Select the required alarm.

3. Under "Properties > Properties > General > Alarm class" in the Inspection window, select 
the alarm class for which the alarm log was configured.

Result
The alarm is saved to the configured alarm log. 

See also
Working with Logs (Page 1468)

Create an alarm log (Page 1357)
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Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime, the logged alarms are output in the alarm view. 

Direct access to the ODBC log database

Overview
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
to be used in WinCC as follows:

Select the database from the Windows Start menu under "Settings > Control panel > ODBC 
Data Sources".

In your configuration, specify the "Data source name" (DSN) instead of a directory name as 
storage path for log data. With the DSN, you are referencing the database and the storage 
location.

The entire functional scope of the database is available for additional processing and 
evaluation of log data.
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Application
The data source sets up the connection to the database. Create the data source on the same 
PC on which the Runtime software is stored. Then enter the DSN configured on this PC when 
you create a log in WinCC. 

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

In addition, you can use the "StartProgram" system function to configure program calls, e.g. 
MS Access, on the HMI device. Runtime is not interrupted while you configure such calls. 

Setting up the ODBC data source

Introduction
To store process values or alarms in the log database in Runtime, set up the ODBC data 
source.

Requirement
● A log database has been created. 

You create the log database using the SQL Enterprise Manager. You can find more detailed 
information on how to do this from Microsoft.

Procedure
To set up an ODBC data source, follow these steps:

1. In Control Panel, open "Administrative Tools" and select "Data Sources (ODBC)".
The "ODBC Data Source Administrator" dialog is opened. 

2. Click "User DSN > Add".

3. Select the "SQL-Server and click on "Finish". 

4. In the dialog that follows, enter a name for the User DSN and the SQL-Server  and click on 
"Next".

5. In the dialog that follows, define the logon procedure for the SQL database and click on 
"Next".

6. Activate "Change the default database to". 

7. Select the database you have created and click on "Next".

8. In the dialog that follows, click "Finish".
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Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.

Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".

3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.
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Result
The log data of the log is assigned a checksum in runtime.

See also
GMP-compliant configuration (Page 2413)

Enabling GMP compliant configuration (Page 2416)

Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format

You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".

3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.
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4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.

 

 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Enabling GMP compliant configuration (Page 2416)

Evaluating Audit Trails in AuditViewer (Page 2434)

Log response to language switching in runtime

Introduction
In the Runtime settings of your HMI device, select the language to be used for writing to logs 
in runtime.       
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Requirement
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
To determine the startup language, follow these steps:   

1. Select "Runtime settings > Language and fonts" in the project navigation.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order". Use 0 to determine the startup language, for example:

– German 0.

– English 1
With "0", German is specified as the "Startup language".

4. Select "Runtime settings > General" in the project navigation.

5. Select the "Logs > Logging language > Startup language".

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.

The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

9.3.3.2 Configuring alarm logging

Basics on alarm logging

Introduction
An alarm log is used to record project alarms.Alarm logs are created by the system. For 
example, after an error has occurred, or a limit was exceeded in Runtime, the corresponding 
alarm you configured in the "HMI alarms" editor is output in Runtime.Each alarm event is 
logged, e.g., the transition of the alarm from "incoming" to "acknowledged" status.

You can store the alarm events in a log database and/or log them to hardcopy in an alarm 
report. You can output the alarms stored in the database in Runtime, for example, in an alarm 
view.
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The logged alarms are stored in a circular log that consists of multiple single segments. The 
size of all the segments and of an individual segment is defined under "Alarm log" in the log 
settings. 

You should configure backups to save the data at regular intervals.   

Configuration steps
To log an alarm, follow these configuration steps:

1. Configuring "Log settings"
You define the settings for the alarm logging in the log settings.

2. Enable alarm logging
You specify that alarms of particular alarm classes will be logged.

3. Assigning an alarm to a loggable alarm class

Content of the alarm log
The alarm logs are used to store all alarm data, including configuration data. You can read all 
alarm properties from the log files, e.g. the alarm class, the timestamp, and the alarm texts.A 
new log segment with the new configuration data is generated whenever you edit configuration 
data of an alarm. This function prevents any change from having an influence on alarms logged 
previously.

The possible number of logged alarms depends on the server used.
 

 Note

The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).

 

As alarm configuration is language-specific, the logs contain a configuration data table for each 
language configured.

Storage media and location
Log data are stored in a database. You can further process the saved data in other programs 
for analysis purposes, for example. 

Backup for log segments
Take backups of your log segments to ensure complete documentation of your process. You 
define the settings under "Log settings".  

Displaying logged data
You can view the logged data on the HMI device.Configure a corresponding alarm view that 
displays the log data, or use buttons to show the "Historical alarm list" (short-term), or the 
"Historical alarm list" (long-term) in Runtime.
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See also
Working with Logs (Page 1470)

Logging alarms

Introduction
Specify the size and time range for the alarm log segments in the log settings.By specifying 
their size, you also define the number of segments.

The segments are filled successively with data in Runtime.The next segment is used on 
overflow of a segment.You can also configure a time-dependent segment change.If you specify 
a time for the segment change, the next log segment is filled after this time was reached.

 

 Note

Ensure that the log size does not exceed memory resources. The log manager does not 
validate the selected settings.A large number of linked log segments might lead to longer 
waiting periods in the system during the startup and shutdown of Runtime.

 

Overview
To log alarms, follow these configuration steps:

● Configure the alarm log in the log settings.
Define the size and segmentation.

● Configure a loggable alarm class.

● Assign the alarm to a loggable alarm class.
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Requirements
● An alarm class has been created.

Configuring an alarm log
To configure the alarm log, proceed as follows:

1. Double-click "Runtime settings" in the project navigation.

2. Double-click "Logging" in the area navigator.
The alarm settings open.

3. Click "Properties > General" in the Inspector window and specify the following:

– Enter the values for "Time period of all segments" and "Maximum size of all segments".
Define the size of the log database by entering the accumulated time period for all 
segments and the maximum segment size.A new segment is started if either one of 
these criteria is exceeded. The oldest segment is overwritten after all segments were 
filled with data.

– Enter your values at "Time period covered by a single segment" and "Maximum size of 
a segment".
You include the size and number of single segments when entering the time period for 
single segments and their maximum size. A new single segment is started if either one 
of those conditions is exceeded. In addition, the oldest single segment is deleted after 
the criterion for "Time period of all segments" is exceeded.

– Select the date and time for the start of the first segment change at "Time of first segment 
change".
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The segment is changed even if the configured size is exceeded after Runtime starts. 
In this case, the oldest individual segment is also deleted.

Create alarm class with logging
To create an alarm class with logging, proceed as follows:

1. Open the "HMI alarms" editor.

2. Click the "Alarm Classes" tab.

3. Select the alarm class whose alarms are logged.

4. In the Inspector window, select "Properties > Properties > General > Settings > Alarm log".

5. Assign the alarm to be logged to this alarm class.

Example for the timing of the first segment change
A segment changes for the first time at 23:59 on January 17. The next time, the segment 
changes at the configured time in the cycle defined in "Time period contained in a single 
segment". If the cycle setting is "1 day", then the change will take place at 23:59 every day. If 
the cycle is set to "1 month", the segment will change at 23.59 on the 17th day of the next 
month. 

See also
Working with Logs (Page 1470)

Logging Settings (Page 1154)

Defining the Log Size and Segmentation (Page 1155)

Configuring the Alarm Log Backup

Principle          
Make regular backups of your log data to ensure complete documentation of your process.

 

 Note

The backup normally starts 15 minutes after the first time-related segment change. To start 
the backup and the segment synchronously with Runtime, define the time for the segment 
change before you start Runtime.

You can enter comments for alarms displayed in the alarm view in Runtime. If the log segment 
in which the alarm is stored has already been swapped out, the comment will not be accepted 
in the swapped-out log. The comment will only be in the local log segment.

If the archive segment has not yet been moved out, then the changed comment is accepted 
permanently.
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Requirement
● The settings for logging are open.

Procedure
To create a backup of the log segments, proceed as follows:

1. Double-click "Logging" in the area navigator.

2. Enable "Alarm log > Backup".

3. In the Inspector window, click "Properties > General > Settings Backup > Path".
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4. Click  and look for an existing folder in which to store the backup file. Use "Make New 
Folder" to create a new folder, if necessary. You can also use a network path as the storage 
location.

5. Activate "Backup" to generate a backup copy of logged data.
Also activate "Backup to both paths" if a backup copy of logged data is to be saved to the 
"Path" and to the "Alternative path" folders. 
You can also use a network path as the storage location.
If the "Backup to both paths" option is not enabled, the second backup file is used in the 
following situations:

– If the storage space on a backup medium is full.

– The original storage location is unavailable due to network failure, for example.

An alarm is output if a storage location was not found, provided you configured 
corresponding system alarms.

6. Activate the "Sign" check box if the backup file must be saved with signature.
When the connection to WinCC is reestablished, the signature is used to detect whether 
any changes have been made to a backup file since it was swapped out. 

 

  Note

The "Sign" option puts a load on the RAM. If you use log signing, the maximum size of a 
single segment must not exceed 200 MB.

 

Result
The log segment backup is stored in the specified location. 
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Structure of the Backup File
A backup file for an alarm log has the following structure:

● Extension
A log segment backup consists of two files in "*.LDF" and "*.MDF" format. To transfer a 
backup to another PC, simply copy both files.

● File name
The file name is in the following form: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". 

Component Explanation Example
Computer name  FLEX-LOG2
Project ID The project ID is assigned by the 

system. Underscores are 
replaced with "#".

HMI#4ZQV

Type The type identification of the 
alarm log is "ALG" (Archive Log).

 

Time_from The time period is specified in 
yyyymmddhhmm format.

200812021118 for December 2, 
2008, 11:18.Time_to

Example of the complete file name of a backup file:
FLEX-LOG2_HMI#4ZQV_ALG_200811291414_200812030502.ldf

 

 Note
Assignment to project

The project name cannot be seen in the file name of the generated project ID.

To be able to allocate the backup files to the project, assign a path name to the storage 
location that contains the project name.

 

Signing the Backup File
If signing and backup are enabled, each log backup file is signed when swapped out. When 
the file is reconnected to WinCC, it is thus determined whether the file was changed after being 
swapped out. 

If you use log signing, the maximum size of a single segment must not exceed 200 MB.

The "Enable signing" check box must be enabled for data verification. When signing is enabled, 
it takes longer to link the log backup file to WinCC. Up to 500 values are logged per second.

 

 Note

If you disable signing off to establish a fast connection to the backup files, for example, you 
should avoid segment changes while it is disabled. After having closed the connection, re-
enable signing so that the data to be logged is assigned a signature.
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See also
Working with Logs (Page 1470)

Connecting and Disconnecting the Alarm Log Backup

Introduction     
To access the data in a swapped-out alarm log in Runtime, connect the log backup to the 
project. You can configure an automatic connection or connect the alarm log to the project via 
a script. The archived alarms are displayed in Runtime in the alarm view. 

If you no longer want to access the backup of a log segment in Runtime, disconnect the log 
backup from the project. 

Requirement
● The relevant backup files in "*. ldf" and "*.mdf" format are stored locally.

● The project is in Runtime.

Display Time Range
The alarms are only displayed in Runtime if the time window in the alarm view has been 
configured accordingly. 

Example
You have configured a time window to display only the alarms of the past 24 hours. If you 
connect to a log backup containing alarms that are older than 24 hours, these alarms are not 
included in the alarm view. 

Connecting to the alarm log automatically
To automatically connect to the alarm log backup, proceed as follows:

1. Insert the log backup files in the "RuntimeProjectPath\ProjectName\CommonArchiving" 
folder.

2. In Runtime, the alarm log is automatically connected to the project.

If signing is enabled, signed log backup files that are changed will not be connected 
automatically. A WinCC system alarm is generated and an entry is added to the Windows 
event log in the "Application" section. 

Connecting to the alarm log using a script
Using the "AlarmLogs" VBS object, you can link the log backup files to the project using a 
script. The log segments are then copied with the "Restore" VBS method to the Common 
Archiving folder of the Runtime project. For additional information, see the description of the 
"AlarmLogs" VBS object and the "Remove" VBS method.
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Automatically disconnecting the alarm log         
To automatically disconnect the alarm log backup from the project, proceed as follows:

1. Go to the folder "RuntimeProjectPath\ProjectName\CommonArchiving".

2. Remove the log backup files from the folder.

Disconnecting the alarm log using a script
Using the "AlarmLogs" VBS object, you can disconnect the log backup files from the project 
using a script. The log segments are then removed with the "Remove" VBS method from the 
Common Archiving folder of the Runtime project. For additional information, see the description 
of the "AlarmLogs" VBS object and the "Remove" VBS method.

Accessing the Log Database Directly with C-API/ODK

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
allow you to directly access the WinCC log databases. Using direct access you can, for 
example, read process values to process them further in spreadsheet programs.

Accessing the log database with C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions 
via open application programmer interfaces. 

Additional information
You will find further information on this topic in the documentation for the WinCC Open 
Development Kit. 

Accessing the Log Database Directly with ADO/OLE DB 

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
allow you to directly access the WinCC log databases. Using direct access you can, for 
example, read process values to process them further in spreadsheet programs.

Accessing the log databases with ADO/OLE DB
Some process values are stored in the log databases in compressed format. Use the WinCC 
OLE DB Provider to access these compressed process values. For non-compressed data and 
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data from the alarm log, you can also use the Microsoft ADO/OLE DB interfaces, for example. 
You can use Visual Basic, Visual C++, etc., as the programming language. 

 

 Note

If you access the log database directly using ADO/OLE DB, remember that the log structure 
may be different in a new version of WinCC.

 

Additional information
You will find more detailed information on this topic on the Internet at:

msdn.microsoft.com (http://msdn.microsoft.com/en-us/library/default.aspx)

Configuring the Reloading of Alarms after a Power Failure

Introduction
Configure the reloading of alarms so that the most recent alarms are displayed in Runtime 
once more after a power failure. In the event of a power failure, the number of alarms that you 
configured is read from the alarm log. This allows the most recent process image to be 
reconstructed.   

Procedure
To define the number of alarms that are reloaded after a power failure, follow these steps:

1. Double-click "Runtime settings" in the project navigation under your HMI device.

2. Double-click "Alarms" in the area navigator.

3. Select "Properties > General > Number of alarm list entries after power failure" in the 
Inspector window to enter the number of alarms to be reloaded after power failure.

Result
After power failure, the number of alarms you configured is reloaded to the alarm view and 
displayed in Runtime.
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9.3.4 Using Alarms in Runtime

9.3.4.1 Alarms in Runtime

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

● Loop-in-alarm

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes  
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgment.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.
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Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  

Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer. Whether alarm 
events have to be acknowledged or not is specified in your configuration.

Alarm window
An alarm window shows all pending alarms or alarms awaiting acknowledgement of a particular 
alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. You can choose to display the 
alarms in ascending or descending order of their occurrence. The alarm window can also be 
set to indicate the exact location of the fault, including the date and time of the alarm event. 
By means of configuration, the display can be filtered in such a way that only alarms that 
contain a specific character string will be shown.

Alarm indicator
The alarm indicator is a graphic icon that is displayed on the screen when an alarm of the 
specified alarm class is activated.  

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them has not gone out yet. The 
displayed number indicates the number of queued alarms.

 

9.3.4.2 Alarms in Runtime

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 
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● Date

● Time of day

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes  
Alarms are assigned to various alarm classes.

● "Warnings"
Usually, alarms of this class indicate states in the plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Usually, error alarms indicate critical 
error events that occurred in the plant, e.g. "Motor overtemperature".

● "System"
System events indicate states or events which occur on the HMI device. 
System events provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controller.

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

● Custom alarm classes
The properties of this alarm class are defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  

Alarm report 
When alarm logging is enabled in the project, alarms are output directly to the printer. 

You can set the logging function separately for each alarm. Printing of such an alarm is initiated 
when the "incoming" and "outgoing" alarm events are generated.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project.
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Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

Alarm view
The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether 
alarm events have to be acknowledged or not is specified in your configuration. By means of 
configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
If configured, an alarm window shows all pending alarms or alarms awaiting acknowledgement 
of a particular alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. At the first position, the current, 
or the oldest alarm will be displayed. The alarm window can also be set to indicate the exact 
location of the fault, including the date and time of the alarm event. By means of configuration, 
the display can be filtered in such a way that only alarms that contain a specific character string 
will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.  

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them has not gone out yet. The 
number indicates the number of queued alarms.

 

9.3.4.3 Using the Alarm Window or Alarm View

Alarm window, alarm view in Runtime

Application             
Alarms are indicated in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window correspond to that of the alarm view.

The alarm window is independent of the process screen. Depending on the configuration, the 
alarm window appears automatically as soon as a new, unacknowledged alarm has been 
received. The alarm window can be configured so that it only closes after all the alarms have 
been acknowledged. 
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Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific string in the alarm text will be displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Symbol Alarm class
! "Errors"
Empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"
S7 "Diagnosis Event"

Operation         
You use the alarm view as follows, depending on how it is configured:

● Change the order of the columns.

● Change the order in which the alarms are displayed.

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:         

Button Function
Displaying a tooltip for an alarm

Editing alarms

Acknowledge alarm

Operation behavior

Linked alarm window for touch panels
When configuring the alarm window for keyboard units, enable the "Modal" property under 
"Properties > Mode". This ensures that the alarm window does not defocus during screen 
changes. Switching back and forth between the screen and different windows with <Ctrl+TAB> 
is not supported. If the linked alarm window has the focus, then the buttons in the screen behind 
it cannot be operated. The functions configured on a function key are carried out.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1383



Changing the order of the displayed alarms
When you click on the column, first of all alarms requiring acknowledgement are sorted 
according to date and time. Then those alarms that do not require acknowledgement are sorted 
according to date and time.

Using the Alarm Window, Alarm View

Introduction
As an alternative to using the mouse, you can operate the alarm view and the alarm window 
using the <TAB> key on your HMI device. This allows you to select the button and the most 
recently selected alarm in the alarm view. Depending on the configuration, you can also 
operate the alarm view via the function keys.

Operation using the mouse     
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard     
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Change the order of the columns
1. Select the column header, such as the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header "Time".
The "Date" column is in front of the "Time" column.

Change the sorting
You can sort the list according to date or time.

1. Click on the corresponding column header.
The list is sorted in descending or ascending order according to this criterion.

2. Click the same column header again to reverse the sort order.

Acknowledge alarm  
1. Click on the alarm to be edited.

2. Click the button.
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Loop-In-Alarm trigger  
1. Click on the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

 

  Note

If you trigger a Loop-In-Alarm  during an unacknowledged alarm, it is acknowledged 
automatically.

 

Displaying configured tooltip  
1. Click on the alarm concerned.

2. Click the  button.
The tooltip configured for the alarm is displayed. 

9.3.4.4 Using the Simple Alarm Window, Alarm View

Basic alarm view, alarm window in Runtime

Application   
The simple alarm view shows selected alarms or alarm events from the alarm buffer. The layout 
and operation of the simple alarm window correspond to that of the simple alarm view.         

 

 Note

The "Single alarm view" object is not assigned dynamic functions by means of scripting. 

In the Engineering System, for example, dynamize the visibility of an object in the 
"Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does not 
support animations. If you configured an animation and, for example, run a consistency check 
on the project, an error alarm is displayed in the output window.
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Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Symbol Alarm class
! "Errors"
empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"

Operation
You use the alarm view as follows, depending on how it is configured:     

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Loop-In-Alarm
Changes to the screen that contains information about the error event
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Button Function
Displaying a tooltip for an alarm

Displays the full text of the selected alarm in a separate window, namely the alarm text 
window
In the alarm text window, you can view alarm texts that exceed the space available in 
the Alarm view. Close the alarm text window with the the  button.
Scrolls one alarm up.

Scrolls one page up in the alarm view.

Scrolls one page down in the alarm view.

Scrolls one alarm down.

Format of the control elements
The display of the buttons for using the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all the required buttons are 
available.       

Basic alarm view, using the alarm window

Introduction
As an alternative to using the mouse, you can operate the simple alarm view using the <TAB> 
key on your HMI device. This allows you to select the button and the most recently selected 
alarm in the alarm view. Depending on the configuration, you can also operate the alarm view 
via the function keys.

Operation using the mouse  
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard  
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Acknowledge alarm 
1. Select the alarm to be acknowledged.

2. Click the button.
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Loop-In-Alarm trigger  
1. Select the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

Calling the infotext 
1. Select the alarm to be edited.

2. Click the button.

3. To close the window for displaying the operator note, press the  button or use the key 
combination <Alt+F4>.

9.3.4.5 Using the Alarm Indicator

Alarm indicator in Runtime

Application    
The alarm indicator is displayed if alarms of the specified alarm class are pending or require 
acknowledgment.

Layout   
The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

Operation   
Depending on the configuration, when operating the alarm indicator an alarm window is 
opened. The icons from the symbol library can only be operated with a mouse or touch screen. 

 

 Note
Device dependency

Operation with mouse is not available for all HMI devices.
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Operating the alarm indicator using the mouse

Operation using the mouse  
1. Click on the alarm indicator with the mouse pointer. Depending on the configuration, the 

Alarm window is open.

2. Click  to close the alarm window. The Alarm window can be opened again by clicking 
on the alarm indicator.

9.3.4.6 Acknowledging alarms

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● Using the "ACK" key on your HMI device

● Using individually-configured function keys or buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To automatically acknowledge alarms in Runtime, use the system functions and scripts, plus 
the "Acknowledgment by the PLC" option.

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

Acknowledgment variants
You acknowledge individual alarms or multiple alarms together in Runtime. They are 
distinguished as follows:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgment of all the alarms of an alarm group using a button or a function key.
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Requirement
● An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, proceed as follows:

1. Select the alarm.

2. If you are using an alarm view or an alarm window, click the  button.

3. If you are using a simple alarm view or a simple alarm window, click the  button.

4. Press the "ACK" button on your HMI device to acknowledge an alarm in an alarm line.
 

  Note
Device dependency

The extended alarm view or alarm window and the alarm line are not available for all HMI 
devices.

 

Result
The alarm status changes to "Acknowledged". If the condition for triggering an alarm no longer 
applies, the alarm status also changes to "Outgoing", and it is no longer displayed on the HMI 
device. 

9.3.4.7 Filtering alarms

Introduction
The alarm view in Runtime does not contain a control element for entering filter criteria. To 
provide this functionality, configure an I/O field using the "Screens" editor. 

Requirements
● A filter has been configured for the alarm view.

● An I/O field for entering the criterion is displayed.

● Alarms are displayed in Runtime.

Enable filter
1. Enter the filter string in the I/O field.

2. Confirm your input.
The alarm view displays only those alarms that are contained in the specified character 
string. Thereby this distinguishes between upper and lower case letters. 
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Disable filter
1. Delete the string from the I/O field that is used to filter the alarm view.

2. Confirm your input.
All alarms are displayed in the alarm view once more.

9.3.5 Using Alarms in Runtime

9.3.5.1 Alarms in Runtime 

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time of day

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes  
Alarms are assigned to various alarm classes.

● "Warnings"
Usually, alarms of this class indicate states in the plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Usually, error alarms indicate critical 
error events that occurred in the plant, e.g. "Motor overtemperature".
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● "System"
System events indicate states or events which occur on the HMI device. 
System events provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controller.

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

● Custom alarm classes
The properties of this alarm class are defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  

Alarm report 
When alarm logging is enabled in the project, alarms are output directly to the printer. 

You can set the logging function separately for each alarm. Printing of such an alarm is initiated 
when the "incoming" and "outgoing" alarm events are generated.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project.

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

Alarm view
The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether 
alarm events have to be acknowledged or not is specified in your configuration. By means of 
configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
If configured, an alarm window shows all pending alarms or alarms awaiting acknowledgement 
of a particular alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. At the first position, the current, 
or the oldest alarm will be displayed. The alarm window can also be set to indicate the exact 
location of the fault, including the date and time of the alarm event. By means of configuration, 
the display can be filtered in such a way that only alarms that contain a specific character string 
will be shown.
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Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.  

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them has not gone out yet. The 
number indicates the number of queued alarms.

 

9.3.5.2 Alarm view

Introduction  
The "Alarm view" object displays alarms that occur during the process  in a plant. You also 
use the alarm view to display alarms in list form. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 

In Runtime, you can use the <TAB> key to jump to different objects in succession to enter 
values, or click buttons. Alternatively you can use the alarm view with the mouse.

 

 Note

An alarm appears in the alarm view with the date and time stamp crossed out in the following 
situations:
● A locked alarm is unlocked.
● An alarm is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.
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Requirement
● Cursor mode is set to "Tab cursor" for the screen.

● The objects are enabled for operation.

● The operator authorization is assigned.

Operation using the mouse   
1. Click on the alarm to be edited.

2. Click on the operator control whose function you wish to use.

Operation using the keyboard    
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the operator control element you wish to use is selected.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.

Example: Change the order of the columns
The function can be configured. It is only available in Runtime if you have activated the alarm 
view "Font table > Header column > Sort" in the Inspector window.

1. Select the column header, such as the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header "Time".

Example: Change the order of the columns
The function can be configured. It is only available in Runtime if you have activated the alarm 
view "Font table > Header column > Sort by column headers" in the Inspector window.

1. Click on the column header.

2. Click the same column header again to reverse the sort order.

Example: Loop-In-Alarm
Loop-In-Alarm  triggers the configured change of screen to the screen containing information 
about the alarm. 

1. Click on the alarm to be edited.

2. Click the button.
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Operation behavior
When Loop-In-Alarm  is triggered for an unacknowledged alarm, it is acknowledged 
automatically.

9.3.5.3 Alarm View Buttons

Introduction
The alarm view displays specific alarm lists in order to provide a better overview of the active 
alarms. These lists filter, and sort alarms by certain properties. You can individually define 
these properties, and how the lists are presented when you configure the alarm view. 

Lists in the alarm view 
You can display six different lists in the alarm window. To display the alarm lists in the alarm 
view, click the associated button on the alarm view's toolbar.

 List Description
Alarm list Shows the pending alarms.
Short-term archive list Shows the logged alarms. 

The display is updated immediately when new incoming 
alarms occur.

Long-term archive list Shows the logged alarms. 
The display is not updated immediately when new incoming 
alarms occur.

Lock list Shows the locked alarms.
Alarm statistics Shows statistical information.
List of Hidden Alarms Shows the hidden alarms. Hidden alarms are also logged.

Filtered alarm list   
You use the filter of the alarms view to configure alarm views in which you display specific 
alarm lists. You can configure a filter for any alarm list. Configure a separate alarm view for 
each filtered alarm list. 

 

 Note

An alarm appears in the alarm list with the date and time stamp crossed out in the following 
situations:
● A locked alarm is unlocked.
● An alarm is reloaded after a power failure; for chronological alarms only.
● The AS is restarted; for chronological alarms only.
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See also
Filtering Alarms in Runtime (Page 1396)

9.3.5.4 Filtering Alarms in Runtime

Introduction      
In Runtime, you can set specific criteria that define the alarms to be displayed in the alarm 
view. In the example below, only alarms that contain the alarm text "Motor on" are displayed. 

Requirement
The "Filter alarms" button  is configured in the alarm view.

Procedure
To filter alarms in the alarm view, proceed as follows:

1. Click  in Runtime.
The "Specify selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Alarm Text". In the right 
pane, select the "Search string" option, and double-click "Search string".

3. The "Text input" dialog opens. Enter the search string "Motor on" and click "OK" to confirm.

4. In the "Specify selection" dialog, click "OK" to confirm your entries.
The alarm view only shows the selected alarms.

In the "Specify selection" dialog, specify the start and end times, or search strings, for alarm 
text blocks such as the "Date" and "Time" system blocks. Your input must be in the format 
required in the dialog. 

The following settings are available in the "Specify selection" dialog:

Field Description
Text filter by 
exact match 

If the "Text filter by exact match" option is not enabled, all text blocks that contain 
the specified string of characters are selected.
If the "Text filter by exact match" option is enabled, all text blocks that correspond 
exactly to the specified string of characters are selected. 

Persistence in 
RT

If the "Persistence in RT" option is enabled, changes to criteria are retained even 
after a screen change.

Persistence in 
CS and RT

If the "Persistence in RT and CS" option is enabled, the modified settings are also 
applied to the Engineering System. To do this, you must open the screen in the 
"Screens" editor, and save it again. The changed settings will also be used when 
you reactivate the project.

Delete filter Use this button to delete all configured criteria.
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Filter by process values 
You cannot enter text as the criterion for a process value.

To filter by the text of a process value block, or the process tags it represents, proceed as 
follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" text block.
 

  Note

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog 
on a client have the same names on all servers.

When filtering by time, the start and stop values are not adjusted automatically when the 
timebase of the alarm view is changed.

Example: At the PC location with time zone "UTC + 1h", the alarm view has the "Local 
time zone" time base. You should filter by the time 10:00 to 11:00. Change the timebase 
from "Local time zone" to "UTC". If you want to display the same alarms, change the filter 
to 9:00 to 10:00. 

 

9.3.5.5 Sorting Alarms in Runtime

Introduction   
In Runtime, you can sort the alarms in the alarm view by column header. 

Examples for sorting alarms: 
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● In descending order by date, time, and alarm number. The most recent alarm is displayed 
at the top.

● By priority
You must have defined the priority of the alarms in the "HMI alarms" editor and configured 
the "Priority" alarm text block in the alarm view. As a result, in a single-line alarm view, only 
the top-priority alarm appears in the alarm window. A lower-priority alarm will not be 
displayed, even if it is more recent. The alarms are displayed in chronological order.

● The "Alarm status" alarm text block is sorted by the type of state and not by the configured 
status texts. For an ascending sort order, the following order is used:

– Incoming

– Outgoing

– Acknowledged

– Locked

– Enabled

– Automatic acknowledgment 

– Emergency acknowledgment

– Incoming/outgoing
 

  Note
Specifying sorting criteria in the ES for the alarm view

You can set the sort criteria to configure the alarm view as required. In the Inspector 
window of the alarm view, select "Properties > Properties > View > Columns".

 

Sorting alarms
To sort the alarm view by column, define the sort order over up to four columns. An arrow and 
a number are shown on the right in the column header. The arrow indicates the sort order 
(ascending or descending). The number beside the arrow indicates the sort order of the column 
headers.

Requirement
● "Sort by click" or "Sort by double-click" is selected in the alarm view.

Click on "Properties > Properties > Table > Table - Sorting > Settings".

● The "Autoscroll" button is activated in the alarm view. 
Click "Properties > Properties > Toolbar > Toolbar buttons". 
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Procedure
To sort alarms in the alarm view by column, proceed as follows:

1. Click or double-click the column header by which you want to sort the alarms first.
The number "1" is displayed, and the arrow points upwards for ascending sort order.

– If sort order "Up and down" is enabled in the alarm view, each click or double-click in 
the column header toggles the sorting between the ascending and descending mode.

– If sort order "Up, down, none" is enabled, then the sort order is cancelled after the 3rd 
click.

2. If you want to sort by several columns, click the column header in the required order.
 

  Note

Sorting is not affected by events or changes to the alarm text block configuration.

An alarm text block corresponds to a field in an alarm. If you define an alarm text block 
as sorting criterion in the sort dialog and then remove this block from the alarm line under 
"Properties> Properties > Columns", the defined sort order remains unchanged. In the 
sort dialog, a blank field is displayed instead of the deleted alarm text block. 

If you do not define another sort order order and reactivate the removed alarm text block 
in the alarm text block configuration, the alarms will be sorted in the original sort order 
once more. 

 

9.3.5.6 Toggling the Alarm View in Runtime 

Introduction
You filter the alarms to be displayed in the alarm view using preconfigured buttons.
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Requirements
● The six buttons needed to display a certain selection of alarms are configured in the alarm 

view.

Procedure
To display a certain selection of alarms in the alarm view, follow these steps:

● Click on one of the following buttons in the alarm view:
 Alarm list, to view alarms pending
 Historical alarm list (short-term), to view logged alarms

The display is updated immediately when new incoming alarms occur.
 Historical alarm list (long-term), to view logged alarms
 Lock list, to view the locked alarms
 Alarm statistics, to view statistical information
 List of hidden alarms, to view alarms which are logged but not visible.

9.3.5.7 Displaying logged alarms in Runtime

Introduction      
In Runtime, the alarm view displays alarms from the log, in addition to the current alarms. 

Requirements
● All the archived data that you intend to display in Runtime must be stored locally on the 

archive server. The SQL server does not allow access to backup files held elsewhere, such 
as another computer on the network.

● The  and  buttons are configured in the alarm view.

Procedure
To logged alarms in Runtime, follow these steps:

1. In the alarm view, click on the "Short-term archive list"  button to display the logged 
and current alarms. Any new incoming alarms will be immediately updated in the historical 
alarm list (short-term).

-OR-
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1. In the alarm view, click on the "Long-term archive list"  button to display only logged 
alarms. The historical alarm list (long-term) only displays logged alarms. You can enter or 
view comments in the historical alarm list (long-term).

9.3.5.8 Printing Alarms in Runtime

Introduction
You have the following options for printing alarms in Runtime, depending on the settings made 
in the "HMI alarms" and "Reports" editors:

Print alarm sequence report

If the alarm sequence report is activated, all alarm status transitions in Runtime are output 
continuously to a printer. No operator input is needed in Runtime. 

Printing report

The operator input in Runtime depends on your configuration. Your options for printing an 
alarm report in Runtime are as follows:

● Time-driven output

– One-off, time-driven output, e.g. at the start of a shift

– Repeated output at specific intervals, such as every two hours

● Event-driven output

– Change in value of a tag

– By clicking a configured button in a screen

– Click the  button in the alarm view

– Overflow of a log

– Script

Requirement
● Several alarms are displayed on the HMI device.

Procedure
To print the current view in the alarm window in Runtime, follow these steps:

1. Filter the alarm view using the alarm view controls, if necessary.

2. Click the  button in the alarm view.

Result
The alarms displayed in the alarm window are output to the printer that you configured in the 
"Reports" editor.
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Printer settings
Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. For detailed information, refer to the operating 
instructions of your HMI device and to the "Reporting alarms" chapter. 

See also
Working with reports (Page 1609)

9.3.5.9 Locking Alarms in Runtime

Locking Single Alarms

Introduction
If you lock an alarm, this alarm will not be displayed, and will not be logged. You can lock single 
alarms, alarm classes or alarm groups as required.

 

 Note
Locked alarm:

Locked alarms are automatically unlocked when WinCC Runtime restarts. Only alarms that 
are locked directly in the AS by means of data blocks will continue to be locked (locking at 
source).
Locked alarm classes / alarm groups:

The locked state of alarm classes and alarm groups is not affected by a restart of WinCC 
Runtime.

 

Requirement
● The alarm view has been configured.

● The alarm view is displayed in Runtime.

● The "Lock alarm / Unlock alarm" button  /  is configured.

● You are authorized to lock, and unlock alarms.
 

  Note

The "Lock alarm", and "Unlock alarm" authorizations must be configured directly one 
above the other. This is necessary because the authorization level used automatically for 
the "Unlock alarms" authorization is directly below the "Lock alarms" authorization.
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Procedure
To lock alarms and prevent them being displayed using the button, follow these steps:

1. Select the alarm that you want to lock from the alarm view.

2. Click the button.
The alarm is removed from the alarm list.

3. Click on the  button to view all locked alarms.
The lock list is displayed.

4. Select the alarm that you want to unlock.

5. Click the button.
The alarm is displayed again and removed from the lock list.

 

  Note

Locking/unlocking an Alarm_8(P) alarm by means of S7PMC always causes all 8 alarms 
of this block to be locked, or unlocked. 
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Locking alarms by means of alarm number

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
Proceed as follows to lock alarms and prevent them being displayed using the alarm number:

1. Click the button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. Click the "Add" button. In the subsequent dialog, enter the alarm number that you want to 
lock.

4. You can lock multiple alarms at the same time. To do this, enter the alarm numbers, 
separated by commas. Enter a range of numbers in the format "5-10". Only contiguous 
number ranges are locked. If there are gaps in the specified range, an "Invalid range" 
message is output.

5. To unlock a locked alarm, select the alarm from the list of locked alarms, and click the 
"Delete" button.

 

  Note

You cannot lock, or unlock more than 50 alarms at the same time. 
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Locking Alarms using the Alarm Class or Alarm Group

Introduction
You can also lock alarms to prevent them from being displayed by locking the entire alarm 
class, or the alarm group to which the alarm belongs. None of the alarms from these locked 
alarm groups and alarm classes will be displayed.

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
To lock, or unlock alarms via the alarm class, or the alarm group, proceed as follows:

1. In the alarm view, click the  button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. In the tree structure, select an alarm class or user-defined alarm group that you want to 
lock.

4. Click the "Lock" button.
All alarms from this alarm class or user-defined alarm group are locked.

To unlock the alarms, select the alarm class or user-defined alarm group and click on the 
"Unlock" button.
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Operator input alarm when an alarm is locked
You can define in the alarm view, whether an operator input alarm is generated when an alarm 
is locked or unlocked. You should configure the operator input alarm yourself if needed. The 
operator input alarm contains the following objects by default:

● A time stamp

● The user logged on

The time stamp for the alarm originates as follows:

● From the alarm source (such as an AS) for active locking.

Actively-locked alarms are visible, and can be used on all HMI devices.

9.3.5.10 Acknowledgement of Alarms

Acknowledging alarms 

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● With customized buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To bypass the acknowledgement in Runtime, WinCC contains system functions and scripts 
that allow you to acknowledge alarms automatically.

Acknowledgement variants
You acknowledge individual alarms or multiple alarms together in Runtime. The following 
options are possible:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgement of all the alarms of an alarm group using a button, or a function key.

● Group acknowledgement
Acknowledgement of all pending alarms in the alarm view that require acknowledgement 
using the  button in the alarm view.

● Dual-mode acknowledgment
If an alarm requires dual-mode acknowledgment, you acknowledge both the incoming, and 
the outgoing alarm.
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Requirement
An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, follow these steps:

● Select the alarm.

● Click the  button in the alarm view.

Result
The alarm status is set to "Acknowledged". If the trigger condition for an alarm no longer 
applies, the alarm status is also set to "outgoing" and no longer displayed on the HMI device. 

Group Alarm Acknowledgement

Introduction
The acknowledgement of all pending, and visible alarms in the alarm window that need to be 
acknowledged is known as a group acknowledgement. If the "Single alarm" option is not 
selected for an alarm, you can trigger a group acknowledgment. 

Requirement
There are several alarms that require acknowledgement in the alarm view.

Procedure
To group-acknowledge an alarm, follow these steps:

1. Read the alarm texts of the queued alarms and initiate remedial action, if necessary.

2. In the alarm view, click the  button.

Result
All queued alarms with the following properties are acknowledged:

● Requires acknowledgement

● Does not require acknowledgement

● Visible
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Emergency acknowledgment of alarms

Introduction
In exceptional situations, the operator acknowledges an alarm based on its alarm number. The 
acknowledgment bit is sent to the AS even if the alarm is currently not pending. This function 
is only intended for use in imminent emergency situations. 

Requirement
The  button is configured in the alarm view.

Procedure
To acknowledge an alarm in Runtime using an emergency acknowledgement, follow these 
steps:

1. Click the  button in the alarm view.
The "Emergency Acknowledgment for Alarms" dialog opens.

2. Select a server.

3. To enter the alarm number, select "Alarm number".

4. Click the "Send acknowledge job" button.
The alarm then appears in the alarm view in the color that you defined for an acknowledged 
alarm.

 

  Note

In the dialog for selecting the servers, only server projects whose "Packages" are loaded 
onto the PC are shown. 
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Acknowledging an alarm annunciator

Introduction
The way you acknowledge an alarm annunciator in Runtime will depend on how you configured 
its acknowledgement. 

Requirements
● The alarm annunciator and its acknowledgment are configured.

● The alarm annunciator is triggered.

Acknowledgment using a separate key
● To acknowledge the alarm annunciator, click the  button in the alarm view.

You only acknowledge the alarm annunciator. The alarm that triggered the alarm 
annunciator is still set to "incoming" status.

Single acknowledgment
● To acknowledge the alarm annunciator, select the current alarm, and click the  button 

in the alarm view. 
You thereby acknowledge the alarm annunciator and the alarm that triggered the alarm 
annunciator.

Acknowledgment tag
If the alarm annunciator is acknowledged using a tag, acknowledge the alarm annunciator 
using a customized button or function key, etc.

Result
This sets the acknowledgment bit of the alarm annunciator.
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9.3.6 Reference

9.3.6.1 System functions for alarms

System functions
System functions are predefined functions you can use to implement many tasks in runtime, 
even with no programming knowledge. You use system functions in a function list or in a 
script.   

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

The table shows all the system functions available for displaying and editing alarms.

System function Effect 
EditAlarm Triggers the Loop-In-Alarm event for all selected 

alarms.
ClearAlarmBuffer Deletes alarms from the alarm buffer on the HMI 

device.
ClearAlarmBufferProtoolLegacy Function such as "ClearAlarmBuffer". This system 

function has been retained to ensure compatibility 
and uses the old ProTool numbering. 

AlarmViewUpdate Updates the advanced alarm view.
AlarmViewEditAlarm Triggers the event Loop-In-Alarm for all alarms 

selected in the specified alarm view.
AlarmViewAcknowledgeAlarm Acknowledges the alarms that are selected in the 

specified alarm view.
AlarmViewShowOperatorNotes Displays the configured tooltip for the alarm 

selected in the specified alarm view.
AcknowledgeAlarm Acknowledges all selected alarms.
SetAlarmReportMode Switches the automatic reporting of alarms on the 

printer on or off.
ShowAlarmWindow Hides or shows the alarm window on the HMI 

device.
ShowSystemEvent Displays the value of the delivered parameter as 

a system event on the HMI device.
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 Note
Device dependency

The following system functions are not available for all HMI devices:
● SetAlarmReportMode
● AlarmViewUpdate
● ShowSystemEvent

 

9.3.6.2 Alarm events 

Alarm events and their display and control objects
In Runtime, the following alarm events are triggered by their display and control objects. You 
can configure a function list for every event.  

Object Configurable events
Alarms Incoming

Outgoing
Acknowledge
Loop-In-Alarm

Alarm view Enabling
Disable
Selection changed

Alarm indicator Click
Click when flashing

 

 Note
Device dependency

The following events in the alarm view are not available for all HMI devices:
● Enabling
● Disable
● Selection changed
● Click
● Click when flashing

 

See also
Events (Page 1839)
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9.3.6.3 Alarm events

Alarm events and their display and control objects
In Runtime, the following alarm events are triggered by their display and control objects. You 
can configure a function list for every event.  

Object Configurable events
Alarms Incoming

Outgoing
Acknowledge
Loop-In-Alarm
Status changed

Alarm view Enabling
Loaded
ToolbarButtonClicked
PropertyChanged
ToolbarButtonPropertyChanged
AlarmBlockPropertyChanged
AlarmColumnPropertyChanged
HitlistColumnPropertyChanged
OperatorAlarmPropertyChanged

See also
Events (Page 1839)

9.3.6.4 System functions for logs

System functions
The following system functions are available for logging:

Function name Function method
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function, for example, to move the audit 
trail from a local storage medium to the server.
When handling audit trails, always use the "Move log (hmiMove)" mode in 
order to avoid noncompliance with FDA guidelines as a result of redundant 
data storage. 

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.
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Function name Function method
StopLogging Stops the logging process in the specified log. To resume logging in 

Runtime, select the "StartLogging" system function.
ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

sequential log that has been configured for the specified log file.
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is recovered.

CopyLog Copies the contents of the specified log to another log.

9.3.6.5 Structure of *.csv files that contain alarms

Introduction
You can save an alarm log as a file in "*.csv" format. CSV stands for Comma Separated Value. 
In this format, the table columns that contain the names and the value of the entry are separated 
by semicolons. Each table row terminates with a line break.  

Example of a log file in *.csv format
This example shows a file with logged alarms:  

"Time_ms";"MsgProc";"StateAfter";"MsgClass";"MsgNumber";"Var1";...;"Var8";"TimeString";"
MsgText";"PLC"37986550590,27;1;1;3;110001;"";...;"";"30.06.99 13:12:51";"Change to 
operating mode 'online'";37986550682,87;1;1;3;140010;"";...;"";"30.06.99 
13:12:59";"Connection established: PLC_1, Station 2, Rack 0, Position 2"; 

Structure of a log file in *.csv format
The following values are entered in the log file columns:

Parameters Description
Time_ms Specify a time stamp as a decimal value ( see below for conversion)
Msg_Proc Alarm procedures: 

0 = Unknown alarm procedure
1 = System event
2 = Alarm bit procedure (operating alarms)
3 = Alarm number procedure ALARM_S
4 = Diagnostic event
7 = Analog alarm procedure
100 = Alarm bit procedure (fault alarms)
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Parameters Description
State after Alarm event: 

0 = Incoming/Outgoing
1 = Incoming
2 = Incoming/Acknowledged/Outgoing
3 = Incoming/Acknowledged
6 = Incoming/Outgoing/Acknowledged

Msg_Class Alarm class: 
0 = No alarm class
1 = "Errors"
2 = "Warnings"
3 = "System"
4 = "Diagnosis Events"
64 ... = of alarm classes configured by the user

Msg Number Alarm number
Var1 to Var8 Value of the trigger tag as a STRING
Time string Time stamp, as STRING in legible data format
Msg text Alarm in a readable STRING
PLC Alarm localization (relevant PLC)

Conversion of the time stamp decimal value
To further process the time stamp value using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: 37986476928 : 1.000.000 = 37986,476928

2. The whole number portion (37986) is the date calculated from 31.12.1899.
In Excel you can now convert the time stamp into days. To do this, assign to the cell that 
contains the time stamp, a respective format form the "Date" group.
Result: 37986 results in 31.12.2003

3. The value after the comma (0,476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46,579
This conversion is supported by Microsoft Excel, for example. 

9.3.6.6 Description of the System Blocks

Introduction      
System blocks allow you to specify predefined information that is not freely utilizable, such as 
date, time and duration.

The value of the alarm text block (such as the time of day) is displayed in the alarm. The 
description of the system blocks provides information on the individual system blocks.
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Overview

System block Description Default 
length

Date Date of the "incoming", "outgoing", and "acknowledged" 
alarm statuses.

8

Time of day Time of the "incoming", "outgoing", and "acknowledged" 
alarm statuses. 
Accuracy of a WinCC time stamp: 1 s. 
Display accuracy: 10 ms.

9

Duration Time period between the "incoming", "outgoing", and 
"acknowledged" statuses. 
There is only one column for duration:
● The column remains blank for alarms with "incoming" 

status.
● For alarms with "outgoing" status, the time that 

elapses between "incoming" and "outgoing" is 
displayed.

● When alarms are acknowledged, the time between 
"incoming" and "outgoing" is displayed.

8

Daylight Saving Time/
Standard Time

Indicates whether daylight saving time is set. 1

Status Indicates the alarm status, such as "Incoming" or 
"Outgoing". 
The letters displayed in this system block to indicate the 
alarm status (such as "Q") are assigned in the alarm class.

1

Acknowledgment status Indicates whether an alarm has been acknowledged. 
The letters that are displayed in this system block to 
indicate the acknowledgment status are configured in the 
alarm class.

1

Number Alarm number 3
Class Alarm class

The text is user-defined.
8

Category Alarm types 8
PLC/CPU number
 

Number of the CPU and AS in which the alarm was 
triggered. 
In Runtime, the value of this system block is not taken 
from the AS but rather is taken from the configured data 
for the alarm. The value has no function in communication 
with the AS.

2

Tag The "Tag" system block is not yet supported. 1
Log ID ID indicating whether the alarm is to be logged. 1
Report ID ID indicating whether the alarm is to be reported. 

The report ID depends on the alarm number. You only 
have read access to the report ID.

1

Comment Indicates whether there is a comment for this alarm. A 
comment is the users input about an alarm, such as "This 
alarm occurred today because...".

1
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System block Description Default 
length

Tooltip Indicates whether there is a tooltip for this alarm. Tooltips 
contain information about the alarm, limited to 255 
characters, such as "This alarm may occur if ...". Tooltip 
cannot be edited in Runtime.

1

Loop-In-Alarm Indicates whether Loop-In-Alarm function is enabled. 1
Computer Name Indicates the name of the PC:

● If the user has entered a comment in the "Historical 
alarm list" (long-term) and then changed the view, the 
name of the PC used appears in the "Historical alarm 
list" (short-term) and "Historical alarm list" (long-term).

● If an alarm was acknowledged on a PC, the name of 
the PC appears in the "Historical alarm lists" (short 
and long-term) in the operator input alarm. The 
operator input alarm must be enabled under 
"Operator input alarm" in the Inspector window for the 
alarm view.

10

User Name Indicates the name of the user (login name):
● If you enter a comment in the "Historical alarm list" 

(long-term) and then exit the view, your user name is 
displayed in the "Historical alarm list" (short-term) and 
"Historical alarm list" (long-term).

● If an alarm was acknowledged by a user logged on to 
WinCC, the user name is displayed in the "Historical 
alarm lists" (short and long-term) in the operator input 
alarm. The operator input alarm must be enabled 
under "Operator input alarm" in the Inspector window 
for the alarm view.

10

Priority Defines the priority of an alarm. You can sort the alarms 
in the alarm view by priority. By sorting by priority, you 
can ensure that, in a single-line alarm view, the most 
important alarm (high priority) is shown in the display 
area. A lower-priority alarm will not be displayed, even if 
it is more recent.
Range: 0 - 16 
In WinCC, the value corresponding to the highest priority 
is not specified. In the PCS7 environment, the value 16 
corresponds to the highest priority.

3

 
 

 Note

If you enabled the "Change ISO8601 format on all components" option in the shortcut menu 
of WinCC RT Professional, "Properties > Time settings > Central date and time formatting", 
the date and time are also displayed in the system blocks of the alarms in ISO8601 format.
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9.3.6.7 SQL Statements for Filtering the Alarm View

Introduction  
In the alarm view, you can only use SQL statements that can be generated using the "Specify 
selection" dialog. The following conditions apply to WinCC: 

● Structure: "Field", "Address", and "Value"
Separate individual parameters with spaces. 
Example:
DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 
All alarms from 21.12.2006 with an alarm number greater than or equal to 100

● The following information is entered in single quotes:

– Character strings

– Date

– Time of day

● In the DATETIME argument, the date and time of day are separated by a blank. Regardless 
of the time base setting in the object properties, the output of DATETIME is based on the 
time base Local Time. The exception to this is when "UTC" is set as the time base. In this 
case, output is based on the time base "UTC".

Permissible Arguments

Name SQL name Type Data Example
Date/time DATETIME Date 'YYYY-MM-DD 

hh:mm:ss.msmsms'
DATETIME >= '2007-05-03 
16:00:00.000'
Outputs alarms as of 05/03/2007, 16:00 
hours.

Number MSGNR Integer Alarm number MSGNR >= 10 AND MSGNR <= 12
Outputs the alarms with alarm numbers 
10 - 12.

Class CLASS IN Integer Alarm class ID 1-256 and 
"System" alarm classes 17 + 18

CLASS IN ( 1 )
Outputs alarms of alarm class 1.

Status STATE Integer Value "ALARM_STATE_xx"
Only the operands "=" and "IN(...)" 
are permitted.
ALARM_STATE_1
ALARM_STATE_2
ALARM_STATE_3
ALARM_STATE_4
ALARM_STATE_10
ALARM_STATE_11
ALARM_STATE_16
ALARM_STATE_17

STATE IN(1,2,3)
Outputs all alarms that came in, went out 
and were acknowledged.
Possible values:
1 = incoming alarms
2 = outgoing alarms
3 = acknowledged alarms
4 = blocked alarms
10 = hidden alarms
11 = displayed alarms
16 = alarms acknowledged by the 
system
17 = Emergency-acknowledged alarms
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Name SQL name Type Data Example
Priority PRIORITY Integer Alarm priority 0 - 16 PRIORITY >= 1 AND PRIORITY =< 5

Outputs alarms that have a priority 
between 1 and 5.

Controller 
number

AG_NR Integer Controller number AG_NR >= 2 AND AG_NR <= 2
Outputs alarms with the Controller 
number 2.

CPU number CPU_NR Integer AG sub-number CPU_NR >= 5 AND CPU_NR <= 5
Outputs alarms with AG sub-number 5.

Instance INSTANCE Text Instance -
Block: 1
...
Block: 10

TEXTxx Text Search string for Text1 - Text10 TEXT2 = "Error"
Outputs the alarms whose Text2 
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the alarms whose Text2 
corresponds with the text "Error" or 
"Fault".
TEXT2 LIKE 'Error'
Outputs the alarms whose Text2 
includes the text "Error".

Process value: 1
...
Process value: 
10

PVALUExx Double Search value for PVALUE1-
PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Outputs process value 1 with start value 
0 and stop value 50.

Permissible Operands
● >= , <= , = , > , <

● IN(...) : Several values as an array, separated by commas, e.g.: CLASS IN( 1 ,2 ,3 ).

● LIKE : Text must contain string, e.g.: TEXT1 LIKE 'Error' relays alarm where Text1 contains 
the search string "Error". The operand LIKE is only allowed for "text" type arguments.

Illegal arguments and operands 
Only the arguments indicated in the table and operands from the list are permitted.

Grouping arguments, with brackets, for example, is not permitted.

9.3.6.8 System events 

Basics on system events

System events
System events on the HMI device provide information about internal states of the HMI device 
and PLC.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
1418 System Manual, 08/2011,  



The following overview illustrates when a system event occurs and how to eliminate the cause 
of error.

 

 Note
HMI device dependency

Some of the system events described in this section apply to the individual HMI devices based 
on their scope of functions.

 

 
 

 Note

System events are output in an alarm view. System events are output in the language 
currently set on your HMI device.

 

System event parameters  
System events may contain encrypted parameters. The parameters are of relevance when 
troubleshooting because they provide a reference to the source code of the Runtime software. 
These parameters are output after the "Error code:" text.

10000 - Printer alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 9-2 10000 - Printer alarms

Number Effect/cause Remedy
10000 The print job could not be started or was canceled 

due to an unknown error. Faulty printer setup. Or: 
No authorization is available for accessing the 
network printer.
Power supply failure during data transfer.

Check the printer settings, cable connections and the 
power supply.
Set up the printer once again. Obtain a network printer 
authorization.
If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not 
been set up.

Install a printer and/or select it as the default printer.

10002 Overflow of the graphics buffer for printing. Up to two 
graphics are buffered.

Allow sufficient intervals between successive print jobs.

10003 Graphics can now be buffered again. --
10004 Overflow of the buffer for printing lines in text mode 

(e.g. alarms). Up to 1000 lines are buffered.
Allow sufficient intervals between successive print jobs.

10005 Text lines can now be buffered again. --
10006 The Windows printing system reports an error. Refer 

to the output text and the error ID to determine the 
possible causes. Nothing is printed or the print is 
faulty.

Repeat the action if necessary. 
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20000 - Global script alarms

Meaning of the system events  
All system events that can be displayed are listed below. The system events are divided into 
different ranges.

Table 9-3 20000 - Global script alarms

Number Effect/causes Remedy
20010 An error has occurred in the specified script line. 

Execution of the script was therefore aborted. Note 
the system event that may have occurred prior to 
this.

Select the specified script line in the configuration. 
Ensure that the tags used are of the allowed types. For 
system functions, verify the correct number of 
parameters and the parameter types.

20011 An error has occurred in a script that was called by 
the specified script. 
Execution of the script was therefore aborted in the 
called script. 
Note the system event that may have occurred prior 
to this. 

In the configuration, select the script that has been 
called directly or indirectly by the specified script. 
Ensure that the tags used are of the allowed types. 
For system functions, verify the correct number of 
parameters and the parameter types.

20012 Inconsistent configuration data. The script could 
therefore not be generated.

Recompile the configuration data.

20013 Incorrect installation of the scripting component of 
WinCC Runtime. Therefore, no scripts can be 
executed.

Reinstall WinCC Runtime on your PC.
Recompile your project using the "Compile > Software 
(compile all)" command from the context-sensitive 
menu and then download the project to the HMI device.

20014 The system function returns a value that is not 
written in any return tag.

Select the specified script in the configuration.
Check whether the script name has been assigned a 
value.

20015 Too many successive scripts have been triggered in 
short intervals. When more than 20 scripts are 
queued for processing, any subsequent scripts are 
rejected. In this case, the script indicated in the 
alarm is not executed.

Check what is triggering the scripts. Extend the times, 
e.g. the acquisition cycle of the tag initiating the script.

30000 - Alarms errors when using system functions

Meaning of the system events
All system events that can be displayed are listed below. The system events are divided into 
different ranges.
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Table 9-4 30000 - Alarms errors when using system functions

Number Effect/causes Remedy
30010 The tag could not accept the function result, e.g. 

when it has exceeded the value range.
Check the tag types of the system function parameters.

30011 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.

30012 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.

40000 - Linear scaling alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 9-5 40000 - Linear scaling alarms

Number Effect/causes Remedy
40010 The system function could not be executed since the 

parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

40011 The system function could not be executed since the 
parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

50000 - Data server alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 9-6 50000 - Data server alarms

Number Effect/causes Remedy
50000 The HMI device is receiving data faster than it is 

capable of processing. Therefore, no further data is 
accepted until all current data have been processed. 
Data exchange then resumes.

--

50001 Data exchange has been resumed. --
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60000 - Win32 function alarms

Meaning of the system events 
All system events that can be displayed are listed below. 

Table 9-7 60000 - Win32 function alarms

Number Effect/causes Remedy
60000 This alarm is generated by the "ShowSystemEvent" 

system function. The text to be displayed is 
transferred to the function as a parameter.

--

60010 The file could not be copied in the direction defined 
because one of the two files is currently open or the 
source/target path is not available.
It is possible that the Windows user has no access 
rights to one of the two files.

Restart the system function or check the paths of the 
source/target files. In Windows NT/XP: Users executing 
WinCC Runtime must be granted access to the files.

60011 An attempt was made to copy a file to itself.
It is possible that the Windows user has no access 
rights to one of the two files.

Check the path of the source/target file.
In Windows NT//XP and NTFS file system: Users 
executing WinCC Runtime  must be granted access to 
the files.

70000 - Win32 function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-8 70000 - Win32 function alarms

Number Effect/causes Remedy
70010 The application could not be started because it could 

not be found in the path specified or there is 
insufficient memory space.

Check whether the application exists in the specified 
path or close other applications.

70011 The system time could not be modified.
The error alarm only appears in connection with area 
pointer "Date/time PLC". Possible causes:
● An invalid time was transferred in the job mailbox.
● The Windows user has no right to modify the 

system time.
If the first parameter in the system event is displayed 
with the value 13, the second parameter indicates 
the byte containing the incorrect value.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70012 Error when executing the function "StopRuntime" 
with the "Runtime and operating system" option.
Windows and WinCC Runtime are not closed. 
The error was possibly generated because other 
programs cannot be closed. 

Close all programs currently running.
Then close Windows.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
1422 System Manual, 08/2011,  



Number Effect/causes Remedy
70013 The system time could not be modified because an 

invalid value was entered. Incorrect separators may 
have been used.

Check the time which is to be set.

70014 The system time could not be modified. Possible 
causes:
● An invalid time was transferred.
● The Windows user has no right to modify the 

system time.
Windows rejects the setting request.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70015 The system time could not be read because 
Windows rejects the reading function.

--

70016 An attempt was made to select a screen by means 
of a system function or job. This is not possible 
because the screen number specified does not exist.
Or: A screen could not be generated due to 
insufficient system memory.
Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with the 
screen numbers configured.
Assign the number to a screen if necessary.
Check the details for the screen call and whether the 
screen is blocked for specific users.

70017 Date/time is not read from the area pointer because 
the address set in the PLC is either not available or 
has not been set up.

Change the address or set up the address in the PLC.

70018 Acknowledgment that the password list has been 
successfully imported.

--

70019 Acknowledgment that the password list has been 
successfully exported.

--

70020 Acknowledgment for activation of alarm reporting. --
70021 Acknowledgment for deactivation of alarm reporting. --
70022 Acknowledgment to starting the Import Password 

List action.
--

70023 Acknowledgment to starting the Export Password 
List action.

--

70024 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70025 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70026 No other screens are stored in the internal screen 
memory.
No other screens can be selected.

--

70027 The backup of the RAM file system has been started. --
70028 The files from the RAM have been copied in the 

Flash memory.
The files from the RAM have been copied in the 
Flash memory. Following a restart, these saved files 
are copied back to the RAM file system.

--

70029 Backup of the RAM file system has failed.
No backup copy of the RAM file system has been 
made.

Check the settings in the "Control Panel > OP" dialog 
and save the RAM file system using the "Save Files" 
button in the "Persistent Storage" tab.
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Number Effect/causes Remedy
70030 The parameters configured for the system function 

are faulty.
The connection to the new PLC was not established.

Compare the parameters configured for the system 
function with the parameters configured for the PLCs 
and correct them as necessary.

70031 The PLC configured in the system function is not an 
S7 PLC.
The connection to the new PLC was not established.

Compare the S7 PLC name parameter configured for 
the system function with the parameters configured for 
the PLC and correct them as necessary.

70032 The object configured with this number in the tab 
sequence is not available in the selected screen.
The screen changes but the focus is set to the first 
object.

Check the number of the tab sequence and correct it if 
necessary.

70033 An e-mail cannot be sent because a TCP/IP 
connection to the SMTP server no longer exists.
This system event is generated only at the first 
attempt. All subsequent unsuccessful attempts to 
send an e-mail will no longer generate a system 
event. The event is regenerated when an e-mail has 
been successfully sent in the meantime.
The central e-mail component in WinCC Runtime 
attempts to connect to the SMTP server at cyclic 
intervals (1 minute) in order to transmit the remaining 
e-mails.

Check the network connection to the SMTP server and 
re-establish it if necessary.

70034 Following a disruption, the TCP/IP connection to the 
SMTP server could be re-established.
The queued e-mails are then sent.

--

70036 No SMTP server for sending e-mails is configured. 
An attempt to connect to an SMTP server has failed 
and it is not possible to send e-mails.
WinCC Runtime generates the system event after 
the first attempt was made to send an e-mail.

Configure an SMTP server:
In the WinCC Engineering System
using "Device settings > Device settings"
In the Windows CE operating system
using "Control Panel > Internet Settings > E-mail > 
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons.
The contents of the e-mail are lost.

Check the e-mail parameters (recipient etc.).

70038 The SMTP server has rejected sending or 
forwarding an e-mail because the domain of the 
recipient is unknown to the server or because the 
SMTP server requires authentication.
The contents of the e-mail are lost.

Check the domain of the recipient address or disable 
the authentication on the SMTP server if possible. 
SMTP authentication is currently not used in 
WinCC Runtime.

70039 The syntax of the e-mail address is incorrect or 
contains illegal characters.
The contents of the e-mail are discarded.

Check the e-mail address of the recipient.

70040 The syntax of the e-mail address is incorrect or 
contains illegal characters.

--

70041 The import of the user management was aborted 
due to an error.
Nothing was imported.

Check your user administration or download it again to 
the panel.

70042 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.

70043 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.
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Number Effect/causes Remedy
70044 An error occurred while sending the e-mails. The e-

mails were not sent. 
Check the SMTP settings and the error message in the 
system event.

70045 Cannot load a file required for encrypting the e-mail. Update the operating system and Runtime.
70046 The server does not support encryption. Select an SMTP server that supports encryption.
70047 The SSL versions of the HMI device and SMTP 

server may not be compatible.
Contact your network administrator or the operator of 
the SMTP server.

80000 - Log alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-9 80000 - Log alarms

Number Effect/causes Remedy
80001 The log specified is filled to the size defined (in 

percent) and must be stored elsewhere.
You swap out the file or table by executing a ‘move’ or 
‘copy’ function.

80002 A line is missing in the specified log. --
80003 The copying process for logging was not successful.

In this case, it is advisable to check any subsequent 
system events, too.

--

80006 Since logging is not possible, this causes a 
permanent loss of the functionality.

In the case of databases, check whether the 
corresponding data source exists and start up the 
system again.

80009 A copying action has been completed successfully. --
80010 An incorrect storage location was entered in WinCC 

and causes permanent loss of functionality.
Configure the storage location for the respective log 
again and restart the system when the full functionality 
is required.

80012 Log entries are stored in a buffer. If the values are 
read to the buffer faster than they can be physically 
written (using a hard disk, for example), overloading 
may occur and recording is then stopped.

Archive fewer values.
Or:
Increase the logging cycle.

80013 The overload status no longer exists. Archiving 
resumes the recording of all values.

--

80014 The same action was triggered twice in quick 
succession. Since the process is already in 
operation, the action is only carried out once.

--

80015 This system event is used to report DOS or database 
errors to the user.

--

80016 The logs are separated by system function 
"CloseAllLogs" and the incoming entries exceed the 
defined buffer size.
All buffer entries are deleted.

Reconnect the logs.
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Number Effect/causes Remedy
80017 The number of incoming entries cause a buffer 

overflow. This can be caused, for example, by 
several copying actions being activated at the same 
time.
All copy jobs in the buffer are deleted.

Stop the copy action. 

80019 The connection between WinCC and all log files was 
shut down, for example, after execution of the 
"CloseAllLogs" system function.
Entries are written to the buffer and written to the 
logs when the connection is recovered. 
There is no connection to the storage location and 
the storage medium can be changed.

--

80020 The maximum number of simultaneously copy 
operations has been exceeded. Copying is not 
executed.

Wait until the current copying actions have been 
completed, then restart the last copy action.

80021 An attempt was made to delete a log which is still 
busy with a copy action. Deletion has not been 
executed.

Wait until the current copying actions have been 
completed, then restart the last action.

80022 An attempt was made to use system function 
"StartSequenceLog" to start a sequence log for a log 
which is not configured as sequence log. No 
sequence log file is created.

In the project, check
● whether the "StartSequenceLog" system function 

was properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80023 An attempt was made to copy a log to itself.

The log is not copied.
In the project, check
● whether the "CopyLog" system function was 

properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80024 In your configuration, you specified that the 

"CopyLog" system function should not allow copying 
if the destination log already contains data ("Mode" 
parameter). The log is not copied.

Edit the "CopyLog" system function in your 
configuration, if necessary. Before you initiate the 
system function, delete the destination log file.

80025 You have canceled the copy operation.
Data written up to this point are retained. The target 
log file (if configured) was not deleted.
The cancellation is reported by an error entry 
$RT_ERR$  at the end of the target log.

--

80026 This alarm is output after all logs are initialized. 
Values are written to the logs from then on. No 
entries are written to the logs before this time has 
expired, irrespective of the active state of 
WinCC Runtime.

--

80027 The internal Flash memory has been specified as 
the storage location for a log. This is not permissible.
No values are written to this log and the log file is 
not created.

Configure "Storage Card" or network path as the 
storage location.

80028 The alarm serves as status report indicating that the 
logs are currently being initialized. No values are 
logged until the alarm 80026 is output.

--
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80029 The number of logs specified in the alarm could not 

be initialized. Initialization of logs was finished.
 The faulty log files are not available for logging jobs.

Evaluate the additional system events related to this 
alarm. Check the configuration, the ODBC (Open 
Database Connectivity), and the specified drive.

80030 The structure of the existing log file does not match 
the expected structure.
Logging is stopped for this log.

Delete the existing log data manually, in advance.

80031 The log in CSV format is corrupted.
The log cannot be used.

Delete the faulty file.

80032 Logs can be configured with events. These are 
triggered as soon as the log is full. Assuming 
WinCC Runtime is started and the log is already full, 
the event would never be triggered.
The specified log is full and no longer accepts data.

Close WinCC Runtime, delete the log, and restart 
WinCC Runtime.
Or:
Configure a button which contains the same actions as 
the event and press it.

80033 "System Defined" is set in the data log file as the 
data source name. This causes an error. No data is 
written to the database logs, whereas the logging to 
the CSV logs works.

Reinstall SQL Sever 2005 Express.

80034 An error has occurred in the initialization of the logs. 
An attempt has been made to create the tables as a 
backup. This action was successful. A backup copy 
of the tables of the corrupted log file was generated 
and the cleared log restarted.

No action is necessary. However, it is recommended to 
save the backup files or delete them in order to make 
the space available again.

80035 An error has occurred in the initialization of the logs. 
An attempt has been made to create backups of the 
tables and this has failed. No logging or backup has 
been performed.

It is recommended to save the backups or to delete them 
in order to release memory.

80044 The export of a log was interrupted because 
Runtime was closed or due to a power failure. At the 
restart of Runtime, it was detected that the export 
must be resumed.

The export resumes automatically.

80045 The export of a log was interrupted due to an error 
in the connection to the server or at the server itself.

The export is repeated automatically. Check:
● The connection to the server.
● If the server is running.
● If there is enough free space on the server.

80046 The destination file or the associated directory could 
not be created on the server.

Check whether there is enough space on the server and 
it you have permission to create the log file.

80047 The log could not be read while exporting it. Check whether the storage medium is correctly inserted.
80049 The log could not be renamed while preparing to 

export it. 
The job can not be completed."

Check whether the storage medium is correctly inserted 
and if there is sufficient space on the medium.

80050 The log which shall be exported is not closed.
 The job can not be completed.

Make sure to call the "CloseAllLogs" system function 
before using the "ExportLog" system function. Change 
the configuration as required.

80051 The log to be copied contains an invalid checksum.
The log was not copied.

Select a log with a valid checksum. The selected log 
may have been manipulated.

80052 The log cannot be read. Check the log and the specified path.
80053 The closed log cannot be read. Open the log.
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90000 - FDA alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-10 90000 - FDA alarms

Number Effect/causes Remedy
90024 No operator actions can be logged due to lack of 

space on the storage medium for log. The operator 
action will therefore not be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90025 No user actions can be logged because of error 
state of the archive. Therefore the user action will 
not be executed.

Check whether the storage medium is correctly inserted.

90026 No operator actions can be logged because the log 
is closed. The operator action will therefore not be 
executed.

Before further operator actions are carried out, the log 
must be reopened with the help of system function 
"OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.
90029 Runtime was closed during ongoing operation 

(perhaps due to a power failure) or a storage 
medium in use is incompatible with Audit Trail. An 
Audit Trail is not suitable if it belongs to another 
project or has already been logged.

Ensure that you are using the correct storage medium.

90030 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90031 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90032 Running out of space on the storage medium for log. Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90033 No more space on the storage medium for log. As 
of now, no more operator actions requiring logging 
will be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90039 You do not have the necessary authorization to 
perform this action. 

Adapt or upgrade your authorizations.

90040 Audit Trail is switched off because of a forced user 
action.

Reactivate the "Audit Trail" with the help of system 
function "StartLog".

90041 A user action which has to be logged has been 
executed without a logged on user.

A user action requiring logging should only be possible 
with permission. Change the configuration by setting a 
required authorization for the input object.

90044 A user action which has to be confirmed was 
blocked, because there is another user action 
pending.

Repeat the user action if necessary.

90048 The Audit Trail  cannot be printed while data 
relevant to the audit is being logged.

Stop logging by calling system function "StopLogging".

90049 Access to required file is not possible. Check the network connection or the storage medium.
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90056 The recipe was not imported because the file 

contains no checksum.
Select a file with a checksum.
You can also disable checksum verification by calling 
system function "ImportDataRecords".

90057 The recipe was not imported because the file 
contains an invalid checksum. The selected file may 
have been manipulated.

Select a file with a valid checksum.

110000 - Offline function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-11 110000 - Offline function alarms

Number Effect/causes Remedy
110000 The operating mode was changed. "Offline" mode 

is now set.
--

110001 The operating mode was changed. "Online" mode 
is now set.

--

110002 The operating mode was not changed. Check the connection to the PLCs.
Check whether the address range for the “Coordination" 
area pointer is present in the PLC.

110003 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "offline" operating mode is now set.

--

110004 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "online" operating mode is now set.

--

110005 An attempt was made to use the 
"SetConnectionMode" system function to set the 
specified PLC to "online" mode, although the entire 
system is in "offline" mode. This changeover is not 
allowed. The PLC remains in "offline" mode.

Switch the complete system to "online" mode and repeat 
execution of the system function.

110006 The content of the "project ID" area pointer does not 
match the project ID configured in WinCC. The 
WinCC Runtime is therefore terminated.

Check:
● the project ID entered on the PLC.
● the project ID entered in WinCC.

120000 - Trend alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 
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Table 9-12 120000 - Trend alarms

Number Effect/causes Remedy
120000 The trend is not displayed because you configured 

an incorrect axis to the trend or an incorrect trend.
Change the configuration.

120001 The trend is not displayed because you configured 
an incorrect axis to the trend or an incorrect trend.

Change the configuration.

120002 The trend is not displayed because the tag assigned 
attempts to access an invalid PLC address.

Check whether the data area for the tag exists in the 
PLC, the configured address is correct and the value 
range for the tag is correct.

130000 - System information alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-13 130000 - System information alarms

Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. Check the following conditions, for example:

● Access to the correct data carrier?
● Is a data carrier inserted?

130004 The data carrier is write-protected. The operation is 
canceled.

Check whether the correct data medium is being 
accessed. Remove the write-protection if necessary.

130005 The file is read only. The operation is canceled. Check whether the correct file is being accessed. 
Change the file attributes.

130006 No access to the file. The operation is canceled. Check the following conditions, for example:
● Is the correct file being accessed?
● Does the file exist?
● Is another action preventing concurrent access to the 

file?
130007 The network connection is interrupted.

Records cannot be saved or read via the network 
connection.

Check the network connection and eliminate the cause 
of error.

130008 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.

130009 The specified folder does not exist on the storage 
card.
The files stored in this directory are not backed up 
after switching off the HMI device.

Insert the storage card.
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130010 The maximum nesting depth can be exhausted 

when, for example, value changes in a script initiate 
the call of an infinite number of further scripts.  
The configured functionality is not provided.

Check the configuration.

130013 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.

140000 - Connection alarms: Connection + device

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-14 140000 - Connection alarms: Connection + device

Number Effect/causes Remedy
140000 An online connection to the PLC is established. --
140001 The online connection to the PLC was shut down. --
140003 No tag update or write operations are executed. Check whether the connection is up and the PLC is 

switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140004 No tag update or write operations are executed due 
to an incorrect access point, or incorrect module 
configuration.

Verify the connection and check whether the PLC is 
switched on.
Check the access point or the module configuration 
(MPI, PPI, PROFIBUS) in the Control Panel with "Set 
PG/PC interface".
Restart the system.

140005 No tag update or write operations are executed due 
to an incorrect HMI device address (possibly too 
high).

Use a different HMI device address.
Verify the connection and check whether the PLC is 
switched on.
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface".
Restart the system.

140006 No tag update or write operations are executed due 
to an incorrect baud rate setting.

Select a different baud rate in WinCC (according to 
module, profile, communication peer, etc.).
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140007 An incorrect bus profile prevents tag updates or 

write operations (see %1).
The following parameters could not be written to the 
registry:
1:  Tslot
2:  Tqui
3:  Tset
4:  MinTsdr
5:  MaxTsdr
6:  Trdy
7:  Tid1
8:  Tid2
9:  Gap Factor
10: Retry Limit

Check the custom bus profile.
Check the connection and whether the PLC is switched 
on.
Check the parameter definitions in the Control Panel 
using "Set PG/PC interface".
Restart the system.

140008 An incorrect baud rate prevents tag updates or write 
operations. The following parameters could not be 
written to the registry: 
0:  General error
1:  Wrong version
2:  Profile cannot be written to the registry.
3:  The subnet type cannot be written to the registry.
4:  The Target Rotation Time cannot be written to 
the registry.
5:  Incorrect Highest Station Address (HSA).

Check whether the connection is up and the PLC is 
switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140009 No tag updates or write operations because the S7 
communication module was not found.

To reinstall the module, open the Control Panel and 
select "Set PG/PC interface".

140010 No S7 communication partner found because the 
PLC is shut down.
DP/T:
The option “PG/PC is the only master” is not set in 
the Control Panel under “Set PG/PC interface”.

Switch on the PLC.
DP/T:
If only one master is connected to the network, disable 
"PG/PC is the only master" in "Set PG/PC interface".
If several masters are connected to the network, enable 
these. Do not change any settings, for this will cause bus 
errors.

140011 No tag updates or write operations because 
communication is down.

Check the connection and whether the communication 
partner is switched on.

140012 There is an initialization problem (e.g. if 
WinCC Runtime was closed in Task Manager).
Or:
Another application (e.g.STEP7) with different bus 
parameters is active and the driver cannot be 
started with the new bus parameters (baud rate, for 
example).

Restart the HMI device.
Or:
Start WinCC Runtime and then start your other 
applications.

140013 The MPI cable is disconnected and, therefore, there 
is no power supply.

Check the connections.

140014 The configured bus address is in use by another 
application.

Change the HMI device address in the PLC 
configuration.

140015 Incorrect baud rate
Or: 
Incorrect bus parameters (e.g. HSA)
Or:
OP address > HSA or: Incorrect interrupt vector 
(interrupt not registered by the driver)

Correct the parameters.
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140016 The hardware does not support the configured 

interrupt.
Change the interrupt number.

140017 The set interrupt is in use by another driver. Change the interrupt number.
140018 SIMOTION Scout disabled the consistency check. 

Only a corresponding note appears.
In SIMOTION Scout, reactivate the consistency check 
and once again download the project to the PLC.

140019 SIMOTION Scout is downloading a new project to 
the PLC. Connection to the PLC is canceled.

Wait until the end of the reconfiguration.

140020 The version in the PLC and in the project (FWX file) 
do not match.
Connection to the PLC is canceled.

The following remedies are available:
Download the current version to the PLC using 
SIMOTION Scout.
Recompile the project using WinCC ES, close 
WinCC Runtime, and restart with the new configuration.

160000 - Connection alarms: OPC: Connection

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 9-15 160000 - Connection alarms: OPC: Connection

Number Effect/causes Remedy
160000 No more data is read or written. Possible causes:

● The cable connection is interrupted.
● The PLC does not respond or has failed, etc.
● The wrong port is used for the connection.
● System overload

Check whether the cable is plugged in and the PLC is 
OK, and whether the correct port is used.
Restart the system if the system event persists.

160001 The connection is recovered because the cause of 
the interruption has been eliminated.

--

160010 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check access rights.

160011 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?

160012 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?
Note for advanced users:
Interpret the value from HRESULT. 
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160013 The specified server was started as InProc server. 

This has not been released and may lead to 
undefined behavior because the server is running 
in the same process area as WinCC Runtime.

Configure the server as OutProc Server or Local Server.

160014 Only one OPC server project can be started on a 
PC/MP. An alarm is output after an attempt was 
made to start a second project.
The second project has no OPC server functionality 
and cannot be located as an OPC server by external 
sources.

Do not start a second project with OPC server 
functionality on the computer.

170000 - S7 dialog alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 9-16 170000 - S7 dialog alarms

Number Effect/causes Remedy
170000 S7 diagnostics events are not indicated because it 

is not possible to log on to the S7 diagnostics 
functions at this device. The service is not 
supported.

--

170001 The S7 diagnostics buffer cannot be viewed 
because communication with the PLC is shut down.

Set the PLC to online mode.

170002 The S7 diagnostics buffer cannot be viewed 
because reading of the diagnostics buffer (SSL) 
was canceled with error.

--

170003 An S7 diagnostics event cannot be visualized. The 
system returns internal error %2.

--

170004 An S7 diagnostics event cannot be visualized. The 
system returns an internal error of error class %2, 
error number %3.

--

170007 It is not possible to read the S7 diagnostics buffer 
(SSL) because this operation was canceled with an 
internal error of class %2 and error code %3.

--

180000 - General alarms

Meaning of the system events  
All system events that can be displayed are listed below. 
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Table 9-17 180000 - General alarms

Number Effect/causes Remedy
180000 A component/OCX received configuration data with 

a version ID which is not supported.
Install a newer component.

180001 System overload because too many actions are 
running in parallel. Certain actions can be executed, 
while others are discarded.

Several remedies are available:
● Generate alarms at a slower rate (polling).
● Initiate scripts and functions at greater intervals.
If the alarm appears more frequently:
Restart the HMI device. 

180002 The screen keyboard could not be activated. 
Possible causes:
"TouchInputPC.exe" was not registered due to 
faulty Setup.

Reinstall WinCC Runtime.

190000 - Tag alarms

Meaning of the system events 
All system events that can be displayed are listed below. 

Table 9-18 190000 - Tag alarms

Number Effect/causes Remedy
190000 It is possible that the tag is not updated. --
190001 The tag is updated after the cause of the last error 

state has been eliminated (recovery of normal 
operation).

--

190002 The tag is not updated because communication with 
the PLC is down.

Select system function "SetOnline" to enable 
communication.

190004 The tag is not updated because the address 
configured for this tag does not exist.

Check the configuration.

190005 The tag is not updated because the configured PLC 
type does not exist for this tag.

Check the configuration.

190006 The tag is not updated because it is not possible to 
map the PLC type in the data type of the tag.

Check the configuration.

190007 The tag value is not modified because the 
connection to the PLC is interrupted or the tag is 
offline.

Set online mode or reconnect to the PLC.

190008 The configured tag limits were violated due to one 
of the following events:
● Value input
● System function
● Script

Observe the configured or current tag limits.

190009 An attempt was made to assign this tag a value that 
is outside the valid range of values for this data type.
For example, input of the value 260 for a byte tag, 
or input of the value -3 for an unsigned word tag.

Observe the range of values for the data type of the tags.
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190010 The rate at which values are written to the tag is too 

high (for example, in a loop triggered by a script).
Values are lost because only up to 100 operations 
are saved to the buffer.

The following remedies are available:
● Extend the interval between multiple write actions.
● Do not use an array tag longer than 6 words when 

configuring an acknowledgment on the HMI device 
using "HMI acknowledgment tag".

190011 Possible cause 1:
The value entered could not be written to the 
configured PLC tag because the high or low limit 
was exceeded.
The system discarded the entry and restored the 
original value.
Possible cause 2:
The connection to the PLC was interrupted.

 
Note that the value entered must be within the range of 
values of the control tag.
 
 
 
 
Check the connection to the PLC.

190012 It is not possible to convert a value from a source 
format to a target format, for example:
An attempt is being made to write a counter value 
that is outside the valid, PLC-specific range of 
values.
A tag of the type Integer should be assigned a value 
of the type string.

Check the range of values, or the data type of the tag.

190013 You entered a string that exceeds the tag length. 
The string is truncated automatically to a valid 
length.

Always enter strings that do not exceed the valid tag 
length.
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190100 - Area pointer alarms

190100 - Area pointer alarms 

Number Effect/causes Remedy
190100 The area pointer is not updated because the 

address configured for this pointer does not exist.
Type
1  Warnings
2  Errors
3  PLC acknowledgment
4  HMI device acknowledgment
5  LED image
6  Trend request
7  Trend transfer 1
8  Trend transfer 2
No.:
Consecutive number displayed in WinCC ES.

Check the configuration.

190101 The area pointer is not updated because it is not 
possible to map the PLC type to the area pointer 
type.
Parameter type and no.:
see alarm 190100

--

190102 The area pointer is updated after the cause of the 
last error state has been eliminated (recovery of 
normal operation). Parameter type and no.: See 
alarm 190100.

--

200000 - PLC coordination alarms

200000 - PLC coordination alarms

Number Effect/causes Remedy
200000 Coordination is not executed because the address 

configured in the PLC does not exist/is not set.
Change the address or set up the address in the PLC.

200001 Coordination is canceled because the write access 
to the address configured in the PLC is not possible.

Change the address or set the address in the PLC at an 
area which allows write access.

200002 Coordination is not carried out at the moment 
because the address format of the area pointer 
does not match the internal storage format.

Internal error

200003 Coordination can be executed again because the 
last error state is eliminated (return to normal 
operation).

--

200004 The coordination may not be executed. --
200005 No more data is read or written. Possible causes:

● The cable is defective.
● The PLC does not respond, is defective, etc.
● System overload

Ensure that the cable is plugged in and the PLC is 
operational.
Restart the system if the system alarm persists.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1437



210000 - PLC job alarms

210000 - PLC job alarms

Number Effect/causes Remedy
210000 Jobs are not processed because the configured 

address does not exist/has not been set up in 
the PLC.

Change the address or set up the address in the PLC.

210001 Jobs are not processed because read/write 
access to the configured address is not possible 
in the PLC.

Change the address, or set up the address in a PLC 
area at which read/write access is possible.

210002 Jobs are not executed because the address 
format of the area pointer does not match the 
internal storage format.

Internal error

210003 The job buffer is processed again because the 
last error status has been eliminated (recovery 
of normal operation).

--

210004 The job buffer is possibly not going to be 
processed.

--

210005 A job mailbox with invalid number was initiated. Check the PLC program.
210006 An error occurred while executing the job 

mailbox. As a result, the control job is not 
executed. Observe the next/previous system 
event.

Check the parameters of the control job. Recompile 
the configuration data.

220000 - WinCC communication driver alarms

220000 - WinCC communication driver alarms 

Number Effect/causes Remedy
220001 The tag is not downloaded because write access 

to data type Bool/Bit  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220002 The tag is not downloaded because write access 
to data type Byte  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220003 The communication driver cannot be loaded as 
it is possibly not installed.

Install the driver by reinstalling WinCC Runtime.

220004 Communication is down and no update data is 
transferred because the cable is not connected 
or defective etc.

Check the connection.

220005 Communication is up. --
220006 The connection between the specified PLC and 

the specified port is active.
--
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220007 The connection to the specified PLC is 

interrupted at the specified port.
Check the following:
● Is the cable plugged in?
● Is the PLC OK?
● Is the right port being used?
● Is your configuration OK (port parameters, 

protocol settings, PLC address)?
Restart the system if the system event persists.

220008 The communication driver cannot access or 
open the specified port. This port might be in use 
by another application, or a port that does not 
exist on the target device is being used.
No communication with the PLC.

Close all applications that access the port and restart 
the computer.
Use another port that exists in the system.

230000 - Screen object alarms

230000 - Screen object alarms 

Number Effect/causes Remedy
230000 The value entered could not be used. The system 

discards this entry and restores the previous 
value.
Possible causes:
● The range of values is exceeded.
● You entered invalid characters
● The valid maximum number of users has 

been exceeded.

Enter a practical value, or delete a user that is no 
longer required.

230002 The user currently logged on does not have the 
necessary authorization, so the system discards 
the entry and restores the previous value.

Log on as user with appropriate authorization.

230003 Change to the specified screen failed because 
this screen is not available/configured. The 
current screen remains selected.

Configure the screen and check the selection 
function.

230005 The range of values of the tag has been 
exceeded in the I/O field.
The original tag value is retained.

Observe the range of values for the tag when 
entering a value.

230100 During navigation in the Web browser, the 
system returned a message which may be of 
interest to the user.
The Web browser continues to run but may not 
(fully) show the new page.

Navigate to another page.

230200 The HTTP channel connection was interrupted 
due to an error. This error is explained in detail 
by another system event.
Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201 The HTTP channel connection is set up.
Data is exchanged.

--
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230202 WININET.DLL has detected an error. Usually, 

this error occurs if it is not possible to connect to 
the server, or the server denies a connection 
because the client lacks proper authorization.
An unknown server certificate may also be the 
cause if the connection is encrypted by means of 
SSL.
The alarm text provides details.
This text is always in the language of the 
Windows installation because it is returned by the 
Windows OS.
Process values are no longer exchanged.
The part of the alarm returned by the Windows 
OS might not be displayed, e.g. "An error has 
occurred". WININET.DLL returns the following 
error: Number: 12055 Text:HTTP: <no error text 
available>."

Depending on the cause:
When an attempt to connect fails, or a timeout occurs:
● Check the network connection and the network.
● Check the server address.
● Check whether the WebServer is actually running 

on the target station.
Incorrect authorization:
● The configured user name and/or password do 

not match the entries on the server. Set 
consistent data.

If the server certificate is rejected:
Certificate signed by an unknown CA ( ):
● Ignore this point, or install a certificate that has 

been signed with one of the root certificates 
known to the client station.

The date of the certificate is invalid:
● Ignore this point, or install a certificate with valid 

date on the server.
Invalid CN (Common Name or Computer Name):
● Ignore this point, or install a certificate with a 

name that corresponds to the server address.
230203 Although a connection can be made to the 

server, the HTTP server refused to connect. 
Possible causes:
● WinCC Runtime does not run on the server
● The HTTP channel is not supported (503 

Service unavailable).
Other errors can only occur if the Webserver 
does not support the HTTP channel. The 
language of the alarm text depends on the 
Webserver.
Data is not exchanged.

On 503 Service unavailable error:
Check whether WinCC Runtime is running on the 
server and whether the HTTP channel is supported.

230301 Internal error. An English text explains the error 
in more detail. The error may be caused by 
insufficient memory.
OCX does not work.

--

230302 The name of the remote server cannot be 
resolved.
An attempt to connect has failed.

Check the configured server address.
Check whether the DNS service is available on the 
network.

230303 The remote server is not running on the 
addressed computer.
incorrect server address.
An attempt to connect has failed.

Check the configured server address.
Check whether the remote server is running on the 
target computer.

230304 The remote server on the addressed computer is 
incompatible with VNCOCX.
An attempt to connect failed.

Use a compatible remote server.

230305 Authentication has failed due to incorrect 
password.
An attempt to connect failed.

Configure the correct password.
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230306 Error in the connection to the remote server. This 

may occur as a result of network problems.
An attempt to connect failed.

Check whether the network cable is plugged in, or 
whether there are network problems.

230307 The connection to the remote server was shut 
down. Possible causes:
● The remote server was shut down
● The user instructed the server to close all 

connections.
The connection is cancelled.

--

230308 This alarm provides information on the 
connection status.
An attempt is made to connect.

--

240000 - Authorization alarms

240000 - Authorization alarms 

Number Effect/causes Remedy
240000 WinCC Runtime is running in demo mode.

You have no authorization, or your authorization 
is corrupted.

Install the authorization.

240001 WinCC Runtime is running in demo mode.
You configured too many tags for the installed 
version.

Load an adequate authorization / powerpack.

240002 WinCC Runtime is running with time-limited 
emergency authorization.

Restore the full authorization.

240004 Error when reading the emergency authorization.
WinCC Runtime is running in demo mode.

Restart WinCC Runtime. Install or repair the 
authorization (see Commissioning Instructions for 
Software Protection).

240005 Automation License Manager has detected an 
internal system error. 
Possible causes:
● Corrupted file
● Faulty installation
● No free memory space for Automation 

License Manager, or similar.

Restart the HMI device/PC. If this procedure does not 
solve the problem, remove and then reinstall 
Automation License Manager.

Visualizing processes (Professional)
9.3 Working with alarms

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1441



250000 - S7 Status/Force alarms

250000 - S7 Status/Force alarms

Number Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is 

not updated because the address configured for 
this tag is not available.

Check the set address and then verify that the 
address is set up in the PLC.

250001 The tag in the specified line in "Status Force" is 
not updated because the PLC type configured 
for this tag does not exist.

Check the set address.

250002 The tag in the specified line in "Status Force" is 
not updated because it is not possible to map the 
PLC type in the tag type.

Check the set address.

250003 An attempt to connect to the PLC failed. The tags 
are not updated.

Check the connection to the PLC. Check that the PLC 
is switched on and is online.

260000 - Password system alarms

260000 - Password system alarms  

Number Effect/causes Remedy
260000 An unknown user or an unknown password has 

been entered in the system.
The current user is logged off from the system.

Log on to the system as a user with a valid password.

260001 The logged in user does not have sufficient 
authorization to execute the protected functions 
on the system.

Log on to the system as a user with sufficient 
authorization.

260002 This alarm output when the "TrackUserChange" 
system function is triggered.

--

260003 The user has logged off from the system. --
260004 The user name entered into the user view 

already exists in the user management.
Select another user name because user names have 
to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.
260006 The entry is discarded. Use a shorter or longer password.
260007 The logoff time entered is outside the valid range 

from 0 to 60 minutes.
The new value entered is discarded and the 
original value is retained.

Enter a logon timeout value between 0 and 60 
minutes.

260008 An attempt was made in WinCC to read a 
PTProRun.pwl file created with ProTool V 6.0.
Reading of the file was canceled due to 
incompatibility of the format.

--

260009 You have attempted to delete the user "Admin" 
or "PLC User". These users are fixed 
components of the user management and 
cannot be deleted.

If you need to delete a user, because perhaps you 
have exceeded the maximum number permitted, 
delete another user.
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260012 The password entries in the "Change Password" 

dialog and in the confirmation field do not match.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter 
the identical password twice to be able to change the 
password.

260013 The password entered in the "Change 
Password" dialog is invalid because it is already 
in use.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter a 
new password that has not been used before.

260014 You have tried to log on with an incorrect 
password three times in a row.
You will be locked out and assigned to group no. 
0.

You can log on to the system with your correct 
password. Only an administrator can change the 
assignment to a group.

260024 The password you entered does not meet the 
necessary security guidelines.

Enter a password that contains at least one number.

260025 The password you entered does not meet the 
necessary security guidelines.

Enter a password that contains at least one special 
character.

260028 Upon system start-up, an attempt to log on, or 
when trying to change the password of a 
SIMATIC log-on user, the system attempts to 
access the SIMATIC Logon Server.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260030 The SIMATIC Logon user could not change his 
password on the SIMATIC Logon Server. The 
new password is possibly noncompliant with 
password rules set on the server, or the user is 
not authorized to change his password.
The old password remains and the user is 
logged off.

Log in again and choose a different password. Check 
the password rules on the SIMATIC Logon Server.

260033 The action change password or log on user 
could not be carried out.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260034 The last logon operation has not yet ended. A 
user action or a logon dialog can therefore not 
be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the logon operation is complete.

260035 The last attempt to change the password was 
not completed. A user action or a logon dialog 
can therefore not be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the procedure is complete.
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260036 There are insufficient licenses on the SIMATIC 

Logon Sever. The logon is not authorized.
Check the licensing on the SIMATIC Logon Server.

260037 There is no license on the SIMATIC Logon 
Sever. A logon is not possible.
It is not possible to log on via the SIMATIC Logon 
Server, only via a local user.

Check the licensing on the SIMATIC Logon Server.

260040 The system attempts to access the SIMATIC 
Logon Server upon system start-up or when 
trying to change the password.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check connection to the domain and its configuration 
in the Runtime security settings editor.
Or use a local user.

260043 It was not possible to log the user on to the 
SIMATIC Logon Server. The user name or the 
password could be incorrect or the user does not 
have sufficient rights to log on.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Try again. If necessary, check the password data on 
the SIMATIC Logon Server.

260044 It was not possible to log the user on to the 
SIMATIC Logon Server as his account is 
blocked.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check the user data on the SIMATIC Logon Server.

260045 The SIMATIC Logon user is not associated to 
any or several groups.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check user data on the SIMATIC Logon Server and 
the configuration in your WinCC project. A user may 
only be assigned to one group.

270000 - System alarms

270000 - System Alarms

Number Effect/causes Remedy
270000 The alarm does not indicate the tag because it 

is accessing an invalid address in the PLC.
Check whether the data area for the tag exists on the 
PLC, whether the configured address is correct, and 
whether the value range for the tag is correct.

270001 There is a device-specific limit as to how many 
alarms may be queued for viewing (see the 
operating instructions). This limit has been 
exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm 
buffer.

--
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270002 The view shows alarms of a log for which there 

is no data in the current project.
Placeholders are output for the alarms.

Delete old log data, if necessary.

270003 The service cannot be set up because too many 
devices want to access this service.
A maximum of four devices can execute this 
action.

Reduce the number of HMI devices which want to use 
the service.

270004 Access to the persistent alarm buffer is not 
possible. Alarms cannot be restored or backed 
up.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270005 Persistent alarm buffer corrupted: Alarms 
cannot be restored.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored 
from the persistent alarm buffer.

The project was compiled and downloaded again to 
the HMI device. The error should no longer occur at 
the next restart of the HMI device.

270007 A configuration problem is preventing you from 
the restoring the data (e.g. a DLL was deleted, 
or unknown directory).

Update the operating system and download your 
project again to the HMI device.

290000 - Recipe system alarms

290000 - Recipe system alarms 

Number Effect/causes Remedy
290000 The recipe tag could not be read or written. It is 

assigned the start value.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags. After that, alarm 
290003 is output.

Check the configuration to see whether the address 
has been set up in the PLC.

290001 An attempt was made to assign the recipe tag a 
value that is outside the valid range of values for 
this type.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags if necessary. After 
that, alarm 290004 is output.

Observe the range of values for the tag type.

290002 It is not possible to convert a value from a source 
format to a target format.
The alarm can be entered in the alarm buffer for 
up to four more faulty recipe tags if necessary. 
After that, alarm 290005 is output.

Check the range of values or type of the tag.

290003 This alarm is output after alarm 290000 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the configuration to see whether the tag 
addresses have been set up in the PLC.

290004 This alarm is output after alarm 290001 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Observe the range of values for the tag type.
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290005 This alarm is output after alarm 290002 was 

triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the range of values or type of the tag.

290006 The limits configured for the tag have been 
exceeded by the values entered.

Observe the configured or current tag limits.

290007 There is a difference between the source and 
target structure in the recipe currently being 
processed. The target structure contains an 
additional recipe tag that is not available in the 
source structure.
The recipe tag specified is assigned its start 
value.

Insert the specified recipe tag into the source 
structure.

290008 There is a difference between the source and 
target structure in the recipe currently being 
processed.The source structure contains an 
additional recipe tag that is not available in the 
target structure and cannot be assigned.
The value is discarded.

Remove the specified recipe tag in the specified 
recipe from the project.

290010 The storage location configured for the recipe is 
invalid.
Possible causes:
Invalid characters, write protection, data carrier 
out of space or not available.

Check the configured storage location.

290011 A data record of the specified number does not 
exist.

Check the source for the number (constant or tag 
value).

290012 A recipe of the specified number does not exist. Check the source for the number (constant or tag 
value).

290013 An attempt was made to save a data record 
under a data record number that already exists.
The operation is not executed.

The following remedies are available:
● Check the source for the number (constant or tag 

value).
● First, delete the data record.
● Modify the "Overwrite" function parameter.

290014 The specified import file was not found. Check the following:
● The file name
● Ensure that the file is in the specified directory.

290020 Check back to verify that the download of data 
records from the HMI device to the PLC has 
started. 

--

290021 Check back to verify that the download of 
records from the HMI device to the PLC was 
completed.

--

290022 Check back to indicate that the download of data 
records from the HMI device to the PLC was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?
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290023 Check back to verify that the download of data 

records from the PLC to the HMI device has 
started.

--

290024 Check back to verify that the download of data 
records from the PLC to the HMI device was 
completed.

---

290025 Check back to indicate that the download of data 
records from the PLC to the HMI device was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?

290026 An attempt was made to read/write a data record 
that is not free at present.
This error can occur if recipes were configured 
for download with synchronization.

Set the mailbox status to zero.

290027 Unable to connect to the PLC at present. As a 
result, the data record cannot be read or written.
Possible causes:
No hardware connection to the PLC (no cable 
plugged in, cable is defect), or the PLC is 
switched off.

Check the connection to the PLC.

290030 This alarm is output after you selected screen 
which contains a recipe view in which a data 
record is already selected.

Reload the data record from the storage location, or 
retain the current values.

290031 While saving, it was detected that a data record 
with the specified number already exists.

Overwrite the data record, or cancel the action.

290032 During the export of data records, a file with the 
specified name was found.

Overwrite the file, or cancel the process.

290033 Confirmation prompt before deleting data 
records.

--

290040 A data record error with error code %1 that 
cannot be described in more detail occurred.
The action is canceled.
It is possible that the mailbox was not installed 
correctly on the PLC.

Check the storage location, the data record, the "Data 
record" area pointer, and the connection to the PLC.
Restart the action after a short waiting time.
If the error persists, contact Customer Support. 
Forward the relevant error code to Customer Support.

290041 A data record or file cannot be saved because 
the storage location is out of sufficient space.

Delete files no longer required.

290042 An attempt was made to execute several recipe 
actions simultaneously. The last action is not 
executed.

Retrigger the action after a short waiting time.

290043 Confirmation prompt before saving data records. --
290044 The database for the recipe was corrupted and 

will be deleted.
--

290050 A check back indicates that the export of data 
records was started.

--

290051 A check back indicates successful completion of 
the export of data records.

--
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290052 A check back indicates that the export of data 

records was canceled due to an error.
Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290053 A check back indicates that the import of records 
was started.

--

290054 A check back indicates successful completion of 
the import of data records.

--

290055 A check back indicates that the import of data 
records was canceled due to an error.

Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290056 Error when reading/writing the value in the 
specified row/column.
The action was canceled.

Check the specified row/column.

290057 The tags of the recipe specified were toggled 
from "offline" to "online" mode.
Each change of a tag in this recipe is now 
immediately transferred to the PLC.

--

290058 The tags of the specified recipe were toggled 
from "online" to "offline" mode.
Modifications to tags in this recipe are no longer 
immediately transferred to the PLC but must be 
transferred there explicitly by downloading a 
data record.

--

290059 A check back indicates that the specified record 
was successfully saved.

--

290060 A check back indicates that the specified data 
record memory was cleared.

--

290061 A check back indicates that deletion of the data 
record memory was canceled due to an error.

--

290062 The data record number exceeds the maximum 
of 65536.
This data record cannot be created.

Select another number.

290063 This occurs when you execute system function 
"ExportDataRecords" while the "Overwrite" 
parameter is set to "No". 
An attempt was made to save a recipe under a 
file name that already exists.
The export is canceled.

Check the parameters of the "ExportDataRecords" 
system function.

290064 A check back indicates that the deletion of data 
records was started.

--

290065 A check back indicates successful completion of 
the deletion of data records.

--

290066 Confirmation prompt before deleting data 
records.

--

290068 Confirmation prompt for deletion of all recipe 
data records.

--

290069 Confirmation prompt for deletion of all recipe 
data records.

--

290070 The data record specified was not found in the 
import file.

Check the source of the data record number, or the 
data record name (constant, or tag value).
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290071 When the editing data record values, you 

entered a value that is below the low limit of the 
recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290072 When editing data record values, you entered a 
value that exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290073 An action (e.g. saving a record) failed for an 
unknown reason.
The error corresponds to status alarm 
IDS_OUT_CMD_EXE_ERR in the large recipe 
view.

--

290074 While saving, a data record with the specified 
number but with different name was found.

Overwrite the record, change the record number or 
cancel the action.

290075 A data record of this name already exists.
The data record is not saved.

Select a different data record name.

290110 The default values could not be set due to an 
error.

--

290111 The recipes subsystem cannot be used. Recipe 
views have no content and recipe-specific 
functions will not be executed.
Possible causes:
● Error when loading the recipes.
● The recipe structure was changed in the ES. 

The recipes were not included in the latest 
project download. This means that the new 
configuration data no longer matches the old 
recipes on the device.

Download the project to the device again, including 
the recipes (the corresponding check box in the 
download dialog must be check marked).

300000 - Alarm_S alarms

300000 - Alarm_S alarms

Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. 

using PDiag or S7 Graph): More alarms are 
queued than specified in the specifications of the 
CPU. No further ALARM_S alarms can be 
managed by the PLC and reported to the HMI 
devices.

Change the PLC configuration.

300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S 
service.
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310000 - Reporting alarms

310000 - Reporting alarms

Number Effect/causes Remedy
310000 An attempt is being made to print too many 

reports in parallel.
Only one log file can be output to the printer at 
a given time; the print job is therefore rejected.

Wait until the previous active log was printed.
Repeat the print job if necessary.

310001 An error occurred on triggering the printer. The 
report is either not printed or printed with errors.

Evaluate the additional system alarms related to this 
alarm.
Repeat the print job if necessary.

330000 - Interaction alarms

330000 - Interaction alarms 

Number Effect/causes Remedy
330022 Too many open dialogs on the HMI device. Close all dialogs you do not require on the HMI device.

 

 

350000 - PROFIsafe alarms

350000 - PROFIsafe alarms  

Number Effect/causes Remedy
350000 PROFIsafe packets were not received within the 

specified time.
There is a communication problem with the F-
CPU. 
RT is terminated.

Check the WLAN connection.

350001 PROFIsafe packets were not received within the 
specified time.
There is a communication problem with the F-
CPU.
The PROFIsafe connection is set up again.

Check the WLAN connection.

350002 Internal error.
Runtime is terminated.

Internal error

350003 Check back for indicating the connection setup 
to the F-CPU.
The Emergency-Off buttons are active 
immediately.

--
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350004 PROFIsafe communication was set up and the 

connection was shut down.
Runtime can be terminated.
The Emergency-Off buttons are deactivated 
immediately.

--

350005 Incorrect address configured for the F-Device.
A PROFIsafe connection cannot be set up.

Check and modify the address of the F-Device in 
WinCC ES.

350006 The project was started. At the start of the 
project, check the proper function of the ACK 
buttons. 

Press the two ACK buttons successively in the 
"Acknowledge" and "Panic" positions.

350008 You configured an incorrect number of failsafe 
buttons.
A PROFIsafe connection cannot be set up.

Modify the number of failsafe buttons in the project.

350009 The device is in Override mode. 
It may no longer be possible to detect the 
location because transponder detection fails.

Exit the override mode.

350010 Internal error: The device has no failsafe buttons. Return the device to Siemens.
Worldwide contact partners

9.3.6.9 System events for Runtime Professional

Introduction  
The system events generated by the various WinCC modules are described below. You can 
integrate these events into your alarm system using the "WinCC - System Events" menu 
command.

 

 Note

You can obtain additional information on the system events in the "Comment" block of the 
active alarm.

 

WinCC system events

Number Error message / description
1000000 WCCRT:Error
1000001 WCCRT:Error on loading the object engine
1000002 WCCRT:Channel could not be loaded
1000003 WCCRT:Tag - Violated lower limit
1000004 WCCRT:Tag - Violated upper limit
1000005 WCCRT:Error on formatting a tag
1000006 WCCRT:Error on scaling a tag
1000100 WCCRT:Driver error
1000200 WCCRT:Status
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1000201 WCCRT:Object engine has been loaded
1000202 WCCRT:Runtime has been activated
1000203 WCCRT:Runtime has been deactivated
1000204 WCCRT:Connection not established
1000205 WCCRT:Connection established
1000206 WCCRT:Client connection established
1000207 WCCRT:Client connection disconnected
1000208 WCCRT:Client connection broken
1000209 WCCRT:Connection deleted
1000210 WCCRT:Connection modified
1000211 WCCRT:Connection reestablished
1000300 WCCRT:Driver status
1000800 PACKAGE:Import
1000801 PACKAGE:Export
1000802 PACKAGE:Delete
1000803 PACKAGE:New
1000804 PACKAGE:Reload
1000805 PACKAGE:DefaultServer
1000806 PACKAGE:Implicit update
1000807 PACKAGE:Update
1000900 PERFMON: is low
1000901 PERFMON: is OK
1000902 PERFMON: is high
1000903 PERFMON: is OK
1000904 PERFMON: is low
1000905 PERFMON: is OK
1000906 PERFMON: is high
1000907 PERFMON: is OK
1000908 PERFMON: is low
1000909 PERFMON: is OK
1000910 PERFMON: is high
1000911 PERFMON: is OK
1000912 PERFMON:Redundancy loss of terminal adapter @2%s@
1000913 PERFMON:Redundancy of terminal adapter @2%s@ restored
1000914 PERFMON:Terminal adapter @2%s@ connected.
1000915 Terminal adapter @2%s@ separated. @2%s@: MAC address of the network card
1001000 PDLRT: General error
1001001 PDLRT: Operator action not active
1001002 PDLRT: Wrong picture format
1001003 PDLRT: Picture not found
1001004 PDLRT: No dynamic active in picture
1001005 PDLRT: Tag could not be written
1001006 PDLRT: Dynamic actions in picture are not active
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1002000 TLGRT: General error
1002001 TLGRT: Error during initialization
1002002 TLGRT: Error loading the runtime data
1002003 TLGRT: Error changing languages
1002004 TLGRT: Error accessing the database
1002005 TLGRT: Error creating runtime objects
1002006 TLGRT: Error in online configuration
1002007 TLGRT: Error in client/server environment
1002008 TLGRT: Error in memory management
1002009 TLGRT: Error compiling measured values
1002010 TLGRT: Error processing measured values
1002011 TLGRT: Error archiving measured values
1002012 TLGRT: Error in Normalization DLL
1002013 TLGRT: Error in user recipe option
1002014 TLGRT: Error in process controlled archiving
1002015 TLGRT: Error in API
1002016 TLGRT: Error in application window
1002017 TLGRT: System fault
1002018 TLGRT: Error overflow in database queue
1002019 TLGRT: Error overflow in notification queue
1002020 TLGRT: Error overflow of the Normalization DLL queue - loss of data!
1002021 TLGRT:Problem with the connection to the central log server!
1002022 TLGRT:The error in the connection to the central log server has been eliminated
1003018 ALGRT:Alarm does not require acknowledgment.

An attempt was made to acknowledge a alarm that does not require acknowledgment.
1003019 ALGRT:Alarm has already been acknowledged

An attempt was made to acknowledge a alarm that has already been acknowledged.
1003020 ALGRT:Alarm class for the alarm not found

The alarm class associated with the alarm does not exist.
1003021 ALGRT:Alarm status cannot be processed

The alarm status (Incoming, Outgoing, Acknowledged, ...) could not be interpreted.
1003022 ALGRT:Alarm is locked

This alarm occurs if you attempt to trigger a locked alarm via the API.
1003023 ALGRT:Alarm date/time-stamp invalid

The date/time stamp from the AS could not be interpreted.
1003032 ALGRT:Alarm window template name unknown

This error occurs when a alarm window that was previously configured in the Graphics 
Design is deleted subsequently.
In the case of client/server projects, this alarm could also be triggered by a communication 
error in the network.

1003033 ALGRT:Alarm window could not be created
1003034 ALGRT:Alarm window - data invalid

Incorrect project data.
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1003048 ALGRT:bit is outside the tag range

For example, an attempt was made to trigger the 18th bit of a 16-bit tag.
1003049 ALGRT:No tag change
1003050 ALGRT:Alarm tag (bit) already occupied by a alarm

The bit of the alarm tag has already been interconnected to a alarm.
1003051 ALGRT:Acknowledgment tag (bit) already occupied by a alarm

The acknowledgment tag bit has already been interconnected to a alarm.
1003052 ALGRT:Status tag already occupied by a alarm

The bit of the status tag has already been interconnected to a alarm.
1003053 ALGRT:Error during conversion of the variant data type
1003054 ALGRT:Alarm tag (bit) already occupied-->different type
1003055 ALGRT:Event - invalid tag or data type

The data type of the alarm tag is invalid. You may have used a tag with sign.
1003056 ALGRT:Invalid acknowledgment tag or data type

The data type of the acknowledgment tag is invalid. You may have used a tag with sign.
1003057 ALGRT:Status - invalid tag or data type

The data type of the status tag is invalid. You may have used a tag with sign.
1003058 ALGRT:Handle invalid

This error message can occur during accesses via the API.
1003059 ALGRT:Selection criteria invalid

This error message can occur during accesses via the API.
1003060 ALGRT:Resources - DLL for language not found

One of the language-dependent files is missing.
1003061 ALGRT:Error while creating the memory mapped files

This internal error indicates a problem involving the memory.
1003062 ALGRT:Error while creating the synchronization mechanism.

This error occurs when the operating system is overloaded.
1003063 ALGRT:Wrong parameter

This error message can occur during accesses via the API.
1003064 ALGRT:Transfer buffer too small

This error message can occur during accesses via the API.
1003065 ALGRT:This function is not available at this time

This error message can occur during accesses via the API.
1003066 ALGRT:Format DLL send data cannot be evaluated
1003067 ALGRT:Format DLL. Do not execute function
1003068 ALGRT:No alarm text blocks in the report

Check the alarm sequence report.
1003069 ALGRT:Invalid reporting
1003070 ALGRT:Report printout is already active

An attempt was made to restart an active report.
1003071 ALGRT:Alarm system runtime <Server> not installed

The server reports that the project was activated without the runtime component of Alarm 
Logging.
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1003072 ALGRT:Printout of the alarm sequence report has not been started.
1003073 ALGRT:Printout of the short-term archive report has not been started.
1003074 ALGRT:Printing of the log segment report has not started.
1003075 ALGRT:Maximum number of alarms that can be configured online

The maximum number of alarms that can be configured online (default setting is 600) has 
been exceeded.

1003076 NRMS7:Parameter error for S7 message frame
A parameter error has occurred on the interface to S7.

1003077 NRMS7:Parameter error for ALGRT
A parameter error has occurred on the interface to ALGRT.

1003078 NRMS7:Parameter error for TLGRT
A parameter error has occurred on the interface to TLGRT.

1003079 NRMS7:Parameter error in additional data
The additional data of the alarms are faulty.

1003080 NRMS7:Parameter error in AR_SEND structure
The structure of the AR-SEND user data is faulty.

1003081 NRMS7:General error
An internal error of unknown cause has occurred.

1003082 NRMS7:Alarm loss on the automation system
1003083 NRMS7:Connecting and updating of the automation system is underway
1003084 NRMS7:Connecting and updating of the automation system is finished
1003085 NRMS7:System change during operation (CiR) is underway
1003086 NRMS7:System change during operation (CiR) is finished
1003087 NRMS7:Error while logging on to receive alarm
1003098 ALGRT:Alarm archiving overflow - alarms will be lost
1003099 ALGRT:[Computer Name]:Locked alarms [alarm number] [alarm text of locked alarm]

This alarm occurs when a alarm is locked.
1003100 ALGRT:[Computer Name]:Alarm [alarm number] unlocked [alarm text of unlocked alarm]

This alarm occurs when a alarm is unlocked.
1003101 ALGRT:Acknowledgment request for alarm [alarm number]  was issued

This alarm occurs when a alarm is acknowledged.
1003102 ALGRT:[Computer Name]:Alarm group [alarm group number] locked

This alarm occurs when a alarm group is locked.
1003103 ALGRT:[Computer Name]:Alarm group [alarm group number] unlocked

This alarm occurs when a alarm group is unlocked.
1003104 ALGRT:[Computer Name]:Alarm archiving overflow ended - no further alarms will be lost
1003105 ALGRT:[Computer Name]:Incoming alarm queue has reached critical value
1003106 ALGRT:[Computer Name]:Incoming alarm queue has reached normal value
1003107 ALGRT:[ComputerName]:Alarm [AlarmNumber] hidden:@1%s@
1003108 ALGRT:[ComputerName]:Alarm [AlarmNumber] shown:@1%s@
1003109 ALGRT:Connection to master is down.
1003110 ALGRT:Found incomplete configuration data for alarm @10%d@. Status: @1%d@.
1004000 RPTRT:General error
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1004001 RPTRT:PRT_OUT directory full
1004002 RPTRT:Spool directory full
1004003 RPTRT:Report was not printed. PRT_OUT directory full
1004004 RPTRT:Report was not printed. Spool directory full
1004005 RPTRT:Alarm sequence report is reprinted
1004006 RPTRT:Spool directory full
1004007 RPTRT:Hardcopy was not printed. Spool directory full
1005000 TXTRT:General error
1005001 TXTRT:Error while logging off the runtime applications.
1005002 TXTRT:Error while logging on the runtime applications.
1005003 TXTRT:Error during initialization of the MMF.

A memory error has occurred.
1005004 TXTRT:Error while loading the MMF.

Error while accessing the database.
1005005 TXTRT:Error while opening the MMF.

A memory error has occurred.
1005006 TXTRT:Error while creating the service window.
1005007 TXTRT:No language found.
1005008 TXTRT:Text ID not found.

The requested Text ID could not be found in the text library.
1005009 TXTRT:Read access to the MMF refused.
1005010 TXTRT:Language not found

The requested language has not been configured in the text library.
1005011 TXTRT:Language table could not be opened.

Either the data are faulty or the table is locked in the database.
1005012 TXTRT:Text table could not be opened.

Either the data are faulty or the table is locked in the database.
1005013 TXTRT:Invalid language specified

The Language ID specified is invalid.
1005014 TXTRT:DBConnect error

No connection to the database could be set up.
1006000 GSCRT:Error
1007000 SCRIPT:Overflow

Overload: either there are too many actions running in a cycle that is too small, or an action 
is suspended (endless loop, dialog output). All the other actions are in the queue and cannot 
be processed.
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1007001 SCRIPT:Action error

One of the following errors has occurred:
● Exception in the action (specific cause unknown)
● Exception when accessing the return result (char* associated memory invalid)
● Stack overflow upon execution of the action
● The action contains a division by 0
● The action contains an access to a non-existing symbol
● The action contains an access violation

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007002 SCRIPT:Overflow
Internal lists have overflowed.

1007003 SCRIPT:Connection error
The connection to the server is broken.

1007004 SCRIPT:Action error 1
The called function is not known. Check the notation of the function call and implementation 
of the function.

1007005 SCRIPT:Action error 2
This error can have several causes:
● The action does not contain a P code. Recompile the action.
● The function could not be loaded, for example, due to incorrect function name.
● The type of return value of the function is invalid.

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007006 SCRIPT:Tag error
A requested tag was not supplied by WinCC Explorer within 10 seconds. Check the spelling 
of the tag name. In the case of external tags, there may be a communication problem 
between the WinCC Explorer and the PLC.
From WinCC version 4.0, you have the option to incorporate the OnErrorExecute function 
into your script, which allows for a detailed analysis of errors.

1007007 SCRIPT: Info
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1007009 SCRIPT:Error in Thread
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1008000 USERT:Connection to the smart card reader interrupted
1008001 USERT:Incorrect login name/password
1008002 USERT:Incorrect login name/password by smart card
1008003 USERT:Manual logon
1008004 USERT:Logon using a smart card
1008005 USERT:Manual logoff
1008006 USERT:Logoff using a smart card
1008007 USERT:Automatic logoff via a timer
1008008 USERT:Authorizations effective for service user/group '@102%s@'
1009000 LBMRT:Error
1009999 LBMRT:Tag @2%s@ does not exist
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1010000 STRRT:Error
1010101 CAS:Starts archive service
1010102 CAS:Archive service has been started
1010103 CAS:Archive service could not be started, error
1010104 CAS:Stops archive service
1010105 CAS:Archive service could not be stopped, error
1010106 CAS:Media backup completed successfully
1010107 CAS:Backup process failed, error
1010108 CAS:Backup medium created
1010109 CAS:Backup medium closed
1010110 CAS:Backup connected
1010111 CAS:Backup connection failed, error
1010112 CAS:Backup disconnected
1010113 CAS:Backup disconnection failed, error
1010114 CAS:Import of archive started
1010115 CAS:Import of archive failed, error
1010116 CAS:Import of archive completed
1010117 CAS:Archive failed, error
1010118 CAS:Archive completed
1010119 CAS:Starts processing of log 
1010120 CAS:Data backup started
1010121 CAS:Data backup completed successfully
1010122 CAS:The server station could not be assigned a symbolic name
1010123 CAS:Warning: No license found: SIMATIC PCS7 StoragePlus Server. Historical alarm list 

(long-term) disabled.
1010124 CAS:Log file '@2%s@' could not be verified.
1010130 StoragePlus: Directory cannot be created, error
1010131 StoragePlus: File cannot be moved, error
1011000 CSIG:Group display error at start up
1011001 CSIG:Group display hierarchy not updated
1011002 Group display: Connection fault
1011003 Group display: Tag does not exist
1011101 PTM: Error during start up
1011201 SSM: Error during start up
1011202 The fill level of the project drive is over 80%
1011203 The project was created with the wrong WinCC version
1012001 SYNC:Switched to master operation
1012002 SYNC:Cannot issue time message frame
1012003 SYNC:Time receipt service: Poor or failed signal
1012004 SYNC:Cannot receive time message frame
1012005 SYNC:Cannot receive any time message frame on redundant bus
1012006 SYNC:No time message frame. Switch to redundant device
1012007 SYNC:Can issue time message frame properly
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1012008 SYNC:Time reception service functions properly
1012009 SYNC:Can receive time message frame properly
1012010 SYNC:Can receive time message frame properly on redundant bus
1012011 SYNC:Switched to slave operation
1012012 SYNC:Time-of-day synchronization deactivated
1012013 SYNC:Time-of-day synchronization activated
1012014 SYNC:DCF77 client service failure
1012015 SYNC:DCF77 client service functions correctly
1012016 SYNC:@2%s@ switched to master mode @3%s@
1012017 SYNC:@2%s@ switched to slave mode @3%s@
1012018 SYNC:@2%s@ cannot transmit time frame
1012019 SYNC:@2%s@ can successfully transmit the time frame
1012020 SYNC:@2%s@ sets the local time
1012021 SYNC:LAN-Sync: Error in time synchronization with PC @2%s@
1012022 SYNC:LAN-Sync: Time synchronization set on PC @2%s@ 
1012023 SYNC:LAN-Sync: Time synchronization with PC @2%s@ completed
1012024 SYNC:Configured device names of time synchronization do not match the PC installation
1012025 SYNC:LAN-Sync: Time cannot be accepted from connected WinCC Server
1012026 SYNC:Time jump noted - switched to permanent slave mode
1012027 SYNC:Time jump noted - time synchronization permanently disabled
1012028 SYNC:Time receipt service not started
1012029 SYNC:Time receipt service running
1012030 SYNC:Time-of-day synchronization disabled
1012200 REDRT:Partner station has failed
1012201 REDRT:Partner station restarted
1012202 REDRT:Projects are not functionally identical
1012203 REDRT:Archive synchronization failed
1012204 REDRT:Internal error in Redundancy
1012205 REDRT:Connection to partner disturbed
1012206 REDRT:Connection to partner reestablished
1012207 REDRT:Partner server - WinCC has not been started
1012208 REDRT:Archive synchronization starts
1012209 REDRT:Archive synchronization ends
1012210 REDRT:Tag Logging synchronization starts
1012211 REDRT:Tag Logging synchronization ends
1012212 REDRT:Alarm Logging synchronization starts
1012213 REDRT:Alarm Logging synchronization ends
1012214 REDRT:User Archive synchronization starts
1012215 REDRT:User Archive synchronization ends
1012216 REDRT:Synchronization was interrupted
1012217 REDRT:Partner server project not activated
1012218 SWITCH:Client switched automatically
1012219 SWITCH:Client switched manually
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1012220 REDRT:Synchronization not ready for all user archives
1012221 REDRT:Synchronization ready for all user archives
1012222 SWRED:Main connection disturbed
1012223 SWRED:Main connection operational
1012224 SWRED:Backup connection disturbed
1012225 SWRED:Backup connection operational
1012226 REDRT:Partner server project activated
1012227 REDRT:Error: Partner computer is not a server
1012228 REDRT:CAS: Log synchronization starts '@2%s@'
1012229 REDRT:CAS: Log synchronization ends '@2%s@'
1012240 REDRT:RedundancyControl error triggered switching
1012241 REDRT:RedundancyControl: Switch to status
1012242 DELTALOADER:Delta transfer has been started
1012243 DELTALOADER:Delta transfer has been terminated
1012244 REDRT:Overload during online synchronization of Alarm Logging
1012245 REDRT:RedundancyControl: Loss of serial connection
1012246 REDRT:RedundancyControl: Serial connection reestablished
1012247 REDRT: OS server (standby) redundancy error
1012248 REDRT: OS server (standby) redundancy reestablished
1012250 AM:Possible inconsistency of the log databases
1012251 AM:Internal error
1012252 AM:Backup:Error while writing to backup path
1012253 AM:Backup:Insufficient memory space on target drive
1012254 AM:No connection to WriteArchiveServer
1012255 AM:No connection to Microsoft Message Queue
1012256 AM:No connection to WinCC project
1012257 AM:No connection to the database
1012258 AM:No connection to the text library
1012259 AM:Error while creating the TagLogging data
1012260 AM:Error while creating the AlarmLogging data
1012261 AM:Warning: Backup is delayed until partner server restarts.
1012265 AM:Database verification failed
1012301 CA:No access to SQL server (risk of data loss)
1012348 AM:Insufficient free memory space on project drive
1012349 REDRT: Loss of connection via network adapter (MAC) address
1012350 REDRT: Connection reestablished via network adapter (MAC) address
1012351 REDRT:RedundancyControl: System blockage detected. Switch to fault status
1012352 REDRT:RedundancyControl: System blockage detected. Restart the computer as soon as 

possible.
1012400 WEBRT:WebClient @1%s@ Connection is up (User=@2%s@)
1012401 WEBRT:WebClient @1%s@ Connection is down (User=@2%s@)
1900000 ESIG:Electronic signature of user @2%s@ successful.
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1900001 ESIG:Electronic signature of user @2%s@ unsuccessful.
1900002 ESIG:Electronic signature of user @2%s@ cancelled.

 

9.3.6.10 Tag Bit Assignments

Tags for Alarm Groups and Alarms

Bit assignment of status tag

Introduction
In WinCC you can define a status tag for an alarm or an alarm group. The status tag for am 
alarm group represents the states of the alarms and child alarm groups it contains.

Description
The following states of an alarm or alarm group are stored in a status tag:

● Incoming/outgoing alarm (status bit)

● Alarm queued for acknowledgment / acknowledged (acknowledgment bit)

Data type of a status tag
The status tag is an internal or external WinCC tag. You can use the following data types for 
status tags:

● Unsigned 8-bit value
The data type represents the states of up to four alarms.

● Unsigned 16-bit value
The data type represents the states of up to eight alarms.

● Unsigned 32-bit value
The data type represents the states of up to 16 alarms.

Each alarm or alarm group occupies 2 bits in the status tag.
 

 Note

A status bit of a status tag can only be assigned to one alarm. 
 

Acknowledgment bit of the status tag of an alarm
When an incoming alarm is received and is not acknowledged, the acknowledgment bit has 
status "1". 
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If the alarm was acknowledged, the acknowledgment bit status changes to "0".

Alarm event Acknowledgment bit
Incoming alarm was not acknowledged 1
Alarm acknowledged 0

Acknowledgment bit of the status tag of an alarm group
When at least one incoming alarm is received and is not acknowledged, the acknowledgment 
bit status in an alarm group changes to "1". 

If all the alarms for the alarm group were acknowledged, the acknowledgment bit is reset to 
"0".

Status bit for the status tags of an alarm or alarm group
If an incoming alarm or alarm group is received and has not yet gone, the acknowledgment 
bit has status "1". If the alarm has gone, the acknowledgment bit status changes to "0". 

Alarm event Status bit
Incoming alarm or alarm group 1
Alarm gone 0

 
 

 Note

Alarms whose alarm class has the "Alarm without status" property cannot be displayed in a 
status tag.

 

Status tag of a locked alarm
If you lock an alarm in Runtime, the bits in the status tags will be reset or not set, regardless 
of the alarm status. The "locked" status of an alarm is not indicated in the status tag. 

 

 Note

To visualize the locked status of an alarm group, use the locked tag for the alarm group.
 

Status tag for chronological alarms
You can use a structure tag to represent the status of a chronological alarm. In the structure 
tag, the "EventState" element, for example, represents the status of a chronological alarm. 
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Position of the Status and Acknowledgment Bit 
You can define the position of the status bit within a status tag. The acknowledgment bit must 
be a certain distance from this bit. The following definitions apply to the data type:

Data type Position of status bit Distance Position of acknowledgment 
bit

Unsigned 8-bit value 0 - 3 4 4 - 7
Unsigned 16-bit value 0 - 7 8 8 - 15
Unsigned 32-bit value 0 - 15 16 16 - 31

Examples
Status Tag of Data Type "32 Bit Unsigned"

Status bit = Position 9

Distance = 16 positions

Acknowledgment bit = Position 25

Status Tag of Data Type "16 Bit Unsigned"

Status bit = 6

Distance = 8 positions

Acknowledgment bit = Position 14

Status Tag of Data Type "8 Bit Unsigned"

Status bit = 2

Distance = 4 positions

Acknowledgment bit = Position 6

Configuring Function Lists for a Change in Value
You can configure a list of functions for the "Value change" event for the tag. You can hide 
any non-relevant bits of the tag to reduce the number of possible signal states for the tag. You 
can configure the hiding of the non-relevant bits using a C or VB script. 
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It is not necessary to hide the non-relevant bits if the following condition is fulfilled:

● You are using a separate status tag for each alarm.

● The non-relevant bits of these status tags always have the value "0".

See also
Tags of an alarm group (Page 1256)

Bit assignment for acknowledgment tags

Introduction
In WinCC you can define an acknowledgment tag for an alarm or alarm group. 

Description
Use the acknowledgment tag to:

● Acknowledge an alarm

● Acknowledge an alarm group
The acknowledgment tag of an alarm group acknowledges all the alarms and alarm 
subgroups it contains.

● Displaying the acknowledgment status of an alarm group

● Linking the acknowledgment to other WinCC components
You can use the acknowledgment tag to link the acknowledgment to other WinCC 
components.

If the operator acknowledges an alarm or alarm group in Runtime, then the associated 
acknowledgment bit will be set.

Using acknowledgment tags
You have the following options available for configuring acknowledgment tags:

● You can configure a separate acknowledgment tag for each alarm or alarm group.

● You can compile several alarms or alarm groups in an acknowledgment tag. The 
acknowledgment bit allows you to distinguish between alarms and alarm groups.

Each alarm occupies one bit in the acknowledgment tag.

Data Type of an acknowledgment tag
The structure of the acknowledgment tag is not specified. The data type depends on the 
number of alarms that you want to represent in the acknowledgment tag.
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Resetting the Acknowledgment Bit for acknowledgment tags
You configure the setting or resetting of the acknowledgment bit in WinCC using a button or 
via the PLC.

 

 Note

When you acknowledge an alarm group in Runtime, the acknowledgment bit does not indicate 
this acknowledgment in the alarm view.

 

● See also "Resetting the acknowledgment bit"

● See also "Tags of an alarm group"

See also
Tags of an alarm group (Page 1256)

Tags for Alarm Groups

Bit assignment for lock tags

Introduction
In WinCC you can define a lock tag for an alarm group. 

Description
The lock tag of an alarm group is used to evaluate the locked status of that alarm group. You 
can define a lock bit in the lock tag for this purpose.

Using the Lock Tag
You have the following options for configuring lock tags:

● You can configure a separate lock tag for each alarm group.

● You can compile several alarm groups in a lock tag. The lock bit allows you to distinguish 
between alarm groups.

When you lock an alarm group in Runtime, the associated lock bit is set in the configured tag.

Data Type of a Lock Tag
The structure of the lock tag is not specified. The data type depends on the number of alarms 
that you want to represent in the lock tag. 
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See also
Tags of an alarm group (Page 1256)

Bit assignment for display suppression tags 

Introduction
In WinCC you can define a display suppression tag for a custom alarm group. The display 
suppression tag saves the potential plant states. Only one plant state can be active at one 
time. The display suppression tag is therefore set by only one bit.       

Description
In the display suppression mask, you can specify which alarm of an alarm group is to be 
suppressed for specific plant states in Runtime.

Data type of the display suppression tag 
The display suppression tag is an external WinCC tag that stores the plant state. You can use 
the following data types for display suppression tags:

● Unsigned 8-bit value

● Unsigned 16-bit value

● Unsigned 32-bit value

Display suppression mask
In the Inspector window of an alarm, you can use the display suppression mask to define the 
plant states at which the alarm is not shown. The project engineer sets the bits that define 
specific plant states. A plant can have a maximum of 32 states.

You enter the selected plant states as hexadecimal value in the Inspector window of the alarm 
under "Display suppression > Mask".

The display suppression tag saves the plant state. When a plant state listed in the mask occurs, 
the alarm is no longer displayed. To view the alarms currently hidden due to a plant state, you 
can switch the alarm view in Runtime to "Alarms with display suppression".
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Example
Five examples for the display suppression mask are offered below:

● Display suppression mask 0x0. The alarm is displayed.

● Display suppression mask 0x1. If the "1" bit is set in the display suppression tag, the alarm 
is not displayed.

● Display suppression mask 0xD. If the "1", "3" or "4" bit is set in the display suppression tag, 
the alarm is not displayed.

● Display suppression mask 0x80000008. If the "4" or "32" bit is set in the display suppression 
tag, the alarm is not displayed.

● Display suppression mask 0xFFFFFFFF. If any bit is set in the display suppression tags, 
the alarm is not displayed.

See also
Tags of an alarm group (Page 1256)
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9.4 Working with logs

9.4.1 Working with Logs

9.4.1.1 Log Basics

Introduction
WinCC provides the following types of log for logging process data for HMI Runtime:

● Data logs

● Alarm logs

A data log is used to log process data from an industrial plant.

An alarm log is used to log alarms that occur in the monitored process.     

Principle
The two types of log both have roughly the same structure and largely work in the same way. 
They are very clear and easy to configure. With both types of log you define the same properties 
for the log. The same logging methods are also available for both types of log.

The following logging methods are available:

● Circular log
If a circular log is totally full, the oldest entries are overwritten.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all log segments are filled, the oldest log segment is overwritten.

● Log with level-dependent system alarm
A system alarm is triggered when a defined level is reached.

● Log with level-dependent triggering of an event
The "Overflow" event is triggered when the log is full. The "Overflow" event triggers a system 
function.

9.4.1.2 Properties of Logs

Introduction
You define the properties of a data log in the "Data logs" editor.

You define the properties of an alarm log in the "Alarm log" editor.

The properties of the data log and alarm log are configured in the same way. You configure 
the properties either directly in the table of the respective editor or in the log properties of the 
Inspector window.
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General properties
● Name

You can assign any name to the log. The name must contain at least one letter or one 
number.

● Storage location
The log is stored in a file or a database. You can only save to a database on a PC. Select 
"File" or "Database" as the storage location.
You can specify a folder on the local PC hard disk or a folder on a network drive as the 
storage location, depending on how the HMI device is configured. The following storage 
locations are available for an HMI device:

– Memory card

– USB storage medium

– Network drive

The selection available depends on the HMI device in use.

● Size
The size of a log depends on the type of log and the selected settings.

– Size of a data log
The size of a data log is calculated as follows:
The number of items * the length of each tag value to be logged.
In the "Properties" window, the maximum size that the log accepts for retention of the 
currently selected number of data records is displayed in the input field "Number of data 
records". The maximum log size is limited by the volume of the storage medium.

– Size of an alarm log
The size of an alarm log is calculated from the number of data records and the 
approximate size of an entry. The size of an entry depends on whether the alarm text 
and the associated tag values are to be logged as well.

● Restart characteristics
Under Restart characteristics you can specify that the logging starts when Runtime starts. 
Check the "Enable logging at runtime start" check box.
You can also control the behavior when Runtime starts. Enable "Reset log" if you want to 
overwrite existing logged data with the new data. Select the "Append data to existing log" 
option if you want to retain the existing logged data. This setting adds the data to be logged 
to an existing log.

See "Basic principles for data logging (Page 1107)" and "Basics on alarm logging 
(Page 1352)" for more details.

 

 Note

You can use system functions to control the restarting of a log in Runtime.
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See also
Log Basics (Page 1468)

Basic principles for data logging (Page 1107)

Basics on alarm logging (Page 1352)

9.4.2 Working with Logs

9.4.2.1 Log basics

Introduction
WinCC provides the following types of logs for logging process data in Runtime Professional:

● Fast data log

● Slow data log

● Alarm logs

Data logs are used to log process data from an industrial plant.

Alarm logs are used to log alarms that occur in the monitored process.      

Principle
The different types of logs all have roughly the same structure and largely work in the same 
way. They are very clear and easy to configure. With all three types of log you define the same 
properties for the log type.

All three log types can be broken down into individual segments. Segmenting can be made 
based on size or time.

There are two types of logs available for data logs:

● Fast data log
This type of log is used to log process data that change rapidly with a cycle time <= 1 min.

● Slow data logs
This type of log is used to log all process data not covered by the "Fast data log" type. In 
the configuration, you can specify several parameters to define the tag values to be saved 
in a certain type of log.

The alarm log settings are independent of the data log settings.
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9.4.2.2 Properties of logs 

Introduction
You can configure the basic properties of logs in Runtime Professional, such as the segment 
size, in the "Runtime settings > Logging" dialog. The settings configured in this dialog apply 
to all the logs in the project.

You configure the special properties for the individual log types either directly in the table of 
the respective editor or in the log properties of the Inspector window.

You configure the logical organization of data logs and compressed logs in the "Historical Data" 
editor. See "Data logging (Page 1127)" for more details.

There are no comparable logical structures within the log for alarm logs. This means there is 
no separate "Alarm log" editor in Runtime Professional. You can only specify whether or not 
an alarm should be logged. You configure logging of alarms in the "HMI alarms" editor in the 
"Alarms classes" tab. For detailed information, refer to "Basics on alarm logging (Page 1368)".

Properties
The following properties are available for segmenting:

● Time period of all segments

● Maximum size of all segments

● Time period contained in one single segment

● Maximum size of a single segment

● Time of first segment change

You can also specify how and when backups are to be created.
Additional properties are available for the "Fast data" log type which you can use to divide the 
process data between the "Fast" or "Slow" log types.
See "Logging Settings (Page 1154)" for more details.

See also
Data logging (Page 1127)

Configuring alarm logging (Page 1368)

Data logging (Page 1127)

Basics on alarm logging (Page 1368)

Logging Settings (Page 1154)

Log basics (Page 1470)
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9.5 Working with recipes

9.5.1 Working with recipes

9.5.1.1 Basics

Definition and applications

Introduction
Recipes are collections of related data, for example, machine parameterizations or production 
data.   

 

 NOTICE

Restrictions for recipes

Recipes are not available on the HMI device OP 73:
 

Examples:

● Machine parameter settings that are needed to convert production to a different product 
variant.

● Product components that result in different compositions for different end products.

A recipe has a fixed data structure. The structure of a recipe is defined during configuration. 
A recipe contains recipe data records. These differ in terms of their values, but not their 
structure. 

Recipes are stored on the HMI device or on an external storage medium. Recipe data records 
are always transferred complete and in a single pass between the HMI device and the PLC. 
In addition, production data can be imported in runtime, in the form of a CSV file.

 

 NOTICE

Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.
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Using recipes
Recipes can be used in the following situations:

● Manual production
You select the required recipe data and display it on the HMI device. You modify the recipe 
data as required and save it on the HMI device. You transfer the recipe data to the PLC. 

● Automatic production
The control program starts transfer of the recipe data between the PLC and HMI device. 
You can also start the transfer from the HMI device. Production is then implemented 
automatically. It is not essential to display or modify the data. 

● Teach-in mode
You optimize production data that was optimized manually on the system, e.g. axis positions 
or filling volumes. The values thus determined are transferred to the HMI device and saved 
in a recipe data record. You can then transfer the saved recipe data back to the PLC at a 
later date.

Entering and modifying the recipe data
You enter the data in the individual recipe data records and modify it as required. The following 
options are available:

● Data entry during configuration
If the production data exists already, you enter the data in the "Recipes" editor during recipe 
configuration.

● Entering the data in Runtime
If you have to frequently modify production data, you can do this directly in Runtime as 
follows:

– Enter the data directly on the HMI device.

– Set the parameters directly on the machine. You then transfer the data from the PLC to 
the HMI device and save it in the recipe.
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Examples for using recipes
Recipes are used in the manufacturing industry and mechanical engineering, for example. The 
following recipes show typical applications which you can implement with the recipe function 
of WinCC:    

● Machine parameter assignment
One field of application for recipes is the assignment of machine parameters in the 
manufacturing industry: A machine cuts wooden boards to a certain size and drills holes. 
The guide rails and drill have to be moved to new positions according to the board size. 
The required position data are stored as data records in a recipe. You reassign the machine 
parameters using "Teach in" mode if, for example, a new board size is to be processed. 
You transfer the new position data directly from the PLC to the HMI device and save it as 
a new data record. 

● Batch production
Batch production in the food processing industry represents another field of application for 
recipes: A filling station in a fruit juice plant produces juice, nectar, and fruit drinks in a 
variety of flavors. The ingredients are always the same, differing only in their mixing ratios. 
Each flavor corresponds to a recipe. Each mixing ratio corresponds to a data record. All of 
the required data for a mixing ratio can be transferred to the machine control at the touch 
of a button. 

Recipe structure

Introduction
The basic structure of a recipe is illustrated with reference to the filling station in a fruit juice 
plant. 

There may be several different recipes in an HMI device. A recipe can be compared to an 
index card box that contains several index cards. The index card box contains several variants 
for manufacturing a product family. All the data for each manufacturing variant is contained on 
a single index card. 

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants include 
fruit juice drink, juice and nectar.
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Recipe
The recipe contains all the recipe data records for the different drink variants.
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Recipe data records
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe entries
Each index card in a drawer has the same structure. All the index cards contain fields for the 
different ingredients. Each field corresponds to a recipe entry. All the records of a recipe thus 
contain the same entries. The records differ, however, in the value of the individual entries. 

Example:

All the drinks contain the following ingredients: 

● Water

● Concentrate

● Sugar

● Flavoring

The records for juice drink, fruit juice or nectar differ, however, in the quantity of sugar used 
in production. 

Display of recipes

Introduction
You can display recipes in the following ways:

● Recipe view

● Recipe screen
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Input in the recipe view and recipe screen
You change the values of a recipe in the recipe screen or recipe view and thus modify the 
manufacturing process or a machine.

The recipe view and recipe screen can perform the same functions when using recipes. They 
differ in the following respects:

● Display options

● Operation

● Possibility of transferring data between the PLC and the HMI device

Recipe view  
The recipe view is suitable for viewing simple recipes.

The recipe view is an off-the-shelf WinCC display and operator control object for managing 
recipe data records. The recipe view is always part of a screen. The recipe view shows recipe 
data records in tabular form. You adapt the appearance and the possible operations to suit 
your specific needs.

If you are editing recipes with a recipe view in your project, the values are saved in recipe data 
records. The values are not transferred between the HMI device and PLC until you use the 
relevant operator control object. 
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Recipe screen   
The recipe screen is an individual screen that contains:

● Input fields for recipe variables

● Operator control objects for using the recipes, e.g. "SaveDataRecord"

The recipe screen is suitable in the following situations:

● Large recipes

● Allocation of recipe fields to the graphic display of the relevant plant area

● Breakdown of the recipe data into several screens
 

  Note

The values of recipe variables are transferred between the PLC and recipe screen at the 
following times depending on the configuration:
● Immediately after modification
● When a relevant operator control object is used

 

Synchronizing recipe view and recipe screen  
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

A complete recipe data record will always be saved or synchronized.
 

 Note

Recipe tags can only be synchronized in the advanced recipe view. Synchronization only 
takes place if the "Synchronize recipe view and recipe tags" setting is activated for the recipe.
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Transferring recipe data records

Flow of data in recipes
The following picture illustrates the flow of data in recipes:   

Interaction between the components
There is interaction between the following components at runtime:

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen:

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.

You synchronize the values displayed in the recipe view with the values of recipe tags 
according to the configuration.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the values of the recipe tags are 
exchanged with the PLC depends on the configuration.

 

  Note

You can synchronize the recipe tags with the recipe data records so that the same values 
are saved in both.
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Loading and saving recipe data
Complete recipe data records are loaded from or saved to the recipe memory on the HMI 
device in the recipe view.

The values of the recipe data record are loaded from the recipe memory to the recipe tags in 
the recipe screen. When they are saved, the values of the recipe tags are saved to a recipe 
data record in the recipe memory.

Transferring the recipe values between the HMI device and the PLC
Complete recipe data records are transferred between the recipe view and PLC.

The following transfers are possible between the recipe screen and PLC, depending on the 
configuration:
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● Transferring recipe data records between recipe view and recipe tags

● Immediate transfer of individual modified values between the recipe tags and PLC. The 
following settings are needed in the recipe in order to do this:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.

Recipe data records can be transferred directly between the HMI device and PLC. In these 
situations, the display on the HMI device is not essential.

Exporting and importing recipe data records
Recipe data records are exported from the HMI device recipe memory and are saved to a CSV 
file on the external storage medium. The records can be reimported from the storage medium 
to the recipe memory.   

The following external storage media may be used, depending on the HMI device:

● No storage medium, for example, for basic panels

● Memory card

● USB stick

● Hard disk
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Configuration of recipes

Introduction
Recipes are configured differently according to the intended use: 

● If you are editing recipes with a recipe view in your project, the values are only saved in 
recipe data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.

The following possible settings determine how the recipe data records, recipe tags and PLC 
all interact.

"Synchronizing recipe view and recipe tags" deactivated
The data in a data record is only displayed and can only be edited in the recipe view. If you 
use data outside the recipe view, they are not synchronized with the recipe view.

"Synchronizing recipe view and recipe tags" activated 
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The recipe tags and the recipe view are not synchronized until you use the 
operating element with the "RecipeViewSynchronizeDataRecordWithTags" function.

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" activated 

With this setting, modified recipe values are not synchronized immediately between the recipe 
tags in the recipe screen of the HMI device,and PLC. 

There must be an operating element with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values.

If recipe values are changed in the controller, the modified values are displayed immediately 
in the recipe screen if you use the operating element with the "GetDataRecordFromPLC" 
function. 

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" deactivated 

With this setting, modified recipe values are synchronized immediately between the recipe 
tags on the HMI device and PLC. 

When you change recipe values in the recipe screen, these changes are applied immediately 
by the PLC and immediately influence the process.

If recipe values are changed in the PLC, the changed values are displayed immediately in the 
recipe screen.

Special features of some devices
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Basic panels, OP 77A, TP 177A and TP 177A (Portrait) respond differently to the other HMI 
devices in the following respects:   

● Only the simple recipe view is supported.

● Recipe tags are always synchronized with the recipe view (see figure above): When the 
operator changes a value of the recipe element in recipe view, the value of the associated 
recipe tag will also change.

● Recipe tags are not automatically transferred between the PLC and HMI device when they 
are modified. Recipe tags are always transferred manually in teach-in mode.
There must be an operator control object with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values with the 
PLC.

 

 
 NOTICE

Restrictions for recipe tags

Generally, in Basic Panels and OP77A, TP177A (Portrait) recipe tags cannot be used, 
except in a recipe.

 

 
 NOTICE

Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported 
using ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is 
interrupted.

 

 
 CAUTION

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.
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Interaction between the components
There is interaction between the following components at runtime:

● Recipe view
Recipes are displayed and edited in the recipe view on the HMI device.
The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain the values of recipe elements.

Synchronization of recipe data records with the PLC

Overview
When recipe data records are transferred between the HMI device and PLC, both 
communication peers access common communication areas on the other peer.

Recipe data records are always transferred directly. The values of the tags are written directly 
to or read directly from the configured addresses without being placed on the clipboard.

Data transfer types
There are two ways to transfer recipe data records between the HMI device and PLC:

● Transfer without coordination

● Coordinated transfer via the "Data record" area pointer.
 

  Note
Coordinated transfer

Transfer with coordinated transfer is used to prevent the uncontrolled overwriting of data 
in either direction in your control program.

 

Requirements for coordinated transfer
The following requirements apply to coordinated transfer:

● The "Data record" area pointer must be set up for the required connection in the 
"Communication > Connections" editor.

● In the properties of the recipe "Coordinated transfer of data records" is activated.

● The connection to the PLC is specified in the properties of the recipe with which the HMI 
device coordinates the transfer.
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Coordinated transfer
In the case of coordinated transfer, both the PLC and the HMI device set the status bits in the 
shared data compartment.

Coordinated transfer of recipe data records can be a useful solution in the following cases:

● The PLC is the "active partner" for the transfer of recipe data records.

● The PLC evaluates information about the recipe number and name, as well as the recipe 
data record number and name.

● The transfer of recipe data records is started by the following PLC jobs:

– "Set_data_record_in_PLC"

– "Get_data_record_from_PLC"  

"Recipes" editor

Introduction
You can create, configure and edit recipes, recipe entries and recipe data records in the 
"Recipes" editor. The "Recipes" editor also allows you to enter values in recipe data records. 

Structure of the "Recipes" editor
You create recipes in the top part of the table editor. You can also configure them there or in 
the Inspector window.

The bottom part of the table editor has the following tabs:

● Elements
Define the recipe elements of the selected recipe using the table cells provided here. You 
can move recipe elements within the table with the shortcut menu commands, "Up" and 
"Down".

● Data records
Define the values of the data records of the selected recipe using the table cells provided 
here.
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You can then configure the selected recipe, the recipe element or the recipe data record in the 
Inspector window. You will find further notes on configuring the components of a recipe under 
"Configuring Recipes".

Recipe settings
The following settings are available for recipes:

Setting Description
Name of the recipe This is a unique identification for the recipe within the HMI device. 
Display name Appears in the recipe view, for example, in Runtime. You can configure 

display names in multiple languages. Assign descriptive names or 
designations which the operator can associate directly with a recipe, e.g. "fruit 
juice drink".

Recipe number This is a unique identification for the recipe within the HMI device.
Version Information about the recipe. The date and time of the last change to the 

recipe is set by default.
Path Defines the storage location for recipes. The recipes are stored as a file.
Size type [fixed] The recipe data records are limited to a predetermined number by default.
Number of data 
records [fixed]

Maximum number of data records in a recipe in Runtime. The number is 
limited by the recipe memory of the HMI device.

Communication type 
[fixed]

The recipe data records are written directly to the addresses of the recipe 
tags and read from there.

Tooltip Tooltip for the recipe which is shown to the operator in Runtime.
 

 NOTICE

Path

The storage location depends on the storage media available on the HMI device. 

Basic Panels and OP77A, TP177A (Portrait)

These HMI devices have no external memory. Recipes are always saved in the internal Flash 
memory. The "Path" setting is therefore not available.

 

Recipe element settings
You can make the following settings on the "Elements" tab:

Setting Description
Name of the recipe element Identifies a recipe element uniquely within the recipe. Enter meaningful 

names or labels that you can allocate uniquely, such as axis labels on 
a machine or ingredients such as "Flavoring".

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
designations which the operator can associate directly, e.g. "fruit juice 
flavoring".
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Setting Description
Recipe tag An assigned tag in Runtime stores the current value of the recipe 

element in the recipe data record.
Data type Data type of the recipe tag.
Data length [fixed] Data length of the recipe tag, depending on the data type.
Text list Text is assigned to a value or range of values in a text list. You can 

display this text in an output field, for example. 
The assigned recipe tag must have the data type of a number. The tag 
value must be within the range of values of the text list.    

Default value This is used as the default entry when you create a new recipe data 
record.

Minimum value [fixed] The smallest representable value of a number-based recipe tag, 
depending on the type of data.

Maximum value [fixed] The largest representable value of a number-based recipe tag, 
depending on the type of data.

Decimal places Determines how many places a decimal number is rounded to, e.g. 3 
decimal places and vice versa by what power of ten an integer value 
is multiplied, e.g. 1,000. 

Tooltip Tooltip about the recipe element which is shown to the operator in 
Runtime.

Recipe data record settings
You can make the following settings on the "Data records" tab:

Setting Description
Name of the recipe data 
record

Identifies a recipe data record uniquely within the recipe. 

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
product numbers which the operator can associate directly with a 
product, e.g. "yellow fruit juice E231".

Recipe data record number Identifies a recipe data record uniquely within the recipe.
Recipe elements 1 to n You can store various values for each recipe element even during 

configuration. Together with the values of the other recipe elements, a 
value always forms a recipe data record. You can store multiple recipe 
data records.
If enabled in the transfer settings, the recipe data records are 
transferred to the HMI device when downloading the project and 
existing data records on the HMI device are overwritten. 

Comment Comment about the recipe data record

9.5.1.2 Displaying and Editing Recipes in Runtime

Recipe screen and recipe view
You can display and edit recipes on the HMI device with a recipe view or recipe screen.   
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Recipe view
The recipe view is an off-the-shelf WinCC display and operator control object.

The recipe view is available in the following views: 

● As anvanced recipe view

● As simple recipe view
 

 
 NOTICE

Availability

In basic panels and OP77A, TP177A, only the simple recipe view is available.
 

Recipe screen
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

 

 NOTICE

Availability

In basic panels and OP73, OP77A, TP177A (Portrait), the recipe screens are not available.
 

Simple recipe view

Recipe view  
The simple recipe view is a ready-made display element and operator control that is used to 
manage recipe data records. The recipe view shows recipe data records in tabular form. 

The displayed buttons and information in the columns are adjustable.

The values displayed or entered in the recipe view are saved in recipe data records. The 
displayed recipe data record can be written into the PLC by buttons or values can be read in 
from the PLC. 

Layout of the display   
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list.

The figure below shows an example of the data record list.
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Display of values  
 

 NOTICE

Processed recipe data record is changed in the background  

Only applies for Basic Panels: if an operator has changed a recipe data record and a PLC 
job wants to read or write any recipe data record of this recipe, the PLC job is stopped and 
a system alarm is output. On the other hand, the changed value is displayed immediately if 
only the PLC job and no operator has changed recipe data.

Does not apply for Basic Panels: If an operator has changed a recipe data record and a PLC 
job has changed the values of the recipe data record concerned, the recipe view is not 
updated automatically. To update the recipe view, reselect the respective recipe data record.

 

See also
Recipe view (Page 901)

Configuration options of the simple recipe view
The response of the simple recipe view can be defined in the recipe view inspector window.

 

 NOTICE

Validity

Some devices, for example basic panels, only support the simple recipe view.

For all other devices, observe the following:
● In the Inspector window, under "Properties > Display > Mode", select "Simple view" as 

"View type".
● The "Properties > Simple view" area contains additional properties only applicable to the 

simple recipe view.
● All other properties are also applicable to the advanced recipe view.
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Displaying recipe data record values only
To display the recipe data in a recipe view for checking only, proceed as follows: 

1. Deselect "Edit mode" in the "General" group.

You cannot create, rename, edit or delete recipe data.  

Writing a recipe data record number or name to a tag
A tag to each recipe data record can be configured in the advanced recipe view. Depending 
on the "String" or "Int" data type of the tag, the name or number of the recipe data record is 
stored in the tag. Conversely, the tag can also be used to select a recipe data record by entering 
the corresponding value. For example, the tag can be transferred as a parameter for a system 
function. 

Proceed as follows:     

1. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The number of the recipe data record is stored in a tag.

Configuring an event on the recipe view    
 

 NOTICE

Events and buttons

The "Events" register is faded out when a minimum of one button is enabled.
 

To configure an event for the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Deactivate all buttons under "Properties > Toolbar" and "Properties > Simple view".
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3. In the Inspector window, under "Properties > Events", click the event to be configured, e.g. 
"Enable".

4. Configure a function list for the event.

The function list is processed when the operator enables the recipe view.

Animation properties of the recipe view    
To configure an animation of a recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Click under "Properties > Animations" in the Inspector window.

3. Link a tag to one or more of the following properties.

– X-Position and y-Position

– Design: Colors, flashing

– Operability

– Visibility
In the "Animations> Overview" area, all animations are summarized in tabular form. 
Under "Animations> Tag links > Tag linkage", as well as visibility and position a tag can 
also be linked to height and width.

 

 
 NOTICE

Animations and buttons

If all buttons are not disabled, an error message appears whilst compiling the project 
for windows-CE HMI devices.
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Constraints on the simple recipe view  
The following functions are not possible in the simple recipe view:

● Synchronizing recipe view and recipe tags

● Writing a recipe number / name to a tag

● Display status bar

● Display data record number

● Display label

● Display table

Advanced recipe view

Recipe view  
The advanced recipe view is an off-the-shelf display and operator control object that is used 
to manage recipe data records. The recipe view shows recipe data records in tabular form. 

The buttons, headers and information displayed in the columns are variable.

The values displayed or entered in the recipe view are saved in recipe data records.

Layout of the display   
The picture below contains an example of the advanced recipe view:
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Display of values  
 

 NOTICE

Changing the recipe data record in the background  

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a control job, the recipe 
view is not updated automatically. 

To update the recipe view, reselect the respective recipe data record.
 

See also
Recipe view (Page 901)

Configuration options of the advanced recipe view
The response of the advanced recipe view in the recipe view inspector window can be 
determined.

 

 NOTICE

Validity

The following description also applies to the advanced recipe view. In the Inspector window, 
under "Properties > Display > Mode", select "Advanced view" as "View type".

All properties described for the simple recipe view are also applicable in the advanced recipe 
view, except "Properties > Simple view". The "Simple view" area contains additional 
properties only applicable to the simple recipe view.

Basic Panels, OP77A and TP177A (Portrait) do not support any advanced recipe view.
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Displaying a recipe
To allow access to the recipe data records of a specific recipe only in a screen, proceed as 
follows:  

1. Enter the recipe or select an existing recipe in the "Recipe" field, under "Properties > 
General".

2. When a recipe is entered in the "Recipe" field, you will have to enable the "Selection list" if 
you want to display the recipe name in Runtime.

The selected recipe appears in the recipe view.

Writing a recipe number or name and recipe data record number or name to a tag
Both the recipe and the recipe data record can each be configured to a tag in the recipe view. 
Depending on the "String" or "Int" data type of the tag, the name or number of the recipe or 
recipe data record is stored in the tag. Conversely, the tag can be used to select the recipe or 
recipe data record by entering the corresponding value. For example, the tag can be 
transferred as a parameter for a system function. 

Proceed as follows:     

1. Enter a tag of the "String" type in the field "Recipe tag", under "Properties > General > 
Recipe".

2. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The name of the recipe and the number of the recipe data record are each stored in a tag.

Using the recipe view as a drop-down list  
To use the recipe view as a selection field for recipes and recipe data records in a recipe 
screen, proceed as follows:

1. Select the tag for the recipe name under "General > Recipe > Recipe tag".

2. Select the tag for the recipe data record name under "General > Recipe data record >Tag".
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3. Disable the "Edit mode". You cannot create, rename, edit or delete recipe data.

4. In order to select recipes, enable "Show selection list" and make sure that no recipe is 
selected under "Properties > General > Recipe".

5. Deactivate all buttons under "Properties > Toolbar".

Configuring an event on the recipe view    
To configure an event on the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. In the Inspector window, click the event you want to configure under "Properties > Events".

3. Configure a function list for the selected event.

The function list is processed when the configured event occurs.

Response of the recipe view in Runtime

Screen change
If you change to another screen and have not yet saved changes to the recipe data in the 
recipe view, you will be prompted to save the recipe data. The recipe name and the name of 
the recipe data record are displayed to show which recipe data have not been saved yet.  

Create, change, copy or delete recipe data records
If you attempt to create a new recipe data record and a recipe data record already exists, a 
system alarm will appear on screen. 

Operating the recipe view with function keys
The Recipe view can be operated with function keys, e.g. if the HMI device does not have 
touch functionality. You can assign functions such as "SaveDataRecord" to the function keys 
on the HMI device.  
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Display after import of recipe data
 

 NOTICE

Availability

Import and export of recipe data is not available for Basic Panels and OP77A, TP177A 
(Portrait).

 

If you open the recipe view during the import of recipe data, only the recipe data that is already 
completely imported will be displayed. The recipe view is not automatically updated with a data 
import. In order to have a complete view of all the recipe data, do not open the recipe view 
until the system prompts you that the recipe data has been imported successfully. Alternatively, 
update the recipe view after successful completion of the import procedure.

Updating tag for recipes and recipe data records
 

 NOTICE

Availability

Tags for recipes and recipe data records are not available for Basic Panels and OP77A, 
TP177A (Portrait).

 

The current recipe data record or its number can be saved to a tag, depending on the 
configuration. The tag will be updated under the following conditions:

● The recipe data record has been loaded.

● The screen with the recipe view was not exited during loading.

This operation may take some time.  

Basics on the recipe screen

Introduction
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

The picture below contains an example of a recipe screen:
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 NOTICE

Availability of recipe screens

Basic Panels and OP73A, OP77A, TP177A (Portrait) do not support any recipe screens.
 

Principle
Configuring a recipe screen allows you to customize the display. You can spread large recipes 
over several screens according to topic and display them clearly using features such as 
graphical display and operator control objects.

● Spreading recipes over several screens according to topic

– You can distribute recipe data records with multiple entries across several screens. For 
example, for each plant area you can configure a screen containing the associated 
screen forms for the recipe data records.

Spreading recipes over several screens is useful for HMI devices with small displays as 
they avoid having to scroll through tables in Runtime. 

● Visual machine simulation
You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements such as axes or guide rails. which produces a direct relationship 
between the values and the machine.  
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Synchronizing recipe values     
To enter recipe data record values outside the advanced recipe view in the configured I/O 
fields, activate "Synchronize recipe view and recipe tags" under "Properties > Synchronization" 
in the recipe properties.

The "Synchronize recipe view and recipe tags" option is not available for the simple recipe 
view.

Transferring recipe values automatically     
If the entered recipe values must be immediately transferred to the connected PLC in Runtime, 
deactivate "Manual transfer of individual modified values (teach-in mode)" under "Properties 
> Options". 

Configure the "SetRecipeTags" system function if you want to enable and disable the 
immediate transfer of entered recipe values in Runtime.

System functions
The following system functions are available for operator control of a recipe screen:

● ImportDataRecords

● ExportDataRecords

● LoadDataRecord

● SaveDataRecord

● SetDataRecordTagsToPLC

● GetDataRecordTagsFromPLC

The following system functions are available for operator control of the recipe view when it is 
being used in the recipe screen:

● RecipeViewSaveDataRecord

● RecipeViewSaveAsDataRecord

● RecipeViewSynchronizeDataRecordWithTags

● RecipeViewDeleteDataRecord

● RecipeViewNewDataRecord

● RecipeViewGetDataRecordFromPLC

Visualizing processes (Professional)
9.5 Working with recipes

WinCC Professional V11.0 SP1
1498 System Manual, 08/2011,  



● RecipeViewRenameDataRecord (for simple recipe view only)

● RecipeViewShowOperatorNotes

● RecipeViewMenu (for simple recipe view only)

● RecipeViewOpen (for simple recipe view only)

● RecipeViewBack (for simple recipe view only)

The system functions for loading, saving and transferring recipe data records and recipes are 
located in the "Recipes" group. 

9.5.1.3 Configuring Recipes

General configuration procedure
Carry out the following configuration steps when you create a new recipe:

Step Description
1 Define the structure of the recipe.
2 Create tags according to the recipe structure. 

Assign process names to these tags.
3 Create the recipe.
4 Enter the required properties for the recipe:

● Language-dependent view name of the recipe
● "Coordinated transfer of data records" option
Not for Basic Panels:
● Recipe storage location
● "Synchronize recipe view and recipe tags" option
● "Manual transfer of individual modified values (teach-in mode)" option

5 Create the recipe elements and enter the required properties:
● Language-dependent view name of the recipe elements
● Tag binding of the recipe elements
● Standard values and decimal places (power of ten) for the recipe elements

6 Create the recipe data records.
Enter the language-specific display names for the recipe data records.

7 Configure a screen with recipe view or a recipe screen.
 

 NOTICE

Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are always 
saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.
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 NOTICE

Restrictions recipe view and recipe image

Only the simple recipe view is available in Basic Panels and OP77A, TP177A. Recipe images 
are not available in Basic Panels and OP73, OP77A, TP177A (Portrait).

 

Creating and Editing Recipes

Creating a new recipe

Introduction
To create a complete recipe, start by creating a new recipe, assign the corresponding recipe 
elements and then define the associated values in a recipe data record.

Requirement
● The tags for the recipe have been created.

● The "Recipes" editor is open.

Create recipe
Create a recipe as follows:

1. Click "Add" in the first free row of the table in the "Recipes" editor.     
The new recipe is created and displayed on a line.

2. Enter a descriptive name for the recipe under "Name" in the "General" area.
This name identifies the recipe unambiguously within the project.

3. Select "Display name" to enter the language-specific name to be displayed in runtime.
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4. Select a recipe number in "Number".
The number identifies the recipe unambiguously within the HMI device.
The recipe is automatically assigned a version that indicates the date and time of the last 
change. As an alternative, you can enter specific information relating to the recipe.

5. Specify the storage location for recipe data records in "Data medium". The options offered 
depend on the specific HMI device used.

 

 
 NOTICE

Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are 
always saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.

 

6. Enter a tooltip that is shown to the operator in runtime.

7. To compare recipe tags which are configured in I/O fields with the recipe view in Runtime, 
activate "Synchronize recipe view and recipe tags" in the Inspector window under 
"Properties > Synchronization".

 

 
 NOTICE

Basic Panels and OP77A, TP177A (Portrait)

Because the recipe tags cannot be additionally used in I/O fields in screens for Basic 
Panels, the "Synchronize recipe view and recipe tags" is not available; you will also not 
be able to use the "Manual transfer of individual modified values (teach-in mode)" option.

 

8. Deactivate "Manual transfer of individual modified values (teach-in mode)" to specify that 
the recipe tags are automatically transferred to the PLC when editing the I/O fields.

9. Activate "Coordinated transfer of data records" to monitor the transfer of recipe data in 
Runtime using area pointers.

10.Select the appropriate connection to the PLC for coordinated transfer under "Synchronize 
with".
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Create recipe element
To create recipe elements, proceed as follows:

1. Click the "Elements" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe element is created.

3. Enter a descriptive name for the element under "Name".
The name identifies the element uniquely within the recipe.

4. Enter a language-specific display name for the element under "Display name".
The display name appears in the recipe view, for example, in runtime.

5. Select the tag you want to link to the recipe element under "Tag".
The value of the recipe data element is saved in Runtime in this tag, which is stored in a 
recipe data record.

6. Enter a tooltip.
The tooltip is shown to the operator in Runtime.

7. Under "Default value", enter the value that you want to use as the default entry when you 
create a new recipe data record.

8. To assign text to a value or range of values, select the relevant text list here. The assigned 
recipe tag must have the data type of a number. The tag value must be within the range of 
values of the text list.
The text stored in the text list is displayed in an output field, for example, in Runtime.

9. Determine exactly how many places a decimal number is rounded to in the "Decimal places" 
column, e.g. 3 decimal places and vice versa by what power of ten an integer value is 
multiplied, e.g. 1,000.
Examples for 3 decimal places: Entering "5" for a recipe element with the "Integer" data 
type gives the value "5000". Entering "5.6789" for a recipe element with the "Real" data 
type gives the value "5.679".

10.Create as many recipe entries as needed for the recipe. The maximum number of recipe 
entries possible depends on the HMI device being used.
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Create recipe data record with known recipe values
To create recipe elements, proceed as follows:

1. Click the "Data records" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe data record is created. The recipe data record has a separate column for 
every recipe element created in the recipe.

3. Enter a descriptive name under "Name".
The name identifies the data record uniquely within the recipe.

4. Enter a language-specific name under "Display name".
The display name appears in the recipe view, for example, in runtime.

5. Enter a recipe data record number under "Number".
The recipe data record number identifies the recipe data record uniquely within the recipe.

6. If you already know the recipe values at the configuration stage, you can enter the relevant 
value for each recipe element.

7. Create as many data records as you need for the recipe.
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Enter the values in runtime
The following options are available for entering values in the recipe data records at runtime:

● Transfer data directly from the PLC (Teach-in mode)

● Import of values from a CSV file

● Input values on the HMI device
 

 
 NOTICE

Basic Panels and OP77A, TP177A (Portrait)

The import of values is not available for these devices.
 

Result
The complete recipe is configured. 

Recipe data records with date or time stamp
If you use date or time data, make sure that the system setting for time and date on the 
configuring computer match those on the target system.  Example: You load a recipe data 
record on the target system at 13:55 in which 14 h is stored as the processing time. If it is 
already 14:05 on the target computer, the recipe will not be processed. If an operator processes 
the recipe, change information will not written back correctly into the database. 

After loading to the target system, check the recipes with date or time stamps on the target 
system.

Editing a recipe

Purpose
You want to modify, extend or delete parts of a recipe. 

Requirement
● You have created at least one recipe.

● The "Recipes" editor is open.

Changing recipe settings
To change the recipe settings, proceed as follows:

1. Select the recipe that you want to change in the "Recipes" editor.
The Inspector window opens.

2. Change the recipe configuration in the Inspector window.

You change recipe elements and recipe data records in the same way.
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Change recipe values
To change recipe values, proceed as follows:

1. Select the recipe whose values you want to change.

2. Click the "Data records" tab.

3. Enter the new values in the value columns.

Adding a recipe element
To add more recipe elements to a recipe, proceed as follows:

1. Select the recipe to which you want to add more elements in the "Recipes" editor.

2. Click the "Elements" tab.

3. Click "Add" in the first free line.
The recipe element is created.

4. Configure the recipe element.

You add recipe data records in the same way.

Managing recipes

Requirement
● You have created a recipe with recipe elements and recipe data record.

● The "Recipes" editor is open.

Renaming recipes
We distinguish between internal names and display names for recipes, recipe entries and 
recipe data records.

To rename recipe elements, proceed as follows:

1. Select the recipe that you want to rename.
The Inspector window opens.

2. Select the "Rename" command from the shortcut menu.

3. Enter the new name.
You rename recipe elements and recipe data records on the relevant tab in the same way.

 

  Note

The view names in the "Recipes" editor can also be renamed under "Languages & 
Resources > Project Texts". This possibility is useful when you have already configured 
in several languages for example.
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Copying and pasting recipes
To copy and paste recipes, proceed as follows:

1. Select the recipe that you want to copy.

2. Select the "Copy" command from the shortcut menu.

3. Select the "Paste" command from the shortcut menu in the first free table row.

The copied recipe is pasted into the table. The recipe elements and recipe data records are 
also copied in the appropriate tab with the recipe.

You also copy the recipe elements and recipe data records on the appropriate tab in the same 
way.

If a recipe data record of the same name already exists, the name of the copied recipe data 
record is extended by one digit. This ensures that the name is unique. Recipe data records 
can only be copied or pasted within the same recipe.

Deleting a recipe
To delete a recipe, proceed as follows:

1. Select the recipe that you want to delete.

2. Select the "Delete" command from the shortcut menu.
The recipe is deleted.

You delete recipe elements and recipe data records on the relevant tab in the same way.
 

 Note

When a recipe is deleted, the recipe data records contained in the recipe are also deleted.
 

 Note

When you delete a recipe element, the associated values in the recipe data records are also 
deleted. The assigned tags are retained.
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Configuring the display of recipes

Configuring the simple recipe view

Requirement
● You have created the recipe.

● The "Screens" editor is open.

● The screen has been created and opened.
 

 
 CAUTION

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.

 

Procedure
To configure a simple recipe view, proceed as follows:

1. Paste the recipe view into the screen. You will find the recipe view under "Controls" in the 
"Tools" task card.  

2. Only in devices which also support the extended recipe view: Activate "Simple view" under 
"Properties > Display > Mode".
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3. If you want to display only the recipe data records of a specific recipe in the recipe view, 
select the specific recipe under "Properties > General > Recipe".

4. If you only want to display the recipe data in the recipe view, deactivate "Processing mode" 
in the "Recipe data record" area.

5. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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6. Select "Properties > Simple view" to select the position, the field length, and the number of 
lines required.
Select "Position > Top" to display the recipe value in the first line of the recipe entry.
Select "Position > Bottom" to display the recipe value in the last line of the recipe entry. 

7. Under "Properties" > Toolbar" specify which menu commands are available in the recipe 
view in Runtime.

Result
The simple recipe view is configured. You can use the recipe view to display and edit recipe 
data during runtime. 
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Configuring the Advanced Recipe View

Requirement
● The recipe has been created.

● The "Screens" editor is open.

● The screen has been created and opened.

Procedure
To configure an advanced recipe view, proceed as follows:

1. Paste the recipe view into the screen. The recipe view is found under "Controls", in the 
"Tools" task card.  

2. Select "Advanced view" under "Properties > Display > Mode" in the Inspector window.

3. Select the required settings from the "General" group in the Inspector window.

– If you want to display only the recipe data records for a particular recipe in the recipe 
view, select the recipe under "Recipe" in the "Recipes" area.

– If no recipe is selected in the "Recipe" recipe view, the operator can select the recipe 
himself in Runtime.

– If you want to save the recipe name or the recipe number in a tag, select the tag under 
"Recipe tag" in the "Recipe" area.

– If you want to save the recipe data record name or number in a tag, select the tag under 
"Tag" in the "Recipe data record" area.

– If you only want to display the recipe data in the recipe view, deselect "Edit mode".

– If you only want to use the recipe view to select recipes, deselect "Display table" under 
"Properties > Table".

4. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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5. If you want to change the label in the recipe view, enter a suitable text under "Properties" 
> "Label".

6. Under "Properties" > Toolbar" specify which buttons are available in the recipe view in 
Runtime.

 

  Note

If you select the "Edit" command in the context menu of the recipe view, the recipe view 
becomes active. To activate the recipe view, the zoom factor must be set to 100%.

You can set the column width and the position of the "Entry name" and "Value" columns 
in active mode.

 

Result
The recipe view is configured. You can use the recipe view to display and edit recipe data 
during runtime. 

Configuring a recipe screen

Introduction
The recipe screen is a screen in which you configure a customized screen form in the "Screens" 
editor. You create the screen form from input/output fields and other display and operator 
control objects. System functions are used to configure the recipe functionality, such as saving 
recipe data records.    

 

 NOTICE

Availability

Recipe screens cannot be created for basic panels and OP73, OP77A and TP177A (Portrait).
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Application
You can spread recipe data records containing lots of entries across several screens. For 
example, for each plant you can configure a screen containing the associated screen forms 
for the recipe data records.

You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements, such as axes or guide rails. You can use this to produce a direct 
reference between the values and the machine.

Requirement
● You have created the recipe.

● The "Screens" editor is open.

Procedure
To configure a recipe screen, proceed as follows:

1. Configure the screen and create the I/O fields for the input mask of the recipe.
You can create multiple screens to suit the size and complexity of the recipe.

2. Configure the I/O fields with the tags you have linked to the recipe element.

3. Configure I/O fields for selecting recipes and recipe data records.

Alternatively:

1. Configure a recipe view as a selection list for recipe data records and recipes.

2. Hide the buttons that are not required in the recipe view.

3. Configure the system functions for editing recipe data records on the configured control 
elements.
Control elements are configured buttons in the screen or function keys on the HMI device.
You will find the system functions for editing recipe data records under "Recipes" and 
"Keyboard operation for screen objects".

Result
The recipe screen is created.

Importing recipes into the configuration and exporting them

Introduction
You can export recipes as a CSV file and import them again into the configuration. 

Application case
Recipe data is exported for long-term storage and backup on a computer. 
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In order to unify and distribute recipe data, export the recipe data to an HMI device. Change 
the CSV file in Microsoft Excel and import the CSV file to all HMI devices that require the same 
recipe data.

You want to exchange recipe data between different projects. You change the recipe data in 
Runtime. To transfer the modified recipe data to WinCC ES, export the recipe data records in 
Runtime and copy the CSV file to the configuring computer. There you import the CSV file 
containing the recipe data records into the recipe. And in the opposite direction, you transfer 
the modified recipe data records to the HMI device in WinCC ES in Runtime.

Requirement
● You have created the recipe.

● The structures of the exported CSV file and the recipe in WinCC ES match; name, number 
and data type of the recipe elements are identical. 

● The "Recipes" editor is open.

Importing CSV files
To import recipe data records into a recipe, proceed as follows:

1. Select the row which contains the desired recipe in the "Recipes" tab.

2. Select the "Import recipe data" command from the shortcut menu.
The "Import" dialog box opens.

3. To select the desired CSV file, go to "File name".

4. Under "Strategy", specify whether a recipe data record with the same recipe number in 
WinCC ES should be overwritten.
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5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

 

 
 NOTICE

Use the same list separator for import as in the CSV file for export.
 

6. Click "Import" to start the operation.

Result
The recipe will be amended by recipe data records from the CSV file that have not yet been 
entered. If the option is selected, existing recipe data records will be overwritten.

An error message is shown in the "Info" of the Inspector window if the structure of the recipe 
does not match the structure of the CSV file.

Exporting CSV files  
1. Select the row which contains the recipe to export in the "Recipes" tab.

2. Select the "Export recipe data" command from the shortcut menu.
The "Export" dialog box opens.

3. Under "File name", specify the path of the CSV file.

4. Select all recipe data records under "Selection content", or restrict the selection to specific 
record numbers of the recipe data.
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5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

6. Click "Export" to start the operation.

Result
The configuration is exported as a CSV file. 

9.5.1.4 Using Recipes in Runtime

Simple recipe view

Description of the simple recipe view

Layout
The simple recipe view consists of the following display areas:     

● Recipe list

● Data record list

● Element list

This application is illustrated below:

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation     
You have the following options for using the simple recipe view, according to the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Using the display area and shortcut menu
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.
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Button Key Function
 <Enter> The next lowest display area is opened, i.e. the data record 

list or the element list.
<Esc> The previous display area opens. 

 <INS> Creates a new data record for the selected recipe if the list 
of recipes or recipe data records is displayed. Then changes 
to the list of recipe element.
Requirement: "Properties >General > Processing mode" is 
activated.
The button can be simulated with the "Key 
SimulateSystemKey" function even on devices without keys.

 <DEL> Deletes the selected recipe data record in the list of recipe 
data records.
Requirement: "Properties >General > Processing mode" is 
activated.

 <Up>/<Down> Selects the previous/next entry.
 <Pg Up>/<Pg Down> Moves the display up or down one page.
 <Home>/<End> Selects the first/last entry. The first/last entry is selected.

The table below shows the operation of the shortcut menu:

Button Key Function
<Right> The shortcut menu of the display area opens.

<Esc> The menu is closed. 
The display area opens.

 Input of the number of 
the menu command

The menu command is executed.

Shortcut menus of the simple recipe view     
You can click the  button in each display area to call up a selection of commands. The 
command selection lists those commands that are available in the current display area. A 
number is assigned to each command. The command is executed when you enter this number. 
Alternatively select the command and press the <Return> key.     

Shortcut menus in the recipe list

Menu command Function
New A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
Display tooltip The tooltip configured for the recipe is displayed.
Open The record list of the selected recipe opens.
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Shortcut menus of the recipe data record list

Menu command Function
New Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
Deleting The displayed record is deleted.
Save as The selected data record is saved under a different name. A dialog box opens 

where you can enter the name.
Rename Renames the selected data record. A dialog box opens where you can enter 

the name.
Open The element list of the selected data record opens.
Previous The recipe list opens.

Shortcut menus of the recipe element list

Menu command Function
Save The selected data record with the recipe element is saved.
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
Save as The data record is saved under a new name. A dialog box opens where you 

can enter the name.
Display tooltip The tooltip configured for the recipe element is displayed.
Rename The selected recipe element is renamed. A dialog box opens where you can 

enter the name.
Previous The data record list opens.

Shortcut menus in the data record list
 

 Note
HMI device dependency

The following menu commands are configured in Basic Panels and in OP 77A, TP 177A, 
TP 177A (Portrait) and TB 177B.

 

Menu command Function
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
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Using the simple recipe view

Controlling the simple recipe view with mouse or touchpad
To control the simple recipe view with mouse or touchpad, proceed as follows:

1. Select the desired recipe from the recipe view.

2. Click the button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

Controlling the simple recipe view with the keyboard
To control the simple recipe view with the keyboard, proceed as follows:

1. Press the <Tab> key until the simple recipe view is selected.

2. Select the desired recipe with the cursor keys.

3. Press <Right>.
The shortcut menu is opened.

4. Press the <Down> key until the desired menu command is selected.

5. Press <Enter> to confirm the command.

Key shortcuts for the simple recipe view
The following key shortcuts are activated for the simple recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Key shortcut Effect Menu command
<Insert> Generates a new recipe data record New
<Del> Deletes the recipe data record displayed. Delete

Managing recipe data records

Recipe data record administration
You have the following options for managing the simple recipe view, according to the 
configuration:

● Creating new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records
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Creating new recipe data records
To create a new recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Select the "New" command from the shortcut menu for the recipe list.
A new data record with the next available number will be created. 
The element list of the new recipe data record opens.

3. Enter values for the elements of the recipe data record.
The configuration data may already contain default values for the recipe data record. 

4. Select the "Save" command from the shortcut menu for the element list.
The dialog "Save as" opens.

5. Enter the name and number of the recipe data record.

6. Click the "OK" button.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system event will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. On the HMI device, select the recipe data record of which you want to save a copy.

3. Select the "Save As" command from the shortcut menu for the data record list.
The dialog "Save as" opens. The recipe data record is automatically given the next free 
recipe data record number.

4. Under name, enter the name of the record.

5. Click the "OK" button.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Select the recipe data record.
The element list of the recipe data record is displayed.

4. Replace the old values with new ones.

5. Select the "Save" command from the shortcut menu for the element list.
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Result
The modified values are applied to the recipe data record.

Deleting a recipe data record
To delete a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device from which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Select the "Delete" command from the shortcut menu for the data record list.

4. Confirm this security prompt to delete the data record.

Result
The recipe data record is deleted. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant that are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.

Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Open the recipe on the HMI device.
The data record list opens.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Select the "From PLC" command from the shortcut menu for the element list.
The values are read from the PLC and displayed in the current recipe data record.

4. If you want to save the values, select the "Save" or "Save As" command.

Result
The values are read from the PLC, visualized on the HMI device and saved to the recipe data 
record. 
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Transferring a recipe data record to the PLC

Introduction   
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Open the recipe you want to use.
The data record list opens.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Select the "To PLC" command from the shortcut menu for the element list.

Result
The values of the recipe data record are transferred to the PLC.

Advanced recipe view

Description of the advanced recipe view

Application
The recipe view is used to display, edit and manage data records.    
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Operation
Depending on the configuration you can:   

● Create, change, copy or delete recipe data records

● Synchronizing recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operating elements
The following operating elements can be configured in the recipe view:   

Operating 
element

Key combination Function

 The configured tooltip is displayed.

<Ctrl+Space 
Bar>

Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

<Ctrl+Enter> Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

<Ctrl+*> The recipe data record is saved under a different name regardless 
of the recipe view. A dialog box opens where you can enter the 
name.

<Ctrl+Del> The displayed recipe data record is deleted.

<Ctrl+=> The system always updates the current value of the recipe view 
with the up-to-date recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize recipe view and recipe tags" must be activated in the 
recipe properties before this function can be used.

<Ctrl+Down> The values of the set recipe data record displayed in the recipe view 
are transferred to the PLC.

<Ctrl+Up> The recipe values from the PLC are displayed in the recipe view.

Using the advanced recipe view

Introduction
You can control the recipe view using both mouse or touchpad or with the keyboard.
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Controlling the recipe view with mouse or touchpad
To control the recipe view with mouse or touchpad, proceed as follows:  

1. Select the recipe you want to use.
The records for the recipe are displayed.

2. Click on the data record you wish to edit.

3. Click the button whose function you want to run.

Controlling the recipe view with the keyboard
To control the recipe view with the keyboard, proceed as follows:  

1. Press the <Tab> key until the cursor reaches the field for selecting the recipe.

2. Press <Enter>.
The drop-down list box for the recipes opens. 

3. Select a recipe. You navigate between the next or previous entry in the list by using the 
cursor keys <Left>, <Right>, <Up> and <Down>.

4. Select a data record.

5. Press the <Tab> key until the operator control object you wish to use is selected.

Alternatively you can control the recipe view using certain key combinations.

Key shortcuts for the advanced recipe view
The following key shortcuts are activated for the advanced recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Keys
shortcut

Effect Menu command Button

<Ctrl
+Space>

Generates a new recipe data record.
Any configured start value is displayed in 
the input field.

Add data record

<Ctrl+Del> Deletes the recipe data record displayed. Delete data record"
<Ctrl+Enter> Saves the edited data record by its current 

name.
Save

<Ctrl+*> Saves the edited data record by a new 
name.

Save as

<Ctrl+=> Compares the values of the selected data 
record with the values on the PLC.
Any value in the recipe view which is more 
recent compared to the current recipe tag 
value is written to the recipe tag.
This function is only available if enabled in 
the ES. 

Synchronizing recipe tags

<Ctrl+Down> Transfers the current value to the PLC. Write to PLC
<Ctrl+Up> Reads the actual value from the PLC. Read from PLC

Visualizing processes (Professional)
9.5 Working with recipes

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1523



Managing recipe data records

Administration of recipe data records
You have the following options for managing recipe data records, according to the 
configuration:

● Create new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records

Creating new recipe data records 
To create a new recipe data record, proceed as follows:      

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Click the  button or press the <Ctrl + Spacebar> keys.
A new recipe data record with the next available number is created.
If you change the new data record number to an existing data record number, the existing 
data record is overwritten.

3. Enter values for the elements of the data record.
The elements of the recipe data record can be assigned default values depending on the 
configuration.

4. Click the  button or press the <Ctrl + *> keys.
The dialog "Save as" opens.

5. Enter a name for the data record.

6. Click on "OK" to confirm your input.
The data record is saved under the new name. 
If the recipe data record already exists, a dialog is opened. In this dialog, specify whether 
the existing data record is to be overwritten.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system alarm will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. Select the recipe data record that you want to copy on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + *> keys.
The dialog "Save as" opens.
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4. Enter a name for the data record.

5. Click on "OK" to confirm your input.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Replace the old values with new ones.

4. Click the  button in the recipe view or press the <Ctrl + Enter> keys.

Result
The modified values are applied to the recipe data record.

Delete recipe data record      
To delete a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + Del> keys.

Result
The recipe data record is deleted. 

Synchronizing recipe data record

Introduction
Differences between the following values may occur during runtime:

● The values displayed in the recipe view

● The actual values of the recipe tags
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Depending on the configuration, the values displayed in the recipe view are synchronized with 
the recipe tags. Synchronization encompasses all tags of a recipe data record.

 

 NOTICE

Changed tag name

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
● A recipe data record is displayed in the recipe view.

● The values of recipe tags were modified by teaching, for example.

Procedure
To synchronize a recipe data record, proceed as follows:

1. Click the  button in the recipe view or press the <Ctrl + => keys.

Result
The system always updates the current value of the recipe view with the up-to-date recipe tag 
value.

When the value shown in the recipe view is more recent than the current recipe tag value, the 
system writes this value to the recipe tag. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant which are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.
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Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to fetch the values from 
the PLC.

3. Click the  button in the recipe view or press the <Ctrl + Up> keys.

Result
The values are read from the PLC and displayed on the HMI device. 

Transferring recipe data records to the PLC

Introduction
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to transfer the values 
to PLC.

3. Click the  button in the recipe view, or press the <CTRL+DOWN> shortcut key.

Result
The values of the recipe data record are transferred to the PLC. 
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Exporting and importing recipe data records

Introduction          
Depending on configuration and the HMI device, either export recipe data records to a CSV 
file, e.g. for editing in MS Excel, or import these from a CSV file. The extent to which you can 
influence these processes is determined by the project configuration. 

 

 Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.

 

A list separator is used to separate the data records during importing and exporting.
 

 Note

The list separator used as the default depends on the setting for formats and numbers in the 
operating system. Select "Start > Settings > Control Panel > Regional and Language 
Options". If you want to import or export recipe data records, do not use this list separator in 
the display name of the recipe data records.

 

The following fields can be configured on the user interface, for example, in order to use the 
export/import function:

● Selection field for the recipe

● Selection field for the recipe data record

● Operating element with the "ExportDataRecords" functionality

● Operating element with the "ImportDataRecords" functionality

Export recipe data record
To export a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ExportDataRecords" functionality.
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Result
The recipe data record are exported to a CSV file. 

 

 Note

New data records created in runtime can be exported to an external file.
 

Importing recipe data records
To import a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ImportDataRecords" functionality.

Result
The recipe data record are imported. 

Reactions to modifications of the recipe structure

Introduction
Different recipe structures can occur in the following situations:

● In the event of changes during commissioning

● When work is carried out on the machine by the machine manufacturer (retrofit)

● When CSV files are imported, the structure of the CSV file can differ from the recipe 
structure.

Nevertheless, you can still use any recipe data records already created.
 

 CAUTION

When a tag is renamed, the assignment is lost. 
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Effects
Handle any structural differences as follows:

● If the old recipe data record or the CSV file contains additional values, these values will be 
discarded.

● If the old recipe data record or the CSV file contains values of the wrong data type, the 
configured default value will be used in the recipe data record.
Example: The recipe data record contains values that show the tank contents and were 
input as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the system discards the transferred value and the configured default 
value is used. 

● If the old recipe data record or the CSV file contains too few values, the configured default 
value will also be used in the recipe data record.

9.5.1.5 Examples

Example of creating a recipe

Task
In this example, you create three recipes for a fruit juice mixing machine. The fruit juice mixing 
machine produces drinks with "orange", "apple" and "tropical" flavors. You create a recipe for 
each flavor.

Each recipe contains a recipe data record for the following mixing ratios:

● Beverage

● Nectar

● Juice

Settings
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or 
SIMATIC S7-400.

In this example, you will need the following tags, recipes, recipe entries and recipe data records:

Tags:

Name PLC connection Address Type
Liter water Yes DB 120, DBW 0 Integer
Liter concentrate Yes DB 120, DBW 4 Integer
Kilo sugar Yes DB 120, DBW 8 Integer
Gram flavoring Yes DB 120, DBW 12 Integer

Recipes:
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● Orange

● Apple

● Tropical

Recipe entries:

Recipe element Associated tag
Liter water Liter water
Liter concentrate Liter concentrate
Kilo sugar Kilo sugar
Gram flavoring Gram flavoring

Recipe data records for drink, nectar and juice:

Data record name Liter water Liter concentrate Kilo sugar Gram flavoring
Beverage 30 70 45 600
Nectar 50 50 10 300
Juice 5 95 3 100

Procedure
To create a recipe, proceed as follows:

1. Create the following tags with the settings specified above: "LiterWater", "LiterConcentrate", 
"KiloSugar" and "GramFlavoring".

2. Create the "Orange", "Apple" and "Tropical" recipes with the settings indicated above. 
Create the recipe entries in each recipe.
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3. Not for Basic Panels: Configure each recipe so that you can synchronize the recipe data 
records between the recipe screen and recipe view. The values of the recipe tags should 
not be transferred automatically to the PLC.
You will have to make the following settings in the Properties dialog for the recipe concerned:
Under "Properties > Options":

– Activate the "Synchronize recipe view and recipe tags" option.

– Activate the "Manual transfer of individual modified values (teach-in mode)" option.

4. Create the data records indicated above in each recipe. Enter the values indicated above 
in each of the data records.

Result
The "Orange", "Apple" and "Tropical" recipes have been created.

Example of configuring a recipe screen

Task
In this example, you create a recipe screen for the visualization of values of the fruit juice 
mixing machine. You use a recipe view to select the recipes and their associated recipe data 
records. 

You should be able to use the following functions with the buttons:

● "Load" Button
The selected recipe data record is loaded from the recipe memory on the HMI device and 
displayed in the recipe screen.

● "Save" Button
The displayed recipe tags are saved in the recipe memory of the HMI device.
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● "Data to PLC" button
The displayed tags are transferred to the PLC.

● "Data from PLC" button
The current recipe data record in the PLC is transferred to the recipe variables and 
displayed on the HMI device. 

Requirement
● The "Creating a recipe" sample application has been carried out.

● You have created and opened the "Fruit juice mixing plant" screen.

Settings
In this example, you need the following tags and buttons with the indicated settings:

Tags:

Name PLC connection Type
RecipeNumber No Integer
Data record number No Integer

Buttons:

Labeling Configured event System function
Load Click LoadDataRecord
Save Click SaveDataRecord
Data to PLC Click SetDataRecordTagsToPLC
Data from PLC Click GetDataRecordTagsFromPLC
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Procedure
To configure a recipe screen, proceed as follows:

1. Drag-and-drop the "Liter water", "Liter concentrate", "Kilo sugar" and "Gram flavoring" tags 
from the object view to the "Fruit juice mixing machine" process screen.
Four IO fields are created and linked by the specified tags. 

2. Add a recipe view containing selection fields for the recipe name and data record name 
only.
Make the following settings in the Inspector window for the recipe view:

– Select the "Advanced view" display type under "General".

– Deselect "Edit mode" under "Properties > General" and "Display table" under "Properties 
> Table".

– Connect the "Recipe tag" field to the "RecipeNumber" tag.

– Connect the "Tag" field to the "DataRecordNumber" tag.

– Disable all the buttons under "Properties > Buttons".

3. Assign the above settings to four buttons. Transfer each "Recipe number" and "Data record 
number" tag as a parameter for the recipe number and recipe data record number.

Result
You can select the recipe and the associated recipe data record from the recipe view and 
modify the recipe values at runtime. You can load, save and transfer the recipe data records 
using the buttons. 

Scenario for Entering Recipe Data Records in Runtime

Objective
You want to enter production data on the HMI device without disturbing the process that is 
currently underway. Therefore, the production data should not be transferred to the PLC. 

Requirement
● The recipe has been created.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated or deactivated.

– If "Synchronize recipe view and recipe tags" is activated, "Manual transfer of individual 
modified values (teach-in mode)" has to be activated.
This will prevent the recipe tags being transferred automatically between the HMI device 
and PLC.

● A recipe screen or a screen with recipe view is available.

● There is an operating element for saving the recipe data records.
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Sequence

1. Enter the production data in the recipe view or recipe screen.

2. Save the modified recipe data record.

Transfer the recipe data to the PLC
The configuration may provide operating elements for transferring recipe data to the PLC.

Scenario for a manual production sequence

Objective
A reading device connected to the PLC reads a bar code on the work piece to be processed. 
The recipe data record names correspond to the respective bar code names. This will enable 
the PLC to load the necessary recipe data record from the storage medium of the HMI device. 
The recipe data record is displayed for inspection on screen. 

You want to be able to correct the transferred production data online, if necessary.
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Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.
 

  Note

The changes are immediately transferred to the PLC
 

● There is a recipe screen available.
There may also be an operating element for saving the recipe data records in the recipe 
screen.

Sequence

Behavior when the recipe view is used
If the recipe view is used, it is not possible to transfer changes immediately. You must use the 
operating element to transfer the recipe data record to the PLC.
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Scenario for an Automatic Production Sequence

Objective
You want production to be executed automatically. The production data is to be transferred 
directly to the PLC, either from the recipe memory in the HMI device or from an external storage 
medium. The screen display is not necessary.

Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Coordinated transfer of data records" is activated.
The production data is transferred to the PLC, so a coordinated transfer with the PLC 
in necessary to prevent the data from being accidentally overwritten.

Sequence

Implementation
You can control the flow of data in the following ways:

● The control program controls the automatic transfer via control jobs or via WinCC system 
functions, if necessary.
The sequence is controlled via the status information in the mailbox and via return values 
from the functions used.

● One or more scripts control the automatic transfer via WinCC system functions.
The sequence can be checked using the values returned by the functions used.
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You can implement the automatic production sequence with available system functions: 

● "ImportDataRecords"
This function loads data records from a *.CSV file into the recipe memory of the HMI device.

● "SetDataRecordToPLC"
This function transfers a data record from the HMI device's recipe memory to the PLC. 

9.5.2 Working with recipes

9.5.2.1 Principles

Definition and applications

Introduction   
Recipes are collections of related data, for example, machine parameter settings or production 
data.

Examples:

● Machine parameter settings that are needed to convert production to a different product 
variant.

● Product components that result in different compositions for different end products.

● Data from technical processes that is continuously stored at longer intervals.

A recipe has a fixed data structure. The structure of a recipe is defined once at the configuration 
stage. A recipe contains recipe data records. These differ in terms of their values, but not their 
structure. 

The project data is stored in an SQL database. Recipe data records are always transferred 
completely and in a single pass between the HMI device and the PLC. You can import the 
production data in Runtime additionally by a CSV file. 

Using recipes  
Recipes can be used in the following situations:

● Manual production
You select the required recipe data and display it on the HMI device. You modify the recipe 
data as required and save it on the HMI device. You transfer the recipe data to the PLC.

● Automatic production
The control program starts transfer of the recipe data between the PLC and HMI device. 
You can also start the transfer from the HMI device. Production is then implemented 
automatically. It is not essential to display or modify the data.

● Saving project data
You are using a recipe which is not interconnected with the PLC to save project data. Project 
data saved to the recipe can be accessed using scripts in Runtime. 
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Views  
Views relate data from existing recipes that have at least one common feature. They are used 
to compile data from the recipes.

Display recipes and views
The recipes and views can be displayed and edited on the HMI device in the following ways:

● A recipe view within a process screen

● A recipe screen

Entering and modifying the recipe data
You enter the data in the individual recipe data records and modify it as required. The following 
options are available:

● Enter the data during configuration
If the production data exists already, enter it in the "Recipes" editor during recipe 
configuration.

● Entering the data in Runtime
Frequent adaptations of production data should be handled directly in Runtime.

– Enter the data directly on the HMI device.

– Set the parameters directly on the machine. You then transfer the data from the PLC to 
the HMI device and save it in the recipe.

– You import the recipe data from already swapped-out CSV files.

See also
Recipe view in reports (Page 1678)

Recipe report (Page 1679)

Recipe structure

Introduction
The basic structure of a recipe is illustrated with reference to a filling station in a fruit juice 
plant.   

There may be several different recipes in an HMI device. A recipe can be compared to an 
index card box that contains several index cards. The index card box contains several variants 
for manufacturing a product family. The complete data of a manufacturer variant are contained 
on one file card.

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants include 
fruit juice drink, juice, and nectar.
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Recipe  

 

5 

30 

23 

80 

15 

35 

20 

70 

Recipe data records   
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe elements  
Each index card in a drawer is printed identically. All the index cards contain fields for the 
different ingredients. Each field corresponds to a recipe element. Each recipe data record 
contains the same elements. The records differ, however, in the value of the individual 
elements. 

Example:

All beverages contain the same elements: 

● Water

● Concentrate

● Sugar

● Flavoring

The records for juice drink, fruit juice, or nectar differ, however, in the quantity of sugar used 
in production.
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Recipe Recipe data record Recipe elements Value
Drinks 1 Item Juice

Water 5
Sugar 30
Flavoring 23
Concentrate 80
Coloring F30

2 Item Nectar
Water 15
Sugar 35
Flavoring 20
Concentrate 70
Coloring F35

Recipe collections
A recipe collection is a recipe whose elements are made up from different recipes. Example: 
Recipe collection element1 = Recipe1_Recipeelement3
Recipe collection element2 = Recipe3_Recipeelement7
Recipe collection element3 = Recipe2_Recipeelement10
The used recipes must already exist.

A recipe collection is displayed in a recipe view. However, a recipe collection does not have 
its own data records but combines all the recipe data records of the used recipes. Example: 
If up to 10 recipe data records exist for every recipe in the above example, the recipe collection 
covers 10*10*10 = 1,000 data records. You can define a relation in the recipe collection to limit 
these data records. Example:
Recipe collection element2 = Recipe collection element3
The relation acts as a filter for the recipe view (see also example below).
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Example
A recipe collection "Label" is created from the "Drinks" and "Order" recipe for label printing. 

Fill quantity

Data elements

Number

Data elements

Order Customer

Item

Quantity

Fill quantity

RecipeData elements

Drinks

Water

Sugar

Flavoring

Concentrate

Coloring

Best before

Recipe

Item

Label Item

Best before

View

Coloring

Sugar

The figure below shows the "Label" recipe collection. The necessary information for the label 
is contained in the "Drinks" and "Order" recipes. The recipe elements "Article", "Sugar", 
"Colorant" and "Best before" from the "Drinks" recipe are transferred to the "Label" recipe 
collection, the recipe elements "Article" and "Net weight" from the "Order" recipe.

The "Article" recipe element is double:
Drinks.Article, Order.Article, Drinks.Water, Order.Net weight...
The recipe view first shows every combination of these data in its own line. However, the recipe 
data of the ordered article and not of another article must be on the label which is ensured by 
the following condition:
Drinks.Article = Order.Article
The recipe view is filtered and only the ordered articles with their recipe data displayed line by 
line.

Displaying Recipes in Runtime
You have the following options of displaying recipe data in Runtime:  

● In I/O fields at any position in plant screens

● In a recipe view in table format

You can connect a recipe view to a selected recipe or view during configuration. The recipe 
view can only access this recipe or view.  

Enable the recipe or the view for access.

You can assign various authorizations for access.
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Communication with the PLC

Introduction
Data are transmitted in two ways between recipes and the PLC:

● By recipe tags with the aid of control tags

● By message frames with the aid of raw data tags

"Control tags" communication type   
A complete recipe data record is transferred to the recipe tags and vice versa by control tags. 
The recipe tags have a communication connection to the PLC

"Raw data tag" communication type   
The PLC and the HMI device exchange raw data tags as message frames with a fixed structure. 

Raw data tags offer the following advantages:

● Several data records transferred between the PLC and the HMI device.

● Parts of a recipe data record transmitted.

● Use the same raw data tag for several recipes.

See also
Overview (Page 1565)

"Recipes" Editor

Introduction
You can create, configure and edit the following objects in the "Recipes" editor.

● Recipes and the corresponding recipe elements and recipe data records.

● Recipe collections and the corresponding recipe collection elements and relations

The "Recipes" editor also allows you to enter values in recipe data records. 

Structure of the "Recipes" editor
The upper area of the working area in the "Recipes" editor contains the "Recipes" and "Recipe 
collections" tabs.

Create the recipes and recipe views using the "Recipes" and "Recipe collections" tabs and 
configure these in the Inspector window. 

The tab called in the upper area of the working area determines the tabs to display in the 
bottom area of the working area.
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"Recipes" tab

● Recipe elements
Define the recipe elements of the selected recipe using the table cells provided here. You 
can move recipe elements within the table with the shortcut menu commands, "Up" and 
"Down".

● Recipe data records
Define the values of the data records of the selected recipe using the table cells provided 
here.

"Recipe collections" tab

● Recipe collection elements
Here you define the recipe collection elements of the selected recipe collection by the table 
cells. You move recipe collections and recipe collection elements within the table by using 
the "Up" and "Down" shortcut menu items.
You define the relations between the recipe collection elements in the "Conditions" box.

Inspector window
Select the Inspector window to configure the corresponding element selected from one of the 
tables, for example a recipe collection or recipe data record.

Settings

Recipes
The following settings are available for recipes:

Setting Description
Recipe name This is a unique identification for the recipe within the HMI device. 
Display name Appears in the recipe view, for example, in Runtime. You can configure 

display names in multiple languages. Enter meaningful names or 
designations which you can assign directly to a product, such as 
"Fruit_juice_Orange".

Recipe number This is a unique identification for the recipe within the HMI device.
For the "Raw data tag" communication type, the "PLC" field in the message 
frame must correspond to a valid recipe number.

Version Information about the recipe. The date and time of the last change to the 
recipe is set by default.

Path Defines the storage location for recipes. The recipes are not saved in a file 
but in a database.

Type You can limit the recipe data records to a maximum number you select 
yourself.

Maximum number of 
data records

Maximum number of data records in a recipe. This limits the required recipe 
memory of the HMI device. The value "0" appears for the "Unlimited" size type.

Communication type Define how the HMI device and PLC exchange recipe data as a rule:
● No communication
● Raw data tags
● Tags
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Setting Description
Raw data tag Tag which is transmitted between the PLC and the HMI device as a message 

frame in the "raw data tag" communication type.
Control tag task, ID, 
field, value

Four tags which control the data transmission between the recipe and recipe 
tags and therefore the PLC in the "tags" communication type.

For reading
For writing

Name of the authorization which has read, write access to the recipe in 
runtime.

Last modification
Last user

Change information of a recipe is displayed in Runtime.

Tooltip Help text for the recipe which is shown to the operator in Runtime.

Recipe elements
You can make the following settings on the "Elements" tab:

Setting Description
Recipe element name Identifies a recipe element uniquely within the recipe. Enter meaningful 

names or labels that you can allocate uniquely, such as axis labels on a 
machine or ingredients such as "Flavoring".

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Enter meaningful names or 
designations which you can assign directly to a product, such as 
"Fruit_juice_Orange".

Recipe tag An assigned tag in Runtime stores the current value of the recipe element in 
the recipe data record.

Data type Data type of the recipe tag.
Data length Data length of the recipe tag, depending on the data type.
Default value This is used as the default entry when you create a new recipe data record.
Minimum value The smallest representable value of a number-based recipe tag, depending 

on the type of data.
Maximum value The largest representable value of a number-based recipe tag, depending 

on the type of data.
For reading
For writing

Name of the authorization which has read, write access to the recipe in 
runtime.

Value required The recipe element has a value other than zero.
Unique values A value for the recipe element may only occur once in all recipe data records. 

Example recipe element "Order number".
Fast search The value of the recipe element is indexed for faster searching.
Tooltip Infotext about the recipe element that the operator sees in Runtime.

Recipe data records
You can make the following settings on the "Data records" tab:
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Setting Description
Recipe data record 
name

Identifies a recipe data record uniquely within the recipe. 

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Enter meaningful names or labels that 
you can assign directly to a product, such as "Product_numbers".

Recipe data record 
number

Identifies a recipe data record uniquely within the recipe.

Recipe element name Name of the created recipe element The values which the recipe element 
has in the different recipe data records (lines) are saved under this name. A 
value forms a recipe data record respectively with the values of the other 
recipe elements in a line. You can already save the values during the 
configuring.

Last modification
Last user

Modification information items of a recipe data record are displayed in 
runtime.

Comment Comment about the recipe data record

9.5.2.2 Configuring Recipes

General configuration procedure 

Configuring steps
Follow the steps outlined below to create a recipe:

Step Task
1 Define the structure of the recipe.
2 Define the communication mode for the recipe. 
3 Define the control tags or raw data tags according to the communication mode 

selected.
4 Create the recipe and define its properties.
5 Create the recipe elements in accordance with the structure planned.
6 Create the recipe data records.
7 Configure views of multiple recipes, if required.
8 Configure a screen which contains a recipe view and interconnect this recipe 

view with the recipe or view.
Or:
Configure a screen which contains I/O fields and buttons. Configure button 
functions for reading and writing the values of recipe data records. 

 

 Note
Runtime API

The Runtime API provides you with extensive uaArchive functions to edit recipes and recipe 
views (see section "Interfaces > Runtime API", subsection "Auto-Hotspot").
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Configuring Recipes and Elements

Creating a New Recipe

Introduction
Create the new recipes using the "Recipes" tab of the "Recipes" editor.

Naming the recipe
Do not use keywords or reserved words of the SQL database language for recipe names (see 
subsection "SQL keywords (Page 1601)").

Recipes with date or time stamp
If you use data or time data, make sure that the system setting for time and date on the 
configuring computer matches that on the target system. Example: You load a recipe data 
record on the target system at 13:55 in which the processing time 14 h is stored. If it already 
14:05 on the target computer, the recipe will not be processed. If an operator processes the 
recipe, modification information is not written back correctly into the database. 

After loading to the target system, check the recipes with date or time stamps on the target 
system.   

Requirement
● You have created the control tags or the raw data tag.

● The "Recipes" editor is open.
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Procedure
Create a recipe as follows:

1. Double-click the first empty table row in the "Recipes" tab of the "Recipes" editor.    

2. Select "Properties > General > Settings > Name" in the Inspector window and enter a 
descriptive recipe name.
The name identifies the recipe uniquely within the project.

3. Select the "Display name" field to enter the language-specific name to be displayed in 
Runtime.

4. Define whether or not the recipe data records are limited to a specified maximum number 
in the area "Size" under "Type".

5. If the size type is limited, specify the maximum number of recipe data records of a recipe 
under "Number of data records".

6. Specify the "Communication type" under "Properties > Communication":

– If you have selected "Raw data tag", create a raw data tag and select it under "Raw data 
tag".

– Select "No communication" if you use the recipe only to save project data.
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7. Select the control tags for access to the recipe under "Properties > Control tags" if you have 
selected the "Tags" communication type.

8. Define under "Properties > Security" which operator authorizations have read and write 
access to the recipe in Runtime.

9. Under "System fields", specify whether to display the "Last modification" and "Last user" 
entries.
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Result
You have created the recipe.

Creating Recipe Elements and Data Records

Introduction
Select the "Recipe elements" tab in the bottom area of the "Recipes" editor to set up the 
elements for the selected recipe. You can also enter the recipe element values in the "Recipe 
data records" tab.

Requirement
● The tags for the recipe have been created.

● You have created the recipe.

● The recipe is selected in the "Recipes" editor.

Procedure
Create a recipe element as follows:

1. Double-click the first empty table row in the "Recipe elements" tab.

2. Select "Properties > General > Settings > Name" in the Inspector window and enter a 
descriptive name for the recipe element. This name must be unique within a recipe.

3. Select the "Display name" to enter the language-specific name to be displayed in Runtime.

4. When the recipe has the "Tags" communication type:
To link the recipe element to a tag, select a tag under "Properties > Values > Settings". The 
data type will be displayed below.
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5. For a "String" data type, also specify the maximum length of the string under "Data length". 
The "Settings" area on the right shows the value range for number-based data types, for 
which you can also specify a default value.

6. When the recipe has the "Raw data tag" communication type or "No communication": Select 
the "Data type" and also the "Data length" of the recipe element for the "String" data type.

7. Define under "Properties > Security" which operator authorizations have read and write 
access to the recipe element in Runtime.

8. Define in "Properties > Extras" which conditions the values of the recipe element must 
satisfy. For faster search, the values can be indexed:

9. Double-click the first empty table row in the "Recipe data records" tab to set up a recipe 
data record.

10.Enter the desired value for the recipe element in the table editor.

Result
The recipe element and a corresponding recipe data record are created with one value. 
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Importing recipes into the configuration and exporting them again

Introduction
You can export recipes as a CSV file and import them again into the configuration. 

 

 Note

You cannot import or export data records from recipe views.
 

Application case
You export recipe data to store and back up recipe data long-term on a computer. 

You export the recipe data to an HMI device to standardize and distribute recipe data. You 
change the CSV file Microsoft Excel and import the CSV file to all HMI devices which require 
the same recipe data.

You want to exchange recipe data between different projects. You change the recipe data in 
Runtime. To transfer the changed recipe data to WinCC ES, export the recipe data records to 
Runtime and copy the CSV file to the configuring computer. There you import the CSV file 
containing the recipe data records into the recipe. And in the opposite direction, you transfer 
the modified recipe data records to the HMI device in WinCC ES in Runtime.

Requirement
● You have created the recipe.

● The structures of the exported CSV file and the recipe in WinCC ES match; name, number 
and data type of the recipe elements are identical. 

● The "Recipes" editor is open.
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Importing CSV files
To import recipe data records into a recipe, proceed as follows:

1. Select the row which contains the desired recipe in the "Recipes" tab.

2. Select the "Import recipe data" command from the shortcut menu.
The "Import" dialog box opens.

3. Select the desired CSV file with the recipe data under "File name".

4. Under "Strategy", define whether a recipe data record in the CSV file overwrites an existing 
recipe data record in WinCC with the same recipe data record number.

5. Click "Import" to start the operation.

Result
The recipe will be amended by recipe data records from the CSV file that have not yet been 
entered. If the option is selected, existing recipe data records will be overwritten.

An error message is shown in the "Info" of the Inspector window if the structure of the recipe 
does not match the structure of the CSV file.
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Exporting CSV files  
1. Select the row which contains the recipe to export in the "Recipes" tab.

2. Select the "Export recipe data" command from the shortcut menu.
The "Export" dialog box opens.

3. Select a path for the CSV file under "File name".

4. Select the desired recipe under "Recipe name".

5. Select all recipe data records or limit the selection to certain recipe data record numbers 
under "Select content".

6. Click "Export" to start the operation.

Result
The configuration is exported as a CSV file. The list separator is the semicolon 
"RecipeElement_1;RecipeElement_2". The decimal separator is a period, e.g. "3.14".

Procedure for changing the recipe structure

Introduction
Different recipe structures can occur in the following situations:

● Due to changes during commissioning

● If a machine is upgraded by the machine manufacturer (retrofit)

● When CSV files are imported, the structure of the CSV file can differ from the recipe 
structure.
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Nevertheless, you can still use any recipe data records already created.
 

 CAUTION

When a tag is renamed, the assignment is lost. 
 

Effects
If the structure of the CSV file differs from the structure of the recipe, deviations are handled 
as follows:

● If the old recipe data record or the CSV file contains additional values, these values will be 
discarded.

● If the old recipe data record or the CSV file contains values of the wrong data type, the 
configured default value will be used in the recipe data record.
Example: The recipe data record contains values that show the tank contents and were 
input as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the system discards the transferred value and the configured default 
value is used. 

● If the old recipe data record or the CSV file contains too few values, the configured default 
value will also be used in the recipe data record.

Configuring recipe views

Creating a recipe view

Introduction  
A recipe view is a set of recipe elements from different recipes. Example: Recipe view "Water 
consumption".

● Water from the "Fruit juice drink" recipe

● Water from the "Juice" recipe

● Water from the "Nectar" recipe

You can link recipe elements to form relations, such as "Nectar.Water > 
FruitJuiceDrink.Water". In recipe view only those data records will be displayed in Runtime 
that satisfy the relation. In the example, these are the records in which the water requirement 
of the "Nectar" recipe is greater than that for "Fruit juice drink".

Assemble the recipe views from the recipe elements in the "Recipe views" tab of the "Recipes" 
editor. Select the recipe elements from the recipes to be included in the recipe view and set 
their relation. The relation expresses a condition. Only those combinations of recipe elements 
which satisfy the condition (true) are displayed in the recipe view.

You can also edit recipe view data in Runtime. The data you have edited are applied to the 
original recipe in Runtime.

The recipe view does not support the following actions:  
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● Creating new recipe data

● Deleting recipe data

Requirement
● You have created at least two recipes.

● The recipes are in the same database on the same HMI device.

● The recipes have at least one identical recipe element in the same data format.

Creating recipe views
Create a recipe view as follows:

1. Double-click the first empty table row in the "Recipe views" tab of the "Recipes" editor.
A new recipe view is generated.   

2. Enter a name for the recipe view under "Properties > General > Name " which indicates its 
function.

3. Select the "Display name" to enter the language-specific name to be displayed in Runtime.

Creating recipe view elements and relations
Proceed as follows to create a new element for the recipe view and the relation:

1. Double click the first free table line in the "Recipe view elements" tab.

2. Under "Properties > General > Recipe element", select the recipe element to insert in the 
view.

3. Create other recipe view elements as required.

4. Select the recipe view in the "Recipe views" tab.
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5. Select a recipe view element and the desired operator as a left and right operand in the 
inspector window under "Properties > Relation > Relation".

6. Click the "Add" button.
The relation appears under "Condition". If a condition was already defined there, the new 
relation with the logical operator "AND" is added. You can edit the condition.

7. Change the order of the recipe view elements as required with drag&drop.

Result
The recipe view is created and a condition defined. Only those combinations of recipe elements 
which satisfy the condition are displayed.
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9.5.2.3 Configuring the visualization of recipes 

Displaying recipes

Introduction
Recipes and recipe views are displayed on the HMI device as follows:

● In a recipe view  

● In individual I/O fields

Recipe view
The recipe view displays the recipes and views in table format. Each recipe data record uses 
one line.

The picture below contains an example of a recipe view.

Operators use the recipe view in Runtime and, for example, create new data records or import 
recipes. You transfer a recipe data record to the recipe tags and vice versa with two buttons 
in the recipe view.

 

 Note

You select a recipe or recipe view in the configuration of a recipe display. The operator can 
change the selection and other properties in Runtime. 
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 NOTICE

Data source

The recipe display only accesses one recipe or recipe view respectively.
Recipe view

An operator can only change the displayed recipe data in Runtime. The creation and deletion 
of data records and their transfer from/to the PLC is not possible.

 

Recipes in the screen  
You can show recipe elements in I/O fields alternatively instead of a preconfigured recipe 
display. The following screen shows an example for a screen with configured I/O fields in the 
"Tags" communication type.

The blue fields at the top show the values of the recipe tags which have a communication 
connection with the PLC. The yellow fields at the bottom show the contents of the four control 
tags. In the example the blue recipe values were written into recipe data record number 3 (task 
= 6) and the number of errors = 0 returned.

See also
Control tags (Page 1567)

Properties of the recipe view

Introduction
The recipe view visualizes recipe elements in table format on the screens. Operators can edit 
recipe data in the recipe view in Runtime.

Configuration of the recipe view
The following optional recipe view configurations are available:

● General > Display: You select a recipe or recipe view as a data source and define whether 
recipe data records can be edited, inserted or deleted.

● General > Print job
The recipe view is automatically linked by logical operation with the system print job for 
recipe views. Create a logical link to the recipe view for any custom print jobs or system 
print jobs.

● General > Time
Define the time base for the "Last access" display, for example the coordinated universal 
time (UTC). You can include the time base selected for output in Runtime.

● Appearance, layout, text format
You define colors and design, size and position of the recipe display, font type and font size.
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● Window
You define the font size, window header of the recipe display and other window properties.

● Table
You define the appearance of the column headers, table and boundary lines and the 
behavior for selecting and sorting data records.

● Table > Mark
Determine whether lines or only cells can be marked with the mouse.
Configure the properties of the selection rectangle which can be shown around the marked 
cells or lines of the table.
Configure the marking colors for the markable cells and/or lines as required. The color 
defined by the system for the marking is used with the "Automatic coloring" property.

● Table > Sorting
Determine whether sorting is to take place and if so, with click or double click on the column 
header.  Define the order of sorting which is to run cyclically when clicking or double clicking 
the column header: either sorting ascending - descending or ascending - descending - no 
sorting
Configure the sorting symbol and sorting index which are to be shown right-justified in the 
column header. You show sorting sequence and sorting order of the columns.
If you activate the "Use sorting key" option, the sorting symbol is displayed as a sorting key 
above the vertical scrollbar. You sort the selected column in the configured sorting order 
with a mouseclick on the sorting key. The sorting key is not displayed if there is no vertical 
scrollbar in the table.

● Columns
You determine which recipe elements are displayed in what order in Runtime. You apply 
write protection to certain elements and determine the width and formatting.
Some columns can also show the content and header as symbols. Determine how these 
columns are displayed in the "Layout" field. The text and symbol can be displayed together.

● Filter
As a filter criterion you define a condition for a recipe element and link several conditions. 
The data record is not displayed until all the filter criteria are satisfied.

● Toolbar
In addition to the appearance of the toolbar you define which buttons are visible in what 
order in Runtime and with what operator authorization they can be operated.
Activate the buttons in the list which you need for operating the WinCC-Control in Runtime. 
Information about the function of the individual buttons can be found in the subsection 
"Operation in Runtime"
Define a hotkey for a button if necessary.
If you assign operator authorizations to the individual buttons, the button is only released 
in Runtime for the users who have the appropriate operator authorization.
If you deactivate the "Active" option for a button, the activated button is displayed in Runtime 
but cannot be operated.

● Status bar
In addition to the appearance of the status line, you define what information is displayed in 
the status line in Runtime, e.g. the recipe data record number.
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● Data export
A standard file name and a standard directory are already entered by switch tags. However, 
you can assign your own file names and directory names.
You can use the following switch tags.
@OBJECTNAME: Object name of the recipe display, see "Properties > Miscellaneous"
@PROJECTPATH: Project directory
@CURRENTDATE: Current date
@CURRENTTIME: Current time

● Safety
You determine whether and how changes to the properties of the recipe display can be 
saved in Runtime and after a screen change and which authorization is necessary for 
changing.

● Miscellaneous
You define the visibility and layer for the recipe display.

Configuring a recipe view

Requirement
● You have created a recipe or a view.

● You have created a screen and the "Screens" editor is open.

Procedure   
Configure a recipe view as follows:

1. Drag the "Recipe display" object from the "Controls" palette of the "Tools" task card into 
the screen.

2. Select the desired recipe or view in the inspector window under "General > View".
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3. Define the write and read rights for the recipe display in Runtime under "General > Allow 
in Runtime".

4. Select "Appearance," "Layout," and "Text format" to define additional display options for 
the recipe view.

5. Select "Properties" > Columns" to define the recipe elements which will be visible and write-
protected in Runtime.

6. Select "Toolbar" to define the recipe view buttons to be available in Runtime.
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7. Select "Status bar" to define the scope of information to display in the status bar in Runtime.

8. Select "Filter" to define the filter criteria for recipe elements in Runtime.

9. Select "Sort" to define the sorting criteria for recipe elements in Runtime.

Result
The recipe view is configured.

Exporting recipe data in Runtime

Introduction        
In Runtime you export the recipe data with a button in the recipe display. You configure 
operation of the data export in Runtime.

How to configure the operation of the data export
1. Define a file name and a directory for the export file under "Properties > Data export".

The file name may be made up of names you select yourself and the following switch tags:
@OBJECTNAME: Object name of the recipe display
@PROJECTPATH: Project directory
@CURRENTDATE: Current date
@CURRENTTIME: Current time

1. Define the file extension, e.g. "CSV".

2. Define the scope of the data export:

– All Runtime data are exported.

– Selected Runtime data are exported. 
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3. Configure the operation of the data export during runtime. Define:

– The "Data export defaults" are displayed in runtime.

– The user may change the file name or the directory.

4. If "Show dialog" is deactivated, the data are exported immediately to the defined export file 
on pressing the "Export log" button.

5. Save the project.

6. Activate the "Export log" button under "Properties > Toolbar".

Results
In Runtime you can export all or selected recipe data to a defined file with the  button.

Configuring persistence

Introduction        
A user can configure WinCC-Controls in Runtime. You define what effect the online 
configuration has in Runtime.

The changes configured in Runtime are saved separately from the screen in the engineering 
system. The screen is thus retained in its original configuration.

Procedure
1. Select "Properties > Safety > Persistence > Online configuration" which you can only 

operate in the engineering system. The online configuration can then be defined 
permanently in Runtime:

– "No persistence" The online configurations are not retained in Runtime. This default 
leaves the user no option in Runtime. The online configurations are lost the next time 
the screen changes and with deactivate/activate.

– "Persistence" This default leaves the user the options of "reject", "retain" or "reset". With 
the "retain" option the online configurations are retained the next time the screen 
changes and with deactivate/activate.

– "Persistence in Runtime". This default leaves the user the options of "reject", "retain" or 
"reset". With the "retain" option the online configurations are retained the next time the 
screen changes but are lost when the project is deactivated/activated.

 

 
 NOTICE

In case of a user change, the different configurations are not saved until you have 
executed a screen change.

 

2. Define what operator authorization the user must have to carry out online configuration.
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3. "Screen change characteristics" can be operated in the engineering system and in Runtime 
with the defaults "Persistence" and "Persistence during Runtime". The "reset" option can 
only be operated in Runtime because the original configuration is in the engineeringm 
system.
Select one of the three effects of the online configuration in the next screen change:

– Activate "Reject changes" so that the online configuration only exists for as long as the 
screen is selected. The changes are rejected at the next screen change. The recipe 
display appears as configured if you select the screen again.

– Activate "Retain changes" so that the online configuration is not lost at the next screen 
change.

– Activate "Reset" so that the configured screen is saved again in Runtime. All online 
configured changes are lost.

 

 
 NOTICE

The screen is also replaced in Runtime when saving the screen or in Delta compiling 
(change loading). All online configured changes are lost.

 

4. Save the configuration.

9.5.2.4 Data transfer to the PLC

Overview
The options for transferring recipe values between the PLC and HMI device are as follows: 

● No data transfer

● "Tags" communication type

● "Raw data tag" communication type

No data transfer 
The recipe is not used for transferring recipe data to the PLC but as a data memory and user 
log: You store values which belong together in data records to which you have multiple access. 
In the simplest case an operator switches between the recipes in a recipe view. The respective 
recipe data are loaded into the recipe tags and processed further there.  

"Tags" communication type  
Recipe tags transfer the recipe values to the PLC. Vice versa the values from the PLC are 
written into a recipe data record by recipe tags. Control tags control the data transfer. The 
following tasks are started automatically by the desired entry into the corresponding control 
tags.

● Write data records into the recipe tags and therefore into the PLC

● Read data records out of the recipe tags and therefore out of the PLC
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● Delete data records

● Create new data records
 

  Note

A complete data record is always transferred in the "Tags" communication type. Transfer 
of recipe data from a recipe collection is not possible.

 

"Raw data tag" communication type  
The automation system sends the raw data tag as a message frame to the HMI device as an 
active partner. The message frame contains the following: 

● Desired target recipe

● Desired target recipe data records

● Job e.g. "Read", "Write" or "Delete"

● New recipe values, e.g. for "Write" job

The HMI device returns recipe and acknowledgement data as a message frame. 

The "BSEND/BRCV" function of the S7 communication is used for the data exchange. The 
consecutive number of the recipe serves to identify the recipe uniquely in the PLC (PLCID). 

The PLC requires a user program which executes the following in Runtime:

● Collect data if necessary via I/O fields in the HMI device.

● Check data.

● Create raw data tag as a message frame.

● Send message frame.

If you want to start creation of the message frame from the HMI device, you configure functions 
in the screen which start the user program. 

 

 Note

The following is possible in the "Raw data tag" communication type:
● Transfer of an individual recipe element
● Transfer of an entire recipe data record
● Transfer of multiple recipe data records

Data transfer from the recipe view or by control tags is not possible. 
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Control tags

Introduction
With the "Tags" communication type in the recipe, you transfer the recipe data between the 
PLC and the HMI device using recipe tags. The data transfer is controlled by four control tags 
which are assigned fixed to a recipe. Other control tags can be assigned to another recipe.

Data transfer is started automatically once you have entered the required value at the 
corresponding control tag.

 

 NOTICE

All four control tags must always be specified in a recipe to ensure that it works. Do not change 
the data type of the control tags.

 

 Note

You must implement access protection for the control tags of a protected recipe separately 
using the object properties of the screen, I/O field or button, for example.  

 

Control tags

Control tag Required data type Meaning
ID Long Number of the recipe data record within the assigned recipe
Job Long Read out of the recipe tags, write into 

the recipe memory:
6

Read out of the recipe memory, write 
into the recipe tags:

7

Delete in the recipe memory: 8
After the job has been carried out, an error ID can be seen in the "Job" control 
tag:
No error 0
Error -1

Field String The name of the recipe element
Value String The value of the recipe element

Visualizing processes (Professional)
9.5 Working with recipes

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1567



Requirement
● Communication type is set to "Tags" in the recipe.

● You have configured a process screen with all I/O fields required for process tags and 
control tags of the recipe.
Example:

Inserting the control tag
The following control tag combinations are supported:

● "ID" and "Job" control tags
The control tag "ID" indicates the number of the recipe data record which is transferred.
The "Job" control tag indicates whether the selected recipe data record is written, read or 
deleted (6, 7, 8) in the recipe memory of the HMI device.

● "Job", "Field" and "Value" control tags
The recipe data record is selected for the data transfer whose recipe element "Field" has 
the recipe value "Value". Example field = "Water", value = "5 liters".
The "Job" control tag indicates whether the selected recipe data record is written, read or 
deleted (6, 7, 8) in the recipe memory of the HMI device.

 

 
 NOTICE

Different data records may not contain the same recipe value in the "Field" recipe element

You have to activate the "Unique values" checkbox under "Properties > Options" for the 
recipe element. Otherwise no clear assignment of the recipe data record by the value is 
possible and the first data record which satisfies the "Value in field" condition is used.

If the type "String" is assigned to the element, you must enclose the entry in the "Value" 
I/O field in inverted commas (such as 'Cola Light').
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More combinations of values for the "ID" and "Job" control tags

ID Job = 6 Job = 7 Job = 8
-1 Data record from the recipe tags is 

read and appended to the end in the 
recipe in the recipe memory.

- Data record with the lowest ID is 
deleted in the recipe in the recipe 
memory.

-6 Data record from the recipe tags is 
read and written into the recipe data 
record with the lowest ID in the recipe.

Data record with the lowest ID is 
written in the recipe into the recipe 
tags.

Data record with the lowest ID is 
deleted in the recipe in the recipe 
memory.

-9 Data record from the recipe tags is 
read and written into the recipe data 
record with the highest ID in the recipe.

Data record with the highest ID is 
written in the recipe into the recipe 
tags.

Data record with the highest ID is 
deleted in the recipe in the recipe 
memory.

See also
Displaying recipes (Page 1558)

Using the recipe screen (Page 1590)

Raw data tag

Data Transfer via Raw Data Tags
This section describes the transfer of recipe data between the HMI device, and PLC using raw 
data tags. The BSEND/BRCV function is used in the PLC. The message frame containing the 
raw data tag is actively sent by the PLC.

The message frames may contain one or more write or read jobs.   

Data transfer procedure
1. The PLC sends the message frame to the HMI device.

2. The HMI device returns the following:

– Data, if requested

– A processing acknowledgement

The HMI device returns a separate acknowledgement for every job.
 

 Note

The PLC is the active partner in this data transfer, so it is the PLC that must start the required 
function. On the HMI device, you can start the required function by means of a change in 
value of an external tag, for example, and the corresponding analysis in the PLC.

Do not use the "Job type" parameter to start the data transfer. The "Job type" parameter used 
in the job, or acknowledgement header only works with respect to recipes.
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Message Frame Structure for Jobs

General message frame structure
Structure of a message frame for sending jobs: 

 Length
Message frame header 16 bytes
  
Job header 1 12 bytes
Data for job 1 n bytes
  
Job header 2 12 bytes
Data for job 2 n bytes
  
  
  
Job header n 12 bytes
Data for job n n bytes

Example
The total length of a message frame with a job, and 10 bytes of job data is 38 bytes.

16 bytes +12 bytes +10 bytes = 38 bytes

Structure of the message frame header
16 bytes are needed for a message frame header. 

Function of the field Comment Byte
Message frame length in bytes LSB 1) Max. length 4091 bytes 1
Message frame length in bytes 2
Message frame length in bytes 3
Message frame length in bytes MSB 2) 4
Transfer type "1" from the HMI device 

"2" from the PLC
5

Reserved  6
Number of jobs in the message frame 
LSB 1)

 7

Number of jobs in the message frame 
MSB 2)

 8

Number of the recipe (PLCID) 1. character, in ASCII 9
Number of the recipe (PLCID) 2. character, in ASCII 10
Number of the recipe (PLCID) 3. character, in ASCII 11
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Function of the field Comment Byte
Number of the recipe (PLCID) 4. character, in ASCII 12
Number of the recipe (PLCID) 5. character, in ASCII 13
Number of the recipe (PLCID) 6. character, in ASCII 14
Number of the recipe (PLCID) 7. character, in ASCII 15
Number of the recipe (PLCID) 8. character, in ASCII 16

① Least significant byte
② Most significant byte

 

 Note

The number of the recipe is defined automatically in the "Recipes" editor during configuration, 
but can later be changed as needed. Enter the number in ASCII format in the message frame. 

 

Structure of a job header
12 bytes are needed for a job header. 

Function of the field Comment Byte
Job length in bytes LSB 1)  1
Job length in bytes MSB 2)  2
Job type see 

"Description of job types and error codes"
3

Reserved  4
Field number LSB1)  5
Field number MSB2)  6
Data record number LSB1)  7
Data record number  8
Data record number  9
Data record number MSB2)  10
Selection criterion LSB1) Element value entered or element number as selection 

criterion.
11

Selection criterion MSB2) not if 0 12

① Least significant byte
② Most significant byte

The field number corresponds to the consecutive number of the recipe element. 
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Message Frame Format for Acknowledgements

General Structure of an Acknowledgement Message Frame
Structure of the acknowledgment message frame to the PLC: 

 Length
Acknowledgement header 24 bytes
Acknowledgement data  

Structure of an acknowledgment header
24 bytes are needed for an acknowledgement header 

Function of the field Comment Byte
Message frame length in bytes LSB 1) Max. length 4091 bytes 1
Message frame length in bytes 2
Message frame length in bytes 3
Message frame length in bytes MSB 2) 4
Transfer type "1" from HMI device, 

"2" from the PLC
5

Reserved  6
Job type See 

Description of "Job Types and Error Codes"
7

Error code See 
Description of "Job Types and Error Codes"

8

Reserved  9
Reserved  10
Field number LSB1)  11
Field number MSB2)  12
Data record number LSB1)  13
Record number  14
Record number  15
Data record number MSB2)  16
Number of the recipe (PLCID) 1st character, in ASCII 17
Number of the recipe (PLCID) 2nd character, in ASCII 18
Number of the recipe (PLCID) 3rd character, in ASCII 19
Number of the recipe (PLCID) 4th character, in ASCII 20
Number of the recipe (PLCID) 5th character, in ASCII 21
Number of the recipe (PLCID) 6th character, in ASCII 22
Number of the recipe (PLCID) 7th character, in ASCII 23
Number of the recipe (PLCID) 8th character, in ASCII 24

① Least significant byte
② Most significant byte
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Acknowledgement data
The acknowledgement can contain the following: 

● The required recipe data record

● The required content of the element

● No data

Configuring raw data tag

Raw data tags of the "SIMATIC S7" channel

Introduction
A tag of the type raw data type is a data telegram on a transport level. The contents of the raw 
data tag are not fixed and therefore only the sender and the receiver can interpret the 
transmitted data. There are no format changes in WinCC for this data type. Maximum length 
is 65535 Byte.

WinCC distinguishes between two types of raw data tags: Raw data tag for free application 
use and raw data tag for handling S7 functions.

Raw data tag for free application use
Raw data tags for free application use are used for transferring user data blocks between 
WinCC and PLC and handle only user data. It distinguishes between:

● Raw data tag as byte array

● Raw data tag for BSEND/BRCV functions

Raw data tag for handling S7 functions
These raw data tags do not have any channel-specific header and are normally used by the 
message system and for process data entry in WinCC.

No further description is needed here as these are tags and functions internal to the channel.
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Creating raw data tag

Procedure
1. Create a new connection, for example, "SIMATICS7".

2. In the "Parameters" tab, select "WinCC RT Prof connection > Send/receive raw data block".

3. Under "Connection", specify the hexadecimal value of the connection ID for the connection 
resource that was assigned during the configuration of the controller.

4. Create a new tag "Raw data tag_1".

5. Select "SIMATICS7" as "Connection".

6. Select the "Raw" "Data type" and specify a sufficient "Length" in bytes.
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7. Select "BSEND / BRCV" under "Raw data."

8. Specify the "R_ID" parameter, which was assigned in the configuration of the controller.

9. Create a new recipe.

10.In the Inspector window under "Properties > Communication" select "Raw data tag" as 
communication type and "Raw data tag_1" as raw data tag.

11.Create the recipe elements and recipe data records. Ensure that the recipe number 
matches the "PLC" field in the message frame.

Raw data tag for BSEND/BRCV functions of S7 communication

Introduction  
Raw data tags for "BSEND/BRCV" functions are used for transferring user data blocks between 
WinCC and AS and handle only user data.

This raw data type can be used to access the "BSEND/BRCV" functions of S7 communication. 
The functions are available in a S7-400 or a S7-300 using CP343. The initiative of data transfer 
always lies with the sending partner; hence "BSEND/BRCV" functions can also be used to 
implement event-controlled or sporadic data block transfers.

For resource reasons, it is advisable to keep the number of BSEND/BRCV raw data tags low.

Resource limitations for using S7 functions "AR_SEND" and "BSEND/BRCV" for 
communication with S7-400
The maximum data volume that can be sent simultaneously using AR_SEND and/or BSEND/
BRCV functions from AS to WinCC is limited to 16 kByte.

Example:
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● 1x BSEND with a max. of 16 Kbytes

● 1x AR_SEND with 8 kBytes + 1x BSEND with 8 kBytes

● 1x AR_SEND with 10 Kbytes + 1x AR_SEND with 2 Kbytes + 1x BSEND with 4 Kbytes
 

  Note

If the data block of a write job is transferred to AS and has not yet been deleted or fully 
deleted from the receiving buffer, then the next write job will be rejected with an error 
message. During such an error display, write jobs with R_ID > 0x8000 0000 are written 
to a connection-specific queue and the system tries to repeat the write job for 6 seconds.

The responsibility for time co-ordination for transfer rests with the user and needs to be 
noted as shorter time intervals for write jobs.

 

Configuring a PBK Connection for Using "BSEND/BRCV" functions
"BSEND/BRCV" functions can only be used via a "hard-configured connection", a so-called 
PBK connection (programmed component communication). To configure a hard-configured 
connection, you must mention a connection resource (hex: 10 ... DF) in the connection 
parameters. This connection resource will be assigned by STEP 7 when the connection is 
configured within the PLC. The connection must be configured in AS as passive connection 
end-point.

A hard-configured connection can also be used to handle "normal" read and write jobs. If very 
large data areas are to be transferred via the connection, then the data blocks are transferred 
in multiple PDUs. For performance reasons, it would therefore be better to create a separate 
connection for "BSEND/BRCV" functions.

Raw data tag for "BSEND/BRCV" functions with the "R_ID" parameter
Raw data tags for transferring "BSEND/BRCV" data blocks are configured as raw data of type 
"BSEND/BRCV" with a "R_ID". The data length is derived implicitly from the sent or received 
data volume.
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A decimal value of 1 to 999999 must be specified for "R_ID". The R_ID is assigned at the time 
of configuration in AS and is used for distinguishing multiple data block transfers over one 
connection. The send and receive calls are always notified with reference to this R_ID in the 
underlying communication sub-system (SIMATIC Device Drivers). A raw data tag is thus 
assigned to one unique R_ID.

Sending a "BSEND/BRCV" raw data tag
Sending a "BSEND/BRCV" raw data tag takes place in the same way as writing a "normal" 
process tag. After sending the data block and receiving a positive acknowledgement from AS, 
the data block is transferred to the image of the Data Manager.

Receiving a "BSEND/BRCV" raw data tag
"BSEND/BRCV" raw data is sproradically sent to the channel on the initiative of the AS. Hence 
it is not possible to explicitly read S7 raw data tags.

The BSEND/BRCV mechanisms do not include any synchronization functions. If no user has 
logged in to receive the data during the start-up phase, the data blocks sent by AS will bounce 
on the receiver side. Hence, the user has to take care of the synchronization and, for e.g., 
release the sending direction on the AS by setting a flag with a data word.

Job types and error codes

Description of the job types

Type Description
4 The existence of the recipe is checked.
5 All data records are deleted from the recipe.
6 The data record is requested from the HMI device and is written to the PLC.
7 The data record from the PLC is written to the required data record.
8 The data record is deleted from the recipe.
9 The element of the required data record is requested from the HMI device and is written 

to the PLC.
10 The element of the required data record is written to the required data record.

Description of the error codes

Group No. Description Possible Fault Causes
General 0 The function has been executed. --
Recipe 2 Data not available No recipe configured with this PLCID.
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Data record 101 Data not allowed Recipe structure does not tally, such as 
number or type of fields.
Failed data record insertion or update.
Possible causes:
● Recipe is of the "limited" type.
● A min. or a max. value is configured 

for a field.
Incorrect criterion

Data record 102 Data not available For job type 6 only:
● No data available
● Criterion is incorrect.

Field 201 Data not allowed For job type 10 only: 
Criterion is incorrect.
Possible causes:
● Field not found.
● A min. or a max. value is configured 

for a field.
Field 202 Data not available For job type 9 only: 

● Criterion is incorrect.
● No field found corresponding to 

criterion.
General 254 Function not found --
General 255 Undefined error --

Differences between data formats

Introduction
The data formats in WinCC conform to the Intel and Microsoft data formats. The least significant 
byte is saved first and the most significant byte is saved last. This data format is very common 
and is generally known as the "Intel format". 

The data formats in WinCC differ fundamentally from the data formats in the PLCs.

Intel format
In the Intel format, the decimal number 300 is stored as follows:

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Binary 0 0 0 0 0 0 0 1 0 0 1 0 1 1 0 0

Hex  0  1  2  C

According to the Intel Format, the decimal number 300 corresponds to the hex-number 12C 
(1*256 + 2*16 + 12*1).
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SIMATIC format
In SIMATIC format, the least significant byte is are stored in the most significant digits. In 
SIMATIC format, decimal number 300 is stored as follows:

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Binary 0 0 1 0 1 1 0 0 0 0 0 0 0 0 0 1

Hex 2 C 0 1

According to the SIMATIC format, decimal number 300 corresponds to hex number 2C01.

If hex number 2C01 is interpreted according to Intel format, it corresponds to decimal number 
11265.

There are function blocks that convert the data for PLCs from the SIMATIC S7 series. You 
must always call up the blocks before and after data transfers between the PLC and WinCC. 
The function blocks are available for download from the Siemens Customer Support website 
in the Internet. The compressed file ANSI_S5.EXE is then loaded. ANSI_S5.EXE contains the 
"IEEE:GP" function block.

Active sending is described in the reference manuals for the PLCs or CPs (communication 
processors).

9.5.2.5 Operation in Runtime

Recipe view

Functional scope   
The recipe view offers access to user logs, the recipes and recipe collections. In runtime, you 
can:

● Online configuration of recipe view

● Create, delete or modify new data records

● Scrolling in recipes

● Read and write tags for direct tag link

● Importing and exporting recipes
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● Defining selection criteria to display only a certain part of the recipes

● Defining sorting conditions for the displayed recipe elements

Properties
You connect a recipe view with a recipe or recipe collection in the configuration. The online 
configuration and changing of selected recipe values in Runtime can be protected against 
unauthorized access respectively by own operator authorizations. If you cancel the access 
protection, you must reconnect the recipe view with the recipe in the configuration dialog box.

The access protection is queried when the recipe view screen opens.

● If the user has no authorization to read a recipe element, the corresponding column is not 
displayed in the table.

● If the user has no authorization to write a recipe element, the user cannot edit the data of 
the the corresponding column in the table.

Access protection for the control tags must be configured separately by the object properties, 
e.g. of a screen, an I/O field or a button.

Using the Recipe View

Mouse and keyboard operation

Introduction        
You operate the recipe view in Runtime by buttons in the toolbar. If you do not want to use the 
toolbar for operation, you can write the "ID" of the desired button in the "ToolbarButtonClick" 
object property with any dynamization type.
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Overview

Symbol Description ID
"Help"
Calls the help for the recipe view.

1

"Configuration dialog"
Opens the configuration dialog box in which you change the properties of 
the recipe view.

2

"Select data connection"
Opens a dialog box for selecting a recipe or recipe collection. The recipe 
data are then shown in the table of the recipe view.

3

"First line"
The first data record is displayed in the table by the button. 

4

"Previous line"
The previous data record is displayed in the table by the button.

5

"Next line"
The next data record is displayed in the table by the button.

6

"Last line"
The last data record is displayed in the table by the button.

7

"Delete lines"
The content of the marked lines are deleted.

8

"Cut lines"
The content of the marked lines are cut out.

9

"Copy lines"
The content of the marked lines are copied.

10

"Insert lines"
The content of the copied or cut-out lines is inserted starting from the marked 
line.

11

"Read tags"
The contents of the connected WinCC tags are read and written into the 
recipe elements by the button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use the button. The recipe 
elements must be connected with tags.

12

"Write tags"
The contents of the recipe elements are written into the connected WinCC 
tags. The "Tags" communication type must be activated in the displayed 
recipe to be able to use the button. The recipe elements must be connected 
with tags.

13

"Import Archive"
A CSV file is imported from the "ua" directory of the project folder into the 
table of the recipe view by the button.

14

"Export archive"
The original contents of the table are exported with table headers by the 
button when loading. The recipe is stored as a CSV file in the "ua" directory 
of the project folder. 

15

"Sort dialog"
Opens a dialog box for setting a customized sorting of the displayed columns.

16
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"Print"
Starts the printout of the displayed values. The print job used for printing is 
defined in the configuration dialog on the "General" tab. 

18

"Export data"
You export the recipe or recipe collection with the button as configured into 
a CSV file but with the current Runtime data. If the option "Display dialog" is 
active, a dialog opens in which you can view the settings for exporting and 
can start the export. With the appropriate operator authorizations you can 
also select the file and the directory for the export.
If no dialog box is displayed, the data export to the preset file starts 
immediately.

20

"Time base dialog"
Opens a dialog box for setting the time base for the used times.

19

"User-defined 1"
Displays the first button created by the user. The function of the button is 
customized.

1001

Possible elements of the status bar
The following elements may appear in the status bar of the recipe view:

Symbol Name Description
Archive name Displays the name of the selected recipe or recipe collection.
Row Shows the number of the marked line.
column Shows the number of the marked column.
Date Shows the system date.
Time Shows the system time.
Time Base Shows the time base used in the display of times.

Navigation in the table
You can navigate in the table as follows:

● You enter the next cell with the "ENTER" key or with the "Right" cursor key.

● You enter the previous cell with "SHIFT+ENTER" key or with the "Left" cursor key.
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● You enter the next line by clicking with the mouse in the line or with the "Down" cursor key.

● You enter the previous line by clicking with the mouse in the line or with the "Up" cursor 
key.

 

  Note

If the "Error while connecting the data!" error message appears when starting Runtime, 
the recipe view has no binding to a recipe or recipe collection. Check the following: 
● The name is specified correctly.
● The configuration is not changed.
● The connected recipe or recipe collection still exists.

 

Editing recipe data

Introduction   
You can edit data in the Data recipe view. The following options are available:

● Enter new data

● Change existing data

● Delete lines

● Cut-out, copy and insert lines

Requirement
● You have permitted editing in the configuration dialog on the "General" tab.

● You have deactivated the "Write-protected" property for the column to be edited in the 
configuration dialog on the "Columns" tab.

● The "ID" column cannot be edited.

● If the recipe view is connected with a view, you cannot delete and cut out a line.

Entering new data in the table
1. Click on  to move to the last line. The line is marked.

2. Double-click on the first cell of the marked line. You can also press on "F2", "Alt+Enter" or 
Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the new data 
record is written into the recipe. You move to another line by clicking with the mouse, with 
the "ENTER" key or with the "Up" and "Down" cursor keys.

4. You can copy the data of a marked line with "CTRL+C" or "CTRL+X" into the clipboard. 
The copied data is inserted into a marked line with "CTRL+V".
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Changing existing data in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Double-click on the desired cell of the marked line. You can also press on "F2", "Alt+Enter" 
or Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the changed 
data record is written into the recipe.

Deleting a line in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  to delete the marked line.

Cutting, copying and inserting lines
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  or  to cut or copy the data of the line. As an alternative, you can also use 
key combination "CTRL+ALT+X" or "CTRL+ALT+C".

3. Go to the desired line into which you want to copy the data. Click on  to insert the cut-
out or copied data. If you do not want to overwrite the data of the marked line, move into 
the last line to insert the data.

Selecting and configuring data

Introduction  
The recipe view shows the data of the connected recipe in a table. The displayed content of 
the table is determined by the selected columns and the selection of contents of the columns.

Requirement
● You have created one or more recipes or recipe collections.

● You have connected the recipe view with a recipe or recipe collection.
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Configuring the columns
1. Go to the "Columns" tab.

2. In the "Columns" list you can see the fields of the connected recipe or recipe collection. If 
a check mark is set in the option check box in front of the name of the column, the column 
is displayed in the table. Deactivate the check box if you do not want it to appear.

3. Determine the order of the columns in the table using the "Up" and "Down" buttons.

4. Select a column to configure the properties and the format.

5. If necessary, change the width of the column in the table. Enter a value in the "Length in 
chars" field.
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6. Some columns can also show the content and the header as a symbol. Determine how 
these columns are displayed in the "Display" field. Text and symbols can be displayed at 
the same time.

7. Save the configuration.

Selection of column content that will be displayed in the table
Configure criteria used to display the content in the columns in the "Selection" area.

Procedure
1. Click "Edit...". The selection dialog is opened.

2. Specify the criteria for the display. More information on the selection of columns can be 
found under Select data (Page 1587).

3. Click "OK" to close the selection dialog. The selection is considered at the start of Runtime 
in the table of the recipe view.
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Configuring the Sorting of Columns
You configure the sorting of the columns in the table in the "Sorting" area. You can also specify 
the sorting criteria in Runtime using the key functions.

1. Click "Edit...". The sorting dialog opens.

2. Set a sorting sequence. More information on the sorting of columns can be found under 
Auto-Hotspot.

3. Click "OK" to close the sorting dialog.

4. Save the configuration of the contents.

See also
Select data (Page 1587)

Select data

Introduction    
Which contents of the recipe you want to show or export in the recipe view table can be defined 
in Runtime by the selection dialog box.  In the selection dialog box you defie selection criteria 
with regard to the displayed columns of the recipe.
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Requirement
● The selection dialog is open (see paragraph "Selecting and configuring data (Page 1584)").

Procedure
Proceed as follows:

1. Double-click in the first empty line in the "Criteria" column. The list with the columns of the 
recipe view is shown. Select the desired columns, e.g. "field1".

2. Double-click in the "Operand" column to select an operand.

3. Double-click in the "Setting" column to enter a comparison value.

4. Double click in the "Logic operator" column to select an "AND" or "OR" function.

5. Repeat the procedure if you want to define further criteria.

6. Click "OK" to close the selection dialog. The selection is displayed in the table of the recipe 
view.

 

 
 NOTICE

Ensuring the display of column content

Make sure of proper use of the settings and connections of criteria. 

Incorrect logical operations can lead to the data of the connected recipe not being 
displayed in the recipe view.

Therefore test every criterion separately before the logical operation and then the logically 
operated criteria respectively. Check that all expected contents are also displayed in 
combination.

This ensures that the selection is displayed completely in the recipe view.
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Sorting data

Introduction    
The data in the recipe view can be sorted by columns in Runtime. You sort the columns either 
via the "Sort dialog" button function or directly via the column headers.

 

 Note

You can define the  sorting criteria already in the configuration in the recipe view by clicking 
the "Edit..." button under "Sorting" on the "Columns" tab.

 

How to sort with the Sort dialog

Requirement
● You have activated the "Sorting dialog" button on the "Toolbar" tab of the UserArchive 

Control.

Procedure
1. Click the "Sort Dialog" button .

2. Select the column of the connected recipe from the "Sort by" list which is to be used for 
sorting first. Select the relevant check box to specify sorting in ascending or descending 
order. If you want to sort by more than one column, select the other columns in the desired 
order in the "Then sort by" lists.
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How to sort the column contents with the column heading 
When sorting using the column header, you are able to specify the sort order for more than 
four columns. A sorting icon and sorting index, displayed with right-justification in the column 
heading, show sorting order and sorting sequence of the column contents.

Requirement
● You have allowed sorting in the list field "Sort by column header" by click or double click 

on the "Parameters" tab of the recipe view.

● You have activated the "Show sorting icon" and "Show sorting index" checkboxes.

Procedure
1. Click the column header of the column you want to sort as first column. The sorting index 

"1" is displayed, and the sorting icon points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.

3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the 
column with a third click.

4. If you want to sort several message blocks, click the respective header columns in the 
desired sequence.

Using the recipe screen

Introduction
You use the recipe screen with the control objects you have configured. The paragraph 
describes the operation of the recipe screen with control tags from the section "Control tags 
(Page 1567)".

 

 Note
Runtime API

The Runtime API provides you with extensive uaArchive functions to edit recipes and recipe 
collections in Runtime (see section "Interfaces > Runtime API", subsection "Control tags").

 

Requirement
● Communication type is set to "Tags" in the recipe.

● The "Unique values" checkbox is activated under "Options" in the properties of the recipe 
element "Coloring 7".

● Recipe tags and control tags are set up.

● A process screen with the required I/O fields is configured.

● The I/O fields are connected with the recipe tags and control tags.
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Example:

Procedure
To transfer recipe data to the recipe memory of the HMI device, follow these steps:

1. Enter the recipe values displayed in the blue fields "Water", "Sugar", "Aroma", "Coloring 7" 
and "Concentrate". The recipe values form the recipe data record you want to transfer.

2. Enter "3" as "ID" for the target recipe data record.

3. Enter "6" as job for reading in the "Instruction" field.

The entered recipe data are transferred as complete data record. The recipe data record 
number 3 is overwritten in the recipe memory. The job mailbox returns the value "0" (no error) 
in the "Job" control tag.

Alternative procedure
1. Enter new recipe values in the blue fields " Water", "Sugar", "Aroma", "Coloring 7" and 

"Concentrate".

2. Enter the recipe element "Coloring 7" as the "Field".

3. Enter the recipe element "020" as the value in the "Value" field.

4. Enter "6" as job for reading in the "Instruction" field.

The entered recipe data are transferred as complete data record. The recipe data record whose 
recipe element " Coloring 7" has the recipe value "020" - in the example the recipe data record 
number 3 in the recipe memory - will be overwritten. The job mailbox returns the value "0" (no 
error) in the "Job" control tag.
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See also
Displaying recipes (Page 1558)

9.5.2.6 Examples

Example: Creating recipes

Task
In this example, you will create two recipes.

● A "Beverage" recipe for drinks. The drinks mixing plant produces various drinks. You create 
a recipe data record for each item.

● An "Orders" recipe for orders. The orders contain the current order data.

Settings
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or 
SIMATIC S7-400.

In this example, you will need the following tags, recipes, recipe entries and recipe data records:

Tags:

Name PLC connection Address Type
article Yes DB 120, DBW 0 String
litrewater Yes DB 120, DBW 4 Integer
kilosugar Yes DB 120, DBW 8 Integer
gramaroma Yes DB 120, DBW 12 Integer
litreconcentrate Yes DB 120, DBW 16 Integer
coloring Yes DB 120, DBW 20 Integer
customer Yes DB 120, DBW 24 String
numbercustomer Yes DB 120, DBW 28 String
numberorder Yes DB 120, DBW 32 Integer
quantitiy Yes DB 120, DBW 36 Integer
filling Yes DB 120, DBW 40 Integer
dateorder Yes DB 120, DBW 44 Date
status Yes DB 120, DBW 48 Integer

"Beverage" recipe:

Recipe element Associated tag
Article article
Water litrewater
Sugar kilosugar
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Recipe element Associated tag
Aroma gramaroma
Concentrate litreconcentrate
Coloring coloring

Data record ID 1 2 3
Article Juice Nectar Cola Light
Water 5 50 72
Sugar 5 10 35
Aroma 100 300 240
Concentrate 95 50 35
Coloring FS 0063 FS 0063 FS 1007

"Orders" recipe:

Recipe element Associated tag
Customer customer
Number numbercustomer
Order numberorder
Article article
Quantitiy quantitiy
Filling filling
Status status
Date dateorder

Procedure
1. Create the tags listed above with the settings described above.

2. Create the "Beverage" and "Orders" recipes with the settings indicated above.

3. Select the following properties for the recipes:

– Under "General > Size" the "Unlimited" type

– Under "Communication > Communication type" the "Tags" communication type
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4. Create the recipe entries in each recipe.

5. Activate the "Unique values" check box for the following elements in the property window 
under "Extras".

– In the "Beverage" recipe for the "Article" recipe element

– In the "Orders" recipe for the "Order" recipe element

6. Create the data records indicated above in the "Beverage" recipe. Enter the values 
indicated above in each of the data records.
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Result
The "Beverage" and "Orders" recipes are created.

See also
Example: Configuring a recipe view (Page 1596)

Example: Creating a recipe view

Task
In this example you create the "Label" recipe view. The following recipe elements are displayed 
in the recipe view. 

Recipe element Recipe
Article Beverage, Orders
Customer Orders
Status Orders
Order Orders
Filling Orders
Sugar Beverage
Coloring Beverage

The "Article" recipe element is contained as a common element of both recipes.

Requirements
The "Beverage" and "Orders" recipes are created.
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Procedure
1. Create the "Label" recipe view. Create the elements listed above.

2. Enter the following conditions under "Properties > Relations":
Beverage.Article = Orders.Article

Result
The "Label" view is created.

Example: Configuring a recipe view

Task
In this example, you will add a plant screen with recipe view to the "Label" view.

Requirement
The examples "Create recipes" and "Create recipe view" are created.

You have created and opened the "Drinks mixing plant" process screen.
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Procedure
1. Insert the recipe view in the process screen. You will find the recipe display in the toolbox 

under "Controls".

2. Select the "Recipe view" type in the inspector window in the "General > View" group in the 
"Data source" input field with the arrow".

3. Select the "Label" recipe view.

4. Define additional display options for the recipe view in the "Properties" > "Appearance" 
group in the Inspector window.

5. Go to the "Properties" > "Columns" group in the inspector window.

– Activate the check box in the "Visible" and "Protected" columns for all recipe elements.

6. In the Inspector window, switch to the "Properties" > "Toolbar" group. Activate the check 
box in the "Visible" column for the following buttons under "Toolbar - Buttons".

– "First line"

– "Previous line"

– "Next line"

– "Last line"

– "Sort dialog"

– "Selection dialog"

7. Go to the "Properties" > "Columns" group in the inspector window. Enter the following 
sorting in the "Sort" column.

– By job number

– Ascending

Result
The recipe display is opened with the "Label" recipe view in Runtime in the process screen 
"Drinks mixing plant". The data records are displayed sorted by job number. You can use the 
buttons to switch between the data records.

Use the "Status" data field to display the current job or jobs that have been run.

You can adapt the recipe display to the data records as required with the "Sort dialog" and 
"Selection dialog" buttons.

See also
Example: Creating recipes (Page 1592)

Using control tags

Example for the use of control tags:
You need to perform the following steps to work through the example with the control tags: 
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Requirement
You have created the "Drinks" recipe.

Properties of the "Cola" recipe
Log type "Unlimited"
Communication "Tags"
Data type for the "ID" control tag Long
Data type for the "Job" control tag Long
Data type for the "Field" control tag String (1 character)
Data type for the "Value" control tag String (1 character)

Procedure
1. Create the control tag with the following properties:

Control tag Data Format Output format
ID decimal 0999
Job decimal s9
Field String *
Value String *

1. Select the "Update for changes" object property for each control tag.

2. Connect the control tags to the "Drinks" recipe.

3. Create a new screen and add a recipe view.

– Select the "Drinks" recipe.

– Check the "Paste", "Change" and "Delete" check boxes under "General".

4. Create an I/O field for every configured recipe element.

5. Connect the I/O fields to the associated tags.
For example, connect the I/O field for "Coloring" to the "Coloring" process tag.

– Create a text field for the label of every configured I/O field.
By doing so, you assign the I/O fields to the individual recipe elements in Runtime.

6. Create an I/O field for every control tag.

– Create a text field for the label of every configured I/O field.
By doing so, you assign the I/O fields to the individual control tags in Runtime.

7. Start Runtime or load the project into the HMI device and start the project.

Result
The configuration for the recipe is completed.
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Accessing the recipe
You can now access the recipe in the following ways:

● In the table view of the recipe view

● Using the configured I/O fields

Write the data record to the process tags using the ID
● Enter the ID "3" in the "ID" I/O field and enter a "7" in the "Job" I/O field.

The values of data record "3" will be written to the process tags in the I/O fields and displayed 
in the I/O fields.
If the data record values were read without error from the recipe, error number "0" is 
displayed in the "Job" field.
Error number "-1" is output if an error occurs.
The "Field" and "Value" control tags are not required.

 

  Note

The current contents of the process tags are read into the recipe by entering the ID "-1" 
and the job "6". The new values are appended at the end of the table. The data record 
IDs are continuously incremented. 

 

Read the process tags via the ID
● Change the values in the I/O fields of the process tags and enter a "5" in the "ID" field. Enter 

"6" in the "Job" I/O field.
The changed values of the process tag are written to data record "5" of the recipe. The 
values that were previously contained in this data record are overwritten.
The "Field" and "Value" control tags are not required.

Write a data record to the process tag using the "Field" and "Value" control tags
 

 Note

For an element that is referenced with the "Value" control tag, you must select the "Field must 
posses an unique value" check box under "Properties" > "Memory options". Otherwise it will 
not be possible to create a unique assignment between the recipe data record and the value 
in the element.

If text is entered in the "Value" I/O field, it must be enclosed in inverted commas (such as 
'Nectar').
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● In the "Field" I/O field, enter the word "Item" and write "Cola Light" to the "Value" I/O field. 
Enter "7" in the "Job" I/O field.
The values of the "Cola Light" data record will be written to the process tags in the I/O fields 
and displayed in the I/O fields.
The "ID" control tag is not needed, so it must be set to 0. 

9.5.2.7 SQL language
SQL (Structured Query Language) is an efficient and widely distributed database language. 
The SQL language is used for database queries in the functions of the WinCC script language. 
You will find further information in the relevant technical manuals.  

In some standard functions and some functions in the "Recipes" editor, you must specify 
conditions in the database language SQL to specify the data records to be edited. A few 
examples of how provide an SQL instruction are given below:

 

 NOTICE

Name convention

Prefixes, suffixes and the name of a recipe, recipe view or a recipe element may only consist 
of letters, numbers and underscores "_" and may not exceed a length of 20 characters. The 
first character must always be a letter.

 

● FieldA > '1992-12-31 23:45:12.12'
The instruction selects all data records whose value in the "FieldA" column is greater than 
the specified value. FieldA is is of the data type DB_TYP_TIME.

● FieldB like 'tank%'
Then the data records for which the "FieldB" column contains the value "tank1" or "tank4" 
or "tank12" etc. are selected for example. FieldB is of the data type DB_TYP_CHAR.

● FieldC > 100
With a condition of this type, all data records are selected for which the "FieldC" column 
contains a value greater than 100. FieldC is of the data type DB_TYP_INTEGER.

● BETWEEN FieldC = 20 AND FieldC = 200
The statement selects all data records for which the "FieldC" column contains a value 
between 20 and 200. FieldC is of the data type DB_TYP_INTEGER.

● FieldD
Sorting then takes place by column "FieldD".

● FieldE desc
Sorting then takes place by column "FieldE" in reverse alphabetical order (descending 
order).

See also
SQL keywords (Page 1601)
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9.5.2.8 SQL keywords

SQL keywords
 

 NOTICE

Do not use the following terms and keywords as names for recipe, recipe view or recipe 
element:
● "Archive"
● "View"
● "Field"
● "ViewCol"

 

Keywords of the SQL language
add all alter and
any as asc begin
between binary break by
call cascade cast char
char_convert character check checkpoint
close comment commit connect
constraint continue convert create
cross current cursor date
dba dbspace deallocate dec
decimal declare default delete
desc distinct do double
drop else elseif encrypted
end endif escape exception
exec execute exists fetch
first float for foreign
from full goto grant
group having holdlock identified
if in index inner
inout insert instead int
integer into is isolation
join key left like
lock long match membership
message mode modify named
natural noholdlock not null
numeric of off on
open option options or
order others out outer
passthrough precision prepare primary
print privileges proc procedure
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Keywords of the SQL language
raiserror readtext real reference
references release remote rename
resource restrict return revoke
right rollback save savepoint
schedule select set share
smallint some sqlcode sqlstate
start stop subtrans subtransaction
synchronize syntax_error table temporary
then time tinyint to
tran trigger truncate tsequal
union unique unknown update
user using validate values
varbinary varchar variable varying
view when where while
with work writetext  

See also
SQL language (Page 1600)

9.6 Working with reports

9.6.1 Basics

9.6.1.1 Reports

Introduction
Reports are used to record process data and processed production cycles. You have the 
opportunity, for example, to create regular shift reports, output batch data, or record the 
production process for quality control (QC). 
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Creating reports 
A report is created and edited in the "Reports" editor. In this editor, you configure the following 
report items:

● Formal appearance
Specify the formal layout of the report in the Inspector window.  In this window, for example, 
you specify the page format, page margins, title page, back page, headers, or footers for 
the report. 
Moreover, you can specify whether to output the different pages with or without watermark 
in the reports for Runtime Professional.

● Content
In the work area, specify the content of the report, for example, the alarms of a shift. To 
this purpose, insert the corresponding objects into the detail page(s). 
You can also design the title page, back page, headers, and footers as you please. For 
watermarked pages, create additional pages to be included as "background image" in the 
output. 

The modular structure lets you configure reports that suit all of your applications. 
 

 Note

The "Reports" editor is not available at HMI devices that do not support reporting.
 

Report output
In Runtime, report output is event-driven or time-driven.

● Time-driven: Automatic print at specific dates, times or intervals.

● Event-driven: Printing is initiated by specific events, e.g. click on a button, or a limit is 
exceeded.

The configuration of report output differs depending on the Runtime version.  

In Runtime Advanced, the configured reports are output on the default printer of the HMI device.

For Runtime Professional, make the following decisions with the help of a print job:

● Output of selected pages, or of all pages of the report

● Output of all data, or only the data of a specific period

● Output of the report to a printer or file

● Whether the operator is allowed to select a printer or modify the scope of pages for report 
output

● Whether the report that is output is displayed in the print job list of an application window 
configured accordingly

Print function of screen objects
Certain screen objects of Runtime Professional, e.g. the alarm view, contain a default button 
function (printer icon) for the report output. WinCC employs predefined system reports for the 
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output. You can can customize these to suit your requirements, or replace them with a report 
of your individual design. 

See also
Structure of reports (Page 1604)

Create a report  (Page 1616)

Print job/Script diagnostics (Page 837)

Principles for preparation of reports (Page 1612)

Principles for report output (Page 1632)

Basics for system traces and system print jobs (Page 1637)

9.6.1.2 Structure of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required. 
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Sections of a report
The following figure shows an example of the different sections of a report in the "Reports" 
editor.

Title page and back page     
The title page contains important information about the report content. The back page is used, 
for example, as Impressum, on which you provide contact information of shift managers or 
service technicians. The title page and back page are output separately on a single page. Each 
of them consist of exactly one page and page breaks are not used. 
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Detail page   
Configure the output of runtime data such as recipe or alarm reports on the detail pages of the 
report. 

Use the shortcut menu on the detail page to insert additional detail pages or change their order. 

Header and footer     
The header and footer are output on each detail page of the report. You typically insert the 
page numbers or the date in the header or footer. 

See also
Create a report  (Page 1616)

Principles for preparation of reports (Page 1609)

9.6.1.3 Structure of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.
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Sections of a report
The following figure shows an example of the different sections of a report in the "Reports" 
editor.
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Title page and back page     
The title page contains important information about the report content. The back page is used, 
for example, as Impressum, on which you provide contact information of shift managers or 
service technicians. The title page and back page are output separately on a single page. The 
page has a precise length and no page break, regardless of whether you configured a dynamic 
object to be output on that page. 

Detail page   
Configure the output of runtime data such as recipe or alarm reports on the detail pages of the 
report. 

Use the shortcut menu on the detail page to insert additional detail pages or change their order.

Header and footer     
The header and footer are output on each detail page of the report. You typically insert the 
project name, report name, page numbers or the date in the header or footer.

Watermarks   
The title, detail and back pages can be output with a watermark.  The page is printed with its 
superimposed watermark. 

With the help of a watermark, output an object "A" next to an object of variable length "B" 
without displacing object "A". Example: You want to output an output field (A) next to a table 
(B) on all pages.

The title and back pages, as well as the detail pages have separate watermarks. 

See also
Reports (Page 1602)

Principles for preparation of reports (Page 1612)

Create a report  (Page 1616)
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9.6.2 Working with reports

9.6.2.1 Creating reports

Principles for preparation of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

● Title page

● Back page

● Detail pages

● Headers and footers for the detail pages
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Procedure    
The following figure shows the general procedure for creating a report: 

1) Settings depend on the report object used. 

Tools for the design of reports
The tools that you can use to design reports are available in the "Tools" task card.

● For graphic design insert "basic objects", "elements" and "graphics" in the different sections 
of the report. For example, for a Logo in the header, separation lines and a page number 
in the footer.

● Using the "Controls" in the detail pages, configure the output of runtime data.
 

  Note

The "Screens" editor provides many objects for designing a report – however, with 
restricted functionality. Data input properties are not available. The I/O fields in the reports, 
for example, serve only to output data.
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Position and size of objects    
Insert the objects at the position where you want them to be output in the report.  The objects 
are output in their configured size and with the following special features: 

On the detail pages, configure "recipe reports" or "alarm reports" that serve to output runtime 
data in tabular format. 

● The width of the table is set up automatically to fit the width of the detail page. You cannot 
modify the width.

● WinCC automatically wraps the height of the table to fit the data content for output in the 
report. The table can be continued on the next page.
In the detail page, WinCC automatically extends tables of dynamic length to the bottom 
margin.

The following figure shows an example of a detail page in the report and its output in Runtime:

Detail page in the report Report output in Runtime

Additional detail pages   
Use the shortcut menu on the detail page to insert additional detail pages or change their order.

See also
Configuring reporting of alarms (Page 1340)

Structure of reports (Page 1604)

Create a report  (Page 1616)

Administration of detail pages (Page 1629)

Objects in reports (Page 1655)
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Principles for preparation of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

● Title page

● Back page

● Detail pages

● Headers and footers for the detail pages

● Watermarks for title page, back page, detail page

Procedure  
The following figure shows the general procedure for creating a report:

1) Settings depend on the report object used. 
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Tools for the design of reports
The objects that you can use to design the reports are available in the "Tools" task card. 

 

 Note

The "Screens" editor provides many objects for designing a report – however, with restricted 
functionality. Data input properties are not available. The I/O fields in the reports, for example, 
serve only to output data.

 

Positioning objects   
Insert the objects at the position where you want them to be output in the report.  However, 
you should be aware that WinCC ignores white spaces at the start of the detail page when the 
report is output. The top object marks the start of the detail page on the printed copy. 

The following figure shows an example of a detail page in the report and its output in Runtime:

Detail page in the report Report output in Runtime

To include a white space in the output, extend the header accordingly. You can also place an 
"invisible" object on the detail page at the required start. For example a white line that is not 
visible on white paper.

Size of objects   
Objects are output in their configured size. 

On the detail pages, configure "controls" and "report objects" for the output of Runtime data. 
WinCC aligns the Runtime data to fit the object frame – with one special feature: If you configure 
an object like a table with dynamic length, WinCC automatically adjusts the height of the table 
to fit the amount of data to print. The table can be continued on the next page. WinCC adapts 
no more than the object height and places all following objects underneath the the object, as 
configured in the detail page.

The following figure shows an example of a detail page in the report and its output in Runtime:
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Detail page in the report Report output in Runtime

Usually, the "controls" and "report objects" are assigned a dynamic length and output Runtime 
data in tabular format. The following objects are included:

● Recipe report

● Alarm report

● Table view

● ODBC database table

● Alarm sequence report

● CSV provider tables

● Control Hardcopy

● Control Data

● Control information

Objects next to dynamic objects   
In a detail page, do not place other objects next to objects that have a dynamic length. Given 
the fact that the position of the objects cannot be clearly defined, WinCC possibly outputs these 
with errors. Instead, configure the objects as watermark.

The following figure shows an example of a watermark and a detail page in the report and the 
output in Runtime:
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Watermark and detail page in the report Report output in Runtime

Title page and back page    
The title page and back page are output separately on a single  page.  WinCC will not continue 
output on the next page if you configured an object with dynamic length for the title or back 
page.    Runtime data of the object exceeding the output capacity of a single page is not output 
to the full extent in the report. 

Additional detail pages  
Use the shortcut menu on the detail page to insert additional detail pages or change their order. 

See also
Report design tools (Page 1618)

CSV file for trend output (Page 1623)

CSV file for output of a table (Page 1626)

Continuous alarm reporting (Page 1622)

Reports (Page 1602)

Structure of reports (Page 1606)

Create a report  (Page 1616)

Administration of detail pages (Page 1629)

Principles for report output (Page 1632)

Objects in reports (Page 1655)
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Create a report 

Requirement
A project with an HMI device is open. 

Procedure   
To create a report, proceed as follows:

1. Double-click "Add new report" under "Reports" in the project navigation.
A new blank report is displayed in the "Reports" editor. 

2. Select the "Report properties" command in the shortcut menu of the report.

3. In the "Properties > Properties > General" area of the Inspector window, specify whether 
you want to configure the "Title page", "Back page", "Header" and "Footer" in the report.
The report sections are updated accordingly.
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4. Configure the format, the page layout, and the page margins of the report under "Properties 
> Properties > Layout."

5. Enter a meaningful report name under "Properties > Properties > Miscellaneous."

6. Design the report sections as required. 
Drag and drop the necessary basic objects, elements, graphic images and controls from 
the "Tools" task card to the required position.
Alternatively, you can also copy or move objects already configured from a screen to the 
report. 

7. Configure the objects in the Inspector window: 
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See also
Report design tools (Page 1618)

CSV file for trend output (Page 1623)

CSV file for output of a table (Page 1626)

Continuous alarm reporting (Page 1622)

Configuring reporting of alarms (Page 1340)

Reports (Page 1602)

Structure of reports (Page 1604)

Structure of reports (Page 1606)

Principles for preparation of reports (Page 1612)

Working with objects (Page 1641)

Objects in reports (Page 1655)

Report design tools

Tools for the design of reports  
In the "Reports" editor, use the objects in the "Tools" task card to design the reports: 

● For graphic design insert "basic objects", "elements" and "graphics" in the different sections 
of the report. For example, for a Logo in the header, separation lines and a page number 
in the footer.

● Using the "Controls" in the detail pages, configure the output of runtime data.

● If you want to use your own reports instead of the system reports for the print function of a 
screen object, configure the output of Runtime data with the help of the "Report objects".

 

  Note

The "Screens" Editor provides many objects, though with restricted functionality, that you 
can use to design a report. Data input properties are not available. The I/O fields in the 
reports, for example, serve only to output data.

 

Elements   
The following table provides an overview of the objects of the "Elements" panel:

Object Application
Date/time field For output of the current data and time

You can customize the output format. 
I/O field For the output of process values

You can choose between different output formats.
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Object Application
Project name For output of the project name 

The name can be output with or without path definition.
Report name For output of the report name 
Page number For output of the page number and total number of pages

You can customize the output format. 

Output of data in tabular format   
For a time-driven or event-driven output of data in table form, configure the following controls 
in reports:

Control Use in report
Table view For time-driven output of the values of one or several logging tags 

Each row of the table represents the status of the selected logging tag at a 
specific time.

ODBC database table For the output of data that does not originate from WinCC
The data is output in tabular format via the ODBC interface.

CSV provider tables For the output of data of a CSV file 
The data of a CSV file must conform to a specific structure. You can select 
a CSV file, or configure a tag for dynamic selection of the CSV file.

A print function is already integrated in the "Table view" control in the "Screens" editor (button 
in Runtime). The "Table view" uses preconfigured system reports for printing. You can specify 
in the system reports if you want to output all data or only the current data displayed in the 
object (snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

Data output in trends   
For a time-driven or event-driven output of data in trend form, configure the following controls 
in reports:

Controls Use in report
f(t) trend view in reports For the output of logging tags as a function of time
f(x) trend view in reports For the output of logging tags as a function of other logging tags, e.g. the 

temperature profile as a function of pressure
You can also compare the trend to a setpoint trend.

CSV provider trends For the output of data of a CSV file 
The data of a CSV file must conform to a specific structure. You can select 
a CSV file, or configure a tag for dynamic selection of the CSV file.

A print function is already integrated in the "f(t) trend view" and "f(x) trend view" controls in the 
"Screens" editor (button in Runtime). For printing, these controls use preconfigured system 
reports that you can customize to suit your requirements.
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Output of recipes   
For a time-driven or event-driven output of recipe data, configure the following controls in 
reports:

Control Use in report
Recipe view For the output of recipe elements

A print function is already integrated in the "Recipe view" control in the "Screens" editor (button 
in Runtime). This control uses preconfigured system reports for printing. You can specify in 
the system reports if you want to output all data or only the current data displayed in the object 
(snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

Output of alarms   
WinCC offers several options for alarm reporting.

For a time-driven or event-driven output of alarms, configure the following control in reports:

Control Use in report
Alarm view For the output of alarms that occur during the process in a plant.

WinCC outputs current alarms, suppressed alarms or alarms from the 
historical alarm list (short-term), depending on the configuration.

A print function is already integrated in the "Alarm view" control in the "Screens" editor (button 
in Runtime). This control uses preconfigured system reports for printing. You can specify in 
the system reports if you want to output all alarms or only the current alarms displayed in the 
object (snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

WinCC lets you continuously output alarms after the start of Runtime, for example, to a line 
printer. All you have to do is activate this output. WinCC offers two preconfigured system 
reports that you can adapt to meet your requirements: one for output in the line layout and one 
for output in the page layout. 

Output of a snapshot from Runtime   
To output a snapshot of Runtime in a report, configure the following control in reports:

Control Use in report
Hardcopy For the output of a snapshot from Runtime

WinCC outputs the entire content of the screen, of the active window, or of 
an individually selected screen area, depending on the configuration.
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Data output via ODBC interface   
To read data from external sources using the ODBC interface and output them in a report, 
configure the following controls in reports. 

Control Use in report
ODBC database field For the output of data from a field of an external database table
ODBC database table For the output of external database tables 

Report objects   
Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. 

For reports that you want to use for the printing a screen object instead of a preconfigured 
system report, configure the output of Runtime data with the help of the "Report objects".

The following table shows the report objects that you can use in the reports:

Object Use in report
Control Hardcopy To output screen objects as it is displayed in Runtime (snapshot)
Control Data For output of the current data of the screen object

The data is output in tabular format.
Control Information To output the data source, for example, window title, object name or screen 

name
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See also
Create a report  (Page 1616)

Principles for preparation of reports (Page 1612)

Control Data (Page 1656)

Control hard copy (Page 1657)

Control Information (Page 1658)

CSV provider trends (Page 1659)

CSV provider tables (Page 1660)

Date/time field (Page 1662)

f(t) trend view in reports (Page 1665)

f(x) trend view in reports (Page 1665)

Hardcopy (Page 1668)

Alarm view in reports (Page 1669)

ODBC database field (Page 1673)

ODBC database table (Page 1674)

Project name (Page 1676)

Report name (Page 1677)

Recipe view in reports (Page 1678)

Page number (Page 1681)

Table view in reports (Page 1682)

Continuous alarm reporting (Page 1622)

Continuous alarm reporting

Alarm sequence report    
An alarm sequence report outputs alarms that occur on the HMI device continuously in 
chronological order, for example, to a line printer.   

To use the preconfigured alarm sequence report, you only need to activate it. 

If you only want to output specific alarms, for example, adapt the report to match your needs. 

Activation and configuration
The output of the pre-configured alarm sequence report is configured in the "Alarm sequence 
report" system print job. 

To automatically run the system print job at the start of Runtime: 
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● In the Runtime settings of the HMI device activate "Services > Start sequence of WinCC 
Runtime  > Alarm sequence report".

The alarm sequence report is output in the default line layout to a line printer. 

To output the alarm report in the page layout:

● Open the "Alarm sequence report" system print job and deactivate the "Use line report" 
option under "Properties > Properties > General".

WinCC assigns the appropriate system report to the system print job. 

Customize the system reports to suit your requirements:

● "@AlarmSequenceReportForPagePrinter" for output in page layout

● "@AlarmSequenceReportForLinePrinter" for output in line layout

See also
Principles for preparation of reports (Page 1612)

Report design tools (Page 1618)

Create a report  (Page 1616)

Alarm sequence report (Page 1670)

Basics for system traces and system print jobs (Page 1637)

Alarm view in reports (Page 1669)

CSV file for trend output

Requirements for a CSV file that is used for the output of trends   
To enable output in a table, the data in the CSV file must have a defined structure.

In the report, the "CSV provider trends" object visualizes the CSV file data in trends. The data 
of a CSV file must conform to the structure described below. 

The CSV file must contain a paragraph for the different parts of the graphic object. A paragraph, 
in turn, can contain several lines. The following paragraphs are mandatory:

● "Graph": Contains the number of trends and specifications concerning visualization of the 
graphic object

● "Trends": Contains information on the trend visualization

● "Trend values": Contains the values of the trends

The syntax is identical in all paragraphs. The first line marks the beginning of a paragraph and 
defines the interpretation of the paragraph data. The other lines of a paragraph contain the 
actual values of the graphic object or trends.

Use a semicolon to separate the values. Insert line breaks to mark the end of lines.
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"Graph" paragraph:
The first line of the "Graph" paragraph must contain the following entry:

#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize

The second line has to contain the values for the graphic object.

Name Meaning Comment
Name Name of the trend view or file  
Curves Number of trends  
DateFrom Start of the time range Notation: 2000-10-30 

10:15:00.000
DateTo End of the time range Notation: 2000-10-30 

10:15:00.000
Common Y-Axis Common Y axis  
Font Font  
Fontsize Font size  

Example:

Line Content
1 #Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize
2 "TrendControl1";3;"2001-10-10 16:30:00.000";"2001-10-10 16:40:00.000";0;"Arial";10

"Trends" paragraph:
The first line of the "Trend" paragraph must contain the following entry:

#Curve; Num; Name; Count; dMin; dMax; Color; Width; CurveType;  Filling

For each trend that is visualized in the graphic object, the paragraph must contain a separate 
line that specifies the trend values.

Name Meaning Comment
Num Trend number beginning with 0
Name Trend name  
Count Number of values  
dMin Low limit of the trend (for scaling)  
dMax High limit of the trend (for scaling)  
Color Color of the Y axis in hexadecimal notation
Width Line thickness in points e.g. 1.5
CurveType Trend type LINE, DOTS, STEP
Filling Fill color for fields 0=no, 1=yes

Example:
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Line Content
1 #Curve; Num; Name; Count; dMin; dMax; Color; Width; CurveType; Filling
2 0;"Temperature";3;10;30;0x00ff0000;1;STEP;0
3 1;"Pressure";5;0;50;0x0000ff00;2;DOTS;0
...  

Structure of the "Trend values" data record
The first line of the "Trend values" paragraph must contain the following entry:

#Data; Num; Date; Value; Flags; Color

For each value that is visualized in the trends, the paragraph must contain a separate line that 
specifies the coordinates. 

Name Meaning Comment
Num Trend number beginning with 0
Date Value on the X axis of the trend Notation: 2000-10-30 

10:15:00.000
Value Value on the Y axis of the trend  
Flags Limits / time overlap  
Color Color of the trend section in hexadecimal notation

If you did not define a color for 
the trend, the color of the 
associated Y axis is applied to 
the trend.

Example:

Line Content
1 #Data; Num; Date; Value; Flags; Color
2 0;"2001-10-10 16:30:00.000";22;0;0x000000FF
3 0;"2001-10-10 16:31:00.000";24;0;
...  

See also
Create a report  (Page 1616)

Principles for preparation of reports (Page 1612)

CSV provider trends (Page 1659)
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CSV file for output of a table

Requirements for a CSV file to be output in tabular format   
In the report, the "CSV provider table" object visualizes the CSV file data in tabular format in 
the report. The data of a CSV file must conform to the structure described below. 

The CSV file must contain a paragraph for the different parts of the table. A paragraph, in turn, 
can contain several lines. The following paragraphs are mandatory:

● "Table": Specifies the number of columns, the font, and the font size

● Columns": Specifies the headers, widths, and alignment of the columns

● "Data" Contains the data

The syntax is identical in all paragraphs. The first line marks the beginning of a paragraph. 
The first line describes how the data of the paragraph are interpreted. The other lines of a 
paragraph contain the actual values of the graphic object or trends.

Use a semicolon to separate the values. Insert line breaks to mark the end of lines.

"Table" paragraph
The first line of the "Table" paragraph must contain the following entry:

#Table; Name; Columns; Font; Fontsize

The second line has to contain the values for the table.

Name Meaning Comment
Name Name of the table view  
Columns Number of columns  
Font Font  
Fontsize Font size  

Example:

Line Content
1 #Table; Name; Columns; Font; Fontsize
2 "Tab_9";4;"Arial";14

"Columns" paragraph
The first line of the "Columns" paragraph must contain the following entry:

#Column; Num; Header; Width; Alignment 

For each table column to be visualized in the graphic object, the paragraph must contain a 
separate line that specifies the column values.
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Name Meaning Comment
Num Column number beginning with 0
Header Column header  
Width Ratio of the width between 

columns 
Example: For a table with three columns, you specify the 
following widths: 2, 4, and 8. 
As a result, the third column is output with twice the width 
of the second and three times the width of the first column.
Column width in characters = [table width in number of 
characters] x [Width] / [Total of Width all values of the 
columns]

Alignment Alignment Left/Central/Right

 

Example:

Line Content
1 #Column; Num; Header; Width; Alignment
2 1;"Number";6;L
3 …
4 …

"Values" paragraph
The first line of the "Values" paragraph must contain the following entry:

#Data; Color; Col1; Col2; Col3; ...

For each line of the table, this paragraph must contain a separate line that specifies the relevant 
column values.

Name Meaning Comment
Color Line color Notation as in HTML as six-digit Hex 

number: 0xbbggrr 
(hex blue blue green green red red)

Col1 Data of column 1  
Col2 Data of column 2  
Col3 Data of column 3  

Example:

Line Content
1 #Data; Color; Col1; Col2; Col3; Col4
2 0xFF00FF;"05/06/02";"15.55.53";86;"+/-"
3 0x32b400;"05/06/02";"15.55.54";87;"+/-"
4 0x32b400;"05/06/02";"16.00.00";82;"+/-"
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Preparing data in the spreadsheet program
As demonstrated in the examples above, the first value in the first line of a paragraph 
represents the paragraph identifier, e.g. "#Data" as identifier of the "Values" paragraph. The 
next lines of the paragraph do not contain this identifier.  

If you process the lines of a paragraph (of a CSV file) in a spreadsheet program such as 
Microsoft Excel, the column headers and values will not be congruent.

In order to avoid this effect, insert a semicolon ";" as wildcard at the beginning of the lines that 
contain the actual values:

● The column headers and values are now correctly aligned vertically in Excel.

● WinCC ignores the semicolon ";" at the beginning of the line and outputs the data correctly 
in a trend or table.

Example:

Line Content
1 #Data; Color; Col1; Col2; Col3; Col4
2 ;0xFF00FF;"05/06/02";"15.55.53";86;"+/-"
3 ;0x32b400;"05/06/02";"15.55.54";87;"+/-"

Control characters for formatting values
The control characters are used to specify value attributes such as the color, font style, or the 
alignment. The control characters always lead the value. You can combine several control 
characters: "<B><U>output text", for example, returns the words "output text" in bold and 
underscored format. No distinction is made between upper and lower case text.

The following table provides an overview of the control characters:

<END> Ends a sequence of control characters. The remaining text is applied as 
specified.

<COLOR=#rrggbb> Font color; notation as six-digit Hex number with the following byte 
sequence: #rrggbb 
(red red green green blue blue)

<BGCOLOR=#rrggbb> Background color on hexadecimal notation
<B> Bold font style
<U> Underlined font style
<I> Italic font style
<STRIKE> Strikethrough font style
<ALIGN=left> Text aligned left
<ALIGN=center> Text centered
<ALIGN=right> Text aligned right
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 Note
Different notation for color definitions

Colors are defined by a six-digit hexadecimal number.

In the "Values" paragraph, the line color has the same notation as in HTML, with the following 
byte sequence:

0xbbggrr (blue blue green green red red).

To format a single value, the colors in the control character <Color> are defined by an inverted 
sequence: 

#rrggbb (red red green green blue blue).
 

 

See also
Create a report  (Page 1616)

Principles for preparation of reports (Page 1612)

CSV provider tables (Page 1660)

Administration of detail pages

Adding a detail page    
1. Open the shortcut menu of a detail page.

2. Select the command "Pages > Insert page before" or "Pages > Insert page after."
Depending on the selected command, the new detail page is inserted either before or after 
the existing detail page.

Deleting a detail page     
1. Open the shortcut menu of the detail page that you want to remove.

2. Select the command "Pages > Delete detail page".
The detail page is deleted. 

Sorting detail pages     
1. Open the shortcut menu of the detail page that you want to move.

2. Select the "Pages > Move one page up" or "Pages > Move one page down" command.
Depending on the selected command, the detail page is moved either upward or downward.
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Showing and hiding sections    
1. To show or hide a specific section, click on the plus or minus sign in the title bar of the 

section in the working area. 

2. If you want to show or hide all sections of a report, select the command "Show all pages" 
or "Hide all pages" in the report shortcut menu.

See also
Structure of reports (Page 1604)

Structure of reports (Page 1606)

Principles for preparation of reports (Page 1612)

Principles for preparation of reports (Page 1609)

9.6.2.2 Report output

Overview of report output

Introduction 
In Runtime, report output is event-driven or time-driven.  

You can also display the pending print jobs as a list in Runtime. Operators can use this print 
job list to decide which report they want to output.

Event-driven output   
The report is output after an event was generated.

Examples:

● A tag value changes or exceeds a limit.

● Alarm is incoming, outgoing or acknowledged

● Action by the operator, for example, clicking a button

Time-driven output   
The report is output automatically.

Examples:

● Once at a specified date, e.g. on December 31, 2010 at 6:30 AM

● At intervals, e.g. daily at 8 am, or on Mondays at 6 pm
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Configuration steps 
The configuration of a time-driven or event-driven report output differs depending on the 
Runtime version. 

To display the print job list in Runtime, configure the "Application window" control in screens. 
The application window shows all or only select print jobs, depending on the configuration. 

See also
Planning tasks (Page 2043)

Create a print job (Page 1633)

Configuring automatic start of a print job in the scheduled tasks (Page 1636)

System reports and system print jobs (Page 1637)

Print job/Script diagnostics (Page 837)

Report output in Runtime Professional (Page 1632)

Report output in Runtime Advanced (Page 1631)

Report output in Runtime Advanced

Introduction   
In Runtime Advanced, report output is event-driven or time-driven. 

Configuration steps  
Configuring event-driven output:

● An event is configured on a button or tag with the "PrintReport" system function.

Configuring time-driven output:

● In the scheduled tasks, configure a "Print job" task and assign it the desired report.
In the task properties, specify the time and frequency of report output.

Output in Runtime
On the control panel of the HMI device, the report is output to the printer that is specified as 
the default printer. 

The default printer enabled for a HMI device can be found in the "Printer list". For further 
information about the "Printer list", refer to the Internet page of Siemens Customer Support 
and the Article ID "11376409".

See also
Configuring reporting of alarms (Page 1340)

Overview of report output (Page 1630)
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Report output in Runtime Professional

Principles for report output

Introduction
In Runtime Professional, report output is event-driven or time-driven.  

Configuration steps  
● Under Reports, create a print job and assign it the desired report.

In the print job properties, specify the number of pages, the time range, and the output 
format (printer or file) of the report.

● To configure a time-driven output, create a task of the type "Print job" in the scheduled 
tasks and assign the desired print job to this task.
In the task properties, specify the time and frequency of report output.

● To configure an event-driven output, configure an event to the selected object to run a C 
Script for calling the "ReportJob" function, e.g.

– ReportJob("<Name of print job>","PRINTJOB");  to output the print job

– ReportJob("<Name of print job>","PREVIEW");  to output a print preview
 

 Note
Screen objects with preconfigured report output

Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. You can choose to modify the default system reports, or use a report 
with individual design.

 

Output in Runtime
The report is written as follows depending on the configuration:

● On the printer that is specified as the default printer in the control panel of the HMI device.
The default printer enabled for a HMI device can be found in the "Printer list". For additional 
information about the "Printer list", refer to the Internet page of Siemens Service & Support 
and the Article ID "11376409".

● On a network printer that is available for the HMI device.

● In a file in EMF format.
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See also
Reports (Page 1602)

Create a print job (Page 1633)

Configuring automatic start of a print job in the scheduled tasks (Page 1636)

Overview of objects (Page 657)

System reports and system print jobs (Page 1637)

Local scripts (Page 1782)

Create a print job

Introduction 
You define the following in the print job:

● Scope of the print job: all pages, or specific pages only

● Time period during which report entries are output

● Printer on which the report is printed

● File to which the report is saved

Requirement
The "Print jobs" editor is open.

Procedure   
Proceed as follows to create a new print job:

1. In the "Name" column, double-click in the "<Add>" cell.
A new print job is inserted.

2. In the "Properties > Properties > General" dialog of the Inspector window, enter a "Name" 
for the print job and select the "Report".
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3. Under "Dialog type", specify whether the operator is allowed to modify the report settings 
prior to output.

4. Under "Properties > Properties > Page range", specify whether the print job outputs all or 
only specific pages.

5. Under "Properties > Properties > Time range", specify the time period for the output of 
report entries.

6. If you want to print the report, enable the "Printer" option under "Properties > Properties > 
Output > Print output".
The report is output to the default printer of the HMI device. 
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7. You can select up to three printers if you want to output the report to a different printer.

8. If you want to output the report to a file, activate under "Properties > Properties > Destination 
file > Print to file > Print to file (*.emf)" and specify the folder to which the file is saved.

Result
The print job is created for the report.

● For time-driven output in Runtime, create a "Print job" task in the scheduled tasks. Assign 
the required print job to this task.

● For event-driven output, assign the object an event that runs a C script for calling the 
"PrintJob" function. 

See also
Principles for report output (Page 1632)

Configuring automatic start of a print job in the scheduled tasks (Page 1636)

Print job/Script diagnostics (Page 837)
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Configuring automatic start of a print job in the scheduled tasks

Introduction
A task of the "print job" type specifies the time and frequency of automatic report output (time-
driven output).

Requirements
● A print job has been created.

Procedure    
To create a task for automatic start of a print job, follow these steps:

1. In the "Runtime settings" of the HMI device activate "Services > Start sequence of WinCC 
Runtime  > Scheduled print jobs in Runtime". 

2. Create a new task in the scheduled tasks.

3. Enter a "Name" for the task under "Properties > Properties > General".

4. Select the "Print job" setting in the "Type" field.

5. Select the required "print job".

6. Under "Start time", specify the time and frequency of report output, for example, daily at 5 
PM:

Result
The task for time-driven report output was created successfully. 

See also
Principles for report output (Page 1632)

Create a print job (Page 1633)

Printing reports (Page 1654)
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System reports and system print jobs

Basics for system traces and system print jobs

System reports and system print jobs for the print function of screen objects
Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. 

The "Print" button of the screen object is linked to a preconfigured system print job. The system 
print job, in turn, outputs a preconfigured system report. 

System reports output a "snapshot", or "all data" of the screen object.

● Snapshot: The report outputs the data currently displayed in the screen object.

● All data: The report outputs all data content of the screen object.

The following table identifies the preconfigured system reports and system print jobs for the 
screen objects. 

Screen object Default Print scope System print job System reports
f(t) trend view X Snapshot Function Trend Control - 

Picture
@Function Trend Control - Picture

f(x) trend view X Snapshot Online Trend Control - 
Picture

@Online Trend Control - Picture

Table view  Snapshot Online Table Control – 
Picture

@Online Table Control – Picture

X All data Online Table Control - Table @Online Table Control - Table
Alarm view  Snapshot Alarm Control – Picture @Alarm Control – Picture

X All data Alarm Control - Table @Alarm Control - Table
Recipe view  Snapshot Recipe Control - Picture @Recipe Control - Picture

X All data Recipe Control - Table @Recipe Control - Table
Value table  Snapshot Ruler Control - Picture @Ruler Control - Picture

X All data Ruler Control - Table @Ruler Control - Table

Usually, there is no need to configure the report output.  Customize the system print job or 
system report to suit your requirements: You can also choose to assign a screen object a 
different, preconfigured system print job, or a print job you created for the output of a report 
with individual design.

System print reports and system print job for alarm sequence reports
The output of an alarm sequence report is configured in a system print job.   If you have 
activated "Properties > Properties > General > Use line report", WinCC uses the alarm 
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sequence report with line layout. If you have not activated this option, WinCC uses the alarm 
sequence report with page layout.

Layout System print job System report
Page layout Alarm sequence report @AlarmSequenceReportForPagePrint

er
Line layout Alarm sequence report @AlarmSequenceReportForLinePrinter

See also
Continuous alarm reporting (Page 1622)

Principles for report output (Page 1632)

Changing system reports and system print jobs

Displaying system reports and system print jobs in the project navigation   
The system reports and system print jobs are stored in the project template and not displayed 
automatically in the project navigation. If you want to modify a system report or system print 
job, display these in the project navigation. 

To do this, follow these steps:

● In the project navigation select the command "Add system report" in the shortcut menu of 
the "Reports" folder.

The project navigation also shows the system reports under "Reports". 

The list of "Print jobs" was extended to include system print jobs.
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Changing system print jobs and system reports 
You can modify system print jobs and system reports similar to "normal" print jobs and report, 
however, with the following restrictions: 

● For system print jobs, you cannot rename the report or change its default assignment.

● You cannot add detail pages to system reports.

Validity of changes
In the project, any modification to system reports and system print jobs affect all objects 
assigned the system report or system print job. 

 

 Note
Cancel changes

To restore the preconfigured status of WinCC, for example, after the control for output of data 
was accidentally deleted in the report, first delete the system report or the system print job 
and then select the "Add system reports" command in the shortcut menu of the "Reports" 
folder in the project tree. 

 

Deleting unnecessary system reports and system print jobs   
To only show reports and print jobs used in the project (e. g. after migration), you can delete 
the system reports and system print jobs using the shortcut menu. 

If the deleted report or the deleted print job is used in the project, the system report and the 
system print job preconfigured in WinCC are used.

To display all system reports and system print jobs once again, select the command "Add 
system reports" in the shortcut menu of the "Reports" folder in the project tree.
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● Any deleted system reports and system print jobs will be shown once again. The 
preconfigured WinCC status is restored. The status at the time of deletion is not 
reconstructed.

● All other system reports and system print jobs remain the same.

See also
Basics for system traces and system print jobs (Page 1637)

Creating an individual layout for the report output of a screen object

Introduction
If you do not want to use the default system print job (including the system report) that is linked 
to the screen object for report output, assign this screen object a different system print job, or 
a report with individual layout.

Using a different system print job 
Proceed as follows to assign a different system print job to the screen object:

1. Select the screen object.

2. Select the system print job under "Properties > Properties > General > Print".

Using a report with individual layout
Proceed as follows to use a report with individual layout:

1. Create the report.

2. Define the content of the detail page.

– To output a snapshot of the data currently displayed in the screen object, insert the 
"Control Hardcopy" report object.

– To output all report data in table form that are currently contained in the screen object, 
insert the "Control Data" report object.

– To include the data source in the report, e.g. window title, name of the object or screen, 
insert the "Control Screen" report object.

3. Create a print job and assign it to the report.

4. Select the screen object and then select the print job under "Properties > Properties > 
General > Print". 
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9.6.2.3 Working with objects

Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
 

Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 

Alternatively, double-click the object in the "Toolbox" task card.

Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.
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Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
 

 

 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.

 

 

See also
Storing an object in a library (Page 781)

Inserting a library object (Page 782)

Deleting an object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.
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Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 

Inserting several objects of the same type

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.

Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.

4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.
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Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.

3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

Positioning objects

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   

 

 Note

If the position is outside the work area the object is not displayed in Runtime.
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Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.

3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 
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Moving an object forward or backward (Basic, Advanced, Professional)

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
 

Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.

3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.

Result
The object is moved up or down. 
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Resizing objects

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.

Procedure   
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
 

  Note

In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

 

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".

Result
The object now appears with its new size. 

Visualizing processes (Professional)
9.6 Working with reports

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1647



Selecting multiple objects

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 

You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.

Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:

● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.

Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.
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Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:

1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.

 

Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size

● Moving all the objects in one group

● Aligning the objects to the reference object

Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects
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Aligning objects

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush   
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.

Distributing objects evenly   
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal."
The selected objects are distributed at equal distances.

The following screen shows how you align the vertical spacing of the selected objects:

Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 
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Harmonizing the object size   
1. Select the objects.

2. Now, click one of the following buttons:  or  or 
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:

Icon Description
Aligns the selected objects to the width of the reference object.
Aligns the selected objects to the height of the reference object.
Aligns the selected objects to the width and height of the reference object.

Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.

 

You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:
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Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 
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Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

9.6.2.4 Operation in Runtime

Printing reports

Printing a report in Runtime
If you have configured an object with the "PrintReport" system function, the operator can print 
out a report in Runtime. To do this, the operator uses the "Print report" button on a screen. 
The operator can set or change further settings for the report. The report is output to the default 
printer. 
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Printing reports

Starting the report printout in Runtime by the operator  
The operator starts printing of a report by using the "Print" button in the following screen objects 
in Runtime:

● f(x) trend view

● f(t) trend view

● Table view

● Alarm view

● Recipe view

If you have specified in the print job that a dialog is displayed for the selection of a printer or 
to specify properties, the operator changes these settings in Runtime.

If you have configured a button and linked it to an appropriate script, the operator can start the 
report printout using this button.

Automatic start of the report printout
The report printout is started automatically in Runtime in the following situations:

● You have linked a print job with a "Print job" type task.

● You have linked a global script for the report printout with a task.

● Under "Services" in the runtime settings of the HMI device, select the item "Scheduled print 
jobs in Runtime". 

Application window
All or selected print jobs are shown in the application window depending on the configuration 
when they are queued in Runtime. Depending on the configuration the operator can start the 
report printout, specify the print options and display a print preview in the application window. 

See also
Principles for report output (Page 1632)

Print job/Script diagnostics (Page 837)

Basics for system traces and system print jobs (Page 1637)
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9.6.3 Objects in reports

9.6.3.1 Audit report

Application
With the audit report, the content of the audit trail of a HMI device is output as a report. 

Requirements
The "audit report" object is available only if the following requirements are met:

● The HMI device supports a GMP-compliant configuration.

● GMP-compliant configuration is active in the Runtime settings of the HMI device.

Note that operator actions and system operations are only recorded if a corresponding log is 
configured. 

Layout
In the Inspector window the position, shape, style, color and font types of the object are 
customized. In particular, the following can be adjusted:

● Visibility of the comment

See also
Enabling GMP compliant configuration (Page 2416)

Audit Trail (Page 2418)

Creating an audit trail (Page 2419)

Logging the audit trail (Page 2427)

Reporting an audit trail (Page 2427)

Audit Trail reporting (Page 2428)

Parameters for the audit trail report (Page 2430)

Printing out an audit trail report (Page 2432)
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9.6.3.2 Control Data

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object. 

The "Control Data" report object outputs all data contained in the screen object in table form 
– including those data that are currently invisible in the screen object in Runtime.

Layout   
Customize the frame and color settings in the Inspector window. You can adapt the following 
properties in particular:

● Control type whose content is output

● Control objects of the screen object to include in the visualization

● Position & size

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output. 

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".

Control objects of the screen object
In the Inspector window, select "Properties > Properties > General > Content" to specify 
whether to include the toolbar, the status bar and the scroll bar in the screen object.

Size & position
In the Inspector window, select "Properties > Properties > Layout" to specify the size and 
position of the report object.

The table is output in the report in accordance with the width of the report object. Therefore, 
configure a report object with suitable width. 
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See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.3 Control hard copy

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object. 

The "Control Hardcopy" object output a snapshot of the screen object. Only the data that is 
visible in the screen object in Runtime is output.

Layout   
Customize the frame and color settings in the Inspector window. 

You can adapt the following properties in particular:

● Control type whose content is output

● Specifies the control objects of the screen objects to include in the visualization.

● Size & position

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output. 

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".

Control objects of the screen object
In the Inspector window, select "Properties > Properties > Content" to specify whether to 
include the toolbar, the status bar and the scroll bar in the screen object.
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Size & position
In the Inspector window, select "Properties > Properties > Layout" to specify the size and 
position of the report object.

In the report, the screen object is resized to fit the frame of the report object. Therefore, 
configure a report object of a suitable size. 

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.4 Control Information

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object.

The "Control Information" report object outputs the window title, the screen object name or the 
screen name. This way you include, for example, the data source in the report. 

Layout   
Customize the frame, color, font, and font size settings in the Inspector window. You can adapt 
the following properties in particular:

● Control type whose content is output

● Content

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output.

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".
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Content
In the Inspector window, select "Properties > Properties > General > Content" to specify the 
information to output with the report object:

● Window title

● Object name

● Screen name

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.5 CSV provider trends

Application   
The "CSV provider trends" object outputs data from a file in the format "*.csv" as trends in the 
report. 

Page breaks are inserted automatically in the report depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Data source

Data source
Specify the data source under "Properties > Properties > General > Provider". You can select 
a CSV file, or configure an internal tag for dynamic selection of the CSV file. This means that 
the data output is changed directly at the HMI device. The tag must be of data type "String" or 
"WString".

 

 Note

For their visualization in trends, the data in the CSV file must have a defined structure. 
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See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.6 CSV provider tables

Application   
The "CSV provider tables" object outputs data from a CSV file in tabular format in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted automatically.

Layout
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Data source

● Applying fonts from the data source 

Data source 
Specify the data source under "Properties > Properties > General > Provider". You can select 
a CSV file, or configure an internal tag for dynamic selection of the CSV file. This means that 
the data output is changed directly at the HMI device. The tag must be of data type "String" or 
"WString".

 

 Note

To enable output in a table, the data in the CSV file must have a defined structure.
 

Applying fonts from the data source 
Under "Properties > Properties > General > Font", specify whether to apply the font and font 
size from the CSV file for the report output. 

If you deactivate the "Font from data source" and "Font size from data source" options, the 
settings you specified under "Format Text > Style" are used. 
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See also
CSV file for output of a table (Page 1626)

Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.7 Date/time field

Application   
The "Date/time field" object shows the system time of the HMI device or the date and / or time 
of a connected tag. The layout depends on the language setting on the HMI device.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. In the "Properties > Properties > General" dialog, you can adapt the following properties 
in particular:

● Long date/time format: This setting defines the format displayed for the data and / or time.

● System time: Specifies whether to use the system time of the HMI device, or the data and / 
or time of a connected tag.

Long date/time format 

Option Description
"Enabled" Date and / or time is fully displayed, for example "Sunday, December 31, 2000 

10:59:59 AM"
"Disabled" Date and / or time is displayed in abbreviated form, e.g. "12/31/2000 10:59:59 

AM"

System time 

Option Description
"Enabled" The system time of the HMI device is displayed
"Disabled" The date and / or time of the connected tag is displayed

Select a tag of the "DateTime" data type, e.g. an internal tag. Information about 
data types which are available for connection to other PLCs can be found in 
the documentation about the respective communication drivers.
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See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.8 Date/time field

Application   
The "Date/time field" object outputs the date and / or time in an individually configured format 
in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Display format of date and / or time

Display format of date and time
Specify the date and / or time format under "Properties > Properties > General > Format". You 
can combine wildcards and any text.

The following table shows which wildcards you can use:

Wildcards Implementation Example
%a Weekday abbreviated Sun
%A Weekday in full form Sunday
%b Month abbreviated Dec
%B Month in full form December
%c Date and time in standard format 12/31/2000 10:59:59 AM
%d Day as decimal value (01 to 31) 31
%H Hours in 24 hour format (00 to 23) 22
%I Hours in 12 hour format (01 to 12) 10
%j Day of the year as decimal value (000 of 366) 366
%m Month as decimal value (01 to 12) 12
%M Minute as decimal value (00 to 59) 59
%p PM/AM notation for the 12 hour format AM
%S Second as decimal value (00 to 59) 59
%U Week of year as decimal value (01 to 51) 50
%x Date in standard format 12/31/2000
%X Time in standard format 10:59 AM
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Wildcards Implementation Example
%y Year without century as decimal value (00 

to 99)
00

%Y Year with century as decimal value 2000
%z Time zone as name W. European Standard Time
%% Percent character %

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Date: %x time: %H:%M Date: 12/31/2000 time: 22:59
Printout of %a %c Printout of Sun 12/06/2010 10:59:59 AM

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.9 I/O field

Application   
The "I/O field" object is used to enter process values.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Display format: Specifies the format in which the values in the I/O field are output.
 

  Note

The "I/O field" object is also available in "Screens" editor. In reports, the object only outputs 
data. Accordingly only configure the output of data for application in reports.

 

Display format  
The "display format" for the output of values is specified in "Properties > Properties > General 
> Format", in the Inspector window.

Layout  
"Binary" Output of values in binary form
"Date" * Output of date specifications. The format depends on the language setting on the 

HMI device.
"Date/time" * Output of date and time specifications. The format depends on the language 

setting on the HMI device.
"Decimal" * Output of values in decimal form.
"Hexadecimal" Output of values in hexadecimal form.
"Time" * Output of time specifications. The format depends on the language setting on the 

HMI device.
"Character string" Output of strings.
*: not in Runtime Professional

Avoid overlaps with output fields 
If several I/O fields are configured as output fields with a transparent background in a report, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in the report. In order to avoid such overlaps, set the 
margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

Visualizing processes (Professional)
9.6 Working with reports

WinCC Professional V11.0 SP1
1664 System Manual, 08/2011,  



9.6.3.10 f(t) trend view in reports

Application   
You use the "f(t) trend view" object to visualize logging tag values in the form of trends as a 
function of time. The report displays the status that the trend profile had at the time of the start 
of the print job. 

 

 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
In contrast to the configuration in the screen, you can dynamize the properties of each trend 
with tags, for example, the display and the data supply. This way you can, for example, use a 
report several times. 

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.11 f(x) trend view in reports

Application   
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. The report displays the status that the trend profile had at the time of the start of the 
print job. 
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You can also compare the trend to a setpoint trend. 

 

 Note
Reduced functional scope for the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
In contrast to the configuration in the screen, you can dynamize the properties of each trend 
with tags, for example, the display and the data supply. This way you can, for example, use a 
report several times. 

See also
f(x) trend view (Page 851)

Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.12 Graphic view

application  
The "Graphic view" object is used to display graphics.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic you want to add in the drop-down list under "Graphic".
The graphic preview is shown in the right pane.

3. Click "Assign" to insert the graphic in the Graphic view .

Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select one of the following options from the "Fit to size" area:

– Fit object size to content

– Fit content to object size
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9.6.3.13 Graphic I/O field

Application   
With the "Graphic I/O field" object, the graphics of a graphics list are displayed, depending on 
the tag value. In the Inspector window, the tag and graphics list are configured, under 
"Properties > Properties > General":

 

 Note

The "Graphic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports.

 

Layout  
Customize settings for color, frame, position and object size in the inspector window. In 
particular, the "Fit to size" is defined by specifying whether the object is adjusted to the graphics 
during output in the report or the graphic is adjusted in the object. 

See also
Create a report  (Page 1616)

9.6.3.14 Hardcopy

Application
Use the "Hardcopy" object to output a snapshot of the screen content in the report. 
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Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Specifying the range

Specifying the range
Under "Properties > Properties > Range", specify the screen content to output in the report: 

● "Current window (1)": Active window

● "Selected section (2)": Selected section

● "Entire screen (0)": Complete content

You can assign a tag of the "Number" type for dynamic range selection. The settings are made 
as follows:

● 0 = "Entire screen"

● 1 = "Current window"

● 2 = "Selected section"

Specify the following properties for a "Selected section (0)":

● X position of the upper left point of the area

● Y position of the upper left point of the area

● Width in pixels

● Height in pixels

You can assign a dynamic tag to each property. 

See also
Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.15 Alarm view in reports

Application   
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 

The report displays the status that the alarm view had at the time of the start of the print job. 
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 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor. 

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

 

See also
Alarm view (Page 887)

Report design tools (Page 1618)

Continuous alarm reporting (Page 1622)

Create a report  (Page 1616)

9.6.3.16 Alarm sequence report

Application   
The "Alarm sequence report" object outputs all alarms from the HMI device as of the start of 
Runtime continuously in chronological order. It is only used in the 
"@AlarmSequenceReportForPage" system report that specified the output of the WinCC alarm 
sequence report in page layout. 

You specify which alarms are output in the object properties. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 
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See also
Report design tools (Page 1618)

Continuous alarm reporting (Page 1622)

Create a report  (Page 1616)

9.6.3.17 Alarm report

Application   
Use the "Alarm report" object to output alarms of the selected alarm classes from the alarm 
buffer or alarm log to the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Source

● Alarm classes

● Time range

● Additional settings for the display

● Visible columns
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Specifying the source
Under "Properties > Properties > General > Settings > Source", specify whether to display 
alarms from the alarm buffer, or from the alarm log. Select the alarm log in the "Alarm log" 
dialog.

Specifying alarm classes
Under "Properties > Properties > General > Alarm classes, enable the alarm classes for the 
alarms output to the report. 

Specifying the time range
If you want to restrict alarm output to a specific time range, select the start and end tags for 
the time range in the "Properties > Properties > General > Time range" dialog. The tag must 
be of the "DateTime" type.

Additional settings for the display
Under "Properties > Properties > General > Settings, specify the following settings for the 
display in the alarm report:  

● Under "Sorting", specify whether to start the display with the oldest or most recent alarm.

● Under "Lines per entry", specify the number of lines to be available for each alarm. The 
required number of lines depends on the following factors:

– Number and width of the selected columns for the output

– Font size used

– Paper format of the printer

● Select "Visible heading" to enable the display of column headers.

● Select "Display milliseconds" to enable the display of milliseconds for time data.

Visible columns
Under ""Properties > Properties > Layout > Visible columns", enable the columns to be 
displayed in the alarm report. 

See also
Configuring reporting of alarms (Page 1340)

Create a report  (Page 1616)
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9.6.3.18 ODBC database field

Application   
Using the "ODBC database field" object, you can output data from a single table row in the 
report via the ODBC interface. The ODBC interface is used for the consistent output of data 
that does not originate from WinCC in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Settings for the SQL connection

● Data selection for the SQL statement

Connection settings
Under "Properties > Properties > SQL connection", specify the data source, user name, and 
password for the SQL connection. You can assign dynamic tag to all settings. This means that 
the data output is changed directly at the HMI device.

Data selection
Under "Properties > Properties > SQL statement", specify the data area to visualize in the 
report. Enter "Select-Statement".

Enter the required "Select-Statement" in the text field of the same name or select the "Tag" 
that supplies the Select-Statement. The tag must be of the "String" or "WString" type.

You can dynamize the Select-Statement in the input field of the same name with tags. To do 
so you select "Insert reportfield" at the required text passage in the shortcut menu and then 
select the required tag.

 

 NOTICE

Enter only "Select-Statements".
 

See also
Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.19 ODBC database table

Application   
Using the "ODBC database table" object, you can output data from a table in the report via the 
ODBC interface. The ODBC interface is used for the consistent output of data that does not 
originate from WinCC in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Settings for the SQL connection

● Data selection for the SQL statement

● Table layout, e.g. number of columns and circular list

Connection settings
Under "Properties > Properties > SQL connection", specify the data source, user name, and 
password for the SQL connection. You can assign dynamic tag to all settings. This means that 
the data output is changed directly at the HMI device.

Data selection
Under "Properties > Properties > SQL statement", specify the data area to visualize in the 
report. 

Enter the required "Select-Statement" in the text field of the same name or select the "Tag" 
that supplies the Select-Statement. The tag must be of the "String" or "WString" type.

You can dynamize the Select-Statement in the input field of the same name with tags. To do 
so you select "Insert reportfield" at the required text passage in the shortcut menu and then 
select the required tag.

 

 NOTICE

Enter only "Select-Statements".
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Circular list
In the Inspector window, use the "Circular list" option under "Properties > Properties > Table" 
to specify the the way the data is distributed to the table columns. 

● "Circular list" disabled
The table rows are filled in descending order. 
A value is output in the first column of a row. The other columns will stay empty.

● "Circular list" is enabled
The table rows are filled in descending order. 
All columns of a row are filled left to right.

 

  Note

This option is only effective if the data are supplied in one column and if the configured 
table has several columns.

 

Example:
● You configure a table with three columns.

● At the time of report output, the screen object contains the following data: A1, A2, A3, B1, 
B2, B3, C1, C3, D4

The following table shows the result with deactivated "Circular list" option:

Column 1 Column 2 Column 3
A1   
A2   
A3   
B1   
B2   
...   

The following table shows the result with activated "Circular list" option:

Column 1 Column 2 Column 3
A1 A2 A3
B1 B2 B3
C1 C3 D4

See also
Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.20 Project name

Application   
Use the "Project name" object to output the name of the current project in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Format of the project name

Format of the project name
In the "Format" field under "Properties > Text format > Style", specify the output format for the 
project name. You can use a placeholder for the project name and enter any text, if necessary.

The following table shows which wildcards you can use:

Wildcards Value
"%R" Path and project name
"%r" Project name (without path information)

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Project: %R Project: D:\WinCC\Projects\MP277_Mixing
Created for project "%r" Created for project "MP277_Mixing"

See also
Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.21 Report name

Application   
Use the "Report name" object to output the report name in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Format of the report name

Format of the report name
In the "Format" field under "Properties > Text format > Style", specify the output format for the 
report name. You can use a placeholder for the report name and enter any text, if necessary.

The following table shows which wildcards you can use:

Wildcards Value
"%L" or "%l" Report name

Example
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Report: %L Report: Alarms

See also
Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.22 Recipe view in reports

Application   
Use the "Recipe view" object to display recipe elements in tabular format. The report displays 
the status that the recipe view had at the time of the start of the print job. 

 

 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime. 

 

See also
Report design tools (Page 1618)

Definition and applications (Page 1538)

Create a report  (Page 1616)

Visualizing processes (Professional)
9.6 Working with reports

WinCC Professional V11.0 SP1
1678 System Manual, 08/2011,  



9.6.3.23 Recipe report

application   
Use the "Recipe report" object to output the elements of recipe data records in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Recipe

● Data record

● Format

● Visible entries

Selecting a recipe
Specify the recipes to be output in the recipe report under "Properties > Properties > General 
> Recipe". You can define the recipes based on their recipe name, or on a range of recipe 
numbers. Under "First recipe" and "Last recipe", enter a value or select a tag.

You can also choose to display all recipes.

Selecting a data record
Under "Properties > Properties > General > Data record", specify which data records of the 
selected recipes are to be output in the recipe report. You can define the data records based 
on the data record name, or on a range of data record numbers. Under "First recipe" and "Last 
recipe", enter a value or select a tag.

You can also choose to display all data records of the selected recipes.
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Format
In the "Format" field of the "Properties > Properties > Layout > Settings" dialog, specify whether 
to output the data records as a table in column format or line report format.

WinCC updates the preview in the detail page accordingly.

Visible entries
Under ""Properties > Properties > Layout > Visible entries", enable the columns to be displayed 
in the recipe report. Select "Show headings" to enable the display of column headers. 

See also
Definition and applications (Page 1538)

Create a report  (Page 1616)

9.6.3.24 Page number

application   
Use the "Page number" object to output the current page number in the report.

Layout    
In the inspector window, change the settings for color, font, position and object size. In 
particular, specify "Size adaptation":

Fit to size
Under "Properties > Properties > Layout > Fit to size", the "Fit object to content" option is used 
to specify whether WinCC adjusts to the object size of the field content:

● Enabled "Fit object to contents" option:
WinCC automatically adjusts the size of the object to the configured format. The font size 
and field length are defined under "Properties > Properties > General > Text". 
The object can be moved in the working area, however, the size cannot be changed. During 
report output, the entire field content is output at the time of report output.

● Disabled "Fit object to contents" option:
Customize the field size by yourself. WinCC does not resize the field for report output. It 
can be possible that not all content of the field is output in the report. Therefore, configure 
a field of sufficient size. 

See also
Create a report  (Page 1616)
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9.6.3.25 Page number

Application   
The "Page number" object outputs the current page number or the total number of pages in 
the report in the header or footer of the report.

Layout    
In the Inspector window, change the settings for color, font, frame, alignment as well as position 
and object size. In particular you set the format of the page number.

Format 
Under "Properties > General > Text > Format", specify the format of the page numbers to be 
displayed. You can use a wildcard for the page numbers and enter a user-specific text.

The following table shows which wildcards you can use:

Wildcards Value
"%N", or "%n" Current page number
"%T", or "%t" Total number of pages in the report

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Page %n of %t Page 2 of 10
%n/%t 2/10

See also
Report design tools (Page 1618)

Create a report  (Page 1616)
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9.6.3.26 Symbolic I/O field

application   
With the "Symbolic I/O field" object, the content of a text list in reports is displayed, depending 
on the tag value. In the inspector window, the tag and text list is configured under "Properties 
> Properties > General":

Layout  
In the inspector window, change the settings for color, frame, font, position and object size. In 
particular, the "Fit to size" is defined, by specifying whether the object size is adjusted to the 
text during output in the report or not.

 

 Note

The "Symbolic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports. 

 

See also
Create a report  (Page 1616)

9.6.3.27 Table view in reports

Application   
You use the "Table view" object to display the process data in a table. Each row of the table 
represents the status of the selected process tags at a specific time.

The report displays the status that the table had at the time of the start of the print job. 
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 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
By contrast to the configuration in the screen, you can assign tags with dynamic properties for 
the time and value columns. This way you can, for example, use a report several times. 

See also
Table view (Page 933)

Report design tools (Page 1618)

Create a report  (Page 1616)

9.6.3.28 Text field

Application 
The "Text field" is a closed object which you can fill with a color. 

Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.
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Text 
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field 
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Auto-size".

Otherwise you can set the size manually. Deactivate "Auto-size". Press the mouse button and 
drag the text field to the required size.

9.7 Configuring user administration

9.7.1 Field of application of the user administration

Principle
The access protection controls access to data and functions in Runtime. This feature protects 
your applications against unauthorized operation. Safety-related operations are already limited 
to specific user groups when a project is being created. To this purpose you set up users and 
user groups that you equip with characteristic access rights, so-called authorizations. You then 
configure the authorizations required for operation of safety-related objects. Operators only 
have access, for example, to specific operator controls. Commissioners, for example, have 
unlimited access in Runtime. 

Definition
You administer users, user groups and authorizations centrally in the user administration of 
WinCC. You transfer users and user groups together with the project to the HMI device. The 
users and passwords are managed on the HMI device in the User view. 
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Application example
You configure the "Service" authorization so that only service technicians have access to the 
configuration parameters. You assign the authorization to the "Service technician" user group. 
This allows all members of this group to set the protected configuration parameters.

 

 CAUTION

Access protection does not protect against incorrect operations. It is your job to ensure that 
only authorized personnel with appropriate training will design, commission, operate and 
maintain plants and machines. 

Access protection is not suitable for defining work routines and monitoring their observance. 
 

9.7.2 Form of the user administration

Introduction
In case of a project in manufacturing engineering, the environment at the equipment 
manufacturer has to be differentiated from the environment at the end customer as plant 
operator. 

The equipment manufacturer allows users, for example Mr. Foreman, a specific access within 
the application or HMI device. However, a user Foreman does not exist at the end customer. 
The machine manufacturer cannot know the end users and the tasks they have to perform for 
configuration. The final users are usually set after commissioning at the end customer.
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Principle
To minimize the work required for management, authorizations are assigned via user groups 
and not directly to individual users.

A user group assembles configured authorizations according to common jobs. For example, 
all permissions required for a service job are collected in a "Service technician" group. When 
you create a user who should be responsible for servicing, you simply assign him to the 
"Service technician" group.

The user view enables user administration in Runtime. Use user view to create, delete and 
assign an authorization to users in Runtime.

The user administration separates the administration of the users from the configuration of the 
authorizations. This ensures flexibility at the access protection. 

Defaults can be set for the user administration during the configuration phase in the 
Engineering System. 

9.7.3 Basics

9.7.3.1 User

Introduction
You can create users in the "Users" tab of the "User administration" editor and assign them to 
user groups. The "Users" tab is part of the user administration in WinCC. 

Open
To open the "Users" tab, double-click "User administration" in the project window.

Work area
The users are managed in the work area:

● You create or delete users.

● You assign users to user groups.
 

  Note

You can assign a user to exactly one user group.
 

Inspector window
When you select a user, you can change the password in the "General" group. Under 
"Automatic logoff" you can specify if the user is to be automatically logged off by the HMI device 
when there is no operator activity after the specified time. 

Visualizing processes (Professional)
9.7 Configuring user administration

WinCC Professional V11.0 SP1
1686 System Manual, 08/2011,  



See also
Settings for the user administration (Page 1691)

9.7.3.2 Users work area

Introduction
The "Users" work area lists the users and user groups in table form. You administrate the users 
and assign them to a user group. 

Principle
The work area consists of the "Users" and "Groups" tables.

The "Users" table shows the existing users. When you select a user in this table, the "Groups" 
table shows the user group to which the user belongs. 

See also
Settings for the user administration (Page 1691)

User groups (Page 1688)

User groups work area (Page 1688)

Settings for the user administration (Page 1689)

Settings for the user administration (Page 1694)
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9.7.3.3 User groups

Introduction
You can create users and authorizations in the "User groups" tab of the "User Administration" 
editor. The "User groups" tab is part of the user administration in WinCC.

Open
Double-click the "User administration" in the project window. Open the "User groups" tab.

Work area
The user groups and authorizations are managed in the work area:

● You create new user groups and authorizations or delete them.

● You assign the authorizations to the user groups.

Inspector window
When a user group or an authorization is selected, you can edit the name in the "General" 
group. You can also enter a brief description in the "Comment" group.

See also
Settings for the user administration (Page 1691)

Users work area (Page 1687)

User groups work area (Page 1688)

Settings for the user administration (Page 1689)

Settings for the user administration (Page 1694)

9.7.3.4 User groups work area

Introduction
The "User groups" work area shows a table of the groups and their authorizations. You 
administer the user groups and assign authorizations to them.
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Principle
The work area consists of the "Groups" and "Authorizations" tables.

The "Groups" table shows the existing user groups. When you select a user group in this table, 
the "Active" column of the "Authorizations" table shows the authorizations which were assigned 
to the user group.

The number of the user group and of the authorization is assigned by the user administration. 
The designations and descriptions are assigned by you.

The number of predefined authorizations are fixed. Authorizations that you create can be freely 
edited. Ensure that the assigned numbers are unique.

See also
Settings for the user administration (Page 1691)

Users work area (Page 1687)

User groups (Page 1688)

Settings for the user administration (Page 1689)

Settings for the user administration (Page 1694)

9.7.3.5 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.   

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration."
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Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 

Effects in runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "Runtime services" group

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters. 

See also
Settings for the user administration (Page 1691)

Users work area (Page 1687)

User groups (Page 1688)

User groups work area (Page 1688)

9.7.3.6 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.   

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration."
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Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 

Effects in runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "Runtime services" group

– "Change initial password" check box selected
The user must change the administrator-assigned password when logging on for the 
first time.

– "Change logoff time" checkbox selected
Simple user rights are sufficient for changing the logoff time. 
The logoff time is the period after which the user administration automatically logs off a 
user when no operator activity is detected in the system.
The logoff time for the SIMATIC Logon user corresponds to the logoff time of the default 
user, "Admin".
Any user changes of the logoff time are logged in the Audit Trail. 

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters.

● "External Runtime services" group

– "SIMATIC Logon" checkbox selected
A connection is established to the server. Authorization is performed via SIMATIC Logon.

– "Encrypted transfer" checkbox selected
The data is encrypted before it is transferred to the server. 

See also
Central user administration using SIMATIC Logon (Page 1705)

User (Page 1686)

Users work area (Page 1687)

User groups (Page 1688)

User groups work area (Page 1688)

Settings for the user administration (Page 1689)

Settings for the user administration (Page 1694)
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9.7.3.7 Settings for the user administration

Introduction
In the "Runtime settings > User administration", editor you specify whether users log on 
dynamically to an HMI device in runtime. You can also activate a central user administration 
by means of SIMATIC Logon.   

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration."

 

 Note

The view of the work area depends on the HMI device in use.
 

Work area
In the work area, you can specify how the operator logs on to the HMI device:

● Dynamic logon  
With dynamic logon, you assign a variable to each HMI device. A variable value is assigned 
to a user. The user then logs on in runtime by setting the variable value on an HMI device, 
for example, using a key switch.

● SIMATIC Logon
When you use SIMATIC Logon, you specify the display name that is shown on the HMI 
device. SIMATIC Logon supports centralized user administration. As soon as you select 
the "SIMATIC Logon" option, the users created in the "User administration" editor will be 
ignored. The "Users" work area is no longer displayed.
Only groups whose settings agree with the names of the Windows groups are important.

 

 
 NOTICE

If you use SIMATIC Logon , you cannot use the "Automatic Logon" option.
 

Effects in Runtime
With dynamic logon, the user is logged on to the HMI device as soon as the variable contains 
the correct value. 

When SIMATIC Logon is used, the operator logs on to the Windows operating system. The 
user settings, such as the password validity, are read by SIMATIC Logon from the user 
administration of the operating system. 
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See also
Settings for the user administration (Page 1691)

Users work area (Page 1687)

User groups (Page 1688)

User groups work area (Page 1688)

9.7.4 Setting up the user administration

9.7.4.1 Basics of user administration

Principle
This section addresses four target groups. The topics are organized correspondingly. The 
target groups serve as examples for different groups of persons who use the user 
administration. 

1. Administrator OEM

2. Administrator RT

3. Planners

4. Operator

As Administrator OEM you create the user groups, users and authorizations for Runtime in 
the Engineering System of, for example, an equipment manufacturer.

As Administrator RT you administer users in Runtime by means of the "User view."

As the project engineer you assign the authorizations to the user groups in the Engineering 
System. In addition, you configure the authorizations for objects. 

As Operator you log on in runtime. You can only access a protected object if you have the 
required authorization.

 

 Note

The Administrator RT target group already exists in the Runtime user administration as the 
predefined user group "Administrator group." For a better understanding the predefined user 
groups and authorizations are not used below. 
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9.7.4.2 Administering users for Runtime 

Creating an authorization

Introduction
You create an authorization and assign it to one or more user groups.  

Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Authorizations" table.

2. Enter "Archive data" as the name of the authorization.

3. Enter a brief description as the "Comment."

See also
Creating a user group (Page 1696)

Managing user groups (Page 1701)

Changing the number of the user group (Page 1703)

Creating a user group

Introduction
User groups are created so that you do not have to assign an authorization to every single 
user. You create a user group, assign authorizations and then assign users to it.  

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

 
 

 Note
Using SIMATIC Logon

Ensure that the names of the user groups in Windows and WinCC are identical.
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Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Groups" table.

2. Enter "Operators" as the "Name" of the user group.

3. Change the "Number" of the user group as required.

4. Enter "Display name" of the "Operators" user group.

5. Enter a brief description as the "Comment".

In runtime, the user view shows the display name of the user group. The display name of the 
user group depends on the language. You can specify the name in several languages and 
switch between languages in runtime. 

See also
Creating an authorization (Page 1696)

Creating a user group

Introduction
User groups are created so that you do not have to assign an authorization to every single 
user. You create a user group, assign authorizations and then assign users to it.   

 

 Note
Using SIMATIC Logon

Ensure that the names of the user groups in Windows and WinCC are identical.
 

 
 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
The "User groups" work area is open.
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Procedure
1. Double-click "Add" in the "Groups" table.

2. Enter "Operators" as the name of the user group.

3. Change the "Number" of the user group as required.

4. Enter a brief description as the "Comment."

Assigning an authorization

Introduction
When you allocate an authorization to a user group, all assigned users have this authorization. 

Requirements
● An "Archive data" authorization has been created.

● An "Operators" user group has been created.

● The "User groups" work area is open.

Procedure
1. Click on the "Operators" user group in the "Groups" table. The "Authorizations" table shows 

all authorizations.

2. Activate the "Archive data" authorization in the "Authorizations" table.
 

 
 NOTICE

The "Archive data" authorization is only a designation and does not having any relation 
to the function "Archiving." You have to establish this relation yourself. To do so, configure 
the "StartArchiving" system functions at a control button and select "Archive data" as the 
"Authorization."

 

Creating users

Introduction
You create a user so that users can log on with their user names in runtime after loading to 
the device.   

As an alternative, you can create and change users by means of the "User view" in Runtime.

In order for a created user to have authorizations you have to assign him to a user group and 
allocate authorizations to the user group.
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The logon is successful when the user name entered during the logon matches a user in 
Runtime. In addition, the entered password must agree with the stored password of the user. 

 

 Note

Note that the entry is case-sensitive.
 

Requirements
The "Users" work area is open.

Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Foreman" as the user name.
 

  Note

The user name must be unique within the project. Otherwise the input is not accepted.
 

3. Click the  button in the "Password" column. A dialog box for entering the password is 
displayed.

4. Enter the password of the user.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box by using the  icon.

7. If a user is to be logged off after a specific time period, activate "Automatic logoff".

8. Click in the "Logoff time" column. The preset value for "Logoff time" is 5 minutes.

9. Enter a brief description as the "Comment".

Assigning a user to a user group

Introduction
When you assign a user to a user group, the user has the authorizations of the user group. 

 

 Note

You have to assign a user to exactly one user group. The assignment is checked during the 
consistency check and generation of the project.
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Requirements
● The user "Foreman" has been created.

● An "Operators" user group has been created.

● The "Users" work area is open.

Procedure
1. Click on the "Foreman" user in the "Users" table. The "Groups" table shows all user groups.

2. Activate the "Operators" user group in the "Groups" table.

Managing users

Introduction
In the work area, you can administer users and assign them to user groups.   

Requirements
The "Users" work area is open.

Changing the user name
1. In the "Users" table, double-click the field in the "Name" column to change the user name.  

2. Change the user name.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the user name under "Properties > 
Properties > General" in the Inspector window.

Changing the password of the user
1. Click the  button in the "Password" column of the "Users" table. A dialog for entering the 

password opens.  

2. In the "Enter password" field, enter the new password.

3. Reenter the new password in the "Confirm password" field.

4. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the password under "Properties > 
Properties > General" in the Inspector window.

Visualizing processes (Professional)
9.7 Configuring user administration

WinCC Professional V11.0 SP1
1700 System Manual, 08/2011,  



Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Logoff time" column, 
for example.

Changing the logoff time of the user
1. In the "Users" area, double-click on the field in the "Logoff time" column to change the logoff 

time.

2. Change the logoff time.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the logoff time under "Properties > 
Properties > Automatic logoff" in the Inspector window.  

Deleting a user
1. Select the line of the user to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined users cannot be deleted. 
 

Managing user groups

Introduction
In the workplace you administer user groups and assign authorizations for use in runtime.     

Requirements
The "User groups" work area is open.

Changing the name of the user group
1. In the "Groups" table, double-click the field in the "Name" column to change the name of 

the user group.  

2. Change the name of the user group.

3. Confirm your entry with <Return>.
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Alternatively, select the user group in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.

 

 Note

Predefined user groups cannot be deleted.
 

Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Display name" column, 
for example.

Changing the displayed name of the user group
1. In the "Groups" table, double-click the field in the "Display name" column to change the 

display name of the user group.  

2. Change the displayed name of the user group.

3. Confirm your entry with <Return>.

Alternatively, select the user group in the work area. Change the display name under 
"Properties > Properties > General" in the Inspector window.

Deleting a user group
1. Mark the line of the user group to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined user groups cannot be deleted.
 

Changing the name of the authorization
1. In the "Authorizations" table, double-click the field in the "Name" column to change the 

name of the authorization.  

2. Change the name of the authorization.

3. Confirm your entry with <Return>.

Alternatively, select the authorization in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.
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Deleting authorizations
1. Mark the line of the authorization to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined authorizations cannot be deleted. 
 

See also
Creating an authorization (Page 1696)

Changing the number of the user group

Introduction
To assign group-specific rights, edit the number of a user group.

Requirements
● In the "Runtime settings> User administration" editor, "Group-specific rights for user 

administration" is selected.

● The "Operator" user group has been created.

● A "User administration" authorization has been assigned.

● The "User groups" work area is open.

Procedure
1. Click on the "Operator" user group in the "Groups" table.

2. Enter "6" in the "Number" column of the user group.

3. Enable the "User administration" authorization in the "Authorizations" table.

Result
The members of the "Operator" user group can only manage users whose group number is 
less than or equal to 6. 

See also
Creating an authorization (Page 1696)
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Logging on users dynamically

Introduction
Two configuration steps are required to allow "Dynamic logon":      

1. Assign an HMI device to a configured variable.

2. Assign a specific variable value to a user.
 

 
 NOTICE

If you have activated SIMATIC Logon, dynamic logon is not possible.
 

Requirements
● User administration exists.

● A "Login" variable of the "Byte" type is created.

Procedure
Assignment of the HMI device to the variable

1. Double-click "Runtime settings > User administration" in the project window.

2. Double-click "Add" in the "Dynamic logon" area of the table.

3. Click the  button in the "HMI device" column. A dialog box for selecting the HMI device 
opens.

4. Select an HMI device.

5. Click the  button in the "Variable" column. A dialog box for selecting the variable opens.

6. Select the "Login" variable.

Assignment of the user to the variable value

1. Open the "Users" work area.

2. Position the mouse cursor on the title of the "Users" table.

3. Open the shortcut menu with the right mouse button and activate the display of the 
"Dynamic logon" and "User identification" columns.

4. Double-click "Add" in the "Users" table.

5. Enter "Smith" as the user name.

6. Click the  button in the "Password" column. A dialog box for entering the password is 
displayed.

7. Enter the password of the user.

8. To confirm the password enter it a second time in the lower field.

9. Close the dialog box by using the  icon.

10.Activate the "Dynamic logon" column.
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Result
When the variable equals 1, the user "Smith" will be logged on.

 

 Note

The used variable must be of the type "binary" or 8, 16 or 32 bit.
 

 

9.7.4.3 Managing users on the server

Central user administration using SIMATIC Logon

Introduction
To manage users and user groups for several applications or HMI devices, activate SIMATIC 
Logon.   

Principle
SIMATIC Logon is a tool for system-wide user administration. If you use SIMATIC Logon, the 
users are centrally managed outside the application or HMI device. 

You configure the user groups and their permissions as you usually do with the local user 
administration in WinCC. You assign identical names to the user groups on the server and in 
WinCC. Authorizations are assigned in Runtime to a user group when the names are identical. 

You do not have to create users in WinCC flexible because they are taken dynamically from 
Windows user management during the logon process. The application or HMI device forwards 
each logon or password change to SIMATIC Logon for processing.

 

 Note

SIMATIC Logon is a product requiring a license. For more information on SIMATIC Logon 
go to <http://support.automation.siemens.com>.

Enter the ID "34519648" in the search field and start searching. The "SIMATIC Logon - 
Electronic Signature" manual is available to download.

 

Visualizing processes (Professional)
9.7 Configuring user administration

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1705



Log on process via SIMATIC Logon Service
The following diagram illustrates the process that runs automatically when a user logs onto 
Runtime.

The application opens the logon dialog box

1. Query: Login and password

The user enters the logon data in the logon dialog box:

<Login>

<Password>

Logon

dialog box

2. Transfer: Logon data

Logon data is verified

3. Query: Does Windows recognize the user?

Logon data is verified

on the local computer or in the domain

4. User authentication in progress 

SIMATIC

Logon

Service

Determining user data:

Operating 

system

User and group 

administration

Transfer of user data:

6. Transfer: full user name,

  group membership,

  password age 

5. Query: Which user data

   is known?

Verifying and transferring user data:

7. Transfer:  full user name,

  group membership

8. Determining roles

9. Setting rights in accordance with role

Results: The user can implement the role functions.

Applications 

which use 

SIMATIC Logon 

functions

See also
Settings for the user administration (Page 1691)

Making settings on the server 

Introduction
Perform the following steps on your sever to ensure correct operation of SIMATIC Logon.
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Procedure
1. Install SIMATIC Logon Services.

2. Create the user group in the user administration of the operating system.

3. Create the users in the user administration of the operating system.
 

 
 NOTICE

Users of SIMATIC Logon must be members of a user group of the operating system. 
Members of a subgroup cannot be logged on.

 

4. Assign the new users to a group.

5. Transfer the licenses for each HMI device on the server.
 

 Note

You can find more detailed information in the documentation supplied with SIMATIC Logon.
 

 Note

The password policies stored on the server are valid if users are authorized by means of 
SIMATIC Logon.

The logoff time for the SIMATIC Logon user corresponds to that of the predefined 
"Administrator" user.

 

Logging on using SIMATIC Logon

Requirements
● User administration exists.

● The groups created in WinCC agree with the Windows groups on the server.

● There is a server with SIMATIC Logon Service installed.
 

 NOTICE

A user may only be a member of one user group in WinCC. When a user is a member of 
several user groups on the server, only one of these user groups can be made known in 
WinCC.

"Administrators" and "Users" are predefined groups in both Windows and WinCC. Any new 
user created in Windows is automatically a member of the "Users" group. A user will be a 
member of two groups if assigned to a new group, for example, to the "SL user" group.

Remove this user from the "Users" group of the operating system to enable logon of this user 
using SIMATIC Logon. 

A system message in Runtime always confirms the successful logon of a user on the server.
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Procedure
1. Open the "Runtime settings > User administration" editor in the Project window.

2. Select "External Runtime services > SIMATIC Logon".

3. Enter the name or IP address of the SIMATIC Logon server in the "Server name" text box.
 

  Note

Make sure your SIMATIC Logon Server always has the same IP address if you use IP 
addresses. 

 

4. Enter the port number for TCP/IP communication in the "Port number" text box. The valid 
range of values lies between 1024 and 49151. The preset port number is "16389" and used 
by SIMATIC Logon as the default.

5. Enter the Windows domain or the logon server in the "Windows domain" text box, including 
the user data.
Enter the name of the sever to access users on the logon server.
Enter the name of the domain if the logon sever is in a domain and you wish to access 
users of the domain. 

 

  Note

Local Windows users are not accepted when the logon server is in a domain.
 

6. Activate the "Encrypted transmission" check box in order to encrypt the data before sending 
it to the server.

Emergency user
If the server cannot be accessed, all local users that were created in WinCC user administration 
can also be used as emergency users.

Emergency users have the rights of the user group to which they were assigned.
 

 Note

For further information, refer to the included SIMATIC Logon documentation. 

This documentation is available at: [SIMATIC Logon installation directory] \manuals
 

Logging on using SIMATIC Logon

Requirements
● User administration exists.

● The groups created in WinCC agree with the Windows groups on the server.

● There is a server with SIMATIC Logon Service installed.
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 NOTICE

When a user is a member of several user groups, the user is assigned the sum of 
authorizations for the groups. Logon is possible. 

 

Procedure
1. Double-click the "Runtime settings" in the project window.

2. Double-click the "User administration" in the work area.

3. Activate "SIMATIC Logon."

9.7.4.4 Administering users for Web Client

Settings for the Web Client

Introduction
A Web Client system is used to operate and monitor your process via the Internet or Intranet. 
If you require this type of access, you create a Web client with the WinCC Web Navigator 
option.

You configure the start screen and language. These are then applied if the user accesses the 
project from the Web.

You can create the start screen and languages used in runtime for the specific device in the 
"Runtime settings" editor.

Language and font settings
1. Open the "Project languages" editor.

2. Activate the required project languages.

3. Open the "Runtime settings > Language & Font" editor.

4. In the table, select the languages that should be available in runtime.

Screen settings
1. Open the "Runtime settings > General" editor.

2. Click the "..." button in the screen name field. A dialog box for selecting the start screen 
opens.

3. Select a screen.

4. Close the dialog box by using the  icon.
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 Note

You have to activate the web access for a screen to be offered as the start screen. Open the 
screen and enable "Properties > Properties > General > Web access" in the Inspector window.

 

See also
Administering user groups for Web Client (Page 1710)

Managing users for the Web client  (Page 1711)

Administering user groups for Web Client

Introduction
A different start screen and also any language can be set for every user group.  This allows 
you to make various sections of a project immediately accessible or inaccessible for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Procedure
1. Position the mouse cursor on the title bar of the "Groups" table.

2. Open the shortcut menu with the right mouse button and activate the display of the "Start 
screen" and "Language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "Web operators" as the name of the user group.

5. Click the  button in the "Start screen" column. A dialog box for selecting the start screen 
opens.

6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Language" column. A dialog box for selecting the language opens.

9. Select the runtime language.
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As an alternative, select the user group in the work area; the properties of the user group are 
then displayed in the Inspector window. 

In the Inspector window, select "Properties > Properties > Web options". 

Select the start screen and the language.
 

 Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 

 

 

See also
Settings for the Web Client (Page 1709)

Managing users for the Web client 

Introduction
For every user, a different start screen and also any language can be set. This allows you to 
make various sections of a project immediately accessible or inaccessible for users.

Requirements
● The "Users" work area is open.

● The user "Foreman" has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu with the right mouse button and activate the display of the "Start 
screen" and "Language" columns.

3. Click the  button in the line of the "Foreman" user in the "Start screen" column. A dialog 
box for selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Language" column. A dialog box for selecting the language opens.

7. Select the runtime language.
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As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another one. The 
start screen will be overwritten.

 

See also
Settings for the Web Client (Page 1709)

9.7.4.5 Administering users in Runtime

Users in runtime 

Principle
You create users and user groups and assign authorizations to them. You configure objects 
with authorizations. After download to the HMI device, all objects which were configured with 
an authorization are protected against unauthorized access in Runtime.

User view
When you configure a user view in the Engineering System, you administer users in this user 
view following download to the HMI device.  

 

 CAUTION

Changes in the user view are effective immediately in Runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Users who have a "User administration" authorization have unlimited access to the user view. 
This allows them to administer all users. Any other user has only limited access to the user 
view for self administration.

See also
Complex user view (Page 1714)

Managing users in the complex user view (Page 1719)

Logging on as a user (Page 1723)
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Simple user view

Purpose
You configure a user view in the engineering system to also administer the users in 
Runtime.   

Structure
The user view shows the following in each line:

● The user

● The corresponding user group.

If no user is logged on, the user view is empty. The content of the individual fields is displayed 
after logon.

User view of an administrator

When an administrator is logged on, the user view shows all the users. The administrator 
changes the user name and the password. The administrator creates new users and assigns 
them to an existing user group. 
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User view of a user

When no administrator is logged on, the user view shows only the logged-on user. Users can 
change their own passwords. 

See also
Logging on as a user (Page 1723)

Complex user view

Purpose
You configure a user view in the engineering system to also administer the users in 
Runtime.   

Structure
The user view shows the following in each line:

● The user

● The encrypted password

● The corresponding user group

● The logoff time

If no user is logged on, the user view is empty. The content of the individual fields is displayed 
after logon.
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User view of an administrator

When an administrator is logged on, the user view shows all the users. The administrator 
changes the user name and the password. The administrator creates new users and assigns 
them to an existing user group. 

User view of a user

When no administrator is logged on, the user view shows only the logged-on user. Users can 
change their own passwords and logoff time.

See also
Users in runtime  (Page 1712)

Logging on as a user (Page 1723)

Configuring a user view

Introduction
You configure a user view in the Engineering System to also administer users in Runtime.  

Requirements
A screen has been created.
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Procedure
1. Select the "User view" object from the "Controls" category in the toolbox.

2. Drag-and-drop the "User view" object into the screen.

3. Click on "Properties > Properties" in the Inspector window.

4. Specify the appearance of the "User view".

5. You can, for example, select " "Display mode > Fit to size > Fit object to contents".

Result
You have created a user view in the screen.

See also
Logging on as a user (Page 1723)

Creating users

Introduction
You create a user so that users can log on under their user name in runtime.   

As an alternative, you can create users in the engineering system and download them to the 
HMI device.

The logon is successful only when the user name entered during the logon matches a user in 
runtime. In addition, the password entered at logon has to match that of the user.

 

 Note

Note that the entry is case-sensitive. 
 

You assign the user to a user group. The user then has the authorizations of the user group.
 

 NOTICE

Runtime users must be assigned to a user group. The user group is created in the Engineering 
System. The designation of the user group is language-dependent.

 

Requirements
● The user view is open.

● A "Group 2" user group has been created.
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Procedure
1. Click "<New User>" in the user view. A dialog box opens.

2. Enter "Foreman" as the user name.

3. Press the <Return> button.

4. Click "Password."

5. Enter the password of the user.

6. Press the <Return> button. The password is hidden.

7. Click in the "Group" column.

8. Select "Group 2" as the "Group".

9. Press the <Return> button.

10.Click in the "Logoff time" column.

11.Enter the time after which the user is logged off automatically.

See also
Logging on as a user (Page 1723)

Managing users in the simple user view

Introduction
If you have configured a user view in the engineering system, the users and user groups can 
be managed in runtime. 

 

 CAUTION

Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the Engineering System. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Requirements
● Runtime is enabled.

● The simple user view has been created.
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● The screen with the simple user view is open.

● You have the default "User administration" authorization.
 

 
 NOTICE

If you do not have a "User administration" authorization, you can only change your own 
password and your logoff time.

 

Changing a user name
1. Click on the line of the user whose name you want to change. A dialog box opens.

2. Enter a new user name.

3. Click "OK" to confirm your entry.  
 

 
 NOTICE

The user can then no longer log on with his previous password in runtime. If you delete 
the name and press <Return>, the user is deleted.

 

Changing the user password in basic user display
1. Click on the line of the user whose password you want to change. A dialog box opens.

2. Enter a new password.

3. Click "OK" to confirm your entry.  
 

 
 NOTICE

The user can then no longer log on with his previous password in runtime.

If you delete the password in the basic user view and press <Return>, a message will be 
generated. The message specifies that the password does not lie within the defined limits. 

 

Changing the logoff time of the user
1. Click on the line of the user whose logoff time you want to change. A dialog box opens.

2. Enter a new logoff time.

3. Click "OK" to confirm your entry.  
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Deleting a user
1. Click the name of the user to be deleted. 

2. Delete the name.

3. Press the <Return> button.
 

 
 NOTICE

The user can no longer log on in runtime.
 

Assigning a user to a different user group
1. Click on the line of the user whose user group you want to change. A dialog box opens.

2. Click on the "User group" box.  

3. Select a user group.

4. Click "OK" to confirm your selection.

See also
Logging on as a user (Page 1723)

Managing users in the complex user view

Introduction
If you have configured a user view in the engineering system, the users and user groups can 
be managed in runtime.   

 

 CAUTION

Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Requirements
● Runtime is enabled.

● A complex user view has been created.
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● The screen with the user view is open.

● You have the default "User administration" authorization.
 

 
 NOTICE

If you do not have a "User administration" authorization, you can only change your own 
password and your logoff time.

 

Changing the user name
1. Enter a new user name in the "Users" column in the user display.

2. Confirm your entry with <Return>.  
 

 
 NOTICE

The user can then no longer log on with his previous password in runtime. If you delete 
the name and press <Return>, the user is deleted.

 

Changing the password of the user
Availability of complex user display in selected devices only.

1. Enter a new password in the "Password" column in the user display.

2. Confirm your entry with <Return>.
 

 
 NOTICE

The user can then no longer log on with his previous password in runtime.

If you delete the password in the complex user view and press <Return>, the user will be 
deleted. 

 

Changing the logoff time of the user
1. Enter a new logoff time in the "Logoff time" column in the user display.

2. Confirm your entry with <Return>.  

Deleting a user
1. Click the name of the user to be deleted. 

2. Delete the name.

3. Press the <Return> button.
 

 
 NOTICE

The user can no longer log on in runtime.
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Assigning a user to a different user group
1. Activate the user group field for the corresponding user.  

2. Select a user group.

3. Confirm your selection with <Return>.

See also
Users in runtime  (Page 1712)

Logging on as a user (Page 1723)

Unlock locked out users

Unlock locked out users
The check box "Activate limit for login attempts" is activated in the "Runtime settings > User 
administration". 
The number 3 is entered in the field "Number of invalid login attempts".

If users have three failed attempts at login, e.g. by entering an incorrect password, they are 
assigned to the "Unauthorized" group. The user loses all authorizations. The user can still log 
on, but no longer has any authorizations. Only a user with administrator rights re-assigns the 
unauthorized user to a user group. 

See also
Logging on as a user (Page 1723)

Logging on as a user

Introduction
As a rule you log-on as a user by means of a special button. The logon dialog box is displayed 
to this purpose.   

The logon dialog box is displayed by default during access to a protected object if

● No user is logged on in Runtime.

● The logged-on user does not have the required authorization.
 

  Note

The system always opens the logon dialog on the OP 73, OP 77A, TP 177A and Basic 
Panels HMI devices when you press an access-protected button:
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Requirements
● Under "Runtime settings > User administration" the

– "Enable limit for logon attempts" check box has been selected.

– The number 3 is entered in the field "Number of invalid login attempts".

● The "ShowLogonDialog" system function is configured on a button called "Logon".

Procedure
1. Click the "Logon" button. The logon dialog box is displayed.

2. Enter your user name as it was specified in the user administration, for example "Foreman".
If someone has logged on before you, the name of the user will be displayed.

3. Enter the corresponding password. The input is concealed.

4. Click "OK" to close the dialog box.

Logon was successful
If you have entered the user name "Foreman" and the entered password corresponds with the 
stored password, you are logged on as the user "Foreman" in Runtime. You have the 
authorizations of the user "Foreman". 

When the user "Foreman" accesses a protected object such as the "Logging" button, access 
to this protected object will only be authorized if the user "Foreman" has the required 
authorization. The programmed function is executed immediately. 

If you do not have the required authorization after the successful log-on, a corresponding error 
message is displayed. However, you remain logged on in Runtime.

Logon was unsuccessful
An error message is displayed.  

In order to maintain security, you or the user logged-on before you no longer has any 
authorizations. However, access to unprotected objects remains possible. The user view does 
not, however, show any entries. The user view and the authorizations change after the next 
successful log-on.

If the third login attempt has failed, the user will be assigned to the "Unauthorized" group. For 
this reason, do not configure a user group with this display name.  

If the "Log off" function is called up or the logoff time of the user has expired, the user is logged 
off. 
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See also
Logging on as a user (Page 1723)

Logging on as a user

Introduction
As a rule you log-on as a user by means of a special button. The logon dialog box is displayed 
to this purpose.   

The logon dialog box is displayed by default during access to a protected object if

● No user is logged on in Runtime.

● The logged-on user does not have the required authorization.

Requirements
● The "ShowLogonDialog" system function is configured on a button called "Logon".

Procedure
1. Click the "Logon" button. The logon dialog box is displayed.

2. Enter your user name as it was specified in the user administration, for example "Foreman".
If someone has logged on before you, the name of the user will be displayed.

3. Enter the corresponding password. The input is concealed.

4. Click "OK" to close the dialog box.

Logon was successful
If you have entered the user name "Foreman" and the entered password corresponds with the 
stored password, you are logged on as the user "Foreman" in Runtime. You have the 
authorizations of the user "Foreman". 

When the user "Foreman" accesses a protected object such as the "Logging" button, access 
to this protected object will only be authorized if the user "Foreman" has the required 
authorization. The programmed function is executed immediately. 

If you do not have the required authorization after the successful log-on, a corresponding error 
message is displayed. However, you remain logged on in Runtime.
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Logon was unsuccessful
An error message is displayed.  

In order to maintain security, you or the user logged-on before you no longer has any 
authorizations. However, access to unprotected objects remains possible. The user view does 
not, however, show any entries. The user view and the authorizations change after the next 
successful log-on.

The user will be logged off if the "Log off" function is called or the user logoff time has expired. 

See also
Users in runtime  (Page 1712)

Simple user view (Page 1713)

Complex user view (Page 1714)

Configuring a user view (Page 1715)

Creating users (Page 1716)

Managing users in the simple user view (Page 1717)

Managing users in the complex user view (Page 1719)

Unlock locked out users (Page 1721)

Logging on as a user (Page 1721)

Exporting the user administration (Page 1724)

Importing the user administration (Page 1725)

Exporting the user administration

Introduction
The users and user groups are transferred to the HMI device from the Engineering System. If 
you have configured a user view, you administer the users at the HMI device via the user 
view.   

If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.

You program a function which exports the user data at a button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 CAUTION

When exporting, the user data are encrypted and written from the HMI device to the target 
file. The target file is overwritten. 
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Requirements
● You have created an HMI device with Runtime Advanced.

● A screen has been created.

● A button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Export" as the "Direction". When exporting, the target file is overwritten with the 
user data.

6. Enter the full path of the destination file as the "File name", for example "a:\test
\usersview.txt".

 

 
 NOTICE

Ensure that the file name is written correctly. If the directory, for example "\test\", does not 
exist, it will be created without a prompt. 

 

See also
Logging on as a user (Page 1723)

Importing the user administration

Introduction
If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.   

You configure a function which imports the user data at a command button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 CAUTION

When importing, the user data are read in from the source file and written into the HMI device. 
The users and passwords currently valid in the HMI device are overwritten. The imported 
users and passwords are valid immediately.
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Requirements
● A screen has been created.

● A command button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Import" as the "Direction." When importing, the user data in the HMI device are 
overwritten.

6. Enter the full path of the source file as the "File name", for example "a:\test\usersview.txt".
 

  Note

Ensure that the file name is written correctly. If the folder, for example "\test\", or the file 
does not exist, an error message will be displayed. 

 

See also
Logging on as a user (Page 1723)

9.7.4.6 Configuring access protection

Access protection

Introduction
You configure an authorization at an object in order to protect it against access. All logged-on 
users who have this authorization can then access the object. If a user does not have 
authorization to operate an object, the logon dialog is displayed automatically.

 

 Note

Several system functions are available under "User administration" so that user, password, 
and user group can be edited, for example, in the PLC. 
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Configuring operating authorizations

Introduction
You configure the "Archive data" authorization for a button. Then only those users who have 
the appropriate authorization have access to this button, for example all the users of the 
"Operators" user group.   

This ensures that access to the command button is protected. If a logged-on user who belongs 
to the "Operators" user group and has the required authorizations clicks the button, alarms 
and variables are archived. 

An example describes in detail how to configure a command button with access protection.

Requirements
● The "Operators" user group has been created.

● The "Archive data" authorization has been created.

● A screen has been created and opened.

● The screen contains a button.

Procedure
1. Click the button in the screen.

2. Click "Properties > Properties > Security" in the Inspector window.

3. Select "Archive data" as the "Authorization".

4. In the Inspector window, select "Properties > Events > Click".

5. Select a system function from the function list.
 

  Note

The "Enable" and "Disable" events are only used to detect whether an object was selected 
or deselected. The events do not, however, trigger a password prompt.

Do not use the "Enable"or "Disable" event if you want to configure access protection at 
the function call of the object.
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9.7.5 Reference

9.7.5.1 Objects with access protection

Introduction
The following objects can be configured with an authorization:   

● Date/time field

● I/O field

● Graphic I/O field

● Recipe view

● Switch

● Button

● Symbolic I/O field

9.7.5.2 Objects with access protection

Introduction
The following objects can be configured with an authorization:   

● Date/time field

● I/O field

● Graphic I/O field

● Alarm view

● Alarm window

● Recipe view

● Switch

● Button

● Slider

● Symbol library

● Symbolic I/O field
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9.7.5.3 Objects with access protection

Introduction
The following objects can be configured with an authorization:   

● Bar

● Scroll bar

● Double T piece

● I/O field

● f(t) trend view

● f(x) Trend View

● Graphic I/O field

● Combo box

● Check box

● List box

● Editable text field

● Alarm window

● Option button

● Pipe

● Pipe bends

● Round button

● Button

● Symbolic I/O field

● T piece

● Connector

 

In order to configure the following objects with access control, you additionally link the system 
function "ShowLogonDialog" to an event, for example, Click.

 

● Line

● Polyline

● Polygon

● Ellipse

● Ellipse segment

● Ellipse arc

● Circle segment
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● Circle

● Circular arc

● Rectangle

● Text field

● Graphic view

9.7.5.4 Default user groups and authorizations 

Principle
The predefined user groups and authorizations have the following numbers:

User group Number
"Administrator group" 1
"Users" 2

Authorization Number
"User administration" 1
"Monitor" 2
"Operate" 3

9.7.5.5 Default user groups and authorizations

Principle
The predefined user groups and authorizations have the following numbers:

User group
"Administrator group"
"Users"

Authorization Number
"User administration" 1
"Monitor" 2
"Operate" 3
"Activate remote control" 1000
"Dat@Monitor" 1002

 

Authorization 1000, "Enable remote control", is practical for client-server projects. 
Authorization 1002, "Dat@Monitor", is important for the Web Navigator.
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9.7.6 Examples

9.7.6.1 Example: Configuring a button with logon dialog box

Task
In the following example, you configure the function "ShowLogonDialog" for a button. A 
different user can then log on in runtime when the shift changes, for example. In the process 
the user previously logged on is logged off.    

 

 Note

In runtime the logon dialog box is not displayed by default until you access a protected object. 
Either no user is logged on or the logged-on user does not have the required authorization.

 

Requirements
● A screen has been created.

● A button has been created in the screen.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.

3. Click the entry "Add function" in the "Function list" table.

4. Select the system function "ShowLogonDialog" from the "User administration" group.
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Result
If the user clicks on the button in runtime, the function "ShowLogonDialog" is called up. When 
the function "ShowLogonDialog" is called up, the logon dialog box is displayed. The user logs 
on with his user name and password. 

9.7.6.2 Example: Logging the logon and logoff events

Task
In the following example, you configure the function "TraceUserChange" to the event "User 
change".   

Principle
The "TraceUserChange" function is called when a user logs on or off. When a function is called 
up, a system message with information about the corresponding user is output. 

This system message can be archived. When archiving, the system message is provided with 
a date stamp and time stamp. This ensures that you can track which user was logged on at 
the HMI device at which time and for how long.

Requirements
● You have created an HMI device with Runtime Advanced.

● The Inspector window is open.

Procedure
1. Double-click the "Scheduler" in the Project view.

2. Double-click "Add" in the table of the tasks.

3. Enter "Logon-Protocol" as the "Name".

4. Select "User change" as the "Trigger".

5. Open "Properties > Events" in the Inspector window.

6. Click the entry "Add function" in the "Function list" table.

7. Select the "TraceUserChange" system function.

Result
A system message is output when a user logs on or logs off. 
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9.7.6.3 Example of a user administration

Example: Structure of user administration

Task
In the following example you set up a user administration for different users and user groups. 
The example orientates itself to a typical requirement profile from manufacturing engineering.  

Principle
Completely different groups of persons are involved in a plant or project. Each group of persons 
protects its respective data and functions against access by others. For this purpose, users 
are created and assigned to a user group. 

You can reproduce different views through user groups. 

Example:

● Organizational view: Commissioners, Operators, Shift I, Shift II

● Technological view: Axis control, Tool changers, Plant North, Plant South

The following example orientates itself to the organizational view.

Every user group has characteristic requirements regarding access protection: A user group 
has operating authorizations for specific application cases. A programmer changes, for 
example, recipe data records. 

In the example the users Miller, Group Smith and Foreman are created and assigned to 
different user groups.

Ms. Miller works as a programmer in the engineering system. The Group Smith are 
commissioners. Mr. Foreman is an operator.

Requirements
● A new project has been created.

● The "User administration" editor is open.

Procedures overview
Working with user administration has the following procedure in the example:

1. Creating authorizations The planner specifies which authorizations are required for access 
protection.

2. Configuring authorizations: The planner specifies which objects may be operated and which 
functions may be executed.

3. Creating user groups and allocating authorizations: The administrator creates the user 
groups together with the planner. The planner uses the authorizations to specify who may 
operate objects and change parameters.

4. Creating users and assigning them to a user group: The administrator administers the users.
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Result
The aim is the following structure of the user administration of users, user groups and 
authorizations:

Users User groups Authorizations
Miller Smith Foreman Roles Changing 

recipe 
records

Changing 
system 
parameters

Changing 
process 
parameters

Managing

   Administrator group    x
X   Programmer X    
 X  Commissioning 

engineers
X X X  

  X Operators x    

The user "Foreman" who belongs to the "Operators" user group has access to the configured 
"To Recipe view" button.

 

 Note

Alternatively, you can create several users as operators with different operating 
authorizations, for example, Operator Level 1, Operator Level 2. 

 

Example: Creating and configuring authorizations

Task
The following example shows you how to create the authorizations  

Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Authorizations" table.

3. Enter "Change recipe data records" as the "Name" of the authorization.

4. Repeat steps 2 and 3 to create additional authorizations: "Change system parameters", 
"Change process parameters".
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Result

Example: Configuring a button with access protection

Task
In the following example you use a system function to create a button for a screen change. 
You protect the "To Recipe view" button against unauthorized operation. To do so, you 
configure the "Change recipe data records" authorization at the "To Recipe view" button.       

Requirements
● A "Change recipe data records" authorization has been created.

● A "Recipes" screen has been created.

● A "Start" screen has been created and opened.

● A button has been created and marked in the "Start" screen.

Procedure
1. Click "Properties > Properties > General" in the Inspector window.

2. Enter "To Recipe view" as the text.

3. Click "Properties > Events > Click" in the Inspector window.

4. Click the "Add function" entry in the first line of the "Function list" table.
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5. Select the "ActivateScreen" system function in the "Screens" group.

6. Click the  button in the "Screen name" field. A dialog box for selecting the screen opens.

7. Select the "Recipes" screen and use the  button to close the dialog box.

8. Click "Properties > Properties > Security" in the Inspector window.

9. Select "Change recipe data records" as the "Authorization."

Result

Access to the "To Recipe view" button is protected. If, for example, the user "Smith" clicks the 
button in Runtime, the function "Recipe view" screen is called up. Prerequisite is that the user 
"Smith" has logged on correctly and has the required authorization. The "Recipes" screen 
contains a recipe view and other screen objects. 

If the logged-on user does not have the required authorization or if no user is logged on, the 
"Logon dialog box" is displayed. 
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Example: Creating user groups and assigning authorizations:

Task
In the following example you create the user groups and assign authorizations to them.       

Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Groups" table.

3. Enter "Programmer" as the "Name".

4. Repeat steps 2 and 3 to create the "Commissioner" and "Operator" user groups.

5. Click "Administrator" in the "Groups" table.

6. Activate the "Change system parameters" authorization in the "Authorizations" table.

Interim result

Procedure
1. Click "Operator" in the "Groups" table.

2. Activate the "Change recipe data records" authorization in the "Authorizations" table.

3. Click "Commissioner" in the "Groups" table.
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4. Activate the authorizations "Change recipe data records", "Change system parameters" 
and "Change process parameters" in the "Authorizations" table.

5. Click "Programmer" in the "Groups" table.

6. Activate the "Change recipe data records" authorization in the "Authorizations" table.

Result

Example: Creating users and assigning them to a user group

Task
In the following example you create the users and assign user groups to them. The users are 
sorted alphabetically immediately after the name has been entered.    

Procedure
1. Open the "Users" work area.

2. Double-click "Add" in the "Users" table.

3. Enter "Miller" as the user name.

4. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

5. Enter "miller" as the password.

6. To confirm the password enter it a second time in the lower field.

Visualizing processes (Professional)
9.7 Configuring user administration

WinCC Professional V11.0 SP1
1738 System Manual, 08/2011,  



7. Close the dialog box by using the  icon.

8. Activate the "Programmer" user group in the "Groups" table.

Interim result

Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Smith" as the user name.

3. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

4. Enter "smith" as the password.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box by using the  icon.

7. Activate the "Commissioner" user group in the "Groups" table.

8. Repeat steps 2 to 6 for the user "Foreman."

9. Activate the "Operators" user group in the "Groups" table.
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Result

9.8 Working with system functions and Runtime scripting

9.8.1 Working with system functions and Runtime scripting

9.8.1.1 Principles

Runtime scripting

Term definition            
The following terms are used in the documentation:

Term  
Runtime scripting Generic term for all activities in user-defined functions and local scripts.
Function Generic term for system functions and user-defined functions.
System functions System functions are all functions supplied with WinCC. The system functions 

are used either in function lists, user-defined functions or local scripts.
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Term  
User-defined functions User-defined functions are functions written in the "Scripts" editor. For more 

precise specification, the term "User-defined VB function" and "User-defined 
C function" is used in the documentation.

Local script A local script is created directly at the point of use, e.g. an object property, 
and has a cyclic or acyclic trigger. For more precise specification, the terms 
"local VB script" and "local C script" are used in the documentation.

VBS/VBScript Abbreviation for Visual Basic Script

Availability

 WinCC RT Advanced and Panels WinCC RT Professional
Customized VB functions X X
Customized C functions -- X
Local VB scripts -- X
Local C scripts -- X

Applying Runtime scripting
The following figure serves as a decision guide for programming tasks at hand:

* Local scripts are not supported in WinCC RT Advanced and Panels.
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Customized function or local script?
Whether you accomplish your programming task with a user-defined function or a local script 
depends on the application purpose and ultimately on the number of user-defined functions 
or local scripts. 

Use local scripts for background activities, e.g. for daily printing or logs, for the monitoring of 
tags or for the execution of calculations. 

Use customized functions to make codes available in several places in your project but only 
create them once. Instead of entering the code several times, you just call the appropriate 
customized function. Your code is clearer and easier to maintain. 

Instruction 1

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 3 Instruction 3 Instruction 3

Instruction 3

See also
User-defined functions (Page 1745)

Local scripts (Page 1747)
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System functions

Applications
● Function lists

When the event occurs, the configured system functions can be performed with the function 
list.       

● User-defined functions
If the HMI device supports user-defined functions, you use system functions in combination 
with instructions and conditions in the code of the user-defined unction. In this way you 
execute a customized function depending on a specific system state. In addition, you can 
evaluate return values of system functions, for example. Depending on the return value, 
you then perform test functions, for example, that in turn affect the function flow.

Application examples of system functions
● Calculations, increase tag value by a defined or variable amount.

● Log function, e.g. to start a process value log.

● Settings, e.g. to switch the PLC or set a bit in the PLC.

● Alarms, e.g after a different user logs on.
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Application
You use system functions in a function list or in a user-defined function. 

● Function list
When configuring a function list, you select the system functions from a selection list that 
is sorted by categories:   

● User-defined functions
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click .

Language dependency
In the function list, the names of the system functions are dependent on the set project 
language. The functionality can then be recognized immediately by the project planner. 

You use the English name of the system function in user-defined functions. You will find the 
English name of the system function in the reference.   
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Availability for WinCC Runtime Advanced and Panels
Which system functions are available depends on the selected HMI device.

HMI device changeover
If you use system functions in a function list that are not available on the set HMI device, these 
system functions are marked in color.

If you use a system function in a user-defined function which is not available on the set HMI 
device, a warning is issued. In addition, the respective system function will be underlined with 
a wavy blue line. 

See also
System functions for logs (Page 1120)

User-defined functions

Applications  
You use customized functions for the following for example:

● Configuring a function list
In a customized function you have the option to have customized functions and system 
functions executed depending on conditions or executed repeatedly. You then add the user-
defined function to a function list, for example. 

● Programming new functions
Customized functions are only valid in the project in which they are defined. For user-
defined functions you define transfer parameters and return values, for example, for 
conversion of values. 

 

 Note

You can only use user-defined functions of a programming language in a function list. Your 
selection of the first user-defined function determines whether VB functions or C functions 
can be selected in the function list.

 

Application examples of customized functions
● Convert values

You use functions to convert values between different measurement units, e.g., 
temperatures.

● Evaluating tag values statistically

● Drawing a trend in a f(t) trend view
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Properties of customized functions
A customized function has the following properties:

● Name

● Parameter (optional)

● Return value and type (optional)

● Can be modified centrally

● has no trigger. You have to call the user-defined function explicitly, e.g. in a function list.

Organization of customized functions
You create customized functions with the "Scripts" editor. See ""Scripts" editor (Page 1753)" 
for additional information.

Customized functions are saved in the project. To protect user-defined functions, set up know-
how protection. See Setting up know-how protection (Page 1762) for additional information.

● Project tree
The user-defined functions are listed in the project tree under "VB scripts" or "C scripts".

● Function list
The user-defined functions are listed in a function list under "VB functions" or "C functions".

● User-defined function
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click .

See also
Runtime scripting (Page 1740)
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Local scripts

Applications
You can use local scripts for the following:

● Dynamizing objects
You use a local script to determine the value of an object property in Runtime. Use this 
approach, for example, to change the color depending on a tag value. 

● Performing tasks at any point in time.
You use a local script to plan jobs, e.g. daily printout of a log at the end of the shift. 

Application examples of local scripts
● Configuring desired values for tags for operator control of a graphic object, e.g., in order to 

assign a value for the PLC via a mouse click.

● Configuring the Runtime language switch for operator control of a graphic object.

● Status monitoring of tags, e.g. to ensure that a value is valid.

Properties of local scripts
You create a local script directly at the point of use. A local script has the following properties:

● Predefined name

● Predefined parameters

● Predefined return value (optional)

● Can only be changed at the point of use

● has no trigger

● Calling customized functions, system functions

Triggers
Triggers are necessary to execute local scripts in Runtime. The trigger is either determined 
automatically when creating a local script or specified by the project manager.

The following triggers are supported by WinCC:

● Acyclic trigger, e.g. you plan a single ending of Runtime for maintenance work.

● Cyclic trigger, e.g. you plan a job which starts daily printing of a log.

● Events, e.g. when clicking the button.

The following figure shows different types of triggers:
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Triggers are used in the following editors:

● Scheduler
First you need to configure the trigger in the Scheduler. Then connect the trigger to the 
local script or a function list.

● Screens
To dynamize an object property, first configure a local script in the property list of the screen. 
The trigger is determined automatically when creating the local script. You can change the 
trigger, e.g. to tag trigger. 

See also
Runtime scripting (Page 1740)

9.8.1.2 Working with Function Lists

Basics of the function list

Introduction
A function list performs one or more system functions and user-defined functions when the 
configured event occurs.  
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Principle
The function list is configured for an event of an object, for example, for a screen object or a 
task. You can configure a function list precisely on every event. The events which are available 
depend on the selected object and the HMI device.

Events occur only when the project is in Runtime. Events include:

● Execution of a task

● Pressing of a button

● Acknowledging an alarm
 

  Note

The choice of configurable system functions in a function list is dependent on the selected 
HMI device. For additional information, refer to "Availability for specific devices of system 
functions".

 

See also
Function list (Page 2039)

Properties of a function list

Status information
During configuration the project data is tested in the background. 

With the following causes the function list is not executed in Runtime and the incorrect entries 
are marked red:
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● At least one system function or one user-defined function is not completely supplied with 
parameters.

● At least one system function or one customized function is contained which is not supported 
by the selected HMI device, e.g. by changing the device type.

Processing of system functions and user-defined functions (WinCC Runtime Advanced and Panels)
A function list is executed from top to bottom in Runtime. If a function list includes system 
functions with longer runtime, these are processed asynchronously. See "Auto-Hotspot" and 
"Auto-Hotspot" for more details.

Configuring a function list

Introduction
You configure a function list by selecting the system functions and customized functions from 
a drop-down list. The system functions are arranged in the selection list according to 
categories. 

You only use customized functions of a programming language in a function list. Your selection 
of the first user-defined function determines whether user-defined VB functions or user-defined 
C functions can be selected in the function list. Which programming languages are available 
depends on the selected HMI device.

If you have created a user-defined VB function, for example, the user-defined function is 
available under the entry "VB functions".   

Requirement
Object has at least one configurable event.

Procedure
Proceed as follows to configure a function list:

1. Open the editor in which the object is located.

2. Select the object.

3. Click "Properties > Events" in the Inspector window. Choose the event for which you want 
to configure the function list.

4. Mark the "<Add function>" entry in the inspector window in the drop-down list.
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5. Select the desired system function or the desired user-defined function from the selection 
list. You can also enter the name of the system function or the user-defined function.

The system function or the customized function is entered in the function list. 

6. If the system function or the customized function has parameters, select the appropriate 
values for the parameters.

7. If you want to add other system functions or user-defined functions to the function list, repeat 
steps 4) to 6).

Result
The function list is configured. In addition, to the configured event, the status of the function 
list is displayed in the Inspector window. When the configured event occurs in Runtime, the 
function list is completed from top to bottom. 

See also
Example: Changing the operating mode on the HMI device with the current display 
(Page 1816)
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Editing a function list

Introduction
A function list can be edited as follows:   

● Change the order of system functions and user-defined functions.

● Remove system functions or user-defined functions.

Requirement
The function list is configured and opened.

Changing the order of a system function or a customized function
1. Select the desired system function or customized function in the function list.

2. Then click the appropriate direction arrow in the inspector window until the system function 
or customized function is in the desired position.

Changing the order of several system functions and customized functions
1. Hold down the <Shift> key.

2. Click desired system functions or customized functions one after another with the mouse.

3. Move the selection to the desired position by drag&drop.

Removing a system function or customized function
1. Select the desired system function or customized function in the function list.

2. Select "Delete" in the shortcut menu.
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9.8.1.3 Working with customized functions

"Scripts" editor

Introduction
The "Scripts" editor supports you in the creating of customized functions with functionalities 
such as auto-completion and syntax highlighting. You can insert code templates for frequently 
used instructions with the "Instructions" task card for example.

Autocompletion and parameter entry         
The "Scripts" editor provides you context-dependent programming support with 
autocompletion parameter entry support. 

When you use system functions, the parameters of the function are shown as a tooltip. 

<Ctrl+J>
The object list can be called context-specifically by using the shortcut <Alt+J>. Use the object 
list to supply values to system functions, methods, and properties: For example, you select 
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screens, screen objects, tags, or colors. You transfer a selected object from the object list into 
the code by double-clicking it. 

 

 Note

Tags and screens can also be inserted using a drag-and-drop operation. Use, for example, 
drag-and-drop to assign values to parameters.

 

<Ctrl+Space>
With the key combination <Ctrl+Space> you call a list with the following contents:

● Constants and functions of the programming language used in the "Scripts" editor.

● Customized functions

● System functions

"Instructions" task card           
The "Instructions" task card contains the "Code templates" and "Function list" palettes.

● Code templates
To insert frequently used instructions, double click the desired instruction in the "Code 
templates" palette. Replace the space holders with the used expressions.

● Function list
In the function list you select the system functions and customized functions from a drop-
down list. Proceed as for configuring a function list. To transfer the function list to the code, 
click the "Transfer" button. The function list is automatically converted into the correct 
syntax. 

 

  Note

Not all system functions are available in the "Scripts" editor. For additional information, 
refer to the reference.

 

Edit functions
Use the buttons of the toolbar "Advanced Edit" to make the code more readable by means of 
indentation and the use of comments.

Bookmarks help you keep an overview, even of many lines of code. 

Further information regarding each button can be obtained in the accompanying direct help. 

Synchronization of tags and objects         
If you change tag names or object names in the project which you use in a user-defined 
function, the names are adapted automatically in the user-defined function. 
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If you change the tag name or object name in the function, the tag names or object names are 
not adapted in the project. An appropriate error message is output when executing the user-
defined function.

Syntax highlighting     
Keywords in the "Scripts" editor are highlighted using different colors. Unknown words are 
underlined with a red wavy line. 

The table shows the preset colors for the most important keywords:

Color Meaning Example
Blue Keyword If, Then
Dark violet Function FahrenheitToCelsius
Chocolate System function SetTag
Orange HMI tag Tag_1
Green Comment 'This is a comment'

Adapting display properties   
When you have opened a user-defined function, you can customize the display properties in 
the editor. Select the "Options > Settings" menu command. Click "General > Text editors" in 
the "Settings" editor. For example, you can change the colors for syntax highlighting or adapt 
the indents for code in the work area. 

See also
Create customized VB functions (Page 1767)

Create customized C functions (Page 1776)

Local scripts (Page 1782)

Editor for local scripts (Page 1784)

Calling system functions

Introduction
You can call system functions in a customized function. The syntax depends on the used 
programming language. Which programming language is supported depends on the selected 
HMI device.

You have the following options for calling a system function in a customized function:

● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette
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With <Ctrl+Space> or with 
Open the selection list with <Ctrl+Space> and select the desired system function.

Direct input
You enter the system functions directly into the code. You use the English name of the system 
function. You can find the English name of the system function in the system function reference 
under "Syntax". The editing language setting is not taken into consideration. 

References to objects, e.g. screens, connections and logs are transferred in inverted commas:

Calling system functions without return value in VBS

 
SetTag "Tag1",64

Calling system functions with return value in VBS

 
InverseLinearScaling "Xvalue","Tag1", 0, 1

Calling system functions without return value in C

 
SetTag ("Tag1",64);

 

Calling system functions with return value in C

 
InverseLinearScaling ("Xvalue","Tag1", 0, 1);

With the "Function list" palette
Select the desired system function from a drop-down list in the "Function list" palette. Proceed 
as for configuring a function list. See "Configuring a function list (Page 1750)" for additional 
information. 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.

HMI device replacement (Runtime Panels and Advanced)
The code of a customized function depends on the selected HMI device. If you use system 
functions in the customized function which are not supported by the selected HMI device, you 
receive an error message in the output window.   
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See also
Create customized VB functions (Page 1767)

Executing customized VB functions (Page 1769)

Executing customized C functions (Page 1779)

Calling customized functions

Introduction
You can insert user-defined functions of the same programming language in a user-defined 
function, e.g. only user-defined C functions in a user-defined C function. 

The syntax depends on the used programming language. Which programming language is 
supported depends on the selected HMI device.

You have the following options for calling a customized function in a customized function:

● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette

With <Ctrl+Space> or with 
Open the selection list with <Ctrl+Space> or with  and select the desired user-defined 
function.

Direct input
You enter the customized function directly into the code. References to objects, e.g. screens, 
connections and logs are transferred in inverted commas.

Calling customized functions without return value in VBS    

 
Average 4,10

Calling customized functions with return value in VBS

 
Dim ValueA
ValueA = Average (4,10)

If you do not want to evaluate the return value, use the call as for a customized function without 
return value.
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Calling customized functions without return value in C

 
Average(4,10);

Calling customized functions with return value in C

 
SetTagDouble("AverageValue",Average (4, 10));

If you do not want to evaluate the return value, use the call as for a customized function without 
return value. 

With the "Function list" palette
Select the desired customized function from a drop-down list in the "Function list" palette. 

Proceed as for configuring a function list. See "Configuring a function list (Page 1750)" for 
additional information. 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.

See also
Create customized VB functions (Page 1767)

Executing customized VB functions (Page 1769)

Executing customized C functions (Page 1779)

Access to HMI tags

Introduction
With VBS or C you can access the HMI tags which you have created in the project. Change 
or read the value of an HMI tag with a user-defined function in Runtime. 

You can also create local tags as counters or buffers. Every local tag must be initialized to 
prevent errors by writing local tags incorrectly.       
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HMI tags
● WinCC Runtime Advanced and Panels

The tag value which is created in the tag map is saved in the user-defined function. Next, 
the tag value will be updated to the set cycle time. The customized function first accesses 
the tag values which were read at the previous cycle time.
If the tag name matches the VBS name conventions in the project, you can use the tag in 
the user-defined function as follows.
'VBS_Example_03
 If BeltDriveOilTemperature > 100 Then [instruction]
If the tag name in the project does not match the VBS name conventions, you must 
reference the tag with the "SmartTags" list. In the following example, the tag name contains 
the "&" character, which is not allowed according to the VBS naming conventions.
'VBS_Example_04
SmartTags("Test&Trial")= 2005

● WinCC Runtime Professional
You have the same access possibilities as in the HMI devices with WinCC Runtime 
Advanced and Panels. You can also access the tag values asynchronously. The tag value 
in the PLC is accessed directly in asynchronous access. You access the tag value as follows 
in a local script or a user-defined C function:

– SmartTags list (VBS)

– Tags listing with Read-/Write method (VBS)

– GetTag function (C)

– SetTag function (C)

The tag value is read once from the PLC when the method or user-defined function is called. 
The tag value is not updated regularly, in contrast to when it is read from the tag image. 

Figure 9-2 Synchronous: Tag value directly from the PLC
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Figure 9-3 Asynchronous: Tag value from the tag image

Local tags     
You can only use local tags within user-defined functions or local scripts. 

You use local tags for the following:

● Buffers

● Counters, for example For instruction

Initialize every tag according to the programming language syntax.

Example: Dim objTagFillLevel

Initialize every tag with a value to avoid errors due to empty HMI tags. To use the value of the 
local tag outside, link it with an internal or external HMI tag. 

Access to HMI tags with dynamic names (WinCC Runtime Advanced and Panels)
The user-defined VB function accesses the tag value using the tag name. You can specify the 
tag name in such a way that the tag name is composed during the runtime of the user-defined 
function. 

If you only call the user-defined VB function in a screen in which the HMI tag is also used 
elsewhere, for example in an I/O field, you should for performance reasons configure the HMI 
tag with "Cyclic in operation" acquisition mode.

If the user-defined VB function is accessed and the HMI tag is not being used in the screen 
currently displayed, configure the HMI tag with "Cyclic continuous" acquisition mode. This 
ensures that the current value of the tag is always available.
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Testing the syntax of customized functions

Introduction
During programming, the code is tested in the background. Syntactical errors are marked with 
a wavy red line. The customized function is checked for correct syntax and valid object 
references. 

Check the syntax in the "Scripts" editor to identify all the errors in the code and output the 
appropriate error messages. In this case, error messages generated by the script parser are 
output. 

Use a separate debugger to check customized VB functions for logical programming errors.   

Error types
The following error types are detected in the syntax test and output in the "output window":

● Unknown string (e.g., not a keyword)

● Assignment of value to a constant

● The name of a local tag created with the Dim instruction is already known, e.g.: as a 
parameter, object, or component of the object model

● Syntax error

Requirements
● Customized function is open.

Procedure
Proceed as follows to check the syntax:

1. Click  to start the syntax check.
The syntax is checked. The result of the syntax check is displayed in the Inspector window 
under "Info > Compilation." Syntax errors are output with the line number. 

2. Correct the errors in the customized function if necessary.

Special consideration in the syntax checking of customized functions 
Customized functions are not interpreted until in Runtime. When an HMI device is being 
compiled, the system checks its user-defined functions for correct syntax. However, runtime 
errors may occur in certain circumstances. 
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Protecting user-defined functions

Setting up know-how protection

Procedure  
To set up know-how protection for user-defined functions, follow these steps:

1. Select the user-defined function without know-how protection that you want to protect.

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click "Define".
The "Define password" dialog box opens.

4. Enter a password in the "New" field.

5. Enter the same password in the "Confirm" field.

6. Confirm your entries with "OK".

7. Close the "Know-how protection" dialog by clicking on "OK".

Result
The user-defined function receives know-how protection. User-defined functions with know-
how protection are marked with a lock in the project tree. The password entered is valid for all 
user-defined functions selected. 

Opening user-defined functions with know-how protection
You can only open multiple user-defined functions with know-how protection at once if they 
are protected with the same password.

Procedure   
To create a user-defined function with know-how protection, follow these steps:

1. Double-click the user-defined function you want to open.
The "Access protection" dialog will open.

2. Enter the password for the user-defined function with know-how protection.

3. Confirm your entry with "OK".

Result
The user-defined function with know-how protection will open provided you have entered the 
correct password. However, the function will remain know-how protected. 

Once you have opened the user-defined function, you can edit it for as long as the user-defined 
function or TIA portal is open. You must enter the password again the next time you open the 
user-defined function. If you close the "Access protection" dialog with "Cancel" or "Close", the 
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user-defined function is opened but the code is not displayed. You cannot edit the user-defined 
function. 

Removing know-how protection

Procedure  
To remove the know-how protection of a user-defined function, follow these steps:

1. Select the user-defined function for which you want to remove know-how protection.
 

  Note

To remove know-how protection for several user-defined functions at once, all selected 
user-defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Deactivate the check box "Hide code (know-how protection)".

4. Enter the password.

5. Confirm your entries with "OK".

Result
Know-how protection will be disabled for the selected user-defined function. 

Changing a password

Procedure  
To change the password, follow these steps:

1. Select the user-defined function with know-how protection for which you want to change 
the password.

 

  Note

To change the password for several user-defined functions at once, all selected user-
defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click the "Change" button.

4. Enter the old password in the "Old" field.

5. Enter the new password in the "New" field.

6. Enter the new password again in the "Confirm" field.
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7. Confirm your entries with "OK".

8. Close the "Know-how protection" dialog by clicking on "OK".

Creating customized VB functions

Accessing objects with VBS

Introduction
The objects of the VBS object model with the appropriate properties and methods are available 
in user-defined VB functions.

The object properties can be read and changed in Runtime. 

Referencing objects
In customized VB functions you reference the objects by the corresponding list. To identify the 
object, use its name or the position number within the list. 

If you access the properties of an object more often, create an object reference. You can 
access object properties with and without object reference.   

With the following instruction the first object is referenced in the "MainScreen":

 
'VBS_Example_01
Dim objObject
'Change to Screen "MainScreen"
HMIRuntime.BaseScreenName = "MainScreen"
Set objObject = HMIRuntime.Screens(1).ScreenItems(1)

 

With the following instruction an object is referenced by its name and an object property is 
changed. You must have created the object with this name in the screen.

 
'VBS_Example_02
Dim objCircle
HMIRuntime.BaseScreenName = "MainScreen"
Set objCircle = HMIRuntime.Screens(1).ScreenItems("Circle_01")
objCircle.BackColor = vbGreen

Use of VB tags

Definition of VB tags
VB tags are declared by inserting definition lines in front of the function name of a user-defined 
VB function.
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Dim objScreen
Dim objScrItem
The validity range of a VB tag depends on where it was declared.

User-defined VB functions
In the "Scripts" editor, lines 1 and 2 are by default the declaration range. You can add any 
number of lines.

You can use a VB tag defined in this manner in user-defined VB functions. When you check 
the syntax in the "Scripts" editor, you receive a message that the VB tag is not known. 

The VB tag is only known in Runtime. It is created as soon as Runtime is started, even if the 
user-defined VB function itself is not called.

To prevent inconsistencies, the VB tags must be unique within the user-defined VB functions. 

Local VB scripts
You can show and hide the declaration range in the editor for local VB scripts. See "Editor for 
local scripts (Page 1784)" for additional information.

Validity range
● Local VB scripts with acyclic trigger

Every VB tag defined in this manner is automatically transferred to the declaration range 
of every local script with acyclic trigger. The declaration range remains empty for local 
scripts with cyclic trigger.

● Local VB scripts with cyclic trigger
Every VB tag defined in this manner is automatically transferred to the declaration range 
of every local VB script with cyclic trigger. The declaration range remains empty for local 
scripts with acyclic trigger.

Example
A local VB script is configured for the property "Background color". The local VB script has a 
cyclic trigger. 

The VB tags a and b are declared in the declaration range.
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When you configure a local VB script for the "Changed" event, this VB script has an acyclic 
trigger. The declaration range is empty.

When you configure a local VB script with cyclic trigger for a different property, the VB tags a 
and b are already declared in the declaration range.

See also
Editor for local scripts (Page 1784)
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Create customized VB functions

Introduction
When you create a customized VB function, you define the following settings:    

● The name with which you call the user-defined VB function.

● The type of user-defined VB function.

● The parameters which are transferred to the user-defined VB function in Runtime.

Use only the following characters for the name:

● "A" to "Z"

● "a" to "z"

● "0" to "9"

● "_" as a separator
 

  Note

When you change the parameters or the function type, the change is color marked at the 
application point, e.g. in the function list. 

 

Procedure
To create a user-defined VB function, follow these steps:

1. Open "Scripts" in the project tree.

2. Double click "Add new VB function" in the project tree under "VB scripts".

The user-defined VB function is created as a new tab in the work area. The input mask for 
the configuration settings of the user-defined VB function opens in the Inspector window.

3. Configure the user-defined VB function in the Inspector window "Properties > General > 
General".

4. Enter a descriptive "Name" for the user-defined VB function.
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5. Select the "Type" of the user-defined VB function.

– "Function" have a return value.

– "Sub" have no return value.

6. Click "<Add>" in the "Parameters" list to add parameters. Enter the parameter name and 
specify the parameter type.
Further information can be found in "Transfer and return of values in VBS (Page 1771)".

– "ByVal" transfers the parameter value.

– "ByRef" transfers the address of the parameter.

7. Enter its code in the work area.
You will find further information about this in ""Scripts" Editor" (Page 1753)".

Result
The user-defined VB function has been created. The type, name, and function parameters are 
displayed in the title bar. 

The start and end are inserted automatically when the user-defined function is created.

If you have protected the user-defined VB functions by a password, it is saved encrypted in 
the project. For additional information, refer to "Protecting user-defined functions (Page 1762)". 

The figure below shows a user-defined VB function which converts the temperature from 
"Fahrenheit" to "Degrees Celsius":

See also
Calling system functions (Page 1755)

Calling customized functions (Page 1757)
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Renaming customized VB functions

Renaming a user-defined VB function in the project tree   
Proceed as follows to rename a user-defined VB function in the project tree:

1. Select the desired user-defined VB function in the project tree.

2. Select the "Rename" (F2) command in the shortcut menu of the user-defined VB function.

3. Enter a new name for the user-defined VB function.

Renaming a user-defined VB function in the Inspector window
Proceed as follows to rename a user-defined VB function in the Inspector window:

1. Open the user-defined VB function in the "Scripts" editor.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the new function name.

Result
The user-defined VB function is renamed. The application points are adapted automatically.

Executing customized VB functions

Introduction
In WinCC you have the following options to execute a customized function:

● Function list

● Customized VB function

● Local VB script (only for WinCC Runtime Professional)
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Calling a customized VB function in a function list 
1. Add the user-defined VB function to a function list like a system function.

You will find the customized VB functions in the drop-down list under "VB functions". 
You will find further information about this in "Configuring a function list".

2. If the user-defined VB function has parameters, supply the parameters with static values 
or HMI tags.

3. If the user-defined VB function has a return value, select an HMI tag. The value to be 
processed is transferred to the HMI tag.

 

  Note

You can only use customized functions of the same programming language in a function 
list. You specify the programming language with the selection of the first customized 
function. 

 

Calling a customized VB function in a customized VB function 
1. Open the user-defined VB function in which you want to call the user-defined VB function.

2. Call the customized VB function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined VB function has a return value, assign an expression, such as a local 
tag, to the VB function.

 

  Note

You can only call user-defined functions of the same programming language in a user-
defined VB function. 

 

Calling a customized VB function in a local VB function 
1. The function list is converted into a local VB script.

2. Call the customized VB function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined VB function has a return value, assign an expression, such as a local 
tag, to the VB function.

 

  Note

You can only call user-defined functions of the same programming language in a local VB 
script. 

 

See also
Calling system functions (Page 1755)

Calling customized functions (Page 1757)
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Transfer and return of values in VBS

Transfer of a value
The following options are available for transferring parameters.

● "Call by Value" - ByVal
ByVal transfers the parameter value. If you transfer a tag as a parameter, the tag value is 
transferred to the user-defined function when the user-defined function is executed.

● "Call by Reference" - ByRef
ByRef transfers the address of the parameter. If you transfer a tag as a parameter, the tag 
address is transferred to the user-defined function when the user-defined function is 
executed. 
When user-defined functions and system functions are called in user-defined functions, the 
parameter is transferred as ByRef.

Return of a value
Return values can return the result of a calculation (e.g., average value of two numbers). But 
a return value can also give information about whether an instruction was executed correctly.  

Therefore, the system functions that perform file operations such as "Delete" also have return 
values. 

For a user-defined function to return a value, you must set the "Function" type. You assign the 
function name to the return value in the user-defined function:

To form an average value of two numbers, call the user-defined VB function Average and 
transfer the result to the HMI tag for example AverageValue. 

● In a customized VB function

 
SmartTags("AverageValue") = Average ("4", "10")

● In the function list

You can output the value of the HMI tag AverageValue in an I/O field. 
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See also
Create customized VB functions (Page 1767)

Example: Converting Fahrenheit into degrees Celsius (Page 1812)

Example: Converting inches into meters (Page 1814)

Creating user-defined C functions

Accessing objects with C

Introduction
To access the object properties, the following system functions are available:

● "GetProp"
System functions which begin with "GetProp" get a value. You will find additional information 
in C Scripting under "GetProp (Page 1865)".

● "SetProp"
System functions which begin with "SetProp" set a value. You will find additional information 
in C Scripting under "SetProp (Page 1896)".

There is a separate system function with GetProp and SetProp for every data type. 

Addressing an object property
You can open the object list for assigning parameters with <Ctrl+J> and select the available 
objects and properties from the list. The data types of the transferred parameters are checked 
for plausibility in a syntax validation. 

Writing an object property
The following example shows how a circle is moved to layer "4":

SetPropLong("Screen_1", "Circle_1", "Layer", 4);

See also
Example of accessing objects in the Screens editor (Page 1834)

SetPropLong (Page 1898)

Creating a C-Header

Introduction
Use the "GlobalDefinitions.h" header file to define functions, tags and constants which you 
need in all local C scripts and customized C functions. In this way local C scripts and 
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customized C functions remain slim and you avoid redundancy. Changes are carried out at a 
central point in the header file.

Customized C functions which you have defined in the project are automatically available. You 
do not need to define these C functions in the "GlobalDefinitions.h". 

C libraries such as "Math" are reference by default.

You can also:

● create additional C header files.

● integrate external C header files.

Creating an additional C header file
1. Double click "Add new header" under "Scripts >C headers" in the project tree".

2. Enter a "Name" for the C header in the Inspector window under 
"Properties >General >General".

3. Insert the required declarations of tags and constants in the work area.

Result
The C header is created. To use the declarations of the C header file in a C function, insert 
the C header in the global area of the C function. C header is integrated with an #include 
instruction.

 

 Note

C header files may not be read in several times, to avoid errors in the tag access. Multiple 
reading of header files is prevented for example by the following structure.

#ifnotdef __myHeader_h
 #def_myheader_h 
 #include "myheader.h" 
#endif

 

Include path for external C header files
You must specify the Include path to use external C header files. Proceed as follows:

1. Select the desired HMI device.

2. Select the "Options > Settings" menu command.

3. Select the path for the additional C header in the area navigation under "Visualization > 
Runtime Scripting".
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Result
The Include path for external C header files is specified. To use the declarations of the external 
C header file in a C function, insert the C header in the global area of the C function. C header 
is integrated with an #include instruction.

Use of Global C-Tags

Definition of global C tags      
A global C tag is inserted by adding the definition line in front of the function name of a function:

 

int a; //The tag a is defined as an integer
void dummy() //Function name
{
  //Function code
}

Validity range
A tag defined in this manner is known to every user-defined C function and local C script in 
Runtime. It is created as soon as Runtime is started, even if the user-defined function itself 
was not called.

 

 Note

When you operate the WinCC Service Mode, there is no common data area for C scripting. 
Thus, for example, no global C tags can be exchanged between user-defined C functions 
and the Screens editor.

 

Use of global C tags
You use global C tags in user-defined C functions or local C scripts by declaring the C tags 
within the header file "GlobalDefinitions.h" as external:

GlobalDefinitions.h
extern int global_a

Customized C function
// Insert the header starting here
#include "GlobalDefinitions.h"
void CFunction()
{
//insert the code starting here
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Printf ("C2: %i\r\n", ++ global_a);
}
The compiler is thus informed that it need not create the tag, because it is created in another 
location in Runtime.

If the value of the tag global_a is now changed, the tag value is changed in all the user-defined 
C functions and local C scripts.

Each C tag may only be defined in one location. For reasons of clarity and to avoid duplicate 
definitions, we recommend defining global C tags in only one location.

 

 Note

A maximum of 64 Kbytes is available to a user-defined function and the global C tag defined 
with it. 

 

Calling functions from DLLs in a user-defined C function

Introduction
You can use functions from DLLs in user-defined C functions. This lets you use the range of 
functions from existing DLLs and avoid redundancy. 

 

 Note
Release and debug DLLs

WinCC is supplied as a Release version and therefore uses the Release versions of system 
DLLs. If you want to use your own DLLs in the Debug version, you can also load the Release 
DLL. Always use the Release version of the DLL when using your own DLLs to avoid a system 
overload. 

 

Requirement
DLL is in the "..\Common Files\Siemens\bin" folder or in a folder which is defined in the PATH 
system tag. This tag is specified by the system properties of the operating system.

Procedure
Proceed as follows to call functions from DLLs:

1. Open the user-defined C function in which you want to call DLL functions.

2. Add the following code to the beginning of the user-defined C function:

 
#pragma code("<Name>.dll")
//Declare functions stored in DLL:
<Return value> <Function name 1>(...);
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<Return value> <Function name 2>(...);
...
<Return value> <Function name n>(...);
#pragma code

Result
The functions <Function name 1> ... <Function name n> from <Name.dll> are declared. You 
can call the functions in the user-defined C function. 

Example
The following example shows how to integrate the "kernel32.dll" file and call the 
"GetLocalTime" function:

 
#pragma code("kernel32.dll")
VOID GetLocalTime(LPSYSTEMTIME lpSystemTime);
#pragma code()
 
SYSTEMTIME st;
 
GetLocalTime(&st);

Create customized C functions

Introduction
When you create a customized C function, you define the following settings:    

● The name with which you call the user-defined C function.

● The type of user-defined C function.

● The parameters which are transferred to the user-defined C function in Runtime.
 

  Note

When you change the parameters or the function type, the change is color marked at the 
application point, e.g. in the function list. 

 

Use only the following characters for the name:

● "A" to "Z"

● "a" to "z"
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● "0" to "9"

● "_" as a separator
 

  Note

Names are not case-sensitive. It is not possible to create two user-defined C functions 
with the same name but different notation.

 

Procedure
Proceed as follows to create a new customized C function:

1. Open "Scripts" in the project tree.

2. Double click "Add new C function" in the project tree under "C scripts".

The user-defined C function is created as a new tab in the work area. The input mask for 
the configuration settings of the function opens in the Inspector window.

3. Configure the function in the Inspector window "Properties > General > General".

4. Enter a descriptive "Name" for the user-defined C function.
Select the "Type" of the user-defined C function. Further information can be found in 
"Transfer and return of values in C".

– Void: Function has no return value.

– Tag: Return value is returned as a tag value.

– Pointer: Return value points on the address of the tag.

5. Double click "<Add>" in the "Parameters" list to add parameters. Enter the parameter name. 
Further information can be found in "Transfer and return of values in C".

– Tag transfers the parameter value.

– Pointer transfers the address of the parameter.

6. Write the code in the work area.
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Result
The user-defined C function is created. The type, name, and function parameters are displayed 
in the title bar. 

The start and end are inserted automatically when the user-defined function is created.

If you have protected the user-defined C function by a password, it is saved encrypted in the 
project. See "Protecting user-defined functions (Page 1762)" for additional information.

The figure below shows a user-defined C function which converts the temperature from 
"Fahrenheit" to "Degrees Celsius":

See also
"Scripts" editor (Page 1753)

Renaming customized C functions

Renaming a user-defined C function in the project tree   
Proceed as follows to rename a user-defined C function in the project tree:

1. Select the user-defined C function in the project tree.

2. Select the "Rename" (F2) command in the shortcut menu of the user-defined C function.

3. Enter a new name for the user-defined C function.
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Renaming a user-defined C function in the Inspector window
Proceed as follows to rename a user-defined C function in the Inspector window:

1. Open the user-defined C function in the "Scripts" editor.

2. In the Inspector window, click "Properties > General > General".

3. Enter the new function name.

Result
The user-defined C function is renamed. The application points are adapted automatically.

Executing customized C functions

Introduction
In WinCC you have the following options to execute a customized C function:

● Function list

● Customized C function

● Local C script

Calling a customized C function in a function list 
1. Add the user-defined C function to a function list like a system function.

You will find the customized C functions in the drop-down list under "C functions". 
You will find further information about this in "Configuring a function list".

2. Supply the parameters with static values or HMI tags.

3. If the user-defined C function has a return value, select an HMI tag. The value to be 
processed is transferred to the HMI tag.

 

  Note

You can only use customized functions of the same programming language in a function 
list. You specify the programming language with the selection of the first customized 
function. 
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Calling a user-defined C function in a user-defined C function
1. Open the user-defined C function in which you want to call the user-defined C function.

2. Call the customized C function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined C function has a return value, assign an expression, such as a local tag, 
to the function.

 

  Note

You can only call user-defined C functions of the same programming language in a user-
defined C function. 

 

Calling a customized C function in a local C script 
1. The function list is converted into a local C script.

2. Call the customized C function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined C function has a return value, assign an expression, such as a local tag, 
to the C function.

 

  Note

You can only use user-defined functions of the same programming language in a local C 
script. 

 

 

See also
Calling system functions (Page 1755)

Calling customized functions (Page 1757)
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Transfer and return of values in C

Transfer of a value
You have the following possibilities for transferring parameters:

● Tag (Call by value)
The tag name and the data type are specified to save values in the tag. But this tag is not 
transferred directly but a copy made. When executing the user-defined C function, the tag 
value of the copy is transferred to the C function. If you change the tag value, the change 
is only valid within the user-defined C function.

● Pointer (Call by reference)
A pointer is a tag which points on the address of a tag. Pointers are defined like tags. The 
* character is added to the data type, e.g. Double*. The user-defined C function accesses 
the tag to which the pointer is pointing. If you change the tag value, the changed tag value 
is written into the tag. 

Return of a value
A user-defined C function can execute simple instructions and return no value. The return 
value is then a "void" data type.

If a return value is required, the value can be returned as a tag or a pointer. 

But a return value can also give information about whether an instruction was executed 
correctly. Therefore, the system functions that perform file operations such as write to a file 
also have return values.  

For a user-defined C function to return a value, you must set the "Double" type. The result is 
transferred to the user-defined C function with the return instruction.

To form an average value from two numbers, call the user-defined C function Average and 
transfer the result to the HMI tag, for example, AverageValue. 

● In a customized C function

 
SetTagDouble("AverageValue",Average (4, 5));
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● In the function list

You can output the value of the HMI tag AverageValue in an I/O field. 

9.8.1.4 Creating local scripts

Local scripts

Definition
Local scripts are bound to a single object, such as an object property, and have a cyclic or 
acyclic trigger. A local script is created directly at the point of use: 

● Scheduler

● Screens

– Event (converted function list)

– Object property (property list)

– Property change (property list)

● Menus and toolbars

● Only C script: Reports

– I/O field at the process value property

Local scripts are not displayed in the project navigation and are only available at the point of 
use. 

Application         
Local scripts are used for the following:

● Property list (screen object): Dynamic control of object properties
A local script is used to dynamize an object property in Runtime by means of its return 
value. Example: Changing the object position in dependence of several parameters.

● Function list (screen object): Converting a function list to a local script
Convert a function list to a local script in order to configure conditional instructions or loops 
at an event. 

● Scheduler (task): Execute local script cyclically or acyclically
Use the Scheduler to execute a script at a specified point in time. 

Local scripts are not loaded into the memory of the HMI device until they are used, for example 
when loading a screen. Local scripts thus reduce memory requirements on the HMI device. 
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Programming
When a local script is created at an object property, a local script with return value is generated. 
The return value supplies the value for the object property. 

When a local script is created at an event, a local script without return value is generated. 

The parameters which are transferred to the local script depend on the used programming 
language and the application point.

Typical parameters of a local VB script

Item: Contains the object reference:

● Scheduler (task): No object is transferred.

● Menu & toolbars: The object that triggers the event is transferred.

● Screens (screen object):

– Property list (screen object): In dynamizations, the screen object whose property you 
dynamize is transferred.

– Converted function list (screen object): The screen object whose event you configure is 
transferred.

To access the properties of the transferred screen object, enter "item.". The available 
properties are listed. Use ScreenItems to access another object of the object model.. 
Further information about parameters of events are available in the reference. 

Typical parameters of a local C script

Char* screenName: Contains the name of the screen that contains the object whose property 
is being dynamized. 

Char* objectName: contains the name of the object whose property you dynamize.

Char* propertyName: Contains the property that is being dynamized. 

Further information about parameters of events are available in the reference. 

Execution of local scripts
Local scripts require a trigger. The trigger specifies when the script will be executed. The point 
of use of the local script determines which trigger is used:

● Local scripts of a converted function list are executed when the event occurs, for example, 
printing.

● Local scripts in the property list get the trigger automatically. You can change the trigger, 
e.g. to tag trigger.

● Local scripts of a task are assigned a trigger by the project engineer.

See also
"Scripts" editor (Page 1753)
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Editor for local scripts

Properties of the editor for local scripts   
The editor for local scripts has no own setting possibilities but "inherits" the settings from 
"Runtime Scripting".

The editor offers similar functions to the "Scripts" editor. You will find further information in 
""Scripts" editor (Page 1753)".

The following functions are not available in the toolbar:

● Drop-down lists for properties and functions

The editor for local VB scripts contains the following additional icons:

●  Shows declaration range.

●  Hides declaration range.

You define local VB tags in the declaration range. See "Use of VB tags (Page 1764)" for 
additional information.

Availability   
The editor for local scripts can be called in the following places:

● Scheduler

– Event: Execute

● Screens

– Event

– Object property (property list)

– Property change (property list)

● Menus and toolbars

– Event: Click

● Only C script: Reports

– I/O field at the process value property

See also
"Scripts" editor (Page 1753)

Converting a function list to a local script

Introduction
When you convert a function list to a local script, you can configure conditional instructions or 
loops for an event. A function list is converted either to a local VB or C script. 
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If the function list does not contain a customized function, the programming language is 
determined by the function. 

If a C function is contained, for example, the function list is converted into a local C script.

Requirement
The function list is opened.

Procedure    
Proceed as follows to convert a function list to a local script:

1. Select the event whose function list you want to convert to a script.

2. Configure system functions at the event as required.

3. To convert the function list to a local script, click  or .

4. Write the program code.

Alternatively you use the "Convert VB script" or "Convert C script" command in the shortcut 
menu.

Result
If the event occurs, the local script is processed automatically.

Deleting a local script    
Proceed as follows to delete a local script:

1. Select the event with the local script.

2. Select "Function list" in the shortcut menu of the event.

The local script is deleted. 

Dynamizing an object property with a local script

Introduction
With a local script you dynamize an object property in Runtime by the return value of the script. 

Requirement
● The object with the property to be dynamized is selected.

● The Inspector window is open.
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Procedure    
1. Click  in the Inspector window.

2. Select the object property to be dynamized.

3. Select the "VB script" or "C script" entry in the "Dynamization" column.
A dialog opens.

4. Write the program code.

5. Click " " in the toolbar to change the trigger.

Result
The object property changes in Runtime according to how the property list is configured.

Deleting the dynamization    
1. Select the dynamized object property in the property list.

2. Select the "None" entry in the "Dynamization" column.

9.8.1.5 Debugging

Debugging user-defined VB functions

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.   

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:
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● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".

 

Error types
The following error types are distinguished when debugging:      

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

For tips and tricks on debugging, common sources of error, and further information, refer to 
the online help for the Microsoft Script Debugger.
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Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

Integrating the Debugger

Installing a script debugger for WinCC
A VBScript-capable debugger must be installed to search for errors in user-defined VB 
functions.

The following VBScript-capable debuggers have been tested and released:

● Microsoft Script Editor by Office XP

● Microsoft Script Debugger: The English version "scd10en.exe" must be used. The German 
version "scd10de.exe" may not be installed.

An installed debugger is started as follows:

● If a runtime error occurs during execution

● Via "Online > Simulate Runtime > With script debugger"

Microsoft Script Editor
The Microsoft Office XP component "Microsoft Script Editor" contains a Script Debugger. If 
the default configuration was installed by Microsoft Office Setup, the "Microsoft Script Editor" 
component is not installed until called the first time ("Installed on First Use"). If you wish to 
explicitly install these components, you must specify it in the Microsoft Office setup. Select the 
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component selection menu, click"Web Debugging" component and then select the "Run from 
My Computer" option.

If a project is activated in WinCC via "Online > Simulate Runtime > With script debugger", a 
dialog containing the list of available script debuggers appears when the first user-defined 
function is run.

Other installed script debuggers such as "Microsoft Visual Interdev" or "Microsoft Visual 
Studio .NET" may also appear in the list. Select "Microsoft Script Editor" and confirm your 
selection with "Yes".
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Activate the "Script" program object in the "Step Into Remote Procedure Call" dialog and 
confirm your selection with "OK".
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The "Microsoft Script Editor" is launched. The execution pauses at the first line of the first 
function.
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Microsoft Script Debugger
If a script debugger is not available, download "Microsoft Script Debugger" (scd10en.exe) free 
of charge from Microsoft (www.microsoft.com). It will be started automatically in WinCC once 
it is installed.

 

 Note

The "Microsoft Script Debugger" can no longer be called or installed when another VBScript-
capable script debugger is available on your computer.

 

Script Debugger is not started at the start of Runtime
If you installed a script debugger and the "Start Runtime with Script Debugger" command still 
fails to start it, make the following settings in the Windows registry to set Microsoft Script 
Debugger as default Just-In-Time (JIT) Debugger: 

● "HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}]
(Default)="ScriptDebugSvc Class"
"AppID"="{A87F84D0-7A74-11D0-B216-080000185165}"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F20-00805F2CD064}\LocalServer32]
(Default)="c:\\Program Files\\Microsoft Script Debugger\\msscrdbg.exe"
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● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}\ProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc.1"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F2000805F2CD064}\VersionIndependentProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc"

The "LocalServer32" file path must point to the installation folder of Microsoft Script Debugger. 
If you have installed Microsoft Script Debugger in a different folder, adapt the path information. 

Starting and stopping the debugger

Requirement
● VBScript-capable debugger (e.g., MS Script Debugger) and WinCC Runtime are installed 

on the configuration PC.

● Project is open.  

Starting the debugger
To start the debugger, proceed as follows:

1. Select the HMI device and then select the "Online > Simulation > With script debugger" 
menu command.
The Runtime software searches for debuggers installed on the configuration PC. 

2. If several debuggers are found click on the one required.

Or:

1. Click "Start > Run".

2. Enter the following command: "HmiRtm /ScriptDebug /<ProjectFile>".
Further information about the project file can be found in "Starting Runtime Advanced and 
Panels (Page 2197)".

Or:

1. Select the "debug" command in the project file shortcut menu in the Windows Explorer.

Result
The debugger is connected automatically with the runtime software.

Stopping the debugger
The debugger is not closed automatically when you close the Runtime software. Therefore, 
close the debugger separately.   
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9.8.1.6 Debugging

Debugging of VBScript files

Overview             
The following VBScript-capable debuggers have been tested and approved:

● Microsoft Script Debugger (runs with Windows 2000 and Windows XP): The English version 
"scd10en.exe" must be used. The German version "scd10de.exe" cannot be installed.

● Debugger "InterDev" (contained in scope of installation material supplied with Developer 
Studio )

● Microsoft Script Editor (MSE) Debugger (contained in material supplied with Microsoft 
Office)

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values

The following description relates exclusively to handling the Microsoft Script Debugger.
 

 Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

Error types
The following error types are distinguished when debugging:           

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
In order to intercept runtime errors, you use the "On Error Resume Next" instruction in the 
function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. In order to stop the handling of 
runtime errors in the function again, use the "On Error Goto 0" instruction. 
Example for error handling

 
Sub OnClick(ByVal Item)
'VBS27
  Dim objScreenItem
'
  'Activation of errorhandling:
  On Error Resume Next
  For Each objScreenItem In ScreenItems
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    If "HMIRectangle" = objScreenItem.Type Then
    '
      '=== Property "RoundCornerHeight" only available for RoundRectangle
      objScreenItem.RoundCornerHeight = objScreenItem.RoundCornerHeight * 2
      If 0 <> Err.Number Then
        HMIRuntime.Trace objScreenItem.Name & ": no RoundedRectangle" & vbCrLf
        '
        'Delete error message
        Err.Clear
      End If
    End If
  Next
  On Error Goto 0  'Deactivation of errorhandling
End Sub

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the function 
step by step. In this way, you identify the portion of the function that is not working.

Download the Microsoft Script Debugger
The Microsoft Script Debugger is located in the Microsoft Download-Center under the following 
URL:

● http://www.microsoft.com/downloads/Search.aspx?
displaylang=en833a6a92-961e-4ce1-9069-528d22605127 

Use the "Search" field to search for "Script Debugger" and select the required download.

Notes on the MSE Debugger
The following settings must be changed when using the MSE Debugger so that the running 
processes will be displayed:

1. Select Processes > Properties to activate the "Just-in-time debugging" option.

2. Restart the computer.

3. Deactivate the "Disable script debugging" option in MS Internet Explorer. As a result, 
Internet Explorer will not prevent the debugging operation of WinCC.

Activating the debugger

Principle       
There are several ways of activating the debugger:

● Automatic call of the debugger after an error has occurred in Runtime.

● Display of an error box in Runtime which is used to call the debugger.

● Starting the debugger from the Start menu and opening an active Runtime script.
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Requirement
Microsoft Script Debugger is installed on the configuration PC.

Procedure
Start the debugger in Runtime as follows: 

1. Select the HMI device and then select "Online > Simulation > With script debugger".
The Runtime software searches for debuggers installed on the configuration PC. 

2. If several debuggers are found click on the one required.

Starting the debugger later
As an alternative, run the debugger later and interconnect it with the currently active system. 
To do so, establish a connection in the debugger to the "pdlrt.exe" process for the Graphical 
Runtime System and the "gscrt.exe" process for the Global Runtime System.

Exiting the debuggers
Exit the debugger without closing WinCC Runtime. 

Components of the Microsoft Script Debuggers

Introduction 
Microsoft Script Debugger supports debugging by means of the following components:

● "Command Window"

● "Running Documents" window

● "Call Stack" window

"Command Window"
Open the "Command Window" by selecting the "View" > "Command Window" menu command.

While a VBScript file is running in Runtime, use the "Command Window" of the debugger, for 
example, to identify and edit the values of tags and properties of the active VBScript file. 
Changes made in the "Command Window" have a direct effect on the running VBScript file so 
that planned changes can be tested immediately.

Perform the following actions in the "Command Window":
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● Command input
Enter commands directly in VBScript and then execute these.

● Change tag values:
Acquire and edit tag values in the "Command Window". This relates to both local tags in 
VBScript files and HMI tags.

● Modify properties:
You can read and write the properties of all objects of the current script context.

Always use the "Command Window" after a VBScript file has reached a breakpoint or after 
you called other commands at the breakpoint.

 

 Note

Note that any changes made in the "Command Window" do not affect the source code of 
your user-defined function and are only used for test purposes in the debugger.

 

"Running Documents" window
Open "Running Documents" window by selecting the "View > Running Documents" menu 
command.

In the "Running documents" window, you see all user-defined functions currently running in 
WinCC Runtime. The local scripts are divided into scripts from the scheduler ("Global Script") 
and local scripts of the graphical Runtime system ("Graphic). You see all running local scripts 
and user-defined functions of the scheduler. The local scripts in the graphical Runtime system 
are divided into trigger-driven scripts (ScreenName_trigger) and event-driven scripts 
(ScreenName_events).

"Call Stack" window
Open the "Call Stack" window by selecting the "View" > "Call Stack" menu command.

The "Call Stack" window outputs a list of all current user-defined functions and of local scripts 
called. The name of a local script called is added to the "Call Stack" list, for example. The name 
is removed again from the list after the local script is completed. Select a local script from the 
list to jump to the corresponding script call position in the VBScript file. 

Structure of VBScript files

Principle
Event-driven and cyclic/tag-triggered VBScript files are strictly separated during their execution 
to prevent any interference with simultaneous processing of cyclic and event-driven VBScript 
files in the graphical Runtime system. A cyclic local script cannot interfere with the execution 
of a user-defined function which is to be triggered by clicking a button, for example.
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The event-driven and cyclic/tag-triggered local scripts are saved to separate VBScript files 
when you save screens to ensure this behavior. Any global screen element you have defined 
for VBScript files in the "Screens" editor is copied to both VBScript files.

 

 Note

Because the two VBScript files are handled separately, they have no common data area. 
Therefore, there is no synchronization of global tags between the two VBScript files. 
Implement any synchronization function which may be required using the DataSet object or 
internal HMI tags.

 

Structure of VBScript files
When VBScript files are debugged with a debugger, the VBScript files always open the different 
Runtime systems.

In the case of the graphical Runtime system, this means that you receive two files per picture:

● <ScreenName>.pdl_events: Contains the event-driven scripts.

● <ScreenName>.pdl_triggers: Contains the cyclic and tag-driven VBScript files.

The following section describes the structure of script files within the graphical Runtime system:

● Content of the VBScript file <ScreenName>.pdl_events
General code
Event-driven scripts

● Content of the VBScript file <ScreenName>.pdl_triggers
General code
Cyclic or tag-triggered scripts

 

  Note

Note that the local scripts and user-defined functions of the graphical Runtime system are 
not displayed by their names in the VBScript file to which they were saved in WinCC. For 
more information refer to Names in the debugger (Page 1803).

 

Selecting a VBScript file for processing

Introduction
You can select a user-defined function or a local script for editing after having opened Microsoft 
Script Debugger from the Windows Start menu while Runtime is active.

Requirement
● Runtime is activated.

● The screen to be debugged is active.
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Procedure
1. Go to the Windows Start menu and select "Programs > Accessories > Microsoft Script 

Debugger".

2. Activate the "View > Running Documents" command in the menu bar.
The "Running Documents" window opens. In this window, you see all VBScript files 
currently running in WinCC Runtime. The files are divided into VBScript files from the 
scheduler ("Global Script") and VBScript files of the graphical Runtime system ("Graphic).

3. Double-click the VBScript file to debug in the "Running Documents" window.
The script document opens with write protection in the debugger window. 

Executing a VBScript file step-by-step

Introduction
Use Microsoft Script Debugger for step-by-step execution of your VBScript files (user-defined 
function or local script) to systematically isolate logical errors, for example. Simulate the effect 
of each code line in Runtime.

The Procedure in Principle
1. Activate the document to debug in Runtime.

2. Start the debugger manually from the Start menu and open the required VBScript file or 
activate the debugger in WinCC.
When activated in WinCC, the debugger automatically opens when an attempt is made to 
execute an erroneous VBScript file.

3. Set a breakpoint in the VBScript file. Breakpoints are normally set in front of code lines in 
which errors are suspected.

4. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript 
files.
The debugger stops at the first break point and marks the current line.

5. Select one of the following menu commands for step-by-step simulation of the VBScript 
document:

– "Debug > Step Into": Skip to the next code line. If the script calls a procedure in this line, 
it skips to the procedure using the "Step Into" command. Execute the called function 
step-by-step.

– "Debug > Step Over": Skips the user-defined function called. The user-defined function 
is executed but the debugger does not stop at the individual lines of the function. Instead 
it moves to the next line of the current VBScript file after the function was executed.

6. Select the "Debug" > "Step Out" menu command to cancel step-by-step execution of a user-
defined function.
The debugger then steps to the next action.

7. Step through the document until you reach the end or select the "Debug" > "Run" menu 
command to restart the VBScript file in Runtime. 
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Setting breakpoints

Introduction
Set breakpoints to stop VBScript file execution at specific points and to start the debugger. Set 
a breakpoint before a line in which you suspect a scripting error, for example.

Use the breakpoints as follows:

● Set breakpoints at specific lines for step-by-step isolation of logical errors in your VBScript 
file.

● Set a breakpoint and call the debugger before the next line of the VBScript file is executed. 
Deploy this procedure to handle "Screen change" events, for example.

When a VBScript file is updated in the debugger, all the breakpoints are lost.

All of the trigger- or event-controlled procedures are stopped in Runtime if you set a breakpoint 
in one of the script files "<ScreenName>.pdl_trigger" or "<ScreenName>.pdl_event".

Requirement
● Runtime is activated.

● The screen to be debugged is active.

Procedure
1. Start the debugger and select the VBScript file.

If automatic activation of the debuggers in WinCC has been selected, the debugger is called 
in as soon as an erroneous script is executed.

2. Place the cursor in the action in which a breakpoint is to be set.

3. Select "Debug > Toggle Breakpoint" in the menu, or the toolbar icon .
The next executable line is marked with a red dot.

4. Change to WinCC Runtime and execute the VBScript file to be debugged.
The debugger stops at the first breakpoint. The current line is displayed on a yellow 
background.
Simulate the program code step-by-step. 

Deleting breakpoints

Introduction
Delete specific or all of the breakpoints in a VBScript file after having successfully cleared an 
error.
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Procedure
1. Position the cursor in the line whose breakpoint is to be deleted.

2. Select "Debug > Toggle Breakpoint" in the menu, or the toolbar icon .
The line is again displayed without marker.

3. You delete all breakpoints from a VBScript file by selecting the "Debug > Clear all 
Breakpoints" menu command or by clicking the toolbar icon .

Setting a bookmark in the VBScript file

Introduction
Within the debugging session, set bookmarks at the code lines to facilitate retrieval of a specific 
line.

Setting or deleting bookmarks
1. Position the cursor in the line in which a bookmark is to be set or deleted.

2. Press <Ctrl+F2>.
A bookmark is either set or deleted

Skipping to the next bookmark
Press <F2> to skip to the next bookmark in the VBScript file.

Skipping to the previous bookmark
Press <Shift+F2> to skip to the previous bookmark in the VBScript file. 

Acquiring and editing tag and property values

Introduction
Use the "Command Window" of the debugger while a VBScript file is active in Runtime, for 
example, to acquire and edit tag or property values. You reset a process value for the user-
defined function to zero without having to stop the process, for example.

 

 Note

To ascertain the name of a WinCC object in Runtime, click <Ctrl+Alt+Shift> and position the 
mouse over the corresponding object. The screen name and the object name are displayed 
in a tooltip. 
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Requirement
● The VBScript file runs in Runtime.

● The debugger is open.

Procedure
1. Set at least one breakpoint in the VBScript file.

2. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript file.
The debugger stops at the first breakpoint.

3. Select "View > Command Window".
The "Command Window" opens.

4. Enter the following string to query a tag or property value:

– "?", followed by a space character

– and the name of the tag or property you want to query

– Example: "? myTag"

5. Execute the command by pressing <Enter>.

6. Change the value of a tag/property by assigning it a value in the VBS syntax.

Executing script commands

Introduction
Use the "Command Window" of the debugger to directly execute commands while a VBScript 
file is active in Runtime. This is how you can manipulate VBScript file execution. You execute 
the script commands directly for testing without creating the command in a script and then 
executing the script. You control the following commands, for example:

● To retrieve methods

● To retrieve procedures

● To manipulate object properties

The "Command Window" is used to execute all commands which can also be executed in a 
VBScript.

Requirement
● The VBScript file runs in Runtime.

● The debugger is open.
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Procedure
1. Set at least one breakpoint in the VBScript file.

2. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript file.
The debugger stops at the first breakpoint.

3. Select "View > Command Window". "Command Window" opens.

4. Enter the required command and confirm with "ENTER".
 

  Note

An error message will not be generated in runtime if you enter an invalid command in the 
"Command Window". The message "<Script Error>" will appear in the Command Window 
instead. 

 

Example

 
Dim i
For i = 1 to 10 
     HMIRuntime.Trace i & vbnewline
Next

When this VBScript is executed and the debugger is in the loop at the breakpoint, you can use

● ?i
to read out the value of variable i

● i = 5
to set the value of variable i to 5.

Names in the debugger

Names in the debugger 
The names of user-defined functions in the debugger differ from the names by which you saved 
your user-defined functions in WinCC.

The function and script names in the script files are compiled according to the following rules:

Action type Name of the script file
Cyclic or tag-triggered scripts at a property ObjectName_PropertyName_Trigger
Mouse events ObjectName_OnClick

ObjectName_OnLButtonDown
ObjectName_OnLButtonUp
ObjectName_OnRButtonDown
ObjectName_OnRButtonUp
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Action type Name of the script file
Keyboard events ObjectName_OnKeyDown

ObjectName_OnKeyUp
Object events ObjectName_OnObjectChanged

ObjectName_OnSetFocus
Events on properties ObjectName_PropertyName_OnPropertyChanged

ObjectName_PropertyName_OnPropertyStateCha
nged

Picture events Document_OnOpen
Document_OnClosed

Valid length of the script names
The name of scripts in the script files is limited to 255 characters. Each special character used 
in an object name is converted to five characters. The special character appended to the 
leading X is represented as four-digit hexadecimal code. If you configure a button action named 
"PushMe" with mouse click trigger, the "DrXFFFCckMe_OnClick" script is written to the script 
file.

If the composite object name is too long, the syntax check in WinCC returns an error message. 
Because of this restriction, you cannot configure graphic object names of unlimited length.

 

 Note

To ascertain the name of an object in Runtime, click <Ctrl+Alt+Shift> and position the mouse 
over the corresponding object. The screen name and the object name are displayed in a 
tooltip. 

 

Diagnostics

Diagnostics

Introduction  
If you execute your local VB scripts and C scripts in Runtime, you output a quick analysis with 
the aid of the application window.

Diagnostics tools
WinCC provides you with tools to analyze the runtime behavior in local C scripts and VB scripts:

● The "GSC diagnostics" application window

● Using a debugger
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Usage
To use the GSC diagnostics, you insert the "Print job/Script diagnostics" object in a screen. 
Use the "GSC diagnostics" template.

This can be a dedicated screen which is designed for diagnostics and which is called in 
Runtime.

GSC diagnosis of VBS
GSC diagnostics returns the trace methods contained in the local scripts in the order in which 
they were called. Trace instructions in user-defined VB functions, which are called in local 
scripts, are also output. Explicit implementation of trace instructions, e.g., for output of the tag 
values, enables the tracing of script execution and of the functions called within those scripts. 
You enter the trace instruction in the form "HMIRuntime.Trace(<Output>)". Error situations 
which result in calling of the OnErrorExecute function are also displayed in the diagnostic 
window.

GSC diagnosis of C
GSC diagnosis outputs the printf methods contained in the local scripts in chronological order 
of their being called. printf instructions in user-defined C functions, which are called in local 
scripts, are also output. By targeted use of printf instructions, e.g. for outputting tag values, 
the sequence of scripts and the functions called in them can be tracked. 

See also
Example of configuring a diagnostics output via a trace (Page 1821)

GSC diagnostics

Introduction
GSC Diagnostics outputs the trace instructions of the scripts to the diagnostics view in the 
chronological order of their call. The application also outputs trace instructions in functions 
which are called in the scripts. Explicit implementation of trace instructions, e.g. for output of 
the tag values, enables the tracing of script execution and of the functions called within those 
scripts. 

Application
Insert an application window of the type GSC Diagnostics in a screen to enable the use of 
GSC Diagnostics. Control the appearance of the GSC Diagnostics window by means of the 
GSC Diagnostics properties.
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In the case of a picture change, the content of the GSC Diagnostics window is deleted.
 

 Note

Messages are also displayed in the "GSC Diagnostics" window when the debugger is 
activated. 

 

See also
Print job/Script diagnostics (Page 837)

Inserting a GSC diagnostics window in a screen 

Introduction     
To use the GSC diagnostics, you insert an application window in a screen. Use either any 
existing screen, or create a screen that is dedicated to diagnostics functions. In the Inspector 
window of the application window, you specify that the application window is to be used for 
GSC diagnostics.

Requirement
● The required screen is open.

● The "Tools" task card is open.

Procedure
Proceed as follows to insert the GSC diagnostics window:

1. Insert the "Application window" object from the "Controls" palette of the "Tools" task card 
into the screen.

2. Assign a name to the GSC diagnostics window at "Miscellaneous > Name".

3. Select the "Functions" option in the inspector window under "Properties > Properties > 
General > Content > Window content".

4. Select the "GSC diagnostics" option under "Template".

5. Specify the further settings for the GSC diagnostics window under "General", "Layout", and 
"Miscellaneous".
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9.8.1.7 Runtime behavior in Runtime

Executing user-defined functions in Runtime

Principle
Only one user-defined function at a time is executed in Runtime. If several user-defined 
functions are waiting to be executed, they are lined up in a queue and executed one after the 
other. 

 

 Note

A loop in a user-defined function therefore blocks the execution of the other functions in the 
queue even if the functions were initiated asynchronously.

 

WinCC supports a maximum nesting depth of eight user-defined functions. Note that the 
nesting depth is not checked.    

 

 Note

If a user-defined function is configured for the "Runtime stop" event, the only system functions 
that may be used in this user-defined function are those which are available at the "Runtime 
stop" event.

Ensure that the ending of the Runtime is not interfered with by the execution of the user-
defined function. 

 

 Note
Configuration of user-defined functions

During configuration make sure that not too many user-defined functions are activated at the 
same time. Avoid a continuous system load of 100%. 

User-defined functions are processed at a lower priority so as not to interfere with the display 
of values and operability. If system utilization is extreme, the user-defined functions to be 
executed are therefore first only reserved for execution. The maximum size of the reservation 
list is dependent on the HMI device and is limited by the maximum permitted number of user-
defined functions. For additional information, see the performance features. If more user-
defined functions are activated at one time than can be reserved, excess calls are discarded 
and a system alarm displayed.

 

HMI device changeover
If you use system functions in a customized function which are not available on the set HMI 
device, you get a warning.  In addition, the corresponding system function in the user-defined 
function will be underlined with a wavy blue line.   
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See also
User-defined functions (Page 1745)

Executing a function list in Runtime

Principle
A function list is executed from top to bottom in Runtime. A distinction is made between 
synchronous and asynchronous execution, so that no waiting periods ensue during execution. 
The distinction is made by the system by evaluating the different runtimes of the system 
functions. User-defined functions are always executed synchronously independent of the 
runtime. If a system function returns an error status, the execution of the function list is 
cancelled.   

Synchronous execution
During synchronous execution, the system functions in a function list are executed one after 
the other. The previous system function must be finished before the next system function can 
be executed.  

Asynchronous execution
System functions that perform file operations such as saving and reading have a longer runtime 
than system functions that, for example, set a tag value. 

Therefore, system functions with longer runtimes are executed asynchronously. For example, 
while a system function is writing a recipe data record to a storage medium, the next system 
function is already being executed. Due to the parallel execution of system functions, waiting 
periods at the HMI device are avoided.  

Execution of functions and local scripts in Runtime

Processing local scripts in Runtime
Two locale scripts of the same type cannot be executed simultaneously in Runtime. Event-
triggered and cyclic/tag-triggered scripts in screens are executed separately to prevent any 
script from interfering with cyclic scripts.

 

 Note

The script types in WinCC are synchronized exclusively by the DataSet object or internal HMI 
tags. Separate execution prevents the generation of any shared data areas for event-
triggered and cyclic/tag-triggered scripts.

 

If high system load or other scripts interfere with cyclic execution of local scripts in the screens, 
the local script is executed once at the next opportunity. Cycles which are not executed are 
not retained in a queue but rejected.
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After a screen change any active scripts are stopped automatically on expiration of 1 minute.

Local scripts which are still active at the end of Runtime are stopped after 5 seconds.

Executing functions in Runtime
Functions are executed successively in Runtime after being triggered. If a function is initiated 
while another is active, the second function is queued until it can be executed.

 

 Note

The local scripts and functions are synchronized exclusively by the DataSet object or internal 
HMI tags. Local scripts and functions do not share any data areas.

 

See also
User-defined functions (Page 1745)

Local scripts (Page 1747)

Processing sequence for user-defined functions and system functions
 

 WARNING

Adherence to the expected processing sequence for user-defined functions and system 
functions in Runtime cannot always be guaranteed. This fact may lead to unexpected 
operating states.

Please note the following description in which the correlations are explained. Instructions for 
a solution are available under "Remedy".

 

Use of user-defined functions for events       
It is not always possible to adhere to the processing sequence for user-defined functions and 
system functions expected in the configuration, for example, when the processing of a user-
defined function lasts beyond the trigger time of a subsequent event. In this case, system 
functions that are configured for the following event may be executed before the system 
functions that were configured with the user-defined function for the same event.

Background
User-defined functions are arranged in a low-priority queue. The queue is processed in 
sequence. If system functions and user-defined functions are configured for an event, all 
system functions and user-defined functions configured for this event are executed in this 
queue.
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Example
On a button, you have configured:

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release ResetBit(Tag) (3)

A

B

Press

Interrupts

lower priority

program

Release

Press Release

(1) Execution time of the user-defined function
(2) Execution time of system function SetBit(Tag)
(3) Execution time of system function ResetBit(Tag)

A: Expected execution of the user-defined function and system functions in the configuration.

When you press the button, user-defined function (1) and then system function SetBit(Tag) 
(2) are executed. When you release the key, system function ResetBit(Tag) (3) is then 
executed.

B: Processing of the user-defined function is not yet complete when you release the key.

When you press the key, the user-defined function (1) is then executed. The execution of the 
user-defined function (1) is not yet complete and you have already released the key. System 
function ResetBit(Tag) (3) interrupts the execution of the function. In this case, system function 
ResetBit(Tag) (3) is executed before system function SetBit(Tag) (2). As a result, the bit 
remains placed.

System function "SetBitWhileKeyPressed" shows the same behavior, if the system function is 
configured together with user-defined functions.
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Remedy
The processing sequence of the previous Example A is adhered to, if you additionally configure 
a user-defined function for the "Release" event. The user-defined function does not require 
functionality for this purpose. 

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release User-defined function_2 (3)
ResetBit(Tag) (4)

 

 NOTICE

Make sure that the user-defined function queue does not overflow; otherwise the system 
function for the following event may not be executed.

An overflow is recognizable by "Overload: Script <name> is rejected" or "Adherence to the 
expected processing order for user-defined functions and system functions in Runtime cannot 
always be ensured". 

 

Making object properties dynamic in Runtime

Introduction
You can use user-defined functions to access object properties of screen objects as well as 
tags in Runtime. If you use a user-defined function to change values of object properties, this 
will not affect the project data.    

Changes to object properties
If you use a user-defined function in Runtime to change an object property of a screen element, 
this change will only remain effective while the screen is active. If you change to the screen, 
or reload the screen, the configured object properties are displayed once more. 

Language switching
If you switch the language in Runtime, the foreign language labels are loaded from the project 
data. If you use a user-defined function to change texts, the texts changed by the user-defined 
function are overwritten again.   
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9.8.1.8 Examples of VBS

Example: Converting Fahrenheit into degrees Celsius

Scheduled task
In this example, create a user-defined VB function which converts the values of a temperature 
sensor from Fahrenheit to degrees Celsius. The temperature is displayed in an output field on 
the HMI device.   

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:

HMI tags:

Name PLC connection Type
Fahrenheit Yes Real
Centigrade No Real

User-defined VB function:

Name Type Parameters
FahrenheitToCelsius Function Fahrenheit
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Procedure
1. Create the two HMI-tags "Fahrenheit" and "Celsius" with the settings named above.

2. Create the user-defined VB function "FahrenheitToCelsius" with the settings given above.

3. Write the following VBS code:
FahrenheitToCelsius = (Fahrenheit-32) * (5/9)

Interim result
The HMI tags and the VB user-defined function are created.

Procedure
1. Open the "HMI Tag"editor and click on the "Fahrenheit" tag.

2. Click the "Properties > Events" tab in the Inspector window. Select the "Value change" 
event.

3. Configure the user-defined VB function "FahrenheitToCelsius" to the "Value change" event.

4. Select the tag "Fahrenheit" for the parameter "Fahrenheit".

5. Select the HMI-tag "Celsius" for the return value "Fahrenheit to Celsius".

6. Configure an output field in a screen and connect it with the tag "Celsius".

Alternative procedure
Instead of using a user-defined VB function of the "Function" type, you can also use the "Sub" 
type. In this case, assign the converted value directly to the HMI-tag "Celsius".

SmartTags("Celsius") = (Fahrenheit-32) * (5/9)
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In this case the return value of the user-defined VB function is not applicable. 

Result
When the tag value of "Fahrenheit" changes in Runtime, the user-defined VB function 
"Fahrenheit to Celsius" is performed. The converted temperature value is returned to the HMI-
tag "Celsius" and displayed in the output field. 

Example: Converting inches into meters

Scheduled task
In this example you create a user-defined VB function that converts the value of a length 
measuring system from inches into meters. The length in meters is displayed on the HMI device 
in an output field. 

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:

HMI tags:

Name PLC connection Type
VarInch Yes Real
VarMeter No Real

Customized VB function

Name Type Parameters
InchToMeter Sub Inch
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Procedure
1. Create the two HMI tags "VarInch" and "VarMeter" with the above settings.

2. Create the user-defined VB function "InchToMeter" with the settings given above.

3. Write the following VBS code:
VarMeter = Inch*0.0254

Interim result
The tags and the user-defined VB function are created.

Procedure
1. Open the "HMI tags" editor and click the "VarInch" tag.

2. Click "Properties> Events" in the Inspector window. Select the "Value change" event.

3. Configure the user-defined VB function "InchToMeter" to the "Value change" event.

4. Select the "VarInch" HMI tag for the "Inch" parameter.

5. Configure an output field in a screen and connect it with the "VarMeter" HMI tag.

Result
When the tag value of "VarInch" changes in Runtime, the "InchToMeter" user-defined VB 
function is performed. The calculated value is written into the "VarMeter" HMI tag and displayed 
in the output field. 
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Example: Changing the operating mode on the HMI device with the current display

Scheduled task
In this example, you use the "SetDeviceMode" system function to switch between the "online" 
and "offline" modes on the HMI device. You also display the current set operating mode on 
the HMI device.   

Requirements
A screen has been created.

Settings
For this example you require a HMI-tag and a text list with the following settings:

HMI tag:

Name PLC connection Type
OperatingMode No Bool

Text list:

Name Contains Values
ShowOperatingMode Bit (0/1) 1: Operating mode: "Online"

0: Operating mode: "Offline"

Procedure
1. Create the "OperatingMode" HMI-tag indicated above.

2. Create the "ShowOperatingMode" text list indicated above.

3. Open the screen and insert a button for which you configure the operating mode change 
to "online".

4. Click "Properties> Events" in the Inspector window. Select the "Press" event.
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5. Configure the "SetDeviceMode" system function for the "Press" event. The system function 
is found in the selection list under "Settings".

6. For the "Mode" parameter, select the "Online" entry.

7. Configure the system function "SetBit" on the event "Press". The system function is found 
in the selection list under "Bit processing".

8. Select the HMI-tag "Operating mode" from the selection list for the parameter "Tag".

9. Add a button in the process screen for which you configure the operating mode change to 
"offline".

10.Repeat steps four to seven. For the "Mode" parameter, select the "Offline" entry. Configure 
the system function "ResetBit" in place of the system function "SetBit."

Interim result
You can toggle the operating mode of the HMI device with the two buttons in Runtime. 

You want to display the current set operating mode in an output field on the HMI device.
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Procedure
1. Create a "Symbolic I/O field" in the process image. Click "Properties > Properties" in the 

Inspector window.

2. Make the following settings in the "General" group:

– Select "Output" as the "Mode".

– Select the text list "Show operating mode" as "Text list".

– Select "Operating mode" as "Tag".

Result
When you change the operating mode with the buttons, the currently set operating mode on 
the HMI device is always shown.

See also
Configuring a function list (Page 1750)

9.8.1.9 Examples of VBS

Overview

Introduction   
You can find the following examples for VBS:

● Access to objects in the "Screens" editor (e.g., color or text change)

● Determining color of objects

● Configuring a language switch
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● Deactivating Runtime

● Configuring a screen change via a property

● Configuring diagnostic output via a trace

● Writing tag values

● Reading tag values

● Writing object properties

● Configuring a recipe view

● Configuring an alarm view

● Drawing a trend

● Evaluating tag values statistically

See also
Example of configuring the recipe view (Page 1830)

Example of configuring the alarm view (Page 1831)

Example of statistically evaluating tag values (Page 1832)

Example of accessing objects in the Screens editor

Introduction  
To make the graphic Runtime environment dynamic, you can use VBS scripting to access all 
objects in the "Screens" editor in WinCC. In doing so, you can make graphic objects dynamic 
in response to an operator input, e.g., in response to a mouse click or depending on tag values.

Procedure
In the following example, the radius of a circle is set to 20 in Runtime per mouse click:

 
'VBS121
Dim objCircle
Set objCircle= ScreenItems("Circle1")
objCircle.Radius = 20

Example of defining object colors

Introduction  
The object colors are defined by means of RGB values (Red/Green/Blue). The color values 
for graphic objects can be set or read. 
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Procedure
The following example defines the fill color for "ScreenWindow1" to blue:

 
'VBS122
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
objScreen.FillColor = RGB(0, 0, 255)

Example of configuring a language switch

Introduction  
The Runtime language can be changed by means of VBS. Use buttons with corresponding 
country markings that you place on the start page of your project.

Using VBS, define the Runtime language by means of country code, e.g., 1031 for German - 
Default, 1033 for English - USA, etc. An overview of all country codes is available in the Basics 
of VBScript, "Regional Scheme ID (LCID) Diagram".

Procedure
Configure a local VBS script for a "Mouse click" event on a button and enter the following code 
to change the Runtime language to German:

 
'VBS123
HMIRuntime.Language = 1031

Example of deactivating Runtime

Introduction  
You can use VBS to exit Runtime, e.g. by means of mouse click, or depending on tag values, 
or on other events.

Procedure
The following example terminates WinCC Runtime:

 
'VBS124
HMIRuntime.Stop
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Example of configuring a screen change via a property

Introduction 
If using split screens in your configuration, e.g. the title and operating bar for the user interface 
in a basic screen and an embedded screen window for the actual screen display, configure a 
screen change using the properties of the screen window.

The property of screen window "ScreenName" must be changed so that the other screen is 
displayed. The local script and the screen window must be configured in the same screen.

Procedure
In the following example you show the "test" screen in a "ScreenWindow" when executing the 
local VB script:

 
'VBS126
Dim objScrWindow
Set objScrWindow = ScreenItems("ScreenWindow")
objScrWindow.ScreenName = "test"

Example of configuring a diagnostics output via a trace

Introduction  
If you have inserted the Print job/Script diagnostics" object in your screen, you can use the 
trace command to display diagnostics outputs in the diagnostics window in Runtime.

Print job/Script diagnostics returns the trace methods contained in the user-defined functions 
in the order in which they were called. This also applies to trace instructions in functions that 
are called in user-defined functions. The targeted use of trace instructions allows you to trace 
the flow of user-defined functions and the functions called therein. You enter the trace 
instruction in the form "HMIRuntime.Trace<Output>".

The "Print job/Script diagnostics" object displays trace outputs from C and VBS.

Outputting text
The following example writes a text in the diagnostics window:

 
'VBS127
HMIRuntime.Trace "Customized error message"
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Outputting alarms
The following example writes the alarms of a "Control2" alarm view to the diagnostics window:

 
Sub TraceMsg
  Dim objAlarmControl
  Dim lIndex
  Dim lCellIndex
 
  'create reference to the alarm control
  Set objAlarmControl = ScreenItems("Control2")
 
  'enumerate and trace out row numbers 
  For lIndex = 1 To objAlarmControl.GetRowCollection.Count
     HMIRuntime.Trace "Row: " & (objAlarmControl.GetRow(lIndex).RowNumber) & "  "
 
     'enumerate and trace out column titles and cell texts
     For lCellIndex = 1 To objAlarmControl.GetRow(lIndex).CellCount
       HMIRuntime.Trace objAlarmControl.GetMessageColumn(lCellIndex -1).Name & " "
       HMIRuntime.Trace objAlarmControl.GetRow(lIndex).CellText(lCellIndex) & "  "
     Next
     HMIRuntime.Trace vbNewLine
  Next
End Sub

Output information about HMI tags
The following example uses the "VarArch100" log tag to write information to the diagnostics 
window:

 
Sub ReadTagInfo
  Dim Tag
  Set Tag = HMIRuntime.Tags("TagLoggingfast\VarArch100")
 
  HMIRuntime.Trace "LastError = " + CStr(Tag.LastError) + vbNewLine
  HMIRuntime.Trace "Name = " + Tag.Name + vbNewLine
  HMIRuntime.Trace "QualityCode = " + CStr(Tag.QualityCode) + vbNewLine
End Sub

See also
Diagnostics (Page 1804)

Example of writing tag values

Introduction  
You can use VBScript to write the tag value to the PLC, for example, by mouse click on a 
setpoint button or to set internal tag values for triggering other user-defined functions. 
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Various write variations are mentioned and explained below.

Simple writing
In the following example, a value is written to the "Tag1" tag:

 
'VBS128
HMIRuntime.Tags("Tag1").Write 6

This is the simplest form of writing since no object reference is generated.

Writing with object reference
In the following example, a local copy of the tag object is generated and a value is written to 
"Tag1":

 
'VBS129
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 7

Referencing offers the advantage of being able to work with the tag object before writing. You 
can read the tag value, perform calculations, and write the tag value again.

 
'VBS130
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
objTag.Value = objTag.Value + 1
objTag.Write

Synchronous writing
The value to be written is usually transferred to tag management and execution of the script 
is continued. In certain cases, however, it must be ensured that the value has actually been 
written before script execution continues.

This type of writing is realized by specifying the value 1 for the additional, optional parameters:

 
'VBS131
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 8.1

or
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'VBS132
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Value = 8
objTag.Write ,1

 
 

 Note

Note that the call takes longer in comparison to the standard call. The duration is also 
dependent on the channel and AS, among other things.

This type of writing corresponds to the SetTagXXXWait() call in C scripting.
 

Writing with status handling
In order to ensure that a value has been written successfully, you perform an error check or 
evaluate the tag status after the write operation was completed.

This is done by checking the value of the LastError property after writing. The tag status is 
checked if the check was completed successfully, i.e., if the job was successfully output.

In the case of a write job, the current status from the process is not determined. To determine 
this, it is necessary to read the tag. The value specified in the QualityCode property after the 
read process provides an indication of the tag status and, if necessary, makes reference to a 
failed AS connection.

In the following example, the "Tag1" tag is written. If an error occurs during writing, the error 
value and error description appear in the Global Script diagnostics window. Finally, the 
QualityCode is checked. If the QualityCode is not OK (0x80), it will be displayed in the 
diagnostics window.

 
'VBS133
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 9
If 0 <> objTag.LastError Then
  HMIRuntime.Trace "Error: " & objTag.LastError & vbCrLf & "ErrorDescription: " & 
objTag.ErrorDescription & vbCrLf
Else
  objTag.Read
  If &H80 <> objTag.QualityCode Then
     HMIRuntime.Trace "QualityCode: 0x" & Hex(objTag.QualityCode) & vbCrLf
  End If
End If
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 Note

After writing a tag, the QualityCode property of the local tag object is set to "BAD Out of 
Service" because it is not known which QualityCode the tag handles in the process. The new 
QualityCode can be determined by reading again.

The Quality Code cannot be written from VBS.
 

Example of reading tag values

Introduction 
VBS can be used to read and further process a tag value. This allows you to click a button, for 
example, to obtain information on the system status or to perform calculations.

Various read variations are mentioned and explained below.

Simple reading
In the following example, the value of "Tag1" is read and displayed in the Global Script 
diagnostics window:

 
'VBS134
HMIRuntime.Trace "Value: " & HMIRuntime.Tags("Tag1").Read & vbCrLf

This is the simplest form of reading since no object reference is generated.

Reading with object reference
In the following example, a local copy of the tag object is created, and the tag value is read 
and displayed in the "Print job/Script diagnostics" object:

 
'VBS135
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
HMIRuntime.Trace "Value: " & objTag.Read & vbCrLf

Referencing offers the advantage of being able to work with the tag object. You can read the 
tag value, perform calculations, and write the tag value again.

 
'VBS136
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
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objTag.Value = objTag.Value + 1
objTag.Write

 

Using the Read method, process tags that have been read are added to the image, from this 
moment on they are cyclically requested from the automation system (AS). If the tag is already 
in the image, the value it contains is returned.

When the screen is exited, the tags are logged off.
 

 Note

If a tag is requested in a function, it remains logged on as long as WinCC Runtime is running.
 

Direct reading
Normally, the tag values are read from the tag image. In certain situations, however, it may be 
necessary to read the value directly from the AS, e.g., to synchronize fast processes.

The tag is not logged on cyclically if you set the optional parameter to 1 when reading the 
value. Instead, the value is requested once from the AS.

 
'VBS137
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
HMIRuntime.Trace "Value: " & objTag.Read(1) & vbCrLf

 
 

 Note

Note that the call takes longer in comparison to the standard call. The duration is also 
dependent on the channel and AS, among other things.

This type of call must be avoided in cyclic C scripts as this is the major cause of performance 
problems.

This read mode corresponds to the GetTagXXXWait() call used in C scripting.
 

Reading with status handling
Always validate the value after reading it. This occurs by checking the QualityCode.

In the following example, the "Tag1" tag is read and the QualityCode then checked. When the 
Quality Code does not correspond to OK (0x80) the LastError, ErrorDescription, and 
QualityCode properties are displayed in the Global Script diagnostics window.

 
'VBS138
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Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
If &H80 <> objTag.QualityCode 
  Then
    HMIRuntime.Trace "Error: " & objTag.LastError & vbCrLf & "ErrorDescription: " & 
objTag.ErrorDescription & vbCrLf & "QualityCode: 0x" & Hex(objTag.QualityCode) & vbCrLf
  Else
    HMIRuntime.Trace "Value: " & objTag.Value & vbCrLf
End If

 
 

 Note

If an error occurs during reading, QualityCode is set to BAD Out of Service". Therefore, it is 
sufficient to check the QualityCode following reading.

 

Example of writing object properties

Introduction 
VBS provides access to the properties of all display and operating objects in the "Screens" 
editor. You can read out properties or change them during Runtime.

The following examples illustrate various forms of access.

Simple setting of a property
In the next example, the background color of the "Rectangle1" object in the screen is set to 
red:

 
'VBS139
ScreenItems("Rectangle1").BackColor = RGB(255,0,0)

This is the simplest form of writing since no object reference is generated.
 

 Note

If you are working without an object reference, only the standard properties are provided by 
autocompletion.

The mode of expression used in this example can only be executed in the "Screens" editor. 
By analogy, you address the objects in the scheduler using the HMIRuntime object.
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Setting a property with object reference
In the following example, a reference is created to the "Rectangle1" object contained in the 
picture and the background is set to red using the VBS standard function RGB():

 
'VBS140
Dim objRectangle
Set objRectangle = ScreenItems("Rectangle1")
objRectangle.BackColor = RGB(255,0,0)

Additional information on RGB is available in "VBScript for Windows".

Referencing is useful if you want to edit several object properties. In this way all of the 
properties of the object will be listed with the autocompletion feature.

 

 Note

The mode of expression used in this example can only be executed in the "Screens" editor. 
By analogy, you address the objects in the scheduler using the HMIRuntime object.

 

Setting properties across screen windows
VBS in the "Screens" editor offers two options of global screen addressing:

● Using the screen object of a screen window with "ScreenItems"

● From the root screen with "HMIRuntime.Screens"

Referencing via the screen window
In the following example, the color of a rectangle is changed in an subordinate screen window. 
The user-defined VB function is executed in the "BaseScreen" screen in which 
"ScreenWindow1" is located. The screen window displays a screen, which contains an object 
of the type "Rectangle" with the name "Rectangle1".

 
'VBS199
Sub OnLButtonUp(ByVal Item, ByVal Flags, ByVal x, ByVal y)
  Dim objRectangle
  Set objRectangle = ScreenItems("ScreenWindow1").Screen.ScreenItems("Rectangle1")
  objRectangle.BackColor = RGB(255,0,0)
End Sub

Referencing from the root screen
You can reference the screen with the object to be modified via HMIRuntime.Screens. The 
specification of the screen is defined relative to the root screen via the following access code:

[<Root screen name>.]<Screen window name>[:<Screen name>]... .<Screen window 
name>[:<Screen name>]
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In the following example, a reference is created to the "Screen2" object contained in the 
"Rectangle1" picture and the background color is set to red.

The screen "Screen2", in this case, is in "Screen1". "Screen1" is displayed in the "BaseScreen" 
root screen.

 
'VBS141
Dim objRectangle
Set objRectangle = 
HMIRuntime.Screens("BaseScreen.ScreenWindow1:Screen1.ScreenWindow1:Screen2").ScreenItems("
Rectangle1")
objRectangle.BackColor = RGB(255,0,0)

It is not necessary to specify the screen name. It is possible to address a screen uniquely using 
the screen window name. Therefore, it is sufficient to specify the name of the screen window, 
as in the following example:

 
'VBS142
Dim objRectangle
Set objRectangle = 
HMIRuntime.Screens("ScreenWindow1.ScreenWindow2").ScreenItems("Rectangle1")
objRectangle.BackColor = RGB(255,0,0)

This type of addressing enables objects in screen windows to be addressed in different 
pictures. This is a particularly interesting aspect for the faceplate system.

Making the property dynamic using the return value
In addition to initiating local scripts for properties by means of an event trigger or cyclic trigger, 
you can also make properties dynamic directly by means of a local script. 

In the next example, the background color of an object made dynamic by means of return 
value. The value transferred can be derived from the evaluation of events in the PLC, for 
example, and can be used for graphic visualization of an operating state:

 
'VBS146
Function BackColor_Trigger(ByVal Item)
  BackColor_Trigger = RGB(125,0,0)
End Function
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 NOTICE

If you use a user-defined function to make an object property dynamic by means of the return 
value of a user-defined function, the value of the object property is only written if it has 
changed compared to the last function session. It is not considered if the value had been 
changed from another location.

For this reason, properties that have been made dynamic by means of the return value with 
user-defined functions must not be changed from another location (e.g. other user-defined 
functions). Incorrect values could be displayed if you ignore this rule. 

 

Example of configuring the recipe view

Introduction  
Recipe data records are output in the recipe view.

You can add, copy, edit or delete data records.

Loading and displaying a recipe
The following example loads the "Juice" recipe in the "Control1" recipe view. The recipe is 
displayed in the recipe view.

 
Sub loadUserArchive()
  Dim objUAC
  Set objUAC = ScreenItems("Control1")
  objUAC.BorderColor = RGB(255,0,0)
  objUAC.BorderWidth = 3
  objUAC.Closeable = False
  objUAC.Datasource = "Juice"
End Sub

Copying a recipe data record
The following example copies the recipe data record of line 3. The copy is inserted at the end 
of the table.

 
Sub CopyRow
  Dim objUAC
  Set objUAC = ScreenItems("Control1")
 
  Dim iRowCount
 
  objUAC.AutoCompleteRows = True
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  objUAC.SelectRow(3)
  objUAC.CopyRows 
 
  iRowCount = objUAC.GetRowCollection.Count
  objUAC.SelectRow(iRowCount + 1)
  objUAC.PasteRows
  objUAC.SelectRow(1)
  objUAC.UnselectAll
End Sub
 

See also
Overview (Page 1818)

Example of configuring the alarm view

Introduction  
The alarm view displays alarms. You can show, hide, sort, and filter alarms.

Filtering alarms
In this example, only the alarms of alarm number 2 are displayed in the "Control2" alarm view.

 
Sub Filter
  Dim objAlarmControl
 
  'create reference to AlarmControl
  Set objAlarmControl = ScreenItems("Control2")
 
  'set / reset the filter and create a trace
  If (objAlarmControl.MsgFilterSQL = "") Then
     objAlarmControl.MsgFilterSQL = "MSGNR = 2"
  Else
     objAlarmControl.MsgFilterSQL = ""
  End If
End Sub

Removing alarms
In this example, alarms 1-3 will be removed from the alarm view.

 
Sub ResetAlarm
  Dim objAlarm
  'reset alarm 1 - 3
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  Set objAlarm = HMIRuntime.Alarms(1)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(2)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(3)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
End Sub

Adding alarms
In this example, alarms 1-3 will be added to the alarm view. Alarms 1-3 must be created.

 
Sub SetAlarm
  Dim objAlarm
 
  'create Alarm 1 - 3
  Set objAlarm = HMIRuntime.Alarms(1)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(2)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(3)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
End Sub 
 

See also
Overview (Page 1818)

Example of statistically evaluating tag values

Introduction  
You can use the value table to display the coordinates of trends and the statistical evaluation 
of tag values in tabular form. You connect the value table to the corresponding object for this 
purpose. The evaluated data can be printed out and exported.
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Procedure
In the following example, the tag values of the f(t) trend view "Control2" are statistically 
evaluated. To display the result in the statistics area window of the value table, you set the 
following in the value table properties:

● Data source: "Control2"

● Mode: "Statistic area" window"

Add a new button in f(t) trend view and configure the user-defined VB function for it. 

 
Sub OnToolbarButtonClicked(ByVal Item,  ByVal lId)  
  Dim objTrend
  Set objTrend = ScreenItems("Control2")
  objTrend.CalculateStatistic()
End Sub

See also
Overview (Page 1818)

9.8.1.10 Examples of C

Overview

Introduction   
You can find examples for C functions:

● Access to objects in the "Screens"editor (e.g. color or text change)

● Determining color of objects

● Configuring a language switch

● Deactivating Runtime

● Configuring a screen change via a property

● Configuring diagnostic output via a trace

● Writing tag values

● Reading tag values

● Writing object properties
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See also
Example of accessing objects in the Screens editor (Page 1834)

Example of defining object colors (Page 1834)

Example of configuring a language switch (Page 1835)

Example of deactivating Runtime (Page 1835)

Example of configuring a screen change via a property (Page 1836)

Example of configuring a diagnostics output via a trace (Page 1836)

Example of writing tag values (Page 1837)

Example of reading tag values (Page 1837)

Example of writing object properties (Page 1838)

Example of accessing objects in the Screens editor

Introduction  
To make the graphic Runtime environment dynamic, you can use C scripting to access all 
objects in the "Screens" editor in WinCC. In doing so, you can make graphic objects dynamic 
in response to an operator input, e.g., in response to a mouse click or depending on tag values.

Procedure
In the following example, the radius of a circle is set to 10 in Runtime per mouse click:

 
'C121
SetPropDouble(screenName,"Kreis_1","Radius",10);

See also
SetPropDouble (Page 1897)

Overview (Page 1833)

Example of defining object colors

Introduction  
The object colors are defined by means of RGB values (Red/Green/Blue). The color values 
for graphic objects can be set or read. 
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Procedure
The following example defines the fill color for "Roundbutton1" to blue:

 
'C122
SetPropertyByConstant (screenName, " Roundbutton1", "FillPatternColor", "65035");

See also
SetPropertyByConstant (Page 1899)

Overview (Page 1833)

Example of configuring a language switch

Introduction   
The Runtime language can be changed by means of VBS. Use buttons with corresponding 
country markings that you place on the start page of your project.

Define the Runtime language by means of country code, for example, 1031 for German - 
Default, 1033 for English - USA etc. An overview of all country codes is available in the basics 
of VBScript, "Regional Scheme ID (LCID) Diagram".

Procedure
Create a user-defined C function for a button for the "Mouse click" event, and enter the following 
code to switch the Runtime language to German:

 
'C123
SetLanguageByLocaleID(1033);

See also
SetLanguageByLocaleID (Page 1895)

Overview (Page 1833)

Example of deactivating Runtime

Introduction 
You can use C functions to exit Runtime, for example, by means of mouse click, or depending 
on tag values, or on other events.
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Procedure
The following example terminates WinCC Runtime:

 
'C124
StopRuntime(hmiStopRuntime);

See also
StopRuntime (Page 1918)

Overview (Page 1833)

Example of configuring a screen change via a property

Introduction   
If using split screens in your configuration, for example, the title and operating bar for the user 
interface in a basic screen and an embedded screen window for the actual screen display, 
configure a screen change using the properties of the screen window.

The property of screen window "ScreenName" must be changed so that the other screen is 
displayed. The C function and screen window must be configured in the same screen.

Procedure
In the next example, the "test" screen is displayed in a "ScreenWindow" when you execute 
the C function:

 
'C126
ActivateScreenInScreenWindow (screenName, "ScreenWindow", "test");

See also
ActivateScreenInScreenWindow (Page 1858)

Overview (Page 1833)

Example of configuring a diagnostics output via a trace

Introduction   
If you have inserted a GSC diagnostics window in your screen, you can use the trace command 
to display diagnostics outputs in the diagnostics window in Runtime.

GSC diagnostics returns the trace methods contained in the functions in the order in which 
they were called. This also applies to trace instructions in functions that are called in user-
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defined functions. The targeted use of trace instructions allows you to trace the flow of user-
defined functions and the functions called therein. You enter the trace instruction in the form 
"printf(<Output>)".

The GSC diagnostics window displays trace outputs of C functions.

Outputting text
The following example writes a text in the diagnostics window:

 
'C127
printf("Customized C script error message\r\n");

See also
Overview (Page 1833)

Example of writing tag values

Introduction   
You can use C functions to write the tag value to the PLC, foe example, by mouse click on a 
setpoint button, or to set internal tag values for triggering other functions. 

Simple writing
In the following example, a value is written to the "Tag1" tag:

 
'C128
int value;
value = 7;
SetTagSDWord("Tag1", value);

See also
SetTag (Page 1902)

Overview (Page 1833)

Example of reading tag values

Introduction   
C functions can be used to read and further process a tag value. This allows you to click a 
button, for example, to obtain information on the system status or to perform calculations.
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Simple reading
In the following example, the value of "Tag1" is read and displayed in the Global Script 
diagnostics window:

 
'C134
int value;
value = GetTagGetTagSDWord("Tag1");

See also
GetTag (Page 1868)

Overview (Page 1833)

Example of writing object properties

Introduction   
C functions provide access to the properties of all display and operating objects in the 
"Screens" editor. You can read out properties or change them during Runtime.

The following example shows how to access a property.

Simple setting of a property
In the next example, the background color of the "Button1" object in the screen is set to red:

 
'C139
SetPropLong("Screen_1","Button1","ForeColor",65333);

See also
SetPropLong (Page 1898)

Overview (Page 1833)
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9.8.2 Reference (Panels, RT Advanced)

9.8.2.1 Events

Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
HMI tags
Logs
Scheduler
Audit Trail

 
Cleared (Page 1845) √ -- -- -- -- --
Activate (Page 1845) -- -- -- -- -- --
Adjust (Page 1845) -- -- -- -- -- --
Loaded (Page 1846) √ -- -- -- -- --
Execute (Page 1846) -- -- -- -- √ --
Selection changed  (Page 1846) -- -- -- -- -- --
When dialog is opened (Page 1846) -- -- -- -- √ --
When dialog is closed (Page 1847) -- -- -- -- √ --
User change (Page 1847) -- -- -- -- √ --
Screen change (Page 1847) -- -- -- -- √ --
Deactivate (Page 1847) -- -- -- -- -- --
Double-click (Page 1848) -- -- -- -- -- --
Press (Page 1848) -- -- -- -- -- --
On Finish Input (Page 1849) -- -- -- -- -- --
Press ESC twice (Page 1849) -- -- -- -- -- --
Outgoing (Page 1849) -- √ -- -- -- --
Incoming (Page 1850) -- √ -- -- -- --
In the event of high limit violation (Page 1850) -- -- √ -- -- --
Click (Page 1850) -- -- -- -- -- --
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Click when flashing (Page 1851) -- -- -- -- -- --
Loop-in alarm (Page 1851) -- √ -- -- -- --
Release (Page 1851) -- -- -- -- -- --
Alarm buffer overflow (Page 1852) -- -- -- -- √ --
In the event of low limit violation (Page 1852) -- -- √ -- -- --
Acknowledge (Page 1852) -- √ -- -- -- --
Reach margin (Page 1852) -- -- -- -- -- --
Runtime Stop (Page 1853) -- -- -- -- √ --
Press key (Page 1853) -- -- -- -- -- --
Release key (Page 1854) -- -- -- -- -- --
Overflow (Page 1854) -- -- -- √ -- --
Switching (Page 1854) -- -- -- -- -- --
Switch OFF (Page 1855) -- -- -- -- -- --
Switch ON (Page 1855) -- -- -- -- -- --
Low free storage space (Page 1855) -- -- -- √ -- √
Free space critically low (Page 1855) -- -- -- √ -- √
Value change (Page 1855) -- -- √ -- -- --
Time expired (Page 1856) -- -- -- -- -- --

Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Polyline
Polygon
Ellipse
Circle
Rectangle
Text field
Graphic view

 

 

 
Cleared (Page 1845) -- -- -- -- -- -- -- --
Activate (Page 1845) -- -- -- -- -- -- -- --
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Adjust (Page 1845) -- -- -- -- -- -- -- --
Loaded (Page 1846) -- -- -- -- -- -- -- --
Execute (Page 1846) -- -- -- -- -- -- -- --
Selection changed  (Page 1846) -- -- -- -- -- -- -- --
When dialog is opened (Page 1846) -- -- -- -- -- -- -- --
When dialog is closed (Page 1847) -- -- -- -- -- -- -- --
User change (Page 1847) -- -- -- -- -- -- -- --
Screen change (Page 1847) -- -- -- -- -- -- -- --
Deactivate (Page 1847) -- -- -- -- -- -- -- --
Double-click (Page 1848) -- -- -- -- -- -- -- --
Press (Page 1848) -- -- -- -- -- -- -- --
On Finish Input (Page 1849) -- -- -- -- -- -- -- --
Press ESC twice (Page 1849) -- -- -- -- -- -- -- --
Outgoing (Page 1849) -- -- -- -- -- -- -- --
Incoming (Page 1850) -- -- -- -- -- -- -- --
Click (Page 1850) -- -- -- -- -- -- -- --
Click when flashing (Page 1851) -- -- -- -- -- -- -- --
Loop-in alarm (Page 1851) -- -- -- -- -- -- -- --
Release (Page 1851) -- -- -- -- -- -- -- --
In the event of high limit violation (Page 1850) -- -- -- -- -- -- -- --
Alarm buffer overflow (Page 1852) -- -- -- -- -- -- -- --
In the event of low limit violation (Page 1852) -- -- -- -- -- -- -- --
Acknowledge (Page 1852) -- -- -- -- -- -- -- --
Reach margin (Page 1852) -- -- -- -- -- -- -- --
Runtime Stop (Page 1853) -- -- -- -- -- -- -- --
Press key (Page 1853) -- -- -- -- -- -- -- --
Release key (Page 1854) -- -- -- -- -- -- -- --
Overflow (Page 1854) -- -- -- -- -- -- -- --
Switching (Page 1854) -- -- -- -- -- -- -- --
Switch OFF (Page 1855) -- -- -- -- -- -- -- --
Switch ON (Page 1855) -- -- -- -- -- -- -- --
Low free storage space (Page 1855) -- -- -- -- -- -- -- --
Free space critically low (Page 1855) -- -- -- -- -- -- -- --
Value change (Page 1855) -- -- -- -- -- -- -- --
Time expired (Page 1856) -- -- -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.
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Icon Object
IO field
Button
Symbolic IO field
Graphic IO field
Date/time field
Bar
Switch
Symbol library
Slider
Gauge
Clock

 
Cleared (Page 1845) -- -- -- -- -- -- -- -- -- -- --
Activate (Page 1845) √ √ √ √ -- -- √ √ √ -- --
Adjust (Page 1845) -- √ √ -- -- -- √ -- √ √ --
Loaded (Page 1846) -- -- -- -- -- -- -- -- -- -- --
Execute (Page 1846) -- -- -- -- -- -- -- -- -- -- --
Selection changed  (Page 1846) -- -- -- -- -- -- -- -- -- -- --
When dialog is opened (Page 1846) -- -- -- -- -- -- -- -- -- -- --
When dialog is closed (Page 1847) -- -- -- -- -- -- -- -- -- -- --
User change (Page 1847) -- -- -- -- -- -- -- -- -- -- --
Screen change (Page 1847) -- -- -- -- -- -- -- -- -- -- --
Deactivate (Page 1847) √ √ √ √ -- -- √ √ √ -- --
Double-click (Page 1848) -- -- -- -- -- -- -- √ -- -- --
Press (Page 1848) -- √ -- -- -- -- -- √ -- -- --
On Finish Input (Page 1849) √ -- √ √ -- -- -- -- -- -- --
Press ESC twice (Page 1849) -- -- -- -- -- -- -- -- -- -- --
Outgoing (Page 1849) -- -- -- -- -- -- -- -- -- -- --
Incoming (Page 1850) -- -- -- -- -- -- -- -- -- -- --
Click (Page 1850) -- √ -- -- -- -- -- √ -- -- --
Click when flashing (Page 1851) -- -- -- -- -- -- -- -- -- -- --
Loop-in alarm (Page 1851) -- -- -- -- -- -- -- -- -- -- --
Release (Page 1851) -- √ -- -- -- -- -- √ -- -- --
In the event of high limit violation 
(Page 1850)

-- -- -- -- -- -- -- -- -- -- --

Alarm buffer overflow (Page 1852) -- -- -- -- -- -- -- -- -- -- --
In the event of low limit violation 
(Page 1852)

-- -- -- -- -- -- -- -- -- -- --

Acknowledge (Page 1852) -- -- -- -- -- -- -- -- -- -- --
Reach margin (Page 1852) -- -- -- -- -- -- -- -- -- -- --
Runtime Stop (Page 1853) -- -- -- -- -- -- -- -- -- -- --
Press key (Page 1853) -- -- -- -- -- -- -- -- -- -- --
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Release key (Page 1854) -- -- -- -- -- -- -- -- -- -- --
Overflow (Page 1854) -- -- -- -- -- -- -- -- -- -- --
Switching (Page 1854) -- -- -- -- -- -- -- -- -- -- --
Switch OFF (Page 1855) -- -- -- -- -- -- √ -- -- -- --
Switch ON (Page 1855) -- -- -- -- -- -- √ -- -- -- --
Low free storage space (Page 1855) -- -- -- -- -- -- -- -- -- -- √
Free space critically low (Page 1855) -- -- -- -- -- -- -- -- -- -- √
Value change (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Time expired (Page 1856) -- -- -- -- -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Alarm view/alarm window
Alarm indicator
Trend view
User view
HTML browser
Status/Force
Sm@rtClient view
Recipe view
f(x) trend view
System diagnostics view / system diagnostics window
Function key

 

 
Cleared (Page 1845) -- -- -- -- -- -- -- -- -- -- --
Activate (Page 1845) √ -- √ √ √ √ √ √ -- √ --
Adjust (Page 1845) -- -- -- -- -- -- -- -- -- -- --
Loaded (Page 1846) -- -- -- -- -- -- -- -- -- -- --
Execute (Page 1846) -- -- -- -- -- -- -- -- -- -- --
Selection changed  (Page 1846) √ -- -- -- -- -- -- -- -- -- --
When dialog is opened (Page 1846) -- -- -- -- -- -- -- -- -- -- --
When dialog is closed (Page 1847) -- -- -- -- -- -- -- -- -- -- --
User change (Page 1847) -- -- -- -- -- -- -- -- -- -- --
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Screen change (Page 1847) -- -- -- -- -- -- -- -- -- -- --
Deactivate (Page 1847) √ -- √ √ √ √ √ √ -- -- --
Double-click (Page 1848) -- -- -- -- -- -- -- -- -- -- --
Press (Page 1848) -- -- -- -- -- -- -- -- -- -- --
On Finish Input (Page 1849) -- -- -- -- -- -- -- --  -- --
Press ESC twice (Page 1849) -- -- -- -- -- -- -- -- -- -- --
Outgoing (Page 1849) -- -- -- -- -- -- -- -- -- -- --
Incoming (Page 1850) -- -- -- -- -- -- -- -- -- -- --
Click (Page 1850) -- √ -- -- -- -- -- -- -- -- --
Click when flashing (Page 1851) -- √ -- -- -- -- -- -- -- -- --
Loop-in alarm (Page 1851) -- -- -- -- -- -- -- -- -- -- --
Release (Page 1851) -- -- -- -- -- -- -- -- -- -- --
In the event of high limit violation 
(Page 1850)

-- -- -- -- -- -- -- -- -- -- --

Alarm buffer overflow (Page 1852) -- -- -- -- -- -- -- -- -- -- --
In the event of low limit violation 
(Page 1852)

-- -- -- -- -- -- -- -- -- -- --

Acknowledge (Page 1852) -- -- -- -- -- -- -- -- -- -- --
Reach margin (Page 1852) -- -- -- -- -- -- -- -- -- -- --
Runtime Stop (Page 1853) -- -- -- -- -- -- -- -- -- -- --
Press key (Page 1853) -- -- -- -- -- -- -- -- -- -- √
Release key (Page 1854) -- -- -- -- -- -- -- -- -- -- √
Overflow (Page 1854) -- -- -- -- -- -- -- -- -- -- --
Switching (Page 1854) -- -- -- -- -- -- -- -- -- -- --
Switch OFF (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Switch ON (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Low free storage space (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Free space critically low (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Value change (Page 1855) -- -- -- -- -- -- -- -- -- -- --
Time expired (Page 1856) -- -- -- -- -- -- -- -- -- -- --
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Events

Cleared

Description
Occurs when the active screen on the HMI device is cleared.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Activate

Description
Occurs when the user selects a display or operating object using the configured tab sequence.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

If the user e.g. clicks a button with the mouse, the "Click" event is triggered. Users wishing 
to trigger the "Enable" event must select the button using the tab key.

 

The "Activate" event is only used to detect whether an object was selected. The event does 
not trigger a password prompt.

For this reason, do not use the "Activate" event if you want to configure access protection on 
the function call of the object.

Adjust

Description
Occurs if the status of a display and operator control object changes. 

The status of an object changes if, for example, the user presses the key. 
 

 Note

Please note that the availability of the event depends on the HMI device and object type.
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Loaded

Description
Occurs when all configured display and operating objects are loaded in the active screen after 
a screen change. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

Enable a screen change to ensure that the connection with the control is established after 
switch-on. 

 

Execute

Description
Occurs when the scheduled task has been executed.   

Selection changed 

Description
Occurs when the user changes the selection. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

When dialog is opened

Description
The event is triggered when a modal dialog opens.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
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When dialog is closed

Description
The event is triggered when a modal dialog closes.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

User change

Description
Occurs when a user logs off at an HMI device or another user logs on at the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Screen change

Description
Occurs when all configured display and operating objects are loaded in the screen after a 
screen change. 

Use the "Loaded" event if you want to perform other system functions during a screen change 
to a certain screen. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Deactivate

Description
Occurs when the user takes the focus from a display and operating object.   
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A screen object can be disabled using the configured tab order or by performing another action 
with the mouse.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

System functions or user-defined functions on the "Deactivate" event of a screen are not 
executed when a screen is being closed.

 

The "Deactivate" event is only used to detect whether an object was deselected. The event 
does not trigger a password prompt.

For this reason, do not use the "Deactivate" event if you want to configure access protection 
on the function call of the object.

Double-click

Description
Occurs when the user double-clicks on an object from the symbol library. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Press

Description
Occurs when the user clicks on a button with the left mouse button, presses <RETURN> or 
<SPACE>. 

Also occurs when the user right-clicks on an object of the symbol library.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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On Finish Input

Description
Triggered when you confirm input at an I/O field by pressing ENTER, or by mouse click, or by 
touch screen operation. 

The "On Finish Input" event is also started if the value of a tag does not change, for example, 
if a value is exceeded, or if a user cancels the dialog to acknowledge a tag (Audit option 
package) that has to be acknowledged.

The event is not triggered, on the other hand, by user logon or by input fields configured with 
an authorization.

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Press ESC twice

Description
Occurs when the user presses the <ESC> key twice at the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Outgoing

Description
Occurs when an alarm is deactivated. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
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Incoming

Description
Occurs when an alarm is triggered and displayed in the alarm view. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

In the event of high limit violation

Description
Occurs when the high limit of a tag is exceeded. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Click

Description
Occurs if the user clicks a display and operating object with the mouse or touches the touch 
display with a finger. 

In case you click the incorrect object, prevent processing of configured function list as follows:

● Move the mouse pointer away from the object while keeping the mouse button pressed. 
Release the mouse button as soon as the mouse pointer leaves the object. The function 
list will then not be processed.

● On touch displays, the display must be touched with the finger until a reaction occurs, e.g., 
a screen change.

 

  Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Click when flashing

Description
Occurs when the user clicks a flashing screen object with the mouse or touches a screen object 
on the touch display with his finger. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Loop-in alarm

Description
Occurs as soon as the user selects an alarm in the alarm view and then clicks on the "Loop-
In-Alarm" button or double clicks on the alarm.   

For the "Loop-In-Alarm" event, you configure system functions, such as a change to the screen 
in which the alarm occurred.

You cannot configure local scripts for the "Loop-In-Alarm" event in Runtime Professional.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Release

Description
Occurs when the user releases a button. 

This even does not occur, as long as the button remains pressed.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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In the event of low limit violation

Description
Occurs when the low limit of a tag is undershot. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Alarm buffer overflow

Description
Occurs when the configured size of the alarm buffer is reached. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Acknowledge

Description
Occurs when the user acknowledges an alarm. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Reach margin

Description
Occurs when the user reaches the beginning or the end of a scrollable area. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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 Note

A user-defined function must not be configured for the "Boundary reached" event.
 

Configurable objects
The event can only be configured on the <Up> and <Down> keys, or on the keys on which 
you have configured the "ScreenObjectPageUp" or "ScreenObjectPageDown" system 
functions.

Runtime Stop

Description
Occurs when the user exits the Runtime software on the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

A user-defined function must not be configured for the "Runtime stop" event.
 

 

Press key

Description
Occurs when the user presses a function key. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Release key

Description
Occurs when the user releases a function key. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Overflow

Description
Occurs when the configured size of the log is reached. You use the log type "Trigger event". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Switching

Description
Occurs when the user toggles a display and operating object, e.g. a switch from "ON" to "OFF". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Switch OFF

Description
Occurs when the user moves the display and operating object "Switch" to the OFF position. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Switch ON

Description
Occurs when the user moves the display and operating object "Switch" to the ON position. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 

 

Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 

 

Value change

Description
Occurs when the value of an object or the value of an array element changes. 
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The value change of a tag is triggered by the PLC or by the user, e.g. when a new value is 
entered. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Time expired

Description
Occurs when the time configured in the scheduler expires. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

9.8.3 Reference (RT Professional)

9.8.3.1 C scripting

System functions

ActivateNextScreen 

Description
WinCC saves the names of the screens opened by the user during runtime as well as the 
sequence in which these screens were opened.

Can only be used in C scripting.

The maximum number of screen names is specified in the "Runtime settings > Screens > 
Screen buffer" editor.

The ActivateNextScreen system function now opens the screen that was opened before the 
last call of ActivatePreviousScreen.

Syntax
BOOL ActivateNextScreen();  
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Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

See also
ActivatePreviousScreen (Page 1857)

ActivatePreviousScreen

Description
WinCC saves the names of the screens opened by the user during runtime as well as the 
sequence in which these screens were opened.

The system function can be used in C scripting only.

The maximum number of screen names is specified in the "Settings > Screens" editor.

The ActivatePreviousScreen system function now opens the screen which was opened before 
the currently open screen.

Syntax
BOOL ActivatePreviousScreen();  

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

ActivateScreen

Description
Performs a screen change to the given screen.    

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 
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Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

ActivateScreenInScreenWindow

Description
Performs a screen change to the specified screen in a specified screen window.    

Use in the function list
ActivateScreenInScreenWindow (Screen name, Screen window, New screen name)

Use in user-defined functions
ActivateScreenInScreenWindow (Screen_name, Screen_window, New_screen_name)
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Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen to be displayed in the screen window. 

Screen window
Name of the screen window in which the new screen is to be displayed.

New screen name
Name of the new screen to be displayed in the screen window. 

See also
Example of configuring a screen change via a property (Page 1836)

ActivateStartScreen

Description
Opens the entered start picture.

Can only be used in C scripting.

Syntax
BOOL ActivateStartScreen();  

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

ActivateStoredScreen

Description
Opens the screen saved with the StoreScreen system function.

Can only be used in C scripting.
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Syntax
BOOL ActivateStoredScreen();  

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

See also
StoreScreen  (Page 1919)

DecreaseTag

Description
Subtracts the given value from the tag value.    

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".
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Parameters

Tag
The tag from which the given value is subtracted.

Value
The value that is subtracted.

GetLocalScreen

Description
Returns a pointer to the screen name. 

Can only be used in C scripting.

Syntax
char* GetLocalScreen(char* Screen name);

Parameters

Screen name
Pointer on the screen

Return value
Pointer on the name of the picture.

 

 Note

The syntax of the transferred call parameterScreen name must correspond to that formed by 
the graphics system for the screen paths:

<RootScreenName>.<ScreenWindowName>:<ScreenName>. ... .<ScreenWindowName>:<
ScreenName>.

 

Example:
In a basic picture "AAA" there is a picture window "bbb" in which a picture "CCC" is called 
which itself contains a picture window "ddd" in which a picture "EEE" is called.

Then the system function GetLocalScreen(Screen name) returns the pointer to the 
screen name:

"EEE" if the system function is called in the picture "EEE";

"CCC" if the system function is called in the picture "CCC";
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"AAA" if the system function is called in the picture "AAA". 

GetLinkedTag

Description
Returns the name of the tag which is logically linked to the specified object property.

Can only be used in C scripting.

Syntax
char* GetLinkedTag(char* Screen Name, char* Object, char* Name of Property);

Parameters

Screen Name
Pointer to the screen

Object
Pointer to the object

Name of Property
Pointer to the object property

Return value
Pointer to the name of the tag which is logically linked to the specified object property.

GetLanguageByLocaleID

Description
Determines the current Runtime language.

Can only be used in C scripting.

Syntax
DWORD GetLanguageByLocaleID ();  

Return value
Language ID.

The following assignments are valid (hexadecimal language code):
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Symbolic name Value(hexadecimal
)

Abbreviation

LANG_ARABIC 0x0401  
LANG_AFRIKAANS 0x0436  
LANG_ALBANIAN 0x041C  
LANG_BASQUE 0x042D  
LANG_BULGARIAN 0x0402  
LANG_BYELORUSSIAN 0x0423  
LANG_CATALAN 0x0403  
LANG_CHINESE 0x0404  
LANG_CROATIAN 0x041A  
LANG_CZECH 0x0405 CSY
LANG_DANISH 0x0406 DAN
LANG_DUTCH 0x0413 NLD
LANG_ENGLISH 0x0409 ENU
LANG_ESTONIAN 0x0425  
LANG_FAEROESE 0x0438  
LANG_FARSI 0x0429  
LANG_FINNISH 0x040B FIN
LANG_FRENCH 0x040C FRA
LANG_GERMAN 0x0407 DEU
LANG_GREEK 0x0408  
LANG_HEBREW 0x040D  
LANG_HUNGARIAN 0x040E HUN
LANG_ICELANDIC 0x040F ISL
LANG_INDONESIAN 0x0421  
LANG_ITALIAN 0x0410 ITA
LANG_JAPANESE 0x0411  
LANG_KOREAN 0x0412  
LANG_LATVIAN 0x0426  
LANG_LITHUANIAN 0x0427  
LANG_NORWEGIAN 0x0414 NOR
LANG_POLISH 0x0415 PLK
LANG_PORTUGUESE 0x0416 PTB
LANG_ROMANIAN 0x0418  
LANG_RUSSIAN 0x0419 RUS
LANG_SLOVAK 0x041B SKY
LANG_SLOVENIAN 0x0424  
LANG_SORBIAN 0x042E  
LANG_SPANISH 0x040A ESP
LANG_SWEDISH 0x041D SVE
LANG_THAI 0x041E  
LANG_TURKISH 0x041F TRK
LANG_UKRAINIAN 0x0422  
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GetParentScreen

Description
Returns a pointer to the screen name. 

Can only be used in C scripting.

Syntax
char* GetParentScreen(char* Screen name);

Parameters

Screen name
Pointer to the screen

Return value
Name of the current screen if the system function is called in the basic picture.

Name path of the higher-level screen if the system function is called in a screen window.
 

 Note

The syntax of the transferred call parameter Screen name must correspond to that formed 
by the graphics system for the screen paths:

<RootScreenName>.<ScreenWindowName>:<ScreenName>. ... .<ScreenWindowName>:<
ScreenName>. 

 

GetParentScreenWindow

Description
Provides a pointer to the name of the picture window.

Can only be used in C scripting.

Syntax
char* GetParentScreenWindow(char* Screen name);

Parameters

Screen name
Pointer to the screen
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Return value
Pointer to the name of the screen window if the system function is called in a screen which is 
displayed in the screen window of a parent screen.

Call parameter "Screen name" unchanged if the system function is called in the basic screen.
 

 Note

The syntax of the transferred call parameter Screen name must correspond to that formed 
by the graphics system for the screen paths:

<RootScreenName>.<ScreenWindowName>:<ScreenName>. ... .<ScreenWindowName>:<
ScreenName>.

 

Example
In a basic picture "Picture_1" there is a picture window "Picture_window_1" in which a picture 
"Picture_2" is called.

In the picture "Picture_2" there is a picture window "Picture_window_2" in which a picture 
"Picture_3" is called.

Then the system function GetParentScreenWindow(Screen name) returns the pointer to 
the screen window name:

"Screen_2", if the system function is called in "Screen_3";

"Screen_window_1", if the system function is called in "Screen_2";

"Screen_1", if the system function is called in "Screen_1". 

GetProp

GetPropBOOL 

Description
Returns the current status of a property of data type "BOOL". 

Can only be used in C scripting.

Syntax
BOOL GetPropBOOL(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)

Parameters

Screen name
Screen name
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Object
Object name

Name of the Property
Name of the object property

Return value
Value of the property in data type "BOOL".

GetPropChar

Description
Returns the current value of a property of data type "Char". 

Can only be used in C scripting.

Syntax
Char* GetPropChar(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property

Return value
Value of the property in data type "Char".

GetPropDouble

Description
Returns the value of a property of data type "Double". 

Can only be used in C scripting.
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Syntax
double GetPropDouble(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property

Return value
Value of the property in data type "Double".

GetPropLong

Description
Returns the status of a property of data type "long". 

Can only be used in C scripting.

Syntax
long GetPropLong(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property
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Return value
Value of the property in data type "long".

GetServerTagPrefix

Description
In order for a WinCC client in a distributed system to access tags of the associated server, the 
tag names must be expanded to include the server prefix.

 

 Note

This system function is not supported at present.
 

A pointer of type "char" to ServerPrefix, TagPrefix, and WindowPrefix is returned in each case.

The user is not permitted to change the memory (including no strcat) or release it.

Can only be used in C scripting.

Syntax
void GetServerTagPrefix (char** ppszServerPrefix, char** ppszTagPrefix, char** 
ppszWindowPrefix);

Return value

ppszServerPrefix
Pointer to a pointer that references the server prefix

ppszTagPrefix
Pointer to a pointer that references the tag prefix

ppszWindowPrefix
Pointer to a pointer that references the window prefix 

GetTag

GetTagXXX

Description
The GetTagXXX function determines the value of a tag of a specified data type. 

Can only be used in C scripting:

The following table shows the different GetTag functions for reading the tag value:
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Type Function 
name

Parameters PLC data type HMI data type

BOOL GetTagBit  Tag Tag_Name Binary tag Bool
BYTE GetTagByt

e  
Tag Tag_Name Unsigned 8-bit UByte

char* GetTagCh
ar  

Tag Tag_Name Text tag 8-bit or 
text tag 16-bit

String

double GetTagDo
uble  

Tag Tag_Name Floating point 64-bit Double

DWOR
D

GetTagD
Word  

Tag Tag_Name Unsigned 32-bit UInteger

float GetTagFlo
at  

Tag Tag_Name Floating point 32-bit Float

BOOL GetTagRa
w  

Tag Tag_Name, 
BYTE* pValue, 
DWORD size

Raw data type Raw

char GetTagSB
yte  

Tag Tag_Name Signed 8-bit Byte

long int GetTagSD
Word  

Tag Tag_Name Signed 32-bit Integer

short 
int

GetTagS
Word  

Tag Tag_Name Signed 16-bit Short

WORD GetTagWo
rd  

Tag Tag_Name Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BYTE GetTagByte (Tag Tag_Name);

Parameters

Tag_Name
Name of the tags

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagChar" returns a pointer on the string that contains the value of 
the tags. 
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The "GetTagRaw" system function returns TRUE or FALSE:

TRUE: The system function has been completed without any errors.

FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

Access to HMI tags (Page 1758)

GetTagMultiStateQCWait

Description
The values, status, and quality code of several tags are established and saved in the repsective 
addresses in the specified format . The values are read explicitly from the AS.

Two DWORD arrays are transferred, in the member of which the status and quality codes of 
the individual tags will be located after the system function has been called. The size of the 
arrays must be large enough to provide sufficient storage space for the status and quality 
codes.  

Can only be used in C scripting.

Syntax
BOOL GetTagMultiStateQCWait (DWORD* pdwState, DWORD* pdwQualityCode, const 
char* pFormat, ...);

Parameters

pdwState
Field in which the status of the individual tags is created after the system function cycle.

pdwQualityCode
Field in which the quality code of the individual tag is created after the system function cycle.

pFormat
Format description for all the requested tags along with the name and address of the value for 
each tag.
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Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

GetTagMultiStateWait

Description
The values and status of several tags are determined and saved in the respective addresses 
in the specified format. The values are read explicitly from the AS. 

The system function must be given a DWORD array, in the member of which the status of the 
individual tags will be located after the system function has been called. The size of the array 
must be large enough to provide sufficient storage space for the status.  

Can only be used in C scripting.

Syntax
BOOL GetTagMultiStateWait(DWORD* pdwState, const char* pFormat);

Parameters

pdwState
Field in which the tag status is saved.

pFormat
Format description for all the requested tags along with the name and address of the value for 
each tag.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.
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GetTagMultiWait

Description
The values of several tags are determined and saved in the respective addresses in the 
specified format. The value is read explicitly from the AS. The memory for the tag value is 
created by the system function with SysMalloc.  

Can only be used in C scripting.

Syntax
BOOL GetTagMultiWait(const char* pFormat,...);

Parameters

pFormat
Format description for all requested tags along with name and address of the value for each 
tag.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

GetTagStateXXX

Description
The GetTagStateXXX function determines the value of a tag of a specified data type. It also 
returns the status of the tags.

Can only be used in C scripting.

The following table shows the different GetTagStateXXX functions for reading the tag value: 

Type Function 
name

Parameters PLC data type HMI data type

BOOL GetTagBitSt
ate  

Tag Tag_Name, PDWORD 
lp_dwstate

Binary tag Bool

BYTE GetTagByte
State  

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 8-bit Byte

char* GetTagChar
State  

Tag Tag_Name, PDWORD 
lp_dwstate

Text tag 8-bit or text tag 16-
bit

String
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Type Function 
name

Parameters PLC data type HMI data type

double GetTagDou
bleState  

Tag Tag_Name, PDWORD 
lp_dwstate

Floating point 64-bit Double

DWORD GetTagDWo
rdState  

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 32-bit UInteger

float GetTagFloat
State  

Tag Tag_Name, PDWORD 
lp_dwstate

Floating point 32-bit Float

BOOL GetTagRaw
State  

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

char GetTagSByt
eState  

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 8-bit Byte

long int GetTagSD
WordState  

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 32-bit Integer

short int GetTagSWo
rdState  

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 16-bit Short

WORD GetTagWor
dState  

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BOOL GetTagBitState (Tag Tag_Name, PDWORD lp_dwstate);

Parameters

Tag_Name
Name of the tags

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharState" returns a pointer on the value of the tags in the "char" 
data type. 

The "GetTagRawState" system function returns TRUE or FALSE:

TRUE: The system function has been completed without any errors.
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FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

GetTagStateQC

Description
The GetTagStateQC function determines the value of a tag of a specified data type. It also 
returns the status and quality code of the tags.

Can only be used in C scripting.

The following table shows the different GetTagStateQC functions for reading the tag value: 

Type Function 
name

Parameters PLC data type HMI data type

BOOL GetTagBitStat
eQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Binary tag Bool

BYTE GetTagByteSt
ateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 8-bit UByte

char* GetTagCharS
tateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Text tag 8-bit or text tag 
16-bit

String

double GetTagDoubl
eStateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 64-bit Double

DWO
RD

GetTagDWor
dStateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 32-bit UInteger
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Type Function 
name

Parameters PLC data type HMI data type

float GetTagFloatS
tateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 32-bit Float

BOOL GetTagRawSt
ateQC  

Tag Tag_Name, 
BYTE pValue[], 
DWORD size, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Raw data type Raw

signed 
char

GetTagSByte
StateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 8-bit Byte

long GetTagSDWo
rdStateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 32-bit Integer

short GetTagSWor
dStateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 16-bit Short

WOR
D

GetTagWord
StateQC  

Tag Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BOOL GetTagBitStateQC (Tag Tag_Name, PDWORD lp_dwstate, PDWORD 
pdwQualityCode);

Parameters

Tag_Name
Name of the tag

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.
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pdwQualityCode
Pointer on a DWORD in which the quality code of the tag is created after the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateQC" returns a pointer on the value of the tags in the 
"char" data type. 

The "GetTagRawStateQC" system function returns TRUE or FALSE:

TRUE: The system function has been completed without any errors.

FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

GetTagStateQCWait

Description
The GetTagStateQCWait function determines the value of a tag of a specified data type. The 
value is read explicitly from the AS. It also returns the status and quality code of the tags.

Can only be used in C scripting.

The following table shows the different GetTagStateQCWait functions for reading the tag value:

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
1876 System Manual, 08/2011,  



Type Function name Parameters PLC data type HMI data type
BOOL GetTagBitStateQ

CWait  
Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Binary tag Bool

BYTE GetTagByteState
QCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Unsigned 8-bit UByte

char* GetTagCharStat
eQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Text tag 8-bit or text tag 
16-bit

String

double GetTagDoubleSt
ateQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Floating point 64-bit Double

DWOR
D

GetTagDWordSt
ateQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Unsigned 32-bit UInteger

float GetTagFloatStat
eQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Floating point 32-bit Float

BOOL GetTagRawState
QCWait  

Tag 
Tag_Name, 
BYTE pValue[], 
DWORD size, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Raw data type Raw
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Type Function name Parameters PLC data type HMI data type
signed 
char

GetTagSByteStat
eQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Signed 8-bit Byte

long GetTagSDWordS
tateQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Signed 32-bit Integer

short GetTagSWordSt
ateQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Signed 16-bit Short

WORD GetTagWordStat
eQCWait  

Tag 
Tag_Name, 
PDWORD 
lp_dwstate, 
PDWORD 
pdwQualityCod
e

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BOOL GetTagBitStateQC (Tag Tag_Name, PDWORD lp_dwstate, PDWORD 
pdwQualityCode);

Parameters

Tag_Name
Name of the tags

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.

pdwQualityCode
Pointer on a DWORD in which the quality code of the tag is created after the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.
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size
Size of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateQCWait" returns a pointer on the value of the tags in 
the "char" data type. 

The "GetTagRawStateQCWait" system function returns TRUE or FALSE: 

TRUE: The system function has been completed without any errors.

FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

GetTagStateWait

Description
The GetTagStateWait function determines the value of a tag of a specified data type. The value 
is read explicitly from the AS. It also returns the status of the tags.

Can only be used in C scripting.

The following table shows the different GetTagStateWait functions for reading the tag value: 

Type Function name Parameters PLC data type HMI data type
BOOL GetTagBitStat

eWait  
Tag Tag_Name, 
PDWORD lp_dwstate

Binary tag Bool

BYTE GetTagByteSt
ateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 8-bit UByte

char* GetTagCharSt
ateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Text tag 8-bit or text tag 
16-bit

String

double GetTagDouble
StateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Floating point 64-bit Double

DWO
RD

GetTagDWord
StateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

float GetTagFloatSt
ateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Floating point 32-bit Float

BOOL GetTagRawSt
ateWait  

Tag Tag_Name, 
BYTE* pValue, 
DWORD size, 
PDWORD lp_dwstate

Raw data type Raw
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Type Function name Parameters PLC data type HMI data type
char GetTagSByteS

tateWait  
Tag Tag_Name, 
PDWORD lp_dwstate

Signed 8-bit Byte

long 
int

GetTagSDWor
dStateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Signed 32-bit Integer

short 
int

GetTagSWord
StateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Signed 16-bit Short

WOR
D

GetTagWordSt
ateWait  

Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>

Example: BOOL GetTagBitStateWait (Tag Tag_Name, PDWORD lp_dwstate).

Parameters

Tag_Name
Name of the tags

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateWait" returns a pointer on the value of the tags in the 
"char" data type. 

The "GetTagRawState" system function returns TRUE or FALSE. 

TRUE: The system function has been completed without any errors.

FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)
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GetTagValue

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value.  

Can only be used in C scripting.

Syntax
BOOL GetTagValue(LPDM_VARKEY lpdmVarKey, LPDM_VAR_UPDATE_STRUCT 
lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmresult
Pointer on the value of data type "DM_VAR_UPDATE_STRUCT"

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

GetTagValueStateQC

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. It also returns the status and quality code of the tags.  

The system function can be used in C scripting only.

Syntax
BOOL GetTagValueStateQC (LPDM_VARKEY, lpdmVarKey, 
LPDM_VAR_UPDATE_STRUCTEX lpdmresult, LPCMN_ERROR lpdmError);
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Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmresult
Pointer on the value of data type "DM_VAR_UPDATE_STRUCTEX"

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

GetTagValueStateQCWait

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. The value is read explicitly from the AS. It also returns the 
status and quality code of the tags.  

Can only be used in C scripting.

Syntax
BOOL GetTagValueStateQCWait (LPDM_VARKEY lpdmVarKey, 
LPDM_VAR_UPDATE_STRUCTEX lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmresult
Pointer on the value of data type "DM_VAR_UPDATE_STRUCTEX"

lpdmError
Pointer on the structure that contains the error description.
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Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

GetTagValueWait

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. The value is read directly from the AS.  

Can only be used in C scripting.

Syntax
BOOL GetTagValueWait(LPDM_VARKEY lpdmVarKey, LPDM_VAR_UPDATE_STRUCT 
lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmresult
Pointer on the value of data type "DM_VAR_UPDATE_STRUCT"

lpdmError
Pointer on the structure that contains the error description

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.
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GetTagWait

Description
The GetTagWait function establishes the value of a tag of a specified data type. The value is 
read explicitly from the AS. 

Can only be used in C scripting.

The following table shows the different GetTagWait functions for reading the tag value:

Type Function 
name

Parameters PLC data type HMI data type

BOOL GetTagBitW
ait  

Tag Tag_Name Binary tag Bool

BYTE GetTagByte
Wait  

Tag Tag_Name Unsigned 8-bit UByte

char* GetTagChar
Wait  

Tag Tag_Name Text tag 8-bit or text tag 
16-bit

String

double GetTagDoub
leWait  

Tag Tag_Name Floating point 64-bit Double

DWOR
D

GetTagDWor
dWait  

Tag Tag_Name Unsigned 32-bit UInteger

float GetTagFloat
Wait  

Tag Tag_Name Floating point 32-bit Float

BOOL GetTagRaw
Wait  

Tag Tag_Name, 
BYTE* pValue, 
DWORD size

Raw data type Raw

char GetTagSByt
eWait  

Tag Tag_Name Signed 8-bit Byte

long int GetTagSDW
ordWait  

Tag Tag_Name Signed 32-bit Integer

short 
int

GetTagSWor
dWait  

Tag Tag_Name Signed 16-bit Short

WORD GetTagWord
Wait  

Tag Tag_Name Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BYTE GetTagByteWait (Tag Tag_Name);

Parameters

Tag_Name
Name of the tags

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
1884 System Manual, 08/2011,  



pValue
Pointer to a byte field containing the value of the raw data tags.

Return value
Value of the tags in the specified type.

The system function "GetTagCharWait" returns a pointer on the string that contains the value 
of the tags. 

The "GetTagRawWait" system function returns TRUE or FALSE:

TRUE: The system function has been completed without any errors.

FALSE: An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

IncreaseTag

Description
Adds the given value to the value of the tags.    

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".
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Parameters

Tag
The tag to which the given value is added.

Value
The value that is added.

InquireLanguage

Description
Determines all languages configured in the text library for the runtime.

Use Pointer to a counter to specify the storage location for language IDs.

The system function can be used in C scripting only.

Syntax
DWORD* InquireLanguage (DWORD* Pointer to a counter);

Parameters

Pointer to a counter
Pointer to the number of language IDs found 

Return value
Pointer to a field containing the established language IDs.

The following assignments apply (hexadecimal language code):

Symbolic description Value(hexadecimal
)

Abbreviation

LANG_ARABIC 0x0401  
LANG_AFRIKAANS 0x0436  
LANG_ALBANIAN 0x041C  
LANG_BASQUE 0x042D  
LANG_BULGARIAN 0x0402  
LANG_BYELORUSSIAN 0x0423  
LANG_CATALAN 0x0403  
LANG_CHINESE 0x0404  
LANG_CROATIAN 0x041A  
LANG_CZECH 0x0405 CSY
LANG_DANISH 0x0406 DAN
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Symbolic description Value(hexadecimal
)

Abbreviation

LANG_DUTCH 0x0413 NLD
LANG_ENGLISH 0x0409 ENU
LANG_ESTONIAN 0x0425  
LANG_FAEROESE 0x0438  
LANG_FARSI 0x0429  
LANG_FINNISH 0x040B FIN
LANG_FRENCH 0x040C FRA
LANG_GERMAN 0x0407 DEU
LANG_GREEK 0x0408  
LANG_HEBREW 0x040D  
LANG_HUNGARIAN 0x040E HUN
LANG_ICELANDIC 0x040F ISL
LANG_INDONESIAN 0x0421  
LANG_ITALIAN 0x0410 ITA
LANG_JAPANESE 0x0411  
LANG_KOREAN 0x0412  
LANG_LATVIAN 0x0426  
LANG_LITHUANIAN 0x0427  
LANG_NORWEGIAN 0x0414 NOR
LANG_POLISH 0x0415 PLK
LANG_PORTUGUESE 0x0416 PTB
LANG_ROMANIAN 0x0418  
LANG_RUSSIAN 0x0419 RUS
LANG_SLOVAK 0x041B SKY
LANG_SLOVENIAN 0x0424  
LANG_SORBIAN 0x042E  
LANG_SPANISH 0x040A ESP
LANG_SWEDISH 0x041D SVE
LANG_THAI 0x041E  
LANG_TURKISH 0x041F TRK
LANG_UKRAINIAN 0x0422  

InverseLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.    

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1887



The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag whose value is used for the calculation.

b
The value which is subtracted.

a
The value through which is divided.

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:    

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).
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Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag
The tag whose bit is set.

InvertBitInTag

Description
Inverts a bit in the given tag:    

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".
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Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

IsUserAuthorized

Description
Authentication of users.

Can only be used in C scripting. 

Syntax
BOOL IsUserAuthorized (DWORD AuthorizationNumber);

Parameters

AuthorizationNumber
Authorization (numerical) to be verified. 

Return value

TRUE
The user has the specified authorization.

FALSE
The user does not have the specified authorization.

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.    
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The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag whose value is used for the calculation.

b
The value which is added.

ReportJob

Description
A print job, or the preview for a print job is started depending on the value of the Name of 
method parameter.

Can only be used in C scripting.

Syntax
void ReportJob(LPCSTR Print job name, LPCSTR Name of method)
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Parameters

Print job name
Pointer to the name of the print job

Name of method
Defines whether to start the print job or a print job preview:

● PRINTJOB: Print job is started

● PREVIEW: Print job preview is started

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).    

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).    
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After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).    

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit(Tag)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".
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Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).    

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).
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When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

SetLanguageByLocaleID

Description
Changes the language setting in Runtime.

Can only be used in C scripting.

Syntax
BOOL SetLanguageByLocaleID (DWORD dwLocaleID);  

Parameters

dwLocaleID
Language ID of the language to be set

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

See also
Example of configuring a language switch (Page 1835)
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SetProp

SetPropBOOL

Description
Sets an object property of data type "BOOL".

Can only be used in C scripting.

Syntax
BOOL SetPropBOOL(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, BOOL Value)   

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property The parameter Name of the property = NULL must be set if the 
function call refers to the screen object.

Value
Value assigned to the object property of data type "BOOL". 

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

SetPropChar

Description
Sets an object property of data type "char".

Can only be used in C scripting.
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Syntax
BOOL SetPropChar(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, char* Value)   

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property The parameter Name of the property = NULL must be set if the 
function call refers to the screen object.

Value
Value assigned to the object property of data type "char". 

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

SetPropDouble

Description
Sets an object property of data type "Double".

Can only be used in C scripting.

Syntax
BOOL SetPropDouble(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, double Value)   

Parameters

Screen name
Screen name
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Object
Object name

Name of the Property
Name of the object property The parameter Name of the property = NULL must be set if the 
function call refers to the screen object.

Value
Value assigned to the object property of data type "double". 

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

See also
Example of accessing objects in the Screens editor (Page 1834)

SetPropLong

Description
Sets an object property of data type "long".

Can only be used in C scripting.

Syntax
BOOL SetPropLong(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, long Value)   

Parameters

Screen name
Screen name

Object
Object name

Name of the Property
Name of the object property The parameter Name of the property = NULL must be set if the 
function call refers to the screen object.
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Value
Value assigned to the object property of data type "long". 

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

See also
Example of writing object properties (Page 1838)

Accessing objects with C (Page 1772)

SetPropertyByConstant

Description
Specifies the value of an object property as a string.    

Use in the function list
SetPropertyByConstant (Screen name, Object, Name of the property, Value)

Use in user-defined functions
SetPropertyByConstant

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is changed. 

Name of the property
Name of the property that will be changed. 
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Value
The value assigned to the property. 

See also
Example of defining object colors (Page 1834)

SetPropertyByProperty

Description
Specifies the value of an object property with another object property.    

Use in the function list
SetPropertyByProperty (Screen name, Object, Name of the property, Destination screen 
name, Destination object, Destination property name)

Use in user-defined functions
SetPropertyByProperty (Screen_name, Screen_object, Property_name, 
Source_screen_name, Source_screen_object, Source_property_name)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is transferred to the destination object. 

Name of the property
Name of the property that will be transferred to the destination object. 

Destination screen name
Name of the screen that contains the destination object. 

Destination object
Name of the destination object to which the property is transferred. 

Destination property name
Name of the property that will be changed. 
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SetPropertyByTag

Description
Specifies the value of an object property with a tag value.    

Use in the function list
SetPropertyByTag (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTag (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property you want to set with a tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that contains the value of the property. 

SetPropertyByTagIndirect

Description
Specifies the value of an object property with a tag. The tag contains the tag name that specifies 
the object property.    

Use in the function list
SetPropertyByTagIndirect (Screen name, Object, Name of property, Tag name)

Use in user-defined functions
SetPropertyByTagIndirect (Screen_name, Screen_object, Property_name, Tag_name)
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Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property you want to set with a tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that, in turn, contains the name of the tag that specifies the object property. 

SetTag

SetTagXXX

Description
The SetTagXXX function sets the value of a tag of the specified data type. 

Can only be used in C scripting.

The following table shows the different SetTag functions for setting the tag value:            

Function 
name

Parameters PLC data type HMI data type

SetTagBit Tag Tag_Name, short int value Binary tag Bool
SetTagByt
e

Tag Tag_Name, BYTE value Unsigned 8-bit UByte

SetTagCh
ar

Tag Tag_Name, LPSTR value Text tag 8-bit or text tag 16-
bit

String

SetTagDo
uble

Tag Tag_Name, double value Floating point 64-bit Double

SetTagD
Word

Tag Tag_Name, DWORD 
value

Unsigned 32-bit UInteger

SetTagFlo
at

Tag Tag_Name, float value Floating point 32-bit Float

SetTagRa
w

Tag Tag_Name, BYTE* 
pValue, DWORD size

Raw data type Raw

SetTagSB
yte

Tag Tag_Name, char value Signed 8-bit Byte
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Function 
name

Parameters PLC data type HMI data type

SetTagSD
Word

Tag Tag_Name, long int value Signed 32-bit Integer

SetTagS
Word

Tag Tag_Name, short int value Signed 16-bit Short

SetTagWo
rd

Tag Tag_Name, WORD value Unsigned 16-bit UShort

Syntax
BOOL<FunctionName><(Parameter)>;

Example: BOOL SetTagBit (Tag Tag_Name, short int value);

Parameters

Tag_Name
Name of the tags

value
Value of the tags of a specified type.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

Access to HMI tags (Page 1758)
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SetTagMultiStateWait

Description
Sets the values of several tags. The system function will end only after the AS has reported 
the acceptance of the value.

The system function can be used in C scripting only.

The system function must be given a DWORD array, in the member of which the status of the 
individual tags will be located after the system function has been called. The size of the array 
must be large enough to provide sufficient storage space for the status.  

Syntax
BOOL SetTagMultiStateWait(DWORD* pdwState, const char* pFormat,...);

Parameters

pdwState
Field in which the tag status is saved.

pFormat
Format description for all the requested tags along with the name and value for each tag.

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred.

SetTagMultiWait

Description
The values of several tags are set in the specified format. The system function will end only 
after the AS has reported the acceptance of the value. 

Can only be used in C scripting.

Syntax
BOOL SetTagMultiWait(const char* pFormat,...);
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Parameters

pFormat
Format description for all the requested tags along with the name and value for each tag.

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred.

SetTagStateXXX

Description
Sets the value of a tag of a specified data type. It also returns the status of the tags.

Can only be used in C scripting.

The following table shows the different SetTagStateXXX functions for setting the tag value:

Function name Parameters PLC data type HMI data type
SetTagBitState  Tag Tag_Name, short 

int value, PDWORD 
lp_dwstate

Binary tag Bool

SetTagByteStat
e  

Tag Tag_Name, BYTE 
value, PDWORD 
lp_dwstate

Unsigned 8-bit UByte

SetTagCharStat
e  

Tag Tag_Name, LPSTR 
value, PDWORD 
lp_dwstate

Text tag 8-bit or text tag 16-
bit

String

SetTagDoubleSt
ate  

Tag Tag_Name, double 
value, PDWORD 
lp_dwstate

Floating point 64-bit Double

SetTagDWordSt
ate  

Tag Tag_Name, 
DWORD value, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

SetTagFloatStat
e  

Tag Tag_Name, float 
value, PDWORD 
lp_dwstate

Floating point 32-bit Float

SetTagRawStat
e  

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw
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Function name Parameters PLC data type HMI data type
SetTagSByteSt
ate  

Tag Tag_Name, signed 
char value, PDWORD 
lp_dwstate

Signed 8-bit Byte

SetTagSDWord
State  

Tag Tag_Name, long int 
value, PDWORD 
lp_dwstate

Signed 32-bit Integer

SetTagSWordSt
ate  

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Signed 16-bit Short

SetTagWordSta
te  

Tag Tag_Name, WORD 
value, PDWORD 
lp_dwstate

Unsigned 16-bit UShort

Syntax
BOOL <FunctionName><(Parameter)>;

Example: BOOL SetTagBitState (Tag Tag_Name, short int value, PDWORD lp_dwstate);

Parameters

Tag_Name
Name of the tags

value
Value of the tags of a specified type.

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.

pFormat
Format description for all the requested tags along with name and value for each tag.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors. 
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FALSE
An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

SetTagStateWaitXXX

Description
Sets the value of a tag of a specified data type. The system function will end only after the AS 
has reported the acceptance of the value. It also returns the status of the tags.

Can only be used in C scripting.

The following table shows the different SetTagState functions for setting the tag value: 

Function name Parameters PLC data type HMI data type
SetTagBitStateWa
it  

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Binary tag Bool

SetTagByteState
Wait  

Tag Tag_Name, BYTE 
value, PDWORD 
lp_dwstate

Unsigned 8-bit UByte

SetTagCharState
Wait  

Tag Tag_Name, 
LPSTR value, 
PDWORD lp_dwstate

Text tag 8-bit or text tag 16-
bit

String

SetTagDoubleStat
eWait  

Tag Tag_Name, double 
value, PDWORD 
lp_dwstate

Floating point 64-bit Double

SetTagDWordStat
eWait  

Tag Tag_Name, 
DWORD value, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

SetTagFloatState
Wait  

Tag Tag_Name, float 
value, PDWORD 
lp_dwstate

Floating point 32-bit Float

SetTagRawState
Wait  

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

SetTagSByteState
Wait  

Tag Tag_Name, char 
value, PDWORD 
lp_dwstate

Signed 8-bit Byte

SetTagSDWordSt
ateWait  

Tag Tag_Name, long 
int value, PDWORD 
lp_dwstate

Signed 32-bit Integer
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Function name Parameters PLC data type HMI data type
SetTagSWordStat
eWait  

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Signed 16-bit Short

SetTagWordState
Wait  

Tag Tag_Name, 
WORD value, 
PDWORD lp_dwstate

Unsigned 16-bit UShort

Syntax
BOOL<FunctionName><(Parameter)>;

Example: BOOL SetTagBitStateWait (Tag Tag_Name, short int value, PDWORD lp_dwstate);

Parameters

Tag_Name
Name of the tags

value
Value of the tags of a specified type.

lp_dwstate
Pointer on a DWORD in which the status of the tag is created after the system function cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors. 

FALSE
An error has occurred.

See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)
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SetTagValue

Description
Enables the transfer of a value in the form of a variant and sets the pointer on the value of the 
"Variant" data type.  

Can only be used in C scripting.

Syntax
BOOL SetTagValue (LPDM_VARKEY lpdmVarKey, LPVARIANT lpdmValue, PDWORD 
dwState, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmValue
Pointer on the value of data type "Variant". For a description of the VARIANT data type see 
the relevant specialist literature.

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred.

SetTagValueWait

Description
Enables the transfer of a value in the form of a variant and sets the pointer on the value of the 
"Variant" data type. The system function will end only after the AS has reported the acceptance 
of the value.  

Can only be used in C scripting.
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Syntax
BOOL SetTagValueWait(LPDM_VARKEY lpdmVarKey, LPVARIANT lpdmValue, PDWORD 
dwState, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer on a structure of data type "DM_VARKEY"

lpdmValue
Pointer on the value of data type "Variant". For a description of the VARIANT data type see 
the relevant specialist literature.

dwState
Status of the tags that is returned after the system function cycle.

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred. 

SetTagWaitXXX

Description
Sets the value of a tag of a specified data type. The system function will end only after the AS 
has reported the acceptance of the value.

Can only be used in C scripting.

The following table shows the different SetTagWait functions for setting the tag value:

Function name Parameters PLC data type HMI data type
SetTagBitWait  Tag Tag_Name, short 

int value
Binary tag Bool

SetTagByteWait
  

Tag Tag_Name, BYTE 
value

Unsigned 8-bit UByte

SetTagCharWai
t  

Tag Tag_Name, char* 
value

Text tag 8-bit or text tag 16-
bit

String
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Function name Parameters PLC data type HMI data type
SetTagDoubleW
ait  

Tag Tag_Name, double 
value

Floating point 64-bit Double

SetTagDWordW
ait  

Tag Tag_Name, 
DWORD value

Unsigned 32-bit UInteger

SetTagFloatWai
t  

Tag Tag_Name, float 
value

Floating point 32-bit Float

SetTagRawWait
  

Tag Tag_Name, BYTE* 
pValue, DWORD size

Raw data type Raw

SetTagSByteW
ait  

Tag Tag_Name, char 
value

Signed 8-bit Byte

SetTagSDWord
Wait  

Tag Tag_Name, long int 
value

Signed 32-bit Integer

SetTagSWordW
ait  

Tag Tag_Name, short 
int value

Signed 16-bit Short

SetTagWordWai
t  

Tag Tag_Name, WORD 
value

Unsigned 16-bit UShort

Syntax
BOOL <FunctionName><(Parameter)>;

Example: BOOL SetTagBitWait (Tag Tag_Name, short int value);

Parameters

Tag_Name
Name of the tags

value
Value of the tags of a specified type.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Size of the byte field in bytes

Return value

TRUE
The system function itself has been completed without any errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred.
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See also
Data types for SIMATIC S7 300/400 (Page 1048)

Data types for OPC-DA (Page 1070)

Data types for OPC-XML-DA (Page 1076)

SetTag

Description
Assigns a new value to the given tag.   

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag(Tag, Value)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
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SetTagByProperty

Description
Specifies a tag value with the value of an object property. The change is also logged in the 
alarm system.    

Use in the function list
SetTagByProperty (Tag name, Screen name, Object, Name of the property, With or without 
operator event)

Use in user-defined functions
SetTagByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name
Name of the tag whose value is specified by the object property.

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property supplies the tag value.

Name of the property
Name of the property that supplies the tag value. 

With or without operator input
0 (hmiWithoutOperatorEvent) = Without operator input

1 (hmiWithOperatorEvent) = With operator input

SetTagByTagIndirect

Description
Specifies the tag value with the value of an indirect tag. The change is also logged in the alarm 
system.    
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Use in the function list
SetTagByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagByTagIndirect (Tag_name, Source_tag_name, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name
Name of the tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that supplies the tag value. 

With or without operator input
0 (hmiWithoutOperatorEvent) = Without operator input 

1 (hmiWithOperatorEvent) = With operator input

SetTagIndirect 

Description
Specifies the indirect name for a tag.    

Use in the function list
SetTagIndirect (Tag name (output), LpValue)

Use in user-defined functions
SetTagIndirect (Tag_name, Value, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 
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SetTagIndirectByProperty

Description
Specifies a tag name with the value of an object property. The change is also logged in the 
alarm system.    

Use in the function list
SetTagIndirectByProperty (Tag name, Screen name, Screen object, Name of the property, 
With or without operator event)

Use in user-defined functions
SetTagIndirectByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name
Name of the tag whose tag name is specified by the object property.

Screen name
Name of the screen that contains the object. 

Screen object
Name of the object whose property returns the tag name.

Name of the property
Name of the property that returns the tag name. 

With or without operator input
0 (hmiWithoutOperatorEvent) = Without operator input

1 (hmiWithOperatorEvent) = With operator input

SetTagIndirectByTagIndirect

Description
Specifies the tag value with the value of an indirect tag. The change is also logged in the alarm 
system.    
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Use in the function list
SetTagIndirectByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagIndirectByTagIndirect (Tag_name, Source_tag_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name
Name of the indirect tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that supplies the tag value. 

With or without operator input
0 (hmiWithoutOperatorEvent) = Without operator input

1 (hmiWithOperatorEvent) = With operator input

SetTagIndirectWithOperatorInputAlarm

Description
Specifies the indirect name for a tag. The change is also logged in the alarm system.    

Use in the function list
SetTagIndirectWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagIndirectWithOperatorInputAlarm

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
1916 System Manual, 08/2011,  



LpValue
Name of the tag written to the tag. 

SetTagWithOperatorEvent

Description
Specifies the value for a tag. The change is also logged in the alarm system.    

Use in the function list
SetTagWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagWithOperatorEvent (Tag_name, Value)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Tag name (output)
Name of the tag whose value is to be set. 

LpValue
Value written to the tag. 

 

StartProgram

Description
Starts the specified program with the specified parameters.

The system function can be used in C scripting only

Syntax
void StartProgram(Program_name,Program_parameter,Display_mode, 
Wait_for_program_end);   
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Parameters

Program_name
Path and name of the program to be started.

Program_parameters
Parameters to be used for start-up. Information on the possible parameters can be found in 
the description of the program to be started.

Display_mode
Defines the display mode in which the program is started:

0 (hmiShowNormal) = Display in window

1 (hmiShowMinimized) = Display in minimized window

2 (hmiShowMaximized) = Display in maximized window

3 (hmiShowMinimizedAndInaktive) = Display in inactive and minimized window

Wait_for_program_end
The parameter is not evaluated by WinCC Runtime Professional.

StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.    

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime(Mode)

Can be used if the configured device supports user-defined functions. Additional information 
is available under "Auto-Hotspot".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)
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See also
Example of deactivating Runtime (Page 1835)

StoreScreen 

Description
Saves the current screen; this saved screen can then be opened with the 
ActivateStoredScreen system function.

Can only be used in C scripting.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred. 

See also
ActivateStoredScreen (Page 1859)

UA (Recipe)

uaAddArchive

Description:  
Adds a new recipe. This corresponds to the configuration of a new recipe using the "Recipes" 
editor.

Can only be used in C scripting.

Syntax
LONG uaAddArchive ( 
UAHCONFIG hConfig,
UACONFIGARCHIVE* pArchive )

Parameters:
UAHCONFIG hConfig
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Configuration handle for the recipe. This handle is generated with "uaQueryConfiguration".

UACONFIGARCHIVE* pArchive
Pointer to buffer for the recipe configuration memory

Return value
Index of the new recipe. An error corresponds to "-1".

See also
UaQueryConfiguration (Page 1953)

uaAddField

Description:  
Adds a new data field.

Can only be used in C scripting.

Syntax
LONG uaAddField ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGFIELD* pField )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

UACONFIGFIELD* pArchive
Pointer to buffer of the field configuration.

Return value:
Index of the new field. A value of "-1" indicates an error.
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uaArchiveClose

Description:  
Terminates the connection to the current recipe.

Can only be used in C scripting.

Syntax
BOOL uaArchiveClose ( 
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful closing of the recipe

FALSE: Error

uaArchiveDelete

Description 
Deletes the data from a recipe. The configured recipe, however, is retained.

Can only be used in C scripting.

Syntax
BOOL uaArchiveDelete ( 
 UAHARCHIVE hArchive,
 LPCSTR pszWhere )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszWhere
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This string contains the SQL selection expression. It defines which data records are to be 
deleted. The expression is identical to the one in the "DELETE FROM <archive> WHERE 
pszWhere" SQL statement. 

Warning! If this string is empty, the entire recipe will be deleted.

Return value:
TRUE: Successful deletion of the recipe

FALSE: Error

 

uaArchiveExport

Description:  
Exports the current recipe to a log in CSV format.

Can only be used in C scripting.

Syntax
BOOL uaArchiveExport (
 UAHARCHIVE hArchive,
 LPCSTR pszDestination,
 LONG lType,
 LONG lOptions )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszDestination
File name of the target archive.

LONG lType
Data format of the target archive. Two formats are available:

● UA_FILETYPE_DEFAULT = 0: Default file format = CSV

● UA_FILETYPE_CSV = 1: CSV file format

LONG lOptions
Reserved for later expansions. Must be 0.
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Return value:
TRUE: Successful export of the recipe

FALSE: Error

uaArchiveGetCount

Description:  
Reads the number of data records.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetCount(
 UAHARCHIVE hArchive,
 LONG * plCount )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG plCount 
Pointer to a tag in which the number of data records should be stored.

Return value:
Number of data records.

0 = Log is empty or error has occurred. Query using uaGetLastError() is required.

uaArchiveGetFieldLength

Description:  
Reads the length of a field in the current data record.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetFieldLength(
 UAHARCHIVE hArchive,
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 LONG lField )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

Return value:
Length of the current field.

uaArchiveGetFieldName

Description:  
Reads the name of a field in the current data record.

Can only be used in C scripting.

Syntax
VOID uaArchiveGetFieldName (
 UAHARCHIVE hArchive,
 LONG lField,
 LPCSTR pszName,
 LONG cMaxLen )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

LPCSTR pszName
Field Name

LONG cMaxLen
Maximum length
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uaArchiveGetFields

Description:  
Reads the number of configured data fields, which also includes the "ID", "Last User", and 
"Last Access" fields. In the Runtime calls, the indexes of the configured fields are indicated 1 
to N. The field ID has the index 0. The fields "Last User" and "Last Access" are appended to 
the end of the configured fields.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetFields (
 UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
Number of configured fields. 

uaArchiveGetFieldType 

Description:  
Reads the type of a field in the current data record.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetFieldType (
UAHARCHIVE hArchive,
LONG lField )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
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The field number; if lField = 1 the first field is addressed.

Return value:
Type of the current field.

The symbolic definitions of the field types are:

UA_FIELDTYPE_INTEGER

UA_FIELDTYPE_DOUBLE

UA_FIELDTYPE_STRING

UA_FIELDTYPE_DATETIME

uaArchiveGetFieldValueDate

Description:  
Reads the date and time of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField, 
LPSYSTEMTIME pstDateTime )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

LPSYSTEMTIME pstDateTime
Pointer to tag of the SYSTEMTIME type

Return value:
TRUE: Successful reading of date and time

FALSE: Error
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uaArchiveGetFieldValueDouble

Description:  
Reads the Double value of a field in the current data record.

The system function can be used in C scripting only.

BOOL uaArchiveGetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField, 
double* pdValue )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

double* pdValue
Pointer to tag for the current field content.

Return value:
TRUE: Successful reading of field value

FALSE: Error

uaArchiveGetFieldValueFloat

Description:  
Reads Float value of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField, 
FLOAT* pfValue )
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Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

FLOAT* pfValue
Pointer to Float tag for the current field content.

Return value:
TRUE : Successful reading of field value

FALSE : Error

uaArchiveGetFieldValueLong

Description:  
Reads the Long Integer value of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField, 
LONG* pdValue )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

LONG* pdValue
Pointer to Long tag for the current field content.

Return value:
TRUE : Successful reading of field value
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FALSE : Error

uaArchiveGetFieldValueString

Description:  
Reads the string of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueString (
UAHARCHIVE hArchive,
LONG lField, 
LPSTR pszString,
LONG cMaxLen )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first field is addressed.

LPCSTR pszString
Field value as string.

LONG cMaxLen
Maximum length of the string.

Return value:
TRUE : Successful reading of field value

FALSE : Error

uaArchiveGetFilter

Description:  
Reads the filter of the current data record. Additional information can be found in the appendix 
under "SQL Statements". 

Can only be used in C scripting.
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Syntax
VOID uaArchiveGetFilter (
 UAHARCHIVE hArchive,
 LPSTR pszFilter,
 LONG cMaxLen )
The system function can be used in C scripting only.

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPSTR pszFilter
Read filter.

LONG cMaxLen
Maximum length

uaArchiveGetID

Description:  
uaArchiveGetID reads the ID of the recipe.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetID (
 UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
ID of the recipe
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uaArchiveGetName

Description:  
Reads the name of the recipe.

Can only be used in C scripting.

Syntax
VOID uaArchiveGetName (
UAHARCHIVE hArchive,
LPSTR pszName,
LONG cMaxLen )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPSTR pszName
Pointer to buffer for recipe name.

LONG cMaxLen
Maximum length

Example:
char Filling [40];

uaArchiveGetName( hArchive, Filling, 39 );

uaArchiveGetSor

Description:  
uaArchiveGetSort reads the sorting of the recipe. 

Can only be used in C scripting.

Syntax
VOID uaArchiveGetSort (
UAHARCHIVE hArchive,
LPSTR pszSort,
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LONG cMaxLen )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszSort
Sort

LONG cMaxLen
Maximum length

uaArchiveImport

Description:  
uaArchivImport imports a recipe using the CSV data format. The structure of the destination 
recipe must be identical to that of the imported recipe.

Syntax
BOOL uaArchiveImport (
UAHARCHIVE hArchive,
LPCSTR pszSource,
LONG lType,
LONG lOptions )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszSource
File name of the source archive.

LONG lType
Data format of the source archive. Two formats are available:

UA_FILETYPE_DEFAULT = 0: Default file format = CSV

UA_FILETYPE_CSV = 1: CSV file format

LONG lOptions
Reserved for later expansions. Must be 0.
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Return value:
TRUE: Successful import of the recipe.

FALSE: Error

uaArchiveInsert

Description:  
Inserts the local data record buffer into the current database. To have useful data in the new 
data record, the fields of the local data record buffer must be written with the 
"uaArchiveSetFieldValue..." system functions before calling "uaArchiveInsert".
The internal column "ID" must be written into the current data record with the system function 
"uaArchiveSetFieldValueLong". Can only be used in C scripting.

Syntax
BOOL uaArchiveInsert (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful insertion of the data record.

uaArchiveMoveFirst

Description:  
Goes to the first data record. 

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveFirst (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
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Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE : Successful jumping in the recipe

FALSE : Error

uaArchiveMoveLast 

Description:  
Goes to the last data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveLast (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE : Successful jumping in the recipe

FALSE : Error

uaArchiveMoveNext

Description:  
Goes to the next data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveNext (
UAHARCHIVE hArchive )
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Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE : Successful jumping in the recipe

FALSE : Error

uaArchiveMovePrevious

Description:  
Goes to the previous data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMovePrevious (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE : Successful jumping in the recipe

FALSE : Error

uaArchiveOpen

Description:  
uaArchiveOpen opens an existing recipe. uaArchiveOpen must always be called when read 
or write operations are to be performed on this recipe. uaArchiveOpen must, for example, be 
called before calling the uaArchiveMoveFirst, uaArchiveMoveLast, uaArchiveMoveNext, 
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uaArchiveMovePrevious, uaArchiveDelete, uaArchiveUpdate, and uaArchiveInsert system 
functions. 

 

 Note
Sort and filter recipes

You can use the "uaArchiveSetSort" and "uaArchiveSetFilter" system functions on a recipe 
without opening the recipe using "uaArchiveOpen".

 

Can only be used in C scripting.

Syntax
BOOL uaArchiveOpen (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful opening of the recipe

FALSE: Error

uaArchiveReadTagValues

Description:  
Reads the current value from the field tag.

Can only be used in C scripting.

Syntax
BOOL uaArchiveReadTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )
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Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG* pnFields
Reserved for future applications (NULL).

LONG cFields
Number of field indices transferred (size of array pnFields).

Reserved for future applications (0).

LONG lOptions
Reserved for future applications (0).

In the case of all other values of lOptions, the data is inserted at the position of the pointer.

Return value:
TRUE : Successful reading in the recipe

FALSE : Error

uaArchiveReadTagValuesByName

Description:  
Reads the tag values in the current data.

Can only be used in C scripting.

Syntax
BOOL uaArchiveReadTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
LONG lOptions )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszFields
Reserved for future applications (NULL).

LONG lOptions
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Reserved for future applications (0).

Return value:
TRUE : Successful reading in the recipe

FALSE : Error

uaArchiveRequery

Description:  
After the call of uaArchiveSetFilter and uaArchiveSetSort, the recipe must be reloaded with 
uaArchiveRequery. 

 

 Note
Sort and filter recipes

You can use the "uaArchiveSetSort" and "uaArchiveSetFilter" system functions on a recipe 
without opening the recipe using "uaArchiveOpen". In this case, do not call the 
"uaArchiveRequery" system function. 

 

Call up the uaArchiveRequery in the following cases:

● If you have made inputs in the recipe view.

● If you have made inputs in the "Recipes" editor that are to be transferred to the table cell.

Syntax
BOOL uaArchiveRequery(
UAHARCHIVE hArchive )
Can only be used in C scripting.

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful requery

FALSE: Error
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uaArchiveSetFieldValueDate

Description:  
Writes the date and time into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField, 
LPSYSTEMTIME pstDateTime )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first configured field is addressed. If lField = 0, the ID field is 
addressed.

LPSYSTEMTIME pstDateTime
Date and Time

Return value:
TRUE: Successful writing of date and time

FALSE: Error

uaArchiveSetFieldValueDouble

Description:  
Writes a Double value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField, 
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double dValue )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first configured field is addressed. If lField = 0, the ID field is 
addressed.

double dValue
Field value

Return value:
TRUE : Successful writing of field value

FALSE : Error

uaArchiveSetFieldValueFloat

Description:  
Writes a Float value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField, 
float fValue )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first configured field is addressed. If lField = 0, the ID field is 
addressed.

float fValue

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
1940 System Manual, 08/2011,  



Field value

Return value:
TRUE : Successful writing of field value

FALSE : Error

uaArchiveSetFieldValueLong

Description:  
Writes a Long Integer value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField, 
LONG dValue )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first configured field is addressed. If lField = 0, the ID field is 
addressed.

LONG dValue
Field value

Return value:
TRUE : Successful writing of field value

FALSE : Error

uaArchiveSetFieldValueString 

Description:  
Writes a String into a field of the current data record.
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Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueString (
UAHARCHIVE hArchive,
LONG lField, 
LPCSTR pszString )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG lField
The field number; if lField = 1 the first configured field is addressed. If lField = 0, the ID field is 
addressed.

LPCSTR pszString
Field value

Return value:
TRUE : Successful writing of field value

FALSE : Error

uaArchiveSetFilter

Description:  
Sets the filter. You can call the system function without opening the recipe using 
"uaArchiveOpen". 

 

 Note

If you have opened the recipe using "uaArchiveOpen", then reload the recipe after filtering 
using "uaArchiveRequery". 

 

Can only be used in C scripting.

Syntax
VOID uaArchiveSetFilter (
 UAHARCHIVE hArchive,
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 LPSTR pszFilter )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPSTR pszFilter
Filter to be set.

uaArchiveSetSort

Description:  
Sets the sorting of the recipe. You can call the system function without opening the recipe 
using "uaArchiveOpen". 

 

 Note

If you have opened the recipe using "uaArchiveOpen", then reload the recipe after sorting 
using "uaArchiveRequery". 

 

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetSort (
UAHARCHIVE hArchive,
LPSTR pszSort )
The system function can be used in C scripting only.

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszSort
Sort

Return value:
TRUE: Successful setting of the sorting

FALSE: Error
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uaArchiveUpdate

Description:  
Updates the open recipe. All data changes of a recipe are transferred to the database. The 
configuration of the recipe remains unchanged.

Can only be used in C scripting.

Syntax
BOOL uaArchiveUpdate (
UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful update of the recipe

FALSE: Error "Update_failed" = 106

This error occurs when there is a consistency violation. Example: The "Field requires a value" 
flag is set in a field, but no value has been entered there.

uaArchiveWriteTagValues

Description:  
Writes the values of the current data record into the tags.

Can only be used in C scripting.

Syntax
BOOL uaArchiveWriteTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )
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Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LONG* pnFields
Reserved for future applications (NULL).

LONG cFields
Reserved for future applications (0).

LONG lOptions
Reserved for future applications (0).

Return value:
TRUE: Successful reading in the recipe

FALSE: Error

uaArchiveWriteTagValuesByName

Description:  
Writes the values of the current data record into the tags. The access is based on the names 
of the recipe and field.

Can only be used in C scripting.

Syntax
BOOL uaArchiveWriteTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
LONG lOptions )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

LPCSTR pszFields
Reserved for future applications (NULL)

LONG lOptions
Reserved for future applications (0)
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Return value
TRUE : Successful reading in the recipe

FALSE : Error

uaConnect

Description:  
Establishes connection to recipes (Runtime).

Can only be used in C scripting.

Syntax
BOOL uaConnect (
 UAHCONNECT* phConnect )

Parameters:
UAHCONNECT* phConnect
Pointer to handle for newly connected recipe.

Return value
TRUE: Successful connection of a recipe

FALSE: Error

uaDisconnect

Description:  
If a connection to recipes (Runtime) exists, it will be disconnected.

Can only be used in C scripting.

Syntax
BOOL uaDisconnect (
 UAHCONNECT hConnect )

Parameters:
UAHCONNECT hConnect
Handle for the connected recipe (Runtime). This handle is generated with "uaConnect".
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Return value
TRUE: Successful disconnection of a recipe

FALSE: Error

uaGetArchive

Description:  
Reads the recipe configuration.

Can only be used in C scripting.

Syntax
BOOL uaGetArchive ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGARCHIVE* pArchive )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

UACONFIGARCHIVE* pArchive
Pointer to buffer for receiving the recipe configuration

Return value
TRUE: Successful access to the recipe

FALSE: Error

uaGetField

Description:  
Reads the field configuration.

Can only be used in C scripting.
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Syntax
BOOL uaGetField ( 
UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

long lField,
The field number; if lField = 0 the first field is addressed.

UACONFIGFIELD* pArchive
Pointer to buffer for receiving the field configuration.

Return value:
TRUE: Successful access to the recipe

FALSE: Error

uaGetLastError 

Description:  
The system functions of the WinCC script language return a BOOL value, whereby TRUE 
corresponds to error-free processing. If FALSE is returned, the error of the last system function 
can be read with "uaGetLastError()" and "uaGetLastHResult()".

Can only be used in C scripting.

If "uaGetLastError()" is called after running several system functions, "uaGetLastError()" will 
return the error that occurred last. To be certain of the system function in which the error 
occurred, "uaGetLastError()" and "uaGetLastHResult()" should be called every time a system 
function returns FALSE.

Example:

if ( uaArchiveGetFieldValueLong ( hArchive, Index, &IntValue ) == 
TRUE )
printf( "Field Value = %u\n", IntValue );
else
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printf("Error calling uaArchiveGetFieldValueLong: %d / %08lx\n", 
uaGetLastError(), uaGetLastHResult());
With system functions which do not return a value (VOID), there should be a request via 
uaGetLastError() in any case.

Example:

   uaArchiveGetFilter(hArchive, pszFilter, cMaxLen);
    INT nUAError = uaGetLastError (  );
    if ( UA_ERROR_SUCCESS != nUAError)
    {
        printf( "Filter = [%s]\n", pszFilter );
    }
    else
    {
        printf("Error calling uaArchiveGetFilter: %d, hr=0x%08lX\n", 
nUAError, uaGetLastHResult());
    }
 

INT uaGetLastError()

Return value:
Error status of the last system function executed. The following errors can be returned by 
"uaGetLastError()":

UA_ERROR_SUCCESS

UA_ERROR_GENERIC

UA_ERROR_CONNECT_FAILED

UA_ERROR_OPEN_FAILED

UA_ERROR_CLOSE_FAILED

UA_ERROR_REQUERY_FAILED

UA_ERROR_MOVE_FAILED

UA_ERROR_INSERT_FAILED

UA_ERROR_UPDATE_FAILED

UA_ERROR_DELETE_FAILED

UA_ERROR_IMPORT_FAILED

UA_ERROR_EXPORT_FAILED

UA_ERROR_READ_FAILED

UA_ERROR_WRITE_FAILED
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UA_ERROR_GET_FAILED

UA_ERROR_SET_FAILED

UA_ERROR_INVALID_NAME

UA_ERROR_INVALID_TYPE

UA_ERROR_INVALID_NUMRECS

UA_ERROR_INVALID_COMMTYPE

UA_ERROR_INVALID_LENGTH

UA_ERROR_INVALID_PRECISION

UA_ERROR_NULL_POINTER

UA_ERROR_INVALID_POINTER

UA_ERROR_INVALID_HANDLE

UA_ERROR_INVALID_INDEX

UA_ERROR_SERVER_UNKNOWN

These error constants, as well as the predefines of the user archives routines, are located in 
CCUACAPI.H.

uaGetLastHResult 

Description:  
Reads the last occurred COM error. This system function is mainly used to diagnose 
incompatibilities during COM implementation or to detect registration and communication 
errors.
This system function is basically used in addition to UAGetLastError, if a user archive system 
function (e.g. uaConnect) signals an error with "FALSE".

Can only be used in C scripting.

Syntax
LONG uaGetLastHResult()

Return value
Last occurred COM error

uaGetNumArchives

Description:  
Reads the number of recipes currently configured.

Can only be used in C scripting.
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Syntax
LONG uaGetNumArchives ( 
UAHCONFIG hConfig )

Parameters:
UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

Return value:
Number of recipes currently configured. In case of an error, -1 will be returned.

uaGetNumFields

Description:  
Supplies the number of the configured fields. The "ID", "Last User" and "Last Access" fields 
are not included. In the configuration calls, the indexes are indicated from 0 to 
"uaGetNumFields() -1".

Can only be used in C scripting.

Syntax
LONG uaGetNumFields ( 
UAHCONFIG hConfig,
long lArchive )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

Return value:
Number of configured fields. In case of an error, -1 will be returned.
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uaQueryArchive 

Description:  
Establishes a connection to the recipe for Runtime operation. UaQueryArchive creates the 
handle UAHARCHIVE.

Can only be used in C scripting.

Syntax
BOOL uaQueryArchive (
UAHCONNECT hConnect,
 LONG lArchive,
 UAHARCHIVE* phArchive )

Parameters:
UAHCONNECT hConnect
Handle of the connected recipe (Runtime). This handle is generated with "uaConnect".

LONG lArchive
Archiv Index (0... uaGetNumArchives() -1)

UAHARCHIVE* phArchive
Pointer to handle of the recipe

Return value:
TRUE: Successful generation of the handle to the recipe.

FALSE: Error

Comment:
If you use User Archives functions in a client project that works with redundant server pairs, 
the user archives connection cannot be switched automatically to the new master when 
switching masters. In this case, all user archive calls deliver the LastError 
UA_ERROR_SERVER_UNKNOWN = 1004. As a result, user programs must run a new 
uaQueryArchive() or uaQueryArchiveByName() and uaArchiveOpen(). 

uaQueryArchiveByName 

Description:  
Establishes a connection to a recipe for Runtime operation using the recipe name. 
UaQueryArchiveByName creates the UAHARCHIVE handle for the recipe.
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Can only be used in C scripting.

Syntax
BOOL uaQueryArchiveByName (
UAHCONNECT hConnect,
 LPCSTR pszName,
 UAHARCHIVE* phArchive )

Parameters:
UAHCONNECT hConnect
Handle of the connected recipe (Runtime). This handle is generated with "uaConnect".

LPCSTR pszName
Name of the recipe. With a client project, you can add a server prefix with ‘::‘ to the recipe 
name as a separator, if a server other than the default server is used. 

UAHARCHIVE* phArchive
Pointer to handle of the recipe

Return value:
TRUE: Successful generation of the handle to the recipe.

FALSE: Error

Comment:
If you use User Archives functions in a client project that works with redundant server pairs, 
the user archives connection cannot be switched automatically to the new master when 
switching masters. In this case, all user archive calls deliver the LastError 
UA_ERROR_SERVER_UNKNOWN = 1004. As a result, user programs must run a new 
uaQueryArchive() or uaQueryArchiveByName() and uaArchiveOpen(). 

UaQueryConfiguration

Description:  
Establishes a connection to the recipe for the configuration.

Can only be used in C scripting.

Syntax
BOOL uaQueryConfiguration ( 
UAHCONFIG* phConfig )
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Parameters:
UAHCONFIG* phConfig,
Pointer to handle of the recipe. 

Return value
TRUE: Successful access to recipe

FALSE: Error

See also
uaAddArchive (Page 1919)

uaReleaseArchive

Description:  
Releases the connection to the current recipe.

Can only be used in C scripting.

Syntax
BOOL uaReleaseArchive (
 UAHARCHIVE hArchive )

Parameters:
UAHARCHIVE hArchive
Handle of the recipe. This handle is generated with "uaQueryArchive" or 
"uaQueryArchiveByName". 

Return value:
TRUE: Successful release of connection to the recipe.

FALSE: Error

Comment
The handle "hArchive" must be set to "ZERO" with successful disengagement, so that the error 
"UA_ERROR_INVALID_HANDLE" will certainly appear if the no longer valid handle is 
continuously used, without the respective function starving in the COM interfaces for a long 
time.
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uaReleaseConfiguration 

Description:  
Releases connection to recipes (configuration).

Can only be used in C scripting.

Syntax
BOOL uaReleaseConfiguration ( 
UAHCONFIG hConfig,
BOOL bSave )

Parameters:
UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

BOOL bSave
Saves changes made to the configuration before releasing the connection to recipes for the 
configuration. 

TRUE = Save Changes, FALSE = Discard Changes

Warning: Save changes (bSave = TRUE) may only be used when Runtime 
is not active! You can check whether Runtime is active by requesting uaIsActive().

Return value
TRUE: Successful connection release

FALSE: Error

uaRemoveAllArchives 

Description:  
Deletes all recipes that are not used in views.

Can only be used in C scripting.

Syntax
BOOL uaRemoveAllArchives
( UAHCONFIG hConfig )
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Parameters:
UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

Return value
TRUE: Successful deletion

FALSE: Error

Comment
After that, you can use "uaGetNumArchives()" to determine whether all recipes were deleted.

uaRemoveAllFields

Description:  
Removes all fields.

Can only be used in C scripting.

Syntax
BOOL uaRemoveAllFields ( 
UAHCONFIG hConfig,
long lArchive )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

Return value:
TRUE: Successful deletion of fields

FALSE: Error
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uaRemoveArchive

Description:  
uaRemoveArchive deletes the entire configured recipe.

Can only be used in C scripting.

Syntax
BOOL uaRemoveArchive ( 
UAHCONFIG hConfig,
long lArchive )

Parameters:
UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

Return value
TRUE: Successful deletion of the recipe.

FALSE: Error

uaRemoveField

Description:  
Removes a field.

Can only be used in C scripting.

Syntax
BOOL uaRemoveField ( 
UAHCONFIG hConfig,
long lArchive,
long lField )

Parameters:
UAHCONFIG hConfig,
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Configuration handle for the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

long lField,
The field number; if lField = 0 the first field is addressed.

Return value:
TRUE: Successful deletion of field

FALSE: Error

uaSetArchive

Description:  
Sets the configuration of a recipe.

Can only be used in C scripting.

Syntax
BOOL uaSetArchive ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGARCHIVE* pArchive
 )

Parameters:
UAHCONFIG hConfig,
Configuration handle for the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

UACONFIGARCHIVE* pArchive
Pointer to pArchive buffer with the recipe configuration.

Return value:
TRUE: Successful access to recipe.

FALSE: Error
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uaSetField

Description:  
Sets the field configuration.

Can only be used in C scripting.

Syntax
BOOL uaSetField ( 
UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameters:
UAHCONFIG hConfig,
Configuration handle for the recipe. This handle is generated with "uaQueryConfiguration".

long lArchive,
Log index (0 to (uaGetNumArchives()-1))

long lField,
The field number; if lField = 0 the first field is addressed.

UACONFIGFIELD* pField
Pointer to buffer of the field configuration.

Return value:
TRUE : Successful access to recipe.

FALSE : Error

c_bib

ctype functions

Function overview
The following ctype functions are available:

● long int isalnum (long int x);

● long int isalpha (long int x);

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
System Manual, 08/2011,  1959



● long int isdigit (long int x);

● long int isgraph (long int x);

● long int islower (long int x);

● long int isprint (long int x);

● long int ispunct (long int x);

● long int isspace (long int x);

● long int isupper (long int x);

● long int isxdigit (long int x);

● long int tolower (long int x);

● long int toupper (long int x);

For a description of the ctype functions see the specialist literature on programming language 
C. 

The functions can be used in C scripts only.

 

Function group c_bib

Introduction
The c_bib function group contains C functions from the C library and is divided into: 

● ctype

● math

● memory

● stdio

● stdlib

● string

● time

stdio itself is again divided into:

● char_io

● directio

● error

● file

● file_pos

● output

For a description of these functions see the relevant specialist literature.
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Specific features of WinCC functions
The localtime function behaves as follows when the date is issued:

● The counting of the months begins with 0.

● The years are counted as of 1990, starting with 0.

Only 360 characters of the functions of the C library printf(), sprintf(), fprintf() can be edited in 
WinCC. 

math functions 

Function overview
The following math functions are available:

● double acos (double x);

● double asin (double x);

● double atan (double x);

● double atan2 (double x, double y);

● double ceil (double x);

● double cos (double x);

● double cosh (double x);

● double exp (double x);

● double fabs (double x);

● double floor (double x);

● double fmod (double x, double y);

● double frexp (double x, long int* y);

● double ldexp (double x, long int y);

● double log (double x);

● double log10 (double x);

● double modf (double x, double* y);

● double pow (double x, double y);

● double sin (double x);

● double sinh (double x);

● double sqrt (double x);

● double tan (double x);

● double tanh (double x);

For a description of the math functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.
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memory functions

Function overview
The following memory functions are available:

● long int memcmp (const void* cs, const void* ct, size_t n);

● void* memchr (const void* cs, long int c, size_t n);

● void* memcpy (void* s, const void* ct, size_t n);

● void* memmove (void* s, const void* ct, size_t n);

● void* memset (void* s, long int c, size_t n);

For a description of the memory functions see the specialist literature on programming 
language C.

The functions can be used in C scripts only.

multibyte functions

Function overview
The following multibyte functions are available:

● int _ismbcalnum( unsigned int c )

● int _ismbcalpha( unsigned int c )

● int _ismbcdigit( unsigned int c )

● int _ismbcgraph( unsigned int c )

● int _ismbclower( unsigned int c )

● int _ismbcprint( unsigned int c )

● int _ismbcpunct( unsigned int c )

● int _ismbcspace( unsigned int c )

● int _ismbcupper( unsigned int c )

● int _mbscmp(const unsigned char *string1, const unsigned char *string2 )

● int _mbsncmp( const unsigned char *string1, const unsigned char *string2, size_t count )

● int _mbsrchr( const unsigned char *string, unsigned int c )

● size_t _mbscspn( const unsigned char *string, const unsigned char *strCharSet )

● size_t _mbsspn( const unsigned char *string, const unsigned char *strCharSet )

● size_t _mbstrlen( const char *string )

● size_t _mbslen( const unsigned char *string )
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● unsigned char *_mbscat( unsigned char *strDestination, const unsigned char *strSource)

● unsigned char *_mbschr( const unsigned char *string, unsigned int c )

● unsigned char *_mbscpy( unsigned char *strDestination, const unsigned char *strSource )

● unsigned char *_mbsdec( const unsigned char *start, const unsigned char *current )

● unsigned char *_mbsinc( const unsigned char *current ) size_t _mbclen( const unsigned 
char *c );

● unsigned char *_mbsncat( unsigned char *strDest, const unsigned char *strSource, size_t 
count)

● unsigned char *_mbsncpy( unsigned char *strDest, const unsigned char *strSource, size_t 
count)

● unsigned char *_mbspbrk( const unsigned char*string, const unsigned char *strCharSet )

● unsigned char *_mbsstr( const unsigned char *string, const unsigned char *strCharSet )

● unsigned char *_mbstok( unsigned char*strToken, const unsigned char *strDelimit )

A description of the multibyte functions can be found in the specialist literature on programming 
language C.

The functions can be used in C scripts only.

stdio functions

Function overview
The following stdio functions are available:

● char* fgets (char* s, long int n, FILE* stream);

● char* tmpnam (char* s);

● FILE* fopen (const char* name, const char* mode);

● FILE* freopen (const char* filename, const char* mode, FILE* stream);

● FILE* tmpfile ();

● fprintf();

● long int fclose (FILE* stream);

● long int feof (FILE* stream);

● long int ferror (FILE* stream);

● long int fflush (FILE* stream);

● long int fgetc (FILE* stream);

● long int fgetpos (FILE* stream, fpos_t* ptr);

● long int fputc (long int c, FILE* stream);

● long int fputs (const char* s, FILE* stream);

● long int fseek (FILE* stream, long int offset, long int origin);
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● long int fsetpos (FILE* stream, const fpos_t* ptr);

● long int ftell (FILE* stream);

● long int getc (FILE* stream);

● long int putc (long int c, FILE* stream);

● long int remove (const char* filename);

● long int rename (const char* oldname, const char* newname);

● long int setvbuf (FILE* stream, char* buf, long int mode, size_t size);

● long int ungetc (long int c, FILE* stream);

● long int vfprintf (FILE* stream, const char* format, va_list arg);

● long int vsprintf (char* s, const char* format, va_list arg);

● printf();

● size_t fread (void* ptr, size_t size, size_t nobj, FILE* stream);

● size_t fwrite (void* ptr, size_t size, size_t nobj, FILE* stream);

● void clearerr (FILE* stream);

● void rewind (FILE* stream);

● void setbuf (FILE* stream, char* buf);

For a description of the studio functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

stdlib functions

Function overview
The following stdlib functions are available:

● char* getenv (const char* name);

● div_t div (long int num, long int denom);

● double atof (const char* s);

● double strtod (const char* s, char** endp);

● ldiv_t ldiv (long int num, long int denom);

● long int abs (long int n);

● long int atoi (const char* s);

● long int atol (const char* s);

● long int labs (long int n);

● long int rand ();

● long int srand (unsigned long int seed);
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● long int strtol (const char* s, char** endp, long int base);

● long int system (const char* s);

● unsigned long int strtoul (const char* s, char** endp, long int base);

● void abort ();

● void* bsearch (const void* key, const void* base, size_t n, size_t size, long int(* cmp) (const 

● void* calloc (size_t nobj, size_t size);

● void exit (long int status);

● void free (void* p);

● void* keyval, const void* datum));

● void* malloc (size_t size);

● void qsort (void* base, size_t n, size_t size, long int* cmp, const void* , const void* );

● void* realloc (void* p, size_t size);

For a description of the stdlib functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

string functions

Function overview
The following string functions are available:

● char* strcat (char* s, const char* ct);

● char* strchr (const char* cs, long int c);

● char* strcpy (char* s, const char* ct);

● char* strerror (size_t n);

● char* strncat (char* s, const char* ct, size_t n);

● char* strncpy (char* s, const char* ct, size_t n);

● char* strpbrk (const char* cs, const char* ct);

● char* strrchr (const char* cs, long int c);

● char* strstr (const char* cs, const char* ct);

● char* strtok (char* s, const char* ct);

● long int strcmp (const char* cs, const char* ct);

● long int strncmp (const char* cs, const char* ct, size_t n);

● size_t strcspn (const char* cs, const char* ct);

● size_t strlen (const char* cs);

● size_t strspn (const char* cs, const char* ct);
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For a description of the string functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

time functions 

Function overview
The following time functions are available:

● char* asctime (const struct tm* tp);

● char* ctime (const time_t* tp);

● clock_t clock ();

● double difftime (time_t time2, time_t time1);

● size_t strftime (char* s, size_t smax, const char* fmt, const struct tm* tp);

● struct tm* gmtime (const time_t* tp);

● struct tm* localtime (const time_t* tp);

● time_t mktime (struct tm* tp);

● time_t time (time_t* tp);

For a description of the time functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

Structure definitions

Structure definition CCAPErrorExecute

 
typedef struct {
DWORD dwCurrentThreadID; Thread ID of the current thread
DWORD dwErrorCode1;      Error code 1
DWORD dwErrorCode2;      Error code 2
BOOL bCycle;             cycle/acycle
char* szApplicationName; Name of the application
char* szFunctionName;    Name of the function
char* szTagName;         Name of the tag
LPVOID lpParam;          Pointer to the action stack
DWORD dwParamSize;       Size of the action stack
DWORD dwCycle;           Cycle of the tag
CMN_ERROR* pError;       Pointer to CMN_ERROR
} CCAPErrorExecute;
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Members
The meaning of the individual error IDs and the structure elements depending on them are 
specified in the following table:

100700
1

0 x x x  x x   Action requires exception

100700
1

1 x x x  x x   Exception when 
accessing the return 
result

100700
1

4097 x x x  x x   Stack overflow while 
executing the action

100700
1

4098 x x x  x x   The action contains a 
division by 0

100700
1

4099 x x x  x x   The action contains an 
access to a non-existing 
symbol

100700
1

4100 x x x  x x   The action contains an 
access violation

100700
4

0 x x x      Function is not known

100700
5

1 x x       Action does not include a 
P code.

100700
5

2 x x       Incorrect function name

100700
5

4 x x x  x x   Return value type is 
invalid

100700
5

32768f
f

x x x  x x   Ciss Compiler error when 
loading the action

100700
6

0 x x x x x x x  Tag is not defined

100700
6

1 x x x x x x x  Tag timeout

100700
6

2 x x x x x x x x Tag cannot be returned in 
the desired format

100700
6

3 x x x x x x x x Tag returns status 
violation, status present 
in 
CMN_ERROR.dwError1 

100700
7

1 x x x  x x  x Error with 
PDLRTGetProp

100700
7

2 x x x  x x  x Error with PDLRTSetProp

100700
7

3 x x x  x x  x Error with DM call
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Error structure
The OnErrorExecute function uses the error structure to evaluate or to output error messages, 
if marked by an "x" in the pError column.

Structure definition CCAPTime

 
typedef struct {
DWORD dwCurrentThreadID; ThreadID of the current Thread
DWORD dwCode;            Code
BOOL bCycle;             cycle/acycle
char* szApplicationName; Name of the Application
char* szFunctionName;    Name of the Function
LPVOID lpParam;          Pointer to the Action-Stack
DWORD dwParamSize;       size of the Action-Stack
double dblTime;
DWORD dwFlags;           flags
} CCAPTime;

 

 

Members

dwCode
The structure element dwCode provides information on calling of OnTime:

dwCode = 113 Call with time definition for each action
dwCode = 114 Call with time monitoring for each action

 

dwFlags
The structure element dwFlags provides information on the output type:

dwFlags = TRUE The results are output to a file
dwFlags = FALSE The results are output to the diagnostics window

Structure definition CMN_ERROR

 
struct CMNERRORSTRUCT {
DWORD       dwError1,
DWORD       dwError2,
DWORD       dwError3,
DWORD       dwError4,
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DWORD       dwError5;
TCHAR       szErrorText[MAX_ERROR_LEN];
}
CMN_ERROR

Description
The extended error structure contains the error code and an error text for the error that has 
occurred. Each application can use the error structure to evaluate or to output error messages.

 

Members

dwError1 .. dwError5
These entries can be used in any way by the API functions.

The API descriptions inform about the values the respective entries contain in case of an error. 
If not specified otherwise, the error codes are present in dwError1.

szErrorText
Buffer for the text description of the error cause

The content is determined from the resources and therefore language-dependent. 

Structure definition DM_TYPEREF

 
typedef struct {
DWORD dwType;
DWORD dwSize;
char szTypeName[MAX_DM_TYPE_NAME + 1];
}
DM_TYPEREF;

Members

dwType
Specifies the tag type

dwType PLC data type HMI data type
DM_VARTYPE_BIT Binary tag Bool
DM_VARTYPE_SBYTE Signed 8-bit value Byte
DM_VARTYPE_BYTE Unsigned 8-bit value UByte
DM_VARTYPE_SWORD Signed 16-bit value Short
DM_VARTYPE_WORD Unsigned 16-bit value UShort
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dwType PLC data type HMI data type
DM_VARTYPE_SDWORD Signed 32-bit value Integer
DM_VARTYPE_DWORD Unsigned 32-bit value UInteger
DM_VARTYPE_FLOAT Floating-point number 32-bit IEEE 754 Float
DM_VARTYPE_DOUBLE Floating-point number 64-bit IEEE 754 Double
DM_VARTYPE_TEXT_8 Text tag, 8-bit character set Char
DM_VARTYPE_TEXT_16 Text tag, 16-bit character set String
DM_VARTYPE_RAW Raw data type Raw
DM_VARTYPE_STRUCT Structure tag Struct
DM_VARTYPE_TEXTREF Text reference tag String

 

dwSize
Specifies the length of the data type in bytes.

szTypeName
In the case of structure tags, contains the name of the structure type

Structure definition DM_VAR_UPDATE_STRUCT

 
typedef struct {
DM_TYPEREF dmTypeRef;
DM_VARKEY dmVarKey;
VARIANT dmValue;
DWORD dwState;
}
DM_VAR_UPDATE_STRUCT;

Members

dmTypeRef
Contains information on the data type. For performance reasons, nothing is entered into this 
structure in case of cyclic requests.

dmVarKey
Specifies the tags to be edited.

dmValue
Tag value

Upon access to the value of the VARIANT a ".u." has to be inserted between the name of the 
VARIANT and the name of the member.

 
Example
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// Supply variant
myVariant.vt = VT_I4;
myVariant.u.lVal = 233;
A description of the data type VARIANT can be found in the associated documentation. The 
VARIANT dmValue must be initialized with VariantInit() before first use and enabled again with 
VariantClear(&dmValue) after use. For this reason, the structure 
DM_VAR_UPDATE_STRUCT must not be deleted with ZeroMemory() or memset().

dwState
Identifies the tag status.

Structure definition DM_VAR_UPDATE_STRUCTEX

 
typedef struct {
DM_TYPEREF dmTypeRef;
DM_VARKEY dmVarKey;
VARIANT dmValue;
DWORD dwState;
DWORD dwQualityCode;
}
DM_VAR_UPDATE_STRUCTEX;

Members

dmTypeRef
Contains information on the data type. For performance reasons, nothing is entered into this 
structure in case of cyclic requests.

dmVarKey
Specifies the tags to be edited.

dmValue
Tag value

Upon access to the value of the VARIANT a ".u." has to be inserted between the name of the 
VARIANT and the name of the member.

 
Example
// Supply variant
myVariant.vt = VT_I4;
myVariant.u.lVal = 233;
A description of the data type VARIANT can be found in the associated documentation. The 
VARIANT dmValue must be initialized with VariantInit() before first use and enabled again with 
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VariantClear(&dmValue) after use. For this reason, the structure 
DM_VAR_UPDATE_STRUCTEX must not be deleted with ZeroMemory() or memset().

dwState
Identifies the tag status.

dwQualityCode
Identifies the QualityCode tag.

Structure definition DM_VARKEY 

 
typedef struct {
DWORD dwKeyType;
DWORD dwID;
char szName[ MAX_DM_VAR_NAME + 1 ];
LPVOID lpvUserData;
}
DM_VARKEY;

Members

dwKeyType
Defines whether the tag is to be addressed by a key ID or by its name.

DM_VARKEY_ID Specification via key ID

DM_VARKEY_NAME Specification via tag name

dwID
Contains the key ID of the tags if dwKey type is set accordingly.

szName
Contains the name of the tag if dwKey type is set accordingly.

lpvUserData
Pointer to application-specific data 

Structure definition LINKINFO

 
typedef struct {
LINKTYPE LinkType;
DWORD dwCycle;
TCHAR szLinkName[256];
}
LINKINFO;
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Members

LinkType
LinkType are enumeration constants defined in the "Trigger.h" file. They are to be integrated 
into your script with the "#include "Trigger.h" command and the corresponding enumeration 
constants.

BUBRT_LT_NOLINK 0 no shortcut
BUBRT_LT_VARIABLE_DIRECT 1 direct tag
BUBRT_LT_VARIABLE_INDIRECT 2 indirect tag
BUBRT_LT_ACTION 3 C action
BUBRT_LT_ACTION_WIZARD 4 Dynamic Dialog
BUB_LT_DIRECT_CONNECTION 5 Direct connection
BUBRT_LT_ACTION_WIZARD_INPROC 6 Dynamic Dialog

For the SetLink function, only the enumeration constants BUBRT_LT_VARIABLE_DIREKT 
and BUBRT_LT_VARIABLE_INDIRECT  may be used. The GetLink function allows to return 
all listed enumeration constants.

dwCycle
Update cycle time

255 Picture cycle
235 Window Cycle
0 Upon change
1 250ms
2 500 ms
3 1 s
4 2 s
5 5s
6 10s
7 1min
8 5min
9 10min
10 1h
11-1
5

User cycle 1-5

szLinkName
Tag name
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Structure definition MSG_FILTER_STRUCT

 
typedef struct {
CHAR        szFilterName[MSG_MAX_TEXTLEN+1];
WORD        dwFilter;
SYSTEMTIME  st[2];
DWORD       dwMsgNr[2];
DWORD       dwMsgClass;
DWORD       dwMsgType[MSG_MAX_CLASS];
DWORD                dwMsgState;
WORD        wAGNr[2];
WORD        wAGSubNr[2];
DWORD       dwArchivMode;
char        szTB[MSG_MAX_TB][
MSG_MAX_TB_CONTENT+1]
DWORD       dwTB;
Double      dPValue[MSG_MAX_PVALUE][2];
DWORD       dwPValue[2];
DWORD       dwMsgCounter[2];
DWORD       dwQuickSelect;
}
MSG_FILTER_STRUCT;

Description
In this structure the criteria are specified.

Members

dwFilter
The filter conditions are defined by means of the following constants from the file "m_global.h":

MSG_FILTER_DATE_FROM Date from
MSG_FILTER_DATE_TO Date to
MSG_FILTER_TIME_FROM Time from
MSG_FILTER_TIME_TO Time to
MSG_FILTER_NR_FROM Message number from
MSG_FILTER_NR_TO Message number to
MSG_FILTER_CLASS Message classes
MSG_FILTER_STATE Message status
MSG_FILTER_AG_FROM AS number from
MSG_FILTER_AG_TO AS number to
MSG_FILTER_AGSUB_FROM AG subnumber from
MSG_FILTER_AGSUB_TO AG subnumber to
MSG_FILTER_TEXT Message texts
MSG_FILTER_PVALUE Process values
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MSG_FILTER_COUNTER_FROM Internal message counter from
MSG_FILTER_COUNTER_TO Internal message counter to
MSG_FILTER_PROCESSMSG Process messages
MSG_FILTER_SYSMSG System messages
MSG_FILTER_BEDMSG Operator messages
MSG_FILTER_DATE Date from to
MSG_FILTER_TIME Time from to
MSG_FILTER_NR Message number from to
MSG_FILTER_VISIBLEONLY Display visible messages
MSG_FILTER_HIDDENONLY Display hidden messages

st
Date/time from - to

Where st[0]  is the start time (from), st[1]  the end time (to)

Assign these fields for the criteria: MSG_FILTER_DATE, MSG_FILTER_DATE_FROM, 
MSG_FILTER_DATE_TO, MSG_FILTER_TIME, MSG_FILTER_TIME_FROM, bzw. 
MSG_FILTER_TIME_TO

If the current time is needed to pass a SYSTEMTIME- parameter, use the GetLocalTime 
function and not GetSystemTime.. There is usually a considerable difference between these 
two functions.

dwMsgNr
Message number from - to

Where dwMsgNr[0]  is start no. (from), dwMsgNr[1] the end no. (to)

Assign these fields for the criteria: MSG_FILTER_NR, MSG_FILTER_NR_FROM bzw. 
MSG_FILTER_NR_TO

dwMsgClass
Message classes bit-coded.

Assign this field for the criterion: MSG_FILTER_CLASS

dwMsgType
Message type per alarm class, bit-coded

Assign this field for the criterion: MSG_FILTER_CLASS

dwMsgState
Message status bit-coded.

Assign this field for the criterion: MSG_FILTER_STATE

wAGNr
AGNr from - to
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Assign these fields for the criteria: MSG_FILTER_AG_FROM or MSG_FILTER_AG_TO

wAGSubNr
AGSubNr from - to

Assign this field for the criteria: MSG_FILTER_AGSUB_FROM or MSG_FILTER_AGSUB_TO

dwArchivMode
Logging / reporting

Must be assigned 0.

szTB
Texts of the text blocks

Assign these fields for the criterion: MSG_FILTER_TEXT

dwTB
Active text blocks (from - to, bit-coded)

Assign this field for the criterion: MSG_FILTER_TEXT

dPValue
Process values from - to

Assign these fields for the criterion: MSG_FILTER_PVALUE

dwPValue
Active process values (from - to, bit-coded)

Assign this field for the criterion: MSG_FILTER_PVALUE

dwMsgCounter
Internal message counter from - to

Assign these fields for the criteria: MSG_FILTER_COUNTER_FROM, 
MSG_FILTER_COUNTER_TO

dwQuickSelect
Quick selection for hour, day, month

The parameter is reserved for future upgrades and must be preset to 0.

Assign this field for the criterion: MSG_FILTER_QUICKSELECT

LOWORD Type:

MSG_FILTER_QUICK_MONTH Quick selection last n months
MSG_FILTER_QUICK_DAYS Quick selection last n days
MSG_FILTER_QUICK_HOUR Quick selection last n hours

HIWORD Number: 1...n
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The end time of the quick selection refers to the current system time of the local computer. 
The start time is calculated back n * ( months, days, hours ). 

Structure definition MSG_RTDATA_STRUCT

 
typedef struct {
DWORD                dwMsgState;
DWORD                dwMsgNr;
SYSTEMTIME           stMsgTime;
DWORD                dwTimeDiff;
DWORD                dwCounter;
DWORD                dwFlags;
WORD                 wPValueUsed;
WORD                 wTextValueUsed;
double               dPValue[MSG_MAX_PVALUE];
MSG_TEXTVAL_STRUCT   mtTextValue[MSG_MAX_PVALUE];
}
MSG_RTDATA_STRUCT;

Members
dwMsgState

Message status

MSG_STATE_COME 0x00000001 Message came in
MSG_STATE_GO 0x00000002 Message went out
MSG_STATE_QUIT 0x00000003 Message acknowledged
MSG_STATE_LOCK 0x00000004 Message locked
MSG_STATE_UNLOCK 0x00000005 Alarm locked
MSG_STATE_QUIT_SYSTEM 0x00000010 Message acknowledged by system
MSG_STATE_QUIT_EMERGENCY 0x00000011 Emergency acknowledgement
MSG_STATE_QUIT_HORN 0x00000012 Alarm alert acknowledgment
MSG_STATE_COMEGO 0x00000013 Message came in and went out, only displayed in the "Current 

messages" display
MSG_STATE_UPDATE 0x00010000 Bit for message update
MSG_STATE_RESET 0x00020000 Bit for message reset
MSG_STATE_SUMTIME 0x00040000 Bit active for daylight savings time
MSG_STATE_INSTANCE 0x00080000 Bit for instance message (n messages of a no.)

dwMsgNr

Message number

stMsgTime

Date/Time: Telegram time depending on the calling function
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dwTimeDiff
Duration coming/Telegram time in seconds

dwCounter

Internal message counter

dwFlags

Message flags in the database

MSG_FLAG_SUMTIME 0x00000001 Daylight savings time active
MSG_FLAG_COMMENT 0x00000002 Message has comments
MSG_FLAG_ARCHIV 0x00000004 Archiving
MSG_FLAG_PROTOCOL 0x00000008 Logging
MSG_FLAG_TEXTVALUES 0x00000010 Message has values accompanying the text
MSG_FLAG_TIMEINVALID 0x00000020 Bit for invalid date/time stamp
MSG_FLAG_INSTANCE 0x00000040 Instance message identification (185269)

wPValueUsed

Process values used, bit-coded. Every bit may only be set in one of the two structure elements 
"wPValueUsed" or  "wTextValueUsed". An accompanying value may either be a number or a 
text.

wTextValueUsed

text values used, bit-coded. Every bit may only be set in one of the two structure elements 
"wPValueUsed" or  "wTextValueUsed". An accompanying value may either be a number or a 
text.

9.8.3.2 Events

Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
Logs
Scheduler
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Play ended (Page 1989) -- -- -- --
Activate (Page 1989) √ -- -- --
Adjust (Page 1990) -- -- -- --
Loaded (Page 1990) √ -- -- --
Execute (Page 1990) -- -- -- √
Selection changed (Page 1990) -- -- -- --
Double-click (Page 1991) -- -- -- --
Press (Page 1991) -- -- -- --
Operator input alarm property changed (Page 1991) -- -- -- --
Block property changed (Page 1992) -- -- -- --
Property diagram changed (Page 1992) -- -- -- --
Property changed (Page 1992) -- -- -- --
Trend property changed (Page 1993) -- -- -- --
Column property changed (Page 1993) -- -- -- --
Alarm statistics column property changed (Page 1993) -- -- -- --
Statistics area column name property changed (Page 1994) -- -- -- --
Change property status bar element (Page 1994) -- -- -- --
Change property toolbar button (Page 1994) -- -- -- --
Change property value axis (Page 1995) -- -- -- --
Change property value column (Page 1995) -- -- -- --
X-axis property changed (Page 1995) -- -- -- --
Y-axis property changed (Page 1996) -- -- -- --
Change property time axis (Page 1996) -- -- -- --
Change property time column (Page 1996) -- -- -- --
Outgoing (Page 1997) -- √ -- --
Incoming (Page 1997) -- √ -- --
In the alarm range (Page 1997) -- -- -- --
In the tolerance range (Page 1998) -- -- -- --
In the warning range (Page 1998) -- -- -- --
Click (Page 1998) √ -- -- --
Shortcut menu (Page 1999) -- -- -- --
Volume (Page 1999) -- -- -- --
Change layout (Page 1999) -- -- -- --
Change ruler (Page 2000) -- -- -- --
Press left mouse button (Page 2000) √ -- -- --
Release left mouse button (Page 2000) √ -- -- --
Loop-in alarm (Page 2001) -- √ -- --
Release (Page 2001) -- -- -- --
Move mouse (Page 2001) -- -- -- --
Medium opened (Page 2002) -- -- -- --
Medium closed (Page 2002) -- -- -- --
Object changed (Page 2002) √ -- -- --
Pause (Page 2003) -- -- -- --
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Acknowledge (Page 2003) √ √ -- --
Press right mouse button (Page 2003) √ -- -- --
Release right mouse button (Page 2004) √ -- -- --
Runtime Stop (Page 2004) -- -- -- --
Click toolbar button (Page 2004) -- -- -- --
Change slider (Page 2005) -- -- -- --
StepForward (Page 2005) -- -- -- --
StepBack (Page 2005) -- -- -- --
Lock changed (Page 2006) -- -- √ --
Status changed (Page 2006) -- √ -- --
Stop (Page 2006) -- -- -- --
Switch toolbar (Page 2007) -- -- -- --
Press key on keyboard (Page 2007) √ -- -- --
Release key on keyboard (Page 2007) √ -- -- --
Change video format (Page 2008) -- -- -- --
Full screen (Page 2008) -- -- -- --
Exit full screen (Page 2008) -- -- -- --
Replay (Page 2009) -- -- -- --

Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Polyline
Polygon
Ellipse
Ellipse segment
Circle segment
Ellipse arc
Circular arc
Circle
Rectangle
Connector
Text field
Graphic view
Pipe
Double T-piece
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Icon Object
T piece
Pipe bends

 

 
Play ended 
(Page 1989)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Activate (Page 1989) √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √
Adjust (Page 1990) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Loaded (Page 1990) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Execute (Page 1990) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Selection changed 
(Page 1990)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Double-click 
(Page 1991)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press (Page 1991) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Operator input alarm 
property changed 
(Page 1991)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Block property changed 
(Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Property diagram 
changed (Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Property changed 
(Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Trend property 
changed (Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Column property 
changed (Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Alarm statistics column 
property changed 
(Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Statistics area column 
name property 
changed (Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property status 
bar element 
(Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property 
toolbar button 
(Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property value 
axis (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property value 
column (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

X-axis property 
changed (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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Y-axis property 
changed (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property time 
axis (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property time 
column (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Outgoing (Page 1997) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Incoming (Page 1997) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
In the alarm range 
(Page 1997)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

In the tolerance range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

In the warning range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Click (Page 1998) √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √
Shortcut menu 
(Page 1999)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Volume (Page 1999) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Change layout 
(Page 1999)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change ruler 
(Page 2000)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press left mouse button 
(Page 2000)

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Release left mouse 
button (Page 2000)

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Loop-in alarm 
(Page 2001)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Release (Page 2001) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Move mouse 
(Page 2001)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Medium opened 
(Page 2002)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Medium closed 
(Page 2002)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Object changed 
(Page 2002)

√ √
 

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Pause (Page 2003) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Acknowledge 
(Page 2003)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press right mouse 
button (Page 2003)

√ √
 

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Release right mouse 
button (Page 2004)

√ √
 

√ √ √ √
 

√ √ √ √ √ √ √ √ √ √ √

Runtime Stop 
(Page 2004)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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Click toolbar button 
(Page 2004)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change slider 
(Page 2005)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

StepForward 
(Page 2005)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

StepBack (Page 2005) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Lock changed 
(Page 2006)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Status changed 
(Page 2006)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Stop (Page 2006) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Switch toolbar 
(Page 2007)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press key on keyboard 
(Page 2007)

√ √
 

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Release key on 
keyboard (Page 2007)

√ √
 

√ √ √ √ √ √ √ √ √ √ √ √ √ √ √

Full screen 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Exit full screen 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change video format 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Replay (Page 2009) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which elements.

Technical data subject to change.

Icon Object
IO field
Editable text field
List box
Combo box
Button
Round button
Symbolic IO field
Graphic IO field
Bar
Symbol library 
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Icon Object
Slider
Scroll bar
Check box
Option button
Gauge
Clock
Disk space view

 

 
Play ended 
(Page 1989)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Activate (Page 1989) √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √ √
Adjust (Page 1990) -- -- -- -- -- -- -- -- -- -- √ -- -- -- √ -- --
Loaded (Page 1990) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Execute (Page 1990) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Selection changed 
(Page 1990)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Double-click 
(Page 1991)

-- -- -- -- -- -- -- -- -- √ -- -- -- -- -- -- --

Press (Page 1991) -- -- -- -- -- -- -- -- -- √ -- -- -- -- -- -- --
Operator input alarm 
property changed 
(Page 1991)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Block property 
changed (Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Property diagram 
changed (Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Property changed 
(Page 1992)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Trend property 
changed (Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Column property 
changed (Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Alarm statistics column 
property changed 
(Page 1993)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Statistics area column 
name property 
changed (Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property 
status bar element 
(Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property 
toolbar button 
(Page 1994)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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Change property value 
axis (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property value 
column (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

X-axis property 
changed (Page 1995)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Y-axis property 
changed (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property time 
axis (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change property time 
column (Page 1996)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Outgoing (Page 1997) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Incoming (Page 1997) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
In the alarm range 
(Page 1997)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- √

In the tolerance range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- √

In the warning range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- √

Click (Page 1998) √ √ √ √ √ √ √ √ √ √ -- √ √ √ -- -- --
Shortcut menu 
(Page 1999)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Volume (Page 1999) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Change layout 
(Page 1999)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change ruler 
(Page 2000)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press left mouse 
button (Page 2000)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Release left mouse 
button (Page 2000)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Loop-in alarm 
(Page 2001)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Release (Page 2001) -- -- -- -- -- -- -- -- -- √ -- -- -- -- -- -- --
Move mouse 
(Page 2001)

-- -- -- -- -- -- -- -- -- √ -- -- -- -- -- -- --

Medium opened 
(Page 2002)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Medium closed 
(Page 2002)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Object changed 
(Page 2002)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Pause (Page 2003) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Acknowledge 
(Page 2003)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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Press right mouse 
button (Page 2003)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Release right mouse 
button (Page 2004)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Runtime Stop 
(Page 2004)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Click toolbar button 
(Page 2004)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Change slider 
(Page 2005)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

StepForward 
(Page 2005)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

StepBack (Page 2005) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Lock changed 
(Page 2006)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Status changed 
(Page 2006)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Stop (Page 2006) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
Switch toolbar 
(Page 2007)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Press key on keyboard 
(Page 2007)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Release key on 
keyboard (Page 2007)

√ √ √ √ √ √ √ √ √ -- -- √ √ √ -- -- --

Change video format 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Full screen 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Exit full screen 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Replay (Page 2009) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which controls.

Technical data subject to change.

Icon Object
Screen window
User view
HTML browser
Print job/Script diagnostics
Recipe view
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Icon Object
Alarm view
f(x) trend view
f(t) trend view
Table view
Value table
Media Player
Channel diagnostics

 

 
Play ended (Page 1989) -- -- -- -- -- -- -- -- -- -- √ --
Activate (Page 1989) √ √ √ √ √ √ √ √ √ √ √ √
Adjust (Page 1990) -- -- -- -- -- -- -- -- -- -- -- --
Loaded (Page 1990) -- -- -- -- √ √ √ √ √ √ -- --
Execute (Page 1990) -- -- -- -- -- -- -- -- -- -- -- --
Selection changed 
(Page 1990)

-- -- -- -- √ -- -- -- -- -- -- --

Double-click (Page 1991) -- -- -- -- -- -- -- -- -- -- -- --
Press (Page 1991) -- -- -- -- -- -- -- -- -- -- -- --
Operator input alarm property 
changed (Page 1991)

-- -- -- -- -- √ -- -- -- -- -- --

Block property changed 
(Page 1992)

-- -- -- -- -- √ -- -- -- √ -- --

Property diagram changed 
(Page 1992)

-- -- -- -- -- -- √ √ -- -- -- --

Property changed (Page 1992) -- -- -- -- √ √ √ √ √ √ -- --
Trend property changed 
(Page 1993)

-- -- -- -- -- -- √ √ -- -- -- --

Column property changed 
(Page 1993)

-- -- -- -- √ √ -- -- -- √ -- --

Alarm statistics column 
property changed (Page 1993)

-- -- -- -- -- √ -- -- -- -- -- --

Auto-Hotspot -- -- -- -- -- -- -- -- -- √ -- --
Change property status bar 
element (Page 1994)

-- -- -- -- √ √ √ √ √ √ -- --

Change property toolbar 
button (Page 1994)

-- -- -- -- √ √ √ √ √ √ -- --

Change property value axis 
(Page 1995)

-- -- -- -- -- -- -- √ -- -- -- --

Change property value column 
(Page 1995)

-- -- -- -- -- -- -- -- √ -- -- --

X-axis property changed 
(Page 1995)

-- -- -- -- -- -- √ -- -- -- -- --

Y-axis property changed 
(Page 1996)

-- -- -- -- -- -- √ -- -- -- -- --
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Change property time axis 
(Page 1996)

-- -- -- -- -- -- -- √ -- -- -- --

Change property time column 
(Page 1996)

-- -- -- -- -- -- -- -- √ -- -- --

Outgoing (Page 1997) -- -- -- -- -- -- -- -- -- -- -- --
Incoming (Page 1997) -- -- -- -- -- -- -- -- -- -- -- --
In the alarm range 
(Page 1997)

-- -- -- -- -- -- -- -- -- -- -- --

In the tolerance range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- --

In the warning range 
(Page 1998)

-- -- -- -- -- -- -- -- -- -- -- --

Click (Page 1998) -- -- -- -- -- -- -- -- -- -- -- --
Shortcut menu (Page 1999) -- -- -- -- -- -- -- -- -- -- √ --
Volume (Page 1999) -- -- -- -- -- -- -- -- -- -- √ --
Change layout (Page 1999) -- -- -- -- -- -- -- √ -- -- -- --
Change ruler (Page 2000) -- -- -- -- -- -- -- √ -- -- -- --
Press left mouse button 
(Page 2000)

-- -- -- -- -- -- -- -- -- -- -- --

Release left mouse button 
(Page 2000)

-- -- -- -- -- -- -- -- -- -- -- --

Loop-in alarm (Page 2001) -- -- -- -- -- -- -- -- -- -- -- --
Release (Page 2001) -- -- -- -- -- -- -- -- -- -- -- --
Move mouse (Page 2001) -- -- -- -- -- -- -- -- -- -- -- --
Medium opened (Page 2002) -- -- -- -- -- -- -- -- -- -- √ --
Medium closed (Page 2002) -- -- -- -- -- -- -- -- -- -- √ --
Object changed (Page 2002) √ -- -- √ -- -- -- -- -- -- -- --
Pause (Page 2003) -- -- -- -- -- -- -- -- -- -- √ --
Acknowledge (Page 2003) -- -- -- -- -- -- -- -- -- -- -- --
Press right mouse button 
(Page 2003)

-- -- -- -- -- -- -- -- -- -- -- --

Release right mouse button 
(Page 2004)

-- -- -- -- -- -- -- -- -- -- -- --

Runtime Stop (Page 2004) -- -- -- -- -- -- -- -- -- -- -- --
Click toolbar button 
(Page 2004)

-- -- -- -- √ √ √ √ √ √ -- --

Change slider (Page 2005) -- -- -- -- -- -- -- -- -- -- √ --
StepForward (Page 2005) -- -- -- -- -- -- -- -- -- -- √ --
StepBack (Page 2005) -- -- -- -- -- -- -- -- -- -- √ --
Lock changed (Page 2006) -- -- -- -- -- -- -- -- -- -- -- --
Status changed (Page 2006) -- -- -- -- -- -- -- -- -- -- -- --
Stop (Page 2006) -- -- -- -- -- -- -- -- -- -- √ --
Switch toolbar (Page 2007) -- -- -- -- -- -- -- -- -- -- √ --
Press key on keyboard 
(Page 2007)

-- -- -- -- -- -- -- -- -- -- -- --
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Release key on keyboard 
(Page 2007)

-- -- -- -- -- -- -- -- -- -- -- --

Change video format 
(Page 2008)

-- -- -- -- -- -- -- -- -- -- √ --

Full screen (Page 2008) -- -- -- -- -- -- -- -- -- -- √ --
Exit full screen (Page 2008) -- -- -- -- -- -- -- -- -- -- √ --
Replay (Page 2009) -- -- -- -- -- -- -- -- -- -- √ --

See also
Statistics area column name property changed (Page 1994)

Events

Play ended

Description
Occurs when the video or audio file has been played.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Activate

Description
Occurs when the user selects a display or operating object using the configured tab sequence.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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 Note

If the user e.g. clicks a button with the mouse, the "Click" event is triggered. Users wishing 
to trigger the "Enable" event must select the button using the tab key.

 

The "Activate" event is only used to detect whether an object was selected. The event does 
not trigger a password prompt.

For this reason, do not use the "Activate" event if you want to configure access protection on 
the function call of the object.

Adjust

Description
Occurs if the status of a display and operator control object changes. 

The status of an object changes if, for example, the user presses the key. 
 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Loaded

Description
Occurs if a display or operating object is completely loaded in Runtime.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Execute

Description
Occurs when the scheduled task has been executed.   

Selection changed

Description
Occurs when the selection is changed. 
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Double-click

Description
Occurs when the user double-clicks on an object from the symbol library. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Press

Description
Occurs when the user clicks on a button with the left mouse button, presses <RETURN> or 
<SPACE>. 

Also occurs when the user right-clicks on an object of the symbol library.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Operator input alarm property changed

Description
Occurs when the property of an operator input alarm is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Block property changed

Description
Occurs when the property of a block, e.g., alarm text block, is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Property diagram changed

Description
Occurs when the property of a trend diagram is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Property changed

Description
Occurs when a property is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Trend property changed

Description
Occurs when the property of the trend is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Column property changed

Description
Occurs when the property of a column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Alarm statistics column property changed

Description
Occurs when the property of the alarm statistics column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Statistics area column name property changed

Description
Occurs when the column name of the statistics area is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property status bar element

Description
Occurs when the property of a status bar element is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property toolbar button

Description
Occurs when the property of a toolbar button is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Change property value axis

Description
Occurs when the property of the value column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property value column

Description
Occurs when the property of the value column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

X-axis property changed

Description
Occurs when the property of the X-axis is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Y-axis property changed

Description
Occurs when the property of the Y-axis is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property time axis

Description
Occurs when the property of the time axis changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property time column

Description
Occurs when the property of the time column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Visualizing processes (Professional)
9.8 Working with system functions and Runtime scripting

WinCC Professional V11.0 SP1
1996 System Manual, 08/2011,  



Outgoing

Description
Occurs when an alarm is deactivated. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Incoming

Description
Occurs when an alarm is triggered and displayed in the alarm view. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

In the alarm range

Description
Occurs if the available storage space has reached the configured monitoring limit "alarm". You 
configure this event in the display and operating object "storage space display".

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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In the tolerance range

Description
Occurs if the available storage space has reached the configured monitoring limit "tolerance". 
You configure this event in the display and operating object "storage space display".

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

In the warning range

Description
Occurs if the available storage space has reached the configured monitoring limit "warning". 
You configure this event in the display and operating object "storage space display".

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Click

Description
Occurs if the user clicks a display and operating object with the mouse or touches the touch 
display with a finger. 

In case you click the incorrect object, prevent processing of configured function list as follows:

● Move the mouse pointer away from the object while keeping the mouse button pressed. 
Release the mouse button as soon as the mouse pointer leaves the object. The function 
list will then not be processed.

● On touch displays, the display must be touched with the finger until a reaction occurs, e.g., 
a screen change.

 

  Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Shortcut menu

Description
Ocurs when the shortcut menu opens.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Volume

Description
Occurs when the volume changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Change layout

Description
Occurs when a property is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Change ruler

Description
Occurs when a property is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Press left mouse button

Description
Occurs when the operator left-clicks on a display and operating object. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Release left mouse button

Description
Occurs when the user releases the left mouse button after clicking.

This event does not occur as long as the left button remains pressed.

If the operator releases the button after clicking on a button, this event will also occur even if 
the mouse pointer is no longer pointing on the button.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Loop-in alarm

Description
Occurs as soon as the user selects an alarm in the alarm view and then clicks on the "Loop-
In-Alarm" button or double clicks on the alarm.   

For the "Loop-In-Alarm" event, you configure system functions, such as a change to the screen 
in which the alarm occurred.

You cannot configure local scripts for the "Loop-In-Alarm" event in Runtime Professional.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Release

Description
Occurs when the user releases a button. 

This even does not occur, as long as the button remains pressed.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Move mouse

Description
Occurs when the user moves the mouse.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Medium opened

Description
Occurs when the medium is opened.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Medium closed

Description
Occurs when the medium is closed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Object changed

Description
Occurs if the user changes a property of a display and operating object in Runtime. 

 

 Note

Every action triggered by this event is logged on individually and then logged off again when 
the screen is changed. This behavior puts a burden on the working memory. Use this event 
only for important changes to properties, e.g., for an I/O field. 
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 Note

The availability of the event is dependent on the HMI device and object type.
 

 

Pause

Description
Occurs when playing of the video or audio file is paused.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Acknowledge

Description
Occurs when the user acknowledges an alarm. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Press right mouse button

Description
Occurs when the user right-clicks on a display and operating object. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Release right mouse button

Description
Occurs when the user releases the right mouse button after clicking.

This event does not occur as long as the right mouse button remains pressed.

If the operator releases the button after clicking on a button, this event will also occur even if 
the mouse pointer is no longer pointing on the button.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Runtime Stop

Description
Occurs when the user exits the Runtime software on the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

A user-defined function must not be configured for the "Runtime stop" event.
 

 

Click toolbar button

Description
Occurs when the user clicks a button in the toolbar.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Change slider

Description
Occurs when the volume slider changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

StepForward

Description
Occurs when the video or audio file goes to the next sequence.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

StepBack

Description
Occurs when the video or audio file goes to the previous sequence.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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See also
Elements (Page 1983)

Lock changed

Description
Occurs when the write access for the log is changed, e.g., from locked to released.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Status changed

Description
Occurs when the status of an alarm is changed, e.g., from incoming to outgoing.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Stop

Description
Occurs when playing of the video or audio file is stopped.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)
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Switch toolbar

Description
Occurs when the property of the time axis changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Press key on keyboard

Description
Occurs when the user presses a key on the keyboard. 

The keys <F10> and <ALT+PRINT> are not used by the operator for process operations.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Release key on keyboard

Description
Occurs when the user releases a key on the keyboard. 

The keys <F10> and <ALT+PRINT> are not used by the operator for process operations.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Change video format

Description
Occurs when the video format changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Full screen

Description
Occurs when the full screen mode is activated.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

Exit full screen

Description
Occurs when the full screen mode is exited.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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See also
Elements (Page 1983)

Replay

Description
Occurs when the video or audio file has been replayed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 1983)

9.9 Mobile Wireless

9.9.1 Field of application of the Mobile Panel Wireless

Introduction
The Mobile Panel Wireless enables you to move through the plant without restrictions and with 
or without security technology. You can operate and monitor moving machine parts or the 
entire plant depending on the situation. You can plan, configure, simulate and extend wireless 
networks quickly and reliably.

The Mobile Panels Wireless are based on standardized WLAN technology and are specially 
tailored to the requirements of automation.

WLAN area
A WLAN area is the area of the plant in which the HMI device communicates with the PLC 
over a wireless local area network. The wireless coverage of the network has a sufficient signal 
strength in this area.  

The WLAN of a plant is formed by the radio area of one or more Access Points. 
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Access Point
The Access Point serves as a gateway between the wireless and hard-wired network. The 
HMI device communicates with an Access Point via WLAN. You can operate the different 
machines or plants without annoying cables. The HMI device is connected to a network in 
which it communicates with a PLC via the access point.  

Effective range
Safety-related operator input is only possible in a limited part of a WLAN area upstream of a 
machine or plant known as the effective range. One exception to this rule is the emergency 
stop, which works in the entire WLAN area.  

The configured effective ranges are stored in the HMI device. The HMI device can only log on 
to a machine within the effective range. This also requires there no other HMI device is logged 
on in the same effective range.

To ensure clear logon and machine operator inputs, one effective range must not overlap 
another effective range.

Tags
Effective ranges are formed by the spatial assignment of tags to a machine or plant. Tags 
create a geometrical space which is relevant for logon to a machine. After logon you operate 
the machine using acknowledgement buttons. 

A distinction is made between two types of tags:   

● Transponder

● RFID tag

Transponder
After successful logon to a machine, the spanned geometrical area will be monitored. The 
distance between the HMI device and the transponder can only be measured if the two devices 
are in the reception range of each other. When you leave the effective range, safety-related 
operator input of the machine with acknowledgment buttons is prevented.  

Zones in the transponder system
Zones are configurable objects within a transponder system. A zone is defined by the maximum 
distance from one or more transponders. In a hard-wired Mobile Panel, the length of the 
connection cable defines a zone around a connection box.  

Zones are operating areas in which safety-related operator input is not possible. To enter a 
zone, you have to configure a screen change to the correct process picture. 

RFID tag
After successful logon to a machine, the spanned geometrical area is not monitored. Monitoring 
therefore calls for an additional organizational measure, for example: a light barrier or a 
protective fence. The protection area is separated from the plant by a security system. The 
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protection area is the area in the plant in which you operate one or more machines in fail-safe 
operation. One or more RFID Tags are distributed within protection zones. The protection area 
is not a configurable object. 

9.9.2 How does the transponder system work?

Overview
To give a basic understanding of all this, the following section describes the interaction 
between:    

● HMI device

● Zone

● Effective range

● Transponder
 

 NOTICE

You should always assign administrator rights or set up encryption to protect the project 
containing a Mobile Panel Wireless for fail-safe operation against unauthorized access.
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Principle of operation in the transponder system
 

① Access Point
② WLAN of the Access Point
③ PLC
④ Plant
⑤ Effective range "Robot 1" with a transponder
⑥ Effective range "Robot 2" with two transponders
⑦ Zone "Zone 1" with a transponder
⑧ Radio area of the HMI device
⑨ HMI device

 

Example: 
● A screen change is configured for "Zone 1".

● Transponder1 is assigned to the "Robot 2" effective range.

● The operator enters the radio cone of the transponder to receive the transponder ID.

Visualizing processes (Professional)
9.9 Mobile Wireless

WinCC Professional V11.0 SP1
2012 System Manual, 08/2011,  



● To log onto the machine "Robot 2", the operator presses the object "Effective range - Name".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range ID 
and confirms with "OK". The dialog is closed.

● If the logon was successful, then the acknowledgement buttons will be active.

● The HMI device measures the distance from the transponder which is less than the 
configured distance of the effective range.

Result:
The operator is logged onto the machine "Robot 2". The operating element "Effective range - 
Name" is green and shows the name of the effective range "Robot 2".

If the HMI device is logged onto the effective range, then the following will apply:

● The operator may not leave the effective range without logging off. If the operator leaves 
the effective range without logging off for more than 30 seconds, a local rampdown will 
occur.

● No other HMI device can log onto the machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot2". 

When the operator enters "Zone 1", a screen change will take place. 

9.9.3 How does the RFID system work?

Overview
RFID stands for radio frequency identification. RFID allows wireless identification of objects 
without contact or visual sighting.  

For a basic understanding, the following section describes the interaction between:

● HMI device

● Effective range (RFID)

● RFID tag
 

 
 NOTICE

RFID Tags in the plant area

You may only affix RFID Tags in restricted plant areas that are protected by additional 
protective measures, for example, protective railings. 
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Principle of operation in the RFID system

① Access Point
② WLAN of the Access Point
③ PLC
④ RFID tag with effective range (RFID) for logon to "Robot 1"
⑤ RFID tag with effective range (RFID) for logon to "Robot 2"
⑥ Plant
⑦ Protective area limit of the machine "Robot1"
⑧ Protective area limit of the machine "Robot2"
⑨ Radio area of the HMI device
⑩ HMI device

 

Example: 
● "RFID Tag1" is assigned to the effective range (RFID) "Robot1".

● An operator enters the restricted plant area. The operator manually switches to the screen 
with the configured operating element "Effective range - Name (RFID)".
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● At "RFID Tag1", he presses the "Scan" button.
During the logon operation, the button is yellow and displays the text "Scanning…".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range 
(RFID) ID and confirms it with "OK". The dialog is closed.

● The "Confirmation of logon" dialog box opens. The operator confirms logon with the 
acknowledgment button.

● If logon was successful, the acknowledgement buttons are active.

Result:
The operator is logged on to the machine "Robot 1" and operates the machine within the 
protection area in fail-safe operation. The operating element "Effective range - Name (RFID)" 
is green and shows the name of the effective range (RFID) "Robot1".

If the HMI device is logged on to the machine, the following applies:

● The user may not leave the protection area without logging off from the machine. If the 
operator leaves the protection area without logging off, a local rampdown occurs.

● No other HMI device can log on to this machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name (RFID)". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot 1". 

9.9.4 Basics

9.9.4.1 Zones

Introduction
The following section applies only to the Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN 
V2 and Mobile Panel 277F IWLAN V2. The "Zones" work area is only visible for these HMI 
devices.   

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Depending on the HMI device selected, open the work area in the project window by double-
clicking on "Zones" or "Zones and effective ranges". 
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Work area
The "Zones" work area displays the zones that have been set up and the transponders 
assigned to them.

Inspector window
When a zone is selected, you can edit the names, display names and the limits of the zone 
under the "General" category. The zone has the "On entry" and "On exit" zones. Assign the 
"ActivateScreen" system function to the events.

9.9.4.2 Zones working area

Introduction
The "Zones" work area displays the zones and the transponders assigned to them in table 
format. You create a list of transponders and assign certain transponders to a zone. The limit 
of the zone is defined by the maximum distance from the transponders.   

Principle
The work area consists of the "Zones" and "Transponders" tables.

If you select a zone in the "Zones" table, the "Transponder" table displays the following:

● Transponder enabled: The transponder is assigned to the selected zone.

● Transponder deactivated: The transponder is not yet assigned to any zone.

● Transponder not available: The transponder has already been assigned to another zone. 
To undo the assignment, switch to the relevant zone and deactivate the transponder.

The zone and transponder IDs are initially assigned automatically. They can be changed, 
however. 

Please note the following:

Visualizing processes (Professional)
9.9 Mobile Wireless

WinCC Professional V11.0 SP1
2016 System Manual, 08/2011,  



● A maximum of 254 zones may be configured.

● The zone ID must be unique and fall within the range from 1 - 254.

● You can initially configure transponders without assigning them to a zone.

● There may be no more than 255 transponders assigned to a zone, an effective range or 
both.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.

 

9.9.4.3 Effective ranges

Introduction
The following section applies only to the Mobile Panels Wireless that support fail-safe 
operation, e.g. Mobile Panel 277F IWLAN V2. The "Effective ranges" work area is only visible 
for these HMI devices.   

You set up effective ranges in order to control safety related operations. An effective range is 
defined by the maximum distance from one or more transponders.

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Zones & effective ranges". 
Click the "Effective ranges" tab.

Work area
The "Effective ranges" work area displays the effective ranges that have been set up and the 
transponders assigned to them. 

Inspector window
When an effective range is selected, you can edit the names, display names and the limits of 
the effective range under the "General" category. 

When you select a transponder, you can see both the effective range and the zone that are 
assigned to that transponder. You can only assign a transponder to one effective range so 
that the effective ranges do not overlap.
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9.9.4.4 Effective ranges working area

Introduction
The "Effective ranges" work area displays the effective ranges and their transponders in table 
format. You create a list of transponders and assign certain transponders to an effective range. 
The limit of the effective range is defined by the maximum distance from the transponders.      

Principle
The work area consists of the "Effective ranges" and "Transponders" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges and transponders reliably match those locally on the machine. The project cannot be 
started on the HMI device unless the local checksum agrees with the checksum stored in the 
"Effective ranges" editor.

When you select an effective range from the "Effective ranges" table, the "Transponder" table 
displays the following:

● Transponder enabled: The transponder is assigned to the selected effective range.

● Transponder deactivated: The transponder is not yet assigned to any effective range.

● Transponder not available: The transponder has already been assigned to another effective 
range. To undo the assignment, switch to the relevant effective range and deactivate the 
transponder.

● The zone assigned to the transponder is displayed in addition to the effective range.

The effective range and transponder IDs are initially assigned automatically. They can be 
changed, however. 

Please note the following:

● A maximum of 127 effective ranges may be configured.

● The effective range ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range must not be the same as its ID.
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● You can initially configure transponders without assigning them to an effective range.

● There may be no more than 127 transponders assigned to a zone, an effective range or 
both.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.

Effective range in Runtime
To log on to the effective range in Runtime, only the display name of the effective range appears 
to the operator in the Runtime language. The operator reads the effective range ID in the plant 
and enters it on the HMI device. This ensures that the right machine operated. The 
acknowledgment buttons are activated after successful logon.     

9.9.4.5 Effective ranges (RFID)

Introduction
The following section only applies to the Mobile Panel 277F IWLAN (RFID tag) which supports 
fail-safe operation with RFID. The "Effective ranges (RFID)" work area is only visible with these 
HMI devices.    

To monitor safety-related operator inputs, you set up effective ranges (RFID). 
 

 Note

For more information, refer to the operating instructions of the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Effective ranges (RFID)". 

Work area
The "Effective ranges (RFID)" work area displays the effective ranges that have been set up 
and the RFID Tags assigned to them. 

Inspector window
When an effective range (RFID) is selected, you can edit the name, display name and ID of 
the effective range under the "General" category. 
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9.9.4.6 Work area for effective ranges (RFID)

Introduction
The "Effective ranges (RFID)" work area displays the effective ranges (RFID) and their 
RFID Tags in table format. You create a list of RFID Tags and assign specific RFID Tags to 
an effective range.       

Principle
The work area consists of the "Effective ranges (RFID)" and "RFID Tags" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges (RFID) and RFID Tags reliably match those locally on the machine. The project cannot 
be started on the HMI device unless the local checksum agrees with the checksum stored in 
the "Effective ranges (RFID)" editor. 

When you select an effective range (RFID) in the "Effective ranges (RFID)" table, the 
"RFID Tags" table displays the following:

● RFID Tag enabled: The RFID Tag is assigned to the selected effective range (RFID).

● RFID Tag disabled: The RFID Tag is not yet assigned to any effective range (RFID).

● RFID Tag not available: The RFID Tag has already been assigned to another effective 
range (RFID). To undo the assignment, switch to the relevant effective range (RFID) and 
deactivate the RFID Tag.

The IDs of the effective ranges (RFID) and RFID Tags are initially assigned automatically. 
They can be changed, however. 

Please note the following:

● A maximum of 127 effective ranges (RFID) may be configured.

● The effective range (RFID) ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range (RFID) must not be the same as its ID.

● You can initially configure RFID Tags without assigning them to an effective range (RFID).
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● A maximum of 127 RFID Tags is available to assign to an effective range  (RFID).

● The RFID Tag ID must be unique and fall within the range 1-65534.

The RFID Tag ID is written to the RFID Tag by the HMI device.

Effective range in Runtime
To log on to the effective range (RFID) in Runtime, only the display name of the effective range 
(RFID) is displayed to the operator in the Runtime language. The operator reads the effective 
range (RFID) ID in the plant and enters it on the HMI device. This ensures that the right machine 
operated. The acknowledgment buttons are activated after successful logon.     

9.9.5 Working with zones

9.9.5.1 Configuring a zone

Validity
The next section applies to all Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN.  

Introduction
You will have to set up a zone in order to carry out plant-specific operator control and monitoring 
tasks.

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Zones" work area is open.

Procedure
1. Double-click "Add..." in the "Zones" table.

2. Enter the "MixingPlant" zone in the "Name" field.

3. Enter "MixingSystem" as the "Display name" for the zone at runtime. Enter zone "1" in the 
"ID" field.

4. Enter "8" meters as the zone "Limit".

5. Double-click "Add..." in the "Transponders" table.

6. Enter "Transponder 1" as the "Name" of the transponder.

7. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.
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8. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingPlant" zone.

9. Repeat steps 6 to -9 accordingly for "Transponder 2".
"Transponder 2" is assigned to the "MixingPlant" zone.

Result
The "MixingPlant" zone is configured as two conical areas arranged at a distance of 8 meters, 
regardless of the effective ranges: one area around "Transponder 1" and one around 
"Transponder 2".

The display name designates the zone in the set editing language. An overview of the display 
names can be found in the "Project texts" editor.

 

9.9.5.2 Displaying the screen on entering a zone

Introduction
Configure a screen change when entering and leaving the zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "MixingPlant" zone is configured.

● The "Plant_1" screen has been created and opened.

● The "MixingPlant_1" screen has been created and opened.

● The "Zones" work area is open.
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Procedure
1. Select the "MixingPlant" zone from the "Zones" table.

2. Click "Properties> Events" in the Inspector window.

3. Click the event "On entry".

4. Select the "ActivateScreen" system function in the "function list".

5. Select "MixingPlant_1" as the "Screen name".

6. Click the event "On exit".

7. Select the "ActivateScreen" system function in the function list.

8. Select "Plant_1" as the "Screen name".

Result
The "MixingPlant_1" screen is displayed on the HMI device when you enter the "MixingPlant" 
zone. When you exit the zone, the "Plant_1" screen appears once more.

9.9.5.3 Displaying an object in relation to the zone

Validity
The following example is independent of the WLAN and applies to all Mobile Panels. 

Introduction
You configure an I/O field that is only visible within a specific zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "Zone_id" variable of the "Int" data type has been created.

● A "Plant_1_Overview" screen has been created.

Procedure
1. Open the "Runtime Settings > General" editor.

2. Select the "Zone_id" tag as the "ID Zone/ Effective range".

3. Open the screen "Plant_1_Overview".

4. Drag and drop the "I/O box" object from the toolbox into the screen.

5. Click "Properties > Animations" in the Inspector window.

6. Click "Layout > Visibility."

7. Select "Zone_id" as the "tag".
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8. Select "from" 1 "to" 1 as the "Range".

9. Enable "Visible".

Result
The IO field is only visible at runtime under the following conditions:

● The hard-wired Mobile Panel is connected to a connection box with ID = 1.

● The Mobile Panel Wireless is located in a zone with ID = 1, for example, the "MixingPlant" 
zone.

 

9.9.6 Working with effective ranges

9.9.6.1 Overview

Introduction
The following configuration guide describes the steps needed to set up an effective range for 
fail-safe operation on a Mobile Panel Wireless.

Procedures overview
1. Configuring the effective range:

You configure the "MixingAxisControl" effective range as a conical area around 
"Transponder1 " at a distance of 5 meters.

2. Configuring the name of the effective range:
To ensure logon to the effective range, configure the object "Effective range - Name".

3. Configuring additional effective range objects:
Configure additional objects for displaying the position and signal strength within an 
effective range.

4. Set parameters for loading:

– PROFIsafe communication

– WLAN network

– Power management

– Interface

5. Configure the data channel

6. Configure network operation

7. Set the transponder

8. Commissioning effective ranges
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9. Switching on and Testing the HMI device

10.Start loading manually

11.Acknowledging the effective range at the plant:
You acknowledge the effective ranges and their transponders.

12.Determine the checksum

13.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

14.Test effective range
 

  Note

For detailed information on items 5 to 14, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)

 

 

9.9.6.2 Configure effective range

Introduction
You set up an effective range in order to control safety related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges" work area is open.

Procedure
1. Double-click "Add..." in the "Effective Ranges" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range.

3. Enter "Mixing_axis_PLC" as the "Display name" for the effective range at runtime.

4. Enter effective range "1" in the "ID" field.
Make sure that the effective range ID matches the ID on the machine.

5. Enter "5" meters as the "Limit" of the effective range.

6. Double-click "Add..." in the "Transponders" table.

7. Enter "Transponder 1" as the "Name" of the transponder.
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8. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.

9. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingAxisControl" effective range.

Result
You configure the "MixingAxisControl" effective range as a conical area around "Transponder 
1" at a distance of 5 meters, regardless of the zones.

The display name designates the effective range in the set editing language. An overview of 
the display names can be found in the "Project texts" editor.

9.9.6.3 Configuring the effective range name

Introduction
Configure at least the "Effective range - Name" object so that an operator can log on and off 
a machine using an effective range. If you do not configure an effective range object for a 
Mobile Panel Wireless for fail-safe operation, a warning appears during generation.     

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Name" object from the "Advanced objects" category in the 

toolbox.

2. Drag and drop the "Effective range - Name" object from the toolbox into the screen.
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Result
If the operator clicks an object during runtime, he initiates logon or logoff of the HMI device to 
a machine that is assigned to an effective range.

See also
Effective range name (Page 942)

9.9.6.4 Configuring additional Mobile Wireless objects

Introduction
You will need to configure other objects in order to display further information about the 
effective range during testing, for example.  

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Signal" object from the "Advanced objects" category in the 

toolbox.

2. Drag and drop the "Effective range - Signal" object from the toolbox into the screen.

3. Repeat steps 1 and 2 with the "WLAN - Reception" object.

Result
The "Effective range - Signal" object indicates how accurately the Mobile Panel Wireless is 
within an effective range. The "WLAN - Reception Quality" object displays the signal strength 
of the WLAN wireless connection.

See also
WLAN reception (Page 947)

Effective range signal (Page 946)
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9.9.7 Working with effective ranges (RFID)

9.9.7.1 Overview

Validity
The next section applies only to Mobile Panels Wireless with RFID, for example, 
Mobile Panel 277F IWLAN (RFID Tag).  

Introduction
The following configuration guide describes the steps required to set up an effective range 
(RFID) for fail-safe operation on a Mobile Panel Wireless with RFID.

Procedures overview
1. Configure effective range (RFID):

You configure the effective range (RFID) "MixingAxisControl".

2. Configuring the name of the effective range (RFID):
To ensure logon to the effective range, configure the object "Effective range - Name (RFID)".

3. Set parameters for loading

4. Configure the data channel

5. Configure network operation

6. Install RFID Tag in the plant

7. Turn on the HMI device and enable loading mode

8. Loading a project

9. Write the suitable IDs to the RFID Tags in the plant

10.Determine the checksum

11.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

12.Test effective range (RFID)
 

  Note

For detailed information on items 4 to 12, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)
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9.9.7.2 Configuring effective range (RFID)

Introduction
You set up an effective range (RFID) to control safety-related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges (RFID)" work area is open.

Procedure
1. Double-click "Add..." in the "Effective Ranges (RFID)" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range (RFID).

3. Enter "MixingAxisControl" in the "Display name" field of the effective range (RFID).

4. Enter "1" in the "ID" field of the effective range (RFID). 
Make sure that the effective range (RFID)-ID matches the ID on the machine.

5. Double-click "Add..." in the "RFID Tag table.

6. Enter "RFID Tag 1" as the "Name" of the RFID Tag.

7. Enter "1" as the "ID" of the RFID Tag. Then set the RFID Tag-ID for the RFID Tag.

8. Enable the assignment of "RFID Tag 1".
"RFID Tag 1" is assigned to the effective range (RFID) "MixingAxisControl".

Result
The effective range (RFID) "MixingAxisControl" is configured.
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The display name describes the effective range (RFID) in the set editing language. An overview 
of the display names can be found in the "Project texts" editor.

9.9.7.3 Configuring the effective range name (RFID)

Introduction
Configure the "Effective range - Name" object so that an operator can log on and off a machine 
using an effective range (RFID). If you do not configure the "Effective range-Name" object for 
a Mobile Panel Wireless RFID with (RFID), a warning will appear during generation.     

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Name (RFID)" object from "Advanced objects" in the toolbox.

2. Drag and drop the "Effective range - Name (RFID)" object from the toolbox into the screen.

Result
If the operator clicks an object during runtime, he will initiate logon or logoff of the HMI device 
to a machine which has been assigned to an effective range (RFID). 

See also
Effective range name (RFID) (Page 944)

9.9.8 Reference

9.9.8.1 PROFIsafe address

Validity
The PROFIsafe address is only available for fail-safe operation for the Mobile Panel Wireless. 

 

 Note

Additional information on fail-safe operation can be found in the operating instructions for the 
HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)
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PROFIsafe address
The PROFIsafe address used for fail-safe I/Os in PROFIsafe communication is unique on the 
entire network and on all stations. On the Mobile Panel Wireless, you create a default value 
in the project and load it to the HMI device. You can also store a PROFIsafe address on the 
HMI device.  

The PROFIsafe address fall within the range from 1 to 65534. The two PROFIsafe addresses 
(in the Engineering System and on the HMI device) are checked for formal validity. 

The PROFIsafe address is loaded as follows at the start of Runtime:

● You programmed a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the Control Panel.

● You did not program a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the project.

 

 
 NOTICE

The invalid address 65.535 is programmed by default in the Control Panel of the HMI 
device. The HMI loads the address set in the project. 

 

See also
Power Management (Page 2031)

Zone ID / connection point ID (Page 2032)

9.9.8.2 Power Management

Validity
In the "Runtime Settings > Power Management" editor, configure the energy-saving mode of 
a Mobile Panel. 

Power Management
The Mobile Panel Wireless can save energy in the following ways:   

● Reduce brightness - minimal saving

● Switch off display - significant saving

You can also indicate after how long without operator input the power management function 
is enabled. The communication link is maintained. The time for "Switch monitor off" is longer 
than the time for "Reduce brightness".

See also
PROFIsafe address (Page 2030)
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9.9.8.3 Zone ID / connection point ID

Validity
In the "Runtime Settings > General" configure an internal tag which, depending on the value, 
shows specific information on the display of the HMI device.

 

 Note
Mobile Panels Wireless with RFID

For Mobile Panels Wireless with RFID, the area "Zone ID / Connection point ID" is not 
available.

 

Zone ID / connection point ID
This field is used to configure an internal tag that contains the following value at runtime in 
relation to the type of HMI device:     

● The ID of the connection box or effective range to which the hard-wired Mobile Panel is 
connected.

● The ID of the zone in which the Mobile Panel Wireless is located. If the value is set to 255, 
then the HMI device is not in any zone.

See also
PROFIsafe address (Page 2030)

9.10 Planning tasks

9.10.1 Field of application of the Scheduler

Definition
You can use the Scheduler to configure tasks to run independent of the screen in the 
background. You create tasks by linking system functions or scripts to a trigger. The linked 
functions will be called when the triggering event occurs.  

Example of an application
The Scheduler is used to execute event-controlled tasks automatically. For example, you use 
a task to automate the following:

● Regular swap out of log data

● Printout of an alarm report when an alarm buffer overflow occurs
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● Printout of a report at shift end

● Monitoring a tag

● Monitoring of a user change
 

 Note

The availability of the listed examples is determined by the HMI device. 
 

9.10.2 Working with tasks and triggers

Introduction
A task consists of a trigger and a task type.

Starting a task
Controlled by a trigger, the Scheduler starts the task linked to the trigger. 
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9.10.3 Basics

9.10.3.1 Work area of the "Scheduler" editor

Introduction
Double-click on "Scheduler" to open it in the project view. The work area shows the scheduled 
tasks, which consist of the trigger and the task type, for example, the function list.  

Structure
The work area consists of the table of jobs.

The table of tasks shows specified tasks with their properties, such as triggers. You select a 
task type and a trigger. You assign a name and a comment to the task. The description provides 
a written summary of the task including the timing for the task.

Inspector window
The "Properties" tab of the Inspector window is split into two parts. 
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The "Job" area lists the name of the job and the job type. The "Starting time" area shows the 
trigger. The area is different depending on the trigger selected. 

In the "Events" tab use the function list with system functions that will be executed in the task.
 

 Note

You can obtain more detailed information about the elements of the user interface using the 
tooltips. To do so, move the mouse pointer to the relevant object or press <F1> if the object 
has already been selected.

 

 

9.10.3.2 Triggers

Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Event trigger
When a task is linked to a system event, the task will be triggered by the event. System events 
include, for example, Runtime stop, screen change, user change, etc. 

Each system event can only be configured once for each HMI device.   

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 

Example: Task "A" is planned with the system event "Shutdown". This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "Runtime stop" system event available again.   

 

 Note

The available triggers depend on the HMI device.
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Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Types of triggers
The Scheduler recognizes different types of triggers:

Acyclic triggers
They consist of a specification for the date and time of day. Tasks with an acyclic trigger are 
performed once by the Scheduler on the specified date and at the specified time.     

Cyclic triggers
Tasks linked to a cyclic trigger occur regularly at a specific point in time.     

● Standard cycle: With a standard cycle, the beginning of the first interval coincides with the 
start of Runtime. The length of the interval is determined by the cycle.  

● Trigger with defined starting time: You specify a start time and a time interval. You can use 
cyclic triggers to perform tasks on a daily or weekly basis, for example. For example, you 
can select a "Weekly" trigger to specify a week as the interval. You specify the beginning 
of the interval with the day of the week and the time of day.  

Event trigger
When a task is linked to a system event, the task will be triggered by the event. In contrast to 
cyclic triggers, system events usually occur acyclically. A Runtime stop is a system event, for 
example.

Each system event can only be configured once for each HMI device.       

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 

Example: Task "A" is planned with the "User change" system event. This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "User change" system event available again.   

 

 Note

The available triggers depend on the HMI device.
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Timers for cyclic triggers

Timers for cyclic and acyclic triggers
You have the option to change the start time of a task dynamically in Runtime. You can select 
an HMI variable as the timer. The value of the tag determines the start time for the task during 
Runtime.     

 

 Note

An HMI tag must be of the type "DateTime". A PLC tag must be of the type "Date and Time" 
or "DTL".

 

As long as the operator does not change the tag after Runtime starts, the start time configured 
in the task is valid. As soon as the operator enters a change to the tag, the current value of 
the tag is always the start time. To reset the configured time as the start time, the operator has 
to enter the configured time again. 

Tag triggers

Tag triggers
In addition to acyclic, cyclic and event triggers, WinCC offers tag triggers.    

Tag triggers consist of the specification of one or more tags. A task linked to such a trigger is 
only performed when the value of the tag changes. This reduces the load on the system. The 
cycle in which the tag values are scanned can be set individually for each tag. Select a value 
ranging from "250 ms" to once an hour for the scanned cycles. You can also define your own 
user cycles.

Visualizing processes (Professional)
9.10 Planning tasks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2037



Rules for selecting the trigger
Use the tag trigger instead of the cyclic trigger for tag processing. This reduces the load on 
the system.

● Cyclic triggers
You have selected "10 seconds" as the cyclic trigger. The task will be executed when the 
trigger occurs.

= task is executed.

● Tag triggers
The task is performed only when the value of the tag changes. 

= task is executed.

 

9.10.3.3 Task type

Function list

Function list
A trigger starts the function list. The function list is executed line-for-line. Each line contains a 
system function. You can configure exactly one function list for each task.   

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device. 
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See also
Integrating local VB scripts (Page 2040)

Integrating local C scripts (Page 2042)

Function list

Function list
A trigger starts the function list. The function list is executed line-for-line. Each line contains a 
system function or a local script. You can configure exactly one function list for each task.

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device.

 

Processing of system functions and scripts
System functions and scripts in a function list are processed in Runtime sequentially from top 
to bottom. 

Basics of the function list (Page 1748) 

Use a script with loops, conditional statements and abort conditions to program non-sequential 
and conditional procedures. 

Print task

Introduction
In addition to the "Function list", WinCC Runtime Professional also includes the "Print job" task 
type.

Print job
You print the report by creating a print job. When a cyclic or acyclic trigger occurs, the 
Scheduler starts the printout of a report. You define the scope of printing and the time range 
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of the report beforehand in the "Print jobs" editor. In addition, you specify whether the report 
will be printed or written into a file.

If you have selected "Print job" as the task type, an additional field will appear in the "Task" 
area. Select the predefined print job for the task in the "Print job" field. 

 

 Note

Activate "Scheduled print jobs in runtime" in the start sequence of WinCC Runtime to use the 
"Print job" job type.

Click on "Runtime settings > Services > Scheduled print jobs in runtime" in the editor.
 

Integrating local VB scripts

Introduction
In addition to the "Function list" and "Print job" task types, Professional Runtime also allows 
you to integrate local VB scripts.
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Integrating local VB scripts
You can create and edit local scripts. You can also convert the system functions offered in the 
function list in a local script and edit the code. The local VB script is stored with the task. 

A trigger starts the script in Runtime. Once you have converted a function list to a VB script, 
you can no longer access the function list for this task. You will have to delete the VB script to 
access the function list once again.

The Scheduler allows you to start VB scripts independent of screens. The VB scripts give you 
access to tags and screens in Runtime. 

There is no common data area between scripts in the Scheduler and screens. Scripts in the 
Scheduler and screens can be synchronized with the DataSet object or tags. The data type of 
VBS variables is always VARIANT. 

The local VB script is not executed simultaneously. The script last triggered is put into a queue 
until it is processed.

 

 Note

When you create a script, the "Option explicit" statement is entered automatically in the 
declaration section and cannot be deleted. The statement is necessary to avoid errors from 
incorrectly spelled tags without declaration. 

The statement requires you to always define tags with the "Dim" statement in your code. Do 
not use the "Option explicit" statement in your code, as it can lead to Runtime errors.

 

Requirement
Enable "Tasks in Runtime" in the startup sequence of WinCC to use the function list and local 
scripts.

Click "Runtime settings > Services > Tasks in Runtime" in the editor.
 

 Note

You cannot call C scripts in VB scripts and vice versa.
 

User cycles as triggers
User cycles used as triggers for your VB scripts will always be executed in Runtime with a 
granularity of 250 ms."

See also
Function list (Page 2038)
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Integrating local C scripts

Introduction
In addition to the "Function list" and "Print job" task types, Runtime Professional also allows 
you to integrate local C scripts.

Integrating local C scripts
You can create and edit local scripts. You can also convert the system functions offered in the 
function list in a local C script and edit the code. The local C script is stored with the task. 

A trigger starts the script in Runtime. Once you convert a function list to a C-script, you can no 
longer access the function list for this task. You will have to delete the C script to access the 
function list once again.

A trigger starts the local C script in Runtime. 

The local C script is not executed simultaneously. The script last triggered is put into a queue 
until it is processed.

Requirement
Enable "Tasks in Runtime" in the startup sequence of WinCC to use the function list and local 
scripts.

Click "Runtime settings > Services > Tasks in Runtime" in the editor.
 

 Note

You cannot call C scripts in VB scripts and vice versa.
 

User cycles as triggers
User cycles used as triggers for your C scripts will always be executed in Runtime with a 
granularity of 250 ms."

 

See also
Function list (Page 2038)
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9.10.4 Planning tasks

9.10.4.1 Planning tasks with acyclic triggers

Introduction
You are planning a one-time Runtime stop for maintenance work. The task starts a function 
which requires Runtime to stop.    

Requirements
● The "Scheduler" editor is open.

● The Inspector window is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Maintenance at end of year" as the "Name."

3. Select "Once" as the "Trigger".

4. Select "31.12.2008" in the "Properties > Properties > General > on" field of the Inspector 
window.

5. Enter the time "18:00" in the "at" field.

6. Click "Properties > Events" in the Inspector window.
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7. Select the "StopRuntime" system function in the function list.

8. Select "Runtime" as the "Mode".

Result
The task is executed once. Runtime will be stopped at 18:00 on December 31, 2008. 

 

 Note
"StopRuntime" event on RT Professional

Please note that the "StopRuntime" event means runtime is in the process of ending and that 
some functionalities are therefore no longer available. 

 

9.10.4.2 Planning tasks with cyclic triggers

Introduction
You plan a task that starts the daily printout of a report.   
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Requirements
● You have created an HMI device with Runtime Professional.

● The "Daily alarm report" print task has been created.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Select "Print task" under "Type."

3. Enter "Daily alarm report printout" as the "Name."

4. Select "Daily" as the "Trigger."

5. In the Inspector window "Properties >Properties > General > at" enter the time "18:00".

6. Select the "Daily alarm report" print task in the "Task" area.

7. Open the "Runtime settings > Services" editor.

8. Enable "Start sequence of WinCC Runtime > Planned print jobs in Runtime".
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Result
The report "Daily alarm report" will be printed every day at 18:00 hours. 

9.10.4.3 Planning tasks with event triggers

Introduction
You plan a task that generates a screen change when the user changes.    

Requirements
● The "Scheduler" work area is open.

● You have created the "Start" screen.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Screen change at user change" as the "Name."

3. Select "User change" as the "Trigger."

4. In the Inspector window, select "Properties > Events".
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5. Select the "Screen/ActivateScreen" system function in the function list.

6. Select the "Start" screen in the screen name field.

Result
The task is executed with the "User change" event. When a new user logs on successfully, 
the "Start" screen is called up. 

9.10.4.4 Administer task

Changing the designation
1. In the work area, double-click the field in the "Name" column. 

2. Change the name of the task.

3. Confirm your entry with <Return>.

As an alternative, you can change the designation in the "Job > Name" box of the Inspector 
window.  
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Changing triggers
1. In the work area, mark the field in the "Trigger" column. 

2. Open the drop-down list using the  button and select the trigger you require.

You can alternatively change the trigger in the "Starting time" area of the Inspector window.

Deleting a task
1. Select one or more lines for the tasks to be deleted. 

2. Open the shortcut menu with the right button and select the menu command "Delete".

As an alternative, delete one or more tasks by using the <Del> button.

9.10.5 Examples for Runtime Professional

9.10.5.1 Example: Activate the start screen daily 

Introduction
You plan a task that activates the start screen daily with a logon dialog before the shift begins.   

Requirements
● A "start screen" has been created.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the "Task" table.

2. Enter "Activate start screen" as the "Name".

3. Select "Function list" as the "Type".

4. Select "Daily" as the "Trigger."

5. In the Inspector window "Properties >Properties > General > at" enter the time "05:30".

6. In the Inspector window, open "Properties > Events".

7. Select the system function "ActivateScreen" from the "Screens" group in the function list.
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8. Enter "Start screen" as the "Screen name".

9. Open the "Runtime settings > Services" editor.

10.Activate "Scheduled tasks in Runtime".

Result
The "Start screen" is activated daily at 5:30 a.m.

9.10.5.2 Example: Printing a report once

Task
You plan a task that prints out a report once at the end of the year. 
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Requirement
● The "Annual overview" print task is created.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Annual summary" as the "Name".

3. Select "Print task" as the "Type".

4. Select "Once" as the "Trigger."

5. Select "31.12.2010" in the "Properties > Properties > General > on" field of the Inspector 
window.

6. Enter the time "22:00" in the "at" field.

7. Select the "Annual overview" print task in the "Task" area.

8. Open the "Runtime settings > Services" editor.

9. Enable "Start sequence of WinCC Runtime > Scheduled print jobs in Runtime".
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Result
The "Annual overview" print job will be started on December 31, 2008 at 10:00 p.m.   

9.10.5.3 Example: Reading the current user name

Introduction
You plan a task that writes the current user into a text field.

Requirements
● A "Screen_1" screen has been created.

● A "Textfield_1" text field has been created in the "Screen_1" screen.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Reading the user name" as the "Name".

3. Select "Tag trigger" as the "Trigger".

4. Click "Properties > Properties > General > Add trigger" in the Inspector window.

5. Select the "@CurrentUser" system variable.

6. Select "1 min" as the "Cycle".

7. In the Inspector window, open "Properties > Events".

8. Click  in the "Function list" area. 

9. Enter the following VB script:

 
Sub Action ()
    Dim user
    user = HMIRuntime.Tags("@CurrentUser").Read
    HMIRuntime.Screens("Screen_1").ScreenItems("Textfield_1").Text = user 
End Sub

1. Open the "Runtime settings > Services" editor.

2. Activate "Scheduled tasks in Runtime".

Result
When the tag value changes, the current user is written into the "Textfield_1" text field.   
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9.10.5.4 Example: Increment a tag

Introduction
You schedule a task that increments the value of a tag by one every hour.

Requirements
● You have created an HMI device with Runtime Professional.

● The "Scheduler" work area is open.

● The "Tag1" tag has been created.

Procedure
1. Click "Add..." in the table of the task area.

2. Select "Function list" as the "Type."

3. Enter "Count up tag" as the "Name."

4. Select "1 hour" as the "Trigger".

5. In the Inspector window, under "Properties > Properties > General > Starting time > at 
minute" enter the value "35:00".

6. In the Inspector window, open "Properties > Events".

7. Click  in the "Function list" area.

8. Enter the following program code in the entry field:

 
Sub Action ()
    Dim objTag1
    Dim lngValue
    Set objTag1 = HMIRuntime.Tags("Tag1")
    lngValue = objTag1.Read
    objTag1.Write lngValue + 1
End Sub

1. Open the "Runtime settings > Services" editor.

2. Select "Scheduled tasks in Runtime".

Result
The tag is incremented cyclically.    
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9.10.6 Examples for Runtime Advanced and Panels

9.10.6.1 Example: Update user following change of user

Task
Configure an I/O field which displays the logged on user. Configure a task which updates the 
I/O field when the logged on user changes.   

Requirements
● A "CurrentUser" tag of the "String" type is created.

● A screen has been created and opened.

● An I/O field is created in the screen.

Procedure
1. Click on the "I/O field" object.

2. In the Inspector window, select "Properties > Events > General":

– Select "Character string" as the "Display format."

– Select "CurrentUser" as the "Variable."

– Select "Output" as the mode.

3. Change to the work area of the Scheduler.

4. Click "Add..." in the table of the task area.

5. Enter "CurrentUser" as the "Name".

6. Select "User change" as the "Trigger."

7. In the Inspector window, select "Properties > Events".
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8. Select the system function "ReadUserName" from the "User Management" group in the 
function list.

9. Select "CurrentUser" as the "Variable."

Result
When a new user logs on successfully, the "ReadUserName" function is called up. The 
"CurrentUser" tag is updated and displayed in the I/O field of the newly logged on user. 

If a user does not log on successfully, the logged on user is logged off. The I/O field continues 
to display the user previously logged on until a new user logs on successfully.    

9.10.6.2 Example: Weekly printout of a report

Introduction
You plan a task that starts the weekly printout of a report.

Requirements
● A "Weekly report" report has been created.

● The "Scheduler" work area is open.
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Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Weekly report printout for end of shift" as the "Name."

3. Select "Weekly" as the "Trigger."

4. Select "Properties > Properties > General > on day" "Friday" in the Inspector window.

5. Enter the time "18:00" in the "at" field.

6. In the Inspector window, select "Properties > Events".

7. Select the "Print/PrintReport" system function in the function list.

8. Select "Weekly report" report.

Result
The weekly print task starts on Friday at 18:00.     

Visualizing processes (Professional)
9.10 Planning tasks

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2055



9.10.6.3 Example: Changing the starting point of a task in Runtime

Example: Changing the starting point of a task in Runtime

Introduction
A cyclic trigger, for example "Starting daily at 18:00," is configured in the Engineering System. 
The time "18:00" is fixed as a constant. To change the start time in Runtime, select a tag as 
the "Timer." The value of the tag determines the start time of the task during Runtime.   

Task
You plan a task that swaps out log data daily and has the "LogTime" tag as the timer. You 
configure a "LogTime" tag in an input field.

Requirements
● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● A "ChangeLogTime" screen has been created.

Procedures overview
1. Creating a timer tag: You create a tag with which you change the starting point of the log 

data swap in Runtime.

2. Configuring a Date/time field: The operator changes the starting point of the task by using 
the Date/Time field in Runtime.

3. Configure the task with a timer tag: You create a task whose start time can be changed 
dynamically in Runtime.

Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 

Example: 1. Configuring a tag for Runtime

Task
In the following example you configure the "LogTime" variable.
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Procedure
1. Open the "HMI tags" editor.

2. Click "Add..." in the table of the task area.

3. Enter "LogTime" as the "Name" of the variable.

4. Select "Internal variable" in the "Connection" column.

5. Select "DateTime" in the "Date type" column.

Result
A variable of the "DateTime" type has been created.

Example: 2. Configuring a Date/time field

Task
In the following example you configure a Date/time field. To change the starting point of the 
task in Runtime, link the "LogTime" variable to the Date/time field.

Requirements
● The "LogTime" variable of the "DateTime" type has been created.

● The "ChangeLogTime" screen is open.

Procedure
1. In the toolbox view, drag-and-drop a "Date/time field" from the "Basic objects" category to 

the screen.

2. In the Inspector window, click "Properties >Properties > General".

3. Disable the "System time."

4. Click "Variable" and select "LogTime."

5. Disable "Display date" and enable "Display time."

6. Select "Input/output" as the "Mode."

7. Click "Properties > Miscellaneous."

8. Enter "LogDataTimeField" as the "Name".

Result
The operator enters a time using the created date/time field.
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Example: 3. Configuring archiving with a timer variable

Task
In the following example you configure a task with a timer tag with which you change the starting 
point of the task in Runtime.    

Requirements
● The "LogTime" tag has been created.

● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● The Scheduler work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Swap out log daily at a tag time" as the "Name".

3. Select "Daily" as the "Trigger".

4. In the Inspector window "Properties >Properties > General > at" enter the time "18:00".

5. Select the "LogTime" tag as the "Standard timer".

6. In the Inspector window, open "Properties > Events".
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7. Select the "System functions/Logs/CopyLog" system function in the function list.

8. Select these settings:

– Select "Data log" as the "Log type".

– Select "DataLogDestination" as the "Destination log".

– Select "DataLogSource" as the "Source log".

– Select "Overwrite" as the "Mode".

– Select "Yes" for "Delete source log".

Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 
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9.11 Using global functions

9.11.1 HMI device wizard basics

Introduction
The HMI device wizard will automatically start when you create a new HMI device in your 
project. 

HMI device wizard
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.
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See also
HMI device wizard basics (Page 2061)

Importing and exporting project data (Page 2062)

General information about cross references (Page 2098)

Languages in WinCC (Page 2102)

Basics (Page 2130)

9.11.2 HMI device wizard basics

Introduction
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.   
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Opening the HMI device wizard
1. Add a new device to your project, for example, RT Advanced.

2. Click on the device in the project tree.

3. Select "Start the HMI device wizard" in the shortcut menu. The "HMI device wizard" opens.
 

  Note

If you make changes after adding the device, such as adding a new screen, the HMI device 
wizard will not open again. 

 

See also
HMI device wizard basics (Page 2060)

9.11.3 Importing and exporting project data

9.11.3.1 Importing and exporting project data

Introduction
WinCC enables you to export data from a project and import it into another project. 

You export or import the following project data:

● Recipe data records

● Alarms

● Tags

● Text lists

● Project texts

Exporting and importing reduces the workload. Instead of creating new data records, you use 
data already created in previous projects.

Editing the export file
The following file formats are available for export and import depending on the editor:

● *.xlsx for alarms, tags, project texts and text lists

● *.csv for recipe data records

You can edit the import file in Excel, for example.
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XLSX file format
XLSX format is a file format for Excel tables based on the Open XML format. XLSX files are 
optimized for Microsoft Excel 2007.

You can sort the columns as required in the XLSX file.

CSV file format
CSV stands for Comma Separated Value. In this format, the columns of the table that contain 
the names and the value of the entry are separated by semicolons. Each table row terminates 
with a line break. You can also open the CSV file for editing in Excel.

Importing project data
When project data is imported, the objects in the project are created.

The syntax of the import file is checked during import. The accuracy of the values imported 
and dependencies between the imported values are not checked.

Any errors found in the imported data are reported when the project is compiled.

See also
HMI device wizard basics (Page 2060)

9.11.3.2 Importing and exporting recipe data records

Exporting recipe data records

Introduction
WinCC features an export function for exporting data records from recipes.     

Requirements
● The WinCC project for the export is open.

● Recipes have been created in a project.

● The "Recipes" editor is open.
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Exporting recipes
1. In the "Recipes" editor, select the recipe with the data records you want to export.

2. Click .
The "Export" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Under "Content selection", specify if all or only selected data records are to be exported.

4. Under "File selection", specify the file in which the recipe data is to be stored.

5. Specify the list separator and decimal separator under "Data separation".

6. Click "Export."
The export will start. 

Result
The exported data has been written to a CSV file. The CSV file will be stored in the specified 
directory. 

See also
Importing recipe data records (Page 2065)
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Importing recipe data records

Introduction
Recipes are identified by their name. The recipe name must therefore be unique. Open the 
import file in a simple text editor to check that it has the correct data structure.

Specify whether or not existing data records should be overwritten by records with the same 
name during the import.    

Requirements
● A CSV file containing at least one recipe has been created.

● The WinCC project for the import is open.

● The "Recipes" editor is open with at least one recipe.

Importing a recipe
1. In the "Recipes" editor, select the recipe with the data records you want to import.

2. Click .
The "Import" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Select the file you want to import under "File selection".

4. Under "Strategy", specify if existing data records should be overwritten by records of the 
same name.
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5. Under "Data separation", select the list separator and the decimal separator to use in the 
CSV file.

6. Click "Import".
The import will start. 

Result
The data records are created in the selected recipe. Depending on the setting for "Strategy", 
existing data records are overwritten by records with the same name from the CSV file. 

Existing data records with the same name will also be imported from the CSV file if you 
deactivate the "Overwrite existing data records" option. 

See also
Exporting recipe data records (Page 2063)

Exporting recipe data records

Introduction
WinCC features an export function for exporting data records from recipes.     

Requirements
● The WinCC project for export is open.

● Recipes have been created in a project.

● The "Recipes" editor is open.
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Exporting recipes
1. In the "Recipes" editor, select the recipe with the data records you want to export.

2. Click .
The "Export" dialog box opens.

The selected recipe is displayed under "Recipe name".

3. Under "File name", specify the file in which the recipe data is to be stored.

4. Under "Content selection", specify if all or only selected data records are to be exported.

5. Click "Export."
The export will start. 

Result
The exported data has been written to a CSV file. The CSV file will be stored in the specified 
directory. 

Importing recipe data records

Introduction
Recipes are identified by their name. The recipe name must therefore be unique. Open the 
import file in a simple text editor to check that it has the correct data structure.

Specify whether or not existing data records should be overwritten by records with the same 
name during the import.    
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Requirements
● A CSV file containing at least one recipe has been created.

● The WinCC project for import is open.

● The "Recipes" editor is open with at least one recipe.

Importing a recipe
1. In the "Recipes" editor, select the recipe with the data records you want to import.

2. Click .
The "Import" dialog box opens.

The selected recipe is displayed under "Recipe name".

3. Select the file you want to import under "File name".

4. Under "Strategy", specify if existing data records should be overwritten by records of the 
same name.

5. Click "Import."
The import will start. 

Result
The data records are created in the selected recipe. Existing data records may be overwritten 
by records with the same name from the CSV file depending on the setting for "Strategy". 
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Format of data from recipe data records

Introduction
This section describes the required format of the file for the import of recipes. The file containing 
the data of the recipes must be available in "*.csv" format. :    

Structure of recipe data
The structure of the import file is fixed. The following example shows the structure of a recipe 
containing two recipe elements, each with two data records:
"ID";<Name, recipe element 1>;< Name, recipe 
element 2>;"LastUser";"LastAccess[UTC]"<Line break>
<Recipe data record number 1>;<Recipe data record 1 value 1>;<Recipe 
data record 1 value 2>;"<Last user 1>";<Date and time 1><Line break>
<Recipe data record number 2>;<Recipe data record 2 value 1>;<Recipe 
data record 2 value 2>;"<Last user 2>";<Date and time 2><Line break>

ID of the language
The recipe always has the first line, which is the header and describes the column headings. 
Only the names of the recipe elements are added dynamically.

Each additional line represents one recipe data record with its recipe element values and 
change information.

9.11.3.3 Importing and exporting alarms

Exporting alarms

Introduction
WinCC has an export function for alarms.       

Requirements
● The WinCC project for the export is open.

● Alarms have been created in the project.

● The "HMI alarms" editor is open.
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Exporting alarms
1. Click the  button in "Discrete alarms" or "Analog alarms".

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Specify whether you want to export "Disrete alarms" or "Analog alarms".

4. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Format of the analog alarm data (Page 2073)

Format of the discrete alarm data (Page 2076)

Format of the analog alarm data (Page 2078)

Format of the discrete alarm data (Page 2082)

Importing alarms

Introduction
Alarms are identified by their alarm number. The alarm numbers must be unique in the analog 
and discrete alarm types. Alarms with redundant alarm numbers will be overwritten. An alarm 
without an existing alarm number is created.   

Any empty list entries for existing alarms contained in an xlsx file will be ignored for the 
purposes of the import. The entries of the existing alarms remain active and will not be replaced 
by empty ones.

Requirements
● An xlsx file with alarms has been created. 

● The structure of the xlsx file meets the requirements.
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● The WinCC project for the import is open.

● The "HMI alarms" editor is open.

Importing alarms
1. Click the  button in "Discrete alarms" or "Analog alarms". The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start. A progress bar indicates the progress of 
the import operation.    

Result
The corresponding alarms including alarm texts are created in WinCC on the basis of the import 
data. Alarms relating to the import operation are displayed in the output window. A log file is 
saved in the source directory of the import files. The log file has the same name as the 
respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a trigger tag 
of an incorrect type, such as string, to an alarm. An error will be reported during compilation.

 

 

See also
Format of the analog alarm data (Page 2073)

Format of the discrete alarm data (Page 2076)

Format of the analog alarm data (Page 2078)

Format of the discrete alarm data (Page 2082)
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Importing alarms

Introduction
Alarms are identified by their alarm name. An existing alarm will be overwritten with the data 
from the xlsx file if the alarm name already exists in the project. A new alarm is created if the 
alarm does not yet exist.

The alarm numbers must be unique in the project. If an alarm number is assigned more than 
once by import, the alarm is imported and the alarm number marked as invalid.   

Requirements
● An xlsx file with alarms has been created. 

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "HMI alarms" editor is open.

Importing alarms
1. Click the  button in "Discrete alarms" or "Analog alarms". The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start. A progress bar indicates the progress of 
the import operation.    

 

  Note

There are no option settings for alarm import.
 

Result
The corresponding alarms including alarm texts are created in WinCC on the basis of the import 
data. Messages relating to the import operation are displayed in the output window. A log file 
is saved in the source directory of the import files. The log file has the same name as the 
respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 
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● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a trigger tag 
of an incorrect type, such as string, to an alarm. An error will be reported during compilation.

 

 

Format of the analog alarm data

Introduction
This chapter describes the required format of the file for the import of analog alarms. The file 
containing the analog alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of a number of worksheets:

● Analog alarms(Analog alarms)

● Limits (Limits)

Each alarm is assigned a separate row in the import file. The import file with the analog alarms 
must be formatted as follows:   

Example of the worksheet "Analog alarms"
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Table 9-19 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts 

must be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts.

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag monitored for limit value violation.
Delay time value Specifies the delay time. The alarm is not triggered until the duration of the limit 

value violation equals the specified delay time.
Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID. 
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Example of the worksheet "Limits"

 

Table 9-20 Meaning of the entries

List entry Meaning
Alarm ID Alarm number

The alarm number is used to reference an alarm. The alarm 
number is unique. Alarms with identical alarm numbers are 
overwritten during import. An alarm without an existing alarm 
number is created.

Limit mode Trigger mode
Indicates the method used for monitoring the limit value.

Limit type Specifies the limit that will be monitored. Both a tag and a 
constant can be used as limit value.

Limit value Limit value
Indicates the tag or constant monitored for limit violation.

Deadband mode Hysteresis mode
Specifies whether and in which cases hysteresis will be used.
For "Outgoing"
For "Incoming"
For "Incoming" and "Outgoing"

Deadband in percent 0 = The value specified for "Hysteresis" is considered to be 
absolute.
1 = The value specified for "Hysteresis" is referred to as a 
percentage of the limit value.

Deadband mode Hysteresis
Specifies a constant as a value of the hysteresis.
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 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 2069)

Importing alarms (Page 2070)

Format of the discrete alarm data (Page 2076)

Format of the discrete alarm data

Introduction
This chapter describes the required format of the file for the import of discrete alarms. The file 
containing the discrete alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of the worksheets "Discrete alarms" (discrete 
alarms). Each alarm is assigned a separate row in the import file. Structure of the import file 
containing the discrete alarms:   

Example of the worksheet "Discrete alarms"
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Table 9-21 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. For import, 

a language ID must be assigned to alarm text.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts. 

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag containing the bit that triggers the alarm.
Trigger bit Specifies the number of the bit that triggers the alarm.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon 

acknowledgment. Only available if the selected alarm class requires alarm 
acknowledgment.

Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the 
alarm.

PLC acknowledgement tag Specifies the tag containing the bit that acknowledges the alarm of the control 
program. Only available if the selected alarm class requires alarm 
acknowledgment.

PLC acknowledgment bit Specifies the number of the bit that acknowledges the alarm of the control program.
Delay time value
 

Specifies the delay time. The alarm is not triggered until the duration of the limit 
value violation equals the specified delay time.

Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID.
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 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 2069)

Importing alarms (Page 2070)

Format of the analog alarm data (Page 2073)

Format of the analog alarm data

Introduction
This chapter describes the required format of the file for the import of analog alarms. The file 
containing the analog alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of two worksheets:

● Analog alarms(Analog alarms)

● Limits (Limits)

Each alarm is assigned a separate line in the import file. The import file with the analog alarms 
must be formatted as follows:   
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Example of the worksheet "Analog alarms"

 

Table 9-22 Meaning of the entries

List entry Meaning
ID Shows the number of the analog alarm. The alarm number must be unique in the 

project.
Name Shows the name of the analog alarm. The name is used to reference an alarm. 

Alarms with identical names are overwritten during import. An alarm without an 
existing name is created.

Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts 
must be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts. 

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Parameter: <ref id = 0; type = AlarmAnalogParameter; Parameter = Limit; 
DisplayType = Decimal; Length = 1; Precision = 0; Alignment = Right; ZeroPadding 
= False;>
System parameters:  <ref id = 0; type = CommonSystemParameter; 
SystemParameter = UserName;>
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List entry Meaning
Class The alarm class of an alarm determines whether or not the alarm has to be 

acknowledged. It can also be used to determine how the alarm appears when it 
is displayed on the HMI device. The alarm class also determines whether and 
where the corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged along with these alarms of the same group 
in a single operation.

Priority Indicates alarm priority. You can sort the alarms in the alarm view by priority. 
Range: 0 -16 

CPU number Specifies the CPU number. This option is only activated if you have enabled the 
"CPU/PLC number" alarm text block in the "Alarm blocks > System blocks" tab in 
the "HMI alarms" editor.

PLC number Shows the PLC number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the 
"HMI alarms" editor.

Trigger tag Specifies the tag monitored for limit value violation.
Verzögerung Specifies the delay time. The alarm is not triggered until the duration of the limit 

value violation equals the specified delay time.
Delay time unit Specifies the time unit for the delay.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon 

acknowledgment. Only available if the selected alarm class requires alarm 
acknowledgment.

Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the 
alarm.

Single acknowledgment Specifies whether each individual alarm must be acknowledged.
True = Alarms must be acknowledged individually.

Status tag Shows the tag which saves the Incoming and Outgoing alarm statuses and the
Acknowledgement request saved.

Status bit Specifies the number of the bit that is set and acknowledges the alarm.
Alarm annonciation Indicates whether an alarm is being suppressed.

True = suppressed alarm.
Display suppresion mask Indicates the display suppression method.
Additonal Text Shows the additional alarm text.
Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 

information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID.
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Example of the worksheet "Limits"

 

Table 9-23 Meaning of the entries

List entry Meaning
Alarm ID The alarm number is used to reference an alarm. The alarm 

number is unique. The alarm number allows alarms to be 
assigned limits.

Name Shows the name of the analog alarm.
Limit mode Indicates the method used for monitoring the limit value.
Grenzen
Limit type

Specifies the limit that will be monitored. Both a tag and a 
constant can be used as limit value.

Limit value Indicates the tag or constant monitored for limit violation.
Suppression Indicates whether an alarm is being suppressed.

True = suppressed alarm.
Deadband mode Specifies whether and in which cases hysteresis will be used.

For "Outgoing"
For "Incoming"
For "Incoming" and "Outgoing"

Deadband in percent 0 = The value specified for "Hysteresis" is interpreted as 
absolute.
1 = The value specified for "Hysteresis" is a percentage value 
of the limit value.

Deadband mode Specifies a constant as value of the hysteresis.

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 
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See also
Exporting alarms (Page 2069)

Importing alarms (Page 2070)

Format of the discrete alarm data

Introduction
This chapter describes the required format of the file for the import of discrete alarms. The file 
containing the discrete alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of the worksheet "Discrete alarms" (discrete alarms). 
Each alarm is assigned a separate line in the import file. Structure of the import file containing 
the discrete alarms:     

Example of the worksheet "Discrete alarms"
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Table 9-24 Meaning of the entries

List entry Meaning
ID Shows the number of the discrete alarm. The alarm number is unique. 
Name Shows the name of the discrete alarm. The name is used to reference an alarm. Alarms 

with identical names are overwritten during import. An alarm without an existing name 
is created.

Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts must 
be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts.

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Parameter: <ref id = 0; type = AlarmDiscreteParameter; Parameter = Parameter 1; Tag 
= HMI_Variable_1; DisplayType = Decimal; Length = 5; Precision = 0; Alignment = 
Right; ZeroPadding = False;>
System parameters: <ref id = 0; type = CommonSystemParameter; System Parameter 
= UserName;>

Class The alarm class of an alarm determines whether or not the alarm has to be 
acknowledged. It can also be used to determine how the alarm appears when it is 
displayed on the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with other 
alarms, it can be acknowledged along with these alarms of the same group in a single 
operation.

Priority Indicates alarm priority. You can sort the alarms in the alarm view by priority. Range: 
0 -16 

CPU number Specifies the CPU number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the "HMI 
alarms" editor.

PLC number Shows the PLC number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the "HMI 
alarms" editor.

Trigger tag Specifies the tag containing the bit that triggers the alarm.
Trigger bit Specifies the number of the bit that triggers the alarm.
Trigger mode Indicates the method used for monitoring the limit value.
Alarm parameter Indicates tag assigned to a parameter block to issue process values in alarm texts.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon acknowledgment. 

Only available if the selected alarm class requires alarm acknowledgment.
Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the alarm.
Single acknowledgment Specifies whether each individual alarm must be acknowledged.

True = Alarms must be acknowledged individually.
Status tag Shows the tag which saves the Incoming and Outgoing alarm statuses and the

Acknowledgement request saved.
Status bit Specifies the number of the bit that is set and acknowledges the alarm.
Alarm annonciation Indicates whether an alarm is being suppressed.

True = suppressed alarm.
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List entry Meaning
Display suppresion mask Indicates the display suppression method.
Additonal Text Shows the additional alarm text.
Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 

information about the alarm. A tooltip will be displayed in a separate window on the 
HMI device when the operator presses the <HELP> key.
The field designation contains a language ID. 

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 2069)

Importing alarms (Page 2070)

9.11.3.4 Importing and exporting tags

Exporting tags

Introduction
WinCC has an export function for tags.     

Requirements
● The WinCC project for the export is open.

● Tags have been created in the project.

● The "HMI tags" editor is open.
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Exporting tags
1. Click on the  button in the "HMI Tags" tab.

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

Importing tags

Introduction
Tags are identified by the tag name. An existing tag will be overwritten with the data from the 
xlsx file if the tag name already exists in the project. A new tag is created if the tag does not 
yet exist.

Requirements
● An xlsx file with tags has been created.

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "HMI tags" editor is open.
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Importing tags
1. Click on the button. The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start.  

Result
The relevant tags have been created in WinCC. Alarms relating to the import operation are 
displayed in the output window. A log file is saved in the source directory of the import files. 
The log file has the same name as the respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a tag a trigger 
tag of the wrong type, for example, string. An error will be reported during compilation.

 

 

Format of the tag data

Introduction
This section describes the format required for the file with tag data used for imports. The tag 
data file must be in "*.xlsx" format. 
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Tag data structure
The import file in Microsoft Excel consists of a number of worksheets:

● HMI Tags (HMI tags)

● Multiplexing (multiplex tags)

Each tag is on a separate line in the import file. The import file with the tag data must have the 
following format:   

Example of the worksheet "HMI Tags"

 

Table 9-25 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag. 
Path Specifies which folders in the project tree contain the tag. The folder structure is 

represented by "\" : "FolderName1\FolderName2\TagName".
PLC Tag Indicates whether the tag is linked to a PLC tag.
Connection Indicates the name of the connection to the PLC.
Data type Specifies the data type of a tag. The data types allowed depend on the 

communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

Length Specifies the length of the tag. This entry is only useful for data types with a 
dynamic length such as strings; it is left empty for all other data types.
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List entry Meaning
Address Specifies the tag address in the PLC. The tag address must exactly match the one 

used in WinCC, for example, "%DB1.DBW0". The tag address is empty for internal 
tags.

Multiplexing Specifies whether multiplexing is used.
Index tag Shows the name of the index tag for multiplexing. 

In Runtime, the system first reads the value of the index tag. It then accesses the 
tag in the corresponding place in the tag list.

StartValue Specifies the start value of a tag. 
ID tag The update ID updates the value of a tag with the aid of a function or a PLC job. 

The update ID must be unique within an HMI device.
Coding Shows the coding method.
DiplayName [de_DE]
 

Shows the display name of an HMI tag. The field designation contains a language 
ID. The field designation contains a language ID. Display names must be assigned 
a language ID for import. Texts are imported to the corresponding project 
language.

Acquisition mode Specifies the tag acquisition mode.
Acquisition cycle Specifies the tag acquisition cycle. The acquisition cycle must correspond exactly 

to the one used in WinCC. The value is not language-dependent and should 
therefore be the same in every language. The default value is "1 s". The acquisition 
cycle is undefined if the tag acquisition mode is "on demand".
User-defined acquisition cycles must be created beforehand as the file will 
otherwise not be imported.

High High Limit type Indicates whether the limit value "High high" is monitored by a constant, a tag or 
not at all.

High High Limit Displays the limit value "High High". 
High Limit type Indicates whether the limit value "High" is monitored by a constant, a tag or not at 

all.
High Limit Displays the limit value "High".
Low Limit type Indicates whether the limit value "Low" is monitored by a constant, a tag or not at 

all.
Low Limit Displays the limit value "Low".
Low Low Limit type Indicates whether the limit value "Low Low" is monitored by a constant, a tag or 

not at all.
Low Low Limit Displays the limit value "Low Low".
Linear scaling Indicates whether linear scaling is enabled. This entry can only be used for external 

tags.
End value PLC Specifies the end value of the PLC tag.
Start value PLC Specifies the start value of the PLC tag.
End value HMI Specifies the end value of the HMI tag.
Start value HMI Specifies the start value of the HMI tag.
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Example of the worksheet "Multiplexing"

Table 9-26 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag which uses indirect addressing. The 

HMI tag must be available in the "HMI Tags" worksheet.
Index Shows the value which governs which tag is selected. 
Multiplex Tag Displays the tag from the tag list corresponding to the index value.

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing tag of the same name. 

 

Format of the tag data 

Introduction
This section describes the format required for the file with tag data used for imports. The tag 
data file must be in "*.xlsx" format. 

Tag data structure
The import file in Microsoft Excel consists of a number of worksheets:

● HMI Tags (tags)

● SubstituteValueUsage (substitute value)

Each tag is on a separate line in the import file. The import file with the tag data must have the 
following format:     
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Example of the worksheet "HMI Tags"

 

Table 9-27 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag. 
Path Specifies which folders in the project tree contain the tag. The folder structure is 

represented by ",": "FolderName1,FolderName2,TagName".
PLC Tag Specifies which PLC tag is linked to the HMI tag.
Connection Indicates the name of the connection.
Date type Specifies the data type of the PLC tag. The data types allowed depend on the 

communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

HMI Data type Specifies the data type of the HMI tag. The data types allowed depend on the 
communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

Length Specifies the length of the tag in bytes. This entry is only useful for data types with 
a dynamic length such as strings; it is left empty for all other data types.

Address Specifies the tag address in the PLC. The tag address must exactly match the one 
used in WinCC, for example, "%DB1.DBW0". The tag address is empty for internal 
tags.

Start Value Specifies the start value of a tag. 
Substitute Value Indicates the substitute value. The substitute value is used when a process value 

with errors is read.
ID tag The update ID updates the value of a tag with the aid of a function or a PLC job 

within a device. The update ID must be unique.
High High Limit type Indicates whether the limit value "High high" is monitored by a constant or not at 

all.
High High Limit Displays the limit value "High High". 
High Limit type Indicates whether the limit value "High" is monitored by a constant or not at all.
High Limit Displays the limit value "High".
Low Limit type Indicates whether the limit value "Low" is monitored by a constant or not at all.
Low Limit Displays the limit value "Low".
Low Low Limit type Indicates whether the limit value "Low Low" is monitored by a constant or not at 

all.
Low Low Limit Displays the limit value "Low Low".
Linear scaling Indicates whether linear scaling is enabled. This entry can only be used for external 

tags.
End value PLC Specifies the end value of the PLC tag.
Start value PLC Specifies the start value of the PLC tag.
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List entry Meaning
End value HMI Specifies the end value of the HMI tag.
Start value HMI Specifies the start value of the HMI tag.

Example of the worksheet "SubstituteValueUsage"

 

Table 9-28 Meaning of the entries

List entry Meaning
Parent Specifies the tag for which a substitute value has been defined. The tag must be 

available in the "HMI-Tags" worksheet.
Substitute Value Usage Indicates the substitute value. The substitute value can be used in the following 

situations:
● As start value
● After communication error
● High High limit value
● Low Low limit value
 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing tag of the same name. 

 

 

9.11.3.5 Importing and exporting text lists

Exporting text lists

Introduction
WinCC has an export function for text lists.     
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Requirements
● The WinCC project for the export is open.

● Text lists have been created in the project.

● The "Text & graphics lists" editor is open.

Exporting text lists
1. Click on the  button in the "TextLists" tab.

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Importing text lists (Page 2092)

Format of text list data (Page 2093)

Importing text lists

Introduction
You then import text lists from an xlsx file to WinCC.

Requirements
● An xlsx file with text lists has been created.

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "Text & graphics lists" editor is open.
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Importing text lists
1. Click on the  button in the "Text lists" tab.

The "Import" dialog box opens.

2. Select the file you want to import under "File selection".

3. Click on the "Import" button. The import will start.  

Result
You have now imported the text lists. The relevant text lists have been created in WinCC. 
Alarms relating to the import operation are displayed in the output window. A log file is saved 
in the source directory of the import files. The log file has the same name as the respective 
import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

See also
Exporting text lists (Page 2091)

Format of text list data

Introduction
This section describes the format required for the file with the text lists used for imports. The 
text list data file must be in "*.xlsx" format. 

Tag data structure
The import file in Microsoft Excel consists of two worksheets:

● TextList (Text lists)

● TextListEntry (Text list entry)

Each text list is assigned a separate line in the import file. The import file containing the data 
must be structured as follows:   
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Example of the worksheet "TextList"

 

Table 9-29 Meaning of the entries

List entry Meaning
Name Shows the name of the text list.
ListRange Shows the text list range:

Number = Bit number (0-31)
Range = value/range (...-...)
Bit = Bit (0;1)

Comment Any comments on the text list. You can use up to 500 characters

Example of the worksheet "TextListEntry"
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Table 9-30 Meaning of the entries

List entry Meaning
Name Shows the name of the text list entry.
Parent Specifies the name of the corresponding text list.
DefaultEntry Indicates whether the text list entry is a default entry. The default entry is always 

displayed when the tag has an undefined value. 
Value Specifies the tag integer values or value ranges which are assigned to the text 

entries in the text list.
Text Shows the text list entry. The field designation contains a language ID. Text list 

entries must be assigned a language ID for import. 
An expression with a reference ID will be added to the text if the text list entry has 
a dynamic parameter. Example: text <field ref="0" />. Use the ID to assign the 
dynamic parameter to a text list entry.

FeldInfo Specifies whether the text list contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = CommonTagDisplayFormat; Tag = tag 1; DisplayType = 
Decimal; DisplayFormat = 9;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textliste_1; Tag = tag 2; 
Length = 5;>
PLC tag: <ref id = 0; type = CommonControlTagDisplayFormat; DisplayType = 
Decimal; DisplayFormat = 9;>

See also
Exporting text lists (Page 2091)

9.11.3.6 Importing and exporting project texts

Importing project texts
Edit the xlsx file or send it to a translator. Import the texts once they have been translated. The 
foreign languages will be imported to the relevant object in the project.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Importing project texts 
To import a project text file, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The lower-level elements will be displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Click on the  button. The "Import" dialog opens.
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4. Select the path and file name of the import file from the "Import file" field.

5. Activate the "Import source language" check box if you have made changes to the source 
language in the export file and would like to overwrite the entries in the project with the 
changes.

6. Click on "Import".

Result
You have imported the project texts.

Exporting project texts
Project texts are exported for translation. Texts are exported to Office Open XML files ending 
in ".xlsx". These files can be edited in Microsoft Excel, for example.

You can exchange the file with the translators and import it back to the project as soon as it 
has been translated.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Exporting project texts
To export individual project texts, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The child elements are displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Select the texts you want to export.
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4. Click on the  button. The "Export" dialog opens.

5. From the "Source language" drop-down list, select the language from which you wish to 
translate, for example Italian.

6. From the "Target language" drop-down list, select the language into which the texts are to 
be translated, for example, French.

7. Enter a file path and a file name for the export file in the "Export file" input field.

8. Click "Export".

Result
The texts selected in the "Project texts" editor are written to an xlsx file. The xlsx file will be 
stored in the specified folder. 
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You can alternatively select and export all project texts from categories. Select "User texts" or 
"System texts" in the "Export" dialog in line with the type of texts you wish to export. In this 
case, export can additionally be limited by categories.

 

 Note

Project texts in library objects cannot be exported.
 

9.11.4 Using cross-references

9.11.4.1 General information about cross references

Introduction   
The cross-reference list provides an overview of the use of objects within the project.

Uses of cross-references
The cross-reference list offers you the following advantages:

● When creating and changing a program, you retain an overview of the objects, tags, and 
alarms etc. you have used.

● From the cross-references, you can jump directly to the object location of use.

● You can learn the following when debugging:

– The objects used in a specific screen.

– The alarms and recipes shown in a specific display.

– The tags used in a specific alarm or object.

● As part of the project documentation, the cross-references provide a comprehensive 
overview of all object, alarms, recipes, tags and screens.

See also
HMI device wizard basics (Page 2060)

9.11.4.2 Displaying the cross-reference list

Introduction
Details on the use of objects can be found in the cross-reference list. You can show cross-
references for HMI devices, folders and all editors in the project tree. The detail view also lets 
you select individual objects of the editors.
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Requirement
You have created a project.

Several objects have been created.

Procedure     
1. Select the required entry in the project tree or detail view.

2. Select "Cross-references" in the shortcut menu. The cross-reference list is opened in the 
work area.

3. Open the "Used by" tab to display where the objects shown in the cross-reference list are 
used.

4. Open the "Used" tab to view the users of the objects displayed in the cross-reference list.

5. You can sort the entries in the "Object" column in ascending or descending order by clicking 
on the corresponding column header.

6. To go to the location of use for a specific object, click on the displayed link.

Result
The cross-reference list for the selected object is displayed in the work area.

9.11.4.3 Structure of the cross-reference list

Views of the cross-reference list 
There are two views of the cross-reference list. The difference between the two views is in the 
objects displayed in the first column:

● Used by:
Display of the referenced objects. Here, you can see where the object is used.

● Used:
Display of the referencing objects. The users of the object are shown here.

The assigned tool tips provide additional information about each object.

Structure of the cross-reference list

Column Content/meaning
Object Name of the object that uses the lower-level objects or that is being 

used by the lower-level objects.
Numbers Number of uses
Location of use Each location of use, for example, an object or event
Property Function of the referenced objects, for example, tag for data record or 

process value
Connected to PLC tag with which the object is connected.
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Column Content/meaning
Type Type of object 
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references. 

Settings in the cross-reference list
You can make the following settings using the icons in the toolbar for the cross-reference list:

● Update cross-reference list
Updates the current cross-reference list.

● Making settings for the cross-reference list
Here, you specify whether all used, all unused, all defined or all undefined objects will be 
displayed. If the "Undefined objects" option is enabled, references to previously deleted 
objects are also displayed.

● Collapse entries
Reduces the entries in the current cross-reference list by closing the lower-level objects.

● Expand entries
Expands the entries in the current cross-reference list by opening the low-level objects.

Sorting in the cross-reference list
You can sort the entries in the "Object" column in ascending or descending order. Click on the 
column header to do this. 

9.11.4.4 Displaying cross-references in the Inspector window

Introduction
The Inspector window displays cross-reference information about a selected object in the "Info 
> Cross-references" tab. The Inspector window displays the cross-reference information in 
tabular format. 

Requirement
You have created a project.

Several objects have been created.
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Procedure   
1. Select an object in a screen or a tabular editor.

2. Select "Cross-reference information" in the shortcut menu. The cross-references are 
opened in the Inspector window.

Result
The instances where and the other objects by which the selected object is being used are 
displayed. 

The table below shows the additional information listed in the "About > Cross-reference" tab:

Column Meaning
Object Name of the object that uses the lower-level 

objects or that is being used by the lower-level 
objects.

Numbers Number of uses
Location of use Each location of use, for example an object or 

event
Property Function of the referenced objects, for example 

tag for data record or process value
Connected to PLC tag with which the object is connected.
Type Type of object
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references.
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9.11.5 Managing languages

9.11.5.1 Languages in WinCC

User interface language and project languages
A distinction is drawn between two different language levels in WinCC:

● User interface language
During configuration, the text in the WinCC menus and dialogs is displayed in the user 
interface language. The user interface language also affects the labeling of operating 
elements, the parameters of the system functions, the online help, etc. 

● Project languages
Project languages are all languages in which a project will later be used. Project languages 
are used to create a project in multiple languages. 

The two language levels are completely independent of one another. For example, you can 
create English projects at any time using a German user interface and vice versa.

Project languages
The following languages are differentiated within the project languages:

● Reference language
The reference language is the language that you use to configure the project initially.
During configuration, you select one of the project languages as the reference language. 
You use the reference language as a template for translations. All of the texts for the project 
are first created in the reference language and then translated. While you are translating 
the texts, you can have them displayed simultaneously in the reference language.

● Editing language
You produce translations of the texts in the editing language. 
Once you have created your project in the reference language, you can translate the texts 
into the remaining project languages. Select a project language respectively as an edit 
language and edit the texts for the appropriate language variant. You can change the editing 
language at any time.

 

  Note

When switching the project languages, the assignment to the keys on the keyboard also 
changes. For some languages (for example, Spanish), the operating system does not 
allow you to switch to the corresponding keyboard assignment. In this case, the keyboard 
assignment is switched to English. 

 

● Runtime languages
Runtime languages are those project languages that are transferred to the HMI device. You 
decide which project languages to transfer to the HMI device depending on your project 
requirements. 
You must provide appropriate controls so that the operator can switch between languages 
in runtime. 
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See also
Language settings in the operating system (Page 2103)

Operating system settings for Asian languages (Page 2104)

Selecting the user interface language (Page 2105)

"Graphics" editor (Page 2116)

Languages in Runtime (Page 2120)

Example: Configuring a button for language switching (Page 2127)

HMI device wizard basics (Page 2060)

9.11.5.2 Language settings in the operating system

Introduction
The configuration PC operating system settings influence WinCC language management in 
the following areas:  

● Selection of project languages

● Regional format of dates, times, currency, and numbers

● Displaying ASCII characters

Project language selection
A language is not available as a project language unless it is installed in the operating system. 

Regional format of dates, times, currency, and numbers
WinCC specifies a fixed date and time format in the Date - Time field for the selected project 
language and runtime language.

In order for dates, times, and numbers to be presented correctly in the selected editing 
language, this language must be set in the Regional Options in the Control Panel.   

Displaying ASCII characters
With text output fields, the display of ASCII characters as of 128 depends on the set language 
and the operating system being used.

If the same special characters are to be displayed on different PCs, the PCs must use the 
same operating system and regional settings.

See also
Languages in WinCC (Page 2102)

Operating system settings for Asian languages (Page 2104)
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9.11.5.3 Operating system settings for Asian languages

Settings on Western operating systems
If you want to enter Asian characters, you must activate the support for this language in the 
operating system.   

The Input Method Editor (IME) is available in Windows for configuring Asian texts. Without this 
editor, you can display Asian text but not edit it. For more information on the Input Method 
Editor, refer to the documentation for Windows. To enter Asian characters when configuring, 
switch to the Asian entry method in the "Input Method Editor".

Switch the operating system to the appropriate language to have language-specific project 
texts, such as alarm texts, displayed in the simulator in Asian characters.

Settings on Asian operating systems
If you are configuring on an Asian operating system, you must switch to the English default 
input language to enter ASCII characters, for example, for object names. As the English default 
input language is included in the basic installation of the operating system, you do not need 
to install an additional input locale.    

Enable language support
1. Open the system controller.

2. Select "Regional and Language Options".

3. On the "Languages" tab, activate the check box "Install files for East Asian languages".

4. Then click on "Details" under "Text Services and Input Languages". The dialog "Text 
Services and Input Languages" is opened.

5. On the "Settings" tab add the required default input language under the "Installed Services".

6. Select the language of the operating system in the "Language for non-Unicode programs" 
area in the "Advanced" tab.

See also
Languages in WinCC (Page 2102)

Language settings in the operating system (Page 2103)
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9.11.5.4 Setting project languages

Selecting the user interface language

Introduction
The user interface language is used for displaying menu entries, title bars, infotexts, dialog 
texts and other designations in the WinCC user interface. 

You can switch between the installed user interface languages during configuration. The 
labeling of the operating elements remains in the language you set when you added the object 
even if you change the user interface language. 

Procedure
1. Select "Options > Settings" in the menu.

The "Settings" dialog box is opened.

2. Select the desired user interface language under "General > General settings".

Result
WinCC will use the selected language as user interface language. 

See also
Enable project languages (Page 2105)

Selecting the reference language and editing language (Page 2106)

Languages in WinCC (Page 2102)

Enable project languages

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. 
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Enable project languages
1. Click on the arrow to the left of "Languages & resources" in the project tree.

The lower-level elements will be displayed.

2. Double-click on "Project languages".
The possible project languages will be displayed in the working area.

3. Enable the relevant project languages.   
 

  Note
Copying multilingual objects

The copies of multilingual objects to a different project only include text objects in the 
project languages which are activated in the target project. Activate all project languages 
in the target project to include the corresponding text objects when transferring the copy.

 

Disabling project languages
1. Disable the languages which are not relevant for the project.   

 

 
 CAUTION

If you disable a project language, all text and graphic objects you have already created 
in this language will be deleted from the current project.

 

See also
Selecting the user interface language (Page 2105)

Selecting the reference language and editing language (Page 2106)

Selecting the reference language and editing language

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. You can change 
the editing language at any time.

Requirements
The "Project languages" editor is open.

Several project languages have been activated.

Selecting the reference language and editing language
1. Click the arrow in the drop-down list in the "General > Editing language" section.    

2. Click on the required language in the drop-down list, for example, German.
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3. Click on the arrow in the drop-down list in the "General > Reference language" section.

4. Click on the required language in the drop-down list, for example, English.

The language selection is displayed in the list box.

Result
You have now selected the editing and reference languages.

If you change the editing language, all future text input will be stored in the new editing 
language.

 

See also
Selecting the user interface language (Page 2105)

Enable project languages (Page 2105)
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9.11.5.5 Creating one project in multiple languages

Working with multiple languages

Multilingual configuration in WinCC
You can configure your projects in multiple languages using WinCC. There are various grounds 
for creating a project in multiple languages:

● You would like to use a project in more than one country.
You create the project in multiple languages but when the HMI device is commissioned, 
only the language spoken by the operators at the respective site will be transferred to the 
HMI device.

● The operators of a system speak a range of different languages.
Example: An HMI device is used in China, but the service personnel understand only 
English.   

Translating project texts
With WinCC, you can enter project texts directly in several languages in various different 
editors, for example, in the "Project texts" editor. WinCC also allows you to export and import 
your configuration for translation purposes. This is particularly advantageous if you configure 
projects containing a large amount of text and want to have it translated.

Language management and translation in WinCC
The following editors are used to manage languages and translate texts in WinCC:  

Editor Short description
Project languages Selection of project languages, editing language and reference 

language.
Languages and fonts Management of runtime languages and fonts used on the HMI device.
Project texts Central management of configured texts in all project languages.
Graphics Graphic library for managing graphics and their language-specific 

versions.

See also
Project text basics (Page 2109)

Translating texts directly (Page 2110)

Translating texts using reference texts (Page 2112)

Exporting project texts (Page 2113)

Importing project texts (Page 2115)
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Project text basics

Texts in different languages in the project  
Texts that are output on display devices during processing are typically entered in the language 
in which the automation solution is programmed. Comments and the names of objects are also 
entered in this language.

If operators do not understand this language, they require a translation of all operator-relevant 
texts into a language they understand. You can therefore translate all the texts into any 
language. In this way, you can ensure that anyone who is subsequently confronted with the 
texts in the project sees the texts in his/her language of choice.

User texts and system texts   
In the interests of clarity, a distinction is drawn between user texts and system texts:

● User texts are texts created by the user.

● System texts are texts created automatically and which are a product of configuration in 
the project.

The project texts are managed in the project text editor. This can be found in the project tree 
under "Languages & Resources > Project texts".

Examples of multilingual project texts
You can, for example, manage the following types of text in more than one language:

● Display texts

● Alarm texts

● Comments in tables

● Labels of screen objects

● Text lists

Translating texts
There are two ways of translating texts.

● Translating texts directly
You can enter the translations for the individual project languages directly in the "Project 
texts" editor.

● Translating texts using reference texts
You can change the editing language for shorter texts. You can enter the new texts in the 
editing language while the texts of the reference language are displayed. 
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See also
Working with multiple languages (Page 2108)

Translating texts directly (Page 2110)

Translating texts using reference texts (Page 2112)

Exporting project texts (Page 2113)

Importing project texts (Page 2115)

Translating texts directly

Translating texts  
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● You are in the project view.

● A project is open.

● You have selected at least two further project languages.
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Procedure
Proceed as follows to translate individual texts:

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project texts".
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

3. To group identical texts and translate them simultaneously, click on the " " button in the 
toolbar.

4. To hide texts that do not have a translation, click on the  button in the toolbar.

5. Click on an empty column and enter the translation.

Result
You have translated individual texts in the "Project texts" editor. The texts will then be displayed 
in the runtime language.
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See also
Working with multiple languages (Page 2108)

Exporting project texts (Page 2113)

Project text basics (Page 2109)

Importing project texts (Page 2115)

Translating texts using reference texts

Introduction  
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for this language, the input boxes are empty 
or filled with default values.

If you enter text again in an input field, this is saved in the current editing language. Following 
this, the texts exist in two project languages for this input field, in the previous editing language 
and in the current editing language. This makes it possible to create texts in several project 
languages.

You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

Requirement
There is at least one translation into a different project language for an input field.

Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. Select "Tasks > Languages & resources" in the task card.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text block, translations that already exist in 
other project languages are shown in the "Tasks > Reference text" task card.

See also
Working with multiple languages (Page 2108)

Exporting project texts (Page 2113)

Project text basics (Page 2109)

Importing project texts (Page 2115)
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Exporting project texts
Project texts are exported for translation. Texts are exported to Office Open XML files ending 
in ".xlsx". These files can be edited in Microsoft Excel, for example.

You can exchange the file with the translators and import it back to the project as soon as it 
has been translated.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Exporting project texts
To export individual project texts, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The child elements are displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Select the texts you want to export.
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4. Click on the  button. The "Export" dialog opens.

5. From the "Source language" drop-down list, select the language from which you wish to 
translate, for example Italian.

6. From the "Target language" drop-down list, select the language into which the texts are to 
be translated, for example, French.

7. Enter a file path and a file name for the export file in the "Export file" input field.

8. Click "Export".

Result
The texts selected in the "Project texts" editor are written to an xlsx file. The xlsx file will be 
stored in the specified folder. 
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You can alternatively select and export all project texts from categories. Select "User texts" or 
"System texts" in the "Export" dialog in line with the type of texts you wish to export. In this 
case, export can additionally be limited by categories.

 

 Note

Project texts in library objects cannot be exported.
 

See also
Working with multiple languages (Page 2108)

Translating texts using reference texts (Page 2112)

Translating texts directly (Page 2110)

Project text basics (Page 2109)

Importing project texts (Page 2115)

Importing project texts
Edit the xlsx file or send it to a translator. Import the texts once they have been translated. The 
foreign languages will be imported to the relevant object in the project.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Importing project texts 
To import a project text file, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The lower-level elements will be displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Click on the  button. The "Import" dialog opens.

4. Select the path and file name of the import file from the "Import file" field.

5. Activate the "Import source language" check box if you have made changes to the source 
language in the export file and would like to overwrite the entries in the project with the 
changes.

6. Click on "Import".

Result
You have imported the project texts.
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See also
Exporting project texts (Page 2113)

Working with multiple languages (Page 2108)

Project text basics (Page 2109)

Translating texts directly (Page 2110)

Translating texts using reference texts (Page 2112)

9.11.5.6 Using language-specific graphics

"Graphics" editor

Introduction
You use the "Graphics" editor to manage the configured graphic objects in different language 
versions. Multilingual projects sometimes also require language-specific versions of the 
graphics, for example, if

● the graphics contain text;

● cultural aspects play a role in the graphics.

Opening the "Graphics" editor
Double-click on "Languages and resources" in the project tree.    

Work area
The work area displays all configured graphic objects in a table. There is a separate column 
in the table for each project language. Each column in the table contains the versions of the 
graphics for one particular language.

In addition, you can specify a default graphic for each graphic to be displayed whenever a 
language-specific graphic for a project language does not exist.

Preview
The preview shows you how the graphics will look on various devices. 

See also
Storing external graphics in the graphics library (Basic, Advanced, Professional) (Page 2118)

Storing graphics in the graphics library (Basic, Advanced, Professional) (Page 2117)

Languages in WinCC (Page 2102)
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Storing graphics in the graphics library (Basic, Advanced, Professional)

Introduction
You use the "Graphics" editor to import graphics you want to use in screens in the "Screens" 
editor. It also allows you to manage language-specific versions of graphics. A preview shows 
the graphic displays on various HMI devices.   

Requirement
● The language-dependent versions of a graphic are available.

● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

Inserting graphics
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Select the required graphic file.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Add graphic" from the shortcut menu. A dialog box opens.

6. Select the desired graphic file and click "Open."
The language-dependent version is inserted in the table in place of the reference language 
graphic. 

7. Then, in the "Default graphic" column, import a graphic to be displayed in runtime for those 
languages for which there is no language-specific graphic.

You can also drag&drop a graphic from Windows Explorer to the relevant position in the 
"Graphics library" table.

Displaying graphics in the HMI device preview
1. Click on a graphic in the table.

2. Select the required HMI device under "Properties > Graphics settings > Device preview" in 
the Inspector window.
The graphic will then be displayed as it will appear in runtime on the selected HMI device.

Result
The graphics added are available in the "Graphics" editor. The graphic assigned to the 
respective editing language will be displayed during editing. The default screen will be 
displayed in all editing languages for which no screen has been imported.
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The screens assigned to the respective runtime language are displayed during runtime. The 
default screen is displayed in all runtime languages for which a screen has not been imported.

 

 Note

If you disable a project language, all of the graphic objects you have already created in this 
language will be deleted from the current project. 

 

See also
"Graphics" editor (Page 2116)

Storing external graphics in the graphics library (Basic, Advanced, Professional)

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

● There is a graphic in the "Graphics" editor.

Creating and adding a new graphic as an OLE object
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Navigate to the folder in which the graphic is stored.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

6. Select "Insert object > Create new" and an object type in the dialog.

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
2118 System Manual, 08/2011,  



7. Click "OK." The associated graphic program is opened.

8. Close the graphics program once you have created the graphic.
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.

Inserting created graphics in WinCC
1. Click in the corresponding cell of a language for which a language-dependent version of 

this graphic exists.

2. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

3. From the "Insert object" dialog box, select "Create from file."

4. Click the "Browse" button.

5. Navigate to the created graphic and select it.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
 

Result
The OLE objects added are available in the "Graphics" editor. 

Versions of the graphics for the current editing language are displayed in the "Screens" editor. 
The default graphic is displayed in all editing languages for which no screen has been imported.

The graphic is displayed in runtime in the set runtime language. The default graphic is displayed 
in all runtime languages for which no graphic has been imported.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. 

See also
"Graphics" editor (Page 2116)
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9.11.5.7 Languages in runtime

Languages in Runtime

Using multiple runtime languages
You can decide which project languages are to be used in runtime on a particular HMI device. 
The number of runtime languages that can be available at one time on the HMI device depends 
on the device. To enable the operator to switch between languages during runtime, you must 
configure a corresponding operator control. 

When runtime starts, the project is displayed according to the most recent language setting. 
When runtime starts the first time, the language with the lowest number in the "Order for 
language setting" is displayed.

Setting runtime languages during configuration
In the "Languages and Fonts" editor you can specifiy: 

● The project languages to be available as runtime languages for the respective HMI device.

● The order in which the languages are to be switched.

See also
Methods for language switching (Page 2120)

Enabling the runtime language (Page 2121)

Setting the runtime language order for language switching (Page 2123)

Setting the default font for a runtime language (Page 2125)

Selecting the log language (Page 2126)

Languages in WinCC (Page 2102)

Methods for language switching

Introduction
You need to configure language switching if you want to have multiple runtime languages 
available on the HMI device. This is necessary to enable the operator to switch between the 
various Runtime languages. 
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Methods for language switching
You can configure the following methods for language switching:

● Direct language selection
Each language is set by means of a separate button. In this case, you create a button for 
each Runtime language.

● Language switching
The operator switches the languages using a button.

Regardless of the method used, the button names must be translated into each of the 
languages used. You can also configure an output field that displays the current language 
setting.

See also
Languages in Runtime (Page 2120)

Selecting the log language (Page 2126)

Enabling the runtime language (Page 2121)

Setting the runtime language order for language switching (Page 2123)

Setting the default font for a runtime language (Page 2125)

Enabling the runtime language

Introduction
The "Language & Font" editor shows all project languages available in the project. Here you 
select which project languages are to be available as runtime languages on the HMI device.  

Requirements
Multiple languages have been enabled in the "Project languages" editor.
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Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Select the following languages:

– German

– Chinese

– French

Result
You have now set three runtime languages. A number is automatically assigned to each 
language in the "Order" column. The enabled runtime languages are transferred with the 
compiled project to the HMI device. 

If the number of languages selected exceeds the number that can be transferred to the HMI 
device, the table background changes color.
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See also
Languages in Runtime (Page 2120)

Selecting the log language (Page 2126)

Setting the runtime language order for language switching (Page 2123)

Methods for language switching (Page 2120)

Setting the runtime language order for language switching

Introduction
You specify the language order for runtime language switching. The first time runtime starts, 
the project is displayed in the language with the lowest number in the "Order" column.   

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● "Language & Font" is open in the editor and three runtime languages have been set in the 
following order:
1. German
2. Chinese
3. French
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Procedure
1. Select the runtime language "German".

2. Click the button. The runtime language "German" will move down a place. The number 
will automatically be changed to "2" in the "Order" column.

Result
You have changed the order of runtime languages. The first time runtime starts, the project 
will be displayed in the language with the smallest number, in other words Chinese. If the 
language is switched, this will happen in numerical order.

See also
Languages in Runtime (Page 2120)

Selecting the log language (Page 2126)

Enabling the runtime language (Page 2121)

Setting the default font for a runtime language (Page 2125)

Methods for language switching (Page 2120)
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Setting the default font for a runtime language

Introduction
You can specify the font used to display the texts for each runtime language on the HMI device 
in the "Language & Font" editor. The default font is used in all texts, such as dialog texts, for 
which you cannot define a specific font.   

WinCC offers only fonts supported by the HMI device.

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● Three runtime languages have been enabled in the "Language & Font" editor.
1. Chinese
2. German
3. French

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font". The table shows the runtime languages and fonts set.

3. Click in the "French" row in the "Default font" column.

4. Select the font to be used by default if a font cannot be selected for a given text.

Result
The project texts for the runtime language "French" are displayed on the HMI device in the 
selected font.

These fonts are transferred to the HMI device during a transfer operation. 

The default font is also used for the representation of dialogs in the operating system of the 
HMI device. Select a smaller font as default if the full length of the dialog texts or headers is 
not displayed.

See also
Languages in Runtime (Page 2120)

Selecting the log language (Page 2126)

Setting the runtime language order for language switching (Page 2123)

Methods for language switching (Page 2120)
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Selecting the log language

Introduction
In the "Runtime settings > General" editor, select the language to be used for writing to logs 
in runtime.       

Requirements
● The languages used in your project are activated in the "Project languages" editor, for 

example "German" and "English" .

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Activate the runtime languages, for example, "German" and "English".

4. Specify the "order":

– 1 German

– 2 English

5. Click on "Runtime settings > General".

6. Select "German" for "Logs > Log language".

Result
After loading, the project will start in the runtime language "German". The logs are now written 
in German. During runtime, the operator switches the runtime language to English. The logs 
will still to be written in German.

See also
Languages in Runtime (Page 2120)

Setting the default font for a runtime language (Page 2125)

Setting the runtime language order for language switching (Page 2123)

Methods for language switching (Page 2120)

Enabling the runtime language (Page 2121)
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9.11.5.8 Example of multilingual configuration

Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.

Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 

See also
Example: Configuring a button in multiple languages (Page 2127)

Example: Configuring a button for language switching for each runtime language 
(Page 2128)

Languages in WinCC (Page 2102)

Example: Configuring a button in multiple languages

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2127



Requirements
● The languages "German" and "English" have been enabled in the "Project languages" 

editor.

● German has been set as editing and reference language.

● You have created and opened the "Screen_1" screen.

● The Inspector window is open.

Procedure
1. Drag-and-drop a button from the "Tools" task card into the screen.

The button will be added to the screen.

2. In the Inspector window, open "Properties > Properties > General".

3. Enter the text ""Sprache umschalten" under "Text > off".

4. Press <Enter> to confirm. The button is named.

5. Open the "Tasks" task card.

6. Select "English" under "Languages & Resources > Editing language".

7. Enter the label "Switch Language" under "Properties > Properties > General > Text > Off" 
in the Inspector window.

Result
The button name is configured in German and English language. The button name 
corresponding with the current Runtime language is shown in Runtime. 

See also
Example: Configuring a button for language switching (Page 2127)

Example: Configuring a button for language switching for each runtime language 
(Page 2128)

Example: Configuring a button for language switching for each runtime language

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
2128 System Manual, 08/2011,  



Requirements
● The following languages have been enabled in the "Project languages" editor

– German

– English

– Italian

● All languages have been set as runtime languages in the "Runtime settings > Language & 
Font" editor.

● You have created and opened the "Screen_1" screen.

● Three buttons have been created on the screen:

– Button_1 labelled "Deutsch"

– Button_2 labelled "English"

– Button_3 labelled "Italiano"

● The Inspector window is open.

Procedure
1. Select "Button_1".

2. In the Inspector window, select "Properties > Events > Press".

3. Click on <Add function> in the table.

4. Select the "SetLanguage" system function.

5. Click on the "Switch" field.

6. Click on the button.

7. Select "Runtime language". The field will be highlighted in red.

8. Select "German" from the drop-down list.

9. Repeat steps 1 - 8 for the other two buttons and select the corresponding runtime language.

Result
You have configured three buttons for switching language in runtime. Each button will switch 
to a different runtime language. For example, clicking on the "English" button during runtime 
will switch the runtime language to English.

See also
Example: Configuring a button for language switching (Page 2127)

Example: Configuring a button in multiple languages (Page 2127)
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9.11.6 Replacing devices

9.11.6.1 Basics

Introduction
You can use existing configurations for new devices and optimize these configurations with 
little manual effort.

All data configured by you is retained in the configuration data. This means you do not need 
to copy individual objects of one device and paste them to another. 

Principle  
The following applies when you replace devices:

● Only functions supported by the new device are available. Only configuration data 
supported by the new device are displayed.
This affects 

– recipes,

– objects available on the screens,

– available system functions,

– available communication logs, etc.

● The number of supported objects, such as screens or tags, may be limited on the new 
device. If the existing objects exceed the limitations on the new device, the objects are 
displayed in full. The objects are, however, highlighted in color in the individual editors. An 
error is generated when the project data is compiled.
Manual post processing is required when switching to a device with fewer features.
Example: Limited number of connections  
All connections will be highlighted in color as invalid if fewer connections are supported on 
the new device than have been configured. Delete any excess connections.

 

 Note

If you replace a Panel and select a PC Station as your new device, for example, WinCC 
Runtime Advanced will automatically be moved below the PC Station in the project tree.
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See also
Device-specific functions (Page 2131)

Example: Replacing devices (Page 2142)

Basics (Page 2144)

HMI device wizard basics (Page 2060)

Engineering system (Page 2380)

Basic Panel (Page 2382)

Panel (Page 2385)

Mobile Panel (Page 2389)

Multi Panel (Page 2393)

Comfort Panel (Page 2397)

WinCC Runtime Advanced (Page 2400)

9.11.6.2 Device-specific functions

Device-specific functions

Functions dependent on the device
Functions dependent on the device are implemented as follows:

● Colors
The color is changed automatically when you switch from a device with full color display to 
one with a smaller color range. 
If you change the color manually and then change back again to a device with a larger 
range of colors, the reduced range of colors will be retained.

● Fonts
Any configured font not available on a device will be replaced by a similar one or by the 
configured default font. The default font depends on the device selected. 

● Character sets with different font sizes
Avoid using too many different font sizes when configuring the following devices:

– OP 73

– OP 77A

– TP 177A

A character set is downloaded to the device for each font size. Check the Inspector window 
during compilation to see how much of the device memory is being used by the character 
sets.
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● Font size
Use small Windows fonts to display the text on devices. If you use large Windows fonts, 
then, depending on the size of the display, the text will not be displayed in full.
Using font sizes of 28 pixels or more for the OP 77A and TP 177A devices will affect device 
performance. 
The character scope is much greater for Asian languages. The use of different font sizes 
therefore has serious implications on the memory requirements of all devices.
Use the same font type for all large characters throughout the project to ensure effective 
and efficient configuration.

● Screens and screen objects
If the new device supports a different resolution than the previous device when you replace 
a device, there are several ways to adjust the screens.
Adjust the size of the screens to the new device in the menu under "Options > Settings > 
Visualization > Fit to size screen".

See also
Basics (Page 2130)

Key assignment when replacing devices (Page 2132)

Key assignment when replacing devices (Page 2134)

Screen adjustment options (Page 2136)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.

Example: Replacing a KTP1000 Basic with a KTP600 Basic
You have configured a function for F2 in KTP1000 Basic. This function is triggered by F2 
following replacement with a KTP600 Basic.

If you have used F7 in a KTP1000 Basic, this function will no longer be available if the panel 
is replaced with a KTP600 Basic.
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Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK

● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2133



 

See also
Key assignment when replacing devices (Page 2134)

Device-specific functions (Page 2131)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys to the left and right of the display are mapped from top to bottom to the new 
device. If the new device has fewer keys, the keys it does not have are not mapped. The 
function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.       

Example: Exchange MP 377 with KP700 Comfort 
You have configured a function on key S3 on the MP 377. This function is triggered by F5 if 
the panel is replaced with an KP700 Comfort.

If you use the S8 key on an MP 377, this function is no longer available when the panel is 
replaced with a KP700 Comfort.
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Mapping K-keys
K-keys are only mapped to the same K-keys in the new device, e.g. K5 to K5.     

If the new device has no K keys, configurations for the K keys are lost.
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If you replace a KP700 with an OP 277,for example, the F1 - F14 keys are retained. The 
configuration of the K keys is lost, because the KP700 has no K keys.

 

Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK

● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN

Exception
"HELP" is triggered by "SHIFT+ ESC" on OP 73.

See also
Key assignment when replacing devices (Page 2132)

Device-specific functions (Page 2131)

9.11.6.3 Adjust screens to the new device

Screen adjustment options

Introduction
Select fit to size for screens before you replace a device. Fit to size is particularly important 
when switching devices with different display resolutions.
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Screen adjustment when replacing devices
Adjust the size of the screens to the new device in the menu under "Options > Settings > 
Visualization > Fit to size screen".

Select one of the following settings.

None
The screens are not scaled. The objects in the screen retain their position and size.

This option may result in objects being outside the configurable area if the display of the new 
device is smaller than the old one. 

Adjusting the width and height to the new device
The position and object size are adjusted to the new display size. Adjustment takes place along 
the x-axis and the y-axis. Graphics and font size are adjusted accordingly. 

Object adjustment to content can be prevented for objects such as graphic views or text fields. 
 

 Note

The objects are distorted if you replace a device with a landscape format display with a device 
with a portrait format display. The difference in display format can, for example, result in object 
labels being cut off and content not being fitted to the object. You must therefore adjust the 
screens to the new device once you have replaced devices.

 

Fit screen to window height
The aspect ratio is maintained and the screens are adjusted to the height of the new device.

Use this option when you are replacing a device with display format 4:3, for example, with a 
device with widescreen. 
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Fit screen to window width
The aspect ratio is maintained and the screens are adjusted to the width of the new device.

Use this option when you are replacing a device with widescreen, for example, with a device 
with display format 4:3. 

Free scale factor
You select a free scale factor for screen adjustment. You can specify a factor for the x-axis 
and the y-axis. 

Using a free scale factor of < 1 may distort the objects. Object labels may, for example, be cut 
off and the content may not be fitted to the object.

You must therefore adjust the screens to the new device once you have replaced devices. 

 
 

 Note

The aspect ratio is not adjusted for objects with a fixed aspect ratio, for example, gauge, 
circle. The objects are displayed on the new device with the same aspect ratio as prior to the 
replacement of the device. 

 

See also
Specifying the position of screen objects (Page 2139)

Fit objects to contents

Introduction
For some objects, you can specify fit to respective content in the Inspector window, for example:

● Text field: fit to text content

● I/O field: fit to text content

● Symbolic I/O field: fit to text content or to text list

● Graphic view: fit to included graphic

Fit to size for text and graphic objects
Disable automatic fit to size of the individual objects in the menu under "Options > Settings > 
Visualization > Resize screen and screen objects > Fit to content". This results in scaling of 
the objects as specified under "Options > Settings > Visualization > Resize screen and screen 
objects".

Select the objects which are not automatically fitted to size.
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● If "Disable 'fit to size' for text objects" is activated, automatic fit to size is ignored in the text 
object properties.
If you have activated "Fit screen to window height", the text field along with the other objects 
is scaled in accordance with the height of the new device.

● If "Disable 'fit to size' for graphic objects" is activated, automatic fit to size is ignored in the 
graphic object properties.
If you have activated "Fit screen to window width", the graphics view along with the other 
objects is scaled in accordance with the width of the new device.

 

 Note

The settings have no effect on screen objects whose size cannot be changed, such as alarm 
indicators or screen objects with a fixed aspect ratio. 

 

"Disable 'fit to size' for text objects" and "Disable 'fit to size' for graphic objects" have no effect 
if:

- You have activated "Resize screen and screen objects > None".

- You have activated "Fit screen to window width and height" and the new device has the same 
resolution as the current device.

- You have activated "Fit screen to window height" and the new device has the same resolution 
as the current device.

- You have activated "Fit screen to window width" and the new device has the same resolution 
as the current device. 

See also
Specifying the position of screen objects (Page 2139)

Specifying the position of screen objects

Introduction
There are various ways to adjust the position of screen objects to the new device.
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Select position
Adjust the position of the screen objects to the new device in the menu under "Options > 
Settings > Visualization > Fit to size screen > Select position".

Example
The following option aligns the objects with the top left edge.

The following object centers the objects in the middle of the screen.

See also
Screen adjustment options (Page 2136)

Fit objects to contents (Page 2138)

9.11.6.4 Example: Replacing devices

Example: Procedures overview

Introduction
In the following example you replace a TP177 B 6'' PN/DP with a TP700 Comfort.

Procedures overview
The procedure when replacing a device is as follows:

1. Adjust screens to the new device

2. Replacing devices

See also
Example: Adjusting screens (Page 2141)

Example: Replacing devices (Page 2142)
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Example: Adjusting screens

Introduction
Adapt the screen before you replace a device. Screen adaptation is required as the display 
formats are different.

The TP 177B format is 320 x 240 pixels while the format of the TP700 Comfort is 800 x 480 
pixels. 

Requirements
● A project is open.

● The TP 177B 6'' PN/DP device is used in the project.

Adjusting screens
1. Open the "Options > Settings" menu.

2. Click on "Visualization > Fit screen to size".

3. Select "Fit screen to window height".

4. Select "Disable fit to size for text objects".

5. Select "Disable fit to size for graphical objects".

Result
You have carried out screen adjustment in preparation for replacing devices. 

See also
Example: Replacing devices (Page 2142)

Example: Procedures overview (Page 2140)
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Example: Replacing devices

Introduction
The following example shows you how to replace a device. 

Requirements
● A project has been created and opened.

● The TP 177B 6'' PN/DP device is used in the project.

Procedure
1. Double-click on "Devices & Networks" in the project tree. The editor will open.

2. Click on the "TP 177B" device.

3. Select "Replace device" in the device shortcut menu. A dialog box opens.
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4. Select the TP700 Comfort device.
Details of hardware differences can be found in the "Compatibility information".

5. Click on the "OK" button. Device replacement is started.

Result
You have replaced the TP 177B device used in the project. You now use the TP700 Comfort 
device. 

See also
Example: Procedures overview (Page 2140)

Basics on migration (WinCC flexible) (Page 92)

Basics (Page 2130)

Example: Adjusting screens (Page 2141)
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9.11.7 Copying between devices and editors

9.11.7.1 Basics

Basics

Copying and pasting within an HMI device   
You can copy and paste objects, such as display objects, within an HMI device. If the object 
is already created in the editor, when the object name is inserted a number is automatically 
attached, in accordance with the following principle:

● "<Object_name>_1" is renamed to "<Object_name>_2".

● "<Object_name>_2" is renamed to "<Object_name>_3".

Copying and pasting between HMI devices
You can also copy and paste between HMI devices. If an object with the same name already 
exists, you have the following options:

 
 

 Note
Exception to this basic rule

Copying and pasting of an alarm class that has been generated from project-wide alarm class 
is handled differently than with this basic rule. When the copied alarm class already exists in 
the target HMI device within the same project, the "Paste" command is not performed.
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Copying user-defined folders  
You can create user-defined folders for editors, for example, for HMI tags, screens, etc.

You can copy user-defined folders and paste them into another HMI device. The objects 
contained in a user-defined folder may exceed the limitations applying to the other HMI device, 
such as the number of supported screens. After they have been pasted, all the objects are 
displayed. An error is displayed when the project data is compiled.

System folders cannot be copied. 

Copy and paste options

Copy and paste options  
Copy and pasting individual objects simplifies configuration. 

WinCC offers a number of options for copying and pasting objects.

Shortcut menu
To copy and paste objects using the shortcut menu, proceed as follows:

1. Select an object, for example a button.

2. Select "Copy" in the shortcut menu.

3. Move the mouse cursor to the place on the screen where you want to paste the button.

4. Select "Paste" in the shortcut menu.
The button will be pasted together with all properties already defined.

Drag&drop
To drag-and-drop objects, proceed as follows: 

1. Click on "Screens > Start" in the project tree of a device.

2. Drag-and-drop the "Start" screen into the "Screens" folder of another device.

3. A dialog will appear if the second device already contains a screen with the same name.

4. Choose whether to replace or rename the existing screen. 

Unsupported objects and functionalities

Introduction 
When an object is copied, all its properties and settings are transferred to the target HMI device.
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Unsupported objects   
Objects that are not supported in the target HMI device cannot be pasted.

 

 Note

When you copy a screen containing objects which are not supported by the destination HMI 
device, the objects remain in the background. When you copy the screen again and the new 
device supports the objects, they are displayed again.

 

Invalid objects
The following objects become invalid once they have been pasted into the target HMI device:

● Referenced objects that do not exist in the target HMI device.

● Objects with settings that are not supported in the target HMI device.

● System functions that were configured for objects and that are not supported in the target 
HMI device.

Invalid objects are highlighted by a color coding. Select a supported object or create a new 
one. If you retain an invalid object, an error will be displayed when the project data is compiled.

Colors and fonts     
Colors and fonts are supported to varying degrees by HMI devices. When unsupported colors 
and fonts are pasted, they are replaced by supported colors and fonts. When you paste the 
same object back into the source HMI device, the original settings become active again. 

9.11.7.2 Copying and pasting

Simple and extended pasting

Introduction
An object is linked to another object in the following situations, for example:

● You specify a tag for an alarm as a trigger tag.
The alarm is the object. The tag is the linked object.

● You specify a connection for an external tag.
The tag is the object. The connection is the linked object.

The object is always fully inserted during copying and pasting. Whether or not the linked object 
is pasted depends on the command used to insert it.
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Simple pasting  
The linked object is not copied. The linked object is transferred and handled as follows in the 
target HMI device:

● If an object with the same name exists, the existing object with its settings is used.

● If no object with the same name exists, the name of the object will be displayed. The object 
becomes invalid.

For some objects, linked objects are pasted automatically during simple pasting.

Extended pasting
Select the "Extended paste" command in the shortcut menu to paste the linked objects as well. 
If objects of the same name exist in the target HMI device, you need to decide whether or not 
to overwrite each of these objects. 

See also
Linked objects copied automatically (Page 2147)

Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
Tag Alarm

Cycle
Recipe element Text list
Scheduler Triggers

See also
Simple and extended pasting (Page 2146)
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Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Cycle

Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
Tag Alarm

Logging tag
Cycle

Log Logging tag
Logging tag Log type
Recipe element Text list
Scheduler Triggers

Drag & drop from the details view

Introduction
You can improve configuration efficiency with just a few simple measures. Below are a few 
examples of efficient configuration.

Pasting objects to a screen from the details view
You can drag objects in the details view from various different editors to other editors. 

Pasting a symbolic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a text list, for example, "Textlist1" in the Details view.

4. Drag-and-drop a text list from the Details view to a screen. A symbolic I/O field has been 
created and connected to the text list "Textlist1".
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Pasting a graphic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a graphics list in the Details view, for example "Graficlist1".

4. Drag-and-drop a graphics list from the Details view to a screen. A graphic I/O field has been 
created and connected to the graphics list  "Graficlist1".

Pasting an I/O field
1. Open a screen.

2. Click on the "HMI tags" editor in the project tree. All existing HMI tags will be shown in the 
Details view.

3. Click on an HMI tag in the Details view, for example "Tag1".

4. Drag-and-drop the HMI tag from the Details view to a screen. An I/O field has been created 
and connected to the HMI tag "Tag1".

 

Copying screens 

Introduction   
You copy one or more screens from the "Screens" folder and paste them into the "Screens" 
folder of another device.

Type and size of the displays     
In the case of HMI devices with keys, the available keys are displayed automatically in the 
screen. When a screen is copied between HMI devices, the keys are either displayed or hidden; 
functions configured for function keys are not transferred.

If there is less space for the screen in the target HMI device than in the source HMI device, 
you can adjust the size of and the spacing between existing objects. 

Automatic fit to size for objects
1. Select "Options > Settings > Visualization > Resize screen and screen objects" in the menu.

2. Activate, for example, "Fit screen to window width and height".

See also
Screen adjustment options (Page 2136)
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Copying recipes within an HMI device

"Recipes" Editor
You can copy recipes, recipe elements and recipe data records within each table. You copy 
a recipe element to another recipe. 

Only WinCC Runtime Professional: You can copy a recipe view element to another recipe 
view. If a recipe view element of the same name already exists, a conflict dialog is displayed. 
You can select whether to replace or rename the recipe element. You can copy recipe elements 
to the first empty row of the "Recipe views" editor, "Elements" tab. 

You can copy a recipe data record to another recipe, if the other recipe contains the same 
number of recipe elements. If the data types differ, the value will be copied to the target data 
record but it is assigned an error flag.

"Tags" editor
You can drag-and-drop a tag to a recipe element in the "Tag" column. The tag is linked to the 
recipe element. If a tag is already linked, an error message will be generated.

"Screens" editor
If you drag-and-drop a recipe to a screen, a new recipe display will be created and linked to 
the recipe. 

Differences between Runtime Advanced and Panels and Runtime Professional

Overview   
The following table shows the availability of the various functions in Runtime Advanced and 
Panels and Runtime Professional.

Function in WinCC Runtime Advanced and Panels Runtime Professional
Logs Yes

Data log
Alarm log

Yes
Data log
Compressed log
Alarm log

Scheduler Yes Yes
User administration Yes Yes
Screens Yes Yes
Settings Yes Yes
Global elements Yes No
Alarms Yes

Alarm indicator
Alarm window
Alarm view

Yes
Alarm view with more functions than in 
Runtime Advanced and Panels
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Function in WinCC Runtime Advanced and Panels Runtime Professional
Menus and toolbars No Yes
Reports Yes

Printout using the "PrintReport" system 
function

Yes
Printout using print job and scheduler

Recipes Yes User archives from WinCC V6.2
Scripts Yes

VBS
Yes
VBS
C

Structures Yes Yes
Text and graphics lists Yes Yes
Tags Yes Yes
Connections Yes

Different communication drivers
Yes
Different communication drivers

Templates Yes No
Cycles Yes Yes

9.11.7.3 Copying and pasting between Runtime Advanced and Panels and Runtime Professional

Basics

Introduction
You can copy and paste project data such as screens, objects and tags between devices in 
different runtimes. 

Properties and settings  
Objects that are supported in both Runtimes can have different properties and settings. During 
copying and pasting these differences are implemented as follows:

● Properties not supported by the target HMI device are not displayed.

● Default settings are specified for properties that are only supported by the target HMI device.

● Settings which are not supported by the target HMI device are replaced by default settings.

If you copy an object back to the source HMI device without manually changing the settings 
in the target HMI device, all properties and settings originally set in the source HMI device will 
be reactivated.
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Unsupported events and animations
When you paste an object into a different Runtime, the following cases are possible:

● The target HMI device does not support events or animations for the object copied.
Events or animations configured for the copied object are not displayed in the target HMI 
device.

● Events or animations for the object copied are only supported by the target HMI device.

● Certain events and animations are not supported by the target HMI device for the object 
copied.
Events or animations that were configured for the copied object and are not supported by 
the target HMI device are not displayed on the target HMI device.

● Certain events and animations for the object copied are only supported by the target HMI 
device.

All events and animations originally set will be reactivated if you copy the same object back to 
the source HMI device. 

System functions

Supported system functions
The following system functions are supported in Runtime Advanced and Panels as well as 
Runtime Professional:

● ActivateScreen

● IncreaseTag

● InvertBit

● InvertBitInTag

● InverseLinearScaling

● LinearScaling

● ResetBit

● ResetBitInTag

● SetBit

● SetBitInTag

● SetTag

● StopRuntime

● DecreaseTag

● ShowLogonDialog

Additional system functions are supported in Runtime Advanced and Panels.
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Limitations during copying

Differences between the Runtimes 
Some functions are supported exclusively in one Runtime. Some functionalities are supported 
in both Runtimes, but have different concepts. You cannot copy and paste These functions 
between the Runtimes.

Functionalities only supported by Runtime Advanced and Panels
● Templates

● Global elements

You cannot copy these functions to Runtime Professional.

Functionalities only supported in Runtime Professional
● Menus and toolbars

● C scripts

You cannot copy these functions to Runtime Advanced and Panels.

Functions with different concepts
● Configuration

● Recipes

These functions cannot be copied between the Runtimes. 

Objects in screens

Introduction 
When you copy an object from a screen and paste it into another screen, the object is inserted 
at the same position in the screen.

Text and graphics lists
When you copy a symbolic I/O field with a text list or a graphic I/O field with a graphics list and 
paste it into another runtime, the text list or graphics list will be copied to the target HMI device.

Copying objects from reports
You can copy objects that are supported in the screen from a report into a screen. Unsupported 
settings are replaced by supported settings. When you copy a copied object back into a report, 
the changed settings remain active.
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Recipe view and alarm view
The "Recipe view" and "Alarm view" objects have such different concepts that you cannot copy 
and paste these objects between the two Runtimes. 

See also
Screen objects (Page 2154)

Objects (Page 2170)

Screen objects

Supported objects
The following table shows which objects in screens are supported in which Runtime:

Object Runtime Advanced and Panels Runtime Professional
Line Yes Yes
Polyline Yes Yes
Polygon Yes Yes
Ellipse Yes Yes
Circle Yes Yes
Ellipse segment No Yes
Circle segment No Yes
Ellipse arc No Yes
Circular arc No Yes
Rectangle Yes Yes
Connector No Yes
Text field Yes Yes
Pipe No Yes
Double T-piece No Yes
T piece No Yes
Pipe bends No Yes
I/O field Yes Yes
Symbolic I/O field Yes Yes
Date/time field Yes No
Button Yes Yes
Round button No Yes
Switch Yes No
Graphic view Yes Yes
Graphic I/O field Yes Yes
Bar Yes Yes
Status/Force Yes No
Clock Yes Yes

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
2154 System Manual, 08/2011,  



Object Runtime Advanced and Panels Runtime Professional
Gauge Yes Yes
Slider Yes Yes
Symbol library Yes Yes
User view Yes Yes
HTML browser Yes Yes
Sm@rtClient view Yes No
Check box No Yes
Option buttons No Yes
Scroll bar No Yes
Screen window No Yes
Disk space view No Yes
Channel diagnostics No Yes
Application window No Yes
Recipe view Yes Yes
Alarm view Yes Yes
Trend view Yes No
f(t) trend view No Yes
f(x) trend view No Yes
Table view No Yes
Alarm view Yes Yes
Recipe view Yes Yes
Charge condition Yes No
Effective range name Yes No
Effective range name (RFID) Yes No
Effective range signal Yes No
Zone name Yes No
Zone signal Yes No

Connections

Differences between Runtime Advanced and Panels and Runtime Professional

Communication drivers
Please refer to the communications manual for information about the communication drivers 
possible in the Runtimes. Runtime Advanced and Panels and Runtime Professional support 
different communication drivers. There is no common communication driver for both runtimes.

Area pointer
The area pointers are not supported in Runtime Professional. 

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2155



Copying connections 

Introduction
You can copy a connection in the "Connections" editor and paste it in the "Connections" editor 
of another Runtime.

Integrated connections
Integrated connections are created under "Devices & networks" in the network view. An 
integrated connection is displayed in the "Connections" editor. However, you cannot edit the 
integrated connection in the "Connections" editor. Any integrated connection you copy and 
paste from the "Connections" editor to another Runtime will become invalid in the target HMI 
device as it lacks a communication partner. You can only edit the copied integrated connection 
in the network view of the target device. 

Copying variables

Introduction
You can copy a tag in the "Tags" editor and paste it in the "Tags" editor of another Runtime.

Unsupported data types
If you copy a tag with a data type that is not supported in the other Runtime, then the data type 
will become invalid.

Logging tags
If you have linked the tag to a logging tag, this logging tag will be copied to the target HMI 
device together with the tag. A logging tag has to be assigned to a data log. A new log will be 
created if there is no corresponding data log in the target HMI device.

Alarms
Any analog or discrete alarms you have configured for a tag will be copied to the target HMI 
device together with the tag.

System tags
System tags are supported in Runtime Professional only. 
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See also
Tag data types and properties (Page 2157)

Logging tags (Page 2166)

Discrete alarms  (Page 2161)

Analog alarms (Page 2162)

Tag data types and properties

Data types
The following table shows which data types are supported in which Runtime.

Data type Runtime Advanced and Panels Runtime Professional
Boolean Yes Yes
Byte (Signed Byte) Yes Yes
UByte (Unsigned Byte) Yes Yes
Short (Signed Int) Yes Yes
UShort (Unsigned Int) Yes Yes
Long (Signed Long) Yes Yes
ULong (Unsigned Long) Yes Yes
Float Yes Yes
Double Yes Yes
String Yes Yes
UString (Unicode String) No Yes
Raw (Raw Data Type) No Yes
Ref (Text Reference) No Yes
Date Time Yes No

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● Address

● Content (comment)

● Connection

● Control variable

● Data type

● Length
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● Limit values:

– Upper error

– Generate analog alarm for upper error

– Upper warning

– Generate analog alarm for upper warning

– Low

– Generate analog alarm for lower warning

– Lower error

– Generate analog alarm for lower error

● Linear scaling

● Name

● HMI device end value

● HMI device start value

● PLC end value

● PLC start value

● Start value

Structures

Structural elements 

Introduction
You can copy a structural element in the "Structures" editor and paste it in the "Structures" 
editor of another Runtime.

Unsupported data types
If you copy a structural element with a data type that is not supported in the other Runtime, 
the data type becomes invalid in the "Structure" editor. 

See also
Structure data types and properties  (Page 2159)
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Structure types

Introduction
You can copy a structure type from the "Structures" folder and paste it into the "Structures" 
folder of another Runtime.

Unsupported controller types
Since no controller type is supported in both Runtimes, the controller type will be invalid in the 
target HMI device.

Device family
The device family is adapted to the target HMI device when copied. If you copy a structure 
type from Runtime Advanced and Panels to Runtime Professional, for example, the "SmartCE" 
entry automatically becomes "SCADA."

Internal and external data types
In Runtime Advanced und Panels, a structure type can contain either exclusively internal data 
types or exclusively external ones. In Runtime Professional, both internal and external data 
types can be contained in one structure type.

If you copy a structure type that contains internal and external data types from Runtime 
Professional to Runtime Advanced und Panels, all internal data types become invalid. Since 
no communication peer is supported in both Runtimes, all external data types become invalid 
as well. 

Structure data types and properties 

Data types
The following table shows which data types are supported in which Runtime.

Data type Runtime Advanced and Panels Runtime Professional
Boolean Yes Yes
Byte (Signed Byte) Yes Yes
UByte (Unsigned Byte) Yes Yes
Short (Signed Int) Yes Yes
UShort (Unsigned Int) Yes Yes
Long (Signed Long) Yes Yes
ULong (Unsigned Long) Yes Yes
Float Yes Yes
Double Yes Yes
String Yes Yes
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Data type Runtime Advanced and Panels Runtime Professional
UString (Unicode String) No Yes
Raw (Raw Data Type) No Yes
Ref (Text Reference) No Yes
Date Time Yes No

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

Structure types:

● Comment: Contents

● Name

● Type of controller

● Device family

Structural elements:

● Comment: Contents

● Data type

● Length

● Linear scaling

● Name

● HMI device end value

● HMI device start value

● PLC end value

● PLC start value

● Error upper limit

● Error lower limit

● Start value

● Bit offset

● Offset
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Alarms

Differences between Runtime Advanced and Panels and Runtime Professional 

Supported objects in the screen
You can configure the following objects for screen alarm display in Runtime Advanced and 
Panels:

● Alarm view

● Alarm window

● Alarm indicator

In Runtime Professional, you can only configure an alarm view.

The concepts of the alarm view in the Runtimes are so different that it is not possible to copy 
an alarm view between the Runtimes.

Alarm text blocks
Alarm blocks are supported in Runtime Professional only. 

Discrete alarms 

Introduction  
You can copy a discrete alarm in the "Alarms" editor in the "Discrete alarms" tab and paste it 
to another Runtime. Pasting a tag with configured discrete alarms to the "Tags" editor will 
automatically also paste the corresponding discrete alarms to the "Alarms" editor.

Supported properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● ID

● Alarm class

● Alarm group

● Acknowledgment: Tag

● Acknowledgment: Bit

● Tooltip

● Trigger: Tag

● Trigger: Bit

● Event text
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Alarm number
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied. If the alarm number already exists, the next free number is assigned 
automatically as the alarm number for the discrete alarm.

Tooltip
Copying a tooltip with more than 255 characters to Runtime Professional will make the entire 
tooltip invalid.

Event text
The event text is displayed in the following dialog boxes of the Inspector window:

● Runtime Panels and Advanced:
"Properties > Properties > General > Settings > Event text"

● Runtime Professional:
"Properties > Properties > Texts > Settings > Event text"

The event texts are copied into the corresponding dialog boxes with all the format data.

Event texts will become invalid:

● if you copy an event text with more than 254 characters to Runtime Advanced and Panels.

● if you copy an event text with a dynamic parameter to Runtime Panels and Advanced.

● if you copy an event text with a text list from Runtime Panels and Advanced to Runtime 
Professional.

Analog alarms

Introduction  
You can copy an analog alarm in the "Alarms" editor in the "Analog alarms" tab and paste it 
to another Runtime. Pasting a tag with configured analog alarms to the "Tags" editor will 
automatically also paste the corresponding analog alarms to the "Alarms" editor.

Supported properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● Alarm number "ID"

● Event text

● Alarm class

● Alarm group

● Tooltip

● Trigger: Tag
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● Delay

● Limit value

● Trigger mode

● Synchronize limit value

● Hysteresis mode

● Hysteresis

● Hysteresis as a percentage

Alarm number "ID"
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied. If the alarm number already exists, the next free number is assigned 
automatically as the alarm number for the analog alarm.

Event text
The event text is displayed in the following dialog boxes of the Inspector window:

● Runtime Advanced and Panels:
"Properties > Properties > General > Settings > Event text"

● Runtime Professional:
"Properties > Properties > Texts > Settings > Event text"

The event texts are copied into the corresponding dialog boxes with all the format data.

Event texts will become invalid:

● if you copy an event text with more than 254 characters to Runtime Advanced and Panels.

● if you copy an event text with a dynamic parameter to Runtime Panels and Advanced.

● if you copy an event text with a text list from Runtime Panels and Advanced to Runtime 
Professional.

Tooltip
Copying a tooltip with more than 255 characters to Runtime Professional will make the entire 
tooltip invalid.

Delay
If you copy a delay with the "Minute" or "Hour" unit from Runtime Professional to Runtime 
Advanced and Panels, the setting becomes invalid. 

See also
Copying variables (Page 2156)
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Controller alarms and system alarms

Controller alarms
Since controller alarms are configured in the controller, it is not possible to copy controller 
alarms.

System alarms
Because system alarms are dependent on the HMI device, it is not possible to copy system 
alarms. 

Alarm classes

Introduction
You can copy an alarm class in the "Alarms" editor in the "Alarm classes" tab and paste it to 
another Runtime.

Predefined alarm classes
You cannot copy and paste predefined alarm classes.

Log
In Runtime Advanced and Panels, you configure an archive in which the alarm is stored. In 
Runtime Professional, you specify whether the alarm is logged for each alarm of an alarm 
class. 

During the copying process the logging specifications are implemented as follows:

● Copying from Runtime Advanced and Panels to Runtime Professional:
If a log has been created in Runtime Advanced and Panels, "Log" is activated in Runtime 
Professional.
If no log has been created in Runtime Advanced and Panels, "Log" is deactivated in 
Runtime Professional.

● Copying from Runtime Professional to Runtime Advanced and Panels:
If "Log" is activated in Runtime Professional, you need to specify a log in Runtime Advanced 
and Panels.
If "Log" is deactivated in Runtime Professional, the entry <No log> is specified in Runtime 
Advanced and Panels.

Flashing
The settings for the flash behavior are not copied. 
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Alarm groups 

Copying and pasting 
You can copy an alarm group in the "Alarms" editor in the "Alarm groups" tab and paste it to 
another Runtime.

Alarm groups from alarm classes
Alarm groups from alarm classes are only supported in Runtime Professional and cannot be 
copied and pasted to Runtime Advanced and Panels.

Hierarchy
Hierarchies of alarm groups are only supported in Runtime Professional. When copied 
between the Runtimes the hierarchy order is implemented as follows:

● Copying from Runtime Advanced and Panels to Runtime Professional
If you copy an alarm group into the "Alarm groups" tab of the "Alarms" editor, the alarm 
group is inserted regardless of any existing alarm groups.
If you copy an alarm group into a line containing an existing alarm group, the alarm group 
is inserted as an alarm group that is subordinate in the hierarchy.

● Copying from Runtime Professional to Runtime Advanced and Panels
Hierarchies cannot be shown in Runtime Advanced and Panels. Alarm groups from all 
hierarchy levels are inserted independently of each other.

ID of the alarm group
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied.

Logs

Differences between Runtime Advanced and Panels and Runtime Professional

Logs
Data logs are supported in both Runtimes. You can copy and paste alarm logs and compressed 
logs between the runtimes.

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

Data logs
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● Name

● Comment

● Storage location

Logging tags

● Name

● Process variable

● Triggers

● Logging cycle

● High limit

● Low limit

● Comment

Events
You cannot copy configured events between Runtime Advanced and Panels and Runtime 
Professional. 

Data logs 

Copying and pasting
You can copy a data log in the "Historical Data" editor in the "Data log" tab and paste it to 
another Runtime. All logging tags contained in the data log are included automatically. 

Logging tags

Introduction  
You can copy a logging tag in the "Historical Data" editor in the "Data log" tab and paste it in 
another Runtime.

In addition, you can copy a logging tag in the "Tags" editor of Runtime Professional and paste 
it into the "Historical Data" editor in Runtime Advanced and Panels. To copy a logging tag in 
Runtime Professional, open the "Tags" editor and select the "Alarms & Logs" tab in the upper 
work area. Copy the desired logging tag in the lower work area of the "Data logs" tab.

Tags used in the logging tags
Any logging tag you have linked to a tag will be automatically also copied if the tag is copied 
to the target HMI device. A new log will be created if there is no corresponding data log in the 
target HMI device. There may be performance problems if too much of this additional data is 
copied.

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
2166 System Manual, 08/2011,  



Multiple logging of tags
When copying from Runtime Professional to Runtime Advanced and Panels, the process tags 
of a logging tag become invalid in the following situations:

● The tag has been logged more than once in Runtime Professional.

● Several logging tags are linked to the same process tag.

Triggers
If you paste a logging tag with a cycle, the cycle will be included in the target HMI device.

In Runtime Professional, configure the log cycle of logging tags in the form "factor x cycle", for 
example, twice an hour. The "Factor" property is not supported in Runtime Advanced and 
Panels. The Factor property is therefore set to the default of "1" when copying from Runtime 
Advanced and Panels to Runtime Professional. When copying from Runtime Professional to 
Runtime Advanced and Panels, only the cycle can be seen in Runtime Advanced and Panels; 
the factor is not taken into consideration. If you copy a cycle of "3 x 1h" from Runtime 
Professional to Runtime Advanced and Panels, for example, this is set in Runtime Advanced 
and Panels as "1h".

Copying logging tags from the "Tags" editor
When you copy a logging tag from the "Tags" editor in Runtime Professional into the "Historical 
Data" editor in Runtime Advanced and Panels, the "Process tag" property is linked to an 
existing tag with the same name. If there is no tag with the same name, the "Process tag" 
property becomes invalid. The "Data log" property is linked to the selected data log.

If you copy a logging tag from the "Tags" editor in Runtime Professional to the "Tags" editor 
of another HMI device, the "Data log" property will not be transferred.

Copying logging tags from the "Historical Data" editor
When you copy a logging tag from the "Historical Data" editor in Runtime Advanced and Panels 
into the "Tags" editor in Runtime Professional, the "Data log" property will not be transferred.

When you copy a logging tag from the "Historical Data" editor into the "Logs" editor of another 
HMI device, the "Process tag" property is linked to an existing tag with the same name. If there 
is no tag with the same name, the "Process tag" property becomes invalid. The "Data log" 
property is linked to the selected data log.

Logging tags used in compressed logging tags
When you copy a logging tag used in a compressed logging tag in Runtime Professional to 
Runtime Advanced and Panels, the settings for the compressed logging tag are also copied 
in the background. There may be performance problems if too many of these unnecessary 
settings are copied to Runtime Advanced and Panels. 

See also
Copying variables (Page 2156)
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Copying VB scripts

Object types, properties and methods in VB script
The objects, object types, properties and methods supported in Runtime Advanced and Panels 
and Runtime Professional are listed in the VBS reference. 

Pasting  
You can copy VB scripts

● using the shortcut menu or by drag & drop from the project tree

● from the code of an open VB script to another open VB script.

Objects called in VB script
You copy a VB script. Objects and their properties which do not exist in or are not supported 
by the target HMI device are called in the VB script. The syntax check reports an error. Correct 
the invalid object references.

Variables called up in a VB script
The syntax check will report errors if tags are called in the copied VB script that do not exist 
in the target HMI device or only exist with a different data type. Replace the invalid tags with 
tags that exist in the target HMI device.

If you are planning to copy scripts into different Runtimes, use the same variables in the 
Runtimes. 

Copying recipes between Runtime Advanced and Panels and Runtime Professional

Recipe and recipe element
The recipe elements and recipe data records will also be copied if a recipe is copied.

 

 NOTICE

Inconsistent data

Properties not supported by the HMI device, for example data type, will be formally copied 
but will appear with an error flag.

Check the properties and reassign those flagged.
 

You can drag-and-drop a recipe element into the first empty line of the "Recipes Element" 
editor of another HMI device. The recipe element is inserted into the other recipe. If the recipe 
does not have the "Tags" communication type, the associated tag will be copied but it is 
assigned an error flag.
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Points to note when copying from WinCC Runtime Advanced and Panels to WinCC Runtime 
Professional

The properties below are preset as follows and may subsequently be edited:

● "Tags" communication type

● "Limited" size type

● Number of data records

The storage location of the recipe is changed to "Database".

With a recipe element, the link will be copied but not the linked tag. You need to copy the tag 
separately or create a new tag with the same name. The same applies to the text list.

 

 NOTICE

Inconsistent data 

Array tags are not supported in WinCC Runtime Professional. After copying the recipe, create 
as many recipe elements and tags as there are array elements in the linked array tag. Link 
the new recipe elements to the tags. Copy the values of the source recipe data records to 
the target recipe data records.

 

Points to note when copying from WinCC Runtime Professional to WinCC Runtime Advanced and 
Panels

The following properties will be changed but cannot be edited:

● "Tags" communication type

● "Limited" size type

● Number of data records per HMI device

● "File" storage location with default path

Recipe data record and recipe collection
You can copy a recipe data record to another recipe, if the other recipe contains the same 
number of recipe elements. If the data types differ, the value will be copied to the target data 
record but it is assigned an error flag.

Features specific to WinCC Runtime Professional
You can drag-and-drop a recipe collection into the first empty line of the "Recipe Views" editor 
of another device. The recipe collection will be copied but not the linked recipe elements and 
their recipes.
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Copying cycles

Introduction 
You can copy cycle in the "Cycles" editor and paste it in the "Cycles" editor of another Runtime. 
Referenced cycles are also copied whenever tags, logging tags or tasks are copied. The cycles 
are then displayed in the "Cycles" editor.

Supported properties
The date and time of the last change are updated during pasting.

Properties
The "Starting point" property is only supported in Runtime Professional.

Cycle units
Runtime Professional and Runtime Advanced and Panels support different cycle units. 

Reports

Objects

Introduction  
When you copy an object from a report and paste it into another report, the object is inserted 
at the same position in the report.

Supported properties
The concepts of the "Recipe display" and "Alarm view" objects differ so greatly that they cannot 
be copied and pasted between the various Runtimes.

Text and graphics lists
Text and graphics lists are automatically copied along with symbolic and graphic I/O fields and 
are then displayed in the "Text and graphics lists" editor.

Copying objects from screens
You can copy objects supported in the report from a screen to a report. Unsupported settings 
are replaced by supported settings. When you copy a copied object back into a screen, the 
changed settings remain active. 
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See also
Objects in reports (Page 2171)

Objects in screens (Page 2153)

Copying a report

Introduction  
You can copy a report from the "Reports" folder and paste it into another "Reports" folder. 

Watermarks
Watermarks are only supported in Runtime Professional. When you copy a report from 
Runtime Professional to Runtime Advanced and Panels, the areas for the watermarks will no 
longer be shown.

Print jobs
The print jobs in the "Reports" folder are only supported in Runtime Professional and cannot 
be copied and pasted between Runtimes. 

Objects in reports

Supported objects
The following table shows which objects are supported in which Runtime:

Basic object Runtime Advanced and Panels Runtime Professional
Line Yes Yes
Polyline Yes Yes
Ellipse Yes Yes
Circle Yes Yes
Ellipse segment No Yes
Circle segment No Yes
Elliptical arc No Yes
Circular arc No Yes
Rectangle Yes Yes
Polygon Yes Yes
Text field Yes Yes
I/O field Yes Yes
Symbolic I/O field Yes Yes
Date/time field Yes No
Graphic I/O field Yes Yes
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Basic object Runtime Advanced and Panels Runtime Professional
Alarm view No Yes
Recipe view No Yes
Table view No Yes
f(t) trend view No Yes
f(x) trend view No Yes
Page number Yes Yes
Report name No Yes
Project name No Yes
Hardcopy No Yes
ODBC database field No Yes
ODBC database table No Yes
Alarm sequence report No Yes
CSV provider tables No Yes
CSV provider trends No Yes
Alarm report Yes No
Recipe report Yes No
Control data No Yes
Control hard copy No Yes
Control screen No Yes

Text and graphics lists

Differences between Runtime Advanced and Panels and Runtime Professional 

Ranges in text lists
When specifying a range the following settings are supported in both Runtimes:

● Individual value

● Range

The following settings are supported in Runtime Professional:

● To (<=)

● From (>=)

Copying text lists and graphic lists

Introduction  
You can copy a text or graphics list in the "Text and graphics lists" editor and paste it to the 
same editor in another runtime. Text and graphics lists are also automatically copied along 
with symbolic and graphic I/O fields and displayed in the "Text and graphics lists" editor.
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List entries
When a text or graphics list is copied, the corresponding list entries are included in copying. 
You can also copy and paste the list entries individually. 

User administration

Differences between Runtime Advanced and Panels and Runtime Professional

Users
Properties for dynamic logon and web client administration are only supported in Runtime 
Professional.

User groups
The "DisplayName" and "Number" properties are only supported in Runtime Advanced and 
Panels. 

Properties for web client administration are only supported in Runtime Professional.

Copying users, user groups and authorizations

Copying and pasting    
You can copy users, user groups and authorizations in the "User administration" editor.

When you copy a user, the corresponding user group is not copied. 

When you copy a user group, the corresponding authorizations are not copied.

Default entries and system authorizations
The following users, user groups and authorizations are predefined. They cannot be deleted 
and may only be edited to a limited extent:

● predefined user "Administrator"

● predefined groups "Administrator" and "Operators"

● predefined authorizations, such as "Operate" and "Enable remote control"

You can copy the predefined entries and paste them into another Runtime. The entries copied 
are pasted as user-defined entries and can then be edited. 
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Scheduler

Copying scheduled tasks

Introduction  
You can copy a scheduled task in the "Scheduler" editor and paste it to the "Scheduler" editor 
of another device.

Task type
The "Print job" task type is supported in Runtime Professional only. Types that are not 
supported in both Runtimes become invalid after they have been pasted. 

See also
System functions (Page 2152)

Scheduler events (Page 2174)

Scheduler events

Events
The following table shows which events are supported in which Runtime:

Event Runtime Advanced and Panels Runtime Professional
Screen change Yes No
User change Yes No
Alarm buffer overflow Yes No
Runtime stop Yes Yes
When a dialog is opened Yes No
When a dialog is closed Yes No
Disabled Yes Yes
Once Yes Yes
250 milliseconds No Yes
500 milliseconds No Yes
1 second No Yes
2 seconds No Yes
5 seconds No Yes
10 seconds No Yes
1 minute Yes Yes
5 minutes No Yes
10 minutes No Yes
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Event Runtime Advanced and Panels Runtime Professional
1 hour Yes Yes
Once daily Yes Yes
Once weekly Yes Yes
Once monthly Yes Yes
Once yearly Yes Yes
Tag triggers No Yes

9.11.8 Configuring system diagnostics

9.11.8.1 System diagnostics basics

Introduction
You use system diagnostics to detect problems and errors in any part of your plant. WinCC 
has two display and operating elements for quick error localization.

The objects for system diagnostics are only available with Comfort Panels.    

System diagnostics view  
The alarm view shows the status of a PLC while the system diagnostics view gives you an 
overview of all devices available in your plant: You navigate directly to the cause of the error 
and to the relevant device. You have access to all devices supporting diagnostics you have 
configured in the "Devices & networks" editor.

System diagnostics window  
The system diagnostics window is an operating and display element that you can only use in 
the global screen. 

The functions of the system diagnostics window are no different than those of the system 
diagnostics view. Because the system diagnostics window is configured in the global screen, 
you can, for example, also specify if the object is closable in Runtime. 

See also
System diagnostics views (Page 2176)

Enabling system diagnostics in the PLC (Page 2178)
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9.11.8.2 System diagnostics views

Introduction
There are three different views available in the system diagnostics view and the system 
diagnostics window. 

● Device view

● Details view

● Matrix view (for master systems, PROFIBUS, PROFINET only)

Device view
The device view shows all the available devices of a layer in a table. Double-clicking on a 
device opens either the child devices or the detail view. Symbols in the first column provide 
information about the current status of the device.
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Details view
The detail view gives detailed information about the selected device and any pending errors. 
Check whether the data is correct in the detail view. You can cannot sort error texts in the 
detail view.

Matrix view
The matrix view is only available for master systems. The matrix view shows the status of the 
subdevices of the master system. 

● In PROFIBUS, the numbers assigned by Profibus are used as identification (DP station 
number).

● The IO devices are numbered consecutively from 1 in PROFINET.
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Navigation buttons

Button Function
Opens the child devices or the detail view if there are no child devices.

Opens the parent device or the device view if there is no parent device.

Opens the device view.

See also
System diagnostics basics (Page 2175)

9.11.8.3 System diagnostics

Enabling system diagnostics in the PLC

Introduction
Settings must be made in the PLC to enable the PLC to transfer error messages to the system 
diagnostics view.    
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Requirements
A PLC has been created.

The "Devices & Networks" editor is open in the "Device view".

Procedure
1. Select the PLC in the selection list.

2. Click on the PLC and select "Properties" in the shortcut menu. The properties of the PLC 
are displayed in the Inspector window.

3. Select "Properties > General > System diagnostics" in the Inspector window.

4. Enable "Activate system diagnostics for this CPU".

5. Select "Properties > General > System diagnostics > Diagnostics support" in the Inspector 
window.
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6. Activate "Diagnostics status DB".

7. Select the PLC and then "Compile > Hardware configuration" in the shortcut menu.

Result
The settings will be effective following compilation. The PLC can now transfer error messages 
to the system diagnostics display. 

See also
System diagnostics basics (Page 2175)

Adding a system diagnostics indicator

Introduction
The system diagnostics indicator is a predefined graphic symbol of the library which alerts you 
to errors in your system. 

The library object shows two different statuses:

- No error

- Error     

Requirement
● A Comfort Panel has been set up in the project.

● The "Libraries" task card is opened.

● The global library "Buttons and Switches > DiagnosticsButtons" is open.
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● A screen is open.

● A system diagnostics window has been created in the global screen.

Procedure
1. Select the "DiagnosticsIndicator" object in the library.

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is added.

3. Select the library object.

4. Click "Properties > Events" in the Inspector window.
The system function "ShowSystemDiagnosticsWindow" is preset for the event "Click".

Visualizing processes (Professional)
9.11 Using global functions

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2181



Result
The status diagnostics indicator has been added to the project and connected with the system 
diagnostics view. 

The system diagnostics indicator changes its appearance if an error message is output in 
Runtime. The system diagnostics window opens when you click on the system diagnostics 
indicator. The system diagnostics window shows the detail view of the affected device. 

Configuring access protection for the system diagnostics view
Configure access protection for the system diagnostics indicator to prevent unauthorized 
access to the system diagnostics window.

1. Select the "DiagnosticsIndicator" object in the screen.

2. Select an authorization in "Properties > Properties > Security in Runtime" in the Inspector 
window.

A logon dialog opens when you click on the system diagnostics indicator in Runtime. The 
system diagnostics window does not open unless you have the required authorization. 

Configuring a system diagnostics window in the global screen

Introduction
The system diagnostics window gives you an overview of all devices available in your plant. 
The system diagnostics window operates like the system diagnostics view, but it is only 
available in the global screen.    

Requirements
● At least one PLC has been created.

● The following options have been enabled in each PLC:

– Enable system diagnostics for this CPU

– Diagnostics status DB

● A Comfort Panel has been set up in the project.

● The global screen is open.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics window" object in the "Tools" task card. The object 

is added to the global screen.

2. Select "Properties > Properties > Columns" in the Inspector window.
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3. Enable the columns that you require in the device view for Runtime, for example:

– Status

– Name

– Operating mode

– Slot

– Address

4. Enable the properties which you require in the detail view for Runtime, for example:

– Status

– Name

– Operating mode

– Plant designation

– Address

5. Enable "Column settings > Columns moveable" to move the columns in Runtime.

6. You can change the column headers under "Properties > Properties > Column headers", 
if necessary.

7. Enable "Properties > Properties > Window > Closable" to allow the system diagnostics 
window to be closed in Runtime.

Result
The system diagnostics window has been added to the global screen. The system diagnostics 
window will respond to error messages in the plant and display the device affected.

Configure a system diagnostics indicator in a screen to open the system diagnostics window.

Configuring a graphic I/O field as a system diagnostics indicator

Introduction
Instead of using the object "DiagnosticsIndicator" from the library, you can configure a graphic 
I/O field to indicate errors in your plant.      

Requirements
● At least one PLC has been created.

● The following options have been enabled in each PLC:

– Enable system diagnostics for this CPU

– Diagnostics status DB

● A Comfort Panel has been set up in the project.

● The "Tools" task card is open.
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● A bit graphics list has been created with two different graphics for the two statuses.

● A screen is open.

● You have created a system diagnostic view.

Procedure
1. Double-click on the "Graphic I/O field" object in the "Tools" task card. An I/O field is added 

to the screen.

2. Select the "@DiagnosticsIndicatorTag" tag under "Properties > Properties > General > Tag 
> Name" in the Inspector window.

3. Select the bit graphics list under "Contents > Graphics list".

4. In the Inspector window, select "Properties > Properties > Appearance > Scrollbars > Type 
> No scrollbar".

Configuring a system function for the graphic I/O field
1. Click "Properties > Events" in the Inspector window.

2. Select the "Enable" event.

3. Click on "Add function" in the table.

4. Select the "EnableSystemDiagnosticsView" system function.

5. Select the system diagnostics view.

Result
You have now configured a graphic I/O field which will respond to error messages from the 
PLC. The graphic I/O field will change when an error message is output in Runtime. The system 
diagnostics window opens when you enable the graphic I/O field. The system diagnostics 
window shows the detail view of the affected device.

Configuring the system diagnostic view

Introduction
You add a system diagnostics view to your project to get an overview of all devices available 
in your plant.

Requirements
● At least one PLC has been created.

● The following options have been enabled in each PLC:

– Enable system diagnostics for this CPU

– Diagnostics status DB
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● A Comfort Panel has been set up in the project.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen.

2. Select "Properties > Properties > Columns" in the Inspector window.

3. Enable the columns that you require in the device view for Runtime, for example:

– Status

– Name

– Operating mode

– Slot

– Address

4. Activate the columns you need in the detail view for Runtime, for example:

– Status

– Name

– Operating mode

– Plant designation

– Address

5. Enable "Column settings > Columns moveable" to move the columns in Runtime.

6. You can change the column headers under "Properties > Properties > Column headers", 
if necessary.

Result
The system diagnostics view has been added to the screen. Error messages for the entire 
plant are now displayed in the system diagnostics view in Runtime. 
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9.12 Compiling and loading

9.12.1 Compiling, downloading and simulating projects

9.12.1.1 Overview of compiling and loading projects

Overview   
The project is compiled in the background even as you are configuring it in WinCC. This 
reduces the time for final compilation. When you start compilation, you create a file that can 
be run on the corresponding HMI device. 

If an error occurs during compilation, WinCC provides support in locating and correcting it.

Once you have corrected any problems, you download the compiled project to the HMI devices 
on which the project is to run. If the configuration PC is not connected to the HMI device, save 
the compiled project on a data medium of your choice. The compiled project is then transferred 
from a PC connected to the HMI device to the HMI device. 

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device.

Project
The term "project" has two different meanings in the contexts of compilation and loading. 
"Project" is the WinCC project on the configuration PC. "Project" is also the Runtime project 
you create by compiling the configuration data of an HMI device and download to the HMI 
device. 

● WinCC project: contains the configuration data of one or more HMI devices

● Runtime project: contains the compiled configuration data of an HMI device

The figure below illustrates the link between WinCC projects and Runtime projects using the 
example of the "Compile and load" process:
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Runtime
Runtime is the software for process visualization. In Runtime, you execute the project in 
process mode. 

A distinction is made between two types of Runtime:

1. Runtime on a panel
Before executing a Runtime project on a panel, you have to transfer the Runtime project 
to the panel before startup.

2. Runtime on a PC
You can execute the Runtime project directly on the configuration PC if Runtime has been 
installed on the configuration PC. 
If you want to execute the Runtime project on a different PC, you have to transfer the 
Runtime project to the PC before startup.

Simulation
You test your configuration with a simulation. You can start a simulation without a link to the 
active process.

In a simulation, you test configured tags or screen changes, for example. During the simulation, 
the configured tags can be manipulated, activated and deactivated with the help of the tag 
simulator. 

There are two types of simulation:

1. Simulating a panel
If you created a panel in your project, the panel is displayed in the simulation. With the help 
of this type of simulation, you can test your configuration on the HMI device without 
transferring the project to the panel.

2. Simulating Runtime
Simulating Runtime allows you to test the project directly on the configuration PC. 
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9.12.1.2 Compiling a project

Introduction   
The changes made to the project are compiled in the background even as you are configuring 
a project in WinCC. Projects are compiled automatically when you load them. This ensures 
that the latest version of the project is loaded at all times.

WinCC checks consistency of the project during compilation. The error locations in the project 
are listed in the Inspector window. You can jump directly to the source of the error from the 
entry in the Inspector window. Check and correct errors found.

Scope of the compilation
Configuration data is compiled in the background as soon as you start configuring an HMI 
device. If you compile a project manually, only the changes in the configuration made since 
the last compilation process are compiled in the background. 

You can start complete project compilation manually at any time; this may, for example, be 
done to test the consistency of the configured data.

Requirement
● A project is open.

Procedure
Proceed as follows to compile a project:

1. If you want to compile several HMI devices at the same time, select all the relevant HMI 
devices with multiple selection in the project tree.

2. Compile the project:

– For delta compilation of the project, select the "Compile > Software" command from the 
shortcut menu of the HMI device.

– To compile all project data, select the "Compile > Software (compile all)" command from 
the shortcut menu.

Result
The configuration data of all selected HMI devices is compiled. Any errors that occur during 
compilation are shown in the Inspector window. 
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9.12.1.3 Loading projects

Overview for loading of projects

Overview
Delta data of the project is automatically compiled before you download it to one or several 
HMI devices. This always ensures that the latest version of the project is transferred. 

Loading a project to an HMI device   
The following steps are completed prior to downloading:

1. The download settings are verified. The "Extended loading" dialog box is opened 
automatically during the initial download of a project to an HMI device. You use this dialog 
to define the protocol and interface or destination path for the project in accordance with 
the HMI device Runtime used.
If, for example, the HMI device is part of a subnetwork, you also select the subnetwork and 
the 1st gateway.
You can call the "Extended loading" dialog at any time with the menu command "Online > 
Advanced download to device...". 
The "Load preview" dialog opens. 

2. The project is compiled. Warnings and errors during compilation are displayed in the 
Inspector window and in the "Load preview" dialog.

3. The "Load preview" dialog shows you the following information for each HMI device:

– The individual steps for loading

– Presettings that take effect at loading. You can change the default settings for this 
download process, if necessary.

– Warning events (optional). You can download a project while ignoring the "warnings". 
The functionality may be restricted in Runtime.

– Error events (optional). You cannot load the project. Eliminate the errors and then reload 
the project.
WinCC will open the invalid configuration in the corresponding editor if you double-click 
the error message in the Inspector window. Correct the errors and reload the project.

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device. 

Loading a project without a connected HMI device   
If you cannot establish a direct connection from the configuration PC to the HMI device, save 
the compiled project on a data medium of your choice. Additional steps depend on the Runtime 
used:

● Panel Runtime: Copy the compiled project to a PC connected to the HMI device, for 
example, via a network. Download the project from this PC to the HMI device ("Pack&Go").

● Runtime Advanced: Move the compiled project to the HMI device.
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Loading with S7 routing
Configure the S7 routing settings in the "Devices & Networks" editor in the relevant PLC. The 
settings depend on the device configured. 

S7 routing supports the following protocols:

● MPI/PROFIBUS

● Ethernet

See also
Loading a project (Page 2210)

Generating a "Pack&Go" file (Page 2191)

Starting Runtime Advanced and Panels (Page 2197)

Loading a project

Introduction
Before a project can run on an HMI device, you must first load it to the HMI device. During 
loading, you must most importantly specify whether existing data on the HMI device such as 
"user administration" and "recipe data" is to be overwritten. 

As a general rule, only one project can be active in Runtime on an HMI device. An HMI device 
is generally configured to exit Runtime automatically when loading is started. If this is not the 
case, you will have to exit Runtime manually on the HMI device. 

You can alternatively enable the "Remote" option in the transfer settings in the control panel 
of the HMI device. This will then allow you to load a project to the HMI device while another 
project is still in Runtime. 

Please refer to the documentation for the HMI device used for more detailed information on 
transfer settings. 

Requirement
● You have created an HMI device in the project.

● The HMI device is connected to the configuration PC.

● Transfer mode is set in the HMI device. 

Procedure   
Proceed as follows to load a project:

1. To download a project simultaneously to several HMI devices, select the HMI devices by 
means of multiple selection in the project navigation.

2. Select the "Download to device > Software" command from the shortcut menu of the HMI 
device.
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3. If the "Extended loading" dialog is open, configure the "Settings for loading". Make sure 
that the "Settings for loading" correspond to the "Transfer settings in the HMI device".

– Select the protocol used, for example, Ethernet or HTTP.

– Configure the relevant interface parameters on the configuration PC.

– Make any interface-specific or protocol-specific settings required in the HMI device.

– Click "Download".

You can call the "Extended loading" dialog at any time with the menu command "Online > 
Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result is 
displayed in the "Load preview" dialog.

4. Check the displayed presettings and change them as necessary.

5. Click "Download".

Result
The project is loaded to all selected HMI devices. If errors or warnings occur during the 
download, corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

See also
Starting Runtime on the configuration PC (Page 2197)

Starting Runtime Advanced and Panels (Page 2197)

Starting Runtime Professional (Page 2221)

Generating a "Pack&Go" file

Introduction
Create a "Pack&Go" file if you cannot connect the HMI device to the configuration PC. The 
"Pack&Go" file is a ZIP file containing the following data:

● The compiled project

● A program for transferring the project to the HMI device

● The operating system image for the configured HMI device

Typical example of an application: An engineering company creates a project variant for a new 
HMI device. The project engineer of the engineering company does not have direct access to 
the plant. The project engineer therefore e-mails the "Pack&Go" file to his local contact. The 
contact unpacks the "Pack&Go" file on a PC connected to the HMI device via a network. He 
then transfers the project from the PC to the HMI device.

Visualizing processes (Professional)
9.12 Compiling and loading

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2191



Requirement
● You have created an HMI device in the project.

Procedure   
To create a "Pack&Go" file, follow these steps:

1. Select the HMI device in the project navigation.

2. Select the "Pack&Go" command from the menu under "Online > HMI device maintenance".

1. The "Create Pack&Go file" opens.

2. Select a protocol as transfer mode.

3. Select the storage location under "Pack&Go file" and enter the file name.

4. If necessary, specify if the "Pack&Go" file is split into several files.

5. Click "Create".

Result
The "Pack&Go" file is created and saved to the specified folder in the file system. Now copy 
the "Pack&Go" file to the PC connected to the HMI device.

Downloading projects from a "Pack&Go" file to the HMI device

Requirement
● The "Pack&Go" file has been stored in the file system of a PC.

● The PC is connected to the HMI device.

● The HMI device operating system version is the same as the operating system version in 
the project.

Procedure   
To download the project from a "Pack&Go" file to an HMI device, follow these steps:

1. Unpack the "Pack&Go" file to a folder of your choice in the file system of the PC.

2. From the "PackNGo" subfolder of this directory, run "Siemens.Simatic.Hmi.PackNgo.exe".
The "Pack'n Go" dialog opens. The settings for loading are set by default. Exception: You 
must select the target device if you are using an S7 USB connection.

3. Adjust the settings for loading appropriately if they differ from the interfaces or protocols 
available on the PC.

4. Specify whether or not to overwrite the user management and recipe data already stored 
on the HMI device.

5. If necessary, edit the "settings for loading".

6. Click "Transfer".
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Result
The connection to the HMI device is set up via the selected path. An alarm is output if you are 
running different operating system in the project and on the HMI device. 

If this is the case, update the operating system on the HMI device. To update the operating 
system on the HMI device, you need ProSave. A prompt for operating system update will 
appear automatically if ProSave has been installed and the selected connection supports the 
update of the operating system.

Loading via USB interface

Introduction
When you load a project via a USB interface, connect the configuration PC and the HMI device 
with a USB cable. You load projects in both directions. 

Requirements for transfer via USB
The following conditions must be met to ensure successful data transfer using a USB interface:   

● Use a USB host-to-host cable, USB 2.0 standard.

● You have installed the provided USB driver.
You can find the driver on the WinCC product DVD under "Support\DeviceDriver\USB".

● The HMI device being used is based on Windows CE and has a USB interface.

You can find more information on the cables used and the manufacturers/suppliers in the 
Internet at:

● http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
view/en/19142034)

 

  Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the 
WinCC product DVD.

 

  Note
Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This 
driver is installed automatically. 
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Installing a USB driver in Windows XP

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.     

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note

Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This driver 
is installed automatically.  

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB interface.

Procedure
To install the USB driver under Windows XP, follow these steps:

1. Connect the USB host-to-host cable to the USB port of the configuration PC.
The USB cable is automatically detected by the hardware detection under Windows XP. 
The driver installation wizard starts automatically.

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. If you are prompted with "Can Windows connect to Windows Update to search for software", 
select "No, not this time" and click "Next".

3. Select "Install software from a list or specific source" and click "Next".

4. Select "Search removable media".

5. Insert the WinCC product DVD into the DVD drive and click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable. 
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows XP.
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6. Check the selection and click "Next".
 

  Note

The "Hardware installation" dialog box indicates that the software found has not passed 
Windows Logo testing. The Logo test does not have any effects on the functioning of the 
USB driver. Continue with the installation.

 

7. Click "Hardware Installation > Continue installation".
The driver is installed.

8. Click "Finish".
The installation is complete.

Result
The driver for the USB host-to-host cable has been installed. To load the project, connect the 
HMI device to the USB cable.

Installing a USB driver in Windows 7

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.     

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note
Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This driver 
is installed automatically.

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB interface.
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Procedure
To install the USB driver under Windows 7, follow these steps:

1. Connect the USB host-to-host cable to the PC's USB port.
The USB cable is detected, but the wizard for the driver installation does not find the driver. 

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. Open the Device Manager in the Control Panel.

3. Select "Other devices > USB host-to-host cable".

4. Select "USB host-to-host cable" and then select "Update driver software..." in the shortcut 
menu.

5. When the "How do you want to search for driver software?" prompt appears, select "Search 
for driver software on the computer".

6. Click "Update driver software > Browse...".

7. Insert the WinCC product DVD as the source for driver installation.

8. Select "Include subfolders" and then click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable.
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows 7. 

9. Check the selection and click "Next".

10.To continue with the installation, click "Hardware Installation > Continue installation".
The driver is installed.

11.Click "Finish".
The installation is complete.

Result
The driver required for the USB host-to-host cable has been installed. To load the project, now 
connect the HMI device to the USB cable.
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9.12.1.4 Starting Runtime

Starting Runtime on the configuration PC

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. During 
startup of the project in Runtime, the project settings made in the "Runtime settings" of the 
HMI device are activated.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

Requirements
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure     
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 

Starting Runtime Advanced and Panels

Introduction
You can start the project in Runtime as soon as you have downloaded the project to the HMI 
device. The project is generally started automatically on the HMI device. 

There may be several projects in the file system of the HMI device for HMI devices with Runtime 
Advanced. You can start one of these projects in Runtime. 

The project settings defined in the "Runtime settings" of the HMI device are activated when 
the project is started in Runtime. Make sure when defining the Runtime settings "Lock task 
switching" and "Full screen" that you will be able to stop Runtime again. You can, for example, 
configure a button with the system function "StopRuntime".
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Requirements
● WinCC Runtime Advanced or Panels is installed on the HMI device.

● The project was downloaded to the HMI device

Starting Runtime on a PC   
The compiled project is saved in the PC file system with the extension "*.fwc" and is freely 
accessible.

1. To start the project once the HMI device has booted up, enter the automatic start of a project 
file under "Settings" in the "RT Loader" ("HmiLoad.exe").
You can also create a link to the project file in the Windows Autostart directory.

Starting Runtime on a panel   
The project will be stored on a panel in a folder you specify in the HMI device transfer settings. 
The "RT Loader" application is started on a panel. The project loaded is started automatically 
after expiration of the configured delay.

If the project does not start automatically:

1. Click on "Start" to start the loaded project.

Refer to the documentation for the HMI device for additional information on startup of projects. 

Result
Runtime is started on the HMI device. 

See also
Starting and stopping the debugger (Page 1793)

9.12.1.5 Simulating projects

Simulation

Simulation basics

Introduction
You can use the simulator to test the performance of your configuration on the configuration 
PC. This allows you to quickly locate any logical configuration errors before productive 
operation. 

You can start the simulator as follows:
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● In the shortcut menu of the HMI device or in a screen: "Start simulation"

● Menu command "Online > Simulation > [Start|With tag simulator|With script debugger]"

● Under "Visualization > Simulate device" in the portal view.

Requirement
The simulation/runtime component is installed on the configuration PC. 

Field of application
You can use the simulator to test the following functions of the HMI system, for example:

● Checking limit levels and alarm outputs

● Consistency of interrupts

● Configured interrupt simulation

● Configured warnings

● Configured error messages

● Check of status displays

WinCC Runtime Advanced simulation

Introduction
There are two different simulation modes for Runtime Advanced simulation:

● Device simulation

● Tag simulation

Both types of simulation simulate the project without a direct process link to the configuration 
PC. Data such as logs or recipes generated during simulation are not deleted. This data is 
saved on the configuration PC in the paths configured in the project. 

Device simulation
Use device simulation to simulate operator control of the HMI device. Device simulation is, for 
example, used to test screen switching. 

Tag simulation
Use tag simulation to simulate the configured process tags. You can either have tag values 
generated automatically by a simulation table or define tag values yourself. 
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Simulating a project

Introduction
You simulate your project with one of the following two methods:

● Without a connected PLC
You change the value of area pointers and tags in a tag simulator that is read for the 
simulation of WinCC Runtime.

● With a connected PLC without a running process
You simulate your project by running it directly in Runtime. The tags and area pointers 
become active. This allows you to create an authentic simulation of your configured HMI 
device in Runtime. 

 

  Note
Simulation restrictions

You cannot simulate the following system functions:
● CalibrateTouchScreen

You cannot simulate the Media Player. A static screen appears in the simulation window 
instead of the Media Player.

File access via scripts is not possible for HMI devices with Windows CE.
 

Requirement
● Simulation without a connected PLC: Tags have been created

● Simulation with a connected PLC but no active process: A project with tags and area 
pointers has been created

Procedure   
To simulate a project using the tag simulator, follow these steps:

1. Open the project on the configuration PC.

2. Select the "Online > Simulation > With tag simulator" menu command.
For initial project simulation, the simulator is started with a new, empty table. The project 
is opened simultaneously in Runtime. 
Toggle between the tag simulator and Runtime using the <Alt +Tab> key combination.

3. To simulate a process value, select the corresponding "tag" from the tag simulator.
The table lists all configured tags. You can simulate up to 300 tags simultaneously. 

4. Select the simulation mode in the "Simulation" column.

5. Change the value of tags and area pointers in the respective columns.

6. Activate the "Start" check box to start the simulation for this tag.

7. To save the simulation, select the menu command "File > Save" and enter a descriptive 
name, for example, "Mixing".
The file name is assigned the extension "*.cors". 
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Result
The process values are simulated in Runtime. The tag values are created at random, or 
incremented, depending on the simulation mode. 

To specify tag values, change the simulation mode to "<Display" and enter a value at "Set 
value". 

The following figure shows a tag simulator with four tags whose values can be determined at 
random in a range of values from 10 to 1000:

Managing simulation data
If you have saved data from a previous simulation, you can open the file at a later point in time 
and simulate your project again. The tags and area pointers listed in the tag simulator must 
still be available in the project. 

Proceed as follows to open a simulation file: 

1. Select the menu command "Online > Simulate Runtime > With tag simulator".

2. Select the menu command "File > Open" in the tag simulator.

3. Select the corresponding simulation file and click "Open".
The simulator loads the stored data.

Enabling and disabling tags
Start and stop the simulation for each tag separately in order to facilitate the transition from 
offline to online engineering. Activate "Start" in the corresponding row.

If a tag is activated, the simulation values are calculated and transferred to the WinCC 
simulator.

Deleting a tag
To delete a tag from the tag simulator, follow these steps:

1. Select the cell that contains the tag name.

2. Select the "Edit > Cut" menu command.
The tag is removed from the table. 
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Simulating a screen

Introduction
If you have only made changes to one screen, you can temporarily specify this screen as the 
start screen for simulation. In this way, you can debug changes without having to modify the 
start screen, or opening the screen on the HMI device. 

Requirements
You created a project that contains at least one screen. 

Procedure  
To define a screen as temporary start screen for simulation, follow these steps:

1. In the project navigation, select the image to display as the start screen in the simulation.

2. Select the "Start simulation" command from the shortcut menu of the screen.

Result
Project simulation is started. Instead of the configured start screen, the simulation window the 
screen you selected in the project navigation. 

Working with the tag simulator

About the tag simulator
The tag simulator has the following columns:

Column Description
Tag Specifies the tags for the simulation. 
Data type Shows the data type of the selected tag.
Current value Shows the simulated value of the defined tags.
Format Specifies the selected format in which the tag values are simulated: 

● Decimal (1, 2, 3, 4, ...)
● Hexadecimal (03CE, 01F3, ...)
● Binary (0 and 1)

Write cycle Specifies the selected time interval at which the current tag values are simulated. If 
you enter "2", for example, the current value of the tag will be shown every 2 seconds.

Simulation Shows the method by which the tag values are processed during simulation. 
Set value Sets the selected value for the respective tag. The simulation start with the specified 

value.
minValue 
maxValue

Specifies the value range of the tag. You set a minimum and maximum value for this 
range. The default values are -32768 for the minimum and 32767 for the maximum.
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Column Description
Period Contains the period during which the value of the tag is repeated for the "Increment" 

and "Decrement" simulation modes.
Start Starts simulation of the tag based on the previously entered information.

Simulation modes
The simulator has six different simulation modes. The configured tags are supplied with nearly 
realistic values during the simulation. 

Simulation mode Description
Sinusoidal Changes the tag value to form a sinusoidal curve. The value is visualized as a 

periodic, non-linear function.
Random Provides randomly generated values. The tag value is changed by means of a 

random function.
Increment Increases the value of the tag continuously up to a specified maximum value. 

Begins again at the minimum after the maximum has been reached. The value 
trend corresponds to a positive saw-tooth curve.

Decrement Reduces the value of the tag continuously down to a specified minimum value. 
Begins again at the maximum after the minimum has been reached. The value 
curve corresponds to a negative saw-tooth curve.

Shift bit Shifts a set bit continuously by one position. The previous position is always reset. 
This lets you test the alarms of an HMI device, for example.

<Display> The current tag value is displayed statically.

Example: Simulate tags with the "Shift bit" simulation mode
Proceed as follows to simulate tags with the "Shift bit" simulation mode:

1. Open the project you want to simulate.

2. Select the menu command "Online > Simulate Runtime > With tag simulator".
The tag simulator opens.

3. In the "Tag" column, select a tag from your project.

4. Select "Bin" in the "Format" column.

5. Enter the value "1" in the "Write cycle" column.

6. Select the "Shift bit" simulation mode in the "Simulation" column.

7. Enter the value "1" in the "Set value" column.

8. Enable the tag with the "Start" check box.
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Result
The simulator tests the selected tag bit-by-bit as follows:

Simulation values Byte for alarms
Set start value 00000001
1. Simulation value 00000010
2. Simulation value 00000100
3. Simulation value 00001000
.... ...

In Runtime you see if the desired alarm is output at a given value. 

Working with the debugger

Debugging scripts

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.   

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".
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Error types
The following error types are distinguished when debugging:      

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

For tips and tricks on debugging, common sources of error, and further information, refer to 
the online help for the Microsoft Script Debugger.

 

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

See also
Debugging (Page 1786)

Start debugger

Introduction
Select the "With script debugger" script mode to test scripts. The debugger allows you to set 
breakpoints in the code, for example, or implement a script step by step.
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Requirements
● A debugger that supports VBS is installed on the Engineering Station, e.g. "MS Script 

Debugger".

● WinCC Runtime is installed on the Engineering Station.

● A project is open.

Procedure  
1. Select the "Online > Simulation > With script debugger" menu command.

The Runtime software searches for debuggers installed on the Engineering Station. 

2. If several debuggers are found, click on a selected.

Result
The debugger is connected automatically with the runtime software. 

9.12.2 Compiling, downloading and simulating projects

9.12.2.1 Overview of compiling and loading projects

Overview   
The project is compiled in the background even as you are configuring it in WinCC. This 
reduces the time for final compilation. When you start compilation, you create a file that can 
be run on the corresponding HMI device. 

If an error occurs during compilation, WinCC provides support in locating and correcting it.

Once you have corrected any problems, you download the compiled project to the HMI devices 
on which the project is to run. If the configuration PC is not connected to the HMI device, save 
the compiled project on a data medium of your choice. The compiled project is then transferred 
from a PC connected to the HMI device to the HMI device. 

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device.

Project
The term "project" has two different meanings in the contexts of compilation and loading. 
"Project" is the WinCC project on the configuration PC. "Project" is also the Runtime project 
you create by compiling the configuration data of an HMI device and download to the HMI 
device. 

● WinCC project: contains the configuration data of one or more HMI devices

● Runtime project: contains the compiled configuration data of an HMI device
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The figure below illustrates the link between WinCC projects and Runtime projects using the 
example of the "Compile and load" process:

Runtime
Runtime is the software for process visualization. In Runtime, you execute the project in 
process mode. 

A distinction is made between two types of Runtime:

1. Runtime on a panel
Before executing a Runtime project on a panel, you have to transfer the Runtime project 
to the panel before startup.

2. Runtime on a PC
You can execute the Runtime project directly on the configuration PC if Runtime has been 
installed on the configuration PC. 
If you want to execute the Runtime project on a different PC, you have to transfer the 
Runtime project to the PC before startup.

Simulation
You test your configuration with a simulation. You can start a simulation without a link to the 
active process.

In a simulation, you test configured tags or screen changes, for example. During the simulation, 
the configured tags can be manipulated, activated and deactivated with the help of the tag 
simulator. 

There are two types of simulation:
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1. Simulating a panel
If you created a panel in your project, the panel is displayed in the simulation. With the help 
of this type of simulation, you can test your configuration on the HMI device without 
transferring the project to the panel.

2. Simulating Runtime
Simulating Runtime allows you to test the project directly on the configuration PC. 

See also
Generating a "Pack&Go" file (Page 2191)

Starting Runtime Advanced and Panels (Page 2197)

9.12.2.2 Compiling a project

Introduction   
The changes made to the project are compiled in the background even as you are configuring 
a project in WinCC. Projects are compiled automatically when you load them. This ensures 
that the latest version of the project is loaded at all times.

WinCC checks consistency of the project during compilation. The error locations in the project 
are listed in the Inspector window. You can jump directly to the source of the error from the 
entry in the Inspector window. Check and correct errors found.

Scope of the compilation
Configuration data is compiled in the background as soon as you start configuring an HMI 
device. If you compile a project manually, only the changes in the configuration made since 
the last compilation process are compiled in the background. 

You can start complete project compilation manually at any time; this may, for example, be 
done to test the consistency of the configured data.

Requirement
● A project is open.

Procedure
Proceed as follows to compile a project:

1. If you want to compile several HMI devices at the same time, select all the relevant HMI 
devices with multiple selection in the project tree.

2. Compile the project:

– For delta compilation of the project, select the "Compile > Software" command from the 
shortcut menu of the HMI device.

– To compile all project data, select the "Compile > Software (compile all)" command from 
the shortcut menu.
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Result
The configuration data of all selected HMI devices is compiled. Any errors that occur during 
compilation are shown in the Inspector window. 

9.12.2.3 Loading projects

Overview for loading of projects

Overview
Delta data of the project is automatically compiled before you download it to one or several 
HMI devices. This always ensures that the latest version of the project is transferred. 

Loading a project to an HMI device   
The following steps are completed prior to downloading:

1. The download settings are verified. The "Extended loading" dialog box is opened 
automatically during the initial download of a project to an HMI device. You use this dialog 
to define the protocol and interface or destination path for the project in accordance with 
the HMI device Runtime used.
If, for example, the HMI device is part of a subnetwork, you also select the subnetwork and 
the 1st gateway.
You can call the "Extended loading" dialog at any time with the menu command "Online > 
Advanced download to device...". 
The "Load preview" dialog opens. 

2. The project is compiled. Warnings and errors during compilation are displayed in the 
Inspector window and in the "Load preview" dialog.

3. The "Load preview" dialog shows you the following information for each HMI device:

– The individual steps for loading

– Presettings that take effect at loading. You can change the default settings for this 
download process, if necessary.

– Warning events (optional). You can download a project while ignoring the "warnings". 
The functionality may be restricted in Runtime.

– Error events (optional). You cannot load the project. Eliminate the errors and then reload 
the project.
WinCC will open the invalid configuration in the corresponding editor if you double-click 
the error message in the Inspector window. Correct the errors and reload the project.

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device. 
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Loading a project without a connected HMI device   
If you cannot establish a direct connection from the configuration PC to the HMI device, save 
the compiled project on a data medium of your choice. Additional steps depend on the Runtime 
used:

● Panel Runtime: Copy the compiled project to a PC connected to the HMI device, for 
example, via a network. Download the project from this PC to the HMI device ("Pack&Go").

● Runtime Advanced: Move the compiled project to the HMI device.

Loading with S7 routing
Configure the S7 routing settings in the "Devices & Networks" editor in the relevant PLC. The 
settings depend on the device configured. 

S7 routing supports the following protocols:

● MPI/PROFIBUS

● Ethernet

Loading a project

Introduction
Before a project can run on an HMI device, you must first load it to the HMI device. During 
loading, you must most importantly specify whether existing data on the HMI device such as 
"user administration" and "recipe data" is to be overwritten. As a general rule, only one project 
can be active in Runtime on an HMI device.

If the HMI device supports PROFINET, the name of the HMI device registered in the project 
navigation is used as the device name for the PROFINET communication. The name is written 
during download to the HMI device. If a device name for the PROFINET communication has 
already been entered in the HMI device, it will be overwritten. 

Please note the following when downloading a project to an HMI device: 

● You can download a project from the configuration PC to the HMI device if no project is 
open or in Runtime on the HMI device.

● If a project is open on the HMI device, you can only completely reload this particular project 
from the configuration PC to the HMI device. Close the project open on the HMI device to 
download a different project to the HMI device.
Example: The project "Mixing" is open on the HMI device but not in Runtime. If you change 
the project, download the changes to the HMI device with "Software (all)". Close the project 
"Mixing" on the HMI device to download the project "Bottling" to the HMI device, for example. 

● You can load certain changes to the configuration data without stopping Runtime (delta 
loading) if a project is in Runtime on the HMI device. You will be notified if a change means 
delta loading is no longer possible. If delta loading is no longer possible, you will only be 
able to download the project to the HMI device using "Load (completely)". Runtime is 
disabled, which may result in plant downtime.
You will have to exit Runtime and close the project on the HMI device to download another 
project to the HMI device. 
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Requirement
● You have created an HMI device in the project.

● The HMI device is connected to the configuration PC.

Procedure   
Proceed as follows to load a project:

1. To download a project simultaneously to several HMI devices, select the HMI devices by 
means of multiple selection in the project navigation.

2. Select the "Download to device > Software" command from the shortcut menu of the HMI 
device.

3. If the "Extended loading" dialog opens:

– Select the "destination path" for the compiled project on the HMI device.
The Windows user group "SIMATIC HMI" must have full access to this destination path. 
Full access is usually set during installation of WinCC Runtime for the "WinCC Projects" 
file. The location of this folder in the file system depends on the operating system of the 
HMI device. 

– Click "Download".

You can call the "Extended loading" dialog at any time with the menu command "Online > 
Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result is 
displayed in the "Load preview" dialog.

4. Check the displayed presettings and change them as necessary.

5. Click "Download".

Result
The project is loaded to all selected HMI devices. If errors or warnings occur during the 
download, corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

See also
Activating and deactivating projects on the WinCC server (Page 2537)

Overview of online delta transfers (Page 2217)
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Generating a "Pack&Go" file

Introduction
Create a "Pack&Go" file if you cannot connect the HMI device to the configuration PC. The 
"Pack&Go" file is a ZIP file containing the following data:

● The compiled project

● A program for transferring the project to the HMI device

● The operating system image for the configured HMI device

Typical example of an application: An engineering company creates a project variant for a new 
HMI device. The project engineer of the engineering company does not have direct access to 
the plant. The project engineer therefore e-mails the "Pack&Go" file to his local contact. The 
contact unpacks the "Pack&Go" file on a PC connected to the HMI device via a network. He 
then transfers the project from the PC to the HMI device.

Requirement
● You have created an HMI device in the project.

Procedure   
To create a "Pack&Go" file, follow these steps:

1. Select the HMI device in the project navigation.

2. Select the "Pack&Go" command from the menu under "Online > HMI device maintenance".

1. The "Create Pack&Go file" opens.

2. Select a protocol as transfer mode.

3. Select the storage location under "Pack&Go file" and enter the file name.

4. If necessary, specify if the "Pack&Go" file is split into several files.

5. Click "Create".

Result
The "Pack&Go" file is created and saved to the specified folder in the file system. Now copy 
the "Pack&Go" file to the PC connected to the HMI device.
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Downloading projects from a "Pack&Go" file to the HMI device

Requirement
● The "Pack&Go" file has been stored in the file system of a PC.

● The PC is connected to the HMI device.

● The HMI device operating system version is the same as the operating system version in 
the project.

Procedure   
To download the project from a "Pack&Go" file to an HMI device, follow these steps:

1. Unpack the "Pack&Go" file to a folder of your choice in the file system of the PC.

2. From the "PackNGo" subfolder of this directory, run "Siemens.Simatic.Hmi.PackNgo.exe".
The "Pack'n Go" dialog opens. The settings for loading are set by default. Exception: You 
must select the target device if you are using an S7 USB connection.

3. Adjust the settings for loading appropriately if they differ from the interfaces or protocols 
available on the PC.

4. Specify whether or not to overwrite the user management and recipe data already stored 
on the HMI device.

5. If necessary, edit the "settings for loading".

6. Click "Transfer".

Result
The connection to the HMI device is set up via the selected path. An alarm is output if you are 
running different operating system in the project and on the HMI device. 

If this is the case, update the operating system on the HMI device. To update the operating 
system on the HMI device, you need ProSave. A prompt for operating system update will 
appear automatically if ProSave has been installed and the selected connection supports the 
update of the operating system.

Loading via USB interface

Introduction
When you load a project via a USB interface, connect the configuration PC and the HMI device 
with a USB cable. You load projects in both directions. 
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Requirements for transfer via USB
The following conditions must be met to ensure successful data transfer using a USB interface:   

● Use a USB host-to-host cable, USB 2.0 standard.

● You have installed the provided USB driver.
You can find the driver on the WinCC product DVD under "Support\DeviceDriver\USB".

● The HMI device being used is based on Windows CE and has a USB interface.

You can find more information on the cables used and the manufacturers/suppliers in the 
Internet at:

● Auto-Hotspot
 

  Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the 
WinCC product DVD.

 

  Note
Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This 
driver is installed automatically. 

 

 

Installing a USB driver in Windows XP

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.     

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note

Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This driver 
is installed automatically.  
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Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB interface.

Procedure
To install the USB driver under Windows XP, follow these steps:

1. Connect the USB host-to-host cable to the USB port of the configuration PC.
The USB cable is automatically detected by the hardware detection under Windows XP. 
The driver installation wizard starts automatically.

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. If you are prompted with "Can Windows connect to Windows Update to search for software", 
select "No, not this time" and click "Next".

3. Select "Install software from a list or specific source" and click "Next".

4. Select "Search removable media".

5. Insert the WinCC product DVD into the DVD drive and click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable. 
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows XP.

6. Check the selection and click "Next".
 

  Note

The "Hardware installation" dialog box indicates that the software found has not passed 
Windows Logo testing. The Logo test does not have any effects on the functioning of the 
USB driver. Continue with the installation.

 

7. Click "Hardware Installation > Continue installation".
The driver is installed.

8. Click "Finish".
The installation is complete.

Result
The driver for the USB host-to-host cable has been installed. To load the project, connect the 
HMI device to the USB cable.
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Installing a USB driver in Windows 7

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.     

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note
Comfort HMI devices

Use the micro USB interface to load projects via USB with Comfort HMI devices. This driver 
is installed automatically.

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB interface.

Procedure
To install the USB driver under Windows 7, follow these steps:

1. Connect the USB host-to-host cable to the PC's USB port.
The USB cable is detected, but the wizard for the driver installation does not find the driver. 

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. Open the Device Manager in the Control Panel.

3. Select "Other devices > USB host-to-host cable".

4. Select "USB host-to-host cable" and then select "Update driver software..." in the shortcut 
menu.

5. When the "How do you want to search for driver software?" prompt appears, select "Search 
for driver software on the computer".

6. Click "Update driver software > Browse...".

7. Insert the WinCC product DVD as the source for driver installation.
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8. Select "Include subfolders" and then click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable.
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows 7. 

9. Check the selection and click "Next".

10.To continue with the installation, click "Hardware Installation > Continue installation".
The driver is installed.

11.Click "Finish".
The installation is complete.

Result
The driver required for the USB host-to-host cable has been installed. To load the project, now 
connect the HMI device to the USB cable.

Online delta transfer for Runtime Professional

Overview of online delta transfers

Online delta loading    
WinCC lets you edit a project on the configuration PC while the same project is active in 
Runtime. You can in most cases load the configuration changes to the HMI devices using 
"Online delta loading" if you change the project on the configuration PC. Online delta loading 
requires less time compared to the transfer of the entire project.

The "Load preview" dialog opens for online delta loading. In this dialog you specify whether 
user administration or logs, which have been changed on the HMI device in the meantime, are 
overwritten or retained during online delta loading. 

 

 NOTICE

Changes to the project made in the meantime on the HMI device, for example in the user 
management or in the logs, are lost during the online delta loading. 

 

Complete transfer
Fundamental changes to configuration data may prevent the online delta transfer. In this case, 
a message informs you of the failure of the online delta loading after you initiated the transfer.  
You then have to reload the entire project to the HMI device. You must explicitly confirm this 
Runtime restart on the HMI device in the "Load" dialog. You can cancel loading at this point. 

The following will happen if you start complete loading while the project on the configuration 
PC is in Runtime on the HMI device:
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● Runtime is stopped

● The entire project is downloaded to the HMI device

● Runtime is restarted

Note that starting and stopping of Runtime can result in plant downtime. 

Application scenarios
You will have to adapt your configuration in various different phases of your project, for 
example, commissioning, operation and maintenance. You can then transfer these changes 
to the HMI device online without having to exit Runtime. 

Cases in which online delta loading is used include:

● Continuous automation tasks:
All changes should be made online from a central configuration PC. This saves you having 
to make changes to the configuration locally. You can also add, change and delete runtime 
Runtime objects such as tags, alarms and logs without having to exit Runtime.

● Testing changes in a protected environment:
You can perform the planned changes offline on the configuration PC before these are 
downloaded to the HMI device. Project engineers can simulate the changes in a protected 
environment before activating the delta data in the process. This allows you to identify and 
clear configuration errors before they can cause any problems in the process or lead to a 
plant shutdown. 

See also
Starting Runtime on the configuration PC (Page 2197)

Use and limitations of online delta loading

Introduction    
The online delta loading capability is lost in some configurations.

Files and elements
The table below shows for which actions the online delta transfer capability is retained and for 
which actions it is not retained:

Element Create Delete Edit Remarks
Project name/properties of the 
project

- - No -

HMI device Yes No No -
Properties of the HMI device - - No Edit:

Changes are only activated in Runtime by 
deactivating the project and restarting 
Runtime.
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Element Create Delete Edit Remarks
User cycle
(project properties)

No No No -

Connections
("HMI Tags" editor)

No No No -

Parameter of a connection
("HMI Tags" editor)

No No No -

Alarms - - - See the "Online configuration for alarms" 
table below

Menus and toolbars No No No -

Online configuration for alarms

Element Attribute Create Delete Edit Remarks
- ● Alarm number

● Alarm group
- - No -

- ● Alarm class Yes No Yes Inactive alarms are updated 
immediately if you change the 
alarm class without changing 
mandatory acknowledgment.
If the mandatory 
acknowledgment of a 
currently active alarm and of 
an unacknowledged alarm is 
changed, the system 
acknowledges the active 
alarm.
An active alarm that is 
changed to an alarm without 
"deactivated" state will be 
deactivated.

User-defined alarm group - Yes No Yes -
Limit values for analog 
alarms

- No No No -

Alarm classes - Yes No Yes Edit:
Valid for most attributes. 
Exceptions are listed 
individually:
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9.12.2.4 Starting Runtime

Starting Runtime on the configuration PC

Introduction
You can start your project in Runtime on the configuration PC while you are performing 
configuration in WinCC. The following restrictions apply to online configuration:

● The project cannot be compiled in the background while Runtime is running on the 
configuration PC.

● The delta data of the project is compiled automatically when you load the project to an HMI 
device after having closed Runtime. You can also start compilation manually.

● During startup of the project in Runtime, the project settings made in the "Runtime settings" 
of the HMI device are activated.

● If Runtime is running on the configuration PC, most changes are applied after compilation. 

– Certain changes require a restart of Runtime for their activation. 

– Changes to the screen that is currently open become visible after a screen change. 

– With some changes, the option to compile configuration changes to the active Runtime 
is lost. The message that this option has been lost is only displayed when the project is 
compiled. 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

Procedure     
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device with Runtime Professional in the project tree.

2. Select the "Online > Start Runtime" menu command.

3. To transfer configuration changes to the the active Runtime, select the "Compile > 
Software" command from the shortcut menu of the HMI device.

Result
Runtime is started and the updated project displayed on the configuration PC. 

See also
Use and limitations of online delta loading (Page 2218)
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Starting Runtime Professional

Introduction             
Runtime in started on a configuration PC with installed WinCC Runtime via the WinCC menu 
bar. If only WinCC Runtime is installed on an HMI device, load the project to the HMI device. 
Use the "WinCC StartTool" for starting the project. 

Requirements
"WinCC Runtime" is installed on the HMI device. 

 

 Note

A least 100 MB free memory must be available on the storage medium before the Runtime 
of a project can be started.

 

Starting Runtime at an Engineering Station
1. Open the desired project in WinCC.

2. Select the "Start Runtime" command from the "Online" menu.

Result
The project is compiled and activated. During activation, all Runtime services that you selected 
in the Runtime settings of the HMI devices are started. 

See also
Activating and deactivating projects on the WinCC server (Page 2537)

9.12.2.5 Simulating projects

Simulation

Simulation basics

Introduction
You can use the simulator to test the performance of your configuration on the configuration 
PC. This allows you to quickly locate any logical configuration errors before productive 
operation. 

You can start the simulator as follows:
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● In the shortcut menu of the HMI device or in a screen: "Start simulation"

● Menu command "Online > Simulation > [Start|With tag simulator|With script debugger]"

● Under "Visualization > Simulate device" in the portal view.

Requirement
The simulation/runtime component is installed on the configuration PC. 

Field of application
You can use the simulator to test the following functions of the HMI system, for example:

● Checking limit levels and alarm outputs

● Consistency of interrupts

● Configured interrupt simulation

● Configured warnings

● Configured error messages

● Check of status displays

Runtime Professional simulation

Introduction
Simulating Runtime Professional allows you to test the project with process link directly on the 
configuration PC. You can also test the tags using the tag simulator. 

Function
Both process values and alarms are saved to a simulation log. The data generated is deleted 
from this log when you exit simulation mode.

The Runtime database is restored to the original state it had prior to simulation. Any changes 
to project data made during Runtime will be lost. You use the tag simulator to simulate the 
assignment of various values to the tags in your project. 

Project logging and backup operations are continued during simulation.
 

 WARNING

Possible damage to the plant

If you have changed tag values during the simulation with a PLC connection, unforeseen 
plant states can result in irreparable damage to the plant. Therefore, limit manual value 
manipulation to a minimum and select the test values carefully.
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Limitations
Client-server operation is not possible during simulation. 

Simulating a project

Requirement
The project is open in the configuration PC.

 

 Note

The tag values of faulty connections to the process cannot be simulated.
 

Procedure
Proceed as follows to simulate a project:

1. Disconnect the connection to the controller or switch the controller off if you do not want to 
test the function of the entire process.

2. Select the menu command "Online > Simulate Runtime > With tag simulator".
Runtime starts and the simulator opens with all the configured tags.

3. Select the "New tag" command in the "Edit" menu to add a tag to the tag simulator.

4. Select the tag from the WinCC tag management.

5. In the tag simulator, select the required tag on the "Tags" tab to supply a tag with simulated 
values.

6. Configure the simulation mode on the "Properties" tab:

– Select the simulation mode.

– Enter values for the simulation.

– Click "Active" to include the tag in the simulation.
 

 
 WARNING

Make sure once again that the configuration computer cannot pass any changed tags 
to the PLC in the active process. If you have not switched the PLC off, the simulated 
tag values will be passed to the PLC and the runtime process. 

 

7. Click the "Start simulation" button on the "Properties" tab.

8. Observe the effect the simulation has on your project in Runtime.

9. Click on the "Stop simulation" button to stop the simulation.

10.To save the settings for the simulation, select the menu command "File > Save" and enter 
a corresponding name.
The file is automatically given the *.sim extension.
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Managing simulation data
If you have saved data from a previous simulation, you can open the file at a later point in time 
and simulate your project again. The tags and area pointers to be simulated must remain 
unchanged in the project, otherwise the saved simulation data will no longer match your project. 

Proceed as follows to open a simulation file: 

1. Select the menu command "Online > Simulate Runtime > With tag simulator".

2. Select the menu command "File > Open" in the tag simulator.

3. Select the corresponding simulation file and click "Open".
The simulator loads the stored data.

Enabling and disabling tags
You can start and stop the simulation for each individual tag to enable a bumpless transition 
from the offline configuration to online configuration. Enable the "Active" check box in the 
"Properties" tab for this purpose.

When a tag is enabled, the simulation values are calculated and transferred to the tag simulator.

Deleting a tag
To delete a tag from the tag simulator, follow these steps:

1. Select the tag name.

2. Select the menu command "Edit > Delete".

The tag is removed from the table. 

Simulating a screen

Introduction
If you have only made changes to one screen, you can temporarily specify this screen as the 
start screen for simulation. In this way, you can debug changes without having to modify the 
start screen, or opening the screen on the HMI device. 

Requirements
You created a project that contains at least one screen. 

Procedure  
To define a screen as temporary start screen for simulation, follow these steps:

1. In the project navigation, select the image to display as the start screen in the simulation.

2. Select the "Start simulation" command from the shortcut menu of the screen.
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Result
Project simulation is started. Instead of the configured start screen, the simulation window the 
screen you selected in the project navigation. 

Working with the tag simulator

Simulation modes
The simulator has six different simulation modes. The configured tags are supplied with nearly 
realistic values during the simulation depending on the simulation mode. 

Simulation mode Description
Sinusoidal Changes the value of the tag to form a sinusoidal curve. The value is visualized 

as a periodic, non-linear function.
Settings:
● Amplitude
● Offset (zero point for value range)
● Period of oscillation

Oscillation For simulating jumps in a setpoint.
Settings:
● Overshoot
● Setpoint
● Period of oscillation
● Damping

Random Provides randomly generated values. The tag value is changed by means of a 
random function.
Settings:
● Minimum value
● Maximum value

Increment Increases the value of the tag continuously up to a specified maximum value. 
Begins again at the minimum after the maximum has been reached. The value 
trend corresponds to a positive saw-tooth curve.
Settings:
● Start value
● End value

Decrement Decreases the value of the tag continuously down to a specified minimum value. 
Begins again at the maximum after the minimum has been reached. The value 
curve corresponds to a negative saw-tooth curve.
Settings:
● Start value
● End value

Slider Sets a fixed value.
Settings:
● Minimum
● Maximum

Visualizing processes (Professional)
9.12 Compiling and loading

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2225



Working with the debugger

Debugging user-defined VB functions

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.   

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".

 

Error types
The following error types are distinguished when debugging:      

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.
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Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

For tips and tricks on debugging, common sources of error, and further information, refer to 
the online help for the Microsoft Script Debugger.

 

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

9.12.3 Servicing the HMI device

9.12.3.1 ProSave

Introduction  
The "ProSave" service tool is installed by default when WinCC is installed. The ProSave 
functions are called in WinCC with the menu "Online > HMI device maintenance". 

Functional scope
ProSave provides all of the functions you need to manage data on the HMI device:  

● Data backup and restoration of backed-up data

● Operating system update for HMI devices with Windows CE or below

● Transferring License Keys

● Installing and uninstalling drivers and options as well as information on installed options 
and options that can be installed on an HMI device

● Communication settings (transferred from WinCC)
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9.12.3.2 Backup of HMI data

Introduction       
Regular backups of HMI device data keep downtimes to a minimum, for example, when you 
replace a device. You simply transfer the backup data to the HMI device, restoring the original 
status. 

Data backup with WinCC
If an HMI device is connected to the configuration PC, you can back up and restore HMI device 
data from the configuration PC using WinCC. 

Scope of data backup
Which data is backed up and restored depends on the type of HMI device:

● Complete backup
Depending on the HMI device: Runtime, firmware, operating system image, configuration, 
recipes, user administration, settings

 

  Note

License Keys are only saved for 177, 277 and 377 series HMI devices.

The License Keys are not saved for the following HMI devices:
● all other Windows CE HMI devices
● TP 177A and OP 77A

 

● Recipes only

● User administration only

A backup file with the extension *.psb is generated when you backup the data of an HMI device. 
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As a general rule, you can backup the data to any storage medium. If the HMI device is 
networked, you can also backup the data to a server. 

 

 Note
Scope of data backup for Windows CE HMI devices

Data backup secures the contents of the flash memory. Alarm logs and process value logs 
are generally saved on the external storage medium. Alarm logs and process value logs are 
not backed up. If necessary, back up the contents of the memory card separately. 

Please note the following when performing a complete data file backup and restore operation 
for Windows CE devices:
● A full backup includes all options installed. As a rule, the backup includes all options data 

that is still available after "POWER OFF".
● All data previously stored on the device, including License Keys and the operating system, 

are permanently deleted when complete data restoration is carried out.
● If the data restoration was interrupted, execute the command "Reset to factory settings". 

Restart data restoration.
 

 Note

Use interfaces with high bandwidths, e.g. USB or Ethernet to backup and restore data. 
 

 Note

For Windows CE devices, you can also backup the data directly to a CF or PC card, 
independent of ProSave and WinCC. For additional information, refer to the relevant 
operating instructions.

 

 

See also
Backing up and restoring data of the HMI device (Page 2229)

9.12.3.3 Backing up and restoring data of the HMI device
 

 Note

Use the restore function for project data only on operating devices which were configured 
using the same configuration software. 

 

Requirements
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project navigation.

● If a server is used for data backup: The configuration PC has access to the server
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Backup of the data of the HMI device   
Proceed as follows to backup the data of the HMI device:

1. Select the "Backup" command from the "Online > HMI device maintenance" menu.
The "SIMATIC ProSave" dialog box opens. 

2. Select the data to backup for the HMI device under "Data type".

3. Enter the name of the backup file under "Save as".

4. Click "Start Backup".

This starts the data backup. The backup operation takes some time, depending on the 
connection selected.

Restoring the data of the HMI device    
Proceed as follows to restore the data of the HMI device:

1. Select the "Restore" command from the "Online > HMI device maintenance" menu.

2. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "Content". 

3. Click "Start Restore".

This starts the restoration. This operation takes some time, depending on the connection 
selected.

Backup/Restore from the "Backup/Restore" dialog in the control panel of the HMI device
The "Backup/Restore" function is enabled for MMC, SD memory cards and USB mass storage 
devices. 

See also
Backup of HMI data (Page 2228)

9.12.3.4 Updating the operating system

Introduction
You must update the operating system of the HMI device if its version is not compatible with 
the configuration. The operating system may (following a prompt) be updated automatically 
when the project is loaded, depending on the protocol used. Loading will then continue. 
Loading will otherwise be aborted. In this case, start the operating system update manually. 

 

 Note

The operating system can only be updated on Windows non-PC-based HMI devices.
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Updating the operating system  
Connect the HMI device to the configuration PC to update the operating system of an HMI 
device. If possible, you should use the interface with the highest bandwidth for this connection, 
such as Ethernet. Updating the operating system via a serial connection can take up to an 
hour. 

 

 Note
Transfer of operating systems for MP 377 via PROFIBUS

The size of the image and the baud rates available with PROFIBUS mean image transfer 
with an MP 377 via PROFIBUS can take up to an hour.

Updating the operating system via USB or Ethernet.
 

"Reset to factory settings"  
If the operating system on the HMI device is no longer operational, update the operating system 
and reset the HMI device to the factory settings. 

 

 Note
Resetting to factory settings via Ethernet for Basic Panels

You will require the following to reset the factory settings via Ethernet:
● the MAC address of the HMI device
● the available IP address
● the programming device/PC interface of the configuration PC set to Ethernet TCP/IP

The programming device/PC interface is configured using the control panel of the 
configuration PC. Select" "S7ONLINE (STEP7) -> TCP/IP" in the "Access point of the 
application" field.

 

See also
Updating the operating system on the HMI device (Page 2232)
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9.12.3.5 Updating the operating system on the HMI device
If possible, you should use the interface with the highest bandwidth for this connection, such 
as Ethernet. Updating the operating system via a serial connection can take up to an hour.

 

 CAUTION

Updating the operating system deletes all data on the HMI device

When you update the operating system you delete data on the target system. For this reason, 
it is advisable to backup the following data:
● User administration
● Recipes

Resetting to factory settings also deletes the License Keys. You should also back up the 
License Keys before resetting to factory settings.

 

Requirement
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project navigation.

Updating the operating system   
Proceed as follows to update the operating system:

1. Select the "Update operating system" command from the "Online > HMI device 
maintenance" menu.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image of the operating 
system has been preset. 

1. If necessary, select another path to the operating system image you want to transfer to the 
HMI device.

1. Click "Update OS".

This starts the update. The update operation can take time, depending on the connection 
selected.

Resetting the HMI device to factory settings   
To reset the HMI device to factory settings, proceed as follows:

1. Switch off power to the HMI device.

2. Connect the HMI device to the Engineering Station.

3. Select the "Update operating system" command from the menu under "Online > HMI device 
maintenance" on the configuration PC in WinCC.
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image of the operating 
system has been preset. 

4. If necessary, select another path to the operating system image you want to transfer to the 
HMI device.
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5. Activate "Reset to factory settings".

6. Click "Update OS".

7. To "Reset to factory settings", switch on power to the HMI device again.
This operation can take time.

Result
The operating system of the HMI device is operational and up-to-date.

See also
Updating the operating system (Page 2230)

Transferring license keys (Page 2233)

Managing licenses (Page 2234)

Overview for loading of projects (Page 2189)

Backing up and restoring data of the HMI device (Page 2229)

9.12.3.6 Transferring license keys

Introduction  
You need a license for certain WinCC Runtime options you may want to install on an HMI 
device. Usually, the necessary licenses supplied as "License Keys" on a data medium, e.g. 
USB stick. The "License Keys" can also be made available on a license server. 

Use "Automation License Manager" to transfer the "License Keys" to or from an HMI device. 
The "Automation License Manager" is included automatically when you install WinCC. 

 

 CAUTION

Backing up License Keys

In the following cases you have to backup the "License Keys" in order to prevent deletion of  
the "License Keys":
● Prior to the update of the operating system of a Windows CE HMI device
● Prior to restoring the data from a full backup

"License Keys" on an HMI device are backed up depending on the HMI device 
configuration. For more information, refer to the operating instructions of the 
corresponding HMI device.

 

See also
Managing licenses (Page 2234)
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9.12.3.7 Managing licenses

Requirement
● The HMI device is connected to the configuration PC or the PC running the "Automation 

License Manager".

● If you are using the configuration PC: The HMI device is selected in the project navigation.

Procedure      
To transfer license key, proceed as follows:

1. Open the "Automation License Manager". Go to the Windows Start menu and start 
"Automation License Manager" on a PC on which WinCC is not installed.
The "Automation License Manager" starts. 

2. Select the "Connect HMI device" command from the "Edit > Connect target system" menu.
The "Connect target system" dialog opens. 

3. Select the HMI device type in the "Device type" area.

4. Select the "Connection".

5. Configure the "connection parameters" associated with the selected connection.
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6. Click "OK."
The connection to the HMI device is now set up. The connected HMI device is displayed 
in the left pane of "Automation License Manager".

7. Transfer the "License Keys" to the HMI device:

– In the left pane, select the drive on which the "License Keys" are located.
The "License Keys" are displayed on the right pane. 

– Select the "License Keys"

– Drag-and-drop the "License Keys" to the HMI device.

You can also remove License Keys from the HMI device using drag-and-drop.

Alternative procedure
You can also start the "Automation License Manager" from WinCC on a PC with a WinCC 
installation: Select the "Authorize/License" command in the "Online > HMI device 
maintenance" menu.

Result
The "License Keys" are transferred to the HMI device. 

To backup the "License Keys" from the HMI device, drag-and-drop the "License Keys" from 
the HMI device to an available drive. 

See also
Transferring license keys (Page 2233)

9.12.3.8 Installing and uninstalling an option

Introduction
You can install the following options on an HMI device: 

● Additional options supplied with WinCC

● Options purchased in addition to WinCC

Which options you can install depends on the HMI device type. 

Requirements
● The HMI device is connected to the Engineering Station, or to the PC with ProSave.

● The HMI device is selected in the project navigation.
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Procedure         
To install an option on the HMI device, proceed as follows:

1. Select the "Options" command from the "Online > HMI device maintenance" menu.
All available options and the previously installed options are displayed.

2. To display the installed options on the HMI device, click "Device status".

3. Select the option to install on the HMI device and transfer it to the list of installed options 
with ">>".

4. Click "<<" to uninstall an option from an HMI device.

5. To start installation or deinstallation, click on "OK".

Result
The selected options were installed on the HMI device, or removed. 

9.12.4 Reference

9.12.4.1 Error messages during loading of projects

Possible problems during the download  
When a project is being downloaded to the HMI device, status messages regarding the 
download progress are displayed in the output window. 

Usually, problems arising during the download of the project to the HMI device are caused by 
one of the following errors:

● Wrong operating system version on the HMI device

● Incorrect download settings on the HMI device

● Incorrect HMI device type in the project

● The HMI device is not connected to the configuration PC.

The most common download failures and possible causes and remedies are listed below.

The serial download is cancelled
Possible remedy: Select a lower baud rate. 
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The download is cancelled due to a compatibility conflict

Possible cause Remedy
Conflict between versions of the configuration 
software and the operating system of the HMI 
device

Synchronize the operating system of the HMI 
device with the version of the configuration 
software.
To update the operating system on the HMI 
device, select the "Update operating system" 
command from the "Online > HMI device 
maintenance" menu in WinCC. You can also use 
ProSave. 
For additional information, refer to the operating 
instructions for the HMI device. 

The configuration PC is connected to the wrong 
device, e.g. a controller.

Check the cabling. 
Correct the communication parameters. 

Project download fails

Possible cause Remedy
Connection to the HMI device cannot be 
established (alarm in the output window)

Check the physical connection between the 
configuration PC and the HMI device. 
Check whether the HMI device is in transfer mode. 
Exception: Remote control

The default communication driver is not listed in 
the Windows Device Manager.

Check the device status of the COM connection in 
the properties window of the Device Manager.

Download over MPI/DP interface fails

Possible cause Remedy
"Configured mode" is set on the CP, for example, 
if you are using the SIMATIC NET CD. 

Set the CP to "PG mode" using the "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the CP.
Set the CP back to "configured mode".

On the programming device/PC panel, the 
"S7ONLINE" access point is not set to a hardware 
device such as CP5611 (MPI). This may be due 
to the installation of "SIMATIC NET CD".

Set the access point "S7ONLINE" on the selected 
device using the "PG/PC Panel" or "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the HMI 
device.
Restore the "S7ONLINE" access point to the 
original device.
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The configuration is too complex

Possible cause Remedy
The configuration contains too many different 
objects or options for the HMI device selected.

Remove all objects of a specific type, for example 
all HTML browsers.
Alternatively, remove options such as 
Sm@rtServer or OPC server.

9.12.4.2 Adapting the project for another HMI device

Introduction
When you download a WinCC project to an HMI device, WinCC checks whether this is 
compatible with the HMI device type used in the project. If the types of HMI device do not 
match, you will see a message before the download starts.

The download is aborted.

Adapting the project for the HMI device
You need to adapt the project accordingly to be able to download the project to the connected 
HMI device.    

● Add a new HMI device in the project tree. Select the correct type of HMI device from the 
HMI device selection.

● Copy the configured components from the previous to the new HMI device.
Copy large amounts of components directly in the project navigation and details view.
For example, copy the "Screens" folder to the screens folder of the new HMI device with 
the help of the shortcut menu.

● Use the detail view to copy entries in the project tree for which the "Copy" command is not 
available in the shortcut menu.

● Select the "Recipes" entry in the project tree, for example. The recipes are displayed in the 
detail view.

● Select the recipes in the detail view and drag them to the "Recipes" entry of the new HMI 
device. The recipes are copied. You can also select multiple objects in the detail view.

● Configure the components that cannot be copied, e.g. connections, area pointers, and 
alarms.

● Save the project at various points in time.

● Compile the full project.

● When the compilation is successfully completed, download the project to the HMI device.

Linking references
References to linked objects are included in the copying. The references are linked again once 
the linked objects are copied.
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Example:

You copy a screen in which objects are linked to tags. The tag names are entered at the 
individual objects after the screen is added to the new HMI device. The tag names are marked 
in red because the references are open. When you then copy the tags and insert them into 
the new HMI device, the open references are closed. The red marking for the tag names 
disappears.

For complete references to connected objects in the PLC, you first need to configure a 
connection to the PLC.

Using the information area
When you compile the project for the HMI device, errors and warnings are displayed in the 
"Info" tab of the Inspector window. You can use the shortcut menu command "Go to" to go 
directly to the location where the error or warning can be corrected.

Work through the list of errors and warnings from top to bottom.

When the compilation is successfully completed, download the project to the HMI device. 

See also
Loading a project (Page 2190)

9.12.4.3 Establishing a connection to the HMI device

Introduction
To download a WinCC project to an HMI device, a properly configured connection must be set 
up between the configuration PC and HMI device. The connection cannot be set up, the 
download is cancelled.

Setting up a connection between the configuration PC and HMI device
1. Check the cable connection between the HMI device and configuration PC.

2. Open the "Devices & Networks" editor in WinCC and start the network view.

3. Select the subnet in the network view and check the settings for the subnet.

4. Select the interface of the HMI device in the network view or device view and check the 
connection parameters in the Inspector window.

5. Switch on the HMI device and press the "Control Panel" button in the loader.
The Control Panel opens.

6. Press "Transfer" twice in the Control Panel.
The "Transfer Settings" dialog box opens.

7. Check the settings and then press "Advanced".
The [Protocol*] Settings" dialog opens.
*: The title of the dialog depends on the protocol used, for example, "PROFIBUS Settings". 

8. Check the advanced settings and close the dialog with "OK".
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Important settings
Check the connection settings and in particular the following parameters:

● Network and station addresses

● Selected transmission rate

● Master on the bus; as a general rule, only one master is permitted.

If using a configurable adapter for the connection, check the adapter settings, for example, 
transmission rate, master on the bus. 

See also
Loading a project (Page 2190)

9.13 Operating in Runtime

9.13.1 Basics

9.13.1.1 Overview

Configuration and process control phases     
HMI devices are used to operate and monitor tasks in process and production automation. 
The plant screens on the HMI devices provide a clear overview of active processes. The HMI 
device project, which includes the plant screens, is created during the configuration phase. 

Transfer the project to the HMI device for the process control phase. Another requirement for 
the process control phase is that the HMI device must be connected online to a PLC. The 
process control phase, operator control, and monitoring can then be carried out during an 
ongoing work process.
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Figure 9-4 Configuration and process control phases

Downloading the project to the HMI device     
The following procedures are available to download a project to an HMI device:

● Downloading from the configuration PC

● Restore the project from a PC using ProSave
In this case, an archived project is downloaded from a PC to the HMI device. The 
configuration software need not be installed on this PC.

These procedures are available for commissioning and recommissioning a project.

Commissioning and Recommissioning         
● When the HMI device is commissioned there is no project at first.

The HMI device is also in this state after the operating system has been updated. 

● When recommissioning, any project on the HMI device is replaced.
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9.13.1.2 Behavior of the Runtime Advanced and Panels system

System functions and user-defined functions

Use
System functions and user-defined functions are used in Runtime for the following purposes: 

● To control the process.

● To utilize the properties of the HMI device.

● To configure system settings on the HMI device in online mode.

Each system function and user-defined function within WinCC is linked to an object and an 
event. As soon as the event occurs, the system function is triggered.

System functions
These default system functions are used to implement many tasks in Runtime, such as:

● Calculations, e.g. increasing a tag value by a specific or variable amount.

● Logging functions, e.g. starting a process value log.

● Settings, e.g. PLC changes or setting a bit in the PLC.

● Alarms, e.g after a different user logs on.

User-defined functions
User-defined functions may also be included in the project for specific applications which may 
require additional functions. WinCC provides an interface to Microsoft Visual Basic Script 
(VBScript or VBS for short) for creating user-defined functions. 

Examples:
● Conversion of values, e.g. between different physical units (temperatures).

● Automation of production sequences
The user-defined function controls a production sequence by transferring values to a PLC. 
The status is checked based on return values and corresponding measures are initiated.

Events
The object and the selected function determine which events can be defined as triggers for 
executing a system function.

For example, the "Value change", "On exceeding" and "On falling below" events are associated 
with the "Tag" object. The "Loaded" and "Cleared" events are associated with the "Screen" 
object.
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Reports

Overview
Logs are used to document process data and completed production cycles. The report content 
and layout are specified in the project, as is the event triggering the printout of the report. 

For example, a report can be configured for output at the end of a shift to record downtimes. 
A log can also be configured for the purpose of the documentation of product testing or quality 
inspections (ISO 9000).

Output
Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or manually 
by means of a softkey.

Printing reports
Reports are output to the printer in graphic mode. The use of a serial printer is not 
recommended because of the accumulated data volume. 

For proper output, the printer must support the paper format and page layout of the report.
 

 Note

The value of a tag in the report is read and output at the moment of printing. A substantial 
time may elapse between printing out the first and the last page of a report consisting of 
several pages. This may lead to the same tag on the last page being output with a different 
value from that on the first page.

 

 

Logs

Overview
Alarm events and process values can be saved to log files. Alarm events are, for example, the 
"Incoming", "Acknowledge" and "Outgoing" events contained in an alarm message.

Data logging can be used for the following purposes: 

● Early detection of danger / fault states

● Increase of productivity

● Enhancement of product quality

● Optimization of maintenance cycles

● Documentation of processes

● Quality assurance
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Memory options
Depending on the configuration, the logs are written to a file or stored in a database set up for 
this purpose.

● Data logging to File – CSV(ASCII)
In CSV format, table columns are separated by separators and the table rows are 
terminated by a line break. This allows you to evaluate or edit your log data, for example, 
using an external text editor or a spreadsheet program.

 

  Note

Double quotation marks or multiple characters cannot be used as list separators for the 
storage location "File - CSV (ASCII)". The setting for list separators can be found under 
"Start > Settings > Control Panel > Regional and Language Options".

 

● Data logging to File – TXT (Unicode)
The data is saved in the Unicode format. This file format supports all characters than can 
be used in WinCC Runtime. For processing, you require a software that can save Unicode, 
such as Notepad.

 

  Note

To save Asian languages, use the storage location "File - TXT (Unicode)".
 

● Data logging to a File - RDB
Log files in this format can only be read or represented with WinCC flexible Runtime.
If you want to evaluate the logged data in a different manner, convert the data to the CSV 
format using the "CopyLog" system function.

● Data logging to a database
Data is saved in a database for which ODBC access was set up by the PC administrator. 

Logging methods
Logging methods used in WinCC:

● Circular log

● Segmented circular log

● Log with level-dependent system alarms

● Log with level-dependent triggering of an event

Alarm logs
Alarms in the project indicate fault states and operating states of a process. They are generally 
triggered by the controller. Alarms are output on the HMI device in form of screen objects. All 
the data associated with an alarm and configuration data are saved in an alarm log, for 
example, alarm class, time stamp and alarm text. All alarm classes can be logged separately. 
Alarms can be logged either automatically or by operator intervention. For additional 
information, refer to "Logging alarms".
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Data logs
In Runtime, the process values are logged, processed and, depending on the project, written 
either to files or to the log database.

Data logging is controlled by means of cyclic operations and events. Logging cycles are used 
to ensure continuous acquisition and storage of the process values. Data logging can also be 
triggered by events, for example, when a value has changed. For additional information, refer 
to "Logging tags".

Storing logs on network drives
Close all logs with the system function "CloseAllLogs" before disconnecting the HMI device 
from the network.

End Runtime if an unexpected network failure occurs. The logs will be available again after 
restarting Runtime.   

Storing files on a Windows 2003 server
Log files and recipes can only be stored on a Windows 2003 server with Active Directory for 
the following HMI devices:

● MP 277

● MP 377

● Mobile Panel 277

● Mobile Panel 277 IWLAN

Tags

Definition
Tags correspond to defined memory areas on the HMI device, to which values are written and/
or from which values are read. This action can be initiated by the PLC, or by the operator at 
the HMI device. 

9.13.1.3 System characteristics of Runtime Professional

Reports

Overview
The protocol system in WinCC does not detect Runtime in the real sense of the meaning. 
Reports and print jobs can be configured and executed at any time. Only print jobs which 
represent log or process data are dependent on Runtime. 
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Sequence
The protocol system is automatically started on every client during the startup routine. The 
server operates as a protocol server, the clients as protocol clients. The clients log on to the 
server during startup. The server provides current information about available print jobs and 
their status to the clients. After having started a print, the client requests the corresponding 
data from the server database. The print job is started locally. The protocol server receives 
the current data concerning the print job status from the client and transfers the information to 
the other clients.

Output
You have the following options for outputting a report in Runtime:

● Using the "Print" button for the following objects:

– f(x) trend view 

– f(t) trend view 

– Table view 

– Alarm view 

– Recipe view 

● Application window
The operator can initiate printing of a report selected in the application window in Runtime. 
All queued print jobs are displayed in the application window.

● Button
The operator can start printing the report using a configured button which is logically linked 
to a corresponding script. 

Alarms

Behavior
If alarms are displayed on a client, the clients will request the data from the alarm server. The 
message server receives the configured data from the database.  

Archive data and message lists can be displayed on every client. The data to be displayed 
always comes from the message server. When new messages are received, the messages 
are archived in the message server. 

When an alarm is acknowledged at an HMI device, the acknowledgement is transferred to the 
message server. The server enters the change of status in the archive and distributes the 
notification to all participating clients. The same process applies to the locking of messages.

If a message server is not available in Runtime, the corresponding message appears in the 
message window instead of the messages. When the server becomes available again, 
messages are displayed in the message window again. 
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Data logs

Behavior
If the data logging system is activated on an HMI device, the tag logging in Runtime operates 
on the server as data log server and on the clients as data log client. Only the archive server 
accesses the database and compiles and archives the process data. The clients receive 
archive data from the archive server. 

The log data is visualized in tabular or graphic format on all clients running tag logging in 
Runtime. The data to be displayed always comes from the archive server. All operations on 
the client are transmitted to the server and the result of the processing is transferred back to 
the client. 

Screens 

Behavior
After a client has called a screen in Runtime, the "Graphic object in Runtime" function initially 
searches for locally stored screens. If no screen with the corresponding name is found locally, 
a search is made in the project folder on the server. A corresponding message is output if the 
screen is unavailable. 

If a screen selection requires data exchange with a different editor (alarms, custom C 
functions), this exchange is always local. A picture can be opened and processed by several 
operating stations in Runtime. 

9.13.2 Commissioning projects

9.13.2.1 Commissioning projects for Runtime Advanced and Panels

Settings for Runtime Advanced and Panels

Settings in the Runtime software (Advanced)
Open the WinCC configuration software and make the following settings for the Runtime 
software: 

Display on the PLC
In WinCC, configure the visual representation of the generated project in Runtime: Select the 
full-screen or window mode for the project. The window has a smaller size than the screen. In 
full-screen mode, the project is zoomed to the full screen. There will be no window and operator 
control elements for this view.
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Click "Screens" in the "Settings" editor to define activation of the full-screen at startup. Activate 
the "Full-screen mode" check box in the "Screen" field. 

You can hide the taskbar in Windows as required. Select "Start > Settings > Taskbar" and then 
deactivate the "Always on Top" and "Auto hide" check boxes in the "Taskbar properties" dialog.

 

 Note
Truncated view

If the HMI screen does not match the configured size (in pixels), the project opened in full-
screen mode only appears on a part of the screen.

 

Dialog fonts
The dialog text will be shown in the standard font. Define the default font by selecting 
"Languages and fonts" in the "Settings" editor.

Disabling program switching
You lock program switching to prevent operators from calling other applications in Runtime.

Click "Screens" in the "Settings" editor and then activate the "Disable program switching" and 
"Full-screen mode" check boxes. Also hide the Windows taskbar.

 

 Note
Stop runtime

If you lock program switching, always configure in your project the system function 
"StopRuntime" for an object, e.g. a softkey or button. Otherwise, you cannot close Runtime 
or Windows.

The <CTRL+ALT+DEL> key shortcut is not available if program switching is disabled. On a 
Windows 2000 operating system this effect prevents you from logging on to your device again 
after the screensaver was started. Windows 2000 allows you to disable the <CTRL+ALT
+DEL> key shortcut required for logon. Open the "Control Panel > Users > Passwords > 
Advanced" tab and deactivate the "Press CTRL + ALT + DEL before logon" check box.

 

Screen saver
A screensaver is no longer required for most modern screens and can, in fact, even cause 
damage. These monitors switch to hibernate mode as soon as the video signal has not 
changed for a specified time. A conventional screensaver would prevent this and thus reduce 
the service life of your monitor. 

 

 Note
Approved screensavers

If you do want to use a screensaver, note that only the standard Windows screensavers are 
approved for use in Runtime.
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Make sure that the correct time zone is set on the PC on which the runtime software is installed. 
To set the time zone in Windows, select Start > Settings > Control Panel > Date and Time. 

Additional operating options (Advanced)

Print functions
Print functions available in online mode: :

● Hardcopy
You can print the content of the currently displayed screen if you utilize the "Print screen" 
system function in your configuration. 

● Printing alarms
Each alarm event that occurs (incoming, outgoing, acknowledgment) is also sent to a 
printer. 

● Printing reports

LED control
The light-emitting diodes (LEDs) in the function keys of the HMI devices can be controlled from 
the PLC. For example, a lit or flashing LED can signal the operator to press a specific function 
key on the device. 

Loading a project

Overview
Various scenarios are possible for loading the project: 

● The Runtime software is installed on the same system as the configuration software.

● The Runtime software and the configuration software are installed on different systems. 
The project must be loaded from the configuration computer to the target system. The HMI 
devices must be connected to the configuration PC for the transfer. Another requirement 
is that the transfer mode must match on the HMI devices and in WinCC.

 

  Note

Security prompts may appear during the loading process, depending on the configuration. 
The recipe data and password list on the HMI device are overwritten following a prompt.
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The configuration software and the Runtime software are installed on the same system
If the configuration software and the Runtime software are installed on the same system, 
proceed as follows: 

1. Create and compile your project.

2. Start Runtime directly from the active configuration software. Select the "Start Runtime" 
command from the "Online" menu.

3. You may test and operate the project online with the controller if you have configured the 
corresponding communication.

The configuration software and the Runtime software are installed on different systems
If the configuration software and the Runtime software are installed on different systems, 
proceed as follows: 

1. Create and compile your project. For additional information, refer to "Compiling a project".

2. To download the file via cable:
Connect the HMI device to the configuration computer using a standard cable to match the 
desired transfer mode and then switch on the HMI device.

3. Set the HMI device to transfer mode.
To start transfer mode, press the "Transfer" button in the Loader. You can also assign the 
system function "SetDeviceMode" to an operator control.

4. Load the project from the configuration computer to your target device. For further 
information, refer to "Loading projects".

 

  Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for 
example, via Ethernet. Double-click the corresponding file on your PC to start Runtime. 

 

Starting Runtime on the Engineering Station

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. During 
startup of the project in Runtime, the project settings made in the "Runtime settings" of the 
HMI device are activated.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.
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Requirements
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure     
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 

Starting Runtime Advanced and Panels

Introduction
You can start the project in Runtime as soon as you have downloaded the project to the HMI 
device. The project is generally started automatically on the HMI device. 

There may be several projects in the file system of the HMI device for HMI devices with Runtime 
Advanced. You can start one of these projects in Runtime. 

The project settings defined in the "Runtime settings" of the HMI device are activated when 
the project is started in Runtime. Make sure when defining the Runtime settings "Lock task 
switching" and "Full screen" that you will be able to stop Runtime again. You can, for example, 
configure a button with the system function "StopRuntime".

Requirements
● WinCC Runtime Advanced or Panels is installed on the HMI device.

● The project was downloaded to the HMI device
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Starting Runtime on a PC   
The compiled project is saved in the PC file system with the extension "*.fwc" and is freely 
accessible.

1. To start the project once the HMI device has booted up, enter the automatic start of a project 
file under "Settings" in the "RT Loader" ("HmiLoad.exe").
You can also create a link to the project file in the Windows Autostart directory.

Starting Runtime on a panel   
The project will be stored on a panel in a folder you specify in the HMI device transfer settings. 
The "RT Loader" application is started on a panel. The project loaded is started automatically 
after expiration of the configured delay.

If the project does not start automatically:

1. Click on "Start" to start the loaded project.

Refer to the documentation for the HMI device for additional information on startup of projects. 

Result
Runtime is started on the HMI device. 

Testing a project

Introduction
You have the following options for testing a WinCC project:

Testing projects on the configuration computer.
● Simulator

The Simulator is used to test WinCC projects with internal tags and process tags. For 
additional information, refer to "Simulating projects".
Tests supported by the Simulator:

– Offline testing of a configuration without connection to a PLC.

– Online testing of a configuration with connection to a PLC and inactive process.

– Implementation of a demo project.

● Script debugger
The script debugger tests your scripts in Runtime to find logical programming errors. For 
additional information, refer to "Working with the Debugger".
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Testing projects on the HMI device
● Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and the PLC is down 
for the duration of the test. You can operate the HMI device, however, without being able 
to exchange data with the PLC. Set the "Offline" mode on the HMI device by assigning the 
system function "SetDeviceMode" to an operating element.

● Online testing of the project on the HMI device
Online testing means that communication between the HMI device and the PLC is up for 
the duration of the test. You can use the HMI device to control the plant as configured. Set 
the "Online" mode on the HMI device by assigning the system function "SetDeviceMode" 
to an operating element.

Procedure
The following steps show the basic procedures for simulating a project offline on the 
configuration computer without PLC connection. 

1. Start by creating a project as it is going to be run later with an interconnected PLC.

2. Save and compile the project.

3. Start the Simulator directly from the active configuration software. Select "Online > Simulate 
Runtime > With tag simulator".
If simulating the project for the first time, the simulator is started with a new, empty 
simulation table. If you have already created a simulation table for your project, it will be 
opened. 
The simulation table "*.six" contains all your settings for the simulation of tags and area 
pointers. 

4. Make any changes to the tags and area pointers of your project in the simulation table.
Toggle between the simulation table and Runtime using the <ALT+TAB> key shortcut.
Save your simulation settings with "File > Save." Assign the file a meaningful name. The 
file name is automatically assigned the extension "*.six".

Backup and restoring projects
 

 Note

Use the restore function for project data only on operating devices which were configured 
using the same configuration software. 

 

Requirements
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project navigation.

● If a server is used for data backup: The configuration PC has access to the server
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Backup of the data of the HMI device   
Proceed as follows to backup the data of the HMI device:

1. Select the "Backup" command from the "Online > HMI device maintenance" menu.
The "SIMATIC ProSave" dialog box opens. 

2. Select the data to backup for the HMI device under "Data type".

3. Enter the name of the backup file under "Save as".

4. Click "Start Backup".

This starts the data backup. The backup operation takes some time, depending on the 
connection selected.

Restoring the data of the HMI device    
Proceed as follows to restore the data of the HMI device:

1. Select the "Restore" command from the "Online > HMI device maintenance" menu.

2. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "Content". 

3. Click "Start Restore".

This starts the restoration. This operation takes some time, depending on the connection 
selected.

Backup/Restore from the "Backup/Restore" dialog in the control panel of the HMI device
The "Backup/Restore" function is enabled for MMC, SD memory cards and USB mass storage 
devices. 

Closing a project

Introduction
You define the steps in closing Runtime in the user program: 

Procedure
Exit Runtime as follows:

1. When Runtime is running in window mode, you can close it by clicking the icon .

2. When Runtime is running in full-screen mode, you can close it by means of the program 
switching function and the Task Manager.

3. When Runtime is running in full-screen mode and program switching is disabled for the 
project, the closing sequence of Runtime must be configured separately. Actuate the 
relevant button to close Runtime.
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9.13.2.2 Commissioning projects for Runtime Professional

Access rights within the operating system

Defining Access Rights in the Operating System

Introduction                
Certain folders can be released for network access when working with WinCC. For security 
reasons you should restrict access to these folders to specific users.

Access rights specified in WinCC
After its installation was completed, WinCC automatically sets up the following local groups in 
the Windows users and groups management: 

● "SIMATIC HMI". These members may create local projects, and may process, start, and 
access these projects remotely. The user who installs WinCC and the local administrator 
are included in this group by default. Additional users must be defined by the administrator. 
For additional information, refer to "Assigning users to the "SIMATIC HMI" user group".

● "SIMATIC HMI CS". These members may configure only but may not make any changes 
to runtime components directly. By default, this group is empty and reserved for later use.

● "SIMATIC HMI Viewer". These members have read access only to configuration and 
runtime data. This group is preferably used for Web publishing services accounts, e.g., IIS 
(Internet Information Services) for operation of WinCC Web Navigator.

The "InstallationDirectory/WinCC/aplib" folder named "SCRIPTFCT" is released after 
installation for the "SIMATIC HMI" user group. This folder contains central libraries for project 
script functions. 

Users of the "SIMATIC HMI" and "SIMATIC HMI CS" user group are granted access rights to 
the project folder when you recreate a project. Following a manual copy, the administrator or 
main user may have to open the project once to set the local authorizations properly. The 
settings of the Auto-Hotspot released WinCC folders will not be changed afterwards. You may 
manually change settings, if necessary.

 

 Note

Configurators and users of runtime components must be registered not only in a "SIMATIC 
HMI" group but also in a user group of the operating system. Users of the "SIMATIC HMI" 
group are only granted access to the projects but not the operating system. In order to create 
a project, the configurator must be at least the main user and a member of the "SIMATIC 
HMI" group.
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Including users in the "SIMATIC HMI" user group

Introduction
Include those local users in the "SIMATIC HMI" group whose login permits access to WinCC. 
You must first create local users to do so. Users of a domain may be directly included in the 
user group "SIMATIC HMI".

Procedure
You add users to the "SIMATIC HMI" user group as follows:

1. Open the workstation administration under Windows.

2. Select the entry "Local Users and Groups > Users" in the navigation window .
All local users are displayed in the data window.

3. Open the "New User" dialog via the shortcut menu.
Create a user account with the same login for each user who has to access WinCC.

4. Select the entry "Local Users and Groups > Groups" in the navigation window".
All groups are displayed in the data window.
Select the "SIMATIC HMI" group.

5. Using the pop-up menu, open the "Add Member" dialog and include those users as 
members of the "SIMATIC HMI" user group.

Result
The user has been added to the "SIMATIC HMI" user group. These changes become effective 
after system restart. 

Including domain-global user group in the "SIMATIC HMI" user group

Introduction
You can set up an additional domain-global user group for operation within a domain as 
member of the "SIMATIC HMI" user group.

Requirement
● The domain administrator creates a domain-global user group.

● Within the domain, the domain administrator includes those users in the domain whose 
login permits access to WinCC.

Visualizing processes (Professional)
9.13 Operating in Runtime

WinCC Professional V11.0 SP1
2256 System Manual, 08/2011,  



Procedure
Set up the access rights of your operating system as follows:

1. Open the workstation administration under Windows.

2. In the navigation window, select the "Local Users and Groups > Users" entry. The data 
window displays all local users.

3. In the pop-up menu, select the "New User" dialog. Create an user account with the same 
login for the domain-global user group.

4. In the navigation window, select the "Local Users and Groups > Groups" entry. The data 
window displays all groups. Select the group "SIMATIC HMI".

5. Using the pop-up menu, open the "Add Member" dialog and include domain-global user 
group as members of the "SIMATIC HMI" user group.

Result
Access rights have been adapted. These changes become effective after system restart.

Sharing an existing project for access by the "SIMATIC HMI" user group 

Introduction
Start by deleting the currently shared access to the project directory if the "SIMATIC HMI" user 
group is to have access to an existing project. The project is then shared on opening.

Procedure
You grant the "SIMATIC HMI" user group access to the project as follows:

1. Open the workstation administration under Windows.

2. In the navigation window, select the entry "Shared Folders > Shares". The data window 
displays all shared directories.

3. Select the respective project directory and remove the enable through the "Cancel Share" 
pop-up menu.

4. If you now open the project in WinCC, the project directory is automatically shared by the 
"SIMATIC HMI" user group and all members of the user group have access to the project 
directory.

 

  Note

Do not change the share name of the directory shared by WinCC.
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Adapting security policies in Windows

Introduction
Before you install WinCC, you must check the operating system settings. The system must 
permit installation of unsigned drivers and files.

Procedure
You adapt the Windows security policies as follows:

1. In the Control Panel, open "Administrative Tools".

2. Double-click "Local Security Policy".

3. In the left pane, click "Local Policies".

4. In the right pane, double-click "Security Options".

5. Check the settings of the security policies below:

– Windows 2000: 
"Unsigned driver installation behavior" and "Unsigned files installation behavior (except 
drivers)"

– Windows XP / Windows Server 2003: 
"Devices: Unsigned driver installation behavior"

For the policies, select either "Accept without warning" or "Warn, but permit installation".

Settings for Runtime Professional

Setting up the start sequence

Introduction    
When you activate a project, additional program modules will be loaded to execute Runtime. 

Select "Start sequence of WinCC Runtime" to specify the applications that will be started on 
activation of a project. "Graphics in Runtime" is always started and is enabled by default.

Start only the applications required in Runtime to obtain a high performance level. 
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Procedure
Set up the startup list as follows:

1. Open the "Runtime settings > Services" editor.

2. Enable the display of the online help in Runtime by activating "Enable help in Runtime".

3. Select the applications to load at the start of Runtime in the "Start sequence of WinCC 
Runtime" area.

4. You can load additional tasks or applications at the start of Runtime by clicking in the table 
row at "Additional tasks/application".

5. Enter a name for the additional task or application. Specify the working directory.

6. The project folder is used as working directory if you select the check box in the "Project 
directory" column.

7. If you clear the check box in the "Project directory" column, use the "Find" button to specify 
the folder in the "Working directory" column.

8. Specify any necessary parameters.

9. Specify the startup size of the task or application window in the "Window style" column, 
e.g. minimized, maximized or standard size. 
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Setting the language and fonts

Introduction   
Define the language and corresponding fonts for Runtime activation. Define the order by which 
languages are changed. 

Requirement
The "Runtime Settings > Language & Font style" editor is open.

Procedure
Set the Runtime language as follows:

1. Select "Runtime language for single-language objects:" to set the substitute text language 
for graphic objects. 

2. Select the required languages.
The project is started in the language assigned the lowest number at the initial start of 
Runtime on an HMI device.

3. Define the font for the Runtime language in the "Standard font" column.
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Activating the on-screen keyboard

Introduction
The on-screen keyboard is always displayed in Runtime after the operator has selected an 
input field. The on-screen keyboard is automatically hidden again after input was completed.

Requirement
The "Runtime settings" editor is open.

Procedure
Proceed as follows to activate the on-screen keyboard:

1. Activate "Runtime settings > General > Use screen keyboard".

Enabling the zoom functions

Introduction   
Zooming in Runtime is supported by three techniques:

● Declutter
The layers and their embedded objects can be shown and hidden.
For additional information, refer to "Dynamic visualization of an object".

● Extended Zooming
The Runtime view of the process screen can be enlarged or reduced using the scroll wheel 
of the mouse. Hold the <CTRL> key down while turning the mouse wheel. If you turn the 
mouse wheel away from the palm of your hand, you increase the zoom factor.

● Panning
You can move a cutout of a screen within the document if this screen is assigned a specific 
zoom factor that activates the scroll bars. A navigation crosshair appears upon clicking on 
the mouse wheel. Moving the mouse pointer scrolls in the desired direction. The distance 
between mouse pointer and navigation crosshair determines the scrolling speed. A second 
click cancels panning.

Requirement
● A driver for a Logitech mouse or Microsoft Intellimouse

● The mouse wheel must be set to "Autoscroll" mode.

● The "Runtime settings" editor is open.
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Enabling the zoom function
1. Click on "Screens".

2. Deactivate "Declutter" and "Extended zoom". 
The functions are disabled if you activate "Declutter" and "Extended zoom".

Configuring Extended Zooming Picture-Specific
The "Extended Zoom" function can be enabled/disabled for specific screens. Make the 
corresponding setting in the Inspector window of a screen under "Properties > Properties > 
Miscellaneous".

 

 Note

"Declutter" is now supported by the following objects:
● "Slider"
● "Clock"
● "Gauge"
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Defining hotkeys in the project 

Introduction
You can define various hotkeys to operate the project. The hotkeys can be used as an 
alternative to the mouse.

● Windows keys
Define the key shortcuts to be supported in Runtime in the "Windows keys" dialog. 

● Action keys

– "Logon" opens a window for user logon in Runtime.

– "Logoff" opens a window for user logoff in Runtime.

– "Hardcopy" opens a dialog for printing the screen in Runtime.

Requirement
The "Runtime settings" editor is open.

Procedure
Set up the hotkeys as follows:

1. Click on "Runtime settings > Keyboard".

2. Activate your hotkeys in the "Windows keys" dialog.

3. Select the action in the "Action keys" dialog. 

4. Click the  button in the selection list. The hotkeys dialog opens.

Visualizing processes (Professional)
9.13 Operating in Runtime

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2263



5. Define your hotkeys.

6. Click the  button to close the dialog.

Configuring hotkeys for operating and screen navigation

Introduction      
Screens can also be operated if mouse control is not available. Define corresponding hotkeys 
for the required operating functions. The operator calls the specific function by operating the 
hotkey. 

The most important hotkeys for operation without mouse in Runtime are defined in the 
"Runtime Settings > Keyboard" editor.
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Procedure
Set up the operator hotkeys as follows:

1. Click in the input field of the selected function.

2. Click the  button in the selection list. The hotkeys dialog opens.

3. Define your hotkeys.

4. Click the  button to close the dialog.

You can also define single-key or a softkey <F1> - <F12> input instead of a hotkey.
 

 Note

The function key F12 may not be configured as a systemwide hotkey.
 

Window control keys
These hotkey changes are activated after system restart.

Changing windows

This hotkey is used to navigate between multiple picture windows, which are configured in a 
main picture. Whenever the hotkey is pressed, the next picture window will be activated for an 
operation.

 

 Note

The <DEL> and <HOME> keys cannot be used as hotkeys.
 

Screen navigation keys
The "Forward" and "Back" buttons of most Internet browsers allow the navigation between 
Internet pages most recently called. A similar technique can be implemented in WinCC to 
navigate between individual process pictures.

Configure corresponding hotkeys in the "Screen selection" dialog to facilitate screen navigation 
in Runtime. Screens are logged to a temporary list after they were called. You can page through 
this list using the "Forwards" and "Backwards" functions, for example, to recall the last five 
screens. The valid maximum number of entries in this list is set in the field "Screen selection 
memory." If this number is exceeded, the oldest entry is replaced after a new screen was called.

 

 Note

The list logs up to 30 screen calls if the default is set for "Screen selection memory." As a 
rule, it is not reasonable to substantially increase this value, since the switchover can only 
be done in single steps. You can achieve more efficient screen navigation using picture 
modules. 
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Configuring cursor control

Introduction
You can configure object navigation without mouse using defined cursor control functions in 
screens with tabular layout of the objects.

Define the cursor control hotkeys and the cursor characteristic in the "Runtime Settings > 
Keyboard" editor.

Procedure
Set up the operator hotkeys as follows:

1. Click in the input field of the selected function.

2. Click the  button in the selection list. The hotkeys dialog opens.

3. Define your hotkeys.

4. Click the  button to close the dialog.

You can also define single-key or a softkey <F1> - <F12> input instead of a hotkey.

Activating time synchronization

Introduction
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

The time master can be a computer or an external clock, such as a SICLOCK. This master 
transmits the time signal to the other components. Only one time master can be the active 
clock in the network. 

To prevent the failure of time synchronization, two components can be configured as the time 
master. The redundant time master is a time slave as long as the active time master is 
transmitting the time message frames.
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The time slaves receive the time signal transmitted by the time master via the bus and thus 
synchronizes its time of day. 

Time synchronization in Runtime
The time synchronization of the computer is entered in the start sequence of the computer for 
the following events:

● Running the OS project editor

● After configuration of the time synchronization
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Activating time synchronization
Proceed as follows to activate time synchronization:

1. Select the "Properties" command from the shortcut menu in the project navigation of 
Runtime and then select "Time synchronization > General".

2. Under "Synchronization", activate "Activate time synchronization".

3. Under "Time settings", select the time source, for example, "No external time source".

4. Specify how often the time message frame should be transmitted by the time master.
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Synchronization via the terminal bus
Proceed as follows to synchronize the time via the terminal bus:

1. Select the "Properties" command from the shortcut menu in the project navigation of 
Runtime and then select "Time synchronization > Terminal bus".

2. Under "Synchronization", activate the "Activate" check box.

3. If you also want to synchronize redundant components, activate the "Synchronize 
redundant partners" check box.

4. Under "Server 1", select the server from which the HMI device should receive the time 
message frame as the time slave.

5. Click "OK" or configure the synchronization via the system bus.
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Synchronization via the system bus
Proceed as follows to synchronize the time via the system bus:

1. Select the "Properties" command from the shortcut menu in the project navigation of 
Runtime and then select "Time synchronization > System bus".

2. Under "Synchronization", activate the "Activate" check box.

3. Activate the "Show symbolic names of access points" check box. Note: If you configure 
time synchronization from another computer, the installed access points are unknown. The 
symbolic names are shown, however, and assigned to the physical names of the access 
points when Runtime starts.

4. Under "Access point 1", select an access point and assign it a role as master or slave.

5. You also select a second access point under the following conditions:

– If you want to use a redundant device.

– If you want to synchronize two system buses via a "bridge".

– If you want to synchronize two system buses as the master.

6. Also assign this access point a role as master or slave. The combination of these roles 
defines the response as shown in the table below.
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Access point 1 Access point 2 Response
Slave Slave The device always functions as a time slave.
Master Master The device functions as a cooperative master at both access 

points. 
Master Slave The devices functions at access point 1 as the master and 

transmits time message frames; at access point 2 the device 
synchronizes with the time signals received there.

Slave Master The device functions at access point 2 as the master and 
transmits time message frames; at access point 1, the device 
synchronizes with the time signals received there.

Set time base

Setting the time base for the time of day
To set the time display on the HMI device, proceed as follows:

1. Select the "Properties > Time settings" command from the shortcut menu in the project 
navigation.

2. Select one of the following options under "Time basis for time display in Runtime":

– Time zone of server (migrated projects)

– Local time

– Coordinated Universal Time

3. Select one of the following options for the display format of the date and time:

– "Configure individual components": If you want to display the date in the configured 
format.

– "Use ISO8610 format on all components": If you want to display the date in ISO8610 
format on all components.
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Loading a project

Overview
Various scenarios are possible for loading the project: 

● The Runtime software is installed on the same system as the configuration software.

● The Runtime software and the configuration software are installed on different systems. 
The project must be loaded from the configuration computer to the target system. The HMI 
devices must be connected to the configuration PC for the transfer. Another requirement 
is that the transfer mode must match on the HMI devices and in WinCC.

 

  Note

Security prompts may appear during the loading process, depending on the configuration. 
The recipe data and password list on the HMI device are overwritten following a prompt.

 

The configuration software and the Runtime software are installed on the same system
If the configuration software and the Runtime software are installed on the same system, 
proceed as follows: 

1. Create and compile your project.

2. Start Runtime directly from the active configuration software. Select the "Start Runtime" 
command from the "Online" menu.

3. You may test and operate the project online with the controller if you have configured the 
corresponding communication.

The configuration software and the Runtime software are installed on different systems
If the configuration software and the Runtime software are installed on different systems, 
proceed as follows: 

1. Create and compile your project. For additional information, refer to "Compiling a project".

2. To download the file via cable:
Connect the HMI device to the configuration computer using a standard cable to match the 
desired transfer mode and then switch on the HMI device.

3. Set the HMI device to transfer mode.
To start transfer mode, press the "Transfer" button in the Loader. You can also assign the 
system function "SetDeviceMode" to an operator control.

4. Load the project from the configuration computer to your target device. For further 
information, refer to "Loading projects".

 

  Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for 
example, via Ethernet. Double-click the corresponding file on your PC to start Runtime. 
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Starting Runtime on the Engineering Station

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. During 
startup of the project in Runtime, the project settings made in the "Runtime settings" of the 
HMI device are activated.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

Requirements
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure     
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 

Starting Runtime Professional

Introduction             
Runtime in started on a configuration PC with installed WinCC Runtime via the WinCC menu 
bar. If only WinCC Runtime is installed on an HMI device, load the project to the HMI device. 
Use the "WinCC StartTool" for starting the project. 
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Requirements
"WinCC Runtime" is installed on the HMI device. 

 

 Note

A least 100 MB free memory must be available on the storage medium before the Runtime 
of a project can be started.

 

Starting Runtime at an Engineering Station
1. Open the desired project in WinCC.

2. Select the "Start Runtime" command from the "Online" menu.

Result
The project is compiled and activated. During activation, all Runtime services that you selected 
in the Runtime settings of the HMI devices are started. 

Testing a project

Introduction
The following options of test WinCC projects are available:

Testing projects on the configuration computer.

● Simulator
The Simulator is used to simulate WinCC projects with internal tags and process tags. For 
additional information, refer to "Simulating projects".
Tests supported by the Simulator:

– Offline testing of a configuration without connection to a PLC.

– Online testing of a configuration with connection to a PLC and inactive process.

– Implementation of a demo project.

● Script debugger
The script debugger tests your scripts in Runtime to find logical programming errors. For 
additional information, refer to "Working with the Debugger".

Procedure
The following steps show the basic procedures for simulating a project offline without PLC 
connection. 

1. Start by creating a project as it is going to be run later with an interconnected PLC.

2. Save the project.

3. Select the HMI device in the project navigator.
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4. Start the Simulator directly from the active configuration software. Select "Online > Simulate 
Runtime > With tag simulator".
If simulating the project for the first time, the simulator is started with a new, empty 
simulation table. If you have already created a simulation table for your project, it will be 
opened. 
The simulation table "*.sim" contains all your settings for the simulation of tags and flags. 

5. Make any changes to the tags and area pointers of your project in the simulation table.
Toggle between the simulation table and Runtime using the <ALT+TAB> key shortcut.
Save your simulation settings with "File > Save." Assign the file a meaningful name. The 
file name is automatically assigned the extension "*.sim".

Closing a project

Introduction
You define the steps in closing Runtime in the user program: 

Procedure
Exit Runtime as follows:

1. When Runtime is running in window mode, you can close it by clicking the icon .

2. When Runtime is running in full-screen mode, you can close it by means of the program 
switching function and the Task Manager.

3. When Runtime is running in full-screen mode and program switching is disabled for the 
project, the closing sequence of Runtime must be configured separately. Actuate the 
relevant button to close Runtime.
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9.13.3 Operating projects

9.13.3.1 Basics

Overview

Operation options
The hardware determines how you can operate the HMI device:

● Touch screen
The operating elements shown in the dialogs are touch-sensitive. Touch objects are 
basically operated in the same way as mechanical keys. You activate operating elements 
by touching them with your finger. To double-click them, touch an operating element twice 
in succession.

● HMI device keyboard
The operating elements shown in the screens are selected and operated using the keys of 
the HMI device.

● External keyboard

● External mouse

Operation feedback from operating elements     
The HMI device provides optical feedback as soon as it detects that an operating element has 
been selected. The operating element receives the focus and is selected. This selection is 
independent of any communication with the PLC. Therefore this selection does not indicate 
whether the relevant action is actually executed or not.

The configuration engineer can also configure the selection of an operating element so that it 
deviates from the standard.
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Optical feedback from operating elements    
The type of optical feedback depends on the operating element: 

● Buttons
The HMI device outputs different views of the "Pressed" and "Unpressed" states, provided 
the configuration engineer has configured a 3D effect:

– "Pressed" state:

– "Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example, line 
width and color for the focus.

● Invisible buttons
By default, invisible buttons are not displayed as pressed when they are touched. No optical 
operation feedback is provided in this case.
The configuration engineer may, however, configure invisible buttons so that their outline 
appears as lines when touched. This outline remains visible until you select another 
operating element.

● I/O fields
When you select an I/O field, the content of the I/O field is displayed against a colored 
background. With touch operation, a screen keyboard is displayed for the entering of values. 

Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the I/O area of a SIMATIC S7. 

Direct keys enable operations with short reaction times that are, for example, a jog mode 
requirement. 

 

 NOTICE

Direct keys are still active when the HMI device is in "offline" mode. 
 

 NOTICE

If you operate a function key with direct key functionality in a running project, the direct key 
function is always executed, independent of the current screen contents.
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 Note

You can only use direct keys when there is a connection via PROFIBUS DP or PROFINET IO.

Direct keys result in additional basic load on the HMI device.
 

Direct keys
The following objects can be configured as a direct key: 

● Buttons

● Function keys

You can also define image numbers in the case of HMI devices with touch operation. In this 
way, the project engineer can configure the direct keys on an image-specific basis.

For additional information on configuring direct keys, refer to "WinCC  Communication." 

Touch operation

Overview

Screen keyboard
When you touch an operating element requiring entry on the HMI device touch screen, a screen 
keyboard appears. The screen keyboard is displayed in the following cases: 

● An I/O field is selected for input.

● A password must be entered for accessing a password-protected function.

The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen 
keyboards for entering numerical or alphanumerical values.

 

 Note

The screen keyboard display is independent of the configured project language.
 

General procedure
The operating elements of a screen are operated by touching the touch screen.

Proceed as follows:
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1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Symbolic I/O field: Select an entry from the drop down list box.

– Slider control: Move the slider control.

Procedure for input fields
Values are entered in the project input fields. Based on your configuration, the values are 
saved to tags and transferred, for example, to the PLC.

Proceed as follows:

1. Touch the desired input field within the screen.
The screen keyboard opens. 
Depending on your configuration, you can enter values in the input field in the following 
manner:

– Numerical values, for example decimal numbers, hexadecimal numbers, binary values

– Alphanumerical values, for example digits and letters

– Date/time

2. Enter the value.

3. Confirm your entry with  or discard your entry using the button .

Entering and editing numerical values

Numerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the numerical screen keyboard appears. This is the case, for example, for an input field. The 
screen keyboard is automatically hidden again when input is complete. 

Figure 9-5 Numerical screen keyboard
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 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
 

Display formats for numerical values   
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values   
Tags can be assigned limits. The current limits are indicated in the numerical screen keyboard. 
If you enter a value that lies outside of this limit, it will not be accepted, for example, 80 with a 
limit value of 78. In this case the HMI device will deliver a system event, if an alarm window is 
configured. The original value is displayed again.

Decimal places for numerical values   
The configuration engineer can define the number of decimal places for a numerical input field. 
The number of decimal places is checked when you enter a value in this type of I/O field.

● Decimal places in excess of the limit are ignored.

● Empty decimal places are filled with "0".

Procedure   
Numerical and hexadecimal values can be entered character-by-character via the buttons on 
the numerical screen keyboard. 

Proceed as follows:
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1. Touch the desired operating element within the screen.
The numerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You can only operate keys that are required for entering values. The keys with letters cannot 
be used, for example, for entering a decimal value. Which keys can be operated can be 
seen from the appearance of the keys.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Change the sign of the value using the  key.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the numerical value or entered a new one. 

Entering and editing alphanumerical values

Alphanumerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the alphanumerical screen keyboard appears. This is the case, for example, for an input field. 
The screen keyboard is automatically hidden again when input is complete. 

Figure 9-6 Alphanumerical screen keyboard, normal level
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 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard. 
The entry of Cyrillic or Asian characters is therefore not possible.  

 

Keyboard levels 
The alphanumerical screen keyboard has various levels. 

● Normal level

● Shift level

The key labels change when you change levels with the  key.

Procedure   
Alphanumerical values can be entered character-by-character via the buttons on the 
alphanumerical screen keyboard. 

Proceed as follows:

1. Touch the desired operating element within the screen.
The alphanumerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Use the  key to toggle between keyboard levels of the screen keyboard. On 
switchover, the key assignment of the screen keyboard changes.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the alphanumeric value or entered a new one. 
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Display tooltip

Purpose   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 9-7 Tooltip for an I/O field, example

Opening tooltips for operating elements
1. Touch the required operating element.

The screen keyboard opens. The representation of the  key indicates whether a 
tooltip was configured for the operating element or for the current screen.

2. Touch the  key of the on-screen keyboard.
The tooltip for the operating element is displayed. If there is no tooltip for the selected screen 
object, the tooltip for the current screen is displayed if it has been configured.
You can scroll through the contents of long tooltips using the   and  buttons.

 

  Note
Switching between displayed tooltips  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by touching the tooltip window. 

 

3. Close the displayed tooltip by pressing .

Alternative procedure
Depending on your configuration, tooltips can also be called via a configured operating 
element. 

Additional information on this topic may be available in your plant documentation. 
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Key operation

Control keys

Introduction     
The following tables list the control keys available to operate the project. For detailed 
information, refer to the description of the individual operating elements.

 

 Note

The availability of system keys is determined by the HMI device used. 
 

Selecting operating elements

Key Function Description

+ 
Tabulator       Selects the next or previous operating element 

based on the configured tab sequence.

Cursor keys     Selects the next operating element on the left, right, 
above or below the current screen object.
Navigates in the operating element.

Operating operating elements     

Key Function Description
+ 
 + 
 + 
 + 

Positioning cursor Positions the cursor within an operating element, for 
example, in an I/O field.

Scrolling back         Scrolls the list back by one page.
+ Scroll to start Scrolls to the start page of a list.

Scrolling up         Scrolls the list up by one page.
+ Scroll to end Scrolls to the end of a list.
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Key Function Description
ENTER key       ● Controls buttons.

● Applies and ends an entry.
● Opens a selection list.
● Toggles between character mode and standard 

mode within an input field.
A single character is selected in character mode. 
In this mode, you can scroll within the character 
set using the cursor keys.     

Cancel       ● Deletes the input characters of a value and 
restores the original value.

● Closes the active dialog.
Delete characters     Deletes the next character to the right of the current 

cursor position.
Delete characters       Deletes the character to the left of the current cursor 

position.
+ Open selection list     Opens a selection list.
+ Accept value Accepts the value selected in the selection list 

without closing the list.

Enter hotkey

Key Function Purpose
Toggle (numbers/letters)   Toggles the assignment from numbers to letters.

● No LED is lit:
The number assignment is enabled. Pressing 
the key once switches to letter assignment.

● An LED is lit:
The left or right letter assignment is enabled. 

Each time the key is pressed, the system toggles 
between the left letter assignment, the right letter 
assignment and the number assignment.       

Shift
(upper/lower case)   

Use in hotkeys, for example, for switching to 
uppercase letters.

Toggle to additional keyboard 
layout 

Some of the keys contain a blue special character 
on their bottom left corner, for example, the "%" 
character. To input these characters, press the 
relevant key in combination with the special 
character key shown on the left.

General control function   Used in hotkeys, for example, for navigating trend 
views.

General control function   Used in hotkeys, for example, for the "Status/Force" 
screen object.
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Acknowledge alarms

Key Function Purpose
Acknowledge     Acknowledges the currently displayed error alarm 

or all alarms of an alarm group (group 
acknowledgment).   
The LED is lit as long as an unacknowledged alarm 
is active.   

 

Displaying infotext    

Key Function Description
Display tooltip     Opens the configured tooltip for the selected object, 

for example, alarm or I/O field. The LED is lit if a 
tooltip is available for the selected object. 

Function keys

Function keys
Function key assignment is defined during configuration. The configuration engineer can 
assign function keys globally and locally.

Function keys with global function assignment
A globally assigned function key always triggers the same action on the HMI device or in the 
PLC irrespective of the screen displayed. Such an action could be, for example, the activation 
of a screen or the closure of an alarm window.

Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only effective 
within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one. 
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate 
operating elements with function keys, for example, the alarm view, trend view, recipe view or 
status / force. 
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General procedures

Introduction
The control keys and function keys of the HMI device are available for key operation. 

General procedure 
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue pressing the  key or the cursor keys until the required operating element is 
selected in the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Slider control: Move the slider control.

3. Confirm the your entry with  or cancel it with .

Entering and editing numerical values

Display formats for numerical values 
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values 
Tags can be assigned limits. If you enter a value that lies outside of this limit, it will not be 
accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver a 
system event, if an alarm window is configured. The original value is displayed again.

Procedure
Numerical and hexadecimal values can be entered in character mode using the system keys. 

Proceed as follows:
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1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the numerical keypad.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
To enter the hexadecimal characters "A" to "F", switch the numerical keypad to alphabet 
mode using the  key.

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.

Result
You have changed the numerical value or entered a new one. 

Entering and editing alphanumerical values

Procedure
Alphanumerical values can be entered in character mode using the system keys. 

Proceed as follows:

1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the system keys.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.
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Result
You have changed the alphanumeric value or entered a new one. 

Enter characters using the alphanumeric keyboard
Using the same keys of the alphanumeric keyboard you can enter up to six different characters. 
The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key  of the keyboard. 
Use the keys ,  and  to select the key mode.

The following table shows the entry options using the key .

Key Key Key Result
No LED is lit. Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %

Display tooltip

Use   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 9-8 Tooltip for an I/O field, example

The lit LED of the  key indicates that a tooltip was configured for the selected screen object 
or for the active screen.

Visualizing processes (Professional)
9.13 Operating in Runtime

WinCC Professional V11.0 SP1
2290 System Manual, 08/2011,  



Procedure
Proceed as follows:

1. Press the  key.
The tooltip for the selected screen object is displayed. If there is no tooltip for the selected 
screen object, the tooltip for the current screen is displayed if it has been configured.
You can scroll the contents of longer tooltips using the cursor keys  and .

 

  Note
Switching between displayed infotext  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by pressing the   key.

 

2. Close the tooltip by pressing the  key.

Alternative procedure
Depending on your configuration, tooltips can also be opened with a function key or via an 
existing operating element. 

Additional information on this topic may be available in your plant documentation. 

Mouse and keyboard operation

Operation with the keyboard
The navigation options listed in the table can be used for keyboard operations in a screen.     

Navigation PC SIMATIC Panel PC
Next field right/left <Shift+Right> / <Shift+Left> <Right> / <Left>
Next field up/down <Shift+Down> / <Shift+Up> <Down> / <Up>
To the right/left in the field <Right> / <Left> <Shift+Right> / <Shift+Left>

The other keys have identical functions on the PC and the SIMATIC Panel PC: 
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Key Function
<Enter> Applies a value (e.g. in unmarked input fields) or opens a 

selection list. 
If the I/O field is marked (highlighted in color), 
WinCC Runtime will switch to the special editing mode. Only 
one character at any time is marked in the field. 
Use the cursor keys <Up>/<Down> to scroll through a 
character table. 
Use the cursor keys Right/Left to move the cursor to the next 
or previous entry position. 
Press <Enter> or <Esc> to exit from the entry mode. The 
characters entered up to this point will be either applied or 
discarded. 

<Esc> Interrupts the input.
<Tab> Selects the next available screen object in the configured tab 

sequence. 
<Shift+Tab> Selects the previously available screen object in the 

configured tab sequence. 
<F1> -... <F12>, 
<Shift+F1>, ..., <Shift+F12>

On the PC: Triggers a function, e.g. screen selection. 

<F1>, ... or <S1>, ... or <K1>, ... On the SIMATIC Panel PC: triggers a global or local function. 

 
 

 CAUTION

If you press a function key after a screen change, the associated function in the new screen 
may be triggered before the new screen is fully displayed.

 

Controlling Windows with the keyboard
You may also use the keyboard to control the operating system of your HMI device. See your 
Windows manual for detailed information. The most important key combinations for SIMATIC 
Panel PCs are listed in the following table. 

Navigation HMI device
Open start menu <Ctrl+Esc>
Show the shortcut menu of the selected element <Shift+F10>
Select all <Ctrl+A>
Display properties of the selected element <Ctrl+Enter>
Explorer:  
Change folder <F4>
Change display areas <F6>
Enable menu bar <F10>
Dialogs:  
Go to next field <Tab>
Back to previous field <Shift+Tab>
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Navigation HMI device
Open next tab <Ctrl+Tab>
Open previous tab <Ctrl+Shift+Tab>

Operation with the mouse
A lightning symbol attached to the mouse pointer indicates that the screen object, for example 
a switch, may be operated with the mouse.     

 

 Note

If a screen object is covered by another, e.g. a button from a rectangle with a transparent fill, 
it is not possible to operate with the mouse in runtime.

The screen object can be operated with the keyboard.
 

9.13.3.2 Setting the project language

Introduction
The HMI device supports multilingual projects. You must have configured a corresponding 
operating element which lets you change the language setting on the HMI device during 
runtime. 

The project always starts with the language set in the previous session.

Requirement
● The required language for the project must be available on the HMI device.

● The language switching function must be logically linked to a configured operating element 
such as a button.

Visualizing processes (Professional)
9.13 Operating in Runtime

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2293



Selecting a language
You can change project languages at any time. Language-specific objects are immediately 
output to the screen in the new language when you switch languages.

The following options are available for switching the language:

● A configured operating element switches from one language to the next in a list.

● A configured operating element directly sets the desired language.

9.13.3.3 Project security 

Overview

Design of the security system 
The configuration engineer can protect the operation of a project by implementing a security 
system. 

The security system is based on authorizations, user groups and users. 

If you use an operator control with access protection, the HMI device first requests that you 
log on. A logon screen is displayed in which you enter your user name and password. After 
logging on, you can operate the operator controls for which you have the necessary 
authorizations. 

The logon dialog can be set up by the configuration engineer via an individual operator control. 

In the same way, the configuration engineer can set up an operator control to log off. After 
logging off, objects assigned access protection can no longer be operated; to do so, log on 
again. 

User groups and authorizations  
Project-specific user groups are created by the configuration engineer. The "Administrators" 
and "Users" groups are included in all projects by default. User groups are assigned 
authorizations. Authorization required for an operation is specifically defined for each individual 
object and function in the project.

Users and passwords   
Each user is assigned to exactly one user group. 

The following people are allowed to create users and assign them passwords: 

● The configuration engineer during configuration

● The administrator on the HMI device

● A user with user administration authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.
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Logoff times 
A logoff time is specified in the system for each user. If the time between any two user actions, 
such as entering a value or changing screens, exceeds this logoff time, the user is automatically 
logged off. The user must then log on again to continue to operate objects assigned access 
protection.

Backup and restore      
The user data is encrypted and saved on the HMI device to protect it from loss due to power 
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be 
backed up and restored. This prevents you having to enter all of the data again on another 
HMI device. 

 

 NOTICE

The currently valid user data is overwritten in the following cases:
● Depending on settings for a new download of the project.
● Upon restore of a backed-up project
● Upon import of the user administration via an operator control. The newly downloaded or 

restored user data and passwords take effect immediately.
 

Displaying users

User view

Use
The user view is used by the administrator to manage user accounts, group assignments and 
user passwords.         

Users can change their passwords and logoff times.
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Layout
The user view contains four columns for the user, password, group and logoff time. The 
passwords are encrypted by means of asterisks.     

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.

Operation
Depending on the configuration you can:     

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

Runtime behavior
The user view on the HMI devices OP 73, OP 77A and TP 177A also displays the "PLC User" 
with administrator privileges who is logged on in Runtime.

Changing existing user data   
The following options are available for the changes that can be made:

● The administrator or a user with user administration authorization can change the data for 
all users on the HMI device system in the user view.

– User name

– Group assignment

– Password

– Logoff times

● A user without user administration authorization can only change their own user data:

– Password

– Logoff time
 

  Note

If you enter the value "0" in the logoff time, user is not logged off automatically.
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Export or import user data
A user view contains all users, passwords, group assignments and logoff times set up on the 
HMI device. To not have to enter all data again on another HMI device, you can export the 
user view and then import it to another device. But you can only do this if this function has 
been configured.     

 

 Note

Do not export the password list immediately after changing it. Exit the "User view" object after 
making changes and wait until the changes have been written to the internal Flash memory 
before performing the export.

 

 NOTICE

The currently valid user data are overwritten during an import. The imported user data and 
passwords are valid immediately.

 

Simple user view

Use   
On HMI devices with a small display, the simple user view is used to display users on the HMI 
device. 

 

 Note

The "Simple user view" object cannot be operated dynamically with a script.
 

Layout
The appearance depends on the authorizations. 

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.  
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Operation  
Depending on the configuration you can:

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

User login

Touch and key operation

Logon dialog    
Use the logon dialog to log on to the security system of the HMI device. Enter your user name 
and password in the logon dialog. 

The logon dialog opens in the following cases: 

● You use an operator control with access protection.

● You press an operator control that was configured for displaying the logon dialog.

● You enable the "<ENTER>" entry in the simple user view.

● You enable a blank entry in the extended user view.

● The logon dialog will be automatically displayed when the project is started, depending on 
the configuration.

Requirement
The logon dialog is open.
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Procedure for touch operation
Proceed as follows:

1. Enter the user name and password.
Touch the corresponding input field. The alphanumerical screen keyboard is displayed. 

2. Select "OK" to confirm logon.

Procedure for key operation
Proceed as follows:

1. Select the "User" input field within the logon dialog by pressing the  key.

2. Enter the user name using the system keys.
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

3. Use the  key to select the "Password" input field.

4. Enter the password using the system keys.

5. Confirm your entries with "OK".
 

  Note

The user name is not case sensitive. 

The password is case sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

Mouse and keyboard operation

Requirement    
The logon dialog is open.

Procedure for mouse operation
Proceed as follows:

1. Click in the input field. The alphanumerical on-screen keyboard is displayed.

2. Enter the user name and the password.

3. Click "OK" in the logon dialog.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the "Users" input field is selected.

2. Enter the user name and the password.

3. Confirm your entries with "ENTER."
 

  Note

The user name is not case-sensitive. 

The password is case-sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

User logoff

Requirement
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:

● You press an operator control that was configured for logoff.

● You will be logged off automatically if you are not operating the project and if the logoff time 
has been exceeded.

You will also be automatically logged off if you enter an incorrect password. 

Result
You are no longer logged into the project. In order to use an operator control with access 
protection, you first have to log on again. 
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Creating users

Key operation 

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator. 

● A user group has been created.
 

 
 NOTICE

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

 
 NOTICE

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Select the user view using the key TAB  or using the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with ENTER .
The following dialog opens:

3. Enter the desired user name using the system keys.

4. Select the next text box with the TAB  key and enter a password using the system keys.

5. Confirm your entries with "OK."
The following dialog opens:
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6. Select the "Group" selection box with TAB .

7. Assign the user to a group.

– Select ENTER  to open the drop down list box. The drop down list box opens.

– Select the required entry using   or .

– Confirm your entry by pressing the key ENTER .

8. Select the text box "Logoff time" with TAB .

9. Enter the desired logoff time using the system keys.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Select the user view with the TAB  key via the configured tab order.

2. Select a blank line with the  or  keys.

3. Select the desired field in the blank line of the user view with the  or  keys.

4. Confirm your entry by pressing the key ENTER .

5. Enter the desired user data:

– Enter the data using the system keyboard. To enter letters, switch the numerical keypad 
to letter assignment using the key A-Z .

– Assign the user to one of the groups from the drop down list box. Open the drop down 
list box with the ENTER  key and select the desired entry with the  or  keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entry by pressing the key ENTER .

Result
The new user is created. 
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Touch operation

Requirement  
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

 
 NOTICE

Runtime users must be assigned to a user group. The user group is created in the 
Engineering System. The designation of the user group is language-dependent.

 

 
 NOTICE

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New user>" entry in the user view. A dialog opens.

2. Enter the desired user name and password.
Touch the corresponding text box. The alphanumerical on-screen keyboard is displayed.

3. Click on the text box of the group. A dialog opens.

4. Assign the user to a group. Select  and  to scroll the selection list.

5. Touch the required entry in the drop down list box.
The selected entry is accepted as input.

6. Touch the text box "Logoff time". The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."

Result
The new user is created. 
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Operation with the mouse

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

 
 NOTICE

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

 
 NOTICE

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New User>" entry in the user view.
The following dialog opens:

2. Enter the desired user name and password.
Click in the corresponding input field. The alphanumerical on-screen keyboard is displayed.

3. Click "OK".
The following dialog opens:

4. Assign the user to a group.
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5. Click the required entry in the selection list.
The selected entry is accepted as input.

6. Click in the "Logoff time" input field. The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Double-click the desired field in the blank line of the user view.
The corresponding on-screen keyboard is displayed. 

2. Enter the respective user data in the field:

– Assign the user to one of the groups from the drop down list box.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

Result
The new user is created. 

Operation with the keyboard

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

 
 NOTICE

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

 
 NOTICE

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "
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Creating users in the simple user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select the "<New user>" entry in the user view using the cursor keys and confirm it 
with <ENTER>.
The following dialog opens:

3. Enter the user name.

4. Press the <Tab> key to move to the next input field and enter a password.

5. Confirm your entries with <ENTER>.
The following dialog opens:

6. Select the "Group" selection list using the <TAB> key.

7. Assign the user to a group.

– Press <ENTER> to open the selection list. The drop down list box opens.

– Select the entry. Use the <Home>,<End>,<Up> and <Down> keys accordingly.

– Confirm the selection with <ENTER>.

8. Change to the "Logoff time" input field using the <TAB> key.

9. Enter the desired logoff time.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with <ENTER>.

Creating users in the advanced user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select an empty line in the user view using the cursor keys.

3. Select the desired field in the empty line of the user view. Use the <Up> and <Down> keys 
accordingly.

4. Confirm the selection with <ENTER>.
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5. Enter the desired user data:

– Enter the user name and the password.

– Assign the user to one of the groups from the drop down list box. Open the selection 
list by pressing <ENTER> and then select the entry using the <Up> and <Down> cursor 
keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entries with <ENTER>.

Result
The new user is created. 

Changing user data

Touch operation

Requirement
The user view is open.

Your authorization level determines the data you can change:
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● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user management authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

 
 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Changing user data in the advanced user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 
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Key operation

Requirement
The user view is open.

Your authorization level determines the data you can edit:

● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user administration authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

 
 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. In the user view, use the cursor keys to select the user whose user data you want to change. 
Confirm your entry by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.
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Changing user data in the advanced user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. Use the cursor keys to select the field in which you want to change data. Confirm your entry 
by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 

Mouse and keyboard operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

 
 NOTICE

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

 
 NOTICE

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Procedure for mouse operation
Proceed as follows:

1. Double-click on an empty line in the "User" column of the user view. 

2. Click in the User name field. Die 

3. Enter the desired user name and password.

4. Click in the corresponding input field. The alphanumerical on-screen keyboard is displayed.

5. Confirm your entries with "OK".

6. Assign the user to a group.

7. Click in the "Logoff time" input field. The screen keyboard is shown.

8. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

9. Confirm your entries with "OK".
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Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select an empty line in the "User" column. Use the <Home>,<End>,<Up> and <Down> 
keys for this purpose.

3. Enter the desired user name and password.

4. Confirm your entries with <ENTER>.

5. Assign the user to a group. Use the <Home>,<End>,<Up> and <Down> keys for this 
purpose.

6. Make an entry in the "Logoff time" input field. Enter a logoff time between 0 and 60 minutes. 
The value 0 stands for "no automatic logoff."

7. Confirm your entries with <ENTER>.

See also
Touch operation (Page 2307)

Deleting a user

Touch and key operation

Requirement    
● You have opened a screen that contains the user view.

● You must be logged on with administrator rights or be authorized for user management to 
delete users.

 

 
 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for touch operation
Proceed as follows:

1. Touch the user to be deleted in the user view.

2. Delete the user name.
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Procedure for key operation
Proceed as follows:

1. Select the user view using the  key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press  to delete the user.

Result
The user has been deleted and may no longer log onto the project. 

Mouse and keyboard operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.
 

 
 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for mouse operation
Proceed as follows:

1. Click the user to be deleted in the user view.

2. Delete the user name.

Procedure for keyboard operation
Proceed as follows:

1. Select the user view using the <TAB> key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press <DEL> to delete the user.

Result
The user has been deleted and may no longer log onto the project. 
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9.13.3.4 Operating recipes

Structure of a recipe

Recipes
The recipe collection for the production of a product family can be compared to a file cabinet. 
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet. 

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe, 
for example, for the flavors orange, grape, apple and cherry.

① File cabinet Recipe collection Recipes for a fruit juice plant
② Drawer Recipe Orange flavored drinks
③ Drawer Recipe Grape flavored drinks
④ Drawer Recipe Apple flavored drinks
⑤ Drawer Recipe Cherry flavored drinks

Recipe data records
The drawers of the file cabinet are filled with suspension folders. The suspension folders in 
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example. 
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① Drawer Recipe Product variants of apple flavored drinks
② Suspension 

folder
Recipe data record Apple drink  

③ Suspension 
folder

Recipe data record Apple nectar 

④ Suspension 
folder

Recipe data record Apple juice

Elements
In the figure showing the file cabinet, each suspension folder contains the same number of 
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data 
record. All the records of a recipe contain the same elements. The records differ, however, in 
the value of the individual elements. 

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The records 
for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in production. 
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Recipes in the project

Overview
If recipes are used in a project, the following components interact:

● HMI device recipe memory
Recipes are saved in the form of data records in the HMI device recipe memory. 

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen.

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.
 

  Note

The same recipe tags can be configured in a variety of recipes. If you modify the value 
of a recipe tag, the synchronization changes the value of the recipe tag in all recipes. 

 

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the recipe tag values are exchanged 
with the PLC depends on the configuration.

Data flow
The following figure shows the data flow in a project with recipes:

Visualizing processes (Professional)
9.13 Operating in Runtime

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2315



① Editing, saving or deleting a recipe data record
② Display recipe data record
③ Synchronize or do not synchronize recipe tags
④ Display and edit recipe tags in the recipe screen
⑤ Write records from the recipe view to the PLC or read records from the PLC and display 

them in the recipe view.
⑥ Recipe tags are to the PLC online or offline
⑦ Export or import recipe data record to memory card

Operating recipes in Runtime Advanced and Panels

Displaying a Recipe

Displaying Recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view 
A recipe view is a screen object used to manage recipe data records. The recipe view shows 
recipe data records in tabular form. 

Depending on the configuration, the recipe view is displayed as follows: 

● As enhanced recipe view

● As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe 
view. Only the simple recipe view can be configured on the TP 177A.

Enhanced Recipe View
The figure below shows an example of the enhanced recipe view:
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① Selection field for the recipe
② Selection field for the recipe data record
③ Element name

The element name designates a specific element in the recipe data record.
④ Display field

This show the number of the selected recipe or the selected recipe data record.
⑤ Value of the element 
⑥ Buttons for editing a recipe data record
⑦ Status bar for display of the status messages

Simple recipe view 
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list or data record list.

The figure below shows an example of the data record list:

① Number of the recipe data record
② Recipe data records
③ Buttons for changing the displayed list and calling the menu

Display of Values
 

 NOTICE

Changing the recipe data record in the background

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a PLC job, the recipe view 
is not updated automatically. 

To update the recipe view, reactivate the respective recipe data record.
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Recipe screen 
A recipe screen allows the correlation between the plant and the recipe data to be displayed 
in graphic form. The configuration engineer combines I/O fields and screen objects to form a 
custom input screen. The configuration engineer can distribute the I/O fields of a recipe over 
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe 
screen can be operated using buttons configured accordingly.

The figure below shows an example of the recipe screen:

① Element names and corresponding values
The element name designates a specific element in the recipe data record.

② Buttons for editing a recipe data record
③ Modified recipe view
④ Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe 
values are exchanged with the PLC immediately or later via these tags. 

A configured recipe view can itself be a component of a recipe screen. You must synchronize 
the tags in order to synchronize data between the tags of the recipe screen and the recipe 
data records displayed in the recipe view. 

Recipe Values in the HMI Device and the PLC

Introduction
You can change the values of a recipe on the HMI device and therefore influence the 
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in different 
ways. 

● If you are editing recipes with a recipe view in your project, the values are saved in recipe 
data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.
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Differences may occur between the display values in the recipe view and the values saved in 
the associated tags in an ongoing project when you edit recipes with a recipe view and in a 
recipe screen. Synchronize the values of the recipe data records with the values of the recipe 
tags to prevent this effect. 

Synchronizing recipe tags
 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Synchronization of the recipe tags depends on the configuration of the enhanced recipe view:

● Automatic synchronization:
The values of the recipe view are synchronized with the associated recipe tags. In this case, 
changes to values in the recipe view have an immediate effect on the values of the 
associated recipe tags. The values are only synchronized, when an operating element that 
is outside the recipe view is operated. 

● Synchronization by the user:
The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The project engineer has assigned the same function to the  button or 
to a different operator control in the recipe view. The recipe tags and the recipe view are 
only synchronized when you operate the buttons or the appropriate operator control.

Recipe Tags Online / Offline
The configuration engineer can configure a recipe so that changes to the values of the recipe 
tags do not have an immediate effect on the current process. 

Synchronization of the recipe values between the HMI device and the PLC depends on whether 
the configuration engineer has selected the settings "Tags online" or the setting "Tags offline" 
for a recipe.

● "Tags online":
This setting has the following effect:

– When you change recipe values in the recipe screen, these changes are applied 
immediately by the PLC and immediately influence the process.

– If recipe values are changed in the PLC, the changed values are displayed immediately 
in the recipe screen.

● "Tags offline":
With this setting, changed recipe values are not synchronized immediately between the 
HMI device and the PLC. 
In this case, the configuration engineer must configure operating elements for transferring 
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values 
are only synchronized between HMI device and PLC when you operate the appropriate 
operator control. 
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Operating the recipe view

Overview

Use
The recipe view is used to display, edit and manage data records.    

Operation
Depending on the configuration you can:   

● Creating, editing, copying or deleting recipe data records

● Synchronize recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operator controls
The following operating elements can be configured in the recipe view:   

Button Hotkey Function
 The configured tooltip is displayed.

 + Creates a new recipe data record.
If a start value is configured, it is displayed in the input field.

 + Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

 + The recipe data record is saved under a different name 
regardless of the recipe view. A dialog box opens where you can 
enter the name.

 + The displayed recipe data record is deleted.
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Button Hotkey Function
 + The system always updates the current value of the recipe view 

with the latest recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize tags" must be enabled in the recipe properties 
before you can use this function.

 + The values of the set recipe data record displayed in the recipe 
view are transferred to the PLC.

 + The recipe values from the PLC are displayed in the recipe view.

Mouse control or touchscreen control of the recipe view  
1. Select the recipe you want to use.

The data records of the recipe are displayed.

2. Click on the data record you wish to edit.

3. Press the button whose function you wish to execute.

Using the keyboard with the recipe view  
1. Press the <Tab> key until the "Recipe name" or "Data record name" field is activated.

2. Press <Enter>.
The selection list for the recipes or data records opens. 

3. Select a recipe or a data record from the list. Toggle between the next or previous entry by 
using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Press the <Tab> key until the operating element you wish to use is selected. You can also 
operate the recipe view via hotkeys.

Creating a recipe data record

Touch and key operation

Introduction
Create a new recipe data record by editing an existing data record.Save this data record under 
a new name. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Touch .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Touch the button  .

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Press  + .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Press  + .

5. Enter a name for the data record.

6. Confirm your input.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 

Mouse and keyboard operation 

Introduction   
Create a new recipe data record by editing an existing data record. Save this data record under 
a new name. 
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Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Click the button.
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Click the button.

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe for which 
you are going to create a new data record is selected.

3. Press the <CTRL+Space> key shortcut to create a new recipe data record with the next 
available number.
An existing data record is overwritten if you assign its number to a new data record.

4. Enter values for the data record elements. The data record elements can be assigned 
default values, depending on the configuration.

5. Press the <CTRL+ENTER> key shortcut to save the recipe data record.

6. Enter a name for the data record. The data record is saved under the new name.
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 
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Editing recipe data records

Touch and key operation

Introduction
Edit the values of the recipe data records and save them in a recipe view. 

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first have 
to read the current values from the PLC with .

You must transfer the data record to the PLC by pressing the  button to activate the changes 
you have made in the recipe view.

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record you want to edit.

3. Edit the data record as required.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Procedure for key operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Mouse and keyboard operation

Introduction   
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC
You must read the current values from the PLC by pressing the  button or the <CTRL+UP> 
key shortcut to display the current recipe values from the PLC in the recipe view.

You must transfer the data record you have edited to the PLC to activate the changes you 
have made in the recipe view by pressing the  button or the <CTRL+DOWN> key shortcut.

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record to be edited.

3. Edit the data record.

4. Click on  to save your changes.
Click the  button to save the recipe data record under a different name.

Procedure for keyboard operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press the <CTRL+ENTER> key shortcut to save your changes.
Use the <CTRL + *> shortcut to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Deleting recipe data records

Touch and key operation

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Press  + .

Result
The recipe data record is deleted. 

Mouse and keyboard operation

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.
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Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

3. Select the recipe data record to be deleted.

4. Press the <CTRL+DEL> key shortcut to delete the data record.

Result
The recipe data record is deleted. 

Synchronize tags

Touch and key operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 NOTICE

Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Touch the button  .

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Press  + .
 

Result
The values of the recipe data record are synchronized with the tag values. 

The most recently updated value is accepted if there is a difference between the values of the 
recipe view and the tag. 

Mouse and keyboard operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 NOTICE

Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.
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 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Click the button.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. You could also use the <CTRL+=> 
key shortcut for synchronizing.

Reading recipe data records from the PLC

Touch and key operation

Introduction
You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. Inconsistency could have developed between the values of the recipe data 
records stored in the HMI device and the values in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Touch the button  .
The values are read from the PLC.

4. Touch the button  to store the displayed values in the HMI device.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Press  + .
The values are read from the PLC.

4. Press the +  keys to store the displayed values in the HMI device.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Mouse and keyboard operation

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Click the button.
The values are read from the PLC.

4. Click on  to store the displayed values in the HMI device.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>.
You could also use the <CTRL+Down> key shortcut.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Transferring recipe data records to the PLC

Touch and key operation

Introduction
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Touch the button  .
The values are transferred to the PLC.
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Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Press  + .
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

Mouse and keyboard operation

Requirement
A screen with a recipe view is displayed. 

Operation with the mouse
1. If the recipe view contains several recipes: Select the recipe which contains the desired 

recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Click the button.
The values are transferred to the PLC.

Operation with the keyboard
1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>. You could also use 
the <CTRL+Down> key shortcut.
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 
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Using the simple recipe view

Overview

Layout
The simple recipe view consists of three areas:     

● Recipe list

● Data record list

● Element list

Figure 9-9 Simple recipe view - example with data record list

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation    
You can use the simple recipe view as follows, depending on the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Operator controls of the simple recipe view 
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.

 Key Function
Touching an entry The next lowest display area is opened, i.e. the data record list or 

the element list.
The previous display area opens. 
The shortcut menu of the display area opens.

The table below shows the operation of the shortcut menu:
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 Key Function
The menu is closed. 
The display area opens.

Touching the menu 
command

Input of the number 
of the menu 
command

The menu command is executed.

Shortcut menus of the simple recipe view    
A shortcut menu can be called for each view area by pressing the  button or the  key. 
The shortcut menu lists the commands that are available in the active view area. A number is 
assigned to each command. You execute the command by entering its number. You can also 
use the system keys to execute certain commands. 

The scope depends on the HMI device.    

● Recipe list

No. Menu command Keys Function
0 New  + A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
1 Displaying infotext Displays the infotext configured for the simple recipe view.
2 Open The record list of the selected recipe opens.

● Data record list

 Menu command Keys Function
 New  + Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
 Deleting The displayed record is deleted.
 Save as  The selected data record is saved under a different name. 

A dialog box opens where you can enter the name.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Open The element list of the selected data record opens.
 Previous The recipe list opens.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Displaying infotext Displays the infotext configured for the simple recipe view.

● Element list

 Menu command Keys Function
 Save  The selected record is renamed.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
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 Menu command Keys Function
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Save as  The data record is saved under a new name. A dialog box 

opens where you can enter the name.
 Displaying infotext Displays the infotext configured for the simple recipe view.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Previous The data record list opens.

Mouse control or touchscreen control of the simple recipe view
1. Select the desired recipe from the recipe view.

2. Click on the  button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

4. Alternatively, open the desired recipe in the recipe view.
The data record list is displayed.

5. Open the desired data record. You could also use the  button to open the shortcut menu 
and select a menu command.
The menu command is executed.

Using the keyboard with the simple recipe view
1. Press the key as many times as required to select the simple recipe view.

2. Select the desired recipe with the cursor keys.

3. Press the  key.
The shortcut menu is opened.

4. Press the cursor key as many times as required to select the menu command.

5. Confirm the menu command by pressing the key .

6. Alternatively, press the number of the desired menu command.
The menu command is executed.

 

Creating a recipe data record

Introduction  
Create a new recipe data record in the recipe list or in the record list. Then enter the values 
for the new record in the element list and save the record.
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Requirement
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows to create a recipe data record:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a 
new recipe data record.

2. Open the recipe list menu.

3. Select the "0 new" menu command.
Creates a new record.
The element list of the new record opens.

4. Enter values for the data record elements.
The tags of the record can be assigned default values depending on the configuration.

5. Open the menu of the element list and select the "0 Save" menu command.

6. Enter a name for the new record.

7. Confirm your entries.
An existing data record is overwritten if you assign its number to a new data record.

Result
The new recipe data record is saved to the selected recipe. 

Editing a recipe data record

Introduction    
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC  
To display the current recipe values from the PLC in the simple recipe view, you first have to 
read the actual values in the element list from the PLC using menu command "2 From PLC". 

Values changed in the recipe view are only activated after you transferred the modified data 
record to the PLC by means of menu command "1 To PLC".

Requirement
A screen with a recipe view is displayed.
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Procedure 
Proceed as follows to copy a recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the recipe data record you want to edit.

4. Open the element list.

5. Edit the element values as required.

6. Save your changes using menu command "0 Save".

Result
The edited recipe data record is saved to the selected recipe. 

Deleting a recipe data record

Introduction  
You can delete all the data records which are not required. 

Requirement
A screen with a simple recipe view is displayed.

Procedure for touch operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

4. Open the menu.

5. Select the menu command "1 Delete".

Procedure for key operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.
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3. Select the data record you want to delete.

4. Press 
INS

DEL .

Result
The data record is deleted. 

Reading a recipe data record from the PLC

Introduction      
The values of recipe elements are exchanged with the PLC via tags.

You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. The values of the tags on the HMI device possibly no longer match the values 
in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a simple recipe view is displayed. 

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Open the menu.

4. Select menu command "2 From PLC".
The values are read from the PLC.

5. Save the displayed values to the HMI device using menu command "0 Save".
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Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

 

 Note
Basic Panels

With Basic Panels, the "From PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "From PLC" menu command in the data record list.

 

Transferring recipe data records to the PLC

Introduction   
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a simple recipe view is displayed.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Open the menu.

4. Select menu command "1 To  PLC".

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

 

 Note
Basic Panels

With Basic Panels, the "To PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "To PLC" menu command in the data record list.
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Exporting a recipe data record

Introduction
You can export one or more recipe data records to a CSV file, depending on the configuration. 
After export, the values in the recipe data record can be further processed in a spreadsheet 
program such as MS Excel. The degree to which you can influence the export depends on the 
configuration: 

Requirement
● A screen with a recipe view is displayed.

● An operating element with the function "Export record" has been configured.

● The following tags are configured equally in the recipe view and for the "Export record" 
operating element.

– Recipe number

– Data record number

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operator control which was configured for export, for example the "Export data 
record" button.
The data record is exported as a CSV file to an external data medium.

Result
The recipe data record is exported. 

Importing a recipe data record

Introduction
You can import values from a CSV file to a recipe data record, depending on the configuration. 

Requirement
● An operator control with the function "Import data record" has been configured, for example 

a button

● A screen with a recipe view is displayed.
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Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the recipe data 
record to be imported.

2. Operate the operator control with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in 
the recipe view after import.

Result
The imported recipe data record is saved on the HMI device.

Deviating structure
If the structure of the CSV file differs from the structure of the recipe, deviations are handled 
as follows:

● Any additional values in the CSV file will be rejected

● The system applies the configured default value to the recipe data record if the CSV file 
contains an insufficient number of values

● If the CSV file contains values of the wrong data type, the configured default value is set 
in the recipe data record
Example:
The imported CSV file contains values that were entered as floating point numbers
However, the corresponding tag expects an integer value. In this case, the system discards 
the imported value and uses the configured default 

Operating recipes in Runtime Professional

Recipe view

Functional scope   
The recipe view offers access to user logs, the recipes and recipe collections. In runtime, you 
can:

● Online configuration of recipe view

● Create, delete or modify new data records

● Scrolling in recipes

● Read and write tags for direct tag link

● Importing and exporting recipes
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● Defining selection criteria to display only a certain part of the recipes

● Defining sorting conditions for the displayed recipe elements

Properties
You connect a recipe view with a recipe or recipe collection in the configuration. The online 
configuration and changing of selected recipe values in Runtime can be protected against 
unauthorized access respectively by own operator authorizations. If you cancel the access 
protection, you must reconnect the recipe view with the recipe in the configuration dialog box.

The access protection is queried when the recipe view screen opens.

● If the user has no authorization to read a recipe element, the corresponding column is not 
displayed in the table.

● If the user has no authorization to write a recipe element, the user cannot edit the data of 
the the corresponding column in the table.

Access protection for the control tags must be configured separately by the object properties, 
e.g. of a screen, an I/O field or a button.

Operating the recipe view

Mouse and keyboard operation

Introduction        
You operate the recipe view in Runtime by buttons in the toolbar. If you do not want to use the 
toolbar for operation, you can write the "ID" of the desired button in the "ToolbarButtonClick" 
object property with any dynamization type.
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Overview

Symbol Description ID
"Help"
Calls the help for the recipe view.

1

"Configuration dialog"
Opens the configuration dialog box in which you change the properties of 
the recipe view.

2

"Select data connection"
Opens a dialog box for selecting a recipe or recipe collection. The recipe 
data are then shown in the table of the recipe view.

3

"First line"
The first data record is displayed in the table by the button. 

4

"Previous line"
The previous data record is displayed in the table by the button.

5

"Next line"
The next data record is displayed in the table by the button.

6

"Last line"
The last data record is displayed in the table by the button.

7

"Delete lines"
The content of the marked lines are deleted.

8

"Cut lines"
The content of the marked lines are cut out.

9

"Copy lines"
The content of the marked lines are copied.

10

"Insert lines"
The content of the copied or cut-out lines is inserted starting from the marked 
line.

11

"Read tags"
The contents of the connected WinCC tags are read and written into the 
recipe elements by the button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use the button. The recipe 
elements must be connected with tags.

12

"Write tags"
The contents of the recipe elements are written into the connected WinCC 
tags. The "Tags" communication type must be activated in the displayed 
recipe to be able to use the button. The recipe elements must be connected 
with tags.

13

"Import Archive"
A CSV file is imported from the "ua" directory of the project folder into the 
table of the recipe view by the button.

14

"Export archive"
The original contents of the table are exported with table headers by the 
button when loading. The recipe is stored as a CSV file in the "ua" directory 
of the project folder. 

15

"Sort dialog"
Opens a dialog box for setting a customized sorting of the displayed columns.

16
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"Print"
Starts the printout of the displayed values. The print job used for printing is 
defined in the configuration dialog on the "General" tab. 

18

"Export data"
You export the recipe or recipe collection with the button as configured into 
a CSV file but with the current Runtime data. If the option "Display dialog" is 
active, a dialog opens in which you can view the settings for exporting and 
can start the export. With the appropriate operator authorizations you can 
also select the file and the directory for the export.
If no dialog box is displayed, the data export to the preset file starts 
immediately.

20

"Time base dialog"
Opens a dialog box for setting the time base for the used times.

19

"User-defined 1"
Displays the first button created by the user. The function of the button is 
customized.

1001

Possible elements of the status bar
The following elements may appear in the status bar of the recipe view:

Symbol Name Description
Archive name Displays the name of the selected recipe or recipe collection.
Row Shows the number of the marked line.
column Shows the number of the marked column.
Date Shows the system date.
Time Shows the system time.
Time Base Shows the time base used in the display of times.

Navigation in the table
You can navigate in the table as follows:

● You enter the next cell with the "ENTER" key or with the "Right" cursor key.

● You enter the previous cell with "SHIFT+ENTER" key or with the "Left" cursor key.
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● You enter the next line by clicking with the mouse in the line or with the "Down" cursor key.

● You enter the previous line by clicking with the mouse in the line or with the "Up" cursor 
key.

 

  Note

If the "Error while connecting the data!" error message appears when starting Runtime, 
the recipe view has no binding to a recipe or recipe collection. Check the following: 
● The name is specified correctly.
● The configuration is not changed.
● The connected recipe or recipe collection still exists.

 

Editing recipe data

Introduction   
You can edit data in the Data recipe view. The following options are available:

● Enter new data

● Change existing data

● Delete lines

● Cut-out, copy and insert lines

Requirement
● You have permitted editing in the configuration dialog on the "General" tab.

● You have deactivated the "Write-protected" property for the column to be edited in the 
configuration dialog on the "Columns" tab.

● The "ID" column cannot be edited.

● If the recipe view is connected with a view, you cannot delete and cut out a line.

Entering new data in the table
1. Click on  to move to the last line. The line is marked.

2. Double-click on the first cell of the marked line. You can also press on "F2", "Alt+Enter" or 
Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the new data 
record is written into the recipe. You move to another line by clicking with the mouse, with 
the "ENTER" key or with the "Up" and "Down" cursor keys.

4. You can copy the data of a marked line with "CTRL+C" or "CTRL+X" into the clipboard. 
The copied data is inserted into a marked line with "CTRL+V".
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Changing existing data in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Double-click on the desired cell of the marked line. You can also press on "F2", "Alt+Enter" 
or Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the changed 
data record is written into the recipe.

Deleting a line in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  to delete the marked line.

Cutting, copying and inserting lines
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  or  to cut or copy the data of the line. As an alternative, you can also use 
key combination "CTRL+ALT+X" or "CTRL+ALT+C".

3. Go to the desired line into which you want to copy the data. Click on  to insert the cut-
out or copied data. If you do not want to overwrite the data of the marked line, move into 
the last line to insert the data.

Selecting and configuring data

Introduction  
The recipe view shows the data of the connected recipe in a table. The displayed content of 
the table is determined by the selected columns and the selection of contents of the columns.

Requirement
● You have created one or more recipes or recipe collections.

● You have connected the recipe view with a recipe or recipe collection.
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Configuring the columns
1. Go to the "Columns" tab.

2. In the "Columns" list you can see the fields of the connected recipe or recipe collection. If 
a check mark is set in the option check box in front of the name of the column, the column 
is displayed in the table. Deactivate the check box if you do not want it to appear.

3. Determine the order of the columns in the table using the "Up" and "Down" buttons.

4. Select a column to configure the properties and the format.

5. If necessary, change the width of the column in the table. Enter a value in the "Length in 
chars" field.
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6. Some columns can also show the content and the header as a symbol. Determine how 
these columns are displayed in the "Display" field. Text and symbols can be displayed at 
the same time.

7. Save the configuration.

Selection of column content that will be displayed in the table
Configure criteria used to display the content in the columns in the "Selection" area.

Procedure
1. Click "Edit...". The selection dialog is opened.

2. Specify the criteria for the display. More information on the selection of columns can be 
found under Auto-Hotspot.

3. Click "OK" to close the selection dialog. The selection is considered at the start of Runtime 
in the table of the recipe view.
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Configuring the Sorting of Columns
You configure the sorting of the columns in the table in the "Sorting" area. You can also specify 
the sorting criteria in Runtime using the key functions.

1. Click "Edit...". The sorting dialog opens.

2. Set a sorting sequence. More information on the sorting of columns can be found under 
Auto-Hotspot.

3. Click "OK" to close the sorting dialog.

4. Save the configuration of the contents.

Select data

Introduction    
Which contents of the recipe you want to show or export in the recipe view table can be defined 
in Runtime by the selection dialog box.  In the selection dialog box you defie selection criteria 
with regard to the displayed columns of the recipe.
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Requirement
● The selection dialog is open (see paragraph "Auto-Hotspot").

Procedure
Proceed as follows:

1. Double-click in the first empty line in the "Criteria" column. The list with the columns of the 
recipe view is shown. Select the desired columns, e.g. "field1".

2. Double-click in the "Operand" column to select an operand.

3. Double-click in the "Setting" column to enter a comparison value.

4. Double click in the "Logic operator" column to select an "AND" or "OR" function.

5. Repeat the procedure if you want to define further criteria.

6. Click "OK" to close the selection dialog. The selection is displayed in the table of the recipe 
view.

 

 
 NOTICE

Ensuring the display of column content

Make sure of proper use of the settings and connections of criteria. 

Incorrect logical operations can lead to the data of the connected recipe not being 
displayed in the recipe view.

Therefore test every criterion separately before the logical operation and then the logically 
operated criteria respectively. Check that all expected contents are also displayed in 
combination.

This ensures that the selection is displayed completely in the recipe view.
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Sorting data

Introduction    
The data in the recipe view can be sorted by columns in Runtime. You sort the columns either 
via the "Sort dialog" button function or directly via the column headers.

 

 Note

You can define the  sorting criteria already in the configuration in the recipe view by clicking 
the "Edit..." button under "Sorting" on the "Columns" tab.

 

How to sort with the Sort dialog

Requirement
● You have activated the "Sorting dialog" button on the "Toolbar" tab of the UserArchive 

Control.

Procedure
1. Click the "Sort Dialog" button .

2. Select the column of the connected recipe from the "Sort by" list which is to be used for 
sorting first. Select the relevant check box to specify sorting in ascending or descending 
order. If you want to sort by more than one column, select the other columns in the desired 
order in the "Then sort by" lists.
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How to sort the column contents with the column heading 
When sorting using the column header, you are able to specify the sort order for more than 
four columns. A sorting icon and sorting index, displayed with right-justification in the column 
heading, show sorting order and sorting sequence of the column contents.

Requirement
● You have allowed sorting in the list field "Sort by column header" by click or double click 

on the "Parameters" tab of the recipe view.

● You have activated the "Show sorting icon" and "Show sorting index" checkboxes.

Procedure
1. Click the column header of the column you want to sort as first column. The sorting index 

"1" is displayed, and the sorting icon points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.

3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the 
column with a third click.

4. If you want to sort several message blocks, click the respective header columns in the 
desired sequence.

9.13.3.5 Operating alarms

Overview

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the plant, in the 
process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Event text

● Location of fault
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● Status

● Alarm class

● Alarm number

● Alarm group

● Supports diagnostics

Alarm classes  
Alarms are assigned to various alarm classes. The selection depends on the HMI device.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on." Alarms 
in this class do not require acknowledgment.

● "Errors"
Alarms in this class must always be acknowledged. Alarms normally indicate critical errors 
within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controllers.

 

 Note
Availability for specific devices

Diagnostic alarms are not available for Basic Panels.
 

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

 

  Note
Availability for specific devices

STEP 7 alarm classes are not available for Basic Panels.
 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  
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Alarm report 
When alarm report is enabled in the project, alarm events are output directly to the connected 
printer. 

You can set the reporting function separately for each alarm. The system outputs "Incoming" 
and "Outgoing" alarm events to the printer.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the complete content of the alarm buffer to the printer. 
To be able to initiate this print function, you need to configure a corresponding control object 
in the project.

 

 Note
Availability for specific devices

Alarm reports are not available for Basic Panels.
 

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

 

 Note
Availability for specific devices

Alarm logs are not available for Basic Panels.
 

Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer or alarm log. 
Whether alarms have to be acknowledged or not is specified in your configuration. By means 
of configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
If configured, an alarm window shows all pending alarms or alarms awaiting acknowledgment 
of a particular alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. Either the current alarm or the 
oldest alarm is displayed. The alarm window can also be set to indicate the exact location of 
the fault, including the date and time of the alarm event. By means of configuration, the display 
can be filtered in such a way that only alarms that contain a specific character string will be 
shown.

Alarm indicator
The alarm indicator is a graphic icon that is displayed on the screen when an alarm of the 
specified alarm class is incoming.  
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The alarm indicator can assume one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number displayed indicates the number of pending alarms.

 

Operating alarms in Runtime Advanced and Panels

Detecting pending alarms

Introduction
You can recognize the presence of alarms which must be acknowledged by the following:

● For an HMI device with keys: The LED of the key  is lit.

● Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also 
defined by the alarm class which an alarm belongs to. 

LED in the "ACK" key   
An LED is integrated in the  key on HMI devices with keyboard. The LED is lit if there are 
alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

Alarm indicator  
The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring 
acknowledgment, depending on the configuration.

Figure 9-10 Alarm indicator with three pending alarms

Layout
The alarm indicator can assume one of two states:

● Flashing:
The alarm indicator flashes as long as alarms are pending for acknowledgment. The 
number displayed indicates the number of pending alarms. The project engineer can 
configure specific functions to be executed by operating the alarm indicator.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated.
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Displaying dialogs
The displayed alarm indicator view is covered, for example, by the logon dialog, help dialog 
or alarm text windows. The alarm indicator is visible once you close these dialogs. 

Viewing alarms

Alarm view, alarm window

Use             
Alarms are displayed in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window corresponds to that of the alarm view.

The alarm window is independent of the process screen. Depending on the configuration, the 
alarm window appears automatically as soon as a new, unacknowledged alarm has been 
received. The alarm window can be configured so that it only closes after all the alarms have 
been acknowledged. 

Control elements
The buttons have the following functions:         

Button Function
Display tooltip for an alarm

Edit alarms

Acknowledge alarm

Layout of the alarm classes   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific character string are displayed in the alarm text.
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To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings"
(depends on the configuration) Custom alarm classes
$ "System"
S7 "Diagnosis Events"

Operation         
Depending on the configuration you can:

● Change the column sequence

● Change the order in which the alarms are displayed

● Acknowledge alarms

● Edit alarms

Runtime behavior

Linked alarm windows for touch panels
When you configure the alarm window for a keyboard unit, select the property "Modal" under 
"Properties > Mode". This ensures that the alarm window does not lose its focus during screen 
changes. This is important, as the switching between the screen and different windows with 
<Ctrl+TAB> is not supported. If the linked alarm window has the focus, the buttons in the screen 
behind it cannot be operated. The functions configured on a function key are carried out.

Changing the order of the displayed alarms
Click in the column to sort the alarms by date and time. 
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Simple alarm view, alarm window 

Use   
The simple alarm view shows selected alarms or alarm events from the alarm buffer or alarm 
log. The layout and operation of the simple alarm window correspond to that of the simple 
alarm view.         

 

 Note

The "Single alarm view" object cannot be operated dynamically with a script. 

In the Engineering System you can dynamically control the visibility of an object, for example, 
in the "Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does 
not support animations. If you have configured an animation and wish to perform a 
consistency check of the project, for example, then an error alarm is issued in the Output 
window.

 

Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings
(depends on the configuration) Custom alarm classes
$ "System"

Operation
Depending on the configuration you can:     

● Acknowledge alarms

● Edit alarms
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Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Edit alarm

Display tooltip for an alarm

Shows the full text of the selected alarm in a separate window, the alarm text window.
In the alarm text window, you can view alarm text that requires more space than is 
available in the alarm view. Close the alarm text window with 

.
Scrolls one alarm up

Scrolls one page up in the alarm view

Scrolls one page down in the alarm view

Scrolls one alarm down

Layout of the control elements
On the OP 73micro and TP 177micro HMI devices the simple alarm view has a button that 
displays the message text in a separate window. This button is not displayed during 
configuration of the simple alarm view in the Engineering System.

The layout of the buttons for operating the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all required buttons are available.       

Display tooltip for alarm

Touch and key operation

Procedure for touch operation
Proceed as follows to display the info text:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.
If configured, the info text assigned to this alarm is displayed. 

3. Close the screen for displaying the Info text by means of the  button.
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Procedure for key operation
Proceed as follows to display the info text:

1. Select the desired alarm in the alarm view.

2. Press the key .
If configured, the info text assigned to this alarm is displayed. 

3. Close the info text by pressing the  key.

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <TAB> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <ENTER>.

Acknowledge alarm

Touch and key operation

Requirement
The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure for touch operation    
To acknowledge an alarm, proceed as follows:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.
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Procedure for key operation
The alarm view and the alarm window have a tab sequence with which you can select operator 
controls and the last selected alarm using the keyboard.

To acknowledge an alarm, proceed as follows:

1. Select the desired alarm view or alarm window using the  key.

2. Select the desired alarm. Use the , ,  or  keys accordingly.

3. Press the key .

Alternative operation
Depending on the configuration, you can also acknowledge an alarm with a function key.

Result
The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the 
associated group are acknowledged. 

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.
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Edit alarm

Touch and key operation 

Introduction  
The configuration engineer can assign additional functions to each alarm. These functions are 
executed when the alarm is processed.

 

 Note

When you edit an unacknowledged alarm, it is acknowledged automatically.
 

Requirement
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure for touch operation
Proceed as follows to edit an alarm:

1. Touch the relevant alarm in the alarm view or in the alarm window. The alarm is selected.

2. Touch the  button in the simple alarm view or  in the enhanced alarm view.

Procedure for key operation
Proceed as follows to edit an alarm:

1. Select the desired alarm view or alarm window with TAB .

2. Select the desired alarm. Use the HOME , END ,  or  keys.

3. Continue to press the key TAB until the button  is selected in the simple alarm view or 
 in the extended alarm view.

4. Confirm your entry by pressing the key ENTER .

Result
The system executes the additional functions of the alarm. Additional information on this topic 
may be available in your plant documentation. 
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Mouse and keyboard operation 

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.
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Operating alarms in Runtime Professional

Alarm view

Overview

Application
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term).

Operation in Runtime
In Runtime, use the <TAB> key to successively move to different objects, to enter values or 
to click buttons. Set the tab sequence for the screen to "Tab sequence" to enable operation 
of the objects without mouse. You can also operate the alarm view using the mouse.

 

 Note

A message is shown with a crossed-out date and time stamp in the message list when any 
of the following occur:
● A locked message is unlocked.
● A message is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.
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Operator controls

Operator controls   
Select "Toolbar" in the Inspector window to define the operator controls and corresponding 
authorizations for the RT alarm view. The following control elements are available for the alarm 
view:

Button Function
Display "Current alarms" Shows the currently active alarms.

Display "Historical alarm 
list" (short-term)

Shows the alarms logged to the historical alarm list (short-
term).

Display "Historical alarm 
list" (long-term)

Shows the alarms logged to the historical alarm list (long-
term).

Display "Locked alarms" Shows all locked alarms in the system.

Alarm statistics Shows the alarm blocks and statistics information you 
configured in the alarm view.

Central alarm 
acknowledgment

Acknowledges a visual, or audible signaling device.

Single acknowledgment Acknowledges an individual alarm.

Group acknowledgment Acknowledges all active visible alarms in the alarm view that 
require acknowledgment, unless they require single 
acknowledgment.

Autoscroll Defines whether it is always the latest alarm that is selected 
in the alarm view. The visible area of the alarm view moves, 
if necessary. 
You can only select specific alarms if "Autoscroll" is inactive.

Filtering alarms Opens a dialog for filtering alarms in the alarm view. Even 
alarms that are not displayed in the filtered view will be 
logged.

Suppressing alarm output Opens a dialog for defining which alarms should be displayed 
in the alarm view. 
If the "All alarms" option is selected, the alarm view displays 
both hidden, and visible alarms.
If the "Visible alarms" option is activated, the alarm view 
contains only visible alarms.
If the "Hidden alarms" option is activated, the alarm view 
contains only hidden alarms.

Lock alarm Opens a dialog for locking alarms. Any alarms that meet 
these criteria are neither displayed, nor logged.

Print active view Starts printing the alarms displayed in the alarm view. 
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Button Function
Emergency 
acknowledgment

Applies emergency acknowledgment to an alarm that 
requires acknowledgment. The acknowledgment bit for an 
alarm is sent directly to the AS, even if the alarm is not active.

Initial value alarm Selects the first of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

Last alarm Selects the last of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

Next alarm Selects the next alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if 
necessary. This button can only be used if the "Autoscroll" 
function is disabled.

Previous alarm Selects the previous alarm in relation to the currently 
selected alarm. The visible area of the alarm view moves, if 
necessary. This button can only be used if the "Autoscroll" 
function is disabled.

Enter tooltip Opens a dialog for viewing infotext.

Enter comment Opens a text editor where you can enter comments.
This button is only available in the alarm view if the historical 
alarm list (long-term) is displayed. 

Loop-in-alarm If a screen change is configured, the display switches to a 
screen containing information about the alarm. 

Lock/unlock alarm Locks or unlocks an alarm in the current alarm list and in the 
alarm log lists. The alarm is entered in the lock list.

"Display options" dialog Opens a dialog for setting user-defined sort criteria for the 
displayed alarms. 

Set time base Opens a dialog for selecting the time base for the time data 
displayed in alarms.

Display "alarms with 
suppressed display"

Opens the list of hidden alarms. 

Suppress/do not suppress 
alarm

Hides an alarm in the alarm list and in the historical alarm 
lists (short-term, long-term). The alarm is entered in the list 
of hidden alarms.

Status bar  
Select "Status bar" in the Inspector window to specify the display of status bar elements. The 
following elements are available for the status bar in the alarm view:

Button Function
Date System date
Time System time

Lock is set.
A filter is activated.

List: Number of alarms currently active in the alarm list.
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Button Function
Window: Number of alarms in the window
Ack: Number of active alarms requiring acknowledgment

Filtering Alarms in Runtime

Introduction      
In Runtime, you can set specific criteria that define the alarms to be displayed in the alarm 
view. In the example below, only alarms that contain the alarm text "Motor on" are displayed. 

Requirement
The "Filter alarms" button  is configured in the alarm view.

Procedure
To filter alarms in the alarm view, proceed as follows:

1. Click  in Runtime.
The "Specify selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Alarm Text". In the right 
pane, select the "Search string" option, and double-click "Search string".

3. The "Text input" dialog opens. Enter the search string "Motor on" and click "OK" to confirm.

4. In the "Specify selection" dialog, click "OK" to confirm your entries.
The alarm view only shows the selected alarms.

In the "Specify selection" dialog, specify the start and end times, or search strings, for alarm 
text blocks such as the "Date" and "Time" system blocks. Your input must be in the format 
required in the dialog. 

The following settings are available in the "Specify selection" dialog:

Field Description
Text filter by 
exact match 

If the "Text filter by exact match" option is not enabled, all text blocks that contain 
the specified string of characters are selected.
If the "Text filter by exact match" option is enabled, all text blocks that correspond 
exactly to the specified string of characters are selected. 

Persistence in 
RT

If the "Persistence in RT" option is enabled, changes to criteria are retained even 
after a screen change.

Persistence in 
CS and RT

If the "Persistence in RT and CS" option is enabled, the modified settings are also 
applied to the Engineering System. To do this, you must open the screen in the 
"Screens" editor, and save it again. The changed settings will also be used when 
you reactivate the project.

Delete filter Use this button to delete all configured criteria.
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Filter by process values 
You cannot enter text as the criterion for a process value.

To filter by the text of a process value block, or the process tags it represents, proceed as 
follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" text block.
 

  Note

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog 
on a client have the same names on all servers.

When filtering by time, the start and stop values are not adjusted automatically when the 
timebase of the alarm view is changed.

Example: At the PC location with time zone "UTC + 1h", the alarm view has the "Local 
time zone" time base. You should filter by the time 10:00 to 11:00. Change the timebase 
from "Local time zone" to "UTC". If you want to display the same alarms, change the filter 
to 9:00 to 10:00. 

 

Sorting Alarms in Runtime

Introduction   
In Runtime, you can sort the alarms in the alarm view by column header. 

Examples for sorting alarms: 
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● In descending order by date, time, and alarm number. The most recent alarm is displayed 
at the top.

● By priority
You must have defined the priority of the alarms in the "HMI alarms" editor and configured 
the "Priority" alarm text block in the alarm view. As a result, in a single-line alarm view, only 
the top-priority alarm appears in the alarm window. A lower-priority alarm will not be 
displayed, even if it is more recent. The alarms are displayed in chronological order.

● The "Alarm status" alarm text block is sorted by the type of state and not by the configured 
status texts. For an ascending sort order, the following order is used:

– Incoming

– Outgoing

– Acknowledged

– Locked

– Enabled

– Automatic acknowledgment 

– Emergency acknowledgment

– Incoming/outgoing
 

  Note
Specifying sorting criteria in the ES for the alarm view

You can set the sort criteria to configure the alarm view as required. In the Inspector 
window of the alarm view, select "Properties > Properties > View > Columns".

 

Sorting alarms
To sort the alarm view by column, define the sort order over up to four columns. An arrow and 
a number are shown on the right in the column header. The arrow indicates the sort order 
(ascending or descending). The number beside the arrow indicates the sort order of the column 
headers.

Requirement
● "Sort by click" or "Sort by double-click" is selected in the alarm view.

Click on "Properties > Properties > Table > Table - Sorting > Settings".

● The "Autoscroll" button is activated in the alarm view. 
Click "Properties > Properties > Toolbar > Toolbar buttons". 
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Procedure
To sort alarms in the alarm view by column, proceed as follows:

1. Click or double-click the column header by which you want to sort the alarms first.
The number "1" is displayed, and the arrow points upwards for ascending sort order.

– If sort order "Up and down" is enabled in the alarm view, each click or double-click in 
the column header toggles the sorting between the ascending and descending mode.

– If sort order "Up, down, none" is enabled, then the sort order is cancelled after the 3rd 
click.

2. If you want to sort by several columns, click the column header in the required order.
 

  Note

Sorting is not affected by events or changes to the alarm text block configuration.

An alarm text block corresponds to a field in an alarm. If you define an alarm text block 
as sorting criterion in the sort dialog and then remove this block from the alarm line under 
"Properties> Properties > Columns", the defined sort order remains unchanged. In the 
sort dialog, a blank field is displayed instead of the deleted alarm text block. 

If you do not define another sort order order and reactivate the removed alarm text block 
in the alarm text block configuration, the alarms will be sorted in the original sort order 
once more. 

 

Toggling the Alarm View in Runtime

Introduction
You filter the alarms to be displayed in the alarm view using preconfigured buttons.
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Requirements
● The six buttons needed to display a certain selection of alarms are configured in the alarm 

view.

Procedure
To display a certain selection of alarms in the alarm view, follow these steps:

● Click on one of the following buttons in the alarm view:
 Alarm list, to view alarms pending
 Historical alarm list (short-term), to view logged alarms

The display is updated immediately when new incoming alarms occur.
 Historical alarm list (long-term), to view logged alarms
 Lock list, to view the locked alarms
 Alarm statistics, to view statistical information
 List of hidden alarms, to view alarms which are logged but not visible.

Displaying archived alarms in Runtime

Introduction      
In Runtime, the alarm view displays alarms from the log, in addition to the current alarms. 

Requirements
● All the archived data that you intend to display in Runtime must be stored locally on the 

archive server. The SQL server does not allow access to backup files held elsewhere, such 
as another computer on the network.

● The  and  buttons are configured in the alarm view.

Procedure
To logged alarms in Runtime, follow these steps:

1. In the alarm view, click on the "Short-term archive list"  button to display the logged 
and current alarms. Any new incoming alarms will be immediately updated in the historical 
alarm list (short-term).

-OR-
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1. In the alarm view, click on the "Long-term archive list"  button to display only logged 
alarms. The historical alarm list (long-term) only displays logged alarms. You can enter or 
view comments in the historical alarm list (long-term).

Printing Alarms in Runtime

Introduction
You have the following options for printing alarms in Runtime, depending on the settings made 
in the "HMI alarms" and "Reports" editors:

Print alarm sequence report

If the alarm sequence report is activated, all alarm status transitions in Runtime are output 
continuously to a printer. No operator input is needed in Runtime. 

Printing report

The operator input in Runtime depends on your configuration. Your options for printing an 
alarm report in Runtime are as follows:

● Time-driven output

– One-off, time-driven output, e.g. at the start of a shift

– Repeated output at specific intervals, such as every two hours

● Event-driven output

– Change in value of a tag

– By clicking a configured button in a screen

– Click the  button in the alarm view

– Overflow of a log

– Script

Requirement
● Several alarms are displayed on the HMI device.

Procedure
To print the current view in the alarm window in Runtime, follow these steps:

1. Filter the alarm view using the alarm view controls, if necessary.

2. Click the  button in the alarm view.

Result
The alarms displayed in the alarm window are output to the printer that you configured in the 
"Reports" editor.
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Printer settings
Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. For detailed information, refer to the operating 
instructions of your HMI device and to the "Reporting alarms" chapter. 

Locking alarms

Locking Single Alarms

Introduction
If you lock an alarm, this alarm will not be displayed, and will not be logged. You can lock single 
alarms, alarm classes or alarm groups as required.

 

 Note
Locked alarm:

Locked alarms are automatically unlocked when WinCC Runtime restarts. Only alarms that 
are locked directly in the AS by means of data blocks will continue to be locked (locking at 
source).
Locked alarm classes / alarm groups:

The locked state of alarm classes and alarm groups is not affected by a restart of WinCC 
Runtime.

 

Requirement
● The alarm view has been configured.

● The alarm view is displayed in Runtime.

● The "Lock alarm / Unlock alarm" button  /  is configured.

● You are authorized to lock, and unlock alarms.
 

  Note

The "Lock alarm", and "Unlock alarm" authorizations must be configured directly one 
above the other. This is necessary because the authorization level used automatically for 
the "Unlock alarms" authorization is directly below the "Lock alarms" authorization.

 

Procedure
To lock alarms and prevent them being displayed using the button, follow these steps:

1. Select the alarm that you want to lock from the alarm view.

2. Click the button.
The alarm is removed from the alarm list.
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3. Click on the  button to view all locked alarms.
The lock list is displayed.

4. Select the alarm that you want to unlock.

5. Click the button.
The alarm is displayed again and removed from the lock list.

 

  Note

Locking/unlocking an Alarm_8(P) alarm by means of S7PMC always causes all 8 alarms 
of this block to be locked, or unlocked. 

 

Locking Alarms using the Alarm Number

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
Proceed as follows to lock alarms and prevent them being displayed using the alarm number:

1. Click the button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. Click the "Add" button. In the subsequent dialog, enter the alarm number that you want to 
lock.
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4. You can lock multiple alarms at the same time. To do this, enter the alarm numbers, 
separated by commas. Enter a range of numbers in the format "5-10". Only contiguous 
number ranges are locked. If there are gaps in the specified range, an "Invalid range" 
message is output.

5. To unlock a locked alarm, select the alarm from the list of locked alarms, and click the 
"Delete" button.

 

  Note

You cannot lock, or unlock more than 50 alarms at the same time. 
 

Locking Alarms using the Alarm Class or Alarm Group

Introduction
You can also lock alarms to prevent them from being displayed by locking the entire alarm 
class, or the alarm group to which the alarm belongs. None of the alarms from these locked 
alarm groups and alarm classes will be displayed.

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
To lock, or unlock alarms via the alarm class, or the alarm group, proceed as follows:

1. In the alarm view, click the  button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.
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3. In the tree structure, select an alarm class or user-defined alarm group that you want to 
lock.

4. Click the "Lock" button.
All alarms from this alarm class or user-defined alarm group are locked.

To unlock the alarms, select the alarm class or user-defined alarm group and click on the 
"Unlock" button.

Operator input alarm when an alarm is locked
You can define in the alarm view, whether an operator input alarm is generated when an alarm 
is locked or unlocked. You should configure the operator input alarm yourself if needed. The 
operator input alarm contains the following objects by default:

● A time stamp

● The user logged on

The time stamp for the alarm originates as follows:

● From the alarm source (such as an AS) for active locking.

Actively-locked alarms are visible, and can be used on all HMI devices.

Acknowledging alarms

Acknowledge alarms

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● With customized buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To bypass the acknowledgement in Runtime, WinCC contains system functions and scripts 
that allow you to acknowledge alarms automatically.

Acknowledgement variants
You acknowledge individual alarms or multiple alarms together in Runtime. The following 
options are possible:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgement of all the alarms of an alarm group using a button, or a function key.
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● Group acknowledgement
Acknowledgement of all pending alarms in the alarm view that require acknowledgement 
using the  button in the alarm view.

● Dual-mode acknowledgment
If an alarm requires dual-mode acknowledgment, you acknowledge both the incoming, and 
the outgoing alarm.

Requirement
An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, follow these steps:

● Select the alarm.

● Click the  button in the alarm view.

Result
The alarm status is set to "Acknowledged". If the trigger condition for an alarm no longer 
applies, the alarm status is also set to "outgoing" and no longer displayed on the HMI device. 

Group Alarm Acknowledgement

Introduction
The acknowledgement of all pending, and visible alarms in the alarm window that need to be 
acknowledged is known as a group acknowledgement. If the "Single alarm" option is not 
selected for an alarm, you can trigger a group acknowledgment. 

Requirement
There are several alarms that require acknowledgement in the alarm view.

Procedure
To group-acknowledge an alarm, follow these steps:

1. Read the alarm texts of the queued alarms and initiate remedial action, if necessary.

2. In the alarm view, click the  button.
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Result
All queued alarms with the following properties are acknowledged:

● Requires acknowledgement

● Does not require acknowledgement

● Visible

Emergency Acknowledgement of Alarms

Introduction
In exceptional situations, the operator acknowledges an alarm based on its alarm number. The 
acknowledgment bit is sent to the AS even if the alarm is currently not pending. This function 
is only intended for use in imminent emergency situations. 

Requirement
The  button is configured in the alarm view.

Procedure
To acknowledge an alarm in Runtime using an emergency acknowledgement, follow these 
steps:

1. Click the  button in the alarm view.
The "Emergency Acknowledgment for Alarms" dialog opens.

2. Select a server.
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3. To enter the alarm number, select "Alarm number".

4. Click the "Send acknowledge job" button.
The alarm then appears in the alarm view in the color that you defined for an acknowledged 
alarm.

 

  Note

In the dialog for selecting the servers, only server projects whose "Packages" are loaded 
onto the PC are shown. 

 

Acknowledging Alarm Alerts

Introduction
The way you acknowledge an alarm annunciator in Runtime will depend on how you configured 
its acknowledgement. 

Requirements
● The alarm annunciator and its acknowledgment are configured.

● The alarm annunciator is triggered.

Acknowledgment using a separate key
● To acknowledge the alarm annunciator, click the  button in the alarm view.

You only acknowledge the alarm annunciator. The alarm that triggered the alarm 
annunciator is still set to "incoming" status.

Single acknowledgment
● To acknowledge the alarm annunciator, select the current alarm, and click the  button 

in the alarm view. 
You thereby acknowledge the alarm annunciator and the alarm that triggered the alarm 
annunciator.

Acknowledgment tag
If the alarm annunciator is acknowledged using a tag, acknowledge the alarm annunciator 
using a customized button or function key, etc.

Result
This sets the acknowledgment bit of the alarm annunciator.
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9.14 Performance features

9.14.1 Engineering system

Engineering system
The following tables help you assess whether your project still meets the performance 
specifications of the Engineering System.   

In addition to the specified limits, allowances must also be made for restrictions imposed by 
main memory resources. WinCC uses up to 2 GB of RAM, depending on the operating system. 
It is nonetheless useful to install more than 2 GB of main memory on the PC if running many 
applications with high memory requirements in parallel.

Project system limits

 WinCC
Number of HMI devices in the project 35
Number of HMI tags 1) 80.000
Number of logging tags 8.000
Number of blocks (faceplates, user data types)3) 10.000
Number of screens 3.000
Number of screen objects per screen 3.000
Number of screen objects 320.000
Number of alarms 2) 3) 20.000
Number of texts 3) 300.000
Number of text lists and graphic lists 3) 10.000
Number of entries per text list 3.000
Number of languages 32
Number of global libraries 3) 20
Number of objects in the project library 3) 300.000

1) Including logging tags.
2) With an average of 5 texts and a dynamic parameter
3) Including the objects configured in the "Program PLC" area

HMI device system limits

 WinCC
Number of HMI tags 1) 80.000
Number of logging tags 8.000
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 WinCC
Number of logs 500
Number of screens 1000
Number of screen objects per screen 3.000
Number of screen objects 320.000
Number of function lists 30.000
Number of animations and local scripts 50.000
Number of user-defined functions 1.000
Number of tasks 500
Number of alarms 2) 20.000
Number of recipes 1.000
Number of recipe elements 10.000
Number of texts 100.000
Number of text lists and graphic lists 1.000
Number of entries per text list 3.000
Number of users 200
Number of reports 300

1) Including logging tags.
2) With an average of 5 texts and a dynamic parameter

System limits during migration
You can migrate projects which are beyond the specified system limits in one or more areas.

An alarm will be output if migration creates a project whose limits are beyond the specified 
system limits. You must then adapt the project after migration to within the specified system 
limits to ensure safe operation in WinCC.

See also
Basic Panel (Page 2382)

Panel (Page 2385)

Mobile Panel (Page 2389)

Multi Panel (Page 2393)

Comfort Panel (Page 2397)

WinCC Runtime Advanced (Page 2400)

WinCC Runtime Professional (Page 2404)

Orientation help for performance in Runtime (WinCC Runtime Professional) (Page 2407)
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9.14.2 Basic Panel

Basic Panel
The following table helps you assess whether your project meets the performance features of 
the HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.     

Tags

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of tags in the project 250 250 500 500 500
Number of PowerTags -- -- -- -- --
Number of elements per array 100 100 100 100 100
Number of local tags -- -- -- -- --

Alarms

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 200 200 200 200 200
Number of analog alarms 15 15 15 15 15
Length of an alarm in characters 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8
Size of the alarm buffer 256 256 256 256 256
Number of queued alarm events 64 64 64 64 64

Screens

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of screens 50 50 50 50 50
Number of fields per screen 30 30 30 30 30
Number of tags per screen 30 30 30 30 30
Number of complex objects per screen 1) 5 5 5 5 5
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1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of recipes 5 5 5 5 5
Number of elements per recipe1) 20 20 20 20 20
User data length in bytes per data record -- -- -- -- --
Number of data records per recipe 20 20 20 20 20
Reserved memory for data records in the 
internal Flash

40 KB 40 KB 40 KB 40 KB 40 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of logs -- -- -- -- --
Number of entries per log (including all log 
segments) 1)

-- -- -- -- --

Number of log segments -- -- -- -- --
Cyclic trigger for tag logging -- -- -- -- --
Number of tags that can belogged per log -- -- -- -- --

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Trends

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of trends 25 25 25 25 25
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Text lists and graphics lists

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of graphics lists 100 100 100 100 100
Number of text lists 150 150 150 150 150
Number of entries per text or graphics list 30 30 30 30 30
Number of graphic objects 500 500 500 500 500
Number of text elements 500 500 500 500 500

Scripts

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of scripts -- -- -- -- --

Communication

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of connections 4 4 4 4 4
Number of connections based on 
"SIMATIC HMI HTTP"

-- -- -- -- --

Help system

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of characters in a help text 320 320 320 320 320

Languages

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of runtime languages 5 5 5 5 5

Scheduler

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Time-triggered tasks 1) -- -- -- -- --
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1) Event-triggered tasks are irrelevant for the system limits

User administration

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 KP300 Basic KTP400 Basic KTP600 Basic KTP1000 
Basic

TP1500 
Basic

Size of the project file "*.srt" 512 KB 512 KB 512 KB 1024 KB 1024 KB

See also
Engineering system (Page 2380)

9.14.3 Panel

Introduction
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.     

Tags

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of tags in the project 1000 1000 1000 500 1000 2048
Number of PowerTags -- -- -- -- - --
Number of elements per array 50 100 1000 250 1000 1000
Number of local tags -- -- 500 -- 500 1000
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Alarms

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of alarm classes 32 32 32 32 32 32
Number of discrete alarms 500 1000 1000 1000 2000 4000
Number of analog alarms 3 5 50 15 50 200
Length of an alarm in characters 80 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8 8
Size of the alarm buffer 150 256 256 256 256 512
Number of queued alarm events 50 64 64 64 64 250

Screens

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of screens 500 500 500 250 500 500
Number of fields per screen 20 30 30 30 50 200
Number of tags per screen 20 30 30 30 50 200
Number of complex objects per 
screen 1)

5 5 5 5 5 10

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of recipes -- 5 100 5 100 300
Number of elements per recipe1) -- 20 200 20 200 1000
User data length in bytes per data 
record

-- -- 800 -- 800 4000

Number of data records per recipe -- 20 200 20 200 500
Reserved memory for data records in 
the internal Flash

-- 40 KB 32 KB 40 KB 32 KB 64 KB

1) If arrays are used, each array element counts as one recipe element
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Logs

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of logs -- -- -- -- -- 20
Number of entries per log (including all 
log segments) 1)

-- -- -- -- -- 10000

Number of log segments -- -- -- -- -- 400
Cyclic trigger for tag logging -- -- -- -- -- 1 s
Number of tags that can be logged per 
log

-- -- -- -- -- 2048

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Trends

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of trends -- -- -- 25 50 300
Number of measured values per trend -- -- -- 999 999 999

Text lists and graphics lists

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of graphics lists -- -- -- 100 100 400
Number of text lists 150 300 300 300 300 500
Number of entries per text or graphics 
list

30 30 30 30 30 256

Number of graphic objects 500 1000 1000 1000 1000 1000
Number of text elements 1000 1000 2500 1000 2500 10000

Scripts

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of scripts -- -- -- -- -- 50
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Communication

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of connections 2 4 4 4 4 6
Number of connections based on 
"SIMATIC HMI HTTP"

-- -- -- -- 4 8

Maximum number of connected 
Sm@rtClients (including a service 
client)

-- -- -- -- 2 3

Help system

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of characters in a help text 320 320 320 320 320 320

Languages

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of runtime languages 5 5 5 5 5 16

Scheduler

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Time-triggered tasks 1) -- -- 10 -- 10 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of user groups 25 50 50 50 50 50
Number of authorizations 32 32 32 32 32 32
Number of users 25 50 50 50 50 50
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Project

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Size of the project files "*.fwc", "*.srt" 256 KB 320 KB 1 MB 6":512 KB 2 MB 4 MB

See also
Engineering system (Page 2380)

9.14.4 Mobile Panel

Mobile Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.     

Tags

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of tags in the project 1000 2048 2048 2048 2048
Number of PowerTags - -- -- -- --
Number of elements per array 1000 1000 1000 1000 1000
Number of local tags 500 1000 1000 1000 1000

Alarms

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 2000 4000 4000 4000 4000
Number of analog alarms 50 200 200 200 200
Length of an alarm in characters 80 80 80 80 80
Number of process values per 
alarm

8 8 8 8 8
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 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Size of the alarm buffer 256 512 512 512 512
Number of queued alarm events 64 250 250 250 250

Screens

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of screens 500 500 500 500 500
Number of fields per screen 50 200 200 200 200
Number of tags per screen 50 200 200 200 200
Number of complex objects per 
screen 1)

5 10 10 10 10

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of recipes 100 300 300 300 300
Number of elements per recipe1) 200 1000 1000 1000 1000
User data length in bytes per data 
record

800 4000 4000 4000 4000

Number of data records per 
recipe

200 500 500 500 500

Reserved memory for data 
records in the internal Flash

32 KB 64 KB 64 KB 64 KB 64 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of logs -- 20 20 20 20
Number of entries per log 
(including all log segments) 1)

-- 10000 10000 10000 10000

Number of log segments -- 400 400 400 400
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 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Cyclic trigger for tag logging -- 1 s 1 s 1 s 1 s
Number of tags that can be 
logged per log

-- 2048 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Trends

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of trends 50 300 300 300 300

Text lists and graphics lists

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of graphics lists 100 400 400 400 400
Number of text lists 300 500 500 500 500
Number of entries per text or 
graphics list

30 256 256 256 256

Number of graphic objects 1000 1000 1000 1000 1000
Number of text elements 2500 10000 10000 10000 10000

Scripts

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of scripts -- 50 50 50 50
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Communication

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of connections 4 6 6 6 6
Number of connections based on 
"SIMATIC HMI HTTP"

4 8 8 8 8

Maximum number of connected 
Sm@rtClients (including a 
service client)

2 2 8'': 3
10": 2

8'': 3
10": 2

8'': 3
10": 2

Mobile Wireless

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of zones -- -- 254 254 --
Number of effective ranges -- -- -- 127 --
Number of assigned 
transponders

-- -- 255 255 --

Number of configurable 
transponders

-- -- 65534 65534 --

Number of effective ranges 
(RFID)

-- -- -- -- 127

Number of RFID tags that can be 
assigned to effective ranges 
(RFID) in a project

-- -- -- -- 127

Help system

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of characters in a help 
text

320 320 320 320 320

Languages

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of runtime languages 5 16 16 16 16
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Scheduler

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Time-triggered tasks 1) 10 48 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Size of the project file "*.fwc" 2 MB 6 MB 6 MB 6 MB 6 MB

See also
Engineering system (Page 2380)

9.14.5 Multi Panel

Multi Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.     
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Tags

 MP 177 MP 277 MP 377
Number of tags in the project 1000 2048 4096
Number of PowerTags -- -- --
Number of elements per array 1000 1000 1000
Number of local tags 500 1000 2000

Alarms

 MP 177 MP 277 MP 377
Number of alarm classes 32 32 32
Number of discrete alarms 2000 4000 4000
Number of analog alarms 50 200 200
Length of an alarm in characters 80 80 80
Number of process values per alarm 8 8 8
Size of the alarm buffer 256 512 1024
Number of queued alarm events 64 250 500

Screens

 MP 177 MP 277 MP 377
Number of screens 500 500 500
Number of fields per screen 50 200 400
Number of tags per screen 50 200 400
Number of complex objects per screen 1) 5 10 20

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 MP 177 MP 277 MP 377
Number of recipes 100 300 500
Number of elements per recipe1) 200 1000 1000
User data length in KB per data record 0,8 4 128
Number of data records per recipe 200 500 1000
Reserved memory for data records in the 
internal Flash

32 KB 64 KB 128 KB
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1) If arrays are used, each array element counts as one recipe element

Logs

 MP 177 MP 277 MP 377
Number of logs -- 20 50
Number of entries per log (including all log 
segments) 1)

-- 10000 50000

Number of log segments -- 400 400
Cyclic trigger for tag logging -- 1 s 1 s
Number of tags that can be logged per log -- 2048 2048

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Trends

 MP 177 MP 277 MP 377
Number of trends 50 300 400

Text lists and graphics lists

 MP 177 MP 277 MP 377
Number of graphics lists 100 400 500
Number of text lists 300 500 500
Number of entries per text or graphics list 30 256 256
Number of graphic objects 1000 1000 2000
Number of text elements 2500 10000 30000

Scripts

 MP 177 MP 277 MP 377
Number of scripts -- 50 100
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Communication

 MP 177 MP 277 MP 377
Number of connections 4 6 6
Number of connections based on "SIMATIC 
HMI HTTP"

4 8 8

Maximum number of connected 
Sm@rtClients (including a service client)

2  6'': max. 3
10'': max. 2

12'': max. 3
15'': max. 2
 19": max: 1

Help system

 MP 177 MP 277 MP 377
Number of characters in a help text 320 320 320

Languages

 MP 177 MP 277 MP 377
Number of runtime languages 5 16 16

Scheduler

 MP 177 MP 277 MP 377
Time-triggered tasks 1) 10 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 MP 177 MP 277 MP 377
Number of user groups 50 50 50
Number of authorizations 32 32 32
Number of users 50 50 50

Project

 MP 177 MP 277 MP 377
Size of the project file "*.fwc" 2 MB 6 MB 12 MB
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See also
Engineering system (Page 2380)

9.14.6 Comfort Panel

Comfort Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of tags in the project 1024 2048 2048 2048
Number of PowerTags -- -- -- --
Number of elements per array 1000 1000 1000 1000
Number of local tags 500 1000 1000 1000

Alarms

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of alarm classes 32 32 32 32
Number of discrete alarms 2000 4000 4000 4000
Number of analog alarms 50 200 200 200
Length of an alarm in characters 80 80 80 80
Number of process values per alarm 8 8 8 8
Size of the alarm buffer 256 1024 1024 1024
Number of queued alarm events 64 500 500 500
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Screens

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of screens 500 500 500 500
Number of fields per screen 50 400 400 400
Number of tags per screen 50 400 400 400
Number of complex objects per screen 1) 5 20 20 20

1) Complex objects include: bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of recipes 100 300 300 300
Number of elements per recipe1) 200 1000 1000 1000
User data length in KB per data record 32 256 256 256
Number of data records per recipe 200 500 500 500
Reserved memory for data records in the internal 
Flash

512 KB 2 MB 2 MB 2 MB

1) If arrays are used, each array element counts as one recipe element

Logs

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of logs 10 50 50 50
Number of entries per log (including all log 
segments) 1)

10000 20000 20000 20000

Number of log segments 400 400 400 400
Cyclic trigger for tag logging 1 s 1 s 1 s 1 s
Number of tags that can be logged per log 100 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all segmental circular logs. The product of the number of segmental circular 
logs and the number of data records per segmental circular log may not exceed the 
system limit.

Visualizing processes (Professional)
9.14 Performance features

WinCC Professional V11.0 SP1
2398 System Manual, 08/2011,  



Trends

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of trends 50 300 300 300

Text lists and graphics lists

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of graphics lists 100 500 500 500
Number of text lists 300 500 500 500
Number of entries per text or graphics list 30 500 500 500
Number of graphic objects 1000 4000 4000 4000
Number of text elements 2500 40000 40000 40000

Scripts

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of scripts 50 100 100 100

Communication

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of connections 4 8 8 8
Number of OPC connections including OPC UA 4 8 8 8
Number of connections based on "SIMATIC HMI 
HTTP"

4 8 8 8

Maximum number of connected Sm@rtClients 
(including a service client)

2 3 3 3

Help system

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of characters in a help text 320 320 320 320
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Languages

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of runtime languages 32 32 32 32

Scheduler

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Time-triggered tasks 1) 10 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Number of user groups 50 50 50 50
Number of authorizations 32 32 32 32
Number of users 50 50 50 50

Project

 KTP400
KP400

TP700
KP700

TP900
KP900

TP1200
KP1200

Size of the project file "*.fwc" 4 MB 12 MB 12 MB 12 MB

See also
Engineering system (Page 2380)

9.14.7 WinCC Runtime Advanced

WinCC Runtime Advanced
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

Visualizing processes (Professional)
9.14 Performance features

WinCC Professional V11.0 SP1
2400 System Manual, 08/2011,  



In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.       

Tags

 WinCC Runtime Advanced
Number of tags in the project 6144
Number of PowerTags 128 –4096
Number of elements per array 1600
Number of local tags 2048

Alarms

 WinCC Runtime Advanced
Number of alarm classes 32
Number of discrete alarms 4000
Number of analog alarms 500
Length of an alarm in characters 80
Number of process values per alarm 8
Size of the alarm buffer 1024
Number of queued alarm events 500

Screens

 WinCC Runtime Advanced
Number of screens 500
Number of fields per screen 400
Number of tags per screen 400
Number of complex objects per screen 1) 40

1) Complex objects include: bars, sliders, symbol library, clock and all objects from the 
Controls area.

Recipes

 WinCC Runtime Advanced
Number of recipes 999
Number of elements per recipe1) 2000
User data length, in KB per data record 256
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 WinCC Runtime Advanced
Number of data records per recipe 5000
Reserved memory for data records in the internal Flash --

1) If arrays are used, each array element counts as one recipe element

Logs

 WinCC Runtime Advanced
Number of logs 100
Number of entries per log (including all log segments) 1) 500000
Number of log segments 400
Cyclic trigger for tag logging 1 s
Number of tags that can be logged per log 6144

1) The number of entries for the "segmented circular log" logging method is the maximum 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 WinCC Runtime Advanced
Number of trends 800

Text lists and graphics lists

 WinCC Runtime Advanced
Number of graphics lists 500
Number of text lists 500
Number of entries per text or graphics list 3500
Number of graphic objects 2000
Number of text elements 30000

Scripts

 WinCC Runtime Advanced
Number of scripts 200
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Communication

 WinCC Runtime Advanced
Number of connections 8
Number of OPC connections including OPC UA 8
Number of connections based on "SIMATIC HMI HTTP" 16
Maximum number of connected Sm@rtClients (including a service client) 4 1)

1) Only up to three Sm@rtClients can interconnect with the Sm@rtServer on Panel PC 
477.

Help system

 WinCC Runtime Advanced
Number of characters in a help text 320

Languages

 WinCC Runtime Advanced
Number of runtime languages 32

Scheduler

 WinCC Runtime Advanced
Time-triggered tasks 1) 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 WinCC Runtime Advanced
Number of user groups 50
Number of authorizations 32
Number of users 100

Project

 WinCC Runtime Advanced
Size of the project file "*.fwc" No limiting
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See also
Engineering system (Page 2380)

9.14.8 WinCC Runtime Professional

WinCC Runtime Professional
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device. Keep the performance characteristics of the engineering 
system in mind in this context. If they are lower, they have priority over the limits given for 
Runtime.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.       

Screens

 WinCC Runtime Professional
Objects per screen 1) No limit 2)

Layers per screen 32
Screens per project No limit 2)

Fixed faceplate instances in a plant screen 31 instances of the same type screen
Screen size in pixels 10,000 x 10,000
Screen object nesting 20
Number of colors Depends on graphics card

1) The number and complexity of objects affects performance
2) Limited by system resources.

Alarms

 WinCC Runtime Professional
Configurable alarms per server/single-user station 150,000
Process tags per alarm line 10
User text blocks per alarm line 10
Alarm classes 256
Alarm priorities 17 (0...16)
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Alarms in Runtime

 Maximum
Alarms per alarm log No limit 1)

Alarms per historical alarm list (short-term) 1,000
Alarms per historical alarm list (long-term) 1,000 2)

Alarms per alarm view 5,000 3)

1) Limited by system resources.
2) On single-user station, or server or client per server if "LongTimeArchiveConsistency" 

has been set to "no". On single-user station, server, or client if 
"LongTimeArchiveConsistency" has been set to "yes".

3) On single-user station or server, or on client per server.
 

 Note

Message bursts and continuous alarm load may be generated simultaneously on a single-
user station or server.

 

Logs

 WinCC Runtime Professional
Trend view per screen 25
Trends per trend view 80
Table view per screen 25
Columns per table view 12
Values per table view 30,000
Logs per single-user station/server 100
Logging tags per single-user station/server 1) 80,000

1) Depends on the Logging PowerPack used for logging tags. The basic version contains 
500 logging tags.

 

 Note

Screen selection times may be extremely long in the event of multiple maximum values.
 

Visualizing processes (Professional)
9.14 Performance features

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2405



Recipes

 WinCC Runtime Professional
Number of recipes No limit 1)

Number of recipe elements 500 2)

Number of recipe data records 3,000 2)

Number of views No limit 1)

1) Limited by system resources.
2) The product of the number of fields and number of data records must not amount to 

more than 320,000 cells, e.g. 3000 data records for 106 fields, or 640 data records for 
500 fields. Both the first two columns (grey column and "ID" column) and the column 
titles must be counted when calculating the current number of cells.

Reports

 WinCC Runtime Professional
Configurable reports No limit 1)

Report lines per detail view 66
Tags per report 2) 300

1) Limited by system resources.
2) The number of tags per report depends on the performance of process communication.

Reports in runtime

 Maximum
Alarm sequence reports running simultaneously per server/client 1
Alarm log reports running simultaneously 3

Configurations - quantity structure in the multi-station system

 WinCC Runtime Professional
WinCC clients in a system 32 1) 2)

Web clients in a system 50 3)

1) The number of clients is reduced to four if the server also used as operator station.
2) Mixed configuration: 32 clients + 3 Web clients
3) Mixed configuration: 50 Web clients + 1 WinCC client
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See also
Engineering system (Page 2380)

9.14.9 Orientation help for performance in Runtime (WinCC Runtime Professional)

WinCC Runtime Professional
The following tables help you to assess operational performance of your project in 
Runtime.     

 

 Note

The values specified greatly depend on the hardware used.
 

Screens in Runtime

Screen change from an empty screen to... Time in seconds
Screen with standard objects (100 objects) 1
Screen with 2480 I/O fields (8 internal tags) 2
Screen with 1000 I/O fields (1000 internal tags) 1
10 MB screen (bitmap) 1
Alarm view 2
Table view with 4 columns, each with 120 values 1) 1

1) The values specified are valid for data from "Tag Logging Fast".

Alarms in Runtime

 Maximum
Continuous alarm load without losses (single-user station/server) 10/sec
Message burst (single-user station/server) 2000/10 seconds at intervals of 5 minutes 1)

1) Alarms are possibly lost if the interval before the next message burst is less than five 
minutes.

 

 Note

Message bursts and continuous alarm load may be generated simultaneously on a single-
user station or server.
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Logs in runtime

 Maximum
Logging in database for server/single-user station (Tag Logging Fast) 5000 values/second 1) 

Logging in database for server/single-user station (Tag Logging Slow) 1000 values/second 1) 2)

Number of values printed in a report The number of values printed depends on the 
number of values displayed in the trend view.

1) The values specified are valid for logging data without signature.
2) With Tag Logging Slow, expect longer screen selection times for a given amount of 

data than for Tag Logging Fast.

Recipes in runtime

Associated conditions

Hardware used Software used Configuration
1.5 GHz AMD Athlon 4
2 GB RAM
No hardware connection

Windows Server 2003 SP2
WinCC V11.0

One WinCC tag per field
300,000 entries each:
- 10 fields with 30,000 data records
- 500 fields with 600 data records

 

Measured values

 10 fields 500 fields
Screen change to a screen with integrated recipe view.
Result of measurement depends on the fill level of the control: 
It can take up to 15 seconds for complete display upon initial 
loading or if considerable configuration changes are made in the 
user log.

1 second 5 seconds

Read data record:
Read the value to the corresponding tag after the button in the 
recipe view was clicked.

1 - 2 seconds 1) n seconds 2)

Write data record: 
Write the value to the corresponding tag and display of the tag 
in the I/O field after the button in the recipe view was clicked.

1 - 3 seconds 1) n seconds 2)

Focus change from the first to the last data record. 1 - 2 seconds 1 - 2 seconds

1) 10 fields with a total of 10 tags.
2) 500 fields with a total of 500 tags.
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Scripting Runtime
The following measured values show the differences between VBS and C on the basis of guide 
values. The measured values are entered in milliseconds

Pentium 4 2.5 GHz, 512 MB RAM VBS ANSI-C
Setting the color of 1000 rectangles 220 1,900
Setting the output value of 200 I/O fields 60 170
Selection of a screen with 1000 static texts which retrieve the object name 
and output it as a return value.

460 260

Read 1000 internal tags 920 500
Re-read 1000 internal tags 30 120
Carry out 100,000 calculations 1) 280 70

Pentium III 700 MHz, 512 MB RAM VBS ANSI-C
Setting the color of 1000 rectangles 610 4,440
Setting the output value of 200 I/O fields 170 670
Selection of a screen with 1000 static texts which retrieve the object name 
and output it as a return value.

770 310

Read 1000 internal tags 3,650 1,310
Re-read 1000 internal tags 70 250
Carry out 100,000 calculations 1) 820 170

1) Sample calculations:
 VBS

For i=1 To 100000
value=Cos(50)*i
Next

ANSI-C
for(i=1;i<=100000;i++)
{
dValue=cos(50)*i;
}

 

 Note

The measured values are also affected by the type of configuration and other processes, 
such as logging or alarm processing.

 

Reports in runtime

 Maximum
Alarm sequence reports running simultaneously per server/client 1
Alarm log reports running simultaneously 3

See also
Engineering system (Page 2380)
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9.14.10 General technical specifications

9.14.10.1 Recommended printers

Recommended printers
The current list of printers recommended for use with the HMI devices is available on the 
Internet at:

Link to the current printer list 
 

 Note

All HMI devices except for a PC and Panel PC support only one printer at their USB port, 
even if several ports are available.

 

9.14.10.2 Memory requirement of recipes

Introduction
The following calculation of memory requirements of recipes is only valid for Windows CE 
devices. 

Calculation of memory requirements
The memory space required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:

● D1 = (number of entries x 5 + M + 8):1024
Applies to M:
M = Accumulated length of all tag names = sum of characters in all tag names (UTF8 coded, 
max. 255 bytes per tag name) used in the entries.

● D2 = [(number of data records x 12) + 4]:1024

● D3 = [number of data records x (data record length + N) + 4]:1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.

Memory requirements for using arrays
The memory required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:
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● D1 = (number of entries x 5 + M + 8):1024
Each element of the tag array used counts as a single entry.
Applies to M:
M = (length of the array tag name + K) x  number of array elements
Applies to K:
K = 3: 2 to 9 elements in the array
K = 4: 10 to 99 elements in the array
K = 5: 100 to 999 elements in the array
K = 6: 1000 to 9999 elements in the array
K = 7: 10000 to 12000 elements in the array

● D2 = [(number of data records x 12) + 4] : 1024

● D3 = [number of data records x (data record length + N) + 4] : 1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.
 

 Note

If you use both tags and arrays in a recipe, you have to add the results of both formulas to 
calculate the total memory required.

 

 

9.14.10.3 Memory requirements of recipes for Basic Panels, OP 77A, and TP 177A

Introduction
The following calculation of memory requirements of recipes is valid for Basic Panels, OP 77A, 
and TP 177A devices. 

Restrictions
The HMI device provides 39 KB of memory space for recipes. This memory space may not be 
exceeded. The total memory space for recipes is calculated as follows: Total of all recipes + 
recipe with highest memory requirement.

Each recipe may not exceed a maximum memory space of 19 KB.

Calculation of memory requirements
The memory space requirement of each recipe (in KB) is calculated based on the three 
addends D1 + D2 + D3.

Valid is::
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● D1 = number of data records x M
 
Rule for M (size of a data record):
M = 1 x number of elements of a byte + 2 x number of elements of 2 bytes + 4 x number 
of elements of 4 bytes + 8 x number of elements of 8 bytes + K
 
Rule for K (size of the string elements):
K = number of string elements x (string length + 1) x 2

 

● D2 - data record size
 
D2 = 4 + number of languages x 8 + number of languages x (4 + 4 x number of data records 
+ (length of the data record name + 1) x 2 x number of data records) + 8 + 8 x number of 
data records
 
Or rewritten:
 
D2 = 12 + 8 x number of data records + number of languages x (12 + number of data records 
x (4 + (length of the data record name +1) x 2))

 

● D3 - shared memory
D3 = 14 + number of elements

 

 Note

Arrays and single elements can be calculated as described above.
 

 

9.15 Options

9.15.1 Following GMP with audit

9.15.1.1 Basics

GMP compliance

GMP compliant projects with WinCC    
Traceability and therefore the documentation of production data is becoming increasingly 
important in many industrial sectors such as the pharmaceuticals industry, the food and 
beverage industry. and in the related mechanical engineering sector. 
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Storage of production data in electronic form offers many advantages compared to paper 
documents, such as simple acquisition and logging of data. 

However, it is also important to ensure that data cannot be falsified and that it can be read at 
any time. 

Industry-specific and general standards for electronic documentation of production data have 
been developed for this purpose. 

The most important set of regulations is the FDA guideline 21 CFR Part 11 for electronic data 
records and electronic signatures issued by the FDA, the US Food and Drug Administration. 
The various EU regulations, such as EU 178/2002, also apply for particular industries.

Requirements for production systems in these industries have been developed on the basis 
of 21 CFR Part 11 and the corresponding layout to comply with GMP (Good Manufacturing 
Practice). They are also required for other industries.

The following primary requirements are derived from these directives and rules:

● Creation of an Audit Trail or operating trace in runtime
This document can be use to trace a complete log of which user has run what control 
function on the machine at what time.

● Important process stages must also be traceable to a specific responsibility, for example 
with an electronic signature.

GMP-compliant configuration

Introduction
"GMP compliant configuration" means creating projects in accordance with "Good 
Manufacturing Practice". The requirements are set out in FDA rules "21 CFR Part 11". The 
FDA is the U.S. Food and Drug Administration. 

GMP-compliant configuration means HMI devices have electronic production data 
documentation functionalities.

GMP relevant and the audit trail
WinCC offers the "Audit" option for implementing GMP compliance. Using the audit option, the 
"GMP compliant configuration" function can be enabled.

Enable the "GMP compliant configuration" function directly in the runtime settings of the HMI 
device. GMP relevant functionalities are then added to WinCC. These functionalities are:

● Audit Trail

● Electronic signature

● Option to label tags as "GMP relevant".

● Option to label tags as "GMP relevant" for recipes.

● NotifyUserAction system function

● Logging of tags using checksum
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● Logging of alarms using checksum

● Audit trail record for printing logged changes

A license is required to convert the GMP-relevant functions configured in WinCC in runtime.

Depending on the edition of WinCC, use one of the following licenses:

● WinCC Audit for RT Advanced

● WinCC Audit for SIMATIC Panel

If the labeled objects are executed or changed, then it is saved in a special log, the "Audit Trail".

See also
Configuring a checksum for a log (Page 1121)

Configuring a checksum for a log (Page 1365)

Audit option

Advanced functions    
The Audit option adds functions to WinCC to ensure that your project is GMP compliant.

The following functions are added:

● Audit Trail
For every HMI device, you can create an Audit Trail .
Operator actions and system processes that are relevant for the FDA-compliance of the 
process are recorded in an Audit Trail during runtime. 

– User actions such as changes in the values of GMP relevant tags or recipes or the 
acknowledgment of alarms.

– Actions by the system, such as starting up runtime or rejection of logon attempts.

● Electronic signature
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing recipe data records or tag values. 
All  Audit-relevant user actions must be protected by authorization in the user administration.
The user will then only be able to run these actions if an electronic signature and, if 
configured appropriately, a comment have been input. The electronic signature and the 
comment are logged in the audit trail.

Extension of the WinCC engineering system  
For all HMI devices that support "GMP-compliant configuration", the WinCC engineering 
system is extended to include the following configuration options when GMP is enabled:

● The entry "AuditTrail" is added to the "Logs" editor.

● A "Good Manufacturing Practice Settings" entry is added to "HMI tags" editor in the 
inspector window of a "Properties > Properties" tag.
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● A "Good Manufacturing Practice" entry is added to "Recipes" editor in the inspector window 
of a "Properties > Properties" recipe.

● "NotifyUserAction" system function

 

Scope of logging

Introduction   
It is important to ensure that audit-related processes are always logged in runtime in the audit 
trail in a project with the option "Audit". 

Scope of logging  
The following operations are Audit-relevant and are automatically saved in the Audit Trail:

● Runtime sequence

– Runtime start and runtime stop

– Project information: Version and project name, of the configuration environment, device, 
and current runtime configuration

– Failure of the voltage supply of an active Uninterruptible Power Supply (UPS).

● User administration

– Logon and logoff of users

– Invalid logon attempts

– Import of user administration

– Changes of user administration

● Alarm system

– All alarms that are acknowledged by the user.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm text in Audit Trail" option in the Audit Trail 
editor:

"Audit trail > Properties > Settings" in the "Settings" area
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● Log operations

– Starting, stopping and copying a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Long-term logging of a log

● Running specific system functions depending on their functionality and the triggering event

The following audit processes are logged depending on the configuration of the recipes and 
the tags of the project:

● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes:

– Storing after changing and creating recipe data records

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

● "NotifyUserAction" system function
You use the system function "NotifyUserAction" to record user actions that are not 
automatically recorded by the audit trail. 
You can configure this system function for screen calls, for example You can also configure 
function lists containing system functions that do not require signature or acknowledgement.

9.15.1.2 Enabling GMP compliant configuration

Introduction
The Audit Trail and "Electronic Signature" functions are qualified as "GMP compliant 
configuration". 

Requirements
● A project is created.

● A GMP compatible HMI device has been created.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click on "GMP".

4. Select "GMP compliant configuration".

Result
The Audit option is now enabled for the HMI device. 

The following functions can now be configured:

● Audit Trail log

● "NotifyUserAction" system function

● GMP relevant tags

● GMP relevant recipes

See also
Configuring a checksum for a log (Page 1121)

Evaluating the checksum of log data (Page 1122)

Configuring a checksum for a log (Page 1365)

Evaluating the checksum of log data (Page 1366)
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9.15.1.3 Using the Audit trail

Audit Trail

Introduction   
Configure a log in the settings for Audit Trail editor. This log is used to store changes in tag or 
recipe values made by the user and other user actions in runtime. 

"Settings for audit trail" editor
1. In the project view, double-click "AuditTrail" in the "Log" group.

2. Click on the "Settings for audit trail" tab.

3. Change the properties of Audit Trail in the inspector window.

Audit trail work area
You define the settings for the Audit Trail in the "Properties > Properties" inspector window. 
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You set the name of the log and the storage location and decide whether logging will begin on 
startup. Also determine if "Forcing" is permitted. 

"Forcing" is a function for administrators. It allows the administrator to continue the process 
even if the maximum log storage space has been exceeded. 

Thus, the Audit Trail switches off and must be rebooted using the "StartLogging" system 
function.

Creating an audit trail

Requirements
"GMP compliant configuration" has been selected on the HMI device.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Logs".
The "Logs" editor will open.
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3. Change to the "Audit Trail" tab.
An audit trail has been created.

4. Define the following in the inspector window:

– Name

– Storage location

– Logging with runtime start-up

– Forcing
 

  Note

No audit-related user actions are permitted in GMP relevant projects if there is 
insufficient storage space available for the audit trail. 

If the check box "Forcing permitted" is activated and, because of the hardware, there 
is insufficient storage space in runtime, the administrator can interrupt audit trail 
logging. The administrator can prevent the process from stopping in this way. 

If the administrator enables the "Forcing" function, the interruption of the audit trail by 
the administrator will be entered in the audit trail as the last entry.

At the end of "Forcing" restart the audit trail using the "StartLogging" system function.
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Configuring a function list
If necessary, configure a function list for the events "Low free storage space" and "Free space 
critically low". 

The "Low free storage space" event is triggered if the amount of free storage space available 
for the audit trail in runtime is less than the amount configured in "Minimum storage space in 
MB". 

The "Free space critically low" event is triggered if there is no longer sufficient free storage 
space for the audit trail in runtime. The value depends on the HMI device.

For more information refer to chapter: Low free storage space (Page 2426)

Result
Audit relevant user actions are entered in the configured audit trail in runtime.

Parameters for the audit trail

Introduction
Configure Audit Trail in the "Logs" editor if you have enabled "GMP compliant configuration" 
in the runtime settings.

There are two ways of assigning parameters for the audit trail:

● "Settings for audit trail" editor

● "Audit Trail" inspector window

Editor "Audit Trail"
The "Audit Trail" editor is an overview of the Audit Trail created.

Only one Audit Trail can be created per HMI device. 

Parameters that are assigned for the Audit Trail can be seen in the line. You can select or 
deselect the parameters displayed.

The parameters of an Audit Trail are also displayed and described in more detail in the 
inspector window.
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General inspector window
You can set the following parameters under "Audit trail > Properties > General":
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Name
● Under "Name", assign a name for the Audit Trail .

Special characters are not permitted when assigning the name.

Storage location
● Storage location

You can choose between:

– a CSV file (ASCII)

– a TXT file (Unicode)
 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

● Path
Depending on the HMI device, enter the storage location of the Audit Trail  under "Path".

● Minimum space in MB
Specify the size of remaining storage space that triggers the "Less free storage space" 
event.
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Inspector window settings
You can set the following parameters under "Audit trail > Properties > Properties > Settings":
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Logging activation
● Enable logging at runtime start

Forcing
● Bypass electronic signature

Specifies whether the administrator is permitted to run operator actions without entering an 
electronic signature or comments.

● Forcing allowed if storage space is exhausted
This function allows the administrator to interrupt audit trail logging in the following 
scenarios:

– There is no free storage space available.

– The storage medium is missing.

– Access to required storage medium is not possible.

You can thus prevent the process from stopping. 
After Forcing was carried out, the audit trail log switches off.
After the end of "Forcing", the audit trail must be restarted with the system function 
"StartLogging".

Settings
● Logging alarm texts in the audit trail.

 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

For further details on setting the logging language, refer to the following section:
Setting the audit trail language (Page 2425) 

Setting the audit trail language

Introduction
The logging language for an Audit Trail is set in the runtime settings.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click "General".

4. Select the logging language in the "Logs" area.
 

  Note

If an Asian language was selected, use the "TXT (Unicode)" storage location in the "Audit 
trail" editor.

 

Low free storage space

Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 
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Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 

 

Configuring the "Low free storage space" event

Requirements
● A GMP- compliant configuration is enabled

● An Audit Trail is created

Procedure
1. Click on the Audit Trail in the "Audit Trail" editor.

2. In the Inspector window, click "Properties > General".

3. In the "Free storage space limit in MB" area, select a value that triggers the "Little free 
space" event.

4. Click on Events in the Inspector window.

5. Click on the "Low free storage space" event.

6. In the function list, specify a system function to execute when an "Overflow" event is 
triggered.

Logging the audit trail

Reporting an audit trail

Introduction
You can print a report of the operations saved in an Audit Trail. All recorded actions are included 
in the printout.

Requirements for reporting
The "Audit trail report" report object is available for the printout of an Audit Trail. 

You can configure the report in the "Report" editor. The report object is only available if the 
"GMP-compliant configuration" option is set in the runtime settings of the HMI device.     
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If an Audit  must be printed in runtime, initially the logging of Audit Trail must be stopped using 
the "StopLogging" system function. 

Whilst an Audit Trail is being printed, no user actions are recorded. Ensure that no GMP-
relevant user actions are executed whilst the logging is stopped.

After printing is complete without any errors, restart the audit trail using the "StartLogging" 
system function.

The header of the report is printed in the current runtime language. Change the runtime 
language to the logging language accordingly. 

The logged data from Audit  are printed in the configured runtime logging language. 

In order to receive a complete report, the report object can also be used in a report in 
conjunction with the "Print alarm" and "Print recipe" report objects.

See also
Audit report (Page 1655)

Audit Trail reporting

Introduction
You use the "Audit Trail" report object to configure a report for the output of Audit Trail contents 
to a printer. 

Once the printout is started in runtime, all entries currently contained in the Audit Trail are 
printed out.

Procedure
To create a report, proceed as follows:

1. Double-click on the "Reports" entry in the project tree.

2. Double-click "Add new report".
A new report is created and opened in the "Report" editor.
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3. Drag & drop the "Audit trail report" object under "Tools > Controls" to the report created.

4. Click on the "Audit trail report" object.

5. Change the object properties of the "Audit trail report" object in the inspector window.

Result
You have created a report for the printout Audit Trail.

See also
Audit report (Page 1655)
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Parameters for the audit trail report

Introduction
The "Audit trail report" parameters can be edited in the inspector window. 

Inspector window appearance
Click on the "Audit trail report" object.

Change the appearance of the "Audit trail report" object in the appearance area of the Inspector 
window under "Properties > Properties > Layout".

You can configure the foreground color, the background color, the style, and the font settings. 

It is recommended to set a font size of 16 px for the output.   

Inspector window layout
Click on the "Audit trail report" object.

Change the position and size of the "Audit trail report" object in the appearance area of the 
Inspector window under "Properties > Properties > Layout".
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The "Audit trail report" object always fills the space down to the footer on the report page. If 
you change the height of the object, then you only change the distance of the object to the 
header. The report printout can involve a large amount of data. 

A page break is automatically inserted when the length of the page is exceeded to print out all 
data. 

In the "Visible entries" area, it is determined whether comments are visible on the printed report.

Inspector window miscellaneous
Click on the "Audit trail report" object. 

Change the name and layer position of the "Audit trail report" object in the appearance area 
in the Inspector window under "Properties > Properties > Miscellaneous".
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See also
Audit report (Page 1655)

Printing out an audit trail report

Introduction
Since logging of the Audit  must be stopped in order to print out an Audit Trail, a few details 
regarding this procedure must be noted. 

The following steps must be taken to print out an audit trail in a report file on a printer:

● Stop logging using the "StopLogging" system function.

● Start the printout using the "PrintReport" system function.

● Check if the printing is successfully completed.

● If needed, move or delete the Audit Trail using the system functions "ArchiveLogFile" or 
"DeleteLog".

● Start the logging of Audit  by selecting the "StartLogging" system function.
 

  Note

Make sure that the Audit Trail has been printed completely before you delete the Audit 
Trail.
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Requirements
● "GMP compliant configuration" has been enabled.

● A report for the printout of an Audit Trail has been configured.

● The screen for the operator control to be configured is open.

Procedure
1. Add a button to the screen and select "Events > Click" in the Properties window.

2. In the function list, assign the "StopLogging" system function to the "Click" event and select 
your Audit Trail log.

3. Following the "StopLogging" system function in the same function list, insert the 
"CloseAllLogs" system function.

4. Insert an additional button and assign the "PrintReport" system function to the "Click" event 
of this button.

5. Insert an additional button and assign the "OpenAllLogs" system function to the "Click" 
event of this button.

6. Following the "OpenAllLogs" system function in the same function list, insert the 
"StartLogging" system function.

7. Insert an additional button and assign the "ArchiveLogFile" or "DeleteLog" system function 
to the "Click" event of this button.

8. Assign unique labels to the buttons.

9. Save the project.

Result
You have configured the required buttons and system functions. The operator can perform the 
operating tasks described in the introduction during runtime to print out an Audit Trail report. 

 

 Note

You can also insert the report objects for the output of alarms and recipes in the report for 
the printout of an Audit Trail. However, since GMP-relevant operations and system processes 
are not recorded while you are printing, you should preferably print the Audit Trail in a separate 
operation.

 

See also
Audit report (Page 1655)

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2433



Evaluating an audit trail

Evaluating audit trails

Introduction
The Audit Trail has been saved to the memory card of the HMI device and is also read only. 

The Audit Trail is protected by a checksum. This checksum ensures that the entry has not 
been modified at any later time. 

There are two possible ways to evaluate the Audit Trail: 

● Use the "Audit Viewer":
You can easily evaluate the Audit Viewer for external analysis on an Office PC with the 
help of the Audit Trail. 

● Use the "HmiCheckLogIntegrity" DOS program:
The DOS program makes it possible to carry out an automatic check of the Audit Trail using 
the return values. 

Evaluating Audit Trails in AuditViewer

Introduction
The Audit Viewer allows you to evaluate all Audit Trail data in a table.

Requirements
● Audit Viewer is installed

● The Audit Traillog is located on the computer which has Audit Viewer installed.
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Procedure
1. Start the Audit Viewer on the configuration PC:

"Start > SIMATIC > Audit Viewer > Audit Viewer"
This path may be different on your operating system version.

2. Click the button.

3. Load the Audit Trail:

The "Data Validity Indicator" is lit up in green to indicate that the loaded Audit Trail has not 
been manipulated.

Each entry in the Audit Trail is time-stamped to allow precise tracking of operator actions. In 
addition to system events, such as the attempt to import a password list, the system also 
records failed logon attempts:

See also
Evaluating the checksum of log data (Page 1366)

Evaluating the checksum of log data (Page 1122)
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Evaluating Audit Trails with DOS program

Introduction
Long-term archiving on a server allows an Audit Trail to be checked automatically using return 
values in a script. 

In addition the programmer can integrate the check using the DOS program 
"HmiCheckLogIntegrity" into the archiving process. "HmiCheckLogIntegrity" then provides the 
following return values:

● < 0: Different errors, for example, wrong file format or no file exists.

● 1: The checked Audit Trail is valid.

● > 0: The first line that was manipulated will be returned.

Audit Trail logging is only continued if the return value is "1". In both error cases, the 
administrator or the shift supervisor can be informed. 

HmiCheckLogIntegrity
The "HmiCheckLogIntegrity.exe" DOS program is in the installation directory under:

"SIEMENS > Automation > WinCC Runtime Advanced"

Audit trail logging concept

Format

Format - Audit Trail
On an HMI device with "GMP compliant configuration", all events which are relevant to the 
audit are recorded at runtime in the Audit Trail. You have several format options. 

Selection is dependent on the display program and the runtime language used:

● File - CSV (ASCII)
To view and evaluate a CSV file use, e.g. Microsoft Excel on your PC.

 

  Note

Double quotation marks or several characters are not permitted as list separators for the 
storage site "File - CSV (ASCII)". You can find the settings for list separators under "Start 
> Settings > Control Panel > Regional and Language Options".

 

● File - TXT (Unicode)
This file format supports all characters that can be used in WinCC. For editing, you will 
need software that can save files in Unicode, such as Notepad.

 

  Note

Use "File - TXT (Unicode)" to log Asian languages.
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Audit Trail with checksum
The following files are generated under special circumstances:    

● *.keep

– If a log is started without checksum and will be continued with a checksum.

– If you update WinCC with a service pack or a new version and the Audit Trail or the log 
is continued with the checksum.

– The content of the keep file will remain the same when compared with the original csv 
file or txt file.

 

  Note

Before you update WinCC with a Service Pack or a new version, exit and save the 
Audit Trail or the logs using checksum. After WinCC is updated, the audit trail or logs 
will be continued with new files using checksum. 

 

● *.bak

– If runtime has determined a serious, irregular problem in the file.

Storage location and medium

Storage location and medium         
Depending on the hardware configuration of the HMI device, the data may be logged locally 
(on the hard disk of a PC or on the storage card of a panel) or, if present, on a network drive.

 

 Note
Logging on network drives

We do not recommend that you log audit trails directly on a network drive. Power supply can 
be interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

We recommend you save the logs on your local hard drive, or on a storage medium of the 
HMI device. Use the system function "ArchiveLogFile" to save the logs long-term on a network 
drive.

 

A "GMP compliant configuration" cannot be operated at runtime to the full extent unless it is 
possible to save all user actions which are relevant to the audit to the Audit Trail. It must be 
ensured that sufficient storage space is available for the Audit Trail and that the connection to 
the storage location for the Audit Trail is not disturbed. 

Error-handling with insufficient free storage space  
If there is insufficient storage space, your project can be configured so that the administrator 
has an option of continuing the process without logging in the audit trail (forcing).
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Error-handling if there is no storage medium or the connection to the server is interrupted
All audit-relevant user actions are blocked if insufficient storage space is available for the Audit 
Trai, e.g. due to missing storage medium. 

Blocking is canceled as soon as the storage location for the Audit Trail is available again. The 
block can be skipped by "forcing".

Error-handling with long-term logging
If the audit trail must be moved to a server for long-term logging and the connection to the 
server is interrupted at this time, the following error-handling is required: 

The system closes the audit trail and renames it. The system attempts to send the renamed 
audit trail to the server again in the background.

If disruption in the connection to the server persists, you receive a system alarm telling you 
that the connection is down. Then the system attempts to send the renamed audit trail every 
300 seconds.

The attempt to transmit the data is repeated until successfully completed. The data is also 
transmitted after a restart of the HMI device.

"Forcing"     
If the storage space for the audit trail is insufficient, for example if there is no storage medium 
or it is full, all audit-relevant user actions are automatically blocked.

In this case the audit trail logging can be configured to give an administrator the option of 
continuing to operate the system without logging the audit trail (forcing). 

The administrator can also be given the option of running the system quickly out of a critical 
state in case of emergency. In this case the administrator can operate the system without the 
requirement to input the required electronic signatures or comments. 

If the administrator uses the "forcing" function, this is logged as the last entry in the audit trail.

After the end of forcing, the audit trail must be restarted with the system function "StartLogging".

Protection mechanisms

Protective mechanisms to prevent changes to audit trail data   
The audit trail data are protected against deliberate or accidental changes:

● The directory in which the audit trail is saved can only be accessed with special rights.

● The audit trail files are write-protected.

● Each data record contains a checksum that can be used to detect a change of its contents. 
This checksum also ensures that the number of lines has not changed in the audit trail file.

Use the "HmiCheckLogIntegrity" tool, included in the audit option, to check whether an audit 
trail has been changed:

Evaluating Audit Trails with DOS program (Page 2436)
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WinCC upgrade

WinCC upgrade
Before you update WinCC with a Service Pack or a new version, you will have to exit and save 
the Audit Trail or the logs with checksum. After WinCC is updated, the audit trail or logs with 
checksum will be continued with new files. 

Make sure that the logs are started at a defined state with the new version.

Audit trail behavior in runtime

Effects in runtime   
The configuration in Audit Trail has the following effects in runtime, depending on the 
configuration:

● Audit relevant user actions (such as tag changes and recipe changes) are recorded in an 
audit trail.

● "Enable logging at runtime start" check box enabled:
The audit trail is started with runtime.

● "Forcing" group, "Allowed if storage space has been exhausted" check box enabled:
A user with administrator rights can use "forcing" to run operations on the plant even though 
the audit trail can no longer be logged because of storage space limitations. Interrupting 
the audit trail prevents the process from being stopped.
If the check box "Signing may be bypassed" is enabled, the administrator is not required 
to input electronic signatures, acknowledgments or comments for operator actions that 
would normally require signing, acknowledgment or comment. 

● If the storage space available for the Audit Trail is less than the configured "Minimum 
storage space in MB", the function list configured for the "Low free storage space" event 
will be processed.

● If there is insufficient storage space for the audit trail because of hardware limits, the 
function list configured for the "Free space critically low" event will be processed.

9.15.1.4 Configuring audit functions

Logging tag value changes

Tag value change

Changes to tag values
User actions in runtime are recorded in a Audit Trail once "GMP compliant configuration" has 
been enabled.
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When you configure a GMP compliant project, you specify which tags must meet the 
requirements of Good Manufacturing Practice (GMP).    

If the user changes the value of a GMP-relevant tag in runtime, the value change action is 
logged in the Audit Trail .

 

 Note

The action of changing the value of GMP-relevant tags made by the PLC, or a system 
function, is not logged in the Audit Trail. 

The system functions used to change the values of GMP-relevant tags which are assigned 
to events that identify a direct user action will be logged.

In addition, configure the "NotifyUserAction" system function to make a manual entry in the 
Audit Trail or to prompt the user for an electronic signature, an acknowledgment, or a 
comment. 

With the "NotifyUserAction" system function only the value changes that are directly triggered 
by the event to which the system function is configured are entered in the Audit Trail. For 
example, if additional tags are changed by changing the value of one tag, the additional value 
changes are not logged in the Audit Trail.

 

Logging tag value changes

Requirement
● "GMP compliant configuration" has been enabled.

● The tags for which you want to configure the GMP settings are created.

● The property view is open.    
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Procedure
1. Open the HMI tags editor and select the tag for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Specify how the user must confirm a value change in the "Confirmation type" selection field:

– "Electronic signature"
If the user's electronic signature is required.

– "None"
If the value change is to be logged in the Audit Trail without user confirmation.

– "Acknowledgment"
If user acknowledgement of the value change is required.

4. Enable the "Comment required" check box if the user is required to input a comment as 
well as an electronic signature or acknowledgment.
This check box is only enabled if "Electronic signature" or "Acknowledgment" is specified 
under "Type of confirmation".

Result
If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail. 
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Effects of tag change

Effects in runtime
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant tags:   

● If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail.

● Electronic signature  
If "Electronic signature" is specified as the "Type of confirmation", the user must log every 
user-related value change of the tags using an electronic signature. Otherwise the value 
change will be rejected.
The user name used to sign the change is logged in the audit trail.

● Acknowledgement  
If "Acknowledgment" is specified as the "Type of confirmation", the user must acknowledge 
every user-related value change of the tags. Otherwise the value change will be rejected.
The acknowledgement is logged in the Audit Trail.

● Comments  
If the "Comment required" check box is enabled, the user must also comment every user-
related value change of the tags, in addition to acknowledgment or input of the electronic 
signature. Otherwise the value change will be rejected.
The entered comment is logged in the Audit Trail.

Logging recipe data record changes

Recipe data changes

Changes to recipe data    
User actions in runtime that are relevant to the quality of the process, such as changes of tag 
values or recipe values, are recorded in an Audit Trail once "GMP compliant configuration" 
has been enabled. 

You specify during configuration which recipes must meet the requirements of "Good 
Manufacturing Practice" (GMP).

For GMP-relevant recipes, the following operations during runtime are recorded in the Audit 
Trail:
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● Storing after changing and creating recipe data records

● Transfer of recipe data records to the PLC and from the PLC

● For recipe tags: Changing the setting for the synchronization of the tag values with the PLC 
("offline"/"online") if the recipe tags are configured as "GMP-relevant".

 

  Note
Differences in the Audit Trail  with recipe display and recipe screen

If you use a recipe screen to save recipe data, enable the "GMP-relevant" property for the 
recipe tags. If the user changes the value of a GMP-relevant recipe tag in runtime, the 
changed value is recorded in the Audit Trail. You can also configure for the tag to require 
the user to confirm the value change with an electronic signature and enter a comment.

If you use a recipe display to edit data records of a GMP-relevant recipe, the Audit Trail 
includes a record of which recipe data records were saved or sent to the PLC. The value 
changes to the recipe tags are not logged in the Audit Trail. Use the "ExportDataRecords" 
system function to save the value change to data records in a csv file. 

If you want to make changes to recipe data records in conformance to the FDA, disable 
"Enable edit mode" in the recipe view. Use the recipe screen and "GMP relevant" recipe 
tags.

 

If you export recipe data records in a regulated project, you can assign the recipe data with a 
checksum. When you later import the recipe data back, you can use the checksum to determine 
if the recipe data has changed. The following system functions are available for exporting and 
importing recipe data with a checksum:

● "ExportDataRecordsWithChecksum"

● "ImportDataRecordsWithChecksum"

Logging recipe data changes

Requirement
● "GMP compliant configuration" has been enabled.

● The recipes for which you want to configure the GMP settings are created.

● The property view is open.
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Procedure   
1. Open the recipe editor and select the recipe for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Under "Settings", select the following:

– "Record operations in audit trail:"
If all user actions in runtime that affect this recipe are to be recorded in the Audit Trail.

– "Sign loading of recipe data":
If the user is required to confirm the transfer of recipe data records to or from the PLC 
using an electronic signature.

– "Sign recipe data saving": "
If the user is required to confirm recipe data record saving with an electronic signature.

Result
If the user works with the GMP-relevant recipe in runtime, the change is entered in the Audit 
Trail. 

Effects of recipe data change

Effects in runtime   
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant recipes:
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Entries in the Audit Trail
Entries are made in the following cases:

● You create and save new recipe data records of a GMP-relevant recipe at runtime.

● You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

● Recipe data records are transferred to the PLC or recipe data are read from the PLC.

● The "SetRecipeTags" system function is used to change the setting for synchronization of 
the tag values with the PLC.
This concerns the following changes:

– "offline" to "online"

– "online" to "offline"

Electronic signature
The user must enter an electronic signature in the following cases depending on the 
configuration:

● The "Sign loading of recipe data" check box is set:
Signature for the transfer of recipe data records to the PLC. Signing is always required if 
the transfer is triggered with the recipe display functions and even if it is triggered with 
"SetDataRecordToPLC" system functions.

● The "Sign saving of recipe data" check box is set:
Sign saving of recipe data records. The signature is always required if the save is triggered 
with the system functions of the recipe display, and even if it is triggered with the 
"SetDataRecordToPLC" or "SaveDataRecord" system function. 

● The user name used to sign the change is logged in the audit trail.
 

  Note

The triggering of the "ImportDataRecords" system function is entered in the Audit Trail but 
does not require a signature or a comment. In addition, call the "NotifyUserAction" system 
function to request an electronic signature with or without user comment. 

 

Logging user actions

User actions with GMP-compliant configuration

Introduction    
In GMP compliant configuration, user actions and system operations in runtime that are 
relevant for the quality of the process are recorded in an Audit Trail . 

For example, a user logon to the system or the change of a tag value are saved in the log.

In runtime, user actions are saved in an Audit Trail under the following conditions:
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● "GMP compliant configuration" has been enabled

● A user is logged on to the system

Logging modes

Automatic logging of user actions
The following user actions are recorded in runtime without the need for additional configuration 
steps if "GMP compliant configuration" is enabled:

● User Administration

– Logon and logoff of users

– Import of user administration

● Alarm system

– All alarms that are acknowledged by the user.
If an alarm from an alarm group is acknowledged, an entry is made in the Audit Trail 
indicating that all other alarms of this group have been acknowledged.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm texts in Audit Trail" option in the Audit Trail 
editor.

 

● Log operations

– Starting and stopping a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Copying a log

– Long-term logging of a log
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Configuration-dependent logging
The following processes are logged depending on the configuration of the recipes and the tags 
of the project:

● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes

– You create and save new recipe data records of a GMP-relevant recipe at runtime.

– You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

In addition to logging user actions you can configure tags and recipes to require the user to 
confirm or acknowledge specific actions with an electronic signature or add a comment to the 
change.

Manual logging by means of "NotifyUserAction" system function   
This system function is used to record actions in the Audit Trail that are not automatically 
entered in the Audit Trail. This system function is also used to request the user to enter an 
electronic signature for the action.

Configuring the "NotifyUserAction" system function

Introduction
This system function is used to log user actions that are not entered automatically entered in 
the Audit Trail. This system function can also used to request an acknowledgment, or an 
electronic signature for the user's action.

In this example, the system function is assigned to a button.  All operations with this button 
are logged to the Audit Trail.

Requirements
● "GMP-compliant configuration" has been enabled.

● You created the object that is to be assigned the system function.
A button is used in this example.

● The properties window is open.

Procedure
1. Click the button.

2. Click on "Events" in the Inspector window.

3. Assign the "NotifyUserAction" system function to the "Click" event.
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GMP-compliant user administration 

SIMATIC Logon
To run a central user and user group administration for several applications or HMI devices, 
activate SIMATIC Logon. 

For more information on user administration and SIMATIC Logon, refer to the following chapter: 

Managing users on the server (Page 1705)

Logging system functions

Introduction    
If system functions are triggered in runtime, this is recorded in the Audit Trail for some system 
functions. If specific system functions are used on a GMP-relevant object, the user must 
confirm the triggering.

Some system functions are not supported when using Audit. If you use these system functions 
in your project, you are solely responsible for them.

The following table shows which system functions are Audit-relevant and whether the user's 
signature is required:

System functions and Audit

Function (call in script) Effect of /Audit
StartLogging (StartLogging) Entered in Audit Trail
StopLogging (StopLogging) Entered in Audit Trail
ClearLog (ClearLog) Entered in Audit Trail
StartSequenceLog (StartSequenceLog) Entered in Audit Trail
CloseAllLogs (CloseAllLogs) Entered in Audit Trail
OpenAllLogs (OpenAllLogs) Entered in Audit Trail
LogTag (LogTag)  ---
CopyLog (CopyLog) Entered in Audit Trail
ActivateScreen (ActivateScreen)  ---
ActivateScreenByNumber (ActivateScreenByNumber)  ---
ActivatePreviousScreen (ActivatePreviousScreen)  ---
ActivateRootScreen(ActivateRootScreen)  ---
ActivateLeftScreen (ActivateLeftScreen)  ---
ActivateRightScreen (ActivateRightScreen)  ---
ActivateParentScreen (ActivateParentScreen)  ---
ActivateFirstChildScreen (ActivateFirstChildScreen)  ---
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Function (call in script) Effect of /Audit
SetBitInTag (SetBitInTag) Entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

ResetBitInTag (ResetBitInTag) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

InvertBitInTag (InvertBitInTag) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

SetBit (SetBit) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

ResetBit (ResetBit) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

InvertBit (InvertBit) Entered in Audit Trail when tag is GMP-
relevant
System function must not be applied to 
tags that require signing or comment.

SetBitWhileKeyPressed (SetBitWhileKeyPressed) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

SetDataRecordToPLC (SetDataRecordToPLC) Entered in Audit Trail when recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC (GetDataRecordFromPLC) Entered in Audit Trail when recipe is 
GMP-relevant

ImportDataRecords (ImportDataRecords) Entered in Audit Trail when recipe is 
GMP-relevant

ImportDataRecordsWithChecksum"(ImportDataRecordsWit
hChecksum)

entered in Audit Trail if the recipe is 
GMP-relevant

ExportDataRecords (ExportDataRecords) ---
ExportDataRecordsWithChecksum 
(ExportDataRecordsWithChecksum)

---

LoadDataRecord (LoadDataRecord) Entered in Audit Trail when recipe is 
GMP-relevant
Signing required depending on recipe 
configuration
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Function (call in script) Effect of /Audit
SaveDataRecord (SaveDataRecord) Entered in Audit Trail when recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

SetDataRecordTagsToPLC (SetDataRecordTagsToPLC) Entered in Audit Trail when recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC 
(GetDataRecordTagsFromPLC)

Entered in Audit Trail when recipe is 
GMP-relevant

SetRecipeTags (SetRecipeTags) Entered in Audit Trail with GMP-relevant 
recipe

GetDataRecordName (GetDataRecordName)  ---
DeleteDataRecordMemory (DeleteDataRecordMemory) Not supported
DeleteDataRecord (DeleteDataRecord) Entered in Audit Trail when recipe is 

GMP-relevant
PrintScreen (PrintScreen)  ---
PrintReport (PrintReport)  ---
RecipeViewSaveDataRecord (---) Entered in Audit Trail when recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSaveAsDataRecord (---) Entered in Audit Trail when recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewNewDataRecord (---)  ---
RecipeViewDeleteDataRecord (---) Entered in Audit Trail when recipe is 

GMP-relevant
RecipeViewGetDataRecordFromPLC (---) Entered in Audit Trail when recipe is 

GMP-relevant
RecipeViewSetDataRecordToPLC (---) Entered in Audit Trail when recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSynchronizeDataRecordWithTags (---) Entered in Audit Trail when recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewRenameDataRecord (---) Entered in Audit Trail when recipe is 
GMP-relevant

RecipeViewShowOperatorNotes (---)  ---
RecipeViewBack (---)  ---
RecipeViewOpen (---)  ---
RecipeViewMenu (---)  ---
TrendViewScrollForward (---)  ---
TrendViewScrollBack (---)  ---
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Function (call in script) Effect of /Audit
TrendViewExtend (---)  ---
TrendViewCompress (---)  ---
TrendViewBackToBeginning (---)  ---
TrendViewStartStop (---)  ---
TrendViewSetRulerMode (---)  ---
TrendViewRulerForward (---)  ---
TrendViewRulerBackward (---)  ---
StatusForceGetValues (---) Not supported
StatusForceSetValues (---) Not supported
AlarmViewAcknowledgeAlarm (---) Entered in Audit Trail
AlarmViewEditAlarm (---)  ---
AlarmViewShowOperatorNotes (---)  ---
HTMLBrowserBack (---) Not supported
HTMLBrowserForward (---) Not supported
HTMLBrowserRefresh (---) Not supported
HTMLBrowserStop (---) Not supported
ScreenObjectCursorUp (---)  ---
ScreenObjectCursorDown (---)  ---
ScreenObjectPageUp (---)  ---
ScreenObjectPageDown (---)  ---
ButtonPress (---)  ---
ButtonRelease (---)  ---
SmartClientViewConnect (---) Not supported
SmartClientViewDisconnect (---) Not supported
SmartClientViewReadOnlyOn (---) Not supported
SmartClientViewReadOnlyOff (---) Not supported
SmartClientViewRefresh (---) Not supported
SmartClientViewLeave (---) Not supported
ShowAlarmWindow (ShowAlarmWindow)  ---
ClearAlarmBuffer (ClearMessageBuffer)  ---
ShowSystemAlarm (ShowSystemAlarm)  ---
SetAlarmReportMode (SetAlarmReportMode)  ---
Logoff (Logoff) Entered in Audit Trail
GetPassword (GetPassword)  ---
GetGroupNumber (GetGroupNumber)  ---
ExportImportUserAdministration 
(ExportImportUserAdministration)

Import of user administration is entered 
in Audit Trail
Export is not entered in Audit Trail

Logon (Logon) Entered in Audit Trail
GetUserName (GetUserName)  ---
TraceUserChange (---)  ---
ShowLogOnDialog (---)  ---
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Function (call in script) Effect of /Audit
SetValue (---) Entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

IncreaseValue (IncreaseValue) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

DecreaseValue (DecreaseValue) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

LinearScaling (LinearScaling) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

InverseLinearScaling (InverseLinearScaling) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

IncreaseFocusedValue (IncreaseFocusedValue)  ---
DecreaseFocusedValue (DecreaseFocusedValue)  ---
OpenCommandPrompt (OpenCommandShell) Not supported
OpenControlPanel (OpenControlPanel) Not supported
ActivateCleanScreen (---)  ---
AdjustContrast (AdjustContrast)  ---
CalibrateTouchScreen (CalibrateTouchScreen)  ---
OpenScreenKeyboard (OpenScreenKeyboard)  ---
OpenTaskManager (OpenTaskManager) Not supported
BackupRAMFileSystem (BackupRAMFileSystem) Not supported
SetAcousticSignal (SetAcousticSignal)  ---
ShowOperatorNotes (ShowOperatorNotes)  ---
AcknowledgeAlarm (---) Entered in Audit Trail
GoToHome (GoToHome)  ---
GoToEnd (GoToEnd)  ---
EditAlarm (EditAlarm)  ---
DirectKeyScreenNumber (---) Not supported
DirectKey (---) Not supported
SetDeviceMode (SetDeviceMode) Entered in Audit Trail
SetDisplayMode (SetScreenMode)  ---
SetConnectionMode (SetConnectionModeToPLC) Entered in Audit Trail
SetScreenKeyboardMode (SetScreenKeyboardMode)  ---
ChangeConnection (ChangeConnection) Not supported
SetLanguage (SetLanguage)  ---
SetWebAccess (SetAccessModeViaWeb) Not supported

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2452 System Manual, 08/2011,  



Function (call in script) Effect of /Audit
StartProgram (StartProgram) Not supported
ShowSoftwareVersion (ShowSoftwareVersion)  ---
SimulateTag (---) Not supported
StopRuntime (StopRuntime) Entered in Audit Trail
ControlWebServer (ControlWebServer) Not supported
ControlSmartServer (ControlSmartServer) Not supported
OpenInternetExplorer (OpenInternetExplorer)  ---
SendEMail (SendEMail)  ---
UpdateTag (UpdateTag)  ---
ClearAlarmBufferProtoolLegacy 
(ClearAlarmBufferProtoolLegacy)

Not supported

SetDaylightSaving (SetDaylightSaving) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

Encoding(Encode) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

EncodeEx(Encode) Entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

9.15.1.5 Performance features of GMP-compliant configuration

Supported HMI devices

Supported HMI devices  
The qualification "GMP relevant configuration" can be configured for the following HMI devices:

● TP 277

● OP 277

● MP 277

● Mobile Panels 277

● MP 377

● Comfort Panels
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● Panel PCs with WinCC RT Advanced

● WinCC RT Advanced
 

  Note

The qualification "GMP" is not supported by WinCC RT Professional.
 

Restrictions

Restrictions  
The following functions and configurations cannot be used simultaneously with the qualification 
"GMP relevant configuration":

● "Status/Force" object

● PN direct keys

● DP DirectKey

● Option /Sm@rtServer

● /Sinumerik option

● The functional scope of the HMI devices is only available to a restricted degree in some 
circumstances because of the limited storage space

● Events of screen objects
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing tag values. If you assign an event which has to be acknowledged to a screen 
object, you may not assign any other events to this graphic object. 
When the event of a screen object is assigned actions which open a user dialog (such as 
change of a tag value with mandatory acknowledgement), you may not be able to execute 
these actions at other events. 

● Controlling GMP-relevant tags using a slider
The slider is not suitable for controlling GMP-relevant tags. Any operation of the slider will 
continuously change the tag value. If this is a GMP-relevant tag, a flood of entries will be 
generated in the AuditTrail. 
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9.15.2 Sm@rt Options

9.15.2.1 Basics

Sm@rt Options

Introduction
Using the Sm@rt Options from WinCC, you can communicate between HMI-systems or to an 
HMI-System by means of TCP/IP-connections (e.g.LAN).

Use of the Sm@rt Options
● Distributed operator stations with Sm@rtClients for controlling large machines or machines 

that are spread out over a large area.

● Operator stations with system-wide access to current process data via the communication 
driver "SIMATIC HTTP Protocol".

● Local servicing solution for the central archiving, analysis and additional processing of 
process data.

● Provision of current process data for higher-level systems (SCADA, production 
management systems, office applications).

● Remote control of an HMI-System by means of Internet, Intranet and LAN.

● Sending of E-Mails on the basis of messages and events

● Provisioning of Standard-HTML-Pages in HMI-system with service-and maintenance 
information as well as diagnostic functions.

User benefits: 

● Flexible solution for access to HMI systems and process data from any location

● Reduction of load on the field bus:
For example, the combination of WinCC Runtime and SIMATIC panels enables a factory 
control system to have access to process data. No load is placed by the factory level on 
the sensitive field level with respect to the necessary communication requirements. These 
requirements are handled by HMI Runtime along with the SIMATIC-panels.

● Expensive on-site service visits to be avoided by using the remote control. Unplanned non-
operation periods are reduced and the system productivity is increased.

Application scenarios

E-Mailing and remote diagnostics
A factory has a service contract with an external service company. The HMI device and the 
service technician's PC are linked together over a TCP/IP-ready network. E-mail delivery of 
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certain alarms to the service technician was configured in the project. The service technician 
accesses the HMI device via the Internet and executes remote diagnostics.

Application example:
Amongst other things,flow rates are measured in the process control of a cooling unit. 
Contamination in a feed line reduces the flow of coolant. When the flow rate drops below the 
configured threshold value, the operating device displays a warning. In addition,this warning 
is also dispatched as an e-mail to the assigned service technician. 

The service technician then establishes a connection with the remote device and takes the 
appropriate actions. 

Advantage: An alarm that reaches the service technician in a timely manner helps to minimize 
unplanned downtime.

Distributed operator stations
Distributed operator systems, the Sm@rtClients are used for controlling large machines or 
machines that are spread out over a large area.

The Client-HMI device connects to Sm@rtServer via the Sm@rtClient-Display. 

The operator can operate and monitor the system from various locations. The operator sees 
the same image at each operator station, whereby only one station can be operated at one 
point of time.

The type of operation is also named as a coordinated operation. Then you must change the 
configuration only at Sm@rtServer.  
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Access to the tags via SIMATIC HMI HTTP Protocol

Operator stations with system-wide access
For use of the SIMATIC HMI HTTP Protocol, you can provide tags of HMI-device (HTTP-
Server) to another device (HTTP-Client). 

Thus the local as well as centrally used HMI-systems have access to the tags of other stations. 
Cell-concepts or line-concepts can be simply implemented. De-centrally obtained information 
is available centrally.

This concept also permits the setting of cost-effective and small central servicing. There are 
additional options for archiving, analysis and additional processing of registered process data, 
if a PC is used for that.

Remote monitoring and remote control- servicing solution
If you connect the use of the SIMATIC HMI HTTP Protocol and the Sm@rtServer with each 
other, you can implement a complex servicing solution.  

For this,display the interested tags of the HMI-devices on the Service-PC. If necessary, use 
the PC for the remote monitoring and remote control of a specific HMI-device. 

The locally used HMI-devices are connected with each other and the total process is controlled 
comprehensively. 

The concept of the remote servicing is possible by using the Sm@rtClient-Display in the 
servicing HMI-Application. The operator has access to the respectively desired local HMI-
device through flexible configuration of the Sm@rtClient-Display.

Connection to the Office-world
The possibility of data exchange exists between HMI-device and office-applications, e.g. MS 
Excel, with help of VBA-Macro. 

For this, the HMI-device must support the Web-Service(SOAP). A script or macro is called in 
the external application, which has only read or write access to the concerned tags according 
to provided syntax. 

HMI devices suitable for use

HMI devices suitable for use
The following table shows the HMI-devices that are suitable for the use of Sm@rt Options.  

The number of the connections based on "SIMATIC HMI HTTP Protocol" and the number of 
maximum connected Sm@rtClients depends on the HMI-device. For additional information 
see the "Performance features" documentation and in the technical manual of your HMI-device.

Technical data subject to change.
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HMI device Sm@rt Options
270 series Yes
370 series Yes
OP 177B, TP 177B Yes
Mobile Panel 177 PN, Mobile Panel 277 Yes
In view mode only:
● Mobile Panel 277 IWLAN
● Mobile Panel 277 IWLAN V2
● Mobile Panel 277F IWLAN (RFID Tag)

Yes

WinCC Runtime Advanced Yes

Combining options on panels
The following table shows which options and functions on the panels can be combined with 
each other. 

Technical data subject to change.

 SIMATIC HMI 
HTTP Protocol

Sm@rt Options HTML 
browser

WinAC/ MP ProAgent

SIMATIC HMI HTTP 
Protocol 

-- Yes Yes Yes Yes

Sm@rtServer Yes -- No No No1)

HTML browser Yes No -- No No
WinAC/ MP Yes No No -- Yes
ProAgent Yes No1) No Yes --

1) MP 277 8" and 10", Mobile Panel 277, MP 377: Parallel operation of the Runtime-options 
ProAgent and Sm@rt Options is possible. Restriction: a maximum of 2 clients can be 
connected simultaneously to a Sm@rtServer.

Settings for Sm@rt Options 

Configuration in WinCC

Introduction
In the "Runtime-Settings" Editor, configure the requirements for using the Sm@rt Options.    

As an alternative, configure the settings in the Control Panel of the HMI-device. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.
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Open
Double-click on the "Runtime-settings" entry in the project tree. In the "Runtime-settings" editor, 
click on the "Services". 

Work area
Enter the settings for the selected HMI device in the work area: 

● "Remote control" Group.

– Sm@rtServer
Configures the HMI-device as Sm@rtServer. 

● "Read/write tags" Group.

– SIMATIC HMI HTTP Server
Configures the HMI device as HTTP-Server.

– Web-service SOAP
Activates the tags-access via SOAP.
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● "Diagnostics" Group

– HTML pages
Activates Service-pages of the HMI device. 

● "SMTP-Communication" Group

– Server name
Enter the name of SMTP server, through which you want to send E-mails.

– Name of the sender
Enter the sender name. The recipient sees in the E-Mail from which device the E-mail 
originates, e.g. "HMI device Production line 2". If the function is not supported by the 
SMTP-Server, delete the entry. You can obtain more detailed information for this from 
your service provider.

– E-mail address
If you use an SMTP server that requires a valid e-mail address for authentication, enter 
it here, for example, "John.Doe@gmx.net. 

– User name
If you use an SMTP server that requires a user name for authentication, enter it here. 
You can obtain the user name from your service provider.

– Password
If you are using an SMTP server that requires a password for authentication, enter this 
password. You can obtain the user name from your service provider.

– The server requires a secure connection (SSL).
The data are sent via an SSL connection. Your service provider can tell you if your mail 
server supports an SSL connection. 

Configurations on the HMI device

Settings on the HMI device

Introduction
The Sm@rt Options settings in the HMI device are configured in the dialog box "WinCC 
Runtime Advanced Internet".  

Additional tabs may be included in the dialog "WinCC Runtime Advanced Internet". This 
depends on which options are activated for the network operation in the project. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.

Tabs
You have opened the dialog "WinCC Runtime Advanced Internet" with the symbol "WinCC 
Runtime Advanced Internet" .

The "WinCC Runtime Advanced Internet" dialog of the control panel can contain the following 
tabs: 
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● WinCC Runtime Advanced Internet, "Email" tab (Page 2461)

● WinCC Runtime Advanced Internet, "Proxy" tab (Page 2462)

● WinCC Runtime Advanced Internet, "Web Server" tab (Page 2463)

● WinCC Runtime Advanced Internet, "Remote" tab (Page 2464)

Input area plan
At Sm@rtServer and Sm@rtClient, the same input area plan must be set.         

The Sm@rtServer uses the Standard-Input area plan of the operating system: 
(Start>Settings>Control Panel> Country settings>Tab "Entry"). These changes become 
effective after system restart.

At Sm@rtClient, the same input area plan must be set like at Sm@rtServer. No restart is 
necessary after the switchover of input area plan at Sm@rtClient. 

WinCC Runtime Advanced Internet, "Email" tab

Purpose of the dialog box
Specifies the settings for the E-Mailing.     

Settings
● SMTP server

– Enter the SMTP-server name.

– Use the default of project file
The SMTP-Server name from the WinCC-Project is used.

● Name

– Name of sender
Enter the sender name. The receipient sees in the E-Mail, from which device the E-mail 
originates, e.g. "HMI-device Production line 2".
If the function is not supported by the SMTP-Server, delete the entry. You can obtain 
more detailed information for this from your service provider.

– eMail Adress of sender
If you use an SMTP server that requires a valid e-mail address for authentication, enter 
it here, for example, "John.Doe@gmx.net. 

Dialog "Advanced Email Settings"
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● Authentication

– Use the default of project file
The user name and the password from the WinCc-Project are used.

– Disable authentication
Authentication is not required.

– Use panel settings for authentication
The settings of the HMI-device are used. Enter the user name under "Login" and the 
password under "Password". You can obtain the user name and the password from your 
service provider.

● Encryption

– Use the default of project file
The setting from the WinCC-Project is used.

– Enable SSL
The user information and e-mail are encrypted for transmission.

– Disable SSL
The user data and e-mail are sent un-encrypted. 

See also
Settings on the HMI device (Page 2460)

WinCC Runtime Advanced Internet, "Proxy" tab

Purpose of the dialog box
Settings for utilizing the Proxy-Server. 

 

 Note

Enter the Proxy-Server in "Internet Options" at PC.
 

Settings
● Use proxy server

Activate the "Use Proxy Server" if access is given in your network via Proxy-server. 

● Proxy
Enter the name or the address of the proxy-server. 

● Port
Enter the port of the proxy-server. 
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WinCC Runtime Advanced Internet, "Web Server" tab

Purpose of the dialog box
The following is configured:         

● The utilization of the integrated web server and of the HTTP-Server

● User and user web authorizations 

Settings
Tag access

Governs the access to tags via the "SIMATIC HMI HTTP protocol": 

● "Read/write": Read/write access

● "Read only": read access only

Tag authenticate

Governs the authentification in case of access to variables via the SIMATIC HMI HTTP 
Protocol": 

● "No authentication": No authentification is required for access.

● "Authentication required": An authentification is required for access.
Specify the user name and password when configuring the communication driver "SIMATIC 
HMI HTTP Protocol". 

Enable Remote-Transfer for Projects

This setting enables remote transfer of project files. 

Start automatically after booting

(on panel only) 

The web server is automatically started after the HMI device boots. As a result, the web server 
is utilized independent of the runtime. 

 

 Note
Start web server automatically on PC 

Add a link with the program "Miniweb.exe" in the Autostart-Organizer in order to start the web 
server automatically after the PC starts. The program is located in the installation index of 
runtime. 

 

Close with Runtime

The web server is closed along with Runtime. 

User Administration

After entering the password "100", the "UserDatabase-Edit".  dialog opens. The 
"UserDatabase-Edit" dialog is theuser administration of the web server. 

Start Webserver
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Starts the web server. 

Close Webserver

Ends the web server. 

WinCC Runtime Advanced Internet, "Remote" tab

Purpose of the dialog box
Settings for the Sm@rtServer     

Settings
Start automatically after booting

The Sm@rtServer is automatically started after the HMI device boots. Otherwise the 
Sm@rtServer starts together with the Runtime. 

Close with runtime

The Sm@rtServer is closed together with Runtime. 

Change settings

Opens the "Sm@rtServer: Current User Properties" dialog for specifying the passwords, 
authorizations, the screen update mechanism and the behavior when connections are 
disconnected.

 

 Note

This dialog is titled "Sm@rtServer: Default Local System Properties" on the panel. 
 

The dialog contains the following tabs:

● "Server" tab (Page 2465)

● "Polling" tab  (Page 2466)

● "Display" tab (Page 2467)

● "Query" tab (Page 2468)

● "Administration" tab (Page 2468)

Start Remoting

Starts the Sm@rt Server explicitly. 

Stop Remoting

Ends the Sm@rt Server explicitly. 

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2464 System Manual, 08/2011,  



"Sm@rtServer Dialog: Current User Properties" 

"Server" tab

Purpose of the dialog box
Specifying passwords, web authorizations and the disconnection. 

Settings
Incoming connections

Settings for handling an attempt to establish a connection. 

● Accept socket connections
This setting enables the connection to the HMI device. It is a basic requirement for using 
the Sm@rtServers from the outside.
If this check box is deactivated, no remote monitoring and no remote control is possible.

● Password 1
First password for remote access. "View only" is disabled as default.

● Password 2
Second password for remote access. "View only" is selected by default.
This password can be provided as a reserve password for third-party users (such as service 
technicians); it can be modified when necessary without significant effort within the 
organization.

● View only
If this check box is enabled, read access (monitoring mode) is the only access available 
when the corresponding password is entered.
Default: Selected

 

  Note

Both key words are preset with "100". Change this password during commissioning 
according to your requirements.

 

Enable network packets queuing (slower)

This setting enables splitting of data into multiple data packets, which are sent separately over 
the network. It is useful when multiple clients are connected.

Display or port numbers to use

Here, you select the TCP/IP port in the network where the Sm@rtServer waits for attempts to 
establish a connection.

● "Auto": The Sm@rtServer automatically searches for the appropriate port by itself.

● "Display": The server uses port 5900 plus display number. For HTTP, the server utilizes 
Port 5800 plus display number.

● "Ports": You enter the port numbers for the "main" and "HTTP" yourself.

No local input during client session
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The keyboard and mouse on the server-HMI device are disabled as long as connections are 
active.

For example, this setting is useful when an HMI device is being administered from outside.

Remove desktop wallpaper

(On PC only)

This setting removes the screen background on the PC, thus saving transmission effort.

Default: Selected

When last client disconnects

(On PC only)

This setting governs the behavior after disconnection of the last client connection:

● "Do nothing": no response.

● "Lock workstation": Server PC is locked.

● "Logoff workstation": Server PC is logged off.

The latter two settings are only useful if the Sm@rtServer is running as a service. 

"Polling" tab 

Purpose of the dialog box
Specifying the screen update and the use of virtual graphics driver. 

Settings
Polling modes

(Available on PC only)

The settings govern the screen update.

Most changes are recognized automatically by the server. In case of problems, you can enter 
additional settings here.

The update method cannot be set on the panel. The settings is always "Poll Full Screen".

● Poll foreground window (On PC only)
Updates the current window. 
It increases the load on the server.

● Poll window under cursor (On PC only)
Updates the window that is located under the mouse cursor. The window is updated when 
a change occurs in the operator control element under the mouse cursor.
Default: Selected
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● Poll full screen (On PC only)
This setting specifies an update each time the screen changes. This setting provides you 
the lowest display error but places a maximum load on the server.

● Polling cycle
Determine the suitable setting for your configuration. Make sure that the selected update 
cycle is not too short, since it affects the computer load.

Window polling

● Poll console windows Only (On PC only)
This setting specifies an additional update when changes occur in a console window (MS 
input requirement).

● Poll on event received only (Only on the PC)
This setting specifies an additional update each time an entry is made.
Default: Selected

● Mirror driver status
(Only on the PC with a mirror driver installed)
Provides information about the status of the virtual graphics driver.

Mirror driver options

(Only on the PC with a mirror driver installed)

Enable direct access to display driver's mirror screen

The shared-memory area of the virtual graphics driver is used for the display. The setting 
improves the performance.

Troubleshooting

(On PC only)

● Don't use VNCHooks.DLL while polling full screen
VNCHooks.dll is used by default for the screen update. If VNCHooks.dll causes problems 
when using other program, select this setting.

● Don't use mirror display driver even if available
(Only on the PC with a mirror driver installed)
Use this setting only for troubleshooting. 

"Display" tab

Purpose of the dialog box
Setting of the screen display.

Settings
Sharing area

(On PC only)
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● Full desktop
The entire desktop of the server is accessed.

● Primary display
The main screen of the multi-monitor configuration is displayed.

Downscale to

(On PC only) 

Scales the screen to be transferred according your inputs. Servers with Windows CE ignore 
this setting.

"Query" tab
 

 Note

This dialog is titled "Default Local System Advanced" on the panel. 
 

Query settings

These settings govern acceptance of incoming attempts to establish a connection. 

● Query console on incoming connections
The Sm@rtServer registers the incoming attempts to establish a connection and displays 
a dialog on the screen in which the connection attempt is accepted or rejected.

● Query timeout
Set the waiting time.

● Default action
Select the response to an attempt to establish a connection once the waiting time expires: 

– "Refuse": Reject attempt (operator control mode - single mode)

– "Accept": Accept attempt (operator control mode – shared mode)

Allow option to accept without authentication

The dialog for handling attempts to establish connections also contains the button "Accept 
without password" . This gives you the option to accept an attempt to establish connection 
without a password. 

"Administration" tab

Purpose of the dialog box
Specifications for session management.

 

 Note

This dialog is titled "Default Local System Advanced" on the panel.
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Settings

Administration
● Disable empty passwords

Select this check box in order to allow an empty "Password 1". 
Default: Selected

● Allow loopback connections
This setting allows connections to your own HMI device. It is useful and necessary when 
security software is used for secure (encoded) connections. 

● Allow only loopback
This setting allows only connections to your own HMI device.

Logging
● Log info to SmartServer.log

(On the panel: Log information to file)
This setting writes information to the server logbook. 

● Log detailed debugging information
This setting writes expanded information to the server logbook (for locating errors). 

With HMI devices operating with Windows CE, the log is only created when the MMC card is 
inserted. If the MMC card is inserted, the log is created directly on the card.

The log files are created in the following path on a PC: C:\Documents and Settings\All Users
\Application Data\Siemens\HmiRTm

Forced write access
This setting governs forced access in an emergency contrary to normal session management. 
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● Password needed
If this check box is not selected, every operator can force access in emergencies as follows:

– Pressing the <Shift> key four times

– Clicking four times

– Touching the screen four times

If this check box is enabled, to force access an attempt must be made to gain access and 
a password must also be entered. 
In this case, enter the applicable password in the input field underneath. If a password is 
not entered, it is not possible to force access in an emergency. 
Default: Selected

 

  Note

On the server, access can only be forced by pressing the <Shift> key four times, clicking 
four times, or touching the screen four times. 

 

HTTP-Server
● Enable built-in HTTP server

If this check box is activated, the Java-Applet is automatically downloaded on the PC when 
the connection is first established.
The Java applet accesses the Java VM that is installed on the client and enables remote 
monitoring and remote control using Internet Explorer. 
Default: Selected

● Enable applet params in URLs
Forwards all parameters of the URL to the Sm@rtClient application.

Connection priority
These settings govern handling of attempts to establish a connection by non-shared clients. 

● Disconnect existing connections
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the existing connections are disconnected (single mode). 

● Automatic shared sesssions
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the prior existing connections are retained. Access is controlled using session 
management in shared mode. 
Default: Selected

● Active user timeout 
For shared mode, enter the time that must elapse without any actions on the active HMI 
device before access can be changed. 
Default setting: 10 seconds

● Refuse concurrent connections
If a non-shared client is already connected to the server, attempts to establish a connection 
by other non-shared clients are rejected. 
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See also
Remote control by means of Internet Explorer (Page 2485)

User administration for web server 

Introduction
Different web authorizations for the operation and monitoring are allocated to the users in the 
user administration.     

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Entries and settings
Click "User Administration" in the "Web Server" tab and enter the password. 

 

 Note

By default, the password is set to "100" and all web authorizations are granted to users with 
"Administrator" rights. Change this password during commissioning according to your 
requirements.

 

The "UserDatabase-Edit" dialog is opened. 

The "UserDatabase-Edit" dialog has three tabs: 
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● Tab "User Manager"
User administration for creation or deletion of users. 
Create a new user using "New"; Delete a user using "Remove". The recreation and deletion 
become effective using "Apply". 

● Tab "Description"
You can store a description of or comments on the users selected on the "User Manager" 
tab. 

● Tab "Authorizations"
Specify the web authorizations for the users selected on the "User Manager" tab. You use 
"Add" to activate a web authorization and "Remove" to deactivate one. 
By default, the password is initially preset to "100" and all web authorizations are granted 
to users with "Administrator" rights. 
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser".
 

 

  Note

In principle, every user who has access to the control panel can manage users and web 
authorizations. If necessary, protect the control panel from unwanted access.

 

List of web authorizations 
The following  web authorizations exist:     

Web authorization Authorized for: 
UserData Import and export of recipes 
UserAdministrator Import and export of password lists 
RuntimeAccess Starting and stopping of runtime
Engineering HTTP transfer from ES to the target device
FileBrowserUser Read access to the file browser
FileBrowserAdministrator Read/write access to the file browser 
RTCommunication Utilization of the SIMATIC HMI HTTP server
SoapUser Read/write access via web service (SOAP) 
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Settings for remote control

Session management for remote control 

Introduction
WinCC enables remote monitoring and remote control of HMI devices over a TCP/IP-ready 
network such as a LAN or the Internet. Remote monitoring and remote control is implemented 
in different ways:     

● Remote control by means of Internet Explorer

● Remote control by means of the Sm@rtClient-application

● Remote control by means of the Sm@rtClient-display in

Only one device can ever have access to the HMI-device. Which device is permitted access 
is determined by the session management. 

Session management options
Session management is used to control access. The client-server connection can be in one 
of two modes: 

● Monitoring mode

● Control mode

Monitoring mode
If the client accesses the server in monitoring mode, the operator can see the current screen 
of the HMI device and track all changes. He can monitor the server but cannot operate.     

In the monitoring mode, all the keys on the client retain their standard functions. 

If remote control was started from the Sm@rtClient display, the operator uses the <Tab> key 
or the cursor keys to go to the next object in the current screen of the client project. 

Control mode
If the client accesses the server in operator control mode, the operator can use the mouse and 
the keyboard to control the server from the client. If an access attempt is made from another 
client, the assignment of operating permission depends on the settings at the server and at 
the clients. 

In operator control mode, the client keys act on the server screen. Thus, the operator uses the 
<Tab> key to go to the next object in the current screen of the project running on the server. 

If remote control was started from the Sm@rtClient display, the operator can only go to another 
object or screen in the project on the client by using an additionally configured function or an 
additional menu command. The operator to this menu command as follows:
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● On the Touch-device, in which he touches the screen longer than 1 sec.

● On the keyboard =device, in which he masks on the menu with <Shift+Control> and  
operates  it with <Alt> and the keyboard.

In both operating modes, the Sm@rtServer is set so that the operator at the remotely controlled 
device, the server, can be prevented from performing any activities. 

In an emergency, the operator can exact the user rights on a remotely controlled HMI device 
as well as on an inactive HMI device. If no password is specified, he must click the user 
interface four times consecutively, touch the screen four times consecutively, or press the 
<Shift> key four times consecutively. If a password is specified, he must click once or press a 
key on the client and then enter the specified password. 

Settings for session management
You make settings for session management on the server and on the client in the Control 
Panel "WinCC Internet Settings". 

Configuring Sm@rtServer for remote control

Introduction
The Sm@rtServer has an internal security concept based on passwords and special settings 
for session management.         

Security concept for the Sm@rtServer
Remote monitoring and remote control of the Sm@rtServer at the Sm@rtClient is protected 
by two passwords. The second password is used as a further password for additional access, 
for example, as a service password. Both key words are preset with "100". The key word can 
be easily changed, if required.

Settings on the Sm@rtServer
The settings on the server govern which remote operators can access the runtime of the server.

The passwords for access are set on the server. Open "WinCC Runtime Advanced Internet" 
in the control panel. On the "Remote" tab, click "Change Settings". On the following Server 
tab of the subsequent dialog, enter the passwords of the Sm@rtClient. For both passwords, 
you can use "View only" to set the monitoring mode and to exclude operator control mode.

On the panel, this dialog is called "Sm@rtServer: Default Local System Properties" and 
contains fewer dialog elements than the dialog on the PC.
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Control mode
To enable operator control mode, the "View only" check box must be cleared.

The manner in which the individual remote control station can access the server is set on the 
"Administration" tab.
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● "Disconnect existing connections"
When an access attempt is made by an non-shared client, the previous connection is 
automatically disconnected and control is transferred to the new client.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

● "Automatic shared sessions"
When an access attempt is made, control is transferred to the new client.
The condition for transferring control is that no action has been undertaken by the previously 
active client for a period of time (in seconds) as specified in the "Active user timeout" setting.

● "Refuse concurrent connections"
When an attempt is made to access by a non-shared client, this access attempt is rejected 
so long as the operator station that currently has access is still connected to the server.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

Disabling local operator control of the server
To do so, open the "WinCC Internet Settings" in the Control Panel. On the "Remote" tab, click 
"Change Settings". On the "Server" tab in the subsequent dialog, select "No local input during 
client session".   

Password for forced access
A password can be specified in "Forced Write Access" for forced access in an emergency.   

Sm@rtServer as a service
You can let the Sm@rtServer run as a service. The operator can then also access the service-
HMI device from the client-HMI device, for example, the screen saver is active with a password.

Select the check box "Start automatically after booting" in "WinCC Runtime Advanced Internet" 
on the "Remote" tab.   

Sm@rtServer as service in Windows 7
The Sm@rtServer always runs as a service under Windows 7. You cannot stop the 
Sm@rtServer in Runtime with the Notification Area in the taskbar. You have the following 
options for stopping the Sm@rtServer:
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● Stop using the "ControlSmartServer" system function
Configure the "ControlSmartServer" system function to a button, for example. Select the 
"Stop" mode at the system function. You can stop the Sm@rtServer in Runtime by clicking 
the button.

● Stopping the Sm@rtServer in the Control Panel:
Open "WinCC Runtime Advanced Internet" in the control panel and select the "Remote" 
tab. Click on the "Stop" button. Sm@rtServer is stopped.

● Stopping Sm@rtServer by stopping Runtime:
Open "WinCC Runtime Advanced Internet" in the control panel and select the "Remote" 
tab. Activate the "Close with Runtime" option. The Sm@rtServer is stopped at the stop of 
Runtime. 

Configure Sm@rtClient for remote control

Settings on the client PC
● Monitoring mode   

At the client-PC you limit the connection to observation mode, if required. This allows you 
to prevent unintended control operations.

– If connection is via the Sm@rtClient application
In the following "Sm@rtClient Connection" of Sm@rtClient-application, click "Options..." 
button. In the "Sm@rtclient Options" dialog, select the setting"View only (inputs 
ignored)".

– If connection is via Internet Explorer
Click on the button "Options..." and select "View only" in the subsequent dialog.

● Layout
You can also specify whether or not the HMI-device is to be displayed with the same layout 
in the Sm@rtClient application. This is useful if you access from a PC on a touch device. 
In order to suppress the layout, select the "Sm@rtclient Options" setting in the "Suppress 
Device Layout" dialog. 
In addition, you can use "Scale by" to zoom in or out of the layout. To use "Scale by", the 
Suppress Device Layout setting must be selected or the HMI-device must not supply any 
layout. Otherwise, the desktop is always displayed with a zoom setting of 100%.

 

  Note

If you scale the display, the performance may be impaired in some situations: 
● Strong scaling, for example from 1600 x 1200 px to 640 x 480 px.
● Scaling with non-matching scaling factors, for example from a 4:3 resolution to 16:10 

resolution.
 

Configuring of the Sm@rtClient-display
You can configure the Sm@rtClient display in different ways, and thereby set certain inputs: 
The server name, the password for accessing Sm@rtServer or the restriction to the monitoring 
mode.
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Sm@rtClient-Application

Dialog "New Sm@rtServer: Connection"

Introduction
This dialog opens when you click the "Sm@rtClient" button in the taskbar. 

Purpose of the dialog box
This dialog is used for selecting the server and the connection method. 

Sm@rtServer:

Enter the address of the server to which the connection is to be established. The various 
options for entering the address can be found in "Remote control by means of the Sm@rtClient 
application  (Page 2485)".

Connection profil

Select the type of connection to the server according to the network you are using. 

Listening mode

If you enable this function, the Sm@rtClient application is minimized and appears as a button 
in the Windows taskbar. The Sm@rtClient waits for the Sm@rtServer to establish a connection. 
To establish the connection, click the "Sm@rtServer" button in the Windows taskbar of the 
server. Select "Add new client" in the context menu.

Options

The "Sm@rtClient Options" dialog containing the technical settings for the Sm@rtClient-
application is displayed. 

See also
"Options" dialog, "Globals" tab (Page 2480)

"Options" dialog, "Connections" tab (Page 2478)

"Options" dialog, "Connections" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are specified in this dialog box.

Only change the settings here in special cases.
 

 Note

You can also specify these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.
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Format and encodings

Settings for compressing (encoding) the screen data of the server. 

● Use encoding
Preassigned based on the selection under "Connection profile".
Select the desired compression or "Raw" (no compression).

● User 8-bit color
(Only in the Java-Applet): Reduces the color depth at the client to 8 bits (256 colors). The 
data are then transferred faster. However, incorrect colors may result.

● Custom Compression level
Allows individual customizing of the compression level in the "Level" input field:
1 = least compression (faster); 9 = maximum compression (slower).

● Allow JPEG compression
Allows the use of JPEG compression (involves losses).
Enter the "Screen quality" in the input field underneath: 
1 = least compression (faster); 9 = maximum compression (slower).

● Allow CopyRect encoding
(In the Java-Applet: Use CopyRect. Encoding)
Allows compression while using "similar rectangles".

Restrictions

● Viewonly (inputs ingnored)
Sets the view mode for this client irrespective of the settings on the server.

● Disable clipboard transfer
Disables the clipboard that is used to transfer data from one PC to another. Applies only 
to the copying and pasting of texts.
This functionality is not available at a Windows CE server.

Display

Settings for the screen display

● Scale by
Zooms in or zooms out the desktop to be displayed. To use "Scale by", the Suppress Device 
Layout setting must be selected or the HMI-device must not supply any layout. Otherwise, 
the desktop is displayed with a zoom setting of 100%. 

● Fullscreen Mode
Displays the desktop to be shown in full-screen mode. If the server screen is larger than 
the screen of the client, it is scrolled automatically by the mouse movement.

● Suppress Device Layout
In the Sm@rtClient application window, the entire layout of remote HMI-device is not shown. 

● Use CTRL + Cursor Key for Scrolling
The key combinations <CTRL> + cursor key are used to scroll within the local screen. They 
are no longer transferred to the server.

Mouse

(In the Java-Applet: Mouse buttons 2 and 3)

Settings for the evaluation of mouse actions
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● Emulate 3 Buttons (with 2-button click)
Emulation of a three-button mouse by a two-button mouse.

● Swap mouse buttons 2 and 3
(In the Java-Applet: reversed/normal)
Mouse buttons 2 and 3 are swapped.

Mouse cursor

(In the Java-Applet: Cursor shape updates)

Settings for the display of the cursor

Select the type of transfer of the mouse actions:

● Track remote cursor locally
The information on the location of the cursor is transferred separately from the screen 
information. This speeds up the transfer of the cursor. (JavaApplet: Enabled)

● Let remote server deal with mouse cursor
Tracks the server cursor to the client cursor. This allows more accurate cursor positioning. 
(YES: Ignore)

● Don't show remote cursor
The cursor at the server is not included in the transfer. (YES: Disable)

Request shared session

(In the Java-Applet: Share desktop)

Declares this client to be a non-exclusive client. 

See also
Dialog "New Sm@rtServer: Connection" (Page 2478)

"Options" dialog, "Globals" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are carried out in this dialog box. 

Only change the settings here in special cases.
 

 Note

You can also carry out these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.

 

Interface options

● Show toolbars by default
Displays the toolbar. 

● Warn at switching to the full-screen mode
Outputs a message before the full-screen mode is activated.
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● Enable Onscreen keyboard
Enables the display of the on-screen keyboard

● Number of connection to remember
The client creates a list of the recently used connections. This setting specifies the number 
of connections listed.

● Clear the list of saved connections
The list is cleared.

Local cursor shape

Specifies the appearance of the local cursor. This allows you to better differentiate between 
the local cursor and remote cursor.

Listening mode

● Accept reverse VNC connections on TCP port
Specifies the TCP port number. The Sm@rtClient waits for the Sm@rtServer to establish 
the connection over this TCP port number.

Logging

● Write log to a file
Writes information in the logbook of the Sm@rtClient-application.

● Verbosity level
Writes expanded information to the server logbook of the Sm@rtClient-application (for 
locating faults). The amount of detail in the information is dependent on the verbosity level 
setting. 

Remote control of key devices

Mapping of the function keys 
HMI devices are equipped with a variety of function keys. 

Example:

From the PC keyboard, you want to remotely control key F20 on the "MP 377 key" of HMI-
device. 

You can control the F20 key with the PC-keyboard shortcut <SHIFT + F8>.

The table provides you with an overview for controlling the keys.

xP177/277 xP377 PC keyboard shortcut 
F13 F13 SHIFT + F1
F14 F14 SHIFT + F2
F15 F15 SHIFT + F3
F16 F16 SHIFT + F4
F17 F17 SHIFT + F5
F18 F18 SHIFT + F6
F19 F19 SHIFT + F7
F20 F20 SHIFT + F8

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2481



xP177/277 xP377 PC keyboard shortcut 
K1 S1 SHIFT + F9
K2 S2 SHIFT + F10
K3 S3 SHIFT + F11
K4 S4 SHIFT + F12
K5 S5 CTRL + F1
K6 S6 CTRL + F2
K7 S7 CTRL + F3
K8 S8 CTRL + F4
K9 S9 CTRL + F5
K10 S10 CTRL + F6
K11 S11 CTRL + F7
K12 S12 CTRL + F8
K13 S13 CTRL + F9
K14 S14 CTRL + F10
K15 S15 CTRL + F11
K16 S16 CTRL + F12
HELP HELP ALT + H
ACK ACK ALT + F1

Use and restrictions of Sm@rt Options

Use restrictions
While using the Sm@rt Options, observe the following instructions: 

● HMI devices suitable for use
For additional information, refer to "Usable HMI devices".

● Sm@rtServer and Sm@rtClient

– If a PC is used as a Sm@rtServer, select the highest-performance platform available.

– Use only simple projects.

– Avoid photographs and color gradients in screens.

– Avoid heavy background loads during operation, for example, those from user-defined 
functions or logs.

– The number of the maximum connected Sm@rt Clients depends on the Server-HMI 
device. For additional information, see the "Performance features" documentation.

– To improve the performance of the Sm@rtServer, you can disable hardware 
acceleration of the graphics card .  

– You inevitably loose performance at the HMI when you access the HMI-device using 
the Sm@rtClient functionality.
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● SIMATIC HMI HTTP Protocol

– Tag exchange via the SIMATIC HMI HTTP Protocol is not suitable for exchanging bulk 
data.

– The maximum number of connections depends on the HMI device: For additional 
information, see the "Performance features" documentation

● Access protection
To protect access to an HMI-device using different passwords, you must use the first 
password for the protected, and the second password for the unprotected access e.g. 
remote control with a password, remote monitoring without password.   

● Port
The web server connects to the network at the port 80. To run it without problems, make 
sure port 80 is not in use by any other application, such as IIS World Wide Web Publishing 
Service.

● Integrated HTML-pages

– The size of the HTML pages must not exceed 100 Kb in case of Windows CE. In case 
of exceeding of the given value, these pages are spooled on external storage media.

– If you display tags on HTML-pages using the entry type "Cyclic on use", it can lead to 
data-inconsistency.

● E-mailing
The E-mailing function is not suitable for the mass dispatch of E-Mails. It is meant for 
sending important messages. 

● Timeout
If the connection between server and client is interrupted, the server will register this 
disconnection only with a certain delay. The delay is based on the Windows standard 
configuration of TCP/IP Timeout.

Use-requirements in the company network 
In order to implement the mentioned scenario, the accesses to the company network must be 
enabled. If the company network is protected by a Firewall, the system administrator must 
release the appropriate ports for that. 

● Access to the integrated HTML-pages
The web server connects to the network at the port 80. 

● Access to Sm@rtServer for downloading the Java-Applet using the Internet Explorer
The Sm@rtServer is connected to the network at the Port 5800 for downloading the Java-
applet. 

● Access to the Sm@rtServer using the Internet Explorer for remote monitoring and remote 
control
The Sm@rtServer is connected to the network at the port 5900. 

 

  Note

If you change the ports of the Sm@rtServer you must customize the links in the used Html-
pages accordingly. Additional information to modify the Html-pages is provided in 
"Example: "Configure integrated webserver".

 

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2483



9.15.2.2 Remote control via Sm@rtServer

Types of the remote control

Remote control and remote monitoring by means of Sm@rtServer

Introduction
The Sm@rtOptions of WinCC enable the access from HMI device or PC to a remote HMI 
device via Ethernet.      

Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

 

  Note

The 14-day license is not supported by Windows CE devices. 
 

● Both devices are linked via a TCP/IP-ready network, that is via a LAN or the Internet.

● "Sm@rtServer" is activated in the WinCC-Project of the Server-HMI device for the "Services 
in Runtime".

● Additional requirements must be satisfied according to the type of implementation.

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

Remote monitoring or remote control can be implemented on the local device (client) in various 
ways: 

● By means of Internet Explorer

● By means of the Sm@rtClient-application

Access via HTML pages
The Sm@rt Options enable access for remote control with Microsoft Internet Explorer and by 
means of integrated HTML pages of the server.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.
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Remote control by means of Internet Explorer

Introduction
On the client HMI device, the connection to the remote HMI device is established by means 
of Internet Explorer.   

The window of the Internet Explorer displays only the screen of the remote HMI device, of the 
server HMI device. If task switching is not disabled at the server HMI device, you can access 
the complete desktop.

Requirement
● The Client-HMI device is a PC.

● Internet Explorer from V6.0 SP1 is installed.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.

● The Java-Applet is installed. The Java applet accesses the Java runtime environment that 
is installed on the client.

 

  Note

You achieve the best results in Internet Explorer by installing the current Java Runtime 
Environment (JRETM) of Sun Microsystems. Go to www.java.com to download this 
program.

 

Process flow
Enter the address of the remote device in Internet Explorer. The address consists of the server 
name and the HTTP port number that is set on the server. The default setting is: 5800.

Examples of addressing: "http://MyPanel:5800" or "http://192.168.168.1:5800".

Restrictions
The "Force write access with password" function cannot be implemented using the Java applet. 

See also
"Administration" tab (Page 2468)

Remote control by means of the Sm@rtClient application 

Introduction
The Sm@rtClient application provides the connection to the remote HMI device on the remote 
HMI device.     
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Requirement
● The Client-and Server-certificates are installed to ensure the data security when transferred 

via internet.

● The Client-HMI device is a PC.

Process flow
The remote control via the Sm@rtClient-application works as follows:

● Start Sm@rtClient application

● Establish connection

● Password input

● Perform operator control or monitoring on the HMI device

Start Sm@rtClient application
You can access the Sm@rtClient application, the program "SmartClient.exe", in various ways: 

● By installing WinCC Runtime on the client device you have automatically installed the 
Sm@rtClient application.

● You have several options if WinCC Runtime is not installed on the client device:

– Copy the Sm@rtClient application from the WinCC product-DVD from the folder "Support
\SmartClient".

– Copy the Sm@rtClient application from the "...\Siemens\Automation
\WinCCRTAdvanced" folder from another PC using a floppy or the Intranet.

Establish connection
In order to establish the connection to the remote HMI device, call the Sm@rtClient application 
and enter the IP address of the server.

● IP address or server name:port number

● IP address or server name:display number

Example: "192.168.0.1::5800"

You can also start the Sm@rtClient application with the command line input: "smartclient.exe 
192.168.0.1". The logon dialog box opens. 
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You can include the password in the command line entry to start the Sm@rtClient application: 
"smartclient.exe 192.168.0.1 /password 100".

 

 Note

If the Sm@rtServer at the server HMI device does not run as a service, the connection 
established with the Sm@rtClient application is interrupted automatically as soon as the 
keyboard shortcut CTRL+ALT+DEL is pressed at the server HMI device or the screen saver 
is activated. In order for the Sm@rtServer to run as a service, the "Start automatically after 
booting" check box in the "Remote" tab in the "WinCC Runtime Advacned Internet Settings" 
dialog must be activated.

 

Password input

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. 

The local on-screen keyboard will be displayed automatically on the Sm@rtClient or in the 
Sm@rtClient view.

Close the on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the local on-
screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
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Perform operator control or monitoring on the HMI device
In the Sm@rtClient application window, the entire layout of the remote HMI device is shown. 
Depending on the configuration, you can specify monitoring only or operator control of all keys, 
including the function keys, with the mouse. In addition, the entire desktop can be accessed 
in the case of a PC.

For operator control via the keyboard, the following is available:

Keyboard shortcut Function
<ALT+CTRL+SHIFT+O> Opens the "Sm@rtClient Options" dialog
<ALT+CTRL+SHIFT+F> Switches over to full screen mode
<ALT+CTRL+SHIFT+R> Updates the display
<ALT+CTRL+SHIFT+N> Opens the "New Sm@rtServer Connection" dialog
<ALT+CTRL+SHIFT+S> Save as
<ALT+CTRL+SHIFT+T> Displays and hides the toolbar

Remote control via the Sm@rtClient display during runtime

Introduction
The Sm@rt options of WinCC enables access from the HMI device or PC to a remote HMI 
device via Ethernet.     

Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

● Both devices are linked via a TCP/IP-ready network, that is, via a LAN or the Internet.

● HMI-device is configured as Sm@rtServer. For detailed instructions on this, refer to 
"Configure Sm@rtServer (Page 2492)".

● The Sm@rtClient-Display in an image is added in the client-HMI device project. For detailed 
information on this, refer to "Project Sm@rtClient (Page 2494)".

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

On the client HMI device, the connection to the Sm@rtServer is made during runtime by means 
of the Sm@rtClient display. 

On the HMI device only the screen of the server, and not the soft keys, is displayed. 
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The form of the cursor is not a part of the screen and is therefore not transmitted. Only the 
coordinates of the cursor are transmitted.

 

 NOTICE

If a soft-key is activated on the client HMI device, then observe the following:

This signal is transferred to the Server-HMI device and becomes effective there, only if no 
function was configured at the soft-key.

Otherwise, the function projected on the client-HMI device is executed. 
 

Use of direct keys for remote access  
You can only operate direct keys locally on the server. Although the key for the direct key can 
be operated on the Sm@rtClient, no bit is set in the I/O range of the PLC.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.

 

Password input     

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. The local on-
screen keyboard will be displayed automatically on the Sm@rtClient or in the Sm@rtClient 
view.
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Close the local on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the 
local on-screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
 

Distributed operator stations

Configuration

Configuration
Multiple HMI devices are used as decentralized, coordinated operator stations that have 
access to a centralized HMI device connected to the PLC. 

The HMI devices are linked via a TCP/IP-network, (LAN or Intranet /Internet).
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...

Figure 9-11 Distributed HMI

Only one HMI device, the Sm@rtServer contains the configuration data. The Sm@rtServer is 
controlled from the HMI devices. 

The decentralized operator stations are the Sm@rtClients. These operator stations display the 
same process screen of the server. A Sm@rtClient-Display is configured in the process screen 
for the operation and monitoring.

All devices have the same screen resolution. 

The operator stations are in shared mode. As soon as a defined period of time elapses without 
any action on an operator station, another operator station can become active. If Sm@rtClient 
display is configured accordingly, the user can also log off directly.

Advantages
● Operator control and monitoring can be performed from various locations without significant 

efforts.
The project only has to run on one HMI device configured as a server. The same client 
project runs on all other HMI devices; the Sm@rtClient display object is contained in a 
screen on these devices. The screen of the server is displayed via the Sm@rtClient display. 

● The server is situated remotely from the machine and is thus not exposed to the 
environmental conditions of the machinery room.

● Coordinated operation is provided by the Sm@rtServer. Additional PLC investments are 
not required. For example, the load on the field bus is also reduced – the communication 
load on the bus is removed due to the interlocking mechanisms on the PLC side.
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Configure distributed operator stations 

Introduction
Operator control of an extensive printing machine need to have the option to exercise control, 
when necessary, at multiple locations along the machinery. Depending on his current location, 
the operator must be able to access the process from an operator station in the vicinity.         

Requirement
● The HMI-device with the configuration data is connected with the control.

● The server-HMI device and the Client-HMI devices are networked with each other via TCP/
IP-Network.

● The License Key "Sm@rtServer" is available.

Configuration steps
The following basic steps are necessary for configuring the distributed operator stations:

Step  
1 Configure WinCc-Project  (Page 2492) 
2 Setting WinCC Runtime Advanced Internet (Page 2493) 
3 Project Sm@rtClient (Page 2494) 

 

Configure Sm@rtServer

Configure WinCc-Project 

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the Sm@rtServer in WinCC:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable "Sm@rtServer" in  the group "RemoteControl".

4. Transfer the compiled WinCC-project to the Server-HMI-device.

5. Transfer the License Key "Sm@rtServer" to the Server-HMI device.
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Result
The Server-HMI device is configured as Sm@rtServer . 

Setting WinCC Runtime Advanced Internet

Requirement
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Remote" tab is displayed.

Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the 
Sm@rtServer:

1. On the "Remote" tab, select Start automatically after booting".

2. Click on the button "Change settings". The dialogue "Sm@rtServer: Current User 
Properties" is opened.

3. On the "Server" tab, select "Accept socket connections".

4. Enter a password for "Password 1 "and "Password 2". Click "Apply".
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5. Click on the "Administration" tab.

6. In the area Connection priority", select Automatic shared sessions". For "Active user 
timeout" enter time that must elapse without any actions on the active HMI device before 
access can be changed.

7. Under the "Forced write access", clear Password needed" for the forced access to the HMI 
device Click on "Apply". Click "OK" to close all opened dialogs.

Result
The settings were changed. The changes will be effective after restarting the Sm@rtServer. 

See also
Project Sm@rtClient (Page 2494)

Project Sm@rtClient

Requirement
● The WinCC-Project for the Client-HMI device is configured.

● The "Screens" editor is open.

● The Inspector window is shown.

● The "Tools" task card is open.
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Procedure
Proceed as follows to configure the Sm@rtClient:

1. Insert the Sm@rtClient display in the start screen.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the IP-address or the name of Server-HMI device in the "Machine name" field.

4. Enter "Password 1" configured on server in the "Password" field.

5. Activate the setting "Allow Menu".
This provides the operator the option to log off using the menu. 

6. Transfer the compiled project to all operator stations.

Result
The Sm@rtClient-display was added in start screen in WinCC-Project of Sm@rtClient. 

After the Sm@rtServer and operator stations are started, the operator sees the current process 
screen of the central HMI device at each operator station. 

In order to control the server from an operator station, the operator must wait a specified 
amount of time following the last action on another HMI device. 

If the operator uses the menu of the Sm@rtClient display to log off at the previously used HMI 
device, he can immediately control the server at the next HMI device. 

See also
Remote control via the Sm@rtClient display during runtime (Page 2488)

"Server" tab (Page 2465)

Setting WinCC Runtime Advanced Internet (Page 2493)

9.15.2.3 E-mail notification from runtime

Process flow

Introduction
WinCC Runtime Advanced with the Sm@rtService offers the option of sending messages 
automatically via email.     

The automatic e-mailing feature ensures that all people affected by the machine status (for 
example, shift engineer and sales manager) are informed in a timely manner. 
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Contents and triggers for e-mailing
The following events can trigger an e-mail to be sent: 

● Alarm of a certain alarm class

● Event in which a standard function has been configured, such as a tag value change, etc.

Such an e-mail can have the following contents: 

● Alarm text with process tags (maximum of 256 characters)

● Date/time

● E-mail address for replies

If you use e-mail gateways or SMS gateways, you receive access to standard networks, which 
requires external service providers. If configured accordingly, in critical situations the operator 
station sends an SMS to your mobile phone. 

Enabling e-mailing and SMS
The HMI device can send e-mails to an SMTP server only. The server sends the e-mails to 
the addresses configured in the server. 

Nothing else is required to send e-mails to addresses in the company network. However, an 
external service provider is required to access standard networks. 

If an SMS communication is to be sent to service personnel, an SMS gateway is required as 
well. 

Settings on the HMI device
The settings for emailing on the HMI device are made in the "Email" tab under "WinCC Runtime 
Advanced Internet" on the control panel. 

The "Sender" entry field is assigned the default value "Automation HMI device." A change is 
useful if you want the recipient to be able to identify the device from which the e-mail originated, 
e.g. "HMI device on production line 2" 

You can also use an SMTP server that support authentication to send e-mail. 

The following authentication modes can be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

Data can also be encrypted and sent via an SSL connection. This means the data cannot be 
manipulated or read. 
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Specify trigger for E-Mailing

Requirement  
● You have to create WinCC project.

Procedure
Proceed as follows to send a message when an alarm is triggered:

1. Double-click on the "HMI-Alarms" entry in the project tree.

2. Click the "Alarm classes" tab in the "HMI-Alarms" editor.

3. Select the alarm class, e.g. "Errors".

4. Enter the E-Mail-Address in the inspector window under "Properties > Properties > 
General".

5. Create an analog or discrete message with this alarm class.

Result
The trigger to send a message was configured. A message is automatically sent when a 
message of this alarm class is triggered.

Configure secure e-mail notification from Runtime

Introduction
If you send e-mail via the SMTP protocol, the sender is not verified. To ensure secure 
transmission of e-mails, you can use SMTP servers that support SMTP AUTH 
(authentication).   

You must log on to the SMTP server to send e-mails. The following authentication modes can 
be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

The data can also be sent via an SSL connection. SSL (Secure Socket Layer) encrypts e-mails 
and user data for transmission. This means the e-mail cannot be manipulated or read during 
transmission. 

Requirement
● The SMTP server supports SMTP AUTH and STARTTLS. You can obtain more detailed 

information from your service provider.

● User name and password or a valid e-mail address for logon to the SMTP Server. You can 
obtain this data from your service provider.

● The SMTP server is available.
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● The e-mail address of the service technician is entered in the alarm class.

● An analog or discrete alarm has been created for this alarm class.

Setting up secure e-mailing

Procedure in the WinCC-Project
1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enter the sender name to be shown in e-mail under "Sender name". If the SMTP-Server 
does not support the function, delete the entry.

4. Enter the authentication data.

– Authentication by means of user name and password:
Enter the user name and click on  at the "Password" input field. Enter the password 
in the "Enter password" box in the next dialog. Enter the password again in the "Confirm 
password" box. Close the dialog.

– Authentication by means of a valid e-mail address
Type in the e-mail address required for SMTP authentication in the "E-mail address" 
input field.

5. Enable "The server requires a secure connection (SSL)".

Procedure on the HMI device
 

 Note

Note that the settings on the HMI device have a higher priority than the settings in the WinCC 
project. 

 

1. Open the "WinCC Runtime Advanced Internet " dialog in the control panel of the HMI device.

2. Click on the "E-mail" tab.

3. Specify the SMTP server.

– Select "Use the default project file" if you want to use the SMTP server defined in the 
project.

– Deactivate "Use the default project file" if you do not want to use the SMTP server 
defined in the project. Specify the required SMTP server. For HMI devices with Windows 
CE, specify the computer name or the FQDN (Fully Qualified Domain Name).

4. Enter the sender name given in the e-mail under "Name of the sender". If the SMTP-Server 
does not support the function, delete the entry

5. Enter the authentication data.

6. Enter a valid e-mail address at "eMail adress of sender" if required for authentication.

– Click "Advanced" if you need a user name and password for authentication. The 
"Advanced Email Settings" dialog opens.
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7. Type in the user name and password in the "Advanced Email Settings" dialog.

– Enable "Use the default of the project file" to use default user data you have defined in 
the project.

– Select "Use panel settings for authentication" if you do not want to use the user data 
defined in the project. Enter the user name and password.

8. Enable transmission via SSL.

– To use the project settings, enable "Use the default of project file" and SSL in WinCC.

Result
If a tag such as a mixer speed exceeds configured limits, a corresponding alarm is displayed 
on the HMI device. The data is sent to the SMTP server via SSL connection. The e-mail is sent 
to the field service technician after successful logon. 

9.15.2.4 Display integrated Service-Pages

Integrated Webserver

Introduction
The operator can display and navigate between web pages during runtime using the web 
server integrated in the HMI device.  

The integrated web server displays the integrated service-pages. Depending on the 
configuration, own configured HTML-pages or Service-pages of a server accessible over 
Ethernet are be displayed. 

Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option 
"HTML-pages" is cleared. Setup always installs the standard pages of the Web Server on 
the PC. Assign an administrator password to prevent unauthorized access to the pages.

 

Purpose of the web server
The integrated web server permits HTML pages to be displayed during runtime over one of 
the following routes: 

● Internet Explorer

● HTML browser screen object during runtime (not on Windows CE devices)

The following are displayed: 
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● internal Service-Pages available by default on the HMI-device

● Other pages that you configure

● Other Internet pages

An operator or service technician can access service-critical information via the HTML pages. 
The standard HTML pages provide the following options: 

● Remote control (if the HMI device is configured as a Sm@rtServer)

● Remote control using Microsoft Internet Explorer

● Starting and stopping of runtime

● Remote access to recipe data records and password lists

● Display of system information

● File management using a file browser

● Downloading of configuration data

● A "DATETIME" tag always returns a date within the range from 1.1.1970 00:00:00 to 
31.12.2037 23:59:59. 

● The "Export recipes" function requires the following authorizations:

– PC: "UserData"

– other HMI devices: "UserData" and "FileBrowserUser"

HTML browser for HTML pages
The HTML-pages are also displayed using the configured "HTML browser" screen object (not 
on Windows-CE devices). 

You can can also arrange for input or activation of an Internet address. As soon as the operator 
enters or activates an address, the HTML browser opens the relevant page. 

The appearance and functionality of the HTML browser screen object depends on the HMI 
device type. On PCs, the HTML browser corresponds to the Internet Explorer installed.

 

 NOTICE

Note that the HTML browser options during runtime are restricted due to operating device 
capacities and options. 

 

Service-pages of the web server

Introduction
The operator can use Internet Explorer or the HTML browser screen object during runtime to 
display service-pages without any additional configuration.   

You can also create own service-pages. For detailed information, refer to "Configure In-house 
service-pages".
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Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option"HTML-
pages" is cleared. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

 

Service-pages
WINCC Runtime has the following service-pages: 

● start.html: Home page

● RemoteControl.html: Remote control (only for Internet Explorer)

● Control.html: Control functions

● StatusDetails.html: System diagnostics

● Browse.html: File browser (only for Internet Explorer)

Home page: Start.html
The start page contains the links to all other pages and displays current information about the 
project: Mode, software versions, device data, etc.

"Remote control": RemoteControl.html
The "Remote control" page enables operator control of the HMI device for which a page is to 
be displayed. This page can only be displayed by using the Internet Explorer.
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"Control functions": Control.html
The "Control functions" page enables the following options on the HMI device for which a page 
is to be displayed: 

● Starting and stopping of HMI runtime
 

  Note

The transfer mode must be set in the Loader-menu on the HMI-device.
 

● Exporting and importing of recipes
 

  Note

After importing recipes with Sm@rtService (HTML pages), restart Runtime. The imported 
recipes only become active the next time Runtime is started. 

 

● Exporting and importing of password lists
 

  Note

The password list must be named "pdata.pwl." It is exported to the following directory: 

On Windows CE-devices: In the "\Flash\simatic\" target directory

On PCs: the folder that was set in the file "HMILoader.exe". 

The password list is exported and becomes active the next time Runtime is started. 
 

"System diagnostics": StatusDetails.html
The "System diagnostics" page contains system alarms from the alarm buffer.

"File Browser" – Browse.html
The "File Browser" page is used to administer directories and files on the remote device. This 
page can only be displayed by using the Internet Explorer. 

Installing the client and server certificates for SSL

Introduction
To ensure data security, data are encoded for transmission over the Internet. Encoding and 
decoding is performed by appropriate software – the certificates for SSL (Secure Sockets 
Layer). 

● The client certificate for SSL must be installed on devices that are to be used to control a 
remote device.

● The server certificate for SSL must be installed on HMI devices that are to allow remote 
control.
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Configure access to  service-pages

Configure integrated web server 

Configure WinCC-Project 

Requirement
● The WinCC-Project of the server-HMI-device is configured.

Procedure
Proceed as follows to configure the HMI device in such a way that other HMI devices or PCs 
can be connected to it:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable the "HTML-Pages" in the "Diagnostics" group.

4. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The Server-HMI-device is configured as web server. 

Setting WinCC Runtime Advanced Internet

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HMI 
device:

1. Click "User Administration" in the "Web Server" tab. Enter "100" as password. The 
"UserDatabase-Edit" dialog is opened.

2. Click "Add" in the "User manager" tab to create a new user. Enter a user name and specify 
a password. Click on "Apply".

3. Click the "Authorizations" tab.

4. Specify on the "Authorizations" tab, which functions can the user carry out on the HTML-
pages of an HMI-device.  See the chapter "User administration for web server  
(Page 2471)" for additional details.
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5. Close the "UserDatabase-Edit" dialog.

6. On the "Remote" tab, select the "Start automatically after booting" check box.

7. Click "Change settings" and enable in the "Sm@rtServer dialog: Current User Properties", 
select the checkbox "Enable connections".

8. Specify a password for "Password2" so that the HMI device can be remotely controlled by 
the service technician.

Result
A user was created on the HMI-device in the user administration of the web server and 
configured for the remote control. 

The service technician can be connected to the HMI-device by means of the Internet Explorer 
and the Sm@rtClient Application. After disconnecting the connection, the HMI-device can be 
operated from his PC. 

See also
WinCC Runtime Advanced Internet, "Web Server" tab (Page 2463)

"Server" tab (Page 2465)

Display and remote-control Service-Pages

Requirement   
● A user is created on the HMI-device in the user administration for the web server.

● The web server is started.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.
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Procedure
To display and control the service-pages, follow these steps: 

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. For "Name" and for "Password", enter the data of the user configured in the user 
administration of the web server. Click "Login".

3. Click "System Diagnostics". The system alarms from the alarm buffer are displayed on this 
page.

4. Click "Remote Control" to remotely control the HMI-device.

Result
The service-pages are displayed. The HMI-device can be operated or monitored via the 
service-pages. 

A keyboard units cannot be operated completely in the Internet Explorer, since only the screen 
content is displayed. Use the Sm@rtClient-Application to remotely control the keys of HMI-
device. The Sm@rtClient-Application can be located under "Start > Program > Siemens 
Automation > Runtime Systems > WinCC Runtime Advanced > Sm@rtClient"
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Create own Service-pages

Basics

Introduction
The basic framework of the service-pages corresponds to a normal HTML-file.

● Declaration of the document type

● Header with data for the title

● Body - content to be displayed.

Variable parameters in Service-pages
You can specify variable parameters in HTML documents. As soon as a page with variable 
parameters is opened, the parameters are replaced by specific values. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[Parameter]")); --></MWSL></BODY>

Available variable parameter

Parameters Meaning
ProgramMemoryComplete CE only: Total program memory
ProgramMemoryFree CE only: Program memory available
ProgramMemoryUsed CE only: Program memory utilized
FlashComplete CE only: Total flash memory
ObjStrComplete CE only: Total available flash memory
ObjStrFree CE only: Volatile memory available
ObjStrUsed CE only: Volatile memory utilized
DeviceType Type of target device as specified in the control panel.
BtLdVer CE only: Bootloader-version, as specified in the control panel. 
BtLdRelDate CE only: Bootloader release date
ImageVersion CE only: Image version as it appears on the loader
DramSize CE only: Size of DRAM
HostName The name by which the device is logged on/identified in the network.
RtState Indicates whether Runtime is running on the target device. 
SystemMessageTable Outputs a table containing the current system events.

In the example below, the "HostName" parameter is replaced by the network-name of the 
device. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[HostName]")); --></MWSL></BODY>
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Process tag
Process tag values can also be displayed in HTML pages. The syntax is the same as for device 
tags. Use the tag name as a placeholder for the tag value, , e.g. Tag_1.

<BODY > Welcome on <MWSL><!-- write(GetVar("[Tag_1")); --></MWSL></BODY>
 

 CAUTION

Data inconsistency caused by HTML pages

Note the information below if the "Cyclic in operation" acquisition mode is set at tag:
1. If this tag is not displayed on the HMI device, the HTML page displays the incorrect tag 

value in the following situations:
– The HTML page display a "0" value at its first call. The HTML page only displays the 

correct value after it is called again or updated.
– The last value is displayed if the connection to the PLC goes down.

2. The HTML page also displays the correct tag value if the tag is displayed on the HMI 
device.

 

Situation 1 is based on standard behavior: If a tag is currently not in use currently and its value 
is not acquired in "Cyclic continuous" mode, the tag is loaded with its initial value in Runtime. 
Instead of reading the values from the PLC, however, the HTML page receives these from 
Runtime.

Link own Service-pages
If a user connects to an HMI device, he is automatically forwarded to the start page http://
<Device name>/www/start.html. This page represents the starting point for the HTML-pages 
of the web server. Every standard page is accessible from the start page via a link. For this 
reason, you insert a link for each of your HTML pages in the start page.

 

 Note

When inserting links in the HTML page, you must differentiate between relative and absolute 
links. Make sure that absolute links start with "/www" to ensure that the document will be 
searched for in the correct directory. Example: "/www/MyDocument.HTML".

 

Storage location of the service-pages 
If files are to be located during a transfer, they must be in a specific directory: 

● on a PC with Windows 7: "C.\ProgrammData\Siemens\CoHmiRTm\MiniWeb11.x.x
\WebContent "

● on a PC with Windows XP: "C:\Documents and Settings\All Users\Application Data
\Siemens\CoHmiRTm\MiniWeb11.x.x\WebContent

● On xP 177B: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On xP 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On MP 177: "<ES-Installationspath>\Transfer\11.0\MP177\WebContent.zip"
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● On MP 377: "<ES-Installationspath>\Transfer\11.0\MP377\WebContent.zip"

● on Mobile Panel 177 PN: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On Mobile Panel 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN: "<ES-Installationspath>\Transfer\11.0\XP277_W
\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN V2: "<ES-Installationspath>\Transfer
\11.0\XP277_W2\WebContent.zip"

Create service-page for displaying process values 

Requirement
The Ta_1 and Tag_2 tags are created in the WinCc-Project. 

Procedure
To create an own Service-page, follow these steps:

1. Copy the "WebContents" ZIP-file in a random work directory on your Configuration-PC and 
un-zip the ZIP-file.

2. Create a copy of start.html and rename the copy in "tag.hml".

3. Open the "tag.html" in a text editor, e.g. Notepad.

4. Replace the existing table with a new table, in which the process values of "Tag_1" and 
"Tag_2" tags are displayed. Save the file"tag.html".

5. Open the "start.html" file and add a hyperlink to page "tag.html". Expand the available 
navigation bar, in which you supplement the existing table by an entry.

6. Save start.html.

Result
You have created the service-page "tag.html". You have added a hyperlink on the start page 
in order to navigate to the service-page from the start-page. 
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Transfer Service-pages

Transfer files using the standard-path (Active Sync/CF- card)  
Proceed as follows to transfer files via the standard-path:

1. Copy the changed HTML pages and pictures according to "\Flash\Simatic\WebContent".
Access then takes place with "http://<device>/www/<HTML page>".

Transfer files via the project transfer
Proceed as follows to transfer the files via the project transfer:

1. Add the changed files to the ZIP-file "WebContents". This file must contain all HTML pages 
and associated pictures.
Make sure to provide the correct path information because the files are unpacked in the 
directories specified in the zip file. Incorrect path information results in errors in direct 
addressing or due to links. 

2. In order to transfer the ZIP-file "WebContents", copy this in a certain directory, e.g. for the 
transfer to an MP377"<ES-Installationspath>\Transfer\1.3\MP377\WebContent.zip".

3. Transfer the project to the HMI device.
The ZIP-file "WebContents" is transferred to the Windows CE device where it is unzipped. 

Transfer files using the File Browser
Proceed as follows in order to transfer files using the file transfer:

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. Log-on to the internal Web Server to work with the File Browser.
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser" .

3. Click on "Browse" in the File Browser . The file selection dialog opens.
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4. Navigate to the file storage location by means of this dialog. Select the desired file and click 
"Open."

5. Click "Upload File". The file is copied in the directory of the internal web server.

See also
Basics (Page 2506)
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9.15.2.5 Access via SIMATIC HMI HTTP Protocol

Configuration

Configuration 
During the communication via  SIMATIC HMI HTTP Protocol, an HMI-device accesses the 
tags of a different HMI-device. The access is "read-only" or "read and write" depending on the 
configuration of the concerned HMI-device.

The HMI device providing the tags is the HTTP-server; the other HMI-device is the HTTP-client. 
However, access to tags functions in both directions.

Configure access via SIMATIC HTTP Protocol 

Introduction
The tags in service-application should be illustrated in an overview for a configuration from 
multiple HMI-devices. 

The panels in the machine level are used as tag server. The service-application illustrating 
tags of machines in an overview image runs on a PC.
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Requirement
● The HMI-devices are networked via a TCP/IP-network with each other.

Configuration steps
The following basic steps are required to configure the access via "SIMATIC HMI Protocol". 

Step  
1 Configure WinCC-Project  (Page 2513) 
2 Setting WinCC Runtime Advanced Internet (Page 2513) 
3 Configuring HTTP connections in the client (Page 2514) 
4 Configure the HTTP-Client tags (Page 2516) 

 

Permissible data types (SIMATIC HMI HTTP protocol)

Permitted data types
When configuring tags, the data types listed below can be used.   

Data types in 
the HTTP 
Protocol

Length Signs Range of values

Bool 0 No true (-1) or false (0)
Char 1 byte Yes -128 to 127
Byte 1 byte No  0 to 255
Int 2 bytes Yes -32768 to 32767
UInt 2 bytes No 0 to 65535
Long 4 bytes Yes  -2,147,483,648 to 2,147,483,647
ULong 4 bytes No 0 to 4,294,967,295
Float 4 bytes Yes  -3.402823E38 to -1.401298E-45 for negative values and 

1.401298E-45 to 3.402823E38 for positive values
Double 8 bytes Yes  -1.79769313486231E308 to

-4.94065645841247E-324 for negative values and 
4.94065645841247E-324 to 1.79769313486232E308 for 
positive values

String 1 to 
255 byte

––––  

DateTime 8 bytes –––– 1.1.1970 00:00:00 up to 31.12.2037 23:59:59
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Please note that data types may be defined in external controllers which have different names 
in WinCC. To ensure correct assignment, please observe the tag definition in the external 
controllers.

 

 Note

It is not possible to access array tags from an HTTP client.
 

See also
Configure WinCC-Project  (Page 2513)

Configure HTTP server

Configure WinCC-Project 

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the HTTP-Server:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Select "SIMATIC HMI HTTP Server" in the group "Read/write tags".

4. Check the data types of the tags. The HTTP-client can access only those tags, whose data 
type is supported by communication driver "SIMATIC HMI HTTP Protocol". For additional 
information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol) (Page 2512)".

5. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The HMI-device is HTTP-server configured. 

Setting WinCC Runtime Advanced Internet

Requirement    
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet " dialog is open.

● The "Web Server" tab is displayed.
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 Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HTTP 
server:

1. Specify the access to tags in case of "Tag access".

– "Read/write": read and write access 

– "Read only": read access 

2. Specify the authentification for access in case of "Tag authenticate":

– "No authentication": No authentication required.

– "Authentication required": A password is required for the access. Specify the password 
for configuring the connection via the SIMATIC HMI HTTP Protocol .

3. Click "User Administration" in the "Web Server" tab. Enter "100" as password. The 
"UserDatabase-Edit" dialog is opened. For detail instructions, refer to "User administration 
for Webserver (Page 2471) ".

4. Click "Add" in the "User manager" tab to create a new user. Enter a user name and specify 
a password. Click on "Apply".

5. Click the "Authorizations" tab.

6. Specify the web-authorizations on the tab "Authorizations". The user must have the Web-
authorization "RTCommunication" for utilizing the SIMATIC HTTP Server.

7. Close all open dialog boxes.

Result
The settings were changed. The changes will be effective after the restart of the WebServer.

See also
Settings on the HMI device (Page 2460)

WinCC Runtime Advanced Internet, "Web Server" tab (Page 2463)

User administration for web server  (Page 2471)

Configuring HTTP clients

Configuring HTTP connections in the client

Requirement
The communication driver "SIMATIC HMI HTTP Protocol" is installed. 
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Procedure
Proceed as follows to create an HTTP-connection:      

1. Double-click on the "Connections" entry in the project tree. The "Connections" editor opens.

2. Create a connection. Select "SIMATIC HMI HTTP Protocol" for "Communication driver".

3. Select "Ethernet" for "Interface". Select the protocol type "http://" or "https://" for address.

4. Enter the name of the HTTP-server or its IP address.
Ask your network administrator for the specific name or parameters of your network.
If the server has already been commissioned, you can read out the IP address on the server 
as well:

– Panel
Click "Start > Programs > Command Prompt" on the server and enter the "ipconfig" 
command using the screen keyboard. Press <Enter> to display the IP-address.

– For PC/Panel PC
Click on the server on "Start > Run", enter "Cmd", and press <Enter>. The command 
interpreter is displayed. Enter the "ipconfig" command. Press <Enter> to display the IP-
address.

5. If the "HTTPS" protocol type is selected, you can establish how the HTTPS-client verifies 
the properties of the server-certificate and how it should react in the event of error:

– "Allow invalid computer names for certificates"

– "Allow expired certificates"

– "Allow certificates signed by unknown publishers"

6. If the "Authentication required" option is selected on the HTTP-server, enter the user name 
and the password.

7. Enter the time for "Timeout" after which disconnection is identified.

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2515



Result
A connection was created in the WinCC-Project of the HTTP-Client. For detail information for 
HTTPS-connection, refer to "Commissioning an HTTP- connection (Page 2517)".

Configure the HTTP-Client tags

Requirement
● An HTTP-connection was created in the WinCC-Project of the HTTP-Client.

● A tag is created in the WinCC-Project of the HTTP-Server. The data type of the tags is 
supported by SIMATIC HMI HTTP Protocols .

Procedure
To create tags on the HTTP-client, proceed as follows:

1. Open the "HMI- tags" folder in the project tree and double-click the entry "Standard-tag 
table". The "Tags" editor opens.

2. Enter a clear tag-name for "Name" in the Inspector window under "Properties > Properties 
> General".

3. Select the HTTP-connection for "Connection".

4. Select the data type for "data type".
The client does not check any verification of the tag name and the data type. Pay attention 
that the selected data type here matches the data type of the tags in the HTTP-server. For 
additional information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol".
Array tags are not permitted.

5. Enter the exact name of the tag that is to be communicated with on the HTTP-server in the 
"Address" field.
If the tag to be addressed is in a sub-folder, the complete path along with tag name must 
be given as address, e.g.[folder name]\[Tag name]. 

Result
A tag was created in the WinCC-Project of the Client-HMI-device. The tag has access to the 
HTTP-server tag via an HTTP-connection. You can use an "E/A-Field" in an image to display 
the process value of this tag.
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Commissioning an HTTP- connection

Introduction
To establish an HTTP connection, you must perform the following actions:

● In the "Connections" editor of WinCC ES, configure the connection as an "https://" protocol 
type and define how the HTTPS client should verify the properties of the server certificate 
and respond to errors.

● Install a valid certificate on the HTTPS client.
Certificates are necessary for server authentication. Using certificates you can ensure that 
the server with which the connection is to be developed is actually the server for which it 
is outputting.           

Principle of an HTTPS connection
After runtime start, the HTTPS client establishes a connection to the HTTPS server. The 
HTTPS server presents its certificate, which the client verifies for authenticity. The session 
code that can only be read by the HTTPS server is then transmitted. The session code is now 
available on both sides and enables a symmetrical data encryption.

 

 Note

The certificate contains the current time. The current time can lead to problems if the time 
zones of the server and client are different. For example, a certificate generated on a server 
with an Asian time zone only becomes valid on a client with European time zone in the future 
(8 hours).

 

Preparation for installing a certificate on the client
With the first HTTPS client access, the HTTPS server generates the certificate itself and then 
saves it in the "Cert.cer" memory. The file is stored in the following directory:

● On a PC / Panel PC (with Windows XP) in the directory "<Runtime-Verzeichnis>
\SystemRoot\SSL"

● On Windows CE-based devices in the directory "Flash\Simatic\SystemRoot\SSL"

The certificate must be stored on the HTTPS client on a storage medium from which it can be 
launched with a double click. You can select from the following transfer options:
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Server Client Possible file transfer
With Windows XP
(PC, Panel PC)

With Windows XP
(PC, Panel PC)

● Diskette
● USB stick
● LAN (Ethernet)
● Internet Explorer (via TCP/IP if 

service is already running)
with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277)

With Windows XP
(PC, Panel PC)

● Memory card
● ActiveSync (serial)

With Windows XP
(PC, Panel PC)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277)

● Memory card

Installing a certificate on a client with Windows XP
Insert the storage medium on which you have saved the "Cert.cer" file into the HTTPS client 
or open the directory in which the file is located. Double click on the file and follow the 
instructions in the Windows dialog.

Tip: The Internet Explorer provides an easy way to install a certificate. Connect to this device 
via HTTPS (e.g.: https://<my device>). The browser establishes if a certificate has not yet been 
imported. In this case, the browser asks if you want to install the certificate. Any faults in the 
certificate are displayed.

Installing a certificate on a client with Windows CE
Insert the memory card on which you have saved the converted "Cert.cer" file into the HTTPS 
client. WinCC includes the "InstallCert.exe" tool for importing certificates with Windows CE.

You can implement the installation as follows:

● In Explorer: 
Double click the "Cert.cer" file to install the certificate.

● In the command prompt:
Enter "InstallCert /[command parameter] [filename]".

– command parameters:
Parameter /r must be specified because the certificate used in WinCC Runtime 
Advanced is a root certificate. 
A root certificate is the main certificate and is used to verify the authenticity of all other 
certificates transferred.

– filename
You must specify the certificate file with its complete path (e.g. "\Storage Card\Cert.cer")
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A status alarm is output when you completed the installation. Runtime has to be restarted after 
the installation of a certificate on Windows CE- HMI devices with HTTPS clients. It is necessary 
to restart Runtime so that an HTTPS connection can be established.

The file "Cert.cer" cannot be opened.
The "Cert.cer" file generated at the HTTPS server cannot be opened on HMI devices based 
on Windows CE 5.0 by double-clicking the client.

1. Open the Control Panel.

2. Select "Certificates > My Certificates."

3. Click the "Import" button.
A dialog box opens. 

4. Select the "From a File" menu in the file browser and select the "Cert.cer" file.

 

9.15.2.6 Connection to the Office-world

Configuration

Data access via web service (SOAP) 
WinCC provides options for utilization of web-service (SOAP). Web service (SOAP) is based 
on the Simple Object Access Protocol. Use of this protocol enables an external application to 
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access tags of an HMI device via Ethernet. If the company network is protected by a Firewall, 
the system administrator must release the appropriate ports.

Figure 9-12 Communication with other applications

For example, a device is accessing two HMI devices. The operator sees the values of certain 
tags and can modify them. 

You can use Microsoft Excel, for example, to display tags. You will require the latest version 
of "MS SOAP Toolkit V2.0" for this purpose. This version is available from Microsoft as a 
download.   

The data access via SOAP is not supported by Windows 7. Use OPC to display the tags in 
MS Excel. For more information, refer to "Configuring OPC clients (Page 2697)".

Data access to Windows CE HMI-devices
The data access via the Web-service(SOAP) on Windows CE-HMI-devices functions using 
only the device name and not via the IP-address. 

Enter the device name of the HMI-device with the appropriate IP-address in the hosts-file. The 
hosts-file is given in the directory"%windir%\system32\drivers\etc\", z. B. C:\WINNT
\system32\drivers\etc.    

The device name, e.g.DEVICEMP377, must be set in the control panel on the HMI device 
under "System > Device Name". Please change the default device name to ensure that the 
device name is unique for the network.
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Example for the entry in the hosts-file:
192.168.56.198 DEVICEMP377

Replace the IP-address by the device name  in the SOAP-client:

objRuntime.mssoapinit http://DEVICEMP377/soap/RuntimeAccess?wsdl

Data access with GetValue, SetValue       
Access to a tag in SOAP using GetValue or SetValue functions require a special syntax.  

● GetValue: "Sinus_1"

● SetValue: Sinus_1

The tag name must be given in inverted commas for GetValue. The message "Runtime is 
offline" will otherwise be output when runtime is accessed.

 

 Note

Note that the tag name entry is case-sensitive.
 

Create VBA-Marko in MS Excel 

Introduction
Data access over the network via web service (SOAP) is to be used to permit certain tags of 
an HMI device to be displayed and reset.  

For this purpose, macros are written in Excel, which: 1) obtain the relevant tags on the PC 
over the network and display them, and 2) transfer reset values back to the HMI device.

The task can be solved using VBA macros "ReadTagValue" and "WriteTagValue," which obtain 
and display the relevant tags in Excel over an appropriate interface and return them to the HMI 
device over the network. Note that the tag name entry is case-sensitive.

Requirement
● The SOAP toolkit is installed.

● "Web-Service (SOAP)" is selected  in the WinCC-Project under "Services in Runtime".

Procedure
1. Insert the "Control element toolbox" toolbar in your workbook in Microsoft Excel.

2. Create a command button. Label the button "ReadTagValue" and name it "Read value".

3. Double-click this command button.
The macro editor is displayed. The "Click" event is already preset. 

4. Write the "ReadTagValue" macro ("intVarTag_1" designates the actual tag value):
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'--------------------------------------------------------------
Private Sub ReadTagValue_Click() 
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(1, 3) 
intVarTag_1 = objRuntime.GetValue(Var) 
objWorksheet.Cells(1, 1) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

 

1. Insert a command button. Label the command button "WriteTagValue" and name it "Write 
value".

2. Double-click this button.

3. Write the "WriteTagValue" macro ("intVarTag_1" designates the return value of the 
operation):

 
'---------------------------------------------------------------
Private Sub WriteTagValue()
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet 
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(2,3) 
Value = objWorksheet.Cells(2,5) 
intVarTag_1 = objRuntime.SetValue(Var,Value) 
objWorksheet.Cells(2,8) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

Result
As soon as you call "ReadTagValue_Click" macro by clicking the button"Read-value", the 
specified intVarTag_1tag is obtained from the HMI device using the specified device address 
and displayed in the cell (1,1). 
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As soon as you call Macro "WriteTagValue" by clicking the "Write value" button, the tag name 
is read from the cell (2,3), and the tag value is transferred from cell (2,5) to the HMI device.

See also
Configuration in WinCC (Page 2458)

9.15.3 WinCC/Server for Runtime Professional

9.15.3.1 Guide to client server systems

Content
You can efficiently distribute operation and monitoring of your plant to multiple operator stations 
and servers. A WinCC Server with process connection records process data and logs alarms 
and process values. Moreover, a WinCC Server performs the following tasks in a WinCC 
network:

● Providing clients with the configuration data

● Providing clients with data from the process

Moreover, you can precisely map technologically or topologically complex systems.

This section  shows you:

● The system configurations you can implement with WinCC.

● How to configure the server and clients in the client/server system.

● How the client/server system reacts in runtime.

9.15.3.2 Clients and servers

Introduction
All process data of a WinCC project, e.g. alarms or trend values, is saved to different Runtime 
databases. Instead of being stored on each HMI device, these Runtime databases are located 
on the central WinCC server. The operator stations, i.e. the WinCC clients, access the WinCC 
server accordingly.

WinCC clients and WinCC servers are independent systems. You can activate WinCC clients 
at any time. It is also possible to activate and deactivate projects when you work on a WinCC 
client.
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Multiple-station system
You can user the server option to expand a WinCC single-station system to a high-performance 
multiple-station system with up to 32 coordinated operator control and monitoring stations.

Figure 9-13 Multiple-station system with up to 32 clients on one WinCC server

WinCC clients display the data of precisely one WinCC server with process connection. WinCC 
clients operating on a multiple-station system do not have an own project ("Client without 
project").  For this reason, it is not necessary to configure the clients. The WinCC server 
provides the process and log data, alarms, screens, and reports to its online WinCC clients.

Licenses required
● A WinCC license on the WinCC server.

● On the WinCC server, the " WinCC Server for RT Professional" license.

● On the WinCC clients, the "WinCC Client for RT Professional" license.

9.15.3.3 Plant configurations

Single-user system

Definition
An operator station has a view of its own project.
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Application
Single-station systems are usually operated at the production level. They are used for operator 
control and monitoring of relatively small applications, but also for independent subprocesses 
or plant components within larger plants. A single-station system operates autonomously with 
its own screens and logs: all data are stored locally on one PC.

Structure

Figure 9-14 Single-station system

Single-station systems are based on the client-server principle:

● Runtime station: The WinCC data is stored in the integrated Microsoft SQL Server database 
on the operator station.

● The various Runtime components, including third-party components can access the 
Microsoft SQL Server database.

● Configuration PC: You can choose to use the actual operator station, or a different PC to 
configure your project.

Multi-user system

Definition
Up to 32 coordinated operator stations (WinCC clients) have a view of the same server project.

All WinCC data is stored in the integrated Microsoft SQL Server database on the WinCC server. 
Since the WinCC clients do not have their own WinCC project, they access the WinCC project 
on the WinCC server.
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Application
The same plant processes can be monitored on several operator stations (clients). Any user 
intervention on an operator station, e.g. value changes, is immediately visible on all other 
operator stations. A multiple-station system is typically configured for small and mid-sized 
plants in which distribution of data to several servers is not required.

Distribution of clients

● With different tasks: You operate and monitor different views of the same process, for 
example, process screens on one operating station and alarms on another operating station.

● With similar tasks: You monitor and control the same view of the process from several 
locations, for example, along a production line.

You use access rights to specify exactly which functions or plant sections are available to a 
given user on which operator stations.

Structure

Figure 9-15 Multiple-station system

The client-server technology makes it possible to easily separate WinCC clients from the 
WinCC server: Configure your project centrally in the TIA Portal on the engineering station 
and download it to the WinCC Server with process connection. The WinCC clients do not need 
a project planning, but merely a configuration:
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● Networking with the WinCC server using drag-and-drop.

● Separately for each WinCC client:

– Start screen

– Runtime language

– Toolbar

– Navigation buttons

– Deactivation of shortcut keys

– Window properties

The WinCC server automatically assumes the task of supplying the WinCC clients:

● Runtime environment

● Screens, process values, alarms, log data, and reports

● Interface with the automation system

● Communication and coordination of clients

● Logging

Process specifications or alarm acknowledgments on one operator station are consistently 
available to other operator stations.

9.15.3.4 Configuring a multiple-station system

Requirement

Requirement
● All HMI devices on a client-server system are interconnected via network (LAN) or ISDN 

and standard TCP/IP protocol.
You can also log on as client or server with PCs in adjacent subnets that are interconnected 
via router.

Server PC

● The server PC is connected to the automation systems via process bus.

● WinCC Runtime Professional is installed.
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● Operating system on the server PC:

– Microsoft Windows XP SP3, maximum 3 WinCC clients.
WinCC ServiceMode is not approved for this configuration.

– Microsoft Windows 7, maximum 3 WinCC clients

– Microsoft Windows 2003 SP2 Server, maximum 32 WinCC clients

– Microsoft Windows 2008 Server, maximum 32 WinCC clients

● Licenses:

– "WinCC Server for RT Professional" for the WinCC Server

– "WinCC RT Professional" for the project

Client PC

● A "WinCC Client for RT Professional" license on all WinCC clients.

●  

● A WinCC license on the WinCC server.

● The "WinCC Client for RT Professional" license on the WinCC clients.

●  

Configuration guidelines

Introduction
This chapter shows the basic procedure for setting up a multiple-station system. The multiple-
station system consists of a WinCC server and two WinCC clients.

Procedure
1. Configuring servers.

2. Configuring clients: Start screen, menus & toolbars, language & font

3. To enable users access to the WinCC server project from a WinCC client: Configure 
operator authorizations

4. Download the project to the server.

Configuring the server

Introduction
Set up a project as the WinCC server.
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Procedure
1. Create a project.

2. Add "WinCC RT Professional" to the HMI device.

3. Enter "WinCC Server" as the device name.

4. Configure the required screens, logs, tags, alarms, custom toolbars, project languages, 
etc. for the "WinCC Server".

5. In the Runtime settings under "General", select the start screen, a configuration and design 
for "Menus & Toolbars".

6. Under "Services", activate the server Runtime services you need for the specific 
configuration. Example: If the server screen displays recipes, select "Recipes".

7. Go to "Screens" to select the corresponding properties.

8. Under "Language & Font" select the Runtime languages required on the WinCC server.

Result
A project is set up and displayed on the WinCC clients. The project only becomes the server 
project when you link the "WinCC Server" with the WinCC clients.

Configuring the operator authorizations

Authorizations in WinCC
To enable access of a WinCC client to a server project, configure the appropriate operator 
authorizations for this WinCC client in the server project. The WinCC server provides the 
following operator authorizations:

● "Operate" The WinCC client is granted access to the WinCC server.

● "Enable remote control": A remote WinCC client can activate a server project, i.e. include 
it in runtime.

The computers on the network are not notified of a change to operator authorizations. This 
change is activated the next time a WinCC client wants to log on to a WinCC server.

The operator authorization "Enable remote control" is requested from the WinCC client as soon 
as the WinCC client requests activation of a project on a WinCC sever. If the corresponding 
operator authorization is not available on the WinCC server, the WinCC client is denied access 
to the project. Once the server project was closed on the WinCC client, a new logon is 
necessary at the next request to open the project.

 

 Note

The operator authorizations configured are user-related, not computer-related. An operating 
authorization assigned is therefore valid for all operating stations with the same login.
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Permissions in the operating system
To enable access of the WinCC clients to the server project, the corresponding project folder 
must be released for network access on the WinCC server. Set up authorizations in the 
operating system with all rights (write, read, modify) for the users who should have access to 
the projects. 

 

 Note

Different Windows permissions can be assigned for the shared project directories to enhance 
network security.

 

Detailed information on the assignment of permissions is provided in the Windows 
documentation.

Procedure
1. Open the WinCC user administration.

2. Select the user group of the user you want to edit.

3. To grant this user full access to the server project, activate the "Operate" and "Enable 
remote control" operator authorizations.

Configuring clients

Introduction
You create two WinCC clients and link them with the WinCC server.
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Procedure
1. Add the following HMI devices to the project:

– WinCC client, device name "WinCC Client1"

– WinCC client, device name "WinCC Client2"

2. In the "Devices & Networks" editor, "Relations" tab, link the two WinCC clients with the 
WinCC server by means of drag-and-drop. A multiple-station system will be created.

 

  Note

In contrast to connections, the physical connection (network) and logic connection (client-
server relation) are always created and deleted jointly. When you configure a relation, the 
devices will be linked automatically.

 

3. Select "WinCC-Client1".

4. In the inspector window, select Properties > Computer name" and enter the physical 
computer name of the HMI device.

5. In the Runtime settings, "General" tab, select a screen as the "Start screen" of the WinCC 
server. In the multiple-station system, the WinCC client then displays this server screen in 
runtime.

6. Select a "Menus & Toolbars" configuration that was made on the WinCC server.

7. At "Services", activate the client Runtime services you need for the specific configuration, 
e.g. the scheduler.

8. Select additional design features under "Screens".
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9. Select a Runtime language for the WinCC server under "Language & Font". For example, 
you can configure a separate Runtime language for each WinCC client.

10.Repeat steps 3 to 9 for "WinCC Client2".

"Network data" editor
Using the arrow buttons below the network view, open the "Network data" editor.  The "Network 
data" editor displays the relations you created. You can edit and delete these relations. If you 
first select a device and then select "Project overview" from the shortcut menu in the "Network 
data" editor, only the relations of the selected device are displayed. 

Result
You have configured a multiple-station system with a WinCC server and two WinCC clients.
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Downloading the project to the server

Procedure
1. Compile the project using the "Compile" icon in the toolbar.

2. Once you successfully compiled your project, select "Project tree > WinCC Server" and 
then select "Download to device" from the shortcut menu of "WinCC RT Professional".

For the initial transfer, enter the computer's's target address "\\computer name\<shared 
folder>" in the next dialog and exit the dialog using the "Transfer" button.

A transfer to the WinCC clients is not necessary because the WinCC server provides all 
necessary data to the WinCC clients.

See also
Overview of compiling and loading projects (Page 2206)

9.15.3.5 Characteristics in runtime

Characteristics (overview)

Editor characteristics in runtime                           
Logs

The Runtime database records and logs the process data on the WinCC server and 
simultaneously operates as log server. The WinCC clients receive their log data from the log 
server and display the data as table or graphics. All operations on the WinCC client are 
forwarded to the WinCC server. Processing results are returned to the WinCC client.

Screens

Data with other subsystems, for example, the log system are always exchanged locally. A 
screen can be opened and processed by several operating stations in runtime. 

Alarms

The "Alarms" Runtime database, which generates alarms on the WinCC server and logs these 
alarms, functions as an alarm server. The WinCC clients receive their alarms from the alarm 
server and display them together with log data in the alarm view or alarm window. 

When an operating acknowledges an alarm, the acknowledgement is transferred to the alarm 
server. The alarm server enters the change of status in the log and distributes the notification 
to all participating WinCC clients. The same process applies to the locking of alarms.

If an alarm server is temporarily unavailable in Runtime, an alarm window will open with a 
corresponding warning. When the alarm server becomes available again, alarms will be 
displayed in the alarm window once again.

Reports

The report system includes only print jobs which show log or process data based on Runtime. 
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The report system is started automatically on all clients during startup. The WinCC server 
functions as a report server. During startup, the WinCC clients log on to the report server and 
obtain the latest information on available print jobs and their status. When a print job is started 
on a client (always local), it receives the corresponding data from the report server. The report 
server, on the other hand, receives the status of the print job from the WinCC client. The report 
server then forwards this information to the other WinCC clients.

Runtime scripts

Project functions and standard functions of the WinCC server are always loaded and executed 
locally on the WinCC client.

Runtime user administration

The operator authorizations are checked by the Runtime component of the user administration. 
The Runtime component is automatically started on every computer when WinCC starts. On 
changes to the login, the current operating rights list is loaded.

Text library (project texts)

The Runtime text library runs on the WinCC server as a text server. The texts are always read 
from the database on the WinCC server.

Reaction to system errors
The WinCC clients are not provided any data if no WinCC server is available. All graphic objects 
that can be operated are grayed out and a connection error is displayed in the controls.

Scripts can be used to configure the display of connection errors on the WinCC client.

Once the WinCC server was recovered, the WinCC client will be reconnected.       

Delta compile in runtime
You create, change and test large, distributed projects with numerous operating stations mostly 
on a configuration computer. The finished and tested project is then transferred to the 
respective HMI device. The project is compiled or delta-compiled depending on whether or not 
the HMI device is in Runtime.

Compiling
The entire project is compiled, downloaded to the HMI device and it will replace the existing 
project.

Delta-compile (download changes) in Runtime
Instead of downloading the entire project or changing it locally, with a delta download the 
changes will be applied directly and locally in Runtime.

At any given time during, only the changed or added Runtime objects, e.g. tags, screens, 
alarms, and logs will be downloaded online to the active runtime of an HMI device, without 
stopping Runtime on that station. 

If you change a screen at runtime and download it to the HMI devices, for example, the modified 
screen is displayed automatically at the next screen selection in Runtime. 
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The offline project on the configuration PC and the online project on the HMI device must be 
consistent.

Field of application
Delta compile (download changes) offers the following options:

● During commissioning, operation, or maintenance, you edit the current project, download 
it to the HMI devices and immediately test it.

● You edit and download the project online at a central configuration station, instead of taking 
time-consuming local actions.

● You can first test the proposed changes on the configuration computer offline in a protected 
environment. Only then do you apply the changes in active operation. This approach helps 
you eliminate possible configuration errors before they result in downtime.

● Changes can be transferred consistently and take effect at the same time: Configuration 
changes are often interrelated and mutually dependent: they recalculate a value, create a 
corresponding tag and add it to a log and a trend display. These changes are completely 
closed and applied in full during operation. This approach prevents error states and 
instabilities in Runtime.

Characteristics of the server

Starting servers

General procedure        
The WinCC servers of a client-server system start independently of the WinCC clients. As 
soon as it has completed its startup, the WinCC makes its services available to the WinCC 
clients and informs itself about all the nodes on the network.

Communication with the automation system will be started.

If a WinCC server fails in runtime, the data on the WinCC client can no longer be updated. The 
WinCC clients will be informed of the absent WinCC server.

See also
Reaction to system errors (Page 2534)

Activating and deactivating projects on the WinCC server (Page 2537)

Server shutdown

General procedure      
When you shut down a WinCC server, it will no longer provide process data to the connected 
WinCC clients. The missing link is, for example, displayed in the alarm window or trend window 
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of the active client projects. All fields with missing process values are displayed in gray in the 
process screen.

See also
WinCCStart (Page 2536)

Characteristics of the client

Starting the Client

General procedure       
A WinCC client always remains in runtime, for example, regardless of whether the WinCC 
server is briefly unavailable. When using WinCCStart to start a WinCC client, the server project 
is also activated if the WinCC server is not in runtime.

See also
Activating and deactivating a project from the WinCC client (Page 2539)

Shutting down a client

General procedure       
Runtime is closed on the WinCC client, while runtime of the server project continues.

See also
Activating and deactivating a project from the WinCC client (Page 2539)

9.15.3.6 WinCCStart

Overview of WinCCStart

Field of application
Using WinCCStart, you enable and disable runtime on the WinCC server and display 
information about the installed product and components.
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Procedure
Proceed as follows to open WinCCStart:

1. In the Windows Start menu, select "Start > All Programs > Siemens Automation > Runtime 
Systems > WinCC Runtime Professional V11 > WinCCStart".

Functions
● Activating and deactivating a project

● Autostart of WinCC Runtime

● Displaying installed products and components

Activating and deactivating projects on the WinCC server

Application area
You activate and deactivate runtime on the WinCC server using WinCCStart.

To enable access from a WinCC client to the server project, the server project must be located 
in a shared folder. The "WinCCProjects" folder is released by default during installation:

Operating system Path
Windows 7 English C:\Users\Public\Documents\Siemens\WinCCProjects
Windows XP SP3 
German

C:\Dokumente und Einstellungen\All Users\Dokumente\Siemens
\WinCCProjects

Windows Server 2003 
German

C:\Dokumente und Einstellungen\All Users\Dokumente\Siemens
\WinCCProjects

Windows Server 2000 
English

C:\Users\Public\Documents\Siemens\WinCCProjects

Windows Server 2008 
German

C:\Benutzer\Öffentlich\Öffentliche Dokumente\Siemens\WinCCProjects

 

 Note

You can also use your own folders and release these with corresponding authorizations.
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Requirement
● The WinCC client and WinCC server are interconnected via network.

● The server project is stored in the "WinCCProjects" folder, or in a different shared folder.

● WinCCStart has been started with the Windows Start menu, "Start > All Programs > 
Siemens Automation > Runtime Systems > WinCC Runtime Professional V11 > 
WinCCStart".

Procedure for activating a project
To activate the server project, proceed as follows:

1. Select the "File > Open" menu command. You can also click the file selection button in the 
"Project" field.

2. Select the server project. The name consists of the project name in the engineering system, 
e.g. "Project1", and the server name, e.g. "HMI_1".

3. You can select different diagnostic sources on the "Diagnostics" tab.

4. Activate the project using the toolbar icon . You can also activate the project using the 
"File > Start RT" menu. Activation of runtime is indicated by a checkmark leading the "File 
> Start RT" menu command.

The WinCC server is started and provides all necessary data to the WinCC clients.
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Procedure for deactivating a project
1. Deactivate the current project using the toolbar icon . The checkmark leading the "File 

> Start RT" menu command is cleared.

The modules for the execution of Runtime will be deactivated. The "WinCC Runtime" program 
window will be closed.

The WinCC clients are not provided any data if no WinCC server is available. All graphic objects 
that can be operated are grayed out and a connection error is displayed in the controls. Once 
the WinCC server was recovered, the WinCC client will be reconnected. 

See also
Loading a project (Page 2190)

Loading a project (Page 2210)

Compiling a project (Page 2188)

Activating and deactivating a project from the WinCC client

Application area
Use WinCCStart to activate and deactivate runtime on the WinCC clients. 
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Requirement
● The WinCC client and WinCC server are interconnected via network.

● The is stored in a shared folder on the WinCC server. The "WinCCProjects" folder is 
released by default and displayed on the network.

● WinCCStart has been started with the Windows Start menu, "Start > All Programs > 
Siemens Automation > Runtime Systems > WinCC Runtime Professional V11 > 
WinCCStart".

Procedure for activating a project
To activate the server project, proceed as follows:

1. You can select different diagnostic sources on the "Diagnostics" tab.

2. Select the "File > Open" menu command. You can also click the file selection button in the 
"Project" field. The WinCC server "\\computer name\<shared folder>" is visible on the 
network.

3. Select the server project from the shared folder. The name consists of the project name in 
the engineering system, e.g. "Project1", and the server name, e.g. "HMI_1". A logon dialog 
opens when you connect to the WinCC server.

4. Enter the user name and password. Once you're successfully connected, the "Activate" 
toolbar icon is displayed if the WinCC server is not in runtime.
If the WinCC-Server is in runtime, the runtime of the WinCC client is started automatically. 
In this case, skip the next step

5. Activate the server project using the toolbar icon . You can also activate the server project 
using the "File > Start RT" menu. Activation of runtime is indicated by a checkmark leading 
the "File > Start RT" menu command.
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Runtime of the WinCC server is started. Runtime of the WinCC client then starts automatically. 
The WinCC server provides all necessary data to the WinCC clients.

Procedure for deactivating a project
1. Deactivate the current runtime of the WinCC client using the toolbar icon . The checkmark 

leading the "File > Start RT" menu command is cleared.

The modules for the execution of Runtime will be deactivated. The "WinCC Runtime" program 
window will be closed.

 

 NOTICE

When working on the WinCC client, you can only terminate runtime on the WinCC client, but 
not the project on the WinCC server.

 

See also
Shutting down a client (Page 2536)

Additional settings: Autostart and language

Introduction
The "Autostart" function automatically starts the server project at the time the server PC starts. 
Moreover, you can prevent users from canceling the start of runtime in order to gain 
unauthorized access to the operating system. To run this setup, you need a corresponding 
operator authorization in WinCC. 

You can change the runtime language.
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Procedure for Autostart 

1. Go to the "Autostart" tab.

2. Activate "Autostart".

3. Select a server project in the "Settings" area.
If you restart the computer with a project, the automatic start of runtime is initiated at the 
end of the load operation. You can prematurely cancel the automatic start and return to the 
operating system by pressing the "Cancel" button.

4. To prevent an operator from canceling the automatic start, deactivate "Allow cancelling of 
activation".

5. Click the "Apply" button. A Logon dialog opens.

6. Log on.

After you successfully logged on, server runtime is started automatically at the next restart of 
the WinCC server.

Language change procedure
1. Select the "View > Language" menu command. A dialog that displays all user interface 

languages available for WinCCStart opens.

2. Select a user interface language.
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Displaying products and components

Introduction
You can view your installed product software and options on the products tab:

The "Component" tab displays the following installed objects:

● Add-on software WinCC tools

● Interfaces

● Drivers

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2543



● Databases

● Logs

Procedure
1. Select "Help > About". The "About WinCC SCADA RT" dialog opens.

2. Select a tab.

9.15.3.7 SIMATIC Shell

Remote Configuration

General procedure     
Clients provided with the corresponding operator authorizations can operate a server project 
from a remote station, e.g.:

● Enable a server project

● Disable a server project
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For remote configuration, the "Simatic Shell" dialog is available which you access through 
Windows Explorer. 

Function of Simatic Shell
In the "Simatic Shell" dialog you can view the enabled servers and projects of your client-server 
system available through the network. These include all projects which run under a demo 
license. 

The window can be used to access an enabled server project from a client:
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● to enable a project remotely

● to disable a project remotely
 

 
 NOTICE

Different names with WinCC Start and SIMATIC Shell

When WinCC Start opens, the name of a client-server project is fully displayed with the 
name of the server PC as the ending, for example, "ClientServerProjectBuild11_1_A-
Server_1". 

SIMATIC Shell does not show PC names under "Object"; it shows the name of the server 
PC on which the client-server project is running, for example, "A-Server_1". This means 
different client-server projects can be referred to with the same object name. 

 

Accessing a computer outside a subnet

General procedure     
Computers located behind a router in a network may be introduced to the system by using the 
"Simatic Shell" dialog.

 

 Note

You use the "Simatic Shell" dialog for central maintenance and diagnostics of all computers 
integrated in your client/server system. 

 

Using the settings in "Simatic Shell", you introduce a computer within your subnet behind your 
router as an "Agent" who distributes the information from other computers to the computers 
within the subnet.

After having logged this computer on, all participating computers in the system can 
communicate even beyond the router limits. Each computer added to an existing group is 
informed of the current status of all computers, including those beyond the router limits. When 
the status of a computer changes, a alarm is issued to all participants, e.g.:

● If a computer has enabled a project

● If a computer is shut down.

● If a computer is started up and thus enters the group.
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Procedure
1. Click on the folder "My Computer > Simatic Shell" in the Windows Explorer of the client 

computer. The "Simatic Shell" dialog opens.

2. Select the "Settings" menu command in the shortcut menu of an entry in the navigation 
window. If no entry is displayed, open the shortcut menu in an empty window. The "Selection 
of the terminal bus" dialog opens. 

3. Check the setting in the field "Multicast Lifetime (TTL)". The value gives the maximum 
number of route jumps between various subnets (IP Parameters TTL).

4. Under "Multicast Proxy", enter the address of the computer that is the "Agent" for the subnet. 
This can be any computer of the subnet (client or server).

5. Add the computer to the list of network partners with the "Add" button.

6. Confirm your entry with "OK".

Activating a project

General procedure        
A client/server system makes it possible to enable and disable projects remotely. 

If you enable a server project from a client by using the "Simatic Shell" dialog, only the server 
project is enabled. 
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Requirements
In order to activate a server project on a client, the following conditions must be fulfilled:

● The user logged onto the client has the operator authorization to "Activate remote" in the 
WinCC project on the server.

● The project has been enabled for network access

Procedure
1. In Windows Explorer of the client, select the "Simatic Shell" entry. The "My Computer > 

Simatic Shell" window will be displayed. 
All the servers and projects available in the network with their current status will be 
displayed.

2. Select the project to be enabled.

3. Select the "Activate remote" command from the shortcut menu. 
A Login dialog appears.

4. Enter the user name and password for the current computer. The project is enabled on the 
server.

Deactivating a project

General procedure     
A client/server system makes it possible to enable and disable projects remotely. 

If you disable a server project from a client by using the "Simatic Shell" dialog, only the server 
project is disabled.

Requirements
In order to deactivate a server project on a client remotely, the following conditions must be 
fulfilled:

● The user logged onto the client has the operator authorization to "Activate remote" in the 
WinCC project on the server.

● The project has been enabled for network access

Procedure
1. In Windows Explorer of the client, select the "My Computer > Simatic Shell". The "Simatic 

Shell" window is displayed. 
All computers and projects available in the network will be displayed with their current status.

2. Select the project to be enabled.

3. Select the "Deactivate remote" command from the shortcut menu. A Login dialog appears.

4. Enter the user name and password for the current computer. The project is disabled on the 
server.
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9.15.4 Web Navigator

9.15.4.1 The basics

Function Overview

Introduction
You can use the WinCC WebNavigator option of WinCC Runtime Professional V11 to monitor 
and control your WinCC project via the Intranet/Internet. This enables you to quickly and easily 
implement a new type of distribution of controlling and monitoring functions of your automation 
system. WebNavigator supports current Internet security methods.

The "WebNavigator" add-on package consists of the following components:

● WinCC WebNavigator Server

● WinCC Web Configurator

● WinCC WebNavigator Client

● WinCCViewerRT

WinCC WebNavigator Server
The WebNavigator server is installed on a PC along with WinCC Runtime Professional. The 
required WinCC screens and functions that are displayed on the WinCC WebNavigator Client 
are stored on the server PC. 

WinCC Web Configurator
The WebNavigator Server needs the Microsoft Internet Information Service (IIS) for 
communication with the WebNavigator Clients. The IIS is set up and managed with the WinCC 
Web Configurator. Accesses of the WebNavigator Client are governed via user administration. 
You can set a different start screen and language for every user. By assigning user 
authorizations, a scalable access to different project areas and functions is implemented for 
the various users.

WinCC WebNavigator Client
The WebNavigator Client is started via the MS Internet Explorer with activated ActiveX 
controls. You control and monitor a running WinCC project without the entire WinCC basic 
system on the PC.

WinCCViewerRT
Instead of the Internet Explorer, you use the Web viewer "WinCCViewerRT" to visualize the 
WinCC project.
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WebNavigator diagnostics client
You can use the diagnostics client, for example, for the maintenance of several WebNavigator 
server.

Licensing
Licensing is managed centrally on the WebNavigator Server in accordance with the number 
of concurrent accesses of 3, 10, 25, 50, 100 or 150 WebNavigator Clients, for example. A 
license is not required on the WebNavigator Clients.

Web Navigator Server on the WinCC server

Structure  
WinCC RT Professional and the server components of the WebNavigator are installed on a 
PC. The WebNavigator client can control and/or monitor the current server project both via the 
Internet and the Intranet. 

To protect against attacks from the Internet, two firewalls are employed. The first firewall 
protects the WebNavigator Server from Internet attacks. The second firewall provides 
additional security for the Intranet.
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WebNavigator diagnostics client

Introduction
The WebNavigator diagnostics client enables cost-effective access to several WebNavigator 
Servers. 

Several diagnostics clients and standard clients can be in operation at the same time. This 
procedure does not demand an additional license for a WebNavigator Server because 
licensing is handled on the diagnostics client. The diagnostics client can always access the 
WebNavigator server, regardless of whether the maximum number of simultaneous accesses 
has been reached. The diagnostics client always has guaranteed access to the WebNavigator 
server.

Possible applications:

● Remote maintenance: With the Diagnostics Client, different WinCC systems are accessed 
for service and maintenance purposes.

● Central Control Room: The diagnostics client is used for simultaneous access to several 
servers.

Diagnostics client

WinCC / WebNavigator Server

WinCCViewerRT

Overview   
Don't use Internet Explorer to run the "WinCCViewerRT.exe" application. Run it on the 
WebNavigator client instead. The WinCCViewerRT is installed along with the WebNavigator 
client.

WinCCViewerRT uses its own communication to access the WebNavigator server. This 
prevents Internet users from accessing the system and protects the system against viruses 
and Trojan horses. 
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Only the screens which are configured for Web access and published on the WebNavigator 
server are displayed. Users can operate and monitor the project, depending on their 
authorizations.

A user assigned authorization 1002 "DataMonitor - Monitor only" is only allowed to monitor the 
project. The WebNavigator client is therefore a so-called "View Only Client". 

The mouse cursor is a so-called "View Only Cursor" which indicates that process-relevant 
operator input is not possible. Certain operations are still possible, such as opening the 
properties dialog of an online trend control. 

You can also use WinCCViewerRT as terminal server application. For more information, refer 
to "Setting up terminal services for WebNavigator servers".

Terminal services and Web Navigator

Introduction
Terminal services in the Windows Server operating systems enable access to the desktop of 
a Windows server. 

The terminal client only handles screen output, while the application runs on the terminal 
server, for example WinCCViewerRT.

The terminal services transmit only the user interface of the application to the clients. Each 
client's keyboard inputs and mouse operations are returned back to the server.

This behavior has the following advantages:

● Use of rugged hardware for the clients, for example without fans and hard drives, for 
application in dusty environments.

● Use of mobile clients with limited power consumption, for example handhelds, palmtops, 
PDA.

● All applications are located on the server in a secure environment.

● Easy, central administration and system maintenance.

● Support of different operating systems, for example Windows CE, Windows 95.
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The WebNavigator client created based on a "THIN²" architecture, i.e. the application running 
in multiple instances on the terminal server, e.g. WinCCViewerRT, is itself already "thin" with 
regard to hardware requirements.

For redundant system configurations with terminal services, please consult the corresponding 
Microsoft documentation.

 

 Note

The terminal client supports only 256 colors.

To reduce the strain on the terminal service, avoid large bitmaps whose size can change 
("live video"). 

 

9.15.4.2 Installing WebNavigator

Software and hardware requirements

Introduction            
This section describes the hardware and operating system requirements for WinCC 
WebNavigator. 

WebNavigator Server on a WinCC single-user system 

Table 9-31 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GB 2 GB

Table 9-32 Software

Operating system: Windows XP Professional SP3 (max. 3 clients) 
Windows 7 Professional, Enterprise, Ultimate (max. 3 clients)
Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2

Software: Internet Explorer as of V6.0 SP2
WinCC V11 Runtime

Miscellaneous: Access to the intranet/Internet 
or TCP/IP connection to the WebNavigator Client 
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WebNavigator Server on the WinCC server

Table 9-33 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GB 2 GB

Table 9-34 Software

Operating system: Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2

Software: Internet Explorer as of V6.0 SP2
WinCC Professional V11

Miscellaneous: Access to the Intranet / Internet
If you publish in the intranet, you need a system for name resolution, 
which can convert computer names into IP addresses. This allows 
users to use alias name instead of IP addresses when connecting to 
the server.
If you publish on the Internet, you need a DNS registry for the IP 
address. This allows users to use alias name instead of IP addresses 
when connecting to the server.

WebNavigator Client

Table 9-35 Hardware

 Minimum Recommended
CPU Pentium II; 300 MHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 256 MB 1 GB

Table 9-36 Software 

Operating system: Windows XP Professional SP3 
Windows 7 (Professional, Enterprise, Ultimate)
Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2
Other operating systems such as WinCE, Win95 via MS Terminal Services
Embedded XP in connection with Panel PC 477

Software: Internet Explorer as of V6.0 SP2
Miscellaneous: Access to the intranet/Internet 

or TCP/IP connection to the WebNavigator Server 

The use of the WebNavigator Client via WLAN is only authorized for the SIMATIC Mobile Panel 
PC 12".
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Web diagnostics client

Table 9-37 Software

Operating system: Windows XP Professional SP3 
Windows 7 (Professional, Enterprise, Ultimate)
Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2

Software: Internet Explorer as of V6.0 SP2
Miscellaneous: Access to the Intranet / Internet

Licensing

WebNavigator Client       
No license is required with server-end licensing on the WebNavigator Server on the PC with 
the WebNavigator Client. 

WebNavigator Server
The WebNavigator Server runs without a license in Demo mode for 30 days.
A license is required, however, if you want to use the WebNavigator Server for a longer period. 
Licenses are available for 3, 10, 25, 50, 100 and 150 clients that can simultaneously access 
the WebNavigator Server. 

If the number of licensed clients is exceeded during a logon attempt of a Web Navigator client, 
a message appears. No further logon is allowed.

Overview of licenses on the server and client

Server WebNavigator Client Diagnostics client
WebNavigator Server license + 
WinCC license

Web Navigator client, no local 
license.
Maximum number of clients 
corresponds to the existing 
license on the server.

Diagnose client 
One license per diagnostics 
client

Web diagnostics server license + 
WinCC license

WebNavigator Client in Demo 
mode
Number unlimited
Valid for 30 days

Diagnose client 
One license per diagnostics 
client

No WebNavigator license or 
no WinCC license

WebNavigator Client in Demo 
mode
Number unlimited
Valid for 30 days

Diagnostics client in Demo 
Modus
Number unlimited
Valid for 30 days
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Restarting the Web client after changing licenses
If you change the WebNavigator licenses on the Web Navigator server, for example, by 
transferring a Powerpack, you must restart the Web viewer or Internet Explorer, if it used, on 
all connected WebNavigator Clients. Otherwise, the WebNavigator Client goes to Demo mode. 
This also applies to automatic reconnection of the WebNavigator Client.

Web diagnostics client
A diagnostics client license is required on the client PC for the diagnostics client. The 
diagnostics client can simultaneously access up to 12 WebNavigator Servers. 

When a license for WebNavigator Server or Web diagnostics server is installed on the server, 
the diagnostics client also has access even when the maximum number of clients is exceeded.

Web diagnostics server
This license allows the diagnostics Web client to access the WebNavigator Server when no 
WebNavigator Server license is installed on the Web Navigator server for the WebNavigator 
Client.

A total of 50 clients per server is allowed at the most for simultaneous access by diagnostics 
clients.

 

 Note
Diagnostics client without corresponding license

If you install the diagnostics client without its license, a message appears approximately 1 
hour after each start of the PC. Install the diagnostics client license or remove the diagnostics 
client software.
PC with WinCC Runtime Professional and diagnostics client

If you install a diagnostics client on a PC with WinCC Runtime Professional, you have to 
reinstall the diagnostics client after removing WinCC.

 

Requirements for the Use of Terminal Services
WebNavigator Client is authorized for use with Windows Terminal Services. A maximum of 25 
sessions per terminal server are permitted.   

Terminal server

Table 9-38 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GB > 1 GB
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Table 9-39 Software

Operating system Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2:
It must be possible to open and execute applications that are run on 
the clients multiple times.

Miscellaneous: If numerous users want to access the server, you need to use a high 
performance network adapter. 

 
 

 Note

The memory requirements and processor load increased with each terminal client. You 
therefore need to ensure that the terminal server has adequate memory and processor load 
reserves. 

 

Terminal client

Minimum requirement: Network adapter with TCP/IP
Terminal client RDP 5.0
Display or screen
Pointing device

Device recommended for use as a client: SIMATIC Mobile Panel PC 12".
 

 Note

As is the case with Windows Server Client Access License CAL, there are two different 
terminal service CALs:
● The TS Device CAL permits one device user-independent Windows sessions on a 

Windows server.
● The TS User CAL permits one user device-independent Windows sessions on a Windows 

server.

A Windows Server Terminal Server "TS CAL" is required for every user or every device.

Please go to "http://www.microsoft.com/resources/sam/lic_cal.mspx" for more information.
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Installation of WebNavigator server

Overview

Requirements
● The software requirements in regard to the Windows operating system apply.

The following operating systems have been authorized: 
Windows XP Professional SP3 
Windows 7 (Professional, Enterprise, Ultimate)
Windows Server 2003 R2 Standard Edition SP2
Windows Server 2008 Standard Edition SP2

● Local administrator rights

Installation sequence for the WebNavigator Server
When you install a WebNavigator Server on a PC, adhere to the following installation sequence:

1. Install the Internet Information Service (IIS).

2. Install the WebNavigator Server.
To install the WebNavigator Server, you also need to install WinCC Runtime Professional. 
Microsoft SQL Server is automatically installed.

Installing Internet Information Services (IIS)

Settings    
Before installing the WebNavigator Server, you need to install the Internet Information Service 
(IIS). You specify the settings for the WebNavigator Server during installation.

Activate the following settings under Windows 7 or Windows Server 2008:

● Web Management Tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– IIS compatibility to IIS metabasis and IIS 6 management

– Compatibility with WMI for IIS 6

● WWW Services > Shared HTTP Features:

– Standard document

– Static content
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● WWW services > Application development features:

– ASP

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Request filter

– Standard authentication
 

  Note

If the logging functions are active with IIS, the log files must be monitored and deleted, 
if necessary. The event views should be configured so that the log files do not become 
too large.

 

Requirements
● Administrator rights

● Write access for the registration database

Procedure
1. Open the dialog for the activation of Windows features from the Windows 7 Control Panel. 

In Windows Server 2008, use the settings for the server manager. For detailed information, 
refer to the help of the operating system.

2. In the settings for the Internet Information Services, enable the settings described above.

3. Close the dialog with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Alternative procedure
You can also use the command line "Start > Run > cmd" to install the IIS components located 
on the installation CD:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
RequestFiltering;IIS-StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-
ASP;IIS-ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-
WindowsAuthentication;IIS-ManagementConsole;IIS-ManagementService;IIS-
IIS6ManagementCompatibility;IIS-Metabase;IIS-WMICompatibility

Installing the WebNavigator Server

Requirements   
● Local administrator rights

● Internet Information Service is installed.
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Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.

6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Select the following components for installation:

– WinCC Runtime Professional

– WebNavigator Server

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".
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13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".

Result
WinCC Runtime Professional and the WebNavigator Server are installed.

Installation of WebNavigator client

Installing the WebNavigator Client

Introduction     
You can install the WebNavigator Client as follows: 

● Installation from the WinCC Runtime Professional Product DVD.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via Intranet/Internet.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation without user interaction:

– With the Windows user rights of the current user

– Or using group policy based software distribution in networks

You can also install the WebNavigator Client additionally on the WebNavigator server . This 
is useful, for example, if you want to check your WinCC project locally on the server in the 
Internet Explorer.

WinCCViewerRT
The "WinCCViewerRT" web viewer is installed together with the WebNavigator Client.
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Procedure
1. Entry and check of the settings of the client computer in Internet Explorer.

2. Installation of the WebNavigator Client.
 

  Note

When you install from the DVD or through group policy based software distribution, you 
can upgrade an older version of the WebNavigator Client directly without removal.
If you install Web Navigator Server on a computer after the WebNavigator Client, you 
need to reinstall the client.

 

 
 NOTICE

Plug-in reinstallation

With the installation of WebNavigator Client V11.0, the "User Archive Control", "Function 
Trend Control", "Hardcopy" and "Web Client" plug-ins are already integrated in the client. 
If the WebNavigator Client V11.0 is connected to a WebNavigator Server V11.0, these 
plug-ins available for installation in the download section of the Web navigation interface. 
The plug-ins are already installed, do not re-install them.

 

Information on setup and installation of the WebNavigator Client:
● Before installing a new version on the WebNavigator client via a download, check the 

languages installed on the client and connected server. After installing the client via 
download, only the languages of the linked server are available on the client computer.

● The setup of the WebNavigator Client is interrupted with the error message "WinCC Active" 
if the local WinCC project is open or has been opened since the PC was last restarted. 
Restart the computer. Check if WinCC has been entered in the Autostart directory. Remove 
the item, if required, and then reboot the computer to run the WebNavigator Client 
installation.

● At least 70 MB free disk space must be available on the local hard drive to install the 
WebNavigator Client. Otherwise, the installation aborts with a message.

● When installing the WebNavigator Client by downloading it from the Intranet/Internet, you 
can select between "Open" and "Save" for the Setup file. If you install plug-ins or ActiveX 
controls at a later time, you need to select the procedure used for installing the 
WebNavigator Client the first time. Otherwise, the error message "Error 1316" of the "MSI 
Installer" service appears.

● Under Windows XP, you can accelerate the installation of the WebNavigator Client by 
disabling the setting "Search Automatically for Network Files and Printers" before you 
commence installation. Open the "Folder Options" dialog using the menu item "Tools > 
Folder Options" in Windows Explorer. Disable the option under "Files and folders" option 
in the "View" tab. Then click "Apply to All".

● In the download area of the Web Navigation user interface, the Plug-Ins which can be 
installed are displayed. At least the same minimum user rights are required as for 
installation of the WebNavigator Client to install this plug-in. If you select a plug-in in the 
Web Navigation user interface, the WebNavigator Client Setup starts. You have to confirm 
the selected plug-in again.
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Installing the WebNavigator Client under Windows Server
You cannot install the WebNavigator Client under Windows Server with user rights lower than 
"Administrator" with the default setting for group policies. 
In the group policies, release the installation of WebNavigator Client by

● Assigning and publishing the software

● Or, under "Administrative Templates / Windows Components / Windows Installer", enabling 
the setting "Always install with elevated privileges". You must activate "Never" for the 
"Disable Windows Installer" option.

User rights, user groups and optional installation possibilities

Windows user rights required for installation and initial registration of the WebNavigator client
"Administrator" rights are required to install the WebNavigator client via Intranet/Internet or 
using the WinCC Runtime Professional Product DVD. For the initial registration of the client 
on the WebNavigator server, you need to use the same name as that used during installation 
and must log on with the same or higher Windows user rights. The connections must be 
established successfully. All subsequent logons can then be performed by users with different 
Windows user rights, which may be more restricted. 

Installing the WebNavigator client with restricted user rights
With the employed MSI technology, you can also install the WebNavigator client with restricted 
Windows user rights. This procedure can be set during the installation using the group policy 
based software distribution in networks.

The add-ons and plug-ins for the WebNavigator client can also be installed this way.

Installation for a configured group of users or computers
Using the Microsoft Systems Management server or group policy on a Domain Controller, it is 
possible to install a group of users or computers configured by the Administrator.

● For this the MSI file "WinCCWebNavigatorClient.msi" is published at the Domain Controller 
and enabled for a user group. Then, depending on the configuration of the group policy 
based software distribution, you perform the installation either during logon of the specified 
users or when the computer boots.

● When using a Microsoft Systems Management Server, the installation is configured by the 
administrator, triggered and executed when the relevant computer boots.

Group policy based software distribution
The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with a higher level of rights. This enables you to perform installations for which the Windows 
user is lacking permission. Applications which require installations with a higher-level 
permission are referred to as "privileged installations" in MSI technology. Installation of these 
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applications is possible when a Windows user is assigned the "Always install with elevated 
privileges" permission. 

To use group policy based software distribution, a group policy is created on the domain 
controller. The software to be distributed is assigned or published using the active directory . 

● Assignment: The software distribution can be assigned to a user or a computer. The 
software to be distributed is automatically installed when the user logs on or computer boots.

● Publication: The software distribution can be published for single users. When the user logs 
onto the client computer, the software to be distributed appears in a dialog and can be 
selected for installation.

Installation without user interaction
During installation of the WebNavigator client, the user is normally prompted to enter 
information, for examples, about the components to be installed. By implementing a 
configuration file, installation is possible without user interaction. The required path 
specification and user information are provided in the "options.ini" configuration file. The file 
must be in the same folder as the WebNavigator client Setup. 
This installation procedure is advantageous when using the group policy based software 
distribution. 

Installation from the product DVD requires user interaction. 

The settings given predefined in the table are used under the following conditions: 

● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the client registry, for example, due to another SIMATIC HMI product installed.

● Alternatively, the installation is performed via the group policy based software distribution 
with assignment to the computer.

Information Parameters
Target directory for the WebNavigator client INSTALLDIR=" <syspath1>\Siemens\Automation

\SCADA-RT_V11\WinCC\WebNavigator"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameter is derived from the setting in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion":

●  "<syspath1>" corresponds to the key "ProgramFilesDir" e.g. "C:\\Program Files"

●  "<syspath2>" corresponds to the key "CommonFilesDir", e.g. "C:\\Program Files\\Common 
Files"

Example of a "options.ini" configuration file for Windows 7
 
[USERINFO]
USER=Integration 
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COMPANYNAME=Siemens AG
 
[INSTALLPATH]
COMMONDIR="C:\Program Files\Common Files\Siemens"
INSTALLDIR="C:\Program Files\Siemens\Automation\SCADA-RT_V11\WinCC
\WebNavigator"
 
[FEATURES]
FUNCTIONTRENDCONTROL=0
HARDCOPY=0
WINCCUSERARCHIVES=0
DEU=0
FRA=0
ITA=0
ESP=0

Internet Explorer Settings

Introduction    
To have the full functionality available on the WebNavigator client, you need to adapt the 
security settings in Internet Explorer. 
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Procedure
1. Click "Tools" > "Internet Options" in the Internet Explorer.

2. Select the "Security" tab. Select the corresponding zone, e.g. "Local Intranet" or "Internet".
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3. Click "Custom Level".

4. Select the options "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls".

5. Select the "Active Scripting" option under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Select the "Trusted Sites" icon. Open the "Trusted Sites" with the "Sites" button.

8. Enter the address of the WebNavigator server in the "Add this Website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com". If necessary, clear the "Require server verification for all sites in this zone 
(https:) check box. Click "Add". Click "Close".

9. Select the "Trusted Sites" icon. Click the "Standard level" button and then the "Custom 
Level" button. Activate the "Activate" option under "Initialize and script ActiveX controls not 
marked as safe". Click "OK".

10.Click on the "General" tab. Click on the "Settings" button in the "Browser History" area . 
Select the "Automatic" option under "Check for newer versions of stored pages". Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".
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Installation from the DVD

Requirements   
● The information provided in Auto-Hotspot applies to the installation and use of the 

WebNavigator client.

● Minimum user rights are required to install the WebNavigator Client depending on the 
operating system, see Auto-Hotspot.

Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.

6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Open the program group "SIMATIC WinCC Web Navigator" and select the "Web Navigator 
Client" component.

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".
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13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".

Result
The WebNavigator Client is installed and has been added as a function in the navigation 
window of the WinCC Explorer.

Installation via the Intranet/Internet

Requirements   
● The information provided in Auto-Hotspot applies to the installation and use of the 

WebNavigator client.

● Minimum user rights are required to install the WebNavigator Client depending on the 
operating system, see Auto-Hotspot.

● WebNavigator Server must be installed on a computer. The Internet Information Server 
must be configured with the WinCC Web Configurator. Users must be registered in the 
WinCC User Administrator. The WinCC project must be in runtime.

Procedure
1. Enter the address "http://www.servername" for the WebNavigator Server in the address 

bar of Internet Explorer. When installing in a virtual directory, the address can be as follows: 
"http:// www.servername/WebNavigator/".

2. Enter the user name and the password.
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3. If you are accessing the WebNavigator Server for the first time, you will be prompted to 
install the WebNavigator Client. Click the "Click here to install" link. Click the "Save" button 
in the "File Download" dialog to store the client setup on the target computer. It is 
recommended to save the Setup file because, in the event of a restart of the client computer 
being necessary, the Setup need not be downloaded again.

 

  Note

If you want to install a more current version for an existing WebNavigator client via the 
Intranet/Internet, go directly to the client setup. You do not need to save the installation 
file on the target computer. If you want to save the new installation file, remove the old 
installation file. Or save the new version of the file in another directory.

 

4. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in 
which you saved the setup file. Start Setup by double-clicking the file.

5. Follow the instructions on the screen and enter the information and settings necessary. 
The client-end controls of the WebNavigator are installed. Close the Setup dialog.

Result
When the installation is completed successfully, the WebNavigator client switches to the 
WinCC project currently in runtime. 

Installing the Web Diagnostics Client

Introduction   
The software for the Web Diagnostics Client is installed from the WinCC Runtime Professional 
Product DVD on the client computer.

Requirements
● To do this, you must have administrator rights.

Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.
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6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Open the program group "SIMATIC WinCC Web Navigator" and select the "Diagnostics 
Client" component.

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".

13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".
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Result
1. The Web Diagnostics Client is installed.

9.15.4.3 Configuring the Web Navigator system

Overview of configuration steps

Requirement   
● The server PC and client PC are interconnected via TCP/IP.

● On the server PC

– Internet Information Service is installed.

– The WebNavigator server is installed.

– A license key is installed.

– WinCC Runtime Professional is installed.

● On the client PC

– Internet Explorer V 6.0 SP2 or higher is installed.

or

– WinCCViewerRT is installed.

Basic procedure
The following configurations are required to set up a WebNavigator system:

1. Configure the WinCC project in the TIA Portal. For more information about the TIA Portal, 
refer to "Getting started with the TIA Portal"

– Configure WinCC screens for Web access.

– Create users for WebNavigator client access

– Observe restrictions

– Compiling a project

2. Transfer your WinCC project to the server PC. If the configuration PC and the WebNavigator 
server are interconnected, transfer the WinCC project using the command "Load to device 
> Software (all)". 

3. Configure the WebNavigator Web page on the WebNavigator server.

4. Operate the WinCC project.

– Using WinCCViewerRT

– Using Internet Explorer
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Configuring a WinCC project

Configuring WinCC screens for Web access

Configuring individual WinCC screens for Web access 
1. Double-click the desired screen in the project tree. The screen is opened and the screen 

properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Web access".

or

1. select the desired screen in the project tree.

2. Select "Web access" command in the shortcut menu.

Configuring several screens for Web access
1. Select "Screens" in the project tree.

2. Select the "Web access for all" command in the shortcut menu.

Result
The WinCC screens are configured for Web access. During compilation of the project, the 
WinCC screens are adapted for access via the Intranet/Internet and published on the 
WebNavigator server.

For more information, refer to "Transferring a WinCC project (Page 2579)".

See also
Transferring a WinCC project (Page 2579)

WinCC screens as a gadget

Gadget on the Web Navigator Server

Introduction
Using the "Preview" property, you define which screens to group in a gadget. Gadgets are mini 
applications for the Windows sidebar. In order to use gadgets, a WebNavigator client must 
always be installed as well on the WebNavigator server.    

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2
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Procedure
To configure WinCC screens as a gadget, proceed as follows:

1. Double-click the desired screen in the project tree. The screen is opened and the screen 
properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web Access".

3. Activate "Preview" and "Web access".

4. Save the WinCC project.

5. Select the "Compile > Software" command in the shortcut menu of the HMI device.

Result
The screens are assembled for the gadget on the WebNavigator server. As soon as the project 
is in runtime, the WebNavigator server generates a jpg snapshot image "pdlImage.jpg" of each 
screen at cyclic intervals and in consecutive order. 

The file is stored in the directory "\WinCC\Webnavigator\Server\Web\image\_gadget". The 
gadget accesses this file cyclically.

Note that user interactions are not possible in the screens displayed. This includes, for 
example, calls from login dialogs or notice dialogs via functions.

The following objects are not supported for the display in a gadget:

● GSC diagnostics window

● Media Player
 

  Note

The WinCC project shown in the gadget cannot be operated.
 

Gadget on the Web Navigator Client

Introduction
In order to use gadgets, a WebNavigator client must always be installed as well on the 
WebNavigator server. A preconfigured gadget for displaying WinCC screens is located on the 
WebNavigator client in the installation directory under "\WinCC\Webnavigator\GADGET".     

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Requirement
The screens are published on the WebNavigator server and configured as "Preview".
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Procedure
To access the gadget with the WebNavigator client, proceed as follows:

1. Double-click on the "_WebNavigator.gadget" gadget in the installation directory under 
"\WinCC\Webnavigator\GADGET". IN Windows 7 / Windows 2008, the gadget is installed 
in the sidebar.

2. Define the update cycle in which the gadget loads a screen from the WebNavigator server, 
every 17 seconds for example.

3. Enter the address of the WebNavigator server. The gadget establishes a connection to the 
WebNavigator server.

4. If necessary, drag-and-drop the gadget onto the desktop.

Configuring runtime settings (WebNavigator)

Introduction  
You can configure the behavior in runtime in the "Runtime settings" editor. 

Procedure
1. Open the "Runtime settings > Web access" editor.

2. To use the "WinCC Classic" design, activate "Use "WinCC-classic" design".

3. To use your own cursor as a "View only cursor", enter the path and file name of the cursor 
at "Cursor "View only". Alternatively, navigate to the file of the desired cursor using the "…" 
button.

4. To change the maximum number of concurrent connections, enter the desired number in 
the "Count of concurrent connections" field.
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5. To change the maximum number of open tabs in the browser, enter a suitable value in the 
"Number of tabs per browser" field. Internet Explorer V7 or higher supports this setting.

 

  Note
Server load settings

Each tab that calls the server homepage uses a license on the server PC. A connection 
setting of "10" and a tab setting of  "2" corresponds to 20 clients. A license for at least 20 
clients must be available on the server PC.

 

6. Define whether the local user group is disabled on the WebNavigator Server.

7. To output an appropriate system message when a WebNavigator logs on and off, activate 
"Enable event log messages".

Result
The settings for Runtime are configured. 

See also
Operating a WinCC project (Page 2594)

Setting up WinCCViewerRT (Page 2592)

Managing users for the Web Navigator Client

Administration of users for the WebNavigator client

Introduction
For every user, a different start screen and also any language can be set. This allows you to 
make various sections of a project immediately accessible or inaccessible for users.

Requirements
● The "Users" work area is open.

● The user "Foreman" has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu with the right mouse button and activate the display of the "Start 
screen" and "Language" columns.
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3. Click the  button in the line of the "Foreman" user in the "Start screen" column. A dialog 
box for selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Language" column. A dialog box for selecting the language opens.

7. Select the runtime language.

As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another one. The 
start screen will be overwritten.

 

Administration of user groups for the WebNavigator client

Introduction
A different start screen and also any language can be set for every user group.  This allows 
you to make various sections of a project immediately accessible or inaccessible for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Procedure
1. Position the mouse cursor on the title bar of the "Groups" table.

2. Open the shortcut menu with the right mouse button and activate the display of the "Start 
screen" and "Language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "Web operators" as the name of the user group.

5. Click the  button in the "Start screen" column. A dialog box for selecting the start screen 
opens.
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6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Language" column. A dialog box for selecting the language opens.

9. Select the runtime language.

As an alternative, select the user group in the work area; the properties of the user group are 
then displayed in the Inspector window. 

In the Inspector window, select "Properties > Properties > Web options". 

Select the start screen and the language.
 

 Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 

 

 

Limitations

Introduction 
You can use your projects already created with WinCC to also make them available via the 
Internet/ Intranet.

Essentially, the step consists in publishing the already created WinCC screens and using user 
administration to set up Web users. 

The current version of the Web Navigator has a number of restrictions with regard to 
functionality, and as a "thin client" solution does not support all the functions offered by a 
standard WinCC basic system. 

You may therefore have to check your existing WinCC projects for these restrictions and if 
applicable, adapt them.

Functionality restrictions
When using non-supported functions, the user will be informed of this in Runtime with plain 
text messages.

● The Web Navigator Client only offers the view of a running WinCC project. A configuration 
of the WinCC Server projects via the Web Navigator Client is not possible.

● Only those WinCC option packages/add-ons can run on the Web Navigator Client, whose 
documentation expressly states that.

● Not all Runtime API functions are supported on the Web Navigator Client. A list of the 
functions supported is provided in the Appendix.

● Nearly all the PCS7 options are supported. A list of the options that are not supported is 
provided in the Appendix.
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● The "Reports" editor is an integrated reporting system of WinCC for the time-triggered or 
event-triggered documentation of alarm messages, operations and log contents. This 
reporting system is not supported via the Intranet/Internet. Thus, the output of reports is, 
for example, only possible on the Web Navigator Server and WinCC client.

● No separate logging system is running on the Web Navigator Client. The message log and 
message system can only be operated and monitored.

● C functions are created and executed in the project of the WinCC server. Functions cannot 
run on the Web Navigator Client. 

● If VB functions are used, there are only minor restrictions due to non-supported functions. 
If non-supported functions are used in a VB function, an alarm is output.

Transferring a WinCC project

Requirement     
● A WinCC project is configured

● WebNavigator server is installed on the server PC.

● The configuration PC and server PC are interconnected.

Online transfer
Transfer the WinCC project using the command "Load to device > Software (all)". The project 
is compiled prior to the download. The screens are adapted for access via Intranet/Internet 
during compilation. 

During the download to the server PC, the configured WinCC project is transferred and the 
screens are published on the WebNavigator server. For more information, refer to "Compiling 
and loading (Page 2206)".

See also
Configuring WinCC screens for Web access (Page 2573)

Configuring the Web Navigator Server

Setting up the Web Navigator Web site

WinCC Web Configurator

Introduction
The Internet Information Service (IIS) is set up and managed with the WinCC Web Configurator.
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Requirement
● WebNavigator Server is installed.

● Internet Information Service is installed.

Starting WinCC Web Configurator:
In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools > 
HMI Tools" > WinCC Web Configurator".

Initial configuration with the WinCC Web Configurator 
During the initial configuration, you specify whether you want to create a new default Web site 
or a new virtual folder. 

● If you only wish to operate the WinCC WebNavigator Web site on your server, activate the 
option "Create a new standard Web site (stand-alone)".

● If the WinCC WebNavigator Web site is to be added as a subdirectory to your existing Web, 
activate the option "Add to an existing Web site (virtual folder)".
This option is necessary if the previous default Web site must remain active or if the 
operating system supports only the operation of one website.

Configuration management with the WinCC Web Configurator
If the IIS is already configured, change the settings of the existing Web server or virtual directory 
with the WinCC Web Configurator.
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The Web Configurator automatically detects whether a configuration already exists. If a 
configuration already exists, the dialog for changing the configuration opens.

 

 Note

When you delete the Web directory, restart the PC before creating a new Web directory with 
the WinCC Web Configurator.

Note the following:

When you change the Web directory and your Web communication is then no longer 
established, the Web Configurator attempts to automatically adjust the settings correctly.

If this does not work, delete the Web directory from the IIS. Restart the PC and create a new 
Web directory with the Web Configurator.

 

Creating a New Standard Web site (Stand-Alone)

Requirement     
● WinCC WebNavigator is installed.

● Internet Information Service is installed

● WinCC Web Configurator is started
 

  Note

If you have any questions or experience problems with the following settings, contact your 
Intranet/Internet administrator.
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Procedure
Proceed as follows to create a standard Web site:

1. Select "Create a new standard Web site (stand-alone)" and click "Next".

2. Enter the name of your Web site in the "Name of the Web site" field.

3. In the "Port" field, enter the port number used for access.

4. In the "IP address" field specify whether the PC is to be reached in the Intranet, Internet or 
in both networks. Only use addresses from the selection list.
If you want to make your PC accessible via the Intranet and the Internet, select "All not 
assigned".

5. Define the standard Web site that is displayed after selecting the Web server on the 
WebNavigator Client

– MainControl.asp
Starts the WinCC Navigation interface. You need the navigation interface, for example, 
for download installation.

– WebClient.asp
Opens the start screen configured in user administration after login.

6. Define the time interval after which the WebNavigator Clients automatically start to establish 
a connection following a connection breakdown. If "0 s" is set, the "Automatic connection 
establishment" function is disabled.

7. Define the way the Web site is started after configuration.

8. If you have not activated a firewall, click "Finish". If you have installed a firewall, click "Next".
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Result
The Web directory has been created and the Web page is activated. If you have activated the 
firewall, configure the firewall settings with the Web Configurator. For further information, refer 
to "Setting up a firewall (Page 2585)".

See also
Setting up a firewall (Page 2585)

Creating a virtual folder

Requirement     
● Internet Information Service is installed

● WinCC WebNavigator is installed.

● WinCC Web Configurator is started
 

  Note

If you have any questions or experience problems with the following settings, contact your 
Intranet/Internet administrator.

 

Procedure
Proceed as follows to create a virtual directory:

1. Select "Add to an existing Web site (virtual folder)". Click "Browse."

2. In the following dialog, select the active Web site to which the virtual directory is to be added.
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3. Click "OK" to close the dialog box. Click the "Next" button in the following dialog.

4. Enter the name of your Web site in the "Name of the Web site" field.

5. The WinCC Web Configurator takes the IIS settings for the port number and IP address.

6. Define the standard Web site that is displayed after selecting the Web server on the 
WebNavigator Client.

– MainControl.asp
Starts the WinCC Navigation interface. You need the navigation interface, for example, 
for download installation.

– WebClient.asp
Opens the start screen configured in user administration after logon.

7. Define the time interval after which the WebNavigator Clients automatically start to establish 
a connection following a connection breakdown. If "0 s" is set, the "Automatic connection 
establishment" function is disabled.

8. Define the way the Web site is started after configuration.

9. Click "Finish" to complete the configuration.

Result
The virtual Web directory has been created and the Web site is activated. To access the Web 
site, with the WebNavigator Client, add the name of the virtual Web directory to the URL, for 
example http://WebServer/WebNavigator.
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No Active Website
If no active Web is found, the WinCC Web Configurator terminates with a message.

Click "OK" to close the dialog box.

To execute the Web Configurator again, first activate a Web site. For additional information, 
refer to "Checking of Activated Web site".

See also
Setting up a firewall (Page 2585)

Setting up a firewall

Setting up a firewall in Windows XP / Windows 2003

Introduction
This chapter describes only the activation of the "HTTP" and "HTTPS" services in Windows 
XP or Windows 2003.

To set up the Windows firewall for a different port, contact your network administrator.

Requirements
● You have created a standard Web site with the Web Configurator.

● The firewall is activated.

● A logged-in Windows user has administrator rights
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Procedure with a standard port
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.
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3. Click the "Advanced" tab. Select the network connection and click the "Settings..."button.
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4. The "Advanced Settings" dialog is opened.

5. Activate "Secure Web Server (HTTPS)" or "Web Server (HTTP)". To display the current 
service settings of the Web server, click the "Edit" button.

6. Exit the open Windows dialogs with "OK". 

7. Click "Finish" in the Web Configurator.
The configuration of the server will be completed.
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Setting up a firewall in Windows 7 / Windows 2008

Introduction
This chapter describes only the activation of the "HTTP" and "HTTPS" services in Windows 7 
or Windows 2008 via Port 80.

To set up the Windows firewall with advanced security, or for a different port, contact your 
network administrator.

Requirements
● You have created a standard Web site using the Web Configurator.

● The firewall is activated.

● A logged on Windows user has administrator rights

Procedure in Windows 7
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.

3. In Windows 7, click "Allow program or feature in the Windows Firewall".
In Windows 2008, click "Allow communication of a program in the Windows Firewall".

4. Activate "Secure WWW Services (HTTPS)", or "WWW Services (HTTP)".

5. Exit the open Windows dialogs with "OK". 

6. Click "Finish" in the Web Configurator. The configuration of the server will be completed.

Checking the Activated Web Site (Web)
 

 Note

Note that the operating system settings shown depend on the language set for the operating 
system.

 

Procedure in Windows XP / 2003
To check the activated Website in Windows XP / 2003, proceed as follows:

1. In the Start menu, select "Programs" > Administrative Tools > "Internet Information 
Services". The Internet Information Service is opened.

2. Click the plus sign next to the PC name in the "Structure" area.

3. Click the plus sign next to "Web sites". The data window displays the corresponding 
websites.
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4. Check the information displayed for the websites. If "Stopped" is displayed next to the 
desired Web site, e.g. "WebNavigator", start the Web site.

5. To start the Web site, select the "Start" command in the shortcut menu.

6. Select the "Close" command in the "Operation" menu. The Internet Information Service is 
closed. The Web site is activated.

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2590 System Manual, 08/2011,  



Procedure in Windows 7 / 2008
To check the activated Website in Windows 7 / 2008, proceed as follows:

1. In the Start menu, select "Programs" > "Administrative Tools" > "Internet Services Manager".

2. Click the name of the PC in the "Connections" area.

3. Click "Default Web Site".

4. Check the information displayed for the websites. If "Stopped" is displayed next to the 
desired Web site, e.g. "WebNavigator", start the Web site.

5. To start the Web site, select the "Start" command in the shortcut menu.
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9.15.4.4 Operating a WinCC project

Operating projects using WinCCViewerRT

Setting up WinCCViewerRT

Requirement   
● On the server PC

– The WebNavigator server is installed.

– A license key is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

● On the client PC

– WebNavigator client is installed.

Procedure
Set up WinCCViewerRT as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Enter the logon data in the "General" tab:

– Server address: http://<server name>, or http://<IP address>

– User name and password
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3. In the "Parameters" tab, specify the Runtime language and whether to disable keystrokes 
that the operator uses to change to other programs.

4. Define the WinCC Runtime Professional properties in the "Graphics Runtime" tab:

– Start screen

– Configuration file for screen navigation

– Window attributes

– Illegal user actions

5. Specify additional user actions on the "Runtime" tab:

– Automatic logout

– Enable screen keyboard.

– Use <Ctrl+Alt+Del> to switch to the Task Manager and to the operating system. This 
setting is only valid for the on-screen keyboard.

– Open the "WinCCRTViewer" by means of keystroke.
You can change the default keystroke <Ctrl+Alt+P>.

6. Close the dialog with "OK".

Result
WinCCViewerRT is configured. When the dialog is closed, the connection to the WebNavigator 
server is established. The settings are saved to the configuration file "WinCCViewerRT.xml". 
The settings in the configuration file are used at the next start of WinCCViewerRT.

The configuration file is stored in the "Documents and Settings\User\Application Data\Siemens
\Automation\Portal V11\WebNavigator\Client" folder. This allows different configurations to be 
used, depending on the logged on user. WinCCViewerRT applies the interface language from 
WinCC.

WinCCViewerRT.xml Renaming or removing 

When you rename or remove the file WinCCViewerRT.xml, the configuration dialog of 
WinCCViewerRT is opened during the start. Reconfigure WinCCViewerRT, or select a different 
configuration file.

See also
Configuring runtime settings (WebNavigator) (Page 2575)
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Operating a WinCC project

Requirements
● On the server PC:

– The "WinCC WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

– A user is created in WinCC.

● On the client PC

– WinCCViewerRT is configured.

Procedure
To view screens, proceed as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Log on to the WebNavigator server:

– If the user and password are configured in "WinCCViewerRT", no logon dialog displayed.

– If no user and password was configured in "WinCCViewerRT", the logon dialog 
displayed. Enter the user name and the password of the WinCC user. Click "OK."

3. Press the <Ctrl+Alt+P> keystroke to change the user. The "WinCCViewerRT" dialog opens.
Enter the user name and password on the General" tab.
You can also select the xml file that contains this data. 

Result
WinCCViewerRT connects to the selected WinCC project. The start screen configured for the 
user is displayed. Users can operate and monitor the project, depending on their authorizations.

A user assigned authorization no. 1002 "DataMonitor - Monitor only" is only allowed to monitor 
the project.

The cursor is a "View Only Cursor" and indicates that process-related operations are not 
allowed. 

Certain operations are still possible, such as opening the properties dialog of an online trend 
control. 

If necessary, you can use your own cursor as a "View Only Cursor". For more information, 
refer to "Configuring runtime settings (WebNavigator) (Page 2575)".
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Operating projects in Internet Explorer

Operating a WinCC project

Requirements
● WebNavigator client is installed. 

● A user for the WebNavigator Client has been created.

● Internet Explorer V 6.0 SP2 or higher

Procedure
To operate the WinCC project, proceed as follows:

1. Enter the address of the WebNavigator Server in the address bar of Internet Explorer:

– Standard Web site: "http://servername"

– Web site in the virtual directory: "http://servername"

2. Confirm your entry

3. Enter the user name and the password. Confirm your entry.

Result
The standard Web site is displayed. The appearance depends on the configuration.

If "WebClient.asp" is set, the WebNavigator Client starts with the start screen defined in user 
administration. For more information, refer to "Managing users for the Web Navigator Client 
(Page 2576)".

If "MainControl.asp" is set, the WebNavigator client starts with the Web navigation interface. 
For more information, refer to "Working with the Web navigation interface (Page 2596)".

See also
Working with the Web navigation interface (Page 2596)
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Working with the Web navigation interface

Structure

Navigation interface menu
The Web Navigation interface combines various Web functions. The various functions are 
grouped in menus. 

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2596 System Manual, 08/2011,  



● "Change Server" menu:
Change to a different WebNavigator Server or Sm@rtServer.

● Menu of the current server:

– Screens: Display or screen navigation of the current WebNavigator Server.

– Report tools: Installed tools such as "DataWorkbook" for the display and analysis of 
current process values and historic data.

– Analysis tools: Installed tools such as "Dat@View" for the display of log data in tables 
and trends.

– Diagnostics tools: Status.html for diagnosing the WinCC project and the connection to 
the Web Navigation server.

– Additional tools: This can be expanded by the user.

– Download area:
The plug-ins which are stored on the WebNavigator Server in the directory "Install / 
Customize" are available, e.g download of add-ons for WebNavigator.

● "Settings" menu:
Settings for the WebNavigator Client e.g. adaptation of size of screens

● "Current" menu:
Links to Web pages, such as "SIMATIC HMI", "WinCC" or "WinCC flexible".

● "Language" menu:
Changing the language of the navigation interface. The standard version of the program 
includes five languages.

Functions

User logon      
When logging onto the WebNavigator server, the user can determine - through the address 
entered in Internet Explorer - whether he logs on via the Web navigation interface or the start 
page configured in the WinCC project. 

● The address "http://<server_name>/webnavigator" opens the start page configured in the 
User Administrator following the logon.

● The address "http://<server_name>/webnavigator/maincontrol.asp" starts the Web 
navigation interface.

Change of the Server
A different server can be selected via the menu command "Change Server". Enter the address 
of the new WebNavigator server in the upper input box. Examples of possible input formats 
are described under "User Logon". 
In the lower field, a symbolic name can be entered, which is shown in the menu as the current 
WebNavigator server. If the name is not specified, the address of the WebNavigator server is 
displayed.  
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Expansion Options
Menu

The menu of the navigation interface can be expanded by additional menu entries and 
functions, for example, depending on the operational area. An expansion is configured in an 
XML file. The XML file is saved on the WebNavigator server in the subdirectory 
"_custom_data". Further information is available in the topic "Extending the Web Navigation 
User Interface".  

Tools

The menu command "Additional tools" can be expanded by the user to provide additional tools 
on the WebNavigator client.

Plug-Ins

The "Download Plug-Ins" menu command provides plug-ins that have been stored on the 
WebNavigator server in the folder "Install/Customize". In order to display the version name of 
a plug-in, it must have been assigned the format "Vxx.xx.xx.xx" or "xx.xx.xx.xx". 

Languages

Adjustment of language options may be facilitated by adjusting the "Menu.xml" file. The 
languages are stored as CSV files on the WebNavigator server in the folder "_languages / 
<language_identifier>". When adding, these language files have to be referenced in the file 
"maincontrol.asp". 

Diagnosis of the Connections with "Status.html"

Introduction
You can retrieve status information about the WebNavigator server and the WebNavigator 
clients from a WebNavigator server or any WebNavigator client. 

The status information provides you with information about which users access the 
WebNavigator server via which WebNavigator clients. The name of the status page is 
"status.html". The page is displayed in Internet Explorer. 

The status information is displayed in blocks within the HTML page. There is one information 
block for the WebNavigator server and one information block for each connected 
WebNavigator client. The information is only displayed in English.
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Status information
Time specification is in UTC (i.e. minus one hour to CET; minus 2 hours to CEST).

Structure of the Information Block of the WebNavigator server

Field Description
Server Version Displays the version number of the WebNavigator server (build 

no.)
Server File Date reserved
License Count Displays the number of licenses
Runtime Mode Displays the status of Runtime, e.g. activated
Last Update Date and time of the last refresh of the display 
Connected WebNavigator client Number of connected WebNavigator clients 
Connected diagnostic clients Number of connected diagnostic clients 
Connected DataMonitor clients Number of connected DataMonitor clients 
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Structure of the information blocks of the Web Navigator clients

Below the caption "Logged on Users:", the information blocks of the connected clients are 
listed. Each block has the name of the client as a header.

Field Description
Login Login name of the current user
Time Login time of the current user or also time of the most recent automatic 

reconnect. 
Type Type of WebNavigator client, such as Default, Demo, View Only 
PID  Process ID of instance of WebNavigatorRT.exe on the WebNavigator 

server communicating with this WebNavigator client. 

Requirement
● User is created in user administration.

Display "Status.html"
To display the "Status.html", enter the corresponding address in the address bar:

● Standard Web site: "http://www.server_name.de/status.html"

● Web site in the virtual directory: "http://www.server_name.de/WebNavigator/status.html"

Save status information
The displayed status information can be saved. To do this, use the "Save As" menu command 
in Internet Explorer and select "(*.txt)" as the file type.

 If "(*.htm, *.html)" are selected, the contents displayed are not saved.

Use the "Hardcopy" function

Introduction
On the WebNavigator client it is possible to generate a hardcopy of the entire screen, of a 
section, or of the active window.

The hardcopy is output to the default printer by executing the "PrtScr.exe" application.

Requirement
● WebNavigator client is installed.

Starting the hardcopy application
The program is started on the WebNavigator client, for example, using the command input 
line, or a user-defined function.
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The application is saved to the folder "...\Common Files\Siemens\BIN\". The hardcopy is 
triggered depending on the parameters used.

Examples of the command line
"C:\Program Files\Common Files\Siemens\BIN\PrtScr.exe" –infinit –hotkey="<ALT>+p"

Starts PrtScr.exe and waits for the <ALT>+p keystroke. The entire screen is printed when you 
press the keystroke.

Parameters

Parameters Function
-infinit Used as parameter for launching PrtScr.exe on a system without WinCC. 

Always use the parameter in combination with "hotkey".
The print keystroke and output parameters are not determined in the 
WinCC project. They are transferred instead via command line input. The 
PrtScr.exe application is started and waits for the input of the print 
keystroke. The parameters were transferred once during startup. To edit 
these parameters close the PrtScr.exe application. Change the parameters 
and then restart PrtScr.exe . 

-end terminates an active instance of PrtScr.exe 
-hardcopy Starts PrtScr.exe, directly initiates a hard copy, and then waits for the 

keystroke.
Always use the parameters in combination with "infinit" and "hotkey".

-nomcp Starts PrtScr.exe , creates the hardcopy, and closes PrtScr.exe. 
/C= left;top;right;bottom Starts PrtScr, directly triggers a hardcopy of the specified screen area, and 

then ends PrtScr.exe (
-l Prints in landscape format.
-hotkey="x" Specifies the keystroke. 

Valid characters and combinations:
 <ALT>, <SHIFT>,<CTRL> +  {0-9, A-Z, 0xXX}
The hexadecimal notation "0xXX" can be used to specify the "Virtual Key 
Code". For more information on "Virtual-Key Codes", refer to the MSDN 
Library. 

9.15.4.5 Setting up terminal services for Web Navigator

Communication Using Terminal Services

Communication by means of terminal services
To use the WebNavigator Client as a terminal client, do not use a proxy server between the 
terminal server and WebNavigator Server.

If the terminal server and WebNavigator Server are not installed on the same PC, the 
WebNavigator Client cannot access the Web Navigation server via the terminal services. 
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This problem can be solved in various ways: 

● A minimal installation of WinCC without licenses is installed on the terminal server.

● After installing the WebNavigator Client, the file "CCEClient_service.vbs" is executed once 
on the terminal server. The file is located on the WebNavigator product DVD in the 
"\WebNavigator" directory. The Windows user right "Administrators" is required to execute 
the VBS file.

Access from the WebNavigator Client and WinCC clients to the WebNavigator Server
If a WebNavigator Client and a WinCC client access the WebNavigator Server, via terminal 
services in the former case, the WebNavigator Client, as a terminal client, may not open a 
Windows Desktop in its session. 

The following options are available to ensure the Windows desktop is not opened on the 
WebNavigator Client when beginning a session:

● Direct entry in the terminal services configuration for all users.

● Enter Internet Explorer as the start program in computer management for individual users.

For more information, refer to the FAQs on the Internet, contribution ID 17498344. 

Activating terminal services on the Windows server

Requirements
● Windows user with administrator rights

● Windows 2003 Server, Windows Server 2008

Procedure
Proceed as follows to activate terminal services:

1. Open Control Panel and double-click "Software".

2. Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components". The "Windows Components Wizard" opens.

3. Activate "Terminal server" and "Terminal server licensing".

4. Click "Next." Follow the instructions.
 

  Note

Activate the terminal services on the server PC before you install the actual applications. 
Install the applications on the server PC via the "Add or Remove Programs" dialog of the 
Control Panel. If you install the application via the Control Panel, the application can be 
configured for all users. Otherwise, the application can only be used for the user who 
installed the application. 
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Setting Up a User with Access Rights to the Terminal Server

Requirements
The terminal server is installed.

Procedure
To set up a user for access to the terminal server, proceed as follows:

1. Go to "Control Panel > Administrative Tools > Computer Management > Local Users and 
Groups".

2. Select "New User" from the "Users" shortcut menu. The "New User" dialog is opened.

3. Click the "User" icon. Double-click the corresponding user. The user properties dialog 
opens.

4. Click the "Member of" tab. Click "Add". The "Select Group" dialog opens.

5. Add the group "Remote Desktop Users". Click "OK" to close all the open dialogs.

6. Check the membership of the new user in other groups. If required, add the user to a 
corresponding group to ensure that the user is assigned the necessary user rights.

7. Close "Computer Management".

Starting the Terminal Server Application on the Terminal Client

Requirement
● The terminal service on the Windows server is started.

● A user is set up for access to the terminal server.

Procedure
To start an application on the terminal server from the terminal client, proceed as follows:

1. On the terminal client, from the Start menu select the menu command "Programs" > 
Accessories > Communication > Remote Desktop Connection". The "Remote Desktop 
Connection" dialog opens.

2. Enter the name of the terminal server.

3. Click the "Connect" button. Log on as the user who was created for access to the terminal 
server.

Result
The connection is now established. The desktop of the terminal server is displayed. On the 
terminal server, start an application, e.g. the Web Navigator Client via Internet Explorer.
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9.15.4.6 Troubleshooting

No Communication Between Web Navigator Server and Client
If a provider (participating proxy, firewall) has activated Content Filtering for an Internet 
connection, Web Navigator communication is no longer possible. With content filtering, only 
certain contents of HTML pages are permitted. The communication is directed via a defined 
port to a certain IP address, e.g. of the WinCC server.

● You have to deactivate Smart Filtering for the IP address of the Web Navigator Server - as 
there are no viruses or HTML contents on the WinCC Server, filtering is not useful in this 
case.

● If the customer uses SSL technology, the data is transferred in encrypted form. Smart 
Filtering for content is therefore not possible.

Connection Abort
In an Internet environment, aborted connections, delays and communication fluctuations may 
occur.

If the communication between the Web Navigator Client and Web Navigator Server is defect, 
the user receives an alarm on the Web Navigator Client.  

The Web Navigator Client then automatically tries to establish a connection in order to restore 
the connection.

The delay between attempts to establish a connection can be configured with the Web 
Configurator. If the value "0" is set, the Web Navigator Client does not attempt to reconnect 
automatically. In this case a message appears on the web client asking you whether the 
connection is to be reestablished. 

Confirm this query to reestablish the connection.

No Screens are Displayed
Make sure the correct Web site is activated on the PC running the Web Navigator Server. 
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Wrong Start Screen
You have edited a new screen in the "Screens" editor.

● Compile and load the screen on the server PC.

● Delete the temporary Internet files in the Internet Explorer via "Tools" > "Internet Options".

9.15.5 DataMonitor 

9.15.5.1 The basics

DataMonitor

Introduction  
WinCC DataMonitor consists of a server component and a client component. The DataMonitor 
Server makes functions for analyzing and displaying data available to the DataMonitor client. 
Access rights govern access to the functions.

● WinCCViewerRT
Program for monitoring WinCC projects. The DataMonitor client is therefore a so-called 
"View Only Client".

● Excel Workbooks
Display of logged process values in an Excel table for analysis and storage in the Web or 
as a print template for reports

● Published Reports
Creation of reports from WinCC print jobs, or from published Excel worksheets. This allows 
you, for example, to generate statistics and analyses of specific process or history data. 
The reports are saved in PDF format and can be transferred by e-mail.

● WebCenter
Central information portal for access to WinCC data via user-specific views, clearly 
structured WebCenter pages through user groups with individual user rights for reading, 
writing and creating WebCenter pages.

● Trends & Alarms
Serves to display logged process values and alarms. The data is displayed in tables and 
diagrams on predefined WebCenter pages.

Your benefit:
● Display and analysis of current process statuses on office PCs with, for example, MS 

Internet Explorer or MS Excel

● No additional configuration effort, as screens from the WinCC project are used directly.

● Evaluation via centrally administered templates for detailed analyses of corporate 
processes, e.g. reports, statistics
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● Creation of event-driven or time-driven reports

● Information from the process is individually compiled online in runtime (information portal) 
and distributed to various people by e-mail.

● User administration with user groups and individual access authorizations, e.g. read, write, 
and creation of WebCenter pages

WinCCViewerRT

Overview   
The Web Viewer is solely a display program for WinCC projects that is installed using the 
DataMonitor Client. DataMonitor Client is therefore a so-called "View Only Client". 

Don't use Internet Explorer to run the "WinCCViewerRT.exe" application. Run it on the 
DataMonitor client instead. 

The Web Viewer uses its own communication resources to access the DataMonitor server. 
This prevents Internet users from accessing the system and protects the system against 
viruses and Trojan horses. 

Only the screens which are configured for Web access and published on the DataMonitor 
server are displayed.

The WinCC user needs authorization no. 1002 "DataMonitor - Monitor only". The cursor is a 
"View Only Cursor" and indicates that process-related operations are not possible. Certain 
operations are still possible, such as opening the properties dialog of an online trend control.

If the WinCC user is not assigned authorization no. 1002, the DataMonitor Client runs in demo 
mode after logon.

You can also use the WebViewer as terminal services application. For more information, refer 
to "Setting up terminal services for WebNavigator servers".

See also
Configuring runtime settings (DataMonitor) (Page 2615)

WebCenter

Overview   
The WebCenter is the central information portal for access to WinCC data via Intranet/Internet. 

With the help of WebCenter pages and Web parts, the user can arrange and save his view of 
the WinCC data. WebCenter pages are stored in directories.

WebCenter pages are like a construction kit. The form of the construction kit is specified by 
layout templates. Users can use either the supplied or self-created layout templates.

Web parts are the individual building blocks that prepare and display data. Within the 
WebCenter pages, the parameter definitions are stored for the respective Web parts and can 
be called up again at any time. A multiple use of the same web part is also possible with different 
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parameter definitions. The WebCenter pages that have been created in this way can be opened 
by different users with the same parameter definitions depending on the assignment of rights.

To transfer the configuration data to a different computer, copy the corresponding project 
directory:

● ..\WebCenter\App_Data\Webcenter

Web parts
Up to 15 of the following Web objects can be combined into one screen view:

● Static process screens: WinCC screens are integrated into the WebCenter with no 
installation download. A JPG screenshot of the process screen is created on the WinCC/
DataMonitor Server at regular intervals.

● Process values as trend view (trend) or table (timestep): Several process values are 
displayed over a given period of time (compressed using specified functions) graphically 
or in table format.

● Process values in a bar chart or pie chart

● Statistics view

● Trend (timestep) provides a clear representation of precompressed values with the 
aggregate functions: initial value, minimum/maximum over time, sum/average/number over 
time, variance, one/two/three standard deviation(s).

● Alarm view

● Alarm hit list

● Links (Favorites) to internal WebCenter pages and external Internet pages, such as stock 
market news

● Graphics in JPG format: This can be any type of information, such as a product logo, trade 
name, etc.
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● Messages that are displayed at specific times.

● History of the most recently compiled reports with direct selection.

Basic procedure
1. Set up a directory for a WebCenter page (Page 2635)

2. Assign access rights (Page 2636)

3. Establish a connection to the WinCC data (Page 2638)

4. Publish screens for the WebCenter (Page 2646)

5. Create a layout template for WebCenter pages (Page 2648)

6. Create a WebCenter page (Page 2651)

7. Insert Web parts into the WebCenter page (Page 2653)

8. Configure Web parts within WebCenter pages (Page 2655)

See also
Trends and Alarms (Page 2608)

Trends and Alarms

Overview   
"Trends & Alarms" are used to display and analyze logged process values and messages in 
trends and tables and for evaluation with statistics functions.

Predefined Web pages contain the following:

● Display of a process value in a table (Page 2660).

● Display of a maximum of three process values in a diagram. (Page 2661).

● Statistics functions for process values (Page 2668).

● Alarm hit list (Page 2667).

● Display of messages in a table (Page 2663).

The functions of "Trends & Alarms" are configured with web parts. The same Web parts are 
used here as are used in the WebCenter pages (Page 2606).

Excel workbooks

Overview  
With "Excel Workbooks", it is possible to display process data such as alarms and values of 
process or logging tags in an Excel table on the DataMonitor client. Data of logging tags of 
swapped out logs is not displayed.
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The data is analyzed using Excel functions or graphically formatted trend view, e.g. mean value 
calculation, diagram presentation. 

You configure the Excel Workbook for displaying the process data using the Excel Add-In 
"Excel Workbook Wizard". The online display of the process data is performed via the Excel 
Add-In "Excel Workbook". 

The created Excel workbooks can also be configured as templates for the function "Reports". 
 

 Note

You need the DataMonitor client to use the "Excel Workbooks" function. The installation file 
can be found on the DataMonitor start page under "Reports > Download area",  on the 
installation medium, or at the download installations.

 

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
Excel worksheet. This requires that you either take the data from an XML file or from a local 
WinCC project during the configuration in the Excel Workbook Wizard.

Separation between process and analysis by configuring with XML file 
By using the XML file for the project-relevant data, a separation between the process and the 
analysis is possible. 

You create the XML file on a DataMonitor server. Afterwards, transfer the XML file to a PC 
with Microsoft Excel, located in operation management for instance. You can configure the 
process data display in the sheet on the PC. 

Afterwards, transfer the workbook to a DataMonitor client where the process data is to be 
displayed online.

Configuration steps
The configuration of this function is carried out with the following steps:

1. In order to configure using the online data, configure directly on the WinCC server or on a 
WinCC client with an online connection to the respective WinCC server.

2. You have to create the XML file in order to configure with the data of an XML file. Use the 
"WinCC DataMonitor Configurator Export" application to create an XML file with the relevant 
data of the opened WinCC project on the DataMonitor server.

3. Use the Excel add-in "Excel Workbook Wizard" to import the project-relevant data to an 
Excel workbook.

4. Configure the display of process data such as alarms and tag values.

5. To display process data in the Excel workbook in online mode, use the Excel add-in "Excel 
Workbook" on a DataMonitor Client. The values can also be further processed in Excel.
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 Note

If you rename a table in an Excel workbook, the configuration data of the table will be lost.
 

Reports

Introduction         
Using Reports , you can use WinCC print jobs and published Excel Workbooks to output 
analysis results and process data. The data is output in PDF or XLS file format

When the reports are created is defined on the DataMonitor Server. The following options are 
available:

● Manually, for example, by a plant operators.

● Event-driven, for example, when a tag value has changed-

● Time-driven, for example, daily.

You can also transmit a report as e-mail attachment The various directories can only be 
accessed with the appropriate authorization; including access over an Intranet or the Internet.

Requirement
Output as PDF file (WinCC print jobs)

● PDF Reader The PDF reader can be obtained from www.adobe.com, for example.

Output as XLS file (Excel workbook)

● MS Excel as of Office XP is installed.
To use the DataMonitor Server for the automatic creation of Excel reports, you must install 
MS Excel on the server PC.

● The Excel workbook is created at and published as template at the DataMonitor Server.
For more information, refer to "Configuring an Excel workbook (Page 2670)".

 

  Note
Displaying data on the DataMonitor Client

In the Excel worksheet, the creation time and periods are always displayed in the local 
time zone of the DataMonitor Server.

 

See also
Configuring an Excel workbook (Page 2670)
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Access rights

Introduction   
When using DataMonitor, different authentications are required. You have to define specific 
users and user rights for this. 

● For the functions "Trends and Alarms", "Reports" and "Webcenter", a Windows user.

● For the functions "WinCCViewerRT" and "Excel Workbooks", a WinCC user.

SIMATIC logon allows the central administration of users. To use SIMATIC logon in conjunction 
with DataMonitor, the DataMonitor user is added to the user group "SIMATIC HMI VIEWER". 
The user group "SIMATIC HMI VIEWER" is created during the installation of WinCC Runtime 
Professional.

9.15.5.2 Configuring the DataMonitor system
 

Introduction
For the use of the WinCC DataMonitor, the data and process screens are made available on 
the DataMonitor Server to be accessed and displayed on the DataMonitor client.

Requirement
● The server PC and client PC are interconnected.

● On the server PC

– Internet Information Service is installed.

– The DataMonitor Server is installed.

– A license key is installed.

– WinCC Runtime Professional is installed.

● On the client PC

– Internet Explorer V 6.0 SP2 or higher is installed.
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Configuration steps
The following configuration steps are required to set up a DataMonitor system.

1. Configure the WinCC project.

– Configuring WinCC screens for Web access

– For WinCCViewerRT and the "Excel Workbooks" function, define the users and access 
rights in the "User administration" dialog.

– Configure Runtime settings

2. Transfer your WinCC project to the server PC. If the configuration PC and the WebNavigator 
server are interconnected, transfer the WinCC project using the command "Load to device 
> Software (all)". 

3. Configure the DataMonitor Server.

– Setting up the Web folder

– Define users and access rights in Windows for the functions "Trend and Alarms", 
"Reports" and "WebCenter".

4. Start WinCC Runtime on the server PC.

5. Use the DataMonitor functions on the DataMonitor Client.

– Check the Internet Explorer security settings on the client PC

– Start Internet Explorer on the client PC and enter the address of the DataMonitor Server.

– After logging on to the DataMonitor Server you can access the DataMonitor functions.

6. Monitor the WinCC project at the DataMonitor Client.

– Setting up WinCCViewerRT

– Displaying screens

Configuring a WinCC project

Configuring WinCC screens for Web access

Configuring individual WinCC screens for Web access
1. Double-click the desired screen in the project tree. The screen is opened and the screen 

properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Web access".

or

1. select the desired screen in the project tree.

2. Select "Web access" command in the shortcut menu.
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Configuring several screens for Web access
1. Select "Screens" in the project tree.

2. Select "Web access all" command in the shortcut menu.

Result
The WinCC screens are configured for Web access. During the transfer of the project, the 
WinCC screens are adapted for access via the Intranet/Internet and published on the 
DataMonitor Server.

For more information, refer to "Transferring when WinCC projects".

See also
Creating static process screens for the Web Center (Page 2646)

WinCC screens as a gadget

Gadget on the Data Monitor Server

Introduction
Using the "Preview" property, you define which screens to group in a gadget. Gadgets are mini 
applications for the Windows sidebar. In order to use gadgets, a DataMonitor client must 
always be installed as well on the DataMonitor server.    

The following operating systems support gadgets:

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Procedure
To configure WinCC screens as a gadget, proceed as follows:

1. Double-click the desired screen in the project tree. The screen is opened and the screen 
properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Preview" and "Web access".

4. Save the WinCC project.

5. Select the "Compile > Software" command in the shortcut menu of the HMI device.
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Result
The screens are assembled for the gadget on the WebNavigator server. As soon as the project 
is in runtime, the WebNavigator server generates a jpg snapshot image "pdlImage.jpg" of each 
screen at cyclic intervals and in consecutive order. 

The file is stored in the directory "\WinCC\Webnavigator\Server\Web\image\_gadget". The 
gadget accesses this file cyclically in the directory again.

Note that user interactions are not possible in the screens displayed. This includes, for 
example, calls from login dialogs or notice dialogs via functions.

The following objects are not supported for the display in a gadget:

● GSC diagnostics window

● Media Player
 

  Note

The WinCC project shown in the gadget cannot be operated.
 

Gadget on the Data Monitor Client

Introduction
In order to use gadgets, a DataMonitor client must always be installed as well on the 
DataMonitor server. A preconfigured gadget for displaying WinCC screens is located on the 
DataMonitor client in the installation directory under ""\WinCC\Webnavigator\GADGET".   

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Requirement
The screens are published on the Data Monitor server and configured as "Preview".

Procedure
To access the gadget with the Data Monitor Client, follow these steps:

1. Double-click on the "_WebNavigator.gadget" gadget in the installation directory under 
"\WinCC\Webnavigator\GADGET". IN Windows 7 / Windows 2008, the gadget is installed 
in the sidebar.

2. Define the update cycle in which the gadget loads a screen from the Data Monitor Server, 
every 17 seconds for example.

3. Enter the address of the Data Monitor Server. The gadget establishes a connection to the 
Data Monitor Server.

4. If necessary, drag-and-drop the gadget onto the desktop.
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Configuring runtime settings (DataMonitor)

Introduction  
You can configure the behavior in runtime in the "Runtime settings" editor. 

Procedure
1. Open the "Runtime settings > Web access" editor.

2. To use the "WinCC Classic" design, activate "Use "WinCC-classic" design".

3. To use your own cursor as a "View only cursor", enter the path and file name of the cursor 
at "Cursor "View only". Alternatively, navigate to the file of the desired cursor using the "…" 
button.

4. To change the maximum number of concurrent connections, enter the desired number in 
the "Count of concurrent connections" field.

5. To change the maximum number of open tabs in the browser, enter a suitable value in the 
"Number of tabs per browser" field. Internet Explorer V7 or higher supports this setting.

 

  Note
Server load settings

Each tab that calls the server homepage uses a license on the server PC. A connection 
setting of "10" and a tab setting of  "2" corresponds to 20 clients. A license for at least 20 
clients must be available on the server PC.

 

6. Define whether the local user group is disabled on the WebNavigator Server.

7. To output an appropriate system message when a WebNavigator logs on and off, activate 
"Enable event log messages".
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Result
The settings for Runtime are configured. 

See also
Display screens (Page 2632)

Defining users in WinCC

Managing a user group for DataMonitor

Introduction
A different start screen and the language can be set for each user group.  This allows you to 
make various sections of a project immediately accessible or inaccessible for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Procedure
1. Position the mouse cursor on the title of the "Groups" table.

2. Open the shortcut menu with the right mouse button and select the display of the "Start 
screen" and "Language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "DataMonitor operators" as the name of the user group. Activate at least the 
"DataMonitor - View only" authorization in the "Authorizations" table.

5. Click the  button in the "Start screen" column. A dialog box for selecting the start screen 
opens.

6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Language" column. A dialog box for selecting the language opens.

9. Select the language.
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As an alternative, select the user group in the work area; the properties of the user group are 
then displayed in the Inspector window. In the Inspector window, select "Properties > 
Properties > Web options". Select the start screen and the language.

 

 Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 

 

 

Managing users for DataMonitor

Introduction
To use the functions "Process Screens" and "Excel Workbooks" , create an appropriate user 
in user administration. 

Requirements
● DataMonitor is installed.

● The "Users" work area is open.

● The user "DM_Demo" has been created.

● The "DataMonitor operators" user group has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu with the right mouse button and select the display of the "Start 
screen" and "Language" columns.

3. Click the  button in the the line of the "DM_Demo" user in the "Start screen" column. A 
dialog box for selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Language" column. A dialog box for selecting the language opens.

7. Select "Spanish" as the Runtime language.

8. Activate the "DataMonitor operators" user group in the "Groups" table.
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As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another. The start 
screen will be overwritten.

 

Transferring a WinCC project

Requirement     
● A WinCC project is configured

● DataMonitor Server is installed on the server PC.

● The configuration PC and server PC are interconnected.

Online transfer
Transfer the WinCC project using the command "Load to device > Software (all)". The project 
is compiled prior to the download. The screens are adapted for access via Intranet/Internet 
during compilation. 

During the download to the server PC, the configured WinCC project is transferred and the 
screens are published on the DataMonitor Server. For more information, refer to "Compiling 
and loading".

Configuring the DataMonitor Server

Setting up the DataMonitor Web page

Requirement
● Internet Information Service is installed.

● The WinCC DataMonitor is installed.

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2618 System Manual, 08/2011,  



Procedure
Set up the DataMonitor Web page as follows:

1. In the Start menu select the command "Start > All Programs > Siemens Automation > Option 
and Tools > HMI Tools" > WinCC Web Configurator". This starts the Web Configurator.

2. The Web Configurator detects whether a configuration already exists.

– No configuration available: Select "Create a new standard website (stand-alone)" and 
click "Next".

– A configuration exists: Check the configuration

3. Define the desired settings.

4. Enter the name of your Web site in the "Name of the Web site" field.

5. In the "Port" field, enter the port number used for access.

6. In the "IP address" field specify whether the PC is to be reached in the Intranet, Internet or 
in both networks. Only use addresses from the selection list.
If you want to make your PC accessible via the Intranet and the Internet, select "All not 
assigned".

7. Select "DataMonitor.asp" as the standard Web site.

8. Define the time interval after which the Web Navigator Clients automatically start to 
establish a connection following a connection breakdown. If "0 s" is set, the "Automatic 
connection establishment" function is disabled.

9. Define the way the Web site is started after configuration.

10.If you have not activated a firewall, click "Finish". If you have installed a firewall, click "Next".
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Result
The Web directory has been created and the Web page is activated. If you have activated the 
firewall, configure the firewall settings with the Web Configurator. See "Setting up a firewall 
(Page 2620)" for additional information.

Setting up a firewall

Setting up a firewall in Windows 7 / Windows 2008

Introduction
This chapter describes only the activation of the "HTTP" and "HTTPS" services in Windows 7 
or Windows 2008 via Port 80.

To set up the Windows firewall with advanced security, or for a different port, contact your 
network administrator.

Requirements
● You have created a standard Web site using the Web Configurator.

● The firewall is activated.

● A logged on Windows user has administrator rights

Procedure in Windows 7
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.

3. In Windows 7, click "Allow program or feature in the Windows Firewall".
In Windows 2008, click "Allow communication of a program in the Windows Firewall".

4. Activate "Secure WWW Services (HTTPS)", or "WWW Services (HTTP)".

5. Exit the open Windows dialogs with "OK". 

6. Click "Finish" in the Web Configurator. The configuration of the server will be completed.

Setting up a firewall in Windows XP / Windows 2003

Introduction
This chapter describes only the activation of the "HTTP" and "HTTPS" services in Windows 
XP or Windows 2003.

To set up the Windows firewall for a different port, contact your network administrator.
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Requirements
● You have created a standard Web site with the Web Configurator.

● The firewall is activated.

● A logged-in Windows user has administrator rights
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Procedure with a standard port
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.
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3. Click the "Advanced" tab. Select the network connection and click the "Settings..."button.
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4. The "Advanced Settings" dialog is opened.

5. Activate "Secure Web Server (HTTPS)" or "Web Server (HTTP)". To display the current 
service settings of the Web server, click the "Edit" button.

6. Exit the open Windows dialogs with "OK". 

7. Click "Finish" in the Web Configurator.
The configuration of the server will be completed.
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Defining users in Windows

User groups

User groups in Windows
The following user groups are created automatically in Windows when the DataMonitor server 
is installed:

"DM_ADMIN"

The membership in the user group "DM_ADMIN" is required for extended rights, especially for 
configuration purposes. You must create at least one user and assign the user group 
"DM_ADMIN".

● The following is possible in the "Webcenter" function:

– Configuration of connections

– Creation of templates for WebCenter pages

– Creation and configuration of public and private WebCenter pages

● The following is possible in the "Reports" function:

– Configuration of reports on the basis of print jobs or Excel workbooks.

"DM_USER"   

The membership in the user group "DM_USER" or in your own user group is required for the 
functions "Webcenter", "Trends and Alarms" and "Reports".

● The following is possible in the "Webcenter" function:

– Setting and configuration of WebCenter pages. WebCenter pages are stored in different 
directories.

– Opening public pages

● The following is possible in the "Reports" function:

– Opening reports on the basis of print jobs or Excel workbooks.

Defining Users and Access Rights in Windows

Requirement
● WinCC Runtime Professional is installed

● DataMonitor Server is installed
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Procedure
Proceed as follows to create a user under Windows:

1. Open the Control Panel. Double-click the "Administration" entry.

2. Double-click "Computer Management" in the "Administration" dialog.
The "Computer Management" dialog opens.

3. Navigate to the directory "System > Local Users and Groups / Groups". Select the "New 
User..." command in the shortcut menu.

4. Enter the name "DM_Demo" in the "User Name" field in the "New User" dialog. Enter the 
description "User for DataMonitor" in the "Complete Name" field. Type the desired 
password into the "Password" field and then repeat it in the "Repeat Password" field. Create 
the user with "Create". Close the "New user" dialog.

5. In the right part of the table window, click the newly created user. Open the shortcut menu 
and select  the command "Properties". Go to the "Member of" tab. Click "Add".

6. Click the "Advanced >" button in the dialog "Select Groups" and then "Find now".

7. In the dialog below, select the two entries "DM_ADMIN" and "SIMATIC HMI VIEWER" from 
the list. To close the dialog, click "OK" twice.

8. The groups "DM_ADMIN" and "SIMATIC HMI VIEWER" are added to the membership list 
in the user properties. Click "OK."

9. Close the dialog "Computer Management" with the menu command "File > Exit".

10.Close the dialog "Management" with the menu command "File > Close".

Result
The user "DM_Demo" with a membership in the user group "DM_ADMIN" and "SIMATIC HMI 
VIEWER" has been set up. 

Starting the DataMonitor on the DataMonitor client 

Configuring security settings in Internet Explorer

Introduction   
To have the full functionality available on the DataMonitor client, adapt the security settings in 
Internet Explorer. 

● Internet Explorer V 6.0 SP2 or higher

Procedure
To configure the security settings in Internet Explorer, proceed as follows:

1. Click "Tools" > "Internet Options" in the Internet Explorer. The "Internet Options" dialog 
opens.

2. Click the "Security" tab.
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3. Select the "Trusted Sites" icon and click the "Sites..." button. The "Trusted Sites" dialog 
opens.

4. Enter the address of the DataMonitor Server in the "Add this Website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. If necessary, clear the "Require server verification for all sites in this zone (https:) check 
box. Click "Add". Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level". Click "Customize Level" in the following dialog.
The "Security settings" dialog box is opened. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".

Result
The necessary settings of the DataMonitor client in the Internet Explorer are configured.

Starting the DataMonitor startup page on the DataMonitor client

Introduction     
The start page of the DataMonitor summarizes the functions of the DataMonitor. 

● "Working with reports (Page 2683)":
Creation and output of the analysis results and process data in print jobs and in published 
Working with Excel Workbooks (Page 2670).

● "Working with the WebCenter (Page 2633)"
Configuration of connections and creation of WebCenter pages for the display of logged 
data.

● "Working with Trends and Alarms   (Page 2660)"
Display of alarms and process values from logs in tables and diagrams.

You start the DataMonitor client on a standalone PC or on a DataMonitor server. 

Requirements
● User has been created in the Windows User Group "DM_ADMIN". 

● The WinCC project on the DataMonitor Server is in Runtime.

● A user is created in WinCC.
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Procedure
To access the Web page of the DataMonitor Server, proceed as follows:

1. Open the MS Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL. 
Confirm the entry with "Enter".

3. The logon dialog opens. Enter the name of a Windows user in the "User name" field. Enter 
the respective password and confirm with "OK".
The start page with the DataMonitor functions will be displayed.

Result
The start page with the DataMonitor functions will be displayed on the DataMonitor client. The 
use of the functions depends on the user's access right. 

See also
Working with WinCCViewerRT (Page 2630)
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General Operations of the DataMonitor Client

Introduction 
The DataMonitor Web pages have the following structure: 

① Header
② Current user
③ Link to logoff
④ Navigation control
⑤ Icon to hide the header
⑥ Interface language selection field
⑦ Tabs depending on the currently displayed contents
⑧ Contents
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Switching the user interface language 
1. Choose the desired language from the selection field in the header.

The GUI language is changed.

Hide and show the header  
1. To hide the header line, click the symbol .

This provides more room for displaying the content.

2. To show the header line again, click the symbol .

Logoff   
1. To log off from the DataMonitor server, click the "Log off" link.

2. Close Internet Explorer.
When you close Internet Explorer, the used license will be released immediately. 

9.15.5.3 Working with WinCCViewerRT

Setting up WinCCViewerRT

Requirement   
● On the server PC

– The DataMonitor Server is installed.

– A license key is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

● On the client PC

– DataMonitor Client is installed.
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Procedure
Set up WinCCViewerRT as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Enter the logon data in the "General" tab:

– Server address: http://<server name>, or http://<IP address>

– User name and password:

3. In the "Parameters" tab, specify the Runtime language and whether to disable keystrokes 
that the operator uses to change to other programs.

4. Define the WinCC Runtime Professional properties in the "Graphics Runtime" tab:

– Start screen

– Configuration file for screen navigation

– Window attributes

– Illegal user actions

5. Define additional user actions in the "Runtime" tab.

– Automatic logout

– Enable screen keyboard.

– Use <Ctrl+Alt+Del> to switch to the Task Manager and to the operating system. This 
setting is only valid for the on-screen keyboard.

– Open the "WinCCRTViewer" dialog by means of keystroke.
You can change the default keystroke <Ctrl+Alt+P>.

6. Close the dialog with "OK".
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Result
The WinCCViewerRT is configured. When the dialog is closed, the connection to the 
DataMonitor server is established. The settings are saved to the configuration file 
"WinCCViewerRT.xml". The settings in the configuration file are used at the next start of 
WinCCViewerRT.

The configuration file is stored in the "Documents and Settings\User\Application Data\Siemens
\Automation\Portal V11\WebNavigator\Client" folder. This allows different configurations to be 
used, depending on the logged on user. WinCCViewerRT applies the interface language from 
WinCC.

Renaming or removing WinCCViewerRT.xml

When you rename or remove the file WinCCViewerRT.xml, the configuration dialog of 
WinCCViewerRT is opened during the start. Reconfigure WinCCViewerRT, or select a different 
configuration file.

Display screens

Requirements  
● A license key is installed on the DataMonitor Server.

● The WinCC project on the DataMonitor Server is in Runtime.

● The WinCC screens are configured for Web access and published.

● A WinCC user with authorization no. 1002 "DataMonitor - Monitor only" is created.

Procedure
To view screens, proceed as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Log on to the WebNavigator server:

– If the user and password are configured in "WinCCViewerRT", no logon dialog displayed.

– If no user and password was configured in "WinCCViewerRT", the logon dialog 
displayed. Enter the user name and the password of the WinCC user. Click "OK."

3. Press the <Ctrl+Alt+P> keystroke to change the user. The "WinCCViewerRT" dialog opens.
Enter the user name and password on the General" tab.
You can also select the xml file that contains this data. 

Result
The Web Viewer connects to the activated WinCC project. The screens of the WinCC project 
are displayed. 

The cursor is a "View Only Cursor" and indicates that process-related operations are not 
allowed. 
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Certain operations are still possible, such as opening the properties dialog of an online trend 
control. 

If necessary, you can use your own cursor as a "View Only Cursor". For more information, 
refer to "Configuring runtime settings (DataMonitor) (Page 2615)".

9.15.5.4 Working with the WebCenter

Administration

User Groups and Directories

Overview    
WebCenter pages and reports are stored in directories on the DataMonitor Server. 

Its standard complement of directories is as follows:

● "Public"

● "Private"
Every user has a "Private" directory. Only the respective user has access rights to this 
directory.

More information on setting up directories can be found in chapter "Creating Directories 
(Page 2635) ".

Windows User Groups
The user groups "DM_ADMIN" and "DM_USER" are created during the installation of the 
DataMonitor Server. You can create more user groups. More information on setting up user 
groups and users can be found in chapter "Assigning Access Rights (Page 2636) ".

To access the DataMonitor, you can assign all members of a user group with the same access 
rights to the directory of the DataMonitor server.

The following access authorization is possible:

● Read

● "Change"

● "Create"

A user, as a member of a user group, only has access to a directory if the respective user 
group has access rights to that directory. This permits user group-specific access. More 
information on assigning access authorization can be found in chapter "Defining users in 
Windows (Page 2625) ".
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The following screen shows the basic user administration for the WebCenter.
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Creating Directories

Introduction  
You store WebCenter pages in directories. The following directories exist as defaults:

● "Public"

● "Private"
Every Windows user has their own "Private" directory.

Requirements
● The logged-in user is a member of the Windows user group "DM_ADMIN".

● The DataMonitor start page is open.

Procedure
1. Click in the start page "Webcenter >Administration".

2. Click the "Directory administration" tab.

3. Enter the name "mypart" in the "New directory" field.

4. Click the "Create" button.

Result
You have created the directory "mypart". The user administration is opened automatically. 
Specify the access rights for the folder. You can also exit the page and configure the access 
rights at a later time.
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Assigning Access Rights

Introduction   
In the WebCenter, directories are created in which, for example, the WebCenter pages are 
stored. You can assign different access rights for the individual directories to Windows user 
groups.

The following access authorization is possible:

● Read

● "Change"

● "Create"
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Requirement
● The logged-in user is a member of the Windows user group "DM_ADMIN".

Procedure
1. Click in the start page "Webcenter> Administration".

2. Click the "User administration" tab.

3. Select the desired directory from the "Current Directory".
All existing Windows user groups are listed.

4. Activate the access rights in the line of the desired Windows user group.

5. Click "Save".

Result
The access rights have been configured for the desired directory.
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Establish a connection to the winCC data

Create connection and set up language

Introduction   
A connection is configured for access to the data in the "Webcenter". A connection is set up 
for each data source, e.g. WinCC server. The connection is required for example for the 
function "Trends and Alarms" and the WebCenter page. 

Requirement
The logged-in user is a member of the Windows user group "DM_ADMIN".

Procedure
1. Click in the start page "Webcenter> Administration".

2. Click the "Connection administration" tab.

3. Choose the language that corresponds with the linguistic region of the server or log to be 
linked in "Linguistic region".
If you do not select the language that corresponds with the respective linguistic region, 
characters may be displayed incorrectly on the page.
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4. Select "New connection".
After the new installation, no selection is possible in the "Connection" field, as no 
connections have been configured yet.

5. Enter a name in the field "Connection name", e.g. "WinCC1_ Runtime".
Any name can be selected. However, it should contain a reference to the selected 
connection type. Do not use spaces and special characters in the connection name.

6. Enter the name of the PC whose data you would like to access in the "Computer name" 
field. As an alternative, select the name of the PC using the "Find" button.

7. Enter the desired database in the "Database" field. Alternatively, select the database using 
the "Find" button.

8. Choose the desired option in the "Connection type" area.

– "Swapped WinCC Log"
Further steps are required to access data from logs. For additional information, refer to 
"Connecting and Disconnecting Swapped Logs (Page 2639)".

– "WinCC Runtime"
The Runtime database of the selected WinCC project is entered in the "Database" field.

– CAS
CAS is not available in this version.

– WinCC Runtime + all segments
"CC_ExternalBrowsing" is entered in the "Database" field.

9. Activate "Automatic adaption of RT database". When a segment is changed, the name of 
the database is adjusted in the connection administration.

10.Click the "Create" button.

Result
The connection to the data source is created and can be selected in "Connections". 

 

Connecting and Disconnecting Swapped Logs

Configuring a directory

Introduction 
To access data from swapped WinCC logs (log backup file), these logs must be connected to 
an SQL server again. 

You can connect all or individual log backup files of a directory to the SQL server.
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Requirements
● Write protection of the log backup file has been removed

Archive backup files are write protected. Create a backup copy of the file before connecting 
and remove the write protection of the copied log backup file. 

● The log backup files are available on the local drive.

● The directories in which the log backup files are set for sharing.

– The directory must be set for sharing in the Windows Explorer before you start the 
DataMonitor Server.

– If you set the directories for sharing later, restart the DataMonitor Server.

● The user group "SIMATIC HMI VIEWER" must have "full access" to the directories.

● The logged-in user is a member of the Windows user group "DM_ADMIN".

● Windows Server 2003 / 2008: "Network service" has been added to the "Print operators" 
group.

● Windows XP / Windows 7: "Network service" has been added to the "Power user" group.

Procedure
Proceed as follows to create a symbolic directory:

1. Click in the start page "Webcenter> Administration".

2. Click the "Archive administration" tab.

3. Enter a unique symbolic name name in the "Symbolic Name" field.
The name should only contain the characters permitted in the SQL syntax. You use the 
symbolic name for access via the DataMonitor client.

4. In "Directory", select the directory in which the log backups are located.
You can only select directories that have been set for sharing.

5. To connect all existing log backups of the directory, select "Automatically connect all logs 
in this directory".
To connect all individual log backup files of the directory, clear "Automatically connect all 
logs in this directory".

6. Click "Add".
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Result
You have created the symbolic directory "Test". If you have cleared "Automatically connect all 
logs in this directory", define the log backups to be connected on the page "Connect/disconnect 
logs (Page 2641)".

To disconnect logs, clear the desired logs on the page "Connect/disconnect logs"
 

 Note
Connected logs on changeable media

Before changing the media in the drive you need to disconnect the logs on this medium. After 
changing the medium, check whether the logs are connected on the new medium.

 

Deleting a symbolic directory
To remove a directory containing logs from the list of symbolic names, disconnect all logs 
contained in the list. The status of the logs can be seen on the page "Connect/disconnect logs".

Connecting and Disconnecting Logs

Requirement
● Write protection of the log backup has been removed

Log backups are write protected. Create a backup copy of the log before connecting and 
remove the write protection of the copied archive.

● The logged-in user is a member of the Windows user group "DM_ADMIN".

● You have configured the symbolic directory "Test" (Page 2639).
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Procedure
To connect or disconnect individual log backups, proceed as follows:

1. Click in the start page "Webcenter> Administration".

2. Click the "Connect/disconnect logs" tab.

3. Select the directory "Test" in "Symbolic directories". Existing logs are displayed in a list. 
The "Info" column provides information about the status.

– Green: Connected

– Red: Disconnected

4. To restrict the display, click "Filter".

5. Enter the desired time period and click "Refresh display".

6. To connect a single archive, select the desired log in the "List of existing logs". Click "Save". 
The status "Green" indicates that the log is connected.

7. To disconnect a single archive, clear the desired log in the "List of existing logs". Click 
"Save". The status "Red" indicates that the log is disconnected.
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Alternative procedure
Archive backups can be connected in the following ways:

● VB function using the "Restore" method. For detailed information, refer to "Restore".

● Automatic Connection: If you copy the log backups to the "CommonArchiving" folder, the 
logs are connected to the project in Runtime.

● Using Archive Connector (Page 2643).

Result
Logs are connected. If you connect signed logs, which have been changed after the swap, an 
alarm is output.

Connecting Logs using WinCC Archive Connector

Introduction
With the Archive Connector, already swapped out WinCC logs can be reconnected to an SQL 
Server.

Requirements
● Write protection of the log backup file has been removed

Archive backup files are write protected. Create a backup copy of the file before connecting 
and remove the write protection of the copied log backup file. 

● The log backup files are available on the local drive.

● The directories in which the log backup files are set for sharing.

● The user group "SIMATIC HMI VIEWER" must have "full access" to the directories.

● The logged-in user is a member of the Windows user group "DM_ADMIN".
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Procedure
To connect log backup files, proceed as follows:

1. Start the "Archive Connector".

2. Click "Add" in the "Configuration" tab. The "New Directory" dialog is opened.

3. Navigate to the directory in which the log backup files are stored.

4. Enter a symbolic name for the directory. Click "OK." The directory is displayed on the 
"Configuration" tab.
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5. Click the "Connect/Disconnect Logs" tab. All the logs in the selected directory are listed in 
the "Connect/Disconnect Logs" tab.

6. Select the desired log and click "Connect".

Result
A connection has been created and the desired log backup files are connected to the SQL 
server.

The connection status of each log is displayed on the "Connect/Disconnect Logs tab". "From" 
and "To" columns contain the archiving period denoted in the local time zone.

The "Type"column contains the details for log type.

"A" Alarm logs
"TF" Fast data log
"TS" Slow data log
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Creating static process screens for the Web Center

Introduction  
In the screen management, specify the screens that you need for the Web element "Static 
process screens".

The DataMonitor Server generates copies of the screens at configurable cyclic intervals and 
provides these to the DataMonitor Client and the form of static process screens. 

Requirements
● The logged-in user is a member of the Windows user group "DM_ADMIN".

● The WinCC screens are configured for Web access and published. For more information, 
refer to "Configuring WinCC screens for Web access (Page 2612)".

● The DataMonitor start page is open.

● The "Screen management" tab is open.
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Creating static process screens for the Web Center
1. Select the screens.

– To select all screens, activate the check box in the column header.

– To select individual screens screens, activate the check box leading the relevant screen.

2. To display only part of the screen, define the following:

– X position: Start positions in x direction in pixels

– Y position: Start positions in y direction in pixels

– Width: Width of screen in pixels

– Height: Height of screen in pixels

3. To output the time at which the static process screen screen was created by the 
DataMonitor Server, activate "Stamp".
The date time are shown in the static process screen.
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4. To change the update cycle, enter the desired value in "Update time interval".
Select this cycle as large as possible. A cycle that is too small leads to performance 
problems.

5. Click "Save".

Result
The DataMonitor Server generates the static process screens from the selected screens. The 
static process screens can be configured in the Web part "Static process screens".

Removing static process screens
To remove static process screens, select the check box at the relevant entry in the "Delete 
graphic object" column. Click "Save" to remove the static process screen or copy. The deleted 
static process screens can no longer be configured in the Web part "Static process screens".

Finding screen names or limiting the view
Use a filter to find screen names, or to limit the view to specific screen names.

At the "Filter" entry, click  to show the filter above the table. Enter the search term in the 
text field and then click <Enter>. 

To hide the filter, click .

Create a layout template for WebCenter pages

Introduction     
You require a layout template to create a WebCenter page. Many prefabricated layouts have 
been installed during the installation. Additionally, you can create your own Layout Templates.

Requirements
● The logged-in user is a member of the Windows user group "DM_ADMIN".

● The DataMonitor start page is open.
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Procedure
Proceed as follows to create your own layout template:

1. Click "WebCenter > Configuration" in the start page.

2. Click the "Create layout" tab.

3. Define the number of columns and rows.

4. Enter the name "mylayout_23" in the "Name of the layout file" field. Click "Next."
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5. If required, group the table fields. For this, click the appropriate arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1.
The modified view will be displayed. 

To restore the original table form, click "Reset configuration".
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6. Click "Next."

7. You define the order of the Web parts in the table fields. 
If necessary, select the corresponding symbol in a table field to place the web parts vertically 
or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a WebCenter page. 

Create a WebCenter page

Introduction   

Requirements
● The directory "myPart" is set up.

● The logged-in user is a member of the Windows user group "DM_Admin" or "DM_USER".

● The Windows user groups have the "Change" or "Create" access rights to the directory.

● The DataMonitor start page is open.
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Procedure
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Create Page" tab.

3. Click the desired layout template. The file name is displayed in the "Layout file" field.

4. Enter a name in the "WebCenter page" field, for example "My_Webcenter".

5. Click the directory in which the WebCenter page is stored. The selected directory is 
displayed in the field "Save WebCenter page as".

6. Click "Save".
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Result
The WebCenter page has been created and saved. 

Insert Web parts into the WebCenter page

Introduction    
You combine Web parts to create the contents of the WebCenter pages. 

Requirements
● The directory "myPart" is set up.

● The WebCenter page "My_Webcenter" is stored in the directory.

● The logged-in user is a member of the Windows user group "DM_Admin" or "DM_USER".

● The Windows user groups have the "Change" or "Create" access rights to the directory.

● The DataMonitor start page is open.

Procedure
Proceed as follows to insert Web parts in the WebCenter page:

1. Click "WebCenter > Pages" in the start page.

2. Click the "myPart" tab.

3. Click the "My_Webcenter" entry.
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4. To add Web parts, click the symbol  on the right side.
The available Web parts are listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your WebCenter page.

5. Select "Trend (Timestamp)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Select "Alarm hit list".
If you insert several Web parts in a spreadsheet field, they are arranged horizontally or 
vertically. Specify this arrangement when creating the layout template.

8. Select the entry "WPZ_02_01" and click "Add". 

9. Click "Close."

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
2654 System Manual, 08/2011,  



Result
Web parts to display data have been inserted into the WebCenter page "My_Webcenter". The 
current summary of the WebCenter page is displayed.

 

Configure Web parts within WebCenter pages 

Requirement
● The logged-in user is a member of the Windows user group "DM_Admin" or "DM_USER".

● The Windows user groups have the "Change" or "Create" access rights to the directory.
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● The WebCenter page "My_Webcenter" is open.

● The WinCC project is in Runtime.
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Procedure
To configure Web parts within WebCenter pages, proceed as follows:

1. Click the icon  in the desired Web part. The configuration dialog opens.

2. Configure the web part.

– Displaying process values in a table (Page 2660)

– Displaying process values in a diagram (Page 2661) 

– Displaying messages in the alarm table (Page 2663) 

– Displaying the hit list of messages (Page 2667) 
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– Displaying statistics function for process values (Page 2668) 

3. To change the position of the web part, move the web part to the desired position with the 
mouse.

More Operational Capabilities     
The following operating options are available:

Delete Web part
Minimize Web part
Maximize Web part
Export Web part
Export configuration of the Web part as an XML file

 

Deleting WebCenter Pages and Layout Templates

Requirement
Deleting layout templates

● The user is a member of the Windows user group "DM_ADMIN".

● The DataMonitor start page is open.

Deleting a WebCenter page

● The logged-in user must have "Create" access rights for the directory in which the page to 
be deleted is stored.

● The DataMonitor start page is open.
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Deleting layout templates
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Delete layout" tab.

3. Delete the selected files.

– To delete several layout files, select the "Selection" check box for the files to be deleted. 
Click "Delete."

– To delete all the layout files, click "Select All". Click "Delete."

– To delete individual layout files, click the respective "Delete" button in the "Action" 
column.

Result
The selected layout file is deleted. Note that this also applies to the layout files included in your 
package.

Existing WebCenter pages which use this layout template are retained. You cannot use this 
layout to create new WebCenter pages. 

Deleting a WebCenter page
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Delete page" tab.

3. Activate the respective check box to mark the pages to be deleted.

4. Click "Delete".
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9.15.5.5 Working with Trends and Alarms  

Displaying process values in a table

Requirements  
● A connection to the WinCC data is established (Page 2638)

● The DataMonitor start page is open.

Procedure
Proceed as follows to display process values in a table:

1. Click "Trends & Alarms " in the start page. Click the "Process value table" tab. The Web 
part "Process Value Table" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.

5. Click "Add" for the desired logging tags.

6. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol.
To check the set time range in the column "Preview time frame", click "Preview".

7. Define the number of decimal places in the "Displaying decimal places" section.

8. In the "Table size" area, define the size of the display window. For example, enter a height 
of "200" and a width of "400". 
If the value "0" is entered into both fields, the size is determined automatically. The size is 
oriented on spatial requirements of the Web part.

9. The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

10.Confirm your entries.
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Result
The values of the logging tags are output in the process value table.

Use the arrow keys to skip backward and forward with multi-page tables. You can export the 
displayed table in CSV format using the  icon. Click the  symbol to change your settings.

Displaying process values in a diagram

Requirements
● A connection to the WinCC data is established (Page 2638)

● The DataMonitor start page is open.

Procedure
Proceed as follows to display process values in a trend view:

1. Click "Trends & Alarms " in the start page. Click the "Trend (process values)" tab. The Web 
part "Trend (process values)" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.
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5. Click "Add" for the desired logging tags, e.g. "TREND_1", "TREND_2", "TREND_3. The 
logging tags are listed in the "Current selection" area.

6. Define the following for the individual logging tags in the "Current selection" area:

– color of time and value axis

– form of the trend display

7. In the section "Value axis editor", you can select the automatic scaling for the different value 
axes or you can assign a minimum and a maximum value to each axis.

8. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol. To check the set time range in 
the column "Preview time frame", click "Preview".

9. In the section "Diagram settings", define the size of the display window. If the value "0" is 
entered into both fields, the size is determined automatically. The size is oriented on spatial 
requirements of the Web part.

10.To display the legend, select "Show legend".

11.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

12.Confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the logging tags. Skip forward or back by 
the selected time frame in the absolute time using the  and  buttons. 

Enlarge the display and you can zoom into the diagram area to the left and right of the center 
line using the "Zoom left"  and "Zoom right"  buttons. The  button is used to  restore 
the original view. 

Export the table displayed in CSV format using the  icon.

Click the  symbol to change your settings.

Displaying messages in the alarm table

Requirements
● A connection to the WinCC data is established (Page 2638)

● The DataMonitor start page is open.
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Procedure
To display alarms in the alarm table, proceed as follows:

1. Click "Trends & Alarms " in the start page. Click the "Alarm table" tab. The Web part "Alarm 
Table" is displayed.
Click . The configuration dialog of the Web part opens.

2. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

3. Select the connection in the "Connection" field. 

4. Select the corresponding WinCC server in the "Selection of WinCC Servers" area. 
You need this setting to be able to select a connection to a swapped out archive that 
contains log files from several WinCC servers.

5. Define the time range in the "Time period" area. With relative times, enter a negative value 
in the respective field. To obtain additional information on the time specification, click the 

 symbol. To check the set time range in the column "Preview time frame", click "Preview".

6. In the section "Language of the alarm texts", select the language in which the alarms are 
displayed.

7. In the section "Filter selection", limit the expected search results by means of filter conditions 
in SQL syntax. To obtain additional information on the filter conditions, click the  symbol.

8. Define the following for displaying the data:

– Sorting order: To obtain additional information on sorting, click the  symbol.

– Visible columns: To display all the columns, click "Select All". For further information, 
refer to "Alarm Log Column Names (Page 2665)".

– Number of decimal places

9. In the "Table size" area, define the size of the display window.
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10.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

11.Confirm your entries.

Result
Use the arrow keys to skip backward and forward with multi-page tables. You can export the 
displayed table in CSV format using the  icon. Click the  symbol to change your settings.

Alarm Log Column Names

Introduction
You can select the alarm log columns while displaying alarms in "Trends and Alarms".
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Overview of column names

Position Name Type Comments
1 MsgNo Integer 4 Bytes Alarm number
2 State Small Integer 2 Bytes Alarm Log Status
3 DateTime DateTime 8 Bytes Time stamp of alarm (Date/time without milliseconds) 
4 Ms Small Integer 2 Bytes Time stamp of alarm (milliseconds)
5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 PValueUsed Integer 4 Bytes Process Values used 
8 to 17 PValue1 to PValue10 Real 8 Bytes Numerical Process Value 1 to 10
18 to 27 PText1 to PText10 VarChar (255) Process Value Text 1 to 10
28 Computer name VarChar (255) Computer Name
29 Application VarChar (255) Application Name
30 Comment VarChar (255) Comments
31 UserName VarChar (255) User Name
32 Counter Integer 4 Bytes Running Alarm Message Counter
33 TimeDiff Integer 4 Bytes Time difference to "Incoming" status 
34 ClassName VarChar (255) Alarm class name
35 Type name VarChar (255) Alarm type name
36 Class Small Integer 2 Bytes Alarm class ID
37 Type Small Integer 2 Bytes Message type ID
38 to 47 Text1 to Text10 VarChar (255) Alarm Text 1 to 10
48 AG_NR Small Integer 2 Bytes Number of the PLC
49 CPU_NR Small Integer 2 Bytes Number of the CPU
50 CrComeFore Integer 4 Bytes Foreground Color for the "Incoming" Status
51 CrComeBack Integer 4 Bytes Background Color for the "Incoming" Status
52 CrGoFore Integer 4 Bytes Foreground Color for the "Outgoing" Status
53 CrGoBack Integer 4 Bytes Background Color for the "Outgoing" Status
54 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" Status
55 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" Status
56 LocaIID Integer 4 Bytes Location of the Alarm
57 Priority Integer 4 Bytes Priority
58 AP_type Integer 4 Bytes Loop-in alarm
59 AP_name VarChar (255) Loop-in-Alarm Function Name
60 AP_PAR VarChar (255) Loop-in-Alarm Screen
61 InfoText VarChar (255) Info text
62 TxtCame VarChar (255) Incoming text
63 TxtWent VarChar (255) Outgoing text
64 TxtCameNWent VarChar (255) Text came in and went out
65 TxtAck VarChar (255) Text acknowledged
66 AlarmTag Integer 4 Bytes Alarm tag
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Position Name Type Comments
67 AckType Small Integer 2 Bytes Acknowledgment Type
68 Params Integer 4 Bytes Parameter

See also
Displaying messages in the alarm table (Page 2663)

Displaying the hit list of messages

Requirements
● A connection to the WinCC data is established (Page 2638)

● The DataMonitor start page is open.

Procedure
To display alarms in a hit list, proceed as follows:

1. Click "Trends & Alarms " in the start page. Click the "Alarm hit list " tab. The web part "Hit 
list of the alarms" is displayed.
Click . The configuration dialog of the Web part opens.

2. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

3. Select the desired connection in the "Connection" field:

4. Define the time range in the "Time period" area. With relative times, enter a negative value 
in the respective field. To obtain additional information on the time specification, click the 

 symbol. To check the set time range in the column "Preview time frame", click "Preview".

5. In the section "Language of the alarm texts", select the language in which the alarms are 
displayed.

6. Select the corresponding WinCC server in the "Selection of the WinCC Server" area.
You need this setting to be able to select a connection to a swapped out archive that 
contains log files from several WinCC servers.

7. In the section "Filter selection", limit the expected search results by means of filter conditions 
in SQL syntax. To obtain additional information on the filter conditions, click the  symbol.

8. Define the following for displaying the data:

– Sorting order: To obtain additional information on sorting, click the  symbol.

– Visible columns: To display all the columns, click "Select All".

– Number of decimal places

9. In the "Table size" area, define the size of the display window. If the value "0" is entered 
into both fields, the size is determined automatically. The size is oriented on spatial 
requirements of the table.
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10.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

11.Confirm your entries.

Result
The analysis values for the alarms are displayed in a hit list:

The table contains configured data and statistical values, e.g. InfoText, frequency of the alarm. 

Explanations for the columns are displayed as a tool tip when the mouse is moved over the 
respective column header. Use the arrow keys to skip backward and forward with multi-page 
tables.

With the icon , the displayed analysis values of the alarms can be exported in CSV format. 
Click the  symbol to change your settings.

 

 Note

The display of alarms in the hit list may take some time and may place a strong load on the 
CPU. A note is displayed in "Trends and Alarms" if the data volume is too high. You may then 
confirm the alarm and continue without any changes, or you may cancel the process to modify 
the filter criteria and thus reduce the expected amount of data.

 

Displaying statistics function for process values

Requirements
● A connection to the WinCC data is established (Page 2638)

● The DataMonitor start page is open.
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Procedure
Proceed as follows to display statistics functions for process values:

1. Click "Trends & Alarms " in the start page. Click the "Statistics functions for process values" 
tab. The Web part "Statistics functions for process values" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.

5. Click "Add" for the desired logging tags.

6. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol.
To check the set time range in the column "Preview time frame", click "Preview".

7. Define the following for displaying the data:

– Number of decimal places

– Aggregate selection: Define the analysis function for the process values.

8. In the "Table size" area, define the size of the display window. For example, enter a height 
of "200" and a width of "400". If the value "0" is entered into both fields, the size is determined 
automatically. The size is oriented on spatial requirements of the table.

9. The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

10.Confirm your entries.

Result
Statistics functions for the selected process values were executed and output in the table.

The log name and tag name are displayed as a tool tip when the mouse is moved over the 
respective column header.
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You can export the displayed table in CSV format using the  icon. Click the  symbol to 
change your settings.

9.15.5.6 Working with Excel Workbooks

Configuring an Excel workbook

Importing data from a WinCC project

Introduction   
You need the WinCC configuration data to configure Excel workbooks. 

Import this data from a local WinCC project when configuring the workbook using the Excel 
Workbook Wizard . 

Requirements
● Server PC

– Office 2003 SP3, or Office 2007 is installed

– The Excel add-In "Excel Workbook" is installed.

– DataMonitor Server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● On the configuration PC

– Office 2003 SP3, or Office 2007 is installed

– The Excel add-In "Excel Workbook Wizard" is installed.

Procedure
To import data from a WinCC project, proceed as follows on the configuration PC:

1. Open an empty Excel workbook. Select the "Excel Workbook Wizard..." command in the 
"DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server".

3. The "WinCC Server" field is shown. Enter the name of the server PC and then click 
"Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next >". The "Add / delete tags" dialog opens.
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Result
The Excel workbook is configured. Create the view of process data.

Importing data from an xml file

Introduction
You can create the Excel workbook on a PC if, for example, Excel is not installed on the server 
PC.  Create the corresponding xml file on the DataMonitor Server. 

Requirement
● Server PC

– DataMonitor Server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● On the configuration PC

– Office 2003 SP3, or Office 2007 is installed

– The Excel add-in "Excel Workbook Wizard" is installed.

Creating an XML file on the server PC   
1. In the Start menu select the command "Start > All Programs > Siemens Automation > Option 

and Tools > HMI Tools" > WinCC DataMonitor Configurator Export".
The function creates an XML file and stores it in subdirectory "Web Navigator\Reports" of 
the current project. The file name is automatically generated using the format 
"<projectname>.XML". 

2. If no Excel installation exists on the server PC, transfer the XML file to another PC on which 
MS Excel and the Excel Workbook Wizard  are installed.

Configuring data access using an XML file
1. Open an empty Excel workbook. Select the "Excel Workbook Wizard..." command in the 

"DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next >".

3. Navigate to the required XML file.

4. Click "Next >". The "Add / delete tags" dialog opens.

Result
The Excel workbook is configured. Create the view of process data. Transfer the Excel 
workbook to the client PC. The DataMonitor Client displays the process data of the server PC. 
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Configuring the display of tag values

Requirements
● The dialog "Add / delete tags" is open.

Procedure
Proceed as follows to display tag values in Excel:

1. Check the option for the insert sequence of tag groups in the "Add tags" area.

2. In the "Tag tree" area, click the directory icon. The object list opens.

3. Select the desired tag in the object list and drag the tag to a field of the Excel table.

4. Close the object list. The tag will be displayed in the window "Tag list".

5. In the "Tag list" window, select the tag and the "Server settings" command from the shortcut 
menu.

6. In the "Server settings" dialog, enter the name and password of a WinCC user. Activate 
"Activate automatic login". Confirm your entries.
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7. In the window "Tag list", select the tag and select the menu command "Properties" from 
the shortcut menu. The dialog "Tag properties" will be opened.

8. Define the properties for the view in the table, e.g. the arrangement of headers, time stamps, 
and quality code.

9. To apply the set update cycle to all tags, select "Save as default".
Settings in the areas "Display in sheet" and "Additional Data" are not valid for all tags.

10.Confirm your entries. Click the "Next >" button in the dialog "Add tag". The dialog "Add/
delete logging tags (Page 2674)" is opened.

Result
The display of tag values in an Excel sheet is configured.     

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying a tag value. 

With tag values, the short text "OV" stands for online tags. 

In the comments, the source of the displayed values is shown in the format 
"WDWx_<number>_<tagname>". 
The value for x means: 
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● O = Online value
 

  Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. 
The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

 

Configuring the display of logging tags

Requirement
● The dialog "Add / delete logging tags" is open.

Procedure
Proceed as follows to display logging tags in Excel:

1. In the "Tag tree" area, click the directory icon. The object list opens.

2. Select the desired logging tag in the object list and drag the logging tag into a field of the 
Excel table.

3. Close the object list. The logging tag will be displayed in the window "Tag list".
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4. In the window "Tag list", select the logging tag and select the menu command "Properties" 
from the shortcut menu. The dialog "Archive tag properties" will be opened.

5. Define properties for display in the table, e.g. the insert sequence, data resolution, display 
time window.

6. To save the settings, select "Save as default". The settings in the "Additional data" area 
are not saved.

 

  Note

If you use the option "Number of data" for Data resolution > User-defined resolution", enter 
an even value in the input box. Even values ensure proper trend display.

 

7. Confirm your entries. Click the "Next >" button in the dialog "Add logging tag". The dialog 
"Add/remove alarms (Page 2676)" will open.

Result
The display of logging tag values in an Excel sheet is configured. 

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying a tag value. 

With tag values, the short text "AV" stands for logging tags. 

In the comments, the source of the displayed values is shown in the format 
"WDWx_<number>_<tagname>". 
The value for x means: 
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● A = Archive value
 

  Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. 
The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

See also
Configuring the display of tag values (Page 2672)

Configuring the display of alarms

Requirement
The dialog "Add / Delete Alarms" is open.
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Procedure
Proceed as follows to display alarms in Excel:

1. Select the required cell in the Excel table. Click "Add alarm".

2. In the "Add alarm" area, click the directory icon. The dialog "Alarm - properties" will be 
opened.

3. Define the properties for the display of alarms in the Excel table, such as headings and 
insertion sequence of attributes.

4. Enter a filter condition in the "Filter string" field or use the selection dialog to define specific 
alarms to be displayed, for example.

5. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 alarms.

6. Activate the desired attributes in the list. For additional information, refer to "Alarm 
Attributes (Page 2681)".
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7. To save the setting, select "Save as default".

8. Confirm your entries. Click the "Next >" button in the dialog "Add logging tag": The 
"Description" dialog box will open.

Result
The display of alarms in an Excel sheet is configured. 

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying an alarm. 

With alarms, the short text "AL" and the comment are shown in the format 
"WDWL_<nummer>_<feldbezeichnung>".

 

 Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. The 
configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

See also
Configuring the display of logging tags (Page 2674)

Publishing an Excel workbook

Requirement
The display of tag values, logging tags and alarms is configured.

The "Description" dialog box is open.

Procedure
To access Excel workbooks on the DataMonitor Server, proceed as follows:

1. Click "Publish". The Excel workbook is made available for download on the DataMonitor 
Server.

2. Use the "Template" button to provide the Excel Workbook for the function "Published 
Reports".

3. Exit the Excel Workbook Wizard

4. Save the workbook and close Excel.

Alternative procedure
You publish the Excel template on the DataMonitor client. For additional information, refer to 
"Preparing an Excel Workbook as a Template (Page 2683)".
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Result
The Excel workbook is made available on the DataMonitor Server. If required, the Excel 
workbook is downloaded on the DataMonitor clients or opened directly in Internet Explorer.

Displaying process data in an Excel Workbook online

Requirements
● The Excel workbook with the configuration of the process value display must be available 

on the PC.

● One of the following Excel versions is necessary for online display in the Excel Workbook:

– Office 2003 SP3

– Office 2007

● WinCC Runtime Professional is installed

● DataMonitor Server is installed.

● The WinCC project is in Runtime.

● The DataMonitor start page is open.

● The user "DM_Demo" has been created (Page 2616).

Procedure
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Report tools" tab.
The Excel workbooks that were published in the Excel Workbook Wizard, are shown in an 
overview.

3. Select a workbook.

4. Click the Excel workbook symbol in the "Open / Save" column.

5. Click "Open >" in the next dialog. The Excel workbook opens.

6. Select the "Excel Workbook" command in the "DataMonitor" menu.
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7. The name of one of the servers, whose tags are configured in the Excel table, is displayed 
in the "WinCC Server" field.
The following options are available for the server name:

– Access via domain
In case of accesses from outside the network domain, the domain is indicated along 
with the server name.

– The DataMonitor start page is the standard Web page.
Only the server name is entered in the "WinCC Server" field.

– The DataMonitor start page is in the virtual directory:
The name of the virtual folder needs to be specified after the server name, e.g. "/
webnavigator".

8. Activate the "All servers" check box when the tags from several servers are configured in 
an Excel sheet. The tag values of all the servers are updated in the online display.

 

  Note

To establish connections to all the servers, select "All servers" before pressing the 
"Connect" button to establish the connection.

 

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened. Enter the user name "DM_Demo" and the 
respective password. When several servers are used, the logon dialogs of the servers 
concerned open one after the other.
If no connection is established, a corresponding message is displayed. Clicking on the 
dialog will display further information about the error (if available).

 

  Note

The Excel Workbook dialog must not be closed as long as the logon dialog for connection 
establishment to the server persists.
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10.The connection status will be displayed in the dialog. Click the buttons "Read tags", "Read 
logging tags" and "Read alarms" buttons to update the respective values or displays.

If necessary, select the check box "Read cyclically" to update the tag values in cycles.

11.Close the dialog "Excel Workbook" after ending your calculations in Excel.

12.Save the results in the workbook and close Excel.

Result
The values of an online tag, a logging tag as well as a message window are displayed in the 
Excel table. 

Alarm Attributes

Introduction
While displaying messages in Excel Workbook  you can select the attributes to be displayed 
in the Excel sheet in the Excel Workbook Wizard .

Overview 

Position Attribute Type Comments
1 Alarm class name VarChar (255)  
2 Alarm type name VarChar (255)  
3 Foreground color Integer 4 Bytes  
4 Background color Integer 4 Bytes  
5 Flashing color Integer 4 Bytes  
6 to 15 Alarm Text 1 to 10 VarChar (255)  
16 to 25 Process value 1 to 10 Real 8 Bytes Numerical Process Value 1 to 10
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Position Attribute Type Comments
26 State VarChar (255) Status text
27 Info text VarChar (255)  
28 Alarm class ID Integer 4 Bytes  
29 Message type ID Integer 4 Bytes  
30 AS Number Small Integer 2 Bytes  
31 CPU Number Small Integer 2 Bytes  
32 Duration Integer 4 Bytes Time difference to "Incoming" status
33 Alarm counter Integer 4 Bytes Consecutive alarm counter
34 Acknowledgment Status VarChar (255) Text of the acknowledgement status
35 Priority Integer 4 Bytes  
36 Application  Application with which the comment was created.
37 Computer VarChar (255) Computer on which the comment was created.
38 Users VarChar (255) User who created the comment.
39 Comments VarChar (255)  

See also
Configuring the display of alarms (Page 2676)

VBA Functions of the Excel Workbook

Excel workbooks: VBA functions of the Excel workbook
The following functions are available to you in an Excel workbook if you have generated an 
instance of the Excel workbook object using the 
"Application.COMAddIns.Item("ExcelWorkbook.Connect").Object".

● ShowDialog(0): Opens the "Excel Workbook" dialog with a normal size.

● ShowDialog(1): Opens the "Excel Workbook" dialog with a minimized size.

● ShowDialog(2): Opens the "Excel Workbook" dialog hidden.

● CloseDialog: Closes the "Excel Workbook" dialog.

● GetServerID(server name): Gets the ID of the WinCC server with a specified name, for 
example: "http://Local_PC".

● Connect(ServerID): Connects the specified WinCC server to the Excel workbooks. You can 
get the "ServerID" using the "GetServerID(server name)" function. The "Excel Workbook" 
dialog must be opened before establishing a connection.

● ConnectAll: Connects all WinCC servers to Excel workbooks. The "Excel Workbook" dialog 
must be opened before establishing a connection.

● Disconnect(ServerID): Disconnects the Excel workbook from the specified WinCC server.

● DisconnectAll: Disconnects the Excel workbook from all WinCC servers.

● ReadTags(ServerID): Reads the tags from WinCC server with "ServerID". The connection 
must be established before tags can be read.
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● ReadArchives(ServerID): Reads the logs from WinCC server with "ServerID". The 
connection must be established before logs can be read.

● ReadAlarms(ServerID): Reads the alarms from WinCC server with "ServerID". The 
connection must be established before alarms can be read.

As soon as a connection is established or closed, the event "ServerConnected(ServerID)" or 
"ServerDisconnected(ServerID)" is output by the "ExcelWorkbook.Connect" object. These 
events can be integrated, for example, using "WithEvents" (VB standard).

9.15.5.7 Working with reports

Preparing an Excel Workbook as a Template

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
Proceed as follows to prepare Excel workbooks as a template:

1. Click "Reports" in the start page.

2. Click the "Upload templates" tag.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click the "Browse" button in the "Selected template" field. Navigate to the required Excel 
workbook.

5. Click the "Upload" button.
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Result
The template is prepared for the function "Published Reports".

See also
Publishing an Excel workbook (Page 2678)

Configuring an Excel workbook (Page 2670)

Making an Excel workbook available as a report tool

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
Proceed as follows to prepare Excel workbooks as a report tool:

1. Click "Reports" in the start page.

2. Click the "Upload templates" tag.

3. Click the "Browse" button in the "Excel Workbook" field. Navigate to the required Excel 
workbook

4. Click the "Upload" button.

Result
The Excel workbook is ready in the "Report tools" section.
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Making Settings for Reports

Introduction      
Different settings are required for using the function "Reports" from DataMonitor. 

Requirements
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor server.

● The WinCC project is selected in "Scheduled print jobs in Runtime".

● The DataMonitor start page is open.

Visualizing processes (Professional)
9.15 Options

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2685



Procedure
To configure the reports settings, proceed as follows:

1. Click "Reports " in the start page. Click the "Settings" tab.
The "Settings" page is displayed.

2. Check the entries in the section "General project settings".
To enable output to a PDF file, select "Activate API print".

3. Enter the data for sending mail in the "Mail" area:

– Server
Outgoing mail server (SMTP)

– User name
Name for the sender

– Password

– Sender
Email account, through which you send your Email

4. Click the disk icon in the section "General project settings" to save your settings.
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5. In the "Circular buffer" area, you can define how many reports can be stored for the selected 
target directory. The field has a pre-assigned value of 20.

6. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have now been made. 

Displaying a report with an Excel Workbook

Requirements   
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor server.

● The WinCC project is selected in "Scheduled print jobs in runtime".

● The DataMonitor start page is open.
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Procedure
Proceed as follows to create a report with Excel workbooks:

1. Click "Reports" in the start page. Click the "Excel Workbooks" tab.
The "Excel Workbooks" page is displayed.

The icons in front of the lists "List of time-controlled Excel Workbooks" and "List of event-
controlled Excel Workbooks" are cleared and show that currently, no reports are triggered.

2. Select the desired Excel workbooks, e.g. "My_workbook_1.xls" in the "Existing Excel 
Workbooks" field.
This field only shows Excel Workbooks that meet the following conditions:

– Workbooks that are published as templates in the Excel Workbook Wizard

– Workbooks in directories for which the current user has the "Read" access right.

3. Select the directory, in which the reports will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Enter an e-mail address in the field "E-mail recipient". The report is e-mailed to this address.
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5. To configure time-controlled triggering, define the following in the "Time-controlled Excel 
Workbooks" area.

– Date:
Enter the date in the field or define the date using the calendar. To open the calendar, 
click the "calendar" symbol.

– Time
Define the triggering time. 

– Repetition
Define the repetition rate, e.g. "Once" or "Weekly".

6. Click the "Add" button in the "Time-controlled Excel Workbooks" area. The report is 
displayed in the "List of time-controlled Excel workbooks".

7. To create the report immediately, click the symbol .

8. To configure event-controlled triggering, define the following in the "Event-controlled Excel 
Workbooks" area.

– Selected WinCC tag
Click . The object list opens. Select the desired tag from the object list.

– Define the event control
Define the triggering event, e.g. change of the tag value.
If you selected "Low limit", "High limit", or "Both limits" for event control, you need 
corresponding limit values.

9. Click the "Add" button in the "Event-controlled Excel Workbooks" area. The report is 
displayed in the "List of event-controlled Excel workbooks"

Result
A time-controlled or event-controlled report has been triggered with an Excel workbook. 

The report is displayed in one of the lists "List of time-controlled Excel workbooks" and "List 
of event-controlled Excel workbooks". The report can be changed or deleted in the list. 

 

 Note

An event-controlled print job will not be initiated if the time, in which the tag changes, is less 
than one minute.

Note that frequent initiation of the event-controlled print job OR simultaneous initiation of 
several print jobs over an extended period will lead to heavy load on memory space and 
resources, e.g. frequent signal changes of a tag.

 

Creating a report with a print job

Requirements 
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor Server.
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● The WinCC project is selected in "Scheduled print jobs in runtime".

● The DataMonitor start page is open.

Procedure
1. Click "Reports" in the start page. Click the "Print jobs" tab.

The "Print Jobs Configuration" page is displayed.

The icons in front of the lists "List of time-controlled print jobs" and "List of event-controlled 
print jobs" are cleared. The icons indicate that no reports are currently triggered.

2. Select the desired print job, such as "Report OnlineTableControl-CP" in the "Existing print 
jobs" field.
You can create the report immediately via the  icon.

3. In "Target directory: ", select the directory in which the reports are created.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Enter an e-mail address in the field "E-mail recipient". The report is e-mailed to this address.

5. To configure time-controlled triggering, define the following in the "Time-controlled print 
jobs" area.

– Date:
Enter the date in the field or define the date using the calendar. To open the calendar, 
click the "calendar" symbol.

– Time
Define the triggering time. 

– Repetition
Define the repetition rate, e.g. "Once" or "Weekly".
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6. Click the "Add" button in the "Time-controlled print jobs" area. The report is displayed in 
the "List of time-controlled print jobs".

7. To configure event-controlled triggering, define the following in the "Event-controlled print 
jobs" area.

– Selected WinCC tag
Click the  icon. The object list opens. Select the desired tag from the object list.

– Define the event control
Define the triggering event, when the tag value is changed, for example

– Low limit and high limit
If you selected "Only low limit", "Only high limit" or "Both limits" for event control, limits 
are required. 

8. Click the "Add" button in the "Time-controlled print jobs" area. The report is displayed in 
the "List of event-controlled print jobs".

Result
A time-controlled or event-controlled report with print job in PDF format has been created. 

Depending on the type, the report is displayed in one the "List of time-controlled print jobs" or 
"List of event-controlled print jobs". The report can be changed or deleted in the list.

 

 Note

An event-controlled print job will not be initiated if the time, in which the tag changes, is less 
than one minute.

Please consider that a frequent triggering of the event-controlled print job over a long time 
period will use a lot of memory and resources, such as the frequent signal change of a tag.
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9.16 Interfaces

9.16.1 OPC

9.16.1.1 OPC for Runtime Advanced

Basics

OPC

Introduction
OPC refers to standardized manufacturer-specific software interfaces for data exchange in 
automation engineering.  

The OPC interfaces provide a standardized environment in which devices and applications 
from various manufacturers can be linked.

OPC is based on the Windows technology COM (Component Object Model) and DCOM 
(Distributed Component Object Model).

OPC UA (Unified Architecture) is the technology succeeding OPC. OPC UA is platform-
independent and can use different reports as a communication medium.

Principle of operation
In WinCC, you can configure HMI devices as OPC servers or OPC clients. The particular HMI 
device determines which OPC servers and OPC clients are available. 

OPC Specifications
OPC specifies interfaces to gain access to the following objects in WinCC:  

● Process values (OPC Data Access 1.0, 2.05a)

● Process values (DataAccess ClientFacet (OPC UA)

● Process values (OPC XML-Data Access 1.01)

You can find additional information about the individual OPC specifications in the Internet at 
the website of OPC Foundation:.

● www.opcfoundation.org (www.opcfoundation.org)

See also
Supported OPC UA services of the OPC UA client (Page 2704)
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Compatibility
Support of the mentioned specifications is checked regularly by the "Compliance Test Tool" 
(CTT) of the OPC Foundation. Interoperability with OPC products of other manufacturers is 
ensured through the participation in "OPC Interoperability Workshops". 

The test results submitted are published on the website of the OPC Foundation. The results 
can be called up from there using the search term "OPC Self-Certified Products".

Using OPC in WinCC

Configuration option
HMI devices configured with WinCC feature an OPC interface for data communication between 
automation devices or automation systems using the OPC communication driver. 

You can use an HMI device as an OPC server and/or as an OPC client. As an OPC client, the 
HMI device can be connected to a maximum of eight OPC servers. 

The software ensures up to eight client HTTP connections for an OPC XML DA server on a 
Multi Panel. For the exchange of data via an XML connection, some OPC XML DA clients 
create several HTTP connections to the OPC XML DA server.        

HMI device Data exchange over Operating system OPC server OPC client
PC, Panel PC (with 
WinCC Runtime 
Advanced)

DCOM or 
OPC UA binary (TCP/
IP)

Windows XP / 7 OPC DA server OPC DA client
OPC UA Client

MP 277, MP 377 
Mobile Panel 277

SOAP Windows CE OPC XML DA Server -

Comfort Panel SOAP or 
OPC UA binary (TCP/
IP)

Windows CE OPC XML DA Server OPC UA Client

*: The OPC UA client exchanges data via TCP/IP. 

A communication via DCOM is only possible between HMI devices of the "PC" or the 
"Panel PC" type. In order for a control room PC to display the process values of Windows CE 
HMI devices in the plant, for example, install "OPC-XML-Gateway" on the control room PC 
using the WinCC Runtime Advanced Setup. The "OPC-XML-Gateway" supports the 
communication within the SIMATIC HMI devices family between an OPC DA client and an 
OPC XML DA server. 

The area pointer is supported by any OPC connection. 

OPC server accessibility    
The following table lists the available OPC servers and how you can access them:

OPC server OPC server name
OPC DA server OPC.SimaticHMI.MhiRTm (ProgID)
OPC XML DA Server http://<xxx>/soap/OpcXml (URL) 1

<xxx>: IP address or DNS name of the HMI device
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OPC server OPC server name
OPC DA server OPC.Siemens.XML (ProgID) for accessing the OPC XML DA server via 

the OPC XML gateway from an OPC DA client
1: For the access of an external OPC DA XML client. 

HMI device as OPC client   
To use an HMI device as an OPC client, create an "OPC" connection in the WinCC project. 
The OPC client accesses the tags of the OPC server over this connection. You need a separate 
connection for each OPC server. 

The following exception applies here:

If you want to connect your OPC DA client to multiple panels, you only need one OPC 
connection to the OPC XML gateway in your project. The multiplexing of the connection to 
multiple OPC XML connections to individual panels takes place in the OPC XML62 gateway. 
You configure the connections to the panels using he OPC XML Manager.

The following figure shows the use of an HMI device as a central operator control and 
monitoring device:

HMI device as OPC server   
An HMI device as OPC server makes the data available to other applications. The applications 
can run on the same HMI device or on HMI devices in the connected network environment. 

The following schematic diagram shows the use of MS Excel as an OPC client that displays 
process values of the OPC server: 

Visualizing processes (Professional)
9.16 Interfaces

WinCC Professional V11.0 SP1
2694 System Manual, 08/2011,  



See also
Configuring an HMI device as OPC DA server (Page 2695)

Creating a connection to a WinCC OPC DA server (Page 2697)

OPC XML Gateway (Page 2700)

Configuring an OPC server

Configuring an HMI device as OPC DA server

Introduction
Which OPC server is used depends on the HMI device:

● For HMI devices with Windows XP / 7, the OPC DA server is used.

● For HMI devices with Windows CE, the OPC XML DA server is used

The following figure shows the two methods of accessing an OPC server:
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Procedure   
To configure an HMI device as an OPC server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Select the "Operate as OPC server" option in the "Runtime settings" under "Services > 
Write/read tags".

3. Save the project.

4. Download the project to the HMI device.

5. Start runtime on the HMI device.

Result
The OPC server is accessible. If an OPC client connects to the OPC server, the OPC server 
on the HMI device is started. 

See also
Using OPC in WinCC (Page 2693)

Creating a connection to a WinCC OPC DA server (Page 2697)

Configuring DCOM user permissions in Windows

Introduction    
The OPC DA client and OPC DA server are DCOM applications, whose security settings must 
be set in compliance with the DCOM security mechanisms:

● The OPC client needs launch/activation rights and access rights for the OPC DA server.

● The OPC DA server only needs access rights for the OPC DA client

The following must be known on the PCs of the OPC DA server and the OPC DA client 
respectively:

● The user account for which the OPC DA client is executed

Requirement
You have administrator rights.

Procedure
The procedure for configuring DCOM user rights is described in the document (http://
www.opcfoundation.org/DownloadFile.aspx?CM=3&RI=326&CN=KEY&CI=282&CU=14) of 
the OPC-Foundation. 

For additional information on granting user rights, refer to the documentation for Windows XP, 
Windows Vista, or Windows 7. 
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Configuring an OPC client

Creating a connection to a WinCC OPC DA server

Introduction
For an HMI device to access the OPC server data of another HMI device, you need to create 
a connection to this OPC server in the WinCC project. Depending on the target HMI device 
used, either an OPC DA server or an OPC XML DA server is employed. 

The following figure shows the two methods for accessing the OPC servers of the HMI devices:

If a connection to one or more OPC XML DA servers is created using an OPC XML gateway, 
also enter the OPC XML DA servers in the "OPC XML Manager". 

Requirement
● An HMI device is configured as an OPC server.

● The project on the HMI device is in runtime.

● For connections to a OPC XML DA server: "OPC-XML-Gateway" is installed on the 
configuration PC and the HMI device with the OPC client.

Procedure   
To create a connection to an OPC server of an HMI device, follow these steps:

1. Open the "Connections" editor on the configuration PC in the WinCC project of the OPC 
client.

2. Create a new connection and enter a meaningful name.
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3. Select the entry "OPC" as the "Communication driver".

4. Enter the communication partner under "Parameters > OPC server" in the work area:

– If the connection communicates directly with the OPC server or with the OPC server on 
a PC-based HMI device, select the "OPC.SimaticHMI.CoRtHmiRTm" item from the list.

– If the connection communicates directly with the OPC server of a Windows CE HMI 
device, select "OPC.Siemens.XML" from the list.

– If the OPC server is installed on a remote computer, enter the computer's IP address 
or name under "Remote computer name".

Result
The OPC connection is configured. To access the data on the WinCC OPC DA server, create 
tags. 

See also
Using OPC in WinCC (Page 2693)

Configuring an HMI device as OPC DA server (Page 2695)

OPC XML Gateway (Page 2700)

Configuring an OPC XML Manager (Page 2701)

Creating a connection to an OPC UA server

Introduction
The OPC UA client can access process data in the hierarchical name space of an OPC UA 
server. 

For the OPC UA client to access the process values of an OPC UA server, the OPC UA server 
and the OPC UA client authorize each other by exchanging certificates. In addition, you can 
encode the data transfer. 

The OPC UA client usually classifies each certificate of an OPC UA server as a "trustworthy". 
How an OPC UA server responds to a connection request of the OPC UA client depends on 
the configuration of the OPC UA server. 

In order to establish communication to an OPC UA server, inform yourself from the OPC UA 
server operator about the following:

● URL of the OPC UA server

● Security settings

● Required certificates

Requirement
URL and security settings of the OPC UA server are known.
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Procedure   
To create a connection to an OPC UA server, proceed as follows:

1. Open the "Connections" editor on the HMI device.

2. Create a new connection and enter a meaningful name.

3. Select the entry "OPC UA" as the "Communication driver".

4. In the work area, under "Parameters", configure the "OPC server":

– Specify the "Discovery URL" of the OPC UA server or select the OPC UA server from 
the list.

– Select the "Security policy"

– Select the "Message security mode"

Result
The OPC UA connection is configured. You create tags to access data from the OPC UA 
server. 

See also
Supported OPC UA services of the OPC UA client (Page 2704)

Accessing process values of an OPC server

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● A connection to the OPC-Server is created

Procedure   
To access process values of an OPC-Server via the OPC connection, follow these steps:

1. On the configuration PC in the project navigation, open the "HMI tags" editor under the HMI 
device that you use as an OPC client.

2. Create a tag with the same data type as the tag on the OPC server.

3. Select the OPC connection for "Connection".

4. Enter the "Address", or select the desired tag on the OPC server via the object list.

Result
If you launch Runtime on the HMI device, the process value from the OPC server will be written 
to the tag on the HMI device via the OPC connection. 
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See also
Permitted data types (OPC) (Page 2702)

Access to tags with OPC (Page 2703)

OPC XML Gateway

Usage
The OPC DA client uses the "OPC XML Gateway" so that the OPC DA client can communicate 
with the OPC XML DA server. The "OPC XML Gateway" compiles the data in the respective 
"language" of the corresponding standard. The "OPC XML Gateway" communicates 
exclusively with the OPC XML DA server which runs on an SIMATIC HMI device. 

Installation
To install "OPC XML Gateway", activate the "OPC XML Gateway" entry during installation of 
WinCC runtime advanced in the component selection. To install "OPC XML Gateway" 
afterwards, re-execute the setup of WinCC Runtime Advanced. 

Proxy setting for the OPC XML Gateway
The configuration settings for the OPC XML Gateway can be found in the "SOPCSRVR.ini" 
file in the section "[Configuration]". The OPC XML Gateway is configured by default on the PC 
as the HMI device, so that a proxy server configured in the Internet settings of Internet Explorer 
is ignored: 

NOPROXY=1

If this entry is set to "0", the OPC XML Gateway uses a configured proxy server for HTTP 
connections. 

You can find the "SOPCSRVR.ini" file in the folder "C:\Program Files\\Siemens\Automation
\WinCC RT Advanced". 

 

 Note

When data is requested from an HMI device that cannot be accessed over the configured 
proxy server, the OPC XML Gateway uses a direct connection after a Timeout. The direct 
connection is set up again on every request for data and slows down OPC communication 
significantly.

 

 

See also
Configuring an OPC XML Manager (Page 2701)

Using OPC in WinCC (Page 2693)
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Configuring an OPC XML Manager

Introduction
The OPC XML DA server, to which the OPC DA client has access, is administered in the "OPC 
XML Manager". The OPC XML Manager can be found in the Windows Start menu under 
"SIMATIC > OPC-XML-Gateway > OPC XML Manager".

To enter an OPC server, you need the following information:

● Server prefix
Any string that is used in the name of the OPC tag. Use an abbreviation of the server, for 
example. You can find the characters permitted for tag names in the reference. 

● Name or IP address of the OPC XML DA server

Requirement
"OPC XML Manager" is open.

Procedure   
To configure the OPC XML Manager, proceed as follows:

1. To enter a new OPC XML DA server, click on the button "Add".
The "Add/Edit Webservice" dialog is opened.

2. Enter the server prefix and the name or IP address of the OPC XML DA server.

3. Close the two dialogs with "OK".

Result
The OPC XML DA server is entered. The OPC DA client can now access the data of the OPC 
XML DA server via the "OPC XML Gateway".

Editing or removing an OPC server     
To edit or delete a configured OPC XML DA server, select the required OPC XML DA server. 
Then click either "Edit" or "Remove" . 

See also
OPC XML Gateway (Page 2700)
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Reference

Permitted data types (OPC)

Permitted data types
The following table lists the data types supported by the WinCC OPC servers:    

OPC data type WinCC data type
VT_BOOL BOOL
VT_I1 CHAR
VT_UI1 BYTE
VT_I2 SHORT
VT_UI2 WORD
VT_UI4 DWORD
VT_I4 LONG
VT_R4 FLOAT
VT_R8 DOUBLE
VT_DATE DATE
VT_BSTR STRING

The following table lists the ranges of values of the OPC data types:

OPC data type Range of values
VT_BOOL 0 or -1
VT_I1 -128 to 127
VT_UI1 0 to 255
VT_I2 -32768 to 32767
VT_UI2 0 to 65535
VT_I4 -2147483648 to 2147483647
VT_UI4 0 to 4294967295
VT_R4 3.402823466 e-38 through 3.402823466 e+38
VT_R8 1.7976931486231e-308 to 1.7976931486231e+308
VT_Date 1 January 100 to 31 December 9999

Special features in communication with the OPC-DA server
The array tag in the OPC-DA server belonging to the area pointer must be of the data type 
SHORT (VT_I2). 

Special features in communication with the OPC-XML server
Array tags are not supported by OPC-XML servers.
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Access to tags with OPC

Introduction  
When accessing tags with OPC, note the following when configuring tags:

● Permitted characters in tag names

● Permitted cycle times (OPC XML)

● Special features of the data type "STRING" (OPC XML)

● Special features of the data type "Date/Time" (OPC XML)

The OPC XML DA server is tested and enabled for eight connections, each with 2 groups and 
consisting of 35 tags. 

Permitted characters in tag names  
Only use the following characters in tag names:

● Letters from "a" to "z" (no umlauts)

● Numbers from "0" to "9"

● Special characters: "-" and "_"

Permitted cycle times (OPC XML)  
OPC XML connections are designed for the exchange of small volumes of data:

● For this reason use cycle times that are greater than one second

● In general, only request a small number of tags; a maximum of 30 per screen

Special features of the data type "STRING" (OPC XML)  
Only valid ASCII values from 0x20hex to 0x7Fhex are supported in the data type "STRING".

Special features of the data type "Date/Time" (OPC XML)  
Values of the data type "Date/Time" are always expected as UTC (Universal Time 
Coordinated) by the OPC-Gateway. If a tag of the type "Date/Time" is read by the OPC client, 
the returned value is a time in UTC. If a value is written to the tag, the value is treated as UTC. 
The time including the time zone and daylight saving time are shown as "local time" on an HMI 
device. 

Example:

The time zone GMT+1 and daylight saving time is set on the HMI device.

OPC DA client (UTC time): 01.01.2005 16:00

Display on the HMI device (OPC server): 01.01.2005 18:00
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Supported OPC UA services of the OPC UA client

OPC UA Services support
The OPC UA client supports the following OPC UA services:

● SecurityPolicy - Basic128Rsa15

● SecurityPolicy - Basic256

● SecurityPolicy - None

● DataAccess ClientFacet

You can additional information about OPC UA services in the "OPC UA Part 3 - Address Space 
Model 1.01 Specification" document under "§5.6". 

Explanation of the security settings
The following table lists the security settings supported by the OPC UA client: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa152 None4 Sign5 SignAndEncrypt6

Basic2563 None Sign SignAndEncrypt
1: The certificate exchange is disabled. Every OPC UA client can log on to the WinCC OPC UA server. This setting can be 
disabled on each OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: Certificate exchange with depth of encryption of 256 bit.
4: The data packages are exchanged after certificate check unsecured between client and server. 
5: The data packages are signed with the certificates, but not encoded
6: The data packages are signed with the certificates and encoded

 
 

 NOTICE

Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.

For a secure communication between client and server, use in operating mode at least the 
following settings:
● SecurityPolicy: Basic128Rsa15
● Message Security Mode: Sign

 

See also
Creating a connection to an OPC UA server (Page 2698)
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9.16.1.2 OPC for Runtime Professional

Basics

OPC
OPC refers to standardized manufacturer-specific software interfaces for data exchange in 
automation engineering.  

The OPC interfaces provide a standardized environment in which devices and applications 
from various manufacturers can be linked.

OPC is based on the Windows technology COM (Component Object Model) and DCOM 
(Distributed Component Object Model).

In addition, OPC XML DA offers a further software interface that is based on the Internet 
standards XML, SOAP, and HTTP.

OPC UA (Unified Architecture) is the technology succeeding OPC. OPC UA is platform-
independent and can use different reports as a communication medium.

See also
Using OPC in WinCC (Page 2706)

OPC Specifications (Page 2705)

Compatibility (Page 2706)

OPC Specifications
OPC specifies interfaces to gain access to the following objects in WinCC:  

● Process values (OPC Data Access 2.05a, 3.0; OPC XML Data Access 1.01; OPC UA 1.01)

● Log process values (OPC Historical Data Access 1.20; OPC UA 1.01)

● Logged alarms (OPC Historical Alarms and Events v0.92)

● Alarms (OPC Alarms and Events 1.10)

For detailed information about the individual OPC specifications, refer to the website of OPC 
Foundation. 

*: Draft from Siemens, which is available on the OPC Foundation website. 

See also
Using OPC in WinCC (Page 2706)

OPC Foundation (www.opcfoundation.org)
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Compatibility
Support of the mentioned specifications is checked regularly by the "Compliance Test Tool" 
(CTT) of the OPC Foundation. Interoperability with OPC products of other manufacturers is 
ensured through the participation in "OPC Interoperability Workshops". 

The test results submitted are published on the website of the OPC Foundation. The results 
can be called up from there using the search term "OPC Self-Certified Products".

See also
OPC (Page 2705)

Licensing

Licensing
For the operation of one of the supported WinCC OPC servers, the following license must be 
installed:

● WinCC Basic System

Using OPC in WinCC

Introduction
On a HMI device with "WinCC Runtime Professional" there are server for the following OPC 
interfaces available:

● OPC Data Access / OPC XML Data Access: Access to the data management of WinCC

● OPC Historical Data Access: Access to the WinCC log system

● OPC Alarms&Events: Access to the WinCC alarm system

● OPC Unified Architecture: Access to the data management and the WinCC log system

In addition, there is by default in WinCC an OPC channel that can access the corresponding 
OPC data access server as client via OPC DA or OPC XML DA.

All WinCC OPC servers are certified by the OPC Foundation.
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OPC communication concept of WinCC  
The following screen shows the OPC communication concept of WinCC:

See also
Licensing (Page 2706)

Functionality of the WinCC OPC DA Server (Page 2709)

Functionality of WinCC OPC XML DA server (Page 2709)

Functionality of the WinCC OPC HDA server (Page 2711)

Functionality of the WinCC OPC A&E server (Page 2720)

Principle of operation the WinCC OPC UA Server  (Page 2738)

Creating a connection to an OPC server (Page 2747)
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Configuration

Basic settings for OPC

Introduction
For the following WinCC OPC servers, you configure the basic settings on the configuration 
PC for OPC in the HMI device runtime settings:

● OPC HDA

● OPC A&E

● OPC UA

Basic settings for OPC   
For HMI devices with Runtime Professional, you define the following in the runtime settings:

● OPC settings
You configure the following in this category:

– Exception rules for the validation of writing access to log data

– Security concept of the WinCC OPC UA server

● Alarms
In this category you configure the mapping of the WinCC alarm system for the alarm 
behavior of the following WinCC OPC servers: 

– OPC A&E

See also
Configure WinCC OPC HDA Server (Page 2719)

Configure WinCC OPC A&E server (Page 2731)

Configure WinCC OPC UA Server (Page 2746)

WinCC OPC server

Accessibility of WinCC OPC servers
Client-specific OPC clients data from the WinCC data management are available for the 
WinCC OPC servers, for example, process values or alarms. 

In order to access a WinCC OPC server, you must activate the related WinCC project on the 
HMI device. 
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WinCC OPC DA Server

Functionality of the WinCC OPC DA Server

Principle of operation    
The WinCC OPC DA server enables any OPC DA client to access process values from the 
data management of WinCC.

Supported specifications  
The WinCC OPC A&E Server supports OPC Data Access 2.05a and 3.0.

ProgID of the WinCC OPC DA servers   
You access the WinCC OPC DA server via the following ProgID: 
"OPCServer.WinCC_SCADA". 

Quality codes 
The "Quality Code" delivers information on the status and quality of the process values. For 
more information, refer to the "OPC Data Access 3.0" specification.

See also
Using OPC in WinCC (Page 2706)

Accessibility of WinCC OPC servers (Page 2708)

Licensing (Page 2706)

WinCC OPC XML DA server

Functionality of WinCC OPC XML DA server

Principle of operation    
WinCC's OPC XML DA Server is implemented as a web service of Microsoft Internet 
Information Server (IIS). The OPC XML DA client accesses the OPC XML DA server via an 
internet protocol to which process values from the data management of WinCC are available. 

Supported specifications  
The WinCC OPC XML DA Server supports the specification OPC XML Data Access 1.01. 
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"OPC XML Data Access" is a standard that supports communication over the Internet by 
means of platform-independent protocol (SOAP/XML). The data access via OPC XML Data 
Access has an OPC Data Access leaning on the scope of operation. 

URL of the WinCC OPC XML DA servers    
You access the WinCC OPC XML DA server via the following URL: "http://<xxx>/WinCC-OPC-
XML/DAWebservice.asmx" 

<xxx>: IP address or DNS name of the OPC XML DA server
 

 Note

If automatic detection of settings is enabled on a PC for the internet options under 
Connections > LAN Settings", access to OPC XML DA through the web service will be slowed 
considerably. 

 

Quality codes 
The "Quality Code" delivers information on the status and quality of the process values. For 
more information, refer to the "OPC XML Data Access1.01" specification.

Special features of tags of "String" type
If you use tags of "string" type that logically stand for floating point values, there can be 
problems when OPC clients want to write and read.

Description
An OPC client writes to a string tag and does not enter the new value in the form of a string 
but as float, double or decimal.

Problem
The comma that indicated the decimal value (in German) can be lost. This will result in a wrong 
value. This behavior also occurs when string tags are read if the value being read is requested 
in float, double, or decimal format.

Remedy
Only use the respective floating point tags for the floating point values. Get string tags only in 
string format. 

See also
Using OPC in WinCC (Page 2706)

Accessibility of WinCC OPC servers (Page 2708)

Installing WinCC OPC XML DA Server (Page 2711)
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Installing WinCC OPC XML DA Server

Introduction
To install the OPC XML DA server automatically in the framework of the WinCC setups, the 
following settings  on the HMI device must be fulfilled:

● Internet Information Service (IIS) is installed

● Microsoft .NET-Framework 2.0 is installed

If the requirements are not fulfilled, you must install the OPC XML DA server separately after 
you have installed the IIS and .Net-Framework 2.0. To avoid problems during installation, follow 
in any case the steps described below. 

Procedure   
To configure the OPC XML DA server on the HMI device, proceed as follows:

1. Install the "Microsoft Internet Information Service (IIS)".

2. Install the "Microsoft .NET-Framework 2.0".

3. Install the WinCC OPC XML DA Server via the WinCC setup.

4. Test the installation on the OPC server:

– Launch Internet Explorer on the PC running as the WinCC OPC XML Server.

– On the address bar enter the URL "http://localhost/WinCC-OPC-XML/
DAWebservice.asmx".

If a page with the supported operations is displayed in Internet Explorer, the installation 
was successful.

See also
Functionality of WinCC OPC XML DA server (Page 2709)

WinCC OPC HDA Server

Functionality of the WinCC OPC HDA server

Principle of operation    
The WinCC OPC HDA server enables any OPC HDA client to access process values from the 
data management of the WinCC log system.

Supported specifications  
The WinCC OPC HDA Server supports the OPC Historical Data Access 1.20 specification.
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ProgID of the WinCC OPC HDA server   
You access the WinCC OPC HDA server via the following ProgID: 
"OPCServerHDA.WinCC_SCADA". 

Quality codes   
The "Quality Code" delivers information on the status and quality of the raw data. For more 
information, refer to the "OPC Historical Data Access 1.20" specification.

Documentation contents
The WinCC OPC HDA Server documentation contains the following information:

● An overview of the data structure

● An overview of supported attributes, aggregates, and functions

For more information about the OPC HDA Server, refer to the "OPC Historical Data Access 
1.20" specification. 

See also
Using OPC in WinCC (Page 2706)

Accessibility of WinCC OPC servers (Page 2708)

Overview of the supported attributes (Page 2716)

Overview of the supported assemblies (Page 2717)

Overview of the supported interfaces and functions (Page 2718)

Configure WinCC OPC HDA Server (Page 2719)

Supported Write-Accesses

Introduction  
By default, any OPC HDA client can change process values in a data log. The tag log validates 
the data and inserts them to their corresponding time stamp.

If you frequently change a lot of process values, you can use the configuration dialog on the 
conifguration PC to deactivate the validation of the process values during writing to the data 
log. You speed up the large writing of process values in this way. The OPC HDA client must 
sort the data themselves chronologically, otherwise the data is not accepted. 

 

 Note
Deactivate writing access  

You can completely deactivate the writing via the WinCC OPC HDA server from log data via 
the (user-defined) WinCC setup.
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Write Accesses
An OPC HDA client does not have generally writing access to the following data logs.

● Compressed logs

● Data logs in main memory

● Swapped logs

The following table shows the supported writing accesses for a process value log on the hard 
disk of a HMI device:

Action Writing in process value log allowed?
Adding process values later Yes 1)

Adding process values in Runtime Yes 2)

Inserting future process values No
Replace process values (Replace) Yes
Deleting process values Yes 1)

1: If the time period is contained in the circular log.
2: The process value is added in the data buffer currently valid for the process value log.

 

See also
Storing Process Values (Page 1140)

Swapping Out Process Values (Page 1142)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 2714)

Configure WinCC OPC HDA Server (Page 2719)
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Special features of the OPC HDA server in WinCC for acyclic logging

Introduction
In WinCC. tags are logged cyclically or acyclically. The WinCC OPC HDA Server works 
differently depending on the logging method for tags:

● For all cyclically logged values, the OPC HDA Server operates in conformity to the HDA 
specification of the OPC foundation. The OPC aggregates are linearly interpolated.

● Acyclically logged tags are not included in the HDA specification of the OPC Foundation. 
The OPC aggregates are interpolated incrementally. If a tag value has not changed for a 
long period of time, no data are available during this time due to the interpolation.
To obtain valid data in spite of this, take note of the following particularities:

 

 
 NOTICE

The OPC HDA Server is not OPC-compliant for acyclically logged tags. The OPC 
Foundation's HDA specification does not cover acyclically logged tags and therefore does 
not support log servers for acyclically logged tags. The supported aggregates are 
calculated in conformity to the OPC HDA specification. No non-explicitly called functions 
are supported.

 

Configuration of acyclically logged tags
When configuring acyclically logged tags, enable the "Log after segment change" option. This 
enters the most recent valid value in the the new log when a segment changes.

Supported aggregates of the WinCC OPC HDA Server for acyclically logged tags
The OPC HDA Server supports the following aggregates:

● OPCHDA_MINIMUM

● OPCHDA_MAXIMUM

● OPCHDA_AVERAGE

● OPCHDA_END

● OPCHDA_INTERPOLATIVE

● OPCHDA_TIMEAVERAGE

● OPCHDA_TOTAL

● OPCHDA_DURATIONGOOD

● OPCHDA_PERCENTGOOD
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Supported functions of the WinCC OPC HDA Server for acyclically logged tags
● ReadRaw only with "Boundings". To find the last value actually saved in an area where 

value changes are not logged, always use "Boundings" when executing "ReadRaw" on a 
tag.

● ReadProcessed

● DeleteRaw

● DeleteAtTime

● Insert

● InsertReplace

● Replace

Calculating the aggregates for acyclically logged tags
The calculation of the aggregates is based on an extended data record of raw data. The 
extended data record contains not only actually stored values, but also virtual data points for 
calculation. The WinCC OPC HDA Server prepares the raw data received according to the 
requirements of "ReadProcessed". The virtual data points needed for the calculation are 
formed from the bordering real data points. The following significant points are generated for 
virtual data points:

● Value for "StartTime"

● Value for "EndTime"

● Value for interval limits

Example
The values for "00:59:00", "01:02:00" and "01:03:00" are stored for an acyclical logging tag. 
An OPC HDA Client uses "ReadProcessed" to request an aggregate with the following 
parameters:

● StartTime = 01:00:00

● EndTime = 01:04:00

● Interval = 00:02:00
 

  Note

When generating virtual values at limits ("EndTime"/"Interval"), the time frame used for 
the calculation is always 1 µs less than the time stamp at the limit.

 

For the sake of clarity, a delta of 1 second is used in the following table. The OPC server uses 
the following raw data to calculate the aggregate:

Number Time stamp Real stored values Generated virtual values
1 00:59:00 1.00  
2 01:00:00  1.00
3 01:01:59  1.00
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Number Time stamp Real stored values Generated virtual values
4 01:02:00 2.00  
5 01:02:59  2.00
6 01:03:00 3.00  
7 01:03:59  3.00

The following figure elucidates the example:

1 2

2

3

3

Real values
Virtual values

① Interval start
② Interval end
③ Value change

 

See also
Supported Write-Accesses (Page 2712)

Overview of the supported attributes (Page 2716)

Overview of the supported assemblies (Page 2717)

Overview of the supported interfaces and functions (Page 2718)

Overview of the supported attributes
The following table contains the attributes supported by the WinCC OPC HDA Server. For 
more information, refer to the "OPC Historical Data Access 1.20" specification.

Attributes 

Attribute Attribute ID Description
ItemID OPCHDA_ITEMID Indicates the WinCC logging tag to be accessed. 
Item Datatype OPCHDA_DATA_TYPE Indicates the data type of the WinCC logging tag.
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Attribute Attribute ID Description
Description OPCHDA_DESCRIPTIO

N
Returns a description of the WinCC logging tag. You 
define the description in the "HMI Tags" editor.

Engineering 
Units

OPCHDA_ENG_UNITS Sets the display of measurement units. You define the 
display in the "HMI Tags" editor.

See also
Functionality of the WinCC OPC HDA server (Page 2711)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 2714)

Overview of the supported assemblies
The following table lists the aggregates supported by the WinCC OPC HDA Server. For more 
information, refer to the "OPC Historical Data Access 1.20" specification.

Assemblies 

Assembly Description
OPCHDA_COUNT Detects the raw data count for the specified time interval.
OPCHDA_START Detects the initial value of the raw data at the beginning of 

the start time interval.
OPCHDA_END Detects the end value of the raw data at the end time interval.
OPCHDA_AVERAGE Detects the raw data mean value for the specified time 

interval.
OPCHDA_TIMEAVERAGE Detects the time-weighted raw data mean value for the 

specified time interval.
OPCHDA_TOTAL Returns the sum total value for the specified time interval.
OPCHDA_STDEV Detects the raw data standard deviation for the specified time 

interval.
OPCHDA_MINIMUMACTUALTIME Returns the minimum value of the raw data time stamp for 

the specified time interval.
OPCHDA_MINIMUM Detects the raw data minimum value for the specified time 

interval.
OPCHDA_MAXIMUMACTUALTIME Detects the maximum value and the raw data time stamp for 

the specified time interval.
OPCHDA_MAXIMUM Detects the raw data maximum value for the specified time 

interval.
OPCHDA_DELTA Detects the difference between the first and the last value of 

the raw data for the specified time interval.
OPCHDA_REGSLOPE Detects the slope of the regression line of the raw data for 

the specified time interval.
OPCHDA_REGCONST Detects the regression line value of the raw data at the 

starting point.
OPCHDA_REGDEV Detects the slope of the regression line of the raw data for 

the specified time interval.
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Assembly Description
OPCHDA_VARIANCE Detects the raw data variance for the specified time interval.
OPCHDA_RANGE Detects the difference between OPCHDA_MAXIMUM and 

OPCHDA_MINIMUM of the raw data for the specified time 
interval.

OPCHDA_DURATIONGOOD Detects the period of time in which the quality of the raw data 
was good. The period is indicated in seconds.

OPCHDA_DURATIONBAD Detects the period of time in which the quality of the raw data 
was bad. The period is indicated in seconds.

OPCHDA_PERCENTGOOD Detects the percentage of the raw data of good quality.
OPCHDA_PERCENTBAD Detects the percentage of the raw data of bad quality.
OPCHDA_WORSTQUALITY Detects the raw data worst quality for the specified time 

interval.

See also
Functionality of the WinCC OPC HDA server (Page 2711)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 2714)

Overview of the supported interfaces and functions
The WinCC OPC HDA Server supports the following interfaces: 

● IOPCHDA_Server

● IOPCHDA_SyncRead (no "ReadModified" method)

● IOPCHDA_SyncUpdate

● IOPCHDA_AsyncRead (no "ReadModified" method)

● IOPCHDA_AsyncUpdate

● IOPCCommon

For more information about the interfaces, refer to the "OPC Historical Data Access 1.20" 
specification.

See also
Functionality of the WinCC OPC HDA server (Page 2711)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 2714)
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Configure WinCC OPC HDA Server

Introduction
On the configuration PC, define in the configuration settings for the WinCC OPC HDA server 
whether specific users or OPC HDA clients may change process values in the data logs without 
validation.

 

 NOTICE

The configuration settings apply for the WinCC OPC HDA server as well as for the OPC UA 
server.

 

 Note
Deactivated writing access

If the writing access of OPC HDA clients was deactivated on the data logs in (user-defined) 
WinCC setup, these settings are ignored. 

 

Procedure   
To configure WinCC OPC HDA server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Define under "OPC settings" which users or OPC clients may change process values in 
the data logs without validation:

– To fully disable validation, select "Disable validation of the data during write access for 
selected OPC clients".

– To deactivate the validation for single users or OPC clients, double-click "Insert" in the 
corresponding table. Enter the name of the user or the OPC client.

– To re-select the validation for a single user or OPC client, clear the option in front of the 
respective user or OPC client.

See also
Functionality of the WinCC OPC HDA server (Page 2711)

Basic settings for OPC (Page 2708)
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WinCC OPC A&E server

Functionality of the WinCC OPC A&E server

Principle of operation    
The WinCC OPC A&E server enables the access to alarms of the WinCC alarm system. The 
OPC A&E Client is kept informed of status changes for WinCC alarms via Subscriptions. To 
avoid displaying all alarms and attributes on the OPC A&E client, configure in the Subscription 
filter. 

Supported specifications  
OPC Alarm & Events is a specification for the transmission of alarms and events. The WinCC 
OPC A&E Server supports the OPC Alarms&Events 1.10 specification.

In addition, the WinCC OPC A&E Server also supports access to historical alarms in 
accordance with the Siemens draft "OPC Historical Alarms and Events v0.92".

ProgID of the WinCC OPC A&E server   
You access the WinCC OPC A&E server via the following ProgID: 
"OPCServerAE.WinCC_SCADA". 

Quality codes
The "Quality Code" delivers information on the status and quality of an alarm. For more 
information, refer to the "OPC Alarms&Events 1.10" specification.

OPC A&E Server mapping rules  
To map the WinCC alarm system on OPC Alarms&Events, the WinCC OPC A&E server 
supports three mapping rules "Mode 1" to "Mode 3". 

"Mode 1" and "Mode 2" are supported because of compatibility reasons to WinCC OPC A&E 
server version 3.52 and earlier. "Mode 1" and "Mode 2" do not have a restricted scope of 
operation. 

"Mode 3" widens the restricted scope of operation of "Mode 1" and "Mode 2".

Documentation contents
The WinCC OPC A&E Server documentation contains the following information:

● A mapping of the alarm system on OPC A&E

● An overview of supported attributes

For more information, refer to the "OPC Alarm&Events 1.10" specification. 
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See also
Using OPC in WinCC (Page 2706)

Accessibility of WinCC OPC servers (Page 2708)

OPC A&E Server mapping rules (Page 2721)

Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Mapping rules "Mode 3": (Page 2728)

Restrictions for Mode 1 and Mode 2 (Page 2728)

Access to logged events (Page 2733)

OPC A&E Server mapping rules

General rules

OPC A&E Server mapping rules
During the configuration of the WinCC message system, settings are made to determine which 
process events generate a message. This message is shown as an alarm in OPC A&E.    

The following table shows the most important parameters of the alarm and how the WinCC 
alarm system prepares the information:

OPC WinCC message system Type of event
Source Source where the alarm was issued. The source has the 

format "<server prefix>::@LOCALMACHINE::".
S, C

Time Time of the event. Issues a time stamp in UTC (Universal 
Time Coordinated).

S, C

EventType Type of event. The WinCC OPC A&E Server supports 
"Simple Events" and "Condition Related Events".

S, C

Severity Priority of the alarm from WinCC S, C
EventCategory Category of the alarms. For more information on this topic, 

refer to "Displaying Message Classes and Types".
S, C

Message Alarm text for the corresponding alarm number. S, C
ConditionName Specified text that is delivered to the alarm additionally. 

Which text is returned, depends on the configured display 
rules:
● "Mode 1" and "Mode 2": Alarm number.
● "Mode 3": Alarm method, for example "Analog alarm". 

C

SubConditionName Corresponds "ConditionName", because WinCC 
supports no Multi-State Conditions.

C

ChangeMask Changed status of the alarm. For more information, refer 
to "Acknowledgment Theory".

C

NewState Status of the alarm. For more information, refer to 
"Acknowledgment Theory".

C
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OPC WinCC message system Type of event
ConditionQuality Returns the quality of the message. For more information, 

refer to "Quality Codes".
C

AckRequired Indicates whether the message requires 
acknowledgment.

C

ActiveTime Returns the time stamp for received messages. C
EventAttribute Lists the attributes required for the respective message. 

For more information, refer to "Attributes of the WinCC 
Message System".

C

Quality Returns the quality code of the message. C
Cookie Returns the cookie from the OPC A&E Server. C
ActorID Returns the logged user. C
S = "Simple Event"
C = "Condition Related Event"

See also
Acknowledgement theory (Page 2723)

Quality Codes for OPC A&E (Page 2725)

Attributes (Page 2725)

Priorities (Page 2730)

Alarm classes and alarm methods (Page 2729)

Alarm Logging in WinCC (Page 1235)

Alarm components and properties (Page 1258)

OPC A&E types of event  (Page 2722)

OPC A&E types of event 

Introduction
The WinCC OPC A&E Server supports "Condition Related Events" and "Simple Events".

Condition Related Events
"Condition Related Events" are alarms triggered by a condition. such as the limit violation of 
a tag, which is then output as an alarm on the HMI device. A "Condition Related Event"contains 
additionally the "Alarm" attribute. 

By default, each alarm as "Condition Related Event" is sent to the OPC A&A client. 

Simple Events
As "Simple Events" all other alarms are treated, which cannot be assigned to the "Condition 
Related Event" type of event.
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In order for an alarm to be treated as a "Simple Event", the following prerequisites must be 
met when the alarm class is configured:

● "Acknowledgment Came In" is not activated.

● "Alarm without outgoing state" is activated.
 

  Note

Note the following while using redundant systems:

"Simple Events" that are connected to internal tags are sent twice during tag comparison.

The first alarm is triggered by master, the second by the standby server.
 

See also
Acknowledgement theory (Page 2723)

OPC A&E Server mapping rules (Page 2721)

Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Mapping rules "Mode 3": (Page 2728)

Acknowledgement theory

Introduction 
For WinCC, the acknowledgment philosophy is how a message is displayed and processed 
from "came in" to "went out". On the WinCC OPC A&E Server, this alarm status is managed 
in the "ChangeMask" and "NewState" parameters.

ChangeMask
The "ChangeMask" parameter keeps track of where the alarm status changed.

Parameter values:
● OPC_CHANGE_ACTIVE_STATE

● OPC_CHANGE_ENABLE_STATE

● OPC_CHANGE_ACK_STATE

NewState
The "NewState" parameter indicates the alarm status after a change. 
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Parameter values:
● OPC_CONDITION_ACTIVE

● OPC_CONDITION_ENABLED

● OPC_CONDITION_ACKED

Overview
The following table shows how WinCC alarm statuses are mapped to the "NewState" and 
"ChangeState" OPC parameters: 

WinCC NewState ChangeState
Received message OPC_CONDITION_ACTIVE

OPC_CONDITION_ENABLED
OPC_CHANGE_ACTIVE_STAT
E

Sent message with receipt OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACTIVE_STAT
E

Sent alarm without 
acknowledgment

OPC_CONDITION_ENABLED OPC_CHANGE_ACTIVE_STAT
E

Acknowledged messages 
(message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Acknowledged messages 
(message no longer pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Locked message - OPC_CHANGE_ENABLED_STA
TE

Unlocked message OPC_CONDITION_ENABLED OPC_CHANGE_ENABLED_STA
TE

Received, acknowledged 
message

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACTIVE_STAT
E

Received, sent message with 
receipt

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Incoming, sent alarm without 
acknowledgment

OPC_CONDITION_ENABLED OPC_CHANGE_ACK_STATE

Message acknowledged by the 
system (message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Message acknowledged by the 
system (message no longer 
pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Emergency-acknowledged 
message (message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Emergency-acknowledged 
message (message no longer 
pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE
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See also
OPC A&E types of event  (Page 2722)

Quality Codes for OPC A&E
The "Quality Code" is required to evaluate the status and quality of an alarm. 

Quality codes
OPC A&E's quality codes are presented in the following table:

Code Quality Status
0xC0 OPC_GOOD OK
0x40 OPC_UNCERTAIN Discrepancies, resulting from delayed 

acknowledgment, for example
0x00 OPC_BAD Connection to source is interrupted

Attributes
The following table lists the OPC attributes of the WinCC message system. You can configure 
the attributes in the "Alarms" editor. Some attributes are intended for internal use in WinCC 
only and are therefore not relevant to an OPC A&E Client. These attributes are not listed.  

OPC attribute WinCC message system Data type
CLASSNAME Returns the alarm class name. VT_BSTR
TYPENAME Returns the alarm method type name. VT_BSTR
FORECOLOR Returns the text color for received, sent and acknowledged alarms. VT_I4
BACKCOLOR Returns the background color for received, sent and acknowledged 

alarms.
VT_I4

FLASHCOLOR Returns the flashing color. VT_I4
FLAGS Indicates whether the message requires acknowledgment. VT_I4
TEXT01 Returns the content of UserTextBlock01. VT_BSTR
TEXT02 Returns the content of UserTextBlock02. VT_BSTR
TEXT03 Returns the content of UserTextBlock03. VT_BSTR
TEXT04 Returns the content of UserTextBlock04. VT_BSTR
TEXT05 Returns the content of UserTextBlock05. VT_BSTR
TEXT06 Returns the content of UserTextBlock06. VT_BSTR
TEXT07 Returns the content of UserTextBlock07. VT_BSTR
TEXT08 Returns the content of UserTextBlock08 VT_BSTR
TEXT09 Returns the content of UserTextBlock09 VT_BSTR
TEXT10 Returns the content of UserTextBlock10 VT_BSTR
PROCESSVALUE01 Returns the content of ProcessValueBlock01  VT_VARIANT
PROCESSVALUE02 Returns the content of ProcessValueBlock02 VT_VARIANT
PROCESSVALUE03 Returns the content of ProcessValueBlock03 VT_VARIANT
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OPC attribute WinCC message system Data type
PROCESSVALUE04 Returns the content of ProcessValueBlock04 VT_VARIANT
PROCESSVALUE05 Returns the content of ProcessValueBlock05 VT_VARIANT
PROCESSVALUE06 Returns the content of ProcessValueBlock06 VT_VARIANT
PROCESSVALUE07 Returns the content of ProcessValueBlock07 VT_VARIANT
PROCESSVALUE08 Returns the content of ProcessValueBlock08 VT_VARIANT
PROCESSVALUE09 Returns the content of ProcessValueBlock09 VT_VARIANT
PROCESSVALUE10 Returns the content of ProcessValueBlock10 VT_VARIANT
STATETEXT Returns the status alarm VT_BSTR
INFOTEXT Returns the information text for the alarm VT_BSTR
LOOPINALARM Indicates if loop-in alarm has been configured. VT_I4
CLASSID Returns the alarm class ID VT_I4
TYPEID Returns the message type ID VT_I4
MODIFYSTATE Returns the value of the status tag of the alarm VT_I4
AGNR Returns the number of the automation system that generated the 

alarm
VT_I2

CPUNR Returns the number of the CPU that generated the alarm VT_I2
DURATION Indicates the period of time between alarm received, sent and 

acknowledged
VT_I4

COUNTER Returns the number of alarms after the start of Runtime VT_I4
QUITSTATETEXT Indicates whether the alarm has been acknowledged VT_BSTR
QUITCOUNT Returns the number of active, unacknowledged alarms VT_I4
PARAMETER Outputs the message parameter. (Image of the message 

configuration)
VT_BSTR

BLOCKINFO Returns the current content of the alarm block VT_BSTR
ALARMCOUNT Outputs the number of alarms pending VT_I4
LOCKCOUNT Returns the number of locked alarms VT_I4
PRIORITY Indicates the configured priority of the alarm VT_I4
APPLICATION Returns the application which triggered the alarm VT_BSTR
COMPUTER Returns the name of the computer which processed the alarm VT_BSTR
USER Returns the name of the user who processed the alarm VT_BSTR
COMMENT Returns the alarm comment VT_BSTR
HIDDEN-COUNT* Number of locked alarms VT_I4
OS-HIDDEN* Indicates whether the alarm is locked VT_BOOL
OS_EVENTID* Indicates the WinCC alarm number VT_I4
BIG_COUNTER* Alarm counter VT_CY
UNIQUE EVENT ID* corresponds to the "BIG_COUNTER" VT_CY
*: Are supported only by "Mode 3". 
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See also
Alarm classes and alarm methods (Page 2729)

Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Mapping rules "Mode 3": (Page 2728)

Mapping rule "Mode 1":
"Mode 1" displays the whole WinCC alarm system under a "OPC Source" with the name 
"localhost::" The "TEXT01" WinCC attribute is written in the OPC alarm text. 

The WinCC alarm number is displayed on the "Condition" of the WinCC OPC A&E server. 

"Mode 1" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be filtered according to the "Event Type", "Category" and "Severity" criteria.  

See also
Restrictions for Mode 1 and Mode 2 (Page 2728)

Attributes (Page 2725)

OPC A&E types of event  (Page 2722)

Configure WinCC OPC A&E server (Page 2731)

Alarm classes and alarm methods (Page 2729)

Priorities (Page 2730)

Mapping rules "Mode 2":
"Mode 2" is implemented as of version 3.5.2. of the WinCC OPC A&E server. The WinCC 
alarm number is displayed on the "Condition" of the WinCC OPC A&E server. 

The text attribute of the WinCC alarm ("TEXT01" to "TEXT10") you have configured, is written 
in the OPC alarm text of "OPC Source".

"Mode 2" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be filtered according to the "Event Type", "Category" and "Severity" criteria.  

See also
Restrictions for Mode 1 and Mode 2 (Page 2728)

Attributes (Page 2725)

OPC A&E types of event  (Page 2722)

Configure WinCC OPC A&E server (Page 2731)

Alarm classes and alarm methods (Page 2729)

Priorities (Page 2730)
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Mapping rules "Mode 3":
"Mode 3" is implemented as of version 3.6 of the WinCC OPC A&E server. "Mode 3" supports 
the hierarchical mapping of user-defined alarms. The hierarchy of "OPC Areas" is set by the 
user-defined alarm groups. 

With "Mode 3" you query the address space of the WinCC OPC A&E server according to 
"Areas" and "Sources". 

"Mode 3" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be additionally filtered according to the "Area" and "Source" criteria. "Mode 3" supports 
the "System Message" OPC category.  

See also
Attributes (Page 2725)

OPC A&E types of event  (Page 2722)

Configure WinCC OPC A&E server (Page 2731)

Priorities (Page 2730)

Restrictions for Mode 1 and Mode 2

Notes on mapping rules "Mode 1" and "Mode 2":
The mapping rules for "Mode 1" and "Mode 2" contain significant restrictions. The mapping 
rules for "Mode 1" and "Mode 2" are therefore only because of compatibility reasons supported 
by the previous version and are not developed further. 

 

 Note

In order to ensure compatibility with the previous version, the WinCC OPC A&E server cannot 
use multiplexer.

 

The restrictions are solved in the mapping rule "Mode 3". 

Some of the restrictions of the mapping rules "Mode 1" and "Mode 2" are listed below: 
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● The WinCC alarm attributes are passed on via the OPC interface.
The IDs value range of WinCC alarm attributes is defined by the OPC specification by 
"Property sets":

– ID Set 1 contains the "OPC-specific Properties". Range: 1 … 99

– ID Set 2 contains the "Recommended Properties". Value range 100 to 199

– IDs 300…399 are especially reserved for OPC A&E

– IDs 400 to 4999 are reserved by OPC.

– ID Set 3 contains the "Vendor-specific Properties". Range: 5000 and higher
The IDs of the WinCC attributes must have values from 5000 and higher. 

Mode 1 and Mode 2 pass on the IDs of the WinCC alarm attributes via the OPC interface. 
These IDs are in the range of 0 to 61. 
If an OPC client, for example, requires the attribute with the IDs 2 ("Item Value") and 3 
("Item Quality") from the WinCC OPC A&E server, the OPC client receives instead the 
corresponding WinCC alarm atrocities. In this case the attributes are "ForeColor" and 
"BackColor".

● Restrictions for transfer of WinCC alarm numbers
Alarm numbers are only transferred as text in the "Condition" when "Condition Related 
Events". When "Simple Events", the alarm numbers are completely lost. 

● Some WinCC attributes are not supported, for example "UNIQUE_EVENT_ID"
You can use the "UNIQUE_EVENT_ID" attribute for alarm synchronization of redundant 
server couples. During switching between redundant servers, the following could happen:

– Alarms can be double- transferred

– Alarms can be lost

You can find an overview of all attributes supported by the different modes at "Attributes 
(Page 2725)". 

See also
Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Alarm classes and alarm methods

Introduction     
The WinCC message system informs the user of disturbances and operating conditions in the 
process. A WinCC alarm always belongs to a specific alarm class and alarm method that is 
related to the "Event Category". 
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Event Category
 

 Note
"Event Category" depends on the set mapping rules

The characteristics of the mapping rules "Mode 1" and "Mode 2" are described below: 
 

An "Event Category" is displayed on the WinCC OPC A&E Server for every combination of an 
alarm class and alarm method. 

An "Event Category" is determined by a "CategoryID" and a descriptive "Category Description". 
The "CategoryID" consists of the WinCC-internal ID of an alarm class and alarm method. The 
"Category Description" comes from the names of the alarm class and alarm method. 

The names of the alarm classes and alarm methods can be ascertained explicitly via the alarm 
attributes "CLASSNAME" and "TYPENAME". 

See also
Mapping rules "Mode 2": (Page 2727)

Mapping rule "Mode 1": (Page 2727)

Priorities

Introduction
The priority of WinCC alarms is displayed by the WinCC OPC A&E server on the "Severity" 
attribute. 

You can configure up to 17 priority levels in WinCC. The "Severity" OPC attribute has a value 
range from "1" to "1000":

● 1: Lowest priority

● 1000: Highest priority

Depending on the number of the configured WinCC priority levels, the value in the "Severity" 
attribute is automatically retrieved by linear scaling. 

Exception: For the mapping rules "Mode 1", the priority levels configured in WinCC are 
displayed directly on the "Severity" attribute. 

Example
If you do not change the default settings in the configuration settings of the WinCC OPC A&E 
server, the 17 priority levels are going to be displayed in the WinCC OPC A&E server as follows:

Priority level in WinCC Assigned value in the "Severity" attribute 
0 1
1 64
2 127
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Priority level in WinCC Assigned value in the "Severity" attribute 
3 190
... ...
15 937
16 1000

See also
Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Mapping rules "Mode 3": (Page 2728)

Description of the System Blocks (Page 1414)

Configure WinCC OPC A&E server

Introduction
Define the display of the WinCC alarm system in the configuration settings of the WinCC OPC 
A&E server.

The following screen shows the configuration settings in the "Runtime settings" of the HMI 
device:

Requirement
Alarms are configured.
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Procedure   
To configure WinCC OPC A&E server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Configure the server settings at "Alarms > OPC Alarms & Events":

– Define the low and high limit for the display of the priority range.

– To activate the WinCC alarms with the mapping rule "Mode 3" in the WinCC OPC A&E, 
activate "Activated" and "OPC areas".
Use primarily this setting. 

– Assign to the "OPC event source" and the "OPC event alarm" respectively an alarm 
quality, for example, " User text block 3".

Result
The WinCC alarms are displayed completely in the WinCC OPC A&E. If you have configured 
user-defined alarms, areas and sources of the user-defined alarms are displayed in the WinCC 
OPC A&E server. 

Alternative procedure
You can display alternatively because of compatibility reasons the WinCC alarm also according 
to the "Mode 2" and "Mode 1" mapping rules in the WinCC OPC A&E server:

1. To display the WinCC alarms with the mapping rule "Mode 2" in the WinCC OPC A&E 
server, activate "Activated" and deactivate"OPC areas".

2. To display the WinCC alarms with the mapping rule "Mode 1" in the WinCC OPC A&E 
server, deactivate "Activated" and "OPC areas".

See also
OPC A&E types of event  (Page 2722)

Priorities (Page 2730)

Basic settings for OPC (Page 2708)

Mapping rule "Mode 1": (Page 2727)

Mapping rules "Mode 2": (Page 2727)

Mapping rules "Mode 3": (Page 2728)
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Accessing logged alarms

Access to logged events

Introduction
You can access the archived messages via the OPC A&E Server using an OPC client. Two 
methods are supported for accessing logged alarms:

● Output archived messages from a time period in the past

● Output archived messages from a time period in the past without mentioning end of period. 
After the output of archived messages, all other newly generated messages are 
automatically sent to the OPC client.

 

 
 NOTICE

After reading tagged logs, you are not allowed to use the returned "ActiveTime" of an 
alarm to acknowledge the alarm or to track any transitions in the alarm. To ensure this 
does not happen, the OPC A&E Client must check the "EventType" of an alarm for the 
extra flag "OPC_HAE_HISTORICAL_EVENTFLAG". The "ActiveTime" is not correct on 
logged alarms. You can find information on the additional flag under "Identifying archived 
messages".

 

Polling the "Historic alarms and events" functionality
The table below lists the filters offered by the WinCC's extended OPC A&E Server, in addition 
to the standard filters:

Filter Filter Values Description
OPC_HAE_FILTER_BY_TIMEFRAME 0x80000000 Corresponds to the "ReadRaw" function 

for OPC Historical Data Access
OPC_HAE_FILTER_BY_STARTTIME 0x40000000 Corresponds to the "AdviseRaw" 

function for OPC Historical Data Access

Source filter and historical alarm request
In order for you to be able to request logged alarms, the OPC client must support the "SetFilter" 
functionality on a Subscription. The OPC server will also send logged alarms if you insert the 
keyword "OPCHAEServer" into the array of the "Source Filter" in a Subscription. In addition 
to this keyword, you can use other parameters to define which messages are to be read:

● Method

● Time period

● With or without limits

The lists of sources that are assigned in the filter can include other source names besides the 
"OPCHAEServer" source. In this a case, the Subscription delivers only the logged events of 
the given sources. The sequence of the source names is inconsequential.
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After configuring the source filter, you can retrieve the selected time period from the client with 
a "Refresh" call.

See also
Identifying logged alarms (Page 2737)

Syntax for accessing logged alarms using OPC (Page 2734)

Read methods for logged alarms (Page 2735)

Syntax for accessing logged alarms using OPC

Syntax
OPCHAEServer hMode=(read|advise) htStartTime=szTime 
[hEndTime=szTime] [bBounds=(TRUE|FALSE)]

Parameter

hMode = [read|advise]
Required Defines how the archived messages and events are to be read. 

● Read
Outputs logged alarms and events of a defined period from the past (comparable to 
ReadRaw for OPC Historical Data Access).
The following example shows how a filter is set to read over the past 30 minutes:
OPCHAEServer hMode=read htStartTime=NOW-30M bBounds=TRUE

● Advise
Outputs archived messages and events from a definite period, When all logged alarms are 
received, new alarms are sent in the same way as for an active subscription (comparable 
to AdviseRaw for OPC Historical Data Accesss).
The following example shows how alarms are read from 30 minutes ago until now 
(subscription must be active):
OPCHAEServer hMode=advise htStartTime=NOW-30M

 

  Note

The following notation is supported for the parameters "htStartTime" and "htEndTime":
● Relative notations such as "NOW"
● Symbolic values such as "NOW", "YEAR", "MONTH"
● Specification of absolute UTC data/time values according to XML notation: 

2006-09-01T10:00:00.000Z

The use of symbolic notation corresponds to the syntax of OPC Historical Data Access.
 

htStartTime = 
Required Defines the time from when the messages and events are to be read from the archive. 
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htEndTime = 
Optional Defines the time up to which the messages and events are to be read from the archive. 
For "hMode = read", the default setting "NOW" is used. 

bBounds = [TRUE|FALSE]
Optional Defines how messages close to the start and end time are to be handled. The function 
is identical to OPC historical data access.

● bBounds=FALSE: 
– Time stamp of the first transferred alarm >= htStartTime

– Time stamp of the last transferred alarm < htEndTime

● bBounds=TRUE:
– Time stamp of the first transferred alarm <= htStartTime

– Time stamp of the last transferred alarm >= htEndTime

The default setting is FALSE.

See also
Read methods for logged alarms (Page 2735)

Identifying logged alarms (Page 2737)

Read methods for logged alarms

Introduction
You can use one of the two read modes to read archived messages:

● read

● advise

"read" mode
"read" mode is used to read logged alarms from a defined period in the past. The sequence 
of read messages is always read from the alarms in chronological sequence in reference to 
each OS server. By setting the start and end time, you can specify whether the last message 
is to be read first or last. If the start time is earlier than the end time, the last message is last 
in the output.

If you want to use "read" mode, run the following functions on the subscription:

1. SetFilter

2. Refresh

A "SetFilter" during the "Refresh" will be rejected. Activating the subscription during "Refresh" 
does not affect how the Refresh is carried out.

The historic events will continue to be transferred with the Refresh flag. 
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The newly generated events are transferred according to the standard reaction of an active 
subscription:

● Taking into account the set filter values with the exception of "historic" source 
"OPCHAEServer"

● Without the Refresh flag

Enables the client to distinguish between the received events based on the Refresh flag. An 
event package never contains historic and new events at the same time.

● Event packets with the Refresh flag contain only historic events. These events can also be 
in queue.

● Event packets without the Refresh flag contain only newly generated events.

"advise" mode
"advise" mode is used to read logged alarms starting from a defined period in the past. After 
reading all archived messages, new messages are sent in the same way as for an active 
subscription. The archived messages are transferred in chronological sequence in reference 
to each OS server: The archived messages from a start time onwards are transmitted. 
Thereafter, the newly archived messages transferred. 

Note that you are not permitted to define an end time for "advise".

An active subscription is used for "advise" mode. If you run the "SetFilter" function on an active 
subscription, the historical alarms are transferred immediately. 

If you run the "SetFilter" function on an inactive subscription, the logged alarms are sent only 
after the subscription is activated. If you want to use "advise" mode with an inactive 
subscription, follow these steps:

1. SetFilter.

2. Set the subscription to "Active" using "SetState".

The transmission is interrupted if you deactivate the subscription.

The transmission is ended if you set the subscription to "inactive". A "SetFilter" is rejected 
when the subscription is active.

A "Refresh" on an active "historic" subscription in "advise" mode functions in the same way as 
it does for a standard subscription:

All queued condition related events are transferred to packages with Refresh flag. The last 
packet also contains an additional "Last Refresh" flag.

A "Refresh" call has no influence on the reading of historical alarms in "advise" mode. 

See also
Syntax for accessing logged alarms using OPC (Page 2734)
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Identifying logged alarms

General procedure
Logged alarms are distinguished using an additional flag in EventType. This flag is ORed with 
the real EventType.

Name EventType EventType (archived message)
OPC_SIMPLE_EVENT 0x01 0x81
OPC_CONDITION_EVENT 0x04 0x84
OPC_TRACKING_EVENT 0x02 0x82
OPC_HAE_HISTORICAL_EVENTFLAG  0x80

Examples

Example 1
The following source filter is used to output logged alarms and events from the past 30 minutes 
in "read" mode. The oldest message for each OS server is output as the first one. The low limit 
value is also sent.

OPCHAEServer hMode=read htStartTime=NOW-30M bBounds=TRUE

Example 2
The following source filter is used to output events logged on September 1, 2006, from 10:00 
a.m. to 12:00 p.m. in "read" mode. The newest message for each OS server is output as the 
first one. The limits for this time period are also sent.

OPCHAEServer hMode=read htStartTime=2006-09-01T12:00:00.000Z 
htEndTime=2006-09-01T10:00:00.000Z bBounds=TRUE

Example 3
The following source filter is used to output logged alarms and events from the past 30 minutes 
in "advise" mode. After reading the archived messages, newly generated messages are sent 
in the same way as for an active subscription.

OPCHAEServer hmode=advise htStartTime=NOW-30M

See also
Access to logged events (Page 2733)

Syntax for accessing logged alarms using OPC (Page 2734)
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WinCC OPC UA Server

Principle of operation the WinCC OPC UA Server 

Principle of operation     
The WinCC OPC UA Server provides the following values:

● Process values

● Values from tag logs

The WinCC OPC UA server is installed as Windows service and started automatically. The 
WinCC OPC UA server supports only the "UA-TCP UA-SC UA Binary" communication profile. 
The used port number is adjustable.

Supported specifications  
OPC Unified Architecture is a specification for the transmission of process values and log data, 
as well as alarms and events. The WinCC OPC A&E Server supports the transfer of process 
values and log data. With this constraint, the WinCC OPC UA Server conforms to OPC UA 
specification 1.01.

URL of the WinCC OPC UA server   
You access the WinCC OPC UA server via the following URL: "opc.tcp://[NodeName]:[Port]/
OpcUaServerWinCC". 

[NodeName]: placeholder for the computer name. Is set automatically. 

[Port]: Port number. The default is "4861".

Discovery Server  
The "Discovery Server" is available by the OPC foundation. The "Discovery Server" is by 
default installed on the HMI device as Windows service. On the "Discovery Server" via OPC 
UA server UA clients information is available that is registered on the "Discovery Server".  

The WinCC OPC UA server registers for Runtime-Start, depending on the configuration, on 
no, one or all available "Discovery Servers" If you end the Runtime, the WinCC OPC UA server 
is automatically logged off from the "Discovery Server". 

Supported languages in the WinCC address area
The WinCC OPC A&E Server supports the WinCC address area in the following languages:

● German

● English

● French
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● Italian

● Spanish

See also
Using OPC in WinCC (Page 2706)

Accessibility of WinCC OPC servers (Page 2708)

Security concept of OPC UA (Page 2739)

OPC UA Services support (Page 2741)

Name area of the WinCC OPC UA server (Page 2742)

OPC UA Data Access (Page 2744)

OPC UA Log Access (Page 2744)

Configure WinCC OPC HDA Server (Page 2719)

Security concept of OPC UA

Introduction
The WinCC OPC UA server uses the TCP/IP protocol for data exchange. For authorization 
between WinCC OPC UA server and OPC UA client certificates are exchanged. In addition, 
you can encode the data transfer. 

Security concept  
The WinCC OPC UA server and each OPC UA client authorize themselves mutually by 
exchanging certificates. 

By default, the WinCC OPC UA server creates during installation a self signed instance 
certificate. You can alternatively replace this instance certificate with a project-specific instance 
certificate. 

 

 Note
Private key and own certificates

If you have an own certification center, you can create your own certificates and make them 
available for all communication partners. In this case, delete the instance certificate created 
by WinCC OPC UA server. 

 

The instance certificate is stored in the certificate memory. Depending on the configuration of 
the WinCC OPC UA server, one of the following certificate memory is used:

● Certificate memory of the WinCC OPC UA server

● Certificate memory of the operating system in "UA Applications" folder

In order for the WinCC OPC UA server and an OPC UA client to communicate with each other, 
the certificates must be known to each other:

Visualizing processes (Professional)
9.16 Interfaces

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2739



● You use the common certificate of the operating system
Or:

● You copy the certificates in the certificate memory of the participating communication 
partners:

– WinCC OPC UA Server

– OPC UA Client

– Discovery server (optional)

Security settings  
The following table lists the security settings supported by the WinCC OPC UA server: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa152 None4 Sign5 SignAndEncrypt6

Basic2563 None Sign SignAndEncrypt
1: The certificate exchange is switched off. Every OPC UA client can log on to the WinCC OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: Certificate exchange with depth of encryption of 256 bit.
4: The data packages are exchanged after certificate check unsecured between client and server. 
5: The data packages are signed with the certificates, but not encoded
6: The data packages are signed with the certificates and encoded

 
 

 NOTICE

Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.

For a secure communication between client and server, use in operating mode at least the 
following settings:
● SecurityPolicy: Basic128Rsa15
● Message Security Mode: Sign

You can deactivate the application of SecurityPolicy "none" in the configuration settings of 
the WinCC OPC UA server. 

 

User identification  
For user account identification of an OPC UA client, the WinCC OPC UA server supports the 
methods "Anonymous" and "User name / Password". Each user account must be known in 
the user administration of the operating system of the WinCC OPC UA server. 

The user identification is only used for setting up a communication session. Different access 
rights are not supported. 
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You can deactivate the support of anonymous users  in the configuration settings of the WinCC 
OPC UA server. 

See also
Configure WinCC OPC UA Server (Page 2746)

Principle of operation the WinCC OPC UA Server  (Page 2738)

OPC UA Services support

Introduction
The WinCC OPC A&E Server supports the following described functionality.

OPC UA Service Sets
The following table shows the supported OPC UA Service Sets: 

OPC UA Service Sets Services Comment
Discovery Service All -
Secure Channel 
Service
Session Service

All -

View Service Browse
BrowseNext
RegisterNodes
UnregisterNodes

Detect the displayed WinCC data: Process values 
and log process values

Attribute Service Read
Write

only WinCC tags
only WinCC tags

 HistoryRead
HistoryUpdate*

only logging tags
only logging tags

Subscription Service All only "Value" attribute of WinCC tags
MonitoredItem Service All only "Value" attribute of WinCC tags
*: With restrictions, see "Supported Write-Accesses (Page 2712)" 

OPC UA profile and Conformance Units
 

 Note

The OPC UA profiles for "Historical Access" are not yet released, that is why they are not 
listed in the following: 

 

The WinCC OPC A&E Server supports the following OPC UA profiles without restrictions:
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● 6.5.17 SecurityPolicy - Basic128Rsa15

● 6.5.18 SecurityPolicy - Basic256

● 6.5.19 SecurityPolicy - None

● 6.5.21 Base Server Behaviour Facet

● 6.5.22 Standard DataChange Subscription Server Facet

● 6.5.28 Enhanced DataChange Subscription Server Facet

● 6.5.39 UA-TCP UA-SC UA Binary

The WinCC OPC A&E Server supports the following OPC UA profiles shown in the following 
table, however with restrictions:

Profile "Group" Not supported "Conformance 
Unit"

6.5.25 Core Server Facet Attribute Services Attribute Write Index
6.5.26 DataAccess ServerFacet Data Access Data Access Analog

Data Access Multistate
Data Access PercentDeadBand
Data Access Semantic Changes
Data Access Two State

6.5.35 Standard UA Server Attribute Services Attribute Write StatusCode & 
TimeStamp

See also
Principle of operation the WinCC OPC UA Server  (Page 2738)

Name area of the WinCC OPC UA server

Introduction
The WinCC OPC UA server provides OPC UA clients with an hierarchical name area to display 
the following Runtime data:

● Process values (WinCC tags and WinCC tag groups)

● Data log inclusive logging tags

The name area of the WinCC OPC UA server is attached in the "Objects" default folder.

The following screen shows the name area of the WinCC OPC UA server of an active WinCC 
project on the local PC ("@LOCALMACHINE::"):
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1

2

3

① Start node of the specific name area of WinCC. 
② Display of the WinCC tags; the structure corresponds to the structure of the tags in WinCC. 
③ Display of the data log

 Display of the WinCC tags  
Tag groups, communication drivers and connections are displayed by OPC UA objects of the 
"FolderType" type. Each of these folders has references of the "Organizes" type to the 
subordinate objects and tags. 

Internal and external WinCC tags are displayed by OPC UA tags of the "DataItemType" type. 
If a WinCC tag is additionally logged, the displayed OPC UA tag has additionally a reference 
of the "HasHistoricalConfiguration" type for a log configuration. The "Historizing" and 
"AccessLevel" attributes are respectively set.

The following table shows the most important attributes of the OPC UA tags that represent a 
WinCC tag. You can find the complete list of attributes in the "OPC UA Part 3 - Address Space 
Model 1.01 Specification" document under "§5.6":

Attribute Description Comment
NodeId Unique designation of the WinCC tag  
BrowseName WinCC tag name  
DisplayName WinCC tag name  
Value Tag value and status  
DataType OPC UA data type that corresponds to the 

WinCC tag type, for example:
● Int32; signed 32 bit value
● UInt32; unsigned 32 bit value

-
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Attribute Description Comment
AccessLevel "CurrentRead" / "CurrentWrite"  

"HistoryRead" / "HistoryWrite" 
correspondingly to the WinCC 
tag configuration

ValueRank Always "Scalar" -

Display of the logging tags  
Process values and compressed logs are displayed by OPC UA objects of the "FolderType" 
type. Each of these folders has references of the "Organizes" type to the related logging tags. 

Logging tags from process value or compressed logs are displayed by OPC UA tags of the 
"BaseDateVariableType" type. A logging tag always has a reference of the 
"HasHistoricalConfiguration" type for a log configuration.

The following table shows the most important attributes of the OPC UA tags that represent a 
WinCC logging tag. You can find the complete list of attributes in the "OPC UA Part 3 - Address 
Space Model 1.01 Specification" document under "§5.6":

Attribute Description Comment
NodeId Unique designation of a logging tag  
BrowseName Name of the logging tag  
DisplayName Name of the logging tag  
Description Node description  
Value Not available For a logging tag, this attribute 

cannot be read nor changed. 
DataType OPC UA data type that corresponds to the 

WinCC tag type, for example:
● Double; 64-bit floating point number
● UInt32; unsigned 32 bit value

-

AccessLevel "HistoryRead" / "HistoryWrite" -
ValueRank Always "Scalar" -

OPC UA Data Access
Internal and external WinCC tags are displayed by OPC UA tags of the "DataItemType" type. 
Other DataAccess tag types as "AnalogItem" or "DiscreteType" are not supported. 

The WinCC OPC A&E Server supports the reading access on the OPC UA tag attributes as 
"DataType" or "AccessLevel". Writing access and subscriptions are only supported for the 
"Value" attribute. 

OPC UA Log Access

Introduction  
"OPC Historical Access" enables the access to logs and includes the "Historical Data" and 
"Alarms & Events" services. The WinCC OPC UA server supports only the "Historical Data" 
service. 
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The WinCC OPC UA Server offers the OPC clients access to the raw data of tag logs via 
"Services".

● HistoryRead (READRAW)

● HistoryUpdate (INSERTDATA, REPLACEDATA, UPDATEDATA, DELETE_RAW)

You can read and limitedly write with an OPC UA client the values of logging tags in the tag 
logs. Depending on the configuration of the tag log, the logging tag can contain either raw or 
already processed process values.

Characteristics of logging tags
According to the OPC "OPC UA Part 11 - Historical Access 1.00 Specification" document, the 
tags to be logged must have a precise reference to a tag configuration 
("HistoricalConfiguration"). A process tag can be contained in WinCC and also in several data 
logs. In this case the process tag is linked to one of the corresponding logging tags.

Attribute / Properties of log configurations
The following table shows the Properties of an OPC UA tag configuration of the 
"HistoricalConfigurationType" type: In the "Description" attribute, the logging tag comment 
configured in WinCC is displayed. You can find the complete list of attributes in the "OPC UA 
Part 11 - Historical Access 1.00 Specification" document under "§4.7.1.4":

Property Description / Value Comment
Definition WinCC process tag name For a process value log
Stepped True -

The following optional Properties are not supported:

● MaxTimeInterval

● MinTimeInterval

● ExceptionDeviation

● ExceptionDeviationFormat

Limitations for Service "HistoryUpdate"
You can use the Service "HistoryUpdate" only on process value logs. 

The following table lists the functions supported by the WinCC OPC UA server: Which functions 
are supported depends on the configuration of the WinCC OPC UA server as well as the 
process value log configuration. You will find additional information in the "OPC UA Part 11 - 
Historical Access 1.00 Specification" document under "§5.5":

Service Function Description
HistoryUpdate INSERTDATA Insert new log values
 REPLACEDATA Replace existing log values
 UPDATEDATA Replace of insert log values
 DELETE_RAW Delete log values
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See also
OPC UA Services support (Page 2741)

Name area of the WinCC OPC UA server (Page 2742)

Supported Write-Accesses (Page 2712)

Configure WinCC OPC HDA Server (Page 2719)

Configure WinCC OPC UA Server

Introduction
Define the following in the configuration settings of the WinCC OPC UA server: 

● OPC HDA Server settings

● Port number (Default: "4861)"

● Security settings

Requirement
A project with an HMI device is open. 

Procedure  
To configure WinCC OPC UA server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. If necessary, configure the writing access validation at "OPC settings > OPC HDA settings". 
 

 
 NOTICE

The "OPC HDA configuration" settings apply for the WinCC OPC HDA server as well as 
for the OPC UA server.

 

3. Configure the server settings at "OPC settings > OPC Unified Architecture Server 
configuration":

– Change the "Port number", if required

– Activate at least a "SecurityPolicy" and the respective "Message security mode".
 

 
 NOTICE

Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.
 

Visualizing processes (Professional)
9.16 Interfaces

WinCC Professional V11.0 SP1
2746 System Manual, 08/2011,  



Result
The WinCC OPC UA Server is configured. If you activate the project on the HMI device, the 
WinCC OPC UA server is accessible. 

See also
Security concept of OPC UA (Page 2739)

OPC UA Log Access (Page 2744)

Supported Write-Accesses (Page 2712)

Basic settings for OPC (Page 2708)

WinCC OPC connection

Creating a connection to an OPC server

Introduction
If to an OPC DA server an external control is available, you can access its process values from 
WinCC with the help of the WinCC OPC connection. You configure for this in the engineering 
system an OPC connection to the desired OPC server. You configure afterwards WinCC tags 
for the process values of the OPC server.

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● The OPC server and the HMI device with WinCC Runtime Professional are located in a 
network

Procedure   
To create a connection to an OPC server, follow these steps:

1. On the HMI device, open the "Connections" editor.

2. Create a new connection and enter a meaningful name.

3. Choose "OPC" as the "Communication driver".

4. In the work area under "Parameters > OPC settings", enter the communication peer.

– Select the "Type of OPC server".

– Select the OPC server based on the OPC server type you chose, or enter the IP address 
or name of the remote computer.

Result
The OPC connection is configured. To access data from the OPC server, you create tags. 
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See also
Accessing process values of an OPC server (Page 2748)

Using OPC in WinCC (Page 2706)

Accessing process values of an OPC server

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● A connection to the OPC-Server is created

Procedure   
To access process values of an OPC-Server via the OPC connection, follow these steps:

1. On the configuration PC in the project navigation, open the "HMI tags" editor under the HMI 
device that you use as an OPC client.

2. Create a tag with the same data type as the tag on the OPC server.

3. Select the OPC connection for "Connection".

4. Enter the "Address", or select the desired tag on the OPC server via the object list.

Result
If you launch Runtime on the HMI device, the process value from the OPC server will be written 
to the tag on the HMI device via the OPC connection. 

See also
Creating a connection to an OPC server (Page 2747)

Commissioning OPC

Configuring DCOM user permissions in Windows

Introduction   
The OPC DA client and OPC DA server are DCOM applications, whose security settings must 
be set in compliance with the DCOM security mechanisms:

● The OPC DA client needs launch/activation rights and access rights for the OPC DA server.

● The OPC DA server only needs access rights for the OPC DA client.

The following must be known on the PCs of the OPC DA server and the OPC DA client 
respectively:
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● The user account for which the OPC DA client is executed

● The "Simatic HMI" user group

The "Simatic HMI" user group is already created on an HMI device during installation. The 
security settings of WinCC OPC DA server and the WinCC OPC channel are also 
preconfigured during installation.

In order to create an additional user for the operation of the OPC DA client, add the user as a 
member to the "Simatic HMI" user group.

Requirement
You have administrator rights.

Setting up a user account on PCs with an external OPC DA server or external client
On PCs without a WinCC installation, you configure the access rights manually. 

1. Open Windows user administration.

2. Create the "SIMATIC HMI" user group.

3. Under "DCOM > My Computer > COM Security > Access Permissions > Edit Default" enter 
the permissions "Local Access" and "Remote Access".

4. Assign the user accounts for this user group.

For additional information on granting user rights, refer to the documentation for 
Windows XP / Vista / 7. 

Adjusting Windows firewall settings

Introduction
After installation of WinCC, the Windows firewall settings of the WinCC OPC servers are 
correctly configured.

If OPC clients access OPC servers in different subnets, you must adapt the configuration of 
the permitted network areas to the OPC servers. 

9.16.2 Customer controls

9.16.2.1 Overview

Introduction  
Use customer controls to create and standardize complex, frequently used display objects. 
Visual Studio 2005/2008 Professional .NET is used to create these.
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You can, for example, place several motors of a similar type in a plant. In a customer control, 
you can summarize motor data such as operating mode, setpoint, actual value, rotational 
speed, operational status, frequency. 
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Hz

Frequency

Value

Setpoint

Process value

Manual Auto

Mode

1/minute

Speed

M

Operating mode

Off

On
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When the customer control is finished, you can integrate it an unlimited number of times into 
WinCC screens, as well as in other applications.

Central changes to the customer control are automatically adopted at all usage locations. In 
this way, you can later expand a customer control with additional functionality. The changes 
are effective on all customer controls of this type used in WinCC screens that are already 
configured.

Target group of this documentation
This documentation is intended for design engineers with experience in VB.net or C#.

9.16.2.2 Interfaces

Introduction    
To access the WinCC tag value, WinCC makes interfaces available for access to the WinCC 
data provider. The connection to the WinCC data provider is established or disconnected using 
methods. Methods are also used to read or write tag values synchronously or asynchronously. 

● Synchronous:
The customer control sends a request to the data provider for which a reply is expected 
immediately. The customer control waits until a reply comes from the data provider. 

● Asynchronous:
The customer control sends a request to the data provider for which a reply is not expected 
immediately. Sending the request and receiving the reply occur at separate times.

Interfaces 
● ITag

The ITag object supports the following methods:

Method Description
Register (Page 2764) Registers the customer control as a consumer at the data provider. The 

consumer receives a cookie from the data provider. The cookie is used to 
assign a request from the data provider to a consumer.

ReadTag 
(Page 2764)

Reads the value of one or more tags at the same time

ReadTagAsync 
(Page 2765)

Reads the tag value asynchronously

ReadTagCyclic 
(Page 2766)

Cyclic reading of the tag values. The update cycle is used to determine how 
often the value is updated. 

RemoveCyclicTag 
(Page 2766)

Removes one or more tags

Cancel (Page 2767) Cancels the cyclic reading of the tag values
WriteTag 
(Page 2767)

Writes values to one or more tags synchronously
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Method Description
WriteTagAsync 
(Page 2768)

Writes values to one or more tags asynchronously

Unregister 
(Page 2769)

Removes the consumer

● ITagSink
The ITagSink object reacts to specific events using methods.

Method Description
OnCanceled 
(Page 2769)

Occurs when the ITag method "Cancel" has ended.

OnDataChanged 
(Page 2770)

Occurs when a tag value is changed by the following ITag methods:
● ReadTagAsync
● ReadTagCyclic

OnError (Page 2771) Occurs as an event of an error with the following methods:
● ReadTagAsync
● ReadTagCyclic
● WriteTagAsync
● OnDataChanged
● OnWriteComplete

OnRemoved 
(Page 2771)

Occurs when the ITag method "RemoveCyclicTag" has ended.

OnWriteComplete 
(Page 2772)

Occurs when the ITag method "WriteTagAsync" has finished.

Requirement
● The "Siemens.Runtime.ControlDev.dll" reference is set. For additional information, refer to 

"Setting the reference "Siemens.Runtime.ControlDev.dll (Page 2755)".
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

Basic procedure
1. Create an ITag object to connect to the data provider.

2. The "Register" method is used to register the customer control as a consumer of the data 
provider. The consumer receives a cookie from the data provider. The cookie is used to 
identify the access by the consumer to the data provider.

3. When the connection is established, you can access the tag values using the methods of 
the ITag object.
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9.16.2.3 Demo project

Demo project "CCITagTestLibrary"
The "<Installationsverzeichnis>SCADA-RT_V11\ControlDevelopment\samples
\VB90\CCITagTest" directory contains the demo project "CCITagTestLibrary". The various 
methods of the iTag-Interfaces are used in this Demo project. 

Use the demo project as a template for your own customer controls. This demo project includes 
the interface to the data provider of WinCC.

To use the demo project, proceed as follows:

1. Copy the entire "CCITagTestLibrary" folder to a local destination directory.

2. Double-click on the "CCITagTestLibrary.vbroj" file.

See also
Creating and testing customer controls (Page 2754)

9.16.2.4 Creating and testing customer controls

Creating and testing customer controls

Introduction
This section shows the basic procedure for creating and testing a customer control in VB.net. 

To follow the configuration steps, use a VB.net project that uses the provided 
"CCITagTestLibrary" demo project as a template.

Requirement
● Visual Studio 2005/2008 Professional .NET

● WinCC RT Advanced or WinCC RT Professional

● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created. For 
additional information, refer to "Editing a project".

Basic procedure
To create and test the "ITagUserControl" customer control, proceed as follows:

1. Check the reference "Siemens.Runtime.ControlDev.dll" (Page 2755)

2. Create a user interface (Page 2757).

3. Create the program code (Page 2758).

4. Create customer controls (Page 2759).
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5. Test customer controls in Visual Studio (Page 2760).

6. Test customer controls in WinCC (Page 2762).

See also
Demo project (Page 2754)

Creating a WinCC project (Page 2760)

Check the reference "Siemens.Runtime.ControlDev.dll"

Introduction  
To access the data provider of WinCC, the VB.net project is linked to the 
"Siemens.Runtime.ControlDev.dll" library.

Requirement
● Visual Studio 2005/2008 Professional .NET is installed.

● A VB.net project is open. The VB.net project uses the demo project as a template.
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Procedure
Proceed as follows to verify the reference:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > My Project" item.

The Project Designer opens.

2. Click on "References" in the Project Designer.

3. If the reference is not set, click on "Add...". In the "Add Reference" dialog, click "Browse".

4. In WinCC Runtime Professional, navigate to the directory "...\Siemens\WinCC\bin".
In WinCC Runtime Advanced, navigate to the directory "...\WinCC Runtime Advanced".

5. Select the entry "Siemens.Runtime.ControlDev.dll". Click "OK".

See also
Interfaces (Page 2752)

Visualizing processes (Professional)
9.16 Interfaces

WinCC Professional V11.0 SP1
2756 System Manual, 08/2011,  



Creating a user interface

Settings
For the configuration you require objects with the following settings:

Object Quantity Property Setting
GroupBox 1 Text ReadTag
Label 2 Text

Text
TagName
Value

Textbox 2 (Name) txtReadTagTagName
(Name)
ReadOnly

txtReadTagValue
True

Button 1 Text
(Name)

Read
btnReadTagStart

Requirement
● A VB.net project is open. The VB.net project uses the demo project as a template.

● The toolbox is displayed.

● The properties window is displayed.

Procedure   
To create the user interface, follow these steps:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > ITagUserControl.vb" item. The 
Form Designer opens.

2. Insert a GroupBox into the form from the tool window. Configure the GroupBox with the 
settings described above.

3. Insert two text box objects into the form from the tool window. Configure the objects with 
the settings described above.

4. Add two labels to the form. Configure the labels with the settings described above.

5. Add a button to the form. Configure the button with the settings described above.
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Result
The user interface for the "ITagUserControl" customer control has been created.

Creating program code

Introduction
To use customer control to access the WinCC tag values, implement the access to the ITag 
interface. 

Procedure     
To create the program code, proceed as follows:

1. For access to the ITag interface, enter the following:

 
   ' ITag interface
   Dim m_ITag As ITag ' get the Tagset Object from the container
   m_ITag = Site.GetService(GetType(ITag))
   ' Connect to server
   m_RegisterCookie = m_ITag.Register(Me)

 

1. Double-click the "btnReadTagStart" button in the Form Designer. The code window with 
the "btnReadTagStart_click" subprocedure opens automatically.

2. Insert the following code between "Sub btnReadTagStart_Click" and "End Sub".

 
Private Sub btnReadTagStart_Click(ByVal sender As Object, ByVal e As EventArgs) 
_Handles btnReadTagStart.Click
  Try
   Dim TagName As Object = "Tag_Test" ' name of the tag, e.g. coming from TextBox
   Dim Values As Object = m_ITag.ReadTag(m_RegisterCookie, TagName)
   Dim Value
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   Dim strResult
   For Each Value In Values
     strResult = CStr(Value) ' the result of the ReadTag could be written in a TextBox 
(Ensabled = False)
   Next
   Catch ex As Exception
     MsgBox("ReadTag:" & vbCrLf & ex.Message)
   End Try
End Sub

Result
Access to the ITag interface is implemented and the code for the button "btnReadTagStart" is 
created.

To access the ITag interface from Visual Studio, the ProgID of the data provider must be 
transferred.

● ProgID for WinCC Runtime Professional: CCITagControl.ITagControl.1

● ProgID for WinCC Runtime Advanced: FwTagDataProvider.FwTagDataProvider

Example
' Create the TagServer Object   
Dim oTagServer As Object = CreateObject("CCITagControl.ITagControl.
1")
' Set the Tagset Object
m_ITag = oTagServer
You can find the full program code in the demo project "CCITagTestLibrary.

Creating customer controls

Procedure   
To create the customer control, proceed as follows.

1. Double-click the "My Project" entry in the project folder explorer. The Project Designer 
opens.

2. Click on the "Compile" button in the Project Designer. Specify the destination directory for 
the DLL file for "Build output path".

3. Save the change in the VB.net project "CCITagTestLibrary".

4. Select the "CCITagTestLibrary" entry in the project folder explorer. Select the "Build" 
command in the shortcut menu.
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Result
The "ITagUserControl.dll" file is now located in the destination directory. The customer control 
"ITagUserControl" will be displayed in the toolbox.

Testing customer controls in Visual Studio

Creating a WinCC project

Introduction
To test the "ITagUserControl" customer control, you will have to create the "TK_Test5" tag and 
the "CC_ITagUserControl" screen in WinCC.

Requirement
● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created.

● You have created and opened the "CC_ITagUserControl" screen.

● The internal tag "TK_Test5" has been created.

Procedure
To create the WinCC project for the test, proceed as follows:

1. Add an I/O field in the "CC_ITagUserControl" screen. Link the I/O field to the "TK_Test5" 
tag.

2. Add a slider to the screen. Link the slider to the "TK_Test5" tag.

3. Configure the "SetTag" system function at the "Change" event with the following settings:

Parameter Setting
Tag (output) TK_Test5
Value TK_Test5

Result
The "CC_ITagUserControl" screen has been created. The tag value in the I/O field will be 
displayed when you use the slider in Runtime.
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Creating a test form

Introduction   
You cannot test the "ITagUserControl" customer control in the Visual Studio Form Designer. 
You need a test form to test the customer control.

Requirement
"ITagUserControl" customer control has been created.

Procedure
Proceed as follows to create a test form:

1. In Solution-Explorer " select the project folder "CCITagTestLibrary". Select "Add > New 
Project..." in the shortcut menu. The "Add new project" dialog opens.

2. In the left window "Project types" under "Other languages > Visual Basic", select the entry 
"Windows". In the right window "Templates" select the entry "Windows Forms Application".

3. Enter "TestCustomControl" as the "Name". Click "OK".

4. A test form opens. Insert the "ITagUserControl" control into the test form.

5. Double-click the "TestCustomControl > My Project" entry in the project folder explorer. The 
Project Designer opens.

6. Click on "References" in the Project Designer. Verify that the reference to 
"Siemens.Runtime.ControlDev.dll" has been set.
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

7. Save the project

Result
You have created the test form for testing the "ITagUserControl" customer control. 

Testing customer controls in Visual Studio

Requirement    
● WinCC runtime is started.

● Test form is created.
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Procedure
To test the customer control in Visual Studio, proceed as follows:

1. Start the test of the customer control with <F5>. The "Form1" form opens.

2. Enter "TK_Test5" in the "TagName" field. Click "Read".

Result
The tag value "TK_Test5" will be displayed in the "Value" field. Move the slider to change the 
tag value in WinCC. The current tag value will be displayed in the I/O field. Click on "Read" to 
update the tag value in the customer control. 

An error message will appear if you enter an incorrect tag name in the "TagName" field.

Testing customer controls in WinCC

Adding customer control in WinCC

Introduction
To use customer controls in WinCC, you need to add them to the "My Controls" palette.
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Procedure
To add customer controls, proceed as follows:

1. Open a screen.

2. Select the "Select object" command in the shortcut menu of the "Tools" task card.

3. Click "Specific .Net Controls" in the "Select control" dialog. Navigate to the desired customer 
control, for example "ITagUserControl", in the "Select assembly" field.

4. Select the "ITagUserControl" customer control.

5. Click "OK".

Result
The"ITagUserControl" customer control is displayed in the "My Controls" palette.

Testing customer controls in WinCC

Requirement
● The "CC_ITagUserControl" screen has been created and opened.

Procedure
To test the "ITagUserControl" customer control, proceed as follows:

1. Add a "ITagUserControl" to the screen.

2. Start WinCC Runtime with the start screen "CC_ITagUserControl".

3. Move the slider. The new value is displayed in the I/O field.

4. Enter "TK_Test5" in the "TagName" field.

5. Click on the button "Read".

Result
The "ITagUserControl" customer control has been added. If you activate WinCC Runtime, the 
tag value is displayed in the "Value" field.
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9.16.2.5 Reference

ITag methods

Register

Description  
Registers the customer control as a consumer at the data provider. The consumer receives a 
cookie from the data provider. The cookie is used to assign a request from the data provider 
to a consumer.

Syntax
RegisterCookie Object.Register (CustomerControl) 

Parameter

Object
Name of the ITag object

Customer Control
Name of the customer controls

Return value

RegisterCookie
Cookie to identify the consumer

ReadTag

Description  
Reads the value of one or more tags at the same time.

Syntax
Values Object.ReadTag(RegisterCookie, TagNames)

Parameter

Object 
Name of the ITag object
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RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Return value

Values
Tag value

ReadTagAsync

Description  
Reads the value of one or more tags asynchronously.

Syntax
Object.ReadTagAsync (RegisterCookie, TagNames, ClientCookies, CacheDevice)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

CacheDevice
This parameter is only evaluated by WinCC RT Professional.

0 = The tag value is read from the process image (cache).

1 = The tag value is read directly from the AS.

See also
OnDataChanged (Page 2770)

OnError (Page 2771)
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ReadTagCyclic

Description
Cyclic reading of the tag values. The update cycle is used to determine how often the value is 
updated.  

Syntax
Object.ReadTagCyclic (RegisterCookie, TagNames, UpdateRates, ClientCookies, 
ServerCookies)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

UpdateRates
Update cycle of the tags. The value is entered in milliseconds.

ClientCookies
Cookie for identification of tags

Return value

ServerCookies
Cookie for identification of tags The return value is used by the ITag method 
"RemoveCyclicTag (Page 2766)".

See also
OnDataChanged (Page 2770)

OnError (Page 2771)

RemoveCyclicTag

Description   
Removes one or more tags.
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Syntax
Object.RemoveCyclicTag (RegisterCookie, ServerCookies)

Parameter

Object
Name of the ITag object.

ServerCookies
Cookie for identification of tags 

See also
ReadTagCyclic (Page 2766)

OnRemoved (Page 2771)

Cancel

Description  
Cancels the cyclic reading of the tag values.

Syntax
Object.Cancel (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

See also
OnCanceled (Page 2769)

WriteTag

Description  
Writes values to one or more tags at the same time.
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Syntax
Object.WriteTag(RegisterCookie, TagNames, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Values
Values written to the tags

WriteTagAsync

Description  
Writes values to one or more tags asynchronously.

Syntax
Object.WriteTagAsync(RegisterCookie, TagNames, ClientCookies, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

Values
Values written to the tags
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See also
OnError (Page 2771)

Unregister

Description 
Removes the consumer.

Syntax
Object.Unregister (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

ITag methods

OnCanceled

Description  
Occurs when the ITag method "Cancel (Page 2767)" has ended.

Syntax
Object.OnCanceled (RegisterCookie)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer
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OnDataChanged

Description  
Occurs when a tag is changed by the following ITag methods.

● ReadTagAsync (Page 2765)

● ReadTagCyclic (Page 2766)

Syntax
Object.OnDataChanged (RegisterCookie, TagNames, Values, Qualities, VarStates, 
TimeStamps, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

Qualities
Quality code of the tags

VarStates
Tag status of the tags

TimeStamps
Time stamp

ClientCookies
Cookie for identification of tags

See also
OnError (Page 2771)
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OnError

Description  
Occurs as an event of an error with the following methods:

● ReadTagAsync (Page 2765)

● ReadTagCyclic (Page 2766)

● WriteTagAsync (Page 2768)

● OnDataChanged (Page 2770)

● OnWriteComplete (Page 2772)

Syntax
Object.OnError (RegisterCookie, TagNames, ClientCookies, Errors)

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

Errors
Error code 

OnRemoved

Description  
Occurs when the ITag method "RemoveCyclicTag (Page 2766)" has ended.

Syntax
Object.Remove(RegisterCookie, ClientCookies)

Parameter

Object
Name of the ITagSink object

Visualizing processes (Professional)
9.16 Interfaces

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2771



RegisterCookie
Cookie to identify the consumer

ClientCookies
Cookie for identification of tags

OnWriteComplete

Description  
Occurs when the ITag method"WriteTagAsync (Page 2768)" has finished.

Syntax
Object.OnWriteComplete(RegisterCookies, TagNames, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

See also
OnError (Page 2771)

9.17 Migration to WinCC V11 

9.17.1 Overview

Overview of the section "Migration to WinCC V11"
SIMATIC WinCC V11 offers a number of functional changes. Some functions differ from the 
functions that you know from familiar environments such as WinCC V7 or WinCC flexible.
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This document provides an overview of the special functions and procedures in 
SIMATIC WinCC V11. 

These functions and procedures are fundamentally different from the WinCC V7 and 
WinCC flexible version, or have a different name.

9.17.2 WinCC V7

9.17.2.1 Actions

Actions in WinCC V7
WinCC supports the use of actions for dynamic response of the processes in your WinCC 
project. These actions are written in ANSI-C code. Action sequences are event-triggered. 

Actions can be used to run the following background tasks independent of the screen:

● Daily printout of a report

● Tag monitoring

● Calculations

How do I configure tasks in WinCC V11?
You configure tasks in WinCC V11 using the scheduler.

Visualizing processes (Professional)
9.17 Migration to WinCC V11 

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2773



You can use the scheduler to configure tasks to run independent of the screen in the 
background. Actions are mapped to tasks of the function list type.

At each task, you configure exactly one function list which is processed line by line. 
Alternatively, you configure a C or VB script. To start the task, you define a trigger.

For more detailed information, see:

Work area of the "Scheduler" editor (Page 2034) 

Example: Reading the current user name (Page 2051) 
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9.17.2.2 User objects

User objects in WinCC V7
Objects of the object pallet can be combined to form a group or user object based on a multiple 
selection. You can also insert a group or combined object into the project library.

In contrast to a group, a user object enables the individual customization of properties and 
events that can be displayed and edited in the "Object properties" window. A user object can 
be edited in Graphics Designer, similar to an individual object of the object pallet. 

How do I configure faceplates in WinCC V11?
You use faceplates to create individually configured display and operating objects in WinCC 
V11. In contrast to user objects, faceplates can be modified centrally.

WinCC V11 provides the "Faceplates" Editor within the project library for creating faceplates 
and editing their properties.

Visualizing processes (Professional)
9.17 Migration to WinCC V11 

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2775



Faceplates are based on a type-instance model to support the centralized editing. You create 
central properties for a faceplate in the types. The instances represent local places of use for 
the types.

For more detailed information, see:

Basics on faceplates (Page 785) 

Example: Configuring a faceplate (Page 809) 

9.17.2.3 User administration

User administration in WinCC V7
The "User Administrator" editor is used to set up and manage user administration.

The user administrator enables the setup and management of access rights for WinCC 
functions and WinCC users. 

In the user administration, you can assign functions such as logon timeout, or log on using a 
key switch / smart card to the users.
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The "User Administrator" editor is used for engineering and in runtime.
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How do I configure user administration in WinCC V11?
● User administration in the engineering system

You manage users, user groups and authorizations centrally in the WinCC user 
administration. You transfer users and user groups along with the project to the HMI device. 
Users are always assigned to a group and therefore inherit the group authorizations.

● User administration in runtime
You can employ a user view in a screen to manage users in runtime as well. You manage 
users and passwords directly in the user view on the HMI device.

For more detailed information, see:

Form of the user administration (Page 1685) 

Complex user view (Page 1714) 

9.17.2.4 Direct connection

Direct connections in WinCC V7
A direct connection is used to respond to events. Whenever this event occurs in runtime, the 
value of a source element is applied to a target element. 

Example of the "Mouse click" event:
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● The fill pattern of the "Rectangle1" object is synchronized with the fill pattern of the "Circle1" 
object.

● A screen change is executed.

How do I configure system functions in WinCC V11?
In WinCC V11, direct connections are mapped to system functions.

You use system functions in a function list or in a user-defined function. When the event occurs, 
execute the configured system functions using the function list. 

When configuring a function list, select the system functions from a selection list that is sorted 
by categories. 

For the implementation of the direct connection, specific functions are integrated, such as 
"SetPropertyByProperty".

Visualizing processes (Professional)
9.17 Migration to WinCC V11 

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2779



For more detailed information, see:

System functions (Page 1743) 

Configuring a function list (Page 1750) 

9.17.2.5 Dynamic Wizard

Dynamic Wizard in WinCC V7
The Dynamic Wizard can be used to set up the dynamic response of an object by means of 
C-script actions. When a wizard runs, prepared C-script actions such as set bit / reset bit and 
trigger events are defined and saved in the object properties. 

You can always edit the C-script actions in the Events tab of the object properties.
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How do I configure system functions in WinCC V11?
You provide objects dynamic properties in WinCC V11, for example, using system functions.

You use system functions in a function list, or in a user-defined function. When the event 
occurs, execute the configured system functions using the function list. 

When configuring a function list, select the system functions from a selection list that is sorted 
by categories. 

For more detailed information, see:

System functions (Page 1743) 

Configuring a function list (Page 1750) 
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9.17.2.6 Dynamics dialog

Dynamic dialog in WinCC V7
The Dynamic dialog is used to configure dynamic object properties. In the Dynamic dialog, 
you formulate an expression by using tags, functions and arithmetic operators. 

The value of the expression, the status, as well as the quality code of the tags used in the 
expression are used to generate the value of the object property in runtime.

The Dynamic dialog is used, for example, for the following purposes:

● Mapping the range of values of a tag to colors.

● Monitoring of individual tag bits and mapping the bit value to colors or texts.

● Monitoring of a Boolean tag and mapping the tag value to colors or texts.

● Monitoring the status of a tag.

● Monitoring the quality code of a tag.

How do I configure animations in WinCC V11?
Dynamic object properties can be realized, for example, using animations that you configure 
in the object properties list, "Properties > Animations".

These animations dynamically change the background color of an object, for example.
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The function "Animate property" is of particular help to you when configuring dynamic 
properties for the dynamic dialog. 

Simple animations are also possible via a tag connection at display and operating objects.

For more detailed information, see:

Basics on dynamization in the property list (Page 756) 

Configuring a new animation (Page 735) 
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9.17.2.7 Working efficiently

Mass data processing in WinCC V7
The WinCC Configuration Tool is an Excel add-in. The tool enables the simple configuration 
of mass data, such as tags. 
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How do I work efficiently in WinCC V11?
WinCC enables efficient processing of process data in table editors. WinCC provides the 
following corresponding functions:

● Importing and exporting project data

● Multiple selection

● Global changes to a property

You export or import the following project data:

● Recipe data records

● Alarms

● Tags

● Text lists

● Project texts for translations

Exporting and importing reduces the workload. 

Instead of creating new data records, use the data you have already created in previous 
projects.

For more detailed information, see:

Importing and exporting project data (Page 2062) 

9.17.2.8 Structures and structure tags

Structure tags in WinCC V7
Structures are used to enable grouping of a larger number of tags and tag types that form a 
logical unit. 

In WinCC V7, you also create structures which you can address by their names at the tag.
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How do I configure user data types in WinCC V11?
In WinCC V11, user data types enable you to group a number of different tags that form a 
logical unit.

You create user data types as a type and use instances of this type in the project. 

User data types are project-specific data and are available for all HMI devices of the project. 

You create user data types and user data type elements in the project library. User data types 
must be enabled before they can be used in the project.

The configured properties of a user data type are used in the instances of the user data type. 
If needed, you can change individual properties directly at the point of use, for example, at a 
tag. Changes to a property at the tag do not affect the user data type created.

For more detailed information, see:

Basics on user data types (Page 1023) 

Basics on user data types (Page 1023) 

See also
Creating the user data type (Page 1025)
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9.17.3 WinCC flexible

9.17.3.1 Libraries

Libraries in WinCC flexible
Libraries are a collection of pre-configured screen objects. They expand the number of 
available screen objects and increase engineering efficiency, because library objects are 
always available for reuse; there is no need to reconfigure them. 

WinCC flexible enables you to create two library types: 

● Project library

● Global library

A library can contain all the WinCC flexible objects, such as screens, tags, graphic objects, or 
alarms. 

How do I configure libraries in WinCC V11?
In WinCC V11, you also configure the "Project library" and the "Global library".

You can no longer store any system functions in libraries, as was the case in WinCC flexible.
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Both the "Project library" and the "Global library" contain the two folders, "Copy templates" and 
"Types". You can create or use the library objects as a copy template, or as a type. 

● Copy templates
Use copy templates to create independent copies of the library object. 

● Types
Create instances of objects of the "Types" folder and use the instances in your project. The 
instances are bound to their respective type. Changes to an instance also change all other 
instances. Types are marked by a green triangle in the "Libraries" task card.

● Managing the library objects
You can only copy and move library objects within the same library. 

For more detailed information, see:

Libraries in WinCC 
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9.17.3.2 Screens and templates

Screens and templates in WinCC flexible
In WinCC flexible, you create screens that an operator can use to control and monitor machines 
and plants. When you create your screens, the object templates provided support you in 
visualizing your plant, displaying processes and defining process values.

The project has a template for every HMI device. You can centrally configure the function keys 
and objects for your project in these templates. 

Every screen based on this template will contain the function keys and objects that you 
configured in the template. Changes to an object or of a function key assignment in the template 
are applied to the object in all the screens, which are based on this template. 

How do I configure screens and templates in WinCC V11?
In WinCC V11, you also configure "Templates" and a "Global screen" along with the "Screens".

You determine functions and objects in the template which then apply to all screens based on 
this template. You can create multiple templates in WinCC.

In the "Global screen", define the elements which are independent of the template used for all 
screens of an HMI device. The "Alarm window" and "Alarm indicator" objects are available for 
use as global objects. For HMI devices with function keys, configure the function keys in the 
"Global Screen" editor. 

For Comfort Panels, you also have the possibility of configuring a "System diagnostics view" 
in the global screen.
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Excluding the controls, the screens are displayed in runtime in the following order:

For more detailed information, see:

Screen basics 
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9.17.3.3 Scripts in faceplates

Scripts in faceplates in WinCC flexible
You configure a script in the "Scripts" tab of the "Faceplate configuration" dialog. These scripts 
are only available within the faceplate. 

Interconnect the script directly to the events of the objects contained in the faceplate, for 
example, with the "Click" event of a button. If you use the faceplate in a screen, a faceplate 
instance is generated. 

How do I configure scripts in faceplates in WinCC V11?
In the configuration area of the "Faceplates" editor, you create scripts that you only use within 
a faceplate type. 

In contrast to WinCC flexible, WinCC V11 allows you to configure several scripts for a faceplate.
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For more detailed information, see:

Example: Creating a script in the faceplate type 

9.17.3.4 Synchronization of recipes

How do I configure the synchronization of recipes in WinCC V11?
You configure the synchronization of recipes in the "Recipes" editor in WinCC V11. A few terms 
have changed in WinCC V11 compared to WinCC flexible.

Synchronization for Panels and RT Advanced

 

● To synchronize recipe tags that are configured in I/O fields with the recipe view, activate 
"Direct synchronization".

● Disable "Direct transfer of individually modified values" to specify that the recipe tags are 
automatically transferred to the controller when you edit the I/O fields.

● Activate "Coordinated data transfer" to monitor the transfer of recipe data in runtime using 
area pointers.

For more detailed information, see:

Synchronization of recipe data records with the PLC 
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Using online and diagnostics functions 10
10.1 General information about online mode

Online mode
In online mode, there is an online connection between your programming device / PC and one 
or more devices.  

An online connection between the programming device/PC and the device is required, for 
example, for the following tasks:

● Testing user programs

● Displaying and changing the operating mode of the CPU

● Displaying and setting the date and time of day of the CPU

● Displaying module information

● Comparing blocks

● Hardware diagnostics

Before you can establish an online connection, the programming device/PC and the device 
must be physically or remotely connected. As an alternative, some devices support a 
simulation mode. In this case, a connection to the device is simulated via the PLCSIM virtual 
interface.

After establishing a connection, you can use the Online and Diagnostics view or the "Online 
tools" task card to access the data on the device. The current online status of a device is 
indicated by an icon to the right of the device in the project tree. You will find the meaning of 
the individual status icons in the relevant tooltip.  

 

 Note

Some online functions depend on the range of the installed software or whether a project is 
open.

 

Standby or hibernation of the programming device / PC   
If the programming device / PC is changed to the standby or hibernation mode when there is 
an online connection, all online connections are terminated. When the programming device / 
PC wakes up from hibernation, the online connections are not automatically re-established.

Note that suddenly terminating an online connection can lead to loss of data or a connected 
device may interrupt program execution.
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Performing an LED flash test
In many online dialogs you can perform an LED flash test, if the device connected online 
supports this feature. When you click on the "LED flashing" button, an LED flashes at the 
currently selected station. This feature is useful, for example, when you are not sure which 
device in the hardware configuration corresponds to the station currently selected in the 
software.

Read any additional information and learn about the possible limitations to the LED flash test 
in the respective device documentation.

See also
View in online mode (Page 2795)
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10.2 View in online mode

Online displays  
After the online connection has been established successfully, the user interface changes. 
The following figure shows a device connected online and the corresponding user interface:

① The title bar of the active window now has an orange background.
② The title bars of inactive windows for the relevant station now have an orange line below 

them.
③ An orange, pulsing bar appears at the right-hand edge of the status bar. If the connection 

has been established but is functioning incorrectly, an icon for an interrupted connection 
is displayed instead of the bar. You will find more information on the error in "Diagnostics" 
in the Inspector window.
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④ Operating mode symbols or diagnostics symbols for the stations connected online and 
their underlying objects are shown in the project tree. A comparison of the online and 
offline status is also made automatically. Differences between online and offline objects 
are also displayed in the form of symbols.

⑤ The "Diagnostics > Device information" area is brought to the foreground in the Inspector 
window.

Online connection abort
The online mode and its display are retained as long as at least one device is connected online. 
If the online connection to one or more devices aborts, the TIA Portal remains in online mode. 
The display of the TIA Portal changes to offline mode only when there is no longer an online 
connection to any device.

See also
General information about online mode (Page 2793)

Basics of project data comparison (Page 210)

10.3 Online access

Online access of the project
In the "Online access" folder of the project tree, you will find all active interfaces of your 
programming device/PC. Each interface icon provides you with information on the status of 
the interface. You can also display the accessible devices and display and edit the properties 
of an interface using the shortcut menu.   

The following figure shows the "Online access" folder in the project tree.
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① "Online access" folder in the project tree
All interfaces installed in the programming device/PC are displayed in the "Online access" folder.

② Status display for the interfaces
The current status of an interface is indicated by an icon to the right of the name. You can see 
the meaning of the icon in the tooltip.

③ Updating the list of accessible devices.
This function is available for each hardware interface of the programming device/PC. Software 
interfaces, such as a remote connection, do not offer this function.

④ Devices connected via the respective interface with the programming device/PC
The type of the respective device and its status are displayed by the preceding icon.

Displaying or updating accessible devices
You have the following options if you want to display all devices accessible online on your 
programming device/PC:

● Display of the accessible devices on a single interface of the programming device / PC in 
the project tree. In the project tree, you can also display additional information about the 
individual accessible devices.

● Display of the accessible devices of all interfaces in a list.

See also: Displaying accessible devices 
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Overview of icons for accessible devices
The accessible devices are identified with an icon according to their type and status. The 
following is an overview of all icons and their meaning.

Icon for unidentified modules
This icon is displayed whenever the identification of a module is not yet complete or when the 
identification of a module was not successful, for example, because the required online data 
could not be read.
Icon for the following device types:
● SIMOCODE pro devices
● IE/PB links
● CPs of PC systems
● SCALANCE head modules
● S7-300 and S7-400 CPs
● PROFINET IO devices and PROFINET CPs
● SCALANCE modules and gateways that could not be identified
PROFINET IO devices, encoders, switchgear, sensors and identification systems that were 
replaced by similar devices because these could not be identified
Icon for the following device types:
● HMI devices
● PROFINET IO devices of the HMI type if these could not be identified and were therefore 

replaced by a similar device
PROFINET IO devices of the drive type that could not be identified and were therefore replaced 
by a similar device
PROFINET IO devices of the development kit and network components type that could not be 
identified and were therefore replaced by a similar device
PROFINET IO devices of the Teleservice adapter type that could not be identified and were 
therefore replaced by a similar device

See also
Opening the properties of an interface (Page 2800)

10.4 Displaying accessible devices

Accessible devices
Accessible devices are all devices connected to an interface of the programming device / PC 
and that are turned on. Devices that allow only restricted configuration using the currently 
installed products or that cannot be configured at all can also be displayed.
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Displaying accessible devices on an interface of the programming device / PC in the project tree  
To display accessible devices on a single interface of the programming device / PC, follow 
these steps:

1. Open the "Online access" folder in the project tree.

2. Click on the arrow to the left of the interface to show all the objects arranged below the 
interface.

3. Double-click on the "Update accessible devices" command below the interface.

All devices that are accessible over this interface are displayed in the project tree.

Displaying accessible devices in a list  
To display the accessible devices on all available interfaces in an overview list, follow these 
steps:

1. Select the "Accessible devices" command in the "Online" menu.
The "Accessible devices" dialog is displayed.

2. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

3. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.
If no devices are available on an interface, an unbroken connecting line is displayed 
between the programming device / PC and the device. If devices are accessible, an 
unbroken connecting line is shown and the devices accessible on the selected interface of 
the programming device / PC are displayed in a list.

4. If you have connected a new device in the meantime, click the "Refresh" button to refresh 
the list of accessible devices.

5. To go to a device in the project tree, select the device from the list of accessible devices 
and click the "Show" button.
The interface to which the selected device is connected is shown as selected in the project 
tree.
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Displaying additional information about the accessible devices in the project tree
To display additional information on the accessible devices in the project tree, follow these 
steps:

1. Click on the arrow to the left of one of the accessible devices in the project tree.
All data available online, for example blocks and system data, is displayed for known 
devices.

10.5 Opening the properties of an interface

Introduction  
For each interface, you can display and, in some cases, modify properties, for example the 
network type, address, and status.

Procedure
To open the properties, follow these steps:

1. Right-click on the required interface below "Online access" in the project tree.

2. Select the "Properties" command from the shortcut menu.
A dialog containing the properties of the interface opens. On the left of the dialog, you will 
see the area navigation. You can view the current parameter settings in the individual 
entries in the area navigation and, if necessary, change them.

10.6 Establishing and canceling an online connection

Requirement
At least one PG/PC interface is installed and is physically connected to a device, for example 
with an Ethernet cable. As an alternative, it is also possible to establish a virtual connection 
using PLCSIM.

Go online  
To establish an online connection, follow these steps:

1. In the project tree, select one or mote devices to which you want an online connection to 
be established.

2. Select the "Go online" command in the "Online" menu.
If the device was already connected to a specific PG/PC interface, the online connection 
is automatically established to the previous PG/PC interface. In this case, you can ignore 
the following steps. If there was no previous connection, the "Go online" dialog opens.
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3. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

4. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.

5. In the "Connection to subnet" drop-down list, select the subnet via which the device is 
connected to the PG/PC interface. If the device is connected directly to the PG/PC interface, 
select the "(local) TCP/IP" setting. In this case, a direct connection is established to the 
device, without a network node, for example, an interposed switch.
If you selected an MPI or PROFIBUS subnet, the bus parameters configured in the 
programming device/PC interface are applied at this point.

6. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.
If no devices are available on the interface, a broken connecting line is displayed between 
the programming device / PC and the device. If devices are accessible, an unbroken 
connecting line is shown and the devices accessible on the selected interface of the 
programming device / PC are displayed in a list.

7. Optional: Click the "Update" button to redisplay the list of accessible devices.

8. Optional: Click the "Flash LED" button on the left of the graphic to run an LED flash test. 
With this function, you can check that you have selected the correct device. The LED flash 
test is not supported by all devices.

9. Select your device in the "Accessible devices in the target subnet" table and confirm your 
selection with "Go online".
The online connection to the selected target device is established.

Result  
After the online connection has been established, the title bars of the editors change to orange. 
An orange activity bar is also shown in the title bar of an editor and in the status bar. In the 
project tree, status symbols show the difference between online and offline objects.

The connection path is stored for future connection attempts. It is no longer necessary to open 
the "Go online" dialog unless you want to select a new connection path.

 

 Note

If no accessible device is displayed, select a different network access for the PG/PC interface 
or check the settings of the interface.

 

Canceling an online connection  
To disconnect the existing online connection, follow these steps:

1. Select the device you want to disconnect from in the project tree.

2. Select the "Go offline" command in the "Online" menu.
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See also
Connecting online with several devices (Page 2802)

View in online mode (Page 2795)

Assigning a temporary IP address (Page 2807)

Influence of user rights (Page 181)

10.7 Connecting online with several devices
You can establish an online connection to several devices at the same time without needing 
to select individual devices previously in the network view.

Requirement
● No device must be selected

● At least one PG/PC interface is installed and is physically connected to a device, for 
example with an Ethernet cable. As an alternative, it is also possible to establish a virtual 
online connection using PLCSIM or a remote connection.

Procedure 
To establish an online connection to several devices at the same time, follow these steps:

1. Select the "Go online" command in the "Online" menu.
The "Select devices" dialog opens with a table of all available devices.

2. Select the devices to which you want to establish an online connection in the "Go online" 
column.

3. Click the "Go online" button.

Result
Without any further prompt for confirmation, a connection is established to all selected devices 
if a connection was already established to the selected devices at least once. If there was no 
previous online connection, the "Go online" dialog opens. In this case, first configure the online 
connection as described in the section "Go online and disconnect online connection 
(Page 2800)".

See also
Establishing and canceling an online connection (Page 2800)

Assigning a temporary IP address (Page 2807)
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10.8 Basics of assigning parameters for the PG/PC interface

Options for connecting to target systems 
If the devices of the project are connected via different subnets, you assign a suitable network 
access to each PG/PC interface to be able to establish online connections to the target 
systems. The following interfaces are automatically supported:

● MPI

● PROFIBUS

● Industrial Ethernet (ISO and TCP/IP)

You can make various settings for the interfaces. The following sections explain the parameter 
settings you can make.

 

 Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.

 

See also
Setting parameters for the Industrial Ethernet interface (Page 2804)

Setting parameters for the MPI and PROFIBUS interfaces (Page 2809)

10.9 Adding interfaces
You have the option of installing additional interfaces after installation of the TIA Portal.

Procedure 
To install an interface at a later time and add it to the TIA Portal, follow these steps:

1. Install or update the drivers in the operating system once you have installed the interface 
hardware.

2. Close the TIA Portal if it is still open.

3. Open the Windows control panel.

4. Open the entry "Setting the PG/PC Interface" in the Control Panel.
The "Setting the PG/PC Interface" dialog opens.

5. Make any necessary changes to the interface configuration and confirm them with "OK". 
You have to click "OK", even if you have not made any changes.

6. Restart the TIA Portal.
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Result
The newly installed interface is now displayed in the project tree under the "Online access" 
folder.

10.10 Setting parameters for the Ethernet interface

10.10.1 Setting parameters for the Industrial Ethernet interface

Options in the parameter settings for the Industrial Ethernet interface  
When setting parameters for the Industrial Ethernet interface, you have the following options:

● Parameters dependent on the operating system
The Industrial Ethernet interface has parameters that are set in the operating system and 
are valid for all connected devices. These parameter settings are only displayed here, they 
can, however, be changed in the network settings of the operating system.

● Parameters that can be set in the software
 

  Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.

 

Parameters for the Industrial Ethernet interface  
The following table contains an overview of the parameters of the Industrial Ethernet interface 
that are set by the operating system and can be changed by the user.

Parameter settings that cannot be changed Parameters that can be set
MAC address Fast acknowledge at the IE-PG access and for 

TCP/IP 
DHCP server activated/deactivated Timeout at the IE-PG access and for TCP/IP
APIPA activated/deactivated LLDP
IP address Additional, dynamic IP addresses for the network 

adapter
Subnet mask -
DNS addresses -
DHCP addresses -
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See also
Basics of assigning parameters for the PG/PC interface (Page 2803)

Displaying operating system parameters (Page 2805)

Connecting the PG/PC interface to a subnet (Page 2806)

Setting parameters for the Ethernet interface (Page 2806)

Assigning a temporary IP address (Page 2807)

Managing temporary IP addresses (Page 2807)

Influence of user rights (Page 181)

10.10.2 Displaying operating system parameters
The Ethernet interface is part of the operating system. All parameters of the network adapter 
can therefore be adapted in the network settings of the operating system.

You can display the following parameters in the software:

● Physical address of the network adapter

● Assignment of the IP address by a DHCP server activated or deactivated

● Assignment of a private IP address by the operating system activated or deactivated

● Current static IP address

● Assigned subnet mask

● DNS addresses

● DHCP addresses

If you want to modify the parameter settings, please refer to the documentation of the operating 
system or the network adapter.

Displaying current parameters of the Ethernet interface  
To display the current parameters of the Ethernet interface, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > Industrial Ethernet" in the area navigation.

See also
Setting parameters for the Ethernet interface (Page 2806)
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10.10.3 Connecting the PG/PC interface to a subnet
If you have created several subnets, you can specify the subnet to which the Ethernet interface 
is connected.

Procedure 
To select the subnet to which the Ethernet interface is connected, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet to which you want to connect the 
Ethernet interface of the programming device / PC in the "Connection to subnet" drop-down 
list.

4. Close the dialog with "OK".

10.10.4 Setting parameters for the Ethernet interface
You can adapt some parameter settings relating to the network protocol directly in the software.

Requirement
You must have adequate user rights.

See also: Influence of user rights (Page 181).

Procedure   
To change parameter settings relating to the network protocol, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > IE-PG access" to adapt the protocol settings relevant to network 
management.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before a 
network node is detected.
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4. To activate the LLDP protocol and discover the network topology more accurately, set the 
"LLDP active" check box in "Configurations > LLDP".

5. Select "Configurations > TCP/IP" to adapt the TCP/IP protocol for network traffic during 
runtime.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before 
there is a timeout during communication with a network node.

See also
Influence of user rights (Page 181)

Displaying operating system parameters (Page 2805)

10.10.5 Assigning a temporary IP address

Adding a dynamic IP address   
If the IP address of a device is located in a different subnet from the IP address of the network 
adapter, you will first need to assign an additional IP address with the same subnet address 
as the device. Only then is communication between the device and the programming device / 
PC possible.

The assignment of an additional temporary IP address is also proposed automatically if you 
want to perform an online action and the current IP address of the programming device/PC is 
not yet in the correct subnet.

A temporarily assigned IP address remains valid until the next time the programming device/
PC is restarted or until you delete it manually.

 

 Note

You require adequate permissions to be able to assign a temporary IP address.

See also: Influence of user rights (Page 181) 
 

See also
Managing temporary IP addresses (Page 2807)

10.10.6 Managing temporary IP addresses
If the IP address of a device is located in a different subnet from the current static IP address 
of the network adapter, the network adapter temporarily assigns a suitable IP address from 
the subnet of the device.
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You can display all temporarily assigned addresses and delete them. Note that IP addresses 
that you manually assigned in the operating system are not displayed in the TIA Portal.

Requirement
To delete, you require adequate permissions.

Procedure  
To display and delete temporarily assigned addresses, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > IE-PG access".
A table with the assigned IP addresses is displayed.

4. Click the "Delete project-specific IP addresses" button to delete all the IP addresses at one 
time.

See also
Influence of user rights (Page 181)

10.10.7 Resetting the TCP/IP configuration
If you have changed the TCP/IP protocol settings, you can reset them to the defaults. 

Procedure
To restore the TCP/IP configuration to the default settings, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > TCP/IP".

4. Click the "Standard" button to reset all the settings.
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10.11 Setting parameters for the MPI and PROFIBUS interfaces

10.11.1 Setting parameters for the MPI and PROFIBUS interfaces

Possible parameter settings for the MPI and PROFIBUS interfaces
The following parameter settings can be made for the MPI and PROFIBUS interfaces:

● Automatic configuration: You can use automatic detection functions to find out whether a 
device is connected to the PG/PC interface over PROFIBUS or MPI.

● Selecting a default configuration for PROFIBUS or MPI that can be adapted later.

Device- and network-related settings for MPI and PROFIBUS
You can set device- and network-related parameters for MPI and PROFIBUS interfaces. 
Device-related parameters are local settings for the interface. Network-related parameters, on 
the other hand, must match up on all devices.

MPI interface parameters you can modify  
You can adapt the following default parameters for the MPI interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout  

PROFIBUS interface parameters you can modify  
You can adapt the following default parameters for the PROFIBUS interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout Profile
 Bus parameters
 Number of masters on bus
 Number of slaves on bus

See also
Basics of assigning parameters for the PG/PC interface (Page 2803)
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10.11.2 Setting MPI or PROFIBUS interface parameters automatically

Setting up automatic bus parameter detection  
If you select an interface with automatic detection of the bus parameters (for example CP 5611 
(Auto)), you can connect the programming device or PC to MPI or PROFIBUS without needing 
to set bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute.

Requirement
● Masters that distribute bus parameters cyclically are connected to the bus.

● In PROFIBUS networks, the cyclic distribution of the bus parameters must be enabled.

Procedure
To enable automatic bus parameter detection, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Configurations > Active configuration" and select the setting "Automatic 
protocol detection".

4. Go to "Configurations > Auto configuration > Local settings" and select the address of the 
PG/PC interface in the "Own address" drop-down list.

5. If you then want to display the current bus settings, click the "Network detection" button.

See also
Setting parameters for the MPI interface (Page 2810)

Setting parameters for the PROFIBUS interface (Page 2812)

10.11.3 Setting parameters for the MPI interface

Changing the parameter settings of the MPI interface  
The network-related parameters and bus parameters for the MPI network can be adapted. 
You should first select a default setting and then adapt this to the specific situation.
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Setting defaults for the MPI interface
To adapt the parameters of the MPI interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > MPI".

You can set the following device-related parameters:
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● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the MPI network.

● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest device 
address is set for all devices of a PROFIBUS or MPI network.

● Transfer rate:
Here, you select the transmission speed to be used on the MPI network.

See also
Setting MPI or PROFIBUS interface parameters automatically (Page 2810)

10.11.4 Setting parameters for the PROFIBUS interface

Changing the parameter settings of the PROFIBUS interface  
The network-related parameters and bus parameters for the PROFIBUS network can be 
adapted more precisely. You should first select a default setting and then adapt this to the 
specific situation.
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Setting defaults for the PROFIBUS interface
To adapt the parameters of the PROFIBUS interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > PROFIBUS".

You can set the following device-related parameters:
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● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the PROFIBUS 
network.

● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest station 
address is set for all devices of a PROFIBUS network.

● Transfer rate:
Here, you select the transmission speed to be used on the PROFIBUS network.

● Profile:
You have a choice of four alternatives for the PROFIBUS settings. "DP", "Standard" and 
"Universal (DP/FMS)" are predefined settings that you cannot change. If you select "User-
defined", you can adapt the bus parameters yourself.

– If you have selected "User-defined", go to "Configurations > PROFIBUS > Bus 
parameters" in area navigation.

– If you have selected one of the defaults (DP, Standard or Universal (DP/FMS)), you 
should select the "Include" check box in "Configurations > PROFIBUS > Bus parameters 
> Additional parameters". You can then set the number of masters and slaves on the 
bus. This allows a more precise calculation of the bus parameters and potential bus 
disruptions can be prevented. The option cannot be selected with a user-defined profile.
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See also
Overview of the bus parameters for PROFIBUS (Page 2815)

Setting MPI or PROFIBUS interface parameters automatically (Page 2810)

10.11.5 Overview of the bus parameters for PROFIBUS

Introduction
The PROFIBUS subnet will only function problem-free if the parameters for the bus profile are 
matched to one another. You should therefore only change the default values if you are familiar 
with how to configure the bus profile for PROFIBUS. 

It may be possible for the bus parameters to be adjusted depending on the bus profile. The 
offline values of the bus parameters are always shown even if you are online and linked to the 
target system.

The displayed parameters are valid for the entire PROFIBUS subnet.

Meaning of the individual parameters
● Tslot: Wait-to-receive time (slot time)

The wait-to-receive time (slot time) defines the maximum time the sender will wait to receive 
a response from the addressed partner.

● Max. Tsdr: Maximum protocol processing time (max. station delay responder)
The maximum protocol processing time defines the time after which the responding device 
must have processed the protocol.

● Min. Tsdr: Minimum protocol processing time (min. station delay responder)
The minimum protocol processing time specifies the minimum time required by the 
responding device to process the protocol.

● Tset: Trigger time (setup time)
The trigger time is the time that may lapse between the reception of a data frame frame 
and the reaction to it.

● Tqui: Quiet time for modulator
The quiet time for modulator specifies the time required to change from sending to receiving.

● GAP factor: GAP update factor (GAP factor)
The GAP factor specifies the number of token rotations before a new device is included in 
the token ring.

● Retry limit: Maximum number of repeated call attempts (retry limit)
This parameter defines the maximum number of attempts made to reach a device.

● Trdy: Ready time
The ready time is the time for an acknowledgment or response.

● Tid1: Idle time 1
Idle time 1 specifies the delay time after receiving a response.

Using online and diagnostics functions
10.11 Setting parameters for the MPI and PROFIBUS interfaces

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2815



● Tid2: Idle time 2
Idle time 2 specifies the delay time after sending a call without a response.

● Ttr: Target rotation time
The target rotation time is the maximum time made available for a token rotation. During 
this time, all active devices (masters) receive the token once. The difference between the 
desired token round-trip time and the actual token round-trip time decides how much time 
is left for masters to send data frames to the slaves.
As the minimum target rotation time (Ttr), select a value = 5000 times the HSA (Highest 
Station Address).

● Watchdog: Watchdog
The watchdog time specifies the time after which a device must be addressed. 
As the minimum watchdog time, select a value = 6250 times the HSA.

 

 Note

If you want to create a user-defined bus profile, please note that the minimum target rotation 
time (Ttr) should be 5000 times the HSA (highest PROFIBUS address). The minimum 
watchdog time should also be 6250 times the HSA.

 

See also
Setting parameters for the PROFIBUS interface (Page 2812)

10.11.6 Resetting the MPI or PROFIBUS configuration
If you have changed the MPI or PROFIBUS protocol settings, you can reset them to the 
defaults.  

Procedure
To restore the MPI or PROFIBUS configuration to the default settings, follow these steps:

1. Select the MPI/PROFIBUS interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > MPI" or "Configurations > PROFIBUS", depending on the interface 
properties you want to reset.

4. Click the "Standard" button to reset all the settings.
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10.12 Establishing a remote connection with TeleService

10.12.1 Basics of working with TeleService

10.12.1.1 Introduction to TeleService

Introduction
TeleService gives your controller telecommunication capability. You can manage, control and 
monitor distributed plants centrally by means of remote connections.

Scope of functions
TeleService allows you to use the range of TIA portal functions via a telephone network by 
establishing a remote connection to a remote system. The online connection allows you to edit 
a remote system in the usual way with the TIA Portal.

Advantages
Using TeleService offers the following advantages:

● You can easily access even remote sections of plants and include them in a complete 
system.

● You can offer rapid help and support in the event of faults in a remote system without having 
to go there yourself.

● You can employ your resources effectively.

● It significantly reduces costs.

● It can significantly reduce plant downtimes.

● It improves the efficiency of your plant.

See also
TeleService functionality (Page 2818)
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10.12.1.2 TeleService functionality

TeleService functionality  
TeleService offers the following functionality:

● Access to remote systems (remote maintenance):
You can manage, control, and monitor distributed plants centrally by means of remote 
connections. 
This is possible with a CPU S7-1200 or CPU S7-300/400 and a TS Adapter MPI  or a 
TS Adapter IE.

● Establishing connections from and to remote systems (PG-AS remote link):
You can use PRODAVE MPI V5.0 and higher to establish a remote connection to a remote 
system, and the communication instruction "PG_DIAL"  to establish a remote connection 
from a remote system.
This is possible with a CPU S7-300/400 or a TS Adapter MPI.

● Data exchange between plants (AS-AS remote link):
The communication instruction "AS_DIAL" allows two automation systems to exchange 
process data via the telephone network. 
This is possible with a CPU S7-300/400 and a TS Adapter MPI.

● Sending an SMS from a system:
An automation system can send a message (SMS) via a GSM radio modem using the 
communication instruction "SMS_SEND" .
This is possible with a CPU S7-300/400 or a TS Adapter MPI.

● Sending an email from a plant
With the communications instruction "AS_MAIL" an automation system can send an email.
This is possible with a CPU S7-31x-2PN/DP or a CPU 41x-3PN/D and a TS Adapter IE.  

See also
Basics of using a TS adapter (Page 2822)

Supported telephone networks and modems (Page 2819)

10.12.1.3 Telephone book at TeleService

Introduction
By double clicking on the "Telephone book" folder in the project navigation, the telephone book 
editor displaying the global telephone book is opened.   

Global telephone book properties
The global telephone book in TeleService  is used to manage the specific system data required 
for establishing a remote connection.   

The first time you open the phone book, an empty phone book will be displayed with all 
available columns; in all other cases, the last phone book to be edited will be displayed.
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You can enter any number of plants in a phone book. Systems contain the data required for 
establishing a remote connection, for example, the name and location of the device and the 
phone number to be dialed, along with all country specific details.

The respective TS adapters used are distinguished by color, depending on if a TS Adapter 
MPI or a TS Adapter IE is used for establishing the connection.

10.12.2 Telephone networks and modems

10.12.2.1 Supported telephone networks and modems

Telephone networks which can be used
TeleService can be used with digital networks (ISDN), analog networks and radio networks 
(with GSM technology). The table below shows the transmission duration scaled to the 
transmission duration of the MPI card (CP 5611 = 1x) and as a function of the TS Adapter MPI 
used:   

Connection: with TS Adapter I 
V5.0:

with TS Adapter I
V5.1/V5.2:

with TS Adapter II
V1.0:

Direct connection (COM, 19.2 
Kbps)

8 x 8 x -

Direct connection (USB) - -  2.5 x
ISDN network (64 Kbps) 16 x 11 x 8 x
Analog network (28.8 Kbps) 32 x 14 x 11 x
Radio network (9.6 Kbps) 150 x 40 x 30 x

Restrictions
Communication with the TS Adapter via the CAPI interface is not possible with internal ISDN 
cards or with PCMCIA cards unless you have a virtual COM interface from the modem 
manufacturer.  

Modem support
TeleService has been implemented to be independent of the modem. This means that all 
standard modems (Hayes-compatible/AT commands) which can be installed in the Windows 
Control Panel can also be used by TeleService.  

The basic requirement is for a physical/virtual COM interface. The choice of modem type is 
determined primarily by the existing hardware of the programming device/PC and the 
telephone network to be used.
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The following modem types/media are supported:
● Modems (external modems at the COM interface, internal modems and PCMCIA cards)

● External ISDN adapter at the COM interface or USB interface

● Internal ISDN adapter with virtual COM interface (for example AVM CAPI port)

● External ISDN modems (ISDN adapter with integrated analog modem functionality) at the 
COM interface or USB interface

● Radio network modems with GSM technology, PCMCIA adapter card or data cable and 
mobile phone

Gateways
Gateways between the various telephone networks are in principle possible. Remote 
connections from an ISDN adapter to an analog modem and vice versa only function with 
special ISDN telephone adapters.  

Performance in telephone networks
The data throughput of a remote connection depends on the modem and telephone network 
used and the quality of the telephone line.  

This version currently supports one remote connection to a TS Adapter.

10.12.2.2 Installing the local modem

Introduction
If you have already installed a modem for data transfer in your operating system, this modem 
can also be used for TeleService.  

If a modem has not yet been installed for your operating system, one must be installed before 
you can establish a remote connection with TeleService.

Procedure
Proceed as follows:

1. Make sure your programming device/PC and the modem are switched off. 

2. Physically connect the external modem to a COM or USB interface on your programming 
device/PC. You can also install an internal modem or a PCMCIA card in accordance with 
the manufacturer's specifications.

3. Now switch on the modem and then the programming device or the PC.
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Result
Plug-and-play modems are recognized and installed automatically by the operating system. 
Dialogs will take you through the installation procedure.

 

 Note
Modems without plug-and-play

If your modem is not recognized automatically when switched on, you will have to install it 
yourself using the Control Panel. 

Please refer to the information in the documentation supplied with your modem.
 

10.12.2.3 Connecting and configuring the remote modem

Introduction
A modem must also be connected to the remote system before you can work with TeleService. 
This modem is designated the "remote modem".

Configuring the remote modem
The modem receives all parameters required for operation from the TS Adapter connected. 
These include data for initializing the modem and settings for serial transmission between the 
TS Adapter and the modem.   

The data required for the remote modem is specified during the configuration of the TS Adapter.

The modem may be internal or external depending on the TS Adapter used.

How to connect a TS Adapter with an internal modem  
1. Switch off the TS Adapter.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the telephone line.

4. Switch on the TS Adapter.

How to connect a TS Adapter with an external modem  
1. Switch off the modem.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the modem using a modem cable.

4. Connect the modem to the telephone line.

5. Switch on the modem.

6. Switch on the TS Adapter.
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 Note
Please note the following information on configuring the remote modem:
● The default parameters for the modem and the serial port set in the TS Adapter should in 

most cases ensure successful operation; changes in the parameter assignment will only 
be needed in rare cases.

● You need only change the parameter assignment of the TS Adapter if a modem connection 
is not established or if factory settings are to be adapted or optimized.

● TS Adapter parameter assignment can be changed via either a direct or a remote 
connection.

 

10.12.2.4 Initialization string requirements

Introduction
The initialization string is a string composed of AT commands (quasi-standard commands for 
modems) used to initialize the modem connected to the TS Adapter.

Initialization string requirements
The following properties must be specified in the string for initializing the modem: 

● The modem outputs feedback messages.

● The feedback messages are output in clear text.

● The DCD signal is only activated when a connection exists.

● The speed of transmission between the TS Adapter and modem is not changed after the 
connection has been established.

● The RTS/CTS protocol has been activated as a flow control between the TS Adapter and 
the programming device or PC.

● Automatic call acceptance by the modem has been activated.

10.12.3 Using a TS adapter to establish a remote connection

10.12.3.1 Basics of using a TS adapter

Using a TS Adapter for TeleService
A TS Adapter is needed for establishing a remote connection using TeleService.  

The TS Adapter is used to prepare an automation system for use with TeleService by 
connecting it to a telephone network via a modem. The TS adapter has an integrated parameter 
memory in which a parameter set for TeleService operation is stored. 
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With the function "export adapter parameter", different parameter sets can be saved in external 
files, and reloaded in the TS Adapter  via the function "import adapter parameter".

The figure below shows how a remote connection can be established with variousTS Adapter: 

Figure 10-1 Establishing the remote connection

You can choose between a number of different TS Adapters, each of which offers a different 
functionality and different connection options.

Overview of possible TS Adapter:
The TS Adapter comes in the following versions:  

● TS Adapter I (also designated "TS Adapter MPI")

● TS Adapter II  (also designated "TS Adapter MPI")

● TS Adapter IE Standard  (also designated "TS Adapter IE")

● TS Adapter IE Basic  (also designated "TS Adapter IE")

Designation "TS Adapter"  
In the following pages, the designation "TS Adapter" stands for all versions. The relevant 
product designation is listed beside information which only applies to a specific version, e.g. 
"TS Adapter I", "TS Adapter II", "TS Adapter IE Standard" or "TS Adapter IE Basic".

 

 Note

For more detailed information on your TS Adapter, please refer to the documentation supplied 
with it.

 

See also
Short description of the TS adapter MPI (Page 2824)

Short description of the TS adapter IE (Page 2831)

Exporting adapter parameters (Page 2830)

Importing adapter parameters (Page 2830)
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10.12.3.2 Installing TS adapter software

Requirement
A TS Adapter is needed for establishing a remote connection using TeleService.

Software for TS Adapter
The software required for running a TS Adapter is installed with the TIA portal. 

No additional software needs to be installed to establish a remote connection with TeleService. 

10.12.3.3 TS adapter MPI

Short description of the TS adapter MPI

TS Adapter MPI:
The designation "TS Adapter MPI" is a collective term for allTS Adapter with an MPI/DP 
interface.  

The TS Adapter MPI comes in the following versions:

● As TS Adapter I (parameters cannot be assigned via the TIA portal)

● as TS Adapter II

The tables below provide a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with it.

TS Adapter I
Direct connection via the serial port. The firmware cannot be replaced.
Version: Main expansions:
V3.0 -
V5.0 Access protection
V5.1 Access protection, network type AUTO
V5.2 Access protection, network type AUTO, sending SMS messages

TS Adapter II:
Direct connection via the Universal Serial Bus (USB). Replaceable firmware. Modem integrated or 
external. The TS Adapter II switches automatically between the modems. As long as no external modem 
is connected, the adapter will use the internal modem.
There are two variants:
● With internal analog modem. An external modem can also be connected to the RS232 port.
● With internal ISDN adapter. An external modem can also be connected to the RS232 port.
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Use of the designation "TS Adapter"
For TeleService the designation "TS Adapter" is the generalization for all versions. The relevant 
product designation is listed beside information which only applies to a specific version of a 
TS Adapter, e.g. "TS Adapter I", "TS Adapter II", "TS Adapter IE Standard" or 
"TS Adapter IE Basic".  

How the TS adapter MPI works

How the TS Adapter MPI Works
In line with the configuration, the TS Adapter MPI connects the serial port or USB port of your 
programming device/personal computer (direct connection) or the serial port of a modem 
(modem connection) to the MPI/PROFIBUS network of your automation system.  

The TS Adapter MPI has a non-volatile memory. Parameters for the following functions are 
stored in this memory:

● The MPI/PROFIBUS network (network parameters)

● The mode of the modem used

● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

When "Direct connection" is configured, the TS Adapter will only use the network parameters 
for access to the MPI/PROFIBUS network.

In the "Modem connection" configuration, all the parameters stored on the TS Adapter will be 
activated.

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.

 

Operating a TS adapter MPI in direct connection mode

Direct connection with TS Adapter MPI
The direct connection is used to assign the parameters of the TS adapter MPI. The same 
configuration also allows you to go online in the TIA portal and thereby check the assigned 
MPI/PROFIBUS parameters for bus compatibility. This means that (as with a PC adapter) 
SIMATIC S7/C7 systems can be accessed via the MPI/DP interface without an MPI/
PROFIBUS module occupying a slot for a programming device/PC.  
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Access protection for the TS Adapter is not active in direct connection configuration. This 
means that the parameter assignment of the TS Adapter can be changed without any 
problems, for example by importing adapter parameters.

 

 Note
Display the TS adapter MPI in the TIA portal

 

As soon as you have connected a TS adapter MPI with the PG/PC via the UBS interface, the 
folder "TS adapter" is displayed in the project navigation. 

When you open the folder, you can assign the parameters of the connected TS adapter MPI 
via the following dialog.

Establishing the direct connection for TS Adapter MPI
Direct connection mode means there is a direct connection via the TS Adapter MPI between 
the programming device/personal computer on which TeleService is installed and the 
automation system. No modem is required.  

The figure below shows the configuration of the TS Adapter MPI with a direct connection.

 

Operating a TS adapter MPI in modem connection mode

Introduction to the modem connection with TS Adapter MPI
This configuration allows you to dial into a remote system. To do this, you establish a remote 
connection to a remote system using TeleService on a telephone network. You can then work 
with the selected system as usual, with the TIA portal, over the established modem connection. 

Establishing a modem connection with TS Adapter MPI
This connection between the programming device or PC on which TeleService is installed and 
the automation system in which the TS Adapter MPI is inserted in the MPI/DP interface is made 
through a modem route. 

The configuration therefore includes the programming device or PC via the telephone network 
and the TS Adapter MPI on the MPI/DP interface of the automation system.

The figure below shows the configuration of the TS Adapter MPI with a modem connection.
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 Note
Parallel operation between direct and modem connection

The TS adapter II has two connections for communication with PG/PC, both of which can be 
connected at the same time. At the same time, connect the USB interface with the PG/PC 
and the modem interface with the telephone network.

In this configuration you can either use the direct or the modem connection.

A parallel operation is not possible!
 

TS adapter MPI configuration options

Useful information on configuring the TS Adapter MPI
The TS Adapter MPI can be configured in both direct connection mode and via an existing 
remote connection.  

The following parameter assignment options are available:

● Reconfiguration (Page 2828)

● Restoring default parameter assignment (Page 2829)

● Importing adapter parameters (Page 2830)

● Exporting adapter parameters (Page 2830)

● Setting up access protection (Page 2838)
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Parameter assignment
Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignment.

 

 Note
Please note the following when configuring the TS Adapter MPI
● If you change the current parameter settings when there is an established remote 

connection, there is a risk it will not subsequently be possible to establish a modem 
connection with the modified parameters. The TS Adapter MPI can in this case only be 
configured in direct connection mode.

● This means that either parameter assignment must be carried out with a programming 
device/personal computer at the plant location or the TS Adapter MPI must be brought to 
the location of the local programming device/personal computer in order to be configured.

 

Positive acknowledgement
During parameter assignment, the data is written to the non-volatile memory of the TS Adapter 
MPI. The parameter assignment process is not acknowledged positively until all precautions 
have been taken to ensure that parameter changes have been carried out correctly and will 
thus survive a power failure.

Changes become effective for the TS Adapter MPI as follows:
● The serial parameters, the modem parameters and the parameters for access protection 

are activated once the remote connection has been terminated.

● The modified network parameters are activated immediately.

Configuring TS adapter MPI

Introduction
The TS Adapter MPI  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.  

The following describes the method for assigning parameters in direct connection.

Requirement
A TS Adapter MPI  is connected to your computer and the folder "TS adapter" is displayed in 
the project tree under "Online access".
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Procedure
To assign the parameters for the TS Adapter MPI im Direktanschluss  please proceed as 
follows:

1. In the project tree, double-click on the "TS adapter" folder under "Online access".

2. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

3. Set the desired parameters in the individual tabs of the dialog.

4. Confirm your entries with "OK".

Result
The configured parameters are saved in the non-volatile memory of the TS adapter MPI. 
Parameter assignment is then complete.

Restoring default parameter assignment for TS adapter MPI

Introduction
You can restore the default, factory state parameters of the TS Adapter MPI.

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
Proceed as follows to restore default parameters for the TS Adapter MPI:  

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Reset" button under "General".

5. Confirm your entries with "OK".

 

Result
The TS Adapter MPI default parameters set on delivery are restored.

See also
TS adapter MPI configuration options (Page 2827)
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Exporting adapter parameters

Introduction
You can export the configuration of a TS Adapter MPI to an external file. The configuration 
saved in this file can be imported in turn into any number of TS Adapter MPI.  

This can for example be useful if you want to assign identical parameters to 
multipleTS Adapter MPI or if you want save, document or distribute the parameter set. 

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To export the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Export" button.

5. A window will open in which you can select the file to which you wish to export the 
configuration of the TS Adapter MPI.

6. Confirm with "Save".

Result
The parameters of the TS Adapter MPI are saved in the specified file (*.tap). The export of the 
adapter parameters is now complete.

 

Importing adapter parameters

Introduction
You can import the configuration of a TS Adapter MPI from a previously created export file 
(*.tap).  

The configuration saved in this file can be imported into any number of TS Adapter. This can 
for example be useful if you want to assign identical parameters to multiple TS Adapter MPI. 

You can import parameters locally in direct connection mode or via an existing remote 
connection in modem connection mode.

Using online and diagnostics functions
10.12 Establishing a remote connection with TeleService

WinCC Professional V11.0 SP1
2830 System Manual, 08/2011,  



Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To import the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Import" button.

5. A dialog will open in which you can select the file to which you wish to import the 
configuration of the TS Adapter MPI.

6. Confirm the next dialog with "Yes".

Result
The parameters selected are saved in the non-volatile memory of the TS Adapter MPI. Adapter 
parameter import is then complete.

10.12.3.4 TS adapter IE

Short description of the TS adapter IE

TS Adapter IE
The designation "TS Adapter IE" is a collective term for allTS Adapter with an Ethernet port.  

The TS Adapter IE comes in the following versions:

● as TS Adapter IE Standard

● as TS Adapter IE Basic

The tables below provide a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with it.

TS Adapter IE Standard:
Direct connection over Industrial Ethernet (IE). Replaceable firmware. Modem integrated or external. 
The TS Adapter IE cannot automatically switch between modems like the TS Adapter II. Parameters 
are assigned via a Web interface.
There are 2 variants:
● With internal analog modem. An external modem can also be connected to the RS232 port.
● With internal ISDN adapter. An external modem can also be connected to the RS232 port.
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TS Adapter IE Basic:
Direct connection over Industrial Ethernet (IE). Replaceable firmware. Plug-in modules. Parameters 
are assigned via a Web interface.
There are 4 variants:
● TS Adapter IE Basic MODEM:

Basic device TS Adapter IE Basic with TS Module MODEM for operation on the analog telephone 
network.

● TS Adapter IE Basic ISDN:
Basic device TS Adapter IE Basic with TS Module ISDN for operation on ISDN telephone systems.

● TS Adapter IE Basic GSM:
Basic device TS Adapter IE Basic with TS Module GSM for operation on the GSM radio network.

● TS Adapter IE Basic RS232:
Basic device TS Adapter IE Basic with TS Module RS232 for connecting an external modem.

Use of the designation "TS Adapter"
"TS Adapter" is used in the TeleService online help as a general designation for all versions. 
The relevant product designation is listed beside information which only applies to a specific 
version of a TS Adapter, e.g. "TS Adapter I", "TS Adapter II", "TS Adapter IE Standard" or 
"TS Adapter IE Basic".  

How the TS adapter IE works

How the TS Adapter IE works
The TS Adapter IE  connects the telephone network or the serial port of a modem with the 
Industrial Ethernet  of your automation system.  

The TS Adapter IE  has a non-volatile memory. Parameters for the following functions are 
stored in this memory:

● The mode of the modem used

● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter IE comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.
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Connection Types

Connection types of the TS Adapter IE Basic
The following diagrams show the connection types possible with the TS Adapter IE Basic. 

Direct connection
In the direct connection to the PG/PC, you can set the TS Adapter IE Basic through Ethernet. 

 

 Note

The operation of the TS Adapter IE Basic  without a TS module is not permitted.
 

Figure 10-2 Direct connection

Connection to the telephone network
In order to have a direct connection to the telephone network, you must connect the 
TS Adapter IE Basic together with one of the following TS modules:

● TS Module Modem

● TS Module ISDN

Figure 10-3 Direct connection to the telephone network
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More information about the TS modules can be found in the TS Adapter modular manual.

Connection to the GSM network
In order to connect to the GSM network, you must operate the TS Adapter IE Basic together 
with this TS module:

● TS Module GSM

Figure 10-4 Connection to the GSM network

More information about the TS modules can be found in the TS Adapter modular manual. 

Connection to the telephone network through an external modem
For the connection to an external modem, you must operate the TS Adapter IE Basic together 
with this module:

● TS Module RS232

Figure 10-5 Connection to an external modem

More information about the TS modules can be found in the TS Adapter modular manual. 
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TS Adapter IE parameter assignment options

Useful information for configuring the TS Adapter IE
The TS Adapter IE is configured via a Web interface. 

Web help associated with the parameter assignment interface is made available for the 
configuring the TS Adapter IE.

The following parameter assignment options are available:

● Reconfiguration

● Restoring default parameter assignment

● Importing adapter parameters

● Exporting adapter parameters
 

 Note
Parameter assignment

Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignments.

 

Parameter assignment for TS Adapter IE

<Introduction
The TS Adapter IE  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.  

The following describes the process of assigning parameters in direct connection. 

Specific details for assigning parameters of the TS adapter IE can be obtained from the TS 
adapter IE documentation.

Requirement
There is a LAN connection to your TS Adapter IE Basic. 

The TS Adapter IE Basic is connected to the power supply. 

Procedure
To assign the parameters for the TS Adapter IE  please proceed as follows::

1. In the project tree of the TIA portal, open the "Online access" folder.

2. Double-click on the Ethernet port of your computer.

3. Double-click on the "Display accessible nodes" command. The TS adapter IE is then 
displayed.
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4. Double-click on the <TS adapter IE> folder and then on "Online and diagnostic", and assign 
the desired IP address to the TS adapter IE in the following dialogs. Please note that the 
IP address of the PG/PC interface card is located in the same subnet as the IP address 
that you issue for the TS adapter IE.

5. Update the view in the project tree for the "Accessible nodes", so that the TS adapter IE is 
displayed with the newly allocated IP address.

6. Open the folder <TS adapter IE> in the node list.

7. Double-click the command "Assign TS adapter IE parameters". The allocated web-interface 
opens for assigning the TS adapters IE parameter.

8. Complete the "logon" for the web interface.

9. Set the desired parameters in the individual tabs of the dialog.

10.Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS adapter IE. 
Parameter assignment is then complete.

10.12.4 Access protection for TeleService and the TS Adapter

10.12.4.1 Access protection information

Introduction
When you assign the parameters for your TS adapter, you can restrict access to the parameters 
of the TS adapter and access to remote systems.

Scope of access protection
Access protection only exists for remote connections; TS adapter parameter assignment can 
be accessed at any time in direct connection mode.  

Access protection also exists in direct connection for the TS adapter IE.

Access protection information
The TS Adapter MPI is not delivered with access protection activated. There is a default 
password for the TS adapter IE.

The first user who assigns the parameters for this adapter can therefore activate access 
protection by defining the password for a user and/or a callback number.  

This is a multi-level access protection with several users, each with or without administrator 
rights. For the TS adapter MPI there is only one adminstrator and no more than two users.
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For a modem connection, only an administrator can define the two users and change and, if 
necessary, delete their settings. Those logged in as users can only change their own 
passwords and their own callback numbers. However, with the TS adapter MP you can access 
the process of assigning parameters of the TS adapter in direct connection, without restriction.

Advantages
Access protection offers the following advantages:  

● Unauthorized access by persons outside the system is almost impossible.

● The plant operator bears most of the telephone costs.

10.12.4.2 TeleService callback options

Callback variants
The costs of a telephone connection are normally borne by the caller who sets up the 
TeleService session.

TeleService can, however, be used so that after a short initial connection the modem 
connection is established again in the opposite direction, in other words initiated by the 
TS Adapter (callback). In this case, the plant operator bears the costs of the callback.

There are two callback variants in TeleService:
1. Callback to a number specified during connection establishment.

2. Callback to a number stored on the TS Adapter.

10.12.4.3 Levels of protection

Introduction
You can set up one of two possible levels of access protection for TeleService access to the 
TS Adapter. Different options are available with each protection level.

Access protection options
Access protection level 1:

The TS Adapter  is protected by the user name and password. You can access the TS Adapter 
via any telephone line and specify any callback number during connection establishment.

Access protection level 2:

The TS Adapter is protected by the user name, password, and the callback number. You can 
only access the TS Adapter from one telephone connection per user.

The table below sets out the above conditions for the various protection levels:
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Level of access 
protection

Administrator/User password Callback number

1 enter do not enter
2 enter enter

Logging on to TS Adapter
When you log on to the TS Adapter and after you have set up access protection, enter your 
user name, the corresponding password and, if desired, a callback number:

Level of access 
protection

Administrator/User password Callback number

1 enter do not enter or enter any 
callback number

2 enter do not enter

 

If you have entered a callback number during connection establishment (access protection 
level 1) or stored a callback number in the TS Adapter (access protection level 2), the modem 
connection will be terminated and the TS Adapter will call back the given number.

 

10.12.4.4 Setting up access protection and callback number for the TS adapter

Introduction
During the parameter assignment for the TS adapter MPI in TeleService, you can set up access 
protection and a callback number for the parameter assignment of the adapter and connection 
to the remote system. The following describes the parameter assignment for a TS adapter 
MPI. The parameter assignment of a TS adapter IE is carried out in analog. The specific method 
is described in the web help of this adapter.  

Requirement 
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Accessible nodes".

Procedure
To set up access protection for the TS adapter, proceed as follows: 

1. Click on the command "Assign TS Adapter MPI parameters" in the project tree.

2. Open the "Access security" tab.
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3. Enter a password for your user name and/or number that you want the modem to call back 
following logon.

– If you are an administrator, you can change all the settings for administrators and users, 
and delete or create users.

– If you are logged on as a user, you can only change your own settings (password and 
callback number).

4. Confirm all entries before exiting the dialog with "OK".

5. Click the "Yes" button to confirm the following query.

Result
The parameter assignment for the access protection and the callback number is saved in the 
non-volatile memory of the TS adapter MPI.

 
 

 Note
Important points to note when setting up access protection:
● The settings in the "Modem" tab must correspond to the conditions at the plant if callback 

functionality is to be guaranteed.
● Entering an incorrect callback number in the role of "ADMIN" user will mean you are no 

longer able to access the TS Adapter MPI over a remote connection!
● Test the callback number before you enter it as the "ADMIN" user by calling the given 

callback number during connection establishment (access protection level 1).
 

 

10.12.4.5 Complete a callback in TeleService

Callback options
Two different callback variants can be set up in TeleService.

The following callback options are available:  

● Callback to a number specified during connection establishment.

● Callback to a number stored on the TS Adapter

Callback to a number specified during connection establishment  
1. In the project tree of the TIA Portal, open the "Online access" folder.

2. Then click the "TeleService" folder contained within.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. Select the adapter type used in the "TS Adapter" drop down list.
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5. Select the telephone network under "Network" if it is not already selected.

6. Select the modem you are using under "Local Settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter your user name and associated password of the TS adapter.

9. If you want a "Connection setup with callback", select the appropriate option button.

10.Click the "Dial" button to establish the desired remote connection. This button only becomes 
active when you have entered all the parameters needed establishing a remote connection. 
Any remote connection is displayed under "Status".

11.Enter the desired callback number in the dialog that follows.

Result
The remote connection to the desired system is made with callback. 

The connected system is shown with the corresponding icon in the project tree.
 

 Note

This procedure is useful if the costs of the modem connection are to be borne by the plant 
operator and if the actual callback number is not fixed, i.e. callback is not always to the same 
receiver. It is particularly useful for mobile users.

 

Callback to a number stored on the TS Adapter
1. Assign the parameters for the desired callback number in the TS adapter.

2. Establish a connection to the TS adapter as described above, and observe the following 
features:

– Enter the user name and password for which the callback number parameters are 
assigned in the TS adapter.

– The optional field "Establish a connection with callback" does not have to be selected, 
since the callback number is already known by the TS adapter.

Result 
Callback to a number stored on the TS adapter has been established. If a remote connection 
is established, the callback occurs from the remote system. 

 

 Note

This procedure offers the highest level of access protection. However, it does pose a risk: if 
the callback number stored on the TS Adapter is not correct, it will no longer be possible to 
access the TS Adapter over a modem connection. The device can in such a case only be put 
back into operation by changing the parameter settings on site.
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10.12.5 Establishing a remote connection to a remote plant

10.12.5.1 Establishing a remote connection

Introduction for establishing a remote connection
A remote connection is established when you use TeleService to dial into a remote system via 
a telephone network. The programming device/personal computer is connected to the 
telephone network with TeleService via a modem. At the other end, the automation system is 
connected to the telephone line via a configured TS Adapter  and a modem.  

Requirements
A local modem is installed and configured.  

The TS adapter is located in the remote system. 

A remote modem is installed and parameters have been assigned. 

Proceed as follows:  
1. In the project tree of the TIA Portal, open the "Online access" folder.

2. Then click the "TeleService" folder contained within.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. Select the adapter type used in the "TS Adapter" drop down list.

5. Select the telephone network under "Network".

6. Select the modem you are using under "Local Settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter the your user name and associated password.

9. If you want a "Connection setup with callback", select the appropriate option button.

10.Click the "Dial" button to establish the desired remote connection. This button only becomes 
active when you have entered all the parameters needed establishing a remote connection. 
Any remote connection is displayed under "Status".

Result
The remote connection to the desired plant is established. In "Status" the progress of 
establishing the connection is displayed: First "Select", then "Authenticate".

The dialog closes once the remote connection is established. The message appears in the 
TIA portal status line: "Remote connection is established". You can now use the remote 
connection with TIA portal and communicate with the automation system.
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If the connection cannot be established ...
If the connection cannot be established, try to find the cause using the "Troubleshooting" 
information.  

Terminating the connection
Once you have finished editing the remote system, exit the remote connection in the project 
tree by double-clicking on the entry "Establish/disconnect remote connection". 

By exiting the TIA portal you are also exiting the remote connection.  

10.12.5.2 Terminating a remote connection

To disconnect an active remote connection, proceed as follows:
1. Double-click the "Set up/close remote connection" entry. 

Result
The connection will be terminated immediately.

"Offline" status will be displayed in the status row again once the remote connection has been 
terminated.

 

 Note

You should go offline in the TIA Portal before you terminate the remote connection.
 

 

10.12.5.3 Checklist for troubleshooting the modem

Introduction
The following list should help you establish the potential cause of any problems with the 
modem. The help topics below set out how and in which dialogs you define the relevant settings.

Modem connection cannot be established:
● Check the cabling and the connections.

● Have you set the correct dialing mode (tone/pulse)?

● If your modem does not react after several attempts to dial, a dial disable function may be 
active. Familiarize yourself with dial disable on your modem.

● Are you operating your modem on a main telephone line or on an extension line? Configure 
the properties and dialing parameters of the modem accordingly.
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● Enable the log file option in the advanced properties. The next attempt to establish a 
connection will then be recorded in a file in the Windows directory.

● Ensure that the ISDN TAs used work with the same B and D channel protocol.

The modem connection is terminated:
● Metering pulses can have a negative affect on a connection. Have the pulses deactivated 

by your telephone company.

● Set fixed monitoring times.

● Deactivate the option that terminates an existing connection automatically after a specified 
time without data transfer (idle).

● Ensure that you have activated the RTS/CTS protocol for data flow control.

10.12.6 Working with the phone book

10.12.6.1 Basics on working with the phone book

Working with the phone book
You have the following options when working with a phone book:  

● Open phone book

● Save phone book

● Import phone book data

● Export phone book data

● Printing the phone book

● Use phone book data to establish a remote connection.

You can implement these functions simply and easily using the buttons in the toolbar.
 

 Note
Access to phone books

The phonebook is user specific in TeleService. However, it is not possible to access the global 
telephone book with more than one instance of the TIA portal at the same time.  
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See also
Open phone book (Page 2845)

Saving phone book (Page 2845)

Importing phone book data (Page 2845)

Exporting phone book data (Page 2846)

Printing the phone book (Page 2847)

10.12.6.2 Structure of the phone book

Introduction
A global telephone book in TeleService is used to manage the data you require for establishing 
a remote connection. Once you have created the connection data and saved it in the telephone 
book, you can access it each time you want to establish a remote connection.

Structure of the phone book
The integrated global telephone book in TeleService contains the following columns: 

Column name Meaning
Plant name Enter a name for your plant
Adapter type Select the TS Adapter type used in the drop down list.
Area code Enter the area code.
Telephone number Enter the telephone number to be dialed for the remote connection.
Country Enter the country code.
User name Enter the user name you have logged on under.
Password Enter the password for this user name.
Group Enter the group if you have carried out grouping.
Company Enter the company to be called.
Department Enter the company department to be called.
Street Enter the street.
Town/City Enter the town or city to be called.
Comment Enter a comment if required.
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10.12.6.3 Symbols in the phone book

Meaning of the TeleService icons   
The following table shows the meaning of the TeleService icons: 

Symbol Meaning
Open the global telephone book.

Import a telephone book.

Exports a phone book.

Establishes a remote connection.

Closes the active remote connection.

Establishing or closing a remote connection.

10.12.6.4 Manage phone book

Open phone book

Opening phone books  
To open the phone book, proceed as follows:

1. In the project tree, double-click on the "Phone book" folder under "Online access" > 
"TeleService".

2. The phone book opens so that you can enter or edit the desired plant data.

Saving phone book

Saving phone books
The global phonebook is saved automatically when you exit the phone book editor or when 
leave the TIA Portal. 

Importing phone book data

Introduction
It is possible to import the phone book data from an external file. The configuration saved in 
this file can be imported in turn into any number of TS Adapter MPIs. 
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Requirement
You have already created an import-capable phone book file under TeleService.

Procedure
Proceed as follows to import the phone book data:

1. Open the "TeleService" folder in project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Import" button in the toolbar.

4. Confirm the prompt asking if you want to save the current state of the phone book with 
"Yes" when applicable, and specify the location for storing the phone book in the dialog 
that follows.

5. If you do not want save the current state of the phone book, answer the prompt with "No". 
In the subsequent dialog, select the phone book file to which in the current phone book 
should be stored.

6. Close the dialog box with "OK".

Result
The imported phone book data is displayed in the global phone book.

Exporting phone book data

Introduction
It is possible to export the phone book data to an external file. The parameter assignment 
saved in this file can be imported in turn into any number of TS adapter. 

Requirement
You have already created a phone book under TeleService with the corresponding plant data.

Procedure
Proceed as follows to export the phone book data:

1. Open the "TeleService" folder in project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Export" button in the toolbar.

4. In the next dialog, select where the current phone book is to be exported.

5. Close the dialog box with "OK".
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Result
The exported phone book data are saved in the specified export file.

Printing the phone book

Printing phone books
You can print out all or some of the data in a phone book.  

Proceed as follows:
1. Open the telephone book.

2. Select the Phone book > Print menu command or click on the appropriate button in the 
toolbar. The "Print" dialog will open.

3. Specify whether you wish to print the complete phone book or just part of it and set all other 
options.

4. Start the print job with "OK".

Result
The phone book data is printed on the default printer. If the printout is more than one page 
long, an identifier is printed after the page number at the bottom right corner of the page to 
indicate that there is another page. The last page does not have this symbol, indicating that 
no more pages are to follow.

10.12.7 CPU controlled TeleService remote connections 

10.12.7.1 Overview of CPU controlled remote connections

Introduction
TeleService offers a range of options for establishing remote connections; these differ 
according to the CPU used. The initiative for establishing a connection starts from the CPU. 
The communication instructions given below are used for the individual connection options.

Connection establishment with S7-300/400 CPUs
The following communication instructions are available:  

● Communications instruction "PG_DIAL": Establish remote connection to programming 
device/PC

● Communications instruction "SMS_SEND": Send text message (SMS)
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● Communications instruction "AS_DIAL": Establish remote connection to AS

● Communications instruction "AS_MAIL": Transfer email

Connection establishment with S7-1200 CPUs
The following communication instruction is available:  

● Communications instruction "TM_MAIL": Transfer email
 

 Note
Description of individual communication instructions

More detailed information on the available communication instructions can be found in the 
information system of the TIA portal in the directory "References > Communication > 
TeleService".

 

 

10.12.7.2 Establishing a connection from and to remote systens (PG-AS-remote coupling)

Remote plant access to a programming device/personal computer

Introduction
You can establish a remote connection to and communicate with a remote system using the 
application TeleService and a TS Adapter MPI. The initiative for establishing the remote 
connection comes from the programming device/personal computer. 

However, events which require rapid intervention often occur at a remote system. In such 
cases, the automation system can initiate a remote connection to a programming device/
personal computer if an asynchronous event occurs.

The graphic below shows the components which are required for establishing a connection 
from a plant to a programming device/personal computer.
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Figure 10-6 How the "PG_DIAL" communications instruction works

Requirements for establishing a connection

Introduction
Certain hardware and software requirements must be fulfilled if a remote system is to establish 
a remote connection to a programming device/personal computer. These requirements are 
detailed below.  

Hardware requirements:
The only hardware required for establishing a remote connection from a remote system to a 
programming device/personal computer is that needed for accessing the remote system from 
the programming device/personal computer.  

Your user program calls the communication instruction "PG_DIAL"  to establish the connection. 
This can only be executed on an S7-300 or S7-400 CPU on which S7 basic communication is 
implemented.  

A TS Adapter I , version 5.0 or later, or a TS Adapter II  must be used.

Software requirements at the plant end:
Communication instruction "PG_DIAL" is included in the TeleService scope of delivery and is 
installed when the TIA portal is installed. You will find the communication instructions installed 
in the "Communication > TeleService" folder of the block editor task card.  

If a remote system is to establish a remote connection to a programming device/personal 
computer, the plant user program must call the "PG_DIAL" function block. 
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Software requirements for the programming device/personal computer
You require a software product in the programming device/personal computer which, with 
TeleService, waits for a call from a remote system, recognizes this call and informs your user 
program.  

10.12.7.3 Data exchange between remote systems (AS-AS-remote coupling)

AS-AS remote link basics

Introduction
The AS-AS remote link allows two automation systems to exchange process data via the 
telephone network.

Requirement
Communication instruction "AS_DIAL"  is available if you use a CPU from the S7-300/400 
family.  

Definition: Local and remote automation system   
● The automation system from which the initiative to establish the remote connection 

originates is described as local.

● The automation system to which the remote connection is to be established is described 
as remote.

Data exchange over the AS-AS remote link
Data exchange is carried out using specific communication instructions for non-configured S7 
connections. Use the communication instruction "AS_DIAL" to establish a remote connection 
to the automation system. 

More detailed information on establishing the connection can be found in the information 
system in the directory "References > Communication > TeleService".

The following graphic shows the components required for establishing a connection from a 
local to a remote automation system.

Using online and diagnostics functions
10.12 Establishing a remote connection with TeleService

WinCC Professional V11.0 SP1
2850 System Manual, 08/2011,  



Figure 10-7 Data exchange over the AS-AS remote link

Hardware and software requirements for AS-AS remote link

Introduction
Certain hardware and software requirements must be fulfilled before a local automation system 
can establish a remote connection to a remote automation system. These requirements are 
detailed below.  

Hardware requirements
The only hardware you need for transferring process data from a local to a remote automation 
system is that also needed for accessing the respective automation system from the 
programming device/personal computer.  

To establish and terminate the remote connection, the TIA Portal user program of the local 
CPU calls a communication instruction. This communication instruction can be executed on 
an S7-300/400 CPU or a C7 CPU. The communication instruction requires S7 basic 
communication to be implemented on the CPU. The remote CPU must also support S7 basic 
communication.

A TS Adapter I, version V5.1 or later, or a TS Adapter II must be used.

Software requirements
The "AS_DIAL" communication instruction is included in the product package of TeleService, 
and is integrated into the library of the TIA Portal during the installation in the communication 
instructions folder of the Task Card under TeleService. In order to establish and terminate a 
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remote connection to a remote automation system from a local automation system, call the 
communication instruction "AS_DIAL" in the TIA Portal user program of the local CPU.  

Figure 10-8 Hardware and software requirements for AS-AS remote link

10.12.7.4 Send SMS from a system

Requirements for sending an SMS

Introduction
Certain hardware and software requirements must be fulfilled before a plant can send an SMS. 
These requirements are detailed below.   

Hardware requirements 
To send an SMS from a plant, you will require a GSM radio modem and a TS Adapter MPI.  

A TS Adapter I, version V5.2 or later, or a TS Adapter II  must be used.

Software requirements at the plant end
The "SMS_SEND" communication instruction is included in the product package of 
TeleService, and is integrated into the library of the TIA Portal during the installation in the 
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communication instructions folder of the Task Card under TeleService. If a plant is to send an 
SMS, the user program of the plant must call the communication instruction "SMS_SEND".  

Figure 10-9 How the "SMS_SEND" communication instruction works

10.12.7.5 Send an email from a system

Requirements for sending e-mails

Introduction
The following hardware and software requirements must be fulfilled if a plant is to send an e-
mail:   

Hardware requirements
To send e-mail from a plant, you will need a TS Adapter IE and a CPU 31x‑2 PN/DP, firmware 
version V2.5 or higher, or a CPU 41x-3 PN/DP.  

Software requirements at the plant end
The "AS_Mail" communication instruction is included in the product package of TeleService, 
and is integrated into the library of the TIA Portal during the installation in the communication 
instructions folder of the Task Card under TeleService.  

If a plant is to send an e-mail, the user program of the plant must call the communication 
instruction "AS_MAIL". This uses the Simple Mail Transfer Protocol (SMTP) to send e-mails 
from a CPU to a mail server.

You will also need the communication instructions described below from the TIA Portal 
standard library.
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The "Use gateway/router" property must also be set for the Ethernet interface in the 
configuration of the CPU on which the communication instruction "AS_MAIL" runs. (See: 
Hardware configuration > PROFINET IO (PN-IO) > General > Properties > Parameters). The 
IP address of the Ethernet interface of the TS Adapter IE should be specified as the "Address".

Required communication instructions
Communication instruction "AS_MAIL" requires the following communication instructions from 
the "IEC Function Blocks" folder of the TIA Portal standard library:  

● Communications instruction "EQ_STRNG"

● Communications instruction "FIND"

● Communications instruction "INSERT"

● Communications instruction "LEFT"

● Communications instruction "LEN" and

● Communications instruction "RIGHT"

Copy these communication instructions from the standard library of the TIA Portal to your 
project and your CPU.

 

 Note

You can find further information in the task card in the Communication instructions folder 
under TeleService.
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10.12.8 Troubleshooting

10.12.8.1 General information on troubleshooting

Introduction
The information below should help you establish and eliminate the causes of any modem 
problems.

1. Activate "Record log file for data traffic between PG/PC and modem". The entries in this 
file can provide valuable information for determining the cause of errors.

2. Switch on the loudspeaker on your local modem. Select a volume loud enough to be clearly 
heard.
You can then hear whether:

– there is a dial tone at the connection

– the modem called is busy

– the modem called accepts the call.

Common modem problems
Modem connection problems are among the most common modem problems:

● Modem connection is not established

● Modem connection is interrupted

The topics below contain tables detailing possible causes and providing information on 
eliminating the error in question.

See also
Remote connection to the TS adapter is not established (Page 2856)

Remote connection from the TS adapter is not established (Page 2857)

Modem connection is interrupted (Page 2858)

Modem alarms (Page 2859)

Recording a log file for the modem (Page 2855)

10.12.8.2 Recording a log file for the modem

Introduction
It is advisable to record a log file as this makes it easier to find the causes of faults in a modem.
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Procedure:
Proceed as follows:

1. Activate the properties dialog of the modem used via the "Phone and modem options" option 
in the Control Panel.

2. Check the settings of the "Log" option in the "Diagnostics" tab and if necessary change the 
log file settings so that the file is recorded.

Result:
Activity between the programming device/personal computer and the modem are entered in 
the log file. If there are problems establishing the connection, you can evaluate the data 
recorded in the log file to determine the cause of the error.

10.12.8.3 Remote connection to the TS adapter is not established

Remote connection to TS Adapter is not established
The table below sets out possible causes and how to eliminate them if no remote connection 
to the TS Adapter can be established. 

Possible cause Check/Remedy
Cabling faulty ● Are all the connecting cables connected correctly?

● Are the connectors loose?
Dial parameters for main telephone 
line and extension incorrectly set

● Are the modem properties and dial parameters set for your modem correct for the 
phone connection (main telephone line or extension)?

● Do not specify a dial-out code in the "Dial parameters" dialog if you operate your 
modem on a local loop (main telephone line).
The fields for the dial-out code for local calls and long-distance calls must be empty.

Dialing mode incorrectly set ● Is the correct dialing mode (tone/pulse) set in the dialog for the dial parameters of 
your modem?

● Use a connected telephone to check the connection on which you want to operate 
the modem. 
You should hear crackling noises on the telephone during pulse dialing and tones 
of varying pitches during tone dialing. 
Set the corresponding dialing mode in the modem dial parameters.
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Possible cause Check/Remedy
Dial disable active ● The dial disable function is a country-specific modem property which, depending 

on the modem, becomes effective after one or more unsuccessful attempts to 
establish a connection.

● If your modem still does not respond after several attempts to dial, the dial disable 
function may be active. Characters are still sent to the modem after the dial 
command but the modem does not start the dialing process. The driver receives a 
general error message.

● Refer to the modem documentation for information on how the dial disable function 
is implemented for your modem.

● Create a log file (Page 2855) (modemlog.txt) in which the activities between the 
programming device/personal computer and modem are recorded.
Then check whether the file contains an entry caused by dial disable (e.g. 
DELAYED).

Phone connection defective or busy ● Connect a phone and check whether a dial tone can be heard on this connection.
● Any analog phone connected on the same connection must be hung up. 

You cannot establish an additional modem connection on this connection if there 
is an existing phone connection.

Serial parameters set incorrectly ● Are the correct values entered in the "Settings" tab for modem properties (8 data 
bits, no parity, 1 stop bit)?
Is the correct COM interface set in the "General" tab for the modem properties?

Initialization string of the 
TS Adapter is not suitable for the 
modem.

● Familiarize yourself with the modem initialization string requirements (Page 2822) 
and set the string accordingly.
Procedure for configuring the TS Adapter IE (Page 2832)

Settings for error correction 
between the modem at the 
TS Adapter and the modem at the 
PC/programming device are not 
compatible.

● Adapt the modem settings.
Useful information on configuring the TS Adapter MPI (Page 2827)
Restoring the default parameter assignment of a TS Adapter MPI (Page 2829)
Procedure for configuring the TS Adapter IE (Page 2828)

10.12.8.4 Remote connection from the TS adapter is not established

No callback from TS Adapter
The table below sets out possible causes and how to eliminate them if there is no callback 
from the TS Adapter.

Possible cause Check/Remedy
Errors in the location or call 
settings in the TS Adapter 

Check the TS Adapter parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter  support the characters configured for the dial-

out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

Initialization of modem 
insufficient

Check the string for modem initialization:
● The modem may require a further initialization in order to establish a remote 

connection.
● Properties of the modem initialization string for the TS Adapter MPI 

Callback number is incorrect Check the configuration of the callback number you assigned.
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No call from TS Adapter MPI
The table below sets out possible causes and and how to remedy them if there is no call from 
the TS Adapter MPI.

Possible cause Check/Remedy
Phone number is incorrect Is the required number being transferred to the communication instruction "PG_DIAL" ?
TS Adapter MPI  parameter 
assignment incorrect

Check the TS Adapter MPI parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter MPI support the characters configured for the 

dial-out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

10.12.8.5 Modem connection is interrupted

Modem connection is interrupted
The table below sets out possible causes and and how to remedy them if the modem 
connection is interrupted.   

Possible cause: Check / Remedy:
Metering pulses in the line ● Metering pulses will be generated if you have applied to the phone company for a 

metering clock. This may mean that the modem no longer recognizes the carrier 
signal and switches off.

● Set a longer waiting or switch-off time at the modem.
● Have the metering pulse deactivated by the phone company.

Shielding ● Are the connection cables used shielded sufficiently?
● Make sure that the modem cables do not run next to power cables and that they 

are as far as possible from power supply units and monitors.
Protocol timeout ● Set fixed monitoring times.
Automatic connection termination ● Deactivate the option that terminates an existing connection automatically after a 

specified time without data transfer ("Terminate after idle of ...").
Data flow control deactivated ● Click on the "Extended" button in the "Settings" tab of the modem properties and 

activate the following options in the dialog displayed (if available and not yet set):
– Data flow control
– Hardware (RTS/CTS)
– Data compression
– Error control

Initialization string of the 
TS Adapter  is not suitable for the 
modem

● Set the modem initialization string in accordance with the following requirements:
For further details, see: 
Requirements of the modem initialization string for TS Adapter MPI
Options for the process of assigning parameters for the TS Adapter IE
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See also
Initialization string requirements (Page 2822)

TS adapter MPI configuration options (Page 2827)

TS Adapter IE parameter assignment options (Page 2835)

10.12.8.6 Modem alarms

Information in the log file 
The modem alarms are entered in a log file if you have activated the recording function.  

The log file contains the following information:

Alarm: Possible cause: Remedy:
NO DIALTONE A phone call may currently be being carried out 

on this line.
● Repeat the process once the phone call is over.

NO CARRIER The device dialed is not ready, is not a modem 
or cannot establish a connection in the set 
operating mode.

● Check the numbers and the settings.

BUSY The device dialed is busy. ● Try again later.
DELAYED: ... Dial disable ● Refer to the modem documentation for 

information on how the dial disable function is 
implemented for your modem and if necessary 
remove it.
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1313
 Configuring the export of Runtime data, 1197, 
1207, 1214
 Online configuration, 1197, 1208, 1215
 Toolbar, 1195, 1206, 1211
~ configuring for logged alarms, 1314, 1363
Activating alarm text blocks for ~ , 1323
Alarm line, 882
Alarm text window, 1387, 2359
Application, 1382
Column, 884, 891
Complex alarm view, 881
Configuration behavior, 891
Configuring, 1310, 1322
Configuring a filter, 1324
Configuring data export, 1338
Configuring the layout, 1312
Configuring the toolbar and status bar, 1323
Control element, 883, 888, 1383, 2356
Enable sorting, 884
Filter display, 1318
Filtering alarms, 1396, 2367
Identifying an alarm class, 885
Layout, 1383, 1386, 2357, 2358
Operation, 1383, 1387, 2357, 2359
Operation using the keyboard, 1384, 1394
Operation using the mouse, 1384, 1394
Operator control, 2365
Simple Alarm view, 882
Use, 2356

Alarm window, 38, 1307, 1382, 1399, 1400, 2356, 
2370, 2371

Application, 1382
Configuring, 1315, 1400, 2371
Control element, 1383, 2356
in Runtime, 2354
In runtime, 1380
In Runtime, 1382, 1392
Operation, 1383, 2357
Operation using the keyboard, 1384, 1394
Operation using the mouse, 1384
Output of log data, 1400, 2371
Use, 2356

Alarm with simple acknowledgment, 1251
Alarm without acknowledgment, 1251
AlarmControl

Online configuration, 1564
Runtime data, 1563
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Alarms
Column names, 2665
continuous reporting, 1622
Creating comments, 1264
Display in the alarm table, 2663
Hit list, 2667
in reports, 1620
Output of a tag value, 1276
Output of texts from a text list, 1277
Parameter output in discrete alarms, 1293
Parameter output in the analog alarm, 1289
Parameter output in user alarms, 1297
Reloading, 1378

Alarms and Trends
Displaying values in a table, 2660
Displaying values in a trend view, 2661

Align
Object flush, 674, 1650

Allen Bradley Ethernet IP
DInt, 1082
Int, 1083
Real, 1084
SInt, 1085
UDInt, 1086
UInt, 1087
USInt, 1088

Allen-Bradley DF1
Migrating data types, 125

Allen-Bradley DH485
Migrating data types, 125

Allen-Bradley Ethernet IP
Migrating data types, 126

Alphanumeric key assignment, 2286
Alphanumerical screen keyboard, 2282
Alphanumerical value

Changing, 2283, 2289
Entering, 2283, 2289

ALT
Key, 2286

Analog alarm, 1238, 1239, 1240
Configuring, 1271, 1285, 1305
Parameter output , 1289

Analog alarm limits
Configuring, 1292, 1295

Analog alarm types, 1238, 1239, 1240
Analog alarms

Configuring, 1260, 1261

Animation, 733
Configuring, 735, 1491
Diagonal movement, 740
Direct movement, 740
Green arrow in Overview, 735
Horizontal movement, 738
Multiple selection, 754
Object group, 753, 754
Overview, 735
Tag binding, 744
Vertical movement, 740

Appearance
Dynamization of an object, 736
Object, 680

Application, 470
Alarm indicator, 1388
Alarm view, 1382
Alarm window, 1382
Control Data, 1656
Control Hardcopy, 1657
Control Information, 1658
Date/time field, 1661
f(x) trend view, 1665
KeySwitch, 913
Recipe view, 1521
Simple alarm view, 1385
simple alarm window, 1385

Application example
Entering recipe data offline , 1534
Recipe with manual production sequence, 1535

Area of unplugged modules, 297
Area pointer

Data record, 1485
Date/time, 43
Date/time PLC, 43
Migration, 108

Arrange
Object in the screen, 666

Array, 41, 1019, 1021
Creating, 1021
Indirect addressing, 1009

Array element
Location of use of HMI tag, 41
Name, 41

Array tag, 1019
Char, 41

AS interface, 443
ASCII code table, 370
ASCII TSAP, 370
asctime function, 1966
Asian operating system, 2104
asin function, 1961
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Assign
Object of a layer, 766

Assign symbol, 390
Assign tag, 390
Assigning parameters

Hardware, 290
atan function, 1961
atan2 function, 1961
atof function, 1964
atoi function, 1964
atol function, 1964
Audit

Configuration, 2454
Enhancements in the ES, 2414
Forcing, 2438
Functional scope, 2414
Logging concept, 2415
Scope of logging, 2415
Screen object, 2454
Supported HMI devices, 2453

Audit Trail
Acknowledgement, 2442
Checksum, 1110, 1122, 1366, 2437
Comments, 2442
CSV file, 2436
Editor, 2418
Effects in runtime, 2439
Electronic signature, 2442
File format, 2436
Log tag value change, 2440
Logging recipe data changes, 2442
Logging system functions, 2448
Logging user actions, 2445
Memory medium, 2437
Printing, 2427
Protection against change, 2438
Reporting, 2427
Storage location, 2437
Troubleshooting, 2437

Audit trail editor, 2418
Authorization, 2294

Assignment, 1698, 1737
Changing the name, 1702
configuring, 1727
Creating, 1696, 1734
Deleting, 1703
Managing, 1701

Automatic
Reporting, 1273

Automatic display suppression, 1329
Automatic hide, 1466

Automation system
Local, 2850
Remote, 2850

Autonegotiation, 464
Autoscroll

Activate, 890
Availability

"Local scripts" editor, 1784
Object for Basic Panels, 817
Object for Comfort Panel, 819
Object for Mobile Panels, 822
Object for Panels, 818
Object for WinCC Runtime Advanced, 824
Objects for Multi Panels, 821

Availability for specific devices
Screen, 632

AWP command, 401
AWP_In_Variable, 404
AWP_Out_Variable, 402
Axis

common, 1187
Multiple, 1186

B
Back page

in reports, 1615
Report, 1605, 1608

Background color
Dynamization, 736

Backing up, 2295
BACKSPACE key, 2286
Backup, 1372

Data of the HMI device, 2228, 2230, 2254
of alarm log, configuring, 1372

Bar, 828, 829
Color transition, 828, 829
Define scale gradation, 830
Display limit lines, 828, 830

Bar segment
Defining, 828, 830

Basic Panel
Display and operating element, 817

Basic settings
OPC, 2708

Basics
Migration, 92

Behavior, 2267
Simple recipe view, 1516, 2334

Benefits of using TeleService, 2817
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Bit (0, 1)
Graphics list, 726
Text list, 715

Bit number  (0 - 31)
Graphics list , 728
Text list, 716

Block parameters
Basics, 527

Block property changed, 1992
Borders

Insert background image, 224
Placeholder for document information, 226
Specifying the print area, 225

Boundaries, 465
Boundary reached

Event, 1852
bsearch function, 1965
Button, 910

Configuring, 1735
Configuring access protection, 1731
Creating, 964
Define hotkey, 912
Graphic, 911
HTML browser, 862
Mode, 911
Recipe view, 1580, 2342
Status/Force, 922
Text, 911

Buttons and Switches
Library, 776

Byte, 1048

C
C

Examples in WinCC, 1833
C function

Example, 1835, 1836, 1837, 1838

C functions
_ismbcalnum function, 1962
_ismbcalpha function, 1962
_ismbcdigit function, 1962
_ismbcgraph function, 1962
_ismbclower function, 1962
_ismbcprint function, 1962
_ismbcpunct function, 1962
_ismbcspace function, 1962
_ismbcupper function, 1962
_mbscat function, 1963
_mbschr function, 1963
_mbscmp function, 1962
_mbscpy function, 1963
_mbscspn function, 1962
_mbsdec function, 1963
_mbsinc function, 1963
_mbslen function, 1962
_mbsncat function, 1963
_mbsncmp function , 1962
_mbsncpy function, 1963
_mbspbrk function, 1963
_mbsrchr function, 1962
_mbsspn function, 1962
_mbsstr function, 1963
_mbstok function, 1963
_mbstrlen function, 1962
abort function, 1965
abs function, 1964
acos function, 1961
asctime function, 1966
asin function, 1961
atan function, 1961
atan2 function, 1961
atof function, 1964
atoi function, 1964
atol function, 1964
bsearch function, 1965
calloc function, 1965
ceil function, 1961
clearerr function, 1964
clock function, 1966
cos function, 1961
cosh function, 1961
ctime function, 1966
difftime function, 1966
div function, 1964
exit function, 1965
exp function, 1961
fabs function, 1961
fclose function, 1963
feof function, 1963
ferror function, 1963
fflush function, 1963
fgetc function, 1963
fgetpos function, 1963
fgets function, 1963
floor function, 1961
fmod function, 1961
fopen function, 1963
fputc function, 1963
fputs function, 1963
fread function, 1964
free function, 1965
freopen function, 1963
frexp function, 1961
fseek function, 1963
fsetpos function, 1964
ftell function, 1964
fwrite function, 1964
getc function, 1964
getenv function, 1964
gmtime function, 1966
isalnum function, 1959
isalpha function, 1959
isdigit function, 1960
isgraph function, 1960
islower function, 1960
isprint function, 1960
ispunct function, 1960
isspace function, 1960
isupper function, 1960
isxdigit function, 1960
labs function, 1964
ldexp function, 1961
ldiv function, 1964
localtime function, 1966
log function, 1961
log10 function, 1961
malloc function, 1965
memchr function, 1962
memcmp function, 1962
memcpy function, 1962
memmove function, 1962
memset function, 1962
mktime function, 1966
modf function, 1961
pow function, 1961
putc function, 1964
qsort function, 1965
rand function, 1964
realloc function, 1965
remove function, 1964
rename function, 1964
rewind function, 1964
setbuf function, 1964
setvbuf function, 1964
sin function, 1961
sinh function, 1961
sqrt function, 1961
srand function, 1964
strcat function, 1965
strchr function, 1965
strcmp function, 1965
strcpy function, 1965
strcspn function, 1965
strerror function, 1965
strftime function, 1966
strlen function, 1965
strncat function, 1965
strncmp function, 1965
strncpy function, 1965
strpbrk function, 1965
strrchr function, 1965
strspn function, 1965
strstr function, 1965
strtod function, 1964
strtok function, 1965
strtol function, 1965
strtoul function, 1965
system function, 1965
tan function, 1961
tanh function, 1961
time function, 1966
tmpfile function, 1963
tmpnam function, 1963
tolower function, 1960
toupper function, 1960
ungetc function, 1964
vfprintf function, 1964
vsprintf function, 1964
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Cabling rules (PROFINET), 464
Callback to a number specified during connection 
establishment, 2839
calloc function, 1965
Cancel

Connection to the faceplate type, 807
Canceling printing, 231
Cascaded counting function, 543
ceil function, 1961
Certificate, 2517

Importing on HTTP client, 2517
Installing on devices, 2517
Installing under Windows XP, 2517

change
Recipe data record in Runtime, 1525

Change property time axis, 1996, 2006, 2007
Change slider, 2005
Change video format, 2008
Changeover contact, 556
Changeover contact sensor type, 556
Changing

Displayed name of user group, 1702
Logoff time in runtime, 1718, 1720
Name of the user, 1718, 1720
Object property, 1811
Object size, 672, 1647
Password, 1700
Password in runtime, 1718
User group in runtime, 1719, 1721
Users, 2307, 2309

Changing and displaying operating mode (example), 
1816
Changing the name

Authorization, 1702
User group, 1701
Users, 1700

Changing windows, 2264
Channel diagnostics, 865
Char, 1049

Array tag, 41
Charging condition, 874

Operation, 874
Checklist for troubleshooting the modem, 2842
Checksum, 1354, 2438

Audit Trail, 1122, 1366, 2437
Log, 1110, 1122, 1366, 2437
Updating WinCC , 1122, 1366

Circle, 868
Design, 680
Fill level, 680
Radius, 869

Circular log, 1354
Select size, 1116

cleared, 1845
clearerr function, 1964
Click, 1850, 1998, 2000
Click toolbar button, 2004
Client

Deactivating a server project, 2548
Enabled remote server project, 2547
Shutdown, 2536
Startup, 2536

Client/server system
Characteristics in Runtime, 2533
Response in Runtime, 2534
Shutting down the client, 2536
Shutting down the server, 2535
Starting up the client, 2536
Starting up the server, 2535

Clock, 938
Display, 938
Display dial, 938
Length of the pointer, 938
Width of hands, 938

clock function, 1966
clock functions

asctime function, 1966
Clock memory, 496, 517
Closing

Runtime, 2254, 2276
Code templates

inserting in user-defined functions, 1754
Color

Diagnostics of Ethernet cables, 593
Diagnostics of ports, 593

Color of individual ranges
Gauge, 950

Color transition
Bar, 828, 829

Column
Alarm view, 884, 891

Column property changed, 1993
Comfort Panel

Display and operating element, 819
S7-1200, 47

Comment, 1414
Comments

Audit Trail, 2442
Electronic signature, 2442
For alarms, 1264

Commissioning
HMI device, 2241

Common alarm classes, 1248
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Communication
via raw data tags, 1569

Communications
Cycle load, 501

Communications instruction
"AS_DIAL", 2818, 2850, 2851
"AS_MAIL", 2818, 2853
"PG_DIAL", 2818, 2848, 2849
"SMS_SEND", 2818, 2852

Communications load, 496, 501
Communications modules, 509

Properties, 509
Communications port

Configuring, 509
Communications processor

Hotfixes, 30
Operation, 30

Communications protocol
Defining, 513
Overview, 512

Compare offline/online
Automatic device assignment, 384

Compatibility, 2693, 2706
Compile

Address parameters, 47
Compiling

Migrated project, 96
Complex alarm view, 881
Complex user view

Configuring, 831
Components

Alarm, 1258
Compressed log, 1139, 1147, 1470

Configuring, 1147
How it works, 1139

Compressed tag, 1129
Compression, 1140
Computer properties, 1795

Configuration
Analog logging tag, 1151
Binary logging tag, 1149
Compressed log, 1147
Compressed tag, 1149
Data log, 1145
Downloading to device, 473
DP slave, 430
DP slave, simple, 422
Hardware, 290
Large data log, 1155
Large log, 1155
Log, 1145
Logging tag, 1149
Process-controlled tag, 1149
Remote, 2544
Tag, 992
Uploading to programming device/PC, 474
WebNavigator, 2550

Configuration file
Menu, 965
Toolbar, 965

Configuration PC
Starting Runtime, 2197, 2220, 2251, 2274

Configuration phase, 2240
Configure a PROFIBUS subnet

Matching parameters to one another, 322
Setting bus parameters, 322

Configured
Loop-in alarm, 1302

configuring
Authorization, 1727
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Configuring, 1275, 1292, 1296, 1306, 1511
 Recipe view , 1561
Access protection, 1735
Alarm, 1285
Alarm acknowledgment, 1343, 1344, 1346
Alarm annunciator, 1336
Alarm group, 1268
Alarm log, 1358, 1369, 1371
Alarm statistics, 1327
Alarm view, 1310, 1322
Alarm view filters, 1324
Alarm view for logged alarms, 1314, 1363
Analog alarm, 1271, 1285, 1305
Analog alarm limits, 1292, 1295
Analog alarms, 1260, 1261
Animation, 1491
Controller alarms, 1260, 1261
Customized C function, 1776
Data export from the alarm view, 1338
Data source of the table view, 1194, 1204
Data source of the trend view, 1194, 1204
Discrete alarm, 1274, 1303
Discrete alarms, 1260, 1261
Display of S7 diagnostic alarms, 1313
Evaluating alarms in Runtime, 1338
Event, 1490, 1495
Event-driven tasks, 1273, 1288
Function list, 1750
Historical alarm list (long-term) , 1337
Historical alarm list (short-term), 1337
HMI device as OPC DA Server, 2696
I slave, 431
Layout of the alarm view, 1312
Linking a log backup, 1376
Local script at event, 1785
Logging tag, 1125, 1165
Multiple tags, 992
OPC XML DA server in the OPC XML Manager, 
2701
Project-wide alarm class, 1265
Recipe screen, 1511
Recipe view, 1507, 1510
Rectangle, 707
Selection in table display, 1203
Sorting a table column, 1204, 1214
System events, 1260, 1261
Table elements, 1202, 1213
Table view, 1199
Time axis, 1190
Toolbar and status bar in the alarm view, 1323
Trend, 1193
Trend view, 1189
Trend view for logging, 1178
Trend view for values from the PLC, 1169, 1176
User-defined VB function, 1767
Value axis, 1191
Value column, 1201
Value table, 1211
WinCC OPC A&E server, 2732
WinCC OPC Client, 2699, 2748
WinCC OPC UA Server, 2746
X axis, 1191

Configuring a filter
for fixed character string, 1318
Historical alarm list (long-term) , 1337
Historical alarm list (short-term) , 1337

Configuring a PROFIBUS subnet
Meaning of the bus parameters, 323

Configuring the network with Ethernet, 327
Creating private subnets, 329
Linking networks, 329
Relationship between IP address and subnet 
mask, 328
Setting the IP address, 328
Setting the subnet mask, 328

Configuring the remote modem, 2821
Configuring the sorting

Historical alarm list (long-term) , 1337
Historical alarm list (short-term), 1337

Connecting, 1163
Alarm log, 1377
Log backup, 1163

Connecting a TS Adapter with an external modem, 
2821
Connecting a TS Adapter with an internal modem, 
2821
Connection, 330, 342

Address details, 627
Change after migration, 107
Configuring a connection when there is no or no 
clear network assignment, 335
Connecting to server, 2638
Creating, 359
Deleting, 361
Establishing connection to the server, 2638
integrated connection, 980

Connection description
Changing parameter values, 367
Data block , 364
Structure, 364

Connection details, 627
Connection diagnostics

Detailed, 625
Overview, 623

Connection information, 626
Connection parameter assignment

Connection parameters, 356
Overview, 354
Starting, 358

Connection resource, 330, 342
SIMATIC S7 1200, 44

Connection resources, 626
Connection status

Displaying using icons, 624
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Connector, 939
Consistency

Slot rules, 292
Context filter, 293
Control Data

Application, 1656
Layout, 1656

Control element
 f(t) trend view, 848
Alarm view, 883, 888, 893, 1383, 2356
Alarm window, 1383, 2356
f(x) trend view, 850, 853
HTML browser, 862
Media Player, 880
Recipe view, 903, 904
Simple alarm view, 1386, 2359
Status/Force, 921
Table view, 935
Trend view, 872
Value table, 941

Control Hardcopy
Application, 1657
Layout, 1657

Control Information
Application, 1658
Layout, 1658

Control tag
Communication between the recipe and the PLC, 
1543

Control tags
Example, 1597

Controller alarm, 1239, 1240, 1242
System-defined, 1244

Controller alarms
Configuring, 1260, 1261
System-defined, 1239, 1241

Converted name (PROFINET), 452
Converting an unspecified CPU, 141
Cookie, 405
Coordinated transfer, 1485

With PLC, 1485
Copy

Recipe data record in runtime, 1524
Screen, 639
Tag, 991
Template, 646

Copy template
Library, 775

Copying
Adjusting screen size, 2149
Alarm class, 2164
Alarm group, 2165
Alarm indicator, 38
Alarm view, 38
Alarm window, 38
Analog alarm, 2162
Authorization, 2173
Color, 2146
Connection, 2156
Cycle, 2170
Data log, 2166
Discrete alarm, 2161
Font, 2146
Function key, 2149
Graphics list, 2172
Hardware component, 306
HMI device, 32
Invalid object, 2146
Linked objects, 2147, 2148
Logging tag, 2166
Principle, 2144, 2145, 2151
Report, 2171
Report object, 2170
Restrictions, 2153
Scheduled task, 2174
Screen, 2149
Screen object, 2153
Structural element, 2158
Structure type, 2159
Tag, 2156
Text list, 2172
User group, 2173
User-defined folders, 2145
Users, 2173
VB script, 2168

Corner points, 899
Corners, 897
cos function, 1961
cosh function, 1961
Count (8 DI NAMUR), 541
Counter, 1050
Counter input, 505
Counter mode, 505
Counter, high-speed, 503
Cover page

Insert background image, 224
Placeholder for document information, 226
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CPU
Displaying the current LED status, 601
Fill level of all types of memory, 601
Inserting a signal board, 392
Properties, 495
Reading out a diagnostics buffer, 603
Selecting from the hardware catalog, 299
Switching operating mode, 608

CPU control panel
Display area, 601

CPU properties, 496
Create

Faceplate type, 791
Global library, 783
Group, 693
Recipe data record on the HMI device, 1524
Report, 1616
Screen, 638
Template, 644

Create script
Faceplate type, 812

Creating, 1500
Alarm group, 1268, 1269
Alarm log, 1353
Alarm log , 1358
Array, 1021
Button, 964
Configuration file, 965
Connection to an OPC UA Server, 2699
Connection to OPC DA server, 2697
Customer control, 2759
Customized C function, 1776
Cycle, 1035, 1038
Data log, 1113
External tag, 984
Hierarchical alarm groups, 1269
Info text, 1288, 1292, 1295
Infotext, 1273, 1275
Internal tag, 986
Main menu command, 961
Menu item, 962
OPC connection, 2747
Program code for customer control, 2758
Project-wide alarm class, 1265
Recipe, 1500, 1548
Recipe data record, 2321, 2322, 2335
Recipe data record on the HMI device, 1519, 
1520
Screen, 638
Submenu command, 962
Test form, 2761
Toolbar, 963
User group, 1696, 1697, 1737
User interface, 2757
User-defined VB function, 1767
Users, 1698, 1738, 2298, 2301, 2303, 2304, 2305, 
2310
Users in runtime, 1716
View, 1556

Creating a print preview, 226
Creating an analog logging tag, 1151
Creating binary logging tag, 1149
Cross-reference

Inspector window, 38
Cross-reference list, (See cross-references)

Displaying, 2099
Overview, 2099
Settings, 2099
Sorting columns, 2099
Structure, 2099
Views, 2099
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Cross-references
Displaying, 2099, 2101
Introduction, 2098
Uses, 2098

csv file
Example, 1173, 1413
Layout, 1173, 1413

CSV file, 2063, 2065, 2066, 2067, 2084
Audit Trail, 2436
Structure for tabular output, 1626
Structure for trend output, 1623

CSV provider table
CSV file structure, 1626
Use in report, 1660

CSV provider trends
CSV file structure, 1623

ctime function, 1966
CTRL

Key, 2286
ctype functions

isalnum function, 1959
isalpha function, 1959
isdigit function, 1960
isgraph function, 1960
islower function, 1960
isprint function, 1960
ispunct function, 1960
isspace function, 1960
isupper function, 1960
isxdigit function, 1960
tolower function, 1960
toupper function, 1960

Cursor Control, 2267
Cursor key, 2285
Cursor mode

Defining, 701
Custom alarm classes, 1247, 1248
Custom alarm groups, 1254
Custom web pages, 397, 411
Customer control, 2749

Creating, 2759
Creating program code, 2758
Setting a reference, 2755

Customer controls
 testing, 2761

customized
Menu, 957
Toolbar, 957

Customized C function, 1740
Rename, 1778
Validity range, 1774

Customized VB function, 1740
Rename, 1769

Cycle, 1134
Creating, 1035, 1038
Define starting point, 1039

Cycle load, 501
Cycle time, 496, 500

display configured, 597
display measured, 599

Cyclic
Continuous, 1012
In operation, 1012

Cyclic interrupt OB
Assigning parameters, 529
Description, 523

Cyclic OB
Description, 521

Cyclic program execution
Options for interrupting, 521
Programming, 521

Cyclic triggers, 2036, 2044, 2048, 2052, 2055, 2058

D
Data

External data in reports, 1621
Data backup, 67

HMI device, 2228
Data bit (DBX), 484
Data buffer, 1140
Data byte (DBB), 484
Data double word (DBD), 484
Data exchange

DP slave, 422
I slave - DP master, 423

Data exchange over the AS-AS remote link
Communication instruction "AS_DIAL", 2850

Data flow, 2315
Data Flow, 1478
Data flow control, 511
Data format differences

between SIMATIC and Microsoft, 1578
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Data log, 396, 1145, 1468, 1470
Acquisition cycle, 1108
Configuring, 1145
Configuring the size, 1155
Creating, 1113
Fast, 1161
Logging cycle, 1108
Name, 1114, 1147, 1148
Output of the tag value, 1175
Processing method, 1134
Slow, 1161
Tags, 1111, 1117
Term definitions, 1127
Tolerance band, 1117

Data logging, 1108, 1128
Application, 1108, 1128
Basics, 1128
Configuration, 1128
Cyclic, 1136
Cyclic-selective, 1137
How it works, 1128
Memory medium, 1109
On demand, 1138
On value change, 1138

Data mailbox
For recipes, 1485

Data record
Exporting, 1528
Importing, 1528
Reading, 1520, 1526
Recipe, 1540
Transfer, 1521, 1527

Data record list, 1488, 2317
Data type, 988

Format adjustment, 988
Internal tag, 982, 983
Unsigned 16-bit value, 1076, 1077, 1078, 1079, 
1080, 1081, 1082
Unsigned word, 1076, 1077, 1078, 1079, 1080, 
1081, 1082
Word, 1076, 1077, 1078, 1079, 1080, 1081, 1082

Data types
Migration, 123

Data word (DBW), 484
DataMonitor, 2605

General operation, 2629
Log off from server, 2630
Start Page, 2627
Starting the Client, 2627
WebCenter, 2606

DataMonitor client
Start, 2627

DataMonitor Server
Logging off from, 2630

Date, 1050, 1058
Date/time field, 836

Application, 1661
Display system time, 836
Format, 836
Layout in reports, 1661, 1662
Using tags, 836

Deactivate, 1847
Deadband

Setting, 1272, 1288
Debugger, 1795

Activating in WinCC, 1795
Closing, 1793
Error types, 1787, 1794, 2205, 2226
Opening after error message, 1795
Opening automatically, 1795
Starting, 1793, 2206
starting for user-defined functions, 1795
Windows, 1786, 2204, 2226
Windows CE, 1786, 2204, 2226

Decimal place, 2281
Decimal places, 28
DecreaseTag, 1860
Default font, 2125
Defective devices, 589
Defective license, 68
Define

Bar segment, 830
Cursor mode, 701
Reference object, 673, 1648
Scale gradation on the bar, 830

Define hotkey, 912
Defining, 1124, 1368

Text format, 890
DEL key, 2286
Delay time

Setting, 1272, 1287
Delete

Recipe data record, 2326
Template, 646
Users, 2312
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Deleting
 Report page, 1629
Authorization, 1703
Hardware component, 305
Local script at event, 1785
Local script at object property, 762, 1786
Object, 669, 1642
OPC XML DA server in the OPC XML Manager, 
2701
Recipe data record, 2337
Recipe data record in runtime, 1525
Screen, 639
Tag, 991
User group, 1702
Users, 1701, 2311

Deleting a category
Faceplate type, 795

Deleting a connection, 145
Deleting a property

Faceplate type, 795
Delta transfer, 2217
Design

apply screen-specific layout specifications, 654
Applying layout defaults to controls, 656
Applying layout specifications to basic elements 
and elements, 655
Applying the layout specifications of a design, 
653
Changing, 652
Copy, 652
Creating, 651
Deleting, 653

Designation
TS Adapter, 2823
TS Adapter, 2825, 2832

Designing a background, 679
Designing a frame, 679
Designs

Default design for screens, 656
Detail page

Adding to report, 1629
remove from report, 1629
Report, 1606, 1608
Sorting, 1629

Details view, 172
Determine diagnostics status, 602
Determining time of day, 609

Device
Adding to a hardware configuration , 300
Copying, 32, 306
Defective devices, 589
Deleting, 305
Moving, 308
Renaming, 384

Device address, 388
Device information, 217, 589
Device name, 447, 449, 452
Device number, 448
Device overview

Address range, 388
Device replacement without exchangeable medium, 
466
Device Tool, 471, 472
Device view

Area of unplugged modules, 297
Edit parameters, 309
Edit properties, 309
Hardware and network editor, 278
Inserting a signal board, 392
Inserting module, 303
Racks, 294

Device wizard, 2060, 2061
Diagnose repeater, 620
Diagnostic error interrupt OB, 526
Diagnostics, 552, 1794, 1804, 1805, 1806

Alarm class, 1313
Debugger, 1794

Diagnostics buffer
Basics, 488, 615
Organization, 615

Diagnostics status
Determine and display online, 589

Diagnostics:GSC Diagnostics, 1805
Diagnostics:Inserting GSC diagnostics window in a 
screen, 1806
Diagonal movement

Animation, 740
Differences

Runtimes, 2150
difftime function, 1966
DInt, 1051, 1059, 1082, 1102
Direct access to the I/O, 489
Direct key, 2279
Disabling

Project language, 2106
Disconnecting

Alarm log, from project, 1377
Log backup, 1164
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Discrete alarm, 1238, 1239, 1240, 1241
Configuring, 1274, 1303
Parameter output , 1293
Structure for the import, 2082

Discrete alarm types, 1238, 1239, 1240
Discrete alarms

Configuring, 1260, 1261
display

Infotext, 2284, 2287, 2290
Display

Limit lines on the bar, 830
Display , 1329
Display classes, 1244
Display dial, 938
Display format, 2281, 2288
Display mode

Ruler window, 1210
Statistics area window, 1210
Statistics window, 1210

Display number, 903
Display object

Availability, 826
Availability for Basic Panels, 817
Availability for Comfort Panels, 819
Availability for Mobile Panels, 822
Availability for Multi Panels, 821
Availability for Panels, 818
Availability for WinCC Runtime Advanced, 824

Display PDF files, 57
Display peak value

Gauge, 950
Display suppression

Define duration, 1332
Display suppression mask, 1329, 1466
Display suppression tag, 1256, 1329, 1466

of a customized group alarm, 1466
Display suppression timeout

Defining, 1332
Display system time, 836
Display the memory types of a CPU, 601
Display Welcome Tour, 57
Displaying

Cross-reference, 2101
Cross-references, 2099

Displaying alarms, 582
Displaying the online status, 2801
Displaying values

As a trend, 1169
Distribute

Objects evenly, 674, 1650
Distributed I/O, 420, 550

Distributed operator stations
Configure SmartClient, 2492
Configure SmartServer, 2492
configuring, 2492

Distributed system
Remote configuration, 2544

div function, 1964
Documentation editor

Structure, 221
Documentation function

Using frames and cover pages, 219
Domain-global user group, 2256
Double, 1093
Double T-piece, 837
double-click, 1848, 1991
Download

Error messages, 2236
Extended download to device, 47
Project, 2190, 2211, 2241

Downloading
"Pack&Go" file to HMI device, 2192, 2213
to the device, 473

Downloading data to the PLC
Error message, 47

DP interface, 425
DP master, 537

Add DP master system, 428
Devices and modules, 425
Disconnection from DP master system, 427
Display on DP slave, 426
DP interface, 425

DP master system
Add DP slave, 429
Creating, 421, 423, 425
Disconnect DP slave, 429
Disconnection from subnet, 427
Edit properties, 428
Highlight, 426
Node disconnection, 427

DP slave
Add to DP master system, 429
Assign DP master system, 430
configuring, 422, 430
Data exchange, 422
Disconnect from DP master system, 429
DP master display, 426
Hardware catalog, 421
Intelligent, (See I slave)
Networking, 423
Types, 428
With preprocessing, (See I slave)

DP standard slave, 441
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DP/DP coupler, 421
DPV1

Configuring an ET 200S, 439
DTL data type

Restriction, 43
Dual-mode acknowledgment, 1251
DWord, 1052, 1060, 1103
Dynamic logon, 1694, 1704
Dynamic time range, 1185
Dynamization

Color of an object, 736
Control enable state of an object, 741
Flashing, 736
Object, 729
Object property, 729
Object property with a local script, 762, 1786

dynamize
Object appearance, 2183

Dynamize
Appearance of an object, 736
Direct movement, 740
Faceplate, 808
Faceplate type, 808
Green arrow in Overview, 735
Movement of an object, 738
Property animation, 746
Property list, 732
Quality Code, 747, 757
Tag binding, 744

E
Edit

Object within a group, 698
Edit networking

Disconnecting from a network, 319
Editable text field, 842
Editing

Alarm, 2362
Folder link, 690
Function list, 1752
OPC XML DA server in the OPC XML Manager, 
2701
Recipe data record, 2324, 2325, 2336
System event, 1279, 1299

Editing language, 2102
Selecting, 2106

Editing networking
Copying a subnet, 319
Copying subnets and devices, 320

Editor
Designs, 649, 650
Graphics, 2116

Effective range, 2010, 2017, 2019, 2021
Calculating signal quality, 947
Configure effective range object, 2027
Configuring, 2025
Configuring logoff, 2026
Configuring logon, 2026
Logoff, 944
Logon, 943
Override function, 947
Principle of Operation, 2011
Runtime, 2019
Work area, 2018

Effective range (RFID), 2020
Configuring, 2029
Configuring logoff, 2030
Configuring logon, 2030
Overview, 2028
Runtime, 2021
Work area, 2020

Effective range name, 942
Effective range name (RFID), 944
Effective range signal, 946
Effective range (RFID)

Logoff, 946
Logon, 945

Effective ranges editor, 2017, 2019
Effects in runtime

Audit Trail, 2439
Effects in Runtime

Recipe data change, 2444
Value changes to GMP-relevant tags, 2442

Electronic signature, 2414
Element list, 1488, 2317
Elements

in reports, 1618
Ellipse

Horizontal radius, 843
Vertical radius, 843

Ellipse , 843
Ellipse segment, 845
Elliptical arc, 844
E-Mail

Setting at the HMI-device, 2461
E-mail attachment

Report, 2685
E-mail notification, 1308, 2495

configuring, 2497
Setting up the trigger, 2497

Emergency acknowledgement, 1408, 2378
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enable, 1845, 1989
Enable autonegation, 463
Enable sorting

Alarm view, 884
Enabling

Reporting, 1341, 1342
S7 diagnostic alarm, 1281

End angle
Circular arc, 870
Ellipse segment, 845
Elliptical arc, 844

End Angle
Circle segment, 871

END key, 2285
End of discovery of accessible devices, 465
End of sync domain, 465
End of topology discovery, 465
Energy-saving mode, 2031
Engineering station

Starting Runtime, 2197, 2220, 2251, 2274
Engineering system

Performance features, 2380
Enhanced Recipe View, 2316
ENTER key, 2286
Entering

Alphanumerical value, 2283, 2289
Input field, 2280
Numerical value, 2281, 2288
Parameters in user-defined functions, 1753

Entry on the HMI device
By means of function key, 2287

Enumeration types, 407
Error

Logical error, 1787, 1794, 2205, 2226
Runtime error, 1787, 1794, 2205, 2226

Error alarm
Acknowledge, 2360

Error message
Downloading data to the PLC, 47

Error messages
Download, 2236

ESC key, 2286
Establishing a connection from a remote system 
("PG_DIAL"), 2849
Establishing a remote connection, 2841

Procedure, 2841
ET 200eco, 535
ET 200eco PN, 535, 550
ET 200iSP, 534
ET 200iSP distributed I/O station

Definition, 536
ET 200L, 534

ET 200M, 534
ET 200pro, 535
ET 200R, 535
ET 200S, 534

DPV1 mode, 439
Option handling, 437
Reference junctions, 433
Slot rules, 432

ET 200S COMPACT, 534
Ethernet interface

Displaying parameters, 2805
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Event
 Block property changed, 1992
 Lock changed, 2006
 Operator input alarm property changed, 1991
 Status changed, 2006
Acknowledge, 1849, 1852, 2003
Adjust, 1845, 1990
Alarm buffer overflow, 1852
Alarm statistics column property changed, 1993
Boundary reached, 1852
Change property time column, 1996, 2006, 2007
Change slider, 2005
Change video format, 2008
cleared, 1845
Click, 1850, 1998, 2000
Click toolbar button, 2004
Column property changed, 1993
Configuring, 1490, 1495
Deactivate, 1847
double-click, 1848, 1991
Dynamize, 734
Enable, 1845, 1989
Execute, 1846, 1990
Exit full screen, 2008
For function lists, 1010
Free space critically low, 1855, 2427
Full screen, 2008
Incoming, 1850, 1997
Inspector window, 38
Limit , 1850, 1852
Loop-In-Alarm, 1851, 2001
Low free storage space, 1855, 2426
Medium closed, 2002
Medium opened, 2002
Menu, 969
Outgoing, 1849, 1997
Overflow, 1119, 1854
Pause, 2003
Play ended, 1989
Press, 1848, 1991
Press key, 1853, 2007
Press right mouse button, 2003
Property changed, 1992, 1999, 2000
release, 1851, 2001
Release right mouse button, 2004
Replay, 2009
Runtime Stop, 1853, 2004
Screen change, 1847
Selection changed, 1846, 1990
Shortcut menu, 1999
Statistics area column name property changed, 
1994
Status bar element property changed, 1994
StepBack, 2005
StepForward, 2005
Switch off, 1855
Switch on, 1855
Tags, 1010
Time column property changed, 1996
Time expired, 1856
Toggle, 1854
Toolbar, 969
Toolbar button property changed, 1994
Trend diagram property changed, 1992
Trend property changed, 1993
User change, 1847
Value change, 1855
Value column property changed, 1995
Volume, 1999
When dialog is closed, 1847
When dialog is opened, 1846
X-axis property changed, 1995
Y-axis property changed, 1996

Event trigger, 2036, 2046, 2054
Event-driven output

Report, 1630
Event-driven tasks

Configuring, 1288
Configuring:event-driven tasks, 1275, 1292, 1296

Events, 1134
Start, 1134
Stop, 1134

Example
 Application for alarm classes, 1246, 1247
 Configuring a language switch (VBS), 1835
Accessing objects (C), 1834
Accessing objects (VBS), 1819
Changing and displaying operating mode, 1816
Determining color of objects (C), 1834
System alarm, 1243
User-defined function for temperature conversion, 
1812

Example C function in WinCC
 Writing tag values, 1837
Configuring a screen change via a property, 1836
Configuring diagnostic output via a trace, 1836
Deactivating Runtime, 1835
Reading tag values, 1837
Writing object properties, 1838

Example:
Discrete alarm, 1242
System event, 1244

Examples
C in WinCC, 1833
Configuring a language switch (VBS), 1820
Configuring a recipe view (VBS), 1830
Configuring a screen change via a property (VBS), 
1821
Configuring an alarm view (VBS), 1831
Configuring diagnostic output via a trace (VBS), 
1821
Deactivating Runtime (VBS), 1820
Determining color of objects (VBS), 1819
Evaluating tag values (VBS), 1832
Reading tag values (VBS), 1825
VBS in WinCC, 1818
Writing object properties (VBS), 1827
Writing tag values (VBS), 1822

Excel Workbook Assistant, 2670
Excel Workbook Wizard, 2670, 2681
Excel workbooks

Alarm Attributes, 2681
VBA functions, 2682

Excel Workbooks, 2608
Exchangeable medium, 466
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Execute, 1846, 1990
Executing

User-defined functions in Runtime, 1807
Exit full screen, 2008
exit function, 1965
exp function, 1961
Export

Alarm, 2069
Project texts, 2096, 2113
Recipe, 2063, 2066
Runtime data, 1563
Tag, 2084
Text list, 2091
User administration, 1724

Export of Runtime data
Configuring, 1197, 1207, 1214

Exporting
Recipe, 1528
Recipe data record, 1480, 1528, 2340

Expression
Dynamize, 747
Property animation, 747

Extended download to device, 47
External graphic

Edit folder, 689
Link folder, 689
Removing the folder link, 689
Rename folder, 689

External image file
add to graphics library, 2118
Managing, 667
Storing in the image browser, 690

F
f(t) trend view, 846, (See trend view)

 Online configuration, 1197, 1208, 1215
Toolbar, 848

f(x) trend view, 849, 851, (See trend view)
 Online configuration, 1197, 1208, 1215
Application, 1665
Rules for the data source, 1183
Toolbar, 850, 853

fabs function, 1961

Faceplate, 786
Cancel connection to faceplate type, 807
Controlling properties dynamically, 808
Create, 810
Dynamically controlling included objects, 816
Dynamize, 808
Example, 809
Faceplate type, 786
Instance of the faceplate, 786
Response to sizing, 806

Faceplate type, 786
 Deleting a property connection, 795
Cancel connection, 807
Create, 791
Creating a tag, 812
Defining properties, 811
Deleting a category, 795
Deleting a connection, 795
Deleting a property, 795
Dynamic control, 808
Editing, 805
Enable, 805
Event, 790
Faceplate, 806
Graphics list, 791
Properties, 790
Response to resizing, 806
Script, 790
Tag, 790
Text list, 790
Updating, 805
Use, 806
User text, 791

FAQs, 288
fclose function, 1963
FDA, 2412
Feedback

Optical, 2278
feof function, 1963
ferror function, 1963
fflush function, 1963
fgetc function, 1963
fgetpos function, 1963
fgets function, 1963
Field device, 441, 468
FIFO buffer, 1140

Basics, 1140
File format

Audit Trail, 2436
File sharing, 2255
Fill level, 680
Fill style, 924
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Filter
Hardware catalog, 293

Filtering
Alarm list:filter, 1395
the alarm view, 1318

Filtering alarms, 1396, 2367
Find and replace, 235

Additional options for searching, 235
Replacing search keys, 236
Start search, 236
Using the search function, 235

Firewall
in Windows 2003, 2585, 2621
in Windows 2008, 2589, 2620
in Windows 7, 2589, 2620
in Windows XP, 2585, 2621

Firmware update memory card, 482
First value alarm, 1251
Fixed aspect ratio, 925
Flash test, 620
Flashing, 682, 736, 1285

Alarm, 1283
Alarm text block , 1285

Flip, 924
Object, 666

Float, 1094
floor function, 1961
Flutter monitoring, 557
fmod function, 1961
Folder, 2255

Released folders, 2255
Folder link

Editing, 690
Removing, 690
Renaming, 690

Font settings
Migrate, 104

Footer
Report, 1606, 1608

fopen function, 1963
Force job

On SD card, 26
Forcing

Audit, 2438
Foreground color

Dynamization, 736
Format, 836

Format adaptation
Allen Bradley Ethernet IP, 1082, 1083, 1084, 
1085, 1086, 1087, 1088
Mitsubishi MC TCP/IP, 1096, 1097, 1098, 1099, 
1100, 1101, 1102, 1103, 1104, 1106
Mitsubishi MC TCP/IP:Int, 1104
Modicon Modbus TCP/IP, 1089, 1091, 1092, 
1093, 1094, 1095
OPC DA, 1070, 1071, 1072, 1073, 1074, 1075, 
1076
S7 1200, 1058, 1059, 1060, 1061, 1062, 1063, 
1064, 1065, 1066, 1067, 1069
S7 300/400, 1050, 1051, 1052, 1053, 1055, 1056, 
1057

Format adjustment
Data type, 988
S7 300/400, 1048, 1049, 1054

Format DLL, 1129
Formatting

Alarm text, 1275
fputc function, 1963
fputs function, 1963
Fragment, 408, 413
fread function, 1964
free function, 1965
Free space critically low, 1855, 2427
freopen function, 1963
Frequency meter, 547, 550
frexp function, 1961
fseek function, 1963
fsetpos function, 1964
ftell function, 1964
Full screen, 2008
Function, 1740

Function list , 1754
Function key

Global screen, 643
Local assignment, 643
Replacing devices, 2134
Use global assignment, 643

Function keys
Global assignment, 2287
Local assignment, 2287

Function list, 1010, 1748, 2038
Asynchronous execution, 1808
Configuring, 1750
Converting to local script, 1785
Deleting local script, 1785
Editing, 1752
Execution in Runtime, 1808
Synchronous execution, 1808
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Functional scope
ProSave, 2227

Functions
Updating tag value, 979

FunctionTrendControl
Online configuration, 1564
Runtime data, 1563

fwrite function, 1964

G
Gadget, 2573, 2574, 2613, 2614
Gateways, 2820
Gauge, 949

Color of individual ranges, 950
Display peak value, 950
GMP-relevant tag, 949
Maximum value, 950
Minimum value, 950
Normal range visible , 950

GE Fanuc SNP
Migrating data types, 126

General information on troubleshooting, 2855
Generation of packed addresses, 435
getc function, 1964
getenv function, 1964
GetLanguageByLocaleID, 1862
GetLinkedTag, 1862
GetLocalScreen, 1861
GetParentScreen, 1864
GetParentScreenWindow, 1864
GetPropBOOL, 1865
GetPropChar, 1866
GetPropDouble, 1867
GetPropLong, 1867
GetTagBit, 1869
GetTagBitState , 1872
GetTagBitStateQC, 1874
GetTagBitStateQCWait, 1877
GetTagBitStateWait, 1879
GetTagBitWait function, 1884
GetTagByte, 1869
GetTagByteState, 1872
GetTagByteStateQC, 1874
GetTagByteStateQCWait, 1877
GetTagByteStateWait, 1879
GetTagByteWait function, 1884
GetTagChar, 1869
GetTagCharState, 1872
GetTagCharStateQC, 1874
GetTagCharStateQCWait, 1877
GetTagCharStateWait, 1879

GetTagCharWait function, 1884
GetTagDouble, 1869
GetTagDoubleState, 1873
GetTagDoubleStateQC, 1874
GetTagDoubleStateQCWait, 1877
GetTagDoubleStateWait, 1879
GetTagDoubleWait function, 1884
GetTagDWord function, 1869
GetTagDWordState, 1873
GetTagDWordStateQC, 1874
GetTagDWordStateQCWait, 1877
GetTagDWordStateWait, 1879
GetTagDWordWait function, 1884
GetTagFloat, 1869
GetTagFloatState, 1873
GetTagFloatStateQC, 1875
GetTagFloatStateQCWait, 1877
GetTagFloatStateWait, 1879
GetTagFloatWait function, 1884
GetTagMultiStateQCWait function, 1870
GetTagMultiStateWait, 1871
GetTagMultiWait , 1872
GetTagRaw, 1869
GetTagRawState, 1873
GetTagRawStateQC, 1875
GetTagRawStateQCWait, 1877
GetTagRawStateWait, 1879
GetTagRawWait function, 1884
GetTagSByte, 1869
GetTagSByteState, 1873
GetTagSByteStateQC, 1875
GetTagSByteStateQCWait, 1878
GetTagSByteStateWait, 1880
GetTagSByteWait function, 1884
GetTagSDWord function, 1869
GetTagSDWordState, 1873
GetTagSDWordStateQC, 1875
GetTagSDWordStateQCWait, 1878
GetTagSDWordStateWait, 1880
GetTagSDWordWait function, 1884
GetTagSWord, 1869
GetTagSWordState, 1873
GetTagSWordStateQC, 1875
GetTagSWordStateQCWait, 1878
GetTagSWordStateWait, 1880
GetTagSWordWait function, 1884
GetTagValue, 1881
GetTagValueStateQC, 1881
GetTagValueStateQCWait, 1882
GetTagValueWait, 1883
GetTagWord , 1869
GetTagWordState, 1873
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GetTagWordStateQC, 1875
GetTagWordStateQCWait, 1878
GetTagWordStateWait, 1880
GetTagWordWait function, 1884
GetValue, 2521
Global C tags, 1774

Definition, 1774
Usage, 1774

Global library, 773
Adding a copy template, 263
Adding types, 264
Basics, 256
Closing, 260
Create, 783
Creating, 256
Creating folders, 262
Deleting, 261
Editing elements, 267
Migrating, 116
opening, 784
Opening, 257
Removing elements, 269
Save, 783
Saving, 259
Shared work, 256
Showing properties, 259
Using a supplied global library, 270
Using filter view, 255, 270
Using master copies, 265
Using the element and part views, 247
Using types, 266

Global screen, 642
Function key, 643
Template, 644

Global telephone book properties, 2818
GMP, 2412
GMP settings, 2440, 2444
GMP-relevant tag, 2440

Gauge, 949
gmtime function, 1966
Go online

connecting several devices, 2802
Going offline, 619
Going online, 618
Good Manufacturing Process, 2412

Graphic
add to graphics library, 2117
Button, 911
Graphic view, 854, 1667
Inserting, 668, 1641
managing, 689
Stretching, 855, 856, 1667
Using from the graphic browser, 688
With transparent background, 688

Graphic browser, 688
Graphic browser , 2118
Graphic I/O field, 855, 857

Adding a system diagnostics indicator, 2183
Output graphics list, 729
Scroll bar type, 858
System diagnostics window, 2183
Use in reports, 1668

Graphic view, 854, 1667
transparent color, 855

Graphics, 690
Editor, 2116

Graphics list
Application, 718
Bit (0, 1), 726
Bit number  (0 - 31), 728
Create, 720
Creating, 719
Graphic I/O field, 729
Outputting configuration data, 728
Range  (0 - 31), 720
Range (... - ...), 720, 723, 725

group
Cancel, 695
Edit, 693
Ungroup, 695

Group
Adding objects, 696
Cancel, 695
Creating, 693
Editing, 693
Removing an object, 697
Ungroup, 695

Group acknowledgment, 2287
Group alarm

Display suppression tag, 1466
GSD files

Configuring devices (PROFIBUS), 441
GSD revisions (PROFIBUS), 440
Installation, 441

GSD files (PROFINET), 467
Changing revision, 469
Installation, 468
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GSDML, (See GSD files (PROFINET))

H
Handshaking, 511
Handwheel, 858

Tag, 858
Hardcopy

Layout in reports, 1669
Hardware

Configurimg and assign parameters, 290
Edit parameters, 309
Edit properties, 309
Requirement, 2553

Hardware acceleration
SmartServer, 2482

Hardware and network editor
Device view, 278
Network view, 275
Topology view, 280

Hardware catalog
Adding device, 301
Browsing, 292
DP slave, 421
DP/DP coupler, 421
I slave, 421
Selecting the hardware component, 299
Task card, 286

Hardware configuration
Adding device, 300
Adding module, 303

Hardware diagnostics, 587
Hardware editor

Components, 273
Function, 273
Hardware catalog, 286
Inspector window , 284

Hardware ID, 388
Hardware interrupt OB

Assigning parameters, 528
Description, 524

Hardware requirements
Communication instruction "AS_MAIL", 2853
Communication instruction "SMS_SEND", 2852
Communications instruction "PG_DIAL", 2849

Hardware requirements for AS-AS remote link
Communication instruction "AS_DIAL", 2851

Hardware support package
Installing, 76

Hardware-controlled data flow control, 511
Harmonize

Object size, 675, 1651

HART, 538
Header

Hide, 2630
Report, 1606, 1608
Show, 2630

Help
Browsing, 186
Call topic from favorites, 187
Delete topic from favorites, 188
Find keywords, 186
Full-text search, 186
Identification of Help topics, 184
Open, 186
Open tooltip cascades automatically, 189
Printing help topics, 188
Save topics in favorites, 187
Use index, 186

Help indicator, 859
Hibernate, 26
Hidden input, 841
Hiding

Report sections, 1630
Hierarchical alarm groups, 1254

Creating, 1269
High-speed counter

Configuring, 506
General, 503
How it works, 504

Historical alarm list (long-term)
Configuring a filter, 1337

Historical alarm list (long-term) 
Configuring, 1337
Configuring the sorting, 1337

Historical alarm list (short-term)
Configuring a filter, 1337
Configuring the sorting, 1337

Historical alarm list (short-term) 
Configuring, 1337

Hit list, 1399, 2370
Hit List of Alarms, 2667
HMI connection, 142, 342
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HMI device, 65
 WinCC Runtime Professional performance , 
2407
as OPC client, 2694
as OPC server, 2694
Changing the device type, 2238
Commissioning, 2241
Data backup, 2228, 2230, 2254
Performance features, 2382, 2385, 2389, 2393, 
2397, 2401, 2404
Recommissioning, 2241
Reset to factory settings, 2232
Restoring data, 2228, 2230, 2254
System limits, 2382, 2385, 2389, 2393, 2397
Transferring license key, 2234
Updating the operating system (Windows CE), 
2232

HMI device change
by the migration, 101

HMI device dependency
in system function, 1756

HMI device licensing
Not PC-based, 65

HMI device replacement, 33
HMI device type

Changing, 2238
HMI device wizard, 2060, 2061
HOME key, 2285
Horizontal radius, 843

Ellipse segment, 845
Elliptical arc, 844

Hotfix for communications processor, 30
Hotkey, 2263

Defining, 2263
Hardcopy, 2263
Logging off, 2263
Logon, 2263

How the frequency meter works, 548
HSC, 503
HSP, (See Support package)
HTML browser, 860, 863

Button, 862
Connecting to the FTP server, 861
Connection to the FTP server, 863
File explorer, 861, 863

HTML page
Displaying data type DATETIME, 2500

HTTP client, 2515
Configure HTTP-Connection, 2515
Configuring tags, 2516
Configuring the SIMATIC HMI HTTP protocol, 
2515
Importing certificates, 2517

HTTP server
Configure WinCC-Project , 2513
Setting at the HMI-device, 2513

HTTPS, 395

I
I address, 388
I slave, 422, 430

configuring, 431
Data access, 431
Data exchange, 423
Hardware catalog, 421

I/O
Direct access to, 489

I/O access error, 487
I/O address, 388, 489
I/O field, 840

application in reports, 1663
Data format, 841
Display format in reports, 1664
Hidden input, 841
Mode, 841

I/O input, 484
I/O output, 484
Icon

For comparison, 592
For comparison status, 625
for connection status, 625
For diagnostics, 591
for operating mode, 593
Overlay icon, 592

Icons
in TeleService, 2845

Identifying
Alarm class, 885

IE/AS-i link PN IO, 443
IEEE tag, 537
IIS, (See Internet Information Service)
Illuminated pushbutton, 874

Tag, 875
Image file

Storing in the image browser, 690
Storing in the image browser , 2118
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Import
Alarm, 2071, 2072
Analog alarm structure, 2073, 2078
Project texts, 2095, 2115
Recipe, 2065, 2067
Structure of discrete alarms, 2076, 2082
Structure of recipe data, 2069
Tag, 2086
Tag data structure, 2089
Text list, 2093
User administration, 1725

Importing
Recipe, 1528
Recipe data record, 1480, 1528, 2340

Importing a recipe
Structure for the import, 2069

Importing alarms
Structure for the import, 2082

Importing analog alarms
Structure for the import, 2073, 2078

Importing discrete alarms
Structure for the import, 2076, 2082

in the screen
Arrange object, 675, 1646

Incoming, 1245, 1850, 1997
IncreaseTag, 1885
Index tag, 1009
Indirect addressing

Tags, 1016
Indirect addressing , 1009
Info text

Creating, 1288, 1292, 1295
Information system

Components of the information system, 183
Roll-out, 184
Tooltip, 184

Infotext, 1259
Creating, 1273, 1275
display, 2284, 2287, 2290
Key, 2287

Infotext 
Display, 1385

Initialization (custom web pages), 397
Initialization of the modem, 2822
Initialization string requirements, 2822
Input (I), 484
Input area plan

SmartClient, 2461
SmartServer, 2461
SmartService, 2461

Input byte (IB), 484

Input field, 2280
Character mode, 2286
Standard mode, 2286

Input word (IW), 484
InquireLanguage, 1886
Insert

Library object, 782
Inserting, 1806

Code template in user-defined functions, 1754
Graphic, 668, 1641
Object, 666, 668, 1641
Rectangle, 706

Inserting in a screen, 1806
Inserting:GSC diagnostics, 1806
Inspector window

Cross-reference, 38
Event, 38
Layout, 169
Reducing automatically, 163

Inspector window 
Diagnostics tab, 589
Hardware and network editor, 284

Installation
Displaying software, 76
Internet Information Service, 2558
Licenses, 71
Log, 72
Modifying products, 77
ProSave, 47
Repairing products, 79
Requirement, 2553, 2556
Security settings, 2565
Starting, 73
Support package, 76
System requirements, 57
Target directory, 29
Updating products, 77
Web diagnostics client, 2570
WebNavigator Client, 2561, 2565, 2568, 2569
WebNavigator Server, 2559

Installing, 63
Add-on, 63
OPC XML DA Server, 2711
Option, 2236
Powerpack, 71

Installing support packages, 76
Installing the local modem, 2820
Instructions

Function list, 1754
Instructions for configuring a remote modem, 2822
Int, 1052, 1061, 1083, 1095, 1104
Integrated connection, 980
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Integrated project
Converting an unspecified CPU, 141
Creating an integrated HMI connection, 142
Deleting an unspecified connection, 145
Linking HMI tags, 144
Migrating, 120, 138
Post-editing, 140

Intel format, 1578
Intelligent DP slave, (See I slave)
Interconnecting ports

Graphic view, 381, 383
In the Inspector window, 460
Table view, 382, 383

Interface
Adding, 2803
Displaying, 598
Renaming, 384

Interface properties, 598
Internet Explorer

Security settings, 2565, 2626
Internet Information Service, 2558
Interrupts

With packed addresses, 439
Invalid license

With a time zone change, 68
InverseLinearScaling, 1887
InvertBit, 1888
InvertBitInTag, 1889
InvertLinearScaling, 1887
IO device

Networking, 458
Update time, 461
Watchdog time, 461

IO system, 457
Creating, 458
Send clock cycle, 460

IO-Link, 472
IP address, 27, 447

Assigning, 610
IP address parameters, 448
IP parameters, 598
IQ sense, 559
isalnum function, 1959
isalpha function, 1959
isdigit function, 1960
isgraph function, 1960
islower function, 1960
ISO-on-TCP

Characteristics, 363
TSAP, 368

isprint function, 1960
ispunct function, 1960

isspace function, 1960
isupper function, 1960
IsUserAuthorized, 1890
isxdigit function, 1960
ITag, 2752
ITag method

Cancel, 2767
ReadTag, 2764
ReadTagAsync, 2765
ReadTagCyclic, 2766
Register, 2764
RemoveCyclicTag, 2766
Unregister, 2769
WriteTag, 2767
WriteTagAsync, 2768

ITagSink, 2752
ITagSink methods

OnCanceled, 2769
OnError, 2771
OnRemove, 2771
OnUpdate, 2770
WriteTagAsync, 2772

J
Job types and error codes

Raw data communication for recipes, 1577

K
Key

Backspace, 2286
Cursor, 2285
Delete, 2286
END, 2285
ENTER, 2286
ESC, 2286
HOME, 2285
Infotext, 2287
Scrolling back, 2285
Scrolling up, 2285
TAB, 2285

Key assignment
Replacing devices, 2134

Key operation, 2285, 2288
Key switch

Layout, 914
Tag, 914
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Keyboard shortcuts
Editing texts, 180
Project editing, 178
Project tree, 179
Tables, 179
Window, 179

Keys, 2267
KeySwitch

Application, 913
K-key

Replacing devices, 2135
Know-how protection

Changing a password, 1763
opening a user-defined function, 1762
remove, 1763
Setting up, 1762

L
labs function, 1964
Language, 2260

Activate project language, 2106
Asian languages, 2104
Asian operating system, 2104
Disabling the project language, 2106
Editing language, 2106
Language support, 2104
Language-dependent format, 2103
Language-specific graphic, 2116
Log, 1124, 1367, 2126
multilingual project , 2108
Reference language, 2106
Regional format of the date, time, currency, and 
numbers, 2103

Language abbreviation, 417
Language behavior

Screen keyboard, 48
Language Settings in Runtime, 2260
Language switching, 417, 2120

In Runtime, 1811
Log, 1124, 1367, 2126
Runtime language, 2123

Languages
Migrating, 114

Layer
Assigning objects to a layer, 766

Layout
 Alarm report , 1671
 Control data, 1656
 Control Information, 1658
 CSV provider trends , 1659
 ODBC database field , 1673
 ODBC database table, 1674
 Project name in reports, 1676
 Recipe report , 1679
 Report name in reports, 1677
Alarm indicator, 895, 1388
Alarm line, 882
Alarm view, 881, 883, 887, 893, 1383, 1386, 1393, 
2357, 2358
Bar, 828, 829
Button, 911
Charging condition, 874
Circle, 869
Clock, 938
Complex alarm view, 881
Connector, 939
Control Hardcopy, 1657
Date/time field, 836
Date/time field in reports, 1661, 1662
Editable text field, 842
Effective range name, 942
Effective range name (RFID), 945
Effective range signal, 946
Ellipse, 843
Ellipse segment , 845
Elliptical arc, 844
f(t) trend view, 846
f(x) trend view, 849, 852
Gauge, 949
Graphic I/O field, 856, 857
Graphic I/O field in reports , 1668
Graphic view, 854, 1667
Handwheel, 858
Hardcopy in reports, 1669
HTML browser, 861, 863
I/O field, 840
I/O field in reports, 1664
Illuminated pushbutton, 875
KeySwitch , 914
Line, 878
List box, 879
Media Player , 880
Page number in reports, 1680, 1681
Polygon, 897
Polyline, 899
Print job/Script diagnostics, 838
Recipe view, 902, 904
Rectangle, 901
Simple Alarm view, 882
Simple recipe view, 1515, 2333
Simple user view, 2297
Slider, 913
Sm@rtClient view, 917
Status/Force, 921
Switch, 910
Symbol library, 923
Symbolic I/O field, 925, 927
Symbolic I/O field in reports, 1682
Table view, 933
Text field, 936, 1683
Trend view, 872
User view, 831, 2296
Value table, 940
WLAN reception, 947
Zone name, 951
Zone signal, 952
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Layout template
Create, 2648

ldexp function, 1961
ldiv function, 1964
LED ACK, 2355
LED control, 2249
LG GLOFA GM

Migrating data types, 127
Library, 773

Basics, 243
Buttons and Switches, 776
Copy template, 775
Copying a library object, 775, 780
Deleting a library object, 780
Global libraries, 256
opening, 784
Project library, 248
Save, 783
Storing an object, 781
System diagnostics indicator, 2180
Task card, 245
Type, 775
Types, 243
Using filter view, 255, 270
Using the element and part views, 247

Library object, 773, 774
Inserting, 782

License
Defective, 68
Defective license, 68
Managing, 2234
OPC server, 2706
Starting without valid license, 63
Web diagnostics client, 2555
Web diagnostics server, 2555
WinCC Runtime Professional Asian, 69

License key, 66
Working with license keys, 66

License Keys, 2233
License Manager Panel Plugin, 65
License key

Transfer to an HMI device, 2234
Licenses, 71
Light emitting diode

acknowledge, 2287
Toggle, 2286

Limit , 1850, 1852
Limit test, 2281, 2288
Limit value, 1259

Tag, 996
Limit values

Tag, 996

Line, 878
design, 679
Line end, 679, 878
Line start, 878

Line break, 553
Line end

Line, 878
Polyline, 899

Line start
Line, 878
Polyline, 899

LinearScaling, 1890
Link folder

External graphic, 689
Linked objects

Copying, 2147, 2148
Linking HMI tags, 144
List box, 879
List of Hidden Alarms, 1350
LLDP (Link Layer Discovery Protocol), 465
load

Recipe data record in Runtime, 1525
Load

In programming device/PC, 474
Recipe, 1547
SIMATIC PC station, 48

Load memory, 484
Loading

Downloading project data to the device, 206
Downloading to a memory card, 208
from a device, 209
General information, 205
USB, 2194, 2214
via USB, 2193, 2214

Loading projects
with connected HMI device, 2189, 2209
without connected HMI device, 2189, 2210

Local data bit (L), 484
Local data byte (LB), 484
Local data double word (LD), 484
Local data word (LW), 484
Local script, 1740

Configuring at event, 1785
Deleting at event, 1785
Deleting at object property, 762, 1786
Dynamic control of object properties, 762, 1786
Use, 1782
Using, 1782

Local tag, 1760
Local time, 496
localtime function, 1966
Lock bit, 1465
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Lock changed, 2006
Lock list, 1399, 2370
Lock tag, 1256, 1465

Alarm group, 1465
Log

Alarm log, 1468, 1470
Characters which may be used in tag names, 
1114, 1147
Checksum, 1110, 1122, 1366
Compressed log, 1470
Configuration, 1145
Configuring the size, 1155
Connecting, 1163
Data log, 1468, 1470
Disconnecting, 1164
Language switching, 1124, 1367, 2126
Level-dependent management, 1116
Runtime language, 1124, 1367, 2126
Storage on network, 2245

Log backup
Connecting, 1163, 1376
Disconnecting, 1164

Log behavior
Control with system function, 1119
Level-dependent management, 1116
Managing upon system start, 1115

Log contents
Display, 1109, 1355

Log data, 1400, 2371
Migrating, 117
output in alarm window, 1400, 2371

Log database, 1140
Direct access with ODBC, 1174, 1363

Log file
 Modem alarms , 2859

log function, 1961
Log language, 1124, 1367, 2126
Log segments

Configuring, 1155
Log tag value change

Audit Trail, 2440
Log type, 1354
Log types, 1161
Log with level-dependent execution of system 
functions, 1354
Log with level-dependent system alarm, 1354
log10 function, 1961

Logging
Change to a recipe data record in Audit Trail, 
2442
Circular log, 1109
Cyclic, 1136
Cyclic-selective, 1137
Log type, 1109, 1354
On demand, 1138
On value change, 1138
Segmented circular log, 1109
Start, 1127
System functions in Audit Trail, 2448
Tag value, 1108
Tag value change in Audit Trail, 2440
Tags, 1111, 1117
Tolerance band, 1117
User actions in audit trail, 2445
Within/outside the limit values, 1117

Logging concept
Audit , 2415

Logging cycle, 1117, 1127, 1134
Tag, 1034, 1036

Logging method, 1127
Circular log, 1109
Level-dependent, 1109

Logging methods, 1133
Compression, 1133
Cyclic, 1133
Cyclic-selective, 1133
On change, 1133
On demand, 1133

Logging recipe data changes
Audit Trail, 2442

Logging system functions
Audit Trail, 2448

Logging tag, 1129, 1149
analog, 1129
binary, 1129
Configuration, 1149
Configuring, 1125, 1165
Creating, 1149

Logging user actions
Audit Trail, 2445

Logical error, 1787, 1794, 2205, 2226
Logoff

Configuring on the effective range, 2026
Configuring to effective range (RFID), 2030
Effective range, 944
Effective range (RFID) , 946
Users, 2300
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Logoff time, 2295
Changing, 1701
Changing in runtime, 1718, 1720

Logon
Configuring on the effective range, 2026
Configuring to effective range (RFID), 2030
Dynamic, 1694
Effective range, 943
Effective range (RFID), 945
Logon failed, 1722, 1724
Reporting, 1732
Users, 1721, 1723, 2299

Logon dialog
Configuring access protection, 1731

Logon for web server, 394
Logon web server, 394
Long-term archive list, 1399, 2370
Long-term archive server, 1142

Installation (overview), 1142
Loop-in alarm

Configured, 1302
trigger, 1388

Loop-in-alarm
Setting, 891

Loop-In-Alarm, 1851, 2001
Low free storage space, 1855, 2426
LReal, 1062

M
malloc function, 1965
managing

Graphic, 689
Managing

License, 2234
User group, 1701
Users, 1700
Users in runtime, 1717, 1719

Manual display suppression, 1329
Manual fragment, 413
Manual hiding, 1350
Manuals, 288
Mapping rules (OPC A&E) 

"Mode 1", 2727
"Mode 2", 2727
"Mode 3", 2728

math functions
acos function, 1961
asin function, 1961
atan function, 1961
ceil function, 1961
cos function, 1961
cosh function, 1961
exp function, 1961
fabs function, 1961
floor function, 1961
fmod function, 1961
frexp function, 1961
ldexp function, 1961
log function, 1961
log10 function, 1961
modf function, 1961
pow function, 1961
sin function, 1961
sinh function, 1961
sqrt function, 1961
tan function, 1961
tanh function, 1961

Maximum cycle time, 481, 500
Maximum length

Tag, 49
Measuring window (GATE), 550
Media Player , 880
Medium closed, 2002
Medium opened, 2002
memchr function, 1962
memcmp function, 1962
memcpy function, 1962
memmove function, 1962
Memory area

Load memory, 484
Retentive memory areas, 486
Work memory, 484

Memory bit (M), 484
Memory byte (MB), 484
Memory card, 482, (See Memory Card)

Accessing, 242
Adding a card reader, 241
Introduction, 241
Showing properties, 243

Memory double word (MD), 484
memory functions

memchr function, 1962
memcmp function, 1962
memcpy function, 1962
memmove function, 1962
memset function, 1962
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Memory medium, 1355
Audit Trail, 2437

Memory requirements
Recipe, 2410, 2411

Memory reset, 482
Making, 609

Memory size
Alarm buffer, 1352

Memory word (MW), 484
memset function, 1962
Menu

Configuring an event, 969
Creating main menu commands, 961
Creating menu commands, 962
Creating submenu commands, 962
customized, 957, 967

Menu command
Simple recipe view, 1516, 2334

Message
Sending, 515
Specifying the end, 516
Specifying the start, 515

Micro USB, 2194, 2214
Microsoft Script Debugger, 1794
Migrated project

Compiling, 96
Migrating projects

Procedure, 89
Requirements, 89

Migration
Adaptations beforehand, 99
Alarm groups, 110
Allen-Bradley DF1 data types, 125
Allen-Bradley DH485 data types, 125
Allen-Bradley Ethernet IP data types, 126
Area pointer, 108
Basics, 92
Data types Modicon Modbus, 129
Data types Modicon Modbus TCP/IP, 129
Data types Omron Hostlink/Multilink, 130
Data types OPC, 130
Data types SIMATIC 500/505 DP, 131
Data types SIMATIC 500/505 serial, 131
Data types SIMATIC HMI HTTP Protocol, 132
Data types SIMATIC S5 AS511, 132
Data types SIMATIC S5 DP, 133
Data types SIMATIC S7 200, 134
Data types SIMATIC S7 300/400, 134
Data types Telemecanique Uni-Telway, 137
Displaying a log file, 91
Displaying history, 90
Excluding the hardware configuration, 86
Font settings, 104
GE Fanuc SNP data types, 126
Global library, 116
HMI device change, 101
Integrated project, 138
Introduction, 91
Introduction to migration, 85
LG GLOFA GM data types, 127
Migrating an integrated project, 120, 138
Migrating projects, 95, 122
Mitsubishi FX data types, 127
Mitsubishi Protocol 4 data types, 128
of external tags, 123
of languages, 114
of log data, 117
of project text, 114
Project library, 116
Recipe data, 117
Reconfigure connection, 107
Runtime data, 117
Script, 113
Supported HMI devices, 97
Supported products, 85
Text, 114
The migration process, 85
User administration, 117
VB-script, 113
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Migration tool, 94
Connecting the hardware configuration, 87
Creating a migration file, 88
Distribution and sources, 82
Removing, 83
System requirements, 82
Using the migration tool, 86

Minimum cycle time, 481, 500
Mitsubishi

Connection interruption, 43
Mitsubishi FX

Migrating data types, 127
Mitsubishi MC TCP/IP

12-Bit Block, 1098
16-Bit Block, 1099
20-Bit Block, 1099
24-Bit Block, 1100
28-Bit Block, 1101
32-Bit Block, 1101
4-Bit Block, 1096
8-Bit Block, 1097
DInt, 1102
DWord, 1103
Real, 1106
Word, 1106

Mitsubishi Protocol 4
Migrating data types, 128

mktime function, 1966
Mobile Panel

Display and operating element, 822
OPC, 2693

Mobile Wireless, 2018, 2019
Work area, 2018
Zone ID / connection point ID, 2032

Mobile Wireless (RFID)
Work area, 2020

Mobile Wireless V2, 2020
Mode, 911

Graphic I/O field, 856, 857
I/O field, 841
Symbolic I/O field, 927

Modem
Local, 2820
Problem, 2855
Remote, 2821

Modem alarms
Log file, 2859

Modem connection cannot be established, 2842
Modem connection is closed, 2843
Modem connection is interrupted, 2858

Causes and solutions, 2858
Modem support, 2819

Modem types / media, 2820
Modems without plug-and-play, 2821
modf function, 1961
Modicon Modbus

Migrating data types, 129
Modicon Modbus TCP/IP

+/- Double, 1089
Double, 1093
Int, 1095
Real, 1091

Modicon Modbus TCP/IP
16 Bit Group, 1092
Float, 1094
Migrating data types, 129

Modifying recipe structures, 1529, 1554
Module

Addressing, 388
Copying, 306
Deleting, 305
Determine diagnostics status, 602
Inserting, 304
Moving, 308
Replacing, 308
Select, 296
Time of day on a module, 609

Module addressing, 488
Module arrangement, 292
Module replacement, 141
Module titles, 294
Module version

Updating, 311
Monitor, 463
Monitoring mode, 2473
Monitoring window, 557
Mono-master system, 422
Move

Screen, 639
Move view

Keyboard shortcuts, 289
Overview navigation, 276, 279, 281

Moving
Hardware components, 308

Multi Panel
Display and operating element, 821
OPC, 2693
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multibyte functions
_ismbcalnum function, 1962
_ismbcalpha function, 1962
_ismbcdigit function, 1962
_ismbcgraph function, 1962
_ismbclower function, 1962
_ismbcprint function, 1962
_ismbcpunct function, 1962
_ismbcspace function, 1962
_ismbcupper function, 1962
_mbscat function, 1963
_mbschr function, 1963
_mbscmp function, 1962
_mbscpy function, 1963
_mbscspn function, 1962
_mbsdec function, 1963
_mbsinc function, 1963
_mbslen function, 1962
_mbsncat function, 1963
_mbsncmp function , 1962
_mbsncpy function, 1963
_mbspbrk function, 1963
_mbsrchr function, 1962
_mbsspn function, 1962
_mbsstr function, 1963
_mbstok function, 1963
_mbstrlen function, 1962

Multiple selection, 296, 672, 1648
Multiplexing, 1009

Address multiplexing, 1002
with absolute addresses, 1002
with symbolic addresses, 1002

N
Name

Array element, 41
Names of alarm classes

Change through migration, 111
Navigation interface

Extending menus, 2597
Server change, 2597
Structure, 2596
User logon, 2597

Network, 2546
Access to subnetworks, 2546
Router, 2546

Network access
Opening the properties, 2800

Network drive, 28
Storing logs, 2245

Network editor
Components, 273
Function, 273
Hardware catalog, 286
Inspector window , 284

Network overview
Basic functions, 316
Basic functions for editing the network overview 
table, 316

Network view
Adding device, 301
Hardware and network editor, 275

Networking devices
Basics of configuring networks, 312
Editing interface parameters, 318
Editing network parameters, 318
Networking several interfaces at the same time, 
314
Networking with an existing subnet, 315
Networking without an existing subnet, 313
Networks within a project, 312
Requirements, 317
Types of communication, 312

Networking in the device view
Networking options, 316
Procedure, 317

New value alarm, 1252
Non-licensed mode

ES, 63
HMI devices, 66
Runtime, 65

Normal range visible, 950
NotifyUserAction, 2447
Numerical

Screen keyboard, 2280
Numerical key assignment, 2286
Numerical value

Changing, 2281, 2288
Decimal places, 2281
Display format, 2281, 2288
Entering, 2281, 2288
Limit test, 2281, 2288

O
O, 2793
OB 1, 521
OB 80, 525
OB 82, 526
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object
Group, 693
Paste, 683, 1643
Rotate, 677, 1651

Object
Arrange, 666, 675, 1646
Assigning to a layer, 766
Availability, 826
Availability for Basic Panels, 817
Availability for Comfort Panels, 819
Availability for Mobile Panels, 822
Availability for Multi Panels, 821
Availability for Panels, 818
Availability for WinCC Runtime Advanced, 824
Creating a new OLE object, 667
Creating an OLE object from a file, 667
Customizing default properties, 666
Deleting, 669, 1642
Deleting local script, 762, 1786
design, 680
Design, 679
Dynamization, 729
Dynamization of the appearance, 736
Dynamize direct movement, 740
Dynamizing a property with a local script, 762, 
1786
editing within a group, 698
Evenly distributing, 674, 1650
Flashing, 682
Flip, 666
Flush alignment, 674, 1650
Grouping, 693
Inserting, 668, 1641
Inserting of the same type, 666
Inserting several times, 683, 1643
Multiplying, 683, 1643
outside the area, 676
Paste, 666
Referencing, 1764
Repositioning and resizing multiple objects, 667, 
685, 1649
Repositioning objects, 666, 670, 1644
Resize, 672, 1647
Resizing, 666
Rotate, 666, 677, 680, 1651
Select multiple objects, 672, 1648
Selecting multiple objects, 666
Storing in a library, 781
Tab sequence, 666

Object group
Animation, 753, 754
Editing an object within a group, 698
Removing an object, 697

Object list
Tag, 985

Object names
Renaming upon migration, 92
Uniqueness, 92

Object property
Dynamization, 729

Object size
Harmonizing, 675, 1651

Objects
 Alarm view , 1669
 CSV provider trends , 1659
 Date/time field, 1662
 f(t) trend view , 1665
 Page number , 1680, 1681
 Position in reports , 1613
 Project name, 1676
 Recipe view , 1678
 Size in reports , 1613
 Table view , 1682
 with dynamic length in reports , 1614
Alarm report, 1671
Alarm sequence report, 1670
CSV provider table, 1660
ODBC database field, 1673
ODBC database table, 1674
Recipe report, 1679
Report name , 1677

Obtaining user rights
Logging on to the operating system with 
administrator privileges, 182
With Windows user account control, 182

ODBC database field
Layout in reports, 1673
Use in reports, 1673

ODBC database table
Layout in reports, 1674
Use in reports, 1674

Offline
Recipe tag, 2319

OLE object
create from a file, 667
Recreate, 667
Save in Graphics, 690
Storing in the image browser , 2118

Omron Hostlink/Multilink
Migrating data types, 130

On demand, 1012
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Online
Recipe tag, 1482, 2319

Online access, 2796
Online and Diagnostics view, 588
Online configuration, 1197, 1208, 1215, 1564

 Table view, 1226
OnlineTrendControl, 1220
Table view, 1230
Trend view, 1230

Online connection, 2793
Online delta loading, 2217

Configuring, 2218
Limitations, 2218
WinCC Web Navigator support, 2218

Online displays
Orange color, 594

Online mode, 2793
Canceling an online connection, 2801
Display of the online mode, 2795
Displaying accessible devices on an interface, 
2799
Displaying all accessible devices as a list, 2799
Go online, 2800
Standby or hibernation of the programming 
device / PC, 2793

Online Tools, 588, 595
OnlineTableControl

Online configuration, 1564
Runtime data, 1563

OnlineTrendControl
Online configuration, 1220, 1564
Runtime data, 1563

OP 177B mono
Symbol library, 924

OP 77A and TP 177A
Differences in the recipe, 1483

OP73
Loading a project, 47

OP77A
Loading a project, 47

OPC, 2692, 2705
Accessing tags, 2703
Basic settings, 2708
Communication concept, 2707
Compatibility, 2693, 2706
DCOM user rights, 2696, 2748
Functionality of the WinCC OPC A&E Server, 
2720
HMI device as OPC client, 2694
HMI device as OPC server, 2694
How the WinCC OPC DA Server works, 2709
HTTP connection, 2693
License, 2706
Migrating data types, 130
Mobile Panel, 2693
Multi Panel, 2693
OPC XML DA Server, 2693
Permitted characters in tag names, 2703
Permitted data type, 2702
Principle of operation of the WinCC OPC HDA 
server , 2711
Principle of operation of the WinCC OPC UA 
Server , 2738
Principle of operation of the WinCC OPC XML DA 
server, 2709
Specifications, 2692, 2705

OPC A&E
License, 2706

OPC A&E Server, 2720
Access to logged events, 2733
Mapping rules, 2720
Principle of operation, 2720
ProgID, 2720
Quality codes, 2725
supported specifications, 2720

OPC A&Raw Data, 2725
OPC connection

Creating, 2747
OPC DA

Byte, 1070
License, 2706
VT_EMPTY, 1076
VT_I2, 1072
VT_I4, 1073
VT_R4, 1075
VT_R8, 1075
VT_UI1, 1071
VT_UI2, 1072
VT_UI4, 1074
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OPC DA data type
VT_, 1075
VT_EMPTY, 1076
VT_I1, 1070
VT_I2, 1072
VT_I4, 1073
VT_R8, 1075
VT_UI1, 1071
VT_UI2, 1072
VT_UI4, 1074

OPC DA server, 2709
Creating a connection, 2697
Principle of operation, 2709
ProgID, 2693, 2709
supported specifications, 2709

OPC DA Server
Configuring HMI device as ~, 2696

OPC Gateway
Proxy setting, 2700

OPC HDA
License, 2706

OPC HDA Server, 2711
Assemblies, 2717
Attributes, 2716
Deactivate writing access, 2712
Principle of operation, 2711
ProgID, 2712
Quality codes, 2712, 2725
Supported interfaces, 2718
supported specifications, 2711
Write Accesses, 2712

OPC server
Accessibility, 2693, 2708
License, 2706

OPC UA
 Display of the WinCC tags, 2743
 OPC UA Service Sets , 2741
Conformance units, 2741
Display of the logging tags, 2744
Profile, 2741

OPC UA Data Access, 2744
OPC UA Log Access, 2744
OPC UA Server

Communication profile, 2738
Creating a connection, 2699
Principle of operation, 2738
Security concept, 2739
Security settings, 2740
supported specifications, 2738
URL, 2738
User identification, 2740

OPC XML
"Date/Time" data type, 2703
"STRING" data type, 2703
Configuring server, 2701
Permitted cycle time, 2703

OPC XML DA
Deleting a server, 2701
Editing a server, 2701
License, 2706

OPC XML DA Client, 2693
OPC XML DA Server, 2709

Installing, 2711
Principle of operation, 2709
supported specifications, 2709
URL, 2693, 2710

Open
Global library, 784
Selection list, 2286

Open User Communication
 Changing parameter values, 367
Ability to read back, 367
Connection description, 364
Connection establishment, 352
Connection parameter assignment, 352, 354
Connection parameters, 356
Creating a connection, 359
Deleting an interconnection, 361
General, 351
Instructions, 352
Port numbers, 367
Protocols used, 362
Starting connection parameter assignment, 358
TCON_Param, 364
TSAP, 368

opening
Menus and Toolbars , 960

Opening phone books, 2845
Operability

Dynamization, 741
Operand area, 484
Operate recipe

Change recipe data record, 1525
Operating

Key, 2288
Runtime using the keyboard, 2291
Runtime with mouse, 2293

Operating behavior
Enabling system memory, 518
Using clock memory, 517
Using time-of-day functions, 502
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Operating element
Availability, 826
Availability for Basic Panels, 817
Availability for Comfort Panels, 819
Availability for Mobile Panels, 822
Availability for Multi Panels, 821
Availability for Panels, 818
Availability for WinCC Runtime Advanced, 824
operation, 2285
Recipe view, 1522, 2320

Operating mode
Introduction, 475
RUN, 481
STARTUP, 477
STOP, 481
Transitions, 476

Operating recipes
Change recipe data record, 1525
Copying a recipe data record, 1524
Creating a recipe data record, 1519
Creating recipe data records, 1519, 1520, 1524
Delete recipe data record, 1525
Load recipe data record, 1525
Modifying the recipe structure, 1529, 1554
Read recipe data record, 1520, 1526
Transfer data record, 1521, 1527

Operating system
Access rights, 2255
Asian language setting, 2104
Setting to Western, 2104

operation
Key, 2285
Operating element, 2285

Operation
Alarm indicator, 1388
Alarm view, 1383, 2357
Alarm window, 1383, 2357
Feedback, 2277
Recipe view, 1522, 2320
Simple alarm view, 1386, 2358
Simple recipe view, 1515, 2333
Simple user view, 2298

Operation feedback, 2277
Operation using the keyboard

Alarm view, 1384, 1394
Alarm window, 1384, 1394
Simple alarm view, 1387

Operation using the mouse
Alarm indicator, 1389
Alarm view, 1384, 1394
Alarm window, 1384, 1394
Simple alarm view, 1387

Operation with the keyboard
Recipe view, 1523, 2321

Operation with the mouse
Recipe view, 1523, 2321

Operator control
Alarm view, 2365

Operator input alarm property changed, 1991
Optical feedback, 2278
Option

Installing, 2236
Uninstalling, 2236

Option handling, 437
Options for establishing the connection

S7-1200 CPUs, 2848
S7-300/400 CPUs, 2847

Outgoing, 1245, 1849, 1997
Output (O), 484
Output alarm, 888
Output byte (QB), 484
Output double word (QD), 484
Output fields

Multiplex tag, 41
Output word (QW), 484
Overflow, 554, 1854
Overlay icon, 592
Override function, 947
Overview navigation, 276, 279, 281
Overview of TS Adapters that can be used, 2823
Overview window, 33, 174

Comparing objects, 176
Showing and hiding columns, 177

P
Page

 Deleting report page, 1629
 Sorting report page, 1629
Adding to report, 1629
Maximum number of configurable in report, 1611

Page number
Layout in reports, 1680, 1681

Pane mode, 172
Panel

Display and operating element, 818
Panning, (See move view)
Parallel installation, 59
Parameter

For CPU, 496
Parameter block

Configuring , 1283
Parameter blocks, 1282
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Parameter transfer
User-defined function, 1757

Parameters
Output in analog alarm, 1289
output in discrete alarms, 1293
output in user alarms, 1297

Password, 2294
Backing up, 2295
Changing, 1700
Changing in runtime, 1718
Hierarchy level, 1692
Hierarchy levels, 1690
Password aging, 1691
Password complexity, 1691, 1693
Restoring, 2295
SmartServer, 2483

Password list, 2294
Password protection, 394, 496, 519

Protection concept, 211
Revoking access rights, 212

Pasting
Adjusting screen size, 2149
Color, 2146
Font, 2146
Function key, 2149
Invalid object, 2146
Principle, 2144, 2151

Pause, 2003
PDF file, 2610
Performance features

Engineering system, 2380
HMI device, 2382, 2385, 2389, 2393, 2397, 2401, 
2404
WinCC Runtime, 2401
WinCC Runtime Professional, 2404
WinCC Runtime Professional performance, 2407

Performance in telephone networks, 2820
Permanent window, 646
Permitted characters

User view, 48
Permitted data type

OPC, 2702
SIMATIC HMI HTTP Protocol, 2512

PG/PC interface
Connecting online, 2801
Modifiable MPI interface parameters, 2809
Modifiable PROFIBUS interface parameters, 
2809

Phone book
Printing, 2847

Picture cycle, 1036
Pipe, 908

Pipe bends, 908
Angle, 909
Radius, 909

Play ended, 1989
PLC

Enabling system diagnostics, 2178
Reading recipe data record, 2329, 2330, 2338
System diagnostics view, 2178
Tag, 999
Transferring recipe data record, 2331, 2332, 
2339

PLC data type
+/- Double, 1089
+/- Int, 1091
12-Bit Block, 1098
16 Bit Group, 1092
16-Bit Block, 1099
20-Bit Block, 1099
24-Bit Block, 1100
28-Bit Block, 1101
32-Bit Block, 1101
4-Bit Block, 1096
8-Bit Block, 1097
Byte, 1048
Char, 1049
Counter, 1050
Date, 1050, 1058
DInt, 1051, 1059, 1082, 1102
Double, 1093
DWord, 1052, 1060, 1103
Float, 1094
Int, 1052, 1061, 1083, 1095, 1104
LReal, 1062
Real, 1053, 1063, 1084, 1106
S5Time, 1054
SInt, 1063, 1085
Time, 1055, 1064
Time_of_day, 1056
Time_Of_Day, 1065
Timer, 1056
UDInt, 1065, 1086
UInt, 1066, 1087
USInt, 1067, 1088
Word, 1057, 1069, 1106

PLC tag
reconnecting, 995

PLC tags, 401, 402, 404
PN/PN couplers

Grouping, 470
Linking Ethernet subnets, 470

Point-to-point communication (PtP), 508
Freeport protocol, 509
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Polygon, 897
Configuring corners, 897
Layout, 897
Radii, 897

Polyline, 899
Configuring corners, 899
Line end, 899
Line start, 899
Radii, 899

Port
Renaming, 384
Setting, 2581, 2583

Port numbers, 367
Port options, 464

Enable autonegation, 463
Monitor, 463
Transmission medium/duplex, 463

Portal view, 153
Position

an object , 666
Editing multiple objects, 685, 1649
Of objects, 670, 1644
of objects in the report, 1611

pow function, 1961
Power Management, 2031
Powerpack, 70, 71

Engineering system, 70
Installing, 71
Runtime, 70

Predefined alarm classes, 1247, 1248
Press, 1848, 1991
Press key, 1853, 2007
Press right mouse button, 2003
Print alarm

Configuring print parameters, 2430
Print job

Creating a task for automatic start, 1636
creating for the report, 1633
Print job/Script diagnostics, 838

Print job list, 1630
Print job/Script diagnostics

Function, 838
Print job, 838

Print job/Script diagnostics , 837
Print scope, 214
Print server, 53
Printable contents, 213

Printing
Alarms, 2249
Audit Trail, 2427
Changing the settings, 214
Creating a cover page, 219
Creating borders, 218
Documentation function, 212
Elements in the library, 218
Elements in the project tree, 217
Non-printable contents, 213
Non-printable objects, 214
Print contents, 216
Print server, 53
Printing device view, 281
Printing network view, 281
Process a cover page, 220
Process borders, 220
Report, 1631, 1653, 1654
Runtime, 2249
Screen, 2249
Specify layout, 215
Specify print layout, 215
Specifying the print area, 225
Structure of printout, 213
Use borders, 217
Use borders and cover pages, 213
Use cover page, 216

Printing a project, 230
Printing of alarms

Configuring:printing of alarms, 1306
Printing phone books, 2847
Priority, 1414

Setting, 1288
Process control phase, 2240
Process data area

Module addressing, 488
Module start address, 488

Process image, 489
Basics, 486
I/O access error, 487
Updating, 487

Process value
 display, 1180
Displaying Statistics Function, 2668
Saving to database, 1140
Swapping out, 1142

Process value logging, 1108
Process-controlled tag, 1129
Processing method, 1135

Data log, 1134
Product support, 288

Enabling, 288
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PROFIBUS, 324
Connection with PROFINET, 443
ET 200S in DPV1 mode, 439

PROFIBUS cable configuration
Optical ring, 326

PROFIBUS DP, 423
PROFIBUS profile, 324

Different profiles on the same subnet, 324
Effect on the transmission rate, 324
Meaning of profiles, 325

Profile, (See bus profile)
PROFINET

Connection with PROFIBUS, 443
Device replacement without exchangeable 
medium, 466

PROFINET device name, 452
PROFINET interface, 496, 598
PROFINET IO, 442, 447, 448, 456, 458

Port options, 463
PROFINET IO device

Assigning a name, 613
Name assignment from the project tree, 614
Name assignment from within the project context, 
614
Name assignment via the "Online" menu, 614

PROFINET IO system, 457
PROFINET RT class, 443
PROFIsafe address, 2031
ProgID

OPC A&E Server, 2720
OPC DA server, 2709
OPC HDA Server, 2712
OPC XML DA Server, 2710

Program editor
General settings, 149, 151, 152

Program execution
Cyclic, 521

Project, 2223
Activating, 2221, 2274, 2547
Basics, 191
Closing, 195
Comparing data, 210
compile (overview), 2186, 2206
Compiling , 2188, 2208
Compiling project data, 204
Creating, 192
Deactivating, 2548
Deleting, 195
Download, 2190, 2211, 2241
download (overview), 2186, 2206
Include in user group, 2257
Migrating, 95, 122
multilingual, 2108
Opening, 192
Operating with WinCC WebNavigator client, 2595
Saving, 194
Showing properties, 194
Simulation with a tag simulator, 2200

Project data
Compiling, 204
Downloading to a memory card, 208
Export alarm, 2069
Export text list, 2091
Exporting a recipe, 2063, 2066
Exporting tag, 2084
Importing alarms, 2070, 2072
Information on compiling, 203
Information on loading, 205
Loading, 206
Loading to an accessible device, 207
Uploading from a device, 209

Project language, 2102
Activate, 2106
Disabling, 2106

Project languages
Changing the editing language, 198
Specifying project languages, 198
System texts, 196, 2109
Use, 196
User texts, 196, 2109
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Project library, 33, 773
Adding a copy template, 249
Adding types, 249
Basics, 248
Creating folders, 248
Editing elements, 253
Migrating, 116
Removing elements, 255
Using filter view, 255, 270
Using master copies, 251
Using the element and part views, 247
Using types, 252

Project text
Exporting, 2096, 2113

Project texts
Application example, 202
Compiling project texts, 199
Displaying reference text, 199, 2112
Exporting all texts, 201
Exporting individual texts, 201
Importing, 202, 2095, 2115
Migrating, 114
Translating individual texts, 803, 2110
Translation into project languages, 196, 2109

Project tree
Adding device, 300
Function, 157
Keyboard shortcuts, 179
Reducing automatically, 163

Project view, 155
Project-wide alarm class

Create, 1265
Use, 1265

Properties
"Local scripts" editor, 1784

Properties (CPU), 496
Property animation

Expression, 747
Quality Code, 747, 757
Section type, 746
Type, 746
Type binary, 746
Type bit, 746
Type Bool, 747
Type direct, 747

Property changed, 1992, 1999, 2000
Property list

Dynamize, 732
ProSave, 2227

Installation, 47

Protection concept
Introduction, 211
Revoking access rights, 212

Protection level, 519
Revoking access rights, 212

Pulse stretching, 557
putc function, 1964

Q
Q address, 388
qsort function, 1965
Quality Code

Dynamize, 747, 757
Quality codes, 2712, 2725

R
R, 324
Racks, 294

Inserting a module, 303
Radius, 869, 897, 899

Circle segment, 871
Circular arc, 870

rand function, 1964
Range (... - ...)

Graphics list, 723, 725
Text list, 714

Raw data tag, 1129, 1573
Acknowledgement Data, 1573
Acknowledgement header structure, 1572
Acknowledgment message frame, 1572
Communication between the recipe and the PLC, 
1543
Structure of job header, 1571
Structure of the message frame header, 1570

Raw Data Tag
for BSEND/BRCV functions, 1575

Raw data tags, 1569
Raw data type, 1129
Read continuously

Tag, 1012
Reading out

Recipe data record, 2338
Reading out a diagnostics buffer, 603
Reading tags, 402
Read-only, 519
Real, 1053, 1063, 1084, 1106
realloc function, 1965
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Recipe, 1472, 1474, 1475, 1538, 1539, 2069, 2313
Application example: Machine parameter 
assignment, 1474
Application example:Batch production, 1474
Basics, 1472, 1474, 1539
Communication by means of control tags, 1543
Configuration option, 1481
Control, 2314
Creating new, 1500, 1548
Data flow, 2315
Data Flow, 1478
Data record, 1475, 1540, 2313
Differences in TP 177A and OP 77A, 1483
Display in I/O fields, 1559
Display in Runtime, 1542
Element, 1540
Entry, 1475
Example, 1540
Exporting, 1528, 2063, 2066
GMP settings, 2444
Importing, 1528, 2065, 2067
Load, 1547
Memory requirements, 2410, 2411
Principles, 1538
Raw data communication, 1543
Raw data tag communication type, 1566
Recipe screen, 1487, 2316
Recipe view, 1487, 2316
Synchronizing recipe tag, 1525
Synchronizing tags, 2327, 2328
Table view in Runtime, 1558
Tags communication type, 1565
Use, 1474, 1538
Use of text lists, 1487

Recipe data
in reports, 1620
Migration, 117

Recipe data record
change, 1525
Copy, 1524
Create on the HMI device, 1519, 1520, 1524
Creating, 2335
Creating new, 1500, 1548
Creating on the HMI device, 1519
Creating, key operation, 2321
Creating, keyboard operation, 2322
Creating, mouse operation, 2322
Creating, touch operation, 2321
Delete, key operation, 2326
Delete, keyboard operation, 2326
Delete, mouse operation, 2326
Deleting, 1525, 2337
Deleting, touch operation, 2326
Editing, 2336
Editing, key operation, 2324
Editing, keyboard operation, 2325
Editing, mouse operation, 2325
Editing, touch operation, 2324
Exporting, 1528, 2340
Importing, 1528, 2340
Importing and exporting, 1480
load, 1525
Reading from PLC, 2329, 2330, 2338
Reading, key operation, 2329
Reading, keyboard operation, 2330
Reading, mouse operation, 2330
Reading, touch operation, 2329
Synchronize with PLC, 2336
Synchronizing, 1525
Synchronizing, key operation, 2327
Synchronizing, keyboard operation, 2328
Synchronizing, mouse operation, 2328
Synchronizing, touch operation, 2327
Transfer option, 1478
Transfer, key operation, 2331
Transfer, keyboard operation, 2332
Transfer, mouse operation, 2332
Transfer, touch operation, 2331
Transferring the project, 52
Transferring to PLC, 2331, 2332, 2339
Use of text lists, 1487

Recipe data record change
Effects in Runtime, 2444

Recipe data record name
Writing to a tag, 1490, 1494

Recipe data record number
Writing to a tag, 1490, 1494

Recipe element
Creating new, 1500, 1548
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Recipe list, 1488, 2317
Recipe name

Writing to a tag, 1490, 1494
Recipe number

Writing to a tag, 1490, 1494
Recipe report

application in reports, 1679
Recipe screen, 1498, 2318

Automatic transfer, 1498
Configuring, 1511
Overview, 2318
Recipe tag, 1477
Synchronizing recipe value, 1498
Visual machine simulation, 1497

Recipe tag
Offline, 2319
Online, 2319
Synchronizing, 1481, 1525, 2319
Teach-in mode, 1482

Recipe value, 1498
Automatic transfer in the recipe screen, 1498
Synchronizing in the recipe screen, 1498

Recipe view, 901, 904, 1488, 1492, 1521, 1542, 
1558, 2316, 2320

 Configuring the export of Runtime data, 1197, 
1207, 1214
 Online configuration, 1197, 1208, 1215
 Toolbar, 1195, 1206, 1211
Advanced recipe view, 902
Application, 1521
Behavior with screen change, 1495
Buttons, 1580, 2342
Configurable events, 1490, 1495
Configuring, 1507, 1510, 1561
Control element, 903, 904
Display number, 903
Displaying one recipe only, 1494
Displaying values only, 1490
Dynamic properties, 1491
Edit data, 1589, 2351
Expanded, 1492, 2316
Layout, 904
Operating element, 1522, 2320
Operation, 1522, 2320
Operation using the function key, 1495
Operation with the keyboard, 1523, 2321
Operation with the mouse, 1523, 2321
Recipe data record, 1476, 1477, 1496
Simple, 1488, 2317
Simple recipe view, 902
Status bar, 1580, 2342
Toolbar, 1580, 2342
Updating, 1489, 1493
Use, 2320
UserArchiveControl, 1583, 2345
Using as a drop-down list, 1494

Recipes
 Export CSV file from ES, 1514, 1554
Acknowledgement data for the raw data tag, 
1573
Acknowledgment message frame structure for raw 
data tag , 1572
Communication via raw data tags, 1570, 1572
Import CSV file into ES, 1513, 1552
Job types and error codes for raw data 
communication, 1577
Message frame structure for raw data tags , 1570
Structure of acknowledgement header for raw 
data tag, 1572
Structure of job header for raw data tag, 1571
Structure of message frame header for raw data 
tag, 1570

Recommissioning
HMI device, 2241
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Reconnecting
Tag, 995

Reconnecting a PLC tag, 995
Recording a log file for the modem, 2855
Rectangle

Configuring, 707
Inserting, 706
Inserting and configuring, 705
Radius corners X, 901
Radius corners Y, 901

Redoing actions
Basics of redoing actions, 231
Redoing actions, 234

Reference junction, 433, 539, 554
Reference language, 2102

Selecting, 2106
Reference object

Defining, 673, 1648
Referencing

Object, 1764
release, 1851, 2001
Release right mouse button, 2004
Reloading

Alarms, 1378
Remote configuration, 2544

Activating a project, 2547
Deactivating a project, 2548

Remote connection cannot be established, 2842
Remote connection from the TS Adapter is not 
established, 2857
Remote connection to the TS Adapter is not 
established, 2856
Remote control

By means of Internet Explorer, 2485
By means of SmartClient application, 2485
Configure SmartClient, 2477
Configure SmartServer, 2474
Devices with  keys, 2481
Direct keys, 2489
Monitoring mode, 2473
Session Management, 2473
Smart Options, 2484
SmartClient display, 2488

Remote monitoring
Smart Options, 2484

Remote system access to a programming device/
personal computer, 2848
Remove

Object from the group, 697
remove function, 1964

Removing, 63
Add-on, 63
Folder link, 690
Formatting in the alarm text, 1276

Rename
Customized VB function, 1769
Screen, 639
Tag, 991
Template, 646
user-defined C function, 1778

rename function, 1964
Replacing

Module, 308
Replacing devices

Function key, 2134
K-key, 2135
Limitations on connections, 2130
Principle, 2130

Replay, 2009
Report

Adding a detail page, 1629
Back page, 1605, 1608
Create a print job, 1633
Creating, 1616
creating (overview), 1610, 1612
Creating a task for the automatic start of a print 
job, 1636
Deleting page, 1629
Detail page, 1606, 1608
Event-driven output, 1630
Footer, 1606, 1608
Header, 1606, 1608
Maximum configurable number of pages, 1611, 
1615
Objects with dynamic length, 1614
Position of objects, 1613
print, 1631
printing, 1653
Printing, 1654
Showing and hiding sections, 1630
Size and position of objects, 1611
Size of objects, 1613
Sorting pages, 1629
Steps for configuring report output in Runtime 
(Advanced), 1631
Steps for configuring report output in Runtime 
Professional, 1632
Time-driven output, 1630
Title page, 1605, 1608
Title page and back page, 1615
Watermarks, 1608
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Report name
Use in reports, 1677

Report objects
in reports, 1621

Report System Errors, (See System diagnostics)
Created error OBs, 567

Reporting
Audit Trail, 2427
enabling, 1341

ReportJob, 1891
Reports, 2610, 2685, 2687, 2689

 CSV provider trends , 1659
 ODBC database field, 1673
 ODBC database table, 1674
 Recipe report , 1679
Alarm report , 1671
Alarm sequence report, 1622
As e-mail, 2685
Data output in tabular format, 1619
Data output in trends, 1619
Date/time field, 1661, 1662
Elements, 1618
Excel workbook, 2687
Graphic I/O field, 1668
Hardcopy, 1669
I/O field, 1663
Output of a Runtime snapshot, 1620
Output of alarms, 1620
Output of external data via ODBC interface, 1621
Output of recipe data, 1620
Page number, 1680, 1681
PDF file, 2610
PDF Report, 2685
Print job, 2689
Project name, 1676
Report name, 1677
Report objects, 1621
Settings, 2685
Symbolic I/O field, 1682
XLS file, 2610

Requirement
Hardware, 2553
Installation, 2553
Operating system, 2553
Software, 2553

Requirements for establishing a remote connection, 
2841
Requirements for sending an SMS, 2852
Requirements for sending e-mails, 2853

Required communication instructions, 2854
Reset to factory settings, 2231
ResetBit, 1892

ResetBitInTag, 1892
Resetting

Acknowledgment bit, 1464
HMI device to factory settings, 2232

Resetting the MPI/PROFIBUS settings, 2816
Resetting the TCP/IP settings, 2808
Resizing

Faceplate, 806
Resource

SIMATIC S7 1200, 44
Response to resizing

Faceplate type, 806
Restore process

Authorization, 66
License key, 67
License Key, 66

Restoring, 2295
Data of the HMI device, 2228, 2230, 2254

Restoring data
HMI device, 2228, 2230, 2254

Restrictions due to user rights, 181, 182
Recognizing, 181

Retentivity, 486
rewind function, 1964
RFID tag, 2013
Rights

Access rights, 2611
Access rights to directories, 2636
User Rights, 2611

Rotate, 924
Object, 666, 680

Rotation, 680
T piece, 937

Router, 2546
RS-232/PIP multi-master cable, 513
RT class, 443
RulerControl, 940

Online configuration, 1564
Runtime data, 1563

Rules for configuring MPI networks
Rules for assigning the MPI address, 320

Rules for network configuration for PROFIBUS 
networks

Assigning device addresses, 320, 321
RUN, 481
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Runtime, 2019, 2021, 2217, 2267, 2533, 2534
 configuring in Runtime, (See Online 
Configuration)
Alarms, 2533
Buttons, 1580, 2342
Changing object property, 1811
Displaying logged alarms, 1400, 2371
Effective range, 2019
Effective range (RFID), 2021
Emergency acknowledgement of alarms, 1408, 
2378
Executing user-defined functions, 1807
Execution of the function list, 1808
Filtering alarms, 1396, 2367
Graphics, 2533
Language switching, 1811
Logs, 2533
Mouse wheel, 49
Multiple-station system, 2221, 2274
Operation with the keyboard, 2291
Operation with the mouse, 2293
Reaction to system errors, 2533
Redundant system, 2221, 2274
Reports, 2533
Requirements, 2221, 2274
Response to system errors, 2534
Scripts, 2533, 2534
Sorting alarms, 1397, 2368
Start screen, 640
Starting, 2221, 2274
starting on a panel, 2198, 2252
starting on PC, 2198, 2252
System characteristics, 2533
Text library, 2533
User administration, 2533

Runtime data
Migration, 117

Runtime error, 1787, 1794, 2205, 2226
Runtime language, 2102, 2120

Font, 2125
Log, 1124, 1367, 2126
Order for language switching, 2123
Selecting, 2121

Runtime Professional
Defining hotkeys, 2263
Language settings, 2260
Setting up the cursor control, 2264
Setting up the startup list, 2258
Setting up the zoom functions, 2261

Runtime screen
in reports, 1620

Runtime scripting, 1740
Functions, 1740
Local script, 1740
System functions, 1740
User-defined functions, 1740

Runtime settings, 2458
Dynamic logon, 1694
User administration, 1689, 1691, 1694

Runtime Stop, 1853, 2004
Runtimes

Differences, 2150

S
S5Time, 1054
S7 1200

Byte, 1065
Date, 1058
DInt, 1059
DWord, 1060
Int, 1061
LReal, 1062
Real, 1063
SInt, 1063
Time, 1064
UDInt, 1065
UInt, 1066
USInt, 1067
Word, 1069

S7 300/400
Byte, 1048, 1056
Char, 1049
Counter, 1050
Date, 1050
DInt, 1051
DWord, 1052
Int, 1052
Real, 1053
S5Time, 1054
Time, 1055
Timer, 1056
Word, 1057

S7 connection, 330
TSAP, 341

S7 CPU
 Work memory, 484
Load memory, 484
Operand area, 484

S7 diagnostic alarm
enabling, 1281

S7 diagnostic alarms, 1244
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S7 Protocol Suite
Raw data tag, 1573
Raw data tag for BSEND/BRCV functions, 1575

S7-PCT, 472
Safety, 2255
Safety guidelines, 189
Safety instruction

Changing the recipe data record in the 
background, 1489
Direct key, 2278
Recipe data record in background, 1493, 2317
Renamed tag, 2327
Switching infotext, 2284, 2291

Save
Global library, 783

Scaling
Applying linear scaling to a tag, 1000, 1001

Scheduler, 2032
Acyclic triggers, 2036, 2043
Administer task, 2047
Cyclic triggers, 2036, 2052, 2055, 2058
Deactivated task, 2035
Event trigger, 2035, 2036, 2046, 2054
Function list, 2038
Print report, 2055
Tag triggers, 2037
Timers for cyclic and acyclic triggers, 2037
Triggers, 2035, 2036
Work area, 2034

Screen
Availability for specific devices, 632
Configuring, 2573
Copy, 639
Copying, 2149
Create, 638
Creating, 638
Define customized menu, 967
Define customized toolbars, 967
Deleting, 639
Font, 633
Inserting, 639
Move, 639
Preview, 2573, 2574, 2613, 2614
Printing, 2249
Rename, 639
Use template, 648
Web access, 2573, 2612
Working steps in creating, 637
Zooming, 635

Screen change, 1847
Displaying the screen on entering a zone, 2022

Screen designs, 648

Screen keyboard, 2279
Alphanumerical, 2282
Keyboard level, 2283
Language behavior, 48
Language change, 2283
Numerical, 2280

Screen object
Dynamic movement, 738
Dynamization of the control enable state, 741

Screen saver, 26
Screen selection

Setting up, 2264
Screen window

Configuring a menu, 968
Configuring a toolbar, 968

Screens
 Applying a design, 653
Designs, 648

Script
Migrating, 113
Print job/Script diagnostics, 838
Updating tag value, 979

Scrolling back key, 2285
Scrolling up key, 2285
SD card

Open force job, 26
Search

Hardware catalog, 293
Security settings

Internet Explorer, 2626
Security system, 2294
Segment, 1140
Segment diagnostics

Graphic display, 622
Icons, 621
Text display, 622

Segmented circular log, 1354
Segments

Define for log, 1155
Select

Multiple objects, 672, 1648
Selecting

Multiple objects, 666
Selection

Selection dialog box, 1587, 2349
Selection changed, 1846, 1990
Selection list

Open, 2286
Send clock cycle, 460, 461
Sequence of columns, 922
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Server
Activating a project from client, 2547
Deactivating a project from client, 2548
Shutdown, 2535
Startup, 2535

Service & Support, 288
Enabling, 288

Service-pages, 2500
Create own , 2508
Display, 2504
remote control, 2504
Transfer, 2509

Session
Closing, 2630

Session Management, 2473
Setting, 2474

Set the services 
SmartClient, 2458
SmartServer, 2458

Set up
Sort, 891

SetBit, 1893
SetBitInTag, 1894
setbuf function, 1964
SetLanguage, 1895
SetPropBOOL, 1896
SetPropChar, 1897
SetPropDouble, 1897
SetPropertyByConstant, 1899
SetPropertyByProperty, 1900
SetPropertyByTag, 1901
SetPropertyByTagIndirect, 1901
SetPropLong, 1898
SetTag, 1912
SetTagBit, 1902
SetTagBitState, 1905
SetTagBitStateWait, 1907
SetTagBitWait, 1910
SetTagByProperty, 1913
SetTagByte, 1902
SetTagByteState, 1905
SetTagByteStateWait, 1907
SetTagByteWait, 1910
SetTagChar, 1902
SetTagCharState, 1905
SetTagCharStateWait, 1907
SetTagCharWait, 1910
SetTagDouble, 1902
SetTagDoubleState, 1905
SetTagDoubleStateWait, 1907
SetTagDoubleWait, 1911
SetTagDWord, 1902

SetTagDWordState, 1905
SetTagDWordStateWait, 1907
SetTagDWordWait, 1911
SetTagFloat, 1902
SetTagFloatState, 1905
SetTagFloatStateWait, 1907
SetTagFloatWait, 1911
SetTagIndirect, 1914
SetTagIndirectByProperty, 1913, 1915
SetTagIndirectByTagIndirect, 1915
SetTagIndirectWithOperatorInputAlarm, 1916, 1917
SetTagMultiStateWait, 1904
SetTagMultiWait, 1904
SetTagRaw, 1902
SetTagRawState, 1905
SetTagRawStateWait, 1907
SetTagRawWait, 1911
SetTagSByte, 1902
SetTagSByteState, 1906
SetTagSByteStateWait, 1907
SetTagSByteWait, 1911
SetTagSDWord, 1902
SetTagSDWordState, 1906
SetTagSDWordStateWait, 1907
SetTagSDWordWait, 1911
SetTagSWord, 1902
SetTagSWordState, 1906
SetTagSWordStateWait, 1908
SetTagSWordWait, 1911
SetTagValue , 1909
SetTagValueWait, 1909
SetTagWord, 1902
SetTagWordState, 1906
SetTagWordStateWait, 1908
SetTagWordWait, 1911
Setting

Deadband, 1272, 1288
Delay time, 1272, 1287
Language, 2293
Languages in the operating system, 2103
Priority, 1288
Time base, 890

Setting AS-i network configuration parameters, 329
Setting at the HMI-device

E-Mail, 2461
HTTP server, 2463, 2513
SmartServer, 2464
Web authorization, 2463
Web server, 2463

Setting language, 2293
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Setting parameters for the Ethernet interface, 2806
Adding a dynamic IP address, 2807
Connecting to a subnet, 2806
Deleting dynamic IP addresses, 2808
Modifiable parameters, 2804
Options in the parameter settings, 2804

Setting the communication load, 327
Setting up

DCOM user rights, 2696, 2748
Setting up DCOM user rights, 2696, 2748
Settings

Changing, 153
General, 149, 151, 152

Settings for the PG/PC interface, 2803
Automatic bus parameter detection, 2810
Setting parameters for the MPI interface, 2810
Setting parameters for the PROFIBUS interface, 
2812

SetValue, 2521
setvbuf function, 1964
Share, 2255
SHIFT

Key, 2286
Shortcut menu, 1999
Short-term archive list, 1399, 2370
Show

Limit lines on the bar, 828
Showing

Report sections, 1630
Shutdown, 2536

Of the client, 2536
Of the server, 2535

Shutting down, 2535, 2536
Of the client, 2536
Of the server, 2535

Shutting down Windows XP, 26
Signal board, 392

Inserting, 392
Signal quality

Calculating the effective range, 947
signature

electronic, 2414
Signing the log backup file, 1159, 1372
SIMATIC

Differences in data format from Microsoft, 1578
SIMATIC 500/505 DP

Migrating data types, 131
SIMATIC 500/505 serial

Migrating data types, 131
SIMATIC HMI, 2256, 2257

User group, 2255

SIMATIC HMI HTTP Protocol
Configuring HTTP clients, 2515
Configuring the connection, 2515
Migrating data types, 132
Permitted data type, 2512

SIMATIC Logon, 1705
SIMATIC S5 AS511

Migrating data types, 132
SIMATIC S5 DP

Migrating data types, 133
SIMATIC Shell, 2544, 2546
SIMATIC Logon, 1694
SIMATIC S7 1200

Connection resource, 44
Resource, 44

SIMATIC S7 200
Migrating data types, 134

SIMATIC S7 300/400
Migrating data types, 134

simple alarm view, 2358
Use, 2358

Simple alarm view, 1385
Application, 1385
Control element, 1386, 2359
Operation, 1386, 2358
Operation using the keyboard, 1387
Operation using the mouse, 1387

Simple Alarm view, 882
simple alarm window

Application, 1385
Use, 2358

Simple recipe view, 902, 1488, 2317
Behavior, 1516, 2334
Configuring, 902
Constraints, 1492
Layout, 1515, 2333
Menu command, 1516, 2333, 2334
Operation, 1515, 2333

Simple user view, 2297
Configuring, 831
Layout, 2297
Operation, 2298
Use, 2297

Simulate hardware, 272
Simulate modules, 272
Simulate software, 272
Simulating, 2223

Define temporary start screen, 2202, 2224
Project with tag simulator, 2200

Simulating devices, 272
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Simulation, 52
PLC connection, 52
Project:simulate, 2223

Simulation data, 2224
sin function, 1961
Single alarm

Filtering, 1396, 2367
Hiding alarms, 1350

sinh function, 1961
SInt, 1063, 1085
Size

An object, 666
Editing multiple objects, 685, 1649
of objects in the report, 1611

Slider, 912
Display bar, 913
Display current value, 913
Maximum value, 913
Minimum value, 913

Slot
Racks, 294
Select, 296

Slot rules, 292
ET 200S, 432

Sm@rtClient view, 917
Shared use, 918
View only, 918

Smart Options, 2484
HMI devices suitable for use, 2457
Remote control, 2484
Remote control by means of Internet Explorer, 
2485
Remote monitoring, 2484

SmartAccess
Distributed operator stations, 2492
Editing tag values in MS Excel, 2521

SmartClient
Monitoring mode, 2477
Password input, 2489
SmartClient display, 2477

SmartClient display, 2488
SmartServer

As a service, 2476
Control mode, 2474
Forced access, 2476
Hardware acceleration, 2482
Local operator control, 2476
Monitoring mode, 2474
Password, 2483
Password input, 2489
Setting at the HMI-device, 2464

SmartService
E-mail notification, 2495
Input area plan, 2461
Remote control by means of the SmartClient 
application, 2485

Smoothing, 553
SOAP

Access from Excel, 2520
GetValue, 2521
SetValue, 2521
Windows CE, 2520

Software
Requirement, 2553

Software requirements at the plant end
Communication instruction "AS_MAIL", 2853
Communication instruction "SMS_SEND", 2853
Communications instruction "PG_DIAL", 2849

Software requirements for AS-AS remote link
Communication instruction "AS_DIAL", 2852

Software requirements for the programming device/
personal computer

Communications instruction "PG_DIAL", 2850
Software-controlled data flow control, 512
Sort

Set up, 891
Sort order

Sorting dialog, 1589, 2351
Sorting

 Report page, 1629
Sorting alarms, 1397, 2368
Special characters

Alarm text, 41
Special tag (web server), 405
Specific .Net control

Add, 687
Remove, 688

SQL, 1600
SQL statements for filtering alarms, 1417
sqrt function, 1961
srand function, 1964
Stamping, 683, 1643
Standard device, 467
Standard slave, 441
Standard Web site, 2581, 2583
Standby Mode, 26
Standby module

Substitute value, 438
Start

Logging, 1127
Start address, 388, 488
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Start angle
Circular arc, 870
Ellipse segment, 845
Elliptical arc, 844

Start Angle
Circle segment, 871

Start screen, 640, 954
Start the online and diagnostics view, 594
Start the simulation, 272
Start value

Tag, 998
Start value of danger range

Gauge, 950
Start value of warning range

Gauge, 950
Starting

Debugger, 1793, 2206
Runtime at Engineering Station, 2197, 2220, 
2251, 2274
Runtime on a panel, 2198, 2252
Runtime on PC, 2198, 2252
Runtime on the configuration PC, 2197, 2220, 
2251, 2274

Starting point
Defining, 1039

Starting point of logging, 1134
Starting removal, 81
Starting the migration tool, 88
Starting the topology view, 374
StartProgram, 1917
Startup, 2535, 2536

Of the client, 2536
Of the server, 2535
Organization blocks, 520

STARTUP
Function, 477
STARTUP activities, 479

Start-up behavior, 2536
Start-up characteristics, 2535

Of the client, 2536
Of the server, 2535

Startup language
determine:Startup language, 1124, 1368

Startup list, 2258
Setting up, 2258

Startup OB
Description, 520

Start-up parameters, 480
Startup program, 520
Startup type, 496
Static time range, 1185

Station
Copying, 306
Deleting, 305
Moving, 308
Renaming, 384

Station name, (See device name)
Statistics area column name property changed, 
1994
Statistics function

Displaying for process values, 2668
Status

Module defective, 603
Status bar, 890, 1195, 1206, 1211, 2366

Recipe view, 1580, 2342
Table view, 1233
Trend view, 1233

Status bar element property changed, 1994
Status changed, 2006
Status display

Channel diagnostics, 865
Status of the online connection, 618
Status tag, 1256

Alarm group, 1320
Status/Force

Button, 922
Column header, 922
Control element, 921
Sequence of columns, 922
Visible column, 922
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stdio functions
clearerr function, 1964
fclose function, 1963
feof function, 1963
ferror function, 1963
fflush function, 1963
fgetc function, 1963
fgetpos function, 1963
fgets function, 1963
fopen function, 1963
fputc function, 1963
fputs function, 1963
fread function, 1964
freopen function, 1963
fseek function, 1963
fsetpos function, 1964
ftell function, 1964
fwrite function, 1964
getc function, 1964
putc function, 1964
remove function, 1964
rename function, 1964
rewind function, 1964
setbuf function, 1964
setvbuf function, 1964
tmpfile function, 1963
tmpnam function, 1963
ungetc function, 1964
vfprintf function, 1964
vsprintf function, 1964

stdlib functions
abort function, 1965
abs function, 1964
atof function, 1964
atoi function, 1964
atol function, 1964
bsearch function, 1965
calloc function, 1965
div function, 1964
exit function, 1965
free function, 1965
getenv function, 1964
labs function, 1964
ldiv function, 1964
malloc function, 1965
qsort function, 1965
rand function, 1964
realloc function, 1965
srand function, 1964
strtod function, 1964
strtol function, 1965
strtoul function, 1965
system function, 1965

StepBack, 2005
StepForward, 2005
STOP, 481
Stopping

Debugger, 1793
StopRuntime, 1918
Storage location, 1355

Audit Trail, 2437
Storing

External graphic, 690
strcat function, 1965
strchr function, 1965
strcmp function, 1965
strcpy function, 1965
strcspn function, 1965
strerror function, 1965
strftime function, 1966
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String functions
strcat function, 1965
strchr function, 1965
strcmp function, 1965
strcpy function, 1965
strcspn function, 1965
strerror function, 1965
strlen function, 1965
strncat function, 1965
strncmp function, 1965
strncpy function, 1965
strpbrk function, 1965
strrchr function, 1965
strspn function, 1965
strstr function, 1965
strtok function, 1965

strlen function, 1965
strncat function, 1965
strncmp function, 1965
strncpy function, 1965
strpbrk function, 1965
strrchr function, 1965
strspn function, 1965
strstr function, 1965
strtod function, 1964
strtok function, 1965
strtol function, 1965
strtoul function, 1965
Structure

of the cross-reference list, 2099
Structure of the phone book, 2844
Subdivision

Trend view, 1192
Subnet mask, 448
Substitute value, 1013

Defining, 1013
Standby module, 438

Supported telephone networks and modems, 2819
Restrictions, 2819

Swapping, 1372
Alarm log, 1372
Signing off alarm log, 1372

Swapping out, 1142
of process values, 1142

Swapping out of process values, 1142
Switch, 909

Type, 910
Switch off, 1855
Switch on, 1855
Switching operating mode, 608
Switchover time, 514
Switchport, 464

Symbol
Alarm classes, 1308

Symbol library, 923
Fill style, 924
Fixed aspect ratio, 925
Flip, 924
OP 177B mono, 924
Rotate, 924
TP 177B mono, 924

Symbolic addressing
of a tag, 981

Symbolic I/O field, 925, 926
 application in reports, 1682
Mode, 925, 927
Text list, 717, 926, 927

Sync domain, 465
Synchronization (custom web pages), 398
Synchronizing

Object in user-defined functions, 1754
Recipe data record, 1525
Recipe tag, 1481, 2319, 2327, 2328
Recipe view and recipe screen, 1477
Tag in user-defined functions, 1754

Syntax for AWP commands, 401
Syntax highlighting

Customized function, 1755
System alarm, 1243

Meaning, 1419, 1421, 1429, 1434, 1437, 1449
System block, 1414

Configuring, 1283
System blocks, 1282
System characteristics, 2533
System diagnostics, 2175

Created blocks, 566
General settings, 576
Graphic I/O field, 2183
Introduction, 564
Send alarms, 576
Settings for "PLC in STOP", 579
Settings for configuring alarms, 577
Settings in the PLC, 2178
System diagnostics view, 2175
System diagnostics window, 2175, 2182

System diagnostics display
Details view, 928
Device view, 928
Icon, 929
Matrix view, 928
System diagnostics indicator, 2180
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System diagnostics indicator
Configuring a graphic I/O field as system 
diagnostics indicator , 2183
Inserting, 2180
System diagnostics window, 2180

System diagnostics view, 2175
Configuring, 2185
Settings in the PLC, 2178

System diagnostics window, 2175, 2182
Configuring, 2182

System error, 2534
System errors, 2533
System event, 1238, 1239, 1241, 1244

Editing, 1279, 1299
Meaning, 1420, 1422, 1425, 1428, 1429, 1430, 
1431, 1433, 1434, 1435, 1437, 1438, 1439, 1441, 
1442, 1444, 1445, 1450
Parameters, 1419

System events
Configuring, 1260, 1261

system function, 1965
System function, 1740

Application, 1743, 1744
HMI device dependency, 1756
In function list, 1743
in user-defined functions, 1743, 1807
Language dependency in function lists, 1744
NotifyUserAction, 2447
Sequence is not adhered to, 1809

System functions
 ActivateScreenInScreenWindow, 1858
ActivateScreen, 1857
DecreaseTag, 1860
IncreaseTag, 1885
InvertBit, 1888
InvertBitInTag, 1889
InvertLinearScaling, 1887
LinearScaling, 1890
ResetBit, 1892
ResetBitInTag, 1892
SetBit, 1893
SetBitInTag, 1894
SetPropertyByConstant, 1899
SetPropertyByProperty, 1900
SetPropertyByTag, 1901
SetPropertyByTagIndirect, 1901
SetTag, 1912
SetTagByProperty, 1913
SetTagIndirect, 1914
SetTagIndirectByProperty, 1913, 1915
SetTagIndirectByTagIndirect, 1915
SetTagIndirectWithOperatorInputAlarm, 1916
SetTagWithOperatorInputAlarm, 1917
StopRuntime, 1918

System limits
HMI device, 2382, 2385, 2389, 2393, 2397

System memory, 496, 518
Diagnostics buffer, 488, 615
Operand areas, 484
process image input/output, 486

System print job
Changing, 1638
Deleting, 1639

System report
Changing, 1638
Deleting, 1639

System response, 2534
System status, 1329, 1466
System-defined controller alarm, 1244
System-defined controller alarms, 1239, 1241
System-defined text lists

Editing, 240
Modifying texts, 240

System-relevant information
Module information, 596
Vendor information, 596

T
T piece, 937

Rotation, 937
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TAB key, 2285
Table

 Table view, (See table view)
Configuring table elements, 1202, 1213

Table column
Configuring the sorting, 1204, 1214

Table view, 933, 1180
 Configuring the export of Runtime data, 1197, 
1207, 1214
 Online configuration, 1197, 1208, 1215
 Status bar, 1195, 1206, 1211
 Toolbar, 1188
Buttons, 1217
Changing the data connection in Runtime, 1227
Changing the time range in Runtime, 1228
Configuring, 1199
Configuring a data source, 934
Configuring selection, 1203
Configuring the data source, 1194, 1204
Configuring the value column, 1201
Editing the table field in Runtime, 1229
Elements of the status bar, 1233
Hide column in Runtime, 1227
Hide columns in Runtime, 1230
Move columns in Runtime, 1230
Online configuration, 1230
Opening the configuration dialog in Runtime, 
1227
operation in Runtime, 1217, 1219
Scrolling through archived data, 1232
Show column in Runtime, 1227
Show columns in Runtime, 1230
Toolbar, 935, 1217

Tables
in reports, 1619

Tag, 1129
absolute addressing, 980
Access in user-defined function, 1758
Access the local script, 1758
Acquisition cycle, 1011, 1012, 1034
Acquisition mode, 1011
Addressing, 984
Changing the PLC, 999
Coding, 1041
Comment, 986
Configuration, 992
Configuring several tags, 992
Connection to PLC, 984
Copy, 991
Creating external tags, 984
Creating internal tags, 986
Creating the user data type, 1025
Data log, 1111, 1117
Data type, 986, 988, 1077, 1078, 1079, 1080, 
1081, 1082
Defining a substitute value, 1013
Defining acquisition cycle, 1015
Deleting, 991
Displaying values, 1169
Event, 1010
Exporting, 2084
external, 1129
External tag, 978, 979
Faceplate type, 812
GMP settings, 2440
GMP-relevant tag, 2440
Handwheel, 858
Illuminated pushbutton, 875
Importing, 2086
in Runtime, 1011
Index tag, 1009
Indirect addressing, 1009, 1016, 1017
internal, 1129
Internal tag, 982, 983
Key switch , 914
Length, 986
Limit value, 996
Limit values, 996
Linear scaling, 1000, 1001
Local, 1760
Logging, 1111, 1117
Logging cycle, 1034, 1036
Maximum length, 49
Multiplexing, 1009
Name, 986
Object list, 985
Output in alarm, 1276
Raw data tag, 1129
Read continuously, 1012
reconnecting, 995
Rename, 991
RFID tag, 2010
Start value, 998
symbolic addressing, 981
Tag type, 988
Tolerance band, 1111, 1117
Transponder, 2010
Update, 1012
User data type, 1023
User data type element, 1023
Value range, 1041
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Tag array, 1019
Tag binding

Animation, 744
Tag data

Structure for the import, 2087, 2089, 2093
Tag import

Tag data structure, 2087, 2093
Tag list

Indirect addressing, 1009
Tag log

Migrating, 117
Tag name

Valid names in logs, 1114, 1147
Tag simulator, 2202
Tag table

Default, 977
for HMI devices, 977
user-defined, 977

Tag triggers, 2037, 2051
Tag type, 988
Tag value

Output, 1169, 1175
Updating, 980

Tags
Alarm group, 1256
Basics, 976
Migration, 123

tan function, 1961
tanh function, 1961
Task, 2033

Changing during Runtime, 2056
Changing the name, 2047
Creating for the automatic start of a print job, 
1636
Deactivate, 2035, 2036
Deleting, 2048

Task card, 634
Changing the pane mode, 172
Function, 171
Hardware catalog, 286
Reducing automatically, 163
Tools, 657, 660, 664

Task Card
Online Tools, 595

TCI (Tool Calling Interface), 471
TCON_Param, 364
TCP

Characteristics, 363
Port numbers, 367

Teach-in mode, 1482
Recipe tag, 1482

Telegram tag, 1129

Telemecanique Uni-Telway
Migrating data types, 137

Telephone book at TeleService, 2818
Telephone networks which can be used, 2819
TeleService

 Meaning of the icons, 2845
AS_DIAL, 2850
Callback variants, 2837
Establish connection to AS, 2850
Global telephone book, 2818

TeleService callback options, 2839
TeleService functionality, 2818
TeleService telephone book, 2818
Temperature coefficient, 552
Temperature compensation, 539
template

Template, 646
Template

Copy, 646
Creating, 644
Deleting, 646
Global screen, 644
Inserting, 646
Move, 646
Rename, 646
Use in screen, 648

Terminal modules and electronic modules, 537
Terminal service, 2556
Terminal services, 2601

activate, 2602
Creating users, 2603
WebNavigator Client, 2601

Terminating the remote connection, 2842
Test form

Creating, 2761
testing, 2761

Customer controls, 2761
Testing, 1794

User-defined function, 1761
with debugger, 1794

Text
Button, 911
Define text format, 890
Editable text field, 842
Text field, 936, 1684

Text field, 936, 1683
Size, 936, 1684
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Text list
Application, 709
Bit (0, 1), 715
Bit number  (0 - 31), 716
Creating, 710
Exporting, 2091
Importing, 2093
Output in alarm, 1277
Range (... - ...), 714
Symbolic I/O field, 717, 926, 927
Value/Range, 712

Text lists
Introduction, 237
System-defined, 238
Use in recipe data records, 1487
User-defined, 238

Texts
Migrating, 114

TIA Portal
Exiting, 149
Starting, 149

Time, 1055, 1064
Time axis

Configuring, 1190
Time base

Setting, 890
Time column property changed, 1996
Time error interrupt OB, 525
Time expired, 1856
time function, 1966
time functions

asctime function, 1966
ctime function, 1966
difftime function, 1966
gmtime function, 1966
localtime function, 1966
mktime function, 1966
strftime function, 1966
time function, 1966

Time of day
Setting the time of day in the Online and 
Diagnostics view, 609

Time range, 1185
Dynamic, 1185
static, 1185

Time stamp, 1258
Time stamping, 540
Time_of_day, 1056
Time_Of_Day, 1065
Time-delay interrupt OB, 522
Time-driven output

Report, 1630

Time-of-day, 496
Time-of-day function

Basics, 502
Clock parameters, 503
Reading the time of day, 503
Setting the time of day, 503
Time-of-day format, 502

Time-of-day synchronization, 496
Timer, 1056, 2037

Acyclic triggers, 2037
Cyclic triggers, 2037, 2048

Title page
in reports, 1615
Report, 1605, 1608

TM_MAIL, 27
tmpfile function, 1963
tmpnam function, 1963
Toggle, 1854

Between Runtime languages, 2120
Key, 2286

Tolerance band
Tags, 1111, 1117

tolower function, 1960
Tool Calling Interface (TCI), 471
Toolbar, 848, 850, 853, 935, 1195, 1206, 1211

 Table view, 1188
Button with screen change:, 972
Configuring a system function, 972
Configuring an event, 969
Creating, 963
customized, 957, 967
Order, 666, 675, 1646
Recipe view, 1580, 2342

Toolbar button property changed, 1994
Tools, 657, 660, 664

for the design of reports, 1618
Topology discovery, 465
Topology view

Adding device, 301
Adopt devices identified online, 387
Adopt port interconnections identified online, 387
Compare offline/online, 379
Configured topology, 375, 376
Diagnostics status in the graphic view, 377
Diagnostics status in the table view, 378
Differences compared with the network view, 373
Functions, 373
Hardware and network editor, 280
Interconnecting ports, 380

toupper function, 1960
TP 177B mono

Symbol library, 924
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TP177A
Loading a project, 47

Transfer card, (See Memory Card)
Transferring

 License key to HMI device, 2234
Recipe data record, 2331, 2332, 2339

Transferring recipe values
between HMI device and PLC, 1565

Transferring the project
HMI device, 52
Recipe data record, 52

Translate
Editor, 2108

Transmission medium/duplex, 463
Transparency

In graphic, 688
transparent color, 855

Display on panels, 855
Transponder, 2010, 2011
Trend, 1171

Common axes, 1187
Configuring, 1193
Multiple axes, 1186
Representation formats, 1184
Text orientation, 1185
Trend curve, 1185

Trend diagram property changed, 1992
Trend display

Resolution, 1181
Trend property changed, 1993

Trend view, 872, 1171, 1182
Button, 872
Buttons, 1217
Changing the order of trends, 1224
Configure trend, 1193
Configuring, 1189
Configuring for logging, 1178
Configuring for values from the PLC, 1169, 1176
Configuring the data source, 1194, 1204
Configuring the export of Runtime data, 1197, 
1207, 1214
Configuring the value axis, 1191
Configuring the X axis, 1191
Configuring the Y axis, 1191
Configuring time axis, 1190
Elements of the status bar, 1233
Moving a trend area in Runtime, 1223
Number of trends, 1181
Online configuration, 1230
operation in Runtime, 1217, 1219
Range proportion, 1192
Representation formats, 1184
Resolution of Trend Display, 1181
Scrolling through archived data, 1232
Status bar, 1195, 1206, 1211
Subdivision, 1192
Text orientation, 1185
Toolbar, 1217
Trend curve, 1185
Trend in the foreground, 1224
Zooming in on ~  area in Runtime, 1222
Zooming in on a trends in Runtime, 1222
Zooming in on the time axis in Runtime, 1223
Zooming in on the value axis in runtime, 1223
Zooming out on a trend in Runtime, 1222

Trends
in reports, 1619

Trends and alarms, (See Trends and Alarms)
Trends and Alarms, 2608

Alarm Table, 2663
Analysis function, 2667, 2668
Display Alarms, 2663
Hit List of Alarms, 2667
Message Column Names, 2665

Trigger mode, 1133
Trigger tag, 1259
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Triggers, 2035
Acyclic, 2036, 2043, 2051
Changing, 2048
Cyclic, 2036, 2044, 2052, 2055, 2058
Event trigger, 2035, 2036, 2046, 2054
Standard cycle, 2036
Tag triggers, 2037, 2051

TS adapter, 52
TS Adapter

Installing additional software, 2824
TS Adapter MPI

Brief description, 2824
Default parameter assignment, 2825
Direct connection, 2825
Establishing a modem connection, 2826
Establishing the direct connection, 2826
Exporting adapter parameters, 2830
Importing adapter parameters, 2830
Modem connection, 2826
parameter Assignment, 2828
Parameter assignment , 2828
Parameter assignment options, 2827
Principle of operation, 2825
Restoring the default parameter assignments, 
2829
Setting up access protection, 2838

TS Adapter IE
Brief description, 2831
Default parameter assignment, 2832
parameter Assignment, 2835
Principle of operation, 2832

TS Adapter IE Basic
Connection to the GSM network, 2834
Connection to the telephone network, 2833
Connection to the telephone network through an 
external modem, 2834
Connection types, 2833

TSAP
ASCII code table, 370
Structure, 341, 368

TSAP assignment
Examples, 370

Type
Library, 775

Types of DP slave, 428

U
uaAddArchive, 1919
uaAddField, 1920
uaArchiveClose, 1921
uaArchiveDelete, 1921

uaArchiveExport, 1922
uaArchiveGetCount, 1923
uaArchiveGetFieldLength, 1923
uaArchiveGetFieldName, 1924
uaArchiveGetFields, 1925
uaArchiveGetFieldType, 1925
uaArchiveGetFieldValueDate, 1926
uaArchiveGetFieldValueDouble, 1927
uaArchiveGetFieldValueFloat, 1927
uaArchiveGetFieldValueLong, 1928
uaArchiveGetFieldValueString, 1929
uaArchiveGetFilter, 1929
uaArchiveGetID, 1930
uaArchiveGetName, 1931
uaArchiveGetSort, 1931
uaArchiveImport, 1932
uaArchiveInsert, 1933
uaArchiveMoveFirst, 1933
uaArchiveMoveLast, 1934
uaArchiveMoveNext, 1934
uaArchiveMovePrevious, 1935
uaArchiveOpen, 1935
uaArchiveReadTagValues, 1936
uaArchiveReadTagValuesByName, 1937
uaArchiveRequery, 1938
uaArchiveSetFieldValueDate, 1939
uaArchiveSetFieldValueDouble, 1939
uaArchiveSetFieldValueFloat, 1940
uaArchiveSetFieldValueLong, 1941
uaArchiveSetFieldValueString, 1941
uaArchiveSetFilter, 1942
uaArchiveSetSort, 1943
uaArchiveUpdate, 1944
uaArchiveWriteTagValues, 1944
uaArchiveWriteTagValuesByName, 1945
uaConnect, 1946
uaDisconnect, 1946
uaGetArchive, 1947
uaGetField, 1947
uaGetLastError, 1948
uaGetLastHResult, 1950
uaGetNumArchives, 1950
uaGetNumFields, 1951
uaQueryArchive, 1952
uaQueryArchiveByName, 1952
UaQueryConfiguration, 1953
uaReleaseArchive, 1954
uaReleaseConfiguration, 1955
uaRemoveAllArchives, 1955
uaRemoveAllFields, 1956
uaRemoveArchive, 1957
uaRemoveField, 1957

Index

WinCC Professional V11.0 SP1
System Manual, 08/2011,  2923



UART data transmission, 508
uaSetArchive, 1958
uaSetField, 1959
UDInt, 1065, 1086
UDP

Characteristics, 363
Port numbers, 367

UInt, 1066, 1087
Underflow, 554
Undoing actions

Basics of undoing, 231
Undoing last action, 233
Undoing multiple actions, 233

ungetc function, 1964
Uninstalling

Option, 2236
Uniqueness

of object names, 92
unlock

Users, 1721
Unplugged module, 297
Unsigned 16-bit value, 1076, 1077, 1078, 1079, 1080, 
1081, 1082
Unsigned word, 1076, 1077, 1078, 1079, 1080, 1081, 
1082
Unspecified CPU, 302
Update

Tag, 1012
Update cycle, 1034
Update time, 461
Updating

Faceplate type, 805
Operating system of the HMI device (Windows 
CE), 2232
Tag, 980

Updating the operating system, 2231
URL

OPC UA Server, 2738
OPC XML DA Server, 2710

USB
Loading, 2193, 2194, 2195, 2214, 2216

USB driver, 2194, 2195, 2214, 2216
Installation under Windows 7, 2195, 2216
Installation under Windows XP, 2194, 2214

USB interface, 2194, 2195, 2214, 2216

Use, 1474
Alarm view, 2356
Alarm window, 2356
Faceplate type, 806
Local script, 1782
Of recipes, 1474
Project-wide alarm class, 1265
Recipe view, 2320
simple alarm view, 2358
simple alarm window, 2358
Simple user view, 2297
User view, 2296
User view , 2295

Use global assignment
Function key, 643

Useful information on configuring the TS Adapter 
MPI, 2827
User

Changing, 1720
Deleting in runtime, 1720
Dynamic logon, 1704

User administration, 1684
Central user administration, 1705
exporting, 1724
importing, 1725
Migration, 117
Object with access protection, 1728, 1729
Runtime settings, 1689, 1691, 1694
Setting up, 1733
SIMATIC Logon, 1705
WebCenter, 2633

User alarm, 1243
Parameter output , 1297

User change, 1847, 2053
User data

Area, 489
Backing up, 2295
Restoring, 2295

User data type, 1023
Copy, 1032
Create, 1025
Creating, 1023
Creating a user data type element, 1025
Deleting, 1032
Inserting, 1032
Rename, 1032
Tags, 1023
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User data type element
Copy, 1033
Create, 1025
Deleting, 1034
Editing, 1033
Paste, 1033
Rename, 1033

User group, 2255, 2294, 2633
Administer authorizations, 1701
Assigning, 1738
Assigning users, 1699
Change displayed name, 1702
Changing in runtime, 1719, 1721
Changing the name, 1701
Creating, 1697, 1737
Deleting, 1702
Domain-global user group, 2256
Include project, 2257
Individual groups, 2625
Managing, 1701
SIMATIC HMI, 2255, 2256, 2257
SQLServer2005MSSQLUser, 2255
Unauthorized, 1722

User group 
SIMATIC HMI, 2256

User interface
Details view, 172
Inspector window, 169
Maximizing the work area, 162
Minimizing the work area, 162
Overview window, 174
Portal view, 153
Project tree, 157
Project view, 155
Resetting the user interface layout, 177
Task card, 171
Views, 153
Work area, 160

User interface language, 2102
Selecting, 2105
Switching, 2630

User log
 Recipe view, 1589, 2351
UserArchiveControl, 1587, 2349

User text block
Configuring , 1283

User text blocks, 1282

User view, 1712, 2295
Changing user data, 2296
Columns moveable, 832
Complex user view, 831
Complex user view , 1714
Configuring, 1715
Export user data, 2297
Import user data, 2297
Layout, 2296
Number of lines, 832
Permitted characters, 48
Simple user view, 831, 1713
Use, 2295, 2296

UserArchiveControl, 1579, 2341
Configuring, 1584, 2346
Edit data, 1587, 2349
Online configuration, 1564
Runtime data, 1563

User-defined function, 1740, 1745
Adapting display properties, 1755
Changing object property, 1811
Code templates, 1754
configuring in C, 1776
configuring with VBS, 1767
Entering parameters, 1753
Executing in Runtime, 1807
Opening know-how protected functions, 1762
Parameter transfer, 1757
Return value in C, 1781
Return value in VBS, 1771
Sequence is not adhered to, 1809
Synchronizing object, 1754
Synchronizing tag, 1754
Syntax highlighting, 1755
Temperature conversion, 1812
Testing, 1761
Using a system function, 1807

User-defined text lists
Creating, 238
Editing, 239
Editing value ranges and texts, 240
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Users, 2294
Admin, 2311
Assigning a user group, 1699
Changing, 1718
Changing the name, 1700
Changing, key operation, 2309
Changing, touch operation, 2307
Creating, 1698, 1738, 2298
Creating in runtime, 1716
Creating, keyboard operation, 2305
Creating, mouse operation, 2304
Creating, touch operation, 2298, 2301, 2303, 
2310
Delete, keyboard operation, 2312
Delete, mouse operation, 2312
Deleting, 1701, 2311
Deleting in runtime, 1719
Logging logons, 1732
Logoff, 2300
Logon, 1721, 1723, 2299
Logon, keyboard operation, 2299
Logon, mouse operation, 2299
Managing, 1700, 1717, 1719
Unlock, 1721
Updating after change of user, 2053

Using
Local script, 1782

Using a TS Adapter for TeleService, 2822
Using frames and cover pages from the library, 219
Using tags, 836
Using the on-screen keyboard, 181
Using the recipe in Runtime

Access protection for control tags, 1567
USInt, 1067, 1088

V
Validity range, 1774
Value axis

Configuring, 1191
Value change, 1855
Value changes to GMP-relevant tags

Effects in Runtime, 2442
Value column

Configuring, 1201
Value column property changed, 1995
Value display

 Configuring the export of Runtime data, 1197, 
1207, 1214
 Status bar, 1195, 1206, 1211
 Toolbar, 1195, 1206, 1211

Value range
Tag coding, 1041

Value table, 1209
 Online configuration, 1197, 1208, 1215
Configuring, 1211
Control elements, 941
Display modes, 1210
Displaying data in the statistics area window, 
1231
Displaying the coordinates of a point, 1225

Value/Range
Text list, 712

VBS
Examples in WinCC, 1818

VBScript
Debugging, 1794

VB-script
Migrating, 113

Vertical movement
Animation, 740

Vertical radius, 843
Ellipse segment, 845
Elliptical arc, 844

vfprintf function, 1964
View

Creating new, 1556
Purpose, 1539
Restrictions in Runtime, 1555

Views editor, 1555
Views of the cross-reference list, 2099
Visible column , 922
Volume, 1999
vsprintf function, 1964
VT_EMPTY, 1076
VT_I1, 1070
VT_I2, 1072
VT_I4, 1073
VT_R4, 1075
VT_R8, 1075
VT_UI1, 1071
VT_UI2, 1072
VT_UI4, 1074

W
Warm restart, 478
Watchdog time, 461
Watermarks

Report, 1608
Web access

WebNavigator, 2575, 2615
Web address, 861, 863
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Web application, 397
Web authorization, 2472

Setting at the HMI-device, 2463
Web Control DB, 412
Web diagnostics client

Installation, 2570
Web pages in browser, 416
Web part

insert in WebCenter page, 2653
Web Part, 2653

Delete, 2658
Export, 2658
Minimize, 2658
Moving, 2658

Web server, 393, 394, 397, 2499
Configure WinCC-Project , 2503
Enable, 395
HTTPS, 395
Service-pages, 2500
User administration, 2471
Web authorization, 2471, 2472

WebCenter, 2606
Access rights to directories, 2636
Create a WebCenter page, 2651
Layout template, 2648
Static process screens, 2646
Template file, 2648
User administration, 2633

WebCenter page
Create, 2651
Creating directory, 2635
Inserting web parts, 2653
Template file, 2648

WebNavigator
Configuring, 2572
Installation requirements, 2553
Publishing screens, 2579, 2618
Runtime settings, 2575, 2615
Terminal services, 2552
Transferring the project, 2579, 2618

WebNavigator client
Navigation interface, 2596

WebNavigator Client, 2568, 2569
Installation, 2561
Installation under the Windows Server, 2561
Operating projects, 2595

WebNavigator diagnostics client, 2553
WebNavigator Server

Installation, 2559
When dialog is closed, 1847
When dialog is opened, 1846

WinCC
Limit access, 2255
Starting Runtime, 2221, 2274

WinCC data provider
accessing, 2752

WinCC DataMonitor, (See DataMonitor)
WinCC flexible project

Migrating, 95, 122
WinCC message system

Attributes, 2725
Display of the WinCC alarm classes and alarm 
methods, 2729
on OPC A&OPC-A&WinCC message system, 
2721
WinCC alarm methods on OPC A&E server, 
2729
WinCC Message Classes on OPC A&E Server, 
2729

WinCC OPC A&E server
Condition Related Events, 2722
Configuring, 2732
Simple Events, 2722

WinCC OPC Client
Configuring, 2699, 2748

WinCC OPC HDA Server
Configuring, 2719

WinCC OPC server
Accessibility, 2708

WinCC OPC UA Server, 2738
Configuring, 2719, 2746
Discovery Server, 2738

WinCC Professional system requirements, 58
WinCC project

Include in user group, 2257
WinCC projects, 2544

Activating remote, 2547
Calling, 2535
Remote deactivating, 2548

WinCC Runtime Advanced
Display and operating element, 824

WinCC Runtime Advanced Internet, 2460
WinCC Runtime Professional Asian

Licensing, 69
WinCC system events, 1451
WinCC UserArchiveControl, (See 
UserArchiveControl), (See UserArchiveControl)
WinCC flexible Runtime

Closing, 2254, 2276
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WinCCViewerRT, 2551, 2606
Display screens, 2551
Displaying screens, 2606, 2632
Monitoring projects, 2594
Setting up, 2592, 2630

Window, 1805
Windows, 2255

Access rights, 2255
User Rights, 2255

Wire break, 553
Wireless LAN/PB link, 443
Wizard

Device wizard, 2060, 2061
WLAN area, 2009
WLAN reception, 947

Layout, 947
Word, 1057, 1069, 1076, 1077, 1078, 1079, 1080, 
1081, 1082, 1106
Work area

Effective range, 2018
Effective range (RFID), 2020
Embedding floating elements, 165
Floating elements, 165
Function, 160
Maximizing, 162
Maximizing elements, 167
Minimizing, 162
Minimizing elements, 167
Mobile Wireless, 2018
Mobile Wireless (RFID), 2020
Saving a layout of editors and tables, 168
Splitting, 164
Switching between elements, 168
Using grouped elements, 165

Work memory, 484
Work area

Zone, 2016
Working step

to create screens, 637
Working with the phone book, 2843
Writing tags, 404
WWW (instruction), 411

X
X axis

Configuring, 1191
X-axis property changed, 1995
xe , 2192, 2212
xlsx file, 2070, 2072, 2085, 2091, 2092

XML file
Creating, 2671
Storage location, 2671

Y
Y axis

Configuring, 1191
Y-axis property changed, 1996

Z
Zone, 2010, 2011, 2015

Calculating quality, 952
Configuring a screen change, 2022
Displaying an object in relation to the zone, 2023
ID Zone, 2023
On entry, 951
Work area, 2016
Zone ID, 951
Zone ID / connection point ID, 2032

Zone name, 951
Zone signal, 952
Zones editor, 2015
Zoom

Adjusting the zoom setting, 276, 278, 281
Keyboard shortcuts, 289

Zoom functions
Setting up, 2261

Zooming
Screen, 635
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